Some examples and graphics depicted herein are provided for illustration only. No real association or connection to ServiceNow products or services is intended or should be inferred.

If you have comments about this documentation, submit your feedback to: docfeedback@servicenow.com
# Table of Contents

**IT Service Management**.............................................................................................................................................. 7
- Script includes and customization................................................................................................................................. 16
- Machine learning solutions for IT Service Management................................................................................................. 16
  - Predictive Intelligence for Incident Management........................................................................................................ 16
  - Request Predictive Intelligence for Incident.................................................................................................................. 20
- Asset Management............................................................................................................................................................. 23
  - Mobile for IT Asset Management................................................................................................................................. 23
  - Asset and CI management................................................................................................................................................. 28
  - Asset classes...................................................................................................................................................................... 38
  - Create fixed assets............................................................................................................................................................. 41
  - Consumables life cycle....................................................................................................................................................... 43
  - Create pre-allocated assets................................................................................................................................................. 46
  - Stockrooms.......................................................................................................................................................................... 48
- Transfer orders for Asset Management............................................................................................................................. 53
- Create a transfer order for Asset Management.................................................................................................................. 57
- Transfer order line asset tracking.......................................................................................................................................... 60
- Example Asset Management process.................................................................................................................................. 61
- ITSM Software Asset Management..................................................................................................................................... 61
- Organization Management..................................................................................................................................................... 171
- Installed with Model Management........................................................................................................................................ 172
- Installed with Asset Management.......................................................................................................................................... 177
- Domain separation and Asset Management........................................................................................................................ 187
- Contract Management............................................................................................................................................................ 188
- Procurement........................................................................................................................................................................... 214
- Product Catalog........................................................................................................................................................................ 238
- Benchmarks............................................................................................................................................................................. 260
  - Benchmarks overview........................................................................................................................................................ 261
  - Benchmarks roles............................................................................................................................................................... 266
  - Enable Benchmarks............................................................................................................................................................ 267
  - Benchmark KPIs..................................................................................................................................................................... 269
  - Benchmarks dashboard......................................................................................................................................................... 285
  - Benchmarks troubleshooting............................................................................................................................................... 294
  - Domain separation and Benchmarks.................................................................................................................................... 295
- Change Management............................................................................................................................................................. 295
  - Change types........................................................................................................................................................................ 296
  - Upgrade Change Management........................................................................................................................................... 297
  - Change Management plugins........................................................................................................................................... 298
  - Configure Change Management........................................................................................................................................ 322
  - Create a change request...................................................................................................................................................... 364
  - Unauthorized change request.............................................................................................................................................. 372
  - Process a change request..................................................................................................................................................... 376
  - Standard change catalog..................................................................................................................................................... 385
  - Change schedules............................................................................................................................................................... 391
  - Change success score.......................................................................................................................................................... 402
  - Analyze change request risk and impact.......................................................................................................................... 411
  - Conflict detection............................................................................................................................................................... 421
  - Change approval policies.................................................................................................................................................... 436
  - Change Advisory Board (CAB) workbench.......................................................................................................................... 443
  - Change management integrations....................................................................................................................................... 466
### Table of Contents

- Mobile experience for Change Management ........................................... 470
- Domain separation in Change Management ........................................... 471
- Change Management Analytics and Reporting Solutions ....................... 473
- Change Management troubleshooting properties .................................... 490
- Quick start tests for Change Management ............................................. 491
- Coaching ......................................................................................... 494
  - Request Coaching ........................................................................ 495
  - Coaching roles ........................................................................... 497
  - Coaching overview .................................................................... 498
  - Setting up Coaching and surveys ............................................... 502
  - Coaching your trainee ............................................................... 506
  - Managing your coaching assessments ....................................... 512
  - Coaching reference .................................................................... 516
- Quick start tests for Coaching ............................................................ 525
- Continual Improvement Management .................................................. 526
  - Request Continual Improvement Management ............................ 528
  - Continual Improvement Management overview ......................... 530
  - Continual Improvement Management roles ............................... 536
  - Monitor and plan improvements ............................................... 538
  - View improvement reports ....................................................... 543
  - Requesting improvements ....................................................... 545
  - Managing improvements .......................................................... 548
  - Continual Improvement Management reference ......................... 563
  - Continual Improvements dashboard ......................................... 592
- Expense Line .................................................................................. 596
  - Components installed with Expense Line ................................... 599
  - View an expense ....................................................................... 601
  - Expense lines and expense allocations ....................................... 601
  - Domain separation and Expense Line ....................................... 606
- ITSM Virtual Agent .......................................................................... 606
  - Set up ITSM Virtual Agent ........................................................ 613
  - ITSM Virtual Agent conversation flows ..................................... 614
  - Manage Office 365 Group conversation flow .............................. 640
- ITSM Virtual Agent Lite ................................................................... 647
  - Set up ITSM Virtual Agent Lite .................................................. 648
  - ITSM Virtual Agent Lite conversation flows ............................... 648
- Walk-up Experience ................................................................. 649
  - Understanding Walk-up Experience .......................................... 650
  - Domain separation and the Walk-up Experience application ......... 653
  - Walk-up Experience portal security and access ......................... 655
  - Walk-up Experience administration ......................................... 656
  - Badge Reader Integration for Walk-up Experience .................... 685
  - Walk-up Experience queue and interaction management ............ 700
  - Walk-up Experience dashboard overview .................................. 710
- ITSM Agent Workspace ................................................................. 711
  - Explore ITSM Agent Workspace ................................................ 717
  - Setting up ITSM Agent Workspace ............................................. 724
  - Using ITSM Agent Workspace ................................................... 730
- Workforce Optimization for ITSM ................................................... 769
  - Explore Workforce Optimization for ITSM .................................. 775
  - Set up Workforce Optimization for ITSM .................................... 790
  - Use Workforce Optimization for ITSM ...................................... 809
- Incident Communications Management ........................................... 827
  - Incident Communications Management plugins ......................... 828
  - Incident communication plan state model (new) ......................... 829

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Working with Incident Communications Management .......................................................... 832
Incident Communications Management integrations........................................................ 851
Domain separation in Incident Communications Management ........................................... 852
Incident Management ...................................................................................................... 853
Incident Management process .......................................................................................... 854
Life cycle of an Incident ..................................................................................................... 855
Incident Management plugins .......................................................................................... 857
Configuring Incident ......................................................................................................... 867
Managing Incidents ............................................................................................................ 894
Incident reporting ............................................................................................................... 932
Domain separation in Incident Management ..................................................................... 970
Major incident management .............................................................................................. 972
Mobile experience with ITSM Mobile agent ...................................................................... 1012
Creating an incident in Microsoft Outlook ....................................................................... 1052
On-Call Scheduling ........................................................................................................... 1055
Activate On-Call Scheduling ............................................................................................. 1056
Definitions of On-Call Scheduling terms ......................................................................... 1061
Administering and managing On-Call Scheduling ............................................................. 1062
On-Call roster members: Your schedules and preferences ............................................... 1132
Mobile experience for On-Call Scheduling ...................................................................... 1139
Problem Management ...................................................................................................... 1142
Understanding problem management .............................................................................. 1142
Problem Management plugins .......................................................................................... 1146
Migration Utility ............................................................................................................... 1154
Configuring problem management .................................................................................... 1163
Managing Problems .......................................................................................................... 1173
Communicating the outcome of a problem ....................................................................... 1196
Problem management integrations .................................................................................... 1200
Release Management ...................................................................................................... 1227
Domain separation in Release Management ..................................................................... 1228
Release Management concepts and tables ....................................................................... 1228
Activate Release Management .......................................................................................... 1231
Release Management v2 application ............................................................................... 1231
Software control distribution ............................................................................................. 1235
Release Management roles ............................................................................................... 1236
Request Management ...................................................................................................... 1236
Request Management architecture ..................................................................................... 1236
Domain separation in Request Management ...................................................................... 1238
Agent Workspace for Request Management ...................................................................... 1239
Request ITSM Roles - Request Management ..................................................................... 1242
Activate Business Stakeholder ........................................................................................... 1245
Service Desk ...................................................................................................................... 1246
Service Desk Call ............................................................................................................... 1248
Service Desk Call uses ....................................................................................................... 1252
Service Portfolio Management .......................................................................................... 1257
Understanding Service Portfolio Management ..................................................................... 1258
Service Portfolio Management administration .................................................................... 1260
Domain separation in Service Portfolio Management ....................................................... 1268
Set up Service Portfolio Management ................................................................................ 1269
Service Portfolio Management design experience ............................................................ 1269
Service Portfolio Management service offering subscriptions ........................................ 1288
Service Level Management for Service Portfolio Management ......................................... 1289
Service Owner Workspace .................................................................................................. 1290
Service Level Management ............................................................................................... 1340
Service Level Management concepts ................................................................................ 1340
Define a service contract ................................................................. 1342
Service Level Management plugins ................................................... 1343
Configure Service Level Agreement (SLA) ......................................... 1352
Service Level Agreement (SLA) breakdown definitions ....................... 1380
Service Level Agreement (SLA) processing ......................................... 1382
Repair Service Level Agreement (SLA) ............................................ 1386
Monitoring Service Level Agreement (SLA) ....................................... 1391
Legacy Service Level Agreement (SLA) engines ................................. 1408
Service level management overview dashboard ................................. 1418
Analytics and Reporting Solutions for Service Level Management ....... 1420
Domain separation in Service Level Management ............................... 1424
Quick start tests for Service Level Management ................................. 1426
Task Outage .................................................................................... 1426
Activate Task-Outage Relationship .................................................. 1426
Add the Outage UI action to another task form ................................. 1427
Associate a task with an outage ....................................................... 1428
Create an outage from a task ......................................................... 1428
Domain separation for task outage .................................................. 1429
Collaboration services ..................................................................... 1429
Install Collaboration services ............................................................ 1430
Setting up Slack for communication ................................................ 1431
Configure Slack as a communication channel for a communication task 1431
Process flow for Slack communication .............................................. 1432
Slack integration - Incident Management .......................................... 1433
Vendor Manager Workspace ............................................................. 1440
Explore Vendor Manager Workspace .............................................. 1446
Set up Vendor Manager Workspace application ............................... 1456
Use Vendor Manager Workspace ..................................................... 1471
Vendor Performance ........................................................................ 1473
Configuring Vendor Performance .................................................... 1474
Activate Vendor Performance ......................................................... 1491
Use the Vendor Performance Overview .......................................... 1493
Vendor scorecards ........................................................................... 1495
Scorecard ratings ............................................................................. 1499
Vendor decision matrices ............................................................... 1510
Using vendor bubble charts ............................................................. 1514
Vendor ticketing .............................................................................. 1518
Domain separation in Vendor Performance ....................................... 1537
ITSM Predictive Intelligence Workbench .......................................... 1538
ITSM Predictive Intelligence Workbench administration ................... 1539
Predictive Intelligence Workbench pretrained use cases .................... 1546
Predictive Intelligence Workbench integration and customization ....... 1546
ITSM Predictive Intelligence Workbench implementation .................. 1547
Manage ITSM Predictive Intelligence Workbench use cases ............... 1612
ITSM Predictive Intelligence Workbench dashboard ......................... 1613
Performance Analytics ITSM Dashboards ........................................ 1621
IT Executive dashboard ................................................................. 1622
IT Manager dashboard ................................................................. 1626
IT Agent dashboard ................................................................. 1636
IT Service Management integration with Microsoft Teams ................ 1642
Overview of IT Service Management integration with Microsoft Teams 1643
Index .......................................................................................... 1705
IT Service Management

The IT Service Management (ITSM) solution provides scalable workflows to manage and deliver IT services to your users all through a single cloud-based platform. The ITSM solution can help increase your agents’ productivity, resolve issues quickly, and improve user satisfaction. Also, powered by platform native AI, you can quickly accelerate technology changes and view recommended actions for incoming tickets or requests and drive self-service and automation through enterprise chatbot technology. The NOW Platform also provides users access to ITSM via mobile or web-portal interfaces.

Transform the impact, speed, and delivery of IT services

The Now Platform was built for the cloud and has its own shared data model, AI, and workflow automation that are leveraged by many IT applications. The combination of the ServiceNow platform and applications helps you increase productivity by automatically identifying and resolving issues, which reduces the negative business impacts of unplanned, non-strategic work.
Siloed functional tools create friction
Disconnecting IT from the business

ServiceNow links IT functions
Connecting IT to the business
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhance the service experience</td>
<td>Automate support for common requests with virtual agents powered by natural language understanding (NLU). Engage users with natural, human conversation to provide consistent good customer service experiences.</td>
</tr>
<tr>
<td>Consolidate IT services</td>
<td>Rapidly consolidate existing tools to a single system of action in the cloud.</td>
</tr>
<tr>
<td>Improve IT productivity</td>
<td>Use machine learning algorithms and virtual agents to automate routine tasks and increase the productivity of agents.</td>
</tr>
<tr>
<td>Gain visibility into processes and services</td>
<td>Get full visibility into any process or service with built-in dashboards and analytics providing real-time, actionable information to improve service quality.</td>
</tr>
<tr>
<td>Provide mobile connectivity</td>
<td>Enable employees to find answers and get work done from a modern mobile application.</td>
</tr>
</tbody>
</table>
Enhance the service experience

Automate routine agent interactions and increase the speed of resolution. With supervised machine learning, you can automate incident categorization and assignment and eliminate bottlenecks created by manual incident triaging. Meet increasing demands without further adding staff and empower existing IT staff to focus on more meaningful work.
Consolidate IT services

Reduce the number of separate tools your company uses to provide a consistent service experience regardless of the issue or the request. Consolidating IT services enables you to better manage and allocate resources and track performance. You can have a single reliable source of information where performance is monitored in real time and data is easy to capture and report.
Accelerate resolution with built-in machine learning. Chatbots provide immediate resolution to common questions. With ITSM Virtual Agent in action, you can have employees with 24*7 support service. Service desk agents can take advantage of machine-learning automation to resolve incidents and recommend resolutions for agents based on similar incidents solved in the past.
Gain visibility into processes and services

Make smarter decisions with real-time analytics across the entire IT value chain. Get new insights into service performance using data trends and forecasts. With Performance Analytics, you can anticipate trends based on current conditions and past performance and identify areas where automation can increase efficiency.
Stay connected and access information in real time using the ITSM mobile agent. You can access work assigned to you or your group, receive push notifications, and approve or reject change requests and requested items. The ITSM mobile agent is available on the iOS platform from the Apple App Store or on the Android platform from the Google Play Store.

**Edge Encryption for ITSM Virtual Agent within ITSM**

Edge encryption provides you with direct control over your data security. Encryption and key management are performed on your intranet between your browser and your ServiceNow instance.

See [Understanding Edge Encryption](#).

Because edge encryption is enabled on a proxy server on your side of the network, there is significant planning, network administration and management, and setup required.

See [Planning for Edge Encryption](#).

To install edge encryption, see [Edge Encryption installation](#).
To configure edge encryption, see *Edge Encryption configuration.*

**Note:** There are limitations when using edge encryption. See *Edge Encryption limitations.*

### Get started

- Set up the service management module for a modern ITSM experience. To learn more, see *Customer Success Center.*
- Learn about the different ITSM packages that work for your business on the *ServiceNow Products website.*
- Take an ITSM course to manage and deliver services to your users. To sign up, go to *ServiceNow training and certification.*
- Read the product documentation, beginning with *IT Service Management.*

### Applications and features

- *Machine learning solutions for IT Service Management*
- *Workforce Optimization for ITSM*
- *Asset Management*
- *Contract Management*
- *Procurement*
- *Product Catalog*
- * Benchmarks*
- *Change Management*
- *Coaching*
- *Continual Improvement Management*
- *Expense Line*
- *ITSM Virtual Agent*
- *Walk-up Experience*
- *ITSM Agent Workspace*
- *ITSM Predictive Intelligence Workbench*
- *Incident Communications Management*
- *Incident Management*
- *On-Call Scheduling*
- *Problem Management*
- *Release Management*
- *Request Management*
- *Service Catalog*
- *Service Desk*
- *Service Portfolio Management*
- *Service Level Management*
- *Task Outage*
- *Collaboration services*
- *Vendor Manager Workspace*
- *Vendor Performance*
- *Performance Analytics ITSM Dashboards*
Script includes and customization

Many Script Includes are provided by default with ITSM products. Script includes are found under System Definition or System UI. You can call existing script includes from a script or create your own by following the format of the existing script includes.

To modify or customize an existing script include, remember the following points:

- Do not use the script includes that are suffixed by SNC, they are read-only and should not be customized. For example, the given type of script include should not be customized.

```javascript
var ChangeProcessSNC = Class.create();
ChangeProcessSNC.prototype = {
  // SNC functions
  type: ""
};
```

- Do not override methods that start with an underscore, they indicate that the functions are private.

However, you can override the functions of the non-SNC script includes that extend the SNC scripts, for example, the given type of script include can be overridden.

```javascript
var ChangeProcess = Class.create();
ChangeProcess.prototype = Object.extendsObject(ChangeProcessSNC,
{ // Customer overridden functions type: "ChangeProcess" });
```

During upgrade, follow these rules to get the latest features and problem fixes without breaking the existing functionality.

Machine learning solutions for IT Service Management

Machine learning in IT service management helps to enhance business scalability and improve business operations for organizations.

Businesses face a challenge with growing volumes of data, in extracting meaningful information from a huge set of raw data, and in deriving meaningful business insights. Machine learning can serve as a solution to a variety of business complexities as its algorithm is built using historical data. It helps avoid duplicate and inaccurate data being entered into the database and enables businesses to compute and process information much faster.

Predictive Intelligence for Incident Management

Use your instance records to build Incident Management-specific solutions.

Solution definitions

These solution definitions are available as templates on instances where both Predictive Intelligence and Incident Management are active. Create your own solution definition records to customize the behavior.
### Solution Definitions for Incident Management

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Assignment</td>
<td>Classification</td>
<td>Predicts the <strong>Assignment group</strong> field from the <strong>Short description</strong>.</td>
</tr>
<tr>
<td>Incident Categorization</td>
<td>Classification</td>
<td>Predicts the <strong>Category</strong> field from the <strong>Short description</strong>.</td>
</tr>
<tr>
<td>Incident Service</td>
<td>Classification</td>
<td>Predicts the <strong>Service</strong> field from the <strong>Short description</strong>.</td>
</tr>
<tr>
<td>Incident Configuration Item</td>
<td>Classification</td>
<td>Predicts the <strong>Configuration item</strong> field from the <strong>Short description</strong>.</td>
</tr>
<tr>
<td>Major Incident Detection</td>
<td>Similarity</td>
<td>Recommends similar active major incidents which the current incident can be linked to. Recommends similar incidents to propose a major incident.</td>
</tr>
<tr>
<td>Similar Incidents (Major Incident Workbench)</td>
<td>Similarity</td>
<td>Recommends similar incidents that are not linked as child incidents to a major incident.</td>
</tr>
<tr>
<td>Similar Incidents</td>
<td>Similarity</td>
<td>Recommends similar incidents to help with incident investigation and resolution processes.</td>
</tr>
<tr>
<td>Similar Open Incidents</td>
<td>Similarity</td>
<td>Recommends similar open incidents that the current incident can be linked to.</td>
</tr>
<tr>
<td>Similar Resolved Incidents</td>
<td>Similarity</td>
<td>Recommends similar resolved incidents to help with incident investigation and resolution processes.</td>
</tr>
</tbody>
</table>

For more information on classification and similarity solution, refer to [Create solution definition](#) and [Create similarity solution](#).

### Business rules for classification solutions

These business rules apply only to the Incident Assignment and Incident Categorization solution definitions and are available only on instances where both Predictive Intelligence and Incident Management are active. Create your own business rules on the Incident table to customize prediction and reporting behaviors.
## Business rules for Incident Management

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Prediction Results</td>
<td>Incident</td>
<td>Updates the solution precision and coverage statistics. Runs when an incident record is closed.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Incident Based Prediction (Service &amp; CI)</td>
<td>Incident</td>
<td>Generates prediction results for active Incident Management solutions. Shows prediction results in an information message to users with the itil role. Runs when an incident record is inserted. Only updates the output field with a predicted value if it has not been already filled.</td>
</tr>
</tbody>
</table>

**Note:** The rule is based on the following conditions:

- First priority is given to the manually entered value in the Service and the Configuration item field.
- Second priority is given to the predicted value of the Service field.
- If the values of the Configuration item and Service fields do not match and the Configuration item field value was manually entered, then the Configuration item field value is considered and the Service field value is discarded. Otherwise, the Service field value is considered.

If the classification is successful, a notification is displayed regarding the classified Service and CI. If there is conflict between predicted CI with existing or predicted Service, then a notification is displayed regarding the conflict with predicted CI. If there is conflict between existing CI with predicted Service, then...
Upgrade Information

If your instance is running on the Kingston release and you are upgrading to the Paris release:

- In a global domain environment, use the new solutionNames array variable which requires that you explicitly provide the solutions that are called by the business rule.
- In a domain-separated environment, such as an MSP environment, refer to the commented code in the business rule template for easy customization.
- The business rule template now calls the `applyPredictionForSolution()` method to predict regardless of any changes to the default value.

Maintaining prediction accuracy

You can manage prediction drift by retraining, modifying, or creating new solutions to reflect changes in your business conditions. Test and modify your business rule over time to ensure it works as desired across multiple consumption points and user Personas.

Request Predictive Intelligence for Incident

To activate Predictive Intelligence for Incident, request the Predictive Intelligence for Incident plugin (com.snc.incident.ml) through the HI Customer Service system. This plugin activates related plugins if they are not already active.

Role required: none

The Predictive Intelligence for Incident plugin activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predictive Intelligence for Contextual Search</td>
<td>Enables customers to leverage machine-learning algorithms for searching with Contextual Search. For example: Similar Open Incidents. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details.</td>
</tr>
</tbody>
</table>

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.
4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click **Submit**.

**Predictive Intelligence for Incident**

Use your instance records to build Incident Management-specific solutions.

**Solution definitions**

These solution definitions are available as templates on instances where both Predictive Intelligence and Incident Management are active. Create your own solution definition records to customize the behavior.
Solution Definitions for Incident Management

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Similar Open Problems</td>
<td>Similarity</td>
<td>Recommends similar open problems that the current incident can be linked to. By default, the similarity is inactive.</td>
</tr>
<tr>
<td>Similar Open Change Requests</td>
<td>Similarity</td>
<td>Recommends similar open change requests that the current incident can be linked to as a request for change. By default, the similarity is inactive.</td>
</tr>
</tbody>
</table>

For more information on similarity solution, refer Create similarity solution.

Asset Management

The ServiceNow® Asset Management application integrates the physical, technological, contractual, and financial aspects of information technology assets.

Asset management business practices have a common set of goals.

- Control inventory that is purchased and used.
- Reduce the cost of purchasing and managing assets.
- Select the proper tools for managing assets.
- Manage the asset life cycle from planning to disposal.
- Achieve compliance with relevant standards and regulations.
- Improve IT service to end users.
- Create standards and processes for managing assets.

Most successful ITAM programs involve various people and departments, including IT, finance, services, and end users.

Asset Management and the Configuration Management Database (CMDB) are related, but have different goals. Asset Management focuses on the financial tracking of company property. Configuration management focuses on building and maintaining elements that create an available network of services.

Mobile for IT Asset Management

Use the Now® Mobile and Agent mobile apps to manage your assets.

Agent Mobile app

Use the Agent Mobile app to create assets, look up assets, and receive assets from a purchase order.

Create an asset

Use the Agent Mobile app to create an asset record by scanning the asset.
Role required: asset

1. Navigate to **Asset** and tap **Create Asset**.

2. Scan the asset serial number or asset tag, then tap **Search**.
An asset record is displayed if the asset already exists in your ServiceNow instance. This is to ensure you don’t create duplicate asset records.

3. If no existing asset record is found, tap the action icon in the upper right and select Create Asset.

4. Scan or enter values for the **Asset Tag**, **Serial Number**, **Model**, and **Stockroom** fields.

5. Tap **Submit** to create the asset.

**Asset lookup**

Search for an asset record in your ServiceNow instance by scanning the asset.

Role required: asset

1. Navigate to **Asset** and tap **Asset lookup**.
2. Scan the asset tag, then tap **Search**.
3. An asset record is displayed if the asset exists in your ServiceNow instance.

**Receive assets from a purchase order**

Scan assets from a purchase order (PO) to verify that you received all assets from the order.

Role required: procurement_admin or procurement_user

1. Navigate to **Procurement** and tap **POs Next 30 Days**.
2. Select a purchase order.
3. Tap **Related list**.
4. Tap the **PO Line Items** asset that you ordered and swipe **Receive** to receive the asset.
5. If you only need to receive a single purchase, on the Receive form, scan the QR code for either the asset tag or serial number.

6. If you need to receive multiple purchases, on the Receive form, tap **Scan next item**. Continue tapping **Scan next item** until you’ve scanned all of your purchases.

7. Tap **Submit**.

The purchase order is marked as received.

**Now Mobile app**

Use the Now Mobile app to view the assets assigned to you. Create incidents to report any issues with your assets to your IT department.
Tap **My Locker** on the Services page to view all assets that are assigned to you. Select any of your assets to create an incident for that asset.

### Asset and CI management

Asset and configuration item (CI) management refers to creating assets, setting appropriate states and substates, synchronizing assets and CIs, managing consumables, and retiring assets.

### Relationship between asset and CI

It is important to manage the relationship between assets and associated CIs. Assets are tracked with the Asset Management application, which focuses on the financial aspects of owning property. Configuration items are stored in the CMDB, which is used to track items and make them available to users.

When an asset has a corresponding configuration item, the asset record and the configuration item record are kept synchronized with two business rules.

- **Update CI fields on change** (on the Asset (alm_asset) table)
- **Update Asset fields on change** (on the Configuration Item (cmdb_ci) table)

**Note:** Assets and CIs can be synchronized only if they are logically mapped.

### Asset-CI mapping and synchronization

The State field of asset record and Status field of CI record are synchronized so that changes made on one form trigger the same update on the corresponding form, ensuring consistent reporting.

**Note:** The Now Platform synchronizes updates between assets and configuration items only if the asset and configuration item are pointed toward each other.

The following diagram illustrates the concept of Asset-CI mapping and synchronization.
This synchronization and mapping is based on the following factors:

- Asset state and CI status are not mapped on one-to-one basis; rather they are mapped to the most logical counterpart on the other table. For example, for a hardware asset set to state **In Stock - Pending disposal**, the corresponding CI is set to **In Disposition** with no substate.
- This synchronization happens between the asset’s State field and the following CI fields:
  - Install Status field: Install Status does not have a sub status and must be used for non-hardware CIs.
  - Hardware Status and Sub status field: Hardware Status is visible only for Hardware CI.
- Drive changes by updating the state on the Asset form. The Asset-CI synchronization can be driven in the following ways:
  - Asset to CI synchronization: Change to the asset’s status updates the logically mapped CI’s Install Status or Hardware Status and sub status.
  - CI to Asset: Change to the CI’s activate Status or Hardware Status updates the logically mapped asset’s states and sub states.
• For a CMDB hardware CI, if both Hardware Status and Install Status is updated, the Hardware Status change is considered for mapping the corresponding state of the asset.

• CI’s Install Status and Hardware Status work independently, so the two fields aren’t related. CI’s Hardware Status change does not change CI’s Install Status and vice versa. To avoid confusion, keeping both status for CMDB CI Hardware is not recommended.

List of the fields that get synced between Asset and CI

When modifying any of following fields on the asset or CI record, the same field on the corresponding record is automatically updated (with the exception of the Cost field, which is informational-only on the CI record).

Following is a list of fields that are synched.

• Asset tag
• Assigned
• Assigned to
• Checked in
• Checked out
• Company
• Cost (synchs in only one direction: asset to CI)
• Cost center
• Delivery date
• Department
• Due in
• Due
• GL account
• Install date
• Invoice number
• Justification
• Lease id
• Location
• Managed by
• Model
• Order date
• Order received
• Ordered
• Owned by
• PO number
• Purchase date
• Purchased
• Serial number
• Support group
• Supported by
• Vendor
• Warranty expiration
Asset and CI creation properties

**glide.create_alm_asset.async**

The system property *glide.create_alm_asset.async* controls whether assets are created immediately when a configuration item (CI) is created, or are created after a delay. A delay in asset creation allows large numbers of CIs to be created quickly. When this property is set to *true*, assets are created by the Asset - Create asset delayed sync scheduled job that runs every 15 minutes. View the status of the scheduled job in the Asset Job Log table (asset_job_log). To view assets waiting to be created and asset creation errors, navigate to Asset > Administration > Asset Creation Queue. To reprocess an error, update the state from Error to Ready. The next time the scheduled job runs, it reattempts to create the asset.

When the *glide.create_alm_asset.async* property is set to *false*, assets are created immediately from CIs.

**Note:** The default value of this property is *false* if you upgrade to Paris from Orlando or earlier. Before updating this property, review your processes that depend on an asset value present on a CI and make any necessary changes to account for delayed asset creation.

**glide.asset.create_ci_with_ire**

The system property *glide.asset.create_ci_with_ire* enables CIs to be created from assets using the ServiceNow® Configuration Management Database (CMDB) Identification and Reconciliation engine (IRE). This property affects CI classes that have an identification rule on serial number and have no dependent relationships with other CI classes.

**Note:** CI classes that are extended from the hardware CI class [cmdb_ci_hardware] are also created from assets using the IRE, but are not controlled by this property.

CIs created with the IRE are named using the format *Serial number - Model name* and the source is SNAssetManagement. The *Serial number* field is mandatory on assets with model categories that correspond to these CI classes. Asset creation fails if its serial number is present on an existing CI or asset. The *Serial number* field is also required to receive purchase order line items for model categories that correspond to these CI classes. The *Serial number* field is not mandatory to create pre-allocated assets, but the serial number must be provided when the asset is allocated.

**Note:** The default value of this property is *false* if you upgrade to Paris from Orlando or earlier. Before updating this property, review customizations on the *Serial number* field and any integrations or flows that use an existing serial number to create an asset.

Create assets

You can create hardware, software license, consumable, license, software entitlement, and facility assets.

Role required: asset

1. Navigate to Asset > Portfolios > All Assets.
2. Select the type of asset you want to create.
3. Click New.
4. Fill in the fields.

### Asset record fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the asset as it appears in record lists. Automatically set when asset is created, based on <strong>Asset Tag</strong> and <strong>Model</strong> fields.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model grouping of the asset. Based on the model category selected, the asset can be linked to a configuration item.</td>
</tr>
<tr>
<td>Model</td>
<td>Specific product model of the asset.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>CI automatically created when this asset is created. The name that appears in this field is based on <strong>Serial number</strong> and <strong>Model</strong>.</td>
</tr>
<tr>
<td></td>
<td>Point to the reference icon to see the configuration item details inherited from the asset record.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Number of Items this asset represents. An asset always has a quantity of one unless one or more of these points are true.</td>
</tr>
<tr>
<td></td>
<td>• It is a consumable. Quantity is unrestricted because consumables are tracked in groups.</td>
</tr>
<tr>
<td></td>
<td>• It is pre-allocated. Quantity is unrestricted when <strong>Model category</strong> and <strong>Model</strong> are defined and <strong>Substate</strong> is set to Pre-allocated.</td>
</tr>
</tbody>
</table>

#### General
Not all fields are available for each type of asset.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset tag</td>
<td>Alphanumeric information assigned by your organization to help track the asset.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the asset, such as <strong>On order</strong> or <strong>In use</strong>.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Person using or primarily responsible for this item. This field is visible when the asset state is <strong>In Use</strong>.</td>
</tr>
<tr>
<td>Managed by</td>
<td>Person who maintains the asset. This can be different from the person in the <strong>Owned by</strong> field.</td>
</tr>
<tr>
<td>Owned by</td>
<td>Person who has financial ownership of the asset. This can be different from the person in the <strong>Managed by</strong> field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent asset of the asset. For example, a monitor or peripheral can have a workstation as their parent asset. When a parent link is defined, the fields related to assignment and state of the child assets is set to read-only and are populated based on the parent assignment and state fields. For more information, see Creating Bundled Models.</td>
</tr>
<tr>
<td>Class</td>
<td>Asset group, for example, base, hardware, license, or consumable.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the asset that would be helpful for others to know.</td>
</tr>
<tr>
<td>Serial number</td>
<td>Serial number of this asset.</td>
</tr>
<tr>
<td>Substate</td>
<td>Current substate of the asset. The available substate settings depend on the state selected. For example, the Retired state contains the Substate options Disposed, Sold, Donated, and Vendor credit.</td>
</tr>
<tr>
<td>Location</td>
<td>Current physical location of the asset.</td>
</tr>
<tr>
<td>Department</td>
<td>Department to which the asset belongs.</td>
</tr>
<tr>
<td>Company</td>
<td>Company or organization to which this asset belongs.</td>
</tr>
<tr>
<td>Assigned</td>
<td>Date on which the asset was assigned to a user.</td>
</tr>
<tr>
<td>Installed</td>
<td>Date on which the asset was installed.</td>
</tr>
<tr>
<td>Financial</td>
<td>The Financial section is only available for hardware, software entitlement, and facility assets.</td>
</tr>
<tr>
<td>Request line</td>
<td>Requested item to which the asset is linked.</td>
</tr>
<tr>
<td>Invoice number</td>
<td>Invoice under which the asset was billed.</td>
</tr>
<tr>
<td>Cost</td>
<td>Price at which the asset was purchased.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor from which the asset was purchased. For assets automatically created from purchase orders in Procurement, the default value of the Vendor field is the vendor specified on the purchase order.</td>
</tr>
<tr>
<td>Opened</td>
<td>Date on which the requested item record was opened. The system automatically populates the field when a request line is specified.</td>
</tr>
<tr>
<td>GL account</td>
<td>General ledger account number with which the asset is associated.</td>
</tr>
<tr>
<td>Cost center</td>
<td>Group financially responsible for the asset.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>How the asset was acquired. Base system choices are <strong>Purchase</strong>, <strong>Lease</strong>, <strong>Rental</strong>, and <strong>Loan</strong>. For assets automatically created from purchase orders in Procurement, the default value is <strong>Purchase</strong>.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Capex</strong>: Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Opex</strong>: Operational expenditure is an ongoing expenditure. For example, toners for the photocopier.</td>
</tr>
<tr>
<td>Disposal</td>
<td></td>
</tr>
<tr>
<td>Disposal order number</td>
<td>A unique number assigned to the asset disposal order.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal vendor</td>
<td>The vendor assigned to carry out the asset disposal order.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Vendor disposal order ID</td>
<td>Order number assigned by the vendor assigned to carry out the asset disposal order.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal date</td>
<td>The date when the asset disposal order process is completed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal reason</td>
<td>Text explaining why the asset is being retired.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Beneficiary</td>
<td>Organization that receives the asset when it is retired.</td>
</tr>
<tr>
<td>Resale price</td>
<td>Value of the asset when it is retired. For example, if the asset is donated, the value used when reporting taxes.</td>
</tr>
<tr>
<td>Scheduled retirement</td>
<td>Scheduled date on which the asset is retired.</td>
</tr>
<tr>
<td>Retired date</td>
<td>Actual date on which the asset was retired.</td>
</tr>
<tr>
<td>Depreciation</td>
<td>The Depreciation section is only available for hardware and facility assets.</td>
</tr>
<tr>
<td></td>
<td>Depreciation method that is applied. Base system choices are Declining Balance and Straight Line. The depreciation value is defaulted from the associated Model.</td>
</tr>
<tr>
<td></td>
<td>Depreciation effective date</td>
</tr>
<tr>
<td></td>
<td>Date on which the specified depreciation method begins.</td>
</tr>
<tr>
<td>Salvage value</td>
<td>Estimated value of an asset at the end of its useful life. This value must be less than or equal to the Cost of the asset.</td>
</tr>
<tr>
<td>Residual date</td>
<td>Number of days that have passed since the Depreciation effective date.</td>
</tr>
<tr>
<td>Residual value</td>
<td>Value in the Cost field with the depreciation method applied.</td>
</tr>
<tr>
<td>Depreciated amount</td>
<td>Amount the asset has depreciated.</td>
</tr>
<tr>
<td>Contracts</td>
<td>The Contract section is only available for hardware, software entitlement, or facility assets.</td>
</tr>
<tr>
<td>Lease contract</td>
<td>Name of the lease contract that applies to the asset.</td>
</tr>
<tr>
<td>Warranty expiration</td>
<td>Expiration date of the asset warranty.</td>
</tr>
<tr>
<td>Support group</td>
<td>Group managing the contract covering the asset.</td>
</tr>
<tr>
<td>Supported by</td>
<td>Person managing the contract covering the asset.</td>
</tr>
<tr>
<td>Activities</td>
<td>Work notes are updated for the following cases:</td>
</tr>
<tr>
<td></td>
<td>- Updates to Assigned To, Managed To State, Substate, and Reserved fields of asset. The columns for these fields are audited by default and any update is recorded in the work notes.</td>
</tr>
<tr>
<td></td>
<td>- Work notes for hardware and software assets are updated when asset is received by a purchase order and transfer order. These work notes help in tracking life cycle of the asset.</td>
</tr>
</tbody>
</table>
## Retire assets

You can retire an asset at any time.

Role required: asset

After you change the state of an asset to **Retired**, the **Substate** field is active. When you retire an asset, the status of related CIs also changes to **Retired**. Selecting a substate is not required, but can be helpful for tracking and reporting.

1. Navigate to **Asset > Portfolios > All Assets**.
2. In **State**, select **Retired**.
3. Optional: In **Substate**, select **Disposed**, **Sold**, **Donated**, or **Vendor Credit**.
4. Click **Update**.

## Delete assets

You can delete an asset at any time.

Role required: asset

A confirmation must be accepted before the asset and components are permanently deleted. If a CI and asset are linked, deleting one also deletes the other.

Only delete an asset to clean up errors. For tracking purposes, the correct method for managing an asset that is no longer in use is to change the state of the asset to **Retired**.

1. Navigate to **Asset > Portfolios > All Assets**.
2. Select the check box to the left of the asset **Name**.
3. In the **Actions** choice list below the list, select **Delete**.

## Map asset and CI fields

When you map the asset and CI fields, synchronization happens both ways. Changes to either the asset or CI record are updated to the logically mapped record. You can synchronize custom mappings and mappings provided with the base instance.

Role required: admin or asset

---

### Table: Related links

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Depreciation</td>
<td>Click to calculate the depreciation amount and residual value.</td>
</tr>
<tr>
<td>Delete Assets Only</td>
<td>Click to delete the assets and not the associated CI.</td>
</tr>
</tbody>
</table>

### Related lists

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets</td>
<td>Assets that are related to the asset you created.</td>
</tr>
<tr>
<td>Expense lines</td>
<td>Expense line associated with the asset</td>
</tr>
</tbody>
</table>
You can conditionally map the fields for synchronization. For example, you can map the Location field only for a hardware asset and not for a software asset. So when an asset is updated, the Location field is synchronized only for the hardware asset.

1. Navigate to Asset > Administration > Asset-CI Field Mapping and click New.
2. From the Asset field list, select the field.
   This list refers to the alm_asset table.
3. From the Configuration Item field list, select the logically associated field. This list refers to the cmdb_ci table.
4. To create conditions for the mapping, click the Advanced view related link.
   - To specify conditions for synchronizing the asset field with the CI field, use the Asset mapping condition builder.
   - To specify conditions for synchronizing the CI field with the asset field, use the Configuration Item mapping condition builder.
5. Select the Active check box to activate the mapping.
6. Click Submit.

**Map asset state and CI install status**

Map the asset State and Substate fields to the CI Install Status field. The Substatus field of the CI Install Status field should not be used for hardware CIs. Asset synchronization does not update this field when hardware assets are updated. When you create the mapping, you can set the synchronization direction from the asset, CI, or both.

Role required: admin or asset

**Note:** If you upgraded from a prior release and customized the AssetAndCISynchronizer script include before the upgrade, you must overwrite the customization and then recreate the custom mappings.

1. Navigate to Asset > Administration > Asset-CI Install Status Mapping.
   By default, only custom mappings display. The list of mappings uses the filter condition of (Out of the box) (is) (False).
2. Click New.
3. From the Asset State list, select the state you want to map.
4. Optional: If available, select a substate from the Asset Substate list.
   Some of the asset states do not have a substate.
5. From the Configuration Item Status list, select the logically associated CI status you want to map.
6. From the Sync direction list, select the direction you want to drive the synchronization.
7. Select the Active check box to activate the mapping.
8. Click Submit.
Map asset state and CI hardware status

Map the asset State and Substate fields to the CI Install Status field. Don't use the Substatus field on hardware CIs because the CI synchronization does not update the field when assets are updated. When you create the mapping, you can set the synchronization direction from the asset, CI, or both.

Role required: admin or asset

Note: If you upgraded from a prior release and you've customized the AssetAndCI’Synchronizer script before the upgrade, overwrite the customization and then recreate the custom mappings.

The Install Status and Hardware Status fields of a CI are independent of each other. There is no correlation between them. A change to the Hardware Status field does not change the CI Install Status field and vice versa.

1. Navigate to Asset > Administration > Asset-CI Hardware Status Mapping.
   By default, only custom mappings display. The list of mappings uses the filter condition of (Out of the box) (is) (False).
2. Click New.
3. From the Asset state list, select the state you want to map.
4. Optional: If available, select a substate from the Asset substate list.
   Some of the asset states do not have a substate.
5. From the Configuration Item status list, select the logically associated CI state you want to map.
6. Optional: If available, select a substate from the Configuration Item substatus list.
   Some of the CI statuses do not have a substatus.
7. From the Sync direction list, select the direction you want to drive the synchronization.
8. Select the Active check box to activate the mapping.
9. Click Submit.

Asset classes

The default asset classes are Hardware, Software License, and Consumable. These general classes can be used to manage various assets.

If the general classes that are provided aren't appropriate for a specific group of assets, consider creating a new asset class. For example, a fleet of cars could be tracked in a custom asset class named Vehicle. Before creating new asset classes, analyze business needs to see if the general classes can be used. Managing a lot of asset classes can be difficult to maintain.

Built-in functionality allows you to use asset classes for financial tracking, in a model bundle, and as a pre-allocated asset.

Create an asset class

Creating a new asset class requires defining a new table and creating a corresponding application and module, then adding the new asset class to new or existing model categories. The default asset classes are Hardware, Software License, and Consumable. These general classes can be used to manage a variety of assets.

Role required: asset or category_manager
If the general classes are not appropriate for a specific group of assets, consider creating a new asset class. For example, a fleet of cars could be tracked in a custom asset class named Vehicle. Before creating new asset classes, analyze business needs to see if the general classes can be used. A large number of asset classes can be difficult to maintain.

Built-in functionality allows you to use asset classes for financial tracking, in a model bundle, and as a pre-allocated asset.

Ensure that the model categories contain models. Use the Table form to extend an existing table.

1. Navigate to **System Definition > Tables & Columns > Create Table** and fill out the Table form fields with information on the new table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Display name of table that can be localized.</td>
</tr>
<tr>
<td>Name</td>
<td>Internal name of table that cannot be changed later.</td>
</tr>
<tr>
<td>Extends table</td>
<td>Table that new table inherit fields from.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that uses the record.</td>
</tr>
<tr>
<td>Create module</td>
<td>Check box for creating a module.</td>
</tr>
<tr>
<td>Create mobile module</td>
<td>Check box for creating a mobile module.</td>
</tr>
<tr>
<td>Add module to menu</td>
<td>Menu that module will display.</td>
</tr>
<tr>
<td>New menu name</td>
<td>New menu name.</td>
</tr>
</tbody>
</table>

2. Click **Submit**.
3. Navigate to the new application (for example, **Asset > Vehicle**) and click **New**.
4. Configure the form to include **Model**, **Model Category**, and **Quantity**.
5. Create a model category and add the asset class you created to the **Asset class** field.
6. Create new models and add them to the model category.

Now that the model category (associated with the new asset class) and the models are created, manage the models as assets. For example, use the model in a bundle.

**Add depreciation to an asset**

Depreciation is the reduction in value of an asset over time.

Role required: asset

A depreciation schedule can be added to hardware assets. Based on the information specified in the asset record, the ServiceNow platform calculates the depreciation amount daily using the **Calculating Depreciation** scheduled job.

The Now Platform calculates the read-only **Residual date** and **Residual value** fields based on the **Cost**, **Depreciation**, and **Depreciation effective date** fields. For example, if the asset **Cost** is $1000.00, the **Straight Line** depreciation method is selected, and exactly two years have passed, the **Residual value** would be $500.00.

For more information about fixed assets and depreciation, see [Using Depreciation with Fixed Assets](#).

1. Navigate to **Asset > Portfolios > Hardware Assets**.
2. Select an asset.
3. Fill in the **Depreciation**, **Depreciation effective date**, **Salvage Value**, and **Covered by fixed asset** fields as described in *Create assets*.
   Consider these points.
   - If the depreciation effective date is in the future, depreciation is 0 and the current, residual value is the original purchase price. The system does not begin to calculate depreciation until the effective date is reached.
   - The salvage value must be less than or equal to the asset cost. If a salvage value greater than the cost is entered, a warning message appears and the record cannot be saved.

4. Right-click the header and click **Save**.
5. Click **Calculate Depreciation**.
   The **Residual date**, **Residual value**, and **Depreciated amount** fields are automatically calculated.

**Create license assets**

You can manage your organization’s software license assets.

Role required: sam

Examples include a license to use a single copy of a desktop software program and an enterprise license to install a software program on multiple computers.

1. Navigate to **Asset > Portfolios > License Assets** and click **New**.
2. In the **Rights** field, type the number of entitlements to be granted by this license.
3. Complete the form as described in *Create assets*.

**Set asset states and substates**

Asset states and corresponding substates can be used to accurately track assets at a detailed level.

Role required: asset

Good asset information helps with reporting, controlling assets, and lowering costs. For example, recording missing items using the **State** and **Substates** fields enables you to run reports and analyze the information. You can use this information to lower costs.

**Tip:** Generally, state values should not be modified and should remain as-is. If the state values are supported and defined by the process, you can modify substates.

1. Navigate to **Asset > Portfolios > All Assets**.
2. Select an asset.
3. Edit the **State** and **Substate** fields.

**Asset states and substates definitions**

<table>
<thead>
<tr>
<th>State</th>
<th>Available substates</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>On order</td>
<td>None</td>
<td>Asset is ordered but not received.</td>
</tr>
</tbody>
</table>
Create fixed assets

Fixed assets are containers that can hold multiple assets. Fixed assets are commonly tracked at the corporate level by a finance or accounting department, but may contain IT assets such as hardware and software.

The Fixed Asset option in the Cost application shows the IT assets related to a fixed asset record. This link can help IT stay coordinated with the corporate asset system. Users with the financial_mgmt_admin and financial_mgmt_user roles can create fixed assets. After creating a fixed asset and adding assets, the residual value can be automatically calculated.

To create a fixed asset:
1. Navigate to Cost > Fixed Assets.
2. Click New.
3. Enter a name for the fixed asset.
4. Click Submit.

To add assets to a fixed asset:
1. Navigate to Cost > Fixed Assets.
2. Click a fixed asset.
3. In the Covered assets related list, click Edit.
4. In the Collection list, double-click an asset to add it to the Covers Assets List.
5. Click **Save**.

To sum the residual values of all assets in a fixed asset:

1. Navigate to **Cost > Fixed Assets**.
2. Click a fixed asset.
3. Click **Sum Residual Value**.

The ServiceNow platform calculates the **Residual Value**, **Total cost**, and **Total depreciation** based on information in the **Financial** and **Depreciation** sections on the individual asset records.

**Use depreciation with fixed assets**

You can calculate depreciation for a fixed asset using a choice of depreciation schedules. Calculating depreciation for a fixed asset can help IT coordinate with the corporate fixed asset system to report correct valuation and book value.

Role required: financial_mgmt_admin or financial_mgmt

When creating a new depreciation schedule, select the **Declining Balance** or **Straight Line** depreciation **Category**. The two categories depreciate an asset by the same overall amount during the asset life cycle, but do so on different schedules.

- **Declining Balance**: depreciates an asset by a greater amount in earlier accounting periods than in later periods.
- **Straight Line**: depreciates an asset by an equal amount each accounting period.

The following example shows depreciated value on a $10,000.00 asset over five years using the two different methods.

**Using depreciation with fixed assets**

<table>
<thead>
<tr>
<th>Year</th>
<th>Declining balance</th>
<th>Straight line</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$5000.00</td>
<td>$8000.00</td>
</tr>
<tr>
<td>2</td>
<td>$2500.00</td>
<td>$6000.00</td>
</tr>
<tr>
<td>3</td>
<td>$1250.00</td>
<td>$4000.00</td>
</tr>
<tr>
<td>4</td>
<td>$625.00</td>
<td>$2000.00</td>
</tr>
<tr>
<td>5</td>
<td>$0</td>
<td>$0</td>
</tr>
</tbody>
</table>

1. To view a depreciation schedule, navigate to **Financial Management > Depreciation** and click the **Category**.
2. To create a new depreciation schedule, click **New**.
3. Enter a **Name**.
4. Select a **Category**.
5. Add a **Script** to calculate depreciation value.
Example depreciation schedule script

6. Click Submit.
The depreciation schedule is now available in the Depreciation field on the asset record.

Consumables life cycle

Consumables are assets that are not tracked individually, but as a group of the same model. The group of consumables has one or more of the following traits.

- Same location
- Same state
- Consumed by the same asset, typically as accessories or parts

Some common consumable assets include mouse devices, computer keyboards, and pencils. The base ServiceNow system includes the Consumable model category. The first step in working with models is to create a model within the model category for an individual consumable asset. Items such as keyboards and mouse devices are often tracked as consumables. Consumables cannot be pre-allocated.

Consumable assets are stored in the Consumable (alm_consumable) table. Consumables follow a slightly different life cycle from other assets.

Stages of consumables

The consumable lifecycle stages are as follows.

- On order
- In stock
- In transit
- Consumed
- In maintenance
View consumable assets
Consumables are tracked as a group of the same model, but you can view individual consumables in the consumable model record.

Role required: model_manager
1. Navigate to Product Catalog > Product Model > Consumable Models.
2. Open a consumable model record.
3. View individual consumables in the Consumables related list.

Create consumable assets
Create a consumable to track an asset as a group of the same model.

Role required: asset
1. Navigate to Asset > Portfolios > Consumables and create a new record (see table for field descriptions).

Consumable record form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the asset.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model category that controls if an asset is linked to a CI.</td>
</tr>
<tr>
<td>Model</td>
<td>Product model of the asset.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Amount of items the asset represents.</td>
</tr>
<tr>
<td>State</td>
<td>State of the asset.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent asset. When a parent asset is defined, the Assignment and State fields of the child asset are automatically populated based on the Assignment and State fields of the parent asset and are read-only.</td>
</tr>
<tr>
<td>Class</td>
<td>Type of asset. The system automatically sets the Class to Consumable.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure. Choose from the following options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Capex</strong>: Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Opex</strong>: Operational expenditure is an ongoing expenditure. For example, toners for the photocopier.</td>
</tr>
<tr>
<td>Substate</td>
<td>Substate of the asset.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Location</td>
<td>Location of the asset.</td>
</tr>
<tr>
<td>Cost</td>
<td>Price that the asset was purchased for.</td>
</tr>
<tr>
<td>Cost Center</td>
<td>Cost center financially responsible for the asset.</td>
</tr>
<tr>
<td><strong>Disposal</strong></td>
<td></td>
</tr>
<tr>
<td>Disposal order number</td>
<td>A unique number assigned to the asset disposal order.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal vendor</td>
<td>The vendor assigned to carry out the asset disposal order.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Vendor disposal order ID</td>
<td>Order number assigned by the vendor assigned to carry out the asset disposal order.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal date</td>
<td>The date when the asset disposal order process is completed.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal reason</td>
<td>Text explaining why the asset is being retired.</td>
</tr>
<tr>
<td>Beneficiary</td>
<td>Organization that receives the asset when it is retired.</td>
</tr>
<tr>
<td>Resale price</td>
<td>Value of the asset when it is retired. For example, if the asset is donated, the value used when reporting taxes.</td>
</tr>
<tr>
<td>Scheduled retirement</td>
<td>Scheduled date on which the asset is retired.</td>
</tr>
<tr>
<td>Retired date</td>
<td>Actual date on which the asset was retired.</td>
</tr>
<tr>
<td>Activities</td>
<td></td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Work Notes | Work notes related to the asset.

2. Click **Submit**.

**Consume consumable assets**

To consume consumable assets, they must have a state of **In Stock** and a substate of **Available**.

Role required: asset

1. Navigate to **Asset** > **Portfolios** > **Consumables**.
2. Click the **Display Name** of a consumable asset with a state of **In Stock** and a substate of **Available**.
3. Click **Consume**.
4. Enter the **Quantity** to consume.
5. In **Asset**, click the lookup icon and select the asset associated with the consumable.
   For example, a mouse tracked as a consumable asset can be associated with a non-consumable asset such as a computer.
6. In **User**, click the lookup icon and select a user associated with the consumable.
7. Click **OK**.
   On the **Consumable** form, the **Quantity** field shows the reduced number. The Consumables list contains two records for the consumable in the specific stockroom: one with a state and substate of **In Stock** and **Available** (if you did not consume the entire quantity), and one with a state of **Consumed**. If a consumable is not in the process of being transferred to a different stockroom and information in the data record is the same, similar records merge automatically. After a consumable is consumed, the record remains in the system for reporting purposes.

**Create pre-allocated assets**

A pre-allocated asset physically exists, but is not yet a financial liability.

Role required: asset

Pre-allocated assets are often assets that the vendor still owns, but has agreed to store in a customer stockroom for just-in-time procurement. For example, a pre-allocated asset could be a pallet of 100 computers ready to be allocated. Allocating the asset generates a configuration item (if required by the category) and enables you to assign the asset. Pre-allocated assets can be components of another asset that is already in use. For example, pre-installed, pre-allocated servers can be set up in server racks next to production servers, but the pre-allocated servers only become a financial liability after they are turned on.

The pre-allocated option can only be used for assets, not consumables or licenses. Pre-allocated assets cannot be comprised of bundles.

**Note:** Warranties are not usually active until an item is installed. Therefore, until an asset is allocated and assigned, it is not under warranty.

1. Navigate to **Asset** > **Portfolios** > **All Assets** and create a new record (see table for field descriptions).
Note: Category must have the **Allow pre-allocated** option selected.

### Consumable record form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the asset.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model category that controls whether or not an asset is linked to a CI.</td>
</tr>
<tr>
<td>Model</td>
<td>Product model of the asset.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Number of item the asset represents.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>State of the asset.</td>
</tr>
<tr>
<td>Stockroom</td>
<td>Stockroom of the asset. This field is only available if the State field is set to <strong>In stock</strong>.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent asset. When a parent asset is defined, the <strong>Assignment</strong> and <strong>State</strong> fields of the child asset are automatically populated based on the <strong>Assignment</strong> and <strong>State</strong> fields of the parent asset and are read-only.</td>
</tr>
<tr>
<td>Class</td>
<td>Type of asset. The system automatically sets the <strong>Class</strong> to <strong>Consumable</strong>.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure. Choose from the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Capex</strong>: Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Opex</strong>: Operational expenditure is an ongoing expenditure. For example, toners for the photocopier.</td>
</tr>
<tr>
<td>Substate</td>
<td>Substate of the asset.</td>
</tr>
<tr>
<td>Location</td>
<td>Location of the asset.</td>
</tr>
<tr>
<td>Cost</td>
<td>Price that the asset was purchased for.</td>
</tr>
<tr>
<td>Cost Center</td>
<td>Cost center financially responsible for the asset.</td>
</tr>
<tr>
<td>Activities</td>
<td></td>
</tr>
<tr>
<td>Work Notes</td>
<td>Work notes related to the asset.</td>
</tr>
</tbody>
</table>

2. **Click Submit.**

### Allocate a pre-allocated asset

Assets can be allocated from pre-allocated asset records, which creates new asset records and reduces the **Quantity** in the original pre-allocated asset record.
Role required: asset

Allocating an asset makes it a financial liability. After all pre-allocated assets have been allocated, the pre-allocated asset record is removed from the asset list.

1. Navigate to Asset > Portfolios > All Assets.
2. Find the row containing the asset to allocate. You may want to filter the Substate column to show only Pre-allocated assets.
3. Click the reference icon in the row containing the asset to allocate.
4. Click Allocate at the bottom of the form.

**Note:** If the glide.asset.create_ci_with_ire property is set to true, a form appears when you click Allocate. On the form, fill in the Asset tag, Serial number, and Reserved for fields, then click OK.

The system creates and navigates to a new asset record, which has the same model and parent information as the pre-allocated asset. The new asset has a Quantity of one, while the pre-allocated asset’s Quantity is reduced by one.

### Split a pre-allocated asset

You can split a pre-allocated asset to create a group that can be moved to a different stockroom.

Role required: asset

For example, a group of 100 pre-allocated computers is in Stockroom A. Split the group into two groups of 50 and move one group to Stockroom B. Allocate the computers from the two different stockrooms.

1. Navigate to Asset > Portfolios > All Assets.
2. Find the row containing the asset to split. You may want to filter the Substate column to show only Pre-allocated assets.
3. Click the reference icon in the row containing the asset to split.
   The asset record is displayed.
4. Click Split.
5. Enter a Quantity to Split and click OK.
   The pre-allocated asset is split into two groups and the Quantity field on each record indicates the number in each group.

### Stockrooms

Stockrooms are places to which assets are assigned.

When stock is low on a particular asset, stock rules can either notify an asset manager or automatically transfer inventory from one stockroom to another.

Stockrooms are separate, standalone entities in the Asset Management application.

### Create a stockroom

You can create a stockroom.
Role required: asset or inventory_user

1. Navigate to Inventory > Stock > Stockrooms and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name and identifier of the stockroom.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group that primarily uses the stockroom.</td>
</tr>
<tr>
<td>External</td>
<td>Whether this stockroom is managed internally (check box is cleared) or is managed externally by a third party (check box is selected).</td>
</tr>
<tr>
<td>Location</td>
<td>Physical location of the stockroom.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of stockroom, such as Field Agent or On site.</td>
</tr>
<tr>
<td>Manager</td>
<td>Person in charge of the stockroom. Receives restocking notifications and requests for the stockroom's stock rules.</td>
</tr>
</tbody>
</table>

2. Click Submit.

Delete a stockroom with assets

You can delete a stockroom. If the stock room has assets, you must remove the assets from the stockroom first.

Role required: inventory_admin

1. Navigate to Asset > All Assets.
2. Personalize the list to add the Stockroom column.
3. Filter the list to show only the assets in the stockroom that you want to delete.
4. Change or remove the stockroom for all of the asset records.
5. After removing assets from the stockroom you want to delete, continue with the instructions for deleting a stockroom with no assets.

Delete a stockroom with no assets

You can delete a stockroom that has no assets.

Role required: inventory_admin

1. Navigate to Inventory > Stock > Stockrooms.
2. Select the check box beside the stockroom Name.
3. In the Actions choice list below the list, select Delete.

Stockroom types

Stockroom types are categories of stockrooms.

The stockroom type has two significant characteristics.
- **Priority**: indicates the order of stockrooms the parts should be sourced from. For example, if a personal stockroom (priority 2) contains the required part, the personal stockroom receives priority over the Central Stockroom (priority 7) because the part in the personal stockroom does not require delivery.

- **Shipment Required**: informs the system if a transfer order needs to be created when the part is sourced from a stockroom of the given type. For example, a part in a personal stockroom does not require shipment, so no transfer order is needed.

<table>
<thead>
<tr>
<th>Value</th>
<th>Name</th>
<th>Priority</th>
<th>Shipment Required</th>
<th>Description</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>on_site</td>
<td>On Site</td>
<td>1</td>
<td>False</td>
<td>Stockroom at the customer site.</td>
<td>Close to the users and does not require shipping.</td>
</tr>
<tr>
<td>field_agent</td>
<td>Field Agent</td>
<td>2</td>
<td>False</td>
<td>Virtual, personal stockroom linked with a field service agent (FSA) directly, used for delivery.</td>
<td>Mainly used to indicate to the system that the part has been delivered and is with the FSA.</td>
</tr>
<tr>
<td>fsl</td>
<td>FSL</td>
<td>4</td>
<td>True</td>
<td>Forward Shipping Location.</td>
<td>Small stockrooms where the parts can typically be shipped via overnight delivery.</td>
</tr>
<tr>
<td>pudo</td>
<td>PUDO</td>
<td>5</td>
<td>True</td>
<td>Pick Up/Drop out location.</td>
<td>This type is sometimes called a by-box. Can be a postal box that can receive new and returned parts. Often in close proximity to major customer sites.</td>
</tr>
<tr>
<td>stockroom</td>
<td>Stockroom</td>
<td>6</td>
<td>True</td>
<td></td>
<td>A regional stockroom.</td>
</tr>
<tr>
<td>Value</td>
<td>Name</td>
<td>Priority</td>
<td>Shipment Required</td>
<td>Description</td>
<td>Comment</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------</td>
<td>----------</td>
<td>-------------------</td>
<td>-------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>central_stockroom</td>
<td>Central Stockroom</td>
<td>7</td>
<td>True</td>
<td></td>
<td>A central stockroom, usually a big facility from which most parts are shipped.</td>
</tr>
</tbody>
</table>

Create a new stockroom type

If you need stockroom types that are not included in the base system, you can create a custom stockroom type.

Role required: inventory_admin

Check the priority level of the stockroom types provided in the base instance to ensure that you assign the correct priority level to any new stockroom types you create. You can also modify the stockroom types included in the base system.

1. Navigate to **Inventory > Stock > Stockroom Types** and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name of the stockroom type.</td>
</tr>
<tr>
<td>Description</td>
<td>General information about the stockroom type.</td>
</tr>
<tr>
<td>External stockroom</td>
<td>Whether stockrooms of this type are managed internally (check box cleared) or managed externally by a third party (check box selected).</td>
</tr>
<tr>
<td>Priority</td>
<td>Level of precedence for this type of stockroom.</td>
</tr>
<tr>
<td>Shipment required</td>
<td>Option that determines if stockrooms of this type require shipment by default.</td>
</tr>
<tr>
<td>Value</td>
<td>Internal identifier of the stockroom type.</td>
</tr>
</tbody>
</table>

2. Click **Submit**.

Stock rules

Stock rules are defined criteria stating that when inventory of a particular asset in a particular stockroom reaches a specified threshold, a certain number should either be transferred from another stockroom or ordered from a vendor.

For example, a specific model of computer keyboard reaches an inventory of 10 in a particular stockroom and, because a stock rule is in place, a transfer order is automatically created to transfer 50 from a different stockroom. Because there can be multiple assets of a model within a stockroom, stock rules enable you to check all assets fitting the criteria and view a total count.
There are two restocking options:

- An email can be sent to the stockroom manager (user identified in the Manager field on the stockroom record) to place a vendor order. A task is automatically created for the stockroom manager or, if Procurement is active, a purchase order and a purchase order line item are created.
- A transfer order can be generated automatically to restock the item from another stockroom.

Stock rules consider existing transfer orders and do not create additional transfer orders if replenishment is already in progress.

A scheduled job named **Stock Rule Runner** runs once per day to create the restocking transfer orders, send email messages to stockroom managers, and create tasks for stockroom managers.

**Note:** If restocking is in progress, the system does not create duplicate email messages or duplicate transfer orders.

If **Procurement** is active when the scheduled job is run, a purchase order and a purchase order line item are automatically created.

**Note:** You must have procurement_user role to access the purchase order and purchase order line item.

### Create a stock rule

You can create a stock rule to control what happens when inventory of a particular asset in a particular stockroom reaches a specified threshold.

**Role required:** inventory_admin

1. Navigate to **Inventory > Stock > Stock Rules** and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>Product model to which the rule applies.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Quantity that the stock must reach to trigger restocking. For example, enter a threshold of 10 for a laptop computer that should be restocked when inventory drops below 10 in the specified stockroom.</td>
</tr>
</tbody>
</table>

**Note:** If a stock rule is created for a hardware or software model reaches the threshold limit, a notification is sent to the stockroom manager and a stock order request is automatically created.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Restocking option     | Location where additional supplies should come from. If *Procurement* is not active, then restocking option is **Stockroom** only. Otherwise, select one of the following:  
  - **Stockroom**: creates a transfer order to obtain the asset from another stockroom.  
  - **Vendor**: sends an email to the stockroom manager to order from a vendor. In addition to the email notification, a purchase order and purchase order line item are created. |
| Active                | Whether this stock rule active (check box is selected). Clearing this check box prevents the stock rule from restocking automatically.                                                                                                                                                                                                      |
| Stockroom             | Current physical location of the asset.                                                                                                                                                                                                                                                                                                     |
| Order size            | Minimum order quantity for stockroom transfers or vendor purchases. ServiceNow calculates the smallest multiple of the order size needed to restock the item above the threshold. For example, there are 3 laptops in stock with a threshold of 10 and the **Stockroom** option selected. If the order size is set to 4, the system creates a transfer order for 8 laptops to exceed the threshold and satisfy the rule (3 in stock + 8 ordered = 11). When restocking from a vendor, ServiceNow sends an email to the stockroom manager showing the total number of items to order, as multiples of the order size. |

2. Click **Submit**.

**Transfer orders for Asset Management**

Transfer orders move assets between company stockrooms. The Asset Management application enables asset managers to create transfer orders for moving assets between company stockrooms.

Consumable assets and non-consumable assets can be transferred as follows:

- If an asset is consumable, it can be transferred and the quantity can be greater than one. Consumable parts are tracked by the system qualitatively.
- If an asset is non-consumable, it must be transferred as a single entity with a quantity of one. Non-consumable parts correspond to assets defined in the system.

**Transfer order lines**

Transfer Order Lines is a new module under Inventory with Template Tasks and Template Subtasks as the sub modules. Transfer order lines allow the transfer of multiple assets on one transfer order.
Actions such as shipment preparation can take place at the transfer order line level. Pre-allocated assets can be included in a transfer order line, but can only be transferred in their full quantity. A business rule prevents the same asset from being transferred on two different transfer orders at the same time.

**Note:** The Transfer Order and the Transfer Order Line workflows have moved from the Procurement plugin to the Asset Management plugin. The Transfer Order Line workflow runs only if no other workflows are matched or running on a specific record.

## Transfer order line tasks

When you create a transfer order line, based on the model category specified in the asset, a transfer order line task is automatically created. Transfer order line tasks are created to move transfer order lines from one stage to the other. Transfer order line tasks also help you to track service levels and the time frame needed to complete a transfer order.

Default template tasks are available with the Asset Management application. The template tasks are based on model categories. Default template tasks cannot be deleted or modified. If required, you can also create your own customized template tasks. For more information, see [Create a customized template task](#). When you create a transfer order line and select an asset, that asset corresponds to a model category. If a customized template task exists for that model category then that template task is added to the transfer order line as a transfer order line task. If no customized template task match is found for the asset you selected, then the default template task is added as a transfer order line task.

Closing a transfer order line task completes the task and creates the next task in the process. For example, once you close the Ready for fulfillment task, the state for this task appears as **Closed Complete** and a new task is opened for the next stage, Ready for Shipment. This process continues till you close all the tasks required for completing the transfer order line. As you close a task and as a task moves from one stage to the next, the asset gets automatically updated too. For example, when the transfer order line moves from Ready to Fulfillment to Prepare for Shipment, the asset’s status also moves from available to reserved.

**Note:** If you skip a transfer order line task and select **Closed Skipped**, the asset is not updated automatically. Once the asset is received or delivered, you can make the update manually.

**Note:** If you are upgrading from any previous release to the New York release, and you have an open transfer order line that is still being processed, all the transfer order line tasks associated with that transfer order line are simultaneously created and displayed in the transfer order line form layout. Based on the stage of the transfer order line, the tasks that still need to be processed will be open; all the other tasks that have already been completed will be closed. Based on the order, if you close a later transfer order line task, all the previous tasks, which are currently open, automatically will be **Closed Skipped**.

## Transfer order line subtasks

To further add granularity and efficiency to the process, you can also create subtasks for each transfer order line task. Each transfer order line task can have multiple subtasks. For example, before preparing for shipment, for a computer, you may want to create subtasks for imaging the computer or adding additional software. If subtasks have been defined for a particular transfer
Transfer assets using transfer orders

Transfer assets from one location to the other by moving the assets through the transfer order process. You create a transfer order and move it from its initial Draft status to the final Received status.

Role required: inventory_user.

1. Navigate to Inventory > Transfer Orders > Create Transfer Order.
2. Select values from the From Stockroom and To Stockroom lists.

   **Note:** If you select the same stockroom for both fields, the transfer order automatically moves from Draft to Received as soon as a transfer order line is added.

3. Select a date and time from the Delivery by date date picker.
4. Click Submit.
5. Open the transfer order.
6. Next to Transfer Order Lines, click New.
7. Select a model for the transfer order line.
8. If the model is a consumable, specify a quantity in Quantity Requested.
9. Click Submit. If necessary, add more transfer order lines.

   After creating transfer order lines, the transfer order and all of the transfer order lines are in the draft stage. While a transfer order or a transfer order line is in the draft stage, it can be deleted.

   **Note:** When an asset is part of a transfer order set to Draft, the asset record updates to show the asset as reserved. No one else can request or transfer the asset while it is reserved.

When you create a transfer order line, based on the model category specified in the asset, a transfer order line task is automatically created. The transfer order line task helps you to progress through the various stages of the transfer order line. Each transfer order line task represents a particular stage in the transfer process. As you close a task, a new task is created and the transfer process moves to the next stage.

10. Open the transfer order line task and click Close Task.
    The transfer order line task is completed and a new transfer order line task is opened.
11. Keep closing each task till you reach the last stage (Received). Once you close the task for the Received stage, the transfer order line is completed and closed.
    All transfer order lines and the transfer order are marked Delivered.

**Summary of transfer order line tasks**

As assets move through the transfer process, the stage of a transfer order is always based on the individual transfer order lines tasks.
### Transfer order line tasks

<table>
<thead>
<tr>
<th>Transfer order line stages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>When a transfer order line is created.</td>
</tr>
<tr>
<td>Requested</td>
<td>This is the first task created for the transfer order line.</td>
</tr>
<tr>
<td>Shipment Preparation</td>
<td>Once the Requested task is closed, this task is created. This task deals with preparing the transfer order line for shipment. Three new fields are added to the Shipment Preparation task: Vendor, Ship date, and Tracking Number.</td>
</tr>
<tr>
<td>In Transit</td>
<td>Once the Shipment Preparation task is closed, this task is created.</td>
</tr>
<tr>
<td>Received</td>
<td>Once the In Transit task is closed, this task is created.</td>
</tr>
<tr>
<td>Delivered</td>
<td>Once the Received task is closed, this task is created. Once you close the Delivered task, the transfer order line is completed.</td>
</tr>
</tbody>
</table>

### Delete a transfer order

You can delete a transfer order only if the transfer order is still in the draft stage.

Role required: inventory_user

1. Navigate to **Inventory Management > Transfer Orders > Transfer Orders**
2. Select the check box beside a transfer order.
3. From the Actions on selected rows menu at the bottom of the list, click **Delete**.

   Alternatively, you can cancel a transfer order or a transfer order line while it is in Requested or Shipment Preparation stage.

### Delete a transfer order line

You can delete a transfer order line only if it's still in the draft stage.

Role required: inventory_user.

1. Open a transfer order.
2. Select the check box beside a transfer order line.
3. From the Actions on selected rows menu at the bottom of the list, click **Delete**.

   Alternatively, you can cancel a transfer order or a transfer order line while it is in Requested or Shipment Preparation stage.

### Return items received in a transfer order

When you receive a transfer order and if there is a problem with all or some of the items, you can return the transfer order.

Role required: inventory_user.
Items in a transfer order must be received before they can be returned.

1. Navigate to Inventory Management > Transfer Orders.
2. Select a transfer order that is in the Received stage.
3. Click the transfer order line Number of the item to return.
4. Click Return.
5. Enter a quantity to return.
6. Enter a reason for the return.
7. Select the Defective check box to return items that are broken.
   
   Defective items are returned to the stockroom from which they were delivered, but are not added to available stock. Instead, they are tracked in the separate category named ‘Defective’ so they cannot be requested or transferred again.
8. Click OK.
9. Click Update.
   
   A new transfer order line is automatically created.
   
   A new corresponding parent transfer order is also automatically created with the new transfer order line on it.
10. If you are returning a consumable, navigate to the transfer order line record and click the model name to open the model record.

   The model record shows which stockrooms contain the model. The one defective model is listed.

   Note: The defective model is still at the stockroom to which it was delivered. The defective model needs to be transferred back to the stockroom where it originated.

11. Move the new transfer order through the regular transfer order process.

   Items are automatically returned to the stockroom from which they were delivered. A transfer order line item that has been returned cannot be delivered at a later time.

   If you return another defective model from the same, original order, the two defective returns are merged into one line item.

Create a transfer order for Asset Management

Create a transfer order in order to transfer assets from one location to the other.

Role required: inventory_user.

1. Navigate to Inventory Management > Transfer Orders > Create Transfer Order.
2. Click the From stockroom list to select a stockroom from which the item(s) is to be shipped.
3. Click the To stockroom list to select a stockroom where the item(s) is to be shipped.
4. Click Submit.

   Once the transfer order is created, you can create transfer order lines to specify the items that the transfer order comprises of. See Create a transfer order line.

Create a transfer order line

Transfer order lines specify the exact items that comprise a transfer order.

Role required: inventory_user.
A transfer order can contain one or more transfer order lines. Under a single transfer order, all transfer order lines will have the same From location and To location. Each line contains an asset to transfer and the quantity to transfer. The item to transfer is identified by asset name and model name. A transfer order line can involve one quantity of a non-consumable asset or multiple quantities of a consumable asset. A bundled model can be transferred.

- After creating a transfer order, click **New** in the **Transfer Order Lines** related list and fill in the fields as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Internal unique number identifying the transfer order line.</td>
</tr>
<tr>
<td>Transfer Order</td>
<td>The transfer order to which the transfer order line belongs.</td>
</tr>
<tr>
<td>Model</td>
<td>Model of the items requested by the transfer order line. For example, a printer. If the Asset field is filled out first, the Model field is automatically filled in with the model corresponding to the asset.</td>
</tr>
<tr>
<td>Quantity requested</td>
<td>Number of items requested by the transfer order line. For example, 3 computers are requested to be transferred.</td>
</tr>
<tr>
<td>Quantity received</td>
<td>Number of items already received. For example, 3 keyboards are transferred, 2 are received.</td>
</tr>
<tr>
<td>Stage</td>
<td>Current stage of the transfer order. Transfer order lines can only be created when a transfer order is in <strong>Draft</strong> stage.</td>
</tr>
<tr>
<td>Request line</td>
<td>Requested item to associate with the transfer order line.</td>
</tr>
<tr>
<td>Asset</td>
<td>Asset requested by the transfer order line. For example, a specific printer. The asset can filter on stockrooms.</td>
</tr>
<tr>
<td>Quantity remaining</td>
<td>Number of items yet to be received. For example, 3 keyboards had been requested, 2 are received, 1 is remaining.</td>
</tr>
<tr>
<td>Quantity returned</td>
<td>Number of items that already needed to be returned.</td>
</tr>
</tbody>
</table>

Create a customized template task

Create customized template tasks to configure your specific task workflow for transfer order lines. Default template tasks are available with the Asset Management application. You cannot modify or delete a default template task.

Role required: inventory_user.

Template tasks help you progress through the various stages of the transfer order line. Custom template tasks are stored in the Custom Template Task (alm_custom_template_task) table. The template tasks are based on model categories. For example, when you create a customized template task for the Application model category, whenever a transfer order line is created for the Application model category, the template tasks associated with the Application model...
category are used as transfer order line tasks. When you create customized template tasks, make a copy of the workflow and update the workflow accordingly. For example, if instead of five flows, you need four flows, then delete the flow that you do not need from the workflow.

**Note:** Two template tasks cannot be created if they are based on the same model category, same order number and the same stage. The model category, the order, and the stage have to be unique for each template task. For example, you cannot create two template tasks for Prepare for Shipment, based on the Application model category, order number 200, and the stage as Requested. If you try to create an identical template task as mentioned in the example, an error message appears.

1. Navigate to **Inventory > Transfer Order Lines > Template Tasks**. All the default template tasks that are available with the Asset Management application are listed.

2. Click **New**. You can also customize a template task by copying a default template task. Click **Copy Default Template** and select a model category.

3. Fill out the form fields (as shown in the table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task name</td>
<td>Name of the template task</td>
</tr>
<tr>
<td>Model category</td>
<td>The model category that this template task is based on.</td>
</tr>
<tr>
<td>Order</td>
<td>the order in which the template task is added to the transfer order line.</td>
</tr>
<tr>
<td>Short description</td>
<td>a brief description about this template task.</td>
</tr>
<tr>
<td>Next stage</td>
<td>the stage that this template task gets executed.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Create a template subtask**

Create template subtasks to add granularity to the transfer order line tasks. For example, before preparing for shipment, for a computer, you may want to create sub tasks for imaging the computer or adding additional software.

Role required: inventory_user.

The template subtasks that you create are stored in the Template Subtask (alm_template_subtask) table. When a transfer order line task is created and if subtasks are defined for that transfer order line task, then the subtasks are automatically added to the transfer order line task.

1. Navigate to **Inventory > Transfer Order Lines > Template Subtasks**.

2. Click **New** and fill out the form fields (as shown in the table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>A brief description of the subtask.</td>
</tr>
<tr>
<td>Subtask name</td>
<td>A name for the subtask.</td>
</tr>
<tr>
<td>Task</td>
<td>The task that this subtask is associated to.</td>
</tr>
</tbody>
</table>
3. Click Submit.

Transfer order line asset tracking

As transfer order line actions are triggered, the stock information and states of any affected assets are updated. Consumables and non-consumables are tracked differently.

When an asset is included in a transfer order line, the following takes place:

- A substate field on the asset form changes to reflect the transfer order line states
- The Active TO option on the asset form is automatically selected to show that the asset is part of a transfer order and cannot be added to multiple transfer orders
- The asset is removed from the pool of available assets and changed to a state of **In Stock Pending Transfer**

Transfer order line asset tracking of non-consumables

When transfer order line stages change for non-consumables, it affects asset substates.

<table>
<thead>
<tr>
<th>Transfer order line stage</th>
<th>Affect on asset substate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>Asset moves to <strong>In Stock &gt; Pending Transfer</strong> (from the current stockroom). If the asset is a consumable, the quantity can be edited.</td>
</tr>
<tr>
<td>Requested</td>
<td>Asset stays in <strong>In Stock &gt; Pending Transfer</strong>.</td>
</tr>
<tr>
<td>Shipment Preparation</td>
<td>Asset stays in <strong>In Stock &gt; Pending transfer</strong>.</td>
</tr>
<tr>
<td>In Transit</td>
<td>Asset moves to <strong>In Transit &gt; Reserved</strong>.</td>
</tr>
<tr>
<td>Received</td>
<td>Asset moves to <strong>In Stock &gt; Available</strong> (in the destination stockroom).</td>
</tr>
</tbody>
</table>

Transfer order line asset tracking consumables

When a consumable is added to a transfer order line, the stock for the consumable is split into two records and the transfer order links to the newly created stock line.

For example:

1. Stockroom A has ten keyboards in stock.
2. A transfer order line named TOL1 transfers three keyboards from stockroom A to stockroom B.
3. The stock of ten keyboards in A is split into two records: seven shown as **In stock > Available** and three shown as **In Stock > Pending Transfer**.
4. Another transfer order is created with a transfer order line named TOL2 that transfers two keyboards from stockroom A to stockroom B.
5. The seven remaining keyboards are split into another two lines: five **In stock > Available** and two **In stock > Pending Transfer**.

Note: The three **In Stock > Pending Transfer** and the two **In Stock > Pending Transfer** are not merged together because they are not part of the same transfer order line and not necessarily from the same person.
6. As TOL2 for two keyboards moves from Draft to Requested to Shipment Preparation, TOL1 for the three keyboards remains In Stock > Pending Transfer.

7. When TOL1 for the three keyboards moves to the In Transit stage, the three keyboards are changed to the In Transit > Reserved stage. The same happens for TOL2 with two keyboards.

8. When TOL1 is Received, the three keyboards move to In stock > Available in stockroom B.

9. When TOL2 is received in stockroom B, the two keyboards move to In stock > Available and are merged with the three keyboards that are also In Stock > Available in B.

10. At the end, stockroom B shows five keyboards are In Stock > Available.

Example Asset Management process

The best method for managing assets depends on business needs and how your business is organized.

These steps are one possible process for getting started with Asset Management.

1. Identify assets in your system. A key component of asset management is the initial and ongoing inventory or discovery of what you own. The ServiceNow platform provides the following options for asset discovery.
   - The separate, robust Discovery tool.
   - A lightweight, native discovery tool, Help the Help Desk lets you scan your network proactively to discover all Windows-based PCs and the software packages installed on those PCs. This WMI-based discovery is included in the base self-service application.
   - For organizations that want to use the discovery technologies they have deployed already, such as SMS, Tally NetCensus, LanDesk, or others, ServiceNow can support integration to those technologies via web services. Scanned data can be mapped directly into the Configuration Management Database (CMDB).

2. Clean up information in the CMDB. Remove information that is obsolete or invalid. Ensure that all remaining information is accurate and complete. Add any necessary information.

3. Create categories of asset models such as computers, servers, printers, and software.

4. Create asset models. Models are specific versions or various configurations of an asset, such as a MacBook Pro 17".

5. Create individual assets, such as hardware, consumables, and software licenses. If you used a discovery tool, you may already have many assets identified accurately.

6. Manage assets by counting software licenses, viewing assets that are in stock, setting asset states and substates, and analyzing unallocated software.

ITSM Software Asset Management

The software asset management features of the ITSM suite can be activated using one of the plugins in the feature table.

**Note:** These features support IT service management processes related to software assets.

For the Software Asset Management product (requires a separate subscription), see Software Asset Management overview.
Note: The Software Asset Management product is a standalone application supporting advanced use cases for software asset management.

ITSM Software Asset Management feature plugins

<table>
<thead>
<tr>
<th>Release</th>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Activation: Kingston</td>
<td>Software Asset Management Foundation plugin</td>
<td>Manage your software assets using manual normalization and reconciliation to determine software compliance.</td>
</tr>
<tr>
<td>• Introduced: Kingston</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Activation: Jakarta and earlier</td>
<td>Software Asset Management plugin</td>
<td>Manage your software licenses.</td>
</tr>
<tr>
<td>• Introduced: Berlin</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: Customers who have the Software Asset Management plugin enabled on a release prior to Kingston can continue to use the Software Asset Management plugin.

Software Asset Management plugin

The Software Asset Management plugin activates the ITSM Software Asset Management feature provided with the Asset Management application.

A strong software asset management (SAM) program can help an organization reduce software costs, improve compliance, and simplify or develop processes for employee software requests. SAM programs can also help control inventory through accurate databases, which in turn helps identify organizational software needs, identify unused software that can be deleted, as well as reduce or consolidate the number of software vendors used.

Software Asset Management plugin Overview module

The Software Asset Management plugin Overview module is a homepage that displays various software asset management reports.

*Use the Software Asset Management plugin Overview module*

The Overview module is a homepage that displays charts and graphs to help you manage software assets in the organization.

To use the Software Asset Management plugin Overview module, navigate to **Software Asset Management > Overview**. Click an element within a report to see more information or add and move widgets as needed.
### Total True-up Cost

<table>
<thead>
<tr>
<th>Publisher</th>
<th>W41 2017 (Oct 09-Oct 15)</th>
<th>Trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM</td>
<td>$498.44k</td>
<td></td>
</tr>
<tr>
<td>Oracle</td>
<td>$40.00k</td>
<td></td>
</tr>
<tr>
<td>VMware, Inc.</td>
<td>$17.48k</td>
<td></td>
</tr>
<tr>
<td>Microsoft</td>
<td>$16.80k</td>
<td></td>
</tr>
<tr>
<td>Adobe Systems</td>
<td>$12.65k</td>
<td></td>
</tr>
</tbody>
</table>

### Publishers Out of Compliance

- **6** publishers out of compliance

### Products Out of Compliance

- **12** products out of compliance

### Potential Savings

- **$174.44k** potential savings

### True-up Cost Breakdown

<table>
<thead>
<tr>
<th>Publisher</th>
<th>W41 2017 (Oct 09-Oct 15)</th>
<th>Trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM</td>
<td>$498.44k</td>
<td></td>
</tr>
<tr>
<td>Oracle</td>
<td>$40.00k</td>
<td></td>
</tr>
<tr>
<td>VMware, Inc.</td>
<td>$17.48k</td>
<td></td>
</tr>
<tr>
<td>Microsoft</td>
<td>$16.80k</td>
<td></td>
</tr>
<tr>
<td>Adobe Systems</td>
<td>$12.65k</td>
<td></td>
</tr>
</tbody>
</table>

### Software Spend Breakdown

<table>
<thead>
<tr>
<th>Publisher</th>
<th>Oct 2017</th>
<th>Trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle</td>
<td>$33.61M</td>
<td></td>
</tr>
<tr>
<td>Microsoft</td>
<td>$5.30M</td>
<td></td>
</tr>
<tr>
<td>IBM</td>
<td>$658.75k</td>
<td></td>
</tr>
<tr>
<td>Adobe Systems</td>
<td>$360.26k</td>
<td></td>
</tr>
<tr>
<td>Splunk</td>
<td>$76.02k</td>
<td></td>
</tr>
</tbody>
</table>
The overview shows the following compliance types:

- **Immediate Compliance**: number of licenses that should be purchased in order to be compliant immediately. Compliance is based on grouping. When tracking software licenses at a high level without any grouping, you are more likely to be compliant. With grouping, you are more likely to be out of compliance. For example, if grouping regionally by location, your organization can be globally compliant, but regionally non-compliant.

- **Planned Compliance**: based on the number of licenses you plan to allocate and the number installed.

The graphs show important statistics about the software being tracked, including software that has been entitled but is not being used and the total number of unallocated licenses.

**Software Asset Management plugin roles**

Software Asset Management plugin adds the following user role.

<table>
<thead>
<tr>
<th>Roles</th>
<th>Contains Role Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sam</td>
<td>inventory_user</td>
<td>Can create, edit, change, and manage software licenses.</td>
</tr>
<tr>
<td></td>
<td>category_manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>contract_manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>financial_mgmt_user</td>
<td></td>
</tr>
</tbody>
</table>

Users with the sam or admin role can view the overview page and refresh, add, delete, and rearrange reports and other widgets.

**Installed with Software Asset Management plugin**

A number of tables, properties, user roles, script includes, client scripts, UI policies, and business rules are installed with Software Asset Management plugin.

Activating Software Asset Management plugin adds these components.

Demo data is available with Software Asset Management plugin.

**Tables**

Software Asset Management plugin adds the following tables.

<table>
<thead>
<tr>
<th>Software Asset Management plugin tables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor Definition (cmdb_processor_definition)</td>
<td>Describes a computer in terms of the attributes IBM uses for its PVU licensing model. If they are all identical in terms of the attributes used for PVU licensing, a row can be associated with one or more discovered computers.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Processor Mapping (sam_processor_mapping)</td>
<td>Encodes the information specified by the IBM Table of Processor Value Units per core and is used in matching a computer's processor definition to a PVU cost for that computer. Each row in this table is a mapping between a set of processors and the associated PVU cost (per core).</td>
</tr>
<tr>
<td>Software Counter (sam_sw_counter)</td>
<td>Configures license counting options for software models.</td>
</tr>
</tbody>
</table>
| Software Counter Compliance Violations (sam_sw_counter_violation) | Stores records of software counter compliance issues that are due to violations other than installs exceeding rights, such as:  
- Maximum CPU/user count exceeded, based on model limits.  
- Maximum or minimum rights rules not followed, based on model limits.  
- Options installed on a server with a license that does not support options (Oracle).                                                                                                                                                                               |
| Software Counter Detail (sam_sw_counter_detail)       | Reconciles a software installation or usage with its corresponding software license and entitlement. The software counting logic automatically generates and maintains these records.                                                                                                                                            |
| Software Counter History (sam_sw_counter_history)     | Stores read-only copies of software counter records, which the system generates automatically each time a software counter finishes counting licenses.                                                                                                                                                                                        |
| Software Counter Result (sam_sw_counter_result)       | Records all software counter results. Organizes the results based on the Grouping field (such as Company, Department, or Location) on the Software Counter record.                                                                                                                                                                                                 |
| Software Counter Summary (sam_sw_counter_summary)     | Aggregates all the software counter details for a given allocation state, a given group, and a given software counter. The software counting logic automatically generates and maintains these records.                                                                                                                                   |
| Software Discovery Model (cmdb_sam_sw_discovery_model) | Stores a unique and definitive list of all software found by a discovery tool.                                                                                                                                                                                                                                                                |
| Software Installation (cmdb_sam_sw_install)           | Associates software discovery models and the hardware on which they are installed.                                                                                                                                                                                                                                                                                                                          |
| Software Usage (cmdb_sam_sw_usage)                    | Associates software discovery models and the hardware that uses the models. ServiceNow Discovery does not populate the Software Usage (cmdb_sam_sw_usage) table. Use a third-party tool to add information about software assets to the Software Usage table.                                                                                                             |
Properties

Software Asset Management plugin adds the following system properties.

**Software Asset Management plugin properties**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sam.install_deletion_deadline</td>
<td>Defines the number of days after which a software install is deleted if not discovered with the configuration item. Use a value that is greater than the number of days between consecutive discovery runs.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 7</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties (sys_properties) table</td>
</tr>
</tbody>
</table>

User roles

Software Asset Management plugin adds the following user roles.

**Software Asset Management plugin user roles**

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sam</td>
<td>inventory_user contract_manager category_manager financial_mgmt_user</td>
<td>Can create, edit, change, and manage software licenses. Can edit the Software model field on a Discovery model. Can approve a model. Has full control of the Software Asset Management plugin feature. Controls the Software Asset Management plugin IBM PVU Process Pack, if activated.</td>
</tr>
</tbody>
</table>

Script includes

Software Asset Management plugin adds the following script includes.

**Software Asset Management plugin script includes**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DiscoveryModelMatcher</td>
<td>Matches a discovery model with a software product model.</td>
</tr>
<tr>
<td>ProcessorDefinitionsUtils</td>
<td>Contains utilities for managing the Processor Definition (cmdb_processor_definition) table.</td>
</tr>
</tbody>
</table>
### ProcessorValueUnitsUtils

Contains logic that determines the IBM PVU pricing associated with a given processor. Also generates an event when a processor mapping is not found.

### SAMMigration

Deprecated. Used by the fix job that migrates software license management data to Software Asset Management plugin.

### SAMSuiteEngine

Contains functions for handling suite inference on software installations.

### SAMUtil

Generates models and counters for Software Asset Management plugin.

---

### Client scripts

Software Asset Management plugin adds the following client scripts.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean up Counter</td>
<td>Software Counter (sam_sw_counter)</td>
<td>Ensures integrity between the various counting options of a software counter.</td>
</tr>
<tr>
<td>Deactivate automatched checkbox</td>
<td>Software Discovery Model</td>
<td>Deactivates the automatically matched check box when a user edits the software model.</td>
</tr>
<tr>
<td>Notify if counter in progress</td>
<td>Software Counter (sam_sw_counter)</td>
<td>Displays a message if the counter is currently running.</td>
</tr>
</tbody>
</table>

---

### UI policies

Software Asset Management plugin adds the following UI policies.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enforce Installs per license</td>
<td>Software Counter (sam_sw_counter)</td>
<td>Makes the Installs per license field mandatory when the software counter License type is By number of users.</td>
</tr>
<tr>
<td>Handle custom counts</td>
<td>License Calculation (sam_sw_license_calculation)</td>
<td>Displays the fields for entitlement type and valuation script when Count by is set to custom.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hide condition fields</td>
<td>Software Counter (sam_sw_counter)</td>
<td>Hides the Software usage condition field if the license calculation query table is set to Software install and hides the Software install condition field if the license calculation query table is set to Software usage.</td>
</tr>
<tr>
<td>Hide query table</td>
<td>Software Counter (sam_sw_counter)</td>
<td>Hides the Query table field on the Software Counter form.</td>
</tr>
</tbody>
</table>

## Business rules

Software Asset Management plugin adds the following business rules.

### Software Asset Management plugin business rules

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>assign processor</td>
<td>Computer (cmdb_ci_computer)</td>
<td>Attempts to match a processor with a processor definition.</td>
</tr>
<tr>
<td>Build Primary Key</td>
<td>Software Installation (cmdb_sam_sw_install)</td>
<td>Sets the primary key for the record to the serial number on the (cmdb_sam_sw_install) table. If the serial number is empty, the rule creates one based on the publisher, display name, product ID, version, and revision.</td>
</tr>
<tr>
<td>Build Primary Key</td>
<td>Software Usage (cmdb_sam_sw_usage)</td>
<td>Creates the primary key for the record from the publisher, name, product ID, and version number on the (cmdb_sam_sw_usage) table.</td>
</tr>
<tr>
<td>Check for software suite</td>
<td>Software Installation (cmdb_sam_sw_install)</td>
<td>Checks if the current software install is part of a software suite.</td>
</tr>
<tr>
<td>Check for suite omission</td>
<td>Software Installation (cmdb_sam_sw_install)</td>
<td>Checks if the current software install should be omitted from any suites.</td>
</tr>
<tr>
<td>Clean up Cache</td>
<td>Software License (alm_license)</td>
<td>Removes the cache for the counter of the software license record when a software license is deleted.</td>
</tr>
<tr>
<td>Clean up software normalization</td>
<td>Software Installation (cmdb_sam_sw_install)</td>
<td>Deletes the discovery model if the discovery model is changed and it is not used by other software installs. This rule is not enabled by default.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Clear install and usage records</td>
<td>Software Counter Summary (sam_sw_counter_summary)</td>
<td>Uncaches all related install and usage records when a software counter summary is deleted.</td>
</tr>
<tr>
<td>Clear normalized flag</td>
<td>Software Usage (cmdb_sam_sw_usage)</td>
<td>Clears normalized flag on certain field changes.</td>
</tr>
<tr>
<td>Clear normalized flag</td>
<td>Software Installation (cmdb_sam_sw_install)</td>
<td>Clears the is_normalized check box when a field value is changed from a normalized value.</td>
</tr>
<tr>
<td>CPU/Core count change</td>
<td>Computer (cmdb_ci_computer)</td>
<td>Clears theCached check box on related software installs when the CPU count or CPU core count changes.</td>
</tr>
<tr>
<td>Create a Software Normalization</td>
<td>Software Installation (cmdb_sam_sw_install)</td>
<td>Links the record to the discovery model with that primary key on the (cmdb_sam_sw_install) table if the primary key changes. The business rule creates a discovery model if none exist for that primary key.</td>
</tr>
<tr>
<td>Create a Software Normalization</td>
<td>Software Usage (cmdb_sam_sw_usage)</td>
<td>Links the record to the discovery model with that primary key on the (cmdb_sam_sw_usage) table if the primary key changes. The business rule creates a discovery model if none exist for that primary key.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delete cached count results</td>
<td>Software License (aim_license)</td>
<td>Marks the software counter results to be recounted when one or more fields on a license have changed. This script runs after a change to a field that a counter can be grouped on, such as location, department, company, cost_center, entitlement_condition, or assigned_condition. If one or more of these fields changes, then the script sets the Recount field to true on any cached counter results matching the previous value. When the counter runs, the results with Recount set to true are treated as non-cached results and are recounted. For example, if Location on a license was Americas and changes to EMEA, cached results for Americas will have Recount set to true for the next count.</td>
</tr>
</tbody>
</table>
| Delete Cached row entry     | License Entitlement (aim_entitlement)       | When an entitlement is deleted:  
  - Deletes all related software counter details.  
  - Clears the Cached check box on the related software install.                                                                                                                                                                                                                     |
<p>| Drop counter Cache          | Software Counter (sam_sw_counter)          | Clears the Cached check box for the software counter if the grouping, license type, contract, or installs per license change in a software counter. Added enforce field changes to the conditions.                                                                                                                                                       |
| Flag counter to reprocess   | Software Upgrade and Downgrades (cmdb_m2m_downgrade_model) | Clears the Cached check box for all related software counters if the upgrade parent or downgrade child values are changed or deleted.                                                                                                                                                                                                 |
| Flag counter to reprocess   | Software Suite (cmdb_m2m_suite_model)       | Clears the Cached check box for all related software counters if the suite parent or suite child values are changed or deleted.                                                                                                                                                                                                 |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalidate sw install cache</td>
<td>Computer (cmdb_ci_computer)</td>
<td>Uncaches all install and usage records referencing a computer when the computer's processor field is changed.</td>
</tr>
<tr>
<td>Limit license metric</td>
<td>License (alm_license)</td>
<td>Limits software licenses to a single license metric value.</td>
</tr>
<tr>
<td>Limit license metric combinations</td>
<td>Hardware (cmdb_ci_hardware)</td>
<td>Rejects license metric combinations of the same type, such as CAL (user) and CAL (devices).</td>
</tr>
<tr>
<td>Link to Model</td>
<td>Software Discovery Model (cmdb_sam_sw_discovery_model)</td>
<td>Finds and sets the model field to the model that best corresponds to the record when a software discovery model is created.</td>
</tr>
<tr>
<td>Mark install for suite omission</td>
<td>License Entitlement (alm_entitlement)</td>
<td>Searches for any matching installs and marks them for suite omission.</td>
</tr>
<tr>
<td>One and only one default mapping</td>
<td>Processor Mapping (sam_processor_mapping)</td>
<td>Ensures only one default mapping by resetting the last resort flag for modified records and setting it to false for new records.</td>
</tr>
<tr>
<td>Process cache reset</td>
<td>Software Installation (cmdb_sam_sw_install)</td>
<td>Resets the install of any counter information when it becomes uncached.</td>
</tr>
<tr>
<td>Process suite component deletion</td>
<td>Software Installation (cmdb_sam_sw_install)</td>
<td>Updates all other members of an install's suite if the install is deleted.</td>
</tr>
<tr>
<td>Rebind processor definitions</td>
<td>Processor Mapping (sam_processor_mapping)</td>
<td>Refreshes processor definitions when a processor mapping changes.</td>
</tr>
<tr>
<td>Rebuild Cache</td>
<td>Software Discovery Model (cmdb_sam_sw_discovery_model)</td>
<td>Clears the Cached field on the software counter if the associated software model is modified on the software discovery model record.</td>
</tr>
<tr>
<td>Rebuild inferred suite and cached</td>
<td>Software Discovery Model (cmdb_sam_sw_discovery_model)</td>
<td>Clears the cached flag and inferred suite field on records referencing this discovery model, when the matched model changes.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remove cached flag</td>
<td>Software Installation (cmdb_sam_sw_install)</td>
<td>Clears the corresponding cached software counter details if a software installation is deleted or if the configuration item on which it is installed changes.</td>
</tr>
<tr>
<td>Remove cached flag</td>
<td>Software Usage (cmdb_sam_sw_usage)</td>
<td>Clears the corresponding cached software counter details if a software usage record is deleted or if the configuration item from which the software is accessed changes.</td>
</tr>
<tr>
<td>Remove caches from detail</td>
<td>Software Counter Detail (sarn_sw_counter_detail)</td>
<td>Clears the Cached check box on the related entitlement, installation, and usage records if they exist.</td>
</tr>
<tr>
<td>Reset counter info on suite change</td>
<td>Software Installation (cmdb_sam_sw_install)</td>
<td>Uncaches and resets counter information on the install if its inferred suite changes.</td>
</tr>
<tr>
<td>Reset Installs per License</td>
<td>Software Counter (sarn_sw_counter)</td>
<td>Clears the Installations per license fields if the counter license type is not per user.</td>
</tr>
<tr>
<td>Retrieve PVU Mapping</td>
<td>Processor Definition (cmdb_processor_definition)</td>
<td>Finds a matching processor mapping based on the information of the processor definition.</td>
</tr>
<tr>
<td>SAM: Core Process</td>
<td>Global (global)</td>
<td>Not used for any processing.</td>
</tr>
<tr>
<td>Set Display name</td>
<td>Software Counter Result (sarn_sw_counter_result)</td>
<td>Sets the display name of the counter result to the counter name with the grouping type.</td>
</tr>
<tr>
<td>Set normalized fields</td>
<td>Software Usage (cmdb_sam_sw_usage)</td>
<td>Sets normalized fields on insert to be copies of discovered fields.</td>
</tr>
<tr>
<td>Set normalized fields</td>
<td>Software Installation (cmdb_sam_sw_install)</td>
<td>Copies the given values as their normalized values when a software install is inserted.</td>
</tr>
<tr>
<td>Sync Software Package</td>
<td>Software Discovery Model (cmdb_sam_sw_discovery_model)</td>
<td>Creates a row in the package table to reflect the row in the discovery model table.</td>
</tr>
<tr>
<td>Update Cache</td>
<td>Software Installation (cmdb_sam_sw_install)</td>
<td>Updates all corresponding cached software counter details if usage metrics for this installation change.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update Cache</td>
<td>Software Usage (cmdb_sam_sw_usage)</td>
<td>Updates all corresponding cached software counter details if usage metrics for this software usage change.</td>
</tr>
</tbody>
</table>

**References**

Software Asset Management plugin adds the following references.

**Software Asset Management plugin references**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor Definition</td>
<td>Activating the Software Asset Management plugin IBM PVU Process Pack after activating Software Asset Management plugin adds a reference to the processor definition to the Hardware (cmdb_ci_hardware) table.</td>
</tr>
</tbody>
</table>

**Software Asset Management plugin setup process**

To get started with Software Asset Management plugin, you need to identify and discover software owned, create software models, create license records, and configure software counters.

To get started with Software Asset Management plugin:

- **Identify Software Owned.** The following methods identify the software your organization owns:
  - Use Discovery to identify currently owned software and begin working with Software Asset Management plugin.
  - Identify and add the software manually or with a third-party tool.

- **Make the Configuration Management Database (CMDB) Accurate**
  - Clean up information in CMDB. At first, focus on your top 10-20 software vendors.

- **Create Software Models**
  - Create software models for all of the software your organization wants to monitor. Software models can also be imported from another source such as a Discovery application, an existing data set of software licenses, or a third-party source.

- **Create Software License Records**
  - Create software license records for all of the software your organization owns. This information can also be based on information from a purchasing source or imported as a spreadsheet.

- **Configure Software Counters**
  - Configure software counters to view your organization's software compliance levels for all of your software.

**Determine where software is installed**

When determining where software is installed, there are a few points to keep in mind.
The software instance no longer contains discovered information. The information previously went to the Software Instance (cmdb_software_instance) table, but now goes to the Software Installation (cmdb_sam_sw_install) table. Because the table has changed, you must change your transform maps to point to the new table.

- Models identified by a discovery tool are linked to software models.
- Use grouping to obtain more specific information from a software counter.
- Software installations link a computer with a software model (via a discovery model).

A discovery tool places the data it obtains into the Software Installation (cmdb_sam_sw_install) table. All of the information can be seen in the Software Installations list and the individual Software Installation forms. When a record is created, the system analyzes the Discovery Model table and identifies five key points.

- Publisher
- Display name
- Prod ID
- Version
- Revision

Find software on the network
After using a discovery tool, you can find a definitive list of all the software found on the network.

Role required: sam

Note: A user with the Asset role can delete software installations, but it is not recommended. As an alternative, archive software installation information.

1. Navigate to Software Asset > Discovery > Discovery Models.
   A software administrator can, for example, look at the list and see that Adobe Acrobat 9.0, 9.2, 9.3, and 9.5 were found. Then, the administrator can edit software discovery models so all the dot versions are considered version 9.0 when doing reconciliation.

2. Click a Display Name in a row.
   All installations that map to an individual software discovery model are displayed.
   All fields on the form are read-only.

### Software installation fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the software installation as it appears in record lists.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software.</td>
</tr>
<tr>
<td>Discovery model</td>
<td>Software discovery model that represents the installed software.</td>
</tr>
<tr>
<td>Prod id</td>
<td>Number created by the publisher to identify the software.</td>
</tr>
<tr>
<td>Install location</td>
<td>Path under which the software is installed.</td>
</tr>
<tr>
<td>Install date</td>
<td>Date on which the software was installed.</td>
</tr>
<tr>
<td>Revision</td>
<td>Revision of the software.</td>
</tr>
</tbody>
</table>
## Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance key</td>
<td>Encrypted credentials for the software installation.</td>
</tr>
<tr>
<td>Installed on</td>
<td>Hardware on which the software is installed.</td>
</tr>
<tr>
<td>Uninstall string</td>
<td>Identifier used to uninstall the software.</td>
</tr>
<tr>
<td>ISO serial number</td>
<td>ISO number of the software.</td>
</tr>
<tr>
<td>Foreground</td>
<td>Duration of foreground usage of the software.</td>
</tr>
<tr>
<td>Background</td>
<td>Duration of background usage of the software.</td>
</tr>
<tr>
<td>Last scanned</td>
<td>Date and time on which the software was last discovered on this hardware.</td>
</tr>
<tr>
<td>Last used</td>
<td>Date and time on which the software was last used on this hardware.</td>
</tr>
<tr>
<td>Counted by</td>
<td>The counter summary name that the installation is counted on.</td>
</tr>
<tr>
<td>Entitlement</td>
<td>Entitlement that is associated with the software installation.</td>
</tr>
<tr>
<td>Inferred suite</td>
<td>Software suite inferred by the inference parameters.</td>
</tr>
<tr>
<td>Valuation</td>
<td>Indicates the number of rights the install has.</td>
</tr>
<tr>
<td>Cached</td>
<td>If checked, the license installation has already been counted.</td>
</tr>
<tr>
<td>Omit from suites</td>
<td>If checked, the license is ignored for any suite calculations. This box is automatically checked if the install finds a possible entitlement of the exact software model for this configuration item.</td>
</tr>
</tbody>
</table>

### Note:
Third-party discovery tools can use software normalization to more effectively manage the software installation database. Software normalization allows you to standardize your software installation data, such as the display name, publisher, revision, and version. You can personalize the software installation form to include these normalization fields. For more information, see [Personalizing forms](#).

For more information on forms see [Configure a form](#).

**Scan software installations with the system scheduler**

Software Asset Management plugin adds a scheduled job for scanning software installations named **SAM License Counters** in **System Scheduler > Scheduled Jobs**.

The **SAM License Counters** job occurs at 2:00am (local time) every morning. The job queries the Software Installation (cmdb_sam_sw_install) table and captures any installations that have not been scanned in the past 7 days. The job runs a join query on hardware that has been scanned within the last day and software installations that have not been scanned in the last 7 days. These software installations are then removed.
Software licenses

Software licenses are based on defined models in the Software Asset Management plugin feature.

You can create the models to organize software licenses in any way that makes sense for your organization. Common methods of defining models and licenses include by department or by region.

Licenses can be associated with a contract. For more information, see the Contract Management application.

Licensing types

Different types of licenses are available in the ServiceNow Software Asset Management plugin feature as listed below.

- By CPU
  - By CPU cores
  - By number of CPUs
- By number of points
  - Per installation - IBM PVU
- By user
  - Number of installs per user
  - Per named user
- By utilization
  - Usage (CPU)
  - Usage (User)
- By workstation
  - Per workstation

Supported license models

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual</td>
<td>Given to individuals.</td>
</tr>
<tr>
<td>Bulk allocated</td>
<td>Allocated to users via entitlements.</td>
</tr>
<tr>
<td>Bulk not allocated</td>
<td>Given to users with details, such as who has a license or where the license is located, not tracked.</td>
</tr>
</tbody>
</table>

License management

The Software Asset Management plugin feature allows asset managers to track and organize the number of licenses available to the organization.

Software licenses are based on models that you create to organize software licenses in meaningful ways. Different license calculation types determine how software is counted.
Software licenses can also be associated with a contract which enables a company to cover software licenses for multiple assets or users. You can manage and track software contracts using the **Contract Management** application.

**Add a new software license**

You can add a new software license using the Software Asset Management plugin feature.

Role required: sam

1. Navigate to **Software Asset > Software Licenses**.
2. Click **New**.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Read-only. Name of the software license. Created automatically.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model category for the software license. <strong>Software License</strong> is selected by default.</td>
</tr>
<tr>
<td>Model</td>
<td>Software model of the license you are matching to. For example, Microsoft Excel.</td>
</tr>
<tr>
<td>Rights</td>
<td>Number of entitlements to be granted by this license. If an enterprise contract is attached to the license, the Rights field does not display.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Asset tag</td>
<td>Number from the asset tag. The tag contains the serial number and bar code for tracking the software license.</td>
</tr>
<tr>
<td>State</td>
<td>Current status of the software license, such as <strong>On order</strong> or <strong>In use</strong>.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User currently assigned to this software license.</td>
</tr>
<tr>
<td>Managed by</td>
<td>User or department that maintains the software license. Can be different than the owner. For example, a specified user can own a software license, but the IT department manages it.</td>
</tr>
<tr>
<td>Owned by</td>
<td>User or department with financial ownership of the software license. Can be different than the manager.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent asset of the software license, if any. For example, the parent asset of Microsoft Word software is often the Microsoft Office suite.</td>
</tr>
<tr>
<td>Class</td>
<td>(Read-only) Automatically created as <strong>Software License</strong>.</td>
</tr>
<tr>
<td>License metric</td>
<td>(Optional) A single metric which the software license is counted against.</td>
</tr>
<tr>
<td>Serial number</td>
<td>Unique number assigned for identification.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Substate</td>
<td>More details about the software license stage. The available substate settings</td>
</tr>
<tr>
<td></td>
<td>depend on the State selected. For example, if you select the Retired state,</td>
</tr>
<tr>
<td></td>
<td>the substate options available are Disposed, Sold, Donated, and Vendor credit.</td>
</tr>
<tr>
<td>Location</td>
<td>Where the license will be used. For example, a specific site, country, or region.</td>
</tr>
<tr>
<td>Department</td>
<td>Department of the person Assigned to this software license.</td>
</tr>
<tr>
<td>Company</td>
<td>Company that created the software.</td>
</tr>
<tr>
<td>Assigned</td>
<td>Date on which the software license was assigned.</td>
</tr>
<tr>
<td>Installed</td>
<td>Date on which the software license was installed.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the software license that would be helpful for others to know.</td>
</tr>
</tbody>
</table>

For information about the fields in the Financial and Contracts sections of the form, see Create assets.

4. Click Submit.

Create and manage an enterprise license

Enterprise licenses are typically for large customers and provide some flexibility, an agreed upon discount price, and a mechanism for easy administration.

Use the Contract Management application to set a software license as enterprise or subscription.

2. Click New.
3. Select a License type of Enterprise.
4. Fill in as many of the remaining fields on the Contract form as you can, and click Submit.
5. Reopen the contract.
6. In the Assets Covered related list, click New.
7. In Asset, select the software covered by the contract.
8. In Date added, select the date the software license was added to the contract. The date can be in the past, the present, or the future.
9. (Optional) In Date removed, select the date asset was, or will be, removed from the contract.
10. Click Submit.
11. Navigate to Software Asset > Reconciliation > Software Counters.
12. Click the software you specified.
13. Click Count Licenses.

The licenses are listed under Software Counter Results. The licenses display as 0, but you are not out of compliance because you have an enterprise license with an enterprise contract. Once an enterprise contract is associated with software, all users are entitled when the licenses are counted.
**Create and manage a subscription license**

You can create subscription licenses, and manage the information as it changes.

Role required: contract_manager

1. Navigate to **Contract > Software License** and click **New**.
2. Select a **License type** of **Subscription**.
3. Complete the **Contract** form, right-click the header, and select **Save**.
4. In the **Assets Covered** related list, click **New**.
5. In **Asset**, select the software covered by the contract.
6. In **Date added**, select the date the software license was added to the contract. The date can be in the past, the present, or the future.
7. Optional: In **Date removed**, select the date asset was, or will be, removed from the contract.
8. Click **Submit**.
9. Navigate to **Software Asset > Reconciliation > Software Counters**.
10. Click the software specified in step 6.
11. Click **Count Licenses**.
    - The licenses are listed under **Software Counter Results**.

**Software license entitlements for Software Asset Management plugin**

Software entitlements enable you to define the people or machines to which a specific, purchased software license is assigned.

Role required: asset

Asset managers allocate a license to entitle a user or machine to use the license. For example, a company purchases a software license for 100 rights. The software entitlement specifies the 100 employees or machines that are rightfully assigned a license. If the ServiceNow Discovery tool is used and it finds the software installed on 200 machines, the asset manager can identify the employees or computers that have the software installed without a license. The asset manager can ask users to remove the software from their computers.

Built-in rules prevent entitling more licenses than have been purchased. License entitlements use specific software license asset tags. In addition to the mandatory asset tag, an individual person and a specific configuration item can be assigned.

The benefits of using software entitlements include the following.

- If the overall license entitlement is exceeded, the asset manager can rapidly address the problem and return to compliant status by either removing unauthorized software or ordering more licenses.
- If the license entitlement is not being used completely, the asset manager can respond by lowering the number of licenses purchased in the future.

1. Navigate to **Asset > Software > Asset License Entitlements** and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name used in record lists.</td>
</tr>
</tbody>
</table>
Create an entitlement for Software Asset Management plugin

You create software entitlements for both CIs and users from the same License Entitlement form. You can create these entitlements from Asset Management. Navigate to one of these locations and click New:

- Asset > Software > Asset License Entitlements
- Asset > Software > User License Entitlements

1. Navigate to Software Asset > Software Licenses.
2. Click an Asset tag.
3. Click Add Entitlement and complete the License Entitlement form using the fields in the table.
4. Click Submit.
   The view returns to the Software License form.
5. Set an optional condition in the Allocated conditions section.
   The configuration items given this license must meet the specified conditions. For example, you might set a condition that allocates this software license to CIs in a certain department only.
6. Click Update.

License entitlement

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name used in record lists.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User of the entitlement token.</td>
</tr>
<tr>
<td>Allocated to</td>
<td>The configuration item consuming the license token.</td>
</tr>
<tr>
<td>Licensed by</td>
<td>License granting this token.</td>
</tr>
<tr>
<td>Cached</td>
<td>Internal flag set and used by software counters.</td>
</tr>
</tbody>
</table>

Create a software user license entitlement

You can entitle a user to use one of your software licenses.

Role required: asset

1. Navigate to Asset > Software > User License Entitlements and create a new record (see table for field descriptions).
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Read-only. Name used in record lists.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User of the entitlement token.</td>
</tr>
<tr>
<td>Licensed by</td>
<td>License granting this token.</td>
</tr>
<tr>
<td>Cached</td>
<td>Read-only. Internal flag set and used by software counters logic.</td>
</tr>
</tbody>
</table>

2. Click Submit.

Entitle a license to a configuration item

You can entitle a license to a configuration item, such as a computer or server, or a location, such as a city of building.

Role required: sam

1. Navigate to Software Asset > Software Licenses.
2. Click an Asset tag, or click New to create a new software license.
3. In the Asset Entitlements related list, perform one of the following actions.
   - Double-click in Allocated to to entitle the license to a specific configuration item, such as a computer or server.
   - Double-click in Location to entitle the license to a specific location, such as a city or building.

4. Optional: Set the Allocated conditions condition to the configuration items given this license must meet the specified conditions. For example, only configuration items in a certain department can be allocated this software license.
5. Click Update.

Entitle a license to a user or location

You can entitle a license to an individual user.

Role required: sam

1. Navigate to Software Asset > Software Licenses.
2. Click an Asset tag, or click New to create a new software license.
3. In the User Entitlements related list, perform one of the following actions.
   - Double-click in Assigned to to entitle the license to a specific user.
   - Double-click in Location to entitle the license to a specific location, such as a city or building.

4. Optional: Set the Assigned to condition to require that every user given this license meets the specified conditions. Only people in a certain region can be assigned this software license.
5. Click Update.

License upgrade and downgrade

The concept of upgrading and downgrading licenses is built into the Software Asset Management plugin feature.

This is helpful when reconciling licenses. Downgrading a license is the process of purchasing a license, but using an earlier version. Upgrading a license occurs when a newer version of a license
Paris IT Service Management

is not purchased, but you are allowed to use the newer version. Downgrading is more common than upgrading.

Any version defined as a downgrade child that does not have entitlements and a license can be counted as an installation of the upgrade parent. Use this method to avoid having to uninstall unlicensed versions of software running in your environment. When you define an unlicensed version as a downgrade child of a licensed version, the system creates a software model record for the unlicensed version with an upgrade path to the licensed version. If you delete the downgrade child from the licensed version’s record, it is automatically deleted from the Software Model record for the unlicensed version.

**Note:** If the downgrade child has either a license or an entitlement, it must also have a counter, which counts all installations of the downgrade child against its own license.

For example, you have licenses for the software model Microsoft Word 2010, but no licenses or entitlements for Word 2007. Discovery finds installations of Word 2007 being used in your organization. Rather than force users to uninstall all instances of this unlicensed version, you decide to count installations of Word 2007 against your Word 2010 license. To do this, you configure Word 2007 as a downgrade child in the Word 2010 Software Model record. A Software Model record is automatically created for Word 2007 which specifies Word 2010 as the upgrade parent.

If a software version has a downgrade child or an upgrade version that can be counted against the parent, the number of installs counted is restricted to the number of available rights of the parent. For example, Microsoft Word 2010 has a downgrade to Word 2007. Both versions have an active counter. Microsoft Word 2010 finds all entitled copies of Word 2007, and also takes out of compliance any installs from that downgrade counter until the available downgrade rights are used. However, if Microsoft Word 2010 only has 100 rights, then the maximum number of rights to be taken from the downgrade counter is 100.

You can set the start and end dates for a software upgrade parent and downgrade child to be valid. The software counter counts the upgrade and downgrade licenses within the selected dates. If the software counter runs outside of the date range, the upgrade and downgrade licenses are not counted.

**Note:** If an upgrade parent or downgrade child is set on the software model, it applies to all licenses of that model. If set on the software license, it applies specifically to that license.

Upgrade a license

You can upgrade a software license using one of two methods: from a software license record or from a software model record.

Role required: sam

1. Complete the following steps to identify an upgrade parent from a software license record.
   a) Navigate to **Software Asset > Software Licenses** and select a software license.
   b) Click the **Software Upgrade and Downgrade** tab and click **New**.
   c) Complete the form.

### Software Upgrade and Downgrades form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License</td>
<td>Name and asset number of the software license.</td>
</tr>
<tr>
<td>Downgrade Child</td>
<td>Lower version of the software license.</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrade parent</td>
<td>Higher version of the software license.</td>
</tr>
<tr>
<td>Start date</td>
<td>Start date of the upgrade.</td>
</tr>
<tr>
<td>End date</td>
<td>End date of the upgrade.</td>
</tr>
</tbody>
</table>

d) Click **Submit**.
   The software upgrade displays in the Software Upgrade and Downgrades section.

e) Select the software upgrade check box and click **Update**.
   The software license is updated in the Software License list.

2. Complete the following steps to identify an upgrade parent from a software model record.
   a) Navigate to **Software Asset > Software Models**.
   b) Select a model.
   c) In the **Upgrade** section, double-click under the **Upgrade parent** column heading.
   d) Select a software model from the list.
   e) Click the green check mark and click **Update**.
      The Software Model form is updated.

### Downgrade a license

You can downgrade a software license using one of two methods: from a software model record or from a software license record.

**Role required:** sam

**Note:** Downgrade children set on the software license applies specifically to that license. If a downgrade child is set on the software model, it applies to all licenses of that model.

1. Complete the following steps to downgrade a license from a software model record.
   a) Navigate to **Software Asset > Software Models**.
   b) Select a model.
   c) In the **Downgrade** section, double-click under the **Downgrade child** column heading.
   d) Select a software model from the list.
   e) Click the green check mark.

2. Complete the following steps to downgrade a license from a software license record.
   a) Navigate to **Software Asset > Software Licenses**.
   b) Select a license.
   c) Click **New** in the Software Upgrade and Downgrades related list.
   d) Select a software model from the list.
   e) Select the **Start** and **End** dates.
   f) Click **Submit**.

Identify a downgrade child from a software license record
How to identify a downgrade child from a Software License record.

1. Navigate to **Software Asset > Software Licenses**.
2. Select a license.
3. Click **New** in the **Software Upgrade and Downgrades** related list.
4. Select a software model from the list.
5. Select the Start and End dates.
6. Click **Submit**.

**Note:** Downgrade children set on the software license applies specifically to that license. If a downgrade child is set on the software model, it applies to all licenses of that model.

### View a list of unallocated software licenses

Managing software licenses includes knowing what licenses are owned by your organization, but are not allocated.

**Role required:** sam

You can allocate the licenses to users or devices. If no one needs the unallocated licenses, this can be noted so that fewer licenses are purchased in the future.

1. Navigate to **Asset > Software > Unallocated Licenses**.
2. View the **Software Counter Details** list (**Unallocated License** view).
   - The **Valuation** column lists the number of unallocated licenses for the given software model.
3. Click a name in the **Model** column for detailed information about a specific license.
   - View the **Software Model** list in the **Unallocated License** view.

### Merge a software license

If you have multiple software licenses that are linked to the same model, you can merge these individual licenses into one new consolidated license.

To be merged, the individual licenses must meet the following requirements:

- The licenses cannot already be merged into another consolidated license.
- The information in the following fields must match for each license:
  - Model
  - Allocated condition
  - Assigned condition
  - Company
  - Location
  - Department
  - Cost center
  - State
- The licenses must have the same set of software upgrades and downgrades and the same set of assets covered. To verify this information, go to **Software Asset > Software Licenses** and select a license.
  - For upgrades and downgrades, go to the **Software Upgrade and Downgrades** related list.
  - For assets covered, go to the **Assets Covered** embedded list in the Contracts related list.
If a license can be merged, **Merge with similar licenses** appears under **Related Links** on the Software License form.

To merge a license:

1. Open a license.
2. Click the **Merge with similar licenses** link.
   
   Displays a dialog box with a message stating that the merge process is irreversible and that license keys are not merged.
3. Click **OK**.
   
   All qualifying licenses, including the current license, are merged into a new consolidated license. An informational message appears until the user is redirected to the newly merged license.

All qualifying licenses are merged into a new consolidated license unless they can be matched to an existing consolidated license. If they are merged into a new consolidated license, the **Asset tag** field is cleared. After merging, the merged license is marked as **Is merged license** (field = true) and the **Merged into** field is set to this license for the consolidated licenses.

**Note:** Licenses that are marked as merged are not counted.

For the consolidated licenses:

- The number of rights are summed up into a new count.
- The asset and user entitlements are transferred to the new license.
- The expense lines and assets on contract rate cards are transferred to the new license.
- The set of software upgrades and downgrades, as well as the set of assets covered, are copied to the new license.
- The cost of each individual license is summed up into the new license using the system base currency.
- A history of the consolidated licenses and where they went is maintained.

**Manage software models**

Software Asset Management plugin uses software models to manage licenses, specifically in software counters and license restrictions, and to track upgrade and downgrade licenses.

Role required: sam or model_manager

Create software models for all of the software your organization wants to monitor. Software models can also be imported from another source such as the Discovery application.

**Note:** Software does not create configuration items. If the discovery tool you use supports and finds ISO information, details such as ISO ID and ISO serial number are added to the Software Model form for compliance purposes.

1. Navigate to **Software Asset > Software Models**.
   
   Users with the model_manager role can navigate to **Product Catalog > Product Model > Software Models**, but cannot administer all aspects of software models.
2. Click **New**.
3. Complete the form.
## Software model fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>(Read-only) Name of the model. A system property called <code>glide.cmdb_model.display_name.shorten</code> controls how software model display names are generated. Administrators can configure the property.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>The company that built the model.</td>
</tr>
<tr>
<td>Name</td>
<td>The manufacturer-assigned name of the model or an abstract name specified by the model manager, such as Field Agent Laptop.</td>
</tr>
<tr>
<td>Edition</td>
<td>The edition of the software model, such as Professional.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the model.</td>
</tr>
<tr>
<td>Model categories</td>
<td>(Read-only) The category the model is assigned to. The system automatically sets the value to Software License. This field is a glide list.</td>
</tr>
<tr>
<td>Asset tracking strategy</td>
<td>The process the model should be tracked by. Choose from the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Leave to Category</strong>: model is transparent and the asset class is defined solely by the category.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Create Consumable Asset</strong>: model forces the asset class to be consumable, regardless of what the category defines as the asset class.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Don’t create assets</strong>: model blocks asset instantiation, regardless of what the category defines as the asset class.</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>The method for purchasing the model. Options are Both, Buy, and Lease.</td>
</tr>
<tr>
<td>Cost</td>
<td>The cost a single unit of the model.</td>
</tr>
<tr>
<td>Depreciation</td>
<td>The depreciation scheme for the model.</td>
</tr>
<tr>
<td>Model number</td>
<td>The specific model number assigned to the item by the manufacturer.</td>
</tr>
<tr>
<td>Barcode</td>
<td>The barcode number assigned to the model. Barcodes are usually assigned by the manufacturer.</td>
</tr>
<tr>
<td>Owner</td>
<td>The person responsible for the model.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the model. Options are In Production, Retired, and Sold.</td>
</tr>
<tr>
<td>Certified</td>
<td>The option that determines whether the model is approved for use.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the model that would be helpful for others to know.</td>
</tr>
<tr>
<td>License</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>The exact version of the software. For example, Version 2.</td>
</tr>
<tr>
<td>Major</td>
<td>The ISO major version number of the software.</td>
</tr>
<tr>
<td>Minor</td>
<td>The ISO minor version number of the software.</td>
</tr>
<tr>
<td>Build</td>
<td>The build number of the software.</td>
</tr>
<tr>
<td>Software category</td>
<td>A category name for grouping software with similar characteristics.</td>
</tr>
<tr>
<td>Single or multi license</td>
<td>Defines whether this model uses a single license or multiple licenses.</td>
</tr>
<tr>
<td>Maximum socket count</td>
<td>Maximum number of CPU sockets that a computer must have for the software to be installed.</td>
</tr>
<tr>
<td>License type</td>
<td>The tracking type for the license. For example, by number of users, per workstation, per installation with IBM PVU or per Oracle processors. If you select the By number of users option, you can create a software counter and specify the number of installations per license.</td>
</tr>
<tr>
<td>Activation status</td>
<td>The activation state of the software model. Options are None and Activated.</td>
</tr>
<tr>
<td>ISO id</td>
<td>The unique ISO identification number of the software product.</td>
</tr>
<tr>
<td>ISO serial number</td>
<td>The serial number issued by ISO for the software.</td>
</tr>
<tr>
<td>Application model</td>
<td>Application associated with this software.</td>
</tr>
<tr>
<td>Rights</td>
<td>Number of licenses granted to this software.</td>
</tr>
<tr>
<td>Minimum users</td>
<td>Minimum number of user licenses required for this software.</td>
</tr>
<tr>
<td>Maximum users</td>
<td>Maximum number of user licenses required for this software.</td>
</tr>
<tr>
<td>Suite Components</td>
<td></td>
</tr>
<tr>
<td>Inference percent</td>
<td>The percentage of suite components that need to be present on a system to count as a suite. Used for suite management. For example, Suite A consists of 5 products. If the inference percent is set to 60% and a discovery tool finds three of the products on the system, the software is flagged for possible purchase as a suite.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Components</td>
<td>The child product or products of the suite. For example, Microsoft Word and Microsoft Excel are child products of Microsoft Office.</td>
</tr>
<tr>
<td>Suite Parents</td>
<td>The parent suites to which the software is assigned. For example, the parent suite for several common Microsoft products is a version of Microsoft Office.</td>
</tr>
<tr>
<td>Parents</td>
<td>An alternative version license to which you have rights. For example, if you purchase version 4 of a software product shortly before version 5 is released, your version 4 license may include a free upgrade to version 5 when it is released.</td>
</tr>
<tr>
<td>Upgrades</td>
<td>An alternative version license to which you have rights. For example, if you purchase version 4 of a software product, your version 4 license may include downgrade rights to version 3.</td>
</tr>
<tr>
<td>Licenses</td>
<td>The software licenses that should be created automatically from this model.</td>
</tr>
<tr>
<td>Catalog Item</td>
<td>The information about the model as it appears in the product catalog and service catalog. Information only appears if the model has been published to the product catalog.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the software model as it appears in the product catalog.</td>
</tr>
<tr>
<td>Picture</td>
<td>An image of the software logo.</td>
</tr>
</tbody>
</table>

Any software licenses you create and assign to the new model are displayed in the Licenses embedded list on the Software Model form.

Create and manage software suites
Software uses the concept of suites instead of bundles.

A software suite is a group of related software offered as one unit. An example is the Microsoft Office Professional suite of office productivity software tools that includes Powerpoint, Word, Excel,
Outlook, and Access. In Software Asset Management plugin, create suites and add components to the suite so the licenses your organization owns are counted accurately.

For any software model, you have the option to specify whether the model is a suite (parent) or a component (child). A software model can be a component in multiple suites. For example, Microsoft Word is a component in Microsoft Office Standard and Microsoft Office Professional. Although you can set a single software model as both a suite and a component, software is not typically sold as nested suites.

Use the **Inference percent** and **Inference mandatory** options for even greater control of suites.

- **Inference percent**: specifies what percentage of the components in the suite must be installed for the software to be identified as a suite.
- **Inference mandatory**: enforces that a specific component in a suite must be installed to infer that the suite is installed.

For example, specify the **Inference percent** as 80% and set the **Inference mandatory** option to true on Microsoft Access. These settings specify that Microsoft Access must be installed, along with 3 out of 4 other products (Microsoft Word, Microsoft Excel, Microsoft PowerPoint, and Microsoft Outlook) to infer that Microsoft Office Professional is installed.

The interference percent and interference mandatory fields

To make the new software model record a parent record in a suite:

1. Open a software model record.
2. In the Suite Components section, double-click an empty row under **Suite child**.
Suite child

3. Add the software to include in the suite.

4. (Optional) Set the **Inference mandatory** option to **true** if the software must be installed to count the model as a suite.

5. Repeat as necessary.

To make the new software record a child item:

1. Open a software model record.

2. In the Suite Parents section, double-click an empty row under **Suite parent**.
Suite parent

3. Add the suite to which this software model should belong.
4. Repeat as necessary.

Note: When a change is made to a suite, a scheduled job called Calculate suites (Software Suite Model) is created. The job runs instantly, calculates any suites, and then deletes itself. The calculations are stored in the cmdb_sam_sw_install table under inferred suite.

License calculations

Software license calculations count the number of licenses that exist in your network environment.

Users with the sam role can choose to count software licenses using a variety of license calculation types, such as counting by the number of users, the number of workstations, the number of CPUs, and others. For example, you can count the number of Adobe Acrobat 9.0 licenses based on the number of users that have the software installed in the organization.

Calculate software licenses

Software calculations use license calculation types to determine how software licenses are counted in your organization.

You can use the default license types provided in the base system or create new ones. To view the default types, navigate to Software Asset > Reconciliation > License Calculations and select a type. All fields in the default records are read-only.
License calculation details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the license type.</td>
</tr>
<tr>
<td>Query table</td>
<td>The table that is being used for data. Possible values are Software install and Software usage.</td>
</tr>
<tr>
<td>Count by</td>
<td>The calculation type by which the license calculation type counts software licenses.</td>
</tr>
</tbody>
</table>

License calculation types

Certain default license calculation types are available.

These license types cannot be deleted.

License calculation types

<table>
<thead>
<tr>
<th>Category</th>
<th>License type</th>
</tr>
</thead>
</table>
| By CPU    | • **By CPU cores**: The counter adds up the total license rights for all software license records of this model. The **CPU Core Count** field on the hardware configuration item determines the number of rights consumed by any software installation located on the configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items.  
  • **By number of CPUs**: The counter adds up the total license rights for all software license records of this model. The **CPU Count field** on the hardware configuration item determines the number of rights consumed by any software installation located on the configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items. |
<table>
<thead>
<tr>
<th>Category</th>
<th>License type</th>
</tr>
</thead>
<tbody>
<tr>
<td>By number of points</td>
<td>• <strong>Per installation - IBM PVU:</strong> The counter adds up the total license rights for all software license records of this model. The installation count for every hardware configuration item that has IBM PVU software is a point calculation. The CPU type determines the PVU per-core multiplier based on the IBM PVU mapping table. The total number of cores on the configuration item is multiplied with this per-core multiplier to determine how many rights are used by an installation on this configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items. This license type is present but does not work until the Software Asset Management plugin <em>IBM PVU Process Pack</em> is active.</td>
</tr>
<tr>
<td></td>
<td>• <strong>CAL (Device):</strong> The counter adds up the total license rights for all software license records of this model. Usage is counted as one installation for every unique configuration item (device). For each installation, the counter checks for a valid entitlement record on any of the software license records. The Software Usage (ast_usage) table is used for counting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>CAL (User):</strong> The counter adds up the total license rights for all software license records of this model. Usage is counted as one installation for every unique user. For that installation, the counter checks for a valid entitlement record on any of the software license records. The Software Usage (ast_usage) table is used for counting.</td>
</tr>
<tr>
<td>Category</td>
<td>License type</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| By user    | • **Number of installs per user**: The counter adds up the total license rights for all software license records of this model. It counts an installation when one software installation matches the discovery models that are mapped to this software model for any hardware used by a user. It counts up to the specified amount. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items.  
        • **Per named user**: The counter adds up the total license rights for all software license records of this model. It counts an installation when there is at least one software installation that matches the discovery models that are mapped to this software model for any hardware used by a unique user. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items.  
        • **No license needed (User)**: The counter adds up the total number of users of this model. It counts an installation when there is at least one software installation that matches the discovery models that are mapped to this software model for any hardware used by a unique user. It applies to software installation data and hardware configuration items. This license type is used for software installations where no license is required, such as open source applications. |

To compare **Number of installs per user** and **Per named user**:

• **Number of installs per user** counts the number of installs the user has and assigns license cost based on installs per license. For example, UserA has three installs. One license is used by each install, for a total of three licenses.  
        • **Per named user**, there is no install limit for a particular user. For example, UserB, who has three installs, needs only one license for the three installs.
<table>
<thead>
<tr>
<th>Category</th>
<th>License type</th>
</tr>
</thead>
</table>
| By utilization   | • **Usage (CPU):** The counter adds up the total license rights for all software license records of this model. The counter looks at all of the software usage data mapped to any of the discovery model records of the counter's software model. It counts one installation for every unique configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software usage data.  
  • **Usage (User):** The counter adds up the total license rights for all software license records of this model. The counter looks at all of the software usage data mapped to any of the discovery model records of the counter's software model. It counts one installation for every unique user Accessed From hardware configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software usage data. |
|                  | • **Per workstation:** The counter adds up the total number of license rights for all software license records of this model. It counts an installation when there is at least one software installation on a hardware configuration item that matches the discovery models that are mapped to this software model. For each installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items.  
  • **No license needed (Workstation)** This license type is used for software installations where no license is required, such as open source applications. |
| By workstation   | • **Oracle Named User:** Oracle licensing scheme that counts by the number of unique users.  
  • **Oracle Named User Plus:** Oracle licensing scheme that counts by the number of unique users and accounts.  
  • **Oracle Processor:** Oracle licensing scheme that counts by the number of processors on a server.  
  This category and its license types are available when the Oracle Process Pack is activated. |
| By Oracle install |                                                                                   |
Create a custom license type
Custom license types allow you to create a license type with special conditions.

Role required: sam

A custom script can provide detailed information about the number of rights a software install or usage consumes.

1. Navigate to **Software Asset > Reconciliation > License Calculations**.
2. Click **New**.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the software license type.</td>
</tr>
<tr>
<td>Query table</td>
<td>The value that is used for queries. This can be either <strong>Software install</strong> to count the number of installations or <strong>Software usage</strong> to count the number of times the software is used.</td>
</tr>
<tr>
<td>Count by</td>
<td>The calculation type by which the license type counts software licenses. Make sure this value is set to <strong>Custom</strong> to create a new calculation type.</td>
</tr>
<tr>
<td>Entitlement type</td>
<td>The entitlement type of the license, either <strong>Workstation</strong> or <strong>User</strong>. This field is available only when the <strong>Count by</strong> field is set to <strong>Custom</strong>.</td>
</tr>
<tr>
<td>Script</td>
<td>The script used for custom license types. This field is available only when the <strong>Count by</strong> field is set to <strong>Custom</strong>.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

Create the script
By default, the **Script** field in the Software License Calculation form contains information about available variables and an example script.

You can use the example as the basis of the custom script or replace the example entirely.

You can use the following variables in the custom script.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>found</td>
<td>Contains a GlideRecord of the software install or software usage record currently being evaluated.</td>
</tr>
<tr>
<td>workstation</td>
<td>Contains a GlideRecord of the workstation referenced by the found record.</td>
</tr>
<tr>
<td>user</td>
<td>Contains a GlideRecord of the user referenced by the found record. Can be null if no user is assigned.</td>
</tr>
<tr>
<td>counter_id</td>
<td>Contains the sys_id of the counter running the script.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>query_table</td>
<td>Identifies the table currently being queried, either Software Installation or Software Usage.</td>
</tr>
<tr>
<td>valuation</td>
<td>Identifies the value in rights that is given to this software install or software usage record.</td>
</tr>
</tbody>
</table>

The following functions are available as part of the SAMutil script include and can be used in custom scripts.

**Note:** All of these functions utilize and depend on the variables mentioned above.

### Custom script functions

<table>
<thead>
<tr>
<th>Functions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>getWorkstationInstallsOrUsages</td>
<td>Returns a list of other installs on the given workstation.</td>
</tr>
<tr>
<td>getUserInstallsOrUsages</td>
<td>Returns a list of all other installs belonging to the user.</td>
</tr>
<tr>
<td>createCounterViolation</td>
<td>Returns insert a counter violation for the current counter with the given cause.</td>
</tr>
</tbody>
</table>

**Example:**

The following script uses the number of rights equal to the number of CPU sockets on the machine the script is installed on. The `workstation` variable is used to identify any workstation that is in the development environment. If such a workstation is found, the script then assigns a `valuation` equal to the number of CPU sockets on the machine. Otherwise, if the workstation is not in the development environment, then no rights are assigned.
Software discovery models

Software discovery models can be used to help normalize the software you own by analyzing and classifying models to reduce duplication.

Software discovery models are stored in the Software Discovery Model (cmdb_sam_sw_discovery_model) table. There is a distinct difference between software models and software discovery models.

- A software model is a specific version or configuration of software.
- A software discovery model is a model created when Discovery runs and identifies software.

Software discovery models cannot be created manually. The ServiceNow platform uses any of the following field combinations to match the new software discovery model to an existing software model.
When analyzing version numbers, the ServiceNow platform always searches for an exact match first, but rounds down to a major version number if an exact match is not found. For example, if no match is found for version number 8.0.4, but version 8.0 is found, then version 8.0 is used in the Software model field.

Edit a software discovery model
You can only edit the Software model field and Approved check box on the Software Discovery Models form.

Role required: sam

If the information automatically added to the Software model field is incorrect, you can change to an existing model or create a new one.

None of the software discovery model records are approved when they are created. You must approve them manually after you have reviewed them for accuracy or normalized them. If the automatically generated software model is correct, approve the model.

1. Navigate to Software Asset > Reconciliation > Discovery models.
2. Click an entry in the Publisher column.
3. Select Approved.

SAM approval

Automatically match to an existing model
The automatic matching feature allows you to match a software discovery model to an existing software model.

Role required: sam

1. Navigate to Software Asset > Reconciliation > Discovery models and open a model.
2. Clear the **Software model** field.
3. Click an entry in the **Publisher** column.
4. Click **Match model**.
   The system searches for the best match from existing models. If a match is found, the system automatically adds the name to the **Software model** field and selects the **Automatically matched** check box. If a match is not found, a **No match found** message is displayed, and two related links appear, allowing you to create a new model. No change occurs if the system has already made a match.
5. If no match is found, create a new model.
   If a model is already matched, then the automatic matching feature does not run.
   The automatic matching feature can also be used when you insert a new discovery model record or if you modify and update an existing discovery model. If automatic matching is run, all software installations and usages that reference the discovery model will have their **Inferred suite** and **Cached** fields cleared.
   For more information on software installation and usage records, see *Determine where software is installed*.

**Create new models**
If the automatically generated software model is not correct or if the system cannot find a match from existing models, you can create a new model.

Role required: sam
1. Navigate to **Software Asset > Reconciliation > Discovery models** and open a model.
2. Clear the **Software model** field.
3. Save the record.
   Two related links appear for creating software models.
4. Select one of these related links to create a new model, which are available only if no **Software model** is specified.
   
   - **Create Software Model**: Creates a new software model for this record if a suitable one does not already exist. You can create a new software model for multiple records in the Discovery Models list view. Select one or more records and then click the link in the **Actions** choice list.
   
   - **Create Software Model and Counter**: Creates a new software model and a new software counter for this record. The system creates the software model automatically using the value in the **Display name** field, and then opens a new Software Counter form. In the Discovery Model list view, you can select multiple records and choose this option from the **Actions** choice list.

5. Complete the form.

**Model fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>(Read-only) Name of the discovery model as it appears in record lists.</td>
</tr>
<tr>
<td>Publisher</td>
<td>(Read-only) Publisher of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>(Read-only) Specific version of the software.</td>
</tr>
<tr>
<td>Revision</td>
<td>(Read-only) Revision number of the software.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Software model</td>
<td>Software product model to which the discovery model maps. Click the reference lookup icon and use the lookup list to find the software model to associate with this software discovery model.</td>
</tr>
<tr>
<td>Prod id</td>
<td>(Read-only) Product ID code for the software, as reported through the discovery process.</td>
</tr>
<tr>
<td>Automatically matched</td>
<td>(Read-only) Check box that indicates whether the discovery tool used the Display Name, Publisher, and Version fields to determine the Software model.</td>
</tr>
<tr>
<td>Approved</td>
<td>Check box that indicates whether the mapping to software model has been reviewed and approved.</td>
</tr>
<tr>
<td>Low confidence</td>
<td>(Read-only) Check box that indicates whether the automatically matched software model is not a close match. If selected, and if after reviewing the item it is determined that it's the correct software model, click Confirm Mapping to match the discovery model to the software model.</td>
</tr>
</tbody>
</table>

6. Select **Approved**.

![Software Discovery Model](image)

**SAM match model**

7. Click **Submit**.
**Software License Compliance Checker**

The Software License Compliance Checker is a fast way to see if the software licenses used in your organization are compliant based on number of rights purchased and number of installations.

For example, if there are 100 licenses for a software program, the Software License Compliance Checker can show if the software has been installed more than 100 times. The Compliance Checker uses information found by a discovery tool such as Discovery, Help the Help Desk, or third-party technologies, to analyze the software installed on your network.

*Use the Software License Compliance Checker*

You can check software license compliance.

Role required: sam

1. Navigate to Software Asset > System > Check License Compliance.
2. Click **Proceed**.
   
   Your organization's network is analyzed for name, software model, rights, installs, license type, and active status.

3. View the results.
   
   The Software Counters list is color coded.
   
   - Green - in compliance
   - Orange - within 5% of being out of compliance
   - Red - not compliant
Use counters for software license reconciliation

Software counters reconcile software rights with software installations to verify compliance.

For asset managers, software counters answer the question: Is my number of installations equal to or lower than the number of rights purchased? Counters are useful for software that must
be tracked; some software may not need to be tracked closely. Grouping—such as location, company, department, cost center, entitlement workstation and entitlement user—or no grouping can be used with software counters.

In addition to software counters, Software Asset Management plugin offers usage counters that track a license based on use by a workstation or user.

The software counter cache is used to increase the speed of counting software licenses. If there is a large number of software license records, the first time software is counted takes several minutes. After the first count, only changes are processed so the procedure is faster.

Get started with software counters
A good way to see how software counters work is to use the demo data provided with Software Asset Management plugin.

Load the demo data on a non-production instance.

Using the demo data, try some of the procedures on this page, such as Use the Software Counter and View a Usage Counter Result.

To use software counters with your own information, follow the steps in the Software Asset Management plugin setup process. ServiceNow Discovery does not populate the Software Usage (cmdb_sam_sw_usage) table. Use a third party tool such as Microsoft’s System Center Configuration Manager to add information about software assets to the Software Usage table.

Schedule a software count
How to schedule a software count.

The SAM License Counters scheduled job scans your instance for software installations. The SAM License Counters job occurs at 2:00am local time every morning. The job queries the Software Installation (cmdb_sam_sw_install) table and captures any installations that have not been scanned in the past 7 days. The job runs a join query on hardware that has been scanned within the last day and software installations that have not been scanned in the last 7 days.

The SAM License Counters scheduled job runs all software counters at once.

To refresh the cache manually for a specific counter:
1. Navigate to Software Asset > Reconciliation > Software Counters.
2. Select a counter whose cache you want to refresh.
3. Right-click in the header bar of the Software Counter record and select Rebuild SAM Cache from the context menu.
Use the software counter

Use a software counter to count the licenses for a specific version of software and receive summary or detailed results.

When a software counter runs for the first time, it can take several minutes to process records. The license counts are cached so that on subsequent runs, the counter processes only changed records, both those from Discovery or altered entitlements, making it faster. The Software Counter form contains check boxes to enable faster counting through the use of quick counters. For more information on using quick counters, see Setting Up Quick Counters.

Use a software counter to count the licenses for a specific version of software and receive summary or detailed results. For example, an asset manager can look at summary information to discover which departments are not in compliance. Then, department managers can look at detailed information to determine the people or individual computers that are not in compliance.

Software counters return results by Licensing Type:

- **Entitled in use**: Number of people who have been allocated a license and installed the software.
- **Entitled not in use**: Number of people who have been allocated a license but did not install the software.
- **Not entitled**: Number of people using an unauthorized copy of the software.
- **Not allocated**: Number of licenses not assigned.
Note: For information about the scheduled job that runs all counters each day or the steps to run all counters manually, see Scheduling Software Counts.

The Software Counters list is color coded:
- Green - in compliance
- Orange - within 5% of being out of compliance
- Red - not compliant

SAM software license compliance check

Create a software counter
How to create a software counter.

Depending on the license type you select for a counter, multiple installations can count as a single license, such as when using the per user license type. This licensing concept is used on occasion by companies like Microsoft and Adobe. It grants users the right to install software on multiple machines if those users already have rights to install the software.

Note: You can create new counters from Discovery model records or from the list view.
To manage multiple versions of software from a single licensing perspective for the parent software model:

- The downgrade child software models that are licensed under the parent software model should all be related to the single parent software model.
- The downgrade child software models should not have any software counters associated with them.
- The software counter should be associated only with the licensed parent software model, otherwise misleading results for the counter will be reported.

To create a software counter:

1. Navigate to **Software Asset > Reconciliation > Software Counters**.
2. Click **New**.
3. Fill in the fields on the Software Counter form (see table).
4. Click **Submit**.
5. Reopen the new counter and click **Count Licenses**.
6. Reload the form to view the **counter results**.

**Software counter form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><em>(Required)</em> Enter the name of the software counter as it appears in record lists.</td>
</tr>
<tr>
<td>Software model</td>
<td><em>(Required)</em> Click the reference lookup icon and select the software model for which the counter will check compliance.</td>
</tr>
<tr>
<td>Contract</td>
<td>Select the contract that you want to use to limit the license. Used for enterprise and subscription-based licenses. Also restricts how counters retrieve licenses for the given counter. If left empty, all licenses for the model are counted.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to have the scheduler run the counter.</td>
</tr>
<tr>
<td>Rights Owned</td>
<td><em>(Read-Only)</em> Displays a summation if a contract is specified. The total sum is the license rights provided by all the licenses for the software model (of the counter) under the specified contract. If no contract is specified, this field is a count of all licenses of this model.</td>
</tr>
<tr>
<td>Rights Used</td>
<td><em>(Read-Only)</em> Displays the number of rights used by all installs, whether a contract is specified or not.</td>
</tr>
<tr>
<td>Immediate compliance</td>
<td><em>(Read-Only)</em> Displays the number of additional rights needed to achieve compliance based on installations.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Grouping</td>
<td>Select the field for grouping data:</td>
</tr>
<tr>
<td></td>
<td>· Location: group by the geographic location set in the license record.</td>
</tr>
<tr>
<td></td>
<td>· Company: group by the company set in the license record.</td>
</tr>
<tr>
<td></td>
<td>· Department: group by the department set in the license record.</td>
</tr>
<tr>
<td></td>
<td>· Cost Center: group by the cost center set in the license record.</td>
</tr>
<tr>
<td></td>
<td>· Entitlement (CPU): group by the condition defined in the Allocated condition field of the license record.</td>
</tr>
<tr>
<td></td>
<td>· Entitlement (User): group by the condition defined in the Assigned condition field of the license record.</td>
</tr>
<tr>
<td></td>
<td>The software counter results also displays counts for licenses that do not match the grouping parameter.</td>
</tr>
<tr>
<td>Enforce to</td>
<td>(Required) Select the level of adherence to the license:</td>
</tr>
<tr>
<td></td>
<td>· License: counts all existing entitlements for the installations or usage you are analyzing regardless of the grouping parameter selected.</td>
</tr>
<tr>
<td></td>
<td>· Strict: counts the license and entitlement as valid only if the license also matches the grouping category. For example, a license is assigned to a specific location, such as Americas. With strict enforcement enabled, the user and the machine on which the license is installed must be in the Americas group. If the person and their license assigned to the Americas group moves to the United Kingdom, the license is still valid, but strict enforcement flags the user as unauthorized to use that license. The license will be counted as valid, but will also show up as not entitled in the summary.</td>
</tr>
<tr>
<td>Verify entitlements</td>
<td>Select the check box to view the software entitlement details for the software counter. Results include the number of installations of all types: not entitled, entitled in use, entitled not in use, and not allocated. For more information, see <a href="#">Setting Up Quick Counters</a>.</td>
</tr>
<tr>
<td>Generate details</td>
<td>Select the check box to generate the details of the entitlement records. For more information, see <a href="#">Setting Up Quick Counters</a>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>License type</td>
<td>(Required) Select the method for counting licenses. For example, Per named user or Per workstation. For more information, see License Calculation Types.</td>
</tr>
<tr>
<td>Installs per license</td>
<td>Enter the number of installations allowed (one or more) per license for each user if the License type is set to By number of users. You can allow more than two installations per license. For all other license types this field is set to 1 install per license.</td>
</tr>
<tr>
<td>Cached</td>
<td>(Read-Only) Shows whether this option is selected. If selected, only changed information is counted, reducing the amount of time it takes to count the licenses.</td>
</tr>
<tr>
<td>License condition</td>
<td>Specify the condition a license should satisfy in order to be counted.</td>
</tr>
<tr>
<td>Software install condition</td>
<td>Specify the condition an install record should satisfy in order to be counted. This field appears depending on the value of the License type field.</td>
</tr>
<tr>
<td>Software usage condition</td>
<td>Specify the condition a usage record should satisfy in order to be counted. This field appears depending on the value of the License type field.</td>
</tr>
</tbody>
</table>

**Related Lists**

- **Software Counter Results**: Displays all results for this software counter.
- **Software Counter Compliance Violations**: Displays all records of compliance violations for this software counter.
- **Software Counter Histories**: Displays all software counter history records for this software counter. Each time a count is completed, the system automatically generates a software counter history record, which is a read-only copy of the software counter record.

**Note**: A message is displayed at top of the software counter form indicating if a license count is in progress. Reload the form to view the counter results.

**Set up quick counters**

Quick counter settings can help speed up the software counting process.

The following check boxes are available in the Parameters section of the Software Counter form:

- **Verify entitlements**: When this check box is selected, the software counter will generate entitlement details in the software counter summaries, displaying the number of entitlements
in use and entitlements not in use. If the check box is cleared, the software counter will display **Entitlement not known** with a count of total installs. The counter will not check for entitlements.

- **Generate details**: When this check box is selected, the software counter will generate **software counter details** for each software counter result type. If the check box is cleared, no details will be available.

Clearing these check boxes in addition to setting the **Grouping** parameter to **None** will enable software counters to run more quickly.

**View a software counter result**
Software counter results provide detailed information about each grouping.

To view software counter results:

1. On the Software Counter form, click a name in the **Software Counter Results** related list.

   ![SAM software counter results](image)

   **SAM software counter results 2**

   2. View the Software Counter Result form (see table).

   All fields on the form are read-only.
### SAM software counter results 3

#### Software counter result form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software counter</td>
<td>Name of the software counter whose results are displayed.</td>
</tr>
<tr>
<td>Grouping</td>
<td>Grouping this software belongs to.</td>
</tr>
<tr>
<td>Parent</td>
<td>Name of the parent software, if one exists, assigned to this software.</td>
</tr>
<tr>
<td>Rights</td>
<td>Number of rights available in the group.</td>
</tr>
<tr>
<td>Installs</td>
<td>Number of rights used by installations of the software in the group.</td>
</tr>
<tr>
<td>Immediate compliance</td>
<td>Number of additional rights needed for the group to achieve compliance based on installations.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Planned compliance</td>
<td>Number of additional rights needed for the group to achieve compliance based on installations and number of unused entitlements available.</td>
</tr>
</tbody>
</table>

**Usage Section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foreground</td>
<td>Total duration of foreground usage of the software, based on all the installations for the group.</td>
</tr>
<tr>
<td>Background</td>
<td>Total duration of background usage of the software, based on all the installations for the group.</td>
</tr>
<tr>
<td>Times used</td>
<td>Total number of times the software was used, based on software usage records for the group.</td>
</tr>
<tr>
<td>Duration</td>
<td>Total duration of software usage, based on software usage records for the group. (Not the sum of Foreground and Background.)</td>
</tr>
</tbody>
</table>

**Related List**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>Breakdown of software counter results by type. Click a type to view a detailed summary.</td>
</tr>
</tbody>
</table>

**View a software counter summary**

Software counter summaries provide information about each software counter type.

To view a software counter summary:

1. On the Software Counter Result form, click a type in the **Summary** related list.
2. View the Software Counter Summary form (see table).
   - All fields on the form are read-only.
SAM software counter results

### Software counter summary

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software counter result</td>
<td>Name of the software counter result for which the summary is displayed.</td>
</tr>
<tr>
<td>Count as</td>
<td>The software model being counted.</td>
</tr>
<tr>
<td>Rights</td>
<td>Number of rights that have been used.</td>
</tr>
<tr>
<td>Valuation</td>
<td>How software is counted during the reconciliation process.</td>
</tr>
<tr>
<td>Software counter</td>
<td>Name of the software counter.</td>
</tr>
<tr>
<td>Summary</td>
<td>Check box that indicates whether the form displays summary information (selected) or detailed information (cleared).</td>
</tr>
<tr>
<td>Type</td>
<td>Type of license counted.</td>
</tr>
</tbody>
</table>

### Usage Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foreground</td>
<td>Total duration of foreground usage of the software, based on all the installations for the grouping.</td>
</tr>
<tr>
<td>Background</td>
<td>Total duration of background usage of the software, based on all the installations for the grouping.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Times used</td>
<td>Total number of times the software was used, based on software usage records for the grouping.</td>
</tr>
<tr>
<td>Duration</td>
<td>Total duration of software usage, based on software usage records for the group. (Not the sum of Foreground and Background.)</td>
</tr>
</tbody>
</table>

### Related List

| Software Counter Details | Shows every entitlement, software install, and software usage for the software. The related list also shows the Workstation and User, if applicable, for each software counter detail. A software asset manager can, for example, identify people who are using the license but are not entitled. The software can then be uninstalled from machines that are not in compliance or people can be entitled a license to meet compliance rules. Click a type to view the *software counter detail*. |

**View software counter detail**

Software counter details provide information about a specific software counter summary.

To view a software counter detail:

1. On the Software Counter Summary form, click a type in the **Software Counter Details** related list.
2. View the Software Counter Detail form (see table).
   - All fields on the form are read-only.
### Software counter detail form

#### Software counter detail

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Type of the counter detail.</td>
</tr>
<tr>
<td>Software install</td>
<td>Name of the related software install record, if applicable. This field is blank if the type is Entitled not in use or Not allocated.</td>
</tr>
<tr>
<td>Software usage</td>
<td>Name of the related software usage record, if applicable.</td>
</tr>
<tr>
<td>Software counter</td>
<td>Name of the related software counter.</td>
</tr>
<tr>
<td>Software counter summary</td>
<td>Name of the related software counter summary.</td>
</tr>
<tr>
<td>Valuation</td>
<td>A valuation of 1 indicates that the license right is being used. A valuation of 0 indicates that the license right is part of a software suite, or that the license allows more than one installation per right. The 0 indicates that this installation does not count against the license.</td>
</tr>
<tr>
<td>Entitlement</td>
<td>Name of the related software license entitlement, if applicable. This field is blank if the type is Not entitled or Not allocated.</td>
</tr>
<tr>
<td>Software license</td>
<td>Name of the related software license, if applicable. This field is blank if the type is Not entitled.</td>
</tr>
</tbody>
</table>

#### Usage Section
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foreground</td>
<td>Total duration of foreground usage of the software, based on the related software install record.</td>
</tr>
<tr>
<td>Background</td>
<td>Total duration of background usage of the software, based on the related software install record.</td>
</tr>
<tr>
<td>Times used</td>
<td>Total number of times the software was used, based on the related software usage record.</td>
</tr>
<tr>
<td>Duration</td>
<td>Total duration of foreground and background software usage, based on the related software usage record.</td>
</tr>
</tbody>
</table>

**View a usage counter result**

A usage counter tracks a license based on how often the license is actually used either by a workstation or a user.

A usage counter tracks a license based on how often the license is actually used either by a workstation or a user. For example, an asset manager can use a usage counter to determine who is actually using the software they have been entitled. If an individual is not using the software at all or very infrequently, the software can be uninstalled and given to an individual who will use it more often. If you have a way of capturing information, for example a proxy server or gateway, you can capture the IP address and the name of the user accessing the license. The captured data can be added directly into the Software Usages list.

1. Navigate to **Software Asset > Discovery > Software Usages**.
2. Click the **Display Name** in the row containing the software and user to check.
3. View the **Software Usage** form (see table).

   All fields on the form are read-only.
SAM software usage

Software usage form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the software usage record.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software.</td>
</tr>
<tr>
<td>Discovery model</td>
<td>Software discovery model associated with the installed software.</td>
</tr>
<tr>
<td>Primary key</td>
<td>Unique identifier for table row.</td>
</tr>
<tr>
<td>Usage</td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>User who accessed the software.</td>
</tr>
<tr>
<td>Accessed from</td>
<td>Hardware configuration item from which the software was accessed.</td>
</tr>
<tr>
<td>Last scanned</td>
<td>Date and time when the software was last discovered on this hardware.</td>
</tr>
<tr>
<td>Duration</td>
<td>Duration of all usage.</td>
</tr>
<tr>
<td>Times used</td>
<td>Number of times the software was accessed from this hardware.</td>
</tr>
<tr>
<td>Last used</td>
<td>Date and time when the software was last used on this hardware.</td>
</tr>
<tr>
<td>Software counter</td>
<td></td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Counted by</td>
<td>The software counter summary record in the Software Counter Summary (sam_sw_counter_summary) table on which this usage is counted.</td>
</tr>
<tr>
<td>Entitlement</td>
<td>The entitlement rights of the software.</td>
</tr>
<tr>
<td>Valuation</td>
<td>Number of license rights used by this software usage.</td>
</tr>
<tr>
<td>Cached</td>
<td>If selected, indicates that a software count has already been cached.</td>
</tr>
</tbody>
</table>

### IBM PVU Process Pack

Processor Value Unit (PVU) is a unit of measurement defined by IBM to determine software licensing costs based on processor or server model.

A processor is defined as each core on a socket. Each software package has a price defined as number of points or PVUs per core. For a complete explanation of IBM PVU licensing for distributed software, see Processor Value Unit (PVU) licensing for Distributed Software on the IBM website.

In the Now Platform, the concept of PVU is used in the Software Asset Management plugin IBM PVU Process Pack, which is an add-on to the Software Asset Management plugin feature. It provides the ability to manage software licensed under the IBM Processor Value Units licensing model.

The Software Asset Management plugin Processor Definition Extension is automatically activated when the Software Asset Management plugin IBM PVU Process Pack is activated. It provides data model support for processor definitions and is required by all Software Asset Management plugin process packs.

**Note:** Oracle and Microsoft also use the concept of PVU, but have slightly different definitions.

### Activate the IBM PVU Process Pack

You can activate the Software Asset Management plugin - IBM PVU Process Pack plugin.

Role required: admin

1. Navigate to **System Applications > All Available Applications > All.**
2. Find the Software Asset Management plugin - IBM PVU Process Pack plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
Requirements to associate a software installation to PVU mapping
Meeting recommended requirements ensures that you receive the highest quality results with PVU mapping.

1. Use a discovery tool, such as ServiceNow Discovery, to identify hardware and populate the configuration management database (CMDB) with the configuration items you want to manage with IBM PVU licensing.
2. Use a discovery tool, such as ServiceNow Discovery, to identify software installations. Check that the added CPU information is correct.
3. Activate the Software Asset Management plugin - IBM PVU Process Pack plugin. This also activates the Software Asset Management plugin if it is not already active.
4. Refresh processor definitions.
5. Ensure that the software models you want to manage with IBM PVU licensing have the correct license type: **Per installation - IBM PVU**.
6. Create software counters to calculate IBM PVU licenses.
7. Count licenses to determine compliance with IBM PVU guidelines.

**IBM PVU mapping preparation**
Most IBM PVU mapping and license checking in the ServiceNow platform is managed automatically.

For the automatic calculations to be as accurate as possible, it is important that configuration item and software model information be accurate.

The important fields describing the processor on the configuration item form are:

- CPU type
- CPU count
- CPU core count
PVU configuration item

This CPU data is often added accurately when the CMDB is populated with information. If the fields contain incorrect information, manually edit the fields on the configuration item form.

The mapping between the configuration item form fields and processor definition fields is as follows.
Preparing for IBM PVU mapping

<table>
<thead>
<tr>
<th>Configuration Item Form Field</th>
<th>Processor Definition Form Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU type</td>
<td>Processor name, Server model number, and Processor model number</td>
<td>Combination of processor name, server model number, and processor model number. The <strong>CPU type</strong> field is created as part of the general process described in Populating the CMDB. Some discovery tools fill in the <strong>CPU name</strong> instead of <strong>CPU type</strong>. If the <strong>CPU type</strong> field is empty, the CPU name field is used for mapping instead. (You can configure the form to display the <strong>CPU name</strong>, if needed.) If the <strong>CPU type</strong> field and the CPU name field are both empty, no mapping is done.</td>
</tr>
<tr>
<td>CPU count</td>
<td>Number of sockets</td>
<td>Number of sockets.</td>
</tr>
<tr>
<td>CPU core count</td>
<td>Cores per socket</td>
<td>Cores per socket</td>
</tr>
</tbody>
</table>

The key field on the Software Model form is **License type**. For any software licenses you want to track with IBM PVU, open the corresponding software model form and select the **Per installation - IBM PVU** license type.
PVU software model

**Refresh processor definitions for Software Asset Management plugin**

After activating the Software Asset Management plugin IBM PVU Process Pack, use the Refresh Processor Definitions module in the Software Asset Management plugin feature to create process definitions for existing computers in the Computer (cmdb_ci_computer) table.

Role required: sam

After this step, business rules in SAM update the Processor Definition (CMDB_processor_definition) table automatically when changes are made to computers or when new computers are added.
You should not need to use the Refresh Processor Definitions module a second time, but it is always available if you make significant changes to the Computer (cmdb_ci_computer) table.

1. Navigate to Software Asset > System > Refresh Processor Definitions.
2. Click Proceed.

Processor definitions
Processor definitions are automatically derived from the information in the configuration item form for an item such as a computer or server.

To view a processor definition, navigate to Software Asset > Reconciliation > Processor Definitions and click an item.

![Processor Definition](image)

Processor definition

The following read-only fields are listed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the processor as it should appear in the processor list.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Company that built the processor.</td>
</tr>
<tr>
<td>Server model number</td>
<td>Number assigned to the model by the server manufacturer.</td>
</tr>
<tr>
<td>Number of sockets</td>
<td>Number of dies on the computer motherboard. The number of CPUs per die is specified by <strong>Cores per socket</strong>.</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM PVU Mapping</td>
<td>The IBM PVU mapping to which this processor is associated. The information in this field is automatically calculated from the server model number, number of sockets, processor name, and processor model number, based on the rules defined in the IBM PVU Table.</td>
</tr>
<tr>
<td>Processor name</td>
<td>Name assigned to the processor by the manufacturer.</td>
</tr>
<tr>
<td>Processor model number</td>
<td>Number assigned to the model by the processor manufacturer.</td>
</tr>
<tr>
<td>Cores per socket</td>
<td>Number of cores (functional unit needed to execute programs) on each physical connection (socket) on the motherboard.</td>
</tr>
<tr>
<td>Match level</td>
<td>Accuracy level of the association between processor and PVU mapping. Automatically set when association is inferred.</td>
</tr>
</tbody>
</table>

View IBM PVU mappings
Every rule listed in the IBM PVU Table is represented by one PVU mapping record in the Software Asset Management plugin feature.

Role required: sam

For example, in the IBM PVU Table there is one line with processor name POWER5 QCM and in IBM PVU mappings there is a line representing POWER5 QCM.
PVU mappings list

1. Navigate to **Software Asset > Reconciliation > IBM PVU Mappings.**
2. Click a **Short Description** for detailed information about the mapping.
The fields are for information only and cannot be edited.

**IBM PVU mappings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor names</td>
<td>Names of running processors. Processor names are separated by commas.</td>
</tr>
<tr>
<td>Model-based condition</td>
<td>Regular expression used to determine whether the server model number of a computer's processor definition matches that of the PVU entry.</td>
</tr>
<tr>
<td>Socket-based condition</td>
<td>Regular expression used to determine whether the number of sockets of a computer's processor definition matches that of the PVU entry.</td>
</tr>
<tr>
<td>Short description</td>
<td>A short description of this PVU mapping.</td>
</tr>
<tr>
<td>PVUs per core</td>
<td>Number of processor value units consumed (according to the IBM PVU chart) by each core.</td>
</tr>
<tr>
<td>Max cores</td>
<td>Maximum number of cores on the processor family, as shown in the IBM PVU Table (rightmost column under cores per socket).</td>
</tr>
<tr>
<td>Rule publication date</td>
<td>Date published by IBM on the PVU Rules table.</td>
</tr>
</tbody>
</table>
Use software counters to calculate IBM PVU licenses
To calculate IBM PVU licenses, you can create a software counter with the IBM PVU license type. For a given PVU software package, you only need to create the counter once and then it can be reused.

Role required: sam

Processor definitions are searched as licenses are counted. If a processor definition is found, but no PVU mapping link exists for the processor, the system automatically does the following to obtain a PVU mapping link.

- Pre-filtering based on processor name.
- Advanced filtering based on PVU mapping records' condition field.
- If no exact match is found, the most expensive mapping is used to increase the chance of being compliant.

1. Navigate to Software Asset > Reconciliation > Software Counters.
2. Click New.
3. Enter a Name.
4. Select a Software Model.
5. Select a level of adherence to the license in the Enforce to field.
6. For License type, select Per Installation - IBM PVU.
7. Add information to other fields as necessary.
8. Right-click the header bar and select Save.
9. Click Count licenses.
10. In the **Software Counter Results** list, drill down to obtain summary and detailed information.
Installed with Software Asset Management plugin IBM PVU Process Pack
The following tables, fields, script includes, and business rules are installed with Software Asset Management plugin IBM PVU process pack.
Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor Definition (cmdb_processor_definition)</td>
<td>Each row in this table describes a computer in terms of the attributes IBM uses for its PVU licensing model. A row can be associated with one or more (if they are all identical in terms of the attributes used for PVU licensing) discovered computers.</td>
</tr>
</tbody>
</table>

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibm_pvu_mapping</td>
<td>Hardware (cmdb_ci_hardware)</td>
<td>PVU rule that applies to the software installation. Used for IBM PVU-based license counting.</td>
</tr>
<tr>
<td>ibm_pvu_mapping</td>
<td>Software Installation (cmdb_sam_sw_install)</td>
<td>PVU rule that applies to the software installation. Used for IBM PVU-based license counting.</td>
</tr>
</tbody>
</table>

Script includes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProcessorDefinitionsUtils</td>
<td>Contains utilities for managing the Processor Definition (cmdb_processor_definition) table.</td>
</tr>
<tr>
<td>ProcessorValueUnitsUtils</td>
<td>Contains logic that determines the IBM PVU pricing associated with a given processor.</td>
</tr>
</tbody>
</table>

Business rules

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One and only one default mapping [sam_ibm_pvu_mapping]</td>
<td>Ensures only one default mapping by resetting the last resort flag for modified records and setting it to false for new records.</td>
</tr>
</tbody>
</table>

Software contracts

A software contract is a binding agreement between the owner of a software product and a buyer. The contract enables the buyer to use the software legally.
In the base system, you can manage and track software contracts with the Contract Management application. When you create a new software contract, you can specify that the contract is an enterprise or subscription license.

**Create software contracts**
You can create a binding agreement that enables the buyer to legally use the software.

Role required: contract_manager

1. Navigate to **Contract > Software License**.
2. Click **New**.
3. Complete the form.
4. Add the software license to the contract.
   Be sure to use the **Software License** option. The **License Bundle** and **Software License Contracts** options are deprecated.

**Oracle process pack**
The Oracle process pack is an add-on to Software Asset Management plugin that provides the ability to manage software licensed under the Oracle licensing model.

Administrators can use this feature to perform the following functions.
- Identify the software packs installed on Oracle database servers.
- See the software packs that are currently in use.
- List which options are installed and in use.

**Oracle software counter**
There are two distinct ways of counting Oracle software. Be sure that your Oracle models are set up accurately.

![Note: Oracle license calculation types are available in the Software Counter form after you activate the Oracle process pack.](image)

Oracle software that uses the **Oracle Processor** license calculation type counts by the number of processors on a server. This license calculation type must exist in the Software Installation (cmdb_sam_sw_install) table. A software installation record must be inserted with a discovery model that matches the correct Oracle software. For an install to be counted by an Oracle processor counter, the **Installed on** field on the Software Installation form should reference a configuration item with a **Metric type** of **Oracle Processor**.

Oracle software that uses the **Oracle Named User** or **Oracle Named User Plus** license calculation types count by number of unique users or number of unique users plus devices. This license calculation type must exist in the Software Usage (cmdb_sam_sw_usage) table. A software installation record must be inserted with a discovery model that matches the correct Oracle software. For a usage to be counted by an Oracle New User or Oracle New User Plus counter, the **Target host** field on the Software Usage (cmdb_sam_sw_usage) table should reference a configuration item with a **Metric type** of **Oracle NU** or **Oracle NUP**.

**Oracle software models**
In order to count Oracle software licenses, you must create software models for your Oracle software.

For more information, see **Manage software models**.

Request the Software Asset Management plugin Oracle Process Pack
The Software Asset Management plugin - Oracle Process Pack (com.snc.sam.oracle.pp) plugin must be activated by ServiceNow personnel.
Role required: admin

The Software Asset Management plugin activates all related plugins.

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the request form on HI.

3. On HI, select to be redirected to the HI Service Portal Service Catalog.
4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click **Submit**.

*Installed with the Oracle Process Pack*

Activating the Oracle Process Pack plugin adds certain components.

The information from this table appears in the Software Counter Compliance Violations section of the Software Model form.
### Software counter compliance violations table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| Software Counter Compliance Violations (sam_sw_counter_violation) | Used to store counter violations that are due to violations other than installs exceeding rights, such as:  
- Maximum CPU/user count exceeded (based on model limits)  
- Maximum or minimum rights rules not followed (based on model limits)  
- Option installed on a server with a non-option-supporting license (Oracle) |

<table>
<thead>
<tr>
<th>Field</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software counter (counter)</td>
<td>Software Counter Compliance Violations (sam_sw_counter_violation)</td>
<td>References the software counter that this violation belongs to. (Reference field to Software Counter table (sam_sw_counter).)</td>
</tr>
<tr>
<td>Cause (name)</td>
<td>Software Counter Compliance Violations (sam_sw_counter_violation)</td>
<td>An explanation of the violation.</td>
</tr>
<tr>
<td>Is an option (is_option)</td>
<td>Software Model (cmdb_software_product_model)</td>
<td>Indicates if the software model is an option or pack for some other software, such as Active Data Guard or Data Mining options for Oracle Enterprise Edition. This field only appears if the manufacturer is Oracle.</td>
</tr>
<tr>
<td>License metric (metric_type)</td>
<td>Software License (aim_license)</td>
<td>A glide list reference to the License Calculation (cmdb_sw_license_calculation) table. This list contains all of the license calculations that apply to this license and identifies the preferred metric types to use when running software counters.</td>
</tr>
<tr>
<td>Field</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>License metric (metric_type)</td>
<td>Hardware (cmdb_ci_hardware)</td>
<td>A glide list reference to the License Calculation (cmdb_sw_license_calculation) table. This list contains all of the license calculations that apply to this license, and identifies the preferred metric types to use when running software counters. This field does not appear on the form by default.</td>
</tr>
</tbody>
</table>

The Oracle Process Pack adds the following license calculation types.

**Oracle license calculation types**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Named User</td>
<td>Oracle licensing scheme that counts by the number of unique users.</td>
</tr>
<tr>
<td>Oracle Named User Plus</td>
<td>Oracle licensing scheme that counts by the number of unique users and devices.</td>
</tr>
<tr>
<td>Oracle Processor</td>
<td>Oracle licensing scheme that counts by the number of processors on a server.</td>
</tr>
</tbody>
</table>

Create an Oracle software license

To use the Oracle process pack, you must create an Oracle software license.

Role required: sam

1. Navigate to **Software Asset > Software Licenses**.
2. Click **New**.
3. Select **Software License** in the **Model category** field.
4. Select an Oracle model in the **Model** field.

   The Oracle models in this list are created by the user. For more information, see *Manage software models*.

5. Ensure that the **License metric** field specifies the correct license calculation type.
6. Fill in the remaining fields, as appropriate.
7. Click **Submit**.

Validate the requirements to associate a software installation to Oracle mapping

Meeting recommended requirements ensures that you receive the highest quality results with Oracle mapping.

1. Use a discovery tool (such as ServiceNow Discovery) to identify software installations. Check that the added CPU information is correct.
2. **Activate** the Software Asset Management plugin - Oracle Process Pack plugin. This also activates the Software Asset Management plugin if it is not already active.
3. Refresh processor definitions by navigating to **Software Asset > System** and clicking **Refresh Processor Definitions**.
4. Ensure that the software models you want to manage with Oracle licensing are set up accurately. See Creating a software model.

5. Create a software license for your Oracle software. Ensure that the license is given the correct license metric.

   The License metric (metric_type) field on the Software License table is a reference field to the License Calculation table.

6. Create a software counter to calculate Oracle licenses with the matching license type.

7. Count licenses to determine compliance with Oracle guidelines.

**Run the Oracle software counter**

Running the Oracle software counter is a requirement to associate a software installation to Oracle mapping.

Role required: sam

1. Navigate to Software Asset > Reconciliation > Software Counters.
2. Click the name of the counter.
3. Click Count Licenses.

   You can view different types of software counter results.

---

**Software Asset Management Foundation plugin**

The Software Asset Management Foundation plugin activates the ITSM Software Asset Management feature provided with the Asset Management application.

Software Asset Management Foundation plugin systematically tracks, evaluates, and manages software licenses and compliance. Functionality consists of these main features.

<table>
<thead>
<tr>
<th>Feature area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard</td>
<td>The Software Asset Management Foundation dashboard shows software installation results for your environment in the form of statistics and charts.</td>
</tr>
<tr>
<td>Licensing</td>
<td>Software models created for all installed software products are used to tie software installations (software being used) with entitlements (software owned). Entitlements define license details and are assigned to software models.</td>
</tr>
<tr>
<td>Discovery and normalization</td>
<td>A discovery process, such as Discovery or Microsoft SCCM, can be used to discover the software installed in your environment. An OOB Normalization library contains publisher and product content. Custom products can be created if a software product does not exist in the Software Library. Discovered software can be manually normalized for reconciliation.</td>
</tr>
<tr>
<td>Reconciliation</td>
<td>The reconciliation process calculates the compliance status of software products with respect to discovery and entitlements. Remediation options are created to resolve compliance issues.</td>
</tr>
</tbody>
</table>

**Request Software Asset Management Foundation plugin**

The Software Asset Management Foundation (com.snc.sams) plugin must be activated by ServiceNow personnel. This plugin includes demo data.

Role required: admin

There are two ways to request a plugin:
• Access the HI Service Catalog directly by clicking **Service Catalog > Activate Plugin** on HI.
• Access the HI Service Catalog through the All Applications page on your instance by following these steps.

1. Navigate to **System Applications > All Available Applications > All.**
2. On the All Applications page, click **Request Plugin** to open the request form on HI.

3. On HI, select to be redirected to the HI Service Portal Service Catalog.
4. **On the Activate Plugin request form, fill in the fields.**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>this plugin to be enabled</td>
<td></td>
</tr>
</tbody>
</table>
| Note:                                      | Plugins are activated in two batches each business day in the Pacific time |}
|                                             | zone, once in the morning and once in the evening. If the plugin must be |}
|                                             | activated at a specific time, enter the request in the Reason/Comments      |
|                                             | field.                                                                      |
| Reason/Comments                            | Information that would be helpful for the ServiceNow personnel who are      |
|                                             | activating the plugin. For example, if you need the plugin activated at     |
|                                             | a specific time instead of during one of the default activation windows,    |
|                                             | specify it in the comments.                                                |

5. **Click Submit.**

*Set up Software Asset Management Foundation plugin*

Set up Software Asset Management Foundation plugin before configuration.

Role required: sam_admin

Once you have requested Software Asset Management Foundation plugin and it has been activated from ServiceNow personnel, complete these steps to set up Software Asset Management Foundation plugin before you begin to use it.

1. **Determine whether you are currently running the ITSM Software Asset Management feature of Asset Management using the Software Asset Management plugin.**

Check the list of plugins to see if the Software Asset Management (com.snc.software_asset_management) plugin is active.

- If so, complete the Software Asset Management Foundation plugin migration procedure.
This step automatically converts and adds new tables, forms and lists, fields and values, and disables deprecated functionality. It also contains manual procedures for you to complete for successful migration.

- If not, proceed to the next step.

2. Determine whether Discovery is activated.
   Check the list of plugins to see if the Discovery plugin is active.
   - If so, run the Migrate SAM Foundation software installations script.
     This step copies records from the (cmdb_ci_spkg) table to the (cmdb_sam_sw_install) table, so that any previously discovered software installs are utilized by the Software Asset Management Foundation plugin.
   - If not, activate and configure Discovery.
     For more information, see Discovery.

3. Proceed to Get started with Software Asset Management Foundation plugin to begin using the Software Asset Management Foundation plugin in your environment.

Get started with Software Asset Management Foundation plugin
Get started with Software Asset Management Foundation plugin to optimize management of software installations in your environment.
Role required: sam_admin
After you have Set up Software Asset Management Foundation plugin, get started by completing these steps for basic configuration.

1. Create a software model for common software, such as Microsoft Office 2013, for example.
   a) Navigate to Software Asset > Licensing > Software Models.
   b) Create a new record (see table for field descriptions).

   Software model form

<table>
<thead>
<tr>
<th>Field</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher</td>
<td>Microsoft</td>
</tr>
<tr>
<td>Product</td>
<td>Office</td>
</tr>
<tr>
<td>Discovery Mapping</td>
<td>Office</td>
</tr>
<tr>
<td>Version</td>
<td>2013</td>
</tr>
<tr>
<td>Edition</td>
<td>Professional Plus</td>
</tr>
<tr>
<td>Platform</td>
<td>Windows</td>
</tr>
<tr>
<td>Language</td>
<td>Anything</td>
</tr>
</tbody>
</table>

2. Create a basic per-user or per-device entitlement for the software.
   a) Open the software model record you created.
   b) Scroll down to the Software Entitlements related list, and create a new Software Entitlements record (see table for field descriptions).

   The Software model field is automatically populated.
3. After discovery of software installed, run reconciliation to reconcile software rights owned against software installed, with respect to discovery and software entitlements.
   a) Navigate to **Software Asset > Reconciliation > Run Reconciliation**.
   b) Select the publisher on which to run reconciliation, or select all publishers, and click **Proceed**.
      Allow time for the reconciliation process to complete, especially if you selected all publishers.

4. View reconciliation results that show the compliance status of your software products.
   a) Navigate to **Software Asset > Reconciliation > Reconciliation Results**.
   b) Open the reconciliation result record to view product results.
   c) Open product result records to view compliance status of specific software models, such as number of unlicensed installs and the true-up cost to become compliant.
   d) Open a software model result to view license metric compliance, such as rights owned and used.
   e) Drill down further into the license metric results to view how rights are used, and software installs using the rights.

Depending on the compliance status of your software installations, you can choose to optimize your environment further.

**Software Asset Management Foundation plugin roles**

Software Asset Management Foundation plugin adds the following roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sam_admin</td>
<td>Inherits the sam_user role and has permission to run reconciliation and manage reclamation rules.</td>
</tr>
<tr>
<td>sam_user</td>
<td>Able to access all features except administrative.</td>
</tr>
</tbody>
</table>

Users with the sam_user or sam_admin role can view and refresh the overview page.

**Software Asset Management Foundation dashboard**

View compliance and true-up cost trend charts on the Software Asset Management Foundation dashboard.
The Software Asset Management Foundation dashboard is accessed by navigating to Software Asset > Overview. Click an element within a report to see more information, or add and move widgets as needed.

Results are updated daily, or whenever a new reconciliation result is available, and can be refreshed by clicking the Refresh icon for each result. You can also save charts in PNG or JPG formats.

The source for overview data is the Product Result (samp_product_result) table.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishers out of Compliance</td>
<td>Number of publishers that have at least one software model out of compliance.</td>
</tr>
<tr>
<td>Products out of Compliance</td>
<td>3</td>
</tr>
<tr>
<td>Total True-up Cost</td>
<td>$12,649.66</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Products out of Compliance</td>
<td>Number of products that have at least one software model out of compliance.</td>
</tr>
<tr>
<td>Total True-up Cost</td>
<td>Cost to be compliant based on the average prices in entitlements for the rights.</td>
</tr>
<tr>
<td>Top 10 Products by True-up Cost</td>
<td>Top 10 products graphed in order of true-up cost.</td>
</tr>
</tbody>
</table>

**SAM Foundation license management**

You can set up software entitlements that are used during reconciliation to compare software rights owned to software installed, including those for named users, devices, and cores.

Software licenses are based on *models* that you create to organize software licenses in meaningful ways. Different license metric calculations determine how software is counted.

Software licenses can also be associated with a contract which enables a company to cover software licenses for multiple assets or users. You can manage and track software contracts using the *Contract Management* application.

Features include:

- Predefined suites mean suite components can be automatically created for known suite parent software models. Discovery maps indicate whether a suite is defined for the product.
- Software rights can be applied according to the conditions set in the software discovery map to filter out specific software installations that do not require a license. For example, production server installations versus failover server installations.
- Software lifecycle phases can be input for use with the *Technology Portfolio Management* feature of Application Portfolio Management to help manage the lifecycle of software that supports business applications.

**Software entitlements**

Software asset managers can allocate one or more rights to a user or device to use certain software.

For example, say a company purchases a software entitlement for 100 rights. From the software entitlement, 100 employee or machine allocations are created that are rightfully assigned a license. If Discovery finds the software installed on 200 machines, the software asset manager must identify the employees or machines that have the software installed without a license, and remediate the situation.

Built-in rules are used to help prevent allocating more rights than have been purchased. Asset tags can be used to track and identify specific software entitlements.

Benefits of using software entitlements:

- If the overall license entitlement is exceeded, the software asset manager can rapidly address the problem and return to compliant status by either removing unauthorized software or ordering more licenses.
- If the license entitlement is not being used completely, the software asset manager can respond by lowering the number of licenses purchased in the future.
Add a SAM Foundation software model
Software models are used to connect purchased software rights with discovered software installations. Additionally, software models can be used to manage suites of software as well as to publish requestable software to the Service Catalog.

Role required: sam_user or model_manager

Manage software available and tie software installations (software being used) with entitlements (software owned) using software models. Create software models for all software to be monitored.

Note: Users with the model_manager role can navigate to Product Catalog > Product Model > Software Models, but cannot administer all aspects of software models.

Predefined suites are used so suite components are automatically created for known suite parent software models. Discovery maps indicate whether a suite is defined for the product.

You can also track a software model lifecycle phase for use with the Technology Portfolio Management.

1. Navigate to Software Asset > Licensing > Software Models and create a new record (see table for field descriptions).

Software Model form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>(Read-only) Name of the model. The system property glide.cmdb_model.display_name.shorten controls how software model display names are generated. System administrators can configure this property. Default format is publisher + product + version + edition.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software. You can use the lookup list provided.</td>
</tr>
<tr>
<td></td>
<td>Note: Publisher is a reference to the company [core_company]. Only companies you are using internally are shown. If the publisher and product do not exist, you can Add a SAM Foundation custom license metric.</td>
</tr>
<tr>
<td>Product</td>
<td>Software product name. The same lookup list provided on the Software Discovery Models form.</td>
</tr>
<tr>
<td></td>
<td>Note: If the relationship between the software publisher [samp_sw_publisher] and company [core_company] is not correct, products for that publisher may not be shown.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Product classification</td>
<td>The official UNSPSC classification of the product.</td>
</tr>
<tr>
<td>Product type</td>
<td>- Child: A subcomponent of main software (not licensable).</td>
</tr>
<tr>
<td></td>
<td>- Driver: A software product that controls a device.</td>
</tr>
<tr>
<td></td>
<td>- Licensable: A software product that is licensable.</td>
</tr>
<tr>
<td></td>
<td>- Not Licensable: A software product that is not licensable.</td>
</tr>
<tr>
<td></td>
<td>- Patch: A software product designed to update, fix, or improve an existing computer program.</td>
</tr>
<tr>
<td></td>
<td>- Unknown: Not discovered.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the model.</td>
</tr>
<tr>
<td>Cost</td>
<td>The cost of a single unit of the software.</td>
</tr>
<tr>
<td>Next version</td>
<td>Reference to another software model of the same manufacturer which represents the next version of the product.</td>
</tr>
<tr>
<td>Owner</td>
<td>The person responsible for the model.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the model. Options are In Production, Retired, and Sold.</td>
</tr>
<tr>
<td>Certified</td>
<td>Check box for indicating the software model has been approved for use.</td>
</tr>
<tr>
<td>Discovery Mapping</td>
<td></td>
</tr>
<tr>
<td>Version condition</td>
<td>Condition qualifier for the Version field.</td>
</tr>
<tr>
<td></td>
<td>- starts with</td>
</tr>
<tr>
<td></td>
<td>- is</td>
</tr>
<tr>
<td></td>
<td>- is anything</td>
</tr>
<tr>
<td></td>
<td>Default is is anything.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software product. Required if version condition value is starts with or is.</td>
</tr>
<tr>
<td></td>
<td>- starts with</td>
</tr>
<tr>
<td></td>
<td>- is</td>
</tr>
<tr>
<td></td>
<td>- is anything</td>
</tr>
<tr>
<td></td>
<td>Default is is anything.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Edition**                   | Edition of the software product to use when searching for the normalized discovery model.  
Required if edition condition value is starts with or is.                                                                                                                                               |
| **Platform**                  | Platform of the software product to use when searching for the normalized discovery model.  
Default is --Anything-- for Windows, Mac, Unix.                                                                                                                                                      |
| **Language**                  | Language of the software product to use when searching for the normalized discovery model, which is populated once it has been normalized or added manually.  
Default is --Anything--.                                                                                                                  |
| **Software installation condition** | Only software installations that meet this software discovery map condition are counted during reconciliation.  
If needed, specify a subset of software installations that should be counted during reconciliation.                                              |
| **Product Catalog**           |                                                                                                                                                                                                 |
| **Catalog Item**              | The information about the model as it appears in the product catalog and service catalog.  
Information only appears if the model has been published to the product catalog.                                                                                                                  |
| **Description**               | Description of the software model as it appears in the product catalog.                                                                                                                                     |
| **Picture**                   | An image of the software logo can be added. This logo appears in the Service Catalog if the software model is published.                                                                                   |

The Suite Components and Suite Parents related lists consist of parent and child software suite configuration.

2.  
To publish the software model to the product catalog, under Related Links, click Publish to Software Catalog and select a category for the software model.  
The values set in the Product Catalog related list are published.

3.  
To show the list of discovery models that match the software publisher and product fields of the software model, under Related Links, click Show Matching Discovery Models.  
The Discovery Models list is opened in a new browser tab for your reference.

4.  
To perform additional configuration, select the new software model record in the Software Models list.  
a)  
In the Software Model Lifecycles related list, create a new record (see table for field descriptions).
### Software Model Lifecycle form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software model</td>
<td>(Read-only) Name of software model.</td>
</tr>
<tr>
<td>Lifecycle type</td>
<td>• Internal&lt;br&gt;• Publisher</td>
</tr>
<tr>
<td>Lifecycle phase</td>
<td>• Pre Release&lt;br&gt;• General Availability&lt;br&gt;Only shown when the Lifecycle type field is Internal.&lt;br&gt;• Upgrade&lt;br&gt;• End of Life&lt;br&gt;• End of Support&lt;br&gt;• End of Extended Support</td>
</tr>
<tr>
<td>Source</td>
<td>(Read-only) Internal (for new records created manually), or ServiceNow (when created automatically).</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the software model lifecycle.</td>
</tr>
<tr>
<td>Phase start date</td>
<td>Date the lifecycle phase starts.</td>
</tr>
<tr>
<td>Phase end date</td>
<td>Date the lifecycle phase ends.</td>
</tr>
<tr>
<td>Risk</td>
<td>• Very High&lt;br&gt;• High&lt;br&gt;• Moderate&lt;br&gt;• Low&lt;br&gt;• None</td>
</tr>
</tbody>
</table>

b) **Add a SAM Foundation software entitlement.**

c) **View SAM Foundation software model results.** The latest software model results are shown in the Software Model Results related list.

d) In the Metric Attributes related list, click a metric attribute to set the attribute value field (see table for field descriptions).

The Metric Attributes related list contains metric values set in software entitlements and is used for reconciliation (metric group, license metric, and software model combination).

### Metric Attributes form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software model</td>
<td>Software model associated with the metric attributes.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metric group</td>
<td>Grouping for the software metric (Common).</td>
</tr>
<tr>
<td>License metric</td>
<td>The license metric that the software license is counted against when reconciliation is run (per user, per device, for example).</td>
</tr>
<tr>
<td>Description</td>
<td>Attribute type description that is based on license metric value.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Attribute type for reconciling entitlements license metric.</td>
</tr>
<tr>
<td></td>
<td>· Maximum active OSEs per server</td>
</tr>
<tr>
<td></td>
<td>· Maximum installs per OSE</td>
</tr>
<tr>
<td></td>
<td>· Maximum installs per right: For Per User, Per Device, Per Named User, and Per Named Device.</td>
</tr>
<tr>
<td></td>
<td>· Maximum processors per right</td>
</tr>
<tr>
<td></td>
<td>· Minimum users per processor</td>
</tr>
<tr>
<td></td>
<td>· Minimum cores per processor</td>
</tr>
<tr>
<td></td>
<td>· Minimum cores per server</td>
</tr>
<tr>
<td>Attribute value</td>
<td>Value of the attribute (integer).</td>
</tr>
<tr>
<td>Attribute value is unlimited</td>
<td>Check box for setting the attribute as unlimited.</td>
</tr>
</tbody>
</table>

### Create a vendor catalog item.

Create and manage a SAM Foundation software suite

Create a suite and add the corresponding components to the suite so the rights that your organization owns are counted accurately during reconciliation.

**Role required:** sam_user or model_manager

A software suite is a group of related software offered as one unit. An example is the Microsoft Office Professional suite of office productivity software tools that includes PowerPoint, Word, Excel, Outlook, and Access.

For any software model, you have the option to specify whether the model is a suite (parent) or a component (child). A software model can be a component in multiple suites. For example, Microsoft Word is a component in Microsoft Office Standard and Microsoft Office Professional. Although you can set a single software model as both a suite and a component, software is not typically sold as nested suites.

Use the **Inference percent** and **Mandatory** fields when the suite parent is not defined in the install table.

- **Inference percent**: Specifies what percentage of the components in the suite must be installed for the software to be identified as a suite.
- **Mandatory**: Enforces whether a specific component in a suite must be installed to infer that the suite is installed. Choices are: Optional, Always Mandatory, Mandatory Group.

For example, say you specify the **Inference percent** as 80% and set the **Mandatory** field to **Always Mandatory** on Microsoft Access. These settings specify that Microsoft Access must be installed.
along with three out of four other products (Microsoft Word, Microsoft Excel, Microsoft PowerPoint, and Microsoft Outlook) to infer that Microsoft Office Professional is installed on a device.

When a suite parent is detected during reconciliation, the suite components do not count for the individual license.

**Note:** Users with the model_manager role can navigate to Product Catalog > Product Model > Software Models, but cannot administer all aspects of software models.

1. Navigate to Software Asset > Licensing > Software Models and open the software model record to add suite configuration to.
2. Configure the software model as a suite parent or child.
   - To make the software model a suite parent, in the Suite Components related list, create a record to specify the child software model to include in the suite (see table for field descriptions).

**Suite Components fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inference percent</td>
<td>The percentage of suite components that need to be present on a system to count as a suite. Used for suite management. Software installations on the same device and assigned to same user that meets the inference percent could be considered a suite. For example, if the inference percent for a suite of five products is set to 60% and three software installs on the same device, or assigned to the same user, are discovered, all three installations are considered a suite.</td>
</tr>
<tr>
<td>Suite child</td>
<td>The child product or products of the suite. For example, Microsoft Word and Microsoft Excel are child products of Microsoft Office.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Determines whether a suite component is optional, mandatory, or part of a mandatory group. Set to Always Mandatory if the software must be installed to count the model as a suite.</td>
</tr>
<tr>
<td>Suite relationship assumed</td>
<td>(Read only) Indicates that multiple software models exist for one or more of the suite components, therefore the relationship between suite parent and suite component was assumed. Review the created suite components to ensure the relationship is correct.</td>
</tr>
</tbody>
</table>

- To make the software model a suite child item, in the Suite Parents related list, create a record to add the parent software model to which this software must belong (see table for field descriptions).
## Suite Parents fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suite parent</td>
<td>The parent suites to which the software is assigned. For example, the parent suite for several common Microsoft products is a version of Microsoft Office.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Determines whether a suite component is optional, mandatory, or part of a mandatory group. Set to <strong>Always Mandatory</strong> if the software must be installed to count the model as a suite.</td>
</tr>
<tr>
<td>Suite relationship assumed</td>
<td>(Read only) Indicates that multiple software models exist for one or more of the suite components, therefore the relationship between suite parent and suite component was assumed. Review the created suite components to ensure the relationship is correct.</td>
</tr>
</tbody>
</table>

### Add a SAM Foundation software entitlement

Software entitlements enable you to define license details that are matched to software models.

Role required: sam_user

Software entitlements are stored in the Software Entitlement (alm_license) table.

**Note:** Entitlements are assigned to **Add a SAM Foundation software model**, which are different than software discovery models.

1. Navigate to **Software Asset > Licensing > Software Entitlements** and create a new record (see table for field descriptions).

## Software Entitlement form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Automatically generated name based on asset tag and model.</td>
</tr>
<tr>
<td>Asset tag</td>
<td>Specify the serial number and the bar code for tracking the asset.</td>
</tr>
<tr>
<td>Software model</td>
<td>Select the software model to match the entitlement.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>License type</td>
<td>Specify the license type. Whether the rights grant full access to the software or if they are being upgraded from a previous version of the software.</td>
</tr>
<tr>
<td></td>
<td>- Full: The rights grant full access to the software.</td>
</tr>
<tr>
<td></td>
<td>- Upgrade: The rights are being upgraded from a previous version of the software.</td>
</tr>
<tr>
<td></td>
<td>When upgrade is selected, the Upgraded Entitlements related list is shown, which is used to specify the entitlements you are upgrading from.</td>
</tr>
<tr>
<td></td>
<td>This field becomes read-only after the form has been submitted.</td>
</tr>
<tr>
<td>License duration</td>
<td>Length of time the license is valid. Default value is Perpetual.</td>
</tr>
<tr>
<td></td>
<td>- Perpetual: Duration is continuous.</td>
</tr>
<tr>
<td></td>
<td>- Subscription: Duration is for a specified length of time.</td>
</tr>
<tr>
<td></td>
<td>Duration dates:</td>
</tr>
<tr>
<td></td>
<td>- Start date: Required.</td>
</tr>
<tr>
<td></td>
<td>- End date: If empty, subscription does not expire.</td>
</tr>
<tr>
<td></td>
<td>State is automatically set to In Use when current date is between start and end dates.</td>
</tr>
<tr>
<td></td>
<td>State is automatically set to Retired when current date is past the end date and active rights is 0.</td>
</tr>
<tr>
<td></td>
<td>State is automatically set to On Order when the start date is in the future and active rights is 0.</td>
</tr>
<tr>
<td>Metric group</td>
<td>Select the metric group for the software. Each metric group has a set of license metrics that are specific to the publisher.</td>
</tr>
<tr>
<td></td>
<td>- Common</td>
</tr>
<tr>
<td></td>
<td>- Custom</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>License metric</td>
<td>Select the license metric for the license group that the software license is counted against when reconciliation is run. Point to the reference field icon to view the license calculation.</td>
</tr>
<tr>
<td></td>
<td>- Common:</td>
</tr>
<tr>
<td></td>
<td>- Per Device: Licenses a device for a number of installations of software.</td>
</tr>
<tr>
<td></td>
<td>- Per Named Device: Licenses a specific device for a number of installations of software.</td>
</tr>
<tr>
<td></td>
<td>- Per Named User: Licenses a specific user for a number of installations of software.</td>
</tr>
<tr>
<td></td>
<td>- Per User: Licenses a user for a number of installations of software.</td>
</tr>
<tr>
<td></td>
<td>- Custom: Configured license metrics, if any.</td>
</tr>
<tr>
<td>Agreement type</td>
<td>Select the agreement type.</td>
</tr>
<tr>
<td></td>
<td>- Generic</td>
</tr>
<tr>
<td></td>
<td>- Enterprise Level Agreement (ELA)</td>
</tr>
<tr>
<td>Purchased rights</td>
<td>Specify the number of rights that you are purchasing. The number of purchased rights for the new entitlement gets set in the Active rights field.</td>
</tr>
<tr>
<td>Active rights</td>
<td>(Read-only) Specifies the number of entitlements to be granted for this license.</td>
</tr>
<tr>
<td></td>
<td>Note: If an enterprise contract is attached to the license, the <strong>Active rights</strong> field is not shown.</td>
</tr>
<tr>
<td>Allocations available</td>
<td>(Read-only) Specifies the number of user or device allocations that have not been created for an entitlement.</td>
</tr>
<tr>
<td></td>
<td>Allocations available = (number of active rights) - (sum of all allocation quantities)</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Serial number</td>
<td>Unique number assigned for identification of the asset.</td>
</tr>
<tr>
<td>Owned by</td>
<td>User or department with financial ownership of the asset. Can be different than the manager.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the asset. Values include On order, In stock, In transit, In use, Consumed, In maintenance, Retired, and Missing. If the state is Retired, the <strong>Active rights</strong> field is set to 0.</td>
</tr>
<tr>
<td>Substate</td>
<td>More details about the software license stage. The available substate settings depend on the <strong>State</strong> selected. For example, if you select the Retired state, the substate options available are <strong>Disposed</strong>, <strong>Sold</strong>, <strong>Donated</strong>, and <strong>Vendor credit</strong>.</td>
</tr>
<tr>
<td>Company</td>
<td>Company to which this asset belongs.</td>
</tr>
<tr>
<td>Location</td>
<td>Where the license is used. For example, a specific site, country, or region.</td>
</tr>
<tr>
<td>Department</td>
<td>Department of the person <strong>Assigned to</strong> this software license.</td>
</tr>
<tr>
<td>Financial</td>
<td>Cost of the software.</td>
</tr>
<tr>
<td>Cost</td>
<td><strong>Note:</strong> Required for total cost and savings calculations on the <strong>Software Asset Management Foundation</strong> dashboard.</td>
</tr>
<tr>
<td></td>
<td>For additional field descriptions, see <a href="#">Create assets</a> in Asset Management.</td>
</tr>
<tr>
<td>Upgraded Entitlements</td>
<td></td>
</tr>
<tr>
<td>From Entitlement</td>
<td>The entitlement from which rights are upgrading. Multiple upgrade entitlements are supported. You can upgrade previously owned rights for a particular version of software to a newer version (for example, Office Professional Plus 2013 to Office Professional Plus 2016).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only when the License type is Upgrade. The rights from entitlements that you are upgrading from get deactivated when you upgrade because they are moved to the new entitlement.</td>
</tr>
<tr>
<td>Number of rights</td>
<td>Number of rights to upgrade.</td>
</tr>
</tbody>
</table>

The Contracts related list contains **contract** details.
The User or Device Allocations related list contains entitlement **allocations**.
The Activities related list contains work notes for the asset.

2. To perform additional configuration, select the new software entitlement record in the Software Entitlements list.
   a) To set upgrade and downgrade entitlements, in the Downgrades/Upgrades related list, create a new record to specify which software models to which you have upgrade or downgrade rights (see table for field descriptions).

   This allows you to set entitlement to previous or future versions of software (for example, the purchase of Office Professional Plus 2016 rights entitles you to Office Professional Plus 2013 as well).

   **Downgrades/Upgrades form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software entitlement</td>
<td>Software entitlement with which the upgrade/downgrade is associated.</td>
</tr>
<tr>
<td>Software model</td>
<td>Software model of the entitlement.</td>
</tr>
<tr>
<td>Order</td>
<td>Order of the upgrade/downgrade.</td>
</tr>
<tr>
<td>Start date</td>
<td>Start date of the upgrade/downgrade.</td>
</tr>
<tr>
<td>End date</td>
<td>End date of the upgrade/downgrade.</td>
</tr>
</tbody>
</table>

   b) To set up cost-tracking details, configure Expense Lines.
   c) To manage license keys, in the License Keys related list, create a new record to specify the licenses keys allocated to entitlements (see table for field descriptions).

   **License Key form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is allocated</td>
<td>Check box indicating that the license key has been allocated.</td>
</tr>
<tr>
<td>License key</td>
<td>License key value. Must be unique per entitlement.</td>
</tr>
<tr>
<td>Software entitlement</td>
<td>Software entitlement associated with the license key.</td>
</tr>
</tbody>
</table>

Add a SAM Foundation entitlement allocation

A user or device allocation can be added to a software entitlement to specify a user or device to which rights have been allocated.

Role required: sam_user

User allocations are stored in the User Allocations (alm_entitlement_user) table. Device allocations are stored in the Device Allocations (alm_entitlement_asset) table.
Note: The total of all allocation quantities cannot exceed the total number of rights for the entitlement.

1. Navigate to Software Asset > Licensing > Software Entitlements and open the software entitlement record to add allocations to.
2. Click the applicable allocations related list (User Allocations or Device Allocations) to configure (see table for field descriptions).

Note: The allocations related list that is shown pertains to the license metric that you chose. Only one related list for allocations is shown.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Allocations</td>
<td></td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user to which the license is allocated.</td>
</tr>
<tr>
<td>Software Model</td>
<td>Automatically set based on entitlements software model.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity of rights allocated to this user. Default is 1. Multiple rights come into play in the case where many rights are needed to fully license a device or user, such as with per core.</td>
</tr>
<tr>
<td>License Key</td>
<td>License key of the software.</td>
</tr>
<tr>
<td>Device Allocations</td>
<td></td>
</tr>
<tr>
<td>Assigned to</td>
<td>The device to which the license is allocated.</td>
</tr>
<tr>
<td>Software Model</td>
<td>Automatically set based on entitlements software model.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity of licenses allocated to this user. Default is 1. Multiple licenses come into play in the case where licenses are allocated per core and multiple core rights are needed.</td>
</tr>
<tr>
<td>License Key</td>
<td>License key of the software.</td>
</tr>
</tbody>
</table>

SAM Foundation software discovery and normalization

ServiceNow Discovery is used to automatically populate the Software Installations table so the software can be manually normalized and reconciled.

The discovery process consists of automatically discovering software used at your organization, which can be done either using ServiceNow Discovery, or using SCCM integration.

For more information, see Collect software data with either SCCM or Discovery and Discovery with Software Asset Management.

Note: To use Discovery, the Discovery plugin must be activated.
Discovery uses patterns in the discovery process that can be created or customized. The base system contains a wide range of patterns that cover most industry standard network devices and applications. Software Asset Management Foundation plugin automatically leverages SQL Server, Exchange Server, and Oracle Database Server specifically, but other patterns can be customized for use by Software Asset Management Foundation plugin, if needed.

Discovered software is stored in the Software Installations (cmdb_sam_sw_install) table.

**Note:** If you are already running Discovery but have not used a version of ITSM Software Asset Management previously, run the Migrate SAM Foundation software installations script to copy records from the (cmdb_ci_spkg) table to the (cmdb_sam_sw_install) table, so that any previously discovered software installs are utilized by Software Asset Management Foundation plugin.

When software install records are written to the Software Installations table, a business rule verifies whether the unique combination of the discovered publisher, discovered product, and discovered version already exist in the Discovery Model table.

- If so, the reference to the discovery model is set in the Software Installations table.
- If not, a new record is created in the Discovery Model table, and that discovery model reference is set in the Software Installations table.

After discovery, you can **manually normalize** the software discovery model for reconciliation. Normalization status can have two different results:

<table>
<thead>
<tr>
<th>Normalization status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manually Normalized</td>
<td>A discovery model is manually normalized when key fields in the discovery model are filled in manually.</td>
</tr>
<tr>
<td>New</td>
<td>The software discovery model has not yet been manually normalized.</td>
</tr>
</tbody>
</table>

**SAM Foundation discovery models and software installations**

Software discovery models are automatically created during discovery so you can manually normalize the software installed in your environment.

Software discovery models are stored in the Software Discovery Model (cmdb_sam_sw_discovery_model) table.

There is a difference between *software models* and software discovery models.

- A software model is a specific version or configuration of software that is purchased and/or available to users.
- A software discovery model is a model created when a version of software is discovered in a network environment.

Multiple software discovery models can be associated to one software model. For example, a software model can be defined as follows:

- Publisher = X
- Product = Y
- Version = Starts with 10
If there are two separate installs of this product (version 10.1 and version 10.2), two discovery models are created. One of the discovery models has the discovered version set to 10.1, and the other discovery model has the discovered version set to 10.2. The reconciliation process associates both of these discovery models to the same software model since they both meet the version criterion of Starts with 10.

**Discovery Models**

Software discovery models cannot be created manually. The following field combination, called the primary key, is used to match new software installations to a new or existing software discovery model.

**Primary key:** Publisher, Display Name, and Version

*Note:* When analyzing version numbers, an exact match is always searched for first, but rounds down to a major version number when an exact match is not found. For example, if no match is found for version number 8.0.4, but version 8.0 is found, then version 8.0 is used in the **Software model** field.

**Discovery Models form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the discovery model as it appears in record lists. This value is generated automatically using the discovered publisher, discovered product, and discovered version.</td>
</tr>
<tr>
<td>Normalization status</td>
<td><em>Status</em> of the normalization process:</td>
</tr>
<tr>
<td></td>
<td>· Manually Normalized</td>
</tr>
<tr>
<td></td>
<td>· New</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software.</td>
</tr>
<tr>
<td>Product</td>
<td>Product name of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software product.</td>
</tr>
<tr>
<td>Discovered publisher</td>
<td>Discovered publisher of the software.</td>
</tr>
<tr>
<td>Discovered product</td>
<td>Discovered name of the software.</td>
</tr>
<tr>
<td>Discovered version</td>
<td>Discovered version of the software.</td>
</tr>
<tr>
<td>Additional Information</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Product type</td>
<td>• Child: A subcomponent of main software (not licensable).</td>
</tr>
<tr>
<td></td>
<td>• Driver: A software product that controls a device.</td>
</tr>
<tr>
<td></td>
<td>• Licensable: A software product that is licensable.</td>
</tr>
<tr>
<td></td>
<td>• Not Licensable: A software product that is not licensable.</td>
</tr>
<tr>
<td></td>
<td>• Patch: A software product designed to update, fix, or improve an existing computer program.</td>
</tr>
<tr>
<td></td>
<td>• Unknown: Not discovered.</td>
</tr>
<tr>
<td></td>
<td>For unknown product types, the product type can be changed to another value.</td>
</tr>
<tr>
<td></td>
<td>When the product type is changed, the normalization status of the discovery model is updated to Manually Normalized.</td>
</tr>
<tr>
<td></td>
<td>The reconciliation process only considers software discovery models that are licensable.</td>
</tr>
<tr>
<td>Platform</td>
<td>Platforms include:</td>
</tr>
<tr>
<td></td>
<td>• Windows</td>
</tr>
<tr>
<td></td>
<td>• Mac</td>
</tr>
<tr>
<td></td>
<td>• Unix</td>
</tr>
<tr>
<td>Language</td>
<td>• Dutch</td>
</tr>
<tr>
<td></td>
<td>• English</td>
</tr>
<tr>
<td></td>
<td>• French</td>
</tr>
<tr>
<td></td>
<td>• German</td>
</tr>
<tr>
<td></td>
<td>• Italian</td>
</tr>
<tr>
<td></td>
<td>• Spanish</td>
</tr>
<tr>
<td></td>
<td>Additional languages are generated if discovered.</td>
</tr>
<tr>
<td>Full version</td>
<td>Full version of the software.</td>
</tr>
</tbody>
</table>

**Note:** If a normalized discovery model has a missing version, edition, language, or platform value, those field values can be set by the user. Once a new value is set, the normalization status changes from New to Manually Normalized.
Software Installations

The Software Installations list contains the software installed in your organization and is automatically populated by discovery.

Installed software is placed in the Software Installation (cmdb_sam_sw_install) table by Discovery, and a primary key is built (using Publisher, Display Name, and Version fields).

Discovery automatically matches the discovered software installation with a new or existing software discovery model using the primary key.

Software Installations form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name.</td>
<td>Name of the software installation as it appears in the record lists. Can be a combination of the discovered product name and edition.</td>
</tr>
<tr>
<td>Discovery model</td>
<td>Software discovery model that represents the installed software.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software.</td>
</tr>
<tr>
<td>Edition Override</td>
<td>Override of the software edition setting.</td>
</tr>
<tr>
<td></td>
<td>If the edition for the software was not discovered, you can edit this field to set the edition, if known, so reconciliation can be performed successfully.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Manually override SAM Foundation edition value.</td>
</tr>
<tr>
<td>Prod id</td>
<td>Unique ID for the product assigned by the manufacturer. Found through discovery.</td>
</tr>
<tr>
<td>Install location</td>
<td>Path under which the software is installed.</td>
</tr>
<tr>
<td>Install date</td>
<td>Date that the software was installed.</td>
</tr>
<tr>
<td>Revision</td>
<td>Revision of the software.</td>
</tr>
<tr>
<td>Instance key</td>
<td>Unique ID for the instantiation of the software. Automatically generated when the software is installed.</td>
</tr>
<tr>
<td>Installed on</td>
<td>Hardware on which the software is installed.</td>
</tr>
<tr>
<td>Uninstall string</td>
<td>Identifier used to uninstall the software.</td>
</tr>
<tr>
<td>ISO serial number</td>
<td>ISO number of the software.</td>
</tr>
<tr>
<td>Reconciliation</td>
<td></td>
</tr>
<tr>
<td>Entitlement</td>
<td>The entitlement found to use with this installation.</td>
</tr>
<tr>
<td>Inferred suite</td>
<td>The inferred suite model this installation belongs to.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Omit from suites</td>
<td>Check box for not counting the software install as a component of a suite during reconciliation.</td>
</tr>
</tbody>
</table>

Manually normalize a SAM Foundation software discovery model
You can edit a software discovery model to manually normalize discovered software on the Software Discovery Models form so that it can be reconciled.

Role required: sam_user

If the information automatically added to the software discovery model is incomplete, you can add the missing fields to manually normalize the software discovery model.

1. Navigate to Software Asset > Discovery > Discovery models and open a discovery model record.
2. Fill in the Publisher, Product, and Version fields, as appropriate.
3. Click Normalize.
   The normalization status is set to Manually Normalized.

Manually override SAM Foundation edition value
When the edition of a software install is not automatically discovered, you can specify the edition on the Software Installation form with the correct value (if known) so the software can be successfully reconciled.

Role required: sam_admin

For reconciliation to run successfully, the publisher, product, version, and edition fields of the software must be set. When the edition is not discovered automatically (edition value is not included as part of the Display name field) but you know the edition, you can manually set it to the correct value (Enterprise, for example).

Once the edition value is set, the discovery model for the software install is automatically reset. If the appropriate discovery model does not exist, a new one is created.

**Note:** Not all software products consist of an edition. Of the software products consisting of an edition, not all edition values are automatically discoverable.

1. Navigate to Software Asset > Discovery > Software Installations and open the software installation record for which to set the edition value.
2. Fill in the Edition override field, as appropriate.

**Note:** The Edition override field is a free-form field (no lookup list) therefore, since this field is used as a key, the value entered must be exact.

3. Click Update.
   The software installation is associated to different discovery model containing the edition value as part of the primary key. If the appropriate discovery model does not exist, a new one is created.

**Customize a Discovery pattern for Software Asset Management Foundation plugin**
Software Asset Management Foundation plugin automatically leverages SQL Server, Exchange, and Oracle Database Discovery patterns, but you can perform steps for Software Asset Management Foundation plugin to utilize additional Discovery patterns, if needed.

Role required: sam_admin
Discovery uses a series of scripts and operations (probes, sensors, and patterns) with the base system to collect data, process it, and update the CMDB. Although Software Asset Management Foundation plugin is already set up to utilize three common patterns (SQL Server, Exchange, and Oracle Database), you can perform a configuration procedure to include additional patterns.

This customization automatically copies the records from the discovered pattern to the Software Installation (cmdb_sam_sw_install) table so Software Asset Management Foundation plugin can utilize this data for reconciliation.

For more information on pattern customization, see Pattern customization.

1. Configure a post processing step in the discovery pattern.
   a) Navigate to Pattern Designer > Discovery Patterns.
   b) Open the pattern record from which you would like to collect data for Software Asset Management (for example, the discovery pattern for MySQL).
   c) Select and copy the Class Name field value.
      You will need to paste this class name value into a record field in the Software Installation Name Mapping (cmdb_sam_sw_name_mapping) table as part of this configuration procedure.
   d) Click the Pre/Post Processing related link.
   e) In the Sync Installed Software section, select the desired software from the list to add it (for example, MySQL).
      Data discovered relating to the software you select is automatically copied into the Software Installation (cmdb_sam_sw_install) table as part of the discovery process.
   f) Click Update.

2. Add the pattern data to a new record in the Software Installation Name Mapping (cmdb_sam_sw_name_mapping) table.
   a) Create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class name</td>
<td>Class name of the discovery pattern. Paste the value that you copied from the class field in discovery pattern.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the product (for example, Oracle).</td>
</tr>
<tr>
<td>Product</td>
<td>Product name (for example, MySQL).</td>
</tr>
</tbody>
</table>

b) Click Submit.

When discovery is run, the records for the software product relating to the customized discovery pattern are utilized by Software Asset Management.

No further configuration is needed unless you know the software product consists of an edition that is not being discovered automatically.

If the software product has an edition that is not being discovered, Manually override SAM Foundation edition value so the software can be successfully reconciled.
SAM Foundation software reconciliation for compliance

Automated license reconciliation keeps license positions accurate and up to date without manual calculations. Reconciliation runs weekly or on demand.

Reconciliation is a scheduled job that is run at a specified frequency (default is weekly). It can also be run on demand for specific or all publishers.

When reconciliation is run, a list of reconciliation results is created that shows the compliance status of software products with respect to discovery and entitlements. Users with the sam_user role can view reconciliation results.

Remediation options include rights not in use, rights not allocated, rights needed, reclaimable rights, and unlicensed rights.

Reconciliation results

Reconciliation results are listed in the navigation path Software Asset > Reconciliation > Reconciliation Results (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique identifying number that is generated during the reconciliation process.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the reconciliation.</td>
</tr>
<tr>
<td></td>
<td>• Completed</td>
</tr>
<tr>
<td></td>
<td>• In Progress</td>
</tr>
<tr>
<td>Last reconciled</td>
<td>Date of last reconciliation run.</td>
</tr>
<tr>
<td>Ran for</td>
<td>All publishers, or specific publishers.</td>
</tr>
<tr>
<td>Publishers</td>
<td>Only shown if publishers were specified on which to run reconciliation.</td>
</tr>
</tbody>
</table>

Software product results

You can access Software Models and Unlicensed Installs related lists from a product result record. A product result for a licensable product is generated after reconciliation even if there are no software models defined for the product.

Note: A Software Model Results record is only created when a software model or entitlement exists for the product.

Software product results are listed in the navigation path Software Asset > Reconciliation > Product Results (see table for field descriptions).
### Product Results form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique product result number that is generated during the reconciliation process.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software.</td>
</tr>
<tr>
<td>Product</td>
<td>Name of software product.</td>
</tr>
<tr>
<td>Latest</td>
<td>Indicates whether this product result is from the most recent reconciliation run.</td>
</tr>
<tr>
<td>Reconciliation result</td>
<td>Unique reconciliation result number that is generated during the reconciliation process.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the product.</td>
</tr>
<tr>
<td></td>
<td>• Compliant</td>
</tr>
<tr>
<td></td>
<td>• Not Compliant</td>
</tr>
<tr>
<td>True-up cost</td>
<td>Estimated cost of remediating non-compliance based on the least number of rights needed.</td>
</tr>
<tr>
<td>Over-licensed amount</td>
<td>Estimated cost of rights not being used. Sum of all Over Licensed amount values from every software model result.</td>
</tr>
<tr>
<td>Potential savings</td>
<td>Estimated cost of savings if software installations are reclaimed. Sum of all potential savings from all removal candidates.</td>
</tr>
<tr>
<td>Unlicensed Installs</td>
<td>Name of the unlicensed software installation.</td>
</tr>
<tr>
<td>Display name</td>
<td>Publisher that represents the software product.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Version</td>
</tr>
<tr>
<td>Installed on</td>
<td>Device on which the product is installed.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User to which the product is assigned.</td>
</tr>
</tbody>
</table>

The **Software Model Results** related list contains software model results from reconciliation.

**View SAM Foundation software model results**

View compliance information for software model results from the Product Results list after reconciliation is run.

Role required: sam_user

You can view License Metric Results, Remediation Options, and Unlicensed Installs related lists for a software model result from a Product Result record.

For example, if the status of a product result shows that it is not compliant, you can drill down on the product result to view software model details, such as the number of unlicensed installs and the true-up cost to become compliant. Further, you can drill down on the software model result to view the license metric result, which is based on the entitlements for the product.
License metric result information includes rights owned and rights used as well as the license allocation breakdown so you can determine your options to become compliant. The Remediation Options related list shows the number of rights needed and calculates the cost of those rights for you, based on the license metric.

1. Navigate to Software Asset > Reconciliation > Product Results and open a record to view product results details.
2. In the Software Model Results related list, open a record to view the details (see table for field descriptions).

### Software Model Results form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software model</td>
<td>Software model associated with the product. Drill down on the software model to see the software model result.</td>
</tr>
<tr>
<td>Product result</td>
<td>Unique product result number generated during the reconciliation process.</td>
</tr>
<tr>
<td>Latest</td>
<td>Indicates whether this software model result is from the most recent reconciliation run.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the software model.</td>
</tr>
<tr>
<td>Agreement type</td>
<td>• Common: Generic, Enterprise License Agreement (ELA)</td>
</tr>
<tr>
<td>Unlicensed installs</td>
<td>Number of unlicensed software installations that are not covered by any entitlements.</td>
</tr>
<tr>
<td>True-up cost</td>
<td>Estimated cost of remediating non-compliance based on the least number of rights needed (rights needed * average price per right from entitlements). The lowest cost from Purchase Rights remediation options.</td>
</tr>
<tr>
<td>Over-licensed amount</td>
<td>Estimated cost of rights not being used. The sum of the Over Licensed amount from the True-up value costs.</td>
</tr>
<tr>
<td>License Metric Results</td>
<td>License metric that the software license is counted against when reconciliation is run.</td>
</tr>
<tr>
<td>Software model result</td>
<td>Software model with which the result is associated.</td>
</tr>
<tr>
<td>Rights owned</td>
<td>Sum of all active rights from entitlements that share a license metric.</td>
</tr>
</tbody>
</table>

**Note:** If the agreement type is Enterprise Level Agreement, the Status is Compliant even if there are unlicensed installations.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rights used</td>
<td>Sum of rights used during reconciliation (allocated + not allocated and installed).</td>
</tr>
<tr>
<td>Unused rights</td>
<td>Sum of rights not used during reconciliation (rights owned - rights used).</td>
</tr>
<tr>
<td>Over-licensed amount</td>
<td>Estimated cost of unused rights.</td>
</tr>
<tr>
<td>Right Allocations</td>
<td></td>
</tr>
<tr>
<td>Allocated in use</td>
<td>Rights that are allocated and are used to license installations.</td>
</tr>
<tr>
<td>Not allocated in use</td>
<td>Number of rights that are used to license installations, but not allocated.</td>
</tr>
<tr>
<td></td>
<td>When this value is greater than 0, two remediation options (Create Allocations and Remove Unallocated Installs) are automatically created for each unique license metric in the software model that meets this requirement, except User CAL and Device CAL.</td>
</tr>
<tr>
<td>Allocated not in use</td>
<td>Rights that are allocated but are not being used to license any installations.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> <em>Allocated not in use</em> reflects rights that are wasted because the user or device for which these rights have been allocated do not have the software installed.*</td>
</tr>
<tr>
<td></td>
<td>When this value is greater than 0, a Remove Allocations remediation option is automatically created for each unique license metric in the software model that meets this requirement.</td>
</tr>
<tr>
<td>Not allocated</td>
<td>Number of rights that have not been allocated (rights owned - allocated regardless of whether installed or not).</td>
</tr>
<tr>
<td>Allocations needed</td>
<td>Number of allocations needed for compliance. Only used for Per Named User and Per Named Device license metrics.</td>
</tr>
<tr>
<td>Remediation Options</td>
<td></td>
</tr>
<tr>
<td>Remediation action</td>
<td>Action to take to for compliance.</td>
</tr>
<tr>
<td></td>
<td>• Purchase Rights</td>
</tr>
<tr>
<td></td>
<td>• Remove Allocations</td>
</tr>
<tr>
<td></td>
<td>• Create Allocations</td>
</tr>
<tr>
<td></td>
<td>• Remove Unallocated Installs</td>
</tr>
<tr>
<td></td>
<td>• Remove Unlicensed Installs</td>
</tr>
<tr>
<td>Affects compliance</td>
<td>Specifies whether compliance is affected by the remediation option.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>License metric</td>
<td>Specific license metric of the software model result.</td>
</tr>
<tr>
<td>Software model result</td>
<td>Specific software model result pertaining to the remediation option.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the remediation option.</td>
</tr>
<tr>
<td></td>
<td>- New (blue)</td>
</tr>
<tr>
<td></td>
<td>- Complete (green)</td>
</tr>
<tr>
<td></td>
<td>- Void (red)</td>
</tr>
<tr>
<td></td>
<td>- In Progress (yellow)</td>
</tr>
<tr>
<td></td>
<td>In Progress state indicates that removal candidates were created for the installs.</td>
</tr>
<tr>
<td>Rights not in use</td>
<td>- Remove Allocations action shows Rights not in use field.</td>
</tr>
<tr>
<td>Rights not allocated</td>
<td>- Create Allocations action shows Rights not allocated field.</td>
</tr>
<tr>
<td>Rights needed</td>
<td>- Purchase Rights shows Rights needed.</td>
</tr>
<tr>
<td>Reclaimable rights</td>
<td>- Remove Unallocated Installs action shows Reclaimable rights field.</td>
</tr>
<tr>
<td>Unlicensed rights</td>
<td>- Remove Unlicensed Installs action shows Unlicensed rights field.</td>
</tr>
<tr>
<td>(Field shown is based on Remediation action type)</td>
<td></td>
</tr>
<tr>
<td>Actionable rights</td>
<td>Total rights affected by the action.</td>
</tr>
<tr>
<td>True-up cost</td>
<td>Estimated cost of remediating non-compliance based on the least number of rights needed.</td>
</tr>
</tbody>
</table>

The Unlicensed Installs related list contains the software installations that are unlicensed.

*Run SAM Foundation software reconciliation*
Reconciliation is run as a scheduled job (default is weekly), but you can also run reconciliation manually to reconcile software products in your environment on demand.

Role required: sam_admin

Reconciliation is run for products that have entitlements.

When running reconciliation manually, allow enough time for the process to complete. For faster results, narrow the scope by selecting specific publishers.

1. Navigate to **Software Asset > Reconciliation > Run Reconciliation** and select a publisher for which compliance should be calculated, or select all publishers.
2. Click **Continue**.
   
   The reconciliation process may take an extended amount of time to complete.
   
   The Reconciliation Results list is shown.

**Software Asset Management Foundation plugin Administration**
Software Asset Management Foundation plugin administration tasks include adding custom product records, creating custom license metrics, and setting properties. You can also refresh processor definitions, and migrate software installations.
The sam_admin role is required to configure administrative tasks. However, the sam_user role can view and read configurations.

**Add a SAM Foundation custom software product**
You can add a custom product if a software product does not exist in the Software Library. Custom products enable you to normalize and account for homegrown software, or software that is not yet part of the Software Library.

Role required: sam_admin

The product and publisher combination is used during discovery model normalization. If the custom product already exists, a message is shown.

Navigate to **Software Asset > Administration > Custom Software Products** and create a new record (see table for field descriptions).

**Custom Software Product form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher</td>
<td>Publisher of the custom software product. If it does not exist, a new one can be created on the Publisher field Companies lookup list.</td>
</tr>
<tr>
<td>Product</td>
<td>Name of the custom software product.</td>
</tr>
<tr>
<td>Product type</td>
<td>Product type of the custom software product.</td>
</tr>
<tr>
<td></td>
<td>• Child: A subcomponent of main software (not licensable).</td>
</tr>
<tr>
<td></td>
<td>• Driver: A software product that controls a device.</td>
</tr>
<tr>
<td></td>
<td>• Licensable: A software product that is licensable.</td>
</tr>
<tr>
<td></td>
<td>• Not Licensable: A software product that is not licensable.</td>
</tr>
<tr>
<td></td>
<td>• Patch: A software product designed to update, fix, or improve an existing computer program.</td>
</tr>
<tr>
<td></td>
<td>• Unknown: A software product that is unknown.</td>
</tr>
<tr>
<td>Product classification</td>
<td>Official UNSPSC classification.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for activating the rule.</td>
</tr>
</tbody>
</table>

**Add a SAM Foundation custom license metric**
You can add a custom license metric to modify the default reconciliation process.

Role required to read the custom metric script: sam_admin

Custom license metrics can be created to define specific software calculations not included in the predefined license metrics list. Custom license metrics are useful so reconciliation can calculate rights per user or device for certain software products and bundles of lesser-known software publishers.

For example, you can create a custom metric to avoid over counting installs for products that are part of an unrecognized bundle.
Custom metrics can be disabled using the custom license metric property. This feature is enabled by default.

Navigate to **Software Asset > Administration > Custom License Metrics** and create a new record (see table for field descriptions).

### Custom License Metric form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License metric</td>
<td>Name of the custom license metric. This name is shown in the License Metric field of software entitlements, and in the license metric results for the software model.</td>
</tr>
<tr>
<td>Metric group</td>
<td>(Read-only) Custom license metric.</td>
</tr>
<tr>
<td>Allocation type</td>
<td>Allocation type of the metric license, per device or per user. ▪️ Device ▪️ User</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the custom license metric.</td>
</tr>
<tr>
<td>Reconciliation order - allocated</td>
<td>Reconciliation metric rank priority for allocated licenses. Lower rank value takes precedence.</td>
</tr>
<tr>
<td>Reconciliation order - unallocated</td>
<td>Reconciliation metric rank priority for unallocated licenses. Lower rank value takes precedence.</td>
</tr>
<tr>
<td>Calculation</td>
<td>The calculation method for the license metric is script. Specify the reconciliation script.</td>
</tr>
</tbody>
</table>

**Migrate SAM Foundation software installations**

If you are using Discovery, run this script after installing Software Asset Management Foundation plugin to copy previously discovered software installation records from the (cmdb_software_instance) table to the (cmdb_sam_sw_install) table, which is used by Software Asset Management Foundation plugin to store software installation records.

Role required: sam_admin

If you are running Discovery and have used a version of **ITSM Software Asset Management** previously, there is no need to run this script. Additionally, if the (cmdb_sam_sw_install) table is already populated with software installation records, this script is disabled. You can run Discovery again to repopulate the table.

When running the Migrate Software Installs script, allow enough time for the process to complete.

Navigate to **Software Asset > Administration > Migrate Software Installs** and click **Proceed**.

The Software Installations list is shown. If the data has already been migrated, a message is shown.

**Software Asset Management Foundation plugin properties**

You can set default reconciliation properties such as reconciliation run with custom license metrics, and reconciliation debugging settings.
These properties are available for Software Asset Management Foundation plugin.
To access these properties, navigate to **Software Asset > Administration > Properties**.

### Properties for Software Asset Management Foundation plugin

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run reconciliation with all available custom license metrics</td>
<td>Enable custom license metrics when running reconciliation.</td>
</tr>
<tr>
<td>com.snc.samp.recon.enablecustommetrics</td>
<td>If you have a custom license metric configured, it is not applied when this property is set to <strong>No</strong>.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type</strong>: Reconciliation</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value</strong>: Yes</td>
</tr>
<tr>
<td>Enable debugging of reconciliation results</td>
<td>Enable debugging of reconciliation results to troubleshoot a result.</td>
</tr>
<tr>
<td>com.snc.samp.debug</td>
<td>- <strong>Type</strong>: Reconciliation</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value</strong>: No</td>
</tr>
</tbody>
</table>

**Software Asset Management Foundation plugin migration**

Migrate from the Software Asset Management plugin to the Software Asset Management Foundation plugin to take advantage of more powerful features. Manual actions by the customer are required after plugin activation.

After automatic changes are performed during plugin activation, successful migration from the Software Asset Management (com.snc.software_asset_management) plugin to the Software Asset Management Foundation (com.snc.sams) plugin requires a **manual procedure** to be performed by the customer.

Customizations to forms and lists may need to be manually overwritten by the customer after plugin activation. In addition, certain fields in software models, software entitlements, user/device allocations forms require manual configuration by the customer after plugin activation.

### Automatic changes

The Software Asset Management Foundation (com.snc.sams) plugin performs these automatic changes:

- Tables
  - Table labels renamed

<table>
<thead>
<tr>
<th>Table</th>
<th>Original Label</th>
<th>New Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>(alm_license)</td>
<td>Software License</td>
<td>Software Entitlement</td>
</tr>
<tr>
<td>(alm_entitlement_user)</td>
<td>User Entitlement</td>
<td>User Allocations</td>
</tr>
<tr>
<td>Table</td>
<td>Original Label</td>
<td>New Label</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>(alm_entitlement_asset)</td>
<td>Device Entitlement</td>
<td>Device Allocations</td>
</tr>
</tbody>
</table>

- Adds new tables and script includes.
- Adds any string value in the Software Entitlements **License key** field to the License Key (samp_sw_license_key) table

- **Field names and values**
  - **Inference mandatory** field
    
    For software models that have suite components (to bundle software models), the **Inference mandatory** field value in the Software Suite (cmdb_m2m_suite_model) table is transferred to a new **Mandatory** field
  - **Rights** field
    
    The Software Entitlements (formerly Software Licenses) **Rights** field value in the License Entitlements (alm_entitlement) table is transferred to a new **Purchased rights** field, and name changed from **Rights** to **Active rights**
  - **The Software model** field for a software entitlement allocation (Software Entitlement (alm_license) table) is automatically set to the software model on the entitlement (License Entitlements (alm_entitlement) table)
  - The quantity for a software entitlement allocation (License Entitlements (alm_entitlement) table) is set to 1 unless there are multiple allocations
    
    If there are multiple software entitlement allocations for the same user or device, the allocations are aggregated into one record, the quantity is set to the count of aggregated records, and duplicate allocations are not allowed

- **Forms and lists**
  
  Software Models, Entitlements (formerly Software License), Discovery Models, and Software Installations form and list layouts are modified to fit the new application

  **Note:** Any customizations to these forms and lists must be manually overwritten after plugin activation.

- **Functionality**

  **Functionality disabled**

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License and software counters</td>
<td>The scheduled job trigger for SAM License Counters is changed to None so that it is deactivated, and software counters are disabled.</td>
</tr>
<tr>
<td>Auto-match functionality</td>
<td>The auto-match functionality, which attempts to match a discovery model to a corresponding software model, is deactivated.</td>
</tr>
<tr>
<td>Navigation menu</td>
<td>The navigation menu for the Software Asset Management plugin is deactivated and renamed.</td>
</tr>
<tr>
<td>Functionality</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Business rules</td>
<td>Legacy business rules applied to discovery models are disabled.</td>
</tr>
</tbody>
</table>

Overwrite customizations for Software Asset Management Foundation plugin migration

When migrating from the Software Asset Management plugin to the Software Asset Management Foundation plugin, further actions are required by the customer after plugin activation to ensure successful migration of customized forms and lists.

Role required: admin

If these lists and forms have been customized before the migration, they may have been skipped during plugin activation and, in that case, require further action.

- Software Entitlements (formerly Software Licenses)
- Software Allocations (formerly Software Entitlements)
- Software Models
- Discovery Models
- Software Installations

You can review plugin activation changes in the Upgrade History module to determine what changes have automatically been skipped so you can resolve the skipped update, if needed.

Certain fields added by the migration also must be configured to take advantage of the new features offered.

1. Navigate to System Diagnostics > Upgrade History.
2. Identify the records that correspond to the upgrade history for the activation of the Software Asset Management Foundation plugin.
   
   The records in System Upgrades list that represent plugin activation contain the value n/a in the From field, and plugin name in the To field (such as com.snc.samp, com.snc.samp.core, com.snc.sam.core, com.glide.data_services_canonicalization.client, com.snc.asset_management, com.snc.model, com.snc.procurement).
   
   You can determine the list of related plugins based on the time stamp of when the Software Asset Management plugin was activated by sorting on the Upgrade started column.
3. Open a Software Asset Management Foundation plugin upgrade record that has changes skipped.
4. In the Upgrade Details related list, open an Upgraded Details record, and then click Resolve Conflicts to view a side-by-side comparison of the base system file with the customized file.
5. Click Revert to Base System to overwrite the skipped change if it applies to form or list customization, and note down the changes. Repeat these steps for all upgrade entries with skipped changes relating to customizations.
6. In Software Asset Management Foundation plugin configuration, manually reconfigure your original form and list customizations.
7. In Software Asset Management Foundation plugin configuration, set new field values (added as part of the automatic changes performed by plugin activation) to take advantage of the new features offered.
   a) Navigate to Software Asset > Licensing > Software Models.
      
      - Select the software product in the Product reference field.
      - Select a discovery map, or clear the Discovery Map field and set the discovery conditions to find all discovery models that correspond to the software model.
b) Navigate to **Software Asset > Licensing > Software Entitlements** (formerly Software Licenses).

- Navigate to **Software Asset > Licensing > Software Entitlements** (formerly Software Licenses).
- Select the **License Metric** that the software license is counted against when reconciliation is run.
- Define the upgrade and downgrade scenarios covered by certain rights.

c) In the **User Allocations** and **Device Allocations** related lists (formerly User/Device Entitlements), verify that the number of allocated rights are not more than rights owned.

If so, delete allocations so that the number of allocations does not exceed the number of rights owned.

8. If you have entitlements that require management of license keys, you can create multiple license keys associated to the same entitlement, as well as allocate these license keys to a user or device.

## Organization Management

The Organization Management application provides an easy way to perform such asset management tasks as updating users and adding vendors.

It includes managing your vendors and manufacturers, as well as managing locations.

### Create a new vendor or manufacturer

You can create a new vendor, which is a company that sells assets or services that your organization purchases. You can also create a new manufacturer, which is a company that builds assets that your organization purchases.

**Role required:** user_admin and asset

1. Navigate to one of the following:

- Organization > Vendors
- Organization > Manufacturers
- Organization > Companies

2. Click **New** and create a new record.

3. Complete the form and select either **Manufacturer** or **Vendor**.

   **Note:** A company can be considered both a vendor and a manufacturer.

4. Click **Submit**.

### Locations module

The Locations module is the Asset view of the Location table (cmn_location).

In addition to the physical specifics for the location, the Asset view includes the **Stock room** designation and a list of configuration items (CI) in stock at that location.
Asset location

Installed with Model Management

Several types of components are installed with Model Management. Demo data is available with Model Management.

Business rules installed with Model Management

Model Management uses a number of business rules.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abort action if no license type</td>
<td>(cmdb_software_product_model)</td>
<td>Ensures that a license type (not a license type group that cannot be handled by counters) has been selected.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Calculate display_name</td>
<td>Product Model (cmdb_model)</td>
<td>Sets the Display name field when any of the following field values change: Manufacturer, Name, Version, Edition. The display name differs depending on whether the glide.cmdb_model.display_name.shorten property is set to true or false.</td>
</tr>
<tr>
<td>Date validation</td>
<td>(cmdb_m2m_downgrade_model)</td>
<td>Ensures that the Start date is before the End date.</td>
</tr>
<tr>
<td>Enforce CI Rules</td>
<td>(cmdb_model_category)</td>
<td>Ensures that categories that track assets as consumables or software licenses do not have a CI class.</td>
</tr>
<tr>
<td>Flag parent as bundle on creation</td>
<td>(cmdb_m2m_model_component)</td>
<td>Flags a model that has components as a bundle.</td>
</tr>
<tr>
<td>License Type - Fullname</td>
<td>(cmdb_sw_license_calculation)</td>
<td>Computes the full name of the license type.</td>
</tr>
<tr>
<td>License validation</td>
<td>Software Upgrade and Downgrades</td>
<td>Prevents software upgrades and downgrades from being duplicated and prevents having duplicate upgrades and downgrades for the same license where duplication also involves having the same dates. Also ensures that both the Upgrade parent and Downgrade child fields are mandatory and that if the License field is not empty, either Upgrade parent or Downgrade child must be equal to the license.model.</td>
</tr>
<tr>
<td>Protect cmdb_ci_class</td>
<td>(cmdb_model_category)</td>
<td>Prevents CI class from being changed after creation.</td>
</tr>
<tr>
<td>Protect cmdb_ci_class on insert</td>
<td>(cmdb_model_category)</td>
<td>Prevents creation of a category if another category already exists for the chosen CI class.</td>
</tr>
<tr>
<td>Protect Contract</td>
<td>(cmdb_model_category)</td>
<td>Prevents changes to the Contract model category record.</td>
</tr>
<tr>
<td>Set parent's main component link</td>
<td>(cmdb_m2m_model_component)</td>
<td>Populates a read-only reference from the bundle to the component when a bundle component is selected as the main component.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unflag parent on last delete</td>
<td>(cmdb_m2m_model_component)</td>
<td>Removes the bundle flag from a model when the last component is deleted from the bundle.</td>
</tr>
<tr>
<td>Update model category</td>
<td>(cmdb_ci)</td>
<td>Updates the model categories for the associated model if the model is not already associated with the CI's model category.</td>
</tr>
<tr>
<td>Validate record before creation</td>
<td>(cmdb_m2m_model_component)</td>
<td>Ensures that a component is not already in a bundle when an attempt is made to add the component to a bundle.</td>
</tr>
</tbody>
</table>

### Client scripts installed with Model Management

Model Management includes a number of client scripts.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear models not matching license</td>
<td>(cmdb_m2m_downgrade_model)</td>
<td>Clears the Upgrade parent and Downgrade child fields when the License field is changed to a license and neither the upgrade or downgrade fields match the license model.</td>
</tr>
<tr>
<td>Constraints based on asset class</td>
<td>(cmdb_model_category)</td>
<td>Enables or disables bundling options based on the asset class of the category.</td>
</tr>
<tr>
<td>Hide sections when needed</td>
<td>(cmdb_model)</td>
<td>Shows and hides sections according to what is relevant for a given model.</td>
</tr>
<tr>
<td>model_category change</td>
<td>(cmdb_model)</td>
<td>Ensures compatibility of classes between the several categories referenced by the same model (client part).</td>
</tr>
<tr>
<td>Populate downgrade from license</td>
<td>(cmdb_m2m_downgrade_model)</td>
<td>Sets the downgrade child to the software model on the referenced license when an upgrade is selected. Only sets the downgrade to the license if the license is not empty.</td>
</tr>
<tr>
<td>Populate upgrade from license</td>
<td>(cmdb_m2m_downgrade_model)</td>
<td>Sets the upgrade parent to the software model on the referenced license when a downgrade is selected. Only sets the upgrade to the license if the license is not empty.</td>
</tr>
</tbody>
</table>
Properties installed with Model Management

Model Management includes the property `glide.cmdb_model.display_name.shorten`.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>glide.cmdb_model.display_name.shorten</code></td>
<td>When set to <code>true</code>, generates shorter display names for models by eliminating duplication of the manufacturer name. Consider the following model, for which <code>Manufacturer</code> is set to <code>Spotify</code> and <code>Name</code> is set to <code>Spotify Premium</code>. The <code>Display name</code> field is set as follows, based on the property setting.</td>
</tr>
<tr>
<td></td>
<td>• false: Display name is <code>Spotify Spotify Premium</code></td>
</tr>
<tr>
<td></td>
<td>• true: Display name is <code>Spotify Premium</code></td>
</tr>
<tr>
<td></td>
<td>For software models, the edition and version are also included in the name, if they are specified.</td>
</tr>
<tr>
<td></td>
<td>• Type: <code>true</code></td>
</tr>
<tr>
<td></td>
<td>• Default value: <code>false</code></td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties (<code>sys_properties</code>) table</td>
</tr>
</tbody>
</table>

Script includes installed with Model Management

Model Management includes script includes.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ModelAndCategoryFilters</td>
<td>Refines reference qualifiers for models and model categories based on class.</td>
</tr>
<tr>
<td>ModelCategoryCheck</td>
<td>Ensures compatibility of classes between the several categories referenced by the same model.</td>
</tr>
</tbody>
</table>

Tables installed with Model Management

Model Management includes numerous tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Model</td>
<td>Stores models used to describe software application products.</td>
</tr>
<tr>
<td>(cmdb_application_product_model)</td>
<td></td>
</tr>
<tr>
<td>Consumable Model</td>
<td>Describes consumable product models.</td>
</tr>
<tr>
<td>(cmdb_consumable_product_model)</td>
<td></td>
</tr>
<tr>
<td>Contract Model</td>
<td>Stores all contract models.</td>
</tr>
<tr>
<td>(cmdb_contract_product_model)</td>
<td></td>
</tr>
<tr>
<td>Depreciation</td>
<td>Stores asset depreciation patterns.</td>
</tr>
<tr>
<td>(cmdb_depreciation)</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hardware Model (cmdb_hardware_product_model)</td>
<td>Describes hardware product models.</td>
</tr>
<tr>
<td>Model Category (cmdb_model_category)</td>
<td>Defines groups of assets, consumables, product bundles, and configuration items.</td>
</tr>
<tr>
<td>Model Compatibility (cmdb_m2m_model_compatibility)</td>
<td>Stores many-to-many relationship between two models signifying their compatibility with one another.</td>
</tr>
<tr>
<td>Model Component (cmdb_m2m_model_component)</td>
<td>Stores many-to-many relationship between two models signifying that they form a bundle.</td>
</tr>
<tr>
<td>Product model (cmdb_model)</td>
<td>Describes all kinds of product models.</td>
</tr>
<tr>
<td>Software License Calculation (cmdb_sw_license_calculation)</td>
<td>Defines commonly used software licensing patterns.</td>
</tr>
<tr>
<td>Software Model (cmdb_software_product_model)</td>
<td>Describes software product models.</td>
</tr>
<tr>
<td>Software Suite (cmdb_m2m_suite_model)</td>
<td>Stores many-to-many relationship between two models that defines elements of a software suite.</td>
</tr>
<tr>
<td>Software Upgrade and Downgrades (cmdb_m2m_downgrade_model)</td>
<td>Stores many-to-many relationship between two models signifying that being licensed for one model grants rights to the other as well.</td>
</tr>
</tbody>
</table>

**UI policies installed with Model Management**

Model Management includes UI policies.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide unverified</td>
<td>Model Category (cmdb_model_category)</td>
<td>Shows the Enforce CI verification field if the Asset class and CI class fields are not empty.</td>
</tr>
<tr>
<td>Lock fields for Contract and Work</td>
<td>Model Category (cmdb_model_category)</td>
<td>Sets all fields on the Model Category form to read-only if the Name is Contract or, Work Order or Work Task.</td>
</tr>
<tr>
<td>Protect model category</td>
<td>Product Model (cmdb_model)</td>
<td>Makes the Model categories field mandatory and read-only if it contains any of the following values: Software License, Contract, Work Order, Work Task.</td>
</tr>
<tr>
<td>Show is an option if Oracle</td>
<td>Software Model (cmdb_software_product_model)</td>
<td>Shows the Is an option field if the selected Manufacturer name starts with Oracle.</td>
</tr>
</tbody>
</table>
User roles installed with Model Management

Model Management includes user roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>category_manager</td>
<td>model manager</td>
<td>Can create, edit, and delete model categories.</td>
</tr>
<tr>
<td>model_manager</td>
<td>none</td>
<td>Can create new CMDB models. The model manager role can control the base models and any model extensions that are not hardware, software, or consumables. Hardware and consumable models are controlled by the asset manager (asset) role. Software models are controlled by the software asset manager (sam) role.</td>
</tr>
</tbody>
</table>

Installed with Asset Management

A number of tables, user roles, UI policies, script includes, client scripts, and business rules are installed with Asset Management.

Demo data is available with asset management. The demo data provides information such as users, specific assets, and individual stockrooms.

Tables

Asset Management includes the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset (alm_asset)</td>
<td>Stores general, financial, and contractual information about assets.</td>
</tr>
<tr>
<td>Asset Entitlement (alm_entitlement_asset)</td>
<td>Enables ServiceNow to categorize the Asset Entitlement table and enforce how entitlements behave.</td>
</tr>
<tr>
<td>Consumable (alm_consumable)</td>
<td>Stores data about consumable assets (previously known as parts).</td>
</tr>
<tr>
<td>Default Stockroom (alm_user_stockroom)</td>
<td>Stores the relationship between a user and their default stockroom.</td>
</tr>
<tr>
<td>Fixed Assets (alm_fixed资产s)</td>
<td>Stores fixed assets, which are containers that can hold multiple assets.</td>
</tr>
<tr>
<td>Fixed asset to asset (m2m_fixed_asset_to_asset)</td>
<td>Stores associations between fixed assets and assets.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hardware (alm_hardware)</td>
<td>Stores general, financial, and contractual information about hardware assets.</td>
</tr>
<tr>
<td>License Entitlement (alm_entitlement)</td>
<td>Stores entitlements that permit users or machines to use a software license.</td>
</tr>
<tr>
<td>Software License (alm_license)</td>
<td>Stores general, financial, and contractual information about software license assets.</td>
</tr>
<tr>
<td>Stock Rule (alm_stock_rule)</td>
<td>Transfers stock or sends an email message to the asset manager when a specified asset drops below a set threshold.</td>
</tr>
<tr>
<td>Stockroom (alm_stockroom)</td>
<td>Stores information about stockrooms.</td>
</tr>
<tr>
<td>Stockroom Model (alm_m2m_stockroom_model)</td>
<td>Tracks all models that have ever been stocked in a stockroom. This table is automatically populated.</td>
</tr>
<tr>
<td>Stockroom Type (alm_stockroom_type)</td>
<td>Stores general information about stockroom types.</td>
</tr>
<tr>
<td>Transfer Order (alm_transfer_order)</td>
<td>Contains data about transfer orders, including the state and stockrooms.</td>
</tr>
<tr>
<td>Transfer Order Line (alm_transfer_order_line)</td>
<td>Contains data about individual assets being shipped with a transfer order.</td>
</tr>
<tr>
<td>User Entitlement (alm_entitlement_user)</td>
<td>Enables ServiceNow to categorize the User Entitlement table and enforce how entitlements behave.</td>
</tr>
</tbody>
</table>

**User roles**

Asset Management includes the following user roles.

**Asset Management user roles**

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>asset (Asset Manager)</td>
<td>category manager, contract manager, contract manager, financial mgmt user, inventory user</td>
<td>Can manage hardware and consumable assets ([alm_hardware] and [alm_consumable]). Asset manager cannot edit asset records that are created and updated automatically, but can read and delete the asset records when needed. Can create requests. Can create and delete stock information.</td>
</tr>
</tbody>
</table>
### Role

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>inventory_admin</td>
<td>inventory_user</td>
<td>Can create and delete stock information. Can edit stock rules, stockrooms, and stockroom types.</td>
</tr>
<tr>
<td>inventory_user</td>
<td>none</td>
<td>Can access stock information. Can create and manage transfer orders.</td>
</tr>
<tr>
<td>sam</td>
<td>contract manager, model manager, financial mgmt user</td>
<td>Can create, edit, change, and manage software licenses. Can edit the Software model field on a <em>discovery model</em>. Can approve a model. Has full control of the Software Asset Management application. Controls the Software Asset Management IBM PVU Process Pack, if activated.</td>
</tr>
</tbody>
</table>

### UI policies

Asset Management includes the following UI policies.

#### Asset Management UI policies

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide asset tag and serial num</td>
<td>(alm_asset)</td>
<td>Hides the asset tag when the asset is pre-allocated and the quantity is greater than 1.</td>
</tr>
<tr>
<td>Hide/show parent stockroom on Stockroom Replenish</td>
<td>(alm_stock_rule)</td>
<td>Shows the Parent stockroom field only when the Restocking option field is set to Stockroom.</td>
</tr>
<tr>
<td>Make allocated to and assigned to mandatory.</td>
<td>License Entitlement (alm_entitlement)</td>
<td>Makes the Allocated to and Assigned to fields mandatory.</td>
</tr>
<tr>
<td>Make substatus read-only when not required</td>
<td>(alm_asset)</td>
<td>Sets the Substatus to read-only if the State is On order, In use, Consumed, or In maintenance.</td>
</tr>
<tr>
<td>Model bundle field hidden but present for UI Policy conditions purposes</td>
<td>(alm_asset)</td>
<td>Hides the Model Bundle field. Exists on page only for use by UI policies and client scripts.</td>
</tr>
<tr>
<td>Pre_allocated constraints</td>
<td>(alm_asset)</td>
<td>Hides unneeded fields and related lists when the asset is pre-allocated.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Quantity readonly until model and category qualify the asset and are not bundle</td>
<td>(alm_asset)</td>
<td>Sets the Quantity field to read-only for assets that are not consumable, software, or pre-allocated. Quantity is also read-only if the model or model category fields are empty.</td>
</tr>
<tr>
<td>Show 'Assigned to'</td>
<td>(alm_asset)</td>
<td>Shows the Assigned to field if the State field is not On order, In stock, or In transit.</td>
</tr>
<tr>
<td>Show 'Reserved for'</td>
<td>(alm_asset)</td>
<td>Shows the Reserved for field if the State field is On order, In stock, or In transit.</td>
</tr>
<tr>
<td>Show 'Stockroom'</td>
<td>(alm_asset)</td>
<td>Shows the Stockroom field if either of the following conditions is true:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The State field is In stock and Substate is not Pre-allocated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The Substate is Pre-allocated and Parent is empty.</td>
</tr>
</tbody>
</table>

**Script includes**

Asset Management includes the following script includes.

**Asset Management script includes**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AssetAndCI</td>
<td>Code for creating and managing the relationship between asset and CI records.</td>
</tr>
<tr>
<td>AssetAndClsSynchronizer</td>
<td>Synchronization code between asset and CI records.</td>
</tr>
<tr>
<td>AssetUtils</td>
<td>Utility functions for asset management. Also checks if a license can be merged and then merges licenses if requirements are met.</td>
</tr>
<tr>
<td>AssetUtilsAJAX</td>
<td>AJAX based utility functions for asset management. Call the AssetUtils script include from a client-side UI action.</td>
</tr>
<tr>
<td>Consumables</td>
<td>Code to modify (for example, consume, split, and merge) consumables.</td>
</tr>
<tr>
<td>FixedAssetUtils</td>
<td>Methods for rolling up fixed asset costs.</td>
</tr>
<tr>
<td>PortalFilters</td>
<td>Filters used in the My Assets portal.</td>
</tr>
<tr>
<td>PreAllocatedAssets</td>
<td>Code to modify pre-allocated assets.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>StockRuleFilters</td>
<td>Reference qualifier code for filtering options on reference fields on stock rules.</td>
</tr>
<tr>
<td>StockRuleTransfer</td>
<td>Transfer order creation code for when stock rules are triggered.</td>
</tr>
<tr>
<td>TransferOrderDateTimeAjax</td>
<td>Date comparison utility for transfer orders.</td>
</tr>
<tr>
<td>TransferOrderFilters</td>
<td>Reference qualifier code for reference field filtering options on transfer orders.</td>
</tr>
<tr>
<td>TransferOrderFinder</td>
<td>Finds an appropriate transfer order to put a transfer order line into.</td>
</tr>
<tr>
<td>TransferOrderHelper</td>
<td>Function that checks if a transfer order has multiple transfer order lines.</td>
</tr>
<tr>
<td>TransferOrderLineFilters</td>
<td>Reference qualifier code for reference field filtering options on transfer order lines.</td>
</tr>
<tr>
<td>TransferOrderReceiver</td>
<td>Code for receiving a transfer order line.</td>
</tr>
<tr>
<td>TransferOrderReturn</td>
<td>Code for returning a transfer order line.</td>
</tr>
<tr>
<td>TransferOrderStageHandler</td>
<td>Code for changing transfer order stages and transfer order line stages.</td>
</tr>
<tr>
<td>TransferOrderStageHelper</td>
<td>Helper method to get numeric stages for transfer orders and transfer order lines.</td>
</tr>
</tbody>
</table>

**Client scripts**

Asset Management includes the following client scripts.

**Asset Management client scripts**

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correct substatus</td>
<td>(alm_asset)</td>
<td>Updates the Substatus field when the Status field is modified.</td>
</tr>
<tr>
<td>Ensure no negative quantity</td>
<td>(alm_asset)</td>
<td>Clears the Quantity field when set to less than 1.</td>
</tr>
<tr>
<td>Error on pre-allocated substatus</td>
<td>(alm_consumable)</td>
<td>Prevents Substatus field from being set to Pre-allocated for consumable assets. Also displays an error message.</td>
</tr>
<tr>
<td>Error on pre-allocated substatus</td>
<td>(alm_license)</td>
<td>Prevents Substatus field from being set to Pre-allocated for license assets. Also displays an error message.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Null out allocated_to</td>
<td>(aim_entitlement)</td>
<td>Does the following when the Assigned to field is set:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Clears the Allocated to field and makes it not mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Makes the Assigned to field mandatory.</td>
</tr>
<tr>
<td>Null out assigned_to</td>
<td>(aim_entitlement)</td>
<td>Does the following when the Allocated to field is set:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Clears the Assigned to field and makes it not mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Makes the Allocated to field mandatory.</td>
</tr>
<tr>
<td>Salvage must be less than cost</td>
<td>(aim_asset)</td>
<td>Displays a warning if a salvage value greater than the cost of an asset is entered.</td>
</tr>
<tr>
<td>Set Cost of the Asset</td>
<td>(aim_asset)</td>
<td>Populates the Cost field when the Model field is set.</td>
</tr>
<tr>
<td>Set Loc/CC/Dep/Com from assigned to</td>
<td>(aim_asset)</td>
<td>Populates the Location, Cost center, Department, and Company fields when the Assigned to field is set.</td>
</tr>
<tr>
<td>Set Location from stockroom</td>
<td>(aim_asset)</td>
<td>Populates the Location field when the Stockroom field is set.</td>
</tr>
<tr>
<td>Update From Location from Stockroom</td>
<td>(aim_transfer_order)</td>
<td>Populates the From location field when the From stockroom field is set.</td>
</tr>
<tr>
<td>Update Model and Quantity based on Asset</td>
<td>(aim_transfer_order_line)</td>
<td>Populates the Model field when the Asset field is set. If the asset is a pre-allocated asset, this client script also populates the Quantity field.</td>
</tr>
<tr>
<td>Update To Location from Stockroom</td>
<td>(aim_transfer_order)</td>
<td>Populates the To location field when the To stockroom field is set.</td>
</tr>
<tr>
<td>Update UI on load and model change</td>
<td>(aim_transfer_order_line)</td>
<td>Runs checks, and updates the user interface, when the transfer order line form is loaded and when a model is selected.</td>
</tr>
<tr>
<td>Validate Delivery by Date</td>
<td>(aim_transfer_order)</td>
<td>Validates that the delivery date is in the future.</td>
</tr>
<tr>
<td>Verify Stock Available</td>
<td>(aim_transfer_order_line)</td>
<td>Verifies that stock exists to fulfill the quantity requested.</td>
</tr>
</tbody>
</table>
### Business rules

Asset Management includes the following business rules.

#### Asset Management business rules

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocated more licenses than rights</td>
<td>Software License (alm_license)</td>
<td>Prevents creation or update of a license if the number of licenses allocated is larger than the total rights.</td>
</tr>
<tr>
<td>Asset Retirement</td>
<td>Asset (alm_asset)</td>
<td>Clears the Assigned to, Stockroom, and Reserved for fields and sets the retirement date to the current time when the asset is retired.</td>
</tr>
</tbody>
</table>
| Automatically Change TOL State                 | Transfer Order Line (alm_transfer_order_line) | If a transfer order has the same From stockroom and To stockroom and it is a personal stockroom, this business rule:  
- Sets the transfer order line Stage to Delivered.  
- Sets the asset Substate to Reserved.  
If a transfer order has the same From stockroom and To stockroom and it is not a personal stockroom, this business rule:  
- Sets the transfer order Stage to Received.  
- Sets the asset Substate to Pending transfer. |
<p>| Build bundle components on Insert              | Asset (alm_asset)                    | Creates assets for the components related to a bundle if the model of the created asset is a bundle.                                      |
| Clear Assigned To on update                    | Asset (alm_asset)                    | Clears the Assigned To field if the State field changes to On order, In stock, or in transit.                                              |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear fields irrelevant for preallocated</td>
<td>Asset (alm_asset)</td>
<td>Clears the value of fields that are irrelevant for pre-allocated assets.</td>
</tr>
<tr>
<td>Create Asset on insert</td>
<td>Configuration Items (cmdb_ci)</td>
<td>Creates a corresponding asset when a new configuration item with no asset is created.</td>
</tr>
<tr>
<td>Create asset on model change</td>
<td>Configuration Items (cmdb_ci)</td>
<td>Creates a new associated asset when the Model ID field changes.</td>
</tr>
<tr>
<td>Create CI on insert</td>
<td>Asset (alm_asset)</td>
<td>Creates a corresponding configuration item when a new asset with no configuration item is created.</td>
</tr>
<tr>
<td>Create Stockroom Model Relation</td>
<td>Asset (alm_asset)</td>
<td>Creates a record (if none already exists) in the Stockroom Model table indicating the stockroom that holds the model when an asset is created or updated.</td>
</tr>
<tr>
<td>Delete all Transfer Order Lines</td>
<td>Transfer Order (alm_transfer_order)</td>
<td>Deletes all related transfer order lines when a transfer order is deleted.</td>
</tr>
<tr>
<td>Ensure Entitlements do not exceed rights</td>
<td>License Entitlement (alm_entitlement)</td>
<td>Checks that the total number of entitlements for the related license does not exceed the number of rights given by the license when an entitlement is created.</td>
</tr>
<tr>
<td>GenerateAssets</td>
<td>Model Categories (cmdb_model_category)</td>
<td>Executes a scheduled script job to create assets for configuration items.</td>
</tr>
<tr>
<td>Inherit information from parent</td>
<td>Asset (alm_asset)</td>
<td>Assigns some parent values to the asset when assigning a new parent to an asset.</td>
</tr>
<tr>
<td>Managed Stockroom for Vendor</td>
<td>Stock Rule (alm_stock_rule)</td>
<td>Validates that a vendor replenishing stock rule has a stockroom selected and the stockroom has an associated manager with a valid email address.</td>
</tr>
<tr>
<td>Mandate allocated to or assigned to</td>
<td>License Entitlement (alm_entitlement)</td>
<td>Makes a value in either the Allocated to field or the Assigned to field mandatory.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Merge Records</td>
<td>Consumable (alm_consumable)</td>
<td>Merges consumables that have matching fields and are not in Transit into one record containing the total count.</td>
</tr>
<tr>
<td>Null out asset on insert and stay</td>
<td>Configuration Items (cmdb_ci)</td>
<td>Clears the Asset field on insert if the field contains an asset that has a CI.</td>
</tr>
<tr>
<td>Null out Ci on insert and stay</td>
<td>Asset (alm_asset)</td>
<td>Nulls out the asset field so a new asset is created for the CI if an insert is performed on an existing CI.</td>
</tr>
<tr>
<td>Populate reserved for field</td>
<td>Transfer Order Line (alm_transfer_order_line)</td>
<td>If the transfer order line has an associated request line, this business rule populates the associated asset's Reserved for field with the appropriate information from the request line.</td>
</tr>
<tr>
<td>Push Status to Asset/Consumable</td>
<td>Transfer Order Line (alm_transfer_order_line)</td>
<td>Modifies the corresponding asset to reflect the current state of transit when a transfer order line moves to another state.</td>
</tr>
<tr>
<td>Release Asset on TOL cancel/delete</td>
<td>Transfer Order Line (alm_transfer_order_line)</td>
<td>Places the corresponding asset back into stock and unsources the part requirement when a transfer order line in the draft state is canceled or deleted.</td>
</tr>
<tr>
<td>Rollup TOL cancellation to TO</td>
<td>Transfer Order Line (alm_transfer_order_line)</td>
<td>Signals to the corresponding transfer order that the transfer order line has been canceled.</td>
</tr>
<tr>
<td>Salvage value must be less than cost</td>
<td>Asset (alm_asset)</td>
<td>Prevents saving an asset record if the salvage value is greater than the cost.</td>
</tr>
<tr>
<td>Sanity check on pre-allocated</td>
<td>Asset (alm_asset)</td>
<td>Prevents creation or update of pre-allocated assets if they do not satisfy the conditions to be pre-allocated.</td>
</tr>
<tr>
<td>Set Class</td>
<td>License Entitlement (alm_entitlement)</td>
<td>Sets the class for this entitlement depending on if the entitlement is assigned or allocated.</td>
</tr>
<tr>
<td>Set Transfer Order Type</td>
<td>Transfer Order (alm_transfer_order)</td>
<td>Sets the type of the transfer order depending on whether there is a related service order or work order task.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sync model category</td>
<td>Product Models (cmdb_model)</td>
<td>When the model category changes, this business rule creates assets if they did not previously exist for configuration items associated with the model.</td>
</tr>
<tr>
<td>Transfer Order Stockroom Rules</td>
<td>Transfer Order (alm_transfer_order)</td>
<td>Prevents the From stockroom field from being changed if the transfer order has multiple transfer order lines.</td>
</tr>
<tr>
<td>Transition reserved to assigned</td>
<td>Asset (alm_asset)</td>
<td>Populates the Assigned to field with the value from the Reserved for field when the asset is in the appropriate state.</td>
</tr>
<tr>
<td>Trickle information down to components</td>
<td>Asset (alm_asset)</td>
<td>Updates components of an asset to reflect any changes that have been made to the asset record.</td>
</tr>
<tr>
<td>Update Asset fields on change</td>
<td>Configuration Items (cmdb_ci)</td>
<td>Synchronizes fields so changes made on the Configuration Item form trigger the same update on the corresponding Asset form, ensuring consistent reporting. ServiceNow recommends updating statuses on the Asset form.</td>
</tr>
<tr>
<td>Update CI fields on change</td>
<td>Asset (alm_asset)</td>
<td>Synchronizes fields so changes made on the Asset form trigger the same update on the corresponding Configuration Item form, ensuring consistent reporting.</td>
</tr>
<tr>
<td>Update location as needed</td>
<td>Asset (alm_asset)</td>
<td>Updates the location of the asset, if the asset is set to a new stockroom or assigned to a new user.</td>
</tr>
<tr>
<td>Validate Field Agent Type</td>
<td>Stockroom (alm_stockroom)</td>
<td>Ensures you do not create a stockroom of type Field Agent without Work Management or Field Service Management activated. Allows for only one personal stockroom per user.</td>
</tr>
<tr>
<td>Validate TOL and check availability</td>
<td>Transfer Order Line (alm_transfer_order_line)</td>
<td>Validates changes made to the transfer order line and checks availability of the assets to be transferred in the specified stockroom.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Validate transfer order</td>
<td>Transfer Order (alm_transfer_order)</td>
<td>Validates that the Delivery by date is not earlier than the current date.</td>
</tr>
<tr>
<td>Validate Unique Users</td>
<td>Default Stockroom (alm_user_stockroom)</td>
<td>Prevents the creation of multiple records with the same user.</td>
</tr>
<tr>
<td>Verify Entitlement (Allocated)</td>
<td>License Entitlement (alm_entitlement)</td>
<td>Ensures that the allocation of the entitlement follows the allocation condition on the license, if a condition exists.</td>
</tr>
<tr>
<td>Verify Entitlement (Assigned)</td>
<td>License Entitlement (alm_entitlement)</td>
<td>Ensures that the assignee of the entitlement follows the assignment condition on the license, if a condition exists.</td>
</tr>
<tr>
<td>Verify Entitlements (Allocated)</td>
<td>Software License (alm_license)</td>
<td>Ensures that the allocations of all the license’s entitlements follow the allocation condition on the license, if a condition exists.</td>
</tr>
<tr>
<td>Verify Entitlements (Assigned)</td>
<td>Software License (alm_license)</td>
<td>Ensures that the assignees of all the license’s entitlements follow the assignment condition on the license, if a condition exists.</td>
</tr>
<tr>
<td>Verify Not Field Agent</td>
<td>Default Stockroom (alm_user_stockroom)</td>
<td>Verifies that the selected default stockroom is not of the Field Agent type.</td>
</tr>
</tbody>
</table>

**Domain separation and Asset Management**

This is an overview of domain separation and Asset Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: Basic**

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.
Contract Management

Manage and track contracts with the ServiceNow® Contract Management application.

A contract is a binding agreement between two parties. In the ServiceNow platform, contracts contain detailed information such as the following:

- Contract number
- Contract start and end dates
- Active status
- Terms and conditions statements
- Documents
- Renewal information
- Financial terms

Contract Management is active by default. If the Cost Management plugin is activated, the Contract Management application integrates with the Cost Management plugin to associate contracts with costs and determine the total cost of ownership. You can track recurring expenses with expense lines. An administrator can activate the Cost Management plugin.

If you are using the Software Asset Management plugin, use the Software Licenses option.

Use the Contract Management Overview module

You can view information about your contract status in the Contract Management Overview module. It displays various contract management reports.

Role required: asset, contract_manager

Because the Contract Management Overview module is a type of homepage, you can add, delete, and rearrange reports on the page.

1. Navigate to **Contract > Overview**.
2. Click elements within the reports to obtain more information.
   For example, click any of the colored bars in the **Contract Expenditure by Type** bar chart to see detailed information.
### Asset Contract Overview

<table>
<thead>
<tr>
<th>Vendor Name</th>
<th>Number</th>
<th>Contract Type</th>
<th>Vendor Details</th>
<th>Starts</th>
<th>Ends</th>
<th>Description</th>
<th>Expiration Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Name 1</td>
<td>1</td>
<td>Type 1</td>
<td>Vendor Details</td>
<td>1 Jan</td>
<td>31 Dec</td>
<td>Description 1</td>
<td>Level 1</td>
</tr>
<tr>
<td>Vendor Name 2</td>
<td>2</td>
<td>Type 2</td>
<td>Vendor Details</td>
<td>1 Jan</td>
<td>31 Dec</td>
<td>Description 2</td>
<td>Level 2</td>
</tr>
<tr>
<td>Vendor Name 3</td>
<td>3</td>
<td>Type 3</td>
<td>Vendor Details</td>
<td>1 Jan</td>
<td>31 Dec</td>
<td>Description 3</td>
<td>Level 3</td>
</tr>
</tbody>
</table>

**Contract Expenditure by Type**

- **Type 1**: 50%
- **Type 2**: 30%
- **Type 3**: 20%

**Contract Expenditure by Vendor**

- **Vendor Name 1**: 80%
- **Vendor Name 2**: 15%
- **Vendor Name 3**: 5%
Components installed with Contract Management

Several types of components are installed with Contract Management. Demo data is available.

Tables installed with Contract Management

Tables are added with Contract Management.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Covered (clm_m2m_contract_asset)</td>
<td>Lists the assets covered by a contract. An asset can be covered by multiple contracts and a contract can have multiple assets.</td>
</tr>
<tr>
<td>Asset Covered (clm_m2m_rate_card_asset)</td>
<td>Lists the rate cards that apply to an asset.</td>
</tr>
<tr>
<td>Condition (clm_condition_checker)</td>
<td>Lists the conditions and values for each condition checker.</td>
</tr>
<tr>
<td>Condition Checks (clm_condition_check)</td>
<td>Stores conditions and values that modify specified condition fields.</td>
</tr>
<tr>
<td>Contract (ast_contract)</td>
<td>Stores contract information.</td>
</tr>
<tr>
<td>Contract History (clm_contract_history)</td>
<td>Stores a copy of the contract when the start date, end date, or terms and conditions change.</td>
</tr>
<tr>
<td>Terms and Conditions (clm_terms_and_conditions)</td>
<td>Lists the terms and conditions used by contracts.</td>
</tr>
<tr>
<td>Terms and Conditions (clm_m2m_contract_and_terms)</td>
<td>Lists all terms and conditions available for use with contracts.</td>
</tr>
<tr>
<td>Users Covered (clm_m2m_contract_user)</td>
<td>Lists the users covered by contracts.</td>
</tr>
</tbody>
</table>

User roles installed with Contract Management

A user role is added with Contract Management.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>contract_manager</td>
<td>financial_mgmt_user</td>
<td>Manages the contract life cycle. Can create, edit, and delete contracts.</td>
</tr>
</tbody>
</table>

Script includes installed with Contract Management

Script includes are added with Contract Management.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConditionChecks</td>
<td>Checks for matching conditions, such as for contract expirations and license compliance, defined in the Condition Checks (clm_condition_check) table.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ContractManagementUtils</td>
<td>Utilities that manage contract management actions, such as state transitions.</td>
</tr>
</tbody>
</table>

**Client scripts installed with Contract Management**

Client scripts are added with Contract Management.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Tax Cost - Base cost</td>
<td>Contract (ast_contract)</td>
<td>Calculates the Tax cost field and the Total cost field on the Contract form when the Payment amount field changes.</td>
</tr>
<tr>
<td>Calculate Tax Cost - Sales tax</td>
<td>Contract (ast_contract)</td>
<td>Calculates the Tax cost field and the Total cost field on the Contract form when the Sales tax field changes.</td>
</tr>
<tr>
<td>Calculate Tax Cost - Tax rate</td>
<td>Contract (ast_contract)</td>
<td>Calculates the Tax cost field and the Total cost field on the Contract form when the Tax rate field changes.</td>
</tr>
<tr>
<td>Ensure discount is valid percent</td>
<td>Contract (ast_contract)</td>
<td>Ensures that the Discount field does not contain a value less than zero or greater than 99.</td>
</tr>
<tr>
<td>Renew Cost Adjustment</td>
<td>Contract (ast_contract)</td>
<td>Sets the Percentage field on the Contract form to zero if the user sets a dollar amount for the cost adjustment.</td>
</tr>
<tr>
<td>Renew Cost Percentage</td>
<td>Contract (ast_contract)</td>
<td>Sets the Amount field on the Contract form to zero if the user enters a percentage for the cost adjustment.</td>
</tr>
<tr>
<td>Tax exempt/ rate</td>
<td>Contract (ast_contract)</td>
<td>Changes all tax-related fields on the Contract form to read-only if the Tax Exempt check box is selected.</td>
</tr>
<tr>
<td>Tax rate/exempt</td>
<td>Contract (ast_contract)</td>
<td>Changes all tax-related fields on the Contract form to writeable if the Sales Tax check box is selected.</td>
</tr>
</tbody>
</table>

**Business rules installed with Contract Management**

Business rules are added with Contract Management.
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate projected costs (Reports)</td>
<td>Contract (ast_contract)</td>
<td>Calculates the projected monthly and annual costs for a contract when costs or payment schedule changes.</td>
</tr>
<tr>
<td>Calculate totals with tax</td>
<td>Contract (ast_contract)</td>
<td>Calculates the Tax cost and Total cost fields for a contract when the contract is created or updated.</td>
</tr>
<tr>
<td>Contract history</td>
<td>Contract (ast_contract)</td>
<td>Stores history when the start, end, or terms and conditions of a contract change.</td>
</tr>
<tr>
<td>Create approval record</td>
<td>Contract (ast_contract)</td>
<td>Updates contract Terms and Conditions and starts the contract approval workflow when a contract is sent for review.</td>
</tr>
<tr>
<td>Flag terms and conditions</td>
<td>Terms and Conditions (clm_m2m_contract_and_terms)</td>
<td>Sets the Use flag on a Terms and Conditions record to true after the record is associated with a contract or to false after the record is disassociated from a contract.</td>
</tr>
<tr>
<td>Activate count for manual licenses</td>
<td>Software License Instance</td>
<td>Calculates and updates the number of computers a particular license is installed on when a software license instance is created or deleted.</td>
</tr>
</tbody>
</table>
| Manage contract lifecycle           | Contract (ast_contract)                    | This business rule:  
  - Updates the end date of a contract when a contract extension has been approved.  
  - Renews the contract, updating its start date, end date, and base cost (if cost adjustments must be applied) when a contract renewal has been approved and the renewal has reached its start date.  
  - Runs the condition checks to evaluate if dates need to be changed when a contract is approved, or an extension or renewal is approved, or the start or end dates have changed. |
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post outage to news</td>
<td>Service (cmdb_ci_service)</td>
<td>Posts a news article on the knowledge table when there is an outage.</td>
</tr>
<tr>
<td>Update contract cost per asset</td>
<td>Asset Covered (clm_m2m_contract_asset)</td>
<td>Updates the cost per unit value based on the total cost and number of assets associated to the contract.</td>
</tr>
<tr>
<td>Update contract lifetime cost</td>
<td>Contract Rate Card (fm_contract_rate_card)</td>
<td>Calculates the lifetime cost of the contract by calculating the sum of the contract expense lines.</td>
</tr>
<tr>
<td>Updates after contract dates change</td>
<td>Contract (ast_contract)</td>
<td>Updates the <strong>Date added</strong> and <strong>Date removed</strong> fields for all assets and users associated with a contract if the contract end date changes.</td>
</tr>
<tr>
<td>Updates after rate card dates change</td>
<td>Contract Rate Card (fm_contract_rate_card)</td>
<td>Updates the related contract assets and users linked to the rate card when the end date is changed.</td>
</tr>
<tr>
<td>Verify contract’s start and end dates</td>
<td>Contract (ast_contract)</td>
<td>Validates contract start and end dates and contract renewal start and end dates.</td>
</tr>
<tr>
<td>Verify purchase agreement discount price</td>
<td>Contract (ast_contract)</td>
<td>For contracts with the contract model <strong>Purchase Agreement</strong>, the business rule validates that the <strong>Discount</strong> field does not contain a value less than zero or greater than 99.</td>
</tr>
</tbody>
</table>

**Contract Management use**

Users with the contract_manager role can use the Contract Management application to create various types of contracts, such as leases, warranties, maintenance, and service.

You can add the following information to contracts.

- Assets covered by the contract
- Users covered by the contract
- Terms and conditions associated with the contract
- Other documents related to the contract

Track the various stages of a contract from draft to closure by viewing contract history and running reports. Adjust, extend, and renew active contracts.

**Contract life cycle**

From creation until closure, contracts follow a life cycle that determines which fields can be edited.
When a contract is in Draft state, almost all fields on the contract record can be edited. After a contract moves past the Draft state, certain date, renewal, extension, and financial fields become read-only. The State field and Substate field are always read-only.

A scheduled job named Contract Compliance Checks runs on the Contract (ast_contract) table automatically each night. For more information about the scheduled job, see Use Condition Check Definitions. The scheduled job performs the following actions:

- Changes the contract state to Active if the contract is approved and reaches the specified start date.
- Renews the contract if the contract is approved for renewal and reaches the specified start date.
- Changes the contract state to Expired if the contract state is Active and reaches the end date.

Expense lines are only generated from contracts that are active or expired.

### Contract states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>User adds information about the contract and specifies an approver.</td>
</tr>
<tr>
<td>Active</td>
<td>Contract was approved and has reached the specified start date.</td>
</tr>
<tr>
<td>Expired</td>
<td>Contract reached the specified end date. Expired contracts with an active renewal workflow that are waiting for approval have a substate of Awaiting Review. Expired contracts with an active renewal workflow where the renewal was approved, but the renewal date has not yet passed, have a substate of Renewal Approved. Expired contracts with no active renewal or extension pending workflow have an empty substate.</td>
</tr>
<tr>
<td>Canceled</td>
<td>Contract was discontinued and is no longer active.</td>
</tr>
</tbody>
</table>

In addition to a state, a contract can also have a substate.

### Contract substates

<table>
<thead>
<tr>
<th>Substate</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Awaiting Review</td>
<td>Contract is being prepared for review.</td>
</tr>
<tr>
<td>Under Review</td>
<td>Contract sent to the approver and the approver is reviewing the contract.</td>
</tr>
<tr>
<td>Approved</td>
<td>Contract reviewed and accepted by the approver.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Contract reviewed and declined by the approver.</td>
</tr>
<tr>
<td>Renewal Approved</td>
<td>Contract renewal approved the approver.</td>
</tr>
<tr>
<td>Renewal Rejected</td>
<td>Contract renewal rejected by the approver.</td>
</tr>
<tr>
<td>Extension Approved</td>
<td>Contract extension approved by the approver.</td>
</tr>
<tr>
<td>Substate</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Extension Rejected</td>
<td>Contract extension rejected by the approver.</td>
</tr>
<tr>
<td>None</td>
<td>No substate is specified.</td>
</tr>
</tbody>
</table>

**Contracts**

A contract is a binding agreement between two parties.

In the Now Platform, contracts contain detailed information such as contract number, start and end dates, active status, terms and conditions statements, documents, renewal information, and financial terms.

Working with contracts includes the following tasks and processes.

*Create a contract*

You can create various contract models for leases, maintenance, or warranties.

Role required: contract_manager or admin

If a contract has one or more associated rate cards, the fields on the Contract form cannot be edited.

1. Navigate to **Contract** and select the type of contract, such as **Insurance**, **Maintenance**, or **Service**, or select **All**.
2. Click **New**.
3. Complete the form.

Not all fields appear on all contract type forms.

**Contract form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique number identifying the contract record.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor responsible for the contract. This field is required when the contract model selected is NDA or Purchase Agreement.</td>
</tr>
<tr>
<td>Contract model</td>
<td>Model the contract is assigned to. For example Lease, Maintenance, Warranty, or Service Contract.</td>
</tr>
<tr>
<td>Commitment</td>
<td>Amount committed to spend with this vendor during this time period, from the start to the end of the contract.</td>
</tr>
<tr>
<td>Discount</td>
<td>Discount the vendor has agreed to provide.</td>
</tr>
<tr>
<td>Contract number</td>
<td>Number assigned to the contract by the vendor (required).</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the contract: Draft, Active, Expired, or Canceled.</td>
</tr>
<tr>
<td>Substate</td>
<td>Current substate of the contract. For example, Awaiting Review, Under Review, Approved, or Rejected.</td>
</tr>
<tr>
<td>License quantity entitled</td>
<td>Number of licenses included in the contract. This field is available for Maintenance and Software License contracts.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Parent contract</td>
<td>Parent contract of the new contract, if applicable. You can select a parent contract from the contract lookup list.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the contract.</td>
</tr>
<tr>
<td>General section</td>
<td></td>
</tr>
<tr>
<td>Starts</td>
<td>Date on which the contract takes effect. This field is required if the contract model is Purchase Agreement or NDA.</td>
</tr>
<tr>
<td>Ends</td>
<td>Date on which the contract expires. Leave the end date blank to create an open-ended contract. This field is required if the contract model is Purchase Agreement or NDA.</td>
</tr>
<tr>
<td>PO Number</td>
<td>Purchase order number assigned to the contract.</td>
</tr>
<tr>
<td>Vendor account</td>
<td>Vendor account associated with the contract.</td>
</tr>
<tr>
<td>Agreement type</td>
<td>Agreement type of license: Enterprise, SaaS, or Subscription. This field is available for Maintenance and Software License contracts.</td>
</tr>
<tr>
<td>Application model</td>
<td>Application model associated with the contract.</td>
</tr>
<tr>
<td>Location</td>
<td>Location covered by the contract.</td>
</tr>
<tr>
<td>Contract administrator</td>
<td>Person responsible for managing the contract and interacting with the vendor.</td>
</tr>
<tr>
<td>Approver</td>
<td>User who approves or rejects the contract. List is filtered to only show users with the itil role.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the contract.</td>
</tr>
<tr>
<td>Renewal/Extension section</td>
<td></td>
</tr>
<tr>
<td>Automatically renew/extend</td>
<td>Indicates if the contract can be renewed at the end of its term.</td>
</tr>
<tr>
<td>Options</td>
<td>Duration of the contract renewal or extension. For example, 1 year.</td>
</tr>
<tr>
<td>Renewal/Extension date</td>
<td>Date on which the contract renewal or extension takes effect.</td>
</tr>
<tr>
<td>Renewal/Extension end date</td>
<td>Date on which the contract renewal or extension ends.</td>
</tr>
<tr>
<td>Renewal/Extension contact</td>
<td>Individual who works for the vendor and is responsible for renewing the contract.</td>
</tr>
<tr>
<td>Cost adjustment type</td>
<td>Type of cost adjustment applied to the contract: Fixed, Manual, or CPI (consumer price index).</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cost adjustment amount</td>
<td>Numerical increase or decrease in price of contract. To indicate a decrease in price, enter a negative number. Either a Cost adjustment or Cost adjustment percentage can be specified, but not both.</td>
</tr>
<tr>
<td>Cost adjustment percentage</td>
<td>Percentage increase or decrease in price of contract. To indicate a decrease in price, enter a negative percentage. Either a Cost adjustment or Cost adjustment percentage can be specified, but not both.</td>
</tr>
</tbody>
</table>

### Financial section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost center</td>
<td>Cost center that is financially responsible for the asset.</td>
</tr>
<tr>
<td>Tax exempt</td>
<td>Indicates if the contract is exempt from tax.</td>
</tr>
<tr>
<td>Sales tax</td>
<td>Indicates whether or not sales tax is applied to the total cost.</td>
</tr>
<tr>
<td>Effective tax rate</td>
<td>Effective tax rate to apply to the total cost, if applicable. Effective tax rate is usually the average tax rate charged.</td>
</tr>
<tr>
<td>Has rate card</td>
<td>Check box to indicate whether the contract has an associated rate card.</td>
</tr>
<tr>
<td>Invoice payment terms</td>
<td>Terms that explain how to pay the contract. For example, Net Monthly Account or Net 30.</td>
</tr>
<tr>
<td>Payment schedule</td>
<td>Schedule that defines when to make payments. For example, Monthly or Annually.</td>
</tr>
<tr>
<td>Payment amount</td>
<td>Amount which has been paid on the contract to date.</td>
</tr>
<tr>
<td>Tax cost</td>
<td>Total cost of the tax.</td>
</tr>
<tr>
<td>Total cost</td>
<td>Final cost of the contract after adjustments have been applied. If a contract has one or more rate cards, this field shows the combined value of all rate cards.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Save**.
5. Continue entering information in the additional sections and related lists that appear.

### Contract form fields and related lists

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terms and Conditions section</td>
<td>Specific legal information in the contract.</td>
</tr>
<tr>
<td>Terms and conditions</td>
<td>Specific legal information in the contract.</td>
</tr>
</tbody>
</table>

**Related lists**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets Covered</td>
<td>Lists all assets covered by this contract.</td>
</tr>
<tr>
<td>Users Covered</td>
<td>Lists all users covered by this contract.</td>
</tr>
<tr>
<td>Contract used by</td>
<td>Lists all configuration items (CI) used in this contract.</td>
</tr>
</tbody>
</table>
6. Perform one of the following actions.
   - Click Update to save and exit the contract.
   - Click Submit for Review to send notification to the approver.

Create a software maintenance contract example
One common use case for the Contract Management application is creating a contract to track maintenance payments for enterprise software. You can use this example to learn how to create a software maintenance contract.

Role required: contract_manager or admin

The goal of this example is to create a contract that shows the total amount of maintenance that must be paid for the software application, independent of different license purchases made over time. The Software Asset Management plugin must be activated to use this example.

1. Create an application model, adding a Name and specifying Software License in Model categories.
2. Create a software model, adding a Name and Model Number, and selecting the application model created in step 1.
3. Follow the steps in Add a software entitlement to create a new software entitlement, selecting the software model created in step 2.
5. Click New and enter the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agreement Type</td>
<td>Select Enterprise.</td>
</tr>
<tr>
<td>Application Model</td>
<td>Select the application model created in step 1.</td>
</tr>
</tbody>
</table>

6. Right-click the form header and click Save.
A number of related lists and sections appear.
7. In the Asset Covered related list, click New and enter the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset</td>
<td>Select the software license created in step 3.</td>
</tr>
<tr>
<td>Date added</td>
<td>Enter the value.</td>
</tr>
</tbody>
</table>
8. Click Submit.
9. Continue completing the form with the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment schedule</td>
<td>Select Annually.</td>
</tr>
<tr>
<td>Payment amount</td>
<td>Enter the value.</td>
</tr>
</tbody>
</table>

10. Complete the other fields as appropriate.
11. Click Update.
12. Submit the contract for review.

Add an asset to a contract
You can associate contracts with specific assets, including software licenses.

Role required: contract_manager or admin

Linking a contract with assets clarifies what the contract legally covers.

2. Select a contract.
3. In the Assets Covered related list, click New.
4. In Asset, select a specific asset that is covered by the contract.
5. In Date added, select the date the asset was added to the contract. The date can be in the past, the present, or the future.
6. Optional: In Date removed, select the date the asset was, or will be, removed from the contract. Specifying Date added and Date removed is useful for reporting.
7. Click Submit.

Add a user to a contract
A contract can cover specific users. For example, you may use a contract to hire a group of temporary workers.

Role required: contract_manager or admin

2. Select a contract.
3. In the Users Covered related list, click New.
4. In User, select a specific user covered by the contract.
5. In Date added, select the date the user was added to the contract. The date can be in the past, the present, or the future.
6. Optional: In Date removed, select the date the user was, or will be, removed from the contract. Specifying Date added and Date removed can be useful for reporting.
7. Click Submit.

Add a configuration item to a contract
Contracts can be associated with specific configuration items. You can link a contract with configuration items to clarify what the contract legally covers.

Role required: contract_manager or admin

2. Select a contract.
3. Optional: In the Contract used by related list, click New to create a new configuration item.
4. In the Contract used by related list, click Edit.
5. In the Collection configuration items list on the left, double-click a configuration item name.
The item is added to the **Contract used by List** on the right.

6. **Click Save.**

Add a document to a contract

Contracts can be associated with documents. Linking a contract to related documents helps keep all relevant information about a contract together and easily accessible.

The **Managed Documents** plugin must be activated.

Role required: contract_manager or admin

1. Navigate to **Contract Management > Contract > All.**
2. Select a contract.
3. In the **Documents** related list, click **Edit.**
   All documents stored in the Managed Documents application appear in the **Collection** list. If the **Collection** list is long, create a filter of **Type is Contract** and click **Run filter.**
4. In the **Collection** list, double-click a document.
   The item is added to the **Documents List.**
5. **Click Save.**

Adjust a contract

After creating a contract, you can change the start date, end date, or payment amount for a contract.

Role required: contract_manager or admin

To adjust a contract, the **State** should be **Active.** If the end date of a contract changes, the end date of any associated assets changes to match the new end date.

1. Navigate to **Contract > Contracts > All.**
2. Select a contract in **Active** state.
3. **Click Adjust.**
4. Complete the form (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract Start Date</td>
<td>Date on which the contract takes effect.</td>
</tr>
<tr>
<td>Contract End Date</td>
<td>Date on which the contract expires.</td>
</tr>
<tr>
<td>Contract Payment Amount</td>
<td>Total amount paid for the contract. If the contract has one or more rate cards, this field shows the total of all rate card base costs.</td>
</tr>
</tbody>
</table>

5. **Click Apply changes.**

Renew a contract

After you have created a contract or the contract has expired, you can renew the contract.

Role required: contract_manager or admin

Contract information and history is retained when a contract is renewed. If the end date of the contract changes, the end date of any associated assets changes to match. You can renew a contract that meets the following conditions.

- **State** is **Active** or **Expired**
• Substate is None or Rejected

1. Navigate to Contract > Contracts > All.
2. Select a contract in Active or Expired state.
3. Click Renew.
4. Complete the form.

**Contract renewal fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Renewal Contact</td>
<td>Individual who works for the vendor and is responsible for renewing the contract.</td>
</tr>
<tr>
<td>Renewal Start Date</td>
<td>Date on which the renewed contract takes effect.</td>
</tr>
<tr>
<td>Renewal Option</td>
<td>Length of time for the renewal, in years.</td>
</tr>
<tr>
<td>Renewal End Date</td>
<td>Date on which the renewed contract expires.</td>
</tr>
<tr>
<td>Cost Adjustment Type</td>
<td>Type of cost adjustment applied to the renewed contract: None, Fixed, Manual, or CPI.</td>
</tr>
<tr>
<td>Approver</td>
<td>User who approves or rejects the contract.</td>
</tr>
<tr>
<td>Cost Adjustment</td>
<td>Numerical increase or decrease in price of the renewed contract. To indicate a decrease in price, enter a negative number. A Cost Adjustment or Cost Adjustment Percentage can be specified, but not both.</td>
</tr>
<tr>
<td>Cost Adjustment Percentage</td>
<td>Percentage increase or decrease in price of the renewed contract. To indicate a decrease in price, enter a negative percentage. A Cost Adjustment or Cost Adjustment Percentage can be specified, but not both.</td>
</tr>
</tbody>
</table>

5. Perform one of the following steps.
   • To save all entered data and change the substate to Under Review, click Submit for Review. The contract is sent to the specified Approver.
   • To save all entered data and change the substate to Awaiting Review, click Save But Do Not Submit. The Renew button is available to submit the renewed contract for review later.

6. Change any information on the Contract form, as necessary.
7. Click Update.

If you selected the Save But Do Not Submit option, ensure that you click Renew when you are ready to submit the contract renewal for approval.

**Extend a contract**

After creating a contract, you can extend it, if necessary. Extending the end date retains contract information and history.

Role required: contract_manager or admin

When you extend a contract, the end date of any associated assets changes to match the new contract end date. All other contract dates, including notification dates, are recalculated.
automatically based on the new end date. You can extend a contract that meets the following conditions.

- **State** must be **Active** or **Expired**
- **Substate** must be **None** or **Rejected**

1. Navigate to **Contract > Contracts > All**.
2. Select a contract in **Active** or **Expired** state.
3. Click **Extend**.
4. Select an option from **Extension Option** or enter an **Extension End Date**.
5. Complete the form.

### Extend the contract

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extension Contact</td>
<td>Individual who works for the vendor and is responsible for extending the contract.</td>
</tr>
<tr>
<td>Extension Option</td>
<td>Length of time for the extension, in years.</td>
</tr>
<tr>
<td>Extension End Date</td>
<td>Date on which the extended contract expires.</td>
</tr>
<tr>
<td>Cost Adjustment Type</td>
<td>Type of cost adjustment to apply to the extended contract: None, Fixed, Manual, or CPI.</td>
</tr>
<tr>
<td>Approver</td>
<td>User with the contract_manager role who approves or rejects the contract extension.</td>
</tr>
<tr>
<td>Cost Adjustment</td>
<td>Numerical increase or decrease in price of the extended contract. To indicate a decrease in price, enter a negative number. A Cost Adjustment or Cost Adjustment Percentage can be specified, but not both.</td>
</tr>
<tr>
<td>Cost Adjustment Percentage</td>
<td>Percentage increase or decrease in price of the extended contract. To indicate a decrease in price, enter a negative percentage. A Cost Adjustment or Cost Adjustment Percentage can be specified, but not both.</td>
</tr>
</tbody>
</table>

6. Perform one of the following tasks.

- To save all entered data and change the substate to **Under Review**, click **Submit For Review**. The contract can be sent to the specified **Approver**.
- To save all entered data and change the substate to **Awaiting Review**, click **Save But Do Not Submit**. The **Extend** button is available to submit the extended contract for review later.

### Cancel a contract

You can cancel a contract when the **State** is **Active**.

Role required: contract_manager or admin

After a contract is canceled, the following process occurs.

- The contract **State** changes to **Canceled**.
- Condition checkers are changed to inactive.
- **Renew** and **Extend** buttons become inactive.
- Contract rate cards become inactive.

1. Navigate to **Contract > Contracts > All**.
2. Select a contract.
3. Click **Cancel Contract**.
4. Click **Yes** to confirm contract cancellation.

**Verify contract administrator assignment for notification**

An event runs automatically each night to send reminders to contract administrators about contract expiration dates so they can renew or renegotiate the contract. You can verify that the right contract administrator is assigned to the contract.

**Role required:** contract_manager or admin

When the contract.expiration event runs on the Contract (ast.contract) table each night, an email message is sent to the person identified as the contract administrator. This email is sent at the following times.

- 90 days ahead of the contract expiration date
- 60 days ahead of the contract expiration date
- 30 days ahead of the contract expiration date
- On the contract expiration date

A user with the admin role can edit the contract.expiration condition check that processes contract notifications.

1. Navigate to **Contract > Contracts > All**.
2. Select a contract.
3. Check that the **Contract administrator** field contains the correct name. A single name can be specified.

**Send the contract for approval**

You can send a contract that is in **Draft** state for approval.

**Role required:** contract_manager or admin

**Note:** Contract approval is only applicable if you are manually adding your contract approvals in the Now Platform. If you have already approved your contracts, you are not required to use this option.

1. Navigate to **Contract > Contracts > All**.
2. Select a contract in **Draft** state.
3. Select an **Approver** for the contract.
4. Click **Submit For Review**.
   An email message is sent to the selected approver and the contract **Substate** changes to **Under Review**.

**Approve or reject a contract**

If you are the contract manager, you can approve or reject a contract.

**Role required:** contract_manager or admin

1. Navigate to **Contract > My Approvals**.
2. Select a contract in **Requested** state.
3. Perform one of the following tasks.
   - To approve the contract, click Approve. The contract Substate changes to Approved.
   - To reject the contract, Click Reject and enter a rejection reason in the Comments field. The contract Substate changes to Rejected.

4. Click Update.
   - A contract with the state set to Draft and a start date set in the future is kept in Draft until the start date is reached. If the contract has a Substate of Approved, the system changes the State to Active and removes the Substate value.
   - When a contract with a State of Draft and a Start Date set to a date in the past is approved, the contract State is automatically set to Active and Substate is left blank.

View approval history on contracts
You can view the approval history for a contract in the Approval History related list on the Contract form.
Role required: workflow_admin or admin
After a contract is sent to an approver for review, the approver name cannot be changed. If the approver rejects a contract, the same approver or a different approver can be specified before the contract is sent for approval again. Once the contract has been reviewed and approved, approval history records are automatically listed in the Approval History related list on the Contract form.

1. Navigate to Contract and select a record.
2. Click the Approval History related list.
3. Click a record to view approval details.

Terms and conditions
You can add terms and conditions to a contract to keep all documentation that is relevant to a contract in one location.

The terms and conditions can be searched and used in reports. If multiple terms and conditions records are added to a single contract, set an order for the records so they appear in a specific sequence. The terms and conditions fields become read-only after a contract is sent for approval.

Users with the contract_manager role can read contract history and add terms and conditions.

There are three procedures involved in adding terms and conditions to a contract:

Create a terms and conditions record
You can create a terms and conditions record to add to a contract.

Role required: contract_manager or admin

1. Navigate to Contract > Contracts > Terms & Conditions and create a new record (see table for field descriptions).

   Terms and Conditions form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique ID used for the terms and conditions. This field is automatically generated.</td>
</tr>
<tr>
<td>Name</td>
<td>Name for the terms and conditions.</td>
</tr>
<tr>
<td>Contract</td>
<td>Link to the contract.</td>
</tr>
</tbody>
</table>
2. Click Submit.

Add terms and conditions to a contract

After you create a terms and conditions record, add the record to a contract.

Role required: contract_manager or admin

1. Navigate to **Contract** > **Contracts** > **All**.
2. Select a contract.
3. In the **Terms and Conditions** section, double-click **Insert a new row**.
4. Click the reference lookup icon and select a terms and conditions record from the list.
5. Optional: Enter a number in **Order** to specify the sequence in which the record should appear in the terms and condition document.

**Note:** If you attempt to enter a duplicate terms and conditions record for a contract and save the record, an error message appears and the new duplicate record is not added.

Build a terms and conditions document within a contract

After adding one or more terms and conditions records to a contract, you can build a terms and conditions document within the contract.

Role required: contract_manager or admin

The terms and conditions records are added in the sequence specified in the **Order** field.

1. Navigate to **Contract Management** > **Contract** > **All**.
2. Select a contract.
3. Ensure that one or more terms and conditions records have been added to the **Terms and Conditions** section.
4. In **Related Links**, click **Build Terms and Conditions**.
   All records from the **Terms and Conditions** related list are added to the Terms and Conditions section of the contract record.
Create a contract rate card
You can create rate cards to track contract expenses. Rate cards help to record and allocate costs.

You must activate Cost Management to use rate cards.

Role required: financial_mgmt_user, asset, or contract_manager

A contract rate card provides detailed price information for a contract and enables you to generate expense lines for recurring expenses automatically. There can be multiple rate cards for the same contract.

Consider the following case: an organization has a contract with a third-party company, which oversees technical operations in the organization's data centers. The contract costs to use a specific server model in the New York data center are different from using the same server model in the Madrid data center. There are two rate cards to detail these costs separately.

2. Select a contract.
3. In the Contract Rate Cards related list, click New.
4. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The contract rate card number.</td>
</tr>
<tr>
<td>Contract</td>
<td>The internal contract number.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The contract rate card type. Categorizing rate cards can be useful for reporting. Select Grow Business, Run Business, or Transform Business.</td>
</tr>
<tr>
<td>Name</td>
<td>A descriptive name for the contract rate card.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that indicates whether the rate card is available for use.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the contract rate card.</td>
</tr>
<tr>
<td>Start date</td>
<td>The date on which the contract rate card becomes active. Expense lines are generated for costs incurred beginning on the date specified. For financial calculations to work, the date cannot be before the start date of the contract.</td>
</tr>
<tr>
<td>End date</td>
<td>The date on which the contract rate card becomes inactive. No expense lines are generated for costs incurred after the end date. For financial calculations to work, the date cannot be after the end date of the contract. The date is automatically set to the end date of the contract if no value is entered and the contract has an end date.</td>
</tr>
<tr>
<td>Interval</td>
<td>The amount of time between rate card charges. For example, Monthly, Quarterly, or Annually.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost center</td>
<td>The cost center financially responsible for the rate card.</td>
</tr>
<tr>
<td>Last processed</td>
<td>The most recent date on which the rate card was charged.</td>
</tr>
<tr>
<td>Next process</td>
<td>The next date on which the rate card will be charged.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed information about the rate card.</td>
</tr>
<tr>
<td>Sales tax</td>
<td>Check box that indicates whether to apply sales tax to the total cost.</td>
</tr>
<tr>
<td>Tax rate</td>
<td>The effective tax rate to apply to the total cost. Tax rate is usually the average tax rate charged.</td>
</tr>
<tr>
<td>Distribute cost</td>
<td>The method for distributing the amount listed in Base cost and generating expense lines.</td>
</tr>
<tr>
<td>Value</td>
<td>Type of value to use when Allocate and distribute cost based on value is selected in the Distribute cost field.</td>
</tr>
<tr>
<td>Base cost</td>
<td>The amount that must be paid before taxes.</td>
</tr>
<tr>
<td>Tax cost</td>
<td>The total cost of the tax.</td>
</tr>
<tr>
<td>Total cost</td>
<td>The final cost of the rate card after adjustments, such as taxes, have been applied.</td>
</tr>
</tbody>
</table>

5. **Click Submit.**

Create a new expense line

Typically, expense lines are automatically generated based on assets or users, but you can create a new expense line manually if needed.

**Role required: asset or contract_manager**

1. **Navigate to Contract Management > Contract > All.**
2. **Select a contract.**
3. **In the Expense Lines related list, click New.**
4. **Complete the form.**

#### Expense line table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the expense line.</td>
</tr>
<tr>
<td>Date</td>
<td>The date on which the expense line was created.</td>
</tr>
<tr>
<td>Rate Card</td>
<td>The identification number of the rate card to which the expense line is associated.</td>
</tr>
<tr>
<td>Rate type</td>
<td>The rate type that is considered during the expense line generation. This field is read-only.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source ID</td>
<td>The identification number of the item associated with the expense line. If this field is filled in, corresponding information is automatically added to the Source fields on this form.</td>
</tr>
<tr>
<td>Amount</td>
<td>The monetary value of the item specified in the Source ID field. Enter a negative value to indicate a credit.</td>
</tr>
<tr>
<td>Process date</td>
<td>The date the expense line is processed.</td>
</tr>
<tr>
<td>Inherited</td>
<td>Check box that indicates whether the expense line is on another expense line.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the expense line, either Pending or Processed.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The expense line category: Grow Business, Run Business, or Transform Business. Categorizing expense lines can be useful for reporting.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the expense line.</td>
</tr>
<tr>
<td>Asset</td>
<td>The identification number of the asset associated with the expense line, if any.</td>
</tr>
<tr>
<td>Fixed asset</td>
<td>Fixed asset that contains the asset in this expense line. A fixed asset is a container that holds one or more individual assets, including hardware or software assets. The system auto-populates this field with the appropriate fixed asset if the named Asset is contained within that fixed asset.</td>
</tr>
<tr>
<td>Contract</td>
<td>The identification number (not the contract number) of the contract associated with the Asset, if any.</td>
</tr>
<tr>
<td>User</td>
<td>The name of the user associated with the Asset, if any.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>The name of the configuration item associated with the expense line, if any.</td>
</tr>
<tr>
<td>Task</td>
<td>The identification number of the task associated with the expense line, if any.</td>
</tr>
<tr>
<td>Cost center</td>
<td>The cost center financially responsible for the item identified in Source ID; if any.</td>
</tr>
</tbody>
</table>

5. **Click Submit.**

Generating expense lines based on assets or users
An expense line is an expense amount at a given point in time and the record that incurred or generated the expense. You can generate expense lines based on assets or users assigned to the contract.

Role required: financial_mgmt_user, asset, or contract_manager

Generating expense lines is a three-step procedure.
Add a user or asset to a contract
You can add a user or asset to a contract to generate expense lines.

Role required: financial_mgmt_user, asset, or contract_manager

2. Create a new contract or select an existing contract.
3. In the Assets Covered or Users Covered related list, click New.
4. Specify an Asset or User.
5. Specify a Date Added.
6. Click Submit.
7. Optional: Repeat the previous steps to add more assets or users to the contract.

Create a rate card and assign a user or asset

You can assign a user or asset when you create a rate card. You can only assign the user or asset that is assigned to the contract.

Role required: financial_mgmt_user, asset, or contract_manager

2. Select a contract with an assigned user or asset.
3. In the Contract Rate Cards related list, click New.
4. Specify a Start date.
   For financial calculations to work, the date cannot be before the start date of the contract.
5. Right-click the header bar and select Save.
6. In the Asset Covered or Rate Card Users related list, click New.
7. Select the Asset or User who is assigned to the contract.
   Only assets and users associated with the parent contract are listed.
8. Specify a Date Added.
9. Click Submit.

Configure rate card expense generation

After assets or users are added to the rate card, you can use the Distribute cost field in the Financial section of the contract to generate rate card expenses.

Role required: financial_mgmt_user, asset, or contract_manager

1. Navigate to Contract > Contracts > All.
2. Select the contract to generate expenses.
3. In the Contract Rate Card related list, select a rate card.
4. In Distribute cost, select one of the following options to distribute the amount listed in Base cost.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split expense lines evenly across assets</td>
<td>Select Allocate and distribute cost per asset. For example, with a $100 Base cost and two assets, two expense lines for $50 are created.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
Split expense lines across assets based on asset value | Select Allocate and distribute cost based on value:

The Value field displays with Cost and Residual Cost options. The cost is derived from the Cost or Residual Cost field on an asset record. If there are multiple assets on the rate card, the cost or residual cost is distributed based on the value of the assets.

For example, if you select the Cost option with a $100.00 Base cost, one asset worth $70, and one asset worth $30, two expense lines are created, one for $70 and one for $30.

Split expense lines evenly across users | Select Allocate and distribute cost per user.

For example, with a $100 Base cost and two users on the contract, two expense lines for $50 are created.

Allocate the cost to the contract instead of the individual assets | Select Allocate cost to contract.

5. Click Update.

Expense lines are automatically generated by a scheduled job for costs incurred between the rate card Start date and End date. The scheduled job, Process FM Costs, runs on the Contract (ast_contract) table once per day. Expense lines are only generated from contracts with the Active or Expired state. You may want to generate expense lines for expired contracts to track previous expenses.

View contract expense lines

Use the Expense Lines related list to view and audit all the expenses recorded for a given contract.

Role required: financial_mgmt_user, asset, or contract_manager

1. Navigate to Contract > Contracts > All.
2. Select a contract.
3. Select the Expense Lines related list.
4. Select an expense line record to view.

Information such as expense line details, total cost of the contract, and the contract current value is listed.

Monitor a contract

You can monitor contracts by viewing contract history and creating contract reports.

Role required: asset or contract_manager

If changes are made to a contract start date, end date, or terms and conditions, a copy of the contract is automatically saved and placed in contract history. This is useful for tracking changes to a contract and keeping an audit trail. Configure the Contract History related list to include columns for creation and update so you can easily see who edited the contract.

1. Navigate to Contract > Contracts > All.
2. Select a contract.
3. View the Contract History related list and perform one of the following actions.
- If earlier versions of the contract exist, click a date in the **Contract Starts** column to view a version.
- If an earlier version of the contract does not exist, change the contract's **Start date** or **End date**. Right-click in the header bar and select **Save**. In the **Contract History** related list, click a date in the **Contract Starts** column to view the earlier version.

**Run a contract report**
A variety of contract reports are available to help track and manage contracts.  
**role required:** contract_manager or admin

1. Navigate to **Reports > View / Run**.
2. Select one of the following reports to run.

<table>
<thead>
<tr>
<th><strong>Report</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Contracts by Cost Per Unit</td>
<td>All active contracts grouped in ascending order by average cost per unit.</td>
</tr>
<tr>
<td>Active Contracts by Lifetime Cost</td>
<td>All active contracts with an associated rate card grouped in ascending order by total cost. Total cost is measured from the beginning of the contract to the report run date.</td>
</tr>
<tr>
<td>Active Contracts by Monthly Cost</td>
<td>All active contracts grouped in ascending order by cost per month.</td>
</tr>
<tr>
<td>Active Contracts by Vendor</td>
<td>All active contracts alphabetically by vendor.</td>
</tr>
<tr>
<td>Active Contracts by Yearly Cost</td>
<td>All active contracts grouped in ascending order by cost per year.</td>
</tr>
<tr>
<td>All Contracts by State</td>
<td>Contracts grouped by state, such as Draft, Active, or Expired, in bar chart format</td>
</tr>
<tr>
<td>Asset Contracts by Type</td>
<td>All active contracts for assets grouped by type, in pie chart format.</td>
</tr>
<tr>
<td>Asset Contracts List</td>
<td>All active contracts for assets by contract number.</td>
</tr>
<tr>
<td>Contract Expenditure by Type</td>
<td>Total contract expenses by type, such as lease, maintenance, or warranty, in bar chart format.</td>
</tr>
<tr>
<td>Contract Expenditure by Vendor</td>
<td>Total costs of all contracts associated with a specific vendor, in bar chart format.</td>
</tr>
<tr>
<td>Contract Pipeline Report</td>
<td>All contracts with a state of Draft, Active, or Expired and a substate of Awaiting Review or Under Review, in bar chart format.</td>
</tr>
<tr>
<td>Expiring Contracts</td>
<td>All contracts expiring in the next 90 days.</td>
</tr>
</tbody>
</table>
**Condition check definitions**

Condition check definitions enable you to define logical conditions that indicate when to change a specific field value in a record.

A scheduled job, called **Contract Compliance Checks**, evaluates these condition check definitions nightly by running the condition checker. Use this condition checker to check start dates and end dates and to set expiration levels for contracts.

For example, a contract has a start date of March 1st. When the condition checker runs on March 1st, it verifies that the contract **Substate** is **Approved** and sets the contract **State** to **Active** based on the **Start Date** field.

The nightly condition checker sets the appropriate expiration level for active contracts based on the contract **End Date**. The expiration level can be viewed in the Contracts list. Knowing the expiration level can help contract managers renew or extend a contract before it expires.

**Define a condition check**

You can define a condition check to change values in a contract when the **Contract Compliance Checks** scheduled job runs each night.

Role required: contract_manager or admin

1. Navigate to **Contract > Administration > Condition Check Definitions**.
2. Click **New**.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table to which the condition applies. For a contract check definition, select <strong>Contract (ast.contract)</strong>.</td>
</tr>
<tr>
<td>Category</td>
<td>The category for the condition check. Select <strong>Contract</strong> or <strong>None</strong>. The category is used for organizing information and reporting.</td>
</tr>
<tr>
<td>Condition field</td>
<td>The field to be updated, typically <strong>Expiration level</strong> or <strong>State</strong>.</td>
</tr>
<tr>
<td>Event name</td>
<td>The name for the event to be fired when this condition changes the value of the field. Create a name using this syntax: <code>&lt;table_name&gt;.&lt;condition_field&gt;</code>, for example, <code>contract.validation</code>.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the conditions are evaluated.</td>
</tr>
</tbody>
</table>

4. Right-click the header bar and click **Save**. The **Conditions** related list appears.
5. In the **Conditions** related list, click **New**.
6. Complete the form.
## Conditions fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The value the field is set to, if the expiration conditions are met.</td>
</tr>
<tr>
<td>Condition check</td>
<td>The associated condition check.</td>
</tr>
<tr>
<td>Table</td>
<td>The table associated with the condition check.</td>
</tr>
<tr>
<td>Event name</td>
<td>The name of the event this condition triggers.</td>
</tr>
<tr>
<td>Expiration Condition</td>
<td>The condition that must be true for the Condition check field to be set to this value (the Name). Add as many conditions as are needed.</td>
</tr>
<tr>
<td>Compliant state</td>
<td>System field. Do not use.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the conditions are evaluated. The first condition that is found to match, where the Expiration Condition is true, is used, and no others are checked.</td>
</tr>
</tbody>
</table>

7. Click **Submit**. The Condition Checks form reopens with the new condition listed in the related list.

8. Optional: Continue adding conditions as needed, following the steps above.

## Domain separation and Contract Management

This is an overview of domain separation and Contract Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: No support**

- The domain field may exist on data tables, but there is no business logic to manage data.
- This level is not considered domain-separated.

For more information, see Application support for domain separation.

## Procurement

Procurement managers can use the ServiceNow® Procurement application to create purchase orders and to obtain items for fulfilling service catalog requests.

Procurement offers the ability to perform the following functions.

- Track service catalog requests
- Create and manage purchase orders
- Create and manage transfer orders
- Receive assets
Procurement roles

The Procurement application uses the following roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>procurement_admin</td>
<td>procurement_user</td>
<td>Can create purchase orders without a request. Can view requests and requested items. Can view transfer orders. Can create a purchase order or transfer order when sourcing items for a request. Can view the vendor catalog. Can refresh, add, delete, and rearrange gauges in the Procurement Overview module.</td>
</tr>
<tr>
<td>procurement_user</td>
<td>financial_mgmt_user, model_manager</td>
<td>Can create purchase orders without a request. Can view requests and requested items. Can view transfer orders. Can create a purchase order or transfer order when sourcing items for a request. Can view the vendor catalog. Can view and refresh gauges in the Procurement Overview module.</td>
</tr>
</tbody>
</table>

Procurement workflows

Procurement uses the following workflows.

- In the Service Catalog Request workflow, items ordered from the service catalog that cost over one thousand dollars require approval.
Service catalog request workflow

- In the Source Request workflow, catalog tasks are created so that a procurement manager can source the item by creating a transfer order or purchase order.

Source request workflow

These workflows are provided in the base system. You can edit these workflows in the graphical Workflow Editor or create a workflow to better fit your organization’s procurement needs.
Use the Procurement Overview module

Use the gauges on the Procurement Overview homepage to help you track and manage requests, purchase orders, and other important aspects of the procurement process.

Role required: procurement_admin or procurement_user

1. Navigate to **Procurement > Overview**.
2. Click elements within the gauges to obtain more information.
   
   For example, click a request number to view the request record.

Activate Procurement

You can activate the Procurement plugin that provides core procurement capabilities.

Role required: admin

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the Procurement plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in *Request a plugin*.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Procurement

Several types of components are installed with Procurement.

Demo data is available with Procurement. The demo data provides sample requests, purchase orders, purchase order line items, and receiving slips.

*Business rules installed with Procurement*

Procurement plugin adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust remaining quantity</td>
<td>Purchase order line items</td>
<td>Calculates the remaining quantity of items ordered on a purchase order line items by subtracting the amount received from the amount ordered.</td>
</tr>
<tr>
<td></td>
<td>(proc_po_item)</td>
<td></td>
</tr>
<tr>
<td>Can request be sourced</td>
<td>Request</td>
<td>Checks if a request can be sourced.</td>
</tr>
<tr>
<td></td>
<td>(sc_request)</td>
<td></td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cancel Procurement Orders</td>
<td>Request (sc_request)</td>
<td>Cancels all unreceived purchase orders and unshipped transfer order lines associated with the request's items if the request state changes to <strong>Closed</strong>.</td>
</tr>
<tr>
<td>Check if req item is sourced</td>
<td>Requested Item (sc_req_item)</td>
<td>Sets the <strong>Sourced</strong> field on the parent request to <strong>true</strong> if all requested items have been sourced.</td>
</tr>
<tr>
<td>Check if request is sourceable</td>
<td>Requested Item (sc_req_item)</td>
<td>Checks if the request associated with a requested item can be sourced (obtained from a transfer order or by creating a purchase order to a vendor).</td>
</tr>
<tr>
<td>Create Assets</td>
<td>Receiving Slip Line (proc_rec_slip_item)</td>
<td>If the purchase order line item is available, creates the assets for a receiving slip line when the slip line assets are received.</td>
</tr>
</tbody>
</table>
| Handle roll up states and assets removal | Purchase order line items (proc_po_item) | Manages purchase order line items if they are canceled or received. If a purchase order line is canceled, this business rule deletes any pre-created assets. 
This business rule also checks the status of other purchase order lines that share the same purchase order and, if necessary, updates the status of the purchase order. For example, when the last purchase order line is received, the status of the purchase order changes to **Received**. |
<p>| Redirect TOL to existing TO-Procurement | Transfer Order Line (alm_transfer_order_line) | Attaches a transfer order line to an existing transfer order if the transfer order is in the <strong>Draft</strong> stage and has the same <strong>From stockroom</strong> and <strong>To stockroom</strong> values as the transfer order line. |
| Shipping Cost Changes                 | Purchase Order (proc_po)     | Recalculates the total cost of the purchase order if the shipping rate changes.                                                            |
| State Change                          | Transfer Order Line (alm_transfer_order_line) | Marks the requested item as <strong>Received</strong> if the state of the associated transfer order line changes to <strong>Received</strong>.                           |</p>
<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State Change</td>
<td>Purchase order line items (proc_po_item)</td>
<td>Sets the time at which the purchase order line item is ordered and updates the original requested item when the purchase order line item is received.</td>
</tr>
<tr>
<td>State Change PO</td>
<td>Purchase Order (proc_po)</td>
<td>Changes the purchase order line item status when the status of the associated purchase order changes.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Purchase order line items (proc_po_item)</td>
<td>Calculates the total order cost based on the cost of individual items and the quantity ordered. When you receive a purchase order line item, this business rule also takes the following steps.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Populates the List price field with the value from the Cost field unless you enter a different value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Calculates the Total list price field value by multiplying the List price and Ordered quantity values.</td>
</tr>
<tr>
<td>Update expected delivery date for PO</td>
<td>Purchase order line items (proc_po_item)</td>
<td>Sets the Expected delivery date for purchase orders to the latest purchase order line Expected delivery date.</td>
</tr>
<tr>
<td>Update expected delivery date for POLs</td>
<td>Purchase Order (proc_po)</td>
<td>Sets the Expected delivery date of associated purchase order lines to the purchase order’s Expected delivery date if at least one of the following conditions is true.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The purchase order line has no expected delivery date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The purchase order line’s expected delivery date is later than the purchase order’s expected delivery date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The purchase order line’s expected delivery date is the same as the purchase order’s previous delivery date.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update Ordered Date</td>
<td>Purchase Order (proc_po)</td>
<td>Sets the Ordered date field to the date and time at which the status of the purchase order is set to Ordered.</td>
</tr>
<tr>
<td>Update PO</td>
<td>Purchase order line items (proc_po_item)</td>
<td>Updates the purchase order if the cost of any purchase order line item changes.</td>
</tr>
<tr>
<td>Update Purchase Order Line</td>
<td>Receiving Slip Line (proc_rec_slip_item)</td>
<td>Updates the Quantify received field on the associated purchase order line item when a receiving slip item is received.</td>
</tr>
<tr>
<td>Update Request Item CI</td>
<td>Hardware (aim_hardware)</td>
<td>Sets the Configuration item field on the catalog task and requested item to the related hardware CI created during the procurement process.</td>
</tr>
</tbody>
</table>

**Client scripts installed with Procurement**

Procurement plugin adds the following client scripts.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide request item if request is not empty</td>
<td>Catalog Task (sc_task)</td>
<td>Displays the task's Request item and the request item's Requested for value if the task is associated with a requested item and not directly with a request. Otherwise, if the task is associated with a request, the client script displays the Request and the request's Requested for value.</td>
</tr>
<tr>
<td>Purchase Order Line Mandatory</td>
<td>Receiving Slip Line (proc_rec_slip_item)</td>
<td>Changes the Purchase Order Line field on the Receiving Slip Line form to mandatory if the associated receiving slip has a listed purchase order.</td>
</tr>
</tbody>
</table>

**Script includes installed with Procurement**

Procurement plugin adds the following script include.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProcurementUtils</td>
<td>Provides utilities for Procurement.</td>
</tr>
</tbody>
</table>

**Tables installed with Procurement**

Procurement plugin adds the following tables.
### User roles installed with Procurement

Procurement plugin adds the following user roles:

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>procurement_admin</td>
<td>procurement_user</td>
<td>Can create purchase orders without a request. Can view requests and requested items. Can view the vendor catalog. Can refresh, add, delete, and rearrange gauges in the Procurement Overview module.</td>
</tr>
<tr>
<td>procurement_user</td>
<td>financial_mgmt_user, model_manager</td>
<td>Can create purchase orders without a request. Can view requests and requested items. Can view transfer orders. Can create a purchase order or transfer order when sourcing items for a request. Can view the vendor catalog. Can view and refresh gauges in the Procurement Overview module.</td>
</tr>
</tbody>
</table>

### Request items source

A request from the service catalog can contain multiple items that must be obtained or sourced. The following diagram illustrates the different methods for sourcing items.
Methods of sourcing requested items

**Note:** Only items with an assigned model can be sourced. Sourcing bundles is not supported.

**Purchase order for sourcing requested items**

Items not in a stockroom can be ordered with a purchase order and delivered to a destination stockroom. In the same purchase order, you can order multiple items.
You can choose to create the hardware asset and reserve it for a user after creating the purchase order. You can also do the same after you receive the items. For software items, you cannot pre-create the assets and assign them before they are received.

**Transfer order for sourcing requested hardware items**

To source requested hardware items, create a transfer order. You can choose to transfer the hardware assets from:
- One source stock room to multiple destination stockrooms.
- In case, if one source stock room doesn’t have sufficient stock, you can specify multiple stockrooms so that items can be transferred to single or multiple destination stockrooms.

**Add assignment for sourcing requested software items**

To source software items, add assignments wherein, you must assign rights of the software license. You can assign rights to a user or device so that they are entitled to use the software.

**Create a purchase order from a request**

You can create a purchase order directly from a request. This enables procurement managers to obtain items and fulfill requests from the Service Catalog. You can create multiple purchase orders from a request.

Role required: procurement_admin or procurement_user

1. Navigate to **Procurement > Requests > Requests**.
2. Click the **Number** of a request that has been approved but not sourced. Look in the **Request State** and **Sourced** columns.
3. In the **Catalog Tasks** related list, click a **Number**.
4. Click **Source Request**. The Source Request screen is displayed with a list of all the requested items.
5. Click **Add Purchase Order** in the requested item section.
6. In the **Vendor** list, select the vendor from which the requested item or items should be delivered.
7. In the **Out of Stock** field, verify if the value is **false**. If the vendor doesn’t have stock, the field value will be **true**.
8. In the **Quantity** field, specify the quantity you want to order.
9. In the **Destination Stockroom** list, select the destination to which the requested item or items should be delivered.
10. Optional: Select the **Consolidate PO** check box to combine the listed items with existing purchase orders. When you check Consolidate Purchase Orders, all items sourced from the same vendor on the same request are placed on the same purchase order. When you select a vendor, the system automatically searches for purchase orders that have been created for the same request, have the same **Vendor** selected, and have the **Requested** status. If the system finds a match, all items are placed on the same purchase order and can be ordered together. If the system does not find a match, a new purchase order is created.

For example, if you are purchasing 25 phones from Apple and an open purchase order already exists for Apple, the 25 phones are added to the open purchase order. If there are no open purchase orders for the selected vendors, new purchase orders are created.
ordered from the same vendor are grouped together. Different items are shown on separate lines on the purchase order.

11. Click Submit.
The catalog task reopens and you see a message that the purchase order was created. When you view the request, the Sourced check box is selected.

Create a transfer order from a request
You can create a transfer order directly from a request to source hardware items and consumables from stockrooms.

Role required: procurement_admin or procurement_user

1. Navigate to Procurement > Requests > Requests.
2. Click the request Number of a request that has been approved but not sourced.
   Check the Request State and Sourced columns.
3. In the Catalog Tasks related list, click a Number.
4. Click Source Request.
The Source Request screen appears with a list of all the requested items.
5. Click Add Transfer Order in the requested hardware item section.
6. In the Source Stockroom list, select a stockroom from which the hardware item should be sourced.
7. The In Stock column, displays the total stock available with the selected source stockroom.
8. In the Transfer Quantity field, specify the quantity you want to transfer.
9. In the Destination Stockroom list, select the destination to which the requested item or items should be delivered.
10. Click Submit.
    A transfer order is created to move the item or items from the Source Stockroom location to the Destination Stockroom location. When you view the request, the Sourced check box is selected.

Add an assignment from a request
You can add assignments directly from a request to source rights from software licenses.

Role required: procurement_admin or procurement_user

1. Navigate to Procurement > Requests > Requests.
2. Click the request Number of a request that has been approved but not sourced.
   Check the Request State and Sourced columns.
3. In the Catalog Tasks related list, click a Number.
4. Click Source Request.
The Source Request screen is displayed with a list of all the requested items.
5. Click Add assignments in the requested software item section.
6. In the License Name list, select a license from which the software rights should be sourced.
7. The Available Rights column, displays the total rights available with the selected license.
8. In the Rights field, specify the rights you want to assign.
9. From the Type list, select whether to assign the rights to a user or device.
10. In the Assigned\Allocated list, select the user or device to whom the requested item should be assigned.
11. Click Submit.
An assignment is created to assign rights from the License Name location to the Assigned \ Allocated user or device. When you view the request, the Sourced check box is selected.

12. If Software Asset Management is active, you are prompted to run the software counter. It is recommended that you run the counter, to ensure that you are in compliance.

13. Click OK.

For auditing, the Assigned Licences related list in the Request form will provide the details of all the assignments done as part of this request.

Procurement purchase order management for assets

Accurate purchase order information is important for invoice tracking, receiving, and reporting in the ServiceNow platform.

The Procurement application enables users with an appropriate procurement role to manage purchase order information for assets. It also provides direct access to service catalog requests. You can create purchase orders and transfer orders directly from requests.

Before using the Procurement application, create assignment groups for catalog tasks. Assignment groups are sets of users, filtered by location, who can perform catalog tasks.

Track a request from the service catalog

The Procurement application lets you track a request that was ordered from the service catalog.

Role required: procurement_admin or procurement_user

When a user places an order from the service catalog, a request record is created to track the order. Each ordered item becomes a requested item that is listed on the request record. For example, a single request for one laptop, two monitors, and one keyboard creates the following records.

Request REQ0000001: 4 items
- Requested Item RITM0000001: 1 laptop
- Requested Item RITM0000002: 2 monitors
- Requested Item RITM0000003: 1 keyboard

1. Navigate to Procurement > Requests > Requests.
2. Click a request Number.

The Requested Items related list displays the items that were ordered. You can view the requested item, or view associated Purchase Orders, Transfer Orders, and Assignments on other related lists. A catalog task is automatically generated for each requested item to identify the source of the item, whether it must be purchased or transferred from a stockroom.

Cancel a request from the service catalog

You can cancel a request from the service catalog if, for example, the item is no longer needed or the request was not approved.

Role required: catalog_admin, procurement_admin, or procurement_user

When a service catalog request is canceled, the following actions occur automatically.
- Associated purchase orders that have not been received are canceled.
- All procurement tasks are canceled.
- Associated transfer orders are canceled, if all transfer order lines related to the transfer order are also associated with the service catalog request and the transfer order lines have all been
canceled. If the transfer order contains transfer order lines that are not related to the service catalog request and those lines have not been canceled, the transfer order is not canceled.

Associated transfer order lines that are in the In Transit or Delivered stages are not canceled.

1. Navigate to Procurement > Requests > Requests.
2. Click a request Number.
3. Click Cancel Request.

View and edit a catalog task

Catalog tasks are used to source items and fulfill requests. You can view and edit catalog tasks from a request.

Role required: procurement_admin or procurement_user

If a request requires approval, a catalog task is created automatically when the request is approved. If a request does not require approval, a catalog task is created automatically when the request is created.

**Note:** If a request contains one requested item and the item has no model specified, a catalog task is not created automatically. If a request has multiple requested items and only some of them have a model specified, catalog tasks are created automatically, but only for the requested items with a model.

1. Navigate to Procurement > Requests > Tasks.
2. Open a catalog task.
3. Edit the fields as necessary.

**Catalog task fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the catalog task.</td>
</tr>
<tr>
<td>Request</td>
<td>The number of the request to which the catalog task is associated. The information in this field is derived from the Number field on the Request form.</td>
</tr>
<tr>
<td>Request item</td>
<td>The number of the requested item to which the catalog task is associated. The information in this field is derived from the Number field on the Requested Item form.</td>
</tr>
<tr>
<td>Requested for</td>
<td>The name of the person for whom the associated item was requested. The information in this field is derived from the Request or Request item field.</td>
</tr>
<tr>
<td>Due date</td>
<td>The date by which the catalog task should be completed.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>The configuration item associated with the Request Item.</td>
</tr>
<tr>
<td>Approval</td>
<td>The status of catalog task approval: Not Yet Requested, Requested, Approved, or Rejected.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
State | The current state of the catalog task: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, or Closed Skipped.
Assignment group | The group from which an individual is selected to complete the catalog task.
Assigned to | The individual assigned to complete the catalog task, selected from the Assignment group.
Work notes list | The list of users to receive email notifications when the work notes on the catalog task are updated.
Short description | A brief description of the catalog task.
Description | A detailed description of the catalog task.
Work notes | Information about how the catalog task is resolved.
Additional comments | Additional information about the catalog task that might be helpful for others to know. This is a customer-visible field.

4. **Click Update.**

**Create a purchase order**

You can create a purchase order. Purchase orders specify assets to order from a single vendor.

Role required: procurement_admin or procurement_user

For example, an organization can create a purchase order to buy 20 laptop computers or 10 servers. Information on a purchase order enables physical and financial tracking of the assets that were ordered.

You can also use a transfer order if an asset is already owned by an organization. A transfer order is used to internally transfer assets from one stockroom to another instead of purchasing the assets. For example, a company stockroom in New York has five laptops that are needed in Boston. You create a transfer order to move the laptops from the New York stockroom to the Boston stockroom.

After you create a purchase order, the **Receiving Slip** related list is available on the Purchase Order form. A receiving slip is created manually or automatically when the item is received. The **Receiving Slip** related list shows all receiving slips related to the purchase order. After a receiving slip is added to a purchase order, all fields on the purchase order record become read-only.

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Click **New**.
3. Complete the form.

**Purchase order fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the purchase order.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Due by</td>
<td>The date by which the purchase order <strong>Total cost</strong> must be paid.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The supplier to which the purchase order was issued.</td>
</tr>
<tr>
<td>Ship to</td>
<td>The stockroom to which items on the purchase order should be shipped.</td>
</tr>
<tr>
<td>PO date</td>
<td>The date on which the purchase order was created.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the purchase order: Canceled, Ordered, Received, Requested, or Suspended.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user to whom the purchase order is assigned.</td>
</tr>
<tr>
<td>Bill to</td>
<td>The location responsible for paying the purchase order <strong>Total cost</strong>.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the purchase order.</td>
</tr>
<tr>
<td>General section</td>
<td></td>
</tr>
<tr>
<td>Shipping</td>
<td>The delivery method to be used when shipping the items on the purchase order.</td>
</tr>
<tr>
<td>Terms</td>
<td>The purchase order payment terms: <strong>Credit</strong>, <strong>Net 30 days</strong>, or <strong>Net 90 days</strong>.</td>
</tr>
<tr>
<td>Ship rate</td>
<td>The amount that must be paid for the delivery method specified in the Shipping field.</td>
</tr>
<tr>
<td>Total cost</td>
<td>The sum of all item costs on the purchase order and the shipping costs.</td>
</tr>
<tr>
<td>Description</td>
<td>A full description of the purchase order contents.</td>
</tr>
<tr>
<td>Details section</td>
<td></td>
</tr>
<tr>
<td>Initial request</td>
<td>The record number of the request that requires the items on the purchase order.</td>
</tr>
<tr>
<td>Requested by</td>
<td>The user requesting the items on the purchase order.</td>
</tr>
<tr>
<td>Requested</td>
<td>The date the user in the Requested by field requested the items on the purchase order.</td>
</tr>
<tr>
<td>Ordered</td>
<td>The date and time the Order button is clicked on the Purchase Order form.</td>
</tr>
<tr>
<td>Expected delivery</td>
<td>The date the items associated with the purchase order are expected to arrive in the stockroom identified in the Ship to field. This field cannot be edited when the purchase order has a Status of Received or Canceled. (For more information about this field, see Purchase order expected delivery date.)</td>
</tr>
<tr>
<td>Received</td>
<td>The date and time at which the purchase order status changed to Received.</td>
</tr>
</tbody>
</table>
4. Click Submit.

Add purchase order line items to specify what you are ordering from this vendor. *Create a purchase order line item*

After you save a new purchase order, you create purchase order line item records to specify the individual items to order.

Role required: procurement_admin or procurement_user

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Open a purchase order.
3. In the **Purchase order line items** related list, click **New**.
4. Complete the form.

**Purchase order line item fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the purchase order line item.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The supplier from which this product should be ordered.</td>
</tr>
<tr>
<td>Product Model</td>
<td>The model of the purchase order line item.</td>
</tr>
<tr>
<td>Product Catalog</td>
<td>The product catalog category to which the product model is assigned. For example, Hardware, Software, or Supplies.</td>
</tr>
<tr>
<td>Part number</td>
<td>The identification number assigned to the product model.</td>
</tr>
<tr>
<td>Request line</td>
<td>The identification number of the requested item record associated with this purchase order line item.</td>
</tr>
<tr>
<td>Ordered</td>
<td>The date and time at which this purchase order line item was ordered.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Expected delivery</td>
<td>The date the purchase order line item is expected to arrive in the stockroom identified in the <strong>Ship to</strong> field on the purchase order record. This field is automatically filled with the value in the <strong>Expected delivery</strong> field on the purchase order record. This field can be edited when the purchase order line item has a <strong>Status</strong> of <strong>Requested</strong>. For more information about this field, see <strong>Purchase order expected delivery date</strong>.</td>
</tr>
<tr>
<td>Received</td>
<td>The date and time at which the purchase order line item status was changed to <strong>Received</strong>.</td>
</tr>
<tr>
<td>Purchase order</td>
<td>The purchase order record number associated with this purchase order line item.</td>
</tr>
<tr>
<td>Rights per license pack</td>
<td>Rights associated with each pack that is purchased for Microsoft Per Core or Microsoft Per Core with CAL licenses.</td>
</tr>
<tr>
<td>Number of packs</td>
<td>Number of packs for Microsoft Per Core or Microsoft Per Core with CAL licenses.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the purchase order line item: <strong>Canceled</strong>, <strong>Ordered</strong>, <strong>Pending Delivery</strong>, <strong>Received</strong>, or <strong>Requested</strong>.</td>
</tr>
<tr>
<td>Ordered quantity</td>
<td>The number of product models that were ordered.</td>
</tr>
<tr>
<td>Received quantity</td>
<td>The number of product models that were shipped and received. The vendor may have sent multiple shipments.</td>
</tr>
<tr>
<td>Remaining quantity</td>
<td>The number of product models that still need to be received to fulfill the <strong>Ordered</strong> quantity.</td>
</tr>
<tr>
<td>List price</td>
<td>The price at which the item retails, not including discounts. If the system creates the purchase order from the service catalog ordering process, the purchase order line item inherits the list price from the associated vendor catalog item. If the vendor catalog item does not have a list price value and you have not entered a value, this field is automatically populated with the value from the <strong>Cost</strong> field.</td>
</tr>
<tr>
<td>Cost</td>
<td>The cost of a single product model, including discounts. If the system creates the purchase order from the service catalog ordering process, the purchase order line item inherits the cost from the associated vendor catalog item <strong>Vendor Price</strong>.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Total cost | The cost of a single product model multiplied by the value specified in **Quantity**.
Stock Order | Read only and selected if the related request is using the bulk stock order workflow.

**Note:** Appears for all purchase order line items when the Hardware Asset Management application is installed from ServiceNow Store.

Short description | A few words or short phrase describing the purchase order line item.

5. Click **Submit**.
   The purchase order reopens with the line item listed. The purchase order and line item are in **Requested** status.

6. Optional: Continue adding purchase order line items for this vendor, as needed.

7. After you initiate the order with the vendor and are ready to show that the order was placed, click **Order**.
   The status of the purchase order and line items change to **Ordered**.

**Purchase order status**
Purchase orders follow a specific life cycle. The **Status** field on the purchase order record is always read-only.

![Status life cycle](image)

### Status life cycle

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested</td>
<td>The status is <strong>Requested</strong> when you create a purchase order.</td>
</tr>
<tr>
<td>Ordered</td>
<td>The status changes to <strong>Ordered</strong> when you add purchase order line items, and click <strong>Order</strong>.</td>
</tr>
<tr>
<td>Pending Delivery</td>
<td>When you create assets before receiving them as a purchase order line item, the status of purchase orders and purchase order line items changes to <strong>Pending Delivery</strong> status.</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Status and Description

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Received</td>
<td>When ordered assets arrive in the specified stockroom and you click <strong>Receive</strong>, the status of purchase orders and purchase order line items changes to <strong>Received</strong>.</td>
</tr>
<tr>
<td>Canceled</td>
<td>You can cancel a purchase order if its status is <strong>Requested</strong>, <strong>Ordered</strong>, or <strong>Pending Delivery</strong>. For more information, see <em>Cancel a purchase order</em>.</td>
</tr>
</tbody>
</table>

### Purchase order expected delivery date

The purchase order record and the purchase order line item record both contain the **Expected delivery** date field.

The **Expected delivery** field can be edited on both records. Editing the field on one record can change the field on the other record.

- If you add an expected delivery date to the purchase order and the expected delivery date field on the purchase order line item is blank, the date on the purchase order is added automatically to the purchase order line item.
- If you add an expected delivery date on the purchase order line item and the expected delivery date field on the purchase order is blank, the date on the purchase order line item is added automatically to the purchase order.
- If the purchase order and the purchase order line item have the same expected delivery date and you change the date on the purchase order, the date is changed automatically on the purchase order line item.
- If you change the date on the purchase order line item to a date that is later than the one specified on the purchase order, the date on the purchase order is changed to the new date. The expected delivery date of a purchase order line item cannot be later than the expected delivery date on the associated purchase order.
- If you change the date on the purchase order line item to a date that is earlier than the date specified on the purchase order, the date on the purchase order remains the same.

### Cancel a purchase order

You can cancel purchase orders with a status of **Requested**, **Ordered**, or **Pending Delivery**.

**Role required:** procurement_admin or procurement_user

Purchase order line items can also be canceled from a purchase order.

1. **Navigate to** Procurement > Orders > Purchase Orders.
2. **Open a purchase order to cancel.**
3. **Click Cancel.**
   - All associated purchase order line items that have not been received are canceled. Any assets created for the purchase order are deleted.

### Cancel a purchase order line item

You can cancel a purchase order line items with a status of **Requested**, **Ordered**, or **Pending Delivery**.

**Role required:** procurement_admin or procurement_user

Keep the following in mind when you cancel a purchase order line item.

- When a purchase order line item is canceled, if all other line items are also canceled, the purchase order is canceled.
After a purchase order line item is canceled, it can be reordered if the associated purchase order has not been canceled or received.

If you cancel a purchase order line item for which assets were created, the assets are deleted from the system and removed from the purchase order.

If you reorder the same purchase order line item, the assets are recreated for that line if the line has a status of **Pending Delivery**.

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Open a purchase order.
3. In the **Purchase order line items** related list, select a line item to cancel.
4. Click **Cancel**.

**Reorder a purchase order**

You can reorder a purchase order that was canceled.

Role required: procurement_admin or procurement_user

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Open a purchase order with a status of **Canceled**.
3. Click **Order**.
   The status changes to *Ordered* for the purchase order and all associated purchase order line items.

**Reorder a purchase order line item**

You can reorder a purchase order line item that was canceled.

Role required: procurement_admin or procurement_user

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Open a purchase order.
3. In the **Purchase order line items** related list, select a line item with a status of **Canceled**.
4. Click **Order**.
   The purchase order line item **Status** field changes based on the **Status** field of the associated purchase order. For example, if the purchase order has a status of **Pending Delivery**, the purchase order line item status changes to **Pending Delivery** and the assets for the purchase order line item are created automatically.

**Create an asset and reserve it for the requester**

In the procurement process, hardware assets can be created before the assets are delivered. Creating the asset before they’re delivered allows you to create the asset record with an asset tag and serial number early in the process and reserve the asset for the user who requested it. The receiver can only select the assets to be received as assets are pre-created.

Role required: procurement_admin or procurement_user

Some requests must be approved before items on the request can be sourced. In the base system, requests over $1,000 require approval. To change the $1,000 approval threshold and other workflow attributes, edit the Service Catalog Request workflow.

When the asset state is **In stock**, the **Reserved for** field is maintained as the asset is received and placed in a stockroom. When the asset state changes to **In use**, the **Reserved for** field is relabeled **Assigned to**. If there is a name in the **Reserved for** field, the name is retained when the field is relabeled. A user with the asset role can change the name in the **Assigned to** field. Changing the name is helpful, for example, if an IT technician orders 10 laptops and must assign them to individual users.
Note: If assets are not created prior to delivery, they are automatically created from line items when purchase orders are received. Also you can enter the asset details and receive them when the purchase orders are received.

1. Navigate to Procurement > Requests > Tasks.
2. Open a task with a State of Open and a Short description of Source Request Items.
3. Click Source Request.
   - If the request is already fulfilled or the items in the request are not sourceable, the Source Request button is hidden.
   - If the requested item does not have an assigned model, the item is not listed on the Source the Request dialog box.
   - Any items on the purchase order that have a remaining quantity of 0 are not listed on the Source the Request dialog box.
4. Select a Destination Stockroom.
5. Select the Create PO option for one or more listed items.
6. For each item requiring a purchase order, select a Vendor.
7. Click OK.
8. Navigate to Procurement > Orders > Purchase Orders.
9. Open the purchase order you just created. If you created a purchase order for more than one item, multiple purchase orders may have been created; select one of them.
10. Click Order. After items are ordered, no additional purchase order line items can be added to the purchase order.
    The status of all purchase order line items changes to Ordered.
11. Click the Create hardware assets prior to delivery related link to automatically create hardware assets for all purchase order line items.
    Hardware assets are listed in the Assets related list. Click an asset in the list to view the asset record. Except for consumables, the Reserved for field contains the name of the user who made the original request.
    You can also create assets for individual purchase order line items. On a purchase order, go to the Purchase order line items related list and click a specific purchase order line item number. Then, click the Create hardware assets prior to delivery related link. Only the hardware assets included on the purchase order line item are created.

Receive assets

Assets can be received and added to the system when they are delivered to a stockroom.

Users with an appropriate procurement role can receive assets. If one purchase order contains multiple purchase order lines, the lines can be received at different times. This is useful if items arrive at the stockroom in different shipments. The purchase order status does not change to Received until all purchase order lines are received.

As an alternative to receiving assets when they arrive, you can create assets before they arrive and reserve them for the requester.

Receive an asset

When assets are received and delivered to a stockroom, they are added to the system.

Role required: procurement_admin or procurement_user

When you receive assets:
- If you have not pre-created hardware assets, you can enter asset details and reserve them for users.
- You can over receive an order wherein, the received quantity can be higher than the ordered quantity.
- If you have ordered multiple items with different receiving stockrooms, you can receive them at the time.

1. Navigate to Procurement > Orders > Purchase Orders.
2. Select a purchase order with a Status of Ordered or Pending Delivery.
3. Click Receive.
   The Receive Purchase Order screen appears with the list of the products ordered.
4. Select the Received check box for the line items you are receiving.
5. To receive software assets:
   a) Edit the Receiving Stockroom if the items arrived at a different stockroom than the one specified on the purchase order.
   b) Edit the Receiving Quantity if the number of items delivered does not match the number ordered.
   c) Edit the Unit Cost if the price changed between the time the item was ordered and the time it arrived at the stockroom. Enter a number; the number can include decimals.
   d) Click Capture Asset tags to enter asset details. You cannot enter details for assets more than the received rights.
   e) The Capture Asset Tag dialog box, click Insert a new row.
   f) Enter the asset tag, serial number, rights, and License key

6. To receive hardware assets and consumables:
   a) Edit the Receiving Stockroom if the items arrived at a different stockroom than the one specified on the purchase order.
   b) Edit the Receiving Quantity if the number of items delivered does not match the number ordered.
   c) Click the Reserve toggle button to reserve the item.
      When a reserved item is received, the State and Substate fields on the corresponding asset record are automatically set to In stock and Reserved, respectively. If the Reserve button is not clicked for an item, the State and Substate fields on the corresponding asset record are set to In stock and Available.
   d) From the Reserved for list select a user you want reserve the asset for.
      If a name was specified in the Requested for field on the Purchase order line item form, the name is added automatically but can be changed.
      You can add multiple users in the Capture Asset tags dialog box.
   e) Click Capture Asset tags to enter asset details. You cannot enter details for assets more than the received quantity. You can also reserve assets for a user.
      Note: If you have pre-created the assets, you must select the ones you want to receive.
   f) On the Capture Asset Tag dialog box, click Insert a new row.

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
g) Enter the asset tag and serial number.

h) From the Reserved for list, select the user for whom the item was ordered. If a name was specified in the Requested for field on the Purchase order line item form, the name is added automatically but you can change it.

i) Edit the Unit Cost if the price changed between the time the item was ordered and the time it arrived at the stockroom. Enter a number; the number can include decimals.

7. Click Submit.
   A confirmation message displays with the details of assets received.

8. Click OK.
   A receiving slip is automatically created and can be viewed in the Receiving Slips related list. If items on a purchase order are received at different times, a new receiving slip is created each time any item on the purchase order is received. For example, if 30 laptop computers were ordered and arrived in three separate shipments, three receiving slips are created.

   Different assets are created for each hardware item. If there is software, one single asset is created for each license if you don’t split the rights. And for consumables, if an asset exists, it is updated, or new assets are created.

Create a receiving slip
Receiving slips are created automatically during the process of receiving assets. You can also create receiving slips manually.

Role required: procurement_admin or procurement_user

After a receiving slip has been created for a purchase order, all fields on the purchase order record are changed to read-only.

1. Navigate to Procurement > Receiving > Receiving Slips.
2. Click New.
   A Number is assigned automatically. The current date and time is added automatically to the Received field.
3. Select a Purchase Order.
   Only purchase orders with a status of Ordered, Pending Delivery, or Requested are listed in the selection window. The Vendor column lists the vendor specified on the purchase order. The Ship to column lists the destination stockroom specified on the purchase order.
4. Select a Receiving Stockroom.
5. Click Submit.

Add a receiving slip line to the receiving slip to identify the items from the purchase order that were received.

Create a receiving slip line
When assets arrive at a stockroom and you receive them, a receiving slip is created on the purchase order. You create a receiving slip line to identify the specific assets and quantities that were received.

Role required: procurement_admin or procurement_user

If the asset already exists, the asset record is updated when you save the receiving slip line. If the asset does not already exist, a new hardware or software asset record is created. The Model category and Configuration item fields are automatically filled in on the new asset record based
on information in the request, purchase order, or receiving slip. If Asset Tag and Serial Number information exists, it is not overwritten.

1. Navigate to Procurement > Receiving > Receiving Slips and open a receiving slip.
2. In the Receiving Slip Lines related list, click New. The following fields are completed automatically.
   - A Number is assigned.
   - In Received, the current date and time are added.
   - In Received by, the currently logged in user is added.

3. In Purchase Order Line, click the reference lookup icon and select a purchase order line. The Purchase Order Line field is mandatory if the parent receiving slip has an associated purchase order. Only purchase order lines that are associated with the same purchase order linked to the parent receiving slip are available to select.
4. In Quantity, enter the number of items received. For example, five items were ordered, but only two are being received.
5. Optional: Edit the Received by, Requested for, and Unit cost fields, as needed.
6. Click Submit. After you create a receiving slip line, the Receiving stockroom field on the Receiving Slip record becomes read-only.

Consumable assets

A consumable asset is one that is purchased in quantity and distributed. It is assigned to the consumable model category, and the asset record tracks the quantity that is available and total cost. When consumable assets are received, they are merged into an existing consumable record, if available.

For the records to merge, the consumable cannot be listed on an active transfer order and the Model, Location, Model Category, Stockroom, Status, and Substatus fields on the asset record must match.

If consumables are merged into an existing consumable record, the cost of the additional consumables received is added to that of the existing consumables in the record. For example, if 50 computer keyboards arrive and 20 keyboards of the same model exists in the receiving stockroom, the two records are merged showing 70 keyboards in the stockroom with a combined total cost.

If no matching consumable record exists in the receiving stockroom, a record is created. After the consumables are received, the quantity is updated, but individual consumables are no longer tracked within the Procurement application and are not displayed on receiving slip lines.

Domain separation and Procurement

This is an overview of domain separation and Procurement processing. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Standard*

The support level is Standard but has some exceptions or special conditions.

- Includes Basic level
• Business logic: Processes can be created or modified per customer by the service provider (SP). The use cases reflect proper use of the application by multiple SP customers in a single instance.
• The owner of the instance needs to be able to configure minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin needs to be able to make comments mandatory when a record closes for one tenant, but not for another.

How domain separation works in Procurement

To create or edit Purchase Orders (POs) or PO line items that distinguish the domain, customers must be working in the proper domain. When adjusting any configuration, you should be in the domain where you're doing the work. Use the domain picker to choose the correct domain to work in.

Product Catalog

The product catalog is a set of information about individual models. Models are specific versions or various configurations of an asset. Asset managers use the product catalog as a centralized repository for model information.

A detailed and well-maintained product catalog can coordinate with service catalog, asset, procurement, request, contract, and vendor information.

Models published to the product catalog are automatically published to the Service Catalog. The service catalog includes information about goods (models) and services. If the model is available from multiple vendors, a model can be listed more than once. Models are included with the Asset Management application.

Keep the following in mind when working with the product catalog.
• A product catalog item can be linked to multiple vendor catalog items or to a single model.
• A model can only have one product catalog item.
• A vendor catalog item can only have a single product catalog item.

Components installed with Product Catalog

The following components are installed with the Product Catalog plugin.

Demo data is available with the product catalog. The demo data provides various models, model categories, product catalog items, vendor catalog items, and vendors.

Tables installed with Product Catalog

Product Catalog plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call</td>
<td>The base table for Product Catalog that contains all call information.</td>
</tr>
</tbody>
</table>
## Table Description

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware Catalog</td>
<td>Stores all hardware catalog items that have been published from the Product Model (cmdb_model) base table. Extends the Product Catalog Item (pc_product_cat_item) table.</td>
</tr>
<tr>
<td>Product Catalog Item</td>
<td>Stores all information for the product catalog. This table extends the Catalog Item (sc_cat_item) table.</td>
</tr>
<tr>
<td>Software Catalog</td>
<td>Stores all software catalog items that have been published from the Product Model (cmdb_model) base table. Extends the Product Catalog Item (pc_product_cat_item) table.</td>
</tr>
<tr>
<td>Vendor Catalog Item</td>
<td>Stores all vendor catalog item information.</td>
</tr>
</tbody>
</table>

### Roles installed with Product Catalog

Product Catalog plugin adds the following roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>model_manager</td>
<td>Can create CMDB models.</td>
<td>none</td>
</tr>
<tr>
<td>category_manager</td>
<td>Can do everything that model managers can do and can administer model categories.</td>
<td>model_manager</td>
</tr>
</tbody>
</table>

### Script includes installed with Product Catalog

Product Catalog plugin adds the following script include.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProductCatalogUtils</td>
<td>Utilities for creating and maintaining product catalog items derived from vendor catalog items and models.</td>
</tr>
</tbody>
</table>

### Client scripts installed with Product Catalog

Product Catalog plugin adds the following client script.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Script contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Model Fields</td>
<td>(pc_vendor_cat_item)</td>
<td>Adds the description and price, if they do not exist, when a vendor catalog item is added to the product catalog.</td>
</tr>
</tbody>
</table>
Business rules installed with Product Catalog

Product Catalog plugin adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear model</td>
<td>(pc_product_cat_item)</td>
<td>Clears the link on a model when the link is cleared from the product catalog.</td>
</tr>
<tr>
<td>Create child product catalog entries</td>
<td>(cmdb_hardware_product_model)</td>
<td>Creates entries in the product catalog for all items in a bundled model when the bundled model is created.</td>
</tr>
<tr>
<td>Sync to Product catalog item</td>
<td>(pc_vendor_cat_item)</td>
<td>Updates the corresponding field in the product catalog when a field is updated.</td>
</tr>
<tr>
<td>Sync to Product catalog item</td>
<td>(cmdb_model)</td>
<td>Updates the corresponding field in the product catalog when a field is updated.</td>
</tr>
</tbody>
</table>

Models

Models are specific versions or various configurations of an asset. Models are used for managing and tracking assets through various ServiceNow platform asset applications, including Product Catalog, Asset Management, and Procurement.

Model definitions can be based on vendor-provided criteria, for example, the manufacturer name Apple MacBook Pro, or on a custom abstraction, for example, Graphic Designer Workstation. All model information is located in the Product Catalog application.

A model can be in one or more model categories. For example, a laptop can be a computer and a server. Model definitions specify whether the model creates an asset, a configuration item, or both. On a hardware model record, compatible hardware models can be added.

Unless otherwise noted, working with product models requires the model_manager role. This role is contained by other roles, such as sam, category_manager, and asset.

Creating models

Models are created in the Product Catalog > Product Model > All Models module.

See Model form fields for a list of the fields that appear on all models, regardless of the type of model.

Model form fields

There are fields on the Model form that apply to all types of models.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the model. A system property called glide.cdb_model.display_name.shorten controls how software model display names are generated.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>The company that built the model.</td>
</tr>
<tr>
<td>Name</td>
<td>The manufacturer-assigned name of the model or abstract name specified by the model manager, such as Field Agent Laptop.</td>
</tr>
<tr>
<td>Edition</td>
<td>The edition of the software model, such as Professional.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the model.</td>
</tr>
<tr>
<td>Model categories</td>
<td>The categories to which the model is assigned. This field is a glide list and cannot be used to create reports.</td>
</tr>
<tr>
<td>Asset tracking strategy</td>
<td>The process by which the model can be tracked. Choose from the following:</td>
</tr>
<tr>
<td></td>
<td>• Leave to Category: model is transparent and the category defines the asset class.</td>
</tr>
<tr>
<td></td>
<td>• Create Consumable Asset: model forces the asset class to be consumable, regardless of what the category defines as the asset class.</td>
</tr>
<tr>
<td></td>
<td>• Don't create assets: model blocks asset instantiation, regardless of what the category defines as the asset class.</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>The method for purchasing the model. Options are Both, Buy, or Lease. Plausible</td>
</tr>
<tr>
<td>Cost</td>
<td>The cost of a single unit of the model.</td>
</tr>
<tr>
<td>Depreciation</td>
<td>The depreciation scheme for the model.</td>
</tr>
<tr>
<td>Salvage value</td>
<td>The estimated value that an asset realizes upon its sale at the end of its useful life. This value must be less than or equal to the cost of the model.</td>
</tr>
<tr>
<td>Model number</td>
<td>The specific model number assigned to the item by the manufacturer.</td>
</tr>
<tr>
<td>Barcode</td>
<td>The barcode number assigned to the model. Barcodes are assigned by the manufacturer.</td>
</tr>
<tr>
<td>Owner</td>
<td>The person responsible for the model.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the model. Options are In Production, Retired, and Sold.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure. Choose from the following:</td>
</tr>
<tr>
<td></td>
<td>• Capex: Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>• Opex: Operational expenditure is an ongoing expenditure. For example, toners for the photocopier.</td>
</tr>
</tbody>
</table>
Create hardware models

Use hardware models to track equipment assets such as servers and racks. You can create a new hardware model.

Role required: model_manager

1. Navigate to Product Catalog > Product Model > Hardware Models.
2. Click New.
3. Complete the form.
   For general field descriptions, see Model form fields. The hardware model fields listed are found in the Information section of the form.

Model form fields for hardware models

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power (watts)</td>
<td>The electrical power, in watts.</td>
</tr>
<tr>
<td>Height (U)</td>
<td>The total height of the hardware item, in inches.</td>
</tr>
<tr>
<td>Flow Rate (cfm)</td>
<td>The flow rate of the hardware model, expressed in cubic feet per minute.</td>
</tr>
<tr>
<td>Sound Power (bels)</td>
<td>The noise measurement, in bels (1 bel=10 decibels).</td>
</tr>
<tr>
<td>Weight (lbs)</td>
<td>The total weight, in pounds.</td>
</tr>
</tbody>
</table>

4. Click Update.

Add compatible models to a hardware model

On a hardware model record, you can add compatible hardware models, giving you a good method for tracking hardware assets that can work together.
Role required: model_manager

Note: Hardware models included in bundled models cannot be added as compatibles.

1. Navigate to Product Catalog > Product Model > Hardware Models.
2. Click a hardware model Name.
3. Click Add Compatible.
4. Select a compatible model.
5. Click Submit.
   The selected model is listed in the Compatibles related list.

Add substitute models to a hardware model
On a hardware model record, you can add substitutes to track what hardware models can be substituted for another hardware model.

Role required: model_manager

For example, a 19" monitor can be a valid substitute for a 17" monitor. Note that substitutions are directional so, in this case, a 17" monitor is not a substitution for a 19" monitor. Information about valid substitute models is useful when you select models while creating transfer orders.

When you select substitute models, note the following conditions.

- Substitute models can be used with work management transfer orders. Substitute models are not used in procurement part sourcing.
- Hardware models included in bundled models cannot be added as substitutes.

1. Navigate to Product Catalog > Product Model > Hardware Models.
2. Click a hardware model Name.
3. Click Add Substitution.
4. In the Collection list on the left, double-click a hardware model.
   The hardware model is added to the List on the right.
5. Click Save.
   The model is listed in the Substitutes related list.

Create consumable models
Consumables are items that are tracked as a group, not individually. An example of consumable items is computer keyboards.

Role required: model_manager

1. Navigate to Product Catalog > Product Model > Consumable Models.
2. Click New.
3. Complete the form.
   For general field descriptions, see Model form fields. There are no fields specific to consumable models.
   Any consumable assets you create and assign to the new model are displayed in the Consumables related list on the model record.
4. Click Submit.

Create a service model
Create a service model for all the services your organization wants to monitor.
Role required: model_manager

A service model is a class of product models to define Software as a Service (SaaS) products. It defines the service and contains the different attributes, choices, and components that can be configured to a customer’s specifications.

Service models have a specific model category called Application Service, which links a service model to the Application Service CI class.

There are two ways of creating a service model.

1. Perform one of the following actions.
   - Navigate to Product Catalog > Product Models > Service Models > New.
   - Navigate to Product Catalog > Product Models > All Models > New > Service.

2. Fill out the fields on the form.

   **Service Model form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the service model.</td>
</tr>
<tr>
<td>Model categories</td>
<td>By default, the model category is Application Service.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the service model. A service model can be In Production, Retired, or Sold.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description for the service model.</td>
</tr>
</tbody>
</table>

3. Click Submit.

**Bundled models**

A bundled model is a single model comprised of individual models. For example, a laptop, printer, keyboard, and mouse can be combined into a single bundled model. If you assign any one asset from the bundled model to an individual, that person receives all the components in the bundle.

Bundled models can be abstract or concrete.

**Abstract**

Permits use of one model in multiple bundles. The abstract bundle is created as a container. One asset in the bundle is specified as the main component. Model categories define which assets can be included in a bundle. Model categories also define what can be the main component of a bundle.

Add a main component to make it easier to track the bundle components. For example, create an abstract bundle adding a computer as the main component and a mouse and keyboard as additional components. When the bundle is assigned to a user, the asset record for the computer shows the computer, mouse, and keyboard all assigned to the user. Abstract bundles are used more often than concrete bundles.

**Concrete**

Is a fixed bundle where the main component is an asset. Specify the main component and the other components to create an exact bundle. Concrete bundles do not allow for a many-to-many relationship with models.

Keep the following tips in mind when creating and using bundled models.
- Bundles can be nested inside bundles.
- Any type of model can be used in a bundle.
- When a parent link is defined, the fields related to assignment and state of the child assets are read-only. They are populated based on the parent's assignment and state fields.
- If you make a change to the parent bundle, the children in the bundle are affected. For example, if you assign a bundle to an individual, all child asset records show that same individual as the person assigned.
- You cannot pre-allocate bundles.
- In a bundle, consumables are consumed and assets are set to the same state as the master component.
- Only the bundle, not individual components, can be part of a transfer order.
- You control what can go into a bundle through the model category. For example, the model category Servers could be set to never allow servers in bundles.
- To create a collection of software, you must create a suite instead of a bundled model.
- A software license cannot be the master component of a bundle.

To create an abstract model, set the model category to Bundle and add the components. To create a concrete model, create a model in the Product Catalog > Product Model > Bundled Models module and add components.

Add model components to a bundle
Add model components to a model as needed, for example, when you upgrade a bundle to include additional assets.

Role required: model_manager and asset

1. Navigate to Product Catalog > Product Model > Bundled Models.
2. Open a bundle record.
3. In the Model Components related list, click New.
4. Select the Model category of the component, such as Computer.
5. Select the Component, such as Apple Computer MacBook Pro 17".
6. Select the Is main component check box if this component is the one that other components are attached to.
7. Click Submit.
8. Repeat steps 3–7 to add more components to the bundle.

Any components you add to the bundled model are displayed in the Model Components related list.
### Hardware

**Developer workstation bundle**

<table>
<thead>
<tr>
<th>Display name</th>
<th>Developer workstation bundle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Developer-workstation bundle</td>
</tr>
</tbody>
</table>

#### General Information

- **Short description**: Developer workstation bundle
- **Model categories**: Bundle
- **Asset tracking strategy**: Leave to category
- **Acquisition method**: None
- **Cost**: $1,568.94
- **Depreciation**: N/A
- **Comments**: N/A
- **Model number**: DWB-001
- **Barcode**: DWB-001
- **Owner**: N/A
- **Status**: In Production
- **Certified**: Yes

#### Related Links

**Publish to Hardware Catalog**

### Model Components

**Bundle = Developer workstation bundle**

<table>
<thead>
<tr>
<th>Model Components</th>
<th>Is main component</th>
<th>Component</th>
<th>Model category of component</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>true</td>
<td>Apple MacBook Pro 13&quot;</td>
<td>Computer</td>
</tr>
<tr>
<td></td>
<td>false</td>
<td>Standard input bundle</td>
<td>Bundle</td>
</tr>
<tr>
<td></td>
<td>false</td>
<td>Samsung SyncMaster 22&quot; Class BackLight LED</td>
<td>Monitor</td>
</tr>
<tr>
<td></td>
<td>false</td>
<td>Samsung SyncMaster 22&quot; Class BackLight LED</td>
<td>Monitor</td>
</tr>
</tbody>
</table>

**Actions on selected rows...**
Remove model components from a bundle
Remove a component from a bundled model, for example, when you want to replace it with a different component.

Role required: model_manager

No component history is retained. If you remove a component from a bundled model, no record is saved showing that the component was ever part of a bundle.

1. Navigate to Product Catalog > Product Model > Bundled Models.
2. Open a bundle record.
3. In the Model Components related list, select the component you want to remove.
4. In the Actions choice list below the list, select Delete.
5. Click OK.

Software models
Software models are created as part of the asset management process. You can create product models for software from the product catalog, but you cannot administer all aspects of the software models.

Software models are used in software counters. For more information about creating software models, see Add a software model.

Create application models
You can create application models that can be managed and tracked within a Scrum development process.

Role required: model_manager

1. Navigate to Product Catalog > Product Model > Application Models.
2. Click New.
3. Complete the form.
   For general field descriptions, see Model form fields. There are no fields specific to application models.
4. Click Submit.

Work order models
When work management is activated, the ServiceNow platform adds the Work Order Models and Work Task Models modules to the product catalog.

Users with the wmn_admin role can define new model records, which can be used as templates to create work orders for common procedures.

Models created for VMware support and Amazon EC2
When you activate Orchestration for VMware or Amazon EC2, the system creates a model (vmware instance or ec2 instance) automatically.

When the virtual machine is terminated, the asset state changes to Retired.

Add skills to a model
You can associate skills with any model. Creating associations between skills and models is helpful if you are using work management and want to assign tasks to agents based on their skills with specific models.
Role required: skill_admin or model_manager

1. Navigate to Product Catalog > Product Model > All Models.
2. Open a product model.
3. In the Skills related list, click Edit.
4. Add items from the Collection list to the Skills List.
5. Click Save.

Publish models to the hardware or software catalog

You can publish models to the hardware or software catalog to make the models available in the service catalog.

Role required: catalog_admin

1. Navigate to Product Catalog > Product Model > All Models.
2. Open a product model.
3. In Related Links, click Publish to Hardware or Publish to Software Catalog.
4. Select a category.
5. Click OK.

Delete models

If a model is no longer needed, you can delete it as long as no assets or configuration items use the model.

Role required: model_manager

1. Navigate to Product Catalog > Product Model > All Models.
2. Select the check box beside the product model.
3. From the Actions choice list below the list, select Delete.
4. Click OK.

Vendor catalog items

The vendor catalog is a list of goods available from different vendors.

An accurate and complete vendor catalog can make it easier to keep items in stock at the best possible price.

You can link multiple vendor catalog items to a single product catalog item, which allows you to track information about a single item at different vendors.

For example, for an iPhone 5 product catalog item, you can create separate vendor catalog items from Apple and from Amazon. Select the vendor with the best price when you source an item. Users need the model_manager role to work with vendor catalog items.

Synchronize information

Certain information is synchronized between models, product catalog items, and vendor catalog items.

When working with models, product catalog items, and vendor catalog items, keep the following in mind:

- Changes to model record update vendor catalog items automatically only if the vendor catalog items are published, not linked.
If a model is linked to a vendor catalog item, any changes to the model do not update the vendor catalog item.

After publishing a vendor catalog item or model to the hardware or software catalog, some fields become read-only on the vendor catalog item or product catalog item record. Information can only be updated on the model record.

List of synchronized fields:
- Description
- Short description
- Name
- Product ID
- Price
- Vendor
- Specs
- Features
- Model
- UPC
- Model number
- Cost
- Manufacturer

Create a vendor catalog item

Create a vendor catalog item to associate product models with a vendor.

Role required: model_manager

1. Navigate to Product Catalog > Catalog Definition > Vendor Items.
2. Click New.
3. Complete the form.

Vendor Catalog Item fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the item is built from information in the Product Model, Vendor, and Product ID fields.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The supplier that provides the item.</td>
</tr>
<tr>
<td>Product model</td>
<td>The specific version or configuration of the item.</td>
</tr>
<tr>
<td>Out of stock</td>
<td>The option that indicates whether the item is unavailable for order. This field is important if you are sourcing request items. Clear this check box if the item is available to order.</td>
</tr>
<tr>
<td>Product ID</td>
<td>The item identification number assigned by your organization.</td>
</tr>
<tr>
<td>List price</td>
<td>The price at which the item retails, excluding vendor discounts.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vendor price</td>
<td>The price at which the item is available in the vendor catalog. If the vendor offers a discount, the vendor price reflects the discounted price.</td>
</tr>
<tr>
<td>Rank tier</td>
<td>Displays the overall ranking for this vendor's products and services, such as Valued Partner or Blacklisted Supplier. Rank tier expresses your organization's opinion of this vendor's performance. It can be used to decide if the vendor's products should be promoted or discontinued. Users with the vendor_manager role can edit this field.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the item.</td>
</tr>
</tbody>
</table>

**General section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product catalog item</td>
<td>Name of the product catalog item, if the item has been added to the product catalog. Leave this field empty if you are going to link a vendor catalog item to the hardware catalog.</td>
</tr>
<tr>
<td>UPC</td>
<td>The barcode number used to uniquely identify and track items for sale.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to list the item in the vendor catalog. Clear this check box to hide the item in the vendor catalog.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the item.</td>
</tr>
</tbody>
</table>

**Information section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifications</td>
<td>Facts about the item such as size, weight, version, or speed.</td>
</tr>
<tr>
<td>Features</td>
<td>Distinct properties or distinguishing characteristics of the item.</td>
</tr>
</tbody>
</table>

4. Click Submit.

*Link an item to the hardware catalog*

After you create a vendor catalog item, link the item to the hardware catalog for viewing.

**Role required:** model_manager

To see the Link to Hardware Catalog Item related link on the Vendor Catalog Item form, add a hardware model or a consumable model to the Product Model field, and leave the Product Catalog Item field blank.

1. Navigate to Product Catalog > Catalog Definition > Vendor Items.
2. Open a vendor catalog item.
3. In Related Links, click Link to Hardware Catalog Item.
4. Select a Catalog Item.
5. Click OK.

The page refreshes to the selected hardware catalog item. The vendor catalog item is listed in the Vendor Catalog Items related list.
**Link an item to the software catalog**
After you create a vendor catalog item, link the item to the software catalog for viewing.

Role required: model_manager

To see the **Link to Software Catalog Item** related link on the Vendor Catalog Item form, add a software model or a consumable model to the **Product Model** field, and leave the **Product Catalog Item** field blank.

1. Navigate to **Product Catalog > Catalog Definition > Vendor Items**.
2. Open a vendor catalog item.
3. In **Related Links**, click **Link to Software Catalog Item**.
4. Select a **Catalog Item**.
5. Click **OK**.
   - The page refreshes to the selected software catalog item. The vendor catalog item is listed in the **Vendor Catalog Items** related list.

**Publish an item to the hardware catalog**
After you create a hardware item for the vendor catalog, publish it to the hardware catalog for viewing. The hardware catalog is a section within the service catalog.

Role required: catalog_admin

To see the **Publish to Hardware Catalog Item** related link on the Vendor Catalog Item form, add a hardware model or a consumable model to the **Product Model** field, and leave the **Product Catalog Item** field blank.

After you publish a vendor catalog item to the hardware catalog, the **Publish to Hardware Catalog** related link is no longer available. Any changes made on the vendor catalog item record are synchronized with the information in the hardware catalog.

1. Navigate to **Product Catalog > Catalog Definition > Vendor Items**.
2. Open a vendor catalog item.
3. In **Related Links**, click **Publish to Hardware Catalog**.
4. Select a **Category**.
5. Click **OK**.
   - The Hardware Catalog form opens and the item is listed in the **Vendor catalog Items** related list.

**Publish an item to the software catalog**
After you create a software item for the vendor catalog, publish it to the software catalog for viewing. The software catalog is a section within the service catalog.

Role required: catalog_admin

To see the **Publish to Software Catalog Item** related link on the Vendor Catalog Item form, add a software model or a consumable model to the **Product Model** field, and leave the **Product Catalog Item** field blank.

After you publish a vendor catalog item to the software catalog, the **Publish to Software Catalog** related link is no longer available. Any changes made on the vendor catalog item record are synchronized with the information in the software catalog.

1. Navigate to **Product Catalog > Catalog Definition > Vendor Items**.
2. Open a vendor catalog item.
3. In **Related Links**, click **Publish to Software Catalog**.
4. Select a **Category**.
5. Click **OK**.
The Software Catalog form opens and the item is listed in the Vendor catalog Items related list.

View a vendor list
You can view a list of vendors from the product catalog.
Role required: model_manager
The list includes every company that has the Vendor option selected on its record.
1. Navigate to Product Catalog > Catalog Definition > Vendors.
2. Click any vendor Name for more information.

Product catalog items
Product catalog items are hardware and software that you can track and offer in the service catalog.
The product catalog is an extension of the Service Catalog that contains a list of available Models. Users with the catalog_admin role can create, activate, and deactivate product catalog items.

Create a product catalog item
Create hardware and software product catalog items to include in the product catalog and the service catalog.
Role required: catalog_admin
You must activate the items separately before they appear in the product catalog or service catalog.
1. Navigate to Product Catalog > Catalog Definition > Hardware and Software Items.
2. Click New.
3. Complete the form.
   Some of the fields listed do not appear until you save the product catalog item.

Product catalog item fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the item as you want it displayed in the product catalog.</td>
</tr>
<tr>
<td>Catalogs</td>
<td>The catalog this item is listed in.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The vendor that supplies the item. If the item is purchased from multiple vendors, use the vendor catalog and leave this field empty.</td>
</tr>
<tr>
<td>Rank tier</td>
<td>The overall ranking for the selected vendor’s products and services. This field is only visible in a Product Catalog Item record when the CI class is Hardware Catalog or Software Catalog.</td>
</tr>
<tr>
<td>Model</td>
<td>The specific version or configuration of the item.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Product ID</td>
<td>The item identification number assigned by your organization.</td>
</tr>
<tr>
<td>Price</td>
<td>The price at which the item is available in the product catalog. Enter a numerical value and select the appropriate currency.</td>
</tr>
<tr>
<td>Recurring price</td>
<td>The item’s recurring price. For example, a subscription to a mobile phone contract could cost $500.00, with an $30.00 monthly recurring price.</td>
</tr>
<tr>
<td>Recurring price frequency</td>
<td>The interval at which the recurring price is accrued.</td>
</tr>
<tr>
<td>List Price</td>
<td>The price at which the item retails. This field is only visible when the Class is Hardware Catalog or Software Catalog.</td>
</tr>
<tr>
<td>Cost</td>
<td>The price at which the item was purchased from the vendor. The cost could be less than the List Price if your organization received a discount from the vendor. This field is only visible in a product catalog item record when the CI class is Hardware Catalog or Software Catalog.</td>
</tr>
<tr>
<td>Omit price in cart</td>
<td>When selected, hides the price when the item is displayed in the service catalog. Clear the check box to show the price in the service catalog. This field is only visible in a product catalog item record when the CI class is Hardware Catalog.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Workflow associated with this item.</td>
</tr>
<tr>
<td>Execution plan</td>
<td>The execution plan associated with this item.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the item.</td>
</tr>
<tr>
<td>Ordered item link</td>
<td>The list of links containing more information about items. The links can be reused across multiple items.</td>
</tr>
<tr>
<td>Class</td>
<td>The catalog item class this item belongs to. Select Hardware Catalog or Software Catalog. This field is visible by default. When you save the record as a hardware or software catalog item, the form is retitled Hardware Catalog or Software, respectively.</td>
</tr>
<tr>
<td>General section</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>The named group of items to which the item belongs.</td>
</tr>
<tr>
<td>Delivery time</td>
<td>The amount of time it takes to deliver the item, starting from when it is ordered from the product catalog.</td>
</tr>
<tr>
<td>UPC</td>
<td>The barcode number used to identify and track items.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the item. The description is displayed in the product catalog listing.</td>
</tr>
<tr>
<td>Product Information section</td>
<td></td>
</tr>
<tr>
<td>Cost</td>
<td>The price at which the item was purchased from the vendor. This field is only visible when the Class is Software Catalog.</td>
</tr>
<tr>
<td>Specifications</td>
<td>Facts about the item, such as size, weight, version, or speed.</td>
</tr>
<tr>
<td>Features</td>
<td>Distinct properties or distinguishing characteristics of the item.</td>
</tr>
<tr>
<td>Images section</td>
<td></td>
</tr>
<tr>
<td>Icon</td>
<td>A small image that appears next to the name when the item is displayed in the service catalog. Supported file types are jpg, png, bmp, gif, and jpeg.</td>
</tr>
<tr>
<td>Picture</td>
<td>An image showing the item. Supported file types are jpg, png, bmp, gif, and jpeg.</td>
</tr>
<tr>
<td>Related lists</td>
<td></td>
</tr>
<tr>
<td>Includes</td>
<td>More catalog items provided with this item. This related list is for informational purposes only.</td>
</tr>
<tr>
<td>Variables</td>
<td>Service catalog variables associated with this item. A service catalog variable captures and passes on information about choices a customer makes when ordering an item from the service catalog.</td>
</tr>
<tr>
<td>Vendor Catalog Items</td>
<td>Vendor catalog items associated with this item. Vendor catalog items allow you to track information about this item by its specifications for each vendor.</td>
</tr>
</tbody>
</table>
Hardware catalog item

- **Name**: Canon ImageCLASS Laser Printer
- **Product ID**: CANONILP1
- **Price**: $495.99
- **Recurring price**: $0.00
- **Vendor**: Canon
- **Model**: Canon ImageCLASS Laser Printer

**Related Links**
- Reactivate
4. Optional: Click Try It to preview the item as it appears in the service catalog.
5. Click Submit or Update.

Activate a product catalog item

Activate a product catalog item to make it available in the product catalog and the service catalog.

Role required: catalog_admin
You can activate the item from either the list view or the record.

1. Navigate to Product Catalog > Catalog Definition > Hardware and Software Items.
2. Complete one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate one or more items from the list view</td>
<td>Select the check box next to one or more items in the record list and click Activate below the list.</td>
</tr>
<tr>
<td>Activate from the record</td>
<td>Click Activate under Related Links.</td>
</tr>
</tbody>
</table>

Deactivate a product catalog item

Deactivate a product catalog item to remove it from the product catalog and the service catalog.

Role required: catalog_admin
You can deactivate the item from either the list view or the record.

1. Navigate to Product Catalog > Catalog Definition > Hardware and Software Items.
2. Complete one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deactivate from the list view</td>
<td>Select the check box next to one or more items in the record list and click Deactivate below the list.</td>
</tr>
<tr>
<td>Deactivate from the record</td>
<td>Click Deactivate under Related Links.</td>
</tr>
</tbody>
</table>

Model categories

Model categories associate CI classes with asset classes. Model categories are part of the Product Catalog application.

The model category configuration determines if the ServiceNow platform creates an asset from a CI, and, if so, what class of asset. Asset classes in the base system are Hardware, Software License, and Consumable. You can associate a model category to many models and a model to many model categories. For example, a specific model of a computer can be a Computer and a Server.
View model categories

Default model categories are included with product catalog. You can view a list of default categories and the categories that you created.

Role required: model_manager

1. Navigate to Product Catalog > Product Model > Model Categories.
2. Open a model category to view its details.

Create model categories

You can add custom model categories for your instance.

Role required: model_manager

When you create model categories, keep the following in mind:

- The base system provides a model category for each CI class in the CMDB. As you create `cmdb_ci` classes, create a corresponding row in the model category table for the model table to be used.
• If you select an **Asset class** on any existing model category, the system automatically creates assets for all configuration items associated with the model category, if configured to do so. If an asset is not created automatically, you can create the asset manually. After an asset class is selected for a model category, the asset class cannot be changed.

• The **Allow pre-allocated**, **Allow in bundle**, and **Allow as master** options are only available if an asset class is specified for the model category.

• If you select **Consumable** or **Software License** for the asset class, the **Allow in bundle** option is available, but not **Allow pre-allocation** or **Allow as master**.

• When a CI is created from a model category that requires asset tracking, the system automatically creates an asset record for the asset class specified in the model category. It then links that asset record to the CI. If a model is specified, the model category of the CI is determined by a combination of the CI class and the list of categories supported by the model. Asset tracking is specified on the model record.

• When an asset is created from a model category that requires CI tracking, the system automatically creates a CI record of the class specified by the category and links it to the asset.

• The Model Categories list (**Product Catalog** > **Product Model** > **Model Categories**) shows all the CI classes and what asset class is generated on the asset side.

---

1. Navigate to **Product Catalog** > **Product Model** > **Model Categories** and click **New**.

2. Complete the form.

**Model Category fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for this category.</td>
</tr>
<tr>
<td>CI class</td>
<td>If a CI class is needed, it must be specified when you create the model category. You can’t add the CI class the model category later.</td>
</tr>
<tr>
<td>Asset class</td>
<td>Default options and any new asset classes you have created. Setting the asset class triggers the creation of assets depending on the model category selected. You can add an asset class to the model category later, but can’t be changed after it is added. If you select <strong>Consumable</strong> or <strong>Software License</strong>, the CI class field becomes read-only because consumables and software licenses do not create CIs. If you specify a CI class and then select <strong>Consumable</strong> or <strong>Software License</strong>, the CI class field is changed to None automatically.</td>
</tr>
</tbody>
</table>

- **Asset**: An item that can be tracked individually.
- **Consumable**: An asset not tracked individually, such as keyboards.
- **Hardware**: A physical piece of computer equipment, such as a laptop or server.
- **Software License**: A legal statement defining the uses of software, such as the number of installations allowed or the terms of distribution.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow pre-allocation</td>
<td>Add and track items in this category as pre-allocated assets.</td>
</tr>
<tr>
<td>Allow in bundle</td>
<td>Use items in this category in bundles.</td>
</tr>
<tr>
<td>Allow as master</td>
<td>Use items in this category as the master component in a bundle.</td>
</tr>
<tr>
<td>Enforce CI verification</td>
<td>Prevents the system from automatically creating assets in a specific model category when CIs are added manually or found with Discovery. This option enables an administrator to review and verify new CIs before adding them as assets. For example, an administrator can prevent contractors© computers that are discovered as CIs by Help the Help Desk from being added to the asset portfolio.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Create assets manually**

The Now Platform does not create an asset automatically under certain conditions. You can create an asset manually as needed.

**Role required:** model_manager

The conditions under which an asset is not automatically created include the following.

- **Forced CI verification:** If you select the **Enforce CI verification** check box in the **Model Category** form, the system does not create an asset automatically when a CI is created or discovered. When **Enforce CI verification** is enabled, newly created CIs do not trigger an automatic creation of an asset. Instead, these newly created CIs have their **Requires verification** field automatically set to true, which displays the following UI actions for the CI:
  - **Create Asset:** Creates an asset and sets **Requires verification** to false.
  - **Merge CI:** Merges duplicates of a CI. This action is useful if an asset for the CI was created in a separate process, which created an associated CI. Then a second CI was created either manually or via the discovery source - and the duplicate CIs did not properly coalesce.

- **Configuration errors:** In rare cases, the system can fail to create the asset automatically. This failure can occur if you assign the model and model category to the CI in the wrong sequence.

Follow these steps to create an asset manually.

1. Navigate to **Product Catalog > Product Model > Model Categories**.
2. Open a model category that has no assigned CI class.
3. Click **Create Assets**.

   This action creates assets from all CIs deferred for verification in this model category. This option is only available for users with the admin role.

**Edit model categories**

All default model categories can be edited, except for the Contract model category. You can edit any custom model categories that you created at any time.
Role required: model_manager

1. Navigate to Product Catalog > Product Model > Model Categories.
2. Open a model category record.
3. Make changes to the model, as appropriate.
4. Click Update.

Delete model categories

If a model category is no longer needed, you can delete it.

Role required: model_manager

Only model categories that are not referenced by any models can be deleted.

1. Navigate to Product Catalog > Product Model > Model Categories.
2. Select the check box beside the model category Name.
3. From the Actions on Selected Rows menu below the list, click Delete.
4. Click Delete.

Domain separation and Product Catalog

This is an overview of domain separation and the Product Catalog. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Standard

- Includes Basic level support.
- Business logic: Processes can be created or modified per customer by the service provider (SP). The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The owner of the instance needs to be able to configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin needs to be able to make comments mandatory when a record closes for one tenant, but not for another.

How domain separation works in Product Catalog

The domain owner's employees and tenants can use the same processes if the work is done in the correct domain. When adjusting any configuration, you should be in the domain where you're doing the work. Use the domain picker to select the correct domain to work in.

Benchmarks

The ServiceNow® Benchmarks application gives you instant visibility into your key performance indicators (KPIs) and trends, as well as comparative insight relative to industry averages of your peers. You can contrast the performance of your organization with recognized industry standards, view a side-by-side comparison of performance with global benchmarks, and implement recommendations for improved performance.
Benchmarks overview

The ServiceNow Benchmarks application securely collects daily data on your instance and then aggregates the data into monthly global benchmark reports. Performance Analytics collects daily data on customer instances. The data from the previous month is uploaded at the beginning of the following month via a scheduled job. If there are any errors, there are multiple retries.

During the month the data is uploaded, the data is aggregated and monthly results (your instance results, global results, and your ranking) are downloaded to the customer instance mid month. Monthly recommendation candidates are provided that you can implement to help improve your KPI performance. An email notification is sent when the global data is available.

ServiceNow has over two thousand customers that have opted into the Benchmarks program. All ServiceNow customers are allowed to participate in the Benchmarks program by opting in from their ServiceNow production instance, except:

- Express customers
- Federal customers
- Customers with on-premise instances

**Note:** You must have a production instance to opt into the Benchmarks program.

Managed Service Providers (MSPs) and MSP-managed instances are supported and have exclusive access to global MSP aggregate score data. All instances will support Global Industry, Number of users, and geographical Region benchmarks that can be downloaded for comparison in the Benchmarks dashboard, but these benchmarks are not calculated using MSP data.

Changing KPI configuration within the month requires one to two months of data collection before your monthly values reflect that change.

**Note:** The Benchmark Scheduler (bm.scheduler) user is added with Benchmarks. It is required for Benchmarks data collection.
Key features

- 26 available KPIs (20 ITSM, 3 ITOM, 3 Security Operations).
- Ability to change KPI definitions to match customizations.
- Benchmarks dashboard in Service Portal (mobile friendly).
- Ability to download KPI reports.
- Filter data by industry, number of users, or geographical region.
- Email notification when new aggregate monthly data is available.
- Percentile ranking to indicate your standing within your participating peer group.
- Recommendation candidates with guided setup to help improve KPI performance.
- Product category-based roles to limit data access.
- Integration with Performance Analytics for daily data collection and drill-down on KPI data.
### Benefits

<table>
<thead>
<tr>
<th>Benefit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global anonymity</td>
<td>Viewers in your organization have access benchmarks for your organization, however the global benchmarks are anonymous and do not include any company information.</td>
</tr>
</tbody>
</table>
| Industry comparison      | Using the Compare with drop-down menu in the Benchmarks dashboard, you can filter the benchmarks results by industry, ServiceNow user size, or geographical region to make the results more relevant to your organization.  
  - Industry is determined based on the standard industry code in the account record for the company.  
  - Number of users is determined by the number of ServiceNow active users within the company, so you can compare your company to similar-sized ServiceNow implementations to gain insight about your company.  
  - Region is determined based on the Region field in the company table.  
  Industry and company size categories are combined when necessary to ensure that the number of customers in each category is large enough to protect the anonymity of each company.  
  If a filter category contains fewer than 20 participants, the corresponding data is shown in the Other category.                                                                                                                                                                                                                                                                                                                                                       |
| Trends                   | You can see the results of all published KPIs as well as the previous six months of history.  
  You can then use the trend data to measure and report on service delivery progress over a period of time to determine what is working well and what needs improvement.                                                                                                                                                                                                                                                                                                                                                                             |
| Recommendations          | Data is analyzed and recommendation candidates are provided to help improve the performance of your KPIs.  
  All recommendations are dynamic and are updated monthly, based on data from the previous month.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                |
| Reports                  | Benchmarks reports get refreshed monthly, which can be downloaded in PDF format. An email notification is sent to the customer when new data is available.                                                                                                                                                                                                                                                                                                                                                                                                                                                                 |

**Email notification**

Users with the Benchmarks admin (sn_bm_client.benchmark_admin) and Benchmarks data viewer (sn_bm_client.benchmark_data_viewer) roles automatically receive email notification regarding availability of monthly scores, historical data recalculation, and new KPIs. You must have system admin (admin) role to modify the email recipient list.
• An email containing notification information is sent when the monthly global data is available. Monthly results (your instance results, and global results) are downloaded to the customer instance mid month.
  
  • Subject: New Monthly Benchmarks report is available now
  • Body: ServiceNow Benchmarks has been updated with <month> data. You can see the updated Benchmarks by viewing the Benchmarks Dashboard <Benchmarks Dashboard Portal link>.

• An email containing notification information is sent when historical data for the past six months is recalculated.
  
  • Subject: Historical Global Benchmarks scores have been refreshed
  • Body: The global Benchmarks scores of last 6 months have been recalculated with improved data quality. You can see the updated Benchmarks by visiting Benchmarks Dashboard <Benchmark Dashboard Portal Link>.

• An email containing notification information is sent when an updated KPI version is introduced (with some fixes, for example).
  
  • Subject: One or more Benchmarks KPI versions have changed
  • Body: The latest Benchmarks scores have a new version of following KPIs with improved data quality.
    
    < KPI name>
    
    You can see the updated Benchmarks by visiting Benchmarks Dashboard <Benchmark Dashboard Portal Link>

Benchmarks notification emails are accessed using the System Settings > Notifications navigation menu.

**Benchmarks data transfer**

Your Benchmarks score data is automatically uploaded to ServiceNow on the 3rd day of the month. Global scores are automatically downloaded to your instance on the 11th day of the month.

You can manually upload or download scores beyond those days of the month (on demand) by executing the Benchmarks scores scheduled jobs through the System Definition > Scheduled Jobs navigation item.

• Upload the benchmark scores (automatically runs on the first day of the month)
• Download the benchmark scores (automatically runs on the ninth day of the month)

These on-demand scheduled jobs are useful if, for any reason, there was a failure in the automatic upload or download scores process and it is after the cutoff dates. You can also run a scheduled job to generate six months of historical data.

**KPI categories**

<table>
<thead>
<tr>
<th>ITSM KPIs</th>
<th>% of high priority incidents resolved</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td></td>
</tr>
<tr>
<td><strong>Paris IT Service Management</strong></td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td></td>
</tr>
<tr>
<td>% of incidents resolved on first assignment</td>
<td></td>
</tr>
<tr>
<td>% of incidents resolved within SLA</td>
<td></td>
</tr>
<tr>
<td>% of reopened incidents</td>
<td></td>
</tr>
<tr>
<td>Average time to resolve a high priority incident</td>
<td></td>
</tr>
<tr>
<td>Average time to resolve an incident</td>
<td></td>
</tr>
<tr>
<td>Number of incidents created per user</td>
<td></td>
</tr>
<tr>
<td><strong>Problem</strong></td>
<td></td>
</tr>
<tr>
<td>% of high priority problems</td>
<td></td>
</tr>
<tr>
<td>% of incidents resolved by problem</td>
<td></td>
</tr>
<tr>
<td>Average time to close a problem</td>
<td></td>
</tr>
<tr>
<td><strong>Change</strong></td>
<td></td>
</tr>
<tr>
<td>% of emergency changes</td>
<td></td>
</tr>
<tr>
<td>% of failed changes</td>
<td></td>
</tr>
<tr>
<td>Average time to close a change</td>
<td></td>
</tr>
<tr>
<td><strong>Service Catalog</strong></td>
<td></td>
</tr>
<tr>
<td>% of closed requests with breached SLAs</td>
<td></td>
</tr>
<tr>
<td>Average time to fulfill a request</td>
<td></td>
</tr>
<tr>
<td>Number of requests created per user</td>
<td></td>
</tr>
<tr>
<td><strong>Knowledge</strong></td>
<td></td>
</tr>
<tr>
<td>% of incidents resolved using KB articles</td>
<td></td>
</tr>
<tr>
<td>Number of knowledge article views per user</td>
<td></td>
</tr>
<tr>
<td><strong>Other</strong></td>
<td></td>
</tr>
<tr>
<td>Average customer satisfaction</td>
<td></td>
</tr>
<tr>
<td>Number of requesters per fulfiller</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>ITOM KPIs</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CMDB</strong></td>
</tr>
<tr>
<td>% of duplicate CIs</td>
</tr>
<tr>
<td>% of non-compliant CIs</td>
</tr>
<tr>
<td>% of stale CIs</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Security Operations</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Security Incident Response</strong></td>
</tr>
<tr>
<td>% of critical and high priority security incidents</td>
</tr>
<tr>
<td><strong>Vulnerability Response</strong></td>
</tr>
<tr>
<td>Average critical vulnerability age</td>
</tr>
<tr>
<td>Average vulnerability age</td>
</tr>
</tbody>
</table>

**Benchmarks roles**

These roles are introduced with Benchmarks.
## Roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Capabilities</th>
</tr>
</thead>
</table>
| sn_bm_client.benchmark_admin              | • Set up Benchmarks from an instance  
• Opt in or out of the Benchmarks program  
• Enable, disable, or modify indicators (including changing Performance Analytics indicator source, script, and conditions for those KPIs not requiring application-specific roles)  
• Receive email notification when new aggregate monthly data is available  
• All functions of the Benchmarks viewer and Benchmarks recommendations roles |
| sn_bm_client.benchmark_data_viewer        | • View full benchmark reports in Service Portal  
• View data visualizations and drill-downs for analyzing trends (not PA scorecards)  
• Download visualizations  
• View industry category or size comparisons  
• Receive email notification when new aggregate monthly data is available |
| sn_bm_client.benchmark_recommendation_viewer | View benchmark KPI recommendation candidates.                                                                                           |

## Enable Benchmarks

You must opt in to Benchmarks to participate in Benchmarks data collection. However, you can opt out at any time.

To keep the Benchmarks comparison data clean, you can opt in to Benchmarks only from your production instance.

Role required: `sn_bm_client.benchmark_admin`

Once you have manually opted into Benchmarks, enable and configure benchmark KPIs. From the Benchmarks dashboard, you can view the Benchmarks KPI data, performance trends, and indicator scorecards.

**Note:** Service Portal must be installed to view the Benchmarks dashboard.

Six months of global data is available after opting in. If available, the corresponding data for your instance is also included.

**Note:** Past data for your instance is only available for Benchmarks users upgrading from a previous release.

1. To opt in to Benchmarks:
Using | Do this
---|---
Guided setup | 1. Navigate to Continual Improvement > Administration > Guided Setup.
| 2. Go to the Enable Benchmarks section and click Configure.

### Opt out of Benchmarks
You can opt out of Benchmarks at any time. If you opt out, your company usage data is no longer included in the Benchmarks data set, and you no longer see aggregate metrics.

**Role required:** sn_bm_client.benchmark_admin

When you opt out of the Benchmarks forum, it means that you no longer have access to benchmarking information for your organization. Your usage data is also removed from the Benchmarks data set going forward. However, your company can rejoin the Benchmarks program at any time.

**Note:** It may take up to two monthly refresh cycles for the request to be processed.

1. Navigate to Benchmarks > Setup.
2. Click Opt-out of ServiceNow Benchmarks.
3. Click Opt-Out.
4. Optional: To send your feedback, provide the relevant information and click Send. Otherwise click Cancel to skip the survey.
The opt-out confirmation is shown. You can opt back in at any time.

**Benchmark KPIs**

You can enable or disable a benchmark KPI, and customize KPI conditions. Integration with Performance Analytics provides daily data collection and drill-down capabilities on KPI data. Benchmarks offers ITSM, ITOM, and Security Operations KPIs.

**Note:** Upgrading Benchmarks does not change KPI status or configuration from the previous release. New KPIs are enabled by default.

Benchmarks uses anonymous, aggregated, usage data from customers who have opted in to calculate global and industry benchmarks. The KPIs in the Benchmarks application are performance analytics indicators that only collect the usage count data, for example, the total number of incidents in a month, based on the monthly aggregates. During data collection, the
Benchmarks application does not consider any other details such as description of incidents, or information about requests, changes, or applications.

To calculate monthly values, the Benchmarks data is aggregated at the top level, such as:

- Global, which applies to all participating customers
- Industry Category
- User Size, which is based on active ServiceNow user count
- Three geo regions

The participating customer count for each cohort bucket in the Industry Category, User Size, and the three geo regions aggregates are large enough to calculate monthly benchmarks values and to maintain the full anonymity. To further ensure data anonymity, the Benchmarks user interface allows you to use only one filter at a time.

**ITSM KPIs**

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>% of high priority incidents resolved</strong></td>
<td>(Number of priority 0 (P0) and priority 1 (P1) incidents resolved during the month) / (Total number of incidents resolved during the same month)</td>
</tr>
<tr>
<td><strong>Incident count</strong></td>
<td>is generated from the Incident table.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>In some environments, KPIs involving resolved incidents may require further configuration to retrieve resolved incident data.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The definition of P0 and P1 incidents is likely to vary per participant. Your P0 and P1 incidents may or may not be similar to the incidents of others. For comparison, the metrics provided in this report represent the average of all participants.</td>
</tr>
<tr>
<td><strong>% of incidents resolved on first assignment</strong></td>
<td>(Number of incidents resolved on first assignment during the month) / (Total number of incidents resolved during the same month)</td>
</tr>
<tr>
<td><strong>First assignment Count</strong></td>
<td>is when the Reassignment Count field is 0 for the incident.</td>
</tr>
<tr>
<td>KPI</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>% of incidents resolved within SLA</td>
<td>(Number of incidents with met SLAs resolved during the month) / (Total number of incidents resolved during the same month)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Met SLAs</strong> are calculated from the task_sla table for incidents resolved during the month.</td>
</tr>
<tr>
<td>% of reopened incidents</td>
<td>(Number of incidents resolved during the month that were reopened) / (Total number of incidents resolved during the same month)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reopened</strong> is when the Reopen Count field is greater than 0 for the incident.</td>
</tr>
<tr>
<td>Average time to resolve a high priority incident</td>
<td>(Sum of the duration of all high priority incidents resolved during the month) / (Total number of high priority incidents resolved during the same month)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Duration</strong> is the length of time from creation to resolution.</td>
</tr>
<tr>
<td></td>
<td>• <strong>High priority</strong> incidents include priority 0 (P0) and priority 1 (P1).</td>
</tr>
<tr>
<td>Average time to resolve an incident</td>
<td>(Sum of the duration of all incidents resolved during the month) / (Total number of incidents resolved during the same month)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Duration</strong> is the length of time from creation to resolution.</td>
</tr>
<tr>
<td>Number of incidents created per user</td>
<td>Number of incidents per user created during the month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Global</strong> value is the average of all participating customers per user.</td>
</tr>
</tbody>
</table>
### Problem

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of high priority problems</td>
<td>(Number of high priority problems closed during the month) / (Total number of problems closed during the same month)</td>
</tr>
<tr>
<td></td>
<td>• High priority problems include priority 0 (P0) and priority 1 (P1).</td>
</tr>
<tr>
<td>% of incidents resolved by problem</td>
<td>(Number of incidents resolved during the month that are associated with a problem) / (Total number of incidents resolved during the same month)</td>
</tr>
<tr>
<td>Average time to close a problem</td>
<td>(Sum of the duration of all problems closed during the month) / (Total number of problems closed during the same month)</td>
</tr>
<tr>
<td></td>
<td>• Duration is the length of time from creating to closure.</td>
</tr>
</tbody>
</table>

### Change

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of emergency changes</td>
<td>(Number of emergency changes closed during the month) / (Total number of all changes closed during the same month)</td>
</tr>
<tr>
<td></td>
<td>• All changes include standard, normal, and emergency.</td>
</tr>
<tr>
<td>% of failed changes</td>
<td>(Number of unsuccessful changes during the month) / (Total number of all changes closed during the same month)</td>
</tr>
</tbody>
</table>
## Paris IT Service Management

### KPI Description

**Average time to close a change**

\[
\text{Average time to close a change} = \frac{\text{Sum of the duration of all changes closed during the month}}{\text{Total number of all changes closed during the same month}}
\]

- **Duration** is the length of time from creating to closure.
- **All changes** include standard, normal, and emergency.

### Service Catalog

**% of closed requests with breached SLAs**

\[
\% \text{ of closed requests with breached SLAs} = \frac{\text{Number of closed requests with breached SLAs during the month}}{\text{Total number of closed requests during the same month}}
\]

- **Breached SLAs** are calculated from the `task_sla` table for requests closed during the month.

**Average time to fulfill a request**

\[
\text{Average time to fulfill a request} = \frac{\text{Sum of the duration for Service Catalog requests fulfilled during the month}}{\text{Total number of Service Catalog requests fulfilled in the same month}}
\]

- **Duration** is the length of time from creation to closure.
- **Number of Service Catalog requests fulfilled** is the count of the number of records in the `sc_req_item` table which were closed within a month.

**Number of requests created per user**

Number of requests per user created during the month.

### Knowledge

**% of incidents resolved using KB articles**

\[
\% \text{ of incidents resolved using KB articles} = \frac{\text{Number of incidents with KB articles resolved during the month}}{\text{Total number of incidents resolved during the same month}}
\]
<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
</table>
| Number of knowledge articles views per user | Number of knowledge article views per user during the month.  
  - Knowledge base views are generated from the sys_view_count table.  
  - Global value is the average of all participating customers per user. |

**Other**

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
</table>
| Average customer satisfaction | (Sum of normalized metric values of all survey instances taken during the month) / (Total number of survey instances taken during the same month)  
  - Table: metric_results.  
  - Metric value is normalized as per category weights. |

**Note:** This KPI uses the base system Customer Satisfaction Survey.  
If you are using a different survey to collect user feedback, you can customize the KPI definition.

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of requests per fulfiller</td>
<td>(Number of active requester (non-ITIL) users during the month) / (Total number of active ITIL users during the same month)</td>
</tr>
</tbody>
</table>
## ITOM KPIs

### CMDB

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of duplicate CIs</td>
<td>(Number of duplicate CIs during the month) / (Total number of CIs during the same month)</td>
<td>Duplicate CIs are calculated using the cmdb_health_scorecard table. Note: The definition of duplicate CIs is likely to vary per participant. Your duplicate CIs definition may or may not be similar to the definitions of others. For comparison, the metrics provided in this report represent the average of all participants.</td>
</tr>
<tr>
<td>% of non-compliant CIs</td>
<td>(Number of CI audit failures during the month) / (Total number of CIs audited during the same month)</td>
<td>Non-compliant CIs are calculated using the cmdb_health_scorecard table. Note: The definition of CI compliance audits is likely to vary per participant. Your CI compliance audit definition may or may not be similar to the definitions of others. For comparison, the metrics provided in this report represent the average of all participants.</td>
</tr>
<tr>
<td>% of stale CIs</td>
<td>(Number of stale CIs during the month) / (Total number of CIs during the same month)</td>
<td>Stale CIs are calculated using the cmdb_health_scorecard table. Note: The definition of stale CIs is likely to vary per participant. Your stale CIs definition may or may not be similar to the definitions of others. For comparison, the metrics provided in this report represent the average of all participants.</td>
</tr>
</tbody>
</table>
Security Operations KPIs

Security Incident Response

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
</table>
| % of critical and high priority security incidents | (Number of critical and high priority security incidents created during the month) /  
|                                               | (Total number of all security incidents created during the same month)       |

Vulnerability Response

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average critical vulnerability age</td>
<td>(Summed age of critical vulnerable items) / (Number of critical vulnerable items)</td>
</tr>
<tr>
<td>Average vulnerability age</td>
<td>(Summed age of vulnerable items) / (Number of vulnerable items)</td>
</tr>
</tbody>
</table>

Enable a benchmark KPI

Enable KPIs to use in your data reporting.
Role required to enable a KPI: sn_bm_client.benchmark_admin
Role required to assign roles to a KPI category: admin

KPIs are grouped within categories (for example, ITSM, ITOM, Security Operations). You can assign roles to certain categories so that the corresponding KPI data is limited to authorized groups.

1. Navigate to Benchmarks > Administration > Setup.
2. To enable or disable a KPI, click the KPI slider.
3. To view more information about a KPI, click the KPI. Additional information includes description, formula, conditions, and tables from which the data is collected.
4. Click Save. Allow one to two months for aggregate monthly data to accurately reflect changes made to KPI status.

Note: In some environments, resolved incident KPIs may require further configuration to retrieve resolved incident data.

5. Optional: To limit access of benchmark data to specific categories, assign roles to a KPI category.
   a) Navigate to Benchmarks > Administration > Category and select a KPI category.
   b) To add a role, click View Roles.
Configure resolved incident Benchmarks KPIs

The source for the KPIs containing resolved incident data is the `resolved_at` field in the Incident (incident) table, which may not exist in some environments. In this case, additional configuration is required to use these KPIs.

**Note:** If you have never tracked resolved incidents in your environment before, install the *Incident Resolution Fields* (com.snc.incident_resolution_fields) plugin, which automatically adds the `resolved_at` field to the Incident table. No further steps are required.

Role required: sn_bm_client.benchmark_admin

If you are receiving errors in the Benchmarks Data Collection job log for resolved incident KPIs because you are using a custom (user-created) field to track resolved incidents, the following procedure is required for successful data retrieval using these Benchmarks KPIs.

- % of high priority incidents resolved
- % of incidents resolved on first assignment
- % of incidents resolved within SLA
- % of reopened incidents
- Average time to resolve a high priority incident
- Average time to resolve an incident
- Number of incidents created per user

Configure the KPI conditions and script to use your custom field (instead of the default `resolved_at` field) for resolved incident Benchmarks KPIs.

1. Configure the `Benchmark.Incidents.Resolved` indicator source condition with your custom field.
   a) Navigate to `Performance Analytics > Sources > Indicator Sources`.
   b) Select the `Benchmark.Incidents.Resolved` indicator source and enter edit mode.
   c) In the Conditions section, select your custom field from the list (custom field names are typically preceded by `u_`).
   d) Click **Update**.

2. Configure the `Benchmark.Incident.ResolvedTime.Hours` script with your custom field name.
   a) Navigate to `Performance Analytics > Automation > Scripts`.
   b) Select the `Benchmark.Incident.ResolvedTime.Hours` script and enter edit mode.
   c) Replace the `resolved_at` field name occurrence within the script with the name of your custom field (custom field names are typically preceded by `u_`).
   d) Click **Update**.

3. Verify that you are no longer receiving errors in the Benchmarks Data Collection job log.
Link or customize a benchmark KPI

You can customize KPI conditions to fit the needs of your organization better.

The Benchmarks admin role does not provide application-specific roles. Therefore, although a Benchmarks admin can access a KPI through the Benchmarks application, changes to KPI conditions require the role specific to the KPI application.

For example, a Benchmarks admin cannot modify conditions for the knowledge base KPI (Knowledge Use (kb_use) table), SLA KPI (Task SLA (task_sla) table), ITOM KPIs (CMDB Health Scorecard (cmdb_health_scorecard) table), or Security Operations KPIs (Vulnerable Item (sn_vul_vulnerable_item), Security Incident (sn_si_incident) tables) from within Benchmarks without specific access granted to those tables (knowledge_admin, sla_admin, asset, sn_si.special_access roles).

Role required: sn_bm_client.benchmark_admin

Customizing KPI conditions is useful to adjust the criteria to more accurately represent the data that your company is interested in.

For example, if your implementation does not use priority 1 incidents, you can change the criteria for high priority KPIs from 1 to 0, which returns more accurate data for your organization.

**Note:** It takes one to two months for aggregate monthly data to accurately reflect changes made to KPI conditions. For example, changes made within the month include a combination of data:
- Data for the previous condition (up until the date the condition was changed)
- Data for the new condition from that date forward

For further analysis, you can link a Performance Analytics indicator that you are already using to the corresponding Benchmarks indicator to see breakdowns, in addition to individual scores, when drilling down on KPI data.

For example, link **Number of resolved incidents by first assigned group** to **Benchmark: Number of incidents resolved on first assignment** to view breakdown values by priority, assignment group, and category.

**Note:** Individual scores are shown by default but you must have **Performance Analytics** to use linking to show breakdowns.

1. Navigate to **Benchmarks > Setup** and click a KPI to access the KPI conditions.
2. Change the conditions, as appropriate.
3. To link a Performance Analytics indicator to a Benchmarks indicator, follow the procedure in **Link an automated indicator to a benchmark.**
<table>
<thead>
<tr>
<th>Benchmarks KPI</th>
<th>Formula</th>
<th>Performance Analytics KPI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of active users</td>
<td>--</td>
<td>Benchmark: Number of active users</td>
</tr>
<tr>
<td>Total time to close changes</td>
<td>--</td>
<td>Benchmark: Total time to close changes</td>
</tr>
<tr>
<td>% of failed changes</td>
<td>(Number of unsuccessful changes during the month) / (Total number of all changes closed during the same month)</td>
<td>Benchmark: % of failed changes</td>
</tr>
<tr>
<td>Number of unsuccessful changes</td>
<td>--</td>
<td>Benchmark: Number of unsuccessful changes</td>
</tr>
<tr>
<td>Number of changes closed</td>
<td>--</td>
<td>Benchmark: Number of changes closed</td>
</tr>
<tr>
<td>% of emergency changes</td>
<td>(Number of emergency changes closed during the month) / (Total number of all changes closed during the same month)</td>
<td>Benchmark: % of emergency changes</td>
</tr>
<tr>
<td>Number of emergency changes closed</td>
<td>--</td>
<td>Benchmark: Number of emergency changes closed</td>
</tr>
<tr>
<td>Average time to close a change</td>
<td>(Benchmark: Total time to close changes) / ((Benchmark: Number of changes closed))</td>
<td>Benchmark: Average time to close a change</td>
</tr>
<tr>
<td>% of stale CIs</td>
<td>Monthly average.</td>
<td>Benchmark: % of stale cis</td>
</tr>
<tr>
<td>% of duplicate CIs</td>
<td>Monthly average.</td>
<td>Benchmark: % of duplicate CIs</td>
</tr>
<tr>
<td>% of non-compliant CIs</td>
<td>Monthly average.</td>
<td>Benchmark: % of non-compliant CIs</td>
</tr>
<tr>
<td>Average time to resolve a high priority incident</td>
<td>((Benchmark: Total time to resolve high priority incidents)) / ((Benchmark: Number of high priority incidents resolved))</td>
<td>Benchmark: Average time to resolve a high priority incident</td>
</tr>
<tr>
<td>% of incidents resolved within SLA</td>
<td>(((Benchmark: Number of resolved incidents with SLAs)) - ((Benchmark: Number of resolved incidents with breached SLAs)) / ((Benchmark: Number of resolved incidents with SLAs)) * 100</td>
<td>Benchmark: % of incidents resolved within SLA</td>
</tr>
<tr>
<td>Benchmarks KPI</td>
<td>Formula</td>
<td>Performance Analytics KPI</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Total number of incidents resolved by problem</td>
<td>--</td>
<td>Benchmark: Total number of incidents resolved by problem</td>
</tr>
<tr>
<td>Number of incidents closed that were re-opened</td>
<td>--</td>
<td>Benchmark: Number of incidents closed that were re-opened</td>
</tr>
<tr>
<td>Number of high priority incidents</td>
<td>--</td>
<td>Benchmark: Number of high priority incidents resolved</td>
</tr>
<tr>
<td>Average time to resolve an incident</td>
<td>((Benchmark: Total time to resolve an incident) / ((Benchmark: Number of incidents resolved))</td>
<td>Benchmark: Average time to resolve an incident</td>
</tr>
<tr>
<td>Number of resolved incidents with SLAs</td>
<td>--</td>
<td>Benchmark: Number of resolved incidents with SLAs</td>
</tr>
<tr>
<td>Number of incidents created per user</td>
<td>((Benchmark: Number of incidents created / By month SUM) / ((Benchmark: Number of active users / By month AVG))</td>
<td>Benchmark: Number of incidents created per user</td>
</tr>
<tr>
<td>Total time to resolve high priority incidents</td>
<td>--</td>
<td>Benchmark: Total time to resolve high priority incidents</td>
</tr>
<tr>
<td>% of high priority incidents</td>
<td>((Benchmark: Number of high priority incidents resolved) / ((Benchmark: Number of incidents resolved)) * 100</td>
<td>Benchmark: % of high priority incidents</td>
</tr>
<tr>
<td>Number of incidents created</td>
<td>--</td>
<td>Benchmark: Number of incidents created</td>
</tr>
<tr>
<td>Number of incidents resolved with attached KB articles</td>
<td>--</td>
<td>Benchmark: Number of incidents resolved with attached KB articles</td>
</tr>
<tr>
<td>Number of resolved incidents with breached SLAs</td>
<td>--</td>
<td>Benchmark: Number of resolved incidents with breached SLAs</td>
</tr>
<tr>
<td>Total number of incidents</td>
<td>--</td>
<td>Benchmark: Number of incidents resolved</td>
</tr>
<tr>
<td>Number of incidents resolved on first assignment</td>
<td>--</td>
<td>Benchmark: Number of incidents resolved on first assignment</td>
</tr>
<tr>
<td>% of incidents resolved on first assignment</td>
<td>((Benchmark: Total time to resolve an incident) / ((Benchmark: Number of incidents resolved))</td>
<td>Benchmark: % of incidents resolved on first assignment</td>
</tr>
<tr>
<td>Total time to resolve incidents</td>
<td>--</td>
<td>Benchmark: Total time to resolve an incident</td>
</tr>
<tr>
<td>Benchmarks KPI</td>
<td>Formula</td>
<td>Performance Analytics KPI</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>% of reopened incidents</td>
<td>( \frac{((\text{Benchmark: Number of incidents closed that were reopened}))}{((\text{Benchmark: Number of incidents closed}))} \times 100 )</td>
<td>Benchmark: % of reopened incidents</td>
</tr>
<tr>
<td>Number of incidents closed</td>
<td>--</td>
<td>Benchmark: Number of incidents closed</td>
</tr>
<tr>
<td>Number of knowledge article views</td>
<td>--</td>
<td>Benchmark: Number of knowledge article views</td>
</tr>
<tr>
<td>Number of knowledge base views per user</td>
<td>( \frac{((\text{Benchmark: Number of knowledge article views / By month SUM}))}{((\text{Benchmark: Number of active users / By month AVG}))} )</td>
<td>Benchmark: Number of knowledge base views per user</td>
</tr>
<tr>
<td>% of incidents resolved using KB articles</td>
<td>( \frac{((\text{Benchmark: Number of incidents resolved with attached KB articles}))}{((\text{Benchmark: Number of incidents resolved}))} \times 100 )</td>
<td>Benchmark: % of incidents resolved using KB articles</td>
</tr>
<tr>
<td>Number of survey instances</td>
<td>--</td>
<td>Benchmark: Number of survey instances</td>
</tr>
<tr>
<td>Number of active ITIL users</td>
<td>--</td>
<td>Benchmark: Number of active ITIL users</td>
</tr>
<tr>
<td>Normalized customer satisfaction</td>
<td>--</td>
<td>Benchmark: Normalized customer satisfaction</td>
</tr>
<tr>
<td>Average customer satisfaction</td>
<td>( \frac{((\text{Benchmark: Normalized customer satisfaction}))}{((\text{Benchmark: Number of survey instances}))} )</td>
<td>Benchmark: Average customer satisfaction</td>
</tr>
<tr>
<td>Number of requesters per fulfiller</td>
<td>( \frac{((\text{Benchmark: Number of active users})) - ((\text{Benchmark: Number of active ITIL users}))}{((\text{Benchmark: Number of active ITIL users}))} )</td>
<td>Benchmark: Number of requesters per fulfiller</td>
</tr>
<tr>
<td>% of high priority problems</td>
<td>( \frac{((\text{Benchmark: Number of high priority problems closed}))}{((\text{Benchmark: Number of problems closed}))} \times 100 )</td>
<td>Benchmark: % of high priority problems</td>
</tr>
<tr>
<td>Total time to close problems</td>
<td>--</td>
<td>Benchmark: Total time to close problems</td>
</tr>
<tr>
<td>Benchmarks KPI</td>
<td>Formula</td>
<td>Performance Analytics KPI</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------</td>
</tr>
<tr>
<td>% of incidents resolved by problem</td>
<td>((Benchmark: Total number of incidents resolved by problem)) / ((Benchmark: Number of incidents resolved)) * 100</td>
<td>Benchmark: % of incidents resolved by problem</td>
</tr>
<tr>
<td>Number of high priority problems closed</td>
<td>--</td>
<td>Benchmark: Number of high priority problems closed</td>
</tr>
<tr>
<td>Number of problems closed</td>
<td>--</td>
<td>Benchmark: Number of problems closed</td>
</tr>
<tr>
<td>Average time to close a problem</td>
<td>((Benchmark: Total time to close problems)) / ((Benchmark: Number of problems closed))</td>
<td>Benchmark: Average time to close a problem</td>
</tr>
<tr>
<td>% of critical and high priority security incidents</td>
<td>(((Benchmark: Number of Critical and High Priority Security Incidents)) / ((Benchmark: Number of Security Incidents)) * 100</td>
<td>Benchmark: % of critical and high priority security incidents</td>
</tr>
<tr>
<td>Number of critical and high priority security incidents</td>
<td>--</td>
<td>Benchmark: Number of Critical and High Priority Security Incidents</td>
</tr>
<tr>
<td>Number of security incidents</td>
<td>--</td>
<td>Benchmark: Number of Security Incidents</td>
</tr>
<tr>
<td>Number of requests created</td>
<td>--</td>
<td>Benchmark: Number of requests created</td>
</tr>
<tr>
<td>Number of requests closed</td>
<td>--</td>
<td>Benchmark: Number of requests closed</td>
</tr>
<tr>
<td>Average time to fulfil a request</td>
<td>((Benchmark: Total time to fulfil requests)) / ((Benchmark: Number of requests closed))</td>
<td>Benchmark: Average time to fulfil a request</td>
</tr>
<tr>
<td>Number of closed requests with SLAs</td>
<td>--</td>
<td>Benchmark: Number of closed requests with SLAs</td>
</tr>
<tr>
<td>Number of requests created per user</td>
<td>((Benchmark: Number of requests created / By month SUM)) / ((Benchmark: Number of active users / By month AVG))</td>
<td>Benchmark: Number of requests created per user</td>
</tr>
<tr>
<td>Number of closed requests with breached SLAs</td>
<td>--</td>
<td>Benchmark: Number of closed requests with breached SLAs</td>
</tr>
<tr>
<td>Total time to fulfil requests</td>
<td>--</td>
<td>Benchmark: Total time to fulfil requests</td>
</tr>
</tbody>
</table>
### Benchmarks KPI

<table>
<thead>
<tr>
<th>Benchmarks KPI</th>
<th>Formula</th>
<th>Performance Analytics KPI</th>
</tr>
</thead>
</table>
| % of closed requests with breached SLAs | \(
\frac{(\text{Benchmark: Number of closed requests with breached SLAs})}{(\text{Benchmark: Number of closed requests with SLAs})} 
\times 100
\) | Benchmark: % of closed requests with breached SLAs |
| Number of critical vulnerability items | -- | Benchmark: Number of critical vulnerability items |
| Number of vulnerability items | -- | Benchmark: Number of vulnerability items |
| Average vulnerability age | \(
\frac{(\text{Benchmark: Summed age of vulnerable items})}{(\text{Benchmark: Number of vulnerability items})}
\) | Benchmark: Average age of vulnerable items |
| Average critical vulnerability age | \(
\frac{(\text{Benchmark: Summed age of critical vulnerable items})}{(\text{Benchmark: Number of critical vulnerable items})}
\) | Benchmark: Average age of critical vulnerable items |
| Summed age of critical vulnerable items | -- | Benchmark: Summed age of critical vulnerable items |
| Summed age of vulnerable items | -- | Benchmark: Summed age of vulnerable items |

### Use Benchmarks data for value management analysis

Manually collect historical Benchmarks data analyze benefits of year-over-year growth when you use the ServiceNow Benchmarks application.

Role required: sn_bm_client.benchmark_admin, pa_data_collector, or admin

If you want to analyze year-over-year performance, you need to collect at least 24 months of Benchmarks data. Use the `sn_bm_client.months_copy_historical_pa_bm` system property to set the number of months from the current month for which you want to collect Benchmarks historical data.

1. **Set up Benchmarks historical data collection.**
   a) Navigate to **Performance Analytics > Data Collection > Jobs**.
   b) Select the **Benchmarks Historical Data Collection** job.
   c) In the **Relative start** field, enter the time period for which you want to collect the data.
   d) In the **Relative start interval** field, select the length of the time period to collect the data. Recommended interval is 24 months.
   e) Click **Execute**.
      
      For detailed information on scheduling a data collection job, refer to **Create or schedule a data collection job**.

2. **Upload the collected data to the centralized Benchmarks instance.**
a) In the **Benchmarks Historical Data Collection** job, navigate to the **Job Logs** related list.

b) Make sure the state for the historical data collection job is **Collected**. This indicates that all data for the job has successfully run and all data has been gathered for the set time period.

c) Navigate to **System Definition > Scheduled Jobs**.

d) Select the **Copy historical scores from PA to Benchmarks table**

e) Click **Execute Now**.

The data will be automatically sent for value management analysis. Connect with your account representative to receive the report and discuss the you benefits for your organization’s value management.

---

**Benchmarks dashboard**

The Benchmarks dashboard shows KPI data, performance trends, and indicator scorecards. The Benchmarks KPI dashboard view, which shows all KPIs, is launched in Service Portal.

Features include:

- Ability to show KPIs in either list or card view.
- Downloadable reports of KPI list and all charts in PDF format.
- Ability to filter data by type of industry, number of users, MSPs, or geographic region (the filter is retained when switching between KPI view and trend view).

**Note:** Only Managed Service Providers (MSP) can view the global MSP aggregate score data.

- Color-coded KPI data (the favorable comparison results for your instance are in green, while red favors global data).
- Monthly change percentage calculation of your instance from the previous month.
- Ability to view six months of historical KPI data.
- Ability to display time values in hours or days (using the `sn_bm_client.dashboard_display_unit` system property).

**Note:** Service Portal must be installed to view the Benchmarks dashboard.
Percentile rank

The exact standing of the KPI for your company within your participating peer group is indicated by percentile rank. A KPI percentile rank of 90% indicates that your instance standing for that KPI is greater than 90% of the instances participating in that group.

**Note:** A high percentile rank does not always indicate a desirable result. For certain KPIs a higher ranking is preferred (% of incidents resolved using KB articles), but for others it is not (% of emergency changes). The meaning of your percentile ranking should be interpreted based on the direction of the KPI being analyzed.

<table>
<thead>
<tr>
<th>KPI</th>
<th>Direction (Percentile rank goal)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Minimize</td>
</tr>
<tr>
<td>Incident</td>
<td></td>
</tr>
<tr>
<td>% of high priority incidents resolved</td>
<td>X</td>
</tr>
<tr>
<td>% of incidents resolved on first assignment</td>
<td></td>
</tr>
<tr>
<td>% of incidents resolved within SLA</td>
<td></td>
</tr>
<tr>
<td>KPI</td>
<td>Direction (Percentile rank goal)</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>% of reopened incidents</td>
<td>X</td>
</tr>
<tr>
<td>Average time to resolve a high priority incident</td>
<td>X</td>
</tr>
<tr>
<td>Average time to resolve an incident</td>
<td>X</td>
</tr>
<tr>
<td>Number of incidents created per user</td>
<td>X</td>
</tr>
<tr>
<td>Problem</td>
<td></td>
</tr>
<tr>
<td>% of high priority problems</td>
<td>X</td>
</tr>
<tr>
<td>% of incidents resolved by problem</td>
<td></td>
</tr>
<tr>
<td>Average time to close a problem</td>
<td></td>
</tr>
<tr>
<td>Change</td>
<td></td>
</tr>
<tr>
<td>% of emergency changes</td>
<td>X</td>
</tr>
<tr>
<td>% of failed changes</td>
<td>X</td>
</tr>
<tr>
<td>Average time to close a change</td>
<td></td>
</tr>
<tr>
<td>Service Catalog</td>
<td></td>
</tr>
<tr>
<td>% of closed requests with breached SLAs</td>
<td>X</td>
</tr>
<tr>
<td>Average time to fulfill a request</td>
<td></td>
</tr>
<tr>
<td>Number of requests created per user</td>
<td>X</td>
</tr>
<tr>
<td>Knowledge</td>
<td></td>
</tr>
<tr>
<td>% of incidents resolved using KB articles</td>
<td></td>
</tr>
<tr>
<td>Number of knowledge article views per user</td>
<td></td>
</tr>
<tr>
<td>Other</td>
<td></td>
</tr>
<tr>
<td>Average customer satisfaction</td>
<td>X</td>
</tr>
<tr>
<td>Number of requesters per fulfiller</td>
<td></td>
</tr>
<tr>
<td>CMDB</td>
<td></td>
</tr>
<tr>
<td>% of duplicate CIs</td>
<td>X</td>
</tr>
<tr>
<td>% of non-compliant CIs</td>
<td>X</td>
</tr>
<tr>
<td>% of stale CIs</td>
<td>X</td>
</tr>
<tr>
<td>KPI</td>
<td>Minimize</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Security Incident Response</td>
<td></td>
</tr>
<tr>
<td>% of critical and high priority security incidents</td>
<td>X</td>
</tr>
<tr>
<td>Vulnerability Response</td>
<td></td>
</tr>
<tr>
<td>Average critical vulnerability age</td>
<td>X</td>
</tr>
<tr>
<td>Average vulnerability age</td>
<td></td>
</tr>
</tbody>
</table>

**ITSM dashboards**

ITSM dashboards are a central place for ITSM users to monitor ongoing ITSM operations. These dashboards contain data visualizations to help you improve your business processes and practices.

Access the dashboards under **Self-Service > Dashboards**. To view detailed information, hover over any report graphic.

**Note:** The **Performance Analytics ITSM Dashboards** are required to view these dashboards. The Performance Analytics - Content Pack - ITSM Dashboards (com.snc.pa.itsm_dashboards) plugin must be activated.

For more information, see **Analytics and Reporting Solutions**.

<table>
<thead>
<tr>
<th>Dashboard</th>
<th>Description</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT Manager</td>
<td>Overview reports and IT service analysis reports</td>
<td>• Incident Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SLA Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_admin</td>
</tr>
<tr>
<td>IT Agent</td>
<td>Agent work and agent group work reports, and prioritized workload</td>
<td>• itil</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• itil_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_admin</td>
</tr>
<tr>
<td>IT Executive</td>
<td>Customer service, performance, and risk map reports</td>
<td>• itil</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• itil_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_admin</td>
</tr>
</tbody>
</table>

**View benchmark KPI data**

Benchmarks KPI data is shown in Service Portal. Data includes values for your company instance, and for global data.
Role required: sn_bm_client.benchmark_data_viewer

1. Navigate to Benchmarks > Dashboard.
2. In the KPI category list, select IT Service Management, IT Operations Management, or Security Operations.
3. To view the corresponding group of KPIs, click a tab.

   **Note:** If the data seems incomplete or incorrect, you can investigate the KPI definition and conditions in Performance Analytics > Sources > Indicator Sources.

4. To filter results, select either an industry, number of users, or region in the Compare with: list. The data is automatically updated when you select a filter.

   **Note:** If a filter category contains fewer than 20 participants, the corresponding data is shown in the Other category.

5. For choice of view, click either the list icon or the card-view icon. In card view, clicking a KPI shows the six-month KPI performance trend chart on the card.

6. To download a report to a PDF file, click the arrow icon ( ).

Click a KPI to view Benchmarks KPI performance trend and recommendations.

**Benchmarks KPI performance trend and recommendations**

The Benchmarks KPI performance chart trend view shows your KPI performance comparison with global data, and provides recommendations to implement for improved performance of your KPI. The KPI Performance Trends chart section is shown only for users with the Benchmarks viewer role (sn_bm_client.benchmark_data_viewer).
% of incidents resolved on first assignment

Summary: September 2017

Your Industry: Communications, Media and Services

DEFINITION

PERFORMANCE TREND

<table>
<thead>
<tr>
<th>Benchmark</th>
<th>Your Instance</th>
<th>Percentile Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>68%</td>
<td>65% ▲ 2%</td>
<td>86.54</td>
</tr>
</tbody>
</table>

KPI Performance Trends chart
Your 6-month monthly data is mapped against global data, and your percentile rank indicating your standing within the participating peer group is shown.

Functionality of the performance trend chart view includes:

- Switching between KPIs in the same category using the KPI list.
- Viewing your instance and global data for a certain month by hovering over a point on the graph.
- Accessing the Performance Analytics scorecard for a data point in your instance.
- Downloading KPI chart reports.
- Filtering data by type of industry, number of users, or geographic region.

Recommendations

The Recommendations section is shown only for users with the Benchmarks recommendation role (sn_bm_client.benchmark_recommendation_viewer).

Recommendation candidates are provided in the performance trend view to help improve the performance of your KPIs. All recommendations are dynamic and are updated monthly, based on data analyzed from the previous month. Recommendation candidates are listed by rank.

Note: Some KPI recommendations that use guided setup require system admin permission. Work with your system administrator to implement these recommendations.
Implement Service Level Management

1. Monitor service levels and receive notification when service levels are not being met, or are close to being breached.
2. Provide escalation notices to the appropriate teams when the delivery time is close to being breached so that work can be prioritized.

Implement Knowledge Management and improve the quality of KB articles

Use Knowledge Management to create known error articles in your knowledge base.
1. End users can find solutions, preventing the creation of incidents.
2. The fullfiller can find answers to known problems without escalating incidents to next level.
3. You can update or retire articles with a low rating to keep information relevant, which increases KB views.

Implement CMDB, and monitor and maintain your CMDB health score

1. Use CMDB to improve the time it takes to determine the cause of an incident and resolve it.
2. Create business services for Cs to provide an accurate picture of the cause of the outage and what is affected by the outage.
3. Determine whether other systems of record have data that could be referenced in ServiceNow to negate the need for multiple systems, or repetitive data entry of employee information.
4. Ensure that high-impact services are reflected in the CMDB and are in sync with environmental changes.

Note: Please work with your System Admin to implement this recommendation using Guided Setup.
Actions are available for each recommendation candidate. Based on the action, recommendations get filtered into the appropriate group tab (Implemented or Saved). Closing out the recommendation removes the recommendation candidate from the list.

- **Get Started**: Executes Guided Setup, if available, otherwise opens documentation containing information regarding the improvement.
- **Mark as Implemented**: Moves the recommendation candidate to the Implemented tab. This action is no longer available when a CIM improvement initiative is associated with the recommendation candidate.
- **Save for Later**: Moves the recommendation candidate to the Saved tab to be implemented at a later time.
- **Improvement Initiative** section:
  - **Create Improvement Initiative**: Creates a CIM improvement initiative, which contains phases and tasks to improve the KPI. Once the CIM improvement initiative is created, the recommendation candidate is moved to Saved tab.
  - **Select Improvement Initiative**: Associates an existing CIM improvement initiative. The state of the recommendation candidate is set to the state of the associated CIM improvement initiative.

  **Note**: CIM Short description and Description fields are populated automatically from the recommendation candidate content only when the CIM improvement initiative is initially created from a recommendation candidate, not when associating afterward.

- **Improvement Initiative related link**: Links to the associated CIM improvement initiative. Click the related link to view the CIM improvement initiative in Continual Improvement Management.
- **Remove Improvement Initiative**: Removes the associated CIM improvement initiative from the item in the Recommendations list.

  When the CIM improvement initiative is closed, the recommendation candidate is moved to the Implemented tab. If the CIM improvement initiative is canceled, the recommendation candidate remains in the Saved tab. The associated CIM improvement initiative can always be removed, and another can be selected.

Tabs for recommendation candidates:

**Recommendations**

Lists all recommendation candidates based on the analysis of the monthly data. This list gets refreshed monthly.

**Implemented**

Lists all recommendation candidates that you have implemented. Recommendation candidates that were implemented the previous month include tracking information on the trend chart so you can determine the impact of the change. Hovering over the implementation point shows the recommendation implemented.

**Note**: Recommendation candidates implemented in the current month do not have tracking data points on the chart until the following month.
Saved
Lists all recommendation candidates that have been saved to implement later.

Drill down within benchmark KPI data
You can drill down within benchmark KPI data for further analysis within Performance Analytics.

ℹ️ Note: When drilling down on a benchmark value, Benchmarks viewers must have the pa_viewer role to view Performance Analytics scorecards.

Role required: sn_bm_client.benchmark_admin or sn_bm_client.benchmark_data_viewer with pa_viewer role
You can drill down on a benchmark value from the KPI performance trends chart to view individual data that makes up that value. For example, you may want to drill down and investigate data that is presented as a value in red (lower performance) on the chart.

ℹ️ Note: You can only drill down within KPI data from the KPI performance trends chart. You can only drill down on scores generated using Performance Analytics.

1. Navigate to **Benchmarks > Dashboard**.
2. To view the KPI definition and performance trend, click a KPI.
3. To drill down further into the Performance Analytics scorecard, click a value in your benchmark data on the performance trends chart.

ℹ️ Note: For additional analysis on **Chart, Scores, Comments**, or **More info**, see **Performance Analytics**.

Benchmarks troubleshooting
Troubleshooting actions can help resolve common issues when setting up or running Benchmarks.

| Scenario                          | Reason                                                          | Action                                                                 |
|----------------------------------|                                                                |                                                                       |
| No data in dashboard after opting in. | The download REST API for six months failed or there is a connection failure. | Verify in the sysevent table that sn_bm_client.download.scores.6months event is processed. |
| No instance data is shown in the dashboard for the last month. | PA data collection or scorecards API failure. | Make sure the condition in the indicator source, script field in the indicator, and additional conditions in the indicator are correct. |
| No global data in dashboard for the last month. | The download REST API failed or there is a connection failure. | Verify in the sysevent table that sn_bm_client.download.scores event is processed. |
| Opt-in process fails.             | Authentication failed or the instance type is not supported.   | Contact ServiceNow Technical Support team.                            |
## Domain separation and Benchmarks

This is an overview of domain separation and the Benchmarks application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: No support**

- The domain field may exist on data tables, but there is no business logic to manage data.
- This level is not considered domain-separated.

For more information, see [Application support for domain separation](#).

## Change Management

The ServiceNow® Change Management application provides a systematic approach to control the life cycle of all changes, facilitating beneficial changes to be made with minimum disruption to IT services.

ServiceNow Change Management integrates with the [Vulnerability response](#) plugin to introduce extra functionality within Change Management.

### Explore
- Change types
- State model and transitions
- Standard change catalog
- Domain separation in Change Management

### Set up
- Change Management plugins
- Change Management properties
- Configure Change Management

### Administer
- Configure ability to copy a change request
- Configure standard change catalog properties
- Create blackout and maintenance schedules in Change Management
- Add a new change request type
- Risk assessment
- Change Management Analytics and Reporting Solutions

### Use
- Create a change request

### Develop
- Developer training
- Developer documentation

### Migrate
Associated CIs on a change request
Process a change request
Analyze change request risk and impact
Change Advisory Board (CAB) workbench

Troubleshoot and get help
- Ask or answer questions in the Change Management forum
- Search the HI Knowledge Base for known error articles
- Contact ServiceNow Technical Support

Change types

Change Management supports the three types of service changes ITIL describes — standard, emergency, and normal. The change type determines which state model is invoked and the change process that must be followed.

Watch this eight-minute video for an overview of Change Management in ITSM.

Standard change

A standard change is a pre-authorized change that is low risk, relatively common and follows a specified procedure or work instruction.

A standard change is one that is frequently implemented, has repeatable implementation steps, and has a proven history of success. As Standard changes are pre-approved, they follow a streamlined process in which group level or peer approval and CAB authorization steps are not required.

Approved standard change requests can be predefined in a catalog of templates to make accessing and requesting a standard change more efficient. This ability also enables the Change Management team to control the changes that are authorized as standard.

Emergency change

A change that must be implemented as soon as possible, for example to resolve a major incident or implement a security patch. This change is of such a high priority that it bypasses group and peer review and approval and goes straight to the Authorization state for approval by the CAB approval group.

Emergency changes cover the following types of emergencies:
- Fix on fail or retroactive situations where the impact to service has already been experienced.
- Fail or fail situations where the impact to service is imminent if action is not taken.

These changes do not follow the complete life cycle of a normal change due to the speed with which they must be authorized. Therefore, they progress directly to the Authorize state for approval from the CAB Approval group.
During an emergency change, there are chances that an unplanned CI change activity occurs. During such a case, an unauthorized change request is created and sent for approvals. For more information, see Unauthorized change request.

**Normal change**

Any service change that is not a standard change or an emergency change.

Normal change requests follow a prescriptive process which requires two levels of approval before being implemented, reviewed, and closed. These changes require a full range of assessments and authorizations such as peer or technical approval, change management, and Change Advisory Board (CAB) authorization, to ensure completeness, accuracy, and the least possible disruption to service. These changes are most often scheduled outside of defined change blackout windows or during defined maintenance windows. The normal type is used to implement beneficial change for any change to a service that is not a standard or emergency change.

**Upgrade Change Management**

Follow these instructions to upgrade your Change Management system.

Prior to Geneva, Change Request installed the Conflict Detection, Best Practice Change Risk Calculator, Change Risk Assessment, and Bulk CI Changes plugins by default.

For new instances from Geneva onwards, the Standard change catalog, State Model, and Mass updates CI plugins are also installed by default.

If you are upgrading from a release prior to Geneva, you can choose to activate Change Management core, State Model, Standard change catalog, and Mass updates CI plugins. The State Model, and Standard change catalog plugins are dependent on the Change Management core plugin. Hence, activating either the State model or the Standard change catalog plugins results in the activation of the Change Management core plugin.

Also consider the following consequences of activating Change Management core and the subsequent changes you might need to make to best suit your organization’s requirements:

- The previous change types are updated from routine, comprehensive, and emergency to standard, normal, and emergency respectively. Analyze customizations that you may have performed that reference old change type values since they are affected and require updating.

  **Note:** When Change management core is activated, the change types are updated.

If you already upgraded from a release prior to Geneva, you must perform the following tasks after you activate Change management core to ensure that change types and customizations are updated.

- If you had created newer change types in addition to the default change types, then you must customize them based on the new change types being introduced.
- Modify the customizations that are affected to use the new change type values.
- A new ACL, `change_request.type`, prevents users from updating the change type. If you allow any roles to update the type of a change request, for example, from Normal to Emergency, modify the ACL. Remove nobody from the Requires role list and add the roles allowed to update the change type.
- If you had the Bulk CI plugin installed, then install the Mass updates CI plugin for enhanced user experience and alignment with the new plugins.
Change Management plugins

You can activate one or more of the Change Management plugins if they are not already active. Some plugins include demo data.

Many of the following Change Management plugins are activated in the base system. Others can be activated when you are ready to use them. The Change Management plugins that are inactive in the base system include the following.

- Change Management mass update CI (com.snc.change_management.mass_update_ci)
- Change Management risk assessment (com.snc.change_management.risk_assessment)
- Best practice - bulk CI changes (com.snc.bestpractice.bulkchange)

You can activate one or more of the following Change Management plugins.

Request ITSM Roles- Change Management

Request the ITSM Roles plugin (com.snc.itsm.roles) to activate the ITSM Roles — Change Management plugin (com.snc.itsm.roles.change_management) to gain more control over the access that different change agents, technicians, and managers have within your Change Management process.

Role required: admin

The ITSM Roles plugin (com.snc.itsm.roles) includes an additional security model. The security model provides more granular roles across ITSM applications as well as within them, allowing you flexibility in setting up access controls. The ITSM Roles plugin is available by default in new instances. Users upgrading from Madrid or earlier versions must request the plugin.

### Plugins for ITSM Roles

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Adds roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Stakeholder (com.snc_business_stakeholder)</td>
<td>business_stakeholder</td>
</tr>
<tr>
<td>ITSM Roles — Incident Management (com.snc.itsm.roles.incident_management)</td>
<td>sn_incident_read&lt;br&gt;sn_incident_write</td>
</tr>
<tr>
<td>ITSM Roles — Problem Management (com.snc.itsm.roles.problem_management)</td>
<td>sn_problem_read&lt;br&gt;sn_problem_write</td>
</tr>
<tr>
<td>ITSM Roles — Change Management (com.snc.itsm.roles.change_management)</td>
<td>sn_change_read&lt;br&gt;sn_change_write</td>
</tr>
</tbody>
</table>

**Note:** The business_stakeholder role contains the sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.
<table>
<thead>
<tr>
<th>Plugin</th>
<th>Adds roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITSM Roles — Request Management</td>
<td>• sn_request_read</td>
</tr>
<tr>
<td>(com.snc.service_management.roles.request_management)</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** As there are future updates expected for the `sn_request_read` role, do not assign it to users without the `business_stakeholder` role.

- sn_request_write

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and subproduction instances, generally within a few days.

If you don’t have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.

**Note:** Activate the ITSM Roles plugin on a subproduction environment and test the functionality before requesting activation in the production environment. For assistance, contact the ServiceNow Professional Services team.

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.
4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specifying the date and time you'd like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click Submit.

**Components installed with ITSM Roles - Change Management**

Several user roles are installed with the activation of the ITSM Roles — Change Management plugin (com.snc.itsm.roles.change_management). Security ACLs to support the security model for Change Management and related functionality are also installed.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.
Roles installed

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change read (sn_change_read)</td>
<td>Read access to the Change Management application and related records.</td>
<td>• dependency_views</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• view_changer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• cmdb_read</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• app_service_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• cmdb_query_builder_read</td>
</tr>
<tr>
<td>Change write (sn_change_write)</td>
<td>Write access to the Change Management application and related records.</td>
<td>• sn_change_read</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• template_editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• cmdb_query_builder</td>
</tr>
</tbody>
</table>

Note: A user with the sn_change_read role can view all change requests as well as the CAB workbench.

Activate Business Stakeholder

Activate the Business Stakeholder plugin (com.snc.business_stakeholder) if you have an admin role. This plugin installs the Business Stakeholder role. Users with this role can view and approve records at all ITSM product levels.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Installed with Business Stakeholder

The Business Stakeholder plugin (com.snc.business_stakeholder) installs the Business Stakeholder role when activated.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.
Roles installed

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Business Stakeholder (business_stakeholder) | Users with this role can view and approve records within all products of ITSM. | · pa_viewer.business_stakeholder  
· approver_user.business_stakeholder  
· cmdb_read.business_stakeholder |

Note: The business_stakeholder role contains the following ITSM roles sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.

Activate Change Management - State Model

You can activate the Change Management - State Model plugin (com.snc.change_management.state_model) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

State Model activates the following related plugin if it is not already active.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Core (com.snc.change_management)</td>
<td>Change management is used to create and manage change requests. Once this is activated, the values for the Type field on the change request are updated.</td>
</tr>
</tbody>
</table>

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

If you upgraded from a release prior to Geneva, you must update old state labels to new state labels.

Update change request states

If you upgraded from a release prior to Geneva, you must update old state labels to new state labels after you activate the Change Management state model.

State values for current change records are not modified when you activate the Change Management state model. However, your current change records display the new state labels in the state field.
For example, records with a state value of -5 have the **Pending** state label before the Change Management state model is activated. After the state model is activated, these records retain the state value of -5 but have the **New** label. To use your organization’s required change management process with the state model, you must update state values to the new labels in your existing change records as appropriate, either manually or by script.

You must also update any reports that run queries based on old state labels to reflect the new state labels.

1. To automatically update the state field values from old state labels to new state labels, customize and then run the following sample script:

```javascript
updateStates();

function updateStates() {

    function hasApprovers(changeGr) {
        var approverGr = new GlideRecord("sysapproval_approver");
        approverGr.addQuery('sysapproval', changeGr.getUniqueValue());
        approverGr.query();
        return approverGr.getRowCount() > 0;
    }

    function hasRunningWorkflows(changeGr) {
        var workflow = new Workflow();
        var workflowGr = workflow.getRunningFlows(changeGr);
        var hasRunningFlows = workflowGr.getRowCount() > 0;
        return hasRunningFlows;
    }

    // Old State Model
    var PENDING = '-5';
    var OPEN = '1';
    var CLOSED_COMPLETE = '3';
    var CLOSED_INCOMPLETE = '4';
    var CLOSED_SKIPPED = '7';

    // New State Model
```
var NEW = '-5';
var ASSESS = '-4';
var AUTHORIZE = '-3';
var SCHEDULED = '-2';
var IMPLEMENT = '-1';
var REVIEW = '0';
var CLOSED = '3';
var CANCELLED = '4';

// Find all change requests
var record = new GlideRecord('change_request');
record.query();

// Update state from old value to new value
while (record.next()) {
    switch(record.getValue('state')) {
    case OPEN:
        if (!hasRunningWorkflows(record) && !hasApprovers(record))
            record.state = NEW;
        break;
    case CLOSED_COMPLETE:
        record.state = CLOSED;
        record.close_code = "successful";
        break;
    case CLOSED_SKIPPED:
        record.state = CANCELLED;
        record.close_code = "unsuccessful";
        break;
    case CLOSED_INCOMPLETE:
        record.state = CLOSED;
        record.close_code = "successful_issues";
        break;
    }
    record.autoSysFields(false);
    record.setWorkflow(false);
    record.update();
}

2. Verify that the state labels have changed in existing change request records.

Installed with Change Management - State Model

Several types of components are installed with the Change Management - State Model.

Table modified with Change Management - State Model

<table>
<thead>
<tr>
<th>Change Request</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(change_request)</td>
<td>Sets the column order in the list of change requests.</td>
</tr>
</tbody>
</table>

Activate Change Management - Collision Detector

You can activate the Change Management - Collision Detector plugin (com.snc.change.collision) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.
Role required: admin

1. Navigate to **System Applications** > **All Available Applications** > **All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: *Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.*

### Installed with Change Management - Collision Detector

Several types of components are installed with Change Management - Collision Detector. **Tables installed with Change Management - Collision Detector**

Change Management - Collision Detector adds or modifies the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change request (change_request)</td>
<td>Specifies the background color of the <strong>Conflict status</strong> message based on whether there is a conflict.</td>
</tr>
<tr>
<td>Blackout Schedule (cmn_schedule_blackout)</td>
<td>Represents a blackout schedule</td>
</tr>
<tr>
<td>Condition Schedule (cmn_schedule_condition)</td>
<td>Represents a schedule condition</td>
</tr>
<tr>
<td>Conflict (conflict)</td>
<td>Represents conflicts found during the detection process.</td>
</tr>
<tr>
<td>Maintenance Schedule (cmn_schedule_maintenance)</td>
<td>Represents a maintenance schedule</td>
</tr>
</tbody>
</table>

### Activate Best Practice - Change Risk Calculator

The Best Practice - Change Risk Calculator plugin (com.snc.bestpractice.change_risk) is active by default in the base system. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

1. Navigate to **System Applications** > **All Available Applications** > **All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: *Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.*
You can define risk and impact conditions for your change records.

**Installed with Best Practice - Change Risk Calculator**

Several types of components are installed with the Best Practice - Change Risk Calculator. Tables installed with Best Practice - Change Risk Calculator

Best Practice - Change Risk Calculator adds the following table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk Conditions</td>
<td>Represents the risk conditions, such as Insufficient lead time or Critical</td>
</tr>
<tr>
<td>(risk_conditions)</td>
<td>service affected.</td>
</tr>
</tbody>
</table>

**Activate Change Management - Change Schedule**

You can activate the Change Management - Change Schedule plugin (com.snc.change_management.soc) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

The Change Management - Change Schedule plugin (com.snc.change_management.soc) activates these related plugins if they are not already active.

**Plugins for Change Management - Change Schedule**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Change Schedule foundation</td>
<td>This plugin contains six change schedules to help users. Enabling this plugin</td>
</tr>
<tr>
<td>(com.snc.change_management.soc.foundation)</td>
<td>automatically enables Change Management – Change Schedules Version 1.0.0.</td>
</tr>
</tbody>
</table>

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
3. You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
4. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Installed with Change Management - Change Schedule**

Several types of components are installed with the Change Management - Change Schedule.

Plugins installed with Change Management - Change Schedule

Plugins are added with activation of Change Management - Change Schedule.
<table>
<thead>
<tr>
<th>Plugin</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Change Schedule</td>
<td>com.snc.change_management.soc</td>
<td>This plugin is the core Change Schedules plugin which includes the supporting Change Schedules table structure, landing page, and Change Schedules user interface.</td>
</tr>
<tr>
<td>Change Management - Change Schedule foundation</td>
<td>com.snc.change_management.soc.foundation</td>
<td>This plugin contains six change schedules to help users. Enabling this plugin automatically enables Change Management – Change Schedules Version 1.0.0.</td>
</tr>
</tbody>
</table>

Roles installed with Change Management - Change Schedule
Roles are added with activation of Change Management - Change Schedule.

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(sn_chg_soc.change_soc_admin)</td>
<td>This role has full administrative rights to Change Schedule pages.</td>
</tr>
</tbody>
</table>

Tables installed with Change Management - Change Schedule
Tables are added with activation of Change Management - Change Schedule.

Change Management - Change Schedule adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style Rule</td>
<td>Define a default style rule that is applied to all Change Schedule definitions for each Change record displayed on the page</td>
</tr>
<tr>
<td>(chg_soc_style_rule)</td>
<td></td>
</tr>
<tr>
<td>Style Rule</td>
<td>Define a style rule for each Change record displayed on the Change Schedule page</td>
</tr>
<tr>
<td>(chg_soc_definition_style_rule)</td>
<td></td>
</tr>
<tr>
<td>Style Rule</td>
<td>Define a style rule for each related record displayed on the Change Schedule page</td>
</tr>
<tr>
<td>(chg_soc_def_child_style_rule)</td>
<td></td>
</tr>
<tr>
<td>Change Schedule Definition</td>
<td>Define a Change Schedule page</td>
</tr>
<tr>
<td>(chg_soc_definition)</td>
<td></td>
</tr>
<tr>
<td>Change Schedule Definition Core</td>
<td>Define related records for each Change record that is presented on the Change Schedule page</td>
</tr>
<tr>
<td>(chg_soc_definition_child)</td>
<td></td>
</tr>
</tbody>
</table>

Properties installed with Change Management - Change Schedule
Properties are added with activation of Change Management - Change Schedule.

Change schedules are loaded on the timeline page on the client side in batches of 20. You can load a maximum of 1000 records. These numbers can be modified using the following properties from the System Properties (sys_properties) table. To open the System Property table, enter sys_properties.list in the navigation filter.
<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_chg_soc.change_soc_initial_limit</td>
<td>Define the number of change_request records to display on load of the Change Schedule.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 40</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Property (sys_properties) table</td>
</tr>
<tr>
<td>sn_chg_soc.change_soc_scroll_load_limit</td>
<td>Define the number of change_request records to display as the Change Schedule is scrolled.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 20</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Property (sys_properties) table</td>
</tr>
<tr>
<td>sn_chg_soc.change_soc_total_limit</td>
<td>Define the total number of change_request records that can be displayed on a Change Schedule.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 1000</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Property (sys_properties) table</td>
</tr>
<tr>
<td>sn_chg_soc.landing_page.pinned_notification</td>
<td>Show a message when pin or unpin a change schedule.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: String</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Property (sys_properties) table</td>
</tr>
<tr>
<td>sn_chg_soc.schedule_window_days</td>
<td>Define the number of days to be factored before and after the respective start/end of a change_request record when displaying blackout and maintenance window spans on the Change Schedule page.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 30</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Property (sys_properties) table</td>
</tr>
</tbody>
</table>

*Business rules installed with Change Management - Change Schedule*

Business rules are added with activation of Change Management - Change Schedule.
<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create default style rule</td>
<td>Related Definition</td>
<td>Defines a standard style rule with a high order for the related records.</td>
</tr>
<tr>
<td></td>
<td>(chg_soc_definition_child)</td>
<td></td>
</tr>
<tr>
<td>Different start and end</td>
<td>Change Schedule Definition</td>
<td>Ensures that the start and end fields are different by aborting an insert</td>
</tr>
<tr>
<td>fields</td>
<td>(chg_soc_definition)</td>
<td>or save when this is the case.</td>
</tr>
<tr>
<td>Flush share lists when</td>
<td>Change Schedule Definition</td>
<td>Empties shared with lists when share with none is set.</td>
</tr>
<tr>
<td>ShareWith is none</td>
<td>(chg_soc_definition)</td>
<td></td>
</tr>
<tr>
<td>Flush shareWith to match</td>
<td>Change Schedule Definition</td>
<td>Ensures shared with is updated to reflect the selected share options such</td>
</tr>
<tr>
<td>empty lists</td>
<td>(chg_soc_definition)</td>
<td>as groups, roles, users.</td>
</tr>
<tr>
<td>Update style field</td>
<td>Style Rule Core</td>
<td>Updates the stylesheet defined in the style field when one of the</td>
</tr>
<tr>
<td></td>
<td>(chg_soc_style_rule_core)</td>
<td>conditions is met:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Label color changes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Label weight changes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Event color changes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Providing Advanced is not true.</td>
</tr>
</tbody>
</table>

*UI policies installed with Change Management - Change Schedule*

UI policies are added with activation of Change Management - Change Schedule.

<table>
<thead>
<tr>
<th>UI Policy</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show maintenance color</td>
<td>Change Schedule Definition</td>
<td>Only show the maintenance color field if Show maintenance has been enabled.</td>
</tr>
<tr>
<td></td>
<td>(chg_soc_definition)</td>
<td></td>
</tr>
<tr>
<td>Switch between Basic and Advanced</td>
<td>Style Rule Core</td>
<td>Only show label and event options if the style rule advanced option is</td>
</tr>
<tr>
<td></td>
<td>(chg_soc_style_rule_core)</td>
<td>false. When advanced is specified only the style field is presented.</td>
</tr>
<tr>
<td>Hide share users, groups and roles</td>
<td>Change Schedule Definition</td>
<td>If sharing with everyone then the other share options are hidden.</td>
</tr>
<tr>
<td>if share with everyone</td>
<td>(chg_soc_definition)</td>
<td></td>
</tr>
<tr>
<td>Show blackout color</td>
<td>Change Schedule Definition</td>
<td>Only show the Blackout color field if Show blackout has been enabled.</td>
</tr>
<tr>
<td></td>
<td>(chg_soc_definition)</td>
<td></td>
</tr>
<tr>
<td>Hide table name</td>
<td>Style Rule Core</td>
<td>Condition builder requires a table field to be present on the form, but it</td>
</tr>
<tr>
<td></td>
<td>(chg_soc_style_rule_core)</td>
<td>is not necessary to present this so it is hidden.</td>
</tr>
<tr>
<td>UI Policy</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hide table name</td>
<td>Change Schedule Definition</td>
<td>Condition builder requires a table field to be present on the form, but it is not necessary to present this so it is hidden.</td>
</tr>
<tr>
<td></td>
<td>(chg_soc_definition)</td>
<td></td>
</tr>
</tbody>
</table>

**Script includes installed with Change Management - Change Schedule**

Script includes are added with activation of Change Management - Change Schedule.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SoC</td>
<td>Base class that provides utilities and constants for Change Schedules</td>
</tr>
<tr>
<td>SoCChangeRequest</td>
<td>Extends SoCChangeRequestSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>SoCChangeRequestSNC</td>
<td>Provides utilities for the change_request table</td>
</tr>
<tr>
<td>SoCDefinition</td>
<td>Extends SoCDefinitionSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>SoCDefinitionSNC</td>
<td>Provides utilities for the chg_soc_definition table</td>
</tr>
<tr>
<td>SoCDefinitionChild</td>
<td>Extends SoCDefinitionChildSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>SoCDefinitionChildSNC</td>
<td>Provides utilities for the chg_soc_child_def table</td>
</tr>
<tr>
<td>SoCDefinitionChildStyleRule</td>
<td>Extends SoCDefinitionChildStyleRuleSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>SoCDefinitionChildStyleRuleSNC</td>
<td>Provides utilities for the chg_soc_def_child_style_rule table</td>
</tr>
<tr>
<td>SoCDefinitionStyleRule</td>
<td>Extends SoCDefinitionStyleRuleSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>SoCDefinitionStyleRuleSNC</td>
<td>Provides utilities for the chg_soc_definition_style_rule table</td>
</tr>
<tr>
<td>SoCLandingModelBuilder</td>
<td>Extends SoCLandingModelBuilderSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>SoCLandingModelBuilderSNC</td>
<td>Builds the change schedule definition model used by the Change Schedule landing page</td>
</tr>
<tr>
<td>SoCModelBuilder</td>
<td>Extends SoCModelBuilderSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>SoCModelBuilderSNC</td>
<td>Builds the change schedule model used by the change schedule page</td>
</tr>
<tr>
<td>SoCRefFieldsList</td>
<td>Field choice list processor. Return the fields on the current table which reference the parent table</td>
</tr>
<tr>
<td>SoCRefTablesList</td>
<td>Field Choice List Processor. Return the tables referencing the provided table name.</td>
</tr>
<tr>
<td>Script include</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SoCStyleRule</td>
<td>Extends SoCStyleRuleSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>SoCStyleRuleSNC</td>
<td>Provides utilities for style rules</td>
</tr>
</tbody>
</table>

**UI scripts installed with Change Management - Change Schedule**

UI scripts are added with activation of Change Management - Change Schedule.

<table>
<thead>
<tr>
<th>UI Scripts</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_chg_soc.change_soc</td>
<td>Angular module for the change schedule, which includes all of the angular applications dependencies</td>
</tr>
<tr>
<td>sn_chg_soc.change_soc_filter</td>
<td>Angular module for text filtering on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.config</td>
<td>Angular module for the configuration panel on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.context_menu</td>
<td>Angular module for the context menu on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.data</td>
<td>Angular module for the data model on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.duration</td>
<td>Angular module for a duration calculation utility</td>
</tr>
<tr>
<td>sn_chg_soc.filter_control</td>
<td>Angular module implementation of the filter widget</td>
</tr>
<tr>
<td>sn_chg_soc.filter_widget</td>
<td>Angular module that provides a filter control similar to a condition builder</td>
</tr>
<tr>
<td>sn_chg_soc.gantt</td>
<td>Angular module that maintains instances of gantt objects and handles the definition of the gantt scale</td>
</tr>
<tr>
<td>sn_chg_soc.keyboard</td>
<td>Angular module for the keyboard panel on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.landing.app</td>
<td>Angular module for the change schedule landing page, which includes all of the angular applications dependencies</td>
</tr>
<tr>
<td>sn_chg_soc.landing_accessibility</td>
<td>Angular module for accessibility support on the change schedule landing page</td>
</tr>
<tr>
<td>sn_chg_soc.landing_card</td>
<td>Angular module defines a directive for a change schedule definition card</td>
</tr>
<tr>
<td>sn_chg_soc.landing_decoration</td>
<td>Angular module defines a directive that provides styling</td>
</tr>
<tr>
<td>sn_chg_soc.landing_notifications</td>
<td>Angular module for displaying notifications</td>
</tr>
<tr>
<td>sn_chg_soc.landing_page_header</td>
<td>Angular module provides header for change schedule landing page</td>
</tr>
<tr>
<td>UI Scripts</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_chg_soc.landing_sort</td>
<td>Angular module provides utility for sorting cards on the change schedule landing page</td>
</tr>
<tr>
<td>sn_chg_soc.landing_splash_screens</td>
<td>Angular module provides splash screen when no change schedule definitions are present in a tab on the change schedule landing page</td>
</tr>
<tr>
<td>sn_chg_soc.landing_tabs</td>
<td>Angular module provides tabs for the change schedule landing page</td>
</tr>
<tr>
<td>sn_chg_soc.landing_wizard</td>
<td>Angular module defines the creation of a new change schedule definition from the landing page</td>
</tr>
<tr>
<td>sn_chg_soc.loading</td>
<td>Angular module defines when the change schedule page is loading by listening to requests</td>
</tr>
<tr>
<td>sn_chg_soc.mousedown</td>
<td>Angular module that makes a button execute multiple times when holding mouse down</td>
</tr>
<tr>
<td>sn_chg_soc.notification</td>
<td>Angular module used to display messages on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.popover</td>
<td>Angular module used for accessibility support for the popover that is displayed on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.share</td>
<td>Angular module for the share panel on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.sn.app_itsm.now.iscroll</td>
<td>Angular module that supports scrolling to load more content on the change schedule landing page</td>
</tr>
<tr>
<td>sn_chg_soc.snCreateNewInvite</td>
<td>Angular module for the share panel component that adds elements to the shared with field for the change schedule</td>
</tr>
<tr>
<td>sn_chg_soc.sn_soc_now.scheduleService</td>
<td>Angular module for the change schedule landing page that is used to retrieve change schedule definitions from the server</td>
</tr>
<tr>
<td>sn_chg_soc.style</td>
<td>Angular module for the style panel on the change schedule page</td>
</tr>
</tbody>
</table>

### Activate Change Management - Risk Assessment

You can activate the Change Management - Risk Assessment plugin (com.snc.change_management.risk_assessment) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Role required:** admin

Change Management - Risk Assessment activates these related plugins if they are not already active.
Plugins for Change Management - Risk Assessment

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment Components (com.snc.assessment)</td>
<td>Provides the core components required for legacy surveys.</td>
</tr>
<tr>
<td>Best Practice - Change Risk Calculator (com.snc.bestpractice.change_risk)</td>
<td>Provides simple risk and impact calculations for change management.</td>
</tr>
<tr>
<td>Assessment Designer (com.glide.assessment_designer)</td>
<td>Provides an interface to create and edit the Change Risk Assessment form that is required to collect user information on risk of the change request.</td>
</tr>
</tbody>
</table>

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

You can define risk assessment conditions for change requests.

Activate Change Management - Standard Change Catalog

You can activate the Change Management - Standard Change Catalog plugin (com.snc.change_management.standard_change_catalog) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

Standard Change Catalog activates the following related plugin if it is not already active.

Plugin for Standard Change Catalog

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Core (com.snc.change_management)</td>
<td>Change management is used to create and manage change requests. Once this is activated, it updates the values for the <strong>Type</strong> field on the change request.</td>
</tr>
</tbody>
</table>

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click **Install**, and then in the **Activate Plugin** dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

### Installed with Change Management - Standard Change Catalog

Several types of components are installed with Change Management - Standard Change Catalog.

#### Tables installed with Change Management - Standard Change Catalog

Change Management - Standard Change Catalog adds or modifies the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change request (change_request)</td>
<td>Adds the standard change template version to the table</td>
</tr>
<tr>
<td>Standard change producer version (std_change_producer_version)</td>
<td>Contains the record producer and change proposal for the standard change with the current version of the template. It also includes the number and percentage of successful and unsuccessful change requests created from the proposal.</td>
</tr>
<tr>
<td>Standard change properties (std_change_properties)</td>
<td>List of standard change catalog properties.</td>
</tr>
<tr>
<td>Standard change proposal (std_change_proposal)</td>
<td>List of standard change proposals.</td>
</tr>
<tr>
<td>Standard change record producer (std_change_record_producer)</td>
<td>List of standard change record producers.</td>
</tr>
<tr>
<td>Standard change template (std_change_template)</td>
<td>List of standard change templates.</td>
</tr>
</tbody>
</table>

### Activate Change Management - Change Success Score

You can activate the Change Management - Change Success Score (com.snc.change_management.change_success_score) plugin if you have the admin role. This plugin activates related plugins if they are not already active.

**Role required:** admin

The Change Management - Change Success Score (com.snc.change_management.change_success_score) plugin activates these related plugins if they are not already active.
Plugins for Change Management - Change Success Score

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Change Success Score Foundation (com.snc.change_management.change_success_score.foundation)</td>
<td>Adds the Change Success Score icon to the change form, loads default rating records, and installs the basic configurations that are needed to use the change success score feature.</td>
</tr>
</tbody>
</table>

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar. You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Change Management - Change Success Score

Several types of components are installed with activation of the Change Management - Change Success Score (com.snc.change_management.change_success_score) plugin, including tables and scheduled jobs.

Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change success score metrics (Daily)</td>
<td>Collects individual metrics for changes completed and incidents raised the previous day. This job runs on a daily basis at 02.00 UTC. When this job is completed, the Daily change success score script action is executed. This action triggers the calculation of the adjustment formula indicators, and store the new score in the metric table.</td>
</tr>
<tr>
<td>Change success score for today</td>
<td>Reads scores from metric table and calculates the daily averages for the past 30 days.</td>
</tr>
<tr>
<td>Change success score metrics (Historical data)</td>
<td>Gathers individual metrics daily for the past 30 days. This result overrides what is already stored in PA, that is not more than 30 days old. When this job is completed, the Historical change success scores script action is executed. The functionality of this script action is similar to that of the Daily change success score. Additionally, creating a new historic metric record for each day of the past 30 days.</td>
</tr>
<tr>
<td>Scheduled job</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change success score (Historical data)</td>
<td>Reads scores from the metric table and calculates the daily average for the past 30 days.</td>
</tr>
</tbody>
</table>

**Note:**
Historical calculations are useful if you decide to change the overall formula or multipliers for individual metrics later on. You can run Change success score metrics (Historical data) to recalculate metrics and score for the past 30 days creating a new history record.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Success Score Rating (chg_success_score_rating)</td>
<td>Defines the record that associates a rating choice and color with a Change Success Score range, such as, 0 to 499.</td>
</tr>
</tbody>
</table>

### Activate Best Practice - Bulk CI Changes

You can activate the Best Practice - Bulk CI Changes plugin (com.snc.bestpractice.bulkchange) if you have the admin role. This plugin activates related plugins if they are not already active.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

You can now configure Change Management.

### Installed with Best Practice - Bulk CI Changes

Several types of components are installed with the Best Practice - Bulk CI Changes.

**Tables modified with Best Practice - Bulk CI Changes**

Best Practice - Bulk CI Changes modifies the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change request</td>
<td>Add the CI class and Proposed change fields to the table.</td>
</tr>
</tbody>
</table>
### Activate Change Management - Mass Update CI

You can activate the Change Management - Mass Update CI plugin (com.snc.change_management.mass_update_ci) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Role required:** admin

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - State model</td>
<td>State model is used to move and track change requests through several states.</td>
</tr>
<tr>
<td>(com.snc.change_management.state_model)</td>
<td></td>
</tr>
<tr>
<td>Best Practice - Bulk CI Changes</td>
<td>Best Practice - Bulk CI Changes enables you to record a single change proposal that are linked to all affected CIs.</td>
</tr>
<tr>
<td>(com.snc.bestpractice.bulkchange)</td>
<td></td>
</tr>
</tbody>
</table>

1. **Navigate to** **System Applications > All Available Applications > All.**
2. **Find the plugin using the filter criteria and search bar.**
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in *Request a plugin.*
3. **Click Install,** and then in the Activate Plugin dialog box, click **Activate.**

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: **Plugin Activation for** `<plugin name>`.

### Installed with Change Management - Mass Update CI

Several types of Change Management - Mass update CI.

**Table modified with Change Management - Mass Update CI**

Change Management - Mass Update CI updates the following table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Request (change_request)</td>
<td>Adds the <strong>Mass Update CI Class</strong> (is_bulk) field to the table to use when the change performs a mass update of configuration items.</td>
</tr>
</tbody>
</table>
Activate Change Management-Approval policy

You can activate the Change Management-Approval policy plugin (com.sn_chg_pol_appr) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Change Management-Approval policy

Several types of components are installed with activation of the Change Management-Approval policy plugin, that includes tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Approval Policy</td>
<td>Extends the Change Policy table.</td>
</tr>
<tr>
<td>(chg_policy_approval)</td>
<td></td>
</tr>
</tbody>
</table>

Activate Change Management - CAB Workbench

You can activate the Change Management - CAB Workbench plugin (com.snc.change_management.cab) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal</td>
<td>Service Portal provides an alternative user experience to the standard platform UI. It is easy to configure, customize, and extend, similar to what users are used to in other consumer products.</td>
</tr>
<tr>
<td>(com.glide.service-portal)</td>
<td></td>
</tr>
</tbody>
</table>
1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in *Request a plugin*.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Installed with Change Management - CAB Workbench

Several types of components are installed with Change Management - CAB Workbench. *Tables installed with Change Management - CAB Workbench*

Change Management - CAB Workbench adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mtg Agenda Item</td>
<td>Parent table for CAB Agenda Item table.</td>
</tr>
<tr>
<td>(mtg_agenda_item)</td>
<td></td>
</tr>
<tr>
<td>CAB Agenda Item</td>
<td>Contains list of CAB agenda items.</td>
</tr>
<tr>
<td>(cab_agenda_item)</td>
<td></td>
</tr>
<tr>
<td>CAB Attendee</td>
<td>Contains list of CAB attendees.</td>
</tr>
<tr>
<td>(cab_attendee)</td>
<td></td>
</tr>
<tr>
<td>Mtg Definition</td>
<td>Parent table for CAB Definitions table.</td>
</tr>
<tr>
<td>(mtg_definition)</td>
<td></td>
</tr>
<tr>
<td>CAB Definition</td>
<td>Contains list of CAB definitions.</td>
</tr>
<tr>
<td>(cab_definition)</td>
<td></td>
</tr>
<tr>
<td>Mtg Meeting</td>
<td>Parent table for CAB Meeting table.</td>
</tr>
<tr>
<td>(mtg_meeting)</td>
<td></td>
</tr>
<tr>
<td>CAB Meeting</td>
<td>Contains list of CAB meetings without completion information.</td>
</tr>
<tr>
<td>(cab_meeting)</td>
<td></td>
</tr>
<tr>
<td>Mtg Runtime State</td>
<td>Parent table for CAB Runtime State</td>
</tr>
<tr>
<td>(mtg_runtime_state)</td>
<td></td>
</tr>
</tbody>
</table>
### Activate Change Management ATF Tests

You can activate the Change Management - ATF Tests plugin (com.snc.change_management.atf) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

Change Management - ATF Tests (com.snc.change_management.atf) loads ATF tests when the Change Management - State Model plugin is active.

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in *Request a plugin*.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Activate Change Management - Core

You can activate the Change Management - Core plugin (com.snc.change_management) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in *Request a plugin*.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

You can activate one or more of the following plugins:
- State model (com.snc.change_management.state_model)
- Change Management - Collision Detector (com.snc.change.collision)
- Best practice - change risk calculator (com.snc.bestpractice.change_risk)
You can now configure Change Management.

Installed with Change Management - Core

Several types of components are installed with the Change Management - Core. Tables installed with Change Management core

Change Management - Core modifies the following table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task CI (task_ci)</td>
<td>Adds Manual Proposed Change (manual_proposed_change) field if the proposed change has been made manually rather than through the Mass Update CI feature</td>
</tr>
</tbody>
</table>

Configure Change Management

You can configure various aspects of Change Management based on the specific requirements of your organization.

Role required: admin or change_manager

Configure one or more of the following aspects of Change Management.

Use guided setup to implement Change Management

The ITSM guided setup provides a sequence of tasks that help you configure Change Management on your ServiceNow instance. To open ITSM guided setup, navigate to Guided Setup > ITSM Guided Setup. For more information about using the guided setup interface, see Using guided setup.

Change Management properties

Administrators can use change properties to configure Change Management behavior.

Navigate to Change > Administration > Change Properties to view and edit these properties.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.approval_engine.change_task</td>
<td>Change request tasks approval engine.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Default value: process_guide</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.ui.risk_calculate_rule</td>
<td>Change risk calculation method. Business rule calculates on insert/update, UI action calculates only on demand. <strong>None</strong> disables this capability.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Default value: ui_action</td>
</tr>
<tr>
<td></td>
<td>For more information, see <strong>Risk Calculator property</strong>.</td>
</tr>
<tr>
<td>com.snc.change_request.enable_copy</td>
<td>Enable copy change feature.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td>com.snc.change_request.copy.attributes</td>
<td>List of attributes (comma-separated) that are copied from the originating change.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: category,cmdb_ci,priority,risk,impact,type,assignment_group,assigned_to,short_description,description,change_plan,backout_plan,test_plan</td>
</tr>
<tr>
<td>com.snc.change_request.copy.rl.change_task.attributes</td>
<td>List of attributes (comma-separated) from the Change Task (change_task) related list that will be copied from the originating change.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: cmdb_ci,priority,assignment_group,assigned_to,short_description,description</td>
</tr>
<tr>
<td>com.snc.change_request.copy.rl.task_ci.attributes</td>
<td>List of attributes (comma-separated) from the Affected CIs ([ask_ci] related list that will be copied from the originating change.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: ci_item</td>
</tr>
<tr>
<td>com.snc.change_request.attach.enable_copy</td>
<td>Copy attachments from the originating change.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td>com.snc.change_request.copy.rl.task_cmdb_ci_service.attributes</td>
<td>List of attributes (comma-separated) from Impacted Services (task_cmdb_ci_service) related list that will be copied from the originating change.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: cmdb_ci_service</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| com.snc.task.refresh_impacted_services | List of all the Task types where **Refresh Impacted Services** action is enabled.  
- Type: string  
- Default value: incident, change_request |
| change.refresh_impacted.include_affected_cis | Lists the impacted CIs or Services with any service supported by a configuration item identified in the Affected CI related list.  
**Note:** This requires any business services identified to be converted to an application service. For instructions, see [Convert an individual business service to an application service](#). For information about application services, see [Application services](#). |
| com.snc.change_management.enforce_data_requirements | Enforce change request process data requirements, so that any data modification on the change request has the same data restrictions. This includes, updates made through the change request form, Workflow, REST/SOAP, JavaScript, and GlideRecord updates. For more information, see [Change Management API](#).  
In the User Interface, when this property is true, it enables additional server sided restrictions to the UI Policy and Client Script controls that already exist.  
- Type: true | false  
- Default value: true |
| com.snc.task.populate_service_offering | Populates the service offering related list from the impacted service list.  
- Type: true | false  
- Default value: false |
| com.snc.change_request.enable_unauthorized | Enables the creation of unauthorized change requests when the event **ci.change.unplanned** is raised.  
- Type: true | false  
- Default value: false |
| com.snc.change_request.event.state_updated.enabled | Generates the **sn_change.state.updated** event when the state of the change request is updated.  
- Type: true | false  
- Default value: false |
### Change Management properties for Discovery integration

If your organization is subscribed to Discovery, integration with Discovery is automatically enabled. With this integration, any configuration item (CI) with an IP address that is part of a change request process can be maintained automatically. When Discovery is activated, the following three new properties become available.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.change_request.auto.discovery</td>
<td>Trigger Discovery for the Affected CIs automatically, manually or not at all.</td>
</tr>
<tr>
<td></td>
<td>Type: Choice list</td>
</tr>
<tr>
<td></td>
<td>Values: Off, Both, Automatic, Manual</td>
</tr>
<tr>
<td></td>
<td>Default value: Off</td>
</tr>
<tr>
<td>com.snc.change_request.disco.auto.state</td>
<td>Defines which Change Request states Discovery will be automatically triggered.</td>
</tr>
<tr>
<td></td>
<td>Type: String</td>
</tr>
<tr>
<td></td>
<td>Default value: Review</td>
</tr>
<tr>
<td>com.snc.change_request.disco.manual.state</td>
<td>Defines which Change Request states allow Discovery to be manually triggered.</td>
</tr>
<tr>
<td></td>
<td>Type: String</td>
</tr>
<tr>
<td></td>
<td>Default value: Implement, Review</td>
</tr>
</tbody>
</table>

### Change Management properties available from sys_properties table

The following properties are available for further configuration. To list them, enter `sys_properties.list` in the navigator text box and filter for `com.snc.change_request`.

© 2020 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Configure ability to copy a change request

You can configure the ability to copy a change request record and its details using system properties.

**Role required:** admin

You can configure the following functionality.

- Disable the ability to copy a change request.
- Disable the ability to copy attachments.
- Determine the components of the source change request that are copied.

1. **Navigate to Change > Administration > Change Properties.**
   - Some properties are found by entering `sys_properties.list` in the application navigator, as noted.
2. **Set the following properties as desired.**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable the ability to copy a change request</td>
<td>Set Enable Copy Change feature (com.snc.change_request.enable_copy) to false.</td>
</tr>
<tr>
<td>Disable the ability to copy an attachment</td>
<td>Set Copy attachments from originating change (com.snc.change_request.attach.enable_copy) to false.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Disable the ability to copy the attachments from the change task | This system property is located in the (sys_properties) table. Set the Enable copying of attachments from the originating change's related change tasks (com.snc.change_request.rl.change_task.attach.enable_copy) system property to false.  

**Note:** If the ability to copy attachments is enabled, the attachment appears on the copy of the change request only after it is saved. |
| Configure attributes to be copied | Edit the list of values in List of attributes (comma-separated) that will be copied from the originating change (com.snc.change_request.copy.attributes) to remove or add more attributes.  

For example, to prevent the Assigned to attribute from being copied, remove the assigned_to value from the list of attributes in the property text box. |
| Configure related lists to be copied | This system property is located in the (sys_properties) table. The following related lists are copied by default:  

- Affected CIs  
- Impacted Services/CIs  
- Change Tasks  

Edit the list of values in Related lists (comma-separated) that will be copied from the originating change (com.snc.change_request.copy.related_lists).  

For example, if you do not want to copy the Change Tasks related list, remove the change_task value from the list of related lists in the property text box.  

**Note:** You can configure this property to control the copy functionality of the Affected CIs, Impacted Services/CIs, and Change Tasks related lists. You cannot add any other related list to this property. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configure attributes of the default related lists to be copied</strong></td>
<td>These system properties are located in the (sys_properties) table. Navigate to the appropriate system property for one of the default related lists to configure the attributes to copy.</td>
</tr>
</tbody>
</table>

**System properties for related list attributes**

<table>
<thead>
<tr>
<th>Related list</th>
<th>System property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Tasks</td>
<td>com.snc.change_request.copy.rl.change_task.attributes</td>
</tr>
<tr>
<td>Affected CIs</td>
<td>com.snc.change_request.copy.rl.task_ci.attributes</td>
</tr>
<tr>
<td>Impacted Services/CIs</td>
<td>com.snc.change_request.copy.rl.task_cmdb_ci_service.attributes</td>
</tr>
</tbody>
</table>

3. Complete the following steps to further customize the ability to copy a change request by modifying a script include.
   a) Navigate to **System Definition > Script Includes**.
   b) Modify the **ChangeUtils** script include.
      For example, the ability to copy a change request is not available by default for standard changes. However, you can provide your own implementation of the `isCopyRulesValid` function in the `ChangeUtils` script include to override the default.

### Create a change request template

You can create a template that can be used to create change requests with pre-defined supporting tasks. Templates simplify the process of submitting new records by populating fields automatically.

The administrator must configure the form layout to add these fields: **Next Related Template**, **Next Related Child Template**, **Link element**.

Role required: admin

There are two change request template configuration items.

- **Change_request**: This object does not have a link element, because it is at root level.
- **Change_task**: This task object is one level below root level, so it uses the parent table as a link element.

1. Navigate to **System Definition > Templates**.
2. Click **New**.
3. Complete the form as described in Create a template using the Template form.
4. Complete the remaining fields, as appropriate.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Related Template</td>
<td>A template at the same hierarchical level as the current template (sibling). Use this field on a child template to specify an extra child template under the same parent template. For example, you can use child templates to create multiple change tasks for a change request template and specify sibling child templates. This field is not supported on top-level templates.</td>
</tr>
<tr>
<td>Next Related Child Template</td>
<td>A template at the hierarchical level below the current template (child). You can assign a child template to a child template.</td>
</tr>
<tr>
<td>Link element</td>
<td>Specifies a link to a record created from a child template to the record created from the parent template. The template script chooses the first valid reference field that can link to the parent record when this field is left blank.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Create a change request assignment rule

You can define assignment rules to automate the process of assigning change requests to the appropriate group or individual.

Role required: admin

You can define an assignment rule either for the change request or for the change tasks that are generated for change requests. In the following example, you create an assignment rule to assign change requests for configuration items in the database class to the **Database** group.

1. Navigate to **System Policy > Assignment**, and then click **New**.
2. Enter the name: Database Change.
3. In the Applies To form section, select the table **Change Request (change_request)** and add a condition **(Configuration Item.Class) (is) (Database)**.
4. In the Assign To section, select the group **Database**.
5. Click **Submit**.

To test the assignment rule, navigate to **Change > Create New** and enter a Normal change. Complete the form, selecting **bond_trade_ny**, or another CI in the database class, in the **Configuration Item** field.

Save the change and see that it was automatically assigned to the **Database** group.
Add a new change request type

You can add a new change type to your change process. There are several processes involved with adding a change type. These processes include managing script includes and workflows.

Role required: admin

In addition to the three types of change available by default, you can add new change types based on your organization requirements. For example, you can create a change type **Expedited** for changes that you require to be processed immediately.

1. Complete the following steps to add a new choice to the **Type** field.
   a) Open an existing change request.
   b) Right-click the **Type** field and select **Show Choice List**.
   c) Click **New** and fill in the following fields.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select the <strong>Change Request</strong> table.</td>
</tr>
<tr>
<td>Label</td>
<td>Enter a value for the new change type. For example, Expedited.</td>
</tr>
</tbody>
</table>
2. Complete the following steps to add the new change type to the change request interceptor.
   a) Navigate to System Definition > Interceptors.
   b) Open the Change Request interceptor.
   c) Click New in the Answers related list.
   d) Complete the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Change Request</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name for the new change type. For example, Direct to Expedited Change.</td>
</tr>
<tr>
<td>User Prompt</td>
<td>Enter a description that is displayed to the end user when they click Create New under Change.</td>
</tr>
<tr>
<td>Target URL</td>
<td>Set the appropriate target URL. For example, change_request.do?sys_id=-1&amp;sysparm_query=type=expedited.</td>
</tr>
<tr>
<td>Order</td>
<td>Set the appropriate order level for the change type. For example, 400.</td>
</tr>
</tbody>
</table>
3. Complete the following steps to create the script include for the new change type.
   a) Navigate to **System Definition > Script Includes**.
   b) Search for a change type script include on which to base the workflow for the new change type. For example, to base it on Emergency change type, search for `ChangeRequestStateModelSNC_emergency` and open the script include.
   c) Copy the script of the `ChangeRequestStateModelSNC_emergency` script include from the **Script** field.
   d) Navigate to **System Definition > Script Includes** and click **New**.
   e) Name the new script include to match the value of the new type. For example, `ChangeRequestStateModelCust_expedited`.
   f) Paste the copied script in the **Script** field of the new script include.
   g) Update any references in the pasted script include from `ChangeRequestStateModelSNC_emergency` to `ChangeRequestStateModelCust_expedited`. 

![Question = Change Request](image)
h) Click **Submit**.

**Note:** An existing script include contains the implementation for all the **moving** and **canMove** functions. The **moving** function is used to pre-populate any fields that are required for the new state. The **canMove** function is used to check for any additional requirements and to validate whether a task can move to the next state.

### 4. Complete the following steps to create the script include to define state transitions and control the transitioning between states for the new change type.

a) Navigate to **System Definition > Script Includes**.

b) Search for change type script include on which to base the transitioning controls for the new change type on. For example, to base it on Emergency change type, search for `ChangeRequestStateModel_emergency` and open the script include.

c) Update the name of the script include to match the value of the new type. For example, `ChangeRequestStateModel_expedited`.

d) Update the reference to the base script include for the new change type. Change the extended Object in line 2 to the base script include name. For example, `ChangeRequestStateModelCust_expedited`, so the reference is similar to the following string.

```javascript
ChangeRequestStateModel_expedited.prototype =
  Object.extendsObject(ChangeRequestStateModelCust_expedited, { // CUSTOM CODE, type:"ChangeRequestStateModelCust_expedited"});
```

e) Click **Insert and Stay** create a copy of the script include `ChangeRequestStateModel_emergency` with the new name `ChangeRequestStateModel_expedited`.

### 5. Complete the following steps to modify the script include that controls the transition between states using one of the defined models for the new change type. The base method is overridden so that the new state model for the new change type can be utilized.

a) Navigate to **System Definition > Script Includes**.

b) Search for and open the `ChangeRequestStateHandler` script include, which controls the transitioning between states using one of the defined models.

c) Create a property to reference the new change request type value. For example, `EXPEDITED:"expedited"`.

d) Override the base method `_resetModel` to be able to include the new model. For example, if the change request type is `expedited`, then the new state model `ChangeRequestStateModel_expedited` is included. Example code with changes highlighted in bold:

```javascript
var ChangeRequestStateHandler = Class.create();
// All references to statehandler constants should be through this class ChangeRequestStateHandler
  ChangeRequestStateHandler.DRAFT = ChangeRequestStateHandlerSNC.DRAFT;
  ChangeRequestStateHandler.ASSESS = ChangeRequestStateHandlerSNC.ASSESS;
  ChangeRequestStateHandler.AUTHORIZE = ChangeRequestStateHandlerSNC.AUTHORIZE;
  ChangeRequestStateHandler.SCHEDULED = ChangeRequestStateHandlerSNC.SCHEDULED;
```
ChangeRequestStateHandler.IMPLEMENT =
ChangeRequestStateHandlerSNC.IMPLEMENT;
ChangeRequestStateHandler.REVIEW =
ChangeRequestStateHandlerSNC.REVIEW;
ChangeRequestStateHandler.CLOSED =
ChangeRequestStateHandlerSNC.CLOSED;
ChangeRequestStateHandler.CANCELED =
ChangeRequestStateHandlerSNC.CANCELED;

ChangeRequestStateHandler.prototype =
Object.extendsObject(ChangeRequestStateHandlerSNC, {
    EXPEDITED:"expedited",
    initialize: function(changeRequestGr) {

        ChangeRequestStateHandlerSNC.prototype.initialize.call(this,
        changeRequestGr);

        _resetModel: function() {
            this._model = null;
            var type = this._gr.getValue('type') + "";

            if (type == this.NORMAL || type == this.STANDARD || type
            == this.EMERGENCY)
                ChangeRequestStateHandlerSNC.prototype._resetModel.call(this);
            else if (type == this.EXPEDITED)
                this._model = new
                ChangeRequestStateModel_expedited(this._gr);
        },

        type:"ChangeRequestStateHandler"
    });

6. Complete the following steps to create a workflow for the new change request type.
   a) Navigate to Workflow > Workflow Editor.
   b) Open an existing change request workflow. For example, Change Request - Emergency.
   c) Select Copy from the Actions menu to copy the workflow and name the new workflow. For example, Change Request - Expedited.
   d) Select Properties from the Actions menu to update the condition under which the new workflow executes. For example, (Type) (is) (Expedited) in the condition.
   e) Open the matching change tasks workflow that is called by the main workflow. For example, Change Request - Emergency change tasks.
   f) Select Copy from the Actions menu to copy the workflow and name the new workflow. For example, Change Request - Expedited change tasks.
   g) Select Publish from the Actions menu to publish the new change tasks workflow and make it available for use.
   h) Go back to the first workflow you created and update the Workflow activity to reference the new change tasks workflow. For example, Change Request - Expedited change tasks.
   i) Select Publish from the Actions menu to publish the new workflow and make it available for use.
Extend or disable multiple CI association

The ability to associate multiple CIs to a task can be extended to other types of tasks. You can also disable multiple CI association from the related lists on change request records.

Role required: admin

1. Enter `sys_properties.list` in the navigation filter to open the System Property (sys_properties) table.

2. Open the List of all the task types where user wants to associate CIs using a List (com.snc.task.associate_ci) system property.
   The value of this property is set to change_request, incident by default to enable association of multiple CIs to change requests.

3. To enable multiple CI association to other types of task, add the required table as a value. For example, to enable multiple CI association for problem records, add `problem` as a value, separated by a comma.

4. Click Update to save and update the property.

5. Optional: Complete the following steps to disable multiple CI association for the Change Request form.
   a) Remove the `change_request` value from the List of all the task types where user wants to associate CIs using a List (com.snc.task.associate_ci) system property.

   b) Navigate to System UI > List control.

   c) Perform one or both of the following tasks to disable multiple CI association for the related lists.

<table>
<thead>
<tr>
<th>Associated CIs</th>
<th>Open the entry with the task_ci.task related list and clear the Omit edit check box.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impacted Services/CIs</td>
<td>Open the entry with the task_cmdb_ci_service.task related list and clear the Omit edit check box.</td>
</tr>
</tbody>
</table>

State model and transitions

Change Management offers a state model to move and track change requests through several states.
Example of state transitions for a normal change request

The following table provides a list of all the states that a change request can progress through. Email notifications can be sent to the user who requested the change when it progresses to the following states: **Scheduled, Implement, Review, and Canceled**.

### Change states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
<th>State value</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Change request is not yet submitted for review and authorization. A change requester can save a change request as many times as necessary while building out the details of the change prior to submission.</td>
<td>-5</td>
</tr>
<tr>
<td>Assess</td>
<td>Peer review and technical approval of the change details are performed during this state.</td>
<td>-4</td>
</tr>
<tr>
<td>Authorize</td>
<td>Change Management and the CAB schedule the change and provide final authorization to proceed.</td>
<td>-3</td>
</tr>
<tr>
<td>Scheduled</td>
<td>The change is fully scheduled and authorized, and is waiting for the planned start date. An email notification is sent to the user who requested the change.</td>
<td>-2</td>
</tr>
<tr>
<td>Implement</td>
<td>The planned start date has approached and the actual work to implement the change is being conducted. An email notification is sent to the user, who requested the change.</td>
<td>-1</td>
</tr>
<tr>
<td>State</td>
<td>Description</td>
<td>State value</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Review</td>
<td>The work has been completed. The change requester determines whether the</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>change was successful. A post-implementation review can be conducted during</td>
<td></td>
</tr>
<tr>
<td></td>
<td>this state. An email notification is sent to the user who requested the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>change.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot cancel the change request if it is in the Review state.</td>
<td></td>
</tr>
<tr>
<td>Closed</td>
<td>All review work is complete. The change is closed with no further action</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>required.</td>
<td></td>
</tr>
<tr>
<td>Canceled</td>
<td>A change can be canceled at any point when it is no longer required.</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>However, a change cannot be canceled from a Closed state. An email</td>
<td></td>
</tr>
<tr>
<td></td>
<td>notification is sent to the user who requested the change.</td>
<td></td>
</tr>
</tbody>
</table>

Normal, standard, and emergency changes progress through states in different ways.

<table>
<thead>
<tr>
<th></th>
<th>New</th>
<th>Assess</th>
<th>Authorize</th>
<th>Scheduled</th>
<th>Implement</th>
<th>Review</th>
<th>Closed</th>
<th>Canceled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Standard</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Emergency</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**State progress for different changes**

- Normal changes progress through all states.
- Standard changes are considered to be pre-authorized, so they bypass the Assess and Authorize states that trigger approval records. Approving these changes progress the change to the next appropriate state. Rejecting these changes send them back to New state.
- Emergency changes are similar to standard changes, except that they must be authorized.
Revert a change request to a New change

Change Management allows the Emergency and Normal change types to be reverted to the new state which is the first approval state using the **Revert to New** action from the **Context** Menu. This action is performed if the approval was requested and the submitter recognizes that not all configuration item in the scope of the change is included before submitting for approval.

- To modify the Normal change request to the New state, modify the state of a change request from **Assess** state to **New** state by clicking **Revert to New** from the Context menu.
- To modify the Emergency change request to the New state, modify the state of a change request from **Authorized** state to **New** state by clicking **Revert to New** from the Context menu.

**Note:** When you revert to **New** from the **Assess** state or the **Authorized** state, the workflow is restarted and all pending approvals are cancelled.

Modify change request type

- A new ACL for change_request.type has been added that allows modification of the **Type** field in change request when the change request is in a **New** state and no approvals have been generated yet for it.
- In case of **Standard** change request, you can modify the type of the change request from Standard to **Normal** or **Emergency**, if the state of a change request is **New**.
- In case of **Normal** or **Emergency** change request, you can modify the type of the change request from **Normal** to **Emergency** or vice versa if the state of a change request is **New**.
- If a **Normal** or **Emergency** change request is rejected, the state of the change request is set to **New**. As the state of the change request is **New**, you can modify the type of the change request again. For example, if your **Emergency** change request is rejected on the grounds that the change request is **Normal**, you can modify the **Type** of the change request to **Normal** and resubmit the change request.

Disabled Cancel change action

- The Cancel option for a change request in the Review state is disabled. This restricts cancelling the request when the work is complete and is waiting for review.

State progression for normal, standard, and emergency changes

Each change request model progresses through a number of state values in a specific order.
### Normal change state progression

<table>
<thead>
<tr>
<th>State</th>
<th>Can be canceled?</th>
<th>Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. New</td>
<td>Yes</td>
<td><img src="image1.png" alt="Diagram" /></td>
</tr>
<tr>
<td>2. Assess</td>
<td>Yes</td>
<td><img src="image2.png" alt="Diagram" /></td>
</tr>
<tr>
<td>3. Authorize</td>
<td>Yes</td>
<td><img src="image3.png" alt="Diagram" /></td>
</tr>
<tr>
<td>4. Scheduled</td>
<td>Yes</td>
<td><img src="image4.png" alt="Diagram" /></td>
</tr>
<tr>
<td>5. Implement</td>
<td>Yes</td>
<td><img src="image5.png" alt="Diagram" /></td>
</tr>
<tr>
<td>6. Review</td>
<td>Yes</td>
<td><img src="image6.png" alt="Diagram" /></td>
</tr>
<tr>
<td>7. Closed</td>
<td>No</td>
<td><img src="image7.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

### Standard change state progression

<table>
<thead>
<tr>
<th>State</th>
<th>Can be canceled?</th>
<th>Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. New</td>
<td>Yes</td>
<td><img src="image8.png" alt="Diagram" /></td>
</tr>
<tr>
<td>2. Scheduled</td>
<td>Yes</td>
<td><img src="image9.png" alt="Diagram" /></td>
</tr>
<tr>
<td>3. Implement</td>
<td>Yes</td>
<td><img src="image10.png" alt="Diagram" /></td>
</tr>
<tr>
<td>4. Review</td>
<td>Yes</td>
<td><img src="image11.png" alt="Diagram" /></td>
</tr>
<tr>
<td>5. Closed</td>
<td>No</td>
<td><img src="image12.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>
## Emergency change state progression

<table>
<thead>
<tr>
<th>State</th>
<th>Can be canceled?</th>
<th>Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Authorize</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Scheduled</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Implement</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Review</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Closed</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

### Add a state to the state model

You can add a new state to the existing state model for different change types based on the requirements of your organization.

Role required: script_include_admin, ui_policy_admin, ui_action_admin, or admin

The State model plugin is activated by default. For more information about base system states for change requests, see State model and transitions.

1. Navigate to Change > Create New and complete the following steps to add a choice to the choice list.
   a) Right-click the State field and click Configure dictionary.
   b) In the Choices related list, run a filter for (Table) (is) (change_request).
   c) Click New and add the new state with the following information.
      - **Table**: Change Request (change_request)
      - **Label**: name of your new state
      - **Value**: numerical value that is not already assigned to an existing state choice
      - **Sequence**: number corresponding to the location for it to appear in the list of states.
        If you assign it the same sequence number as another choice, it appears below the other choice.
   d) Click Submit.

2. Navigate to System definition > Script includes.
Script include records that contain SNC in the name are read-only. As you complete the following steps, ensure that you are selecting the correct script include to modify. For example, modify ChangeRequestStateHandler not ChangeRequestStateHandlerSNC.

**Note:** Extended script includes (without SNC) include all of the functionality of their SNC counterparts. If you modify a base script include (appended with SNC), it is no longer updated during system upgrades.

3. Open the ChangeRequestStateHandler script to perform the following edits.
   - Update the statehandler constants section at the start of this script include to include values for the newly added state. For example:
     ```javascript
     ChangeRequestStateHandler.MY_NEW_STATE = "mynewstate";
     
     this.STATE_NAMES["-6"] = ChangeRequestStateHandler.MY_NEW_STATE;
     ```
   - Update the STATE NAMES map at the end of the initialize function to include the numeric value for the newly added state. For example:

**Note:** The STATE NAMES map provides a mapping between the numeric values that are stored in the State field on a change request under a memorable name. This mapping enables the memorable name to be used in the state model script includes.

4. Edit the appropriate script include to incorporate the new states into the model for the relevant change request types.

Each type of change request has a corresponding script include named ChangeRequestStateModel_<type> where <type> is the value of the change request type. For example, ChangeRequestStateModel_normal defines the state model for change requests with a type of normal.

Each state model script include defines objects that specify the following information.
   - Which states are available.
   - The next state or states for each available state.
   - Functions for each state transition to decide whether that transition is available (canMove) along with a function to be executed as part of moving to that state (moving).

The following example is from the ChangeRequestStateModel_normal script include.
5. Create a UI action to provide a button to progress the change request to the new state.
   a) Use **Insert and Stay** to make a copy of one of the default UI actions, such as **implement**.
   b) Update the following fields on the form.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Update to match the name of the new state.</td>
</tr>
<tr>
<td>Action name</td>
<td>Replace the state at the end of the name with the new state.</td>
</tr>
<tr>
<td>Hint</td>
<td>Update the text to refer to the new state.</td>
</tr>
<tr>
<td>Onclick</td>
<td>Rename the function to match the new state.</td>
</tr>
<tr>
<td>Condition</td>
<td>Update the call to the <code>isNext</code> function with the new state.</td>
</tr>
</tbody>
</table>
The following example uses the Implement UI action to show the values to update.
The ChangeRequestStateHandler script includes two functions that are used to determine if a UI action is displayed based on the current state of the change request:

- **isNext(stateName)**: This function only checks if the stateName passed as a parameter is available as a next state for the current state of the change request.
- **canMoveTo(stateName)**: This function performs the same check as the isNext function. However, it also checks the result of calling the appropriate canMoveTo function for the transition from the current state to the stateName passed as a parameter. This function is used if there are additional checks in the canMove functions such as checking that a field contains a particular value.

6. Complete the following steps to update the process flow configuration to incorporate the new change state.

The process flow is displayed at the top of the Change Request form and is configured in various process flow records.

![Change Request Form](image)

<table>
<thead>
<tr>
<th>Field name</th>
<th>Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Update to match the name of the new state.</td>
</tr>
<tr>
<td>Label</td>
<td>Update to match the name of the new state. This value is included in the process flow at the top of the Change Request form.</td>
</tr>
<tr>
<td>Order</td>
<td>Update this number so that the new state is in the correct sequence with the existing process flow records for other states.</td>
</tr>
</tbody>
</table>
d) Click **Update**.

To ensure that the new state works as expected, review the default workflows. Add the new state to the workflow as necessary.

**Review default workflows**

Any modification to the state model may impact the default workflows for change requests.

Role required: admin

Each change type has a default workflow. To ensure that any change to the state model has not adversely impacted workflows, you must review each of the default workflows.

Review the workflow for each `ChangeRequestStateModel_<type>` script include that has been modified.

### Change request default workflows

<table>
<thead>
<tr>
<th>Change type</th>
<th>Script include name</th>
<th>Workflow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>ChangeRequestStateModel_normal</td>
<td>Change Request - Normal</td>
</tr>
<tr>
<td>Standard</td>
<td>ChangeRequestStateModel_standard</td>
<td>Change Request - Standard</td>
</tr>
<tr>
<td>Emergency</td>
<td>ChangeRequestStateModel_emergency</td>
<td>Change Request - Emergency</td>
</tr>
</tbody>
</table>

Modifications to the default workflow for each change type depend on where the new state is added in the sequences of states.

### Configure state model transitions

You can use script includes or UI policies to configure state models and the criteria for moving change requests from one state to another.

Role required: script_include_admin, ui_policy_admin, or admin

1. Complete the following steps to add state change criteria in a script include that enables a state transition.
   a) Navigate to **System Definitions > Script Includes**.
   b) Open the script include for the state transition model that you want to edit.

<table>
<thead>
<tr>
<th>State transition model</th>
<th>Script include</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td><code>ChangeRequestStateModel_normal</code></td>
</tr>
<tr>
<td>Standard</td>
<td><code>ChangeRequestStateModel_standard</code></td>
</tr>
<tr>
<td>Emergency</td>
<td><code>ChangeRequestStateModel_emergency</code></td>
</tr>
</tbody>
</table>

   c) Modify the appropriate method `canMove` method in the script include. For example, to add a condition for a normal change to transition from the New state to the Authorized state, modify the `draft.authorized.canMove()` method in the `ChangeRequestStateModel_normal` script include. In the script, the GlideRecord you are acting on can be referenced using the `this._gr` variable.
The `canMove` method is part of a structure that defines the transitions available to the change type. The `canMove` method is contained in the `currentState.nextState.canMove()` structure.

2. Complete the following steps to use a UI policy to add new criteria for state transitions.
   a) Navigate to `System UI > UI Policies`.
   b) Open a default UI policy to edit or click `New` to create a new policy.

   The following are the default UI policies.

<table>
<thead>
<tr>
<th>UI Policy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>CAB fields for normal and emergency changes from the <code>Authorize</code> state and onwards.</td>
</tr>
<tr>
<td>Mandatory</td>
<td><code>Assignment Group</code> field.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Close notes and Code fields when in the Closed state.</td>
</tr>
</tbody>
</table>

   **Note:** In both of the mandatory UI policies, the state of the change request determines the mandatory fields. For `Show - CAB` fields, the type of change is also taken into account because standard changes do not require approval.

   c) Complete and save the UI policy.

**Modify the email notification for change request state changes**

There is a change request email notification, which, if active, sends a notification to the user when the state progresses to `Scheduled`, `Implement`, `Review`, or `Canceled`. You can modify the change request notification to specify when to send it, who receives it, and what it contains.

Role required: admin

By default, the notification is sent to the user who originally requested the change. Notifications are not sent to the user who updated the state on the change request.

1. Navigate to `System Notification > Email > Notifications`.
2. Locate and open `Change request state change notification`.
3. On the form, modify information in the following form sections: `When to send`, `Who will receive`, `What it will contain`.
   - For more information about email notifications and the fields in the form, see `Create an email notification`.
4. Click `Update`.

**Tutorial: add a new change management state**

This tutorial provides an example of adding a new state to the existing state model.

Role required: admin

Consider the following scenario:
Based on your organization’s requirements, you must add a new state, **Complete**, between the existing **Implement** and **Review** states. You must also add the ability to decide if the **Review** state is needed.

Perform the following steps:

*Create a new choice*
Create a new choice for the change request state.

Role required: admin

1. Open the **Change Request** form.
2. Right-click the **State** field label and select **Configure Choices**.
   The Configuring State Choices slushbucket opens.
3. Enter the following information and click **Add**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New item text</td>
<td>Enter Complete.</td>
</tr>
<tr>
<td>Numeric value</td>
<td>Enter -6.</td>
</tr>
<tr>
<td>Apply to table</td>
<td>Set to Change Request</td>
</tr>
</tbody>
</table>

The new state appears in the **Selected** slushbucket on the form.

4. Use the up and down arrows to move the new state between **Implement** and **Review** states.
5. Click Save.
The new choice is created and the Change Request form reopens.

Create a custom field
Create a custom choice field to indicate whether a change request must go through the Review state.

Role required: admin

1. Open the Change Request form.
2. Complete the following steps to create a new field on the Change Request form.
   a) Open the form context menu and select Configure > Form Layout.
   b) Enter the following values in the Create new field section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Needs Review</td>
</tr>
<tr>
<td>Type</td>
<td>Choice</td>
</tr>
</tbody>
</table>

   c) Click Add to add the new field to the slushbucket.
The new field appears at the bottom of the Selected slushbucket.
a) Use the up and down arrows next to the slushbucket to move the new field next to the Assigned to field.

b) Click Save.
The Change Request form reopens with the Needs review field below the Assigned to field.

3. Complete the following steps to configure the choices for the Needs review field.
   a) Right-click the Needs review field label and select Configure choices.
The Configuring choices form appears with empty slushbucket lists for Available and Selected.
   b) In the Enter new item field, add Yes and No choices and click Add.
The choices appear in the Selected list.
   c) Click Save

The Change Request form reopens. The Needs review choice list contains the Yes and No choices.

4. Optional: If the value in the Needs review field is Yes, No, or blank, configure the default by completing the following steps.
   a) Right-click the Needs review field label and select Configure Dictionary.
   b) In the Choice List Specification section, select Dropdown with – None – as the default Choice.
   c) Click Update.

The Change Request form reopens. The Needs review field displays -- None --.
Add a UI policy
Add a UI policy to display the **Needs review** field for **Normal** change requests when it reaches the **Complete** state.

Role required: admin

1. Open the **Change Request** form.
2. Open the form context menu and select **Configure > UI Policies**.
3. Click **New**.
4. Enter the following values on the **UI Policy** form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Change Request</td>
</tr>
<tr>
<td>Short description</td>
<td>Show “Needs review” field</td>
</tr>
<tr>
<td>Conditions</td>
<td>(Type) (is) (Normal) (State) (is one of) (Review, Complete, Closed)</td>
</tr>
</tbody>
</table>

5. Open the form context menu and select **Save** to create the UI Policy record and stay on the form.
   The **UI Policy Actions** related list appears.
6. Click **New** in the **UI Policy Actions** related list.
7. Enter the following values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field name</td>
<td>Needs review</td>
</tr>
<tr>
<td>Mandatory</td>
<td>True</td>
</tr>
<tr>
<td>Visible</td>
<td>True</td>
</tr>
</tbody>
</table>

8. Click **Submit** to create the UI Policy action and return to the **UI Policy** form.
### Show "Needs Review" field [Advanced view]

**Table:** Change Request [change_request]

**Application:** Global

**Active:**

**Short description:** Show "Needs Review" field

**Order:** 100

**When to Apply:** Script

**Conditions:**

- **Add Filter Condition**
- **Add "OR" Clause**

**All of these conditions must be met**

<table>
<thead>
<tr>
<th>Type</th>
<th>IS</th>
<th>Normal</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>IS</td>
<td>Complete</td>
</tr>
</tbody>
</table>

**Global**

**Reverse if false**

**On load**

**Inherit**

---

**Related Links**

**Default view**

**UI Policy Actions**

- **Search**
  - Field name: u_needs_review
  - Mandatory: True
  - Visible: True
  - Read only: Leave alone

---

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Create an ACL

Create an access control rule (ACL) to prevent the **Needs review** field from being modified after it has been set.

Role required: admin with elevated security

The newly created UI Policy makes the **Needs review** field mandatory when a change request reaches the **Complete** state.

The subsequent configuration of the state model ensures that a value is required in the **Needs review** field before the change request can be saved in the **Complete** state. To prevent the **Needs review** value from being changed after it has been set, create a new access control level record (ACL) to make the field read-only.

1. Open the **Change Request** form.
2. Open the form context menu and select **Configure > Security Rules**.
3. Elevate your security role in the user menu that opens when you click your name in the header.
   - Only administrators with elevated security roles can add ACLs.
4. Click **New**.
5. Enter the following values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Record</td>
</tr>
<tr>
<td>Operation</td>
<td>Write</td>
</tr>
<tr>
<td>Name (first part)</td>
<td>Change Request</td>
</tr>
<tr>
<td>Name (second part)</td>
<td>Needs review</td>
</tr>
<tr>
<td>Condition</td>
<td>(State) (is) (Implement)</td>
</tr>
</tbody>
</table>
6. Click **Submit**.

**Update the state handler script include**

Update the `ChangeRequestStateHandler` script include with the new **Complete** state.

Role required: admin

The `ChangeRequestStateHandler` script include defines the states available for the Change Request state model.

1. Navigate to **System Definition > Script Includes**.
2. Open the `ChangeRequestStateHandler` script include and modify the script as follows.
1. Add the following line to the top of the script in the **Constants** section:

   ```javascript
   ChangeRequestStateHandler.COMPLETED = "complete";
   ```

2. Add the following line as the last line of the function in the `initialize` function:

   ```javascript
   this.STATE_NAMES["-6"] = ChangeRequestStateHandler.COMPLETED;
   ```

3. Click **Update**.

   **Update the state model script include**

   Update the `ChangeRequestStateModel_normal` script include to add new functions for the **Complete** state.

   Role required: admin

   You update the `ChangeRequestStateModel_normal` with the following configuration.

   - Add new `canMove` and `moving` functions for the **Complete** state. These functions can return a value of `true` since there are no special conditions for or extra actions to perform when moving to the **Complete** state.
   - Modify the definition of the existing object for the **Implement** state to ensure that the next state is **Complete**.
   - Add an object for the **Complete** state, which defines **Review** and **Closed** as the next two states.
Note: The canMove functions for the transition to these states from Complete checks the Needs review custom field to determine the correct next state.

1. Navigate to System Definition > Script Includes.
2. Open the ChangeRequestStateModel_normal script include and modify the script as follows.

   1. Add the following line at the end of the script include but before the line that starts with type:

```
toComplete_moving: function() {
    return true;
},

toComplete_canMove: function() {
    return true;
},
```

2. Modify the existing implement object to toComplete:

```
implement: {
    nextState: [ "complete" ],

cancelled: {},

toComplete_moving: function() {
    return true;
},

toComplete_canMove: function() {
    return true;
},

type: "ChangeRequestStateModel_normal"
};
```
3. Add the following new state object for `complete`.

```javascript
complete: {
  nextState : [ "review", "closed" ],

  review : {
    moving : function() {
      return this.toReview_moving();
    },

    canMove : function() {
      if (this._gr.getValue("u_needs_review") == "Yes")
        return true;
      return false;
    }
  },

  closed : {
    moving : function() {
      return this.toClosed_moving();
    },

    canMove : function() {
      if (this._gr.getValue("u_needs_review") == "No")
        return true;
      return false;
    }
  },

  canceled : {
    moving : function() {
      return this.toCanceled_moving();
    },

    canMove : function() {
      return this.toCanceled_canMove();
    }
  }
},
```

4. Click **Update**.

Create a UI action to display a button on a change request for the **Complete** state.

Role required: admin

The UI action must contain a condition that uses the state model script include to decide when the **Complete** button is displayed on the Change Request form. In this case, the **Complete** button is displayed only when the change has reached the **Implement** state.

1. Open the **Change Request** form.
2. Open the form context menu and select **Configure > UI Actions**.
3. Locate and open the existing **Implement** UI action.
4. Open the form context menu and click **Insert and Stay** to create a duplicate record.
5. Modify the following fields with new values.
6. Click **Update**.

**Create a process flow record**
Create and add a process flow record for the **Complete** state. The process flow formatter displays at the top of the Change Request form.

Role required: admin

1. Navigate to **System UI > Process Flow**.
2. Open the Normal Change – Implement state record.
3. Open the form context menu and click Insert and Stay to create a duplicate record.
4. Modify the following fields with new values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Normal Change – Complete State</td>
</tr>
<tr>
<td>Label</td>
<td>Complete</td>
</tr>
<tr>
<td>Order</td>
<td>550</td>
</tr>
<tr>
<td>Condition</td>
<td>(State) (is) (Complete)</td>
</tr>
</tbody>
</table>
5. Click **Update**.

*Update the change request workflow*

Update the change request workflow to reflect the addition of the **Complete** state.

Role required: `admin`

The Change Request – Normal workflow for the **Normal** type change request must be updated to progress the change request to **Complete** instead of **Review**.

In case of a change request of type **Normal**, in the **Assess** state, any user from the **Assignment group** can approve the change request. When the value of **Risk** is **Moderate** or **High**, a CAB
approval is initiated in the **Authorization** state. In case the **Risk** is **Low**, an approval from the CAB team is not required. Instead, the manager of the assignment group can approve the change request.

**Note:** If the manager of the assignment group also happens to be the user who had approved the change request in the **Assess** state, the **Authorize** state is skipped and the state of the change request is set to **Scheduled**.

The functionality is available only for the new customers.

1. Navigate to **Workflow > Workflow Editor**.
2. Select **Change Request – Normal** from the list of workflows.
3. Select the **Checkout** option from the **Context** menu to create a new version of this workflow.
4. Open the **Set Values** activity that transitions to the **End** activity and modify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Move to Complete</td>
</tr>
<tr>
<td>Set these values</td>
<td>State = Complete</td>
</tr>
</tbody>
</table>
5. Click **Update**.
6. Open the **Wait for conditions** activity that transitions to the End activity and modify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Change moves to Complete</td>
</tr>
<tr>
<td>Set these values</td>
<td>(State) (is) (Complete)</td>
</tr>
</tbody>
</table>
7. Click **Update**.
8. Open the Workflow Actions menu and click **Publish**.

**Change Management workflows**

The Change Management processes for a change request are controlled by workflows defined for a specific change request type. You can use the graphical Workflow Editor to modify one of
the default workflows, or to create additional change request workflows. For more information on using the Workflow editor, see Workflow editor. Change Management workflows support domain separation.

By default, seven change request workflows are provided.

**Default change workflows**

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Request - Emergency</td>
<td>The workflow process that an emergency change request follows.</td>
</tr>
<tr>
<td>Change Request - Emergency change tasks</td>
<td>The child workflow process that handles the creation and management of the change tasks for the emergency change request workflow.</td>
</tr>
<tr>
<td>Change Request - Normal</td>
<td>The workflow process that a normal change request follow.</td>
</tr>
<tr>
<td>Change Request - Normal change tasks</td>
<td>The child workflow process that handles the creation and management of the change tasks for the normal change request workflow.</td>
</tr>
<tr>
<td>Change Request - Standard</td>
<td>The workflow process that a standard change request follow.</td>
</tr>
<tr>
<td>Change Request - Standard change tasks</td>
<td>The child workflow process that handles the creation and management of the change tasks for the standard change request workflow.</td>
</tr>
</tbody>
</table>

**Create a change request**

A change request allows you to implement a controlled process for the addition, modification, or removal of approved and supported configuration items (CIs). A change request records the detailed information about the change, such as the reason of the change, the priority, the risk, the type of change, and the change category.

Role required: itil, admin, or sn_change_write

If you use conflict detection, the planned start and end dates and the configuration item (CI) are required.

1. Create the change request with one of these options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Change module</td>
<td>You can create all three types of change from the Change module.</td>
</tr>
<tr>
<td></td>
<td>1. Navigate to Change &gt; Create New.</td>
</tr>
<tr>
<td></td>
<td>2. Select Normal, Emergency, or Standard changes.</td>
</tr>
<tr>
<td>From an incident or a problem</td>
<td>As an IT technician user, you can create only normal or emergency changes from an incident or a problem.</td>
</tr>
<tr>
<td></td>
<td>1. Open the incident or problem.</td>
</tr>
<tr>
<td></td>
<td>2. Right-click the form header and select Create Normal Change, Create Standard Change, or Create Emergency Change.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| From an existing change record | If the administrator enabled the change request copy option, you can create a new change by copying an existing change record.  
1. Open the change record that you want to copy.  
2. Click Copy Change.                                                                 |

Note: If the create task workflow sets the create_from field in the (change_task) table to workflow, manually created tasks from the existing change record are copied.

2. On the form, fill in the fields.

**Change Request form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Displays the Change request number.</td>
</tr>
<tr>
<td>Requested by</td>
<td>User who requested the change. This field is available in the Change Requests list view, so that you can see who requested a particular change.</td>
</tr>
<tr>
<td>Category</td>
<td>The category of the change, for example, Hardware, Network, Software.</td>
</tr>
<tr>
<td>Service</td>
<td>The business service that you want to make available for the change request.</td>
</tr>
</tbody>
</table>

**Note:** If you select a business service as the configuration item and that business service is also listed as the configuration item in any other active task, the active tasks icon appears. Click the icon to view the list of all the other active tasks that are affecting the business service. You can view the BSM map (dependency view) of the selected business service by clicking the dependency icon.

<p>| Service Offerings | Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. You can choose to receive different levels of performance and features for a given service through service offerings. You must select a service to filter the available service offerings. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item</td>
<td>Configuration item (CI) that the change applies to. Change requests can be associated with any type of CI, including service offerings, providing detailed access to SLA and availability requirements. After selecting a CI, you can click the health dashboard icon to view the CI health details.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority is based on impact and urgency, and it identifies how quickly the service desk should address the task.</td>
</tr>
<tr>
<td>Risk</td>
<td>The risk level for the change. The risk of a change can be defined manually as High, Moderate, or Low. You can also use Risk Calculation and Risk Assessment to drive the risk value of the change.</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact is a measure of the effect of an incident, problem, or change on business processes.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of change request. This field is read-only.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the change request. The default state is New.</td>
</tr>
<tr>
<td>Conflict status</td>
<td>Displays whether there is a conflict for this Change or the conflict is not run.</td>
</tr>
<tr>
<td>Conflict last run</td>
<td>Displays the date and the time when conflict was last run.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group that the change is assigned to.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user that the change is assigned to. If an assignment rule applies, the change is automatically assigned to the appropriate user or group.</td>
</tr>
<tr>
<td>Short description</td>
<td>A summary of the change.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the change.</td>
</tr>
</tbody>
</table>

3. To plan the Change, click the **Planning** tab and enter information. This information is critical for change approvers.

4. Click the **Schedule** tab.
   a) Enter as much information about the scheduled dates as you have. Some of the fields are available for normal or emergency changes only because standard changes are preapproved.

   Note: For normal or emergency changes, enter the planned start and end dates and actual start and end dates manually. Populate the actual start and end date fields during the Implement state as the assignee begins and completes the work.
b) If the form is configured to show the **CAB required** check box, select it to indicate that CAB approval is required before implementation.

The **CAB date** field in the change request is automatically updated with the date in the **Meeting start time** field of the CAB meeting form.

c) If there is an unplanned CI activity, the **Unauthorized** check box helps in determining if the change is an unauthorized change. For more information, see **Unauthorized change request**.

![Note: This check box is visible only for emergency change requests.]

d) If the form is configured to show the **CAB delegate** field, select the user who attends the CAB meeting to describe the change.

e) In the **CAB recommendation** field, enter notes or recommendations related for the CAB meeting.

5. Click the **Conflicts** tab.
6. To detect change conflicts, click **Check conflicts**.
7. Right-click the form header and click **Save**.
8. Review entries in the related lists and modify the entries as appropriate.

### Default Change Request related lists

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Affected CIs</td>
<td>List of CIs (from the CMDB) affected by the change. You can associate multiple affected CIs with a change.</td>
</tr>
<tr>
<td>Impacted services/CIs</td>
<td>List of CIs, such as business services or from other CI classes, that are impacted by the affected CI in the change. You can associate multiple impacted CIs with a change.</td>
</tr>
</tbody>
</table>
| Service Offerings    | List of service offerings affected by the change. This related list is available only when a service offering is selected. You can associate multiple service offerings with a change.  
If there are service offerings associated to the Impacted Services, then refresh the Impacted services/CIs related list to view the offerings. |
| Approvers            | This list is automatically generated from the workflow. You can also view the **Group** of approvers assigned to the task.                                                                                 |

**Note:** Customers who have customized the default view of their form or related list before the Paris release cannot see the field or the related list by default. Modify your form to add them manually.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Tasks</td>
<td>The list of tasks can be created from a workflow. The default workflow generates tasks in the Implementation state. You can also create a new change task. The Planned start date and Planned end date in task type Implementation must fall within the planned start and end dates specified in the change request.</td>
</tr>
<tr>
<td>Problems</td>
<td>If the change was generated from a problem, this list is generated automatically.</td>
</tr>
<tr>
<td>Incidents Fixed by Change</td>
<td>List of incidents that require the change for resolution.</td>
</tr>
<tr>
<td>Incidents Caused by Change</td>
<td>List of incidents caused by implementation of the change.</td>
</tr>
<tr>
<td>CAB Agenda Items</td>
<td>List of agenda items and details of respective items. For example, the meeting start and end time, allocated time for the meeting, state of the meeting, and the decision made for that agenda item.</td>
</tr>
</tbody>
</table>

**Note:** The CAB Agenda Items related list is not shown on the form when the list is empty. This feature is available only for Jakarta instances.

9. When the change request is ready to move to the next state, click Request Approval. The state is moved forward based on the type of change request.

- **Assess** state for group level approval for a normal change request. Approval records are automatically generated based on the Assignment group. You can conduct peer and technical reviews of the proposed change.
- **Authorize** state for an emergency change request.
- **Scheduled** state for pre-approved standard changes.

**Note:** To mail the change record, click the more options icon in the content frame and select Email. The user who requested the change and the user who is assigned to the change is automatically populated in the list of recipients.

To view the calendar, click View Calendar in the title bar of the Change Request form.

**Process a change request**

**Create a change request from a CI**

You can create a change request from a list of CIs, or add selected CIs from a list to a change record.
Role required: itil, admin, or sn_change_write

1. Select a list of CIs. For example, navigate to Configuration > Servers > Unix.
2. Select one or more CIs from the list.
3. Select one of the following options from the Actions list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to existing Change Request</td>
<td>Select this option to associate the CIs with an existing change request.</td>
</tr>
<tr>
<td>Add to new Change Request</td>
<td>Select this option to associate the CIs with a new change request.</td>
</tr>
</tbody>
</table>

![UNIX Servers](image)

**Note:** CIs with a Business Service CI class are added to the Impacted Services/CIs related list on the change request. The remaining CIs are added to the Affected CIs related list.
Depending on your selection, either an existing change request is updated with the selected CIs or a new change request record is created with the selected CIs.

4. You can continue to create or modify the change record as required.

**Request a standard change from the catalog**

You can request a new standard change from the published standard change catalog templates.

Role required: itil, admin, or sn_change_write

2. Select one of the following options depending on the type of standard change you want to request.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Standard Changes</td>
<td>Request a standard change to the network.</td>
</tr>
<tr>
<td>Server Standard Changes</td>
<td>Request a standard change for servers and attached storage.</td>
</tr>
</tbody>
</table>

3. Select a template from the *Items* section.
   - For example, *Add network switch to datacenter cabinet* in the *Network Standard Changes* > *Items* section.

   When you select the catalog item, a standard change is created. The Change Request form is displayed with values from the standard change template.

4. Complete the form with additional information you have.
   - For example, add the *Configuration item* and the *Assignment group*.

5. Open the form context menu and click *Save*.

6. Complete any information in the related lists that apply to the standard change request.

7. Click *Update*.

**Copy a change request**

You can copy details of an active or canceled change request to a new change request.

Role required: itil, admin, or sn_change_write

The administrator configures which of the following items are copied to the new change request.

- The content that is copied.
- The attributes or fields and values that are copied. All non-copied attributes are reset to default values.
- The configured related tables that are copied.

**Note:** You cannot copy change details from a standard change.

New change tasks can be created when a change is copied. If your change record has associated workflows that create change tasks, then these change tasks may not be copied because the workflow creates them. Only manually created tasks are copied, if the workflow when creating the task sets the *created_from* field on the *change_task* table to *workflow*. The *created_from* field has a default value of *manual*.

1. Navigate to the change request to be copied.
2. In the Context menu, right-click and then click *Copy Change* to copy change details.
A preview of the new change record appears with values from the original source change record.

3. Edit values on the newly created change record, as appropriate.
4. Click Submit to create a new change request record.

After an existing change request is copied and a new one created, it is sent for processing to the change manager. The change manager then reviews, approves, implements, and closes the change request as necessary.

In addition, you can associate CIs to the newly created change request.

Create a change task

You can create change tasks for a change request. A change task is a piece of work related to the change request. For example, there can be tasks to plan the change, implement the change, and test, and review the work.

Role required: itil, admin, or sn_change_write

Change tasks can be created manually or from a workflow. The Change Request form has a Change Tasks related list, which includes all manual and workflow change tasks. From this related list, you can edit existing tasks or create tasks. Workflow change tasks are generated automatically in Review task type.

1. Navigate to Change > Open.
2. Select the change request to add a change task.
3. In the Change Tasks related list, click New.
4. Fill in the fields, as appropriate.

### Change Task form

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration item</td>
<td>The configuration item (CI) or service that the change task applies to.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>The date you plan to begin working on the task.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>The date the change task is planned to be completed.</td>
</tr>
<tr>
<td></td>
<td>If the task type is Implementation, the Planned start date and Planned end date values must fall within the planned start and end dates specified in the change request.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of change task, Planning, Implementation, Testing, or Review. The default workflow generates tasks in type Review.</td>
</tr>
</tbody>
</table>
Name | Definition
---|---
State | The state of the change task:
- **Pending**: Open and unassigned
- **Open**: Open and unassigned
- **In progress**: Open and actively being worked on
- **Closed**: Inactive and closed. Requires close code and close notes to be provided.
- **Canceled**

On hold | The **On hold** check box indicates whether the change task is on hold. Provide an **On hold reason** if a change task is placed on hold.

Assignment group | The group that the change task is assigned to.

Assigned to | The user that the change task is assigned to. If an assignment rule applies, the change task is automatically assigned to the appropriate user or group.

Short description | A summary of the task.

Description | A detailed description of the task.

5. To enter work notes for the change task, click the **Notes** tab.
6. To enter notes on why the task was closed, click the **Closure Information** tab.
7. Click **Submit**.
   The change task is added to the change request. The assigned user receives a notification that a task was assigned to them.

**Unauthorized change request**

When unauthorized change activity occurs on CIs that are part of the application service, it is critical to capture the change activity and notify change management so that the change activity is reviewed by the appropriate stakeholders.

As part of the Service Mapping integration with ITSM, the Change Management application receives an event notification when unauthorized change activity is detected. As a result, an emergency unauthorized change request is created for the relevant CI. You can review and approve or reject the unauthorized change from the Change Management application.

**Note**: Unauthorized change requests are created only for the CIs that are part of the application services. Also, there is a flapper algorithm that uses a learning pattern to minimize false positives.

At times, the discovery process (horizontal or top down discovery) identifies a change on a specific CI property that may not be an actual change by definition. This can be due to a measurement error or just a different representation of the same value such as case sensitivity. This learning pattern identifies the false positives (flapper changes) and prevents triggering the re-computation and timeline updates. This is because, emergency change request is a critical action and we want to avoid false positives and report only real changes.
Let us see how the learning pattern identifies the false positives.

1. When a property of a CI associated with a service changes, the new value (CI and field pair) is logged in the flapper’s data table.

2. The system runs a nightly job and executes various algorithms on the data collected to identify patterns pointing to false positives.

3. The system runs all the relevant strategy predicates for the changed CI fields with the confidence level greater than 90%. This step determines whether all the new values are false positives or not. If all the new values are false positives then the change is ignored, and the model will not be updated.

Note: If the CI is associated with an active change request, then this step is skipped.

Let us understand how the unauthorized change request is created. When an unplanned CI change activity occurs, the system starts learning the pattern and triggers the following changes:

- If the CI is not associated with an active change and has at least one positive field change, then a `ci.change.unplanned` event is generated and the `com.snc.change_request.enable_unauthorized` property is set to true.
- If the `com.snc.change_request.enable_unauthorized` property is true, then an unauthorized change request is created. By default, this property is false.

Now, the `ci.change.unplanned` event that is generated automatically triggers the creation of an Emergency type change request. With the help of the following details that are pre-populated in the form, you can identify and review the unauthorized change:

- The Unauthorized check box selected. This indicates that the change is an unauthorized change.
- The Assignment group is populated with Change Management.
- The Configuration item is populated with the item for which the unauthorized change was made.
- The Description is populated with the information on the changed fields of the change request.
Change Request
CHG03240002

Configuration Item
PS LinuxApp2

Priority
- Low

Risk
- Moderate

Impact
- Low

Short description
An unauthorized change has been detected

Description
- Field cpu_name: OldValue: New Value: 1
- Field cpu_manufacturer: OldValue: New Value: "Intel"
- Field cpu_model: OldValue: New Value: "Rome"
- Field os_release: OldValue: New Value: "RHEL 7.7"
- Field os_kernel: OldValue: New Value: "3.13.0-41-generic"
- Field disk_space: OldValue: New Value: "20GB"
- Field short_description: OldValue: New Value: "Linux Hadoop 3.13.0-41-generic #294 SMP Thu Jan 9 12:03:57 UTC 2014 i686 i686 i686 GNU/Linux"
- Field manufacturer: OldValue: New Value: "SUSE Linux Enterprise Server 12 SP1"
- Field model: OldValue: New Value: "x86_64"
- Field cpu_count: OldValue: New Value: 1
- Field cpu_clock: OldValue: New Value: 2.0GHz
- Field hardware: OldValue: New Value: "Intel Xeon E5-2650v4"
- Field ram_size: OldValue: New Value: "32GB"
- Field os_version: OldValue: New Value: "RHEL 7.7"
- Field os_kernel: OldValue: New Value: "3.13.0-41-generic"
- Field os_release: OldValue: New Value: "RHEL 7.7"
- Field os_model: OldValue: New Value: "Rome"
- Field os_products: OldValue: New Value: "Linux Hadoop 3.13.0-41-generic #294 SMP Thu Jan 9 12:03:57 UTC 2014 i686 i686 i686 GNU/Linux"
- Field numa_node: OldValue: New Value: 0

Planning Status
- Planned start date and planned end date are the requested change window

Authorized

Non-authorized

Authorized

Non-authorized
Additionally, the following notifications are invoked: an email notification is sent to the Assignment group, CI Item managed by, Owned by, and Assigned to members for review and approval. However, if there are massive CI changes and there are no open change request created to include the CIs, the system creates unauthorized change requests on these CIs. When this event occurs, the members receive numerous unauthorized change notification emails. In such case, you can choose to disable the notifications. For more information, see Disable unauthorized change request creation.

**Note:** Email notifications are sent only when there is an unplanned change on the CI that is part of an application service (discovered or manual service).

After this change request is approved, the state changes to Review and the regular process is followed to close the request.

**Post-implementation review**

When a change is implemented without approval, post-implementation review is necessary to evaluate the risk and impact of the unauthorized change.

After the unauthorized change is approved, a change task is created with State as Review. This change task is assigned to the Change Management group with the Short description as Post Implementation Review. The assigned members who receive the notification can review and close the change task.

**Modify the unauthorized change setting**

As a change manager, you can deselect the Unauthorized check box to convert the unauthorized change request to an emergency change request. When you deselect the check box, enter the reason for this modification in Work notes.

If you are an ITIL user, to deselect the Unauthorized check box, create an outage from the task record with the Type specified as Outage. For more information see, Create an outage from a task.

**Note:** When there is an unauthorized change without an outage record associated, then the state flow moves from Authorize to Review and skips the schedule or implement state. This is because the implementation has already happened for this change.

**Disable unauthorized change request creation**

You can choose to disable the notifications that you receive on any unauthorized change event. When a configuration item (CI) that is part of an application service is updated, the system identifies this update and verifies whether the updated CI is part of an open change request. If it is not, then the system triggers a change request and sends a notification. The Change Management application uses this event to create an unauthorized change.

Role required: admin or change_manager

If there are massive CI changes with no open change request created to include the CIs, then the system creates unauthorized change requests on these CIs. When this event occurs, numerous unauthorized change requests are triggered, and notifications are sent to the members of the group. To avoid this situation, you can disable the com.snc.change_request.enable_unauthorized property before you perform the updates.
Note: Ensure that you enable the property when you finish your updates. If you keep this property disabled, no unauthorized change requests are created.

1. Navigate to Change > Administration > Change Properties.
2. Deselect the Enable the creation of unauthorized change requests when the event "ci.change.unplanned" is raised. property.
3. Click Save.

This action disables the creation of unauthorized change request and no notifications are sent.

Process a change request

You can approve, implement, review, and close a change request.

As part of processing a change request, ensure that you have detected any change conflicts and performed risk assessment.

Role required: itil, admin, sn_change_write, or change_manager

You can perform the following actions on a change request based on your role.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve or reject a change request</td>
<td>Open the approval record and click Approve to approve the change request or Reject to reject it. The change request changes to the Scheduled state if it is approved or to New state if it is rejected.</td>
</tr>
<tr>
<td>Implement a change request</td>
<td>Click Implement to put the change request into action. The change request state changes to Implement. The workflow creates two change tasks: Implement and Post-implementation testing. Review the change tasks and assign them to a user or group, as appropriate.</td>
</tr>
<tr>
<td>Review a change request</td>
<td>Click Review after reviewing the details on the change request. The change request is moved to the Review state. All open change tasks are set to Canceled.</td>
</tr>
<tr>
<td>Close a change request</td>
<td>Click Close after entering the Close code and Close notes in the Closure Information section. The change request is closed.</td>
</tr>
<tr>
<td>Cancel a change request</td>
<td>From the context menu, click Cancel Change. Provide a reason for canceling the change and click Save. The change request is canceled and the reason for canceling the change is added to the Work Notes field.</td>
</tr>
</tbody>
</table>
Note: Manually created change tasks are not automatically closed or cancelled when state is changed from Implement to Review. You must first close the change tasks and to close the change request.

Users with approval_user role, who approve change requests, do not have access to the change request itself. The following information are made available within the approval record to help these users make the right approval decision:

- Number Requested by
- Configuration Item Type
- Planned Start Date Risk
- Planned End Date Impact
- Short Description
- Description
- Justification
- Implementation plan
- Risk and impact analysis
- Backout plan
- Test plan

You can also add approval history to the change request activity log. Click the activity filter icon and select Approval history from the list. When there is a change in the approval process, such as an approval, rejection, or comments, the activity log is updated.

Associated CIs on a change request

You can associate additional CIs or services to change requests through related lists on the Change Request form. You can also associate CIs with a change request from the dependency views map.

The Affected CIs and Impacted Services/CIs related lists enable you to manage CI changes. When you first access a change request and work with these related lists, you can identify CIs across CI classes using configuration class. You can change the configuration class manually to filter the list and narrow the selection of CIs. For example, to filter for Linux servers only, select Linux Servers as the Configuration Class.

You can also create and save filters to provide quick access to common CI searches. The next time you access the change request, the Configuration Class field displays the last associated CI class. This automatic filter ensures that relevant CIs are displayed.

After identifying the CIs affected by a change request, you can add them to the Affected CIs related list on the change request. After saving affected CIs, you can open the form context menu and select the Refresh Impacted Services option. This option populates the Impacted Services/CIs related lists based on the primary CI i.e. the CI that is mentioned on the form.

The Impacted Services/CIs and Service Offering related lists represents a many-to-many relationship between the Task (task) and CMDB (cmdb_ci) tables. The related list displays CIs, such as business services or other CI classes, and the offerings that are impacted. You can add this related list to any task form such as an incident or problem form. You can also enter the details of the impacted services and the service offerings manually, as required.

Note:
The manually added CIs are not deleted each time the impacted services are refreshed. However, business services related to the CIs are displayed on the Impacted Services/CIs related list.

Refresh Impacted Services was only available for Change Request table. From this release, it is available for tables that extend the Task table. The list of these tables is driven by the com.snc.task.refresh_impacted_services property. This UI action populates the Impacted Services/CIs related list based on the primary CI i.e. the CI that is mentioned on the form.

The Impacted Services list includes application services discovered by Service Mapping.

Add affected CIs to change requests using dependency views

You can use dependency views to identify dependent CIs affected by a change request, and then add them to the Affected CIs related list.

Role required: itil, sn_change_write, or admin

When a change request is associated with a configuration item, the change record becomes accessible from dependency views. Services affected by the change request are easy to assess in dependency views.

If not visible, the administrator can configure the change request form to display the Affected CIs related list.

1. In the change request, click the dependency views icon next to the Configuration item field.

   ![Note:](image)

   Note: If there are critical change requests attached to a CI for a database, the map includes the business services that rely on that database. The database icon has a blinking glyph on the lower left edge that indicates any issues with the node.

   The configuration item is displayed in the map with all dependent CIs.

2. Click the down arrow next to the CI to display a list of tasks and issues with the CI.

   The list may contain one or more change requests, and follow-on audit tasks. You can open each record from this list.

3. Click the task number to display the complete list of tasks attached to this CI.

   You can view the user assigned to the change and also open the record for more information.

4. To change the map configuration, select a format from the Layout field or use the filter panel to filter the map.

   The dependency views map highlights the affected CIs that depend on the database or other CI.

5. To add an affected CI to the change, click the arrow next to the highlighted node and select Add Affected CIs.

6. Reload the change request form.

   You can view the CI you added in the Affected CIs related list.

Associate multiple CIs with a change request

You can associate multiple impacted or affected CIs with a single change request.

Role required: itil, change_manager, sn_change_write, or admin
Use the **Configuration Item** field in the change form when there is one primary CI that is the cause of the change. The configuration items displayed are only those CIs whose class is set as the Principal Class in **Configuration > CI Class Manager**.

In the Affected CIs related list, a new filter is added for the Principal Class. You can control this functionality by the system property `com.snc.task.principal_class_filter`. The property contains all the task types where the Principal Class filter is applied to.

When you create a change request, you can add multiple CIs to that change request using the **Affected CIs** or **Impacted Services/CIs** related lists in the change record. Affected CIs can be added only when the change request is in the **New** state.

1. Navigate to **Change > Open** and select a change request record.
2. In either the **Affected CIs** or **Impacted Services/CIs** related list, click **Add**.

3. Select the appropriate CIs from the list of CIs displayed in the pop-up window. The pop-up window for the **Affected CIs** list is filtered for the configuration class of the last added CI. This automatic filter ensures that relevant CIs are displayed. You can change the class to list other CIs, if appropriate.
The **Impacted Services/CIs** pop-up window lists all CIs and provides standard filtering options. You can also save any filters you create to provide faster access to common CI searches.

4. Perform one of the following actions.
   - Select the CIs to add and click **Add Selected** to add the selected CIs to the change request.
Click Add All to add all the CIs in the list to the change request.

Add an affected CI with a calculated application service

From the change request form, you can add an affected CI that is associated with a calculated application service.

Role required: itil, sn_change_write, or admin

1. Navigate to Change > Open.
2. Select a change request to add affected CIs to.
3. On the Change Request form, scroll to the Related Links section.
4. Click the Affected CIs tab and then click Add to add an affected CI to the change request.
5. Open the form context menu and click Refresh Impacted Services.
6. Click the Impacted Services/CIs tab to see any dynamic services that are associated with the affected CI and that are impacted by the change request.

Use Bulk CI Changes and Mass Update CI

After these change management features are activated, you can use proposed changes in a change request to apply the same update to a set of CIs for a specific CI class.

Role required: itil, sn_change_write, or admin

1. Navigate to Change > Create New and select Normal or Emergency change.
2. Complete the information at the top of the form, but do not select a Configuration item.
3. Select the Mass update CI class check box.
   The Mass update CI class tab or form section appears.
4. On the Mass update CI class tab, select the CI class to update.
   The parent CMDB table, cmdb_ci, is selected by default. Search for the class name, for example, enter linux or email.
5. Enter the proposed changes to make to all the affected CIs.
   Each time you select a field and value, another line appears. If you enter a proposed change in error, click the X beside the line to remove it.
6. Click Submit.
7. Open the change request you submitted.
8. In the Affected CIs related list, click Add.
   The Add Affected Configuration Items window that opens lists only the CIs in the selected CI class.
9. Select one or more CIs and click Add Selected, or click Add All.
   If you change the CI class after selecting affected CIs, the list is cleared when you save the record.
10. Continue with the change management process for this change request.
11. When the record reaches the Implement or Review states, click Apply Proposed Changes.
    A message informs you that the proposed changes were applied to all the affected CIs.

Note: If you are using Bulk CI Change without Mass Update CI, then the proposed changes are applied when the change request is closed.
Place a change request on hold

You can put a change request on hold when it is not in the **New, Canceled, or Closed** state.

Roles required: itil, admin, sn_change_write, or change manager

The following plugins need to be activated to avail the synchronization of the **On Hold** functionality between change task and change request:

- Change Management Best Practice — madrid (com.snc.best_practice.change.madrid)
- Change Management — Core (com.snc.change_management)
- Change Management — State Model (com.snc.change_management.state_model)

Change tasks inherit some state conditions from the parent change request they are related to. When a change request is placed on hold, these conditions are applied to it:

- If the change is waiting for approval, the pending approvals are marked **No Longer Required**. When the change request is no longer **On Hold**, the pending approvals are reinstated and are **Awaiting approval**.
- The change can progress only to the **Canceled** state while it is **On Hold**.
- If a change request is canceled while it is **On Hold**, then its **On Hold** flag is set to **false** so the change cannot be canceled and still be **On Hold**.
- If the change request is set to **On Hold**, the value of the **On Hold** field for all the active change tasks for that change request is set to **true** and the **On hold reason** is copied from the change request to the change tasks.
- If you clear the **On Hold** check box in a change request, the **On Hold** field for all the active change tasks for that change request is set to **false** and the **On hold reason** is cleared from the change tasks.
- If the change request is canceled, all the active change tasks related to that change request are also canceled.
- A change request can only be closed when all the active change tasks related to that change request are closed or canceled otherwise a pop-up appears notifying that there are open change tasks that require to be closed.
- If there are existing change tasks that are manually placed on hold, those change tasks do not get overwritten when the change request is placed to the **On Hold** state. Similarly, when the change request is taken off the hold state, the change tasks that were placed on hold manually stays in the **On Hold** state.

1. Navigate to **Change > Open**.
2. Open the specific change request.
3. Select the **On Hold** check box.
4. In the **On hold reason** field, enter the reason for placing the change request on hold.
5. Click **Update**.

Perform bulk changes to CIs on a change request

You can perform bulk changes to CIs from the change request form.

Role required: admin

*Best Practice - Bulk CI Changes* is activated and the **change request form is configured** to perform bulk changes to CIs.

1. On the change request form, select a CI class.
   - If all required fields are completed, then the form is saved and submitted.
2. Click **Add** on the **Affected CIs** related list. The list in the pop-up window is filtered to list only CIs from the selected CI class.

3. Add the CIs that are involved in the change.

<table>
<thead>
<tr>
<th>Configuration Item</th>
<th>Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>KIOSK Keyboard</td>
<td>Computer Peripheral</td>
</tr>
<tr>
<td>KIOSK Scanner</td>
<td>Computer Peripheral</td>
</tr>
</tbody>
</table>

4. Enter the proposed changes in the **Proposed change** field. Whenever the **Proposed change** field is modified or affected CIs are added, the saved changes are applied to all affected CIs. In the illustrated examples, the assignment group and cost center values are applied to the KIOSK keyboard and scanner when the change request is completed.
5. Click **Update** to save and update the record.

The resulting changes are listed at the top of the form. The following message displays on the form when CIs are listed in the **Affected CIs** related list.

When the change request is in the **Implement** state, you can click **Apply Proposed Changes** in the form header to update the affected CIs. Otherwise, the changes are applied when the change request is closed.
Bulk CI Changes and Mass Update CI

The Best Practice - Bulk CI Changes plugin and the Change Management - Mass Update CI plugin enable users to apply the same update to a set of CIs for a specific CI class. The Change Management - Mass Update CI plugin extends the Best Practice - Bulk CI Changes plugin and is intended to be used when the Change Management - State Model plugin is activated. The Best Practice - Bulk CI Changes plugin is intended to be used with the legacy state model that preceded the Change Management – State Model plugin introduced in the Geneva release.

To use these features, activate the Change Management - Mass Update CI plugin and the Best Practice - Bulk CI Changes plugin.

When you activate the Change Management - Mass Update CI plugin, the Mass update CI class check box appears on the Change Request form. When selected, the Mass update CI class tab appears and allows changes to be proposed against the configuration items that match that class associated with the affected CI’s related list in that change.

In the Implement state, the system generates the Mass Update CI.xml that allows to update the CI records. When the proposed change is saved, Mass Update CI.xml is added to the affected CIs. The update can then be applied when the change is in the Implement or Review state.

**Note:** This feature is available for normal and emergency changes only.

Change Request form modifications for Bulk CI Changes

If you prefer to use Best Practice - Bulk CI Changes without Mass Update CIs, the CI class and Proposed change fields must be added to the Change Request form. The administrator configures it as described in the following list:

- Add the CI Class and Proposed Change fields, if they are not already visible.
- Add the Affected CIs related list, if it is not already visible.
- Remove the Configuration Item field from the form because all CIs are tracked through the Affected CIs related list.

Standard change catalog

Standard changes are pre-approved, low risk changes with a proven history of success. The standard change catalog contains the changes that have been approved by the Change Management application as standard changes.

Users with the ITIL role can view the list of available standard changes and submit change requests.

This video demonstrates how the standard change catalog works and how it enables change managers to manage change requests effectively.

A property controls whether the selection of a standard change request from the catalog inserts the change request record into the database. An administrator can select the Two step check box in Standard Change Properties. This property requires the requester to click Submit to insert the change request record.

Standard changes are logically grouped under specific categories. The Change Management application uses a proposal process to control which changes become available in the standard change catalog.

The standard change catalog enables you to perform the following activities:
- Request, review, and approve standard change templates.
- Request preapproved standard changes.
- Determine access to standard change templates at the user level.

You can propose, modify, and retire standard change templates based on the requirements of your organization.

**Pre-approved standard changes**

Submitting a change request from a standard change template ensures that pre-approved information is automatically populated in the necessary fields. Standard changes are submitted more quickly and fulfillment can be expedited.

**Note:** You cannot mass-update a set of Configuration Items (CIs) in standard changes. However, you can propose individual changes.

**Determine access to standard change templates at the user level**

Standard change templates are logically grouped under specific categories. These categories are displayed to users based on user criteria such as user role, geographical location, and department.

**Configure standard change catalog properties**

Configure the standard change catalog through the standard change properties.

The Change Management - Standard Change Catalog (com.snc.change_management.standard_change_catalog) plugin must be activated.

Role required: admin

2. On the form, fill in the fields.

**Standard change properties form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog</td>
<td>Select the service catalog to add the generated standard change template to.</td>
</tr>
<tr>
<td>Category</td>
<td>Select the service catalog category to add the generated standard change template to. You can also choose the category or any child categories of the selected catalog.</td>
</tr>
</tbody>
</table>

**Note:** This value is not set automatically on the Proposal form, but must be specified before it is approved.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Two step</strong></td>
<td>Check box to make the request of a standard change a two-step process. The process redirects the requester from a standard change template to a change request that can be reviewed before submitting. This option is enabled by default on instances provisioned on Jakarta. Customers upgrading from prior releases must enable the <strong>Two step</strong> property.</td>
</tr>
<tr>
<td><strong>Mandatory Change Request values</strong></td>
<td>Specify a list of mandatory fields that require values when you propose a new standard change template or a modification to a standard change template. This configuration ensures that when a standard change request is created from a standard change template, one or more fields on the Change Request form contain preset values.</td>
</tr>
<tr>
<td><strong>Default Change Request values</strong></td>
<td>Specify default values for common fields on the Change Request form.</td>
</tr>
<tr>
<td><strong>Restricted Change Request values</strong></td>
<td>Specify the list of fields that end users are not allowed to provide any value for when making a proposal.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Ensure that internal columns, such as Updates, Updated, Updated by, Domain, Created, Created by are restricted.</td>
</tr>
<tr>
<td><strong>Read-only fields</strong></td>
<td>Specify the fields that end users are not allowed to provide any value for in the created standard change request.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This configuration ensures that for the specified fields, the values approved in the standard change template do not change when the standard change request is submitted.</td>
</tr>
<tr>
<td><strong>Fields to copy</strong></td>
<td>Specify the fields whose values are copied to the <strong>Propose a New Standard Change Template</strong> record producer from a non-standard change request.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If any fields not specified in this list have default values specified, the default values are copied to the record producer.</td>
</tr>
</tbody>
</table>

**Change Task properties**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mandatory Change Task fields</strong></td>
<td>Specify a list of mandatory fields. Enter values for these fields when proposing a new change task template or modifying a change task template.</td>
</tr>
<tr>
<td><strong>Default Change Task values</strong></td>
<td>Specify default values for fields on the Change Task form when creating a change task template.</td>
</tr>
<tr>
<td><strong>Restricted Change Task fields</strong></td>
<td>Specify the list of change request fields that end users are not allowed to provide any value for when creating a change task template.</td>
</tr>
</tbody>
</table>
3. Click **Update**.

You can create a standard change catalog. By default, the basic Standard Change Proposal workflow sends approval records to members of the Change Management group and the members should verify and modify the records, as appropriate.

### Create a standard change task template

You can create a change task template to add to a standard change proposal. If the standard change proposal is approved, the related change tasks are created when the standard change request is created.

**Role required:** itil, change_manager, or sn_change_write

1. Navigate to **Standard Change > Open Proposals**.

   ![](Note) You can add standard change tasks to a standard change proposal only when the proposal is in the **New** state. Once you submit a standard change task for approval, you cannot add additional tasks.

2. Click the **Change Task Templates** tab, and then click **New**.
3. On the form, fill in the fields.

   **Change task template form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the change task.</td>
</tr>
<tr>
<td>Std change proposal</td>
<td>Name of the standard change proposal for which you want to create the change task template.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which change tasks are created in the change request.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the change task template.</td>
</tr>
<tr>
<td>Change Task values</td>
<td>Field values that are populated on the change task created as part of the standard change.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
Propose a standard change template

Propose a new standard change template when you identify a need while creating a change request. As an IT technician, you can propose a new change template for a change request that you frequently create. This new template is later sent for approval to the change management team, which reviews the request and approves the template as part of the approval process.

Role required: itil, admin

1. You can propose a standard change template by navigating to Change > Standard Change > Standard Change Catalog > Template Management > Propose a new Standard Change Template and filling in the fields on the form.

   **Standard Change Proposal form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description of the standard change proposal template.</td>
</tr>
<tr>
<td>Category</td>
<td>Category under which the template is published. For example, Server Standard Changes.</td>
</tr>
<tr>
<td>Sample Change Requests</td>
<td>Change requests that are available as samples for the change that you propose. The Change Management team reviews the requests as a part of the approval process.</td>
</tr>
<tr>
<td>Change Request values</td>
<td>Text which appears as default text in the standard change proposal template.</td>
</tr>
</tbody>
</table>

2. Click **Save**. The proposal is created with the status **New**.
3. Click **Request Approval**. The proposal is created with the status **In Progress**.
4. Optional: You can create a standard change template from a change that exists by completing the following steps.
   a) Navigate to **Change > Open** and click the change whose information you want to use in the standard change template.
   b) Open the form context menu and click **Propose a Standard Change Template**.

**Note:**
- Any change tasks that are included with the change also get copied to the new standard change proposal. The fields copied from both the change and change tasks are defined in the **Standard Change Properties**.
- By default, approval records are created for members of the Change Management group.

Alternatively, as a change manager, create and submit a standard change proposal that can be utilized as a template to draft a standard change request that occurs frequently and is of low risk. By default, the basic standard change proposal workflow sends approval records to members of the change management group where the members verify and modify the
records, as appropriate. Navigate to Change > Standard Change > My Proposals. Click New, fill the form, and then click Submit.

A new template record is created for use.

**Attach files to a standard change template**

Standard change templates copy any file attached to the template to a change request that the template creates. You can attach files, such as documents, spreadsheet, and images to a standard change proposal.

Role required: itil, admin

2. Open the proposal to which you want to add the attachment to.
3. Click the icon to browse and select the file. The attached file appears at the top of the proposal.

   **Note:** You can add more than one file as an attachment.

4. Click Update and request approval for the proposal.

Any attachment associated with a standard change proposal gets copied to the standard change template that is created when the proposal is approved. When that template is used to create a standard change, any attachment associated to it is also copied to those standard change requests.

**Modify or retire a standard change template**

You can modify and retire standard change templates based on your organization's requirements.

Role required: admin, change_manager, sn_change_write or itil

1. Navigate to Change > Standard Change > All Templates.
2. Select the template you want to modify or retire and perform one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
   | Modify a standard change template | 1. Click Modify Template under Related Links.  
   |                             | 2. Enter your modifications in the Modify a Standard Change Template form.  |

   | Retire a standard change template | 1. Click Retire Template under Related Links.  
   |                                 | 2. Enter your business justification to retire the specific template in the Retire a Standard Change Template form.  |

3. Perform one of the following actions:
   - Click Save. The modifications are saved but not sent for approval.
- Click **Request Approval**. The template is sent for approval to the change management team.

**Change schedules**

The Change Schedules landing page provides a view of schedules that are categorized under **Pinned Schedules**, **Your Schedules**, and **All Schedules**. The grouping of schedules provides easy access to your most required schedules and saves your time from searching through all the schedules in the system.

To access Change Schedules, navigate to **Change > Schedule > Change Schedules**.

**Note:** To view the Change Schedules page, you must activate Change Management - Change Schedule plugin (com.snc.change_management.soc).
You can find schedules arranged under three categories as follows:

- **Pinned Schedules**: Includes all change schedules you have previously chosen to pin for quick access.
- **Your Schedules**: Includes all change schedules you own or are a member of the group that owns the schedule.
- **All Schedules**: Includes all change schedules you have access to.

To pin a schedule, hover over the schedule tile and click the pin icon ( ). The schedule appears under **Pinned Schedules**. To unpin a tile, click the pin icon again.

**Note:** The **Show an information message when a change schedule is pinned** property in Change Properties controls whether you see an informational message confirming the pinning or unpinning of the schedule.

Click a tab to view a Change Schedule. For more information, refer *Change schedules view*.

**Change schedules view**

The Change Schedules module provides a Gantt or timeline view of change requests based on criteria defined within a Change Schedule Definition. The change schedule provides detailed insight to change requests that are included based on the change schedule definition. The change requests can include change timing, duration, related change tasks, blackout periods, and maintenance windows for any given date, week or month.

To view the Change Schedules page, you must activate Change Management - Change Schedule plugin (com.snc.change_management.soc).

Change requests are represented by a span. The duration of the span is defined by the start and end date fields defined in the Change Schedule definition. The Change Schedules page allows conditions to be defined using the condition builder. The condition builder determines which change requests are displayed and sorted in a change schedule.

**Note:** To show the blackout and maintenance windows of the change in the calendar view, the **Affected CI** field for the change must be configured.
### Change Schedule Timeline

<table>
<thead>
<tr>
<th>Number</th>
<th>Configuration Item</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHG0003010</td>
<td>PS Apache01</td>
<td>12 hours</td>
</tr>
<tr>
<td>CHG0003035</td>
<td>PS Apache02</td>
<td>4 hours</td>
</tr>
<tr>
<td>CHG0003011</td>
<td>PS Apache03</td>
<td>13 hours</td>
</tr>
<tr>
<td>CHG0003008</td>
<td>PS Apache03</td>
<td>7 hours</td>
</tr>
<tr>
<td>CTHG0040100</td>
<td>PS Apache01</td>
<td>2 hours</td>
</tr>
<tr>
<td>CTHG0040109</td>
<td>PS Apache03</td>
<td>3 hours</td>
</tr>
<tr>
<td>CTHG0040108</td>
<td>PS Apache03</td>
<td>3 hours</td>
</tr>
<tr>
<td>CHG0003073</td>
<td>PS Apache02</td>
<td>4 hours, 44 min...</td>
</tr>
<tr>
<td>CHG0003068</td>
<td>PS Apache02</td>
<td>5 hours, 58 min...</td>
</tr>
<tr>
<td>CHG0003079</td>
<td>PS Apache02</td>
<td>4 hours</td>
</tr>
<tr>
<td>CHG0003115</td>
<td>PS Apache01</td>
<td>6 hours</td>
</tr>
<tr>
<td>CHG0003241</td>
<td>PS Linux001</td>
<td>4 hours</td>
</tr>
<tr>
<td>CHG0003211</td>
<td>PS Apache01</td>
<td>6 hours</td>
</tr>
<tr>
<td>CHG0003202</td>
<td>PS Linux001</td>
<td>2 hours, 44 min...</td>
</tr>
<tr>
<td>CHG0003233</td>
<td>PS Apache01</td>
<td>3 hours</td>
</tr>
<tr>
<td>CHG0003216</td>
<td>PS Apache01</td>
<td>3 hours</td>
</tr>
<tr>
<td>CHG0003204</td>
<td>PS Apache01</td>
<td>30 minutes</td>
</tr>
</tbody>
</table>

**State:** New
**Type:** Normal
**Risk:** Moderate

**Planned start date:** 2018-09-12 18:00:00
**Planned end date:** 2018-09-12 21:00:00
**Impact:** 3 - Low
**Priority:** 1 - Critical
<table>
<thead>
<tr>
<th>SI #</th>
<th>UI Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Context Menu | Option to do the following:  
- Create new schedule: You can create a new schedule from a simplified wizard.  
- Edit a schedule: Allows the modification of change schedules you own and any changes made are saved to the related Change Schedule Definition record.  
- Copy a schedule: If you are the owner of the change schedule that you want to copy, then a copy of the change schedule is created. If you want to copy a change schedule that is owned by any other user, then you become the owner of the copied schedule and the new schedule is fully editable by you.  
- View schedule definition: You can view the change schedule definition and the related fields associated with it.  
- Delete: Allows users, who own a change schedule, to delete the schedule.  

**Note:**  
- A user who only possesses the ITIL role and is not the owner of a change schedule can only create a schedule, copy a schedule, or view an existing schedule definition.  
- You become the owner of any schedule that you create. The new schedule that you create appears in the Change Schedule page in a tile form under the Your Schedules tab. |
| 2    | Span styles  | Defined span color based on conditions you specify. You can add new span styles by clicking **Add Span Styles**. You can also edit an existing style rule, apply filters to a style rule, or remove a style rule.  

**Note:** By default, span styles are based on the Risk value of a change.  
- Risk = High – Span style is Red  
- Risk = Moderate – Span style is Orange  
- Risk = Low – Span style is Green |
| 3    | Share        | Schedules to be shared to other users by user name, group, or role. The share pane also provides a check box to share a change schedule with everybody. If change schedules are not shared with anyone, then only the owner, owner group, and administrator can see them. If a change schedule is shared with other users, an option is available to send an email notification to inform them of their access. |
| 4    | Configuration| Components of the change schedule including the configuration item, duration, or any related tasks can be hidden or exposed. |
### Create a change schedule from the Change Schedules page

You can create a change schedule to view all scheduled changes, change tasks, blackout periods, maintenance windows for any given date, week, month, or year.

- You have activated Change Management - Change Schedule plugin (com.snc.change_management.soc).
- Role required: itil, sn_chg_soc.change_soc_admin, sn_change_role, sn_change_write roles, sn_change_write, or admin

**Note:** A user with an ITIL role can create a Change Schedule definition and view the schedule definition that they have created.

An admin or a change schedule administrator can read or edit all Change Schedule definitions.

1. Navigate to Change > Schedules > Change Schedules and click New.
2. On the form, fill in the fields.
New Change Schedule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the change schedule.</td>
</tr>
<tr>
<td>Start date field</td>
<td>Field from the change request form that indicates the start date as an example planned start date.</td>
</tr>
<tr>
<td>End date field</td>
<td>Field from the change request form that indicates the end date as an example planned end date.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions that determine which change requests display in the Change Schedule interface and the order in which those change requests are sorted.</td>
</tr>
</tbody>
</table>

3. **Click Submit.**
The change schedule is displayed in the timeline view.

Create a change schedule from the change schedule definition

You can define a change schedule from a change schedule definition record. Change schedule definitions help you to define the content that displays in the change summary popover, the users, groups or roles with whom a schedule is to be shared, and related span style colors.

- You have activated Change Management - Change Schedule plugin (com.snc.change_management.soc).
- Role required: itil, sn_chg_soc.change_soc_admin, sn_change_role, sn_change_write roles, sn_change_write, or admin

To create a new Change Schedule, specify the start and end date fields that you want to be represented in the user interface and also specify the conditions to determine which change requests to display.

1. Navigate to **Change > Schedules > Change Schedule Definitions** and click **New**.
2. On the form, fill in the fields.

Change Schedule Definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the change schedule.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to select if a schedule is active.</td>
</tr>
<tr>
<td>Changes</td>
<td></td>
</tr>
<tr>
<td>Start date field</td>
<td>Field from the change request form that determines the start date of the span.</td>
</tr>
<tr>
<td>End date field</td>
<td>Field from the change request form that determines the end date of the span.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions which determine which change requests display in the Change Schedule interface and the order in which those change requests are sorted.</td>
</tr>
</tbody>
</table>

Record Summary
### Field Summary

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Left column fields</strong></td>
<td>List of fields which appear on the left column of the record summary pop-up. The record summary pop-up appears when you click any span on the change schedule timeline.</td>
</tr>
<tr>
<td><strong>Right column fields</strong></td>
<td>List of fields that appear on the right of the window when you click any span on the change schedule timeline. The record summary pop-up appears when you click any span on the change schedule timeline.</td>
</tr>
<tr>
<td><strong>Blackout and Maintenance</strong></td>
<td></td>
</tr>
<tr>
<td>Show blackout window</td>
<td>Check box to select if blackout window associated to a change request appears in the change schedule timeline.</td>
</tr>
<tr>
<td>Blackout window color</td>
<td>Color to represent blackout window in the change schedule timeline.</td>
</tr>
<tr>
<td>Show maintenance window</td>
<td>Check box to select if maintenance window associated to a change request appears in the change schedule.</td>
</tr>
<tr>
<td>Maintenance window color</td>
<td>Color to represent maintenance window in the change schedule timeline.</td>
</tr>
<tr>
<td><strong>Sharing</strong></td>
<td></td>
</tr>
<tr>
<td>Share with</td>
<td>Option to share the schedule with everyone associated with the change or with specific users and groups.</td>
</tr>
<tr>
<td>Owner</td>
<td>Owner of the change schedule.</td>
</tr>
<tr>
<td>Group Owner</td>
<td>Group that owns a change schedule and has administrative rights to the change schedule.</td>
</tr>
<tr>
<td><strong>Related Link</strong></td>
<td></td>
</tr>
<tr>
<td>Show Schedule</td>
<td>Link to the change schedule that you have defined.</td>
</tr>
<tr>
<td>Related Lists</td>
<td></td>
</tr>
<tr>
<td>Related Definitions</td>
<td>Details of related child schedules</td>
</tr>
<tr>
<td><strong>Style Rules</strong></td>
<td>Options to define style conditions to determine the color of a span using a condition builder. For example, if you want all changes of type Emergency to show as a red span, a span style can be defined for that condition.</td>
</tr>
</tbody>
</table>

### 3. Click Submit.

### Add related tasks to a change schedule

Create related definitions to present related tasks for change requests in the change schedule. For example, to view the change tasks associated with a change request, you need to define a related definition. You can also add style rules specific to a related task.

- You have activated Change Management - Change Schedule plugin (com.snc.change_management.soc).
- Parent change schedule is defined.
- Role required: itil, sn_chg_soc.change_soc_admin, sn_change_role, sn_change_write roles, sn_change_write, or admin

1. Navigate to Schedules > Change Schedule Definitions.
2. In the related list, click the Related Definition tab.
3. On the form, fill in the fields.

**Related Definition form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the related definition.</td>
</tr>
<tr>
<td>Change schedule definition</td>
<td>Reference for the parent change schedule.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to select whether the child schedule is active.</td>
</tr>
</tbody>
</table>

**Related Records**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table name</td>
<td>Choice list to select the table on which the Related Definition is based.</td>
</tr>
<tr>
<td>Reference field</td>
<td>Reference the Related Definition is based on, for example, change request.</td>
</tr>
<tr>
<td>Start date field</td>
<td>Start date field from the related record.</td>
</tr>
<tr>
<td>End date field</td>
<td>End date field from the related record.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions included in the change schedule and the associated ordering of the conditions.</td>
</tr>
</tbody>
</table>

**Record Summary**

- Note: The record summary pop-up appears when you click any span on the change schedule timeline.

<table>
<thead>
<tr>
<th>Left column fields</th>
<th>List of fields that appear on the left column of the record summary pop-up. The record summary pop-up appears when you click any span on the change schedule timeline.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right column fields</td>
<td>List of fields that appear on the right column of the record summary pop-up. The record summary pop-up appears when you click any span on the change schedule timeline.</td>
</tr>
</tbody>
</table>

4. Click Submit.

**Style rules definition**

You can create a style span to specify the color for different events in a change schedule. Style spans in a schedule help to quickly identify characteristics of a change based on a field value from the Change Request.

Change Schedules includes several base styles to ensure every schedule has span styles to begin with. By default, Blackout Schedules are represented by a gray color, Maintenance schedules are represented by a light blue color and change requests are represented by either red (risk = High), orange (risk = moderate), or green (risk = low).
To define style rules, you must activate Change Management - Change Schedule plugin (com.snc.change_management.soc).

You can define styles in multiple ways, such as from the Default Style Rules, Change Schedule definitions, or from the Span Style window in the Change Schedule timeline.

**Note:** All style rule tables extend the Style Rule Core table (chg_soc_style_rule_core).

### Define default style rules

You can define style rules from the Default Style Rules module when you want the style rules to be used by change schedules globally and not for any specific application.

Role required: itil, sn_chg_soc.change_soc_admin, sn_change_role, sn_change_write roles, sn_change_write, or admin

1. Navigate to **Change > Schedule > Default Style Rules**.
2. On the Style Rule page, click **New**.
3. On the form, fill in the fields.

#### Style Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the style rule.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions which dictate the style rule. For example, risk = High = red.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to determine whether the style rule is active.</td>
</tr>
<tr>
<td>Styling</td>
<td></td>
</tr>
<tr>
<td>Advanced</td>
<td>Check box to write script to set the value of label color, label weight, and event color.</td>
</tr>
<tr>
<td></td>
<td>If you do not select the check box, the <strong>Label color</strong>, <strong>Label weight</strong>, and the <strong>Event color</strong> fields appear.</td>
</tr>
<tr>
<td>Label color</td>
<td>Color of the text that is displayed for each record on the timeline that matches the style rule.</td>
</tr>
<tr>
<td>Label weight</td>
<td>Thickness of the label such as normal or bold.</td>
</tr>
<tr>
<td>Event color</td>
<td>Color of the schedule span displayed for each record on the timeline that matches the style rule.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

### Define style rules from Change Schedule Definitions

You can define style rules from change schedule definitions when you want the style rules to be applied to the change schedule related to the change schedule definition.

Role required: itil, sn_chg_soc.change_soc_admin, sn_change_role, sn_change_write roles, sn_change_write, or admin

1. Navigate to **Change > Schedules > Change Schedule Definitions**.
2. Open the definition for which you want to define or edit a style rule.
3. Click the Style Rules related list and click **New**.
4. On the form, fill in the fields.

**Style Rule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the style rule.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions which dictate the style rule. For example, risk = High = red.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to determine whether the style rule is active.</td>
</tr>
<tr>
<td>Styling</td>
<td>Check box to write a script to set the value of label color, label weight, and event color. If you do not select the check box, the Label color, Label weight, and the Event color fields appear.</td>
</tr>
<tr>
<td>Label color</td>
<td>Color of the text that is displayed for each record on the timeline that matches the style rule.</td>
</tr>
<tr>
<td>Label weight</td>
<td>Thickness of the label such as normal or bold.</td>
</tr>
<tr>
<td>Event color</td>
<td>Color of the schedule span displayed for each record on the timeline that matches the style rule.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Note:** Style rules that you create from a change schedule definition take precedence over the style rules that exist in the base style rule table (chg_soc_style_rule).

**Define style rules from Change Schedules View**

You can create style rules from the change schedules view when you want the style rules to be applied to the specific change schedule where it is defined.

Role required: sn_chg_soc.change_soc_admin, sn_change_role, sn_change_write, or admin

1. Navigate to **Change > Schedule > Change Schedules**.
2. Click a tile to view the Change Schedule page.
3. Click the style icon ( ).
4. Do any one of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new span style</td>
<td>Click Add Span Style.</td>
</tr>
<tr>
<td>Edit the name of an existing span style</td>
<td>Click the name of the span style that you want to edit.</td>
</tr>
<tr>
<td>Edit all details of the span style</td>
<td>Click that appears to the right of the span style name and edit style rule name, span color, and filtering, as required.</td>
</tr>
</tbody>
</table>

5. Click **Save**.
Change success score

Change success score uses team’s historical data to provide an insight to the performance to make informed decisions.

Note: The Change success score feature is installed after you activate the Change Management - Change Success Score plugin that is available with the ITSM Professional subscription only. Please contact your account manager for more information.

Use the change success score to evaluate the team’s success in handling prior change requests.

The following are the key features offered by the change success score capability:

- The score is calculated daily based on the team’s performance from yesterday.
- The score value enables you to determine how likely the team is to complete your change request without issues.
- The change success score indicator allows you to adjust the multipliers.
- The Change Success Score Dashboard helps you to compare individual team scores.
- The change score enables approvers to take decisions on the change request.
# Change Success Score Card

## PROFILE

### Hardware

<table>
<thead>
<tr>
<th>Success Metric</th>
<th>Count</th>
<th>Delta</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total changes</td>
<td>229</td>
<td>▼6</td>
</tr>
<tr>
<td>Successful changes</td>
<td>194</td>
<td>▼6</td>
</tr>
<tr>
<td>Successful changes with issues</td>
<td>28</td>
<td>▲0</td>
</tr>
<tr>
<td>Unsuccessful changes</td>
<td>7</td>
<td>▲0</td>
</tr>
<tr>
<td>P1 incidents caused by change</td>
<td>5</td>
<td>▲0</td>
</tr>
<tr>
<td>P2 incidents caused by change</td>
<td>3</td>
<td>▲0</td>
</tr>
<tr>
<td>P3 incidents caused by change</td>
<td>2</td>
<td>▲0</td>
</tr>
</tbody>
</table>

**850 ▲0 Excellent**

Contact: hardware@example.com

IT department responsible for all hardware requests including installation and repair

[View change history details](#)
You can use the Change Success Score only after you activate the Change Management - Change Success Score (com.snc.change_management.change_success_score) plugin that automatically installs the Change Management - Change Success Score Foundation (com.snc.change_management.change_success_score.foundation) plugin.

When the Change Management - Change Success Score plugin is activated, a Change success score metrics (Daily) performance analytic (PA) job is added. The PA job is a daily job that collects the first set of change success scores until the next job run time, that is 02.00 UTC. After the first job run, a Change Success Score card icon appears next to the Assignment group field on the change request form. On click of this icon, you can view the score card details of the assignment group.
### Change Success Score dashboard

Use this dashboard to see the trends in the resolution efficiency of the team over time based on the same parameters used to calculate overall score. To view the trends of all the assignment groups, clear the selected element.
### Change Success Score

<table>
<thead>
<tr>
<th>Date</th>
<th>Total Changes (last 30 days)</th>
<th>Successful Changes (last 30 days)</th>
<th>Successful Changes with Issues (last 30 days)</th>
<th>Unsuccessful Changes (last 30 days)</th>
</tr>
</thead>
<tbody>
<tr>
<td>May 25</td>
<td>386</td>
<td>229</td>
<td>123</td>
<td>34</td>
</tr>
</tbody>
</table>

**Change success score:**

- **May 25:** 691
- **Total changes:** 386
- **Successful changes:** 229
- **Successful changes with issues:** 123
- **Unsuccessful changes:** 34

**Percentage:**

- **% Successful changes:** 57.3%
- **% Successful with issues changes:** 35.1%
- **% Unsuccessful changes:** 7.6%
For more information on the indicators, see *Success score indicators*.

**Success score indicators**

Change Success score contains Performance Analytics indicators for data collection. Indicators define a performance measurement taken at regular intervals of a business service, an activity, or organizational behavior. These performance measurements result in a series of indicator scores over time.

The following are the Change Success Score indicators that are used to collect data daily for the changes completed on the previous day.

**Total Changes**
The total number of change requests addressed during the time.

**Successful changes**
The number of successfully resolved change requests.

**Unsuccessful changes**
The number of change requests that was not resolved.

**Successful changes with issues**
The number of change requests that was resolved, but had other defects that were not addressed.

**P1 incidents caused by change**
The total number of P1 incidents that were reported as caused by one of the changes completed by the team.

**P2 incidents caused by change**
The total number of P2 incidents that were reported as caused by one of the changes completed by the team.

**P3 incidents caused by change**
The total number of P3 incidents that were reported as caused by one of the changes completed by the team.

For more information on the PA indicators, see *Performance Analytics indicators*.

**Success score calculation**

To calculate the success score, formula indicators are provided. These indicators apply the multiplication operation to the data collected by the automated indicators to arrive at the final score.

You can view the Change success score formula indicators in Performance Analytics under the indicator group *Change success score - multipliers*.

Review the following table to understand the default multipliers used in success score calculation.

<table>
<thead>
<tr>
<th>Automated indicator</th>
<th>Multiplier applied by formula indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Successful changes</td>
<td>3</td>
</tr>
<tr>
<td>Successful changes with issues</td>
<td>-2</td>
</tr>
<tr>
<td>Automated indicator</td>
<td>Multiplier applied by formula indicator</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Unsuccessful changes</td>
<td>-5</td>
</tr>
<tr>
<td>P1 incident caused by change</td>
<td>-10</td>
</tr>
<tr>
<td>P2 incident caused by change</td>
<td>-5</td>
</tr>
<tr>
<td>P3 incident caused by change</td>
<td>-2</td>
</tr>
</tbody>
</table>

**Modify score calculation**

Modify the multiplier values in the formula indicators to calculate the final success score.

Role required: admin

1. Navigate to **Performance Analytics > Indicator Groups > Change success score - multipliers**.
2. Open the indicator that you want to modify.
3. In the formula, change the multiplier value.
Indicator - Change success score PI Incidents caused by change Multiplier (Formula View)

Add Indicator Groups

Change success score

Change success score - multipliers

**Name**: Change success score PI Incidents caused by change Multiplier

**Description**:

**Indicator properties**

Specify the indicator properties for this formula indicator.

**Direction**: Minimize

**Unit**: %

**Precision**: 0

**Key**: 0

**Formula**

Specify the formula. Use "browse for an indicator" link to pick indicators.

Formula:

\[ \text{[PI Incidents caused by change, Yesterday]} \times -30 \]
4. Click Update.

**Success score rating**

Based on the change success score rating, a color and text is associated that is displayed as part of the Change Success Score card. By default, four success score ratings are available with a specific score range.

Role required: admin

The following default ratings available.

- Low
- Medium
- High
- Excellent

Each rating is associated with a default range and color.

The Change Success Score Ratings table is used to hold the records of the text and a color associated with the success score range.

You can choose to modify the score range, color, introduce, or modify new rating values. The values defined here can be viewed in the **Change Success Score card** on the change Request form.

1. Navigate to **Change > Administration > Change Success Score Ratings**.
2. Perform the given action based on your requirements.
### Action

<table>
<thead>
<tr>
<th>Action</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add a new score range</td>
<td>Click <strong>New</strong> and fill in the range details and the color you want to associate and submit.</td>
</tr>
<tr>
<td>To modify the existing range</td>
<td>Open the rating, and click the <strong>here</strong> link in the record information message to modify the values.</td>
</tr>
</tbody>
</table>

3. Click **Update**.

### Analyze change request risk and impact

After you create a change request, you can assess and analyze the risk and impact involved in the change request. You can review any conflicts that are detected by reviewing the change request.

Analyze the risk of change and review detected conflicts in the following ways.

#### Risk conditions and calculation

Change Management features provide ways to calculate and assess the risk of change requests, and to identify and resolve conflicts.

Risk assessment and calculation assists you with understanding the urgency and impact of change requests. **Conflict detection** assists you with scheduling change requests for the least impact to stakeholders. This feature minimizes the risk and cost of rapid changes in your environment.

#### Risk Calculator property

The Best Practice - Change Risk Calculator plugin enables dynamic calculations of the risk and impact of a change. The administrator specifies how and when risk and impact rules are applied.

The Best Practice - Change Risk Calculator plugin bundles some risk calculations using configuration item (CI) attributes and time measures.

A change management system property determines the risk calculation method. In **Change > Administration > Change Properties**, the administrator selects one of the following methods.

**Change Risk calculation method**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| UI Action | Enables users to click the **Calculate Risk** related link to check condition rules on demand.  
This UI action applies matching conditions according to their order. Each time a rule is applied, an alert is displayed confirming the new values for risk and impact.  
The **Calculate Risk** related link appears on the Change Request form only if the following statements are true.  
- There are risk and impact conditions that apply to the current change record.  
- The user has the admin or the itil role. |
### Add or modify risk and impact conditions

You can define risk calculation rules on which the risk and impact of a change are calculated. Best Practice - Change Risk Calculator is activated by default in the base system.

**Role required:** itil_admin or admin

Risk Conditions are run against the change request based on their **Order** field from lowest to highest. The first Risk Condition that matches the change request record is applied. All subsequent risk conditions are then ignored whether they match or not. A risk calculation rule is defined with two elements:

- Conditions that can evaluate to *true* or *false*. You can use a condition builder or write a script.
- **Risk** and **Impact** field value settings when the conditions evaluate to *true*.

1. Navigate to **Change > Administration > Risk Conditions**.
2. Click **New**, or click the risk condition to modify.
   You can also edit risk conditions from within the Change Request form by opening the form context menu and clicking **Edit Risk Conditions**.
3. Complete or update the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Enter a descriptive name for the rule</td>
</tr>
<tr>
<td><strong>Risk</strong></td>
<td>Select a value for one of these fields. The selection determines which field to update based on this risk calculation.</td>
</tr>
<tr>
<td><strong>Impact</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Select the check box to use the rule.</td>
</tr>
<tr>
<td><strong>Order</strong></td>
<td>Enter the order in which this risk calculation is evaluated. Rules with lower numbers are evaluated first. If there are two or more rules with differing orders, the rule with the lowest order is evaluated and the others are ignored.</td>
</tr>
<tr>
<td><strong>Use advanced condition</strong></td>
<td>Select the check box to enter a script instead of using the condition builder.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use script values</td>
<td>Select the check box to hide the <strong>Risk</strong> and <strong>Impact</strong> fields. The script specifies the risk and impact values.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of how this risk calculation is applied.</td>
</tr>
</tbody>
</table>

4. Specify the rule based on your selected rule method.

<table>
<thead>
<tr>
<th>Choice</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Condition</strong></td>
<td>Use the condition builder to add conditions. It is hidden if you selected <strong>Use advanced conditions</strong>.</td>
</tr>
<tr>
<td><strong>Use advanced conditions</strong></td>
<td>Write the script in the <strong>Advanced condition</strong> field using standard business rule syntax. The condition must set the global variable answer to <strong>true</strong> or <strong>false</strong>.</td>
</tr>
<tr>
<td><strong>Use script values</strong></td>
<td>Write the script in the <strong>Script values</strong> field. Specify the <strong>Risk</strong> and <strong>Impact</strong> values in the script. The conditions are set using either the condition builder or an advanced condition script.</td>
</tr>
</tbody>
</table>

In the following example, the **Advanced condition** script first determines whether the CI is a business service. If so, the script identifies whether the **Business criticality** value is **1 - most critical** or **2 - somewhat critical**. If it does, it sets the global variable answer to **true**.
## Critical service changed

**Name**: Critical service changed  
**Application**: Global  
**Active**: ✔️  
**Order**: 200  
**Use advanced condition**: ✔️  
**Use script values**: ✔️  

**Description**

Change is for a highly critical or somewhat critical business service.

**Advanced condition**

```plaintext
1
2   answer = false;
3   if ((current.cmdb_ci.sys_class_name == 'cmdb_ci_service') {
4       var serv = new GlideRecord('cmdb_ci_service');
5       serv.get(current.cmdb_ci);
6       if (serv.business_criticality == "1 - most critical" ||
7             serv.business_criticality == "2 - somewhat critical")
8           answer = true;
9   }
```

**Script values**

```plaintext
if (serv.business_criticality == "1 - most critical") {
    current.impact = 1;
    current.risk = 2;
}
if (serv.business_criticality == "2 - somewhat critical") {
    current.impact = 2;
    current.risk = 3;
```
When the **Advanced condition** script returns `true`, the script in the **Script values** field sets the change request **Impact** and **Risk** values based on the **Business criticality** value.

**Risk assessment**

There are two methods to calculate the risk of a change. The Best Practice - Change Risk Calculator is activated in the base system by default. Change Management - Risk Assessment is optional.

- Change Risk Calculator uses predefined properties and conditions to calculate a risk value.
- Change Management - Risk Assessment uses information provided by the end user to assess a risk value.

The two methods can be used individually or together, depending on your requirements. If the methods are used together, the highest risk value from both methods is always selected.

**Risk assessment and calculation**

**Note:** If both Risk Assessment and Risk Calculator are active but you want to use only one method, remove conditions for the method you do not want to use.

If you activate Change Management - Risk Assessment, the administrator can add the **Task Assessment > Task** related list to the change request form, if necessary. The related list displays risk assessments associated with the change request.

**Define risk assessments**

Change Management - Risk Assessment provides a flexible way to capture information from the end user to calculate the risk of the associated change request. You can define the risk assessment questions, thresholds, and conditions that calculate risk for any change request. **Change Management - Risk Assessment** must be activated.

Role required: itil_admin

You can use a series of questions to capture the risk of a change. A different assessment of the questionnaire can be defined on the change record. The assessment uses a weighted score.
approach for each question. The composite weighted score derived from the answer of the end user is used to calculate risk. This score is based on the thresholds associated with the risk assessment.

Change Risk Assessment is an application built on Survey and Assessment V2 architecture. While it's possible to configure multiple metric categories on this architecture, it is better not to do so to avoid errors.

You can configure multiple change Risk Assessment definitions each with one Metric Category, where the Metric Category filter is identical to the filter of the change Risk Assessment condition.

1. Navigate to Change > Administration > Risk Assessments.
2. Click New.
3. Complete the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the risk assessment. This name is displayed to the end user.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the assessment: Draft or Published.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the risk assessment.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions which determines if a risk assessment is attached to the change. Typically, the first attachment that matches the conditions gets attached during evaluation. Therefore, ensure that the conditions result in the correct assessments being attached especially when defining multiple questionnaires.</td>
</tr>
</tbody>
</table>

Note: Ensure that the conditions are simple and mutually exclusive so that the assessment conditions are easy to understand and maintain.

4. Click the form context menu and select Save.
The page refreshes with the Assessment Categories and Assessment Thresholds related lists. The Assessment Categories related list enables you to define the questions that the end user answers to assess the risk of a change request.

5. Complete the following steps to create an assessment question.
   a) In the Assessment Categories related list, click New.
   b) Complete the form, as appropriate.

<table>
<thead>
<tr>
<th>Metric category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the assessment category.</td>
</tr>
<tr>
<td>Create Stakeholders</td>
<td>If selected, automatically creates stakeholders for all assessable records linked to this category.</td>
</tr>
<tr>
<td>Weight</td>
<td>Value that represents importance of this category relative to other categories. The weight is multiplied to the score of the answer to calculate the weighted score.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Filter</td>
<td>Only assessable records that meet filter conditions are evaluated by metrics in this category.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the assessment category.</td>
</tr>
</tbody>
</table>

c) Click **Submit**.
d) Open the assessment category.
e) In the related list, click **Assessment Metrics**.
f) Complete the form, as appropriate.

## Assessment metrics

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the assessment metric.</td>
</tr>
<tr>
<td>Category</td>
<td>The category of the assessment metric.</td>
</tr>
<tr>
<td>Method</td>
<td>The method of gathering data for this metric.</td>
</tr>
<tr>
<td>Weight</td>
<td>Value that represents importance of this metric relative to other metrics. The weight is multiplied to the score of the answer to calculate the weighted score.</td>
</tr>
<tr>
<td>Order</td>
<td>Order of the question in the assessment.</td>
</tr>
<tr>
<td>Active</td>
<td>If selected, the metric is activated to be used for assessments and result calculations.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>If selected, makes a field mandatory in an assessment.</td>
</tr>
<tr>
<td>Question</td>
<td>Question that is displayed on the assessment.</td>
</tr>
<tr>
<td>Description</td>
<td>Tool tip text for the assessment.</td>
</tr>
<tr>
<td>Depends on</td>
<td>The condition that determines whether the metric is shown to the user or not.</td>
</tr>
<tr>
<td>Allow Additional Information</td>
<td>If selected, a text box appears for the user to enter additional information for the question.</td>
</tr>
<tr>
<td>Field Type</td>
<td>The data type of the answer that is given by a user for a question.</td>
</tr>
</tbody>
</table>

Note: Depending on the data type that you select, additional fields may appear.

g) Click **Submit**.

h) In the **Assessment Threshold** related list, click **New**.
i) Complete the form, as appropriate.
Change risk assessment threshold

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk Assessment</td>
<td>The assessment name for which assessment threshold is applied.</td>
</tr>
<tr>
<td>Risk</td>
<td>Risk value applied on the change request.</td>
</tr>
<tr>
<td>Application</td>
<td>The name of the application that contains the record.</td>
</tr>
<tr>
<td>Score greater than</td>
<td>The threshold against which the composite score is compared and evaluated.</td>
</tr>
</tbody>
</table>

| Note: Risk value can be overridden by risk conditions. |

j) Click Submit.

Note: You can create or edit the assessment questionnaire through the Assessment Designer module or by clicking Edit in Assessment Designer related link.

For example, after you define the risk assessment, this is how the risk assessment score is calculated and set.

- **asmt_metric_result** stores the score set.
- The weight is calculated as \( \text{sum} (\text{asmt_metric_result}.\text{normalized_value}) \) where \( \text{asmt_metric_result}.\text{normalized_value} = \text{actual_value} \times \text{weight} \).
- The risk calculated as \( \text{sum}(\text{actual_value} \times \text{weight}) > \text{threshold} \). For example, if the result is 7 and moderate threshold is 6 risk is moderate.

Perform risk assessment

You can perform risk assessment of existing change requests after the risk assessment criteria are defined. After assessing the risk, you can view the risk assessment responses in the change request.

Role required: itil, sn_change_write, or admin

Verify that the **Risk Assessment** related list is configured on the Change Request form. If it is not configured, an administrator can add the **Task Assessment > Task** related list.

The **Risk Assessment** related link is available only when the change request meets the risk assessment condition and risk assessment category condition, the change request type is **Normal** or **Emergency**, and the **State** is **New**, **Assess**, or **Authorized**. On clicking the **Risk Assessment** related link, the Change Risk Assessment form appears if you have not assessed the risk for this change request before. When you submit the form, these three things appear at the top of the change request form:

- **Risk assessment evaluated**: The estimation of risk after it is assessed against the Change Risk Assessment form and the criteria set for assessment for the change request.
- **Risk Condition applied**: The result of the risk calculated against pre-defined risk conditions.
- **Risk set to**: The final weight of risk based on risk assessment and risk calculation.
1. Open a change request.
2. Click the Risk Assessment related link. The Change Risk Assessment form appears.
3. Answer the questions and click Submit. After submitting the risk assessment, click the Risk Calculation related link to calculate the risk. The result of risk assessment, risk calculation, and the value that appears in the Risk field of the change request form appears.

Risk calculation results

Users with survey_admin or survey_reader role can navigate to Legacy Surveys > Survey Responses and filter by Instance. Survey instances are individual assessments distinguished by the date and time when they are taken.

Legacy change risk assessment migration

Users can migrate legacy change risk assessments to versions compatible with the new Change Risk Assessment table schema and logic.

Role required: itil_admin

Few points to remember:
- Customers with Change Management - Risk Assessment (Legacy) (com.snc.change.risk_assessment) plugin already installed on their instances should only follow this task.
- The Change Management - Risk Assessment (Legacy) (com.snc.change.risk_assessment) plugin cannot be installed for customers who are on Kingston and later releases.
- Migration guidance and best practice suggests that the migration should be performed on a development instance and not on a production instance.
- The development instance must have the new Change Management - Risk Assessment (com.snc.change_management.risk_assessment) plugin installed.
- All migration work must be captured in an update set, moved to a test instance, and then tested before moving them to a production instance.

The following legacy risk assessment components are migrated:
- Risk assessment definition, questions, and question choices.
For multiple assessment conditions, the migration might result in the following one or more than one risk assessment records:

- If all the multiple assessment conditions are on the same table, then the migration results in only one risk assessment.
- If the multiple assessment conditions are on different tables, then the migration creates as many risk assessments as they pertain to different tables.

1. Create an update set and set it as the current set. For more information, see ..Create and select an update set as the current set
2. Navigate to Change > Risk Assessment (legacy).
3. Open the legacy risk assessment that you want to migrate to a change risk assessment.
4. Click the Migrate to Risk Assessment related link.
   A message window appears stating that the assessment is migrated to a new change risk assessment.
   
   **Note:** Migrating legacy risk assessment to a new change risk assessment does not modify the existing legacy assessment records.

5. Click OK.
6. Repeat steps 4-5 for all the legacy risk assessment to be migrated.

After all the legacy risk assessments are migrated, reach out to the support team to run the following scripts:

```javascript
disable_legacy_change_risk_assessment.js
```

Capture the results in the update set created and later mark the update set as closed complete. For more information, see ..Mark an update set complete

**Note:** The given procedure is a suggested practice. Alternatively, you can capture each migrated Change Risk Assessment in their own update set. You can also capture the results of disabling of the Change Management - Risk Assessment (Legacy) using `disable_legacy_change_risk_assessment.js` in a separate update set.

**Migrated risk assessment components**

When you migrate a change risk assessment, the system maps records from legacy risk assessment to the new risk assessment tables.

To create a functional risk assessment on the assessment framework, the system converts risk assessment records to the most logical equivalent assessment risk records. This may mean multiple assessment risk records are created from one legacy risk record.

**Migrated components**

<table>
<thead>
<tr>
<th>Risk assessment components</th>
<th>Change risk assessment components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment Master (assessment_master)</td>
<td>Change Risk Assessment (change_risk_asmt)</td>
</tr>
<tr>
<td>Assessment Question (assessment_question)</td>
<td>Assessment category (asmt_metric_category)</td>
</tr>
<tr>
<td></td>
<td>Assessment Metric (asmt_metric)</td>
</tr>
</tbody>
</table>
Conflict detection

Conflict detection identifies potential scheduling conflicts for a change request based on the configuration items (CIs), planned start date, and the planned end date in scope for the change. If a scheduling conflict exists, conflict detection also checks any related blackout or maintenance schedules and other active change requests to determine the scheduling conflict.

Conflict detection identifies conflicts for any of the following reasons:

- The CIs are already scheduled at the given date and time.
- A parent of the CI is already scheduled at the given date and time.
- A child of the CI is already scheduled at the given date and time.
- The CI is not in the maintenance window.
- A parent of the CI is not in the maintenance window.
- A child of the CI is not in the maintenance window.
- The CI is in a blackout window.
- A parent of the CI is in a blackout window.
- A child of the CI is in a blackout window.
- The assigned to person is already scheduled at the given date and time.

If conflicts are identified, the Conflict status field is updated to reflect a conflict and an error message directs you to the Conflict form section of the Change request record to review conflicts. When you create a change request and provide a CI, planned start date, and planned end date, or update any of these values, conflict detection is executed automatically.

You can choose to show or hide the conflict error message by using the Enable/Disable Scheduling Conflict Message menu item from the context menu. As an admin, you can configure the message display setting using the change.conflict.show_conflict_message property. For more information on the property, see Conflict analysis properties.

You can manually execute conflict detection. For more information, see Detect conflicts manually and review conflict details.

The Conflicts form section lists specific conflict details including the type of conflict, conflicting schedule, or conflicting change request. If a conflict must be resolved before requesting approval, modify the Planned start date and Planned end date fields in the Schedule form section.

Conflict Calendar

You can also use the Conflict Calendar to visually display any scheduling conflicts identified. To reschedule the change request, click the change request record or drag the change request to another time within the calendar.
Configure conflict analysis properties

Configure Change Management conflict analysis properties to detect change conflicts. Use the relevant information to calculate conflicts for change requests and review and modify the change to eliminate conflicts.

Role required: admin

By default, not all properties are selected in the Change Management Conflict Analysis Properties page. Modify or customize conflict detection capabilities to meet the needs of your organization.

1. Navigate to Change > Administration > Conflict Properties.
2. In the Change Management Conflict Analysis Properties page, enter the roles that have access to the conflict detection feature.
3. Configure the remaining customization properties as required.
4. Click Save.

Conflict analysis properties

Conflict detection includes properties that determine how the conflict detection capability is executed. Identify conflicts based on the selected properties and the roles that have access to the feature.

These properties are available by navigating to Change > Administration > Conflict Properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A comma separated list of roles which have access to the conflict detection feature. Roles included here should have access to the underlying change_request record</td>
<td>change.conflict.role</td>
<td>The roles are entered exactly as they appear in User Administration &gt; Roles. For example, enter itil.</td>
</tr>
<tr>
<td>When checking for change request conflicts, check against blackout windows</td>
<td>change.conflict.blackout</td>
<td>To check if the change request falls within the blackout window, select Yes.</td>
</tr>
<tr>
<td>When checking change request conflicts, check whether the change falls within the child CIs' blackout window</td>
<td>change.conflict.relatedchildblackout</td>
<td>To check if the change request of any of the child configuration items (CIs) falls within the blackout window, select Yes.</td>
</tr>
<tr>
<td>When checking change request conflicts, check whether the change falls within the parent CIs' blackout window</td>
<td>change.conflict.relatedparentblackout</td>
<td>To check if the change request of the parent CI falls within the blackout window, select Yes.</td>
</tr>
<tr>
<td>When checking change request conflicts, check against changes already scheduled for the same CI</td>
<td>change.conflict.currentci</td>
<td>To check if the change request is already scheduled against the given CI, select Yes.</td>
</tr>
<tr>
<td>Property</td>
<td>Property name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>When checking change request conflicts, check whether the change falls</td>
<td><code>change.conflict.currentwindow</code></td>
<td>To check if the change request of the CI falls within the maintenance window, select Yes.</td>
</tr>
<tr>
<td>within the CIs' maintenance window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>When checking change request conflicts, check whether the change falls</td>
<td><code>change.conflict.relatedchildwindow</code></td>
<td>To check if the change request of any of the child CIs falls within the maintenance window, select Yes.</td>
</tr>
<tr>
<td>within child CIs' maintenance window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>When checking change request conflicts, check whether the change falls</td>
<td><code>change.conflict.relatedparentwindow</code></td>
<td>To check if the change request of the parent CI falls within the maintenance window, select Yes.</td>
</tr>
<tr>
<td>within parent CIs' maintenance window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>When checking change request conflicts, check whether the change falls</td>
<td><code>change.conflict.ci_maint_sched</code></td>
<td>To check if the change request falls within the scheduled maintenance defined for the CI in the maintenance schedule reference field, select Yes.</td>
</tr>
<tr>
<td>within the schedule defined in the maintenance schedule reference field on the CI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>When checking change request conflicts, check whether the change falls</td>
<td><code>change.conflict.relatedservices</code></td>
<td>To check if the change request that falls within the maintenance or blackout windows affects other related application services, such as the services created that include the CI scheduled for change or any other CI within that service, select Yes.</td>
</tr>
<tr>
<td>within maintenance or blackout windows affecting related Application Services</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** This action requires any business services identified to be converted to an application service. For more information, see Convert an individual business service to an application service. For information about application services, see Application services.
<table>
<thead>
<tr>
<th>Property</th>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When checking change request conflicts, check whether other change requests are already scheduled for the same assigned to user</td>
<td>change.conflict.assigned_to</td>
<td>To check if any other change request is assigned to the same change request assigned to a user. For example, if you assign a change request to a user who is already scheduled to implement another change request at that date and time, a conflict error is displayed, select Yes.</td>
</tr>
<tr>
<td>CI conflict check mode. Basic mode only checks the change requests CI. Advanced mode checks the entire Affected CIs related list (the change's CI will be automatically added to the related list)</td>
<td>change.conflict.mode</td>
<td>To check the conflict mode for a CI, select the appropriate CI conflict mode.</td>
</tr>
<tr>
<td>Run conflict detection automatically after changes to Configuration item, Planned start date, Planned end date or State when a change request is updated</td>
<td>change.conflict.refresh.conflicts</td>
<td>To refresh and run conflict detection automatically when any of the following field values are changed, select Yes.</td>
</tr>
<tr>
<td>Enable the scheduled change conflict checker</td>
<td>change.conflict.refresh.scheduled</td>
<td>To enable the schedule change conflict checker, select Yes.</td>
</tr>
<tr>
<td>Automatically include business or application services related to CIs with conflicts in the Impacted CI related list</td>
<td>change.conflict.populateimpactedcis</td>
<td>To automatically include and list all the business and application services with related CIs that have conflicts, select Yes.</td>
</tr>
<tr>
<td>Property</td>
<td>Property name</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Identify the most critical business or application service affected when a conflict is detected against a supporting configuration item</td>
<td><code>change.conflict.identifymostcritical</code></td>
<td>To identify the most affected business or application services that have a related conflicting CI, select Yes.</td>
</tr>
</tbody>
</table>
| Define the number of days to be factored after the respective Planned start/end date of a Change record when searching for the next available time. This window is used to find all potentially conflicting Changes, the larger the window, the more Changes that need to be factored per search. Default value is 90 days; the value must be a positive integer. | `change.conflict.next_available.schedule_window` | From the scheduled planned start date or end date of the change request to find the next available time, enter the number of days.  
- Type: Integer  
- The default value is 90 |
| Define the number of suggestions to be calculated for the next available time field on a Change. The greater the value, the more time taken to calculate the next available times to implement the change. Default value is 25 suggestions; the value must be a positive integer. | `change.conflict.next_available.choice_limit` | Enter the number of suggestions to calculate and display for the next available time.  
- Type: Integer  
- The default value is 25 |
| Logging level for ChangeCheckConflict (default: Notice) | `change.conflict.log` | Select any of the logging levels for the change conflict.  
- Emergency  
- Alert  
- Critical  
- Error  
- Warning  
- Notice  
- Info  
- Debug  
The default level is Notice. |
| Handle contiguous change request that has overlapping schedules that results in conflicts. | `change.conflict.allow_contiguous_changes` | The property is enabled by default. |
Create blackout and maintenance schedules in Change Management

Use the Blackout and Maintenance windows to schedule a change. Blackout windows specify times during which normal change activity should not be scheduled. Maintenance windows specify times during which change requests should be scheduled. For example, create a blackout schedule for code freezes at the end of the year.

Ensure that the Change Management - Collision Detector (com.snc.change.collision) plugin is activated.

Role required: itil_admin or admin

Conflict detection uses blackout and maintenance schedules to find potential scheduling conflicts for the configuration items (CIs) associated with a change request. When conflict detection runs, either automatically or by manual request, conflict detection determines if either type of defined schedule applies to the change request. If a potential conflict is identified, a warning message appears and conflicts are listed within the Conflict form section. View conflicts in the Conflict calendar.

Note: To use the business service as the source for a blackout or maintenance schedule, the business service must be converted to an application service. For instructions, see
Convert an individual business service to an application service. For information about application services, see Application services.

1. Create a blackout or maintenance schedule.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a blackout schedule</td>
<td>1. Navigate to Change &gt; Schedules &gt; Blackout Schedules.</td>
</tr>
<tr>
<td></td>
<td>2. Click New.</td>
</tr>
<tr>
<td>Create a maintenance schedule</td>
<td>1. Navigate to Change &gt; Schedules &gt; Maintenance Schedules.</td>
</tr>
<tr>
<td></td>
<td>2. Click New.</td>
</tr>
</tbody>
</table>

2. On the form, fill in the fields.

**Blackout and Maintenance schedule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the schedule.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description about the schedule.</td>
</tr>
<tr>
<td>Time zone</td>
<td>The time zone for the schedule.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Floating</strong> to evaluate planned start and end dates on the change request form for the logged-in user.</td>
</tr>
<tr>
<td>Source</td>
<td>The source of the blackout or maintenance schedule. The available options are Service, Change Request, and CI Class.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When you select <strong>Service</strong> or <strong>Change Request</strong> from the Source list, the <strong>Applies to</strong> field does not appear. The <strong>Applies to</strong> field appears if you select CI Class as the Source, which in turn allows the selection of a CI Class.</td>
</tr>
<tr>
<td>Applies to</td>
<td>The CI classification that the conflict detection is filtered on.</td>
</tr>
<tr>
<td>Condition</td>
<td>The conditions to specify the CIs that the schedule applies to.</td>
</tr>
<tr>
<td></td>
<td>This field does not appear when the <strong>Applies to</strong> field is set to None.</td>
</tr>
</tbody>
</table>

| Note: Related fields used in conditions are not evaluated for blackout or maintenance schedules. |

3. Open the form context menu and click **Save**.
A blackout or maintenance schedule is created and the Schedule Entries, Child Schedules, and Referenced By related lists appear in the change.

**Note:**
The Blackout Schedule (cmn_schedule_blackout) table extends the Condition Schedule (cmn_schedule_condition) table, which in turn extends the Schedule (cmn_schedule) table. The Blackout Schedule table inherits the domain properties from the Schedule table which has the Domain and Domain path columns. Because the Blackout schedule table uses the same Child Schedule and Schedule Entry tables as the Schedule table uses, the domain support is identical; the domain_master attribute is used to derive the domain from a parent record. For more information, see Domain support for schedules.

4. Create one or more schedule entries by completing the following steps:
   a) In the Schedule Entries related list of the new maintenance schedule, click **New**.
   b) Enter a unique name and define the time during which you want to schedule the maintenance.
      For more information about the schedule entries field, see Schedule entry fields.

A blackout or maintenance schedule is created.

Associate the configuration item with the maintenance schedule that is used in the change request.

**Assign a maintenance schedule to configuration items**

You can review and determine the conflicts in a change schedule by assigning the maintenance schedules to configuration items (CI). After you assign a maintenance schedules to the CI, add the CI to the change request.

Role required: itil

When the configuration item with an assigned maintenance schedule is used in the change request, the conflict detection determines the schedule change outside the maintenance window and displays a conflict error message.

1. Navigate to **Configuration > Application Servers**.
2. From the list of servers, select the server that you want to add the maintenance schedule to.

   **Note:** If you don't see the Maintenance schedule field on the record, click the personalize list icon ( ) and modify the Personalize List settings to add this field.

3. Double-click the Maintenance schedule field and use the search icon to select a schedule and assign it to the server.

The selected maintenance schedule is assigned to the server.
Configure a change request to monitor outside maintenance schedule conflicts

When a change request is configured to display the conflicts that are outside the maintenance schedule, conflict detection indicates whether the planned start and end dates occur outside the maintenance window or not. By reviewing the conflicts that are detected, you can modify the change schedule.

Role required: personalize_ui or admin

The Outside maintenance schedule check box is informational and the instance sets this value and disregards any changes that you make to this check box. The check box is selected by default if either of the following actions occur.

- The planned start and end dates in the change request with an associated configuration item (CI) are compared to the maintenance schedule and are determined to be outside the schedule.
- Affected CIs associated with the change request are checked against their assigned maintenance schedules, if any.

**Note:** Only the maintenance window for the primary CI or affected CIs is checked; the upstream and downstream items are not checked.

1. Navigate to Change > Open and select an existing change request.
2. If the Outside maintenance schedule field does not appear, add the field to the form.
   a) Click the context menu icon and then click Additional actions > Configure > Form Layout.
   b) Move Outside maintenance schedule to the Selected list.
   c) Click Save.

When you save a change request that is outside the maintenance schedule, a warning appears for each item (primary or affected). This warning also displays the planned dates that fall outside the maintenance window.

**Conflict calendar**

The conflict calendar graphically represents the potential scheduling conflicts for a change request. Conflicts are identified as active change requests, blackout schedules, and changes scheduled outside maintenance schedules. Use the Scheduling Assistant to resolve any schedule conflicts.
Conflict calendar

<table>
<thead>
<tr>
<th>SI #</th>
<th>UI Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>View Form</td>
<td>Returns you to the Change Request form.</td>
</tr>
<tr>
<td>2</td>
<td>Calendar</td>
<td>Enables you to choose a date. When you select a date, you can view the schedule details of that day.</td>
</tr>
<tr>
<td>3</td>
<td>Current day or month</td>
<td>Enables you to view the schedule of the current day or month when you click Today.</td>
</tr>
<tr>
<td>4</td>
<td>Navigating dates</td>
<td>Enables you to navigate to the previous day, the next day, or month, depending on the view type when you click the arrow buttons.</td>
</tr>
<tr>
<td>5</td>
<td>Scheduling Assistant</td>
<td>Enables you to choose from the list of available time slots to resolve conflicts. For more information on resolving conflicts, see Manage your change schedules and resolve conflicts.</td>
</tr>
<tr>
<td>SI #</td>
<td>UI Component</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>6</td>
<td>Day or Month view</td>
<td>Enables you to change the calendar view to a day view or month view.</td>
</tr>
<tr>
<td>7</td>
<td>Keyboard Shortcuts</td>
<td>Provides you with keyboard shortcuts for quick navigation.</td>
</tr>
<tr>
<td>8</td>
<td>Options</td>
<td>Enables you to control the view of the calendar, customize settings, or set the configuration filters using the Settings tab and the Configuration tab. From the configuration filters you can select and display the Assigned to, Assignment group, Configuration item, or Show all options in the Related Changes section. This section has the same value of the option selected for the current change.</td>
</tr>
<tr>
<td>9</td>
<td>Change request block</td>
<td>Enables you to view the details of the change request.</td>
</tr>
<tr>
<td>10</td>
<td>Related Changes</td>
<td>Helps you to detect other scheduled changes that potentially conflict with the change based on a schedule or assignment. For example, if the same person is assigned to two or more changes at the same date and time, you can visually see the conflict and update one of the scheduled changes, as appropriate.</td>
</tr>
</tbody>
</table>

### Manage your change schedules and resolve conflicts

Prevent schedule conflicts by using the conflict calendar to manage your change schedule details, customize views, and resolve conflicts.

Role required: admin

**Note:** Users with the admin role must activate the Change Request Calendar (com.snc.change_request_calendar) plugin for the Conflict Calendar button to appear.

When there is a conflict, you can use Scheduling Assistant link in the change form to find the next available slot.
When there are no available slots for the next 90 days, then an actionable message is displayed with the reason why the assistant was not able to find a slot.

No availability found, try again.

There is no availability for 90 days from May 8, 2020
Reason: No common windows found between the related maintenance schedules
Review change request conflicts or search for availability between August 6, 2020 and November 4, 2020

Cancel

Search
Alternatively, you can resolve conflicts by moving the change request to be within a maintenance window in the conflict calendar. The Conflict Calendar button appears in the header of the change form once the Planned start date, Planned end date, and the Configuration items fields are added and the record is saved.

1. Navigate to Change > Open.
2. Open your required change request.
3. Click Conflict Calendar.
4. Click Scheduling Assistant. 
   The scheduling assistant dialog box displays the next available times to choose to resolve the conflict. The number of days factored after the planned start and end dates and the number of suggestions calculated for the next available time are configured under Conflict properties. For more information, see Conflict analysis properties form.
5. Select the time from the available time slots.
6. Click Select Available Time.
   The planned start date and end date are updated with the new time, and the conflict is resolved.
7. To select another day from the calendar, click the calendar icon and select the date.

The conflicts are reviewed and resolved.

**Enable automatic change conflict detection**

Automate conflict detection to run at specific intervals or when a change request is updated to immediately review the conflicts when the schedule dates are updated.

Prior to running conflict detection, consider the following scenarios unique to your organization.

**CMDB list size and relationship complexities**

If you have a large organization with a large CMDB, conflict detection can take longer to complete.

**Inactive changes are not evaluated**

Conflict detection does not evaluate inactive changes when determining conflicting changes.

**Advanced mode conflict checking is disabled by default**

When you upgrade the application, advanced mode conflict checking is disabled by default and affected CIs are not considered during conflict detection. To evaluate all the CIs, set the mode to Advanced.

Role required: change_manager or admin

1. Navigate to Change > Administration > Conflict Properties.
2. Select one of the following options.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Run conflict detection automatically after changes to Configuration item, Planned start date, Planned end date, or State when a change request is updated | When selected, runs conflict detection automatically when a change to one or more of the following fields on the change request record is saved.  
  - Configuration item  
  - Planned start date  
  - Planned end date  
  - State |

| Enable the scheduled change conflict checker                           | When selected, runs the following conflict detection scheduled jobs at these intervals:  
  - Change Conflict Detection < 1 Week Away is scheduled every day.  
  - Change Conflict Detection < 1 Month Away is scheduled every two days.  
  - Change Conflict Detection >=1 Month Away is scheduled every seven days. |

3. Click **Save**.  
You can view the conflicts on the **Conflicts** tab on the change request record.

**Detect conflicts manually and review conflict details**

Run conflict detection manually for a change request and cancel conflict detection before it completes. Review the conflicts detected either automatically or manually and resolve them by changing the schedules.

Before you can run conflict detection for a change request, the following fields must be completed in the change record.

- **Configuration item**, except in advanced mode. In advanced mode, the **Affected CIs** field is required instead.
- **Planned start date** of the change request.
- **Planned end date** of the change request.

For more information about running conflict detection automatically, see **Enable automatic change conflict detection**.

Prior to running conflict detection, consider the following scenarios unique to your organization.

**CMDB list size and relationship complexities**

If you have a large organization with a large CMDB, conflict detection can take longer to complete.

**Inactive changes are not evaluated**

Conflict detection does not evaluate inactive changes when determining conflicting changes.

**Advanced mode conflict checking is disabled by default**

When you upgrade the application, advanced mode conflict checking is disabled by default and affected CIs are not considered during conflict detection. To evaluate all the CIs, set the mode to **Advanced**.
Role required: itil or sn_change_write

1. Navigate to **Change > Open**.
2. From the list of change requests, open the desired change request.
3. Click the **Conflicts** tab or scroll to the bottom the form to find the **Conflicts** tab.
4. Click **Check Conflicts**.
   The Checking conflicts progress status pop-up window appears. To cancel without detecting conflicts, click **Close**.
5. When the conflict detection is completed, click **Close** in the pop-up window.
   Conflicts appear in the Conflicts Detected list on the **Conflicts** tab. The **Conflict status** and **Conflict last run** fields on the change request record are also updated.
6. In the Conflicts Detected list, review the list of conflicts that appear.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conflicting change</td>
<td>The change that is in conflict with the scheduled change, if any.</td>
</tr>
<tr>
<td>Affected CI</td>
<td>The affected CI associated with the change.</td>
</tr>
<tr>
<td>Last Checked</td>
<td>The last time the conflicts were checked. The <strong>Last Checked</strong> field is automatically updated.</td>
</tr>
<tr>
<td>Related CI</td>
<td>The parent CI or child CI of the current CI, if the CI has caused a conflict.</td>
</tr>
<tr>
<td>Schedule</td>
<td>The name of the maintenance window or blackout window that is causing the conflict, if any.</td>
</tr>
<tr>
<td>Type</td>
<td>The issue that caused the conflict.</td>
</tr>
<tr>
<td></td>
<td>· CI Already Scheduled</td>
</tr>
<tr>
<td></td>
<td>· Parent CI Already Scheduled</td>
</tr>
<tr>
<td></td>
<td>· Child CI Already Scheduled</td>
</tr>
<tr>
<td></td>
<td>· Not in Maintenance Window</td>
</tr>
<tr>
<td></td>
<td>· Parent Not In Maintenance Window</td>
</tr>
<tr>
<td></td>
<td>· Child Not In Maintenance Window</td>
</tr>
<tr>
<td></td>
<td>· Blackout</td>
</tr>
</tbody>
</table>

You can review the conflicts and the affected CIs in the Conflicts Detected list and reschedule the change to resolve the conflicts.

**Cancel conflict detection manually**

Cancel any conflict detection jobs that are actively running for a change request if you want to make any modifications to the schedules. After modifying the schedules, you can rerun the check conflicts action again to identify potential conflicts.

Role required: admin

1. Navigate to **Change > Open**.
2. Open the change request that you want to cancel conflict checking for.
3. Click the **Conflicts** tab.
4. Click **Check Conflicts**.
   The Checking conflicts progress status pop-up window appears.
5. To cancel conflict detection, click **Cancel**.

The active conflict detection job is canceled and all conflicts displayed in the Conflicts section are cleared. The **Conflict Status** field displays a **Not Run** status.

**Note:** If you set conflict detection to run automatically or on a scheduled basis, the future executions of conflict detection against the same change request record are not canceled.

---

**Change approval policies**

In Change approval policies, approval definitions are used to generate approvals according to your business requirements.

A change approval policy is a course of action that can be applied to a change request. It uses a set of variable inputs to evaluate the decisions that are associated with it. For each matching decision, the associated approval definition is applied.

An approval policy can contain multiple decisions allowing a single policy to handle every approval required for a change type. When a decision condition matches, the related approval definition is evaluated. If one or more decisions match, all the related approval definitions are evaluated. Change approval policies are based on **Decision Tables**.

Use the **Change Approval Policy** workflow activity instead of the **User and Group Approval** workflow activities to manage the approvals at a particular stage of the workflow. For more information, see **Change Approval Policy workflow activity**

**Note:** To use the change approval policies after you upgrade:

1. Configure the approval policies as needed.
2. Replace the **User** and **Group Approval** activities with the **Change Approval Policy** activity in the workflow.

A change approval policy consists of three components:

- **Policy inputs:** The variable sources evaluated within the condition defined on a decision.
- **Decisions:** Based on the conditions, determines whether the associated Change approval definition applies.
- **Approval definitions:** Defines the type of approval that can applied.

---

**Create approval definitions**

Use approval definitions to define a set of criteria that are evaluated automatically before the policy is marked as approved.

In the approval definitions, you can define to determine

- If the approval is user or group based.
- If it should automatically approve or reject on behalf of a user.
- If a response to the approval is required.

Role required: change_manager or admin
Note: Approval definitions can be applied only once if multiple applied decisions have the same approval definitions associated with them.

1. Navigate to **Change > Change Policy > Approval Definitions**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Indicates the name of the approval definition.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>When checked, indicates if the Change Approval Policy must wait until there is a response from the approval generated by the definition.</td>
</tr>
<tr>
<td>Approval action</td>
<td>Allows you to choose the type of the approval record to be created.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Approve</strong>: Generates an approval record with the state set to <strong>Approved</strong>. Assign the user to associate with the record in the User field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reject</strong>: Generates an approval record with the state set to <strong>Rejected</strong>. Assign the user to associate with the record in the User field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Add a user approval</strong>: Adds an approval record for the user specified in the User field. If the approval is necessary before the policy is approved, select the Mandatory check box.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Add a group approval</strong>: Adds approval records for the members of the group listed in the Group field. If the approval is necessary before the policy is approved, select the Mandatory check box.</td>
</tr>
<tr>
<td></td>
<td>When the Add a Group Approval action is selected, the Wait for field determines when an approval action should be considered met.</td>
</tr>
<tr>
<td>Approver source</td>
<td>Allows you to select the source of the user or group approver.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Approval Definition</strong>: enables the selection of a specific user or group.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Change Request</strong>: enables the user or group to be determined dynamically through a reference field from the change_request table.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
Wait for | Determines the approval timing.
- **First response**: waits for the first response from the group.
- **All responses**: waits for all responses from the group. All members of the group must approve for the approval decision to be approved.
- **Percentage of users**: Set a percentage of users required for approval in the **Percentage** field. The possible values are:
  - Empty: The first response satisfies the approval decision.
  - Less than or equal to 0%: The first response satisfies the approval decision.
  - Greater than or equal to 100%: All responses are required.
  - Between 0 and 100%: The specified percentage of response is required.

---

**Note:** When adding users or groups to which you want to send the approval, specify the **Approval Definition** value as **Approver Source**.

4. Click **Submit**.

### Create change approval policies

Use a change approval policy to define approvals that should be generated for your change.

Role required: admin or change manager

1. Navigate to **Change > Change Policy > Change Approval Policies**.
2. Click **New** to create a new approval policy.
3. Enter the **Name** of the policy.
4. In the **Execution** field, select an option to determine the approach to execute your decision.
   - **First decision that matches**: Uses the first matching decision in the ascending order of the value defined in the **Order** column of the **Decisions** list. The associated approval definition is applied.
   - **Run all decisions that match**: Uses all matching decision and applies the associated approval definition.

5. Click **Submit**.
6. Select the policy you created.
7. Add your decisions to the policy and click **Submit**.

To add additional policy inputs and decisions, see **Create Policy inputs** and **Create Decision records**. For more information, see **Create a decision table to resolve complex decisions**.

### Create policy inputs

Policy inputs are variable sources that you can use while evaluating a decision to determine the approval action. You can create multiple policy inputs to evaluate the decision created, and also access the change request table and any table change request references.
Role required: admin or change manager

You can create multiple policy input types. By default, the change_request policy input of type Reference is available for all change types. This policy input provides access to the change request table and to any table change request references. For a normal change policy, an extra manager_approved policy input of type True/False is available. For more information, see Create a decision table to resolve complex decisions.

To define additional policy inputs, perform the following steps:

2. Create a change approval policy or open an existing policy.
   For more information, see Create change approval policies
3. In the Policy inputs tab, click New to create a record.
   The Name and Application fields are auto-populated.
4. Click the reference lookup icon for the Type field and choose a Type value.
5. Enter a name in the Label field.
   The column name for the new record is populated in the Column Name field automatically.
6. Depending on the value of the Type field, you can configure the other parameters for the policy input.
7. Click Submit.

After you create a policy input, reference it within a decision.

Create Decision records

Decision records contain the conditions that you can use to determine the change approval action. Create decisions using condition builder when creating change approval policies.

Role required: admin or change manager

You can create decisions to evaluate conditions that reference policy inputs and apply the associated approval definition. To create a decision, perform the following steps:

2. Create a change approval policy or open an existing policy.
   For more information, see Create change approval policies
3. In the Policy inputs tab, create a policy input or update an existing record.
   For more information, see Create policy inputs.
4. In the Decisions tab, open the default decision record.
5. Copy and modify the decision record configuration or click New to create a new decision record.
6. Provide a label in the Label field.
7. In the Answer field, select an approval definition.
8. Add any necessary filter conditions using the condition builder.
   These conditions determine the outcome of the policy. For example, to generate approvals at the Assess state that trigger an approval definition when risk is low, set the condition to (Change request.state) (is) (Assess) AND (Change request.Risk) (is) (Low).
9. Click Submit.

Change Approval Policy workflow activity

Use the Change Approval Policy workflow activity to control the approval process for a change request by creating user and group approvals according to a change approval policy record.
Multiple activities can be used in a workflow, where each activity can reference the same or different Change Approval Policies.

Using the current change request and additional inputs defined in the Policy Input script field in the activity, you can evaluate the Change Approval Policy record, which applies the approval definitions from matching decisions.

*Note:* This activity is only available when the workflow runs on a table that extends or is the (change_request) table.

**Results**

The activity assigns a result value according to the outcome of the applied policy. The possible result values are:

- Approved
- Rejected
- Canceled
- Skipped
- Finished

**Input variables**

Input variables determine the initial behavior of the activity.

**Change Approval Policy activity input variables**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Policy</td>
<td>The Change Approval Policy that you want to apply to the change request.</td>
</tr>
<tr>
<td>Policy Input</td>
<td>Policy Inputs that are defined on the Change Approval Policy record. Set additional policy inputs here.</td>
</tr>
<tr>
<td>Finish condition</td>
<td>Determine if the activity should complete while pending approvals remain. Use this condition if the workflow is configured to handle restarting the Change Approval Policy activity. For example, when the Change Request goes on-hold.</td>
</tr>
</tbody>
</table>

**Condition**

The following conditions determine which transition runs after this activity.
### Change Approval Policy activity conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>Change request is approved when the criteria defined by applied Approval Definitions is met.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Any rejection from applied Approval Definitions will result in the Rejected outcome.</td>
</tr>
<tr>
<td>Error</td>
<td>The event or condition that generates an error.</td>
</tr>
</tbody>
</table>
| Skipped   | If this condition is not configured on the activity, then the Approved condition is used. This outcome occurs for the following scenarios:  
- No decisions from the Change Approval Policy match  
- No approvals can be generated from matched decisions |

### States

The workflow engine uses the activity state to perform the next logical action on the activity.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine starts the <code>execute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

### Example

In this example, let us reference the Risk approvals activity in the **Change Request - Normal** workflow. In the workflow, the change approval policy factors if the assigned group’s manager has already approved the Change Request.
You can use this activity to access the risk of the change request of a normal change policy. When this activity runs, the associated decisions executes the approvals that need to be requested.
Use the **Policy Input** field to set up additional inputs. In the given example, the activity defines the manager_approved property and performs the query to check if an approved record exists for the approved group’s manager.

**Note:** Ensure that the manager_approved policy input is defined in the Change Approval Policy record.

The **Finish condition** field is used to complete the activity by marking pending approvals as **No Longer Required**. In this workflow example, when the Change Request is put on-hold, the Change Approval Policy activity is completed and the workflow disregards the pending approvals before waiting for the Change Request to resume. When the on-hold state is released, the Change Approval Policy activity is restarted.

**Use the Change Approval Policy workflow activity**

Apply your Change Policy in your Change Request workflow to manage the approvals.

**Role required:** admin

1. Navigate to **Workflow Editor**.
2. Open the change request workflow that you want to use in the **Change Policy** activity.
3. Drag and drop the **Change Approval Policy** activity from the **Change Policy** section in the **Core** activities tab.

**Note:** This activity is only available when the workflow runs on a table that extends or is the change_request table.

4. Configure the activity by specifying the Change Approval Policy in the workflow.
5. Configure the Policy input field to setup inputs that are defined on the associated Change Approval Policy record.
6. Configure the **Finish condition** if the workflow needs to handle a scenario where the activity needs to complete ahead of time because of a change in the Change Request. For example, when the change request is on-hold.
7. Click Update.

**Change Advisory Board (CAB) workbench**

The Change Advisory Board (CAB) workbench enables a CAB manager to schedule, plan, and manage CAB meetings.

CAB meetings are typically intended to review and authorize change requests and review recently implemented changes. A standard agenda with the relevant change request details enables the CAB members to conduct risk and impact analysis prior to the CAB meeting.

The CAB workbench assists you in managing CAB meetings in the following ways:

**Define a schedule for CAB meetings**

Schedule a recurring series of CAB meetings for CAB members to assess the impact and risk of change requests prior to the meetings.

**Define CAB meeting attendees**

Define members who attend this CAB meeting series for each occurrence. For example, define the CAB board members or any delegates who can substitute if the CAB manager cannot attend.
Define CAB meeting agenda
Define filter criteria that determines which change requests are included in any occurrence of a CAB meeting. If a change request is included in an agenda, the change requester is notified of the CAB meeting in which the change request is discussed. The change requester can attend and present the reasons for the proposed change, and explain the intended outcomes and potential risks of the change.

View change calendar
Schedule changes by displaying existing planned changes in a change calendar in daily, weekly, and monthly view. The calendar view also lists maintenance windows and blackout schedules, if any.

Approve or reject a change request
Approve or reject a change request based on the decision taken in the CAB meeting.

View and record meeting notes
Record meeting notes from a specific CAB meeting and share these notes with other meeting attendees.

The CAB Definition (cab_definition) table inherits the domain properties from the Schedule (cmn_schedule) table which has the Domain and Domain path columns. As the CAB Definition table makes use of the same Child Schedule and Schedule Entry tables as the Schedule table, domain support is identical, where the domain_master attribute is used to derive Domain from a parent record. For more information, refer Domain support for schedules.

Create a CAB definition
A Change Advisory Board (CAB) definition is similar to a recurring meeting invitation. When you define a CAB definition, it determines the attributes that are associated with all CAB meetings generated from that definition.

Role required: sn_change_cab.cab_manager

1. Navigate to Change > Change Advisory Board > My CAB Definitions.
2. Click New.
3. On the CAB Definition form, fill in the fields.

### CAB Definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the CAB definition.</td>
</tr>
<tr>
<td>CAB Manager</td>
<td>Name of the user who manages the CAB meetings.</td>
</tr>
<tr>
<td>Delegates</td>
<td>Delegate CAB members who can substitute as the CAB manager during the meeting.</td>
</tr>
<tr>
<td>Board Members</td>
<td>Board members who are expected to attend the CAB meeting, selected from the list of users.</td>
</tr>
<tr>
<td>Board Groups</td>
<td>Board groups who are expected to attend the CAB meeting, selected from the list of user groups.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rolling Meeting Window</td>
<td>Number of days for which you want to create CAB meetings. <strong>Note:</strong> The CAB schedule and related schedules, if any, determine the number of CAB meetings that are created. For example, if you have a CAB schedule of once every week and you enter 28 days in the <strong>Rolling Meeting Window</strong> field, then three CAB meetings are created.</td>
</tr>
<tr>
<td>CAB Type</td>
<td>Type of CAB meeting this definition is used for.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Time zone for the CAB meeting.</td>
</tr>
<tr>
<td>Locations</td>
<td>One or more locations for your CAB meetings. For example, meeting rooms in different offices.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that specifies whether the CAB definition is active. Clear the check box to deactivate the CAB definition.</td>
</tr>
<tr>
<td>Conference Details</td>
<td>Information such as meeting links, passwords, and phone numbers.</td>
</tr>
<tr>
<td>Agenda Management</td>
<td><strong>Use filter criteria to drive Change Request date range</strong> If selected, helps to choose a time range for the planned start and end date from <strong>Change Request additional condition</strong> instead of selecting specific dates based on meeting schedule. <strong>Note:</strong> The same field is selected for all CAB meetings in the CAB definition unless individually overridden.</td>
</tr>
<tr>
<td>Notification lead time</td>
<td>The advanced notification on the number of agenda items that needs to be discussed.</td>
</tr>
<tr>
<td>Auto Add Agenda Decisions</td>
<td>Check box for capturing agenda decisions automatically on the meeting widget. The agenda decision is captured in the following format: (CAB Automation) - &lt;change request number&gt; - &lt;decision&gt; - &lt;CAB Manager name&gt; - &lt;time&gt;&lt;AM/PM&gt; &lt;timezone&gt;</td>
</tr>
<tr>
<td>Automatically Add Change Requests</td>
<td>Check box to define the types of change requests that are automatically added to the CAB meeting agenda. When you select <strong>Automatically Add Change Requests</strong>, the <strong>Refresh CAB Meetings</strong> related link appears. If you click this link, search is performed for change requests that match the value in the <strong>Change Request Addition Conditions</strong> field. If there are any matching change requests, agenda items are created for them and added to the CAB agenda. If you do not select <strong>Automatically Add Change Requests</strong>, then you need to create individual agenda item for the associated change request for the meeting agenda.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change Request Addition Conditions</td>
<td>Condition builder to specify which change requests are added to the CAB meeting agenda.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Add Filter Condition</strong>: Click to add additional filter conditions, or click <strong>AND</strong> next to the existing filter condition.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Add “OR” Clause</strong>: Click to display the results of multiple filter criteria in a single list.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Add Sort</strong>: Click to define the order of the change requests in this CAB meeting agenda. The agenda order can be defined in CAB Definitions or CAB Meetings, and can be based on one or more fields.</td>
</tr>
<tr>
<td>Time per Agenda Item</td>
<td>The time, in minutes and seconds, allotted to discuss each change request on the agenda. The allotted time can be adjusted for agenda items before or during the meeting.</td>
</tr>
<tr>
<td>Complete Pre-approved Changes</td>
<td>Check box to mark each pre-approved change request as <strong>Complete</strong> in the CAB meeting agenda.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Pre-approved changes are automatically marked as complete so that approvers do not have to review them. The pre-approved changes are visible in the CAB Workbench, and can be discussed if necessary.</td>
</tr>
</tbody>
</table>

4. Open the form context menu and select **Save**. The **Schedule Entries**, **Related Schedules**, and **CAB Meetings** related lists appear.

5. To set the meeting schedule for your CAB meeting series, complete the following steps:
   You can add one or more schedule entries to a CAB definition to schedule the series of CAB meetings. These schedule entries let you set valid days and times for holding CAB meetings.
   a) In the **Schedule Entries** related list, click **New**.
   b) On the Schedule Entry fields form, fill in these fields.

### Schedule Entry fields form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the schedule entry.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of schedule entry for the specified date and time duration, for example, appointment or meeting.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Time off</strong>: Shown as planned time-off.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Appointment</strong>: Shown as appointment time.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Meeting</strong>: Shown as meeting time.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Phone call</strong>: Shown as time for making phone calls.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Excluded</strong>: The duration is excluded.</td>
</tr>
<tr>
<td>Show as</td>
<td>How the schedule entry is displayed on the CAB calendar, for example, busy or tentative.</td>
</tr>
<tr>
<td>When</td>
<td>Start and end date and time for the schedule entry.</td>
</tr>
<tr>
<td>All day</td>
<td>Check box to make the schedule entry active for the entire duration of the selected dates.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Time zone</td>
<td>Time zone for the schedule entry. The time zone cannot be modified.</td>
</tr>
</tbody>
</table>
| Repeats       | Frequency with which the schedule entry repeats, for example, daily or weekly. When you select Monthly, the Monthly type field appears. Enter the number of times in a month when the schedule entry repeats. When you select Yearly, the Yearly type field appears. Select an option, as follows:  
  - Day of the year: Chosen as the current day on which you define the schedule.  
  - Floating: If you select this option, the following fields appear:  
    - Float week: The week of the month when the schedule entry repeats.  
    - Float day: The day of that week when the schedule entry repeats.  
    - Month: The month when the schedule entry repeats.  
| Repeat every  | If the schedule entry is selected to repeat, specifies how often it repeats. For example, if you select weekly repetitions, specify the frequency such as every week or every two weeks. This field appears when you select the Weekly, Monthly, or Yearly options. |
| Repeat on     | If the schedule entry is selected to repeat, then specify when it repeats. For example, if you select weekly repetitions, specify the days of the week when it repeats. This field appears when you select the Weekly option. |
| Repeat until  | If the schedule entry is scheduled to repeat, specifies an end date until which the schedule entry is repeated. |

6. To set a related schedule for your CAB meeting series, complete the following steps:  
You can add one or more related schedules to a CAB definition. Related schedules enable you to set valid schedules for holding CAB meetings. For example, if you set the public holiday schedule as a related schedule, it ensures that no CAB meeting is scheduled on a public holiday.  
   a) In the Related Schedules related list, click Edit.  
   b) Select one or more related schedules and move them to the Related Schedules List.  
   c) Click Save.  
   d) Optional: On the CAB Definition form, click the Show Schedule related link to view the defined schedule in the calendar.
7. In the Related Links section, click Refresh CAB Meetings. The CAB meeting series created from CAB definitions inherit the criteria of the CAB definition. You can view the series of CAB meetings generated from the CAB definition in the CAB Meetings related list.

You can modify CAB meeting details and send meeting requests to attendees. You can also manage agendas by reviewing or adding agenda items to each of the meetings.

**View the CAB calendar**

The CAB calendar provides an overview of your CAB meeting schedule to help with planning and managing CAB meetings.

Role required: itil, sn_change_cab.cab_manager, sn_change_read, sn_change_write, or admin

You can view the CAB calendar to view and attend specific meetings.

1. Navigate to Change > Change Advisory Board > CAB Workbench.

2. You can perform the following actions from the CAB calendar.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View the calendar</td>
<td>Click the options in the top right of the CAB calendar to display the calendar in daily, weekly, or monthly view.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View CAB meeting details at a glance</td>
<td>Click a specific CAB meeting to view details such as the CAB manager, meeting start time, and meeting end time.</td>
</tr>
<tr>
<td>Attend a specific CAB meeting</td>
<td>Click the meeting you want to attend and click Open to launch the meeting.</td>
</tr>
</tbody>
</table>

### Create a single CAB meeting occurrence

Depending on your requirements, you can create an individual Change Advisory Board (CAB) meeting occurrence.

Role required: sn_change_cab.cab_manager

1. Navigate to Change > Change Advisory Board > My CAB Meetings.
2. Click New.
3. On the CAB Meeting form, fill in the fields.

#### CAB Meeting form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the CAB meeting.</td>
</tr>
<tr>
<td>CAB manager</td>
<td>Name of the user who manages the CAB meeting. The default is the user that is currently logged in.</td>
</tr>
<tr>
<td>Delegates</td>
<td>Delegate CAB members who can substitute as the CAB manager during the meeting.</td>
</tr>
<tr>
<td>Board groups</td>
<td></td>
</tr>
<tr>
<td>Board members</td>
<td></td>
</tr>
</tbody>
</table>
| State              | • **Pending**: Indicates that the meeting is yet to begin. It is the default state of the meeting.                                           
|                    | • **In progress**: Indicates that the meeting has begun and is in progress.                                                                  |
|                    | • **Complete**: Indicates that the meeting has occurred and is finished.                                                                     |
|                    | • **Canceled**: Indicates that the meeting has been canceled.                                                                                 |

**Note:** The system automatically updates the State field when the meeting starts and ends from within the CAB workbench. There is no need to manually change this field, unless, for example, the CAB manager wants to cancel a future meeting. If the CAB workbench closes unexpectedly, the CAB manager must manually update the State field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting start time</td>
<td>Start date and time for the meeting.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When you add an agenda item to a CAB meeting, the <strong>CAB date</strong> field in the change request is automatically updated with this date.</td>
</tr>
<tr>
<td>Meeting end time</td>
<td>End date and time for the meeting.</td>
</tr>
<tr>
<td>Meeting Notes</td>
<td>Enter notes for the meeting, if any.</td>
</tr>
<tr>
<td>Locations</td>
<td>One or more locations for your CAB meetings. For example, meeting rooms in different offices.</td>
</tr>
<tr>
<td>Conference Information</td>
<td></td>
</tr>
<tr>
<td>Conference details</td>
<td>Information such as meeting links, passwords, and phone numbers.</td>
</tr>
<tr>
<td>Agenda Management</td>
<td></td>
</tr>
<tr>
<td>Use filter criteria to drive Change Request date range</td>
<td>If selected, helps to choose a time range for the planned start and end date from <strong>Change Request additional condition</strong> instead of selecting specific dates based on meeting schedule.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select the <strong>Use filter criteria to drive Change Request date range</strong> field in a cab meeting, the <strong>Change Requests starting after</strong> field and the <strong>Change Requests starting on or before</strong> field is disabled for the meeting, and therefore ignored. The change request additional conditions drive the date range.</td>
</tr>
<tr>
<td>Change Requests starting after</td>
<td>Change requests that starts after this date and time should be added to the CAB meeting.</td>
</tr>
<tr>
<td>Change Requests starting on or before</td>
<td>Change requests that starts on or before this date and time should be added to the CAB meeting.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete Pre-approved Changes</td>
<td>Check box to mark each pre-approved change request as Complete in the CAB meeting agenda.</td>
</tr>
<tr>
<td>Time per Agenda Item</td>
<td>The time, in minutes and seconds, allotted to discuss each change request on the agenda. The allotted time can be adjusted for agenda items before or during the meeting.</td>
</tr>
<tr>
<td>Notification lead time</td>
<td>The advanced notification on the number of agenda items that needs to be discussed.</td>
</tr>
<tr>
<td>Auto Add Agenda Decisions</td>
<td>Check box to capture agenda decisions automatically on the meeting widget. The agenda decision is captured in the following format: (CAB Automation) - &lt;change request number&gt; - &lt;decision&gt; - &lt;CAB Manager name&gt; - &lt;time&gt;&lt;AM/PM&gt; &lt;timezone&gt;</td>
</tr>
</tbody>
</table>

4. Open the form context menu and select Save. The Agenda Items and Attendees related lists appear.

You can now add agenda items and attendees to the cab meeting.

**View CAB meeting details**

You can view the details of any past, scheduled, or in-progress CAB meeting.

Role required: itil, sn_change_cab.cab_manager, sn_change_read, sn_change_write, or admin

1. Use one of the following ways to navigate to the CAB meeting:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
   | CAB meeting     | 1. Navigate to Change > Change Advisory Board > All CAB Meetings and open the specific CAB meeting to view.  
<p>|                 | 2. Click the Go to this meeting in CAB workbench related link. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAB workbench</td>
<td>1. Navigate to Change &gt; Change Advisory Board &gt; CAB Workbench.</td>
</tr>
<tr>
<td></td>
<td>2. Click the meeting details you want to view from your calendar.</td>
</tr>
<tr>
<td></td>
<td>3. Click Open in the window that appears for the meeting.</td>
</tr>
<tr>
<td></td>
<td>Note: You can only click Open if the meeting has an agenda.</td>
</tr>
</tbody>
</table>
The following information is available:

**CAB meeting**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Time           | • Total time scheduled for the CAB meeting  
• Time covered until present for a CAB meeting in progress  
• Time spent discussing current agenda item  
• Time assigned to each agenda item |
| Agenda items   | List of agenda items for the CAB meeting. You can view all agenda items or filter the list for current, pending, and completed agenda items. |
| Calendar       | The blackout and maintenance windows are displayed on the change calendar. You can also view when the current agenda item is scheduled. You can view the calendar in a daily and weekly format. |
| Meeting Notes  | Meeting notes, if any, for a past CAB meeting. If you are the CAB manager, you can take notes during the meeting. |
| Attendees      | Details of attendees for the specific CAB meeting including the CAB board and delegates.          |
| Conference Information | Conference details of the CAB meeting.               |

2. If you are the CAB manager, or one of the CAB delegates who has chosen to host a specific CAB meeting, you can perform the following tasks:

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the change request</td>
<td>Click the edit icon beside the Change, Planning, and Schedule tabs.</td>
</tr>
<tr>
<td>Start the meeting</td>
<td>Click Start meeting</td>
</tr>
<tr>
<td>End the meeting</td>
<td>Click End meeting</td>
</tr>
<tr>
<td>Pause the timer on the current agenda item</td>
<td>Click Pause on the Current Agenda Item widget.</td>
</tr>
<tr>
<td>Move to the next agenda item</td>
<td>Click Next after a decision is taken on the current agenda item.</td>
</tr>
<tr>
<td>Host the meeting</td>
<td>Click Attendees &gt; Host to become the host. You can host the meeting when you are a CAB manager or delegate.</td>
</tr>
<tr>
<td>Promote an agenda item</td>
<td>Click Promote under a change request name and title to promote it as the next agenda item for discussion.</td>
</tr>
</tbody>
</table>
### Modify CAB meeting details

You can modify the agenda items for a specific CAB meeting.

**Role required:** itil, sn_change_read, sn_change_write, or sn_change_cab.cab_manager

After you update the CAB board or change request conditions, refresh the CAB meeting to apply the updates. If you add new board members or attendees to the meeting, they are notified via email invitations after the meeting is refreshed.

1. Navigate to the CAB meeting whose agenda you want to modify using one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open from the CAB meeting list</td>
<td>1. Navigate to Change &gt; Change Advisory Board &gt; All CAB meetings.</td>
</tr>
<tr>
<td></td>
<td>2. Select and open the CAB meeting to modify.</td>
</tr>
</tbody>
</table>

| Open from the CAB definition list | 1. Navigate to Change > Change Advisory Board > All CAB definitions.          |
|                                  | 2. Select and open the CAB definition to send out the meeting request.        |
|                                  | 3. Select and open the specific CAB meeting to modify.                       |

2. Modify the CAB meeting agenda in the **Agenda Management** tab or form section, as appropriate.

**Agenda Management fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification lead time</td>
<td>The advanced notification on the number of agenda items that needs to be discussed.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Automatically Add Change Requests</td>
<td>Check box to define the types of change requests that are automatically added to the CAB meeting agenda.</td>
</tr>
<tr>
<td></td>
<td>When you select <strong>Automatically Add Change Requests</strong>, the <strong>Refresh CAB Meetings</strong> related link appears. If you click this link, search is performed for change requests that match the value in the <strong>Change Request Addition Conditions</strong> field. If there are any matching change requests, agenda items are created for them and added to the CAB agenda.</td>
</tr>
<tr>
<td></td>
<td>If you do not select <strong>Automatically Add Change Requests</strong>, then you need to create each agenda item for the associated change request for the meeting agenda.</td>
</tr>
<tr>
<td>Change Request Addition Conditions</td>
<td>Condition builder to specify which change requests are added to the CAB meeting agenda.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Add Filter Condition</strong>: Click to add additional filter conditions, or click <strong>AND</strong> next to the existing filter condition.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Add “OR” Clause</strong>: Click to display the results of multiple filter criteria in a single list.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Add Sort</strong>: Click to define the order of the change requests in this CAB meeting agenda. The agenda order can be defined in CAB Definitions or CAB Meetings, and can be based on one or more fields.</td>
</tr>
<tr>
<td>Time per Agenda Item</td>
<td>The time, in minutes and seconds, allotted to discuss each change request on the agenda. The allotted time can be adjusted for agenda items before or during the meeting.</td>
</tr>
<tr>
<td>Complete Pre-approved Changes</td>
<td>Check box to mark each pre-approved change request as <strong>Complete</strong> in the CAB meeting agenda.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Pre-approved changes are automatically marked as complete so that approvers do not have to review them. The pre-approved changes are visible in the CAB Workbench, and can be discussed if necessary.</td>
</tr>
</tbody>
</table>

3. From **Related Links**, you can perform any of the following tasks.

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh Agenda Items</td>
<td>The agenda items for the CAB meeting are refreshed. If you added or updated attendees, a</td>
</tr>
</tbody>
</table>
4. From related lists, you can perform any of the following tasks.

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agenda Items</td>
<td>Manually add agenda items. In the Allotted Time field, the CAB manager can override the default time for any agenda item.</td>
</tr>
<tr>
<td>Attendees</td>
<td>Manually add attendees to a CAB meeting.</td>
</tr>
</tbody>
</table>

5. Click **Update** to save your changes.

**Send CAB meeting request to attendees**

You can send CAB meeting invitations to attendees for each CAB meeting.

Role required: sn_change_cab.cab_manager

You can send meeting invitations from a CAB meeting only.

1. Navigate to the CAB meeting for which you want to send out invitations using one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open from the CAB meeting list</td>
<td>1. Navigate to Change &gt; Change Advisory Board &gt; All CAB meetings.</td>
</tr>
<tr>
<td></td>
<td>2. Select and open the CAB meeting to modify.</td>
</tr>
<tr>
<td>Open from the CAB definition list</td>
<td>1. Navigate to Change &gt; Change Advisory Board &gt; All CAB definitions.</td>
</tr>
<tr>
<td></td>
<td>2. Select and open the CAB definition to send out the meeting request.</td>
</tr>
<tr>
<td></td>
<td>3. Select and open the specific CAB meeting to modify.</td>
</tr>
</tbody>
</table>

2. Click the **Send meeting request to attendees** related link. The CAB meeting invitation is sent to all listed attendees.

**CAB meeting using the CAB workbench**

As an ITIL user, you can attend a Change Advisory Board (CAB) meeting, view the agenda items and the change schedule. If you are an approver, you can approve a change request.
You can view the details of a CAB meeting and its agenda by navigating to Change > Change Advisory Board > CAB Workbench. From the calendar, you can view the CAB meeting schedule for a day, week, or month. To view details of a meeting, click the meeting and then click Open in the pop-up window.

CAB Workbench

The following components describe the different activities that you can perform in the interface:
## CAB workbench

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1     | You can view the timer that displays the total elapsed time, the meeting name, and the scheduled date and time of the meeting. The timer count starts from zero. The color code in the timer changes based on the overall percentage elapsed from the total duration of the meeting:  
  - 0% - 50%: Green  
  - 50% - 70%: Yellow  
  - 75% - 100%: Orange  
  - > 100%: Red  
The text below the meeting name displays the total time allotted for the meeting. |
| 2     | You can view the current agenda item. The timer displays the amount of time spent discussing the current meeting agenda item. The form area displays the details of the current agenda item that you have selected. When the current agenda item changes, the details on the form and the calendar change accordingly. If you select an agenda item that is not the current agenda item, the form area displays the details of the selected agenda item. The form area does not display details of the current agenda item even when the current agenda item is changed to the next agenda item.  
  **Note:** If you are one of the approvers for the agenda item, the Approve and Reject buttons appear below the timer.  
  You can click Approve or Reject as appropriate, enter your comments in the Confirmation pop-up window, and click Approve or Reject. |
| 3     | You can filter the agenda items that you want to view and click Notify me to receive a notification before the agenda item starts. Click the Pending Agenda Items list, and select the All Agenda Items, My Agenda Items, or Approved Agenda Items option. The list of agenda items appears under the filter condition list, in the order that the items appear in the agenda. |
| 4     |  
  - **Meeting Notes:** Displays the document note entered by the host of the meeting.  
  - **Attendees:** Displays the list of attendees and also indicates whether the attendees are currently connected to the meeting via the green Presence icon.  
  - **Conference Information:** Displays any content that was stored in the Conference Information field from the related CAB meeting record. |
<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>You can view the details of a current change in the form view or in the calendar view.</td>
</tr>
<tr>
<td></td>
<td><strong>Show form:</strong> Click the show form icon to display change details in the form view. The <strong>Change</strong>, <strong>Planning</strong>, and <strong>Schedule</strong> tab provide information about the change request meeting, planning, and scheduling.</td>
</tr>
<tr>
<td></td>
<td><strong>Show calendar:</strong> Click the show calendar icon to display change details on the calendar form. You can select the day or the month that you want to view details of a change for. In a day view, you can click the settings icon and then click the configuration icon to set relevant filter conditions. If you turn on any of the configuration filter conditions, the related change records are displayed. The change records appear in the timeslot of the day that the current change implementation is planned for. In the configuration settings, you can view other potential conflicts. The conflicts can be other change requests that are scheduled for implementation by the same assignee, assignment group, or for the same configuration item.</td>
</tr>
<tr>
<td></td>
<td>The day and month view of the calendar displays the Blackout Schedule time, Maintenance Window, and the agenda item that is in progress. In the day view, the specific timeslot of the planned blackout and maintenance window is highlighted. In the calendar view, the entire day is highlighted.</td>
</tr>
</tbody>
</table>

**CAB meeting management using the CAB workbench**

As a Change Advisory Board (CAB) manager, you can view and manage details of a CAB meeting and its agenda items through the CAB workbench.

You can view the details of a CAB meeting and its agenda by navigating to **Change > Change Advisory Board > CAB Workbench**. The calendar offers a view of your CAB meeting schedules for the day, week, or month. To view your meeting details, click the meeting and then click **Open** in the pop-up calendar. If you want to start a meeting, click **Start meeting**.

**Note:** If you click the first agenda item for the first time, a Confirmation window appears. If you want to start the meeting, click **Yes**, otherwise, click **No**.

Watch this six-minute video to learn more about CAB meeting management.
Start CAB meeting

The details of the change request meeting appear.
CAB workbench

The following table describes the CAB workbench components:
CAB workbench

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1     | You can view the timer that displays the total elapsed time, the meeting name, and the scheduled date and time of the meeting. The timer count starts from zero. The color code in the timer changes based on the overall percentage elapsed from the total duration of the meeting:
  - 0% - 50%: Green
  - 50% - 70%: Yellow
  - 75% - 100%: Orange
  - < 100%: Red
  
The text below the meeting name displays the total time allotted for the meeting. |

| 2     | - Click **Pause** to pause an agenda item.  
        - Click **Next** if you want to skip an agenda item.  
        - **Note:** The agenda item is added in the list of **All Agenda Items** list.  
        - Click **Restore** if you again want the agenda item back in the **Pending Agenda Items** list.  
        - **Note:** The agenda item is added to the end of the **Pending Agenda Items** list.  
        - Click **Promote** to move the agenda item to the top of the list.  
        - Click **Demote** to append the current agenda item in the **Pending Agenda Items** list so that you can discuss the agenda item later.  
        - **Note:** The timer displays the amount of time spent discussing the current meeting agenda item.  
        - Click **End meeting** to end a meeting. |

| 3     | You can filter the agenda items that you want to view.  
        - Click the **Pending Agenda Items** list, and select the **All Agenda Items**, **My Agenda Items**, or **Approved Agenda Items** option.  
        - **Note:** The list of agenda items appears under the filter condition list, in the order that the items appear in the agenda.  
        - Click **Promote** if you want an agenda item to appear at the top of the agenda item list. |
<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4     | **Meeting Notes**: Enables the CAB manager to document notes for the overall meeting. The notes captured in the widget can be shared from the widget. The widget emails the contents to the list of attendees, which are automatically saved to the corresponding **Meeting Notes** field in the CAB Meeting record. Any notes specific to a change request can be added directly to the change request. To add a note, use the editable view of the form under the edit icon in the upper left of the form widget.  

**Note**: The agenda decisions made by the CAB and change approvers, such as whether the agenda item is approved or rejected or when CAB manager skips to another agenda item without making a decision, are automatically captured in the meeting notes widget. The agenda decisions are stored in the **Meeting Notes** field in the related CAB Meeting record.  

| Attendees: Displays the list of attendees and indicates if the attendees are currently connected to the meeting via the green Presence icon. The list also displays the attendee’s response to the meeting invitation such as Accept, Tentative, Decline, or No response.  
<p>| Conference Information: Displays any content that was stored in the <strong>Conference Information</strong> field on the related CAB Meeting record. |</p>
<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>You can view the details of a current change in the form view or in the calendar view.</td>
</tr>
<tr>
<td></td>
<td><strong>Show form:</strong> Click the show form icon to display change details in the form view. The Change, Planning, and Schedule tab provide information about the change request meeting, planning, and scheduling.</td>
</tr>
<tr>
<td></td>
<td>You can edit the form view, by using the edit icon.</td>
</tr>
<tr>
<td></td>
<td>To customize the view, click the list contextual menu and then click <strong>View &gt; cab_workbench</strong>. On the Change Request form, rightclick and navigate to <strong>Configure &gt; Form Layout</strong>. On the Configuring Change Request form, you can add fields and sections that you want to display in the form view.</td>
</tr>
<tr>
<td></td>
<td><strong>Show calendar:</strong> Click the show calendar icon to display current change details on the calendar form. You can select the day or the month that you want to view meeting details for. In the day view, click the settings icon and then click the configuration icon to set relevant filter conditions. If you turn on any of the configuration filter conditions, the related change records are displayed. The change records appear in the timeslot of the day that the current change implementation is planned for. In the configuration settings, you can view other potential conflicts. The conflicts can be other change requests that are scheduled for implementation by the same assignee, assignment group, or for the same configuration item. The day and month view of the calendar displays the Blackout Schedule time, Maintenance Window, and the agenda item that is in progress. In the day view, the specific timeslot of the planned blackout and maintenance window is highlighted. In the calendar view, the entire day is highlighted.</td>
</tr>
</tbody>
</table>

**Change management integrations**

You can integrate Change Management with other ServiceNow applications such as Discovery, Software Asset Management, and Hardware Asset Management.

The following topics provides information about integration of different applications with Change Management, prerequisites, and way to enable functionality of those integrated applications.
Change Management integration with Discovery

If your organization is subscribed to Discovery, integration with Discovery is automatically enabled. With this integration, any configuration item (CI) with an IP address that is part of a change request process can be maintained automatically. Change request fulfillers can also manually request the discovery process for a CI.

You must install and configure the Discovery plugin (com.snc.discovery) to get the enhanced functionality.

When Discovery is activated, Change Management exposes three new properties within the Change Properties module (Change Management > Administration > Change Properties):

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configures how Discovery will be triggered for Affected CIs (automatically, manually or off)</td>
<td>Determines whether to trigger Discovery for the affected CIs automatically, manually, both, or not at all. Type: Choice list Values: Off, Both, Automatic, Manual Default value: Off</td>
</tr>
<tr>
<td>List of Change Request states (comma-separated) where Discovery can be triggered manually</td>
<td>Defines the change request state values to allow Discovery to be manually initiated. For these defined state values, the Initiate Discovery related link is available. Type: String Default value: Implement, Review</td>
</tr>
<tr>
<td>List of Change Request states (comma-separated) where Discovery will trigger automatically. E.g. when the Change Request’s state changes to Review</td>
<td>Defines the change request state values for which Discovery is automatically triggered. Discovery initiates when transitioning to the state values listed. Type: String Default values: Review</td>
</tr>
</tbody>
</table>

In addition to the new properties, the Discovery State and the Discovery last updated fields get added to the Affected CI related list. Discovery State provides one of five status values and a corresponding icon to reflect that status:

- In Progress
- Completed Successfully
- Completed w/Warning
- Completed w/Error
- Cancelled

The Discovery State value is presented as a link to the corresponding Discovery log file. The Discovery last updated field contains a date and time stamp indicating the last time Discovery was executed.

If you have opted to manually initiate the Discovery module, or opted for both manual and automatic initiation, then the Initiate Discovery related link appears in the Related Links section.
when the state of the change request matches one of the defined states in the property. When Discovery is triggered, the values in the Discovery State and the Discovery last updated fields change.

<table>
<thead>
<tr>
<th>Affected Cis</th>
<th>Impacted Service/Is</th>
<th>Approves G/I</th>
<th>Change Tasks G/I</th>
<th>Problems</th>
<th>Incidents Fixed By Change</th>
<th>Incidents Caused By Change</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Configuration Item</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Change management integration with discovery

**Change Management integration with Software Asset Management**

The Change Management integration with Software Asset Management (SAM) displays the projected licensing cost implication of a change.

This integration focuses on the projected license cost change when a change is proposed to one or more configuration item (CI) processor resources (CPU or CPU Core) running software licensed by the processor.
This integration requires the Software Asset Management Professional (com.snc.samp) and Change Management - License Change Projections (com.sn_samp_change) plugins.

Note: You need to request the activation of the Change management – License Change Projections plugin (com.sn_samp_change) through the HI Service Portal.

When a change request is in the New state, users can propose a change to the CPU or CPU Cores of a CI using Propose Change or Mass Update CI. Those proposed changes are captured in an XML field that is then passed to Software Asset Management when the change request transitions into its first approval state. Once Software Asset Management performs the projected licensing cost change, those results are displayed in a new form section called License change projection.

The License change projection form section displays the license projection change summary for every CI in scope for the change. The left side of the section displays fields relaying the current spend, projected spend, the spend change, and the number of impacted installations. On the right is a bar graph providing a visual representation of that information.

For a more detailed breakdown of the license change projections, a related list can be added to the Change Request form called CI Projection Summary. This related list provides a CI-by-CI breakdown of the license change projection summary information and provides easy access to the Software Asset Management CI Project Summary record and additional data.

Change Management integration with Hardware Asset Management

The Change Management integration with Hardware Asset Management helps in determining the asset action that must be performed on the configuration item (CI) that is associated with a hardware asset. Using this capability, change implementers can quickly update asset records directly from change and the Asset Manager can see current state on all assets that were updated by the change request.

This integration requires the Hardware Asset Management Professional (com.sn_hamp) plugin.

Note: You must request the activation of the Hardware Asset Management Professional (com.sn_hamp) plugin from the ServiceNow® application store.

When the configuration items listed in the Affected CIs related list have an asset associated, then the Asset action field is populated.

You can choose an Asset action for the CI, from the Affected CI related list. This Asset action field provides three possible actions that can be selected which triggers an event.

- **Deploy**: When this action is selected, the sn_hamp.asset.deploy event is triggered.
- **Update/Repair**: No event is triggered for this action.
- **Retire**: When this action is selected, the sn_hamp.asset.rehire event is triggered.

Note: The Asset action column can be added to the Affected CI related list if not already available.

When a change request is in the Implement state, the proposed asset action triggers the corresponding event. When the workflow is complete, the asset action updates the asset and the related records and progresses to the Review state.

Note: If the asset action is not selected, then the change request will not progress to the Review state.
Mobile experience for Change Management

Manage your change tasks from anywhere using the ServiceNow Agent mobile application. With this mobile application, you can stay connected and access the information in real time to complete your tasks.

As an ITSM agent or technician, you can use ServiceNow Agent when connected online to accomplish the following task:

- Access the change tasks assigned to you or to your group.
- Add comments or work notes or reassign the change tasks.
- Receive push notifications for change tasks assigned or commented on.
- Approve or reject change requests, requests, and requested items.

Watch this three-minute video to learn about the ServiceNow Agent for managing change tasks.

Configure the ServiceNow Agent mobile application

Access ServiceNow Agent on your mobile device to manage your change tasks.

Role required: itil or sn_change_write

The ServiceNow Agent mobile application runs on the Studio mobile platform. Activate the ITSM Mobile Experience (com.sn_itsm_mobile) plugin to enable the ITSM mobile application on your device.

1. In your mobile device, go to Apple App store if you are on an iOS platform or Google Play Store if you are on an Android platform.
2. Search for ServiceNow Agent.
3. Download and install the ServiceNow Agent application.

Getting started with Change Management mobile tasks

Access ServiceNow Agent on your mobile device to manage change tasks.

Download ServiceNow Agent on an iOS platform from the Apple App Store or on an Android platform from Google Play Store. For more information, see Configure the ServiceNow Agent mobile application.

Role required: itil or sn_change_write

1. Open ServiceNow Agent and tap the plus icon (+).
2. Add a ServiceNow instance by tapping the plus icon (+) and then entering the instance address. You do not need to include service-now.com at the end of the instance name.
3. Tap Change tasks to get started with managing your change tasks.

View change tasks

You can view the state, risk, and the schedule of the change tasks in the ServiceNow Agent mobile application.

Role required: itil or sn_change_write

1. Tap Change tasks to open the list of change tasks.
2. Tap the change task for a detailed view.
3. Tap any field with right arrow to view its details.

**Add comments to your change tasks**

You can add comments to a change task from the ServiceNow Agent mobile application. For example, to add an insight about the change task or a discussion regarding the change task.

Role required: itil or sn_change_write

1. Tap **Change Tasks** to open the list of change tasks.
2. Tap the change task to open the detailed view.
3. Tap **Add comment** to add your worknotes.

**Resolve or close a change task**

When you implement the change task, you can close the task from the ServiceNow Agent mobile application.

Role required: itil or sn_change_write

1. Tap **Change tasks** to open the list of change tasks.
2. From the list of change tasks, swipe left the change task that you want to close.
3. Tap **Close task**.

**Domain separation in Change Management**

This is an overview of domain separation and Change Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: Basic**

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

**Overview**

Change Management provides a systematic approach to controlling the life cycle of all changes, facilitating beneficial changes with minimum disruption to IT services.
How domain separation works in Change Management

Change management involves the management of change requests. A change request allows you to implement a controlled process for the addition, modification, or removal of approved and supported configuration items (CIs). The request records the detailed information about the change, such as the reason for the change, the priority, the risk, the type of change, and the change category.

- A change request is an extension of a Task. Records are created in the domain of users creating the task they have in session.
- All change properties are global, meaning they are the same for every application that uses the `sys_properties` table properties. The table is not domain separated so any changes made impact all domains.

Domain separated tables

- Change Request (change_request)

Use case

- An ITIL user in the Acme domain logs in and creates a change request. The change request is created in the domain that the user has selected.

How domain separation works in Change Advisory Board (CAB) Workbench

- CAB meetings synchronize with the CAB Definition table if:
  - the meeting was generated via a definition.
  - or
  - the meeting was created manually and has the CAB Definition field populated.
- CAB Meetings are created in the domain of the user if:
  - the meeting is created manually without an associated CAB definition.
- Meeting records are not supported if in a different domain from the associated definition.
- All other CAB records have their domain master set to the associated CAB Meeting record.

Domain separated tables

- CAB Definition (cab_definition)
- CAB Meeting (cab_meeting)

Domain master tables (linked to domain of its associated cab_meeting)

- CAB Attendee (cab_attendee)
- CAB Agenda Item (cab_agenda_item)
- CAB Runtime State (cab_runtime_state)

Use cases

- A CAB manager creates a new CAB definition and generates 20 meetings while in the ACME domain. The result: Both the definition and meetings are created within the ACME domain.
• A CAB manager creates an ad-hoc CAB meeting from the related list on the CAB definition form. Result: The meeting is created in the domain of the CAB meeting.
• All other use cases behave in the same way as when domain separation is not enabled.

How domain separation works in Change Schedules (New feature)

• Change Schedule definitions encapsulate all the configuration options and related records used to display a given Change Schedule.
• Records are created in the domain of the current user.
• Ancillary records are created in the domain of the Change Schedule definition.

Domain separated tables

• Change Schedule Definition (chg_soc_definition)
• Related Definition (chg_soc_definition_child)
• Style Rule (chg_soc_definition_style_rule)
• Style Rule (chg_soc_style_rule)
• Style Rule chg_soc_def_child_style_rule

Use cases

• An ITIL user in the ACME domain logs in and navigates to the Change Schedule landing page. The user can view the Change Schedules in both their current or global domain.

Change Management Analytics and Reporting Solutions

Analytics and Reporting Solutions and in-form analytics contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Analytics and Reporting Solutions

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can get value from Performance Analytics for your application with minimal setup. You can always create your own objects as well.

**Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

**Note:** Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see [Configure Analytics and Reporting Solutions](#).

To enable the solutions for Change Management, an admin can navigate to **Performance Analytics > Guided Setup**. Click **Get Started** then scroll to the section for Change Management. The guided setup takes you through the entire setup and configuration process.
Inactive dashboards

Some dashboards in this content pack are inactive when installed. Complete configuration and run data collection jobs before you activate these dashboards. You can activate dashboards in Dashboard Properties, accessible from the context menu. You have to assign an owner to the dashboard to activate it. For more information about configuring Analytics and Reporting Solutions, see Configure Analytics and Reporting Solutions.

Change Premium dashboard

This dashboard uses Workbench widgets and other advanced Performance Analytics features to give you all the information about the Change process in one place.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Manager - Needs to break down the trends in change request resolution over time to spot areas that need attention</td>
<td>itil</td>
</tr>
</tbody>
</table>

Use case

Indicators

Number of open changes
The number of changes open at the end of the collection date. This calculation is the number of changes opened on or before the collection date and not closed by that date.

Average age of open changes
\[
\frac{\text{Summed age of open changes}}{\text{Number of open changes}} / 24
\]

Average re-assignment of open changes
\[
\frac{\text{Summed re-assignment of open changes}}{\text{Number of open changes}}
\]

Average age of last update
The average length of time since the last update made to a change.

Number of new changes
The number of new changes with a registration date on the data collection date.

Change backlog growth
The number of closed changes subtracted from the number of new changes.

Number of closed changes
The number of changes with a close date on the data collection date.

% of urgent changes
Percentage of urgent changes. Is a formula: Number of new changes classified as urgent / Number of new changes * 100

Average close time of changes
The average length of time in hours between when a change request is opened and closed.

Average implementation time of closed changes
The average length of time in hours between when a change request enters the Implementation state and when it is closed

Number of reassigned open changes
The number of changes with a reassignment count of 1 or higher

Number of unsuccessful changes
The number of closed changes with a Close Code of "Unsuccessful"

The following indicators are not displayed on the dashboard but are used in formulas:

- Summed age of open changes
- Summed age of updated since of open changes
- Summed duration of closed changes
- Summed implementation time closed changes
- Summed re-assignment of open changes

**Breakdowns**

- Age
- Category
- Priority
- Risk
- State
- Assignment Group
- Type

**Reports**

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changes Opened Today</td>
<td>Single</td>
<td>Number of active changes opened on the day the dashboard is viewed.</td>
</tr>
<tr>
<td></td>
<td>Score</td>
<td>42</td>
</tr>
<tr>
<td>Unassigned Changes</td>
<td>Single</td>
<td>Number of active changes that don't have an assignee.</td>
</tr>
<tr>
<td></td>
<td>Score</td>
<td>42</td>
</tr>
<tr>
<td>Overdue Changes</td>
<td>Single</td>
<td>Number of changes that are in one of the following states: New, Assess, Authorize, or Scheduled and for which the planned start date is before the current date.</td>
</tr>
<tr>
<td></td>
<td>Score</td>
<td>42</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Changes On Hold</td>
<td>Single</td>
<td>Number of changes with the status On hold.</td>
</tr>
<tr>
<td>Conflicting Changes</td>
<td>Single</td>
<td>Number of changes with the status Conflict.</td>
</tr>
<tr>
<td>Rejected Changes</td>
<td>Single</td>
<td>Number of changes for which the approval status is Rejected.</td>
</tr>
<tr>
<td>Open Changes - Grouped</td>
<td>Horizontal</td>
<td>Open changes grouped by Priority</td>
</tr>
<tr>
<td>Upcoming Changes (30 days) -</td>
<td>Horizontal</td>
<td>Active changes for which the planned start date is in the past 30 days and</td>
</tr>
<tr>
<td>Grouped</td>
<td></td>
<td>for which the state is Scheduled.</td>
</tr>
<tr>
<td>Open Changes by Risk and Priority</td>
<td>Horizontal</td>
<td>Active changes sorted by risk on the Y-axis and priority on the X-axis. Cells are highlighted from white for low scores to dark blue for high scores.</td>
</tr>
<tr>
<td>Upcoming Changes (30 days) by Risk and Priority</td>
<td>Horizontal</td>
<td>Active changes sorted by risk on the Y-axis and priority on the X-axis. Cells are highlighted from white for low scores to dark blue for high scores.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Changes Opened per Month by Type</td>
<td>Column</td>
<td>All closed reports opened in the current calendar year. Grouped by type and trended by month opened.</td>
</tr>
<tr>
<td>Closed Changes per Month</td>
<td>Line</td>
<td>Number of closed changes per month expressed on a line chart.</td>
</tr>
</tbody>
</table>

**Change Management dashboard**

Use this dashboard to see the trends in change request resolution over time across different change request risks, ages, and priorities. Break down change requests over time according to the assignment groups you manage.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Manager - Needs to break down the trends in change request resolution over time to spot areas that need attention</td>
<td>itil</td>
</tr>
</tbody>
</table>

Use case

Change Management dashboard indicators

**Number of open changes**
The number of changes open at the end of the collection date. The number of changes opened on or before the collection date and no close date or a close date after collection date.

**Number of new changes**
The number of new changes with a registration date on the data collection date.

**Number of new emergency changes**
The number of new changes where type=emergency

**Change backlog growth**
The number of closed changes subtracted from the number of new changes.

**Number of closed changes**
The number of changes with a close date on the data collection date.

**Average age of open changes**
The average amount of time a change has been open.

**% of urgent changes**
Percentage of urgent changes. Is a formula: Number of new changes classified as urgent / Number of new changes * 100

**Average close time of changes**
The average amount of time it has taken to close a change

The following indicators do not appear on the dashboard but are used in formulas:
- Summed age of open changes
- Summed duration of closed changes

**Breakdowns**
- Priority
- Age
Open Changes Reports dashboard

Use this dashboard to get an overview of the current status of open reports.
<table>
<thead>
<tr>
<th>Number</th>
<th>Short description</th>
<th>Category</th>
<th>Priority</th>
<th>Status</th>
<th>Assignment group</th>
<th>Assigned to</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHG0001005</td>
<td>Changes in configurations settings for PeopleSoft Financials</td>
<td>Software</td>
<td>4 - Low</td>
<td>New</td>
<td>Oracle Support</td>
<td>Carmela Wishman</td>
</tr>
<tr>
<td>CHG0001094</td>
<td>Event manager configuration changes for Oracle Taleo Compensation Management</td>
<td>Software</td>
<td>4 - Low</td>
<td>New</td>
<td>Oracle Support</td>
<td>Carolee Overfelt</td>
</tr>
<tr>
<td>CHG0001084</td>
<td>Patch the correct file version for Saba Succession@Work</td>
<td>Software</td>
<td>4 - Low</td>
<td>New</td>
<td>Sales Systems Support</td>
<td>Bryan Revell</td>
</tr>
<tr>
<td>CHG0001084</td>
<td>Performance fix for Adobe Photoshop &amp; Digital Publishing</td>
<td>Software</td>
<td>4 - Low</td>
<td>New</td>
<td>Marketing Systems Support</td>
<td>Beverly Burche</td>
</tr>
<tr>
<td>CHG0001083</td>
<td>Event manager configuration changes for Oracle Manufacturing and Maintenance</td>
<td>Software</td>
<td>4 - Low</td>
<td>New</td>
<td>Oracle Support</td>
<td>Buster Wubbel</td>
</tr>
<tr>
<td>CHG0001083</td>
<td>Datafix for Retail Client Lookup</td>
<td>Software</td>
<td>4 - Low</td>
<td>New</td>
<td>Technical Services Support</td>
<td>Eduardo Ballardir</td>
</tr>
<tr>
<td>CHG0001082</td>
<td>Event manager configuration changes for PeopleSoft Asset Lifecycle Management</td>
<td>Software</td>
<td>4 - Low</td>
<td>New</td>
<td>Oracle Support</td>
<td>Paul Stafer</td>
</tr>
<tr>
<td>CHG0001053</td>
<td>Notification configuration changes for Salesforce SalesforceP3 Platform</td>
<td>Software</td>
<td>4 - Low</td>
<td>New</td>
<td>Technical Services Support</td>
<td>Amelius Schermuth</td>
</tr>
<tr>
<td>CHG0001044</td>
<td>Performance fix for Oracle Strategic Sourcing</td>
<td>Software</td>
<td>4 - Low</td>
<td>New</td>
<td>Oracle Support</td>
<td>Paul Stafer</td>
</tr>
<tr>
<td>CHG0001033</td>
<td>Changes in configurations settings for Taxware Use Tax</td>
<td>Software</td>
<td>4 - Low</td>
<td>New</td>
<td>Financial Systems Support</td>
<td>Barton Hesmer</td>
</tr>
<tr>
<td>CHG0001030</td>
<td>Notification configuration changes for SuccessFactors Learning</td>
<td>Software</td>
<td>4 - Low</td>
<td>New</td>
<td>SAP Support</td>
<td>Amelia Caruso</td>
</tr>
<tr>
<td>CHG0001025</td>
<td>Notification configuration changes for Anaplan Strategic Planning</td>
<td>Software</td>
<td>4 - Low</td>
<td>New</td>
<td>Sales Systems Support</td>
<td>Callie Lobossef</td>
</tr>
</tbody>
</table>
### Open Changes Pivot

<table>
<thead>
<tr>
<th>State</th>
<th>Category</th>
<th>1 - Critical</th>
<th>2 - High</th>
<th>3 - Moderate</th>
<th>4 - Low</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>▼ New</td>
<td>Total</td>
<td>1</td>
<td>0</td>
<td>4</td>
<td>113</td>
<td>340</td>
</tr>
<tr>
<td></td>
<td>Server Reboot</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Software</td>
<td>1</td>
<td>0</td>
<td>4</td>
<td>24</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>Other</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>108</td>
<td>208</td>
</tr>
<tr>
<td>▼ Assess</td>
<td>Total</td>
<td>1</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Hardware</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Network</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>▼ Authorize</td>
<td>Total</td>
<td>0</td>
<td>24</td>
<td>39</td>
<td>7</td>
<td>61</td>
</tr>
<tr>
<td></td>
<td>Network</td>
<td>0</td>
<td>24</td>
<td>39</td>
<td>6</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>Other</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>▼ Scheduled</td>
<td>Total</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Other</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>2</td>
<td>3</td>
</tr>
</tbody>
</table>

**Count**: 2, 27, 34, 144, 207
Use case

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA.Source: Open changes - List</td>
<td>List</td>
<td>A list report of the unclosed changes opened on or before the current date. Columns include Number, Short description, Category, Priority, State, Assignment group and Assigned to.</td>
</tr>
<tr>
<td>PA.Source: Open changes - MPivot - Priority/State/Category</td>
<td>Pivot</td>
<td>Report that shows unclosed changes opened on or before the current date. The visualization shows changes by Priority, State, and Category.</td>
</tr>
<tr>
<td>PA.Source: Open changes - Heatmap - Priority/Category</td>
<td>Heatmap</td>
<td>Heatmap report that shows unclosed changes opened on or before the current date. Larger values are highlighted in darker colors.</td>
</tr>
</tbody>
</table>

Open Changes State Monitor dashboard

This workbench dashboard enables you to view and assess all open changes separated into status brackets: New, Assessed, Authorized, Scheduled, Implemented, and Reviewed.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Use case

Indicators

**Number of open changes**
The number of changes open at the end of the collection date. This calculation is the number of changes opened on or before the collection date and not closed by that date.

**Average age of open changes**

\[
\frac{\text{Summed age of open changes}}{\text{Number of open changes}} / 24
\]

**Average re-assignment of open changes**

\[
\frac{\text{Summed re-assignment of open changes}}{\text{Number of open changes}}
\]

**Average age of last update**
The average length of time since the last update made to a change.

Breakdowns

- Priority
- Risk
- Age
- Assignment Group

**Age of Open Changes Monitor dashboard**
This workbench dashboard enables you to view and assess all open changes separated into age brackets: less than one day, from 1-5 days, from 6-30 days, from 31-90 days, and over 90 days.
### Age of Open Changes Monitor

<table>
<thead>
<tr>
<th>Days</th>
<th>Records</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - 1 day</td>
<td>0</td>
</tr>
<tr>
<td>1 - 5 days</td>
<td>0</td>
</tr>
<tr>
<td>6 - 30 days</td>
<td>186</td>
</tr>
<tr>
<td>31 - 90 days</td>
<td>0</td>
</tr>
<tr>
<td>90+ days</td>
<td>21</td>
</tr>
</tbody>
</table>

**Mar 31 - 6 - 30 days**

**186**

0 (0.0%)

- **Average age**: 0.17 days
- **Average re-assignment times**: 13.58 days

#### Breakdowns

6 - 30 days, Mar 31: 186 (0.0%)

<table>
<thead>
<tr>
<th>Priority</th>
<th>Name</th>
<th>Mar 31</th>
<th>Change</th>
<th>Trend</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 - Low</td>
<td></td>
<td>127</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 - Moderate</td>
<td>34</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 - High</td>
<td>24</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 - Critical</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Manager - Needs to break down the trends in change request resolution over time to spot areas that need attention</td>
<td>itil</td>
</tr>
</tbody>
</table>

Use case

Indicators

**Number of open changes**

The number of changes open at the end of the collection date. This calculation is the number of changes opened on or before the collection date and not closed by that date.

**Average age of open changes**

\[
\frac{\text{Summed age of open changes}}{\text{Number of open changes}} / 24
\]

**Average re-assignment of open changes**

\[
\frac{\text{Summed re-assignment of open changes}}{\text{Number of open changes}}
\]

**Average age of last update**

The average length of time since the last update made to a change.

Breakdowns

- Priority
- Risk
- Assignment Group
- State

Change Management troubleshooting properties

Use the Change Management troubleshooting properties and change the value of the properties to get additional logging details for the feature.

The following properties are available for further configuration. To list them, enter `sys_properties.list` in the navigator text box.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>change.conflict.log</td>
<td>The logging property that controls logging level displayed for Change Management while detecting the change conflicts.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Default value: notice</td>
</tr>
<tr>
<td>com.snc.change_management.cab.log</td>
<td>The logging property that controls the logging level displayed for Change Management when using the CAB functionality.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Default value: info</td>
</tr>
<tr>
<td>com.snc.change_management.core.log</td>
<td>The logging property that controls level logging displayed for Change Management.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Default value: warn</td>
</tr>
<tr>
<td>com.snc.change_management.policy.approval.log</td>
<td>The debug logging property that provides the detailed logging information of the workflow activity when using Change Approval Policies.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
</tbody>
</table>

**Quick start tests for Change Management**

Validate that Change Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Change Management quick start tests require activating the Change Management - ATF Tests plugin (com.snc.change_management.atf).

**CHG: Emergency Type Change Request test suite**

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency Type Change Request workflow</td>
<td>Process an emergency change request from new to closed.</td>
<td>Madrid</td>
</tr>
<tr>
<td>On Hold for Emergency type Change Request</td>
<td>Validate the approval state of an on-hold emergency change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Copy Change For Emergency type Change Request</td>
<td>Validate the state of a copied emergency change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Reject By Approver for Emergency type</td>
<td>Validate the state of a rejected emergency change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Revert to new for emergency type</td>
<td>Validate the state of an emergency change request after using the Revert to new UI action.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Convert Emergency to Normal type</td>
<td>Validate the conversion of an emergency change request to a normal change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Cancel Change Request For Emergency Type</td>
<td>Validate the state of a canceled emergency change request.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

**CHG: Normal Type Change Request test suite**

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Type Change Request Workflow</td>
<td>Process a normal change request from new to closed.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Convert Normal to Emergency type</td>
<td>Validate the conversion of a normal change request to an emergency change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Copy change on Normal Change Request</td>
<td>Validate the state of a copied normal change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>On hold for Normal type Change Request</td>
<td>Validate the approval state of an on-hold normal change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>State validation when Reject Normal type Change request by Approver.</td>
<td>Validate the state of a rejected normal change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Revert to New Functionality for Normal Type Change Request</td>
<td>Validate the state of a normal change request after using the Revert to new UI action.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Cancel Change Request For Normal type</td>
<td>Validate the state of a canceled normal change request.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

**CHG: Standard Change Proposal test suite**

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Change Proposal</td>
<td>Determine whether a user can successfully perform standard change proposal creation, approval, and template publishing processes.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>
### CHG: Standard Type Change Request test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Change Request Workflow</td>
<td>Process a standard change request from new to closed.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Convert Standard to Emergency Change Request</td>
<td>Validate the conversion of a standard change request to an emergency change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Convert Standard to Normal Change Request</td>
<td>Validate the conversion of a standard change request to a normal change request.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

### CHG: Unauthorized Change Request and Outage test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unauthorized change request Workflow</td>
<td>Process an unauthorized change request from new to closed.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Create Outage of type planned outage from change request</td>
<td>Validate the creation of an outage of type planned outage from a change request.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Create Outage of type outage from change request</td>
<td>Validate the creation of an outage of type outage from a change request.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

### CHG: Risk Conditions with Best practice plugin test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moderate Risk with UI Action Property</td>
<td>Process a moderate risk with UI action property.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Low Risk with UI Action Property</td>
<td>Process a low risk with UI action property.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Leave Alone Risk with UI Action Property</td>
<td>Process a leave alone risk with UI action property.</td>
<td>Orlando</td>
</tr>
<tr>
<td>High Risk with UI Action Property</td>
<td>Process a high risk with UI action property.</td>
<td>Orlando</td>
</tr>
<tr>
<td>High Risk with Business Rule Property</td>
<td>Process a high risk with Business rule property.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Moderate Risk with Business Rule property</td>
<td>Process a moderate risk with Business rule property.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
CHG: Change Request against Conflict Sources test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change against Blackout window</td>
<td>Process a change request against a blackout window.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Check conflicts for CI Already Scheduled</td>
<td>Validate the conflicts for CI already scheduled.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Change against Conflict Sources</td>
<td>Validate the change request against conflict sources.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

CHG: Change Schedule Definition and Sharing test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Schedules Definitions on New</td>
<td>Process the creation of change schedules definitions from New button on Change Schedules landing page.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Share Panel On Change Schedules Definition</td>
<td>Validate the share panel on change schedules definition.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Share Change Schedule Definition</td>
<td>Validate the sharing of change schedules definitions.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

Coaching

The ServiceNow® Coaching application lets you facilitate the coaching of employees using coaching opportunities that you can configure for a critical moment in a process. Coaching consistently improves employee performance and processes by providing real-time improvement feedback as well as automated contextual recommendations.

This 26-minute podcast includes a discussion of the Coaching application, the coaching process, virtual coaching, and building coaching into a workflow.

When a coaching opportunity is triggered, an assessment is generated for a trainee. The coaching assessment then is assigned to a coach for training or, if the virtual coaching conditions are met, training content is automatically assigned to the trainee.

Coaching can be applied to any task-based process, such as Change Management, Customer Service Management or Incident Management. A non-task or custom table source can also be used for coaching, but you must configure a business rule.

To gain a general understanding of the application and how it is used, see Coaching overview.

Start coaching

To coach users to improve processes in your environment, select an activity.
Define a coaching moment

Assess a trainee

Coach

Understand Coaching concepts

- Coaching overview
- Setting up Coaching and surveys
- Coaching your trainee
- Managing your coaching assessments
- Domain separation and Coaching

Get help from ServiceNow resources

- Ask or answer questions in the Coaching forum
- Search the HI Knowledge Base for known error articles
- Contact ServiceNow Technical Support

Request Coaching

The Coaching (com.sn_coaching) plugin requires a separate subscription and must be activated by ServiceNow personnel. This plugin includes demo data and activates related plugins if they are not already active. The Coaching application is available with the ITSM Professional subscription only. Please contact your account manager for more information.

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization's production and subproduction instances, generally within a few days.

If you don’t have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.

Role required: none

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.
### Activate Plugin

In order to enhance the user experience, we have redesigned Activate a Plugin service catalog. Please use the new HI Service Portal 'Activate a Plugin' service catalog item. You can also use Manage Instances page on Service Portal to Activate a Plugin.

Take me to the HI Service Portal Activate a Plugin Service Catalog.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click **Submit**.

### Coaching roles

Assign Coaching roles to specify what different users can see and do.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Roles inherited</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_coaching.trainee</td>
<td>Able to view coaching assessments to which they belong.</td>
<td>• skill_user</td>
</tr>
<tr>
<td>(Coaching trainee)</td>
<td>Able to add work notes in a coaching assessment by clicking <strong>Review Assessments</strong>.</td>
<td>• survey_reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_viewer</td>
</tr>
</tbody>
</table>
### Coaching overview

After you enable Coaching, you can set up roles and groups, define coaching opportunities, create training material, and start assessing and coaching employees. The Coach and Trainee dashboards provide useful overviews to manage and measure results.

### Initial Coaching setup

Once you have enabled Coaching, set up the application by assigning user roles, configuring coaching opportunities and creating training content.

1. Set up Coaching roles and groups
2. Define trigger conditions for a coaching opportunity
3. Identify learning content and a virtual coach
4. Set up surveys

### Workflow of Coaching roles

An employee with the Coaching trainee role is in need of coaching at a critical moment in a process.

An administrator with the Coaching admin role is in charge of setting up coaching opportunities, learning content, virtual coaches, and surveys used in the coaching process.

A manager, or coach, with the Coaching coach role is a subject matter expert of a process and is responsible for providing coaching to an employee, or trainee.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Roles inherited</th>
</tr>
</thead>
</table>
| sn_coaching.coach     | Able to read and write coaching assessments assigned to the coach group to which they belong. Able to assign a training and virtual coaches to a coaching opportunity. | • sn_coaching.trainee  
                        | (Coaching coach)                                                           | • pa_viewer                                                     |
| sn_coaching.admin     | Able to perform all functions.                                              | • sn_coaching.coach  
                        | (Coaching admin)                                                          | • survey_admin  
                                                                 | • sn_cim_improvement_requester |
Coaching dashboards

Use Coaching dashboards to manage and measure results in a simplified view.

- *Coaching Dashboard*
- *Trainee Dashboard*

Identifying coaching opportunities

Coaching opportunities can be found in many tasks that occur throughout your environment.

- Writing better work notes when service desk escalates incidents to a second level.
- Correctly setting affected configuration items when the service desk works on incidents.
- Using the correct naming convention for admin in update sets.
- Coaching during the onboarding and the warranty period of a new application.
- Correctly reassigning a case to another user with pertinent information in comments.
- Engaging a user on closed records when non-positive feedback is received through surveys.
- Spot-checking a user on quality control.
- Helping to guide project managers in projects.
- Improving knowledge article quality when knowledge articles are attached to resolved incidents.

Common ITSM assessment triggers

You can define activities that occur when trainees work through an ITSM process, such as resolving an incident, as assessment triggers.

<table>
<thead>
<tr>
<th>Table</th>
<th>Assessment triggers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>Moment of first response</td>
</tr>
<tr>
<td></td>
<td>Categorization and prioritization</td>
</tr>
<tr>
<td></td>
<td>Reassignment</td>
</tr>
<tr>
<td></td>
<td>Proposal of solution to the customer</td>
</tr>
<tr>
<td>Problem</td>
<td>Definition of the Problem statement</td>
</tr>
<tr>
<td></td>
<td>Writing the Known Error</td>
</tr>
<tr>
<td></td>
<td>Writing the Workaround</td>
</tr>
<tr>
<td></td>
<td>Root Cause analysis</td>
</tr>
<tr>
<td></td>
<td>Root Cause confirmation</td>
</tr>
<tr>
<td></td>
<td>How can this issue be avoided?</td>
</tr>
<tr>
<td>Change</td>
<td>Categorization and prioritization</td>
</tr>
<tr>
<td></td>
<td>Implementation description</td>
</tr>
<tr>
<td></td>
<td>Risk analysis</td>
</tr>
<tr>
<td></td>
<td>Impact analysis</td>
</tr>
</tbody>
</table>
### Integration with other applications

Coaching opportunities, coaching assessments, and assigned training in Coaching are integrated with these applications.

- **Continual Improvement Management (CIM)**
  
  One example of a coaching opportunity with CIM would be to use improvement initiatives to set up external training tasks.

  **Note:** The Continual Improvement Management (com.sn_cim) plugin must be active to create an improvement initiative. Continual Improvement Management requires a separate subscription and must be activated by ServiceNow personnel.

- **Skills Management**
  
  In a coaching assessment, you can assess trainee skills to identify gaps so the trainee can be coached to acquire new skills or to enhance their existing skill level.

- **Knowledge Management**
  
  You can assign knowledge articles as assigned training.

### Domain separation and Coaching

This is an overview of domain separation and Coaching. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: Basic**

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

### Overview
All tables including Coaching Opportunity, Coaching Assessment, Virtual Coach, and Trainings support domain separation so the coach and Coaching admin can view records within the (tenant) domain to which they belong.

**How domain separation works in Coaching**

Domain separation is supported in Coaching with no setup or configuration required. You can create coaching opportunities and coaching assessments in separate domains, including the global domain.

Coaching assessments extend the platform Task (task) table.

When domain separation is implemented, coach and trainee users can view coaching assessments and trainings only in the domain assigned. The **Domain** and **Domain Path** columns are available for coaching opportunities, coaching assessments, virtual coaching, and trainings provided with the base system.

The **Domain** column contains the name of the domain to which the event or alert belongs, and the **Domain Path** column contains the unique domain identifier.

**Note:** If the domain column is not shown, click the **Update Personalized List** icon and add the required column. You can also add the domain path column, if desired.

**Domain-separated tables**

- Coaching Assessment (sn_coaching_assessment)
- Coaching Opportunity (sn_coaching_opportunity)
- Trainings (sn_coaching_recommendation)
- Assigned Training (sn_coaching_assessment_recommended_learning)
- Assigned Training (sn_coaching_opportunity_recommended_learning)
- Virtual Coach (sn_coaching_opportunity_virtual_coach_m2m)
- Virtual Coaching (sn_coaching_virtual_coach)

**Use cases**

- A Coaching admin that belongs to a parent domain creates a coaching opportunity at a parent domain level or at a child domain level. Coaching opportunities created at a parent level are available to view in all domains.
- A Coaching admin has access to multiple domains but wants to update content in a record within a specific domain. The domain specified in the record drives the functionality of that record and reference fields.
- A Coaching user that belongs to the Acme domain can view the coaching assessment task created in the Acme domain.
- A Coaching user wants to associate an assigned training for an integrated application in the Acme domain. The user must belong to the domain of the integrated application from which a record is associated.
- The trainee user of a parent domain can view a coaching assessment of the parent as well as of all child domains of that parent. A trainee user must belong to the Acme domain, its parent domain, or the global domain to view that coaching assessment.
Setting up Coaching and surveys

To take full advantage of Coaching, configure the Coaching application and set up surveys.

Setting up Coaching

Configure Coaching to start assessing and coaching trainees.
1. Set up Coaching roles and groups to identify Coaching users, coaches, and admins.
3. Identify training content that is provided as part of a training or virtual coaching.
4. Configure virtual coaches to add to a coaching opportunity.
5. Set up surveys to provide feedback on the coaching experience so you can make improvements.

Setting up surveys

You can obtain feedback for both the coach and the trainee by creating surveys that are accessed from a Coaching Assessment form that has been resolved or closed.
- Survey taken by trainee to provide feedback on the coach
- Survey taken by coach to provide feedback on the trainee

Access the Survey designer for Coaching by navigating to Survey > Survey Designer.
Access the Coaching Survey definitions by navigating to Coaching > Coaching Surveys.

Define trigger conditions for a coaching opportunity

Use the Coaching Opportunity form to define a critical moment in a process on which a user can be coached. A coaching opportunity consists of the relationship between a process that can be improved, and coaches and trainees.

Role required: sn_coaching.admin

When the triggered conditions defined in a coaching opportunity are met, an assessment for that trainee is generated. The coaching assessment is then assigned to a coach for training, or is completed using automated virtual learning content.

You can add assigned trainings and virtual coach items to the related lists, if applicable, to complete the coaching opportunity.

You can create an improvement initiative in the Continual Improvement Management (CIM) application to set up external training tasks, for example, using the Create Improvement Initiative related link.

Note: The Continual Improvement Management (com.sn_cim) plugin must be active to create an improvement initiative. Continual Improvement Management requires a separate subscription and must be activated by a ServiceNow personnel.

To create a coaching opportunity:
Using | Do th
--- | ---
Guided setup | 1. Navigate to Continual Improvement > Administration > Guided Setup.
2. Go to the Add a Coaching Opportunity section and click Configure.

Application navigator | Navigate to Coaching > Coaching Opportunities.

2. Click **New**.
3. Fill in the fields on the Coaching Opportunity form.
   a) Select the table that contains the field for coaching in the **Table** field.
   b) Select the **Trainee field** from the source table.
   c) To limit the trainees for which a coaching assessment is generated, select a specific **Trainee group**.
   d) Select a coach or a group of coaches to assess and provide feedback to trainee assessments generated from this coaching opportunity.
      - To select a coach group, from the **Coach group** field, select the group of coaches.
      - To select the assignment group manager as the coach for the selected task record, enable the **Specify coach user** check box and select the coach user from the selected table.
   e) Add the condition for the critical moment in the **Trigger** fields.
      See **Common ITSM assessment triggers** for examples.

4. Fill in the fields in the **Snapshot Settings** tab.
   a) Select the **Snapshot fields** that contain the values to capture in the coaching assessment when an assessment is triggered.
   b) To use an advanced script, select the **Advanced** check box and add your script.
      See **Scripts** for more information on scripting.

5. Fill in the fields in the **Frequency** tab.
   a) To limit the number of coaching assessments generated, set the **Random sample (%)** to a percentage of the total number.
      If you reduce the random sample size, you can prevent certain trainees from being excluded by specifying **Users who should be coached on every opportunity**. For example, you may want new employees to be coached every time.
   b) Specify the **Assessment duration** after which the coaching assessment is set to **Closed Complete** state.
      You can disable automatic closure behavior by deactivating the **Close assessments after expiration** scheduled job.
   c) To **Prevent duplicate assessments** from being created for a trainee for the same coaching opportunity within a certain time period, select the check box.
      Specify the **Time period** within which duplicate assessments are not created.

6. Fill in the fields in the **Surveys** tab.
a) To select feedback surveys taken by trainees and coaches when the coaching assessment is in **Resolved** state, select a **Survey taken by Coach** and a **Survey taken by Trainee**.

7. Fill in the fields in the **Related KPIs** tab.
   a) Select the primary KPI improved by the coaching opportunity in the **Improvement KPI** field.
   b) Select the **Strategic objective** affected by the coaching opportunity in the **Strategic objective** field.

   **Note:** You can set strategic objectives by navigating to **Continual Improvement > Strategy Objectives**.

---

**Coaching admin defines a trigger condition**

**Coaching Opportunity form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>COP0000109</td>
</tr>
<tr>
<td>Name</td>
<td>Incident Process: Coaching on Incident Reassignment</td>
</tr>
<tr>
<td>Description</td>
<td>Coach a user on the reassignment process of an incident, including adding comments, CI, and category.</td>
</tr>
<tr>
<td>Table</td>
<td>Incident (incident)</td>
</tr>
<tr>
<td>Trainee</td>
<td>Assigned to</td>
</tr>
<tr>
<td>Trainee group</td>
<td>Trainee group</td>
</tr>
<tr>
<td>Coach group</td>
<td>Coach Group</td>
</tr>
<tr>
<td>Active</td>
<td>Selected</td>
</tr>
<tr>
<td>Trigger</td>
<td>Option: Assigned to Operator: changes</td>
</tr>
</tbody>
</table>

**Coaching Opportunity tabs**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td></td>
</tr>
<tr>
<td>Random sample (%)</td>
<td>100</td>
</tr>
<tr>
<td>Assessment duration</td>
<td>5 days</td>
</tr>
<tr>
<td>Surveys</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Survey taken by Coach</td>
<td>Trainee Assessment Survey (provided by coach)</td>
</tr>
<tr>
<td>Survey taken by Trainee</td>
<td>Coach Effectiveness Survey (provided by trainee)</td>
</tr>
<tr>
<td>Related KPIs</td>
<td></td>
</tr>
<tr>
<td>Improvement KPI</td>
<td>Number of reassigned open incidents</td>
</tr>
<tr>
<td>Strategic objective</td>
<td>Retrofit Staffing to include more global logistics</td>
</tr>
<tr>
<td>Snapshot Settings</td>
<td></td>
</tr>
<tr>
<td>Snapshot fields</td>
<td>Resolution code, Resolution notes, Work notes</td>
</tr>
</tbody>
</table>

**Identify and associate training content with a virtual coach**

Set virtual training conditions, containing training content, for automated coaching. Virtual training content is automatically attached to a coaching assessment when triggered.

Role required: sn_coaching.admin

Typical assigned training content includes micro trainings, best practices, tips, knowledge articles, videos, and community links.

You can access trainings by navigating to Coaching > Virtual Coach > Trainings.

1. Navigate to Coaching > Virtual Coach > All and click New to create a record.
2. Select the Table from which a coaching opportunity is generating assessments.
3. Assign a training as the training content for the virtual coaching record.
   a) In the Training field, click the search icon and create a new record.
      You can also access trainings by navigating to Coaching > Virtual Coach > Trainings navigation module.
   b) Select the Learning category for reporting purposes.
   c) Add the training Content, which can include a message, a link, a video, or source code.
      Training content automatically is attached to the coaching assessment when the virtual coaching record conditions are met.
4. To use an advanced script, select the Advanced check box and add your script.
   See Scripts for more information on scripting.
5. Add the condition that triggers the virtual coaching in the Condition field.
6. To set field values automatically, select Autofill fields and enter values.
Coaching admin sets up learning content

**Virtual Coaching form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CVC0000106</td>
</tr>
<tr>
<td>Short Description</td>
<td>Virtual Coach for the Incident Process</td>
</tr>
<tr>
<td>Table</td>
<td>Incident (Incident)</td>
</tr>
<tr>
<td>Training</td>
<td>CR0000106</td>
</tr>
<tr>
<td>Active</td>
<td>Selected</td>
</tr>
<tr>
<td>Advanced</td>
<td>Cleared</td>
</tr>
<tr>
<td>Condition</td>
<td>- Assigned to changes</td>
</tr>
<tr>
<td></td>
<td>- Configuration item is empty</td>
</tr>
<tr>
<td>Autofill fields</td>
<td>• State Resolved</td>
</tr>
<tr>
<td></td>
<td>• Performance rating N/A</td>
</tr>
</tbody>
</table>

**Training form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CR0000106</td>
</tr>
<tr>
<td>Title</td>
<td>Increase customer satisfaction by solving issues faster</td>
</tr>
<tr>
<td>Active</td>
<td>Selected</td>
</tr>
<tr>
<td>Category</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>Content</td>
<td>Watch this video to increase customer satisfaction by solving issues faster.</td>
</tr>
</tbody>
</table>

**Coaching your trainee**

A manager, or coach, is a subject matter expert of a process and is responsible for providing coaching to an employee, or trainee. Use the Coach Dashboard to manage and measure the effectiveness of your coaching.

You can access the Coaching Dashboard from the Coaching navigation menu, or directly from the dashboard list. Click a report to view the detailed data.

**Note:** You must have the Coaching coach role to view the Coach Dashboard.
Coaching begins once a trainee assessment has been assigned to you. Coaching assessments are triggered from a coaching opportunity that is set up by the coaching admin. Use coaching assessments to facilitate a dialog with your trainee, assign training content, and set a due date and other details.

The Coach Dashboard lets you manage the details and effect your coaching has on your trainees.

- Check the progress state of your coaching assessments.
- Analyze the number and types of follow-up actions necessary on your resolved coaching assessments.
- View the types of survey feedback from your trainees.
- View the number of your assessments that were resolved by the virtual coach.
- Check the performance rating of your trainees from your coaching.
- View the list of KPIs affected by your coaching.
- Verify the types of coaching opportunities that are being assigned to you (last 6 months).
Assess a trainee

Use a coaching assessment to review the work of a trainee and to provide training and feedback.

Role required: sn_coaching.coach

A trainee can view any field on the coaching assessment form and add comments to the to the Work notes field. A trainee can submit feedback for a coach using a survey when a coaching assessment is in resolved, closed complete, or closed incomplete state.

When an assessment is generated, all users in the Coach group receive a notification. Assessments are generated automatically (as the result of a coaching opportunity) or created manually. You can provide feedback for your trainees using a survey at any time during the coaching assessment.

You can create a coaching assessment from incidents, problems, change requests, or any other table that extends the task table. Enable the display of the Create Coaching Assessment button and create your assessments using that button. To enable display of the button:

- Configure the UI actions on the record.
- In the sn_coaching.CoachingExtensionPoint extension point, make sure the getCreateAssessmentUITables method is implemented to return the name of the tables.

1. Navigate to Coaching > Coaching Assessment and select a coaching assessment in the Open state.

You can take a survey using the Start Survey button to provide feedback for the trainee at any point during the assessment. After you complete the survey, the score is calculated using the Calculate coaching survey score business rule and is automatically populated in the Trainee Rating field. The trainee rating generates an assessment rating that is populated in the Assessment Rating field.
2. Fill in the fields on the Coaching Assessment form.
   a) Verify the Coach group, which is obtained from the coaching opportunity, is accurate.
   b) Set the coaching assessment Coach field to a coach.
   c) Set the Due date, after which time the coaching assessment is set to Closed Incomplete state.
      You can disable automatic closure behavior by deactivating the Close assessments after expiration scheduled job.

3. Fill in the fields in the Notes tab.
   a) Add a Description to the coaching assessment.
   b) Add Work notes to facilitate a dialog with the trainee.

4. Review the Snapshot content in the Snapshot tab and add your feedback in the Notes field.

5. Fill in the fields in the Feedback tab.
   a) Set the Assessment rating based on the coaching experience.
      When you submit feedback for a trainee, the score in the Trainee Rating field, which is based on a scale of 1-10 is converted to a rating such as good or excellent. This rating displays in the Assessment rating field.
   b) Set the Follow up action as part of coaching.

6. Review the skills applicable to the trainee in the Trainee Skillset related list.
   See Skills Management for more information.

7. Add assigned training content in the Assigned Trainings related list.

8. Review survey feedback for the trainee in the Survey Results related list.

9. When coaching is finished:
   a) Add a Summary of the coaching experience as an overview of your assessment.
   b) Set the coaching assessment to Resolved.

### Coach assesses trainee

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CAS0001004</td>
</tr>
<tr>
<td>Trainee</td>
<td>Trainee User 2</td>
</tr>
<tr>
<td>Record</td>
<td>Incident: INC0000055</td>
</tr>
<tr>
<td>Opportunity</td>
<td>COP0000109</td>
</tr>
<tr>
<td>State</td>
<td>Work in Progress</td>
</tr>
<tr>
<td>Coach group</td>
<td>Coach Group</td>
</tr>
<tr>
<td>Coach</td>
<td>Coach User 1</td>
</tr>
</tbody>
</table>
Assign skills after completing an assessment

Automatically assign skills to trainees for specific skill levels based on the training they have completed. For example, if a trainee completes training for learning Japanese at an expert level, then the skill level 'expert' can be assigned to the trainee.

Role required: sn_coaching.coach and sn_coaching.admin

You can associate skills with coaching opportunities, coaching assessments, or trainings. When a trainee completes a coaching assessment, you can automatically assign the skill the trainee has acquired during that coaching opportunity.

The coaching assessments generated from coaching opportunities award the skills to the trainee after the assessment is complete. If the assessment is configured to include assigned trainings, the skills associated with trainings are also added to the assessments.

1. Perform any of the following actions:
<table>
<thead>
<tr>
<th>Associate skills with coaching opportunities</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Navigate to Coaching &gt; Coaching Opportunities.</td>
<td></td>
</tr>
<tr>
<td>2. Select the record for which you want to associate a skill and skill level.</td>
<td></td>
</tr>
<tr>
<td>3. In the Skills Awarded on Assessment Completion related list, click New.</td>
<td></td>
</tr>
<tr>
<td>4. In the Skill field, click the lookup icon and select the skill to associate with this opportunity.</td>
<td></td>
</tr>
<tr>
<td>5. In the Skill level field, click the lookup icon and select the skill level for this opportunity.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Associate skills with coaching assessments</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Navigate to Coaching &gt; Coaching Assessments</td>
<td></td>
</tr>
<tr>
<td>2. Select the record for which you want to associate a skill and skill level.</td>
<td></td>
</tr>
<tr>
<td>The Award skills on completion check box must be enabled for the skills to be automatically awarded when an assessment is complete.</td>
<td></td>
</tr>
<tr>
<td>3. In the Skills Awarded by Assessment related list, click New.</td>
<td></td>
</tr>
<tr>
<td>4. In the Skill field, click the lookup icon and select the skill to associate with this assessment.</td>
<td></td>
</tr>
<tr>
<td>5. In the Skill level field, click the lookup icon and select the skill level for this assessment.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Associate skills with trainings</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Navigate to Coaching &gt; Trainings</td>
<td></td>
</tr>
<tr>
<td>2. Select the record for which you want to associate a skill and skill level.</td>
<td></td>
</tr>
<tr>
<td>3. In the Skills Awarded on Assessment Completion related list, click New.</td>
<td></td>
</tr>
<tr>
<td>4. In the Skill field, click the lookup icon and select the skill to associate with this training.</td>
<td></td>
</tr>
<tr>
<td>5. In the Skill level field, click the lookup icon and select the skill level for this training.</td>
<td></td>
</tr>
</tbody>
</table>

2. Click Submit.

You can navigate to the All Awarded Skills related list in a Coaching Assessments record for a trainee to view all skills to be awarded for that trainee. The Source field displays whether the award came from an opportunity, assessment, or training.

Managing your coaching assessments

Employees, or trainees, are assessed on work they have done that has triggered a coaching opportunity. Once assessed, the trainee is assigned training by the coach. Use the Trainee Dashboard to manage your assessments and track results.

You can access the Trainee Dashboard from the Coaching navigation menu, or directly from the dashboard list. Click a report to view the detailed data.

Note: You must have the Coaching trainee role to view your Trainee Dashboard.
Your training starts when your assessment has been assigned to a coach. Coaching assessments are triggered from a coaching opportunity set up by the coaching admin and are used to facilitate your learning, as well as providing a dialogue with your coach.

The Trainee Dashboard lets you manage your assessments and track results.

- Keep track of your active coaching assessments.
- Analyze how your assessments have been rated in the past.
- View the types of survey feedback from your coaches.
- Manage the full list of your coaching assessment details.
### My Assessment Details

<table>
<thead>
<tr>
<th>Number</th>
<th>Status</th>
<th>Coach</th>
<th>Comments</th>
<th>Tracking</th>
<th>Created</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Closed Complete</td>
<td>Coach User 1</td>
<td>Worked very well on the training.</td>
<td>Knowledge: K10123234</td>
<td>2020-12-06 16:56:34</td>
</tr>
<tr>
<td>2</td>
<td>Open</td>
<td>Coach User 1</td>
<td></td>
<td>Jirky</td>
<td>2020-12-06 16:56:27</td>
</tr>
<tr>
<td>3</td>
<td>Resolved</td>
<td>Coach User 1</td>
<td></td>
<td>Knowledge: K10123234</td>
<td>2020-12-06 16:56:33</td>
</tr>
<tr>
<td>4</td>
<td>Closed Complete</td>
<td>Coach User 1</td>
<td>Followed all the training and completed ...</td>
<td>Knowledge: K10123234</td>
<td>2020-12-06 16:56:23</td>
</tr>
</tbody>
</table>
## Work with your coach

Use your assessments to work with your coach, including assigned training and due dates. You can view your assessments and track your results using the Trainee Dashboard.

**Role required**: sn_coaching.trainee

You can provide feedback for your coach when the assessment is in resolved, closed complete, or closed incomplete state.

1. Navigate to **Coaching > Trainee Dashboard**.
2. Select an active **Coaching Assessment** record from the **My Assessment Details** list to view feedback from your coach.
3. View the **Notes** from your coach for coaching instructions.
4. Complete any learning content in the **Assigned Trainings** related list before the **Due date**.
5. Add any **Notes** for your coach that are applicable to your progress or learning status.
6. To provide feedback for the coach, click **Start Survey**. The **Provide Training Feedback** form appears.
7. Complete the feedback and click **Submit**.
   - The score for the survey is added to the **Coach rating** field.
8. To assess your survey results and other reports, navigate to **Coaching > Trainee Dashboard**.

## Trainee works on a coaching assessment

**Coaching Assessment form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Trainee</td>
<td>Trainee User 1</td>
</tr>
<tr>
<td>Record</td>
<td>Incident: INC000055</td>
</tr>
<tr>
<td>Opportunity</td>
<td>COP0000109</td>
</tr>
<tr>
<td>State</td>
<td>Resolved</td>
</tr>
<tr>
<td>Coach group</td>
<td>Coach Group</td>
</tr>
<tr>
<td>Coach</td>
<td>Coach User 1</td>
</tr>
<tr>
<td>Due date</td>
<td>2018-10-25 05:18:59</td>
</tr>
</tbody>
</table>
Coaching reference

Coaching reference content includes business rules and field descriptions.

Coaching on a non-task table

To provide coaching on a table source that does not extend the Task table, you must create a business rule to initiate the coaching process.

The business rule **Evaluate coaching opportunity on tasks** initiates coaching for tables that extend Task. You can copy this business rule and modify it for tables that do not extend the Task table.
A business rule is a server-side script that runs when a record is displayed, inserted, deleted, or when a table is queried. Use business rules to automatically change values in form fields when the specified conditions are met. More info

Name: Coaching opportunity create for User
Application: Global
Active: 
Advanced: 

When to run: 
Actions: 
Advanced: 

Condition: 
Script:

```javascript
(function executeRule(current, previous) {
  var coachingUtil = new sn_coaching.CoachingUtils();
  coachingUtil.evaluateOpportunities(current, previous);}
}()).create, previous);```


Coaching assessment flow states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>New coaching opportunity.</td>
</tr>
<tr>
<td>Work in Progress</td>
<td>Trainee is being coached.</td>
</tr>
<tr>
<td>Resolved</td>
<td>All learnings and coaching in the assessment have been completed successfully.</td>
</tr>
<tr>
<td>Closed Complete</td>
<td>Assessment has been resolved and closed.</td>
</tr>
<tr>
<td>Closed Incomplete</td>
<td>Assessment has been closed but was not completed, typically because the coaching assessment Due date has expired.</td>
</tr>
</tbody>
</table>

Form and list permissions

<table>
<thead>
<tr>
<th>Element</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaching Opportunity</td>
<td>• sn_coaching.admin: create, write, delete</td>
</tr>
<tr>
<td></td>
<td>• sn_coaching.coach: read</td>
</tr>
<tr>
<td></td>
<td>• sn_coaching.trainee: none</td>
</tr>
<tr>
<td>Coaching Assessment</td>
<td>• sn_coaching.admin: create, write, delete</td>
</tr>
<tr>
<td></td>
<td>• sn_coaching.coach: create, write own or group assessment</td>
</tr>
<tr>
<td></td>
<td>• sn_coaching.trainee: read own assessment, write own assessment work notes</td>
</tr>
<tr>
<td>Training History</td>
<td>• sn_coaching.admin: view</td>
</tr>
<tr>
<td></td>
<td>• sn_coaching.coach: view</td>
</tr>
<tr>
<td></td>
<td>• sn_coaching.trainee: none</td>
</tr>
<tr>
<td>Assigned Training</td>
<td>• sn_coaching.admin: create, write, delete</td>
</tr>
<tr>
<td></td>
<td>• sn_coaching.coach: create, write and delete own training action</td>
</tr>
<tr>
<td></td>
<td>• sn_coaching.trainee: view</td>
</tr>
<tr>
<td>Element</td>
<td>Permissions</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Training       | • sn_coaching.admin: create, write, delete  
                 | • sn_coaching.coach: create, write and delete own training  
                 | • sn_coaching.trainee: view |
| Virtual Coachings | • sn_coaching.admin: create, write, delete  
                   | • sn_coaching.coach: read, and associate existing virtual coach to a coaching opportunity  
                   | • sn_coaching.trainee: none |
| Virtual Coach  | • sn_coaching.admin: create, write, delete  
                   | • sn_coaching.coach: create, write and delete own virtual coaching  
                   | • sn_coaching.trainee: none |

**Coaching field descriptions**

Coaching field descriptions also include form related lists and actions.

**Coaching Opportunity form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique (COP) number for the coaching opportunity.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name for the coaching opportunity.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the coaching opportunity.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to use for the coaching opportunity.</td>
</tr>
<tr>
<td>Trainee</td>
<td>Field from the selected table that identifies the trainee.</td>
</tr>
<tr>
<td>Trainee group</td>
<td>Limit the trainees identified in the Trainee field to a group or groups of users.</td>
</tr>
<tr>
<td>Specify coach user</td>
<td>Check box to enable the Coach field.</td>
</tr>
<tr>
<td>Coach</td>
<td>Field from the selected table that identifies the coach.</td>
</tr>
<tr>
<td>Coach group</td>
<td>Group of coaches that assess and provide feedback to trainees.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the coaching opportunity, Clear the check box to disable.</td>
</tr>
</tbody>
</table>
### Frequency tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger</td>
<td>Event that triggers a coaching opportunity for the selected table. Conditions for opportunities are generally unique events, such as when an incident is reassigned.</td>
</tr>
<tr>
<td>Random sample (%)</td>
<td>Percentage of the total assessments that get created. Use a random sample percentage to reduce the number of assessments that are created if too many events that meet the criteria for creating a coaching assessment occur.</td>
</tr>
<tr>
<td>Users who should be coached on every opportunity</td>
<td>Users that always get coached, regardless of random sample percentage. Because the specified users are exempted from the random sample percentage, a coaching assessment is always created when the assessment is triggered. Selected users might be new hires, for example, or others who require additional coaching.</td>
</tr>
</tbody>
</table>

**Note:** Only shown if the Random sample (%) is less than 100.

| Assessment duration                        | Amount of time before the assessment is set to Closed Complete state.                                                                                                                                       |
| Prevent duplicate assessment               | Check box to prevent an assessment from being created within a specified time period if one exists for that user for the same opportunity.                                                                 |
| Within time period                         | Time period within which duplicate assessments are not created.                                                                                                                                               |

**Note:** This field appears only when Prevent duplicate assessment check box is selected.

### Surveys tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey taken by trainee</td>
<td>Survey selected for the trainee to provide additional feedback.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
Survey taken by coach | Survey selected for the coach to provide additional feedback.

### Related KPIs tab

| Field | Description |
---|---|
Improvement KPI | Primary KPI used to measure the success of the coaching opportunity. |
Strategic objective | Strategic objective affected by the coaching opportunity. |

### Snapshot Settings tab

| Field | Description |
---|---|
Snapshot fields | Field values to show in the coaching assessment unless an advanced script is used. |
Advanced | Check box to use a script to determine the content for the snapshot. |
Snapshot script | Script that defines the evaluation process applied to the selected table. Select the fields from the table for which you want to capture the values. For example, when analyzing the Incident table, use #{number} to display the record number (such as INC0010002) for the incident record that triggered the coaching opportunity. |

**Note:** This field appears only if the Advanced check box is selected.

### Coaching Assessment form

| Field | Description |
---|---|
Number | Unique (CAS) number for the coaching assessment. |
Trainee | Trainee user that triggered the assessment in the coaching opportunity. |
Record | Record associated with the assessment triggered in coaching opportunity. |
Opportunity | Coaching opportunity number associated with the coaching assessment. |
<table>
<thead>
<tr>
<th>State</th>
<th>State of the assessment.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Open</strong>: New coaching opportunity.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Work in Progress</strong>: Trainee is being coached.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Resolved</strong>: All coaching and learnings have been provided to the trainee.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Learnings may not have been completed by the trainee.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Closed Complete</strong>: Assessment has been resolved and closed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Closed Incomplete</strong>: Assessment has been closed but was not completed, typically because the coaching assessment <strong>Due date</strong> has expired.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Coach group</th>
<th>Group of coaches to which the assessment is assigned.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Default value is populated from the coaching opportunity form.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Coach</th>
<th>Coach user performing the assessment.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This field is typically set by the coach before performing the assessment, but can also be set by a member of the coach group or by the coaching admin.</td>
</tr>
</tbody>
</table>

| Due date    | Date the assessment is due. After this time, the assessment is set to **Closed Incomplete** state. |

**Notes tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description of the assessment.</td>
</tr>
</tbody>
</table>

| Work notes  | Notes about the assessment (journal field). Additional notes can be added as the coach and trainee engage in further dialogue. |

**Snapshot tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snapshot</td>
<td>Field contents of the task, action, or behavior captured at the time the coaching opportunity was triggered.</td>
</tr>
</tbody>
</table>
# Feedback tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment rating</td>
<td>Value of the performance of the trainee for reporting and trend-tracking purposes.</td>
</tr>
<tr>
<td></td>
<td>· Excellent&lt;br&gt;   · Good&lt;br&gt;   · Average&lt;br&gt;   · Poor&lt;br&gt;   · Unacceptable</td>
</tr>
<tr>
<td>Follow up Needed</td>
<td>Further action required, if any, to improve the performance of the trainee.</td>
</tr>
<tr>
<td></td>
<td>· Recognize: Trainee needs recognition for good performance.</td>
</tr>
<tr>
<td></td>
<td>· Needs Additional Coaching: Trainee needs additional feedback from the coach.</td>
</tr>
<tr>
<td></td>
<td>· Needs Outside Training: Trainee needs additional training outside the scope of the coaching assessment.</td>
</tr>
<tr>
<td></td>
<td>· Referral to Manager: Indicates a major issue with the trainee performance.</td>
</tr>
<tr>
<td></td>
<td>· Create Virtual Coach</td>
</tr>
<tr>
<td></td>
<td>· No Follow Up</td>
</tr>
</tbody>
</table>

| Summary                    | Summary of the coaching assessment.                                                                                                           |

## Coaching Assessment actions

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete Assessment</td>
<td>Set the coaching assessment to Closed Complete state.</td>
</tr>
<tr>
<td>Reopen Assessment</td>
<td>Change the coaching assessment state from Resolved or Closed Complete back to Work In Progress for additional action.</td>
</tr>
<tr>
<td></td>
<td>Either the coach or the trainee can reopen the coaching assessment.</td>
</tr>
<tr>
<td>Submit feedback</td>
<td>Feedback submitted by either a trainee or a coach from the survey form.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the coaching assessment from the Assessment Created by Opportunity list.</td>
</tr>
</tbody>
</table>
### Virtual Coaching form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>Description of the virtual coaching (CVC) record.</td>
</tr>
<tr>
<td>Table</td>
<td>Table source of coaching opportunity events.</td>
</tr>
<tr>
<td>Training</td>
<td>Record that contains related training content.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the virtual coaching. Clear the check box to disable.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check box to use a script to determine when the automation triggers.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Event that triggers a virtual coaching for the selected table.</td>
</tr>
<tr>
<td></td>
<td>Conditions for virtual coachings are generally unique events.</td>
</tr>
<tr>
<td>Script</td>
<td>Script that defines the evaluation process applied to the selected table.</td>
</tr>
<tr>
<td></td>
<td>Select the fields from the table to capture the values for.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Only shown if [Advanced] check box is selected.</td>
</tr>
<tr>
<td>Autofill fields</td>
<td>Fields to autofill under certain conditions.</td>
</tr>
</tbody>
</table>

### Training form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique (CMC) number of the training.</td>
</tr>
<tr>
<td>Title</td>
<td>A short description for the training.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of learning content, which is used for reporting.</td>
</tr>
<tr>
<td></td>
<td>- Customer experience</td>
</tr>
<tr>
<td></td>
<td>- Best Practice Series</td>
</tr>
<tr>
<td></td>
<td>- Soft-Skill Communication</td>
</tr>
<tr>
<td></td>
<td>- Behavioral Coaching</td>
</tr>
<tr>
<td></td>
<td>- Product Support</td>
</tr>
<tr>
<td>Content</td>
<td>Content for assigned users to learn.</td>
</tr>
</tbody>
</table>

The **Preview Message** related list shows the learning content in the context of the trainee.
## Coaching troubleshooting

Troubleshooting actions can help resolve common issues when setting up or running Coaching.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error after creating a coaching opportunity: You must create a business rule for a non-task type source table to trigger a coaching assessment. For more information, refer to <a href="http://docs.servicenow.com/?context=CSHelp:Coaching-Non-Task-Table">http://docs.servicenow.com/?context=CSHelp:Coaching-Non-Task-Table</a>.</td>
<td>Create a business rule to initiate the coaching process for a non-task type table. Copy the Coaching Opportunity creator for Task business rule and modify it for tables that do not extend Task.</td>
</tr>
<tr>
<td>Do not automatically close a coaching assessment after the due date has passed.</td>
<td>Deactivate the Close assessments after expiration scheduled job in System Definition &gt; Scheduled Jobs.</td>
</tr>
<tr>
<td>Coaching assessment is not created.</td>
<td>These resolutions are applicable to a coaching assessment not being created:</td>
</tr>
<tr>
<td></td>
<td>• Add the trainee as a member of the trainee group.</td>
</tr>
<tr>
<td></td>
<td>• Clear the Prevent duplicate assessment check box if the trainee already has a coaching assessment for the same coaching opportunity.</td>
</tr>
<tr>
<td></td>
<td>• Include the trainee in the Users who should be coached on every opportunity list when the Random sample (%) is less than 100.</td>
</tr>
<tr>
<td>I need to override ACLs and trainings for the Assigned Training related list on the Coaching Opportunity and Coaching Assessment forms.</td>
<td>Implement Coaching extension points:</td>
</tr>
<tr>
<td></td>
<td>• CoachingExtensionPoint</td>
</tr>
<tr>
<td></td>
<td>• CoachingACLEXTensionPoint</td>
</tr>
</tbody>
</table>

## Quick start tests for Coaching

Validate that Coaching still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Coaching quick start tests require activating the Coaching plugin (com.sn_coaching).

### Coaching test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaching: Create an assessment manually when logged in as a coach.</td>
<td>As a coach, verify that you can create an assessment and assign it to trainees.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Coaching: Add skills to an opportunity and verify those skills awarded to trainee.</td>
<td>Add skills to a coaching opportunity and verify that those skills have been awarded to trainees after they complete an assessment.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Coaching: Complete an assessment as a virtual coach.</td>
<td>Verify that the virtual coach completes an assessment and provides feedback to the trainee when a virtual coach is attached to an opportunity.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Coaching: Add skills to an assessment and verify those skills awarded to trainee.</td>
<td>Add skills to a coaching assessment and verify that those skills have been awarded to trainees after they complete an assessment.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Coaching: Add skills to a recommendation and verify those skills awarded to trainee.</td>
<td>Add skills to a coaching recommendation and verify that those skills have been awarded to trainees after they complete an assessment.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Coaching: Move assessments from one state to another when logged in as a coach.</td>
<td>As a coach, verify that you can move an assessment from one state to another.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Coaching: Attach a recommendation learning to an assessment.</td>
<td>Verify that a recommendation learning on an opportunity gets attached to an assessment when an assessment is generated.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Coaching: When a coaching opportunity is inactive, assessments are not generated.</td>
<td>Verify that when a coaching opportunity is in inactive state, it does not generate assessments.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

**Continual Improvement Management**

Use the ServiceNow® Continual Improvement Management (CIM) application to request improvement opportunities, and implement phases and tasks to meet performance goals, track progress, and measure success.

An improvement initiative consists of:

- Goals to measure success
- Phases to organize work effort
- Tasks with specific actions to complete

To learn more about how your ServiceNow instance supports Continual Improvement Management, see [Continual Improvement Management overview](#) for a general understanding of the application and how it is used.
Listen to this 24-minute podcast for a discussion of the Continual Improvement Management application.

**Start an improvement**

For continual improvement in your environment, select an activity.

- Incident/Problem
- Demand
- Benchmarks
- Surveys

**Implement Improvement**

- Measurement
- Tasks

**Monitor Improvement**

- Workbench
- Dashboard

**Understand Continual Improvement Management concepts**

- Continual Improvement Management overview
- Requesting improvements
- Managing improvements
- Domain separation and Continual Improvement Management

**Get help from ServiceNow resources**

- Ask or answer questions in the Continual Improvement Management forum
Request Continual Improvement Management

The Continual Improvement Management (com.sn_cim) plugin requires a separate subscription and must be activated by ServiceNow personnel. This plugin includes demo data and activates related plugins if they are not already active. The Continual Improvement Management application is available with the ITSM Professional and CSM Professional subscription only. Contact your account manager for more information.

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization's production and subproduction instances, generally within a few days.

If you don't have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.

Role required: none

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.
4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note**: Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click Submit.

**Continual Improvement Management overview**

Enable Continual Improvement Management (CIM) and then set up roles, groups, and integration properties to improve your organization's processes and functions. You can use the CIM workbench and dashboard to monitor, plan, and measure improvement success.

The video below gives you an overview of Continual Improvement Management application.

Continual Improvement Management is used to implement service, process, and function improvements. An improvement initiative contains goals to measure success, and phases that contain tasks with specific actions to complete the improvement.
Use the *Continual Improvement Workbench* to plan and manage improvements. Both tile and list views are supported.

The *Continual Improvements dashboard* shows progress and results in the form of statistics and charts using Performance Analytics.

To use guided setup to configure and set up Continual Improvement Management application, navigate to *Continual Improvement > Administration > Guided Setup* and click *Configure* in the Request CIM section.

**Integration with other applications**

As part of Continual Improvement Management integration with other applications, an improvement initiative can be created from within other applications, and conversely, records for other applications can be created from within an improvement initiative (or CIM task).

An improvement initiative can be created from these applications:

- Benchmarks
- Coaching
- Configuration Management Database
- Demand Management
- Governance, Risk, and Compliance
- Idea Portal
- Incident Management
- Problem Management
- Process Optimization
- Survey Management
- Vendor Manager Workspace

As part of an improvement initiative or CIM task, these records can be created:

- Change record (*Change Management*)
- Coaching opportunity (*Coaching*)
- Demand record (*Demand Management*)
- Knowledge base article (*Knowledge Management*)
- Project (*Project Management*)
- Story record (*Agile Development*)

**Initial CIM setup**

Once Continual Improvement Management has been enabled, set up the application by assigning user roles and groups, and configuring integration properties.

- Assign user *roles* and groups.
  - Improvement Manager role
  - Improvement Coordinator role
  - Approver group membership (CIM Approvers, default is empty)

- Configure properties for Continual Improvement Management integration with other applications.
  - List of applications from which an improvement initiative can be created.
Workflow of Continual Improvement Management roles

Improvement requests are submitted when an Improvement Requester, such as a help desk manager, process owner, or ITL user, for example, recognizes the need for an improvement anywhere within the company.

When an improvement request is submitted, the Improvement Manager, reviews the improvements, accepts, and assigns it to an Improvement Coordinator for implementation. The Improvement Manager also runs prioritization meetings with Improvement Coordinators and uses the workbench to monitor, manage, and plan overall progress.

After the improvement request is assigned, the Improvement Coordinator along with the Improvement manager, creates phases and tasks to complete the improvement. The Improvement Coordinator also meets with task owners to ensure that they are on track to meet the deadline.

When all work has been completed, the Improvement Manager reviews the improvement for closure, and uses the dashboard reports to measure the status and success of the request.

Email notification

Email notifications are sent when the state of the improvement request changes or when the target date is breached.
Domain separation

Domain separation capability is supported in Continual Improvement Management with no setup or configuration required.

You can create improvements separately in a specific domain, or in the global domain.

Domain separation and Continual Improvement Management

Domain separation in Continual Improvement Management is configured to apply to all features of the application. Separation of data is configured along with separation of logic and process. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Basic

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

Overview

When an improvement opportunity is discovered within your organization, you can implement the improvement in a structured manner using Continual Improvement Management with domain separation.

Once an improvement initiative is created, the Improvement Manager uses the Improvement Register to review and prioritize the improvement, and assigns improvement tasks. CIM task owners are responsible to fulfill assigned tasks to the desired outcome of that improvement. Both Improvement Register and CIM Task tables support domain separation so the Improvement

<table>
<thead>
<tr>
<th>Improvement action</th>
<th>Improvement Manager</th>
<th>Improvement Coordinator</th>
<th>Improvement Requester</th>
<th>Watch list</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canceled</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Approved</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Closed</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Target review date is breached</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Requester, task owners, Improvement Coordinator, and Improvement Manager can view only the improvement initiatives and related tasks within the (tenant) domain to which they belong.

**How domain separation works in Continual Improvement Management**

Domain separation is supported in Continual Improvement Management with no CIM setup or configuration required. Improvements can be created in separate domains, including the global domain.

Continual Improvement Management extends the platform Task (task) table.

When domain separation is implemented, CIM users can view and request improvements initiatives only in the domain assigned. **Domain** and **Domain Path** columns are available for two main CIM tables (Improvement Register and CIM Tasks) provided with the base system. The **Domain** column contains the name of the domain to which the event or alert belongs, and the **Domain Path** column contains the unique domain identifier.

<table>
<thead>
<tr>
<th>Table</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>(sn_cim_register)</td>
<td>Improvement Initiatives</td>
</tr>
<tr>
<td>(sn_cim_task)</td>
<td>CIM Tasks</td>
</tr>
</tbody>
</table>

**Note:** If the domain column is not shown, click the Update Personalized List icon and add the required column. You can also add the domain path column, if desired.

**Use cases:**

- An Improvement Requester that belongs to the Acme domain creates an improvement initiative and wants to view it.
  
  A user must belong to the Acme domain, its parent domain, or the global domain to view the improvement initiative.

- An Improvement Manager that belongs to a parent domain tries to view an improvement initiative in a child domain.
  
  The user of a parent domain can view improvement initiatives of the parent as well as all child domains of that parent.

- An Improvement Requester that belongs to Acme domain wants to create an improvement initiative on behalf of another user in the Acme domain.
  
  A user must belong to the same domain as the user for which the improvement initiative is created.

- An Improvement Requester wants to associate a record for an integrated application in the Acme domain.
  
  A user must belong to the domain of the integrated application from which a record is associated.

- An Improvement Manager has access to multiple domains, but wants to update a record with content within a specific domain.
  
  The domain specified for the current record drives the functionality of that record and reference fields.
## Continual Improvement Management roles

Use Continual Improvement Management roles to specify what different users and user groups can see and do.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Roles inherited</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_cim.improvement_requester (Improvement Requester)</td>
<td>Able to perform these application functions:</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>• Create improvement initiative</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View My CIM requests</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View Watched CIM requests</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View All CIM requests</td>
<td></td>
</tr>
<tr>
<td>sn_cim.improvement_coordinator (Improvement Coordinator)</td>
<td>Able to perform all functions for improvements to which they are assigned as Improvement Coordinator except:</td>
<td>• sn_cim.improvement_requester</td>
</tr>
<tr>
<td></td>
<td>• Create Enterprise Strategies</td>
<td>• app_service_user</td>
</tr>
<tr>
<td></td>
<td>• Delete improvement</td>
<td>• certification</td>
</tr>
<tr>
<td></td>
<td>Although able to perform Improvement Manager functions, an Improvement Coordinator can only perform those functions for improvements that they are assigned as Improvement Coordinator by the Improvement Manager.</td>
<td>• cmdb_query_builder</td>
</tr>
<tr>
<td></td>
<td>Primary responsibility is to coordinate improvements within their area of expertise (at the process or service level).</td>
<td>• dependency_views</td>
</tr>
<tr>
<td></td>
<td>Can access both Continual Improvement Workbench and dashboard.</td>
<td>• itil</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Problem/change/incident records can be added.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• knowledge</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_analyst</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_contributor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_power_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Existing Performance Analytics indicators can be accessed, and new ones created.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_target_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_threshold_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_bm_client.benchmark_data_viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_bm_client.benchmark_recommendation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Benchmarks data and recommendations can be viewed and an improvement initiative can be created from Benchmarks recommendations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• template_editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• view_changer</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Roles inherited</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_cim.improvement_manager (Improvement Manager)</td>
<td>Able to perform all application functions. The Improvement Manager is primarily responsible for all improvements, including initial acceptance of new improvement requests, assignment, and closure. The Improvement Manager also monitors the overall progress of all improvements.</td>
<td>sn_cim.improvement_coordinator</td>
</tr>
</tbody>
</table>

### Automatic assignment of the sn_cim.improvement_requester role

The sn_cim.improvement_requester role is automatically assigned to these roles upon Continual Improvement Management activation so these users can create an improvement request.

<table>
<thead>
<tr>
<th>Application</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITBM (only if ITBM plugins are active)</td>
<td>scrum_master</td>
</tr>
<tr>
<td>Agile Development</td>
<td>it_demand_manager</td>
</tr>
<tr>
<td>Demand Management</td>
<td>it_portfolio_manager</td>
</tr>
<tr>
<td>Portfolio Management</td>
<td>it_program_manager</td>
</tr>
<tr>
<td>Program Management</td>
<td>it_project_manager</td>
</tr>
<tr>
<td>Project Management</td>
<td>tm_test_manager</td>
</tr>
<tr>
<td>Test Management</td>
<td></td>
</tr>
<tr>
<td>ITSM</td>
<td></td>
</tr>
<tr>
<td>Benchmarks</td>
<td>sn_bm_client.benchmark_admin</td>
</tr>
<tr>
<td></td>
<td>sn_bm_client.benchmark_recommendation_viewer</td>
</tr>
<tr>
<td>Change Management</td>
<td>change_manager</td>
</tr>
<tr>
<td>Coaching</td>
<td>sn_coaching.admin</td>
</tr>
<tr>
<td>Incident Management</td>
<td>incident_manager</td>
</tr>
<tr>
<td>ITSM</td>
<td>itil</td>
</tr>
<tr>
<td>Survey Management</td>
<td>survey_admin</td>
</tr>
<tr>
<td>Assessments</td>
<td>survey_reader</td>
</tr>
<tr>
<td>Performance Analytics and Reporting</td>
<td></td>
</tr>
</tbody>
</table>
Monitor and plan improvements

Use the Continual Improvement Workbench to monitor and plan improvements in a single view. The workbench shows tile and list views of improvements in progress, as well as listings under review, and in the backlog to help you plan your sprint.

Role required: sn_cim.improvement_manager, sn_cim.improvement_coordinator

The workbench is a flexible graphical view that you can tailor to your needs, which is helpful for the Improvement Manager when running planning meetings and when doing a quick status update to other stakeholders.

The tile-based drag-and-drop user interface makes it easy to monitor, plan, and approve improvements.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview tab</td>
<td>Shows two groups of improvements.</td>
</tr>
<tr>
<td></td>
<td>• Tiles in Implement and On Hold states.</td>
</tr>
<tr>
<td></td>
<td>• Listings in Review state.</td>
</tr>
<tr>
<td></td>
<td>This list can be customized in the Workbench Review list layout.</td>
</tr>
<tr>
<td></td>
<td>Use this section for daily monitoring and assessment of improvements being implemented, as well as those recently implemented that are in review.</td>
</tr>
<tr>
<td>Planning tab</td>
<td>Lists two groups of improvements.</td>
</tr>
<tr>
<td></td>
<td>• Listings in Implement and On Hold states.</td>
</tr>
<tr>
<td></td>
<td>• Listing for backlog (New, Accepted, Assess, and Approved states).</td>
</tr>
<tr>
<td></td>
<td>Use this section for ranking and prioritization of improvements in the Implement state, or in the backlog (improvement initiatives in Approved, Assess, Accepted, and New states, listed in that order).</td>
</tr>
</tbody>
</table>

Note: Configuration changes made to the Planning workbench are reset when the Planning workbench is reloaded.
## Work in Progress

<table>
<thead>
<tr>
<th>Number</th>
<th>Short description</th>
<th>Priority</th>
<th>State</th>
<th>Planned end date</th>
<th>Effort estimate</th>
<th>CM Coordinator</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Bank Management</td>
<td>High</td>
<td>In Progress</td>
<td>In 6 months</td>
<td>Large</td>
<td>Adam Turner</td>
</tr>
<tr>
<td>2</td>
<td>Survey Results e.g. Customers are unhappy about the slow processing of ticket requests</td>
<td>Low</td>
<td>In Progress</td>
<td>In 3 months</td>
<td>Small</td>
<td>Jeff Alexander</td>
</tr>
<tr>
<td>3</td>
<td>Release Management: A number of issues have been resolved when implementing updated or new</td>
<td>High</td>
<td>In Progress</td>
<td>In 3 months</td>
<td>Large</td>
<td>Adam Turner</td>
</tr>
<tr>
<td>4</td>
<td>CRM Decrease in the number of completed initiatives that have not achieved their objectives</td>
<td>High</td>
<td>In Progress</td>
<td>In 3 months</td>
<td>Large</td>
<td>Jeff Alexander</td>
</tr>
<tr>
<td>5</td>
<td>Knowledge Improvement: Knowledge base does not exist for Problem Management</td>
<td>Low</td>
<td>In Progress</td>
<td>In 3 months</td>
<td>Large</td>
<td>Adam Turner</td>
</tr>
<tr>
<td>6</td>
<td>Adoption: Improve adoption of new HR application</td>
<td>Low</td>
<td>In Progress</td>
<td>2 months ago</td>
<td>Small</td>
<td>Alicia Ceravola</td>
</tr>
<tr>
<td>7</td>
<td>New App: Improve Continuous feedback by implementing Coaching Loop App</td>
<td>Low</td>
<td>In Progress</td>
<td>In 3 months</td>
<td>Small</td>
<td>Jeff Alexander</td>
</tr>
<tr>
<td>8</td>
<td>Increase average handle time to resolve an incident by 2%</td>
<td>Low</td>
<td>In Progress</td>
<td>In 3 months</td>
<td>Medium</td>
<td>Alicia Ceravola</td>
</tr>
<tr>
<td>9</td>
<td>Improvement of Lead time per incident</td>
<td>Low</td>
<td>In Progress</td>
<td>In 1 month</td>
<td>Medium</td>
<td>Alicia Ceravola</td>
</tr>
<tr>
<td>10</td>
<td>Enhanced business and stakeholder confidence by ensuring consistent level of quality of service at all times</td>
<td>Low</td>
<td>In Progress</td>
<td>2 months ago</td>
<td>Medium</td>
<td>Adam Turner</td>
</tr>
</tbody>
</table>

## Backlog

<table>
<thead>
<tr>
<th>Number</th>
<th>Short description</th>
<th>Priority</th>
<th>State</th>
<th>Planned end date</th>
<th>Effort estimate</th>
<th>CM Coordinator</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Change Management: Ensure multiple authorization channels have equal access to data</td>
<td>High</td>
<td>New</td>
<td>In 4 months</td>
<td>Large</td>
<td>Adam Turner</td>
</tr>
<tr>
<td>2</td>
<td>IR: Bank: The incident backlog is on continuous rise. Come up with a solution to keep it under control</td>
<td>Moderate</td>
<td>Accepted</td>
<td>In 3 months</td>
<td>Medium</td>
<td>Jeff Alexander</td>
</tr>
<tr>
<td>3</td>
<td>Quality improvements: Decrease in business user complaints or issues about the content and quality</td>
<td>Low</td>
<td>New</td>
<td>In 5 months</td>
<td>Large</td>
<td>Jeff Alexander</td>
</tr>
<tr>
<td>4</td>
<td>Major incident Management: Ensure all field major incidents related problems are documented</td>
<td>Critical</td>
<td>Accepted</td>
<td>In 4 months</td>
<td>Medium</td>
<td>Alan Turner</td>
</tr>
<tr>
<td>5</td>
<td>Reduce average age of open incidents</td>
<td>Low</td>
<td>Approved</td>
<td>In 3 months</td>
<td>Small</td>
<td>Jeff Alexander</td>
</tr>
<tr>
<td>6</td>
<td>Increase the average priority level of incidents above 7</td>
<td>Moderate</td>
<td>New</td>
<td>In 3 months</td>
<td>Medium</td>
<td>Jeff Alexander</td>
</tr>
<tr>
<td>7</td>
<td>Increased value in knowledge management satisfaction survey of service operation teams</td>
<td>Low</td>
<td>Approved</td>
<td>In 3 days ago</td>
<td>Large</td>
<td>Jeff Alexander</td>
</tr>
<tr>
<td>8</td>
<td>Increase in number of incidents under Release Management</td>
<td>Low</td>
<td>Approved</td>
<td>In 3 months</td>
<td>Medium</td>
<td>Jeff Alexander</td>
</tr>
</tbody>
</table>
Features:

- Tile layout (12 improvement tiles shown by default).
- Search by keyword.
- Sort by rank, priority, due date, or effort estimate.
- Status on tile (percentage complete, assignment, priority, and time left)

  Percentage complete is based on the number of completed tasks in each phase of the improvement. Percent complete values are shown per phase, and per improvement.
- Color-coded status badge on tile.

<table>
<thead>
<tr>
<th>Status badge</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete</td>
<td>All tasks have been completed (percent complete is 100%).</td>
</tr>
<tr>
<td>Overdue</td>
<td>Due date has passed.</td>
</tr>
<tr>
<td>Due soon</td>
<td>Less than 15% of duration left until the due date.</td>
</tr>
<tr>
<td>On Hold</td>
<td>Improvement has been placed on hold.</td>
</tr>
</tbody>
</table>

- Customize fields shown in workbench lists using the Workbench Review view.

Access the Workbench Review view from the List Controls menu (List Controls > View > Workbench Review).

Note: Only the fields visible in the Improvement Register (Workbench Review) view are shown in the workbench overview section.

On the planning page, you can prioritize your backlog using an easy-to-use drag-and-drop interface, similar to sprint planning, where you have an active sprint and a list of backlog items. Move backlog items to the Work in Progress list, which is your active sprint.
Features:
- Color coding on Planned end date field (red, green)
- Search by keyword.
- Move items up or down a list.
- Group multiple items together.
- Drag and drop within and between lists.

**Note:** Moving an item, or group of items, from one list to another changes the state of the improvement.

For example, moving an item from Backlog to Work in Progress changes the state from Approved to Implement. Conversely, moving an item from Work in Progress back to the Backlog changes the state to Approved.

Only approved items can be moved from the Backlog list to the Implement list.

- Customize fields shown in workbench lists using the Workbench Planning view.

   Access the Workbench Planning view from the List Controls menu ( ) of the Improvement Register (List Controls > View > Workbench Planning).

- Filter by priority, benefits, effort estimate, and CIM Coordinator.

  **Note:** The filters are dynamic and show only the fields visible in the Workbench Planning view.

- Toggle the Filter menu and fields shown using the Configuration menu ( ).

  **Note:** Only the fields visible in the Improvement Register (Workbench Planning) view are shown in the workbench planning section.

1. Navigate to Continual Improvement > Workbench.
2. On the Overview tab, analyze the Work in Progress tiles to get an overall picture of the improvements in progress.
   Color-coded alert banners call out improvements that need attention. You can click on a tile to view the improvement.
3. Use the Planning tab to build the contents of your current sprint, according to capacity.
   a) Drag and drop items from the Backlog list to the Work in Progress list.
   b) Use the filters (Priority, Benefits, Effort Estimate, and CIM Coordinator) to narrow the data contained in the lists so you can focus on certain groups of improvements.
4. Use the Configuration menu to customize the columns shown in the Planning tab lists that is specific to your needs.
View improvement reports

Evaluate improvement results using the Continual Improvements dashboard overview and outcome analysis reports to determine how well the improvements are helping your company.

Role required: sn_cim.improvement_manager, sn_cim.improvement_coordinator

Reports and Spotlight list can be filtered by improvement priority, state, business process, business service, benefits, and CIM coordinator.
Priority

- 27

State

- Unassigned

Business Process

- All

Business Service

- All

Prioritized List Using Spotlight

<table>
<thead>
<tr>
<th>Number</th>
<th>Short description</th>
<th>CMW Coordinator</th>
<th>Priority</th>
<th>State</th>
<th>Benefits</th>
<th>Effort estimate</th>
<th>Due date</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CM: Decrease in the number of completed initiatives that have not achieved their objective</td>
<td>Alexander Laval</td>
<td>2 - High</td>
<td>Implement</td>
<td>High</td>
<td>Large</td>
<td>2018-06-23</td>
<td>133</td>
</tr>
<tr>
<td>2</td>
<td>Major Incident Management: Ensure all major incidents related Problems are documented in the known error database.</td>
<td>Abdi Tuur</td>
<td>1 - Critical</td>
<td>Accepted</td>
<td>High</td>
<td>Medium</td>
<td>2018-06-24</td>
<td>133</td>
</tr>
<tr>
<td>3</td>
<td>Training Issue: Service Desk staff would benefit from additional training on on-boarding application</td>
<td>Adeel Gwamukt</td>
<td>2 - High</td>
<td>Monitor/Review</td>
<td>High</td>
<td>Large</td>
<td>2018-06-27</td>
<td>133</td>
</tr>
<tr>
<td>4</td>
<td>Change Management: Having multiple authorization channels have caused issues with some users because of</td>
<td>Abdi Tuur</td>
<td>2 - High</td>
<td>New</td>
<td>High</td>
<td>Large</td>
<td>2018-08-20</td>
<td>133</td>
</tr>
</tbody>
</table>
Overview:

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Engagement</td>
<td>Open improvement count from the last six months.</td>
</tr>
<tr>
<td>Total Initiatives</td>
<td>Improvement count by state.</td>
</tr>
<tr>
<td>Open Backlog</td>
<td>Number of open improvements.</td>
</tr>
<tr>
<td>Unassigned</td>
<td>Number of improvements without a CIM Coordinator assigned.</td>
</tr>
</tbody>
</table>

- Prioritized List Using Spotlight.

To use Spotlight to help prioritize the improvement backlog, navigate to Continual Improvement > Administration > Spotlight Config.

Improvements can be prioritized based on multiple weighted criteria so you can quickly identify the most important tasks. The Improvement Register list shows improvement ranking based on specific criteria (priority, benefits, and effort estimate).

Outcome Analysis:

- Outcomes Achieved - Last 6 Months
  Report of closed improvement count in the last six months grouped by:
  - Category
  - Strategy
  - Closure Code
  - Type

- KPIs Completed in the Last 6 Months
  List of closed improvements in the last six months

1. Navigate to Continual Improvement > Dashboard.
2. On the Overview tab, use the filters (Priority, State, Business Process, Business Service, Benefits, and Coordinator) to narrow the data contained in the reports.
   You can click a report to view a list of improvements that make up that report.
3. On the Outcome Analysis tab, select a report from the Group by list to view improvement results by different attributes.
   You can click a report to view a list of improvements that make up that report.
4. Compare monthly reports to evaluate the impact improvements have on your company.

Requesting improvements

Identify improvement opportunities within your environment and create an improvement request to begin implementation.

You can request improvements either manually from Continual Improvement Management, or from an application that is integrated with Continual Improvement Management.

Continual Improvement Management integration with other applications lets you:

- Create an improvement initiative from within other applications
Identifying improvement opportunities

There are many different ways you can identify improvements in your organization. Improvement opportunities need not to be limited to the applications you use, your area of expertise, or your specific group.

You can identify improvement opportunities based on feedback from other groups.

**Process manager or process owner**
Reach out to the process manager or process owner to identify improvement suggestions for a process that is not working well.

**IT, development, and project management groups**
Reach out to the IT staff, development team, and project management staff for improvement suggestions, and provide the Improvement Requester role so they can submit an improvement request from within an integrated application with one click.

You can also identify improvement opportunities from within many different applications.

**Surveys**
Review customer feedback and complaints and send additional assessments soliciting customers for improvement opportunity suggestions.

**Performance Analytics**
Monitor process KPIs and internal process assessments in Performance Analytics reports to identify improvement opportunities.

**Benchmarks**
Compare KPI performance with Benchmarks baseline reports, and identify improvement opportunities in Benchmarks recommendations.

**Service**
Review undesirable trends in reports to identify improvement opportunities.

**Problem Management and Change Management**
Review Problem Management and Change Management trend reports to identify improvement opportunities.

**Risk and GRC Audits**
Review Risk registers and GRC Audit test failures to discover improvement opportunities.

**IT Service Management**
Review ITSM regularly to identify improvement opportunities for what is not working well.

Create an improvement request
Create an improvement request for improvement opportunities you identify in your environment. Once submitted, the improvement request is analyzed and implemented by the Improvement Manager and Improvement Coordinator.

Role required: sn_cim.improvement_requester
1. Identify an opportunity for improvement.
   Any type of improvement identified in your company qualifies as the basis for an improvement request. For example, KPI performance, customer satisfaction, resources, processes, training, to name a few.

2. Determine your improvement goal.
   The improvement goal is the expected result to be achieved from the improvement.

3. Submit an improvement request.
   a) Navigate to Continual Improvement > Create New.
   b) Fill in the short description and the business justification, and click Submit.
      The improvement request is created and set to New for the Improvement Manager to accept or reject based on alignment with strategic objectives.

4. To track the status of your improvement request, navigate to Continual Improvement > My CIM Requests.

Create improvement request

In the process of reviewing KPI performance in the Performance Analytics application, the incident manager noticed the Average time to resolve an incident KPI scorecard was too high (24 hours).

As part of the improvement identification process, the incident manager analyzed the KPI performance by comparing it with values from other companies using the Benchmarks application, determined an improvement was needed, and set a target goal.

Improvement Initiative form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CIM0000135 (set internally)</td>
</tr>
<tr>
<td>Business service</td>
<td>IT Services</td>
</tr>
<tr>
<td>Business process</td>
<td>Incident Management</td>
</tr>
<tr>
<td>Short description</td>
<td>(Required) Improve average time to resolve an incident by 25%</td>
</tr>
</tbody>
</table>
Managing improvements

After an improvement is requested, the Improvement Manager reviews it, assigns an Improvement Coordinator, and monitors progress of all improvements to ensure value and success. The Improvement Coordinator works with the Improvement Manager to implement the improvement.

The Improvement Manager oversees, identifies, drives, and monitors the progress of all improvements.

The Improvement Coordinator manages the improvements to which they have been assigned by the Improvement Manager, and works with the CIM task owners to track task completion.

Note: Although both roles can cancel an improvement, only the Improvement Manager can delete an improvement, which removes it from the Improvement Register list.

Process flow

1. The process flow starts with a new improvement request. A need for improvement is identified in the environment and a new improvement request is submitted by a user with the Improvement Requester role.

2. The Improvement Manager then verifies that the new improvement request aligns with at least one company strategic objective, and assigns an Improvement Coordinator before
accepting the improvement as valid. The assigned Improvement Coordinator is notified that
the improvement request has been **accepted**.

There is typically more than one Improvement Coordinator in a company since that role is
responsible for implementing and tracking the progress of assigned improvement initiatives at
the task level, and there can be many tasks per improvement.

3. Once accepted, the Improvement Manager sets the remaining attributes on the
Improvement Initiative form, and progresses it to be **assessed** for approval (by Approver group
members).

4. During assessment, users in the approver group (shown in the Approvers related list) are
notified of the approval request. One or all of the approver group members evaluate the
improvement attributes and either **approve** or reject the improvement.

5. Once approved, the Improvement Coordinator and Improvement Manager work together (in
regular implementation meetings, for example) to determine what work is needed to ready
the improvement for **implementation**.

During implementation, the Improvement Coordinator creates and assigns phases and tasks
to complete the improvement. The Improvement Coordinator works with the task owners (in
regular task status meetings, for example) to track the progress of task completion. Records
for other supported applications can also be created from within the improvement initiative
or CIM task, if needed, and are typically shown in a related list in the improvement initiative or
CIM task.

If, for some reason, implementation for the improvement has been halted, the Improvement
Manager or Improvement Coordinator can place the Improvement on **hold**. All CIM tasks that
are not closed or canceled are also placed on hold.

6. The Improvement Coordinator places the improvement under **review** when all CIM tasks in all
CIM phases are verified 100% complete. The Improvement Manager reviews the improvement
completeness and sets the improvement to **closed**.

### Alignment with company strategic objectives

You can ensure alignment with company goals by setting the **Strategies** field on the Improvement
Initiative form to one or more company **enterprise strategies** from the Strategic Objectives lookup
list so they are linked.

**Note:** Only the Improvement Manager can create a strategy.

Coordinating improvements with enterprise strategies of the company ensures the improvement
contributes to the overall goals of the company.

Access enterprise strategies by navigating to **Continual Improvement > Enterprise Strategies** (or
**Organization > Enterprise Strategy**).

### Improvement Register list

View, prioritize, and track improvements, related tasks, and phases from one Improvement
Register list that includes all open and closed improvements in one list.
Embedded Performance Analytics scorecard

Use the Performance Analytics scorecard embedded in the Improvement Initiative form for continuous KPI monitoring, and to track the progress of the KPI improvement during the lifecycle of the improvement. The KPI scorecard is useful so you can monitor the incremental benefits of the KPI, or adjust CIM tasks and assignments to meet your improvement goal, if needed.
Embedded KPI scorecard

The improvement icon ( ) indicates the start and end dates that are tracked on the KPI scorecard chart.
Scorecards are also shown for any KPIs listed in Impacted KPIs related list on the Improvement Initiative form.

Accept an improvement

Accept and assign a new improvement request so it can be assessed for approval. You can reject the improvement request if it does not align with company strategic objectives.
Role required: sn_cim.improvement_manager, sn_cim.improvement_coordinator
Precondition: Improvement Requester created an improvement request.

1. Identify the new improvement request.
   a) Navigate to Continual Improvement > Open.
   b) In the Improvement Register list, open an improvement in the New state.

2. Align the improvement request with company strategic objectives, and assign an Improvement Coordinator.
   a) On the Improvement Initiative form, unlock the Strategies field to access your company strategic objectives, then click the lookup list.
   b) Select the enterprise strategy aligned with the improvement request.

   Note: Only the Improvement Manager can create a strategy.

   c) Click the CIM Coordinator lookup list and select an Improvement Coordinator to manage the improvement.

3. Complete the fields for business service, business process, priority, effort estimate, benefits, and why this improvement is important.

4. In the header bar, click Accept to progress the improvement request to the Assess state. Improvement Coordinator is notified of assignment.

5. Complete the content in the Goals, Details, and Schedule tabs on the Improvement Initiative form.

6. Click Assess in the header bar to request approval of the improvement. Members of the Approver group are notified of the request for approval.

Accept improvement request

In the process of reviewing KPI performance in the Performance Analytics application, the incident manager noticed the Average time to resolve an incident KPI scorecard was too high (24 hours).

As part of the acceptance process, the Improvement Manager determined that KPI performance improvement aligned with the Automation/Effort Reduction strategic objective, assigned the Improvement Coordinator that drives KPI improvements, and accepted the improvement request.
## Improvement Initiative form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CIM0000135 (set internally)</td>
</tr>
<tr>
<td>Business service</td>
<td>IT Services</td>
</tr>
<tr>
<td>Business Process</td>
<td>Incident Management</td>
</tr>
<tr>
<td>CIM Coordinator</td>
<td>Adela Cervantsz</td>
</tr>
<tr>
<td>Approver Group</td>
<td>CIM Approvers</td>
</tr>
<tr>
<td>Strategies</td>
<td>Automation/Effort Reduction</td>
</tr>
<tr>
<td>State</td>
<td>Accepted</td>
</tr>
<tr>
<td>Priority</td>
<td>4 - Low</td>
</tr>
<tr>
<td>Effort estimate</td>
<td>Medium</td>
</tr>
<tr>
<td>Benefits</td>
<td>High</td>
</tr>
<tr>
<td>Percent complete</td>
<td>0</td>
</tr>
<tr>
<td>Short description</td>
<td>Improve average time to resolve an incident by 25%</td>
</tr>
<tr>
<td>Business justification</td>
<td>Average time to resolve an incident time is bad compared to Industry average. I compared our value with global values from companies in the same industry using the Benchmarks application.</td>
</tr>
</tbody>
</table>

## Goals tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success measurement method</td>
<td>Automated: PA Indicator</td>
</tr>
<tr>
<td>Improvement KPI</td>
<td>Average close time of incidents</td>
</tr>
<tr>
<td>Breakdown</td>
<td>--</td>
</tr>
<tr>
<td>Aggregation</td>
<td>--</td>
</tr>
<tr>
<td>Base value</td>
<td>100</td>
</tr>
<tr>
<td>Percentage improvement</td>
<td>25</td>
</tr>
<tr>
<td>Target value</td>
<td>75</td>
</tr>
<tr>
<td>Target review date</td>
<td>2018-06-30</td>
</tr>
<tr>
<td>Expected outcomes</td>
<td>Improvement in average time to resolve an incident.</td>
</tr>
</tbody>
</table>
Assess an improvement for approval

Once accepted and set to assess, Approver group members evaluate the improvement for approval before implementation can begin.

Role required: None (must be a member of the Approver group)
Note: Only one Approver group member needs to approve the improvement before moving to the next state. To require additional approvers, configure the CIM Approval workflow in Flow Designer.

The default expiration period for approval requests is seven business days. Pending approval requests are automatically canceled after seven days but can be resubmitted for approval.

Preconditions:
- Incident manager created an improvement request.
- Improvement Manager accepted and assigned the improvement request.

By default, an improvement requires approval before it can progress to the Implement state. You can disable the approval requirement using the `sn_cim.need_approval` property. When disabled, the Approver group field and the Approvers related list on the Improvement Initiative form are not shown.

1. Navigate to Self Service > My Approvals.
2. On the Approval form, scroll down to the Summary of Item being approved section and assess the details of the improvement, including alignment with strategic objectives (strategies), business service, business process, priority, effort estimate, benefits, and why this improvement is important.
3. Click Approve in the header bar to approve the improvement.

The improvement is ready for implementation by the Improvement Manager and Improvement Coordinator.

A default CIM phase (CIMT number) is automatically created.

**Approve an improvement**

In the process of reviewing KPI performance in the Performance Analytics application, the incident manager noticed the Average time to resolve an incident KPI scorecard was too high (24 hours).

As part of the approval process, an Approver group member assessed the details of the improvement and approved it to begin implementation.

**Approval form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approver</td>
<td>Howard Johnson</td>
</tr>
<tr>
<td>State</td>
<td>Approved</td>
</tr>
<tr>
<td>Approving</td>
<td>CIM0000135</td>
</tr>
<tr>
<td>Comments</td>
<td>--</td>
</tr>
</tbody>
</table>
Prepare an improvement for review

Once the improvement is approved, you can create or update CIM tasks, create CIM phases, and identify impacted KPIs. The Improvement Coordinator for the improvement works with the Improvement Manager to plan implementation.

Role required: sn_cim.improvement_manager, sn_cim.improvement_coordinator

Preconditions:

- Improvement Requester created the improvement request.
- Improvement Manager accepted and assigned the improvement request.
- Approver group member assessed and approved the improvement.

1. Determine phases and tasks needed for the improvement.
   Improvement Manager and Improvement Coordinator meet to determine the tasks required to complete the improvement, and whether multiple phases are required.

2. Set up CIM phases to track CIM tasks.
   a) Navigate to Continual Improvement > Open and open the improvement in the In Progress state.
   b) In the CIM Phases related list, open the default CIM phase automatically created for the improvement, and fill in the description and planned end date.
   c) To add another phase, in the CIM Phases related list, click New.

3. Create and assign CIM tasks required to complete the improvement for each CIM phase.
   a) In the CIM Phases related list, open a CIM phase.
   b) In the CIM Tasks related list, click New to create a CIM task.
   c) Set the CIM task attributes, including assignment, priority, state, planned end date, and short description.

4. To create a separate application task for an integrated application, click the related link for that application task.

5. To monitor a KPI with the improvement, add a record to the Impacted KPIs tab.

6. Meet with CIM task owners to oversee status, monitor work completed, add or update tasks and phases, and track overall progress of the improvement to completion.
   a) Oversee the progress of CIM tasks with task owners on a regular basis until all tasks are presented as complete.
b) On the Improvement Initiative form, verify that all tasks in the CIM Tasks related list are **Closed Complete**.

c) On the Improvement Initiative form, verify that all phases in the CIM Phases related list are 100% complete.

7. **Click Review** in the header bar to request the improvement be reviewed by the Improvement Manager for closure.

**Implement improvement**

In the process of reviewing KPI performance in the Performance Analytics application, the incident manager noticed the **Average time to resolve an incident** KPI scorecard was too high (24 hours).

As part of the implementation process, the Improvement Manager and Improvement Coordinator determined the work required in the next three to six months to complete the improvement, with a target review date 3 months after start.

- Configured default CIM Phase 1 (added two CIM tasks), and created CIM Phase 2 (added two CIM tasks).
- Created a Change Management application task record (CHG0030001) associated with CIM Task 2 using the **Create Change** related link, and set the change record attributes.
- Added four KPIs to the Impacted KPIs tab to monitor with the improvement.

Improvement Coordinator met with CIM task owners regularly to oversee status and monitor work completed, and set the improvement status to review after all implementation was complete.

<table>
<thead>
<tr>
<th><strong>CIM Phase 1: CIM Tasks 1 and 2</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>Parent</td>
</tr>
<tr>
<td>Percent complete</td>
</tr>
<tr>
<td>Planned end date</td>
</tr>
<tr>
<td>Actual end date</td>
</tr>
<tr>
<td>Short description</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>CIM Task 1</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>Parent</td>
</tr>
<tr>
<td>Configuration item</td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Implementing task</td>
</tr>
</tbody>
</table>
### Field | Value
--- | ---
Assigned to | Bernard Laboy
Improvement register | CIM0000135
Priority | 4 - Low
State | Open
Planned end date | 2018-06-19
Short description | Improve % of incidents resolved by first assigned group by using self service and more automation

**Work notes**

**CIM Task 2**

**Number** | CIMT0000119 (assigned internally)
**Parent** | CIMT0000116
**Configuration item** | --
**Active** | (Selected)
**Implementing Task** | CHG0030001
**Assigned to** | Change Manager
**Improvement register** | CIM0000135
**Priority** | 4 - Low
**State** | Open
**Planned end date** | 2018-06-19
**Short description** | Reduce the reassigned count by using ServiceNow Auto Categorization and Auto Assignment models

**Work notes**

---

**CIM Phase 2: CIM Tasks 1 and 2**

**Field** | **Value**
--- | ---
**Number** | CIMT0000120
**Parent** | CIM0000135
**Percent complete** | 0
**Planned end date** | 2018-06-19
**Actual end date** | --
**Short description** | Knowledge improvements and self-service improvements
### Change Request Form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CHG0030001 (set internally)</td>
</tr>
<tr>
<td>Requested by</td>
<td>Improvement Manager</td>
</tr>
<tr>
<td>Configuration item</td>
<td>--</td>
</tr>
</tbody>
</table>
### Field Value

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned start date</td>
<td>2018-03-18</td>
</tr>
<tr>
<td>Planned end date</td>
<td>2018-06-19</td>
</tr>
<tr>
<td>Type</td>
<td>Normal</td>
</tr>
<tr>
<td>State</td>
<td>New</td>
</tr>
<tr>
<td>Priority</td>
<td>4 - Low</td>
</tr>
<tr>
<td>Impact</td>
<td>3 - Low</td>
</tr>
<tr>
<td>Risk</td>
<td>Moderate</td>
</tr>
<tr>
<td>Short description</td>
<td>Reduce the reassigned count by using ServiceNow Auto Categorization and Auto Assignment models.</td>
</tr>
<tr>
<td>Description</td>
<td>--</td>
</tr>
</tbody>
</table>

### Impacted KPIs related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impacted KPI</td>
<td>• % of incidents resolved by first assigned group</td>
</tr>
<tr>
<td></td>
<td>• % of incidents resolved on same day opened</td>
</tr>
<tr>
<td></td>
<td>• % of incidents resolved without reassignment</td>
</tr>
<tr>
<td></td>
<td>• Average age open incidents</td>
</tr>
</tbody>
</table>

### Review and close an improvement

Once all tasks in each phase of the improvement have been completed, the Improvement Coordinator sets the improvement to review for the Improvement Manager to close.

Role required: sn_cim.improvement_manager, sn_cim.improvement_coordinator
Preconditions:

- Incident manager created an improvement request.
- Improvement Manager accepted and assigned the improvement request.
- Approver group member approved the improvement.
- Improvement Manager and Improvement Coordinator implemented the improvement.

1. Review the improvement for closure.
   a) Navigate to Continual Improvement > Under Review.
   b) In the Improvement Register list, open the improvement in the Monitor/Review state.
   c) On the Improvement Initiative form, verify that all phases in the CIM Phases related list are 100% complete.

2. Verify the improvement has met the improvement goal.

3. Close the improvement.
   a) In the Closure Notes tab, set the closure code, achieved outcome category, and close notes.
   b) Click Close in the header bar to close the improvement.
   The improvement is no longer shown in the Open Improvement Register list.

Close improvement

In the process of reviewing KPI performance in the Performance Analytics application, the Incident Manager noticed the **Average time to resolve an incident** KPI scorecard was too long (24 hours).

As part of the review process for **Improve average time to resolve an incident by 25%** improvement, the Improvement Manager verified the work for the improvement is complete (Improvement Initiative form and CIM Phases related list shows 100% complete).

The Improvement Manager also verified the improvement in two places before closing the improvement.

- Performance Analytics now shows that the **Average time to resolve an incident** KPI has a value of 16 hours, which is more improvement than the target value of 18 hours (18 hours is 25% faster than the previous average of 24 hours).
- Benchmarks application now shows that the company result for the **Average time to resolve an incident** KPI has a value of 16 hours, which is 2 hours better than the global industry average.

### CIM Phase 1: CIM Tasks 1 and 2

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CIMT0000116 (assigned internally)</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Percent complete</td>
<td>*100</td>
</tr>
<tr>
<td>Actual end date</td>
<td>*2018-03-14</td>
</tr>
<tr>
<td>Short description</td>
<td>Resolved incident and reassigned count improvements</td>
</tr>
<tr>
<td>CIM Task 1</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>CIMT00000118 (assigned internally)</td>
</tr>
<tr>
<td>Active</td>
<td>*(Not selected)</td>
</tr>
<tr>
<td>State</td>
<td>*Closed Complete</td>
</tr>
<tr>
<td>Short description</td>
<td>Improve % of incidents resolved by first assigned group by using self service and more automation</td>
</tr>
<tr>
<td>Work notes</td>
<td>*Self service and automation implemented to improve % of incidents resolved by first assigned group</td>
</tr>
<tr>
<td>CIM Task 2</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>CIMT00000119 (assigned internally)</td>
</tr>
<tr>
<td>Active</td>
<td>*(Not selected)</td>
</tr>
<tr>
<td>State</td>
<td>*Closed Complete</td>
</tr>
<tr>
<td>Short description</td>
<td>Reduce the reassigned count by using ServiceNow Auto Categorization and Auto Assignment models</td>
</tr>
<tr>
<td>Work notes</td>
<td>*Auto Categorization and Auto Assignment implemented to reduce reassigned count</td>
</tr>
</tbody>
</table>

**CIM Phase 2: CIM Tasks 1 and 2**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CIMT00000120</td>
</tr>
<tr>
<td>Percent complete</td>
<td>*100</td>
</tr>
<tr>
<td>Actual end date</td>
<td>*2018-03-14</td>
</tr>
<tr>
<td>Short description</td>
<td>Knowledge improvements and self service improvements</td>
</tr>
<tr>
<td>CIM Task 1</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>CIMT00000121 (assigned internally)</td>
</tr>
<tr>
<td>Active</td>
<td>*(Not selected)</td>
</tr>
</tbody>
</table>
### Continual Improvement Management reference

Continual Improvement Management reference content including states, integration properties, and field descriptions.

#### Approval property

By default, an improvement requires approval before it can progress to the Implement state. You can disable the approval requirement using the `sn_cim.need_approval` property.

To access Continual Improvement Management properties, navigate to **Continual Improvement > Administration > Properties.**
Note: System admin role is required to set Continual Improvement Management properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enables approval process for Continual Improvement initiatives sn_cim.need_approval</td>
<td>Check box indicating whether to require manual approval for the improvement to progress from Accepted state to Approved state. Default is checked (require manual approval). If this property is not checked, the improvement automatically progresses to Approved state once it is accepted, and the Approver group field and the Approvers related list on the Improvement Initiative form are not shown.</td>
</tr>
</tbody>
</table>

### Improvement states

The state of an improvement indicates the progress of the improvement in the process.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Improvement request is created either manually, or from within an integrated application by an Improvement Requester. Integrated applications include Benchmarks, CMDB, Coaching, Demand, GRC, Major Incident Management, Problem Management, and Survey Management. States list: • Accepted • Canceled List Controls menu ( ) options on the Improvement Initiative form: Copy Initiative.</td>
</tr>
<tr>
<td>Accepted</td>
<td>Improvement request aligns with company strategic objectives and is considered valid by the Improvement Manager. States list: • Assess • Canceled List Controls menu ( ) options on the Improvement Initiative form: Copy Initiative.</td>
</tr>
<tr>
<td>State</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Canceled</td>
<td>Improvement is not accepted <em>(Reject action is selected by the Improvement Manager)</em>, or can be canceled directly in any state.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Any CIM tasks created for the improvement are also canceled.</td>
</tr>
<tr>
<td></td>
<td>List Controls menu (⋯) options on the Improvement Initiative form: Copy Initiative.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assess</td>
<td>All improvement attributes are set by the Improvement Manager, including business process, business service, and success measurement details. The improvement is waiting to be assessed by an Approver group member for approval.</td>
</tr>
<tr>
<td></td>
<td><strong>States</strong> list:</td>
</tr>
<tr>
<td></td>
<td>• Approved</td>
</tr>
<tr>
<td></td>
<td>(only shown for an Approver group member)</td>
</tr>
<tr>
<td></td>
<td>• Canceled</td>
</tr>
<tr>
<td></td>
<td>List Controls menu (⋯) options on the Improvement Initiative form:</td>
</tr>
<tr>
<td></td>
<td>• Copy Initiative</td>
</tr>
<tr>
<td></td>
<td>• Revert to Accepted</td>
</tr>
<tr>
<td>State</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Approved  | The improvement is assessed and approved by an Approver group member and is ready for implementation. The improvement is set to implement by the Improvement Manager.  
**States list:**  
- Implement  
- Canceled  
- Assess (for reapproval)  
  If additional tasks were added, or if the target has changed, the improvement may need to go through approval again.  
  List Controls menu (....) options on the Improvement Initiative form:  
- Copy Initiative  
- Submit for Re-Approval |
| Implement | CIM task creation is completed by the Improvement Manager or Improvement Coordinator. CIM tasks are completed by the task owners.  
The Improvement Coordinator determines either that the improvement is complete and sets it to review, or that progress is halted and places it on hold.  
**States list:**  
- Monitor/Review  
- On Hold  
- Assess (for reapproval)  
  If additional tasks were added, or if the target has changed, the improvement may need to go through approval again.  
  List Controls menu (....) options on the Improvement Initiative form:  
- Copy Initiative  
- Submit for Re-Approval |
<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Hold</td>
<td>Improvement is no longer in progress but may resume at a later date. The Improvement Manager determines the outcome of the improvement including whether it should go back to implementation, or be closed or canceled. States list: Implement, Closed, Canceled.</td>
</tr>
<tr>
<td></td>
<td>Note: When an improvement is placed on hold, all active CIM tasks (not closed or canceled) are also placed on hold, but the state can be changed manually. When the improvement is taken off hold, all active CIM tasks (not closed or canceled) are set to Open state (unless they were changed manually).</td>
</tr>
<tr>
<td>Monitor/Review</td>
<td>All CIM tasks for the improvement are complete, improvements have been measured, and no further action is required by the task owners. The improvement is reviewed for closure by the Improvement Manager. States list: Implement, Closed, Assess (for reapproval). If additional tasks were added, or if the target has changed, the improvement may need to go through approval again. List Controls menu options on the Improvement Initiative form: Copy Initiative.</td>
</tr>
<tr>
<td>Closed</td>
<td>Improvement is complete and is added to the Closed Improvement Register list.</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
CIM task states

An improvement contains one or more CIM tasks to complete the improvement. A CIM task is assigned to an owner to be responsible for the work specified.

The state of a CIM task indicates the level of progress for the task.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>State of a CIM task added before the improvement has been approved. If a CIM task is added after the improvement is approved, the CIM task is set to Pending state until the improvement is approved again. Once approved, the CIM task is set to Open state. If rejected, the CIM task remains in the Pending state.</td>
</tr>
<tr>
<td>Open</td>
<td>State of a new CIM task for an improvement that has been approved.</td>
</tr>
<tr>
<td>Work in Progress</td>
<td>State of a CIM task for which work has begun.</td>
</tr>
<tr>
<td>Closed Complete</td>
<td>State of a closed CIM task that has been completed.</td>
</tr>
<tr>
<td>Closed Incomplete</td>
<td>State of a closed CIM task that has been closed but not fully completed.</td>
</tr>
<tr>
<td>Closed Skipped</td>
<td>State of a closed CIM task for which no work has been done.</td>
</tr>
</tbody>
</table>
### CIM approver states

Each improvement needs at least one approval to progress to the Implement state. The Approvers related list in the improvement contains a list of user approval records and the state of the approval.

The users in the Approvers related list belong to the Approver Group specified on the Improvement Initiative form. Once the improvement has been approved by an Approver Group member, approval from other members is no longer required to progress the improvement. However, other Approver Group members can still set their individual approval state.

To require additional approvers, configure the CIM Approval workflow in Flow Designer.

### Improvement process flow

<table>
<thead>
<tr>
<th>Process flow</th>
<th>Role</th>
<th>Description</th>
<th>Next action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Improvement Initiative</td>
<td>Improvement Requester</td>
<td>The need is determined for an improvement and an improvement request is created.</td>
<td>Click Submit. Required: Short Description</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Hold</td>
<td>State of a CIM task for an improvement set to On Hold state. The state of a CIM task on hold can be manually changed to Open or Work In Progress states.</td>
</tr>
</tbody>
</table>

Note: When an improvement is placed on hold, all active CIM tasks (not closed or canceled) are also placed on hold, but the state can be changed manually.

When the improvement is taken off hold, all active CIM tasks (not closed or canceled) are set to Open state (unless they were changed manually).
<table>
<thead>
<tr>
<th>Process flow</th>
<th>Role</th>
<th>Description</th>
<th>Next action</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Improvement Manager</td>
<td>Acceptance is determined by verifying that the improvement objective aligns to a company strategic objective, and an Improvement Coordinator is assigned.</td>
<td>Click Accept. Required: <em>Improvement Coordinator</em>  <em>Strategies</em></td>
</tr>
<tr>
<td>Accepted</td>
<td>Improvement Manager</td>
<td>Other attributes are set and the improvement request is ready to be assessed for approval (by Approver group members).</td>
<td>Click Assess. (Waiting for approval) Approver group members are notified. Required: Approver Group</td>
</tr>
<tr>
<td>Assess</td>
<td>CIM approver (member of the Approver group)</td>
<td>The improvement attributes are assessed for approval from the Approvers related list.</td>
<td>Click Approved.</td>
</tr>
<tr>
<td>Approved</td>
<td>Improvement Manager or Improvement Coordinator</td>
<td>Improvement Coordinator and Improvement Manager work together to determine what is needed to ready the improvement for implementation.</td>
<td>Click Implement. <em>Actual start date</em> (Schedule tab) is automatically populated.</td>
</tr>
<tr>
<td>Implement</td>
<td>Improvement Coordinator</td>
<td>Implementation of the improvement begins with the assigned task owners. Any problem, change, or knowledge submission is shown in the corresponding related list.</td>
<td>Click Review if implementation is complete. Click On Hold if the process has halted. Required: On Hold Reason</td>
</tr>
<tr>
<td>On Hold</td>
<td>Improvement Manager or Improvement Coordinator</td>
<td>Implementation for the improvement has halted (<em>On Hold</em> state) but the process flow remains in Implement.</td>
<td>Click Implement to continue the process. Click Close if no further work will be done.</td>
</tr>
</tbody>
</table>
### Improvement integration with other applications

You can create an improvement request from within multiple integrated applications. You can also create many application tasks from within an improvement initiative. Set the Continual Improvement Management attributes property to determine which field values get copied to integrated application tasks.

Set Continual Improvement Management properties for integration with other applications.

As part of Continual Improvement Management integration with other applications, improvement requests can be created from within other applications and, conversely, records for other applications can be created from within an improvement initiative (or CIM task).

Multiple tasks from outside integrated applications can be linked to a single improvement initiative (or CIM task), and multiple CIM tasks can be linked to a single integrated application task for maximum flexibility when creating improvements.

An improvement initiative can be created from these applications.

- **Benchmarks**
- **Coaching**
- **Configuration Management Database**
- **Demand Management**
- **Governance, Risk, and Compliance**
- **Incident Management**
- **Problem Management**
- **Survey Management**

As part of an improvement initiative, these records can be created.

- Demand record
- **Project** (optional)

- As part of a CIM task:
  - **Change** record
  - Coaching opportunity
  - **Knowledge** base article (optional)
  - **Story** record (optional)
Integration property

You can set field values that get copied to the improvement request when the improvement request is created from within another application.

To access Continual Improvement Management properties, navigate to Continual Improvement > Administration > Properties.

**Note:** System admin role is required to set Continual Improvement Management properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of attributes (comma-separated) that will be copied from the originating improvement initiative. sn_cim.initiative_copy_attributes</td>
<td>Specifies the field values that are copied from the originating improvement initiative to the application task record (for example, demand, project, change record) created from the improvement initiative.</td>
</tr>
<tr>
<td>· Short description (short_description)</td>
<td>· Description (description)</td>
</tr>
<tr>
<td>· Priority (priority)</td>
<td>· CIM estimate (cim_estimate)</td>
</tr>
<tr>
<td>· Benefit (benefit)</td>
<td>· Assigned to (assigned_to)</td>
</tr>
<tr>
<td>· Strategic objective (strategic_objective)</td>
<td>· Business process (business_process)</td>
</tr>
<tr>
<td>· Business service (business_service)</td>
<td>· Approver group (approver_group)</td>
</tr>
<tr>
<td>· Type (type)</td>
<td></td>
</tr>
</tbody>
</table>

Create Improvement Initiative related link

- **Benchmarks**

  When you create an improvement initiative from Benchmarks, the improvement is associated with the Benchmarks recommendation candidate, and the Benchmarks KPI is added to the improvement initiative.

<table>
<thead>
<tr>
<th>Benchmarks recommendation candidate</th>
<th>Improvement initiative</th>
</tr>
</thead>
<tbody>
<tr>
<td>· Create Improvement Initiative related link is added.</td>
<td>Benchmarks recommendation KPI is added to the Improvement KPI field on the Goals tab.</td>
</tr>
<tr>
<td>· Create Improvement Initiative related link is replaced by the CIM number related link once an improvement initiative is created.</td>
<td></td>
</tr>
</tbody>
</table>

- **Coaching**
When you create an improvement initiative from Coaching, the Improvement Initiatives related list is added to the coaching opportunity, and the coaching opportunity details are added to the improvement initiative.

<table>
<thead>
<tr>
<th>Coaching opportunity</th>
<th>Improvement initiative</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Improvement Initiative</strong> related link is added.</td>
<td>Coaching opportunity record to which the improvement initiative is linked is added to the Source/Parent field in the Details tab.</td>
</tr>
<tr>
<td>Improvement Initiatives related list is added that contains the improvement initiative (CIM) record.</td>
<td></td>
</tr>
</tbody>
</table>

- **Configuration Management Database (CMDB)**

When you create an improvement initiative from CMDB, the Improvement Initiatives related list is added to the task, and the Remediate Duplicate Task details are added to the improvement initiative.

<table>
<thead>
<tr>
<th>Remediate Duplicate Tasks record</th>
<th>Improvement initiative</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Improvement Initiative</strong> related link is added.</td>
<td>Remediate Duplicate Tasks record to which the improvement initiative is linked is added to the Source/Parent field in the Details tab.</td>
</tr>
<tr>
<td>Improvement Initiatives related list is added that contains the improvement initiative (CIM) record.</td>
<td></td>
</tr>
</tbody>
</table>

- **Demand Management**

When you create an improvement initiative from Demand Management, the improvement initiative is associated with the demand record, and the demand details are added to the improvement initiative.

<table>
<thead>
<tr>
<th>Demand record</th>
<th>Improvement initiative</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Improvement Initiative</strong> related link is added.</td>
<td>Demand record to which the improvement initiative is linked is added to the Source/Parent field in the Details tab.</td>
</tr>
<tr>
<td>Improvement initiative (CIM) record is set in the Improvement field.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** When the improvement is closed, the demand record is set to complete.

- **Governance, Risk, and Compliance (GRC)**

When you create an improvement initiative from GRC, the improvement initiatives related list is added to the issue, and the issue details are added to the improvement initiative.
• **Incident Management**

When you create an improvement initiative from Incident Management, the improvement initiative is associated with the incident record, and the incident details are added to the improvement initiative.

<table>
<thead>
<tr>
<th>Incident record</th>
<th>Improvement initiative</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Improvement Initiative related link is added.</td>
<td>Issue record to which the improvement initiative is linked is added to the Source/Parent field on the Details tab.</td>
</tr>
</tbody>
</table>

**Note:** You must customize the Incident form to show the Improvement Initiatives related list that contains the improvement initiative (CIM) record.

| Incident (INC) record is added to the Source/Parent field on the Details tab. |

• **Problem Management**

When you create an improvement initiative from Problem Management, the improvement is associated with the problem record, and the problem details are added to the improvement initiative.

<table>
<thead>
<tr>
<th>Problem record</th>
<th>Improvement initiative</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Improvement Initiative related link is added.</td>
<td>Problem (PRB) record is added to the Source/Parent field on the Details tab.</td>
</tr>
</tbody>
</table>

**Note:** You must customize the Problem form to show the Improvement Initiatives related list that contains the improvement initiative (CIM) record.

<table>
<thead>
<tr>
<th>Problem record state</th>
<th>Improvement initiative state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>New</td>
</tr>
<tr>
<td>Pending change</td>
<td>In Progress</td>
</tr>
<tr>
<td>Closed/Resolved</td>
<td>Closed</td>
</tr>
</tbody>
</table>

• **Survey Management and Assessments**
When you create an improvement initiative from Survey Management, the improvement is associated with the Survey, and the survey details are added to the improvement initiative. (Assessment Metric Type (Survey view) record)

<table>
<thead>
<tr>
<th>Survey definition record</th>
<th>Improvement initiative</th>
</tr>
</thead>
<tbody>
<tr>
<td>· Create Improvement Initiative related link is added.</td>
<td>· Survey definition (Assessment Metric Type (Survey view)) record is added to the Source/Parent field on the Details tab.</td>
</tr>
<tr>
<td>· Improvement Initiatives related list is added that contains the improvement initiative (CIM) record.</td>
<td></td>
</tr>
</tbody>
</table>

**Related links in improvement initiatives**

- **Create Demand**
  When you create a demand record from an improvement initiative, the demand record is associated with the improvement initiative, and the Demands related list is added to the improvement initiative.

<table>
<thead>
<tr>
<th>Improvement initiative</th>
<th>Demand record</th>
</tr>
</thead>
<tbody>
<tr>
<td>· Create Demand related link is added.</td>
<td>· Continual Improvement Management is set in the Type field.</td>
</tr>
<tr>
<td>· Demands related list is added that contains the demand (DMND) record.</td>
<td>· Improvement initiative (CIM) record is set in the Improvement field.</td>
</tr>
</tbody>
</table>

- **Create Project**
  When you create a project record from an improvement initiative, the Projects related list is added to the improvement initiative.

<table>
<thead>
<tr>
<th>Improvement initiative</th>
<th>Project record</th>
</tr>
</thead>
<tbody>
<tr>
<td>· Create Project related link is added.</td>
<td>No change.</td>
</tr>
<tr>
<td>· Projects related list is added that contains the project (PRJ) record.</td>
<td></td>
</tr>
</tbody>
</table>

- **Create PA Indicator** related link
  Creates a Performance Analytics automated indicator.

- **Show Benchmarks** related link
  Shows the benchmarks for the KPI specified in the Improvement Initiative form Improvement KPI field using the Benchmarks application.
Related links in improvement initiative CIM tasks

Note: Related links in CIM tasks are shown only when a CIM task is in Open, Work in Progress, or On Hold state.

- **Create Change**
  When you create a change (CHG) record from an improvement initiative CIM task, the change record is added to the Change Requests related list in the CIM task.

<table>
<thead>
<tr>
<th>Improvement initiative CIM task</th>
<th>Change record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change (CHG) record is added to the Change Requests related list.</td>
<td>No change.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Improvement initiative CIM task state</th>
<th>Change record state</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>New</td>
</tr>
<tr>
<td>In Progress</td>
<td>Implement</td>
</tr>
<tr>
<td>Closed</td>
<td>Closed</td>
</tr>
</tbody>
</table>

- **Create Coaching Opportunity**
  When you create a coaching opportunity from an improvement initiative CIM task, the coaching opportunity record is added to the Coaching Opportunities related list in the CIM task.

<table>
<thead>
<tr>
<th>Improvement initiative CIM task</th>
<th>Coaching opportunity record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaching opportunity (COP) record is added to the Coaching Opportunities related list.</td>
<td>No change.</td>
</tr>
</tbody>
</table>

- **Create Knowledge**
  When you create a Knowledge Management knowledge base article (KB) record from an improvement initiative CIM task, the KB article record is added to the Knowledge Articles related list in the CIM task.

<table>
<thead>
<tr>
<th>Improvement initiative CIM task</th>
<th>Knowledge base article record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge article record is added to the Knowledge Articles related list.</td>
<td>No change.</td>
</tr>
</tbody>
</table>

- **Create Story**
  When you create an Agile Management story record from an improvement initiative CIM task, the story record is added to the Stories related list in the CIM task.

<table>
<thead>
<tr>
<th>Improvement initiative CIM task</th>
<th>Story record</th>
</tr>
</thead>
<tbody>
<tr>
<td>The story (STRY) record is added to the Stories related list.</td>
<td>No change.</td>
</tr>
</tbody>
</table>
# Integration with other applications

<table>
<thead>
<tr>
<th>Application</th>
<th>Application record</th>
<th>Create improvement initiative</th>
<th>Create application record from improvement initiative</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>GRC</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audit Management</td>
<td>Issue record</td>
<td>X</td>
<td>--</td>
</tr>
<tr>
<td>IT Business Management</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agile Development</td>
<td>Story record</td>
<td>--</td>
<td>X</td>
</tr>
<tr>
<td>Demand Management</td>
<td>Demand record</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Project Management</td>
<td>Project record</td>
<td>--</td>
<td>X</td>
</tr>
<tr>
<td><strong>IT Operations Management</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CMDB</td>
<td>Remediate Duplicate Task</td>
<td>X</td>
<td>--</td>
</tr>
<tr>
<td><strong>IT Service Management</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Benchmarks</td>
<td>Benchmarks recommendation</td>
<td>X</td>
<td>--</td>
</tr>
<tr>
<td>Change Management</td>
<td>Change record</td>
<td>--</td>
<td>X</td>
</tr>
<tr>
<td>Major Incident Management</td>
<td>Post incident review</td>
<td>X</td>
<td>--</td>
</tr>
<tr>
<td>Problem Management</td>
<td>Problem record</td>
<td>X</td>
<td>--</td>
</tr>
<tr>
<td><strong>Platform Capabilities</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Knowledge Management</td>
<td>Knowledge base article</td>
<td>--</td>
<td>X</td>
</tr>
<tr>
<td>Survey Management</td>
<td>Survey</td>
<td>X</td>
<td>--</td>
</tr>
<tr>
<td>Service Management</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coaching</td>
<td>Coaching opportunity</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

## Extension point

You can use the Continual Improvement Management integration extension point to define an application to be integrated.

Extend `sn_cim.CIMIntegrationAPI` extension point to integrate Continual Improvement Management with other applications.

## Improvement field descriptions

Improvement Initiative form and related field descriptions.
### Improvement Initiative form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique CIM number.</td>
</tr>
<tr>
<td>Business service</td>
<td>CMDB Business service improved by the improvement initiative.</td>
</tr>
<tr>
<td>Service offering</td>
<td>Service offering associated with this improvement initiative.</td>
</tr>
<tr>
<td>Business process</td>
<td>Business process improved by the improvement initiative.</td>
</tr>
<tr>
<td></td>
<td>When a business process is selected, the improvement area Type field on the Details tab is automatically set to Process.</td>
</tr>
<tr>
<td>CIM Coordinator</td>
<td>User primarily responsible for ensuring the completion of the improvement initiative.</td>
</tr>
<tr>
<td></td>
<td>The CIM Coordinator must have the Improvement Coordinator role (sn_cim.improvement_coordinator).</td>
</tr>
<tr>
<td>Approver group</td>
<td>Group of users that have permission to approve the improvement initiative.</td>
</tr>
<tr>
<td></td>
<td>CIM Approvers group is added with Continual Improvement Management. Default is empty.</td>
</tr>
<tr>
<td>Strategies</td>
<td>Strategic objectives impacted by the improvement initiative.</td>
</tr>
<tr>
<td></td>
<td>Multiple strategic objectives can be selected. Strategic objectives can be added from the lookup list.</td>
</tr>
<tr>
<td></td>
<td>The lookup list contains both Continual Improvement Management strategic objectives and business enterprise strategies to align with the improvement initiative.</td>
</tr>
<tr>
<td></td>
<td>An enterprise strategy can be added from the navigation menu Continual Improvement &gt; Enterprise Strategies.</td>
</tr>
<tr>
<td></td>
<td>Also accessible through Business Planner and Organization navigation menus.</td>
</tr>
</tbody>
</table>

**Note:** If the improvement initiative does not align with a company strategic objective, you can click Reject in the header bar to reject the improvement initiative.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td><em>State of the improvement initiative.</em> This field is read only.</td>
</tr>
<tr>
<td></td>
<td>• New</td>
</tr>
<tr>
<td></td>
<td>• Accepted</td>
</tr>
<tr>
<td></td>
<td>• Assess</td>
</tr>
<tr>
<td></td>
<td>• Approved</td>
</tr>
<tr>
<td></td>
<td>• In Progress</td>
</tr>
<tr>
<td></td>
<td>• On Hold</td>
</tr>
<tr>
<td></td>
<td>• Review</td>
</tr>
<tr>
<td></td>
<td>• Closed</td>
</tr>
<tr>
<td></td>
<td>• Canceled</td>
</tr>
<tr>
<td>On hold reason</td>
<td>Reason for putting the improvement initiative on hold.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only when the state is on hold.</td>
</tr>
<tr>
<td></td>
<td>When an improvement initiative is placed on hold, all CIM tasks are also</td>
</tr>
<tr>
<td></td>
<td>placed on hold, but the state can be changed manually.</td>
</tr>
<tr>
<td></td>
<td>When the improvement initiative is taken off hold, the CIM tasks are</td>
</tr>
<tr>
<td></td>
<td>returned back to their previous state unless they were changed manually.</td>
</tr>
<tr>
<td>Priority</td>
<td>Sequence in which an incident or problem is to be worked on, based on</td>
</tr>
<tr>
<td></td>
<td>impact and urgency.</td>
</tr>
<tr>
<td></td>
<td>• 1 - Critical</td>
</tr>
<tr>
<td></td>
<td>• 2 - High</td>
</tr>
<tr>
<td></td>
<td>• 3 - Moderate</td>
</tr>
<tr>
<td></td>
<td>• 4 - Low</td>
</tr>
<tr>
<td></td>
<td>• 5 - Planning</td>
</tr>
<tr>
<td>Effort estimate</td>
<td>Estimate of effort to complete all required tasks for the improvement</td>
</tr>
<tr>
<td></td>
<td>initiative.</td>
</tr>
<tr>
<td></td>
<td>• Small</td>
</tr>
<tr>
<td></td>
<td>• Medium</td>
</tr>
<tr>
<td></td>
<td>• Large</td>
</tr>
<tr>
<td></td>
<td>• Extra Large</td>
</tr>
<tr>
<td>Benefits</td>
<td>Expected level of benefits achieved by completing the improvement initiative.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>Percentage of work completed. The percentage is based on the completed</td>
</tr>
<tr>
<td></td>
<td>state of the CIM phases that belong to this improvement initiative. For</td>
</tr>
<tr>
<td></td>
<td>example, if there are five CIM phases, each contributes to 20% completion.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief explanation of the improvement initiative.</td>
</tr>
</tbody>
</table>
### Business justification
Description about the importance of the improvement and additional details that includes metrics or KPIs used to measure the success.

### Goals tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success measurement method</td>
<td>- Automated: PA Indicator: An improvement KPI.</td>
</tr>
<tr>
<td></td>
<td>- Survey and Assessment: An Assessment metric type.</td>
</tr>
<tr>
<td></td>
<td>- Manual: All other types.</td>
</tr>
<tr>
<td>Improvement KPI</td>
<td>Primary KPI used to measure the improvement of the improvement initiative.</td>
</tr>
<tr>
<td></td>
<td>The Show Score Card icon launches the Performance Analytics score card for</td>
</tr>
<tr>
<td></td>
<td>the improvement KPI.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is shown only when the Success Measurement Method field</td>
</tr>
<tr>
<td></td>
<td>is set to Automated: PA Indicator.</td>
</tr>
<tr>
<td>Breakdown</td>
<td>The breakdown of the improvement KPI, if one exists.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is shown only when an improvement KPI is selected for</td>
</tr>
<tr>
<td></td>
<td>the Automated: PA Indicator success measurement method.</td>
</tr>
<tr>
<td>Element</td>
<td>The element of the KPI breakdown.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is shown only when a breakdown is selected.</td>
</tr>
<tr>
<td>2nd Breakdown</td>
<td>The second-level breakdown of the improvement KPI, if one exists.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is shown only after the first breakdown is selected.</td>
</tr>
<tr>
<td>2nd Element</td>
<td>The element of the second-level KPI breakdown.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is shown only when a second-level breakdown is selected.</td>
</tr>
<tr>
<td>Time Series</td>
<td>Time series for the improvement KPI.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field is shown only when an improvement KPI is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Survey &amp; Assessment</td>
<td>Assessment metric type associated with the improvement initiative.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only for the Survey &amp; Assessment success measurement method.</td>
</tr>
<tr>
<td></td>
<td>If the improvement initiative was created from within the Survey Management application, this field is not automatically populated.</td>
</tr>
<tr>
<td>Base value</td>
<td>Base value of the success measurement method when the target is set.</td>
</tr>
<tr>
<td>Percentage improvement</td>
<td>Percent improvement target.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only when an improvement KPI is selected.</td>
</tr>
<tr>
<td></td>
<td>If the KPI is a percent type, then this field is calculated automatically (based on Base value and Target value fields).</td>
</tr>
<tr>
<td>Target value</td>
<td>Absolute target value.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For the Automated: PA Indicator success measurement method, if the KPI is not a percent type, then this field is calculated automatically (based on base value and percentage improvement).</td>
</tr>
<tr>
<td></td>
<td>If the target value is already set on the indicator, breakdown, element, and aggregation, this field is automatically set. However, you can override this value by specifying a percent in the Percent Improvement field.</td>
</tr>
<tr>
<td></td>
<td>The target value set in this field is synced with the Performance Analytics indicator target for the KPI (Performance Analytics &gt; Indicator &gt; Targets).</td>
</tr>
<tr>
<td>Target review date</td>
<td>Date the goal should be achieved.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For the Automated: PA Indicator success measurement method, even if the target date is already set on the indicator, breakdown, element, and aggregation, this field is not automatically set.</td>
</tr>
<tr>
<td>Expected outcomes</td>
<td>Tangible artifacts and updates expected by the improvement initiative (for example, updated process published in new template, work instructions, and FAQ published in knowledge base).</td>
</tr>
</tbody>
</table>
## Details tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested for</td>
<td>User for which the improvement initiative was created.</td>
</tr>
<tr>
<td>Type</td>
<td>Area improved by the improvement initiative. One or many areas may be selected.</td>
</tr>
<tr>
<td></td>
<td>• People</td>
</tr>
<tr>
<td></td>
<td>• Process</td>
</tr>
<tr>
<td></td>
<td>• Technology</td>
</tr>
<tr>
<td></td>
<td>When a value is selected for the Business Process field, the Type field is automatically set to Process.</td>
</tr>
<tr>
<td>Watch list</td>
<td>Users notified when updates are made to the improvement initiative.</td>
</tr>
<tr>
<td>Parent initiative</td>
<td>Parent initiative associated with this child initiative.</td>
</tr>
<tr>
<td></td>
<td>When a parent initiative is selected, all associated child initiatives display in the Child Initiatives related list.</td>
</tr>
<tr>
<td>Source/Parent</td>
<td>Source or parent application from which the improvement initiative was created.</td>
</tr>
</tbody>
</table>
|                | • Coaching Opportunity (COP)  
|                | Coaching opportunity record to which the improvement initiative is linked. |
|                | • CMDB  
|                | Remediate Duplicate Tasks record to which the improvement initiative is linked. |
|                | • Demand (DMND)  
|                | Demand record to which the improvement initiative is linked. |
|                | • GRC issue  
|                | Issue record to which the improvement initiative is linked. |
|                | • Incident (INC)  
|                | Incident record to which the improvement initiative is linked. |
|                | • Problem (PRB)  
|                | Problem record to which the improvement initiative is linked. |
|                | • (Survey) Assessment Metric Type  
|                | Assessment metric type for the survey definition record to which the improvement initiative is linked. |

**Note:** This field is shown only when an improvement initiative is created from Coaching, CMDB, Demand Management, GRC, Incident Management, Problem Management, or Survey Management applications.
### Schedule tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned start date</td>
<td>Expected start date.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Expected end date.</td>
</tr>
<tr>
<td>Actual start date</td>
<td>Date the improvement initiative started.</td>
</tr>
<tr>
<td>Actual end date</td>
<td>Date the improvement initiative ended.</td>
</tr>
</tbody>
</table>

### Notes tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional comments (customer visible)</td>
<td>Check box to show additional comments that are visible to the customer. If checked, the Additional comments (Customer visible) field content is shown.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Work notes relating to the improvement initiative. <strong>Note:</strong> Required when submitting the improvement initiative for reapproval.</td>
</tr>
</tbody>
</table>

### Closure Notes tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Closure code         | • Successful: Goals met.  
• Withdrawn: No longer needed/applicable.  
• Unsuccessful: Goals not met. |
| Achieved outcome category | • Cost Reduction  
• Revenue Generation  
• Time Savings  
• Customer Satisfaction  
• Quality Improvement |
| Close notes          | Notes regarding the improvement initiative closure.                        |
## CIM Phases related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique CIMT phase number.</td>
</tr>
<tr>
<td>Parent</td>
<td>Improvement initiative to which the CIM phase belongs. There can be multiple CIM phases per improvement initiative. The CIM phase groups the tasks, sets a planned end date, and shows the percent complete for tracking purposes.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>Percentage of work completed. Percentage is based on the completed state of the CIM tasks that belong to this CIM phase. For example, if there are five CIM tasks, each contributes to 20% completion.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Estimated phase end date.</td>
</tr>
<tr>
<td>Actual end date</td>
<td>End date of the phase.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Short description of the phase.</td>
</tr>
<tr>
<td>Description</td>
<td>(Required) Full description of the phase.</td>
</tr>
</tbody>
</table>

## CIM Tasks related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique CIMT task number.</td>
</tr>
<tr>
<td>Parent</td>
<td>Improvement phase number to which the CIM task belongs. CIM tasks consist of the work required to complete the improvement initiative. Each CIM task is tied to a CIM phase of the improvement initiative. A CIM task can only be tied to one CIM phase.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that indicates whether the task is active.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User primarily responsible for completion of the task.</td>
</tr>
<tr>
<td>Improvement Initiative</td>
<td>Improvement initiative number to which the CIM task belongs.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Priority</td>
<td>Sequence in which an incident or problem is to be worked on, based on impact and urgency.</td>
</tr>
</tbody>
</table>
|                       | • 1 - Critical  
• 2 - High  
• 3 - Moderate  
• 4 - Low  
• 5 - Planning |
| State                 | State of the task.                                                                                                                          |
|                       | • Pending  
• Open  
• Work In Process  
• Closed Complete  
• Closed Incomplete  
• Closed Skipped  
• On Hold |
| On Hold Reason        | Reason for putting the CIM task on hold.                                                                                                    |
|                       | **Note:** This field is shown only when the state is on hold.  
When an improvement initiative is placed on hold, all CIM tasks are also placed on hold, but the state can be changed manually.  
When the improvement initiative is taken off hold, the CIM tasks are returned back to their previous state (unless they were changed manually). |
| Planned end date      | Estimated end date of the task.                                                                                                             |
| Short Description     | Short description of the task.                                                                                                              |
| Description           | Full description of the task.                                                                                                               |
| Work notes            | Work notes for the task.                                                                                                                    |

**Impacted KPIs related list**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improvement Initiative</td>
<td>Improvement initiative number to which the impacted KPI belongs.</td>
</tr>
<tr>
<td>Impacted KPI</td>
<td>Other related KPIs (independent of the Improvement KPI) that are affected by changes made as a result of the improvement initiative.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown</td>
<td>The breakdown of the impacted KPI.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only when an impacted KPI is selected.</td>
</tr>
<tr>
<td>Element</td>
<td>The element of the KPI breakdown.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only when a breakdown is selected.</td>
</tr>
<tr>
<td>Breakdown Level 2</td>
<td>The second-level breakdown of the improvement KPI, if one exists.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only after the first breakdown is selected.</td>
</tr>
<tr>
<td>Element Level 2</td>
<td>The element of the second-level KPI breakdown.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only when a second-level breakdown is selected.</td>
</tr>
<tr>
<td>View Scorecard</td>
<td>Related link to view the scorecard for the KPI.</td>
</tr>
</tbody>
</table>

### Approvers related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td><em>State of the approval.</em></td>
</tr>
<tr>
<td></td>
<td>- Not Yet Requested</td>
</tr>
<tr>
<td></td>
<td>- Requested</td>
</tr>
<tr>
<td></td>
<td>- Approved</td>
</tr>
<tr>
<td></td>
<td>- Rejected</td>
</tr>
<tr>
<td></td>
<td>- Canceled</td>
</tr>
<tr>
<td></td>
<td>- No Longer Required</td>
</tr>
<tr>
<td>Approver</td>
<td>User authorized to approve the improvement initiative.</td>
</tr>
<tr>
<td></td>
<td>Approvers are members of the group set in the Approver Group field on the Improvement Initiative form.</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments for the approval improvement initiative.</td>
</tr>
<tr>
<td>Created</td>
<td>Date the improvement initiative was created.</td>
</tr>
</tbody>
</table>
Components installed with Continual Improvement Management

Several types of components are installed with activation of the com.sn_cim plugin, including tables, user roles, and scheduled jobs.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see *Find components installed with an application*.

Demo data is available for this feature.

### Roles installed

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Roles inherited</th>
</tr>
</thead>
</table>
| Improvement Requester (sn_cim.improvement_requester) | Able to perform these application functions:  
- Create improvement initiative  
- View My CIM requests  
- View Watched CIM requests  
- View All CIM requests | None |
<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Roles inherited</th>
</tr>
</thead>
</table>
| Improvement Coordinator                  | Able to perform all functions for improvements to which they are assigned as Improvement Coordinator except:  
- Create Enterprise Strategies  
- Delete Improvement  
  Although able to perform Improvement Manager functions, an Improvement Coordinator can only perform those functions for improvements that they are assigned as Improvement Coordinator by the Improvement Manager.  
  Primary responsibility is to coordinate improvements within their area of expertise (at the process or service level).  
  Can access both Continual Improvement Workbench and dashboard.  | sn_cim.improvement_requester  
- app_service_user  
- certification  
- cmdb_query_builder  
- dependency_views  
- itil  
  Problem/change/incident records can be added.  
- knowledge  
- pa_analyst  
- pa_contributor  
- pa_power_user  
  Existing Performance Analytics indicators can be accessed, and new ones created.  
- pa_target_admin  
- pa_threshold_admin  
- pa_viewer  
- sn_bm_client.benchmark_data_viewer  
- sn_bm_client.benchmark_recommendation_viewer  
  Benchmarks data and recommendations can be viewed and an improvement initiative can be created from Benchmarks recommendations.  
- template_editor  
- view_changer  |
| Improvement Manager                      | Able to perform all application functions.  
The Improvement Manager is primarily responsible for all improvements, including initial acceptance of new improvement requests, assignment, and closure. The Improvement Manager also monitors the overall progress of all improvements.  | sn_cim.improvement_coordinator  |

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(PA Continual Improvement)</td>
<td>Daily CIM data collection.</td>
</tr>
<tr>
<td>(PA Continual Improvement)</td>
<td>Historical CIM data collection.</td>
</tr>
</tbody>
</table>

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improvement Initiative</td>
<td>Contains the all improvement initiatives.</td>
</tr>
<tr>
<td>(sn_cim_register)</td>
<td></td>
</tr>
<tr>
<td>CIM Task</td>
<td>Contains the CIM tasks created for an improvement initiative.</td>
</tr>
<tr>
<td>(sn_cim_task)</td>
<td></td>
</tr>
<tr>
<td>Impacted KPIs</td>
<td>Contains KPIs related to the CIM improvement initiative.</td>
</tr>
<tr>
<td>(sn_cim_related_kpi)</td>
<td></td>
</tr>
</tbody>
</table>

### Quick tests for Continual Improvement Management

Validate the continued functionality of Continual Improvement Management during application development and after upgrades. Copy and configure these automated tests to identify customizations needing review. All test suites and tests should pass.

**Note:** The Continual Improvement Management Automated Tests (com.sn_cim_atf) plugin must be activated for CIM automated tests.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIM Parent test suite</td>
<td>Parent test suite that contains multiple child test suites.</td>
</tr>
<tr>
<td></td>
<td>- CIM Inbound Integration</td>
</tr>
<tr>
<td></td>
<td>- CIM Outbound Integrations</td>
</tr>
<tr>
<td></td>
<td>- CIM Phase and Task</td>
</tr>
<tr>
<td></td>
<td>- CIM State Flow</td>
</tr>
</tbody>
</table>

**Note:** There is no dependency between child test suites.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIM Inbound Integrations</td>
<td>Suite that contains tests to create an improvement initiative from inbound integration applications.</td>
</tr>
<tr>
<td></td>
<td>· Problem Management</td>
</tr>
<tr>
<td></td>
<td>· Incident Management</td>
</tr>
<tr>
<td></td>
<td>· Demand Management</td>
</tr>
<tr>
<td></td>
<td>· Coaching</td>
</tr>
<tr>
<td></td>
<td>· Survey Management</td>
</tr>
<tr>
<td></td>
<td>· Assessments</td>
</tr>
<tr>
<td>CIM Outbound Integrations</td>
<td>Suite that contains tests for all CIM outbound integrations.</td>
</tr>
<tr>
<td></td>
<td>· From an improvement initiative: Create demand and create project.</td>
</tr>
<tr>
<td></td>
<td>· From an improvement initiative task: Create knowledge article, change request, coaching opportunity, and story.</td>
</tr>
<tr>
<td>CIM Phase and Task</td>
<td>Suite that contains tests for CIM phase and CIM task creation, roll-up tasks, roll up phases, and dates.</td>
</tr>
<tr>
<td>CIM State Flow</td>
<td>Suite that contains all CIM state-related tests.</td>
</tr>
<tr>
<td>CIM: Create a demand from an improvement initiative</td>
<td>Tests that a user with the Improvement Manager role can create a demand from an improvement initiative.</td>
</tr>
<tr>
<td>CIM: Create a project from an improvement initiative</td>
<td>Tests that a user with Project manager and Improvement Manager roles can create a project from an improvement initiative.</td>
</tr>
<tr>
<td>CIM: Create a change request from an improvement initiative task</td>
<td>Tests that a user with the Improvement Manager role can create a change request from an improvement initiative task.</td>
</tr>
<tr>
<td>CIM: Create a coaching opportunity from an improvement initiative task</td>
<td>Tests that a user with Coaching admin and Improvement Manager roles can create a coaching opportunity from an improvement initiative task.</td>
</tr>
<tr>
<td>CIM: Create a knowledge article from an improvement initiative task</td>
<td>Tests that a user with Knowledge admin and Improvement Manager roles can create knowledge article from an improvement initiative task.</td>
</tr>
<tr>
<td>CIM: Create a story from an improvement initiative task</td>
<td>Tests that a user with Project manager and Improvement Manager roles can create a story from an improvement initiative task.</td>
</tr>
<tr>
<td>CIM: Create a task within a phase</td>
<td>Tests that a task can be created within a phase.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CIM: Improvement Coordinator creates a task and phase</td>
<td>Tests that a user with the Improvement Coordinator role can create a task and phase.</td>
</tr>
<tr>
<td>CIM: Improvement Coordinator state flow from Approved to Implement</td>
<td>Tests that a user with the Improvement Coordinator role can change an improvement initiative from Approved state to Implement state.</td>
</tr>
<tr>
<td>CIM: Improvement Manager creates a strategic objective</td>
<td>Tests that a user with the Improvement Manager role can create a strategic objective.</td>
</tr>
<tr>
<td>CIM: Improvement Manager creates a task and phase</td>
<td>Tests that a user with the Improvement Manager role can create a task and phase.</td>
</tr>
<tr>
<td>CIM: Improvement Manager deletes an improvement initiative</td>
<td>Tests that a user with the Improvement Manager role can delete an improvement initiative.</td>
</tr>
<tr>
<td>CIM: Improvement Requester cannot create a task or phase</td>
<td>Tests that a user with the Improvement Requester role cannot create a task or phase.</td>
</tr>
<tr>
<td>CIM: Improvement Requester creates an improvement initiative</td>
<td>Tests that a user with the Improvement Requester role can create an improvement initiative.</td>
</tr>
<tr>
<td>CIM: Inbound integration from Assessments</td>
<td>Tests that a user with the Survey administrator role can create an improvement initiative from an assessment.</td>
</tr>
<tr>
<td>CIM: Inbound integration from a coaching opportunity</td>
<td>Tests that a user with the Coaching admin role can create an improvement initiative from a coaching opportunity.</td>
</tr>
<tr>
<td>CIM: Inbound integration from Demand Management</td>
<td>Tests that a user with the Demand manager role can create an improvement initiative from a demand.</td>
</tr>
<tr>
<td>CIM: Inbound integration from Incident Management</td>
<td>Tests that a user with the ITIL role can create an improvement initiative from an incident.</td>
</tr>
<tr>
<td>CIM: Inbound integration from Problem Management</td>
<td>Tests that a user with the ITIL role can create an improvement initiative from a problem.</td>
</tr>
<tr>
<td>CIM: Inbound integration from Survey Management</td>
<td>Tests that a user with the Survey administrator role can create an improvement initiative from a survey.</td>
</tr>
<tr>
<td>CIM: Initiative reject approval state flow from Assess to Accepted</td>
<td>Tests when an improvement initiative in Assess state is rejected by an approver, the state reverts back to Accepted.</td>
</tr>
<tr>
<td>CIM: Initiative state flow from Implement to On Hold</td>
<td>Tests that an improvement initiative in Implement state can be changed to On Hold state.</td>
</tr>
<tr>
<td>CIM: Initiative state flow from New through Closed</td>
<td>Tests that an improvement initiative in New state can be progressed through states Accepted, Assess, Approved, Implement, Review, to Closed state.</td>
</tr>
<tr>
<td>CIM: Initiative state flow from On Hold to Implement</td>
<td>Tests that an improvement initiative in On Hold state can be changed to Implement state.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CIM: Initiative state flow from On Hold to Review</td>
<td>Tests that an improvement initiative in On Hold state can be changed to Review state.</td>
</tr>
<tr>
<td>CIM: Initiative state flow from Review to Implement</td>
<td>Tests that an improvement initiative in Review state can be changed to Implement state.</td>
</tr>
<tr>
<td>CIM: New phase planned end date check</td>
<td>Tests that the planned end date for a new phase is at least one day later than the planned start date of the improvement initiative.</td>
</tr>
<tr>
<td>CIM: Phase creation for a new improvement initiative</td>
<td>Tests that a phase is automatically created when an improvement initiative is created.</td>
</tr>
<tr>
<td>CIM: Planned end date always later than planned start date</td>
<td>Tests that the planned end date of the improvement initiative is not later than the planned start date of the improvement initiative.</td>
</tr>
<tr>
<td>CIM: Roll-up phase to improvement initiative value check</td>
<td>Tests that the phase-level roll-up value for the improvement initiative (percent complete) is accurate.</td>
</tr>
<tr>
<td>CIM: Roll-up tasks to phase value check</td>
<td>Tests that the task-level roll-up value for the phase (percent complete) is accurate.</td>
</tr>
<tr>
<td>CIM: Skip approval process flow</td>
<td>Tests that the approval process is skipped when the Enable approval process for Continual Improvement initiatives property is cleared.</td>
</tr>
<tr>
<td>CIM: Submit an initiative in Accepted state to Cancel</td>
<td>Tests that an improvement initiative in Accepted state can be submitted for Cancel action.</td>
</tr>
<tr>
<td>CIM: Submit an initiative in Approved state for Re-Approval</td>
<td>Tests that an improvement initiative in Approved state can be submitted for Re-Approval action.</td>
</tr>
<tr>
<td>CIM: Submit an initiative in Assess state for Revert to Accepted</td>
<td>Tests that an improvement initiative in Assess state can be submitted for Revert to Accepted action.</td>
</tr>
<tr>
<td>CIM: Submit an initiative in Implement state for Re-Approval</td>
<td>Tests that an improvement initiative in Implement state can be submitted for Re-Approval action.</td>
</tr>
</tbody>
</table>

### Continual Improvements dashboard

The Continual Improvements dashboard enables an Improvement Process Coordinator or Manager to determine which process to start next, how many initiatives they have underway at a given time, and what the employee participation is.

This dashboard is included in the Continual Improvements Management plugin.
Outcomes Achieved - Last 6 Months

KPI's Completed in the Last 6 Months

<table>
<thead>
<tr>
<th>Number</th>
<th>Improvement KPI</th>
<th>Closed</th>
<th>Closure code</th>
<th>View Scorecard</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIM0000150</td>
<td>Benchmark: % of duplicate CIS</td>
<td>2018-07-20 15:10:59</td>
<td>Successful</td>
<td>View Scorecard</td>
</tr>
<tr>
<td>CIM0000153</td>
<td>Benchmark: Number of active ITIL users</td>
<td>2018-07-20 15:10:59</td>
<td>Unsuccessful</td>
<td>View Scorecard</td>
</tr>
</tbody>
</table>
End users and roles

<table>
<thead>
<tr>
<th>End user</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improvement Process Coordinator: Needs to verify the status of their initiatives.</td>
<td>sn_cim.improvement_coordinator</td>
</tr>
<tr>
<td>Improvement Process Manager: Must be able to see the state of all improvement processes and assign employees where they are needed.</td>
<td>sn_cim.improvement_manager</td>
</tr>
</tbody>
</table>

Reports

The Continual Improvements dashboard includes the following reports:

<table>
<thead>
<tr>
<th>Report Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Engagement</td>
<td>Column, Chart</td>
<td>State is not Closed or Cancelled Trended by Created</td>
</tr>
<tr>
<td>Total Initiatives</td>
<td>Horizontal Bar, Chart</td>
<td>State is not Closed or Cancelled Grouped by State</td>
</tr>
<tr>
<td>Open Backlog</td>
<td>Single, Score</td>
<td>State is not Closed or Cancelled</td>
</tr>
<tr>
<td>Unassigned</td>
<td>Single, Score</td>
<td>CIM Coordinator is empty and State is not Closed or Cancelled</td>
</tr>
<tr>
<td>Report Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Prioritized List Using Spotlight</td>
<td>List</td>
<td>Name: Benefit High Query: benefit=high Weight: 50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name: Benefit Low Query: benefit=low Weight: 30</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name: Benefit Medium Query: benefit=medium Weight: 40</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name: Effort Estimate Extra Large Query: cim_estimate=4 Weight: 50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name: Effort Estimate Large Query: cim_estimate=3 Weight: 40</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name: Effort Estimate Medium Query: cim_estimate=2 Weight: 30</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name: Effort Estimate Small Query: cim_estimate=1 Weight: 20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name: Priority 1 Query: priority=1 Weight: 50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name: Priority 2 Query: priority=2 Weight: 40</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name: Priority 3 Query: priority=3 Weight: 30</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name: Priority 4 Query: priority=4 Weight: 20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name: Priority 5 Query: priority=5 Weight: 10</td>
</tr>
</tbody>
</table>

**Expense Line**

Expense lines enable you to track costs and represent when a point-in-time expense incurred. Expense lines can be created manually or generated by the scheduled processing of recurring costs.

The Expense Line plugin is active for all instances. To use the Expense Allocations and Expense Allocation Rules modules, activate the Cost Management plugin.

The Now Platform generates expense lines automatically when you create an asset, and updates expense lines automatically when you revise the **Cost** or **Quantity** field on an asset record.

Users with the financial_mgmt_admin and financial_mgmt_user roles can work with expense lines. Expense lines integrate closely with asset management, CMDB, cost management, and contract management, but can be used with any application. The **Source ID** field on an expense line record can be linked to any record in any table. This identifier allows expenses to be associated.
with a wide variety of items, such as a contract, an individual asset, a single configuration item, a software installation, a lease, a service contract, a user, or a group.
Example expense line for an asset monthly lease
Components installed with Expense Line

Several types of components are installed with the Expense Line plugin.

Tables installed with Expense Line

Tables are added with activation of Expense Line.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense Line (fm_expense_line)</td>
<td>Stores information about expense lines, including a link to the associated rate card. Contains the status and next scheduled processing date for the expense line.</td>
</tr>
</tbody>
</table>

Roles installed with Expense Line

Roles are added with activation of Expense Line.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial admin (financial_mgmt_admin)</td>
<td>(financial_mgmt_user)</td>
<td>Can create, write, and delete allocation units, fixed assets, depreciation, rate cards, distribution costs, expense lines, and expense allocations.</td>
</tr>
<tr>
<td>Financial user (financial_mgmt_user)</td>
<td>none</td>
<td>Can read allocation units and expense allocations. Can create, read, and write rate cards and expense lines. Can create, read, write, and delete fixed assets, depreciation, distribution costs.</td>
</tr>
</tbody>
</table>

Script includes installed with Expense Line

Script includes are added with activation of Expense Line.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExpenseLine</td>
<td>Helps create expense line records.</td>
</tr>
<tr>
<td>ExpenseManagementUtils</td>
<td>Provides utilities for financial management modules.</td>
</tr>
<tr>
<td>ExpenseManagementUtilsAJAX</td>
<td>Provides AJAX utilities for expense lines.</td>
</tr>
</tbody>
</table>

Client scripts installed with Expense Line

Client scripts are added with activation of Expense Line.
### Business rules installed with Expense Line

Business rules are added with activation of Expense Line.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Expense Line</td>
<td>(alm_asset)</td>
<td>Automatically creates an expense line for a new asset based on asset cost unless the asset is a merged software license.</td>
</tr>
<tr>
<td>Set source allocation fields</td>
<td>(fm_expense_line)</td>
<td>Sets the related source fields when the source ID changes. For example, when an asset becomes the source ID, the asset source field and configuration item source field are automatically populated.</td>
</tr>
<tr>
<td>Update Costs</td>
<td>(alm_consumable)</td>
<td>Updates the cost of a consumable when quantity is reduced.</td>
</tr>
</tbody>
</table>
Domain separation and Expense Line

This is an overview of domain separation and Expense Line processing. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: No support

- The domain field may exist on data tables, but there is no business logic to manage data.
- This level is not considered domain-separated.

For more information, see Application support for domain separation.

View an expense

Expense lines can be used in various ways, for example, how to view expenses that are associated with a given contract.

Role required: asset or contract_manager

1. Navigate to **Contract > Contract > All**.
2. Select a contract.
3. View the **Expense Lines** related list.
   - All the expense lines for the contract are listed. The total cost of the contract and its current value are also shown.
4. Select an expense line to view its details.

Expense lines and expense allocations

The Expense lines application tracks costs and record expenses incurred. Expense allocations let you associate expenses with items such as users, groups, or departments.

Expense lines are a key component of cost management because they can be generated from any application and are used to allocate expenses to business entities. Expense lines can be created manually or generated automatically when costs are created by scheduled processing.

Users with the financial_mgmt_admin and financial_mgmt_user roles can work with expense lines and expense allocation rules.

To use expense allocation rules, activate the Cost Management application.

Create an allocation rule

Expense allocation rules enable you to associate expenses with an item, such as a user, group, or department.

To use expense allocation rules, activate Cost Management.

Role required: admin, financial_mgmt_admin, or financial_mgmt_user

1. Navigate to **Cost > Administration > Expense Allocation Rules**.
2. Click New.
3. Complete the form.
### Allocation rule fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The allocation rule name.</td>
</tr>
<tr>
<td>Table</td>
<td>The table to which the allocation rule is associated.</td>
</tr>
<tr>
<td>Allocation field</td>
<td>The field on the table to populate with the expense allocation.</td>
</tr>
<tr>
<td>Inherited</td>
<td>Check box that indicates whether the expense allocation is inherited.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that indicates whether the expense allocation is available to use.</td>
</tr>
<tr>
<td>Percentage</td>
<td>The percentage of the expense line allocated to the table and field combination. Not available if the Advanced check box is selected.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The expense allocation category: Grow Business, Run Business, or Transform Business. Categorizing expense allocations can be useful for reporting.</td>
</tr>
<tr>
<td>Condition</td>
<td>The condition under which the expense allocation is applied. Not available if the Advanced check box is selected.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check box that indicates whether to display the Script field.</td>
</tr>
<tr>
<td>Script</td>
<td>The script field that determines expense allocations. This field is only available if the Advanced check box is selected.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

### Automatic expense line creation

You can automatically create expense lines to facilitate the accurate reporting of expenses. If enabled, the following processes generate expense lines automatically.

- Active CI rate cards are processed monthly to generate expense lines for each CI in the rate card. If a CI relationship is changed, existing expense lines are not affected. Changes are reflected in the next scheduled expense line.
- Active distribution costs are processed monthly to generate expense lines based on distribution rule targets.
- Closed tasks on task rate cards are processed to generate expense lines.

Expense lines can also be imported from external systems or generated from scripts. To generate an expense from a server-side script, use the ExpenseLine API.
Create expense lines manually

You can create expense lines at a single level or in a hierarchy to better organize expense information.

Role required: admin, financial_mgmt_admin, or financial_mgmt_user

Use a hierarchy if it makes sense for your organization. In the example below, the last two expense lines are a level under expense line number EXP0010001.

Expense lines in a hierarchy

1. Navigate to Costs > Expense Lines.
2. Open an expense line record, or click New to create a new expense line.
3. Complete the form.

Expense line table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the expense line.</td>
</tr>
<tr>
<td>Date</td>
<td>The date on which the expense line was created.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rate Card</td>
<td>The identification number of the rate card to which the expense line is associated.</td>
</tr>
<tr>
<td>Rate type</td>
<td>The rate type that is considered during the expense line generation. This field is read-only.</td>
</tr>
<tr>
<td>Source ID</td>
<td>The identification number of the item associated with the expense line. If this field is filled in, corresponding information is automatically added to the Source fields on this form.</td>
</tr>
<tr>
<td>Amount</td>
<td>The monetary value of the item specified in the Source ID field. Enter a negative value to indicate a credit.</td>
</tr>
<tr>
<td>Process date</td>
<td>The date the expense line is processed.</td>
</tr>
<tr>
<td>Inherited</td>
<td>Check box that indicates whether the expense line is on another expense line.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the expense line, either Pending or Processed.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The expense line category: Grow Business, Run Business, or Transform Business. Categorizing expense lines can be useful for reporting.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the expense line.</td>
</tr>
<tr>
<td>Asset</td>
<td>The identification number of the asset associated with the expense line, if any.</td>
</tr>
<tr>
<td>Fixed asset</td>
<td>Fixed asset that contains the asset in this expense line. A fixed asset is a container that holds one or more individual assets, including hardware or software assets. The system auto-populates this field with the appropriate fixed asset if the named Asset is contained within that fixed asset.</td>
</tr>
<tr>
<td>Contract</td>
<td>The identification number (not the contract number) of the contract associated with the Asset, if any.</td>
</tr>
<tr>
<td>User</td>
<td>The name of the user associated with the Asset, if any.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>The name of the configuration item associated with the expense line, if any.</td>
</tr>
<tr>
<td>Task</td>
<td>The identification number of the task associated with the expense line, if any.</td>
</tr>
<tr>
<td>Cost center</td>
<td>The cost center financially responsible for the item identified in Source ID, if any.</td>
</tr>
</tbody>
</table>
Delete an expense line
Deleting an expense line also deletes all expense allocations that were generated from the expense line.
Role required: admin or financial_mgmt_admin
Deleting expense lines and allocations should be limited to an emergency case only when they were created incorrectly.
1. Navigate to Costs > Expense Lines.
2. Select an expense line.
3. Click Delete.
4. In the confirmation message, click OK.

Create a sample allocation rule
You can create a sample expense allocation rule that allocates the cost of an incident to the department of the caller.
To use expense allocation rules, activate the Cost Management application.
Role required: admin, financial_mgmt_admin, or financial_mgmt_user
1. Costs > Administration > Expense Allocation Rules
2. Click New.
3. In Name, enter Incident Caller Department.
4. In Table, select Incident.
5. In Allocation field, click the control, expand the Caller element, and select a department.
6. In Percentage, enter 100 to allocate all the expense to the caller’s department.
7. Select the Active check box.
8. Click Submit.
   After an incident expense line is created, the allocation rule processes the expense line and generates an expense allocation linking the expense and amount to the caller’s department. The expense is stored in the Target field on the Expense Allocation record.

Use a scripted allocation
Scripted allocations define custom allocation amounts and targets by executing a script.
Role required: admin, financial_mgmt_admin, or financial_mgmt_user
You can use scripted allocations to perform any of the following actions.
• Allocate an expense to all cost centers based on the current head count in the cost center.
• Query usage data to determine the allocation amount to assign to a target.
• Track the business users that are consuming business services.
1. Navigate to Costs > Administration > Expense Allocation Rules.
2. Select an expense allocation rule.
3. Select the Advanced check box.
4. Use the following concepts to build the script
   • Query for target records and data to use for calculating the allocation amount.
Create allocation records using the ExpenseAllocation API.

The following variables are available during the script processing:

- allocation: expense allocation object used to create allocations.
- expense: GlideRecord for the expense_line that is being processed.
- rule: GlideRecord for this rule.

To create an allocation record, use the allocation object already instantiated in the script scope:

```
allocation.createAllocation(targetGlideRecord, amount);
```

Domain separation and Expense Line

This is an overview of domain separation and Expense Line processing. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: No support

- The domain field may exist on data tables, but there is no business logic to manage data.
- This level is not considered domain-separated.

For more information, see Application support for domain separation.

ITSM Virtual Agent

Implement ITSM Virtual Agent to support and scale your IT organization by enabling a virtual agent to perform the less complicated, more common IT requests and incidents. ITSM Virtual Agent includes predefined conversations designed to help both your IT fulfillment professionals and users complete common tasks, such as resolve an incident, reset a password, and create an incident.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Understanding ITSM Virtual Agent

ITSM Virtual Agent enables your technicians to concentrate on more challenging, demanding user requests and incidents. ITSM Virtual Agent enhances the employee experience by addressing IT-related queries immediately. At any time during a virtual conversation, a user can request to interact with a live IT technician.
Several predefined ITSM Virtual Agent topic conversations, covering common IT interactions, are included with the base-system application. These conversations run in the web chat client and also in supported ITSM Virtual Agent messaging integrations.

Conversations represent dialogs between the virtual agent and the user to accomplish a specific goal. The information exchanged during the conversation flow, such as user inputs and virtual agent responses, enables the virtual agent to fulfill a request or help complete a task.

Listen to this 18-minute podcast for a discussion of the Virtual Agent and how it can streamline interactions between a company and its customers and employees.

For complete details about ITSM Virtual Agent, refer to Virtual Agent.

**Natural Language Understanding**

Implement Natural Language Understanding (NLU) for all your ITSM Virtual Agent topic conversation flows. ITSM Virtual Agent uses NLU to comprehend word meanings and recognize word contexts to better infer user or system actions.

You can decide whether you want ITSM Virtual Agent to use only keywords, which results in quicker time-to-value in the short term. Or, you can choose to use NLU, which results in a better employee experience with a virtual agent in the long term.

ITSM Virtual Agent and the ITSM NLU Model for Virtual Agent Conversations are available from the ServiceNow Store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

The ITSM NLU Model for Virtual Agent Conversations provides numerous base system, pre-built NLU model system entities, NLU intent entities, NLU utterance entities, NLU entities, NLU intents, NLU utterances, and NLU vocabulary. NLU utterances exist in the ITSM NLU Model to provide greater precision in identifying user intents. Some utterance examples include:

- **Escalate Ticket topic:**
  - raise incident INC0010023 ticket priority to higher level
  - please can you raise the priority on my open ticket

- **Check Outages and Service Degradations topics:**
  - are there currently any reported company wide issues
  - is there an outage

- **Email Setup topic**
  - i want to setup email on my mobile device
  - how do i setup company email on my phone

Enable NLU on the ITSM Virtual Agent application and republish your existing conversations to optimize user experience with the NLU feature.

Refer to the following information for details regarding the NLU feature: Natural Language Understanding in Virtual Agent.
Edge Encryption for ITSM Virtual Agent

Edge encryption provides you with direct control over your data security. Encryption and key management are performed on your intranet between your browser and your ServiceNow instance. For details, refer to Edge Encryption for ITSM Virtual Agent within ITSM.

ITSM Virtual Agent topic categories and conversations

The ITSM Virtual Agent predefined topic conversations are contained in several topic categories, including:

<table>
<thead>
<tr>
<th>Topic category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITSM Fulfiller</td>
<td>Topic conversations specifically for ITSM professionals with the itil role, such as resolving an incident, creating a problem, and updating data in the system</td>
</tr>
<tr>
<td>ITSM IT Issues</td>
<td>Topic conversations for common IT-related issues, such as email setup, VPN connectivity, and conference room problems.</td>
</tr>
<tr>
<td>ITSM Self Service</td>
<td>Topic conversations enabling users to easily access IT-related information, such as password reset, verify assigned equipment, and search the Knowledge Base.</td>
</tr>
<tr>
<td>Setup Topics</td>
<td>Topic conversations, such as a standard welcome greeting and a conversation closing, related to initiating an ITSM Virtual Agent experience for your users. This includes a greeting, feedback, survey, and live agent support.</td>
</tr>
<tr>
<td>Small Talk Topics</td>
<td>Topics that you build to enable your virtual agent to engage in casual conversation with users. A small talk topic provides a response to a casual question that users might ask during a conversation, such as the time or date. A small talk topic can occur anytime within a conversation session and can be unrelated to the original conversation intent.</td>
</tr>
</tbody>
</table>

The individual ITSM Virtual Agent predefined topic conversations include:

ITSM Virtual Agent predefined Fulfiller category topic conversations

- Identify Scheduled Changes
- Create Change Request
- Resolve Incident
- Create Problem
- Update Assigned Task
- Identify Available Change Windows
Update Change Request

**ITSM Virtual Agent predefined IT Issues category topic conversations**

- Local Admin Access
- RSA Token
- Email Issues
- Manage Distribution List
- Manage Office 365 Group (Template)

**Note:** This topic is only available with the activation of the Microsoft Azure AD for IntegrationHub (com.sn.azure_ad.spoke) plugin.

- Repository Access
- Email Setup
- Meeting Room Issues
- Troubleshoot Slow Computer
- Guest WiFi Access
- Printer Issues
- VPN Connectivity

**ITSM Virtual Agent predefined Self Service category topic conversations**

- Submit a request
- Check IT Ticket Status
- Process Approval
- Get Password Reset Link
- My Assigned Equipment
- Service Disruptions
- Search Knowledge Base

**Note:** The Search Knowledge Base topic conversation uses the Contextual Search reusable topic block.

- Open IT Ticket

**Note:** The Open IT Ticket topic conversation uses the Create Incident reusable topic block.

- Intelligent Open IT Ticket (Template)
- Escalate IT Ticket
- Walk-up Check-in

**Note:** the Walk-up Check-in topic conversation is available when the Walk-up Experience plugin (com.snc.walkup) is activated.

- Report IT Issue

**ITSM Virtual Agent predefined Setup Topics category conversations**

- Greetings
Reusable ITSM Virtual Agent topic blocks

Create and reuse topic blocks to perform common functions in ITSM Virtual Agent conversations, such as creating an incident or performing a search. ITSM Virtual Agent provides the following predefined, reusable topic blocks and templates:

- Contextual Search: This topic block provides standardized contextual search functionality for your ITSM related topics, as well as your other business unit related topics, such as human resources and service management.

  Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks).

- Contextual Search (Template)

  Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks).

- Create Zoom Meeting Link (Template)

  Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks).

- Request Catalog Item

  Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks). For detailed information about this topic block, including input and output parameters and descriptions, refer to Service Catalog topic blocks in Virtual Agent.

- Request Catalog Item (Template)

  Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks). For detailed information about this topic block, including input and output parameters and descriptions, refer to Service Catalog topic blocks in Virtual Agent.
topic block, including input and output parameters and descriptions, refer to Service Catalog topic blocks in Virtual Agent.

- Search Catalog Item

    Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks). For detailed information about this topic block, including input and output parameters and descriptions, refer to Service Catalog topic blocks in Virtual Agent.

- Search Catalog Item (Template)

    Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks). For detailed information about this topic block, including input and output parameters and descriptions, refer to Service Catalog topic blocks in Virtual Agent.

- Troubleshoot Cisco Webex (Template)

    Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks).

- Troubleshoot Microsoft Teams (Template)

    Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks).

- Transfer to Live Agent
- Create Incident
- Create Incident (Template)
- Survey
- Add Comments - Similar Incident: ITSM Virtual Agent uses the similarity analysis framework to prevent users from opening duplicate incidents. This topic block finds similar incidents and asks if the user wants to add comments to the similar incident.

Some topic blocks require input and output parameters:

**Contextual Search topic block parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input parameter:</td>
<td></td>
</tr>
<tr>
<td>context</td>
<td>The sys_id of a Search Context (cxs_context_config) record. Defines what</td>
</tr>
<tr>
<td></td>
<td>sources are included in the search, for example, knowledge base or community.</td>
</tr>
<tr>
<td>query</td>
<td>The search keyword entered by a user during a virtual agent conversation.</td>
</tr>
<tr>
<td>portal</td>
<td>The portal from which the conversation initiated. For example, a service</td>
</tr>
<tr>
<td></td>
<td>portal or human resources portal.</td>
</tr>
<tr>
<td></td>
<td>This is the URL suffix, for example, sp, esc, csm, and hr, from which the</td>
</tr>
<tr>
<td></td>
<td>search result will open.</td>
</tr>
</tbody>
</table>
### Input parameter:

**kb_knowledge_base**

The sys_id of a Knowledge Base (kb_knowledge_base) record. Within context, search only these knowledge base articles.

### Output parameter:

**results_returned**

True if search results are found, otherwise false.

### Output parameter:

**results_helpful**

True if user responds that search results are helpful, otherwise false.

### Create Incident topic block parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input parameter:</strong> caller</td>
<td>The name of the user creating an Incident (incident) record.</td>
</tr>
<tr>
<td><strong>Input parameter:</strong> short_description</td>
<td>The short description entered in the Incident (incident) record.</td>
</tr>
<tr>
<td><strong>Input parameter:</strong> urgency</td>
<td>The urgency level indicated in the Incident (incident) record.</td>
</tr>
<tr>
<td><strong>Input parameter:</strong> description</td>
<td>The description entered in the Incident (incident) record.</td>
</tr>
<tr>
<td><strong>Output parameter:</strong> created_incident_sys_id</td>
<td>The return sys_id of a newly created incident.</td>
</tr>
</tbody>
</table>

The Topics page in Virtual Agent Designer features a sort tab called **Topic Blocks** for viewing just the reusable topic functions. For detailed information about ITSM Virtual Agent reusable topic blocks, refer to Virtual Agent Designer, Reusable topic blocks, and Predefined Virtual Agent topics, topic blocks, and NLU models.

**Pre-built clustering solution definition**

ITSM Virtual Agent delivers a pre-built clustering solution definition using the ServiceNow platform Predictive Intelligence clustering capability. Clustering solution definitions provide data that, over time, help you identify automation and topic conversation candidates for Virtual Agent.

For complete information regarding Predictive Intelligence and clustering solution definitions, refer to Predictive Intelligence and Create and train a clustering solution.
ITSM Virtual Agent automatic notifications

The virtual agent proactively informs you about the status of your incidents and requests. Managers are alerted when they have approvals.

ITSM Virtual Agent notification defined on the Task (task) table

The Task type filter on the Task table enables automatic status notification when the value is Incident or Requested item. When the state of the incident or requested item task changes, a virtual agent message is sent to the user.

ITSM Virtual Agent notification defined on the Approval (sysapproval_approver) table

When an approval is submitted, an automatic virtual agent message is sent to the approver alerting them of the approval request.

Set up ITSM Virtual Agent

Administrators and users with the virtual_agent_admin role can create and publish conversation topics in Virtual Agent Designer.

Role required: admin or virtual_agent_admin

Virtual Agent must be activated before you can use the ITSM Virtual Agent topic conversations. Users with the admin or virtual_agent_admin role can activate Glide Virtual Agent (com.glide.cs.chatbot).

Install ITSM Virtual Agent and the ITSM NLU Model for Virtual Agent Conversations by requesting them from the ServiceNow Store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Topics must be activated and published before your employees can use them. By default, the base system provides topics as inactive and unpublished. To view, duplicate, preview, or publish ITSM topics in the Virtual Agent Designer, refer to Virtual Agent Designer.

1. Activate the Glide Virtual Agent plugin (com.glide.cs.chatbot).
2. Install ITSM Virtual Agent by requesting it from the ServiceNow Store.
3. Review the ITSM-related conversation topics in Virtual Agent Designer.
4. If you have decided to implement NLU, enable it in the Virtual Agent application.
   a) Navigate to Virtual Agent > General Settings.
   b) Click NLU Settings.
   c) Click the Enable NLU in Virtual Agent radio button to enable NLU.

   Note: To disable NLU, click the radio button.

5. To use any of the ITSM Virtual Agent conversation topics, publish them in Virtual Agent Designer so that your users can run the conversations in your Virtual Agent support client.

   Note: You cannot edit the provided topics. You can duplicate a provided topic and then edit it. You can also create additional topics. For complete details regarding activating and publishing conversation topics, refer to Virtual Agent Designer.

6. To test an active, published conversation topic, click the topic to test in Virtual Agent Designer and click Test.
The Virtual Agent window opens and engages you to enter data, such as an IT issue or search for a knowledge base article.

**ITSM Virtual Agent conversation flows**

ITSM Virtual Agent includes several predefined topic conversations designed to help your users complete common IT-related tasks, such as resetting a password and creating an incident.

**ITSM Virtual Agent predefined Fulfiller category topic conversation flows**

**Identify Scheduled Changes**

Users with the itil role can find upcoming change requests for a specific configuration item (CI). To see the change requests, users must type in the name of the configuration item that contains the changes.

**Create Change Request**

Users with the itil role can create change requests using a client of choice, such as Slack. Users indicate the type of change request (Normal, Standard, or Emergency). Change type definitions are provided by the virtual agent.

For normal and emergency change requests, the virtual agent prompts the user to enter the following criteria:

- Short description
- Justification
- Configuration item
- Assignment group
- Planned start date
- Planned end date

For standard change requests, the virtual agent sends a carousel link to a catalog of standard change items. After the user selects an item, the virtual agent provides a link to open the associated category page to request the change.
Resolve Incident

Users with the itil role can resolve an incident through support chat by providing a close code, for example, Solved (Permanently) or Solved (Workaround), and resolution notes.
You have one incident assigned:

<table>
<thead>
<tr>
<th>Incident</th>
<th>INC0010143</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Test</td>
</tr>
<tr>
<td>Priority</td>
<td>4 - Low</td>
</tr>
<tr>
<td>State</td>
<td>In progress</td>
</tr>
</tbody>
</table>

Do you want to resolve this incident?

Yes

Alright. Let's start by selecting a resolution code:

Solved (Permanently)

Please provide some resolution notes.

just now

After some further investigation, I was able to resolve this incident.

Got it! Would you like to add an additional comment or a work note?

Neither

I've successfully resolved this incident!
Users with the itil role can create problem records. Users provide a description of the problem and specify the urgency and the impact of the problem. Users need to know and enter the associated problematic configuration item as well.

**Update Assigned Task**

Users with the itil role can update comments or work notes in assigned tasks. When a user wants to update a task, the virtual agent returns a list of all assigned tasks and asks which task the user wants to update. Users can select a single listed task to update or select All to load and update all assigned tasks. The virtual agent then asks if the user wants to add a comment, a work note, or both. Optionally, users can cancel the update.

**Identify Available Change Windows**

Users with the itil role can check the next available change window for a configuration item. For example, you can determine the next available change window for a specific asset assigned to a user, regarding maintenance or black-out calendars. Users must enter the configuration item to check, such as PROmonitor, and then select a planned start and end date and time.
Let’s start by searching for the configuration item whose availability you want to check:

ProMonitor

Alright, I’ve captured PROMonitor.

Do you want to select this CI?

Yes, select this CI

Now, give me a representative planned start and end date for a change so that I can see if there are any upcoming available windows that match your duration.

Let’s select a Planned start date and time:

Monday, December 31 2018, 7:50 pm

now let’s select a Planned end date and time:

just now

Wednesday, January 2 2019, 7:50 pm
Users with the ITIL role can update the actual start and end time of a change, as well as move it to work in progress or closed states.

**ITSM Virtual Agent predefined IT Issues category topic conversation flows**

**Local Admin Access**

Users can request and gain admin rights and permission to install or access software and other admin-related items within your system.

```
Local admin access is commonly required to install software or make system changes. Do you want local admin access on your machine?
```

```
Yes
```

```
Ok, I've granted you local admin permission for 2 Hours
```

**RSA Token**

Users can request an RSA token or report a problem with an RSA token. Users can also request help with setup of an RSA token.
Email Issues

Users can request help with email problems, such as issues sending and receiving email or problems with the email client.
Manage Distribution List

Users can create, delete, and manage a distribution list.
Manage Office 365 Group (Template)

Users can create, delete, and manage a distribution list. Users can add themselves or others to an existing distribution list. They can also remove themselves from a distribution list.

This topic is only available with the activation of the Microsoft Azure AD for IntegrationHub (com.sn.azure_ad.spoke) plugin.

To set up Microsoft Azure AD for IntegrationHub, refer to Set up Microsoft Azure AD spoke.

Repository Access

Users can request and gain access to a data repository manually, or choose from pre-loaded available repositories.
Email Setup

Users can request help with email access or setting up an email account accessible by computer or phone. Users can also request help with configuring email or setting up web mail.

Configure your new email account:
1) Select the email application on your phone.
2) Tap the Corporate icon.
3) Enter your email: FirstName.LastName@yourcompany.com
4) Password: Enter your Active Directory password.
5) Tap Next and Accept all default notifications.

Meeting Room Issues
Users can request help with meeting room issues, such as conferencing problems, sound issues, display, connectivity, sharing, and more.

**Troubleshoot Slow Computer**

Users can request help associated with a slow computer, such as low RAM.
Guest WiFi Access

Guests to your company can obtain WiFi access.

What type of machine are you having issues with?

Mac

Here are a few things you can try:
1) If you have not restarted your machine, do that before moving to the next steps. If that did not solve the issue, try the next step.
2) Open Activity Monitor on your Mac to check if there is a process using significant memory or CPU.
3) Try closing and reopening the applications consuming significant memory or CPU.
4) If it doesn’t work, restart your computer and try again.

Did these steps work for you?

Yes
Printer Issues

Users can request help with issues associated with a printer, such as a paper jam, printer not working, or connectivity problems.
VPN Connectivity

Users can request help with connecting to VPN or setting up VPN to access business systems from remote locations.
ITSM Virtual Agent predefined Self-Service category topic conversation flows

Submit a request

The Submit a request topic conversation uses the following topic blocks:

What type of machine are you trying to access from?

about a minute ago

Do the following to connect:
1) Click the VPN Client located at the top right corner of your desktop.
2) Click connect.
3) Enter your Active Directory username (first.lastname) and password. If you have a hard token, your password should be PIN + Token.

just now

When you're successfully connected, you'll see a 'house' symbol when you're connected internally and a 'shield' symbol when you're connected externally.

Did these steps work for you?

Yes
No
• Search Catalog Item
• Request Catalog Item

Using the Submit a request topic conversation, users can submit a request by choosing from all available options. For example, when a user is requesting for an item, the Virtual Agent prompts the user to enter a search keyword. After the user enters the keyword, the Virtual Agent responds with available choices in a carousel view.

When the user selects the required item, the following scenarios are possible:

• A user can submit a request in the conversation mode (by answering the questions in line). After the request submission, a URL, which opens up the ticket page, is provided.

  Note: In Now Mobile, the URL opens the native screen.

• In all other cases, Virtual Agent provides a link for the user to submit the request in the Service Portal defined in the sn_itsm_va.com.snc.itsm.virtualagent.portal_url property.

  Note: Now Mobile opens the item in Mobile Employee Service Portal (mesp).
For information about Service Catalog topic blocks, see *Service Catalog topic blocks in Virtual Agent*.

**Check IT Ticket Status**

Users can check the status of active IT tickets (incidents or requests). When a user asks about a ticket status, the virtual agent responds with a list of all active tickets for that user. Each ticket includes a link to the incident or request, the item, the status (*Stage*), and when it was updated.

Users can add comments and also ask to chat with a live agent.
Process Approval

Users with the ITIL role can access active approval requests. The virtual agent returns all active approvals as a list. Users click an approval to access the actual approval record to approve or reject.

Get Password Reset Link

Users can access a password reset link when system lockout occurs or when passwords are forgotten. When a user enters keywords related to password reset, the virtual agent provides a link to the password reset process. If a user is not authenticated in the system, the virtual agent requests the user's email address. If a user is not enrolled in Password Reset, the virtual agent provides a link to Password Enrollment.

Note: An admin must properly configure the password reset process with a valid verification type for this topic to work as described. For details, refer to Configure your Password Reset process.

My Assigned Equipment

Users can view a list of all assigned equipment, such as laptops, mobile phones, and monitors. Clicking an item link provides additional details about the asset. Users can also create an asset-related incident directly within the conversation. Opening an incident from this conversation initiates the Open IT Ticket conversation topic by using the Create Incident topic block.
Service Disruptions

Users can access all known outage information. When a user asks if a particular system is down, the virtual agent returns a list of links displaying planned or non-planned outages and any system degradations. Users can click the links for more detailed information about a specific outage or degradation, as well as click **Show more** when additional outages are known.
Search Knowledge Base

This conversation is re-factored to use the reusable Contextual Search topic block.

Users can access knowledge base articles to quickly resolve issues. After a user enters keywords associated with a knowledge base, the virtual agent prompts the user to enter a search phrase. A contextual search runs and relevant knowledge base articles appear as choices to select. Users can select a new search or cancel the search. If the returned articles do not provide the required information, users can create an incident or ask to chat with a live agent.

Note: If the Communities (com.sn_communities) plugin is activated, the virtual agent can also return a list of answered Community questions.

Open IT Ticket

This conversation topic is re-factored to use the reusable Create Incident topic block.

Users can open an incident or access relevant knowledge base articles to resolve an issue. After typing keywords, such as open ticket or incident, the virtual agent prompts the user to enter a short description of the issue. The virtual agent returns links to relevant knowledge base articles and asks if an article resolved the issue. If it did not, the virtual agent asks for the urgency of the issue and creates an incident, providing a link to the actual incident.
When creating an incident, if you also want to create an associated Universal Request and display the Universal Request card in Virtual Agent instead of the incident, the Universal Request plugin (com.snc.universal_request) must be active and the Create Universal Request with incident property (com.snc.create_universal_request_with_incident) must be set to Yes (default is Yes).
Intelligent Open IT Ticket (Template)

Users can leverage machine-learning algorithms with application logic for predicting similar open tickets. Prevent users from opening duplicate incidents by finding similar incidents and asking if the user wants to add comments to the similar incident.

Note: Requires activation of the Predictive Intelligence for Incident (com.snc.incident.ml) plugin, which requires a separate license.

Escalate IT Ticket

Users can raise the urgency of an IT ticket for a faster resolution. Escalating a ticket priority requires choosing the incident and verifying the escalation. Users must provide a justification to escalate the incident. The virtual agent escalates the incident to the next urgency level, for example, from low to medium, or from medium to high. If an incident is already at high-level urgency, the virtual agent alerts the user to this and asks if the user would like to add a comment to help expedite resolution.
You have 8 open tickets. Which ticket do you want to escalate?

Test Currency [INC0010180]

<table>
<thead>
<tr>
<th>Incident</th>
<th>INC0010180</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Test Currency</td>
</tr>
<tr>
<td>Urgency</td>
<td>3 - Low</td>
</tr>
<tr>
<td>State</td>
<td>New</td>
</tr>
</tbody>
</table>

Would you like to escalate this ticket?

Yes

Please enter a justification.

just now

Need the test performed today since I’ll be on PTO next week.

I’ve escalated your ticket to 2 - Medium
Users can check into a Walk-up Experience location and secure a place in the queue. Users can also schedule an appointment at a walk-up location.

**Note:** This topic conversation is available when the Walk-up Experience plugin (com.snc.walkup) is activated.
Sure, I can hold a place in line for you.

There are currently 2 locations. Please select one:

San Diego Tech Lounge

San Diego Tech Lounge

Hours of operation: 8-5 weekdays excluding holidays

Accepts online check-in: Yes

There's no waiting line right now. I can check you in right away!

Would you like to check in right now?

Yes

Schedule for later

No, never mind

Report IT Issue
Conversation flow for creating incidents using a record producer. You can define the Virtual Agent variable value for the sys_id of the record producer to use the Report IT Issue conversation topic.

This conversation topic uses the Request Catalog Item topic block.

**ITSM Virtual Agent predefined Setup Topic conversation flows**

For complete details about Setup Topic conversations, refer to *Setting up the Virtual Agent conversation framework*.

**Greetings**

Users receive a greeting at the beginning of a conversation from a virtual agent.

**Anything Else Topic**

Users are asked if they want to continue with another request or task.

**Live Agent Support**

Users can request a live agent and view items that a live agent can assist with.

**Closing Conversation**

Users receive an ending message when the conversation is done.

**Personalized Greeting Topic**

Users are greeted by name at the beginning of a conversation.

**Dynamic Greeting Topic**

Users receive a dynamic, time-based greeting at the beginning of a conversation from a virtual agent. The greeting includes addressing the user by first name with the time of day, referencing any incident or request the user may have open, and mentioning outage information if an outage is occurring or planned. For example:

"Good morning, John. You currently have [x] incidents and [x] requests open. We are aware of [outage] with [service] that began at [start time]."

When the end time is known, the virtual agent includes the message:

"The [outage] is planned to end at [end time]."

*Note: If there are no incidents, requests, or outages these messages do not display.*

The dynamic greeting is followed by the standard greeting, which asks the user to type information.

**Error Handling Topic**

Users see an error message when the virtual agent encounters a problem that it cannot resolve.

**Virtual Agent Feedback**

This conversation is re-factored to use the reusable Survey topic block Survey.
Users can provide CSAT feedback on their virtual agent experience before the conversation ends.

This is a simple, reusable virtual agent survey topic enabling you to collect CSAT feedback on virtual agent within your organization. Users are asked to rate the experience by choosing a sentiment from an image carousel of three faces. Choices include a happy face, a neutral face, and a sad face. If the sad face is chosen, users are prompted to provide a comment about the poor experience.

**Fallback Topic**

Users see a message when the virtual agent cannot find a topic that matches a request or when it does not understand an entry.

**Search Fallback Topic**

Dynamic topic that runs a search of knowledge base articles and catalog items when no existing conversation topics match the users query. Integrates with catalog and knowledge base search.

**Virtual Agent Capabilities**

Users can ask for assistance during the conversation and view a list of items that the virtual agent can assist with.

**Survey**

Users can provide insight into what they need prior to a conversation, as well as feedback on their conversational experience before the conversation ends.

Automatically route incoming conversations to the correct live-IT agent group. Reduce live-IT agent time by automating pre-chat data collection. By providing a pre-chat survey to users to find out what is needed, ITSM Virtual Agent can route the conversation to a proper live IT agent.

Deliver a survey through ITSM Virtual Agent, for both pre- and post-chat experiences.

Use the Pre-Chat survey and Post-Chat survey topics before starting or prior to completing a ITSM Virtual Agent conversation. Present surveys for data collection or to gather feedback on the experience.

**Manage Office 365 Group conversation flow**

ITSM Virtual Agent enables you to manage a Microsoft Office 365 Group using a prebuilt set of topics. With this conversation flow, you can add or remove users from an existing Microsoft Office 365 Group, create a Microsoft Office 365 Group, and more.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
How does the Microsoft Office 365 Group conversation flow work?

Natural Language Understanding (NLU) is used to identify and trigger the Microsoft Office 365 Group action that a user wants to perform. Integration is required with the Microsoft service via IntegrationHub and Flow Designer. Using the existing IntegrationHub Azure AD Spoke, the topics create a conversation that calls these actions to complete an end-to-end fulfillment of the request.

This topic is only available with the activation of the Microsoft Azure AD for IntegrationHub (com.sn.azure_ad.spoke) plugin.

Note: If the Microsoft Office 365 topics are duplicated in a different scope than ITSM VA Conversations, script logics can be affected and cause errors.

To set up Microsoft Azure AD for IntegrationHub, see Set up Microsoft Azure AD spoke.

Microsoft Office 365 Group conversation flow actions

You can perform the following actions with the Microsoft Office 365 Group conversation flow:

- Create Microsoft Office 365 Group
- Add User to Microsoft Office 365 Group
- Remove User from Microsoft Office 365 Group
- Add Owner to Microsoft Office 365 Group
- Remove Owner from Microsoft Office 365 Group
- Get Microsoft Office 365 Group Details

For details about each conversation flow action, see Manage Office 365 Group conversation flow actions.

Manage Office 365 Group conversation flow actions

ITSM Virtual Agent helps you manage Microsoft Office 365 Groups using actions in conversation flows.

Create Office 365 Group

Users can create a group in Microsoft Azure AD by providing the following information:

- Group privacy
- Group email alias
- Outlook display name
- Group description
- Owners and members (optional)

The current user is automatically added as the Group Owner, along with any other specified users.
Add User to Microsoft Office 365 Group

Group owners can add themselves or other users to a Microsoft Azure AD group by providing the group name and the email address of one or more users to add.
Remove User from Microsoft Office 365 Group

Users can remove themselves from a Microsoft Azure AD group. Group owners can remove other users from a group. Provide the group name and user email addresses to remove.
Add Owner to Microsoft Office 365 Group

Group Owners can add other users as Group Owners by providing the group name and the user email addresses to add.
Hi, I'm your Virtual Agent. Let me know how I can help you today.

What's your issue or request? Or take a look at what I can help with.

add owner to a group

I can help you add an owner to a group

Type in the name of the group you want to add owners to

just now

app-dev@testazuread123456.onmicrosoft.com

Remove Owner from Microsoft Office 365 Group

Group Owners can remove themselves or other Group Owners by providing the group name and the user email addresses to remove.
Hi, I'm your Virtual Agent. Let me know how I can help you today.

What's your issue or request? Or take a look at what I can help with.

remove owner from a group

I can help you remove an owner from a group.

Type in the name of the group you want to remove owners from

just now

app-dev@testazure123456.onmicrosoft.com

Get Microsoft Office 365 Group Details

Group members can get group details by providing the name or email of the group.
ITSM Virtual Agent Lite

Access a pre-built subset of ITSM Virtual Agent features to quickly and easily implement a virtual agent for your end users. ITSM Virtual Agent Lite offers an introductory collection of conversation topics for IT support.

Understanding ITSM Virtual Agent Lite

ITSM Virtual Agent Lite enables you to use a limited version of Virtual Agent. The available keyword-based conversations run in the web chat client and also in the supported ITSM Virtual Agent messaging integrations. Get familiar with virtual agent technology to improve your ITSM self-service experience with a streamlined conversational interface.

ITSM Virtual Agent Lite topic category and conversations

Topic conversations run in the web chat client and also in supported ITSM Virtual Agent messaging integrations. Get familiar with virtual agent technology to improve your ITSM self-service experience with a streamlined conversational interface.

The ITSM Virtual Agent Lite pre-built, read-only topic conversation templates are contained in the ITSM Self Service Lite Virtual Agent Designer category. The following conversation topic templates are ready for you to publish for use:

- Search KB
- Check Ticket Status
Set up ITSM Virtual Agent Lite

Activate and quickly begin using several read-only, pre-built conversation topics for your most common ITSM self-service cases. Promptly engage your users with a virtual agent to check ticket status, search the knowledge base, and report and issue.

Role required: admin or virtual_agent_admin

Virtual Agent Lite, a subset of the Virtual Agent platform, is available with activation of the Glide Virtual Agent Lite (com.glide.cs.chatbot.lite) plugin. You do not need a subscription for Virtual Agent Lite. For details, see Activate Virtual Agent Lite.

Users with the admin or virtual_agent_admin role can activate the required plugins:
- Glide Virtual Agent Lite (com.glide.cs.chatbot.lite): Activates the lite version of Virtual Agent platform features and other necessary plugins.
- ITSM Virtual Agent Conversation Topics Lite (com.snc.itsm.virtualagent.lite): Activates read-only conversations topics for basic ITSM self service.

Note: The Service Management Virtual Agent Core (com.glideapp.sm_va_core) plugin is required and is automatically activated with ITSM Virtual Agent Conversation Topics Lite.

1. Activate the Glide Virtual Agent Lite (com.glide.cs.chatbot.lite) plugin.
2. Activate the ITSM Virtual Agent Conversation Topics Lite (com.snc.itsm.virtualagent.lite) plugin to access the pre-built ITSM Virtual Agent Lite conversation topics.
3. Review the ITSM Self Service Lite read-only conversation topics in Virtual Agent Designer.
   a) Navigate to Virtual Agent > Designer.
   b) In the Category drop-down box, select ITSM Self Service Lite.
4. To activate and publish a conversation topic, click Inactive in the topic tile.
   The conversation topic template opens for review.
5. Click the Active radio button to activate the topic.

Note: To deactivate a topic, click the radio button.

6. Click Publish to publish the topic for use.

Note: For complete details regarding activating and publishing conversation topics, refer to Virtual Agent Designer.

7. To test an active, published conversation topic, click the topic to test in Virtual Agent Designer and click Test.
   The Virtual Agent window opens and engages you to enter data, such as an IT issue or search for a knowledge base article.

ITSM Virtual Agent Lite conversation flows

ITSM Virtual Agent Lite includes several pre-built, read-only topic conversations to quickly and easily implement a virtual agent for your end users.
ITSM Virtual Agent Lite topic conversation flows

**Search KB**

Users can access knowledge base articles to quickly resolve issues. After a user enters keywords associated with a knowledge base, the virtual agent prompts the user to enter a search phrase. A contextual search runs and relevant knowledge base articles appear as choices to select. Users can select a new search or cancel the search. If the returned articles do not provide the required information, users can create an incident or ask to chat with a live agent.

**Check Ticket Status**

Users can check the status of active IT tickets (incidents or requests). When a user asks about a ticket status, the virtual agent responds with a list of all active tickets for that user. Each ticket includes a link to the incident or request, the item, the status (Stage), and when it was updated.

**Report an Issue**

Users can create incidents using a record producer.

---

**Walk-up Experience**

With the ServiceNow® Walk-up Experience application you can create and manage an onsite IT walk-up venue where requests and issues are fulfilled and solved by experienced IT technicians in person and in real time. You can configure Walk-up Experience to serve all users in your organization by using an inclusive branding, such as Tech Lounge, Service Center, Genius Bar, and more.

---

**Explore**

- ServiceNow upgrades
- Understanding Walk-up Experience
- Utilizing a Walk-up Contact Channel for IT and Beyond (includes Whitepaper: Walk-up Experience)
- Domain separation and the Walk-up Experience application

**Set up**

- Activate Walk-up Experience

**Administer**

- Configure the Walk-up Experience portal
- Create or modify Walk-up Experience notifications
- Create or modify Walk-up Experience schedules
- Create or modify a Walk-up Experience stockroom
- Create or modify Walk-up Experience locations
- Create or modify a Walk-up Experience customer satisfaction survey

**Use**

- View assigned Walk-up Experience locations
- Manage Walk-up Experience interactions manually
- View Walk-up Experience location stockroom and assets
- Walk-up Experience dashboard overview

**Develop**

- Developer training
- Developer documentation
- Installed with Walk-up Experience

**Troubleshoot and get help**

- Ask or answer questions in the Walk-up Experience community
- Search the HI Knowledge Base for known error articles
- Contact ServiceNow Technical Support
Understanding Walk-up Experience

Walk-up Experience enables your IT organization to set up a contact channel to support both online check-in and onsite check-in to a pre-established walk-up service center.

What is Walk-up Experience?

Walk-up Experience aims to delight users and significantly improve their satisfaction with IT, as well as increasing productivity of both the technicians and users via fast in-person support. Employees and business guests can get real-time, in-person help with their IT issues and equipment requests. Walk-up service centers specialize in supporting technology devices — smart phones, tablets, and laptops — as well as hardware repairs and requests, technology refreshes, and software upgrades.

The main purpose of a walk-up service center is to support and resolve the more common, everyday routine IT service desk functions, such as a request for a new mouse or keyboard, unlocking an account, or help setting up software on a mobile device. Common branding names for your walk-up center include, “Tech Lounge,” “Service Center,” or “Genius Bar.”

Who uses Walk-up Experience?

Everyone from the company CEO to visiting business guests can check in and get IT support at an established walk-up service center. Walk-up Experience is for anyone who would prefer to meet face-to-face with an experienced IT technician in a welcoming and supportive environment.

Requesters

Users access the Walk-up Experience application in several ways.

- Online and via mobile device:
  - Quickly check in online to the nearest available walk-up venue via a pre-built check-in widget on the Service Portal using your laptop, tablet, or mobile phone.

  **Note:** Geolocation interfaces with the Walk-up Experience application to automatically route you to the nearest walk-up queue. You can always change the location, if desired.

  Geolocation uses browsers or mobile device coordinates to determine location. If geolocation is blocked on the browser, Walk-up Experience defaults to Latitude/Longitude criteria in the user profile or mobile device.

  - View hours of operation, the estimated wait time, and your position in the queue at the check-in location via the **Walk-up Status** widget on the Service Portal. You can also access the online Walk-up Experience check in from this widget.

    **Note:** The Walk-up Status widget must be configured to appear on the Service Portal.

  - View upcoming walk-up appointments and current queue position by location using the Now Mobile application **Services** tab on your mobile device. **Tech Lounge visits** appears if there is associated data. If no data exists, the section is hidden.
Note: Requires activation of the ServiceNow Mobile Request Native Application Screens and Applet Launcher plugin (com.glide.mobile.employee). See Mobile plugins and upgrades for more information. This plugin enables the Service Catalog functionality by default.

- Schedule appointments for support and receive appointment reminders, as well as cancel or reschedule appointments from links in the reminder or from the online check-in interface.
- Schedule only one appointment per walk-up location queue at a time.

Note: Even with a scheduled appointment, you can still check into a walk-up location queue online or in person onsite.

- Schedule appointments on behalf of others who need IT support, such as executives or direct reports.

Note: Configuration is necessary to make this available to the Appointment delegation group of users, such as executive assistants. This is configured in the Walk-up Location Queue (wu_location_queue) table.

- Receive notifications via email or your mobile device when your request is assigned to an IT support fulfiller, when you are close to next in line to be helped, and when your walk-up request has been closed or abandoned, should you decide not to attend the queue.

- Onsite at the Walk-up Experience location:
  - Check into a queue at the physical walk-up location by manually entering either your name or email or by scanning an employee badge.

Note: The badge scanning feature requires activation and configuration. Refer to Badge Reader Integration for Walk-up Experience.

- Observe queue activities on a large monitor that displays both walk-in requesters and those with appointments.
- View the monitor displaying how many people are currently in the queue, guest positions in the queue, who is being helped, and estimated wait times.
- Answer an available single-question survey which captures your user sentiment after a visit.
- After-hours support — Get support even when a walk-up queue is closed. An IT support phone number is displayed on the check-in device, along with a link to create an incident in real time.

**Fulfillers**

The IT organization uses the Walk-up Experience application to meet the demand of urgent IT issues and requests.

- Walk-up Experience IT technicians manage daily operations at the walk-up queue locations. They resolve IT-related issues, support mobile devices and laptops, and fulfill requests for software and hardware consumables.
- Technicians can accept and close Walk-up Experience interactions through the Agent Workspace interface. Agent Workspace contains a personal inbox where walk-up interactions, if configured in Advanced Work Assignment, are automatically pushed for assignment.
• Agents can manage all aspects of Walk-up Experience fulfillment using Agent Workspace. Based on their capacity, and if records are on-hold, they can work on multiple transactions at the same time and promote interactions to incidents or requests, or access associated stockroom consumables.

• Technicians can view and accept scheduled appointments in their Agent Workspace personal inbox. Appointments are routed to the inbox according to agent availability. Alternatively, agents can pick and choose appointments manually.

• If necessary, technicians can work with anyone in the queue at any time. Technicians can manually assign themselves to a walk-up interaction, by accepting the interaction from a list of unassigned interactions in Agent Workspace.

• Agents can use the Agent Assist feature to expedite incident resolution.

Managers

IT managers supervise the walk-up location technicians and oversee daily operations.

• Walk-up managers can observe and capture operational and performance data by monitoring the walk-up dashboard.

• Walk-up managers can use the application to increase IT customer satisfaction, ensure and confirm stockroom inventory is available, provide customer service in a timely manner, and report performance data to upper management.

Administrators

Configure and maintain walk-up related systems, such as the walk-up location branding and text, queue locations and schedules, appointments, advanced work assignments, and notifications, CSAT surveys, and associated stockrooms.

Access the pre-built Walk-up online check-in Experience widget for use in your Service Portal. Make minor label changes directly in the widget without the need to customize through code.

How do you benefit from Walk-up Experience?

Your entire organization benefits by using the application in the following ways:

Improves employee access to IT professionals

Employees access IT services in real time by visiting a walk-up location. Employees can also schedule appointments to visit the walk-up location at a convenient future time. This saves time for everyone and results in greater productivity. IT technicians get direct access to user devices so that employees can return to work faster.

Tracks interactions and performance

IT managers use the Walk-up Experience dashboard to analyze and understand the work IT technicians are performing to support the company.

Integrates with other services

Technicians can manage Walk-up Experience interactions from the Agent Workspace interface. Walk-up technicians can create traditional incidents when issues cannot be resolved at the walk-up location directly in Agent Workspace.

If a requested item is not available at an associated stockroom, walk-up technicians can create a request by ordering from the Service Catalog directly in Agent Workspace.
CSAT surveys are available at the walk-up queue and emailed to walk-up customers after an interaction is closed to capture customer-service sentiments.

Devices necessary to deliver Walk-up Experience

The Walk-up Experience application depends on several types of devices to deliver functionality. Users can check into an online walk-up queue using a desktop or laptop computer, tablet, or mobile phone. Onsite walk-up location users can check into the queue by scanning an employee badge or with a provided, typically stationary, tablet. The following guidance describes what devices are needed and function best for each Walk-up Experience feature:

- Online check-in and appointment scheduling: Desktop or laptop computer, tablet, or mobile phone.
- Onsite check-in: Tablet is recommended, but also works on desktop.
- Onsite queue: Large flatscreen TV. This feature is designed for larger display devices, such as a TV monitor. It is not supported on a tablet.
- Onsite CSAT survey: Tablet is recommended, but also works on desktop.
- Onsite badge reader: Badge scanning integration. For complete details, refer to Badge Reader Integration for Walk-up Experience.

Note: To optimize the experience for Apple iOS-based tablet devices, save the opened Check-in and CSAT survey tabs to the homepage of the device. When clicked from the homepage, they will open in full screen.

Domain separation and the Walk-up Experience application

This is an overview of domain separation as it pertains to the Walk-up Experience application and how it relates to Service Portal pages, interaction queues, and configurations. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Basic

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

Overview

Domain separation in the Walk-up Experience application is supported at the Basic level. However, the application depends on the Service Portal, which is not supported for domain
domain separation. Domain separation pertains to the Walk-up Experience application in the following ways:

- Walk-up location queues support domain separation in order to define which end users can access each location queue.
- The Interaction table supports standard domain separation for data security. Interaction tickets are opened for a specific domain.
- Walk-up location queues and interactions support domain separation. Therefore, fulfillers also work within a domain-separated environment when addressing interaction tickets associated with a location queue.
- Management and administration configurations reside in the walk-up location queue records. Therefore, those configurations are available to the respective domain managers and admins.
- While the Service Portal pages are not domain separated, the Walk-up Experience application’s portal pages retrieve data within the user’s specific domain. Therefore, those pages can be reused across different service portals designed and configured for separate domains. The admins must build each portal themselves.
- The Domain field is available on the wu_location_queue table. Setting domain here ensures users only see queues that are part of their domains during online check-in.
- For Advanced Work Assignment routing to operate, each wu_location_queue must include a work item routing condition which explicitly adds a reference to the domain the queue is part of.

**Note:** The appointment booking feature is not domain separated. Since Appointment (itil_appointment) table data is not domain separated, list views could reveal data across domains.

### How domain separation works in the Walk-up Experience application

For this application to be the most effective, walk-up administrators should configure walk-up locations accordingly. This is done by configuring the wu_location_queue record to meet user needs, which affects the Requestor experience. Each domain configured to the location queue record has its own set of rules. The same applies to other tables within the Walk-up application as well.

**Note:** Elements of the Service Portal platform such as settings, portals and widgets cannot be domain separated. However, the data within the widgets displays based on how the domain is configured. The recommended approach is to set up separate portals for each MSP customer.

Below are the elements of the Service Portal that are used as part of the walk-up experience:

- Portal (Walk-up)
- Pages (walkup_online_checkin, walkup_queue_on_site, walkup_home, walkup_survey, walkup_check_in)
- Theme (Walk-up theme)
- Widgets (Online check-in experience, walk-up queue on site, walk-up check-in, walk-up exit survey, walk-up home, walk-up schedule)

To learn more, see [Domain separation in Service Portal](#).
For data separation, the Walk-up Experience application uses the domain of the walk-up user (Requestor/Walkup login user) to determine in which domain the Requestor data should be placed.

- Requestors can check in only in locations for which they have visibility.
- Requestors are able to select the Reasons that belong only to their own domain.
- Interaction records are created in the Requestor’s domain.

For the Fulfiller side, the application uses the domain of the walk-up user (walk-up technician/manager/admin) to determine which records are visible.

- By domain separation rules, Fulfillers can work only on interactions that are visible to them.
- Fulfillers are able to configure only walk-up location records that belong to their domain, are in the global domain, or have the parent-child hierarchy.
- The same visibility rules apply for the Many to Many \([wu_m2m_location_queue_reason]\) table that controls the mapping between a location and Reason.
- The walk-up contexts records also have domain separation support, thereby ensuring technicians are able to view detailed Requestor information only for the records that are visible by domain separation rules.

## Domain-separated tables

As part of the Walk-up Experience, records in the following tables can be domain separated.

- Walk-up location queues \([wu_location_queue]\)
- Walk-up reasons for visit \([wu_reason]\)
- Walk-up reasons \([wu_m2m_location_queue_reason]\)
- Walk-up contexts \([wu_context]\)
- Interactions \([interaction]\)

## Walk-up Experience portal security and access

Security is built into the application to prevent end-user facing devices at the Walk-up Experience onsite portal from offering elevated role privileges to users. The Walk-up Experience onsite portal is accessed by an account containing only the \(sn\_walkup.walkup_login\) role.

## Understanding Walk-up Experience portal security

Accessing the onsite Walk-up Experience portal requires the singularly assigned \(sn\_walkup.walkup_login\) role. The user record with this role cannot contain any other roles. Since most user records contain multiple roles, the \(sn\_walkup.walkup_login\) role is assigned to a user record account, not a human user. This security feature prevents the onsite portal check-in device from permitting elevated privileges to users who may attempt to access the portal with an elevated privilege role.

The \(sn\_walkup.walkup_login\) role is granted to a user record for an account used to log into the check-in device, typically a tablet, at the onsite Walk-up Experience portal. It is not an actual human being with an assigned role, but an account with a role. For example, a technician opening the onsite Walk-up portal for business logs into the check-in device using the user record that contains the \(sn\_walkup.walkup_login\) role. Again, the portal can only be accessed by a user record that contains this role only. A user cannot access the portal with the admin role or if the user record contains roles other than the \(sn\_walkup.walkup_login\) role.
Access to Walk-up Experience

Technicians opening up the onsite Walk-up location for business, or joining the support team during operation hours, access the user record account with sn_walkup.walkup_login role to log into the Walk-up Experience portal. Internal and external users can access the onsite Walk-up Experience portal via a check-in device, typically a tablet, to enter a queue. Internal, authenticated users can also access an online queue check-in via desktop or mobile device.

Walk-up Experience administration

Walk-up Experience users with the sn_walkup.walkup_admin role and administrators can activate and configure the application to meet specific requirements.

You can configure appointments, decide when to send notifications to users, establish and configure physical queue locations and operating schedules, integrate with CSAT surveys, and associate stockrooms with queue locations. You can also customize your Walk-up Experience portal with a unique logo and branding.

Activate Walk-up Experience

You can activate the Walk-up Experience plugin (com.snc.walkup) if you have the admin role. This plugin includes demo data.

Role required: admin

The Walk-up Experience application is for prebuilt tech lounges. The application enables your IT organization to set up a walk-up contact channel to support online and onsite queue check-in.

The Interaction Logging, Routing, and Queuing (com.glide.interaction) plugin will activate with Walk-up Experience plugin (com.snc.walkup). The following plugins must also be activated in order to use the Walk-up Experience application:

1. Asset Management (com.snc.asset_management)
2. Service Portal (com.glide.service-portal)

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Installed with Walk-up Experience

Several types of components are installed with activation of the Walk-up Experience plugin, including tables and user roles.
Demo data is available for this feature.

### Roles installed

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk-up login (sn_walkup.walkup_login)</td>
<td>Used to log into the onsite Walk-up Experience portal when needed. For example, at the beginning of the work day for a technician.</td>
<td>None</td>
</tr>
<tr>
<td>Walk-up technician (sn_walkup.walkup_technician)</td>
<td>Works at the Walk-up Experience location to fulfill customer demands, such as IT-related issues and requests.</td>
<td>itil, interaction_agent, workspace_agent, awa_agent, sn_apptmnt_booking.appointment_booking_user</td>
</tr>
<tr>
<td>Walk-up manager (sn_walkup.walkup_manager)</td>
<td>Manages the technicians at the Walk-up Experience location. Access the Walk-up Experience Dashboard to oversee and monitor operations and performance.</td>
<td>itil, sn_walkup.walkup_technician, sn_apptmnt_booking.appointment_booking_user</td>
</tr>
</tbody>
</table>
### Role title (name)

**Walk-up administrator (sn_walkup.walkup_admin)**

Description:

Administers and configures Walk-up Experience modules.

Contains roles:

- itil
- sn_walkup.walkup_manager
- inventory_admin
- schedule_admin
- sp_admin
- sn_apptmnt_booking.appointment_booking_admin
- awa_admin

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk-up Reason for Visit (wu_reason)</td>
<td>Record used to define various common reasons why a user needs walk-up support.</td>
</tr>
<tr>
<td>Walk-up context (wu_context)</td>
<td>Record used to configure an online check-in channel for users to join a walk-up queue before physically arriving at the walk-up queue. Identifies a walk-up user and the description of the associated interaction.</td>
</tr>
<tr>
<td>Walk-up Location Queue (wu_location_queue)</td>
<td>Record used to configure a walk-up location. Extends the Queue (awa_queue) table.</td>
</tr>
<tr>
<td>Walk-up Reason (wu_m2m_location_queue_reason)</td>
<td>Record used to set the order a particular visit reason should be prioritized at a walk-up location.</td>
</tr>
<tr>
<td>Walk-up Appointment (wu_appointment)</td>
<td>Record used to configure scheduled appointments. Extends the Task (task) table.</td>
</tr>
</tbody>
</table>

### Quick start tests for Walk-up Experience

Validate that Walk-up Experience still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Walk-up Experience quick start tests require activating the Walk-up Experience plugin (com.snc.walkup) and loading demo data.

#### Walk-up Experience - Tests test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a location</td>
<td>Ensure users with the Walk-up administrator (sn_walkup.walkup_admin) role can access all existing walk-up queues, create new queue locations, and configure queues appropriately.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Onsite checkin (ITIL User)</td>
<td>Verify that users with the ITIL role can check into an onsite queue location.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Onsite checkin (ESS User)</td>
<td>Verify that users with the ESS role can check into an onsite queue location.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Onsite checkin (Guest)</td>
<td>Verify that guest users can check into an onsite queue location.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

**Walk-up Experience configuration**

Customize your Walk-up Experience portal and configure appointments, notifications, walk-up venue locations, associated stockrooms, customer satisfaction surveys, and hours of operation to meet your required needs.

Walk-up Experience includes associated notifications to alert users when the location is closed or when an interaction is assigned to a technician. Pre-built customer satisfaction surveys capture user sentiment about the experience. Also included are several configurable tables for customizing your walk-up portal and service center experience. You can configure and specify the following features for your experience:

- Configure an online check-in channel for users to join a walk-up queue before physically arriving at the walk-up location.
- Access the pre-built **Walk-up online check-in Experience** widget for use in your Service Portal. Make minor label changes directly in the widget without the need to customize through code.
- Configure the physical walk-up location queue information to manage and administer the walk-up service center.
- Establish walk-up locations, set hours of operation, enable online check-in, determine assignment groups, associate stockrooms, as well as design the queue time display and position notification system.
- Configure reasons for visits to a walk-up queue by location.
- Add a logo and brand your portal and walk-up location to fit your style.
- Access location-specific branding elements, such as logo images, for walk-up queues. These configuration options are found in the Walk-up Location Queue (wu_location_queue) table.

The following applications are included in the **Administration** module of the Walk-up Experience navigation bar:

**Walk-up Experience administration applications**

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portal Configurations</td>
<td>Create and modify custom Walk-up Experience online and on-site service portals.</td>
</tr>
<tr>
<td>Notifications</td>
<td>Access and configure alerts that keep users and fulfillers informed of events that concern them.</td>
</tr>
<tr>
<td>Application</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Appointment Configurations</td>
<td>Create service configurations for individual walk-up queue locations. You can configure schedules, number of appointments allowed per day, how far in the future users can book appointments, and more.</td>
</tr>
<tr>
<td>Walk-up Locations</td>
<td>Create walk-up location queues with custom schedules, assignment groups, average wait time, and more.</td>
</tr>
<tr>
<td>Schedules</td>
<td>View, create, or modify walk-up venue schedules, such as 8-5 weekdays, and associate them to the walk-up location queues.</td>
</tr>
<tr>
<td>Walk-up Stockrooms</td>
<td>Establish walk-up venue stockrooms by location and specify available consumables.</td>
</tr>
<tr>
<td>Surveys</td>
<td>Access customer satisfaction surveys and enable public access to the surveys, set survey trigger conditions, and view user responses.</td>
</tr>
</tbody>
</table>

**Configure the Walk-up Experience portal**

Create engaging walk-up center service portals featuring your logo, portal theme, desired catalog, links to a knowledge base and social community, and more.

Walk-up Experience includes a complete base-system Walk-up Portal with theme. The Walk-up Portal pages are meant to be used as built. You can create custom portal pages to meet your needs by copying the portal pages and associated widgets and making changes to the copies. You can configure both an online check-in portal and a physical check-in portal for your walk-up locations.

There are several ways to configure the Walk-up service portal:

- **Service Portal** application: Modular user interface framework for quick and easy building and customization of application portals.
- Service Portal Walk-up form: Requires CSS and HTML experience.

Role required: admin or sn_walkup.walkup_admin

1. To configure the Walk-up service portal using the Service Portal application, navigate to Service Portal > Service Portal Configuration. The Service Portal configuration page opens.
2. To customize the base-system walk-up portal with your unique branding, title, logo, theme colors, layout, properties, widgets, and more, or to create a new walk-up portal, refer to Service Portal for detailed information.
3. Alternatively, to configure the Walk-up service portal using the Service Portal Walk-up form, navigate to Walk-up Experience > Administration > Portal Configurations. The Service Portals list opens.
4. In the Service Portals list, click Walk-up or search for it in the list header search box.
5. Click the form menu icon

and select **Configure > Form Design**. The form designer opens.
6. In the form designer header drop-down list select or search for any of the configurable walk-up forms to customize your portal appearance.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk-up context (wu_context)</td>
<td>Configure an online check-in channel for users to join a walk-up queue before physically arriving at the walk-up location. Identifies a walk-up user and the description of the associated interaction.</td>
</tr>
<tr>
<td>Walk-up Location Queue (wu_location_queue)</td>
<td>Configure the physical walk-up location interaction queue to manage and administer the service center. You can establish walk-up locations, set hours of operation, enable online check-in, determine assignment groups, associate stockrooms, as well as design the queue time display and position notification system.</td>
</tr>
<tr>
<td>Walk-up Reason (wu_m2m_location_queue_reason)</td>
<td>Define various common reasons why a user needs walk-up support.</td>
</tr>
<tr>
<td>Walk-up Reason for Visit (wu_reason)</td>
<td>Specify the order in which reasons for a visit should be prioritized at a walk-up location.</td>
</tr>
</tbody>
</table>

The associated form opens. To modify form content to meet your portal requirements, refer to Form configuration for detailed information.

**Enable Self-Service online check-in for Walk-up Experience**

Show or hide the Walk-up Experience online Walk-up Check-in module under Self-Service in the application navigator. You can enable or disable the module using the basic platform menu or module enablement process.

Role required: admin or sn_walkup.walkup_admin

The Walk-up Experience online Walk-up Check-in module is disabled (hidden) by default and does not appear under the Self-Service menu until enabled.

1. Navigate to System Definition > Application Menus.
2. Click All in the conditions breadcrumbs to display both active and inactive application menus. This action removes the default filter condition.
3. Search by Title for the Self-Service application menu.
   Search yields the itil_self_service and mobile_self_service menu applications. You can enable (show) the Walk-up Check-in module for each menu application.
4. Click the Self-Service menu application with the Name: itil_self_service. The application menu Self-Service record opens and the Modules related list shows the modules that appear in the application navigator.
5. Search by Title for the Walk-up Check-in module.
6. Click Walk-up Check-in.
   The Walk-up Check-in module record opens.
7. In the Visibility tab, click Active to enable the Walk-up Check-in module. Active is true for the module. Alternatively, you can enable the module from the Applications Menus Self-Service Modules related list:
   a) Double-click the Active field beside the Walk-up Check-in module name in the Modules related list.
   b) Set Active to true (show) or false (hide).
8. Click Update.
When you change application menus or modules, the application navigator automatically refreshes to display the changes.

9. To enable the Walk-up Check-in module to display under Self-Service on the mobile application, click Walk-up Check-in in the Mobile Modules related list.

10. Click the Active field to enable the module for mobile devices.

11. Click Update.

Configure Walk-up Experience online check-in icon to appear on Service Portal

Users can check in to a walk-up location online via the Service Portal. You can edit the Service Portal Home page to replace the general IT Get Help support icon link with the Walk-up Experience online check-in support icon link.

Service Portal for Enterprise Service Management (com.glide.service-portal.esm) must be activated.

Role required: admin and sp_admin

To replace the Get Help icon link with the Walk-up Check-in icon link on the Service Portal Home page, access Service Portal Designer. Alternatively, you can add a new container to the Service Portal for the Walk-up Check-in icon link, so that the Get Help icon link remains.
1. Navigate to **Service Portal > Service Portal Configuration**.
2. Click the **Designer** tile on the configuration page. The Service Portal Designer opens.

3. Select the **Service Portal** index page to edit.

4. Ensure you are in edit mode by verifying that **Edit** is highlighted as active in the Service Portal Designer banner.

   In edit mode, you can add a new container for the Walk-up Check-in icon link or edit an existing container, depending on where you want to place the icon link.

5. To edit an existing container, select the **Get Help** icon link container.

6. Click the edit icon in the upper right corner.

   The **Get Help** icon link container form opens for editing.

7. Edit the form fields with the following data and presentation details:

<table>
<thead>
<tr>
<th>Fields</th>
<th>Configuration input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Type</td>
<td>Select <code>Page</code> to embed the <code>walkup_online_checkin</code> page with widget on the icon link.</td>
</tr>
<tr>
<td>Page ministry</td>
<td>Select <code>walkup_online_checkin</code>.</td>
</tr>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Enter <code>Walk-up Check-in</code>.</td>
</tr>
<tr>
<td>Short description</td>
<td>Enter details about the icon link, that you want displayed, such as <code>Check in to an IT walk-up location to make a request or report a problem</code>.</td>
</tr>
<tr>
<td>Bootstrap color</td>
<td>Select <code>Default</code>.</td>
</tr>
<tr>
<td>Bootstrap class name</td>
<td>Enter a class name or leave this field empty.</td>
</tr>
<tr>
<td>Glyph</td>
<td>Select a glyph or you can select the empty glyph to bypass this field.</td>
</tr>
<tr>
<td>Template</td>
<td>Select <code>Circle Icon</code>.</td>
</tr>
</tbody>
</table>

8. Click **Save**.

   The Service Portal Home page opens in edit mode. The online Walk-up Check-in icon link with your selected glyph image and description displays in place of the former **Get Help** icon link.
9. Navigate to **Service Portal > Service Portal Home** to verify and test the newly created Walk-up Check-in icon link.

10. To add the Walk-up Check-in icon link to a new container, refer to **Create and edit a page using the Service Portal Designer**.

11. Edit the container form fields with the same data and presentation information as detailed above in the form configuration input descriptions and follow the remaining relevant steps.

**Configure Walk-up Experience service channel**

Configure the Walk-up Experience service channel to meet the needs of your walk-up agents and how they are assigned to and manage interactions in Agent Workspace.

Role required: admin or sn_walkup.walkup_admin

The Walk-up Experience service channel is viewed and configured through Advanced Work Assignment. You can modify default values and conditions as desired.

1. Navigate to **Advanced Work Assignment > Service Channels**.
The Service Channels list displays.

2. Select **Walk-up** to open the Walk-up Experience service channel.
3. Refer to *Create a service channel* for detailed information regarding the Service Channel Walk-up form values and conditions.

For more information regarding Advanced Work Assignment service channels, including configuring capacity and utilization, inbox layout, and overriding agent capacity for selected agents, refer to *Service channels*.

**Create or modify Walk-up Experience notifications**

Create and use Walk-up Experience notifications to keep requesters informed of queue events that concern them. The system can notify users by email, SMS text message, or push notification to a mobile device.

Role required: admin or sn_walkup.walkup_admin

Walk-up Experience includes several base-system notifications that you can use or customize to notify walk-up visitors about specific information and interactions, including:

<table>
<thead>
<tr>
<th>Notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk-up Abandoned</td>
<td>Notifies when a walk-up interaction is closed.</td>
</tr>
<tr>
<td>Walk-up Threshold Notification</td>
<td>Notifies visitors when they are close to being next in line for support.</td>
</tr>
<tr>
<td>Walk-up Assigned</td>
<td>Notifies when an interaction is assigned to a technician.</td>
</tr>
<tr>
<td>Walk-up Closed</td>
<td>Notifies when a walk-up location is closed.</td>
</tr>
</tbody>
</table>

Notifications are

1. To view Walk-up Experience notifications, navigate to **Walk-up Experience > Administration > Notifications**.
2. Click an available walk-up notification to view basic properties, as well as information about when to send it, who will receive it, and what the notification will contain.
   
   The walk-up notification form appears.
3. To modify a walk-up notification, edit any of the form fields.
4. To create a new walk-up email or push notification, click **New** and refer to *Create an email notification* or *Create a push message*.

For complete information regarding using the System Notification application, refer to *Notifications*.

**Create or modify Walk-up Experience schedules**

Once you know the hours of operation for your Walk-up Experience location, you can either access the base-system default schedules or create new schedules to associate with your walk-up location.

Role required: admin or sn_walkup.walkup_admin

1. To view and use a base-system default schedule in the Walk-up Experience application, navigate to **Walk-up Experience > Administration > Schedules**.
The Schedules list opens. You can view all available base-system default schedules, such as 8-5 weekdays excluding holidays.

2. To modify an existing base-system schedule, click the schedule name, otherwise click New to create a schedule if none of the default schedules apply for your walk-up location.

3. Complete the Schedule New record form or modify fields on an existing form.

To complete this process and for detailed information on creating, modifying, and using schedules in the system, including a definition of all form fields, refer to Creating and using schedules.

Walk-up Experience appointment booking

With the Walk-up Experience appointment booking feature, walk-up users can view available appointment windows, make a selection, and book an appointment for a walk-up location using online Walk-up Check-in feature. Walk-up agents can also book appointments on behalf of customers.

Create time windows for walk-up queue locations enabling requesters to book service appointments.

The Appointment Booking plugin (com.snc.appointment_booking) must be activated to use the application. Appointment booking adds the Appointment Booking menu to the application navigator and the following modules:

- **Appointment Booking Configuration**: Use this module to create an appointment booking configuration for an application and then configurations for each service within that application.
- **Appointment Bookings**: Use this module to view a list of appointments that have been booked for services. This list includes the work orders associated with each appointment.

Appointment booking requires configuration at both the application level, in this case, Walk-up Experience, and at the walk-up queue service level, represented by the actual location of the walk-up queue.

The Walk-up Experience application configuration contains settings that apply to all of the service locations within the application that support appointment booking.

A service configuration is required for each of the walk-up queue locations within the application that offer scheduled appointments. A service configuration includes settings that apply only to that specific walk-up queue service location.

**Note:** Both the application configuration and the service configuration must be active to book appointments.

For detailed information about the Appointment Booking application, refer to Appointment booking.

Walk-up Experience appointment booking administration

Create or modify and enable the Walk-up Experience application configuration and the individual service location configurations for the Appointment Booking feature.

Administrators can create, modify, and enable the Walk-up Experience application configuration. Appointment booking administrators (appointment_booking_admin) can create, modify, and enable configurations for service locations within the Walk-up Experience application.

Walk-up Experience is an application level configuration provided with the base system appointment booking feature. You can include as many service level configurations as needed. The service level configurations apply to the individual walk-up queue locations that exist.
Administrators can modify these configurations as needed or use them as examples to create new configurations.

For detailed information on appointment booking administration, refer to Administer appointment booking.

Enable Walk-up Experience appointment booking
Enable or disable the appointment booking feature for Walk-up Experience as well as for the individual walk-up service locations available to customers.

Role required: admin or sn_walkup.walkup_admin

The Appointment Booking plugin (com.snc.appointment_booking) must be activated to use the application.

When appointment booking is enabled, the Schedule an appointment tab appears on the online check-in page. Users choose a reason for the appointment and select a date a time from current available appointments.

1. Navigate to Appointment Booking > Appointment Booking Configuration.
2. Click Walk-up Experience.
   The Walk-up Experience configuration is provided with the base system Appointment Booking feature.
3. Click Active to enable appointment booking for the Walk-up Experience application. Alternatively, if the feature is active you can deactivate it by clicking Active.
4. In the Appointment Booking Service Configuration related list, click the name of a service. For Walk-up Experience, a service is defined by the physical location of a walk-up queue. Every walk-up queue associated with your application is a service that needs to be configured for appointment booking.
   The Appointment Booking Service Configuration form for the selected service opens.
5. Click Active to set the field to true.
6. Click Update.

Walk-up Experience appointment booking configuration
Create or modify appointment booking configurations for the Walk-up Experience. You can view or modify the Walk-up Experience application appointment booking configuration and create or modify related service appointment configurations.

The base system Walk-up Experience application includes a default appointment booking configuration that can be modified. By default, the information stored in the Walk-up Experience application appointment booking configuration applies to all services within that application. Services within the Walk-up Experience application are defined as the actual walk-up queue locations. You can create new appointment booking service configurations for the Walk-up Experience application or modify existing configurations.

For example, you may want to configure one walk-up queue to accept appointment booking every day from Monday to Friday, but for another queue, you only want appointment booking available on Monday, Wednesday, and Friday. By configuring appointment booking at the service level, you can achieve this goal.

Specific Walk-up Experience set-up criteria for appointment booking include the following configurations:
- Define different appointment schedules and time windows per queue location.
- Define the time window in which you want to support appointments. For example, 15 minutes v. 30 minutes.
- Define the time window capacity. For example, the maximum number of appointments per time window.

View or modify a Walk-up Experience appointment booking configuration

View the base system default appointment booking application configuration to determine if the criteria meets your walk-up appointment booking needs. You can modify the application configuration to uniquely manage appointment booking for your experience. The information stored in the Walk-up Experience appointment booking application configuration applies to all the services within the application.

Role required: admin or sn_walkup.walkup_admin

The Walk-up Experience configuration is provided with the Appointment Booking feature.

1. Navigate to Appointment Booking > Appointment Booking Configuration.
2. To view the Walk-up Experience configuration, click the configuration name.
3. In the Appointment Booking Configuration form, view or modify the following fields as needed.

### Appointment booking application configuration fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the application configuration.</td>
</tr>
<tr>
<td>Task Table</td>
<td>Appointments are created for the tasks in the selected table. The Walk-up Appointment (wu_appointment) table is the default table for the Walk-up Experience configuration.</td>
</tr>
<tr>
<td>Availability Method</td>
<td>Use one of two methods to determine appointment availability.</td>
</tr>
<tr>
<td></td>
<td>- Number of appointments per slot: Define a specific number of appointments per time slot. Use this availability method if the task assignment method is set to manually. This is the default setting.</td>
</tr>
<tr>
<td></td>
<td>- Scripted: Use this configuration setting to determine availability if the task assignment method is set to using auto assignment or dynamic scheduling.</td>
</tr>
<tr>
<td>Active</td>
<td>Activates the application configuration and enables appointment booking.</td>
</tr>
<tr>
<td>Auto acceptance</td>
<td>If the application configuration setting for Process lifecycle is set to task-driven, an agent must accept or reject an assigned task. Enable the Auto acceptance check box to override this configuration setting for appointment booking.</td>
</tr>
<tr>
<td>Portal View</td>
<td>Display available appointments for a single day or for a week on the online Self Service Walk-up Check-in portal or from the Service Portal if the walk-up icon is configured there.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Create a record producer to capture Walk-up Experience appointment records
Capture Walk-up Experience appointment records by creating unique record producers for your individual walk-up locations. The Appointment Booking Service Configuration form contains required fields that refer to variables in the associated record producer.

Role required: appointment_booking_admin or admin

In order to properly configure your walk-up location services for appointment booking, you must first create a unique record producer for each walk-up location. You must also add variable sets to the record producer. By creating the unique record producer with appropriate variable sets, you can capture all your walk-up appointment records for each location.

1. Navigate to **Service Catalog > Record Producers**.
2. Click **New** to open the Record Producer New Record form.
3. Provide a unique name for the record producer in the **Name** field.
4. Search for and select **Walk-up Appointment (wu_appointment)** in the **Table name** field.
5. Provide a short description for added detail.
6. Click **Submit**.
7. Return to the Record Producers list and search for your newly created record producer.
8. Click to open your newly created record producer.
9. Scroll down the form and click to open the **Variable Sets** tab.
10. Click **Edit** to add the appropriate variable sets to the record producer.
11. Select and add the following variable sets to the record producer using the add button: **sn_appointment_variable_set** and **sn_walkup_variable_set**.
12. Click **Save**.

Create or modify a Walk-up Experience appointment booking service configuration

Create or modify appointment booking configurations for Walk-up Experience services. A service is defined as the actual physical location of a walk-up queue. The information stored in the Walk-up Experience application configuration applies to all services, or queue locations, within the application.

Role required: appointment_booking_admin or admin

To use the appointment booking feature, administrators must create a configuration for each service, or queue location, that is available to walk-up customers. Service configurations are created within the **Walk-up Experience** application configuration, as part of the **Appointment Booking** application.

1. Navigate to **Appointment Booking > Appointment Booking Configuration**.
2. Click **Walk-up Experience**.
3. In the Appointment Booking Service Configuration related list, click **New** to create a new service configuration. Alternatively, you can click an existing service configuration to modify data.
4. In the Appointment Booking Service Configuration form, fill in the following fields as needed.
## Appointment booking service configuration fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active</strong></td>
<td>Activates appointment booking for the service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If deactivated, customers cannot schedule appointments for the service but can still create work orders.</td>
</tr>
<tr>
<td><strong>General Information</strong></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>The name of the service configuration.</td>
</tr>
<tr>
<td>Configuration</td>
<td>The name of the appointment booking configuration to which this service belongs.</td>
</tr>
<tr>
<td>Availability table</td>
<td>The table that is used to calculate appointment availability. For Walk-up Experience, choose Walk-up Appointment (wu_appointment).</td>
</tr>
<tr>
<td><strong>Holiday Schedule</strong></td>
<td></td>
</tr>
<tr>
<td>The holiday schedule to use when determining availability. Appointment booking evaluates the holiday schedule when determining the number of available appointments and excludes any day in the schedule that is set to Exclude. Click the lookup icon and select a schedule from the Schedules list.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Holiday schedules are useful when the assignment method for tasks is set to manually, which does not consider agent schedules.</td>
</tr>
<tr>
<td><strong>Catalog Information</strong></td>
<td></td>
</tr>
<tr>
<td>Catalog item</td>
<td>The service in the service catalog for which this appointment booking configuration is being created. Click the lookup icon and select the associated service from the Record Producers list.</td>
</tr>
<tr>
<td>You must create a record producer for each walk-up service location. Refer to Create a record producer to capture Walk-up Experience appointment records.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The catalog item must exist in the service catalog.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you are using appointment booking with work orders, create a work order template before you configure appointment booking.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Location</td>
<td>The field on the record provider that determines the appointment location.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Ensure the Location field on both this form and the Walk-up Location Queue (wu_location_queue) form are configured in alignment. It contains the location reference variable, which is a Location (cmn_location) record. Selecting Location from the search list icon ensures you are aligning with the same time zone as the walk-up location you are configuring for. When you select Location, the online appointment scheduling calendar displays in the user timezone. If this field is left empty or if the user preference for the instance is not configured to have an associated time zone, the appointment scheduling calendar defaults to display in the user timezone. If a user in Europe has User preferences for Time zone configured for Europe/Brussels and the Appointment Booking Configuration for the Location field is set to a cmn_location with the time zone US/Pacific, then the appointment scheduling calendar will display in the US/Pacific time zone. When a user creates an appointment, the system defaults to use the schedule associated with the Walk-up Location Queue (wu_location_queue), regardless of the Location field value of this record producer.</td>
</tr>
<tr>
<td>Appointment is mandatory</td>
<td>Enable this check box if it is mandatory that a customer create an appointment when requesting this service.</td>
</tr>
<tr>
<td></td>
<td>· If enabled, the Appointment field appears on the record producer and the user must select an available appointment before submitting the service request.</td>
</tr>
<tr>
<td></td>
<td>· If disabled, the user can submit the service request without selecting an appointment.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User contact</td>
<td>The field on the record producer that determines who the appointment is being created for. Set this field to <strong>Contact</strong>. This is a reference field that looks for a sys_user variable on the record producer.</td>
</tr>
<tr>
<td>Booking</td>
<td></td>
</tr>
<tr>
<td>Appointments per window</td>
<td>The number of available appointments for each configured appointment time slot. This number determines the number of available appointments that are displayed on the Select Appointment window. Enter a number in this field if the assignment method for tasks is set to <strong>manually</strong>. If set to either <strong>using auto-assignment</strong> or <strong>using dynamic scheduling</strong>, this setting does not apply, unless a location is not provided. Then the configuration defaults to the number of appointments per window.</td>
</tr>
<tr>
<td>Lead time</td>
<td>The number of hours or days from the current time after which an appointment can be booked for this service. Define the lead time in hours or days. The default is 4 hours.</td>
</tr>
<tr>
<td>Future bookable max days</td>
<td>The number of days in advance of the current day for which an appointment can be booked for this service. The default is 14 days.</td>
</tr>
<tr>
<td>Reschedule / Cancel by time</td>
<td>The number of hours or days prior to an appointment start time that are required for an appointment to be canceled or rescheduled. If a user attempts to cancel or reschedule an appointment within this number of hours, the <strong>Cancel</strong> button is not available. Define the time in hours or days. The default is 4 hours.</td>
</tr>
<tr>
<td>Appointments</td>
<td></td>
</tr>
<tr>
<td>Appointment window</td>
<td>The length or duration of the appointment window. <strong>Note:</strong> Allow enough time for the work to be started and completed within this window.</td>
</tr>
<tr>
<td>Work duration</td>
<td>The amount of time required to complete all tasks created by the record producer. This duration is set for a task when it is created. Used to determine availability. The default is 1 hour.</td>
</tr>
<tr>
<td>Travel duration (round trip)</td>
<td>An estimated value of the average travel time required (round trip) for the agent performing the task. Set the value to 0 since the work is performed onsite and travel time is not needed.</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookable days</td>
<td>The days of the week for which appointments can be booked. The default is Monday through Friday. Bookable days should reflect the appointment schedule.</td>
</tr>
<tr>
<td>Daily start time</td>
<td>The start of the work day and the earliest start time for an appointment window. The default is 9:00.</td>
</tr>
<tr>
<td>Daily end time</td>
<td>The end of the work day and the latest end time for an appointment window. The default is 18:00 PM.</td>
</tr>
<tr>
<td>Include daily break</td>
<td>Enable this check box to schedule a break for each bookable day, then select the break start and end times. Can define one break which applies to all days.</td>
</tr>
<tr>
<td>Appointment booking preview</td>
<td>Provides a preview of the appointment windows and times based on the selected start and end times, break time, and appointment window.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Configure daily schedules for Walk-up Experience service appointment booking
Specify different daily hours of operation for your Walk-up Experience location appointment booking.

Role required: appointment_booking_admin or admin

Create a unique appointment booking schedule for each day of the week or for specific days of the week. For example, you can set the appointment booking availability schedule to run all day, from 9:00am to 5:00pm, Monday, Wednesday, and Friday. The Tuesday and Thursday appointment availability schedule can run from 9:00am to 12:00pm. You can completely remove appointment booking for a specific day of the week, for example, Friday.

Note: To specify unique daily booking schedules, while using your associated appointment booking configuration, create new Schedule Entries to exclude the hours appointment booking is not available.

1. To configure, for example, the Tuesday and Thursday appointment availability schedule from 9:00am to 12:00pm, navigate to Walk-up Experience > Schedules.
2. Select the schedule you use, for example, the 8-5 weekdays excluding holidays schedule.
3. In the Schedule Entries related list, click New.
   The Schedule Entry New record form appears.
4. Name the new record Excludes and fill in the form to create a unique daily booking schedule for Tuesday and Thursday appointments.
### Schedule Entry Excludes configuration fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name the record. For example, name the record <strong>Excludes</strong> to indicate the hours excluded from appointment booking.</td>
</tr>
<tr>
<td>Type</td>
<td>Choose <strong>Excluded</strong> as the type.</td>
</tr>
<tr>
<td>Show as</td>
<td>Choose <strong>Busy</strong> as the reason for the exclusion.</td>
</tr>
<tr>
<td>When</td>
<td>Indicate the date to begin using this booking availability schedule. Also indicate the time to exclude booking availability for this date. For example, the hours of 12:00pm through 5:00pm.</td>
</tr>
<tr>
<td>Repeats</td>
<td>Indicate the recurrence for this availability schedule. For example, <strong>Weekly on Tue and Thu.</strong></td>
</tr>
<tr>
<td>Repeat until</td>
<td>Specify how long you want this availability schedule to run by selecting an end date.</td>
</tr>
</tbody>
</table>
5. Click Submit.

6. To verify that Tuesday and Thursday appointment booking is only available from 9:00am to 12:00am, navigate to your online Walk-up Check-in application.

   If configured for view, You can access the online Walk-up Check-in application from the Service Portal Home page or under Self-Service in the left navigation bar.
7. Select the walk-up location for which you are verifying the schedule.
8. Click **Schedule an appointment** and select a reason for the visit.
9. Select a date for the appointment. The **Select Appointment** window displays the first available appointment, by week and day.
10. Determine that appointments are only available on Tuesdays and Thursdays from 9:00am to 12:00pm.

Activate and configure appointment booking reminders for Walk-up Experience

Configure scheduled appointment reminders for Walk-up Experience users. Reminders ensure users attend appointments in a timely manner or reschedule or cancel an appointment if they can no longer attend.

Role required: admin or sn_walkup.walkup_admin
In order for appointment booking reminders to operate, you must activate the Appointment Booking Reminders Scheduled Job, which is not active by default. In addition, the Appointment reminder field does not appear on the Appointment Booking Service Configuration form by default. You must add it to the form and configure reminders. Reminders are inactive unless a configuration is set.

1. To activate the Appointment Booking Reminders Scheduled Job, navigate to System Definition > Scheduled Jobs.
2. Search for Appointment Booking Reminders by name and click to open.
3. Click the Active field to activate the scheduled job.
4. Click Update.
5. To add the Appointment reminder field to the Appointment Booking Service Configuration form, navigate to Walk-up Experience > Administration > Appointment Configurations.
6. Select a Walk-up Experience service configuration from the list. The Appointment Booking Service Configuration form opens.
7. Click the menu button ( ) and scroll to Configure > Form Layout.
8. Select Appointment reminder from the Available list and move it to the Selected list using the add button.
9. Click Save.
   The Appointment Booking Service Configuration form displays with the Appointment reminder field.
10. To configure an appointment reminder, choose an amount of time, in hours, from the Appointment reminder field drop-down list. The hour or hours you choose represents the amount of time before a scheduled appointment that you want to send a reminder, for example, 2 hours before a scheduled appointment.
11. Click Update to add the appointment reminder configuration.

Create or modify a Walk-up Experience stockroom

Create stockrooms and assign assets and groups specifically for your walk-up location. Walk-up stockrooms contain common assets that visitors to the walk-up location will typically request, such as a computer mouse, monitors, and cables. The walk-up location stockroom should be easily accessible to your walk-up location for fast request fulfillment.

Role required: admin, sn_walkup.walkup_admin, asset, or inventory_user

Stockrooms are separate, standalone entities in the Asset Management application.

1. To view walk-up location stockrooms, navigate to Walk-up Experience > Administration > Walk-up Stockrooms.
   The Stockrooms (Walk-up view) list opens.
2. To modify an existing walk-up stockroom, click the stockroom name, otherwise click New to create a stockroom.
3. Complete the Stockroom New record (Walk-up view) form or modify fields on an existing form.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name and unique identifier of the stockroom.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group that primarily uses the stockroom.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>External</td>
<td>Whether this stockroom is managed internally (check box is cleared) or is managed externally by a third party (check box is selected).</td>
</tr>
<tr>
<td>Location</td>
<td>Physical location (address) of the stockroom.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of stockroom. Chose Walk-up to create a walk-up stockroom.</td>
</tr>
<tr>
<td>Manager</td>
<td>Person in charge of the stockroom. Receives restocking notifications and requests for the stockroom stock rules.</td>
</tr>
</tbody>
</table>

To complete this process and for detailed information pertaining to creating or modifying a stockroom, and adding and managing stockroom assets, refer to **Stockrooms**.

### Create or modify Walk-up Experience locations

Walk-up Experience locations contain all the information about the physical walk-up support venue. Easily configure Walk-up Experience to serve all users in your organization by using an inclusive branding, such as Tech Lounge, Service Center, Genius Bar, and more. You can configure schedules, assignment groups, associate stockrooms, and both management and administrative information for your walk-up location. Specify reasons-for-visit options and configure how interactions display for each walk-up location.

**Role required:** admin, sn_walkup.walkup_admin, or sn_walkup.walkup_manager

1. Navigate to **Walk-up Experience > Administration > Walk-up Locations**.
2. To modify an existing walk-up location, click the name of the walk-up location queue. Otherwise, click **New** to create a walk-up location.
   - The Walk-up Location Queue form opens.
3. Complete the form.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a detailed name for the location, such as the city or building it is located at.</td>
</tr>
<tr>
<td>Description</td>
<td>Provide a description of the location, if desired.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Select a schedule for operation days and hours.</td>
</tr>
<tr>
<td>Appointment Booking</td>
<td>Add and configure an appointment booking schedule for the walk-up location.</td>
</tr>
<tr>
<td>Service channel</td>
<td>Search for and choose the Walk-up service channel.</td>
</tr>
<tr>
<td>Define condition here</td>
<td>Select whether or not to automatically route work items to this queue using a condition.</td>
</tr>
</tbody>
</table>
### Fields

<table>
<thead>
<tr>
<th><strong>Condition mode</strong></th>
<th>Choose either <strong>Simple mode</strong> or <strong>Advanced mode</strong> to automatically route work to the queue. Simple mode is the default. With simple mode you can select from pre-built conditions. For example, select <strong>Location is X</strong> (search and select location). With advanced mode you can provide your own scripting and code.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Work item routing condition</strong></td>
<td>Configure and specify who will provide customer support at a walk-up location. Location is determined by physical address.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Check to make this queue location active.</td>
</tr>
<tr>
<td><strong>Enable away state</strong></td>
<td>Check to allow an away state.</td>
</tr>
<tr>
<td><strong>Away message</strong></td>
<td>Specify a display message for when the location is temporarily closed. This is for hours other than the scheduled closed times.</td>
</tr>
<tr>
<td><strong>Stockroom</strong></td>
<td>Select a stockroom to supply assets for the location.</td>
</tr>
<tr>
<td><strong>Location</strong></td>
<td>Select the physical address of your location.</td>
</tr>
<tr>
<td><strong>Location image</strong></td>
<td>Click to add an image of your location. For example, this can be an image of the city or building where the walk-up location is located.</td>
</tr>
</tbody>
</table>

4. Click the **Management** tab to complete the Management section of the form.

<table>
<thead>
<tr>
<th><strong>Fields</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Position notification</strong></td>
<td>Select the queue position that triggers a notification to visitors when they are close to being assisted at the location. For example, when a visitor is third in line to be assisted.</td>
</tr>
<tr>
<td><strong>Last check-in</strong></td>
<td>Specify the last available check-in time in minutes. For example, 30 minutes before closing.</td>
</tr>
<tr>
<td><strong>Enable online check-in</strong></td>
<td>Allow visitors to check in to the location remotely from a laptop or mobile phone.</td>
</tr>
<tr>
<td><strong>Enable appointment delegation</strong></td>
<td>Enable users to book an appointment for someone else.</td>
</tr>
</tbody>
</table>

**Note:** When you enable appointment delegation, the **Appointment delegation group** field appears. Select a group to allow appointment delegation. Add a new group of users if an appropriate group does not exist. Only users in this group will have the choice of scheduling for themselves or another user when they book an appointment.
<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name configuration</td>
<td>Select a name configuration to display visitor information on the onsite queue TV monitor and online check-in screen. The first name will always display. However, you can show first and last name, first name with last name initial only, or first name only.</td>
</tr>
<tr>
<td>Appointment routing</td>
<td>Specify the amount of time, in minutes, to route the work item to an agent prior to an appointment time.</td>
</tr>
<tr>
<td>Hold time</td>
<td>Enter an amount of time, in minutes, that you want to put an interaction on hold before attempting to route it again to a technician. For example, entering 5 will put the interaction on hold for 5 minutes before rerouting.</td>
</tr>
<tr>
<td>Show estimated wait</td>
<td>Enable the estimated wait time to show for walk-up queues.</td>
</tr>
</tbody>
</table>
|                        | **Note:** The wait time is calculated from the average wait time of the queue and how many users are currently in the queue. All estimated wait times are rounded to the nearest whole minute. The estimated wait time calculation requires the use of Service Owner Workspace to calculate the average wait time. Service Owner Workspace uses the Advanced Work Assignment queueing system to obtain the average wait time. Estimated wait times display in the following places:  
  - Online check-in.  
  - Onsite check-in and onsite queue screen (TV).  
  - **Status** widget on the Service Portal                                                                                           |
| Audio Playback         | Specify when the audio confirmation will play, for example, when a requester checks into an onsite queue, when a requester checks in online, or both. The default mode is None.                                                                                                                      |
### Audio File

Specify an audio file to play when a requester checks into a queue. The base-system default file is `walkup_checkin.mp3`.

**Note:** Only mp3 file formats are supported across all browsers. You may need to provide additional browser permissions to use an audio file on the Safari browser.

---

### Fields

5. Click the **Administration** tab to complete the Administration section of the form.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue time display</td>
<td>Chose from <strong>None</strong>, <strong>Check-in time</strong>, or <strong>Time waited</strong> to be displayed on the location wall monitor.</td>
</tr>
<tr>
<td>Queue message</td>
<td>Specify a welcome message for your location wall monitor.</td>
</tr>
<tr>
<td>Check-in greeting</td>
<td>Create a check-in message to guide visitors to sign into the queue at the designated check-in monitor.</td>
</tr>
<tr>
<td>Closed message</td>
<td>Create a message to alert visitors that it is outside the hours of operation and the location is closed.</td>
</tr>
<tr>
<td>Closed phone number</td>
<td>Select your country from the drop-down menu to display the IT phone number.</td>
</tr>
<tr>
<td>Closed phone number label</td>
<td>Define a label to display, such as, Contact IT Support.</td>
</tr>
<tr>
<td>Closed record producer</td>
<td>Search for and select a record producer to display and link to during closed hours, such as <strong>Create incident</strong>.</td>
</tr>
<tr>
<td>Badge Check-in Reason</td>
<td>Define a reason for checking into a walk-up location.</td>
</tr>
<tr>
<td></td>
<td>The default reason is <strong>Other</strong>.</td>
</tr>
<tr>
<td>Badge Check-in reason description</td>
<td>Define the check-in reason description. The default description is <strong>Walk-up badge scan check-in</strong>.</td>
</tr>
</tbody>
</table>

**Note:** Badge scan check-in is not an authentication mechanism.
<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed image</td>
<td>Click to add an image indicating the walk-up location is closed. The image displays on the wall monitor to alert walk-in visitors that the location is closed.</td>
</tr>
<tr>
<td>Max search results</td>
<td>Specify how many search results to provide for contextual searches.</td>
</tr>
<tr>
<td>Contextual search config</td>
<td>Configure which search context will provide results at the location.</td>
</tr>
<tr>
<td>Enable unregistered user entry</td>
<td>Check to allow users who do not have a user name in the system to check in to the location for support. For example, guests visiting the location (opposed to employees).</td>
</tr>
<tr>
<td>Enable lookup user entry</td>
<td>Check so that when users begin typing their names they can quickly see and select their names from a list.</td>
</tr>
<tr>
<td>Enable technician info</td>
<td>Check to allow the display of available technician names on the location wall monitor.</td>
</tr>
<tr>
<td>Enable technician avatar</td>
<td>Check to allow the display of technician avatars on the location wall monitor.</td>
</tr>
<tr>
<td>Enable badge check-in notification</td>
<td>Enable to show a notification when a requester checks into a queue using a badge scanner.</td>
</tr>
<tr>
<td>Header logo</td>
<td>Click to add a header logo. The header logo is location specific. If no logo is specified, by default, the Walk-up Portal logo is used.</td>
</tr>
<tr>
<td>Queue logo</td>
<td>Click to add a logo for the designated walk-up location wall monitor. Design this logo to work correctly with a black background. If no logo is specified for the queue, by default, the Header logo is used. If no Header logo is specified, the Walk-up Portal logo is used.</td>
</tr>
</tbody>
</table>

6. Right-click in the form header and select **Save**. Several tabs appear.
   - Interactions
   - Walk-up Appointments
   - Reasons for Visit
   - Assignment Eligibility
   - Work Item Sort Order
   - Location Queues Badge Readers

7. Click the **Interactions** tab to view interactions or configure how the walk-up Interactions list should display. You can use the filter icon (🔎) and the personalize list icon (⚙️) to modify.
8. Click the **Walk-up Appointments** tab to view appointments or configure how the Walk-up Appointments list should display. You can use the filter icon (🔧) and the personalize list icon (⚙️) to modify.

9. Click the **Reasons for Visit** tab to view, modify, or create a reason for visit option. The base system includes three active reasons:
   - I need something
   - Something is not working
   - Laptop refresh
   - Other

10. Click the **Assignment Eligibility** tab to view, modify, or create an assignment rule for your walk-up queue locations. Assignment rules are configured in the Advanced Work Assignment product.

11. Click the **Work Item Sort Order** tab to view, modify, or create an Work Item Sort Orders for your walk-up queue locations.

12. Click the **Location Queues Badge Readers** tab to view, modify, or add a badge reader for your walk-up queue locations.

13. Click **Update** to save the new or modified location queue.

---

**Walk-up Experience customer satisfaction surveys**

With Walk-up Experience surveys, users can rate their satisfaction with walk-up location interactions, providing management with feedback to improve the walk-up experience.

Two base-system predefined Walk-up Experience surveys are provided:

- **Walk-up CSAT survey**: Onsite one-click sentiment-analysis survey where the user can quickly rate service based on a 1 - 3 scale, where 1 is a negative experience and 3 is a positive experience. The survey uses an image scale of three faces with different sentiments (sad, neutral, and smiling).

- **Walk-up Experience Satisfaction Survey**: A survey link is sent via email when walk-up interactions are closed. It uses sentiment analysis for the overall experience, wait-time

![](image.png)

- **Sorry to hear.**
- **Got it. Good to know.**
- **Awesome! Good to know.**

---

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
experience, technician experience, technician professionalism, and additional comments. This survey is based on a 1 - 5 numeric rating scale, where 1 is very unsatisfied and 5 is very satisfied.

Walk-up administrators and managers can modify these surveys and the associated trigger conditions. Managers and administrators can review responses by question and see a scorecard for each survey on the Walk-up Experience Dashboard module. User comments provide feedback that is used to improve the performance of walk-up interactions.

For more detailed information about working with surveys, sentiment analysis, trigger conditions, and survey questions, see Survey Management.

Create or modify a Walk-up Experience customer satisfaction survey

Improve your Walk-up Experience operations and customer service by using surveys and monitoring survey results. Walk-up surveys capture important information from users about the interaction experience provided to them at the venue.

Role required: admin or sn_walkup.walkup_admin or sn_walkup.walkup_manager

Creating a new customer satisfaction survey requires that you first define a new survey and then use the Survey Designer to design, configure, and make it available to users.

1. To view and use a base-system predefined survey in the Walk-up Experience application, navigate to Walk-up Experience > Administration > Surveys.
   The Assessment Metric Types list opens displaying the available walk-up surveys.
2. To modify an existing walk-up survey, click the survey name, otherwise navigate to Survey > View Surveys and click New to define a new survey if none of the base-system surveys are optimal for your walk-up location.
   The Survey Definition New record form opens.
3. To modify or complete the form, refer to Modify a survey definition.

Remove a Walk-up Experience location

If you permanently close down a physical Walk-up Experience location, you can also remove the location from the Walk-up Location Queues table.

Role required: admin or sn_walkup.walkup_admin

1. Navigate to > Administration > Walk-up Locations.
2. Click the name of the walk-up location you want to remove to open the location queue record.
3. Click Delete in the form header.
   A confirmation pop-up appears ensuring you want to delete the record.
4. When the confirmation pop-up asks if you want to delete the record, click Delete.
   The Walk-up Experience location queue is removed from the application.

Badge Reader Integration for Walk-up Experience

Improve your Walk-up Experience user satisfaction by introducing the Badge Reader Integration application at your onsite walk-up queue locations. Walk-up Experience users can scan an employee badge to check in to a queue, rather than entering credentials.

Badge Reader Integration for Walk-up Experience onsite queue locations

Badge Reader Integration is a pre-built, domain-separated, base-system application enabling your Walk-up Experience users to simply scan an employee badge to join an onsite walk-up
queue. Badge scanning is quick and eliminates the need for users to look up a name or email to join a queue. Administrators configure badge scanning integration for use. There is no need for customizations because the application is pre-built and ready for operation.

By providing an enhanced, easier, and faster Walk-up Experience check-in process, use of onsite walk-up location queues can increase and overall user satisfaction can improve. Users receive an on-screen confirmation and an audio alert upon successful check in to a walk-up queue.

Badge scanning integration requires activation of the Badge Reader Integration plugin (com.snc.badge_reader). The plugin enables applications, such as Walk-up Experience, to integrate with badge reader hardware. Badge Reader Integration administration requires the Badge Admin role (sn_badge.badge_admin).

**Note:** Badge Reader Integration is not an authentication mechanism.

### Walk-up Experience Badge Reader Integration components

The badge reader hardware and integration client are physically located at a walk-up queue location. The Badge Reader Integration application provides a generic, reusable REST API used by the badge integration clients. Walk-up Experience uses the Badge Reader Integration application as a soft dependency.

Download the Badge Reader Integration executable for installation on your system. Activation of the Badge Reader Integration application provides an executable file. The client integrates with the Human Interface Device (HID) Omnikey 5427ck USB Badge Reader hardware and the Badge Reader Integration application REST API. The Badge Reader Integration module contains links to download the client to either a Linux or OSX operating system.

Walk-up Experience implementers install the HID Omnikey 5427ck USB Badge Reader hardware on a new computer at each onsite walk-up queue location. The hardware replaces any existing tablets used for onsite check-in. The following are important associated components to know:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Badge number</td>
<td>Employee badge number.</td>
</tr>
<tr>
<td>Facility code</td>
<td>Unique facility or site code encoded into each card that identifies the organization.</td>
</tr>
<tr>
<td>Human Interface Device (HID)</td>
<td>Protocol for interfacing with user interface devices via USB.</td>
</tr>
<tr>
<td>Physical Access Control Services (PACS)</td>
<td>Method used to protect the security of a physical environment by setting authorization and authentication rules.</td>
</tr>
<tr>
<td>Badge reader client</td>
<td>Acceptable platforms include Mac and Linux.</td>
</tr>
<tr>
<td>Badge reader plugin</td>
<td>Badge Reader Integration plugin (com.snc.badge_reader) is no additional cost.</td>
</tr>
</tbody>
</table>
Badge Reader Integration components

Badge Reader Integration modules

Badge admins can access several application modules.
<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Downloads</td>
<td>Badge Reader Integration client for download to your system.</td>
</tr>
<tr>
<td>Badge Readers</td>
<td>Configuration module for defining and activating your badge reader devices.</td>
</tr>
<tr>
<td>Badge Event Handlers</td>
<td>Configuration module for defining what action to take when a badge is scanned by a badge reader device.</td>
</tr>
<tr>
<td></td>
<td>The script entered is the code executed when a badge is scanned.</td>
</tr>
<tr>
<td></td>
<td>These records are typically delivered as part of the application specific badge reader integrations.</td>
</tr>
<tr>
<td>User Badges</td>
<td>Configuration module for associating users with user badges.</td>
</tr>
<tr>
<td></td>
<td>Configuration requires associating a sys_user with a unique badge number and facility code.</td>
</tr>
<tr>
<td>Badge Scan Logs</td>
<td>View-only module to monitor badge reader error events.</td>
</tr>
</tbody>
</table>

**Badge Reader Integration security**

The Badge Reader Integration application is not an authentication mechanism. It provides a quicker, more convenient way for users to check into a walk-up queue. It is meant for use within the existing security perimeter at the facility. The application does not integrate with existing access control software at the facility.

**Activate Badge Reader Integration**

You can activate the Badge Reader Integration plugin (com.snc.badge_reader) if you have the Badge sn_badge.badge_admin role.

Role required: sn_badge.badge_admin

The Badge Reader Integration application is a framework enabling other applications, such as Walk-up Experience, to integrate with badge reader hardware. Administrators configure and manage badge reader clients and integrations by linking badge scanners to walk-up locations and ensuring there is mapping between badge ID numbers and the reader.

Developers can extend the badge scanning framework to trigger actions in other applications based on a badge scan event. The Badge Reader Integration application does not require customization, but is customizable to respond to unique badge system hardware.

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.
Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Installed with Badge Reader Integration

Several types of components are installed with activation of the Badge Reader Integration plugin, including tables and user roles.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Badge admin</td>
<td>Used to administer badge reader integrations.</td>
<td>None</td>
</tr>
<tr>
<td>(sn_badge.badge_admin)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Badge</td>
<td>Record used to configure a user badge, associating a user to a badge number and facility code.</td>
</tr>
<tr>
<td>(sn_badge_user_badge)</td>
<td></td>
</tr>
<tr>
<td>Badge Event Handler</td>
<td>Record used to configure actions associated with a badge scan event. Stores an event handler script that can be mapped to a badge reader. Extends the Application File table.</td>
</tr>
<tr>
<td>(sn_badge_event_handler)</td>
<td></td>
</tr>
<tr>
<td>Badge Scan Log</td>
<td>Record used to log all badge reader error events.</td>
</tr>
<tr>
<td>(sn_badge_scan_log)</td>
<td></td>
</tr>
<tr>
<td>Badge Reader</td>
<td>Record used to configure badge reader devices. Extends the Task table.</td>
</tr>
<tr>
<td>(sn_badge_badge_reader)</td>
<td></td>
</tr>
</tbody>
</table>

Walk-up Experience Badge Reader Integration setup and configuration

Badge Reader Integration set up and configuration enables your onsite Walk-up Experience users to scan a badge to quickly check into the queue.

The Walk-up Experience (com.snc.walkup) and Badge Reader Integration (com.snc.badge_reader) plugins must be activated before you set up and configure the integration. Refer to Activate Walk-up Experience and Activate Badge Reader Integration for details regarding activation.
Badge Reader Integration is automatically activated with Walk-up Experience via a conditional plugin.

Activation of Badge Reader Integration provides a client executable file, that, once installed on the appropriate computer, integrates with the HID Omnikey 5427ck USB Badge Reader hardware and the Badge Reader Integration application REST API. The **Badge Reader Integration** module contains links to download the client to either a Linux or OSX operating system.

Badger Reader Integration requires connecting the HID Omnikey 5427ck USB Badge Reader hardware to a client computer at an onsite Walk-up Experience location. Downloading and installing the badge reader client executable on this computer enables integration between it and the badge reader hardware.

Set up and configuration entails the following stages:

- **Client software**: Download the client executable file and install on your system.
- **Badge reader device**: Configure the badge reader device and register it manually or via an assisted process.
- **Approval**: Request and receiving device activation approval.
- **Walk-up Experience application**: Configure Walk-up Experience to integrate with a badge reader device.

### Download Badge Reader Integration client and configure hardware

Configuring the HID Omnikey 5427 CK USB badge reader device after you download and install the client software enables the Badge Reader Integration application to parse data from the device.

Role required: sn_badge.badge_admin

**Note**: This procedure is based on the HID Omnikey 5427 CK USB badge reader device hardware. Specific configurations may vary depending on your device manufacturer. For complete configuration details regarding the HID Omnikey 5427 CK USB badge reader device and for related supplemental documentation, refer to:

- **HID OMNIKEY 5427 CK Keyboard Wedge User Guide User Manual**
- **Find facility code/card number with PACS data output for HID Global 5427 USB Multi reader**
- **Wiegand interface**

You need to have the HID Omnikey 5427 CK USB badge reader device hardware available for configuration. Download the executable client and configure the badge reader device to integrate with the Badge Reader Integration application.

To successfully configure the badge reader, you need to configure the **Keyboard Wedge Enable**, **Card Data Selection**, and the **Card Data Manipulation** tabs. Configuring the Card data Selection depends on your specific card format. Please refer to your manufacturer documentation for specific details.

Configuring Card Data Selection is a device configuration and depends on your specific card format. Please refer to your specific manufacturer documentation for details.

Configure the Card Data Manipulation format so the badge reader client obtains the expected and necessary badge reader device data output. The client requires the badge reader to output accordingly: `<facility code>:<badge number>(enter)`, so it can parse the data when the badge is scanned.

1. Plug your device into a Linux or Windows machine.
2. Navigate to the IP address of your device.
   The out-of-the-box IP address is 192.168.63.99. The out-of-the-box IP address may have been overridden in your system if this device was previously configured. Refer to the HID OMNIKEY 5427 CK Keyboard Wedge User Guide User Manual for more details.
3. Navigate to **Badge Reader Integration** > **Downloads** to select your operating system.
4. Click the download icon to choose either a **Linux** or **OSX** client.

   **Note:** Ubuntu Linux is supported.

   The appropriate client software executable is downloaded to your computer.
5. Click to open the client **badge-reader** executable file to install it on your computer.
6. On the HID Omnikey 5427 CK USB badge reader device interface, click the **Keyboard Wedge** tab and then the **General Config** tab to configure the card data output in a format that the Badge Reader Integration application can parse.

7. Check the **Keyboard Wedge Enable** box to activate this mode.
8. From the **Keyboard Wedge** tab, click the **Card Data Selection** tab.
9. Choose **Seos** from the **Card Type** drop-down menu.

   **Note:** Currently only Seos is supported.
10. Ensure **Enable Seos** is checked.
11. Check the **PACS Custom** box to output the card data into an easily parsed format.
12. Specify the offset and length appropriate for your card format.
This configuration is for a 48bit card format. The first bit is a parity bit. There are 23 bits for the facility code, 23 bits for the card number, and 1 final parity bit.

**Note:** If necessary, refer to the supplemental documentation links provided above in this topic to determine the offset and length for your card format.

13. Type `:` to configure the first *Poststrokes* element to contain a colon. The first *Prestrokes* element is the facility code. The colon separates the facility code from the badge card number, with the second *Prestrokes* element.

14. Type `[ENTER]` to configure the second *Poststrokes* element. The second *Prestrokes* element is the badge card number. `ENTER` refers to the keystroke that terminates the card data string, triggering the badge reader client to send the badge scan event to the API endpoint.

The goal is to output the facility code and badge card number separated by a colon and terminated by pressing the Enter key on your keyboard. If the facility code is 12345 and the badge card number is 6789, the desired output is: `12345:6789[enter]` where `[enter]` is pressing the enter key.

15. From the *Keyboard Wedge* tab, click the *Card Data Manipulation* tab.

16. In the **PACS Custom 1 > Format** field, use the drop-down menu to change the format to **DEC**.

   The sets the output to decimal format for readability.

17. Set the **PACS Custom 2 > Format** field to **DEC** for output readability.
18. Navigate to the System Config tab to apply your changes.
19. Click Apply Changes.
20. Scan a badge to ensure your system is working.
   - The client application should not be running. Ensure the badge reader is connected and enabled for Keyboard Wedge mode.
   - The badge reader should keystroke out the data in the format you have configured, for example: 12345:6789(enter)

Create or modify Badge Reader Integration event handlers

Configure actions associated with a badge scan event and define the code to execute when a badge is scanned.

Role required: sn_badge.badge_admin

Using the Badge Event Handlers module you can map badge event handlers to multiple badge readers. For example, you may have a badge reader at your San Diego, CA walk-up location and another badge reader at your Santa Clara, CA location. Both of these badge readers can be mapped to the same Walk-up Badge Reader event.

Badge Event Handler records are delivered as part of the Walk-up Experience application-specific badge reader integrations.
The code entered in the **Script** field of the Badge Event Handler form is executed using a GlideScopedEvaluator in the BadgeScanProcessor.

1. Navigate to **Badge Reader Integration** > **Badge Event Handlers**.
   The Badge Event Handlers list appears and displays any existing badge event handlers.

2. To modify an existing badge event handler, click on the name. Otherwise, to create a new badge event handler, click **New**.
   The Badge Event Handler form opens for configuration.

3. Enter a name for the badge event handler in the **Name** field. For example, *Walk-up Badge Event*.

4. Enter details in the **Short description** field, if desired.

5. Enter code in the **Script** field.
   Enter the code in the `// your code goes here` section of the scripting field.

```
(function(user, badge_reader)

// your code goes here

)(user, badge_reader);
```

**Note:** This code is executed when a badge is scanned.
6. Click Submit to create the record.

**Use Badge Reader Client to define and register a badge reader device**

Use the Badge Reader Client to create a badge reader device for registration in your system. Registering your badge reader enables you to make it operational at your Walk-up Experience onsite queue.

**Note:** By default, the Application field is set to **Global** until you enter code specifying Walk-up Experience application in the Script field and save or submit the record.
Role required: sn_badge.badge_admin

There are two ways to register a badge reader device:

- Assisted method, through the **Badge Reader Client**.
- Manually, through the Now Platform®. Refer to *Manually define and register a badge reader device* for details on this procedure.

The **Badge Reader Client** assisted registration method creates an initial Badge Reader record. When a badge is scanned using the client executable, this method automatically populates the **Device Identifier** field in the record with the badge reader device serial number.

Automatic population of the **Device Identifier** field saves you time from looking for the badge reader device serial number to add to the Badge Reader record.

To register your badge reader device with **Badge Reader Client** assistance, first you need to configure system properties to enable badge scan registration and disable the badge access token. The following System Properties must be configured:

- **sn_badge.enable_scan_registration**: Disabled by default. When set to **True**, this property enables n_badge.badge_admins to quickly register badge reader devices by scanning a badge.
- **sn_badge.disable_access_token**: Enabled by default. This property disables the access token requirement for the Badge Reader Integration API.

1. Navigate to **System Properties > All Properties**.
2. Search by **Name** for the properties by typing `sn_badge`.
   The Badge Reader Integration system properties are listed for view.
3. Click **sn_badge.enable_scan_registration** to open the system property record.
   The property is set to **False** by default.
4. Change the property **Value** field to **True** and click **Update**.
5. Click **sn_badge.disable_access_token** to open the system property record.
   The property is set to **False** by default.
6. Change the property **Value** field to **True** and click **Update**.
7. Navigate to your downloaded **Badge Reader Client** files to configure `client.json`.
8. Locate and click the `client.json` file.

**Note:** Start the client using `sudo` to enable access to a USB port.
When using scan registration, only the URL is required. The Secret Key field is generated when the Badge Reader record is created.

9. Navigate to **Badge Reader Integration > Badge Readers** to view the newly created record.

10. Provide a name for the badge reader in the **Name** field. For example, **Building B Tech Lounge Badge Reader**.

   **Note:** The **Status** field is read only and indicates **New** when configuring a new badge reader. The field indicates **Activated** when a badge reader is approved for activation. If a badge reader is deactivated, the field indicates **Deactivated**.

11. Specify a **Badge Event Handler** using the search list icon.

   **Note:** If no badge event handlers are available to select, create a new Badge Event Handler record. For details about this process, refer to **Create or modify Badge Reader Integration event handlers**.

12. Verify that the **Device Identifier** and **Secret Key** fields are populated.

    The Device Identifier uniquely identifies the badge reader hardware. The client defaults to using the badge reader device serial number. The value entered must match the device serial number received from the client software application.

13. Populate the non-mandatory **Short description** and **Location** form fields if desired.

14. Click **Submit** to register the badge reader.

---

**Manually define and register a badge reader device**

Manually create a badge reader device for registration in your system. Registering your badge reader enables you to make it operational at your Walk-up Experience onsite queue.

Role required: sn_badge.badge_admin

There are two ways to register a badge reader device:

- Manually, through the Now Platform®.
- Assisted method, through the **Badge Reader Client**. Refer to **Use Badge Reader Client to define and register a badge reader device** for details on this procedure.

1. To manually register your badge reader device, navigate to **Badge Reader Integration > Badge Readers**.

2. Click **New** to create a new badge record

   The Badge Reader form opens for configuration.

3. Provide a name for the badge reader in the **Name** field. For example, **Building B Tech Lounge Badge Reader**.

   **Note:** The **Status** field is read only and indicates **New** when configuring a new badge reader. The field indicates **Activated** when a badge reader is approved for activation. If a badge reader is deactivated, the field indicates **Deactivated**.

4. Specify a **Badge Event Handler** using the search list icon.
5. Enter the **Device Identifier**.

The Device Identifier uniquely identifies the badge reader hardware. The client defaults to using the badge reader device serial number. The value entered must match the device serial number received from the client software application.

**Note:** The **Secret Key** field is automatically populated when you create the badge reader record.

6. Populate the non-mandatory **Short description** and **Location** form fields if desired.

7. Click **Submit** to register the badge reader.

---

**Request activation approval for a badge reader device**

Request activation approval for your badge reader device. Badge Reader Integration will not trigger event handlers until the badge reader is activated. Badge reader device approval and activation is granted by users with the itil role.

**Role required:** sn_badge.badge_admin

When you request activation approval, via the Badge Reader record, you initiate the device registration workflow. Activation requests are routed to a badge reader approvers group. System approvals require the itil role. Ensure users with the itil role are added to the badge reader approvers group.

If there are no people in the approval group, the workflow will skip past the approval group requirement, and activate the badge reader. For detailed information about approvals, groups, and adding users to groups, refer to **Approvals** and **Groups**.

**Note:** Badge Reader record required fields are read only when the badge reader device is activated. Badge reader devices can be deactivated by de-selecting the **Active** field on the Badge Reader record. Reactivation of a badge reader requires going through the approval process again.

---

1. Navigate to **Badge Reader Integration > Badge Readers**.

2. Click the name of the badge reader you want to activate.

   The Badge Reader record opens.

3. Ensure all mandatory form fields are populated. This includes the **Name**, **Badge Event Handler**, **Device Identifier**, and **Secret Key** fields.

   Refer to **Use Badge Reader Client to define and register a badge reader device** or **Manually define and register a badge reader device** for information regarding populating Badge Reader form fields.

4. Click **Request Activation** to initiate the activation approval workflow.

   The request is approved by a user with the itil role in the badge reader approvers group. If there is no badge reader approvers group or the group is empty, then the badge reader is activated when a user with the sn_badge.badge_admin role requests activation.
Configure Walk-up Experience for Badge Reader Integration

Associate badge reader devices with an onsite Walk-up Experience queue. While you can associate more than one badge reader device to a walk-up location, individual badge reader devices are mapped to only one walk-up location.

Role required: sn_walkup.walkup_manager

The Walk-up Experience application requires that a badge reader device is mapped to a walk-up location for feature integration.

Walk-up Experience managers can configure badge reader integration to a walk-up location using the Location Queues Badge Readers related list on the Walk-up Location Queue (wu_location_queue) table.

At least one badge reader must be activated and available to integrate with the walk-up location. Refer to Request activation approval for a badge reader device if no badge readers are activated for use.

1. Navigate to Walk-up Experience > Administration > Walk-up Locations.
2. Click the name of the walk-up location queue you want to associate with a badge reader device.
   The Walk-up Location Queue form opens.
3. Click the Location Queues Badge Readers related link.
4. Click New and use the search list icon in the Badge Reader form field to select an available badge reader.
5. Click Submit.
   You can integrate with as many badge readers at your walk-up location as you need.

View Badge Scanner Integration scan logs

Monitor scanner-use error activity at a Walk-up Experience onsite location by viewing the scan logs. Each time a badge reader device triggers an error, a scan event is logged in the Badge Scan Logs module.

Role required: sn_badge.badge_admin

The Badge Scan Logs module only stores badge reader integration error messages. It does not display error messages for Walk-up Experience specific badge scans.

Walk-up Experience badge scan errors can be found in the System Log.

1. Navigate to Badge Reader Integration > Badge Scan Logs.
2. Click an event in the Badge Scan Logs list to view the associated Message, Badge Reader, and User Badge.

Badge Reader Integration customization

Badge Reader Integration includes several scripted extension points enabling you to customize script includes installed with the feature.

The underlying Badge Reader Integration script includes are read only. Customers who want to modify the look and feel of the feature can alter several script includes using scripted extension points.

Various scenarios exist whereby the ability to modify script-includes code is beneficial. For example, if you already use a data model to store your badge numbers, you may not want
to use the Badge Reader Integration application User Badge (sn_badge_user_badge) table to store your badge numbers. Instead, you can create an extension implementation for sn_badge.BadgeReader that supports your data model.

Perhaps you want to customize the types of data you receive from a badge scan or how you want to parse that data. You can create an extension implementation for sn_badge.BadgeReaderParser that supports your data model.

The following code is available for alteration using scripted extension points with the Badge Reader Integration application:

<table>
<thead>
<tr>
<th>Scripted Extension Points</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BadgeReader</td>
<td>Extension point used by the BadgeReaderImpl script include. Use this script to find a badge reader by its device identifier.</td>
</tr>
<tr>
<td>BadgeReaderParser</td>
<td>Extension point used by the BadgeReaderParserImpl script include. Use this to parse the card data string from the API.</td>
</tr>
<tr>
<td>BadgeReaderUser</td>
<td>Extension point used by the BadgeReaderUserImpl script include. Use this script to find a sys_user from a badge number and facility code.</td>
</tr>
<tr>
<td>BadgeReaderScanProcessor</td>
<td>Extension point used by the BadgeReaderScanProcessor script include. Use this frontage to manage the badge scan event.</td>
</tr>
</tbody>
</table>

Note: If you already have a data model for storing your badge numbers, this is the script to use to override the Badge Reader Integration application code to support your data model.

For complete details about scripted extension points and how to create and use them, refer to Using extension points to extend application functionality and Creating and adding a scripted extension point.

Walk-up Experience queue and interaction management

Walk-up Experience managers and technicians can efficiently manage all aspects of a walk-up location queue and interaction demand. Technicians can view assigned walk-up locations, interactions, and associated stockrooms used for walk-up fulfillment.

Walk-up Experience provides technicians with inclusive fulfiller resources to organize and manage a walk-up queue.

Technicians primarily access Agent Workspace to manage all aspects of Walk-up Experience. Using Agent Workspace technicians can:

- Access a personal inbox to view work assigned from multiple service channels, including the Walk-up Service Channel.
• Get assignments automatically pushed to the inbox from the walk-up interaction queue.
• Work on concurrent or multiple interactions at the same time.
• Promote interactions to incidents or requests.
• Work with any requester in the queue at any time by pulling from anywhere in the queue list, as well as from the top of the list.
• Use Agent Assist for expedited fulfillment.

With Agent Workspace, technicians typically fulfill interactions on a first-come-first-served basis as interactions are pushed to individual walk-up inboxes. Interactions are distributed to walk-up agent inboxes based on assignment rule configurations in the Advanced Work Assignment feature.

Technicians can directly open incidents in Agent Workspace when an issue is not resolved at the walk-up location. Technicians can also directly create a request for hardware or software through the Service Catalog when an asset is not available at the walk-up location stockroom.

Walk-up Experience also includes a Technician module in the application navigator where IT agents supporting a walk-up queue can perform the following actions:
• Access the personal walk-up inbox linking directly to Agent Workspace.
• View assigned walk-up interactions.
• Reassign and modify walk-up interactions when necessary.
• View all scheduled and upcoming appointments.
• View walk-up queue locations.
• View available assets and fulfill requests from a local stockroom.
• Create incidents and requests when necessary.
• Transfer walk-up interactions to other agents or queue locations when necessary.

The following applications are included in the platform Technician module of the Walk-up Experience navigation bar as well as viewed in the Agent Workspace Walk-up Experience interface:

<table>
<thead>
<tr>
<th>UI view and application</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Platform:** My Walk-up Inbox  
**Agent Workspace:** Inbox | View walk-up interactions assigned to you in your personal inbox on Agent Workspace. Interactions are pushed to your inbox according to assignment rule configurations in the Advanced Work Assignment feature. |
| **Platform:** My Walk-up Locations  
**Agent Workspace:** Walk-up Locations | View walk-up queue locations that you are assigned to support by physical address. |
| **Platform and Agent Workspace:** My Assigned Walk-ups | View walk-up interactions you are assigned to resolve or fulfill. These interactions have a Work in Progress state. You can also see your assigned interactions in your personal inbox on Agent Workspace. |
| **Platform:** My Walk-up Stockrooms  
**Agent Workspace:** My Stockrooms | View stockrooms and assets associated with the walk-up queue locations you support. |
<table>
<thead>
<tr>
<th>UI view and application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform and Agent Workspace: Open - Unassigned</td>
<td>View all open and unassigned walk-up interactions for your queue locations. These interactions have either a <strong>New</strong>, <strong>Queued</strong>, or <strong>Work in Progress</strong> state.</td>
</tr>
<tr>
<td>Platform and Agent Workspace: Closed Walk-ups</td>
<td>View all closed walk-up interactions. Closed interactions have either a <strong>Closed Complete</strong> or <strong>Closed Abandoned</strong> state.</td>
</tr>
<tr>
<td>Platform: Scheduled Appointments</td>
<td>View all upcoming appointments scheduled for your walk-up queue.</td>
</tr>
</tbody>
</table>

For more information on Agent Workspace and Advanced Work Assignment, refer to **Workspace** and **Advanced Work Assignment**.

**View assigned Walk-up Experience locations**

Walk-up Experience technicians can view a list of the walk-up queues they are assigned to support. Locations queues reveal all the information a technician needs to know to operate the queue efficiently.

Role required: sn_walkup.walkup_technician

There are two ways technicians can view the walk-up location queues they are assigned to support. Technicians primarily access Agent Workspace for all Walk-up Experience related information, including locations. However, technicians can also access Walk-up Experience in the application navigator, or left navigation bar, to view assigned queue locations.

1. **To view walk-up locations using Agent Workspace**, navigate to **Workspace Experience > Agent Workspace Home**.
   
   The Agent Workspace homepage opens, greeting you with your name.

2. **Click List** in the left navigation bar.

3. **Under Walk-up, click Walk-up Locations**.
   
   Walk-up locations you are assigned to support are listed.

4. **Click a queue name to view details about the location, such as, interactions, appointments, reasons for visits, and more**.

5. **Alternatively, to view walk-up locations via the application navigator, navigate to Walk-up Experience > Technician > My Walk-up Locations**.

6. **Click a queue name to see details about the location, such as, interactions, appointments, reasons for visits, and more**.

   If interactions are leftover from a previous day or are still queued at the end of the day with no associated guests at the queue, you can click **Abandon All** to cancel these interactions.

**View Walk-up Experience inbox**

View a personal inbox of automatically assigned Walk-up Experience interactions using the Agent Workspace feature interface.

Role required: sn_walkup.walkup_technician

There are two ways technicians can view the walk-up inbox. Technicians primarily access Agent Workspace for all Walk-up Experience related information, including the inbox. However
technicians can also access Walk-up Experience in the application navigator, or left navigation bar, to link to and view the inbox in Agent Workspace.

1. To view the walk-up inbox using Agent Workspace, navigate to **Workspace Experience > Agent Workspace Home**.
   The Agent Workspace homepage opens, greeting you with your name.

2. Click **Inbox** in the left navigation bar of the interface.
   Automatically pushed interaction assignments appear in the inbox based on agent schedules and assignment rule configurations in the Advanced Work Assignment feature. Technicians can set an inbox status of **Available**, **Away**, and **Offline**.

3. Alternatively, to view the walk-up inbox via the application navigator, navigate to **Walk-up Experience > Technician > My Walk-up Inbox**.
   You are linked directly to your personal inbox in Agent Workspace. Automatically pushed interaction assignments appear in the inbox based on agent schedules and assignment rule configurations in the Advanced Work Assignment feature.

### Manage automatically assigned Walk-up Experience interactions

Technicians supporting Walk-up Experience locations can view and manage interactions automatically pushed to the Agent Workspace inbox.

Role required: sn_walkup.walkup_technician

Walk-up Experience interactions can be automatically pushed to a personal inbox in Agent Workspace based on agent schedules and assignment rule configurations in the Advanced Work Assignment feature. Technicians fulfill interactions on a first-come-first-served basis as they appear in the inbox.

To manually assign and manage interactions using the Walk-up Experience Technician modules found in the application navigator, refer to **Manage Walk-up Experience interactions manually**.

Technicians set a status in the Agent Workspace inbox to indicate readiness to accept interactions. Status choices are **Available**, **Away**, and **Offline**.

Even though interactions are automatically pushed to the walk-up inbox, agents can work with anyone in the walk-up queue at any time.

View walk-up queue interactions assigned to you automatically in your walk-up inbox or in your **My Assigned Walk-ups** list. You can also view all **Open - Unassigned** interactions for the queue you support.

With Agent Workspace you can view lists of all your related walk-up interactions and appointments, your cases, customer accounts and contacts, incidents, requests, and more using one convenient interface. The Walk-up Experience related interaction list includes the following items:
## Walk-up Experience related interaction list

<table>
<thead>
<tr>
<th>List item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Assigned Walk-ups</td>
<td>Interactions you assign to yourself when you accept an active interaction or that are assigned to you. Agents assign interactions to themselves when they accept a queued interaction. Managers can assign interactions to specific agents. These interactions are in a Work in Progress state. Once assigned, an agent can transfer the interaction to another agent or queue to complete the work, if necessary.</td>
</tr>
<tr>
<td>Open — Unassigned</td>
<td>All open but unassigned interactions associated with your specific walk-up queue location. When a guest checks into a walk-up queue, an interaction is created. The interaction is Queued until an agent accepts it or is assigned the interaction. At that point, the state changes to Work in Progress.</td>
</tr>
<tr>
<td>Closed Walk-ups</td>
<td>All Closed Complete and Closed Abandoned interactions assigned to a specific walk-up location queue. Agents can abandon an interaction when a guest leaves the queue before receiving support.</td>
</tr>
</tbody>
</table>

1. To begin supporting a walk-up queue guest, navigate to **Workspace Experience > Agent Workspace Home**. The Agent Workspace homepage opens, greeting you with your name.

2. Click **Inbox** and ensure your status is set to **Available**. View interactions in your inbox automatically pushed to you.

3. Select the interaction at the top of the list and begin resolving the issue or fulfilling the request. When you create an associated incident or request through the Service Catalog, a **New Incident** tab or a **New Catalog Item** tab opens next to the Details tab of the original interaction. Fill out the new incident form or order assets. Click the Save button to save the new incident or complete the order confirmation. You will receive an Request Number for your ordered item.

   a) If an interaction requires an unusual amount of time to resolve or fulfill or if closure depends on resources not readily available, you can place the interaction on hold. The requester does not lose position in the queue and you can help another requester simultaneously. Placing an interaction on hold does not affect your capacity for new interactions. To put an interaction on hold, click the **Put on Hold** button.

   b) You can associate the interaction with another record by selecting **Associate Record** from the more UI actions icon in the interaction header.

   c) To view the walk-up location stockroom for fulfillment requests, click **List** in the left navigation panel of the Agent Workspace interface. Then click **My Stockrooms**.

   d) If you cannot resolve an issue, click the **Create Incident** button in the interaction header. If you cannot fulfill a request from the stockroom, click the more UI actions icon in the
interaction header to view more actions. Select **Create Request** from the list to access the Service Catalog.

When you create an associated incident or request through the Service Catalog, a **New Incident** tab or a **New Catalog Item** tab opens next to the **Details** tab of the original interaction. Fill out the new incident form or order assets. Click the **Save** button to save the new incident or complete the order confirmation. You will receive an **Request Number** for your ordered item.

4. When you are finished resolving the interaction, click the **Close** button in the interaction header.

Closing an interaction affects your capacity because a new interaction will be pushed to your inbox.

**Manage Walk-up Experience interactions manually**

Technicians supporting walk-up locations can manually manage queue requests with several Walk-up Experience interaction-related modules.

Role required: **sn_walkup.walkup_technician**

Manage interactions manually using the Walk-up Experience Technician modules found in the application navigator. To manage automatically assigned interactions from the Agent Workspace inbox, refer to **Manage automatically assigned Walk-up Experience interactions**.

Walk-up queues support guests in the order that they check into the queue — first come, first served. Technicians supporting the queue can decide who will work the first interaction. As new guests enter the queue and submit interactions, technicians share the workload, assigning queued interactions to themselves.

Certain guests are considered VIPs. The system recognizes this when they check into the queue. An interaction for a VIP shows **true** for **VIP** in the Interactions list. Technicians can move VIP guests to the front of the queue by assisting them first.

View walk-up queue interactions using several Walk-up Experience modules:

**Walk-up Experience interaction modules**

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Assigned Walk-ups</td>
<td>Interactions you assign to yourself when you accept an active interaction or that are assigned to you.</td>
</tr>
<tr>
<td></td>
<td>Agents assign interactions to themselves when they accept a queued interaction. Managers can assign interactions to specific agents.</td>
</tr>
<tr>
<td></td>
<td>These interactions are in a Work in Progress state. Once assigned, an agent can transfer the interaction to another agent or queue to complete the work, if necessary.</td>
</tr>
<tr>
<td>Module</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open — Unassigned</td>
<td>All open but unassigned interactions associated with your specific walk-up queue location. When a guest checks into a walk-up queue, an interaction is created. The interaction is Queued until an agent accepts it or is assigned the interaction. At that point, the state changes to Work in Progress.</td>
</tr>
<tr>
<td>Closed Walk-ups</td>
<td>All Closed Complete and Closed Abandoned interactions assigned to a specific walk-up location queue. Agents can abandon an interaction when a guest leaves the queue before receiving support.</td>
</tr>
</tbody>
</table>

1. To begin supporting a walk-up queue guest, navigate to > Walk-up Experience > > Technician > Opened - Unassigned. The Interactions list opens.
2. Find the guest name under the Opened for column of the Interactions list.
3. Click the interaction Number associated with the guest. The Walk-up Interaction form opens with details about the issue or request.
4. Enter your name in the Assigned to field on the form, change the State to Work in Progress, and click Update.
   a) To close an interaction if the guest has left the queue, click Abandon in the form header or choose Closed Abandoned from the State form field and click Update
   b) Alternatively, you can associate the interaction with another record by clicking the Associate Record button in the interaction header.
5. To resolve the interaction, navigate to Walk-up Experience > Technician > My Assigned Walk-ups.
6. Click the interaction number from the list to open the Walk-up Interaction form.
7. Resolve the issue or fulfill the request.
   a) Change the interaction status to On Hold if the requester is not present for an appointment or if the interaction entails a lengthy process, for example, an OS upgrade.
   b) To view the walk-up location stockroom for fulfillment requests, click the Stockroom Consumables related link.
   c) If you cannot resolve the issue or fulfill the request, click either the Create Incident or Create Request related link to create an incident or access the Service Catalog.

When you create an associated incident or request through the Service Catalog, the associated related lists on the form populate accordingly. Related lists include the following details:

- Incidents for Interaction: Incidents associated with the interaction
- Requests for Interaction: Service Catalog requests associated with the interaction
- Incidents by Same Caller: Incidents created for a walk-up guest
- Requests by Same Caller: Requests created for a walk-up guest
8. When you are finished resolving the interaction, change the interaction State to Closed Complete and click Update to update the interaction. Alternatively, you can click Close to complete the interaction.

View Walk-up Experience location stockroom and assets

Technicians supporting Walk-up Experience locations can view and access stockrooms to provide commonly requested hardware and software assets for walk-up queue guests. Stockroom inventory is defined by asset and inventory managers. Walk-up location agents can monitor inventory and alert asset and inventory managers when additional consumables are needed.

Role required: sn_walkup.walkup_technician

There are two ways technicians can view associated walk-up location stockrooms. Technicians primarily access Agent Workspace for all Walk-up Experience related information, including stockroom information and assets. However technicians can also access Walk-up Experience in the application navigator, or left navigation bar, to view stockrooms.

1. To view walk-up stockrooms using Agent Workspace, navigate to Workspace Experience > Agent Workspace Home.
   The Agent Workspace homepage opens, greeting you with your name.
2. Click List in the left navigation bar.
3. Under Walk-up, click My Stockrooms.
   Walk-up stockrooms associated with your assigned queue are listed.
4. Click the name of your stockroom to view details about the stockroom, such as the physical address, the group assigned to the stockroom, and the available assets (hardware, consumables, and software licenses).
5. Alternatively, to view walk-up locations via the application navigator, navigate to Walk-up Experience > Technician > My Walk-up Stockrooms.
6. Click the name of your stockroom.
   The associated stockroom form opens displaying information about the stockroom, such as the physical address, the group assigned to the stockroom, and the available assets (hardware, consumables, and software licenses).
7. In either Agent Workspace or via the application navigator, click any of the list tabs to see available inventory. For example, you can click the Consumables tab to see a list of all available consumables. Inventory list tabs include:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware</td>
<td>Cables, connectors, batteries, and more.</td>
</tr>
<tr>
<td>Consumables</td>
<td>Computer monitors, video equipment, tablets, laptops, computer mouse, and more.</td>
</tr>
<tr>
<td>Software Licenses</td>
<td>Available software programs and tools.</td>
</tr>
<tr>
<td>Other Assets</td>
<td>Miscellaneous other assets.</td>
</tr>
</tbody>
</table>

8. Click the name of an available consumable.
   The Consumable form opens displaying details about the asset, such as, Quantity (how many are stocked), cost, and Expense Line information.

Use platform view to fulfill a Walk-up Experience request from a stockroom

Walk-up Experience technicians can access an associated stockroom and fulfill user requests directly from an interaction in platform view.

Role required: sn_walkup.walkup_technician
When a walk-up queue guest requests a consumable, such as a computer monitor or keyboard, you can quickly fulfill the request by accessing an associated on-site stockroom. Walk-up guests leave the queue with the requested item in hand.

For details regarding fulfilling a Walk-up Experience request from a stockroom using Agent Workspace, refer to

1. Navigate to  > Technician > My Assigned Walk-ups.  
   The Interaction list opens.
2. Click the interaction Number associated with the request.  
   The Walk-up Interaction form opens with details about the request.
3. Click Stockroom Consumables in the Related Links section of the interaction.  
   The associated Stockroom list opens displaying all available consumables.
4. Click the requested consumable Display name.  
   The Consumable form opens with details about the item.
5. Click the Consume button.  
   The Consume pop-up form opens with the name of the consumable and the associated stockroom.
6. Update the form with the Quantity, Asset, and User information.
7. Click OK.  
   The Consumable form indicates that an item has been consumed and attached to the specified user.
8. Retrieve the item from the stockroom and provide it to the requester.
9. Return to the interaction in your My Assigned Walk-ups module to change the State to Closed Complete and click Update to update the interaction. Alternatively, you can click Close to complete the interaction.

If you cannot fulfill the request from the associated stockroom, click the Create Request related link from the interaction form to access the Service Catalog. Refer to Create a request through a catalog to order an item for the requester.

**Use Agent Assist to expedite Walk-up Experience fulfillment**

Walk-up Experience technicians can use the Agent Assist feature in Agent Workspace to expedite incidents and requests.

Role required: sn_walkup.walkup_technician

Agent Assist is a contextual search option available in Agent Workspace when a technician creates a new incident or new case associated with a Walk-up Experience interaction.

1. To use Agent Assist navigate to Workspace Experience > Agent Workspace Home.
2. Open a walk-up interaction from your inbox or from My Assigned Walk-ups under Lists that you know requires an associated new incident or new case.
3. Click the Create Incident or Create Case button.  
   A new incident or case tab opens next to the details tab for the original associated walk-up interaction.
4. Click the agent assist icon to use the feature.

For more detailed information about Agent Assist and using it to expedite incidents and requests, refer to Finding solutions using Agent Assist and Order a catalog item for a requester.
View and manage Walk-up Experience appointments in Agent Workspace

Viewing upcoming scheduled Walk-up Experience appointments provides technicians with an estimate of future queue demand and workload. Managers can view future appointments and adjust staffing at walk-up queue locations to best support demand.

Role required: sn_walkup.walkup_technician

Technicians and managers primarily use Agent Workspace for all Walk-up Experience related information, including viewing and managing scheduled appointments.

**Note:** You can also view and manage scheduled appointments from Walk-up Experience in the application navigator, or left navigation bar.

Appointments are automatically routed to your Agent Workspace inbox based on availability. You can also view a list of scheduled appointments and choose which one to accept.

Upcoming appointments also display with a small calendar icon next to the user name on the onsite walk-up location queue wall monitor. The user with an appointment appears on the monitor a short time before the appointment is scheduled to begin.

**Note:** Upcoming appointments are also displayed on online check-in screen with the same calendar icon next to the user name.

1. **Navigate to Workspace Experience > Agent Workspace Home.**
   The Agent Workspace homepage opens, greeting you with your name.
2. **Click List in the left navigation bar.**
3. **Under Walk-up, click Appointments.**
   Walk-up appointments assigned to your queue are listed.
4. **Click an appointment number to view details, such as the requester name, the interaction number and description, and the appointment time.**
   a) To open the associated interaction to view details, click the open record icon next to the interaction number.
   b) **Click Accept appointment** to begin working on the interaction.
      If necessary, you can assign the appointment to another agent and add work notes.
      If a significant amount of time has passed and the requester does not show up for the appointment, you can delete the appointment by clicking the more UI actions icon in the interaction header and choosing Delete.
   c) **Click Save** to save any changes you make to the appointment interaction.

View and manage Walk-up Experience appointments from application navigator

Viewing upcoming scheduled Walk-up Experience appointments provides technicians with an estimate of future queue demand and workload. Managers can view future appointments and adjust staffing at walk-up queue locations to best support demand.

Role required: sn_walkup.walkup_technician
Technicians and managers can view and manage scheduled walk-up appointments from Walk-up Experience in the application navigator, or left navigation bar.

Note: Primary access is through Agent Workspace for all Walk-up Experience related information, including scheduled appointments.

Upcoming appointments also display with a small calendar icon next to the user name on the onsite walk-up location queue wall monitor. The user with an appointment appears on the monitor a short time before the appointment is scheduled to begin.

1. Navigate to **Walk-up Experience > Technician > Scheduled Appointments**.
   - all walk-up appointments scheduled for the upcoming 14 days display.
2. Click an appointment number to view details, such as the requester name, the interaction number and description, and the appointment time.
   a) If desired, to preview the associated interaction details, click the preview record icon next to the appointment number.
   b) To begin working on the interaction, click **Accept appointment** on the **Walk-up Appointment** form.
      - If necessary, you can assign the appointment to an agent and add work notes.
      - If a significant amount of time has passed and the requester does not show up for the appointment, you can delete the appointment by clicking **delete**.
   c) Click **Update** to save any changes you make to the interaction form.

Walk-up Experience dashboard overview

The Walk-up Experience dashboard and reporting module provides basic high-level reporting on incident and request types, record volume, average wait and service times, assignments by technician and location, and more. By viewing the dashboard, IT managers can quickly understand the walk-up location operations and can report performance data to upper management.

To view the Walk-up Experience dashboard you must be assigned one of the following roles:

- sn_walkup.walkup_manager
- sn_walkup.walkup_admin
- admin

Access the dashboard by navigating to **Walk-up Experience > Dashboard**. To view detailed information, hover over any report graphic. You can save graphs as PNG or JPEG files to attach to emails or include in reporting presentations. All graphs can be refreshed for the latest data.

<table>
<thead>
<tr>
<th>Dashboard report graphic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed Walk-ups for the Quarter</td>
<td>Total number of records created during the fiscal business quarter. Volume shown as a single score.</td>
</tr>
<tr>
<td>Exit Survey CSAT for this Year</td>
<td>Speedometer showing the average customer satisfaction sentiment (1 to 3) during the exit survey for the current calendar year.</td>
</tr>
<tr>
<td>Dashboard report graphic</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Overall CSAT within Last Year</td>
<td>Speedometer showing the average customer satisfaction sentiment (1 to 5) captured by the email survey within the last year (364 days from current date).</td>
</tr>
<tr>
<td>Walk-ups by Location within Last Year</td>
<td>Total number of walk-up interactions, by location within the last year (364 days from current date). Volume shown as a spline distributed by month.</td>
</tr>
<tr>
<td>Walk-up Interactions with Incidents by Location within Last Year</td>
<td>Total number of walk-up incidents, by location within the last year (364 days from current date). Volume shown as a spline distributed by month.</td>
</tr>
<tr>
<td>Walk-up Interactions with Requests by Location within Last Year</td>
<td>Total number of walk-up requests, by location within the last year (364 days from current date). Volume shown as a spline distributed by month.</td>
</tr>
<tr>
<td>Walk-up Reasons by Location within Last Year</td>
<td>Reasons for visiting the walk-up queue, by location within the last year (364 days from current date). Data shown as a bar chart.</td>
</tr>
<tr>
<td>Walk-ups by Day of the Week</td>
<td>Total number of walk-up interactions per day during the course of a week, by location. Data shown as a bar chart.</td>
</tr>
<tr>
<td>Walk-ups by Hour</td>
<td>Total number of walk-up interactions, by hour and by location. Data shown as a bar chart.</td>
</tr>
<tr>
<td>Walk-up Consumables</td>
<td>Total number of assets consumed by walk-up guests, by location stockroom. Data shown as a bar chart.</td>
</tr>
<tr>
<td>Average Service Time by Location</td>
<td>Average time it takes to close an interaction, by location. Time average shown as a spline by month.</td>
</tr>
<tr>
<td>Average Wait Time by Location</td>
<td>Average time a walk-up guest waits for service, by location. Data shown as a bar chart.</td>
</tr>
</tbody>
</table>

For more information about viewing and using dashboards, see Analytics and Reporting Solutions.

**ITSM Agent Workspace**

Improve your ITSM agent experience and manage your IT fulfillment volume more efficiently using ITSM Agent Workspace. The easy-to-navigate, multi-tab interface enables you to efficiently oversee and resolve multiple incidents, problems, and change requests.

**ITSM Agent Workspace in action**

Here’s how IT agents use ITSM Agent Workspace.

**Key features**

**Data in unified location**
Interact with your requesters, respond to inquiries, and resolve incidents, problem, and change tasks using ITSM Agent Workspace.
<table>
<thead>
<tr>
<th>Number</th>
<th>Opened</th>
<th>Short Description</th>
<th>Caller</th>
<th>Priority</th>
<th>State</th>
<th>Cat</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC000002</td>
<td>2019-07-27 16:07:12</td>
<td>Network file shares access issue</td>
<td>Fred Luddy</td>
<td>1 - Critical</td>
<td>On Hold</td>
<td>Net</td>
</tr>
<tr>
<td>INC000003</td>
<td>2019-08-03 16:07:30</td>
<td>Wireless access is down in my area</td>
<td>Joe Employee</td>
<td>1 - Critical</td>
<td>In Progress</td>
<td>Net</td>
</tr>
<tr>
<td>INC000007</td>
<td>2019-08-12 16:08:24</td>
<td>Need access to sales DB for the West</td>
<td>Joe Employee</td>
<td>1 - Critical</td>
<td>On Hold</td>
<td>Dat</td>
</tr>
<tr>
<td>INC000015</td>
<td>2019-07-19 16:38:46</td>
<td>I can't launch my VPM client since the L...</td>
<td>Fred Luddy</td>
<td>1 - Critical</td>
<td>In Progress</td>
<td>Sof</td>
</tr>
<tr>
<td>INC000016</td>
<td>2019-07-14 16:40:23</td>
<td>Rain is leaking on main DNS Server</td>
<td>Bob Rugger</td>
<td>1 - Critical</td>
<td>In Progress</td>
<td>Har</td>
</tr>
<tr>
<td>INC000017</td>
<td>2019-08-12 16:41:00</td>
<td>How do I create a sub-folder</td>
<td>Joe Employee</td>
<td>1 - Critical</td>
<td>On Hold</td>
<td>Inq</td>
</tr>
<tr>
<td>INC000018</td>
<td>2019-07-20 16:42:46</td>
<td>Sales forecast spreadsheet is READ O...</td>
<td>Taylor Wiveland</td>
<td>1 - Critical</td>
<td>In Progress</td>
<td>Sof</td>
</tr>
<tr>
<td>INC000019</td>
<td>2019-07-22 16:44:39</td>
<td>Can't Launch 64-bit Windows 7 virtual...</td>
<td>Fred Luddy</td>
<td>2 - High</td>
<td>In Progress</td>
<td>Sof</td>
</tr>
<tr>
<td>INC000020</td>
<td>2019-08-01 16:51:35</td>
<td>I need a replacement iPhone, please</td>
<td>Fred Luddy</td>
<td>5 - Planning</td>
<td>In Progress</td>
<td>Inq</td>
</tr>
<tr>
<td>INC000021</td>
<td>2019-07-12 16:53:46</td>
<td>Need to add more memory to laptop</td>
<td>Don Goodliffe</td>
<td>1 - Critical</td>
<td>In Progress</td>
<td>Har</td>
</tr>
</tbody>
</table>

Showing 1-20 of 49

| 1 | 2 | 3 | ... | 20 |

rows per page
See all details related to an incident, problem, or change task in one place.
Agent assistance

Efficiently and quickly resolve tickets with AI-assisted recommendations.
Get started

Select a tile to get started.

- **EXPLORE**
  rect 4, 3, 169, 80
  Agents and system administrators go here to learn about Workspace.

- **SET UP**
  rect 1, 2, 164, 76
  System administrators go here to set up Workspace.

- **USE**
  rect 3, 4, 166, 79
  Agents go here to learn how to use Workspace.

Explore ITSM Agent Workspace

Get an overview of ITSM Agent Workspace and how it works.

Features

Manage multiple incident, problem, and change records using these ITSM Agent Workspace features.
I can't launch my VPN client since the last software update

Compose

Type your Comments here

Activity Stream

System Administrator

Agent Assist

I can't launch my VPN client since the last software update

Compose

Type your Comments here

Activity Stream

System Administrator

Agent Assist

I can't launch my VPN client since the last software update

Compose

Type your Comments here

Activity Stream

System Administrator

Agent Assist

I can't launch my VPN client since the last software update

Compose

Type your Comments here

Activity Stream

System Administrator

Agent Assist

I can't launch my VPN client since the last software update

Compose

Type your Comments here

Activity Stream

System Administrator

Agent Assist

I can't launch my VPN client since the last software update

Compose

Type your Comments here

Activity Stream

System Administrator

Agent Assist

I can't launch my VPN client since the last software update

Compose

Type your Comments here

Activity Stream

System Administrator

Agent Assist

I can't launch my VPN client since the last software update

Compose

Type your Comments here

Activity Stream

System Administrator

Agent Assist

I can't launch my VPN client since the last software update

Compose

Type your Comments here

Activity Stream

System Administrator

Agent Assist

I can't launch my VPN client since the last software update

Compose

Type your Comments here

Activity Stream

System Administrator

Agent Assist

I can't launch my VPN client since the last software update

Compose

Type your Comments here

Activity Stream

System Administrator
<table>
<thead>
<tr>
<th>Number</th>
<th>ITSM Agent Workspace feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1      | Multi-tab interface         | Tabs to easily navigate between multiple open records.  
  - Incident records open in top-level tabs.  
  - Associated records, such as problem and change, open in sub-tabs below the Incident tab. |
| 2      | Form header                 | Configurable fields in the form header to give you a quick summary of incident, problem, or change records. |
| 3      | Form fields                 | Detailed view of the form fields from the Details related list. |
| 4      | Activity stream             | Activity stream to display a chronological record of activities. The activity stream occupies a central location in the default layout, making it easy for agents to scroll through the record history. |
| 5      | Agent Assist                | List of information across multiple sources such as open incidents, problem, and change records. With Predictive Intelligence, agents can also view similar task records. |

**Components installed with ITSM Agent Workspace**

Several types of components are installed with activation of the ITSM Workspace (com.snc.agent_workspace.itsm) plugin, including user roles.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see *Find components installed with an application.*

**Roles installed**

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workspace agent (agent_workspace_user)</td>
<td>The Workspace agent role (agent_workspace_user) is added to the ITIL role. The role is required to access ITSM Agent Workspace.</td>
<td>None</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Tables

ITSM Agent Workspace provides the Workspace view for the following tables:

- Incident (incident)
- Problem (problem)
- Change (change)
- Problem Tasks (problem_task)
- Change Tasks (change_task)
- Affected CIs (task_ci)
- Impacted Services/CIs (task_cmdb_ci_service)
- Task SLA (task_sla)
- Outages (task_outage)
- Approvals (sysapproval_approver)

Viewing incident details and your incident tasks in ITSM Agent Workspace - Standard landing page

On the ITSM Agent Workspace standard landing page, you can view incident reports that provide information such as the number of open priority 1 incidents, incidents for which SLA is not met, or incidents that are in the verge of breaching the SLA, and any unassigned incidents in the system. You can also view all the tasks that are assigned to you.

The ITSM Workspace plugin (com.snc.agent_workspace.itsm) activates the ITSM Workspace Landing Pages (com.snc.agent_workspace.itsm.landing_page) plugin that delivers the basic version of ITSM Agent Workspace landing page.

To see the list of incidents for a queue, click a tile in the Happening Now section. To view the details of an incident, click the incident number. The My Work section contains the list of all the tasks that are assigned to you.
### Happening Now

<table>
<thead>
<tr>
<th>Open P1 Incidents</th>
<th>Incident SLA Breached</th>
<th>Incident SLA at Risk</th>
<th>Unassigned Incidents</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td>9</td>
<td>0</td>
<td>15</td>
</tr>
</tbody>
</table>

### My Work

<table>
<thead>
<tr>
<th>Number</th>
<th>Created</th>
<th>Priority</th>
<th>State</th>
<th>Short description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHG50000004</td>
<td>2017-09-01 01:03:09</td>
<td>4 - Low</td>
<td>Review</td>
<td>Upgrade to Oracle 11i</td>
</tr>
<tr>
<td>CHG50000006</td>
<td>2017-08-18 04:00:00</td>
<td>3 - Moderate</td>
<td>Scheduled</td>
<td>Put another 100 GB drive on the 2nd Floor Server</td>
</tr>
<tr>
<td>CHG50000007</td>
<td>2017-08-18 04:04:30</td>
<td>4 - Low</td>
<td>Authorise</td>
<td>R&amp;D wants to know what it'd cost to switch them over to Linux desktops</td>
</tr>
<tr>
<td>CHG50000008</td>
<td>2019-03-03 04:44:14</td>
<td>1 - Critical</td>
<td>Assess</td>
<td>Install new Cisco</td>
</tr>
<tr>
<td>ICT0011105</td>
<td>2018-03-14 04:38:21</td>
<td>4 - Low</td>
<td>Open</td>
<td>Technical Conference</td>
</tr>
<tr>
<td>ICT0011106</td>
<td>2018-03-14 04:38:21</td>
<td>4 - Low</td>
<td>Open</td>
<td>Initial Technical Communication</td>
</tr>
<tr>
<td>ICT0011109</td>
<td>2018-03-14 04:38:21</td>
<td>4 - Low</td>
<td>Open</td>
<td>Internal Stakeholder Conference</td>
</tr>
<tr>
<td>ICT0011110</td>
<td>2018-03-14 04:38:21</td>
<td>4 - Low</td>
<td>Open</td>
<td>Initial Stakeholder Communication</td>
</tr>
<tr>
<td>ICT0011113</td>
<td>2018-03-14 04:38:21</td>
<td>4 - Low</td>
<td>Open</td>
<td>Initial End User Communication</td>
</tr>
<tr>
<td>INC00000016</td>
<td>2019-07-08 03:11:58</td>
<td>1 - Critical</td>
<td>In-Progress</td>
<td>Rain is leaking on main DNS Server</td>
</tr>
</tbody>
</table>
Incident details on the ITSM Agent Workspace – Premium landing page

On the ITSM Agent Workspace Premium landing page, you can view incident reports and Performance Analytics information such as Mean Time To Resolution, First Call Resolution, and Customer Satisfaction.

You must activate the ITSM Workspace Landing Pages – Premium plugin (com.snc.agent_workspace.itsm.landing_page_premium) to access the information available on the premium landing page. For details, see Activate ITSM Workspace Landing Pages – Premium. The information available on this page are:

- List of all the tasks that are assigned to you in the My Work section.
- List of unassigned incidents in the system in the Unassigned Incidents section.

To display a list of incidents for a queue, click its tile in the Happening Now section. To view details of an incident, click an incident number.
<table>
<thead>
<tr>
<th>Number</th>
<th>Created</th>
<th>Priority</th>
<th>State</th>
<th>Short description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHG0000004</td>
<td>2017-09-01 21:01:06</td>
<td>Low</td>
<td>Review</td>
<td>Upgrade to Oracle 12c</td>
</tr>
<tr>
<td>CHG0000006</td>
<td>2017-08-18 04:07:59</td>
<td>Moderate</td>
<td>Scheduled</td>
<td>Put another 400-GB drive on the 2nd Floor...</td>
</tr>
<tr>
<td>CHG0000007</td>
<td>2017-08-10 04:14:30</td>
<td>Low</td>
<td>Authorize</td>
<td>R&amp;D wants to know what I'd cost to switch...</td>
</tr>
<tr>
<td>CHG0000008</td>
<td>2019-03-30 04:44:14</td>
<td>Critical</td>
<td>Assess</td>
<td>Install new Cisco</td>
</tr>
<tr>
<td>ICT001110</td>
<td>2018-03-14 10:39:21</td>
<td>Low</td>
<td>Open</td>
<td>Technical Conference</td>
</tr>
<tr>
<td>ICT001106</td>
<td>2018-03-14 10:38:21</td>
<td>Low</td>
<td>Open</td>
<td>Internal Technical Communication</td>
</tr>
<tr>
<td>ICT001110</td>
<td>2018-03-14 10:38:21</td>
<td>Low</td>
<td>Open</td>
<td>Internal Stakeholder Communication</td>
</tr>
<tr>
<td>ICT001111</td>
<td>2018-03-14 10:38:21</td>
<td>Low</td>
<td>Open</td>
<td>Initial End User Communication</td>
</tr>
<tr>
<td>INC0000016</td>
<td>2019-07-10 05:31:15</td>
<td>Critical</td>
<td>In Progress</td>
<td>Rain is leaking on main DNS Server</td>
</tr>
</tbody>
</table>

### Happening Now

<table>
<thead>
<tr>
<th>Open P1 Incidents</th>
<th>Incident SLA Breached</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td>9</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Incident Not Update in 24 Hours</th>
<th>Incident SLA at Risk</th>
</tr>
</thead>
<tbody>
<tr>
<td>75</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>My Incidents</th>
<th>Unassigned Incidents</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>15</td>
</tr>
</tbody>
</table>
The performance metrics at the organization level provide the following indicators:

- **Mean Time To Resolution**: The average time to resolve an incident.
- **First Call Resolution**: The ability of the service desk agent to resolve customer issues or questions by the first assigned group, with no reassignment required.
- **Customer Satisfaction**: How satisfied customers are with the service they have received.

### Setting up ITSM Agent Workspace

Set up ITSM Agent Workspace for your agents so they can engage with customers, answer questions, create task records, and resolve issues.

The ITSM Workspace (com.snc.agent_workspace.itsm) plugin provides you with the functionality of ITSM Agent Workspace. The plugin is available by default for new and existing customers.

### Activate ITSM Workspace Landing Pages – Premium

You can activate the ITSM Workspace Landing Pages – Premium plugin (com.snc.agent_workspace.itsm.landing_page_premium) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: agent_workspace_user or admin

The ITSM Workspace Landing Pages – Premium plugin (com.snc.agent_workspace.itsm.landing_page_premium) activates the related plugin if it is not already active.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Workspace (com.agent_workspace)</td>
<td>Provides a suite of tools that provide agents, case managers, help desk professionals, and managers with tools to help answer customer questions or resolve customer problems.</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/15" alt="Note" /></td>
<td>The Agent Workspace plugin activates the ITSM Workspace Landing Pages plugin (com.snc.agent_workspace.itsm.landing_page) that delivers the standard landing page for ITSM Agent Workspace.</td>
</tr>
<tr>
<td>Performance Analytics – Content Pack – ITSM Dashboards (com.snc.pa.itsm_dashboards)</td>
<td>Activation of this plugin on production instances may require a separate Performance Analytics license.</td>
</tr>
</tbody>
</table>

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.
Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Set the default landing page

You can set a default landing page to surface the information that is most relevant for your agents.

Role required: agent_workspace_user or admin

1. Navigate to Workspace Experience > Administration > All Workspaces.
2. Click Agent Workspace.
3. In the Landing Pages related list, set the value of the Order field of the landing page that you want to set as the default to minimum.

Note: The landing page with the minimum order value is considered to be the default landing page.

4. Optional: Verify the default landing page assignment by navigating to Workspace Experience > Workspaces > Agent Workspace Home. The default landing page opens.

Add field or related list to a workspace form

You can quickly add fields or related lists to a workspace form by configuring form layout or related lists from Platform.

Role required: agent_workspace_user or admin
2. Change the view of the task table to **Workspace**.

3. Open an incident record.

4. Optional: Click the settings icon and under System Settings, click **Developer**.

5. From the Application list, select ITSM Landing Pages or ITSM Landing Pages Premium depending on which form layout you want to update and close the window.

6. Perform any of the following actions:
<table>
<thead>
<tr>
<th>What do you want to do?</th>
<th>How do you do it?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add field</strong></td>
<td>Click the additional actions icon 📈 and select Configure &gt; Form Layout.</td>
</tr>
<tr>
<td><strong>Add related list</strong></td>
<td>Click the additional actions icon 📈 and select Configure &gt; Related Lists.</td>
</tr>
</tbody>
</table>

7. Move the required fields and related lists from the Available box to the Selected box.
8. Click Save.

**Create an interaction record in ITSM Agent Workspace**

Create an interaction record when you communicate with the user if you are not clear on the user requirements. You can create an incident or a request later from the interaction based on the use case.

Role required: workspace_agent or admin

- On clicking **Create Incident** from the Interaction record form, a new unsaved Incident opens that has the value of the caller and the short description copied from the Interaction record.
- On clicking **Create Problem** from the Interaction record form, a new unsaved Problem opens that has the value of the Problem statement copied from the Short description of the Interaction record. The Allow Problem creation from Interaction (glide.problem.interaction.allow_create) problem property available at Problems > Administration > Problem Properties determines whether the Create Problem option is shown on the interaction form.
- On clicking the **Create Standard Change**, you are directed to the New Catalog Item page. Select Standard Change from the menu.
- On clicking **Create Request**, you are directed to the New Catalog Item page from where you can create a new catalog request.

1. Navigate to Agent Workspace > Agent Workspace Home.
2. Click the plus icon (+) to open a new tab.
   The New Interaction page appears.
3. On the form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>(Auto-generated). Unique number to identify the interaction record.</td>
</tr>
<tr>
<td>Type</td>
<td>The communication channel using which the agent interacted with the user.</td>
</tr>
<tr>
<td>State</td>
<td>Different states through which the interaction proceeds for a resolution.</td>
</tr>
<tr>
<td>Opened for</td>
<td>The agent for whom the interaction is created.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The agent to work on the interaction.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Wait time</td>
<td>The duration from creation of the interaction to the time it is assigned to an agent.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the interaction.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Inscription about the work that you perform on the interaction record.</td>
</tr>
</tbody>
</table>

4. Click **Save**.
   An interaction record is created. The **User’s Calls** and the **User’s Task** related list are available on the interaction form.

   - **User’s Calls**: The **User’s Calls** related list displays historical calls between a requester and Service Desk agents. This feature is available to the users who has the Service Desk Call plugin (com.snc.service_desk_call) already activated.

   - **User’s Task**: When a requester contacts an agent through chat, phone call, request, or walk-in, the **User’s Task** related list shows the agent all of the other tasks (incident, problem, change request, request, and so on) that have been created for the requester. For example, if a requester calls about the status of a request that was made the previous day, the **User’s Task** related list shows the request. Workspace includes the other tasks in the **User’s Task** related list when the value for the **Opened for** field in the interaction record matches the:

     - **Caller** field in an incident record
     - **Opened by** field in a problem record
     - **Requested by** field in a change record
     - **Requested for** field in a Service Catalog record

---

Create an outage from a task record in ITSM Agent Workspace

You can create an outage from a task record such as incident, problem, or change, to track the down time of a configuration item.

Role required: agent_workspace_user or admin

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. Navigate to the task record type from which you want to create an outage.

<table>
<thead>
<tr>
<th>Task record</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>Click Incidents &gt; Open.</td>
</tr>
<tr>
<td>Problem</td>
<td>Click Problems &gt; Open.</td>
</tr>
</tbody>
</table>
3. Open the task record from which you want to create an outage.

4. Click the more actions icon (…) and then click **Create Outage**.

5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique number that identifies the outage.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the outage applies to.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the outage such as Degradation, Outage, and Planned Outage.</td>
</tr>
<tr>
<td>Begin</td>
<td>Date and time when the outage starts. To enter the current date and time, click the <strong>Begin Outage Now</strong> related link.</td>
</tr>
<tr>
<td>End</td>
<td>Date and time when the outage ends. When the outage ends, open the record and enter the date and time manually. To enter the current date and time, click the <strong>End Outage Now</strong> related link.</td>
</tr>
<tr>
<td>Duration</td>
<td>Duration of the outage in days and hours.</td>
</tr>
<tr>
<td>Task number</td>
<td>Parent task record number from which you have created the outage.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the outage.</td>
</tr>
</tbody>
</table>

6. Optional: If you want to attach a supporting document, click the attachment icon and select the file.

7. Click **Save**.

**Using ITSM Agent Workspace**

Use ITSM Agent Workspace to interact with customers, create and work on task records, and resolve issues.

**ITSM Agent Workspace - Incident**

The Incident workspace form is similar to the default platform Incident form. If you want to change the view of the incident workspace form, customize the workspace view from the Incident form. For details, see **Add field or related list to a workspace form**.
<table>
<thead>
<tr>
<th>Number</th>
<th>Opened</th>
<th>Description</th>
<th>Caller</th>
<th>Priority</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC001001</td>
<td>2019-07-26 02:22:28</td>
<td>test</td>
<td>Abel Tutor</td>
<td>5 - Planning</td>
<td>New</td>
</tr>
<tr>
<td>INC000001</td>
<td>2019-07-19 02:42:59</td>
<td>The USB port on my PC stopped w...</td>
<td>Beth Anghin</td>
<td>5 - Planning</td>
<td>Resolved</td>
</tr>
<tr>
<td>INC000005</td>
<td>2019-07-02 21:47:23</td>
<td>SAP Sales app is not accessible</td>
<td>Carol Cloughin</td>
<td>1 - Critical</td>
<td>In Progress</td>
</tr>
<tr>
<td>INC000046</td>
<td>2019-07-02 15:04:15</td>
<td>Can't access SPA software</td>
<td>Bud Richman</td>
<td>3 - Moderate</td>
<td>New</td>
</tr>
<tr>
<td>INC000050</td>
<td>2019-07-02 14:58:24</td>
<td>Can't access Exchange server - i...</td>
<td>Jerod Bennett</td>
<td>1 - Critical</td>
<td>In Progress</td>
</tr>
<tr>
<td>INC000049</td>
<td>2019-07-02 14:56:37</td>
<td>Network storage unavailable</td>
<td>Beth Anghin</td>
<td>2 - High</td>
<td>In Progress</td>
</tr>
<tr>
<td>INC000047</td>
<td>2019-07-02 13:33:18</td>
<td>Issue with email</td>
<td>Joe Employee</td>
<td>3 - Moderate</td>
<td>In Progress</td>
</tr>
<tr>
<td>INC000053</td>
<td>2019-07-02 13:49:46</td>
<td>The SAP HR application is not accessible</td>
<td>Margaret Grey</td>
<td>1 - Critical</td>
<td>In Progress</td>
</tr>
<tr>
<td>INC000092</td>
<td>2019-07-02 13:49:40</td>
<td>SAP Financial Accounting applicati...</td>
<td>Bud Richman</td>
<td>1 - Critical</td>
<td>In Progress</td>
</tr>
<tr>
<td>INC000051</td>
<td>2019-07-02 13:48:37</td>
<td>Manager can't access SAP Control...</td>
<td>Joe Employee</td>
<td>1 - Critical</td>
<td>In Progress</td>
</tr>
</tbody>
</table>

Showing 1-10 of 45
Create an incident in ITSM Agent Workspace

You can create an incident record to document a deviation from an expected standard of operation.

Role required: agent_workspace_user or admin

Incident records enable you to track the investigation, possible solutions, and resolution of a problem for a customer. If resolving the incident involves creating a problem, change, or service request, you can create the record directly from the incident record.

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the navigation list, click Incidents > Open.
3. Click New.
4. On the form, fill in the fields.

Incident form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>(Auto-generated). Unique number to identify the incident record.</td>
</tr>
<tr>
<td>Caller</td>
<td>User who contacted you with an issue. Begin typing the first name of the caller to select from a list of matching names, or click the lookup icon and select the user.</td>
</tr>
<tr>
<td>Category</td>
<td>Type of issue. After selecting a category, you can select a subcategory if applicable.</td>
</tr>
<tr>
<td>Subcategory</td>
<td>Subdivision of the category.</td>
</tr>
<tr>
<td>Service</td>
<td>Business service that is affected.</td>
</tr>
<tr>
<td>Service Offering</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. Service offering enables you to receive different features and their levels of performance for a given service.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item that is affected.</td>
</tr>
<tr>
<td>Contact type</td>
<td>Mode of communication taken by the user to create the incident.</td>
</tr>
<tr>
<td>State</td>
<td>Different states through which the incident proceeds during its life cycle.</td>
</tr>
<tr>
<td>Impact</td>
<td>The effect of an incident, problem, or change on the business processes.</td>
</tr>
<tr>
<td>Urgency</td>
<td>How long the resolution can be delayed until an incident, problem, or change has a significant business impact.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the task. Priority is based on impact and urgency.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group to work on this incident. If you do not provide a value, the incident is automatically assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user to work on this incident.</td>
</tr>
<tr>
<td>Note:</td>
<td>If the <strong>Assignment group</strong> changes, the <strong>Assigned to</strong> field is cleared.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the incident.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed explanation of the incident.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Watch list</td>
<td>Users who receive notifications about the incident when comments are added.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notifications about the incident when work notes are added.</td>
</tr>
<tr>
<td>Note:</td>
<td>The administrator must create an email notification for the work notes list.</td>
</tr>
<tr>
<td>Additional comments (Customer visible)</td>
<td>More information about the issue as needed. All users who can view incidents can also see additional comments.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about how to resolve the incident or steps taken to resolve it, if applicable.</td>
</tr>
<tr>
<td>Related Records</td>
<td></td>
</tr>
<tr>
<td>Parent Incident</td>
<td>Associated parent incident that makes the current incident a child incident.</td>
</tr>
<tr>
<td>Note:</td>
<td>When the parent incident is resolved, the child incident is also marked as resolved.</td>
</tr>
<tr>
<td>Problem</td>
<td>Any related problem record.</td>
</tr>
<tr>
<td>Change Request</td>
<td>Any related change request.</td>
</tr>
<tr>
<td>Caused by Change</td>
<td>Associated change request that prompted the creation of the incident.</td>
</tr>
<tr>
<td>Resolution Information</td>
<td></td>
</tr>
</tbody>
</table>
### Field Description

**Knowledge**  
Option for enabling a knowledge article to be created from this incident when the incident is closed.

**Note:** If you activate the KCS Integration for Incident Management plugin (com.snc.incident.knowledge), the check box is disabled and the Create Knowledge UI is available by clicking the more actions icon.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution code</td>
<td>The resolution code for the incident.</td>
</tr>
<tr>
<td>Resolution notes</td>
<td>How or why the incident was closed.</td>
</tr>
<tr>
<td>Resolved by</td>
<td>User who resolved the issue.</td>
</tr>
<tr>
<td>Resolved</td>
<td>Date and time when the incident was resolved.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

### Create an incident from an interaction

Create an incident record directly from an interaction when the customer reports events that result in interruption of one or more services.

Role required: agent_workspace_user or admin

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. Create an interaction record.  
   For more information, see **Create an interaction record in ITSM Agent Workspace**.
3. On the interaction page, click **Create Incident**.
4. On the form, fill the fields.

### Incident form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Auto-generated unique number to identify the incident record.</td>
</tr>
<tr>
<td>Caller</td>
<td>User who contacted you with an issue. Begin typing the first name of the caller to select from a list of matching names, or click the lookup icon ( ) and select the user.</td>
</tr>
<tr>
<td>Category</td>
<td>Type of issue. After selecting a category, you can select a subcategory if applicable.</td>
</tr>
<tr>
<td>Subcategory</td>
<td>Subdivision of the category.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service</td>
<td>Business service that is affected.</td>
</tr>
<tr>
<td>Service Offering</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. Service offering enables you to receive different features and their levels of performance for a given service.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item that is affected.</td>
</tr>
<tr>
<td>Contact type</td>
<td>Mode of communication taken by the user to create the incident.</td>
</tr>
<tr>
<td>State</td>
<td>Different states through which the incident proceeds during its life cycle.</td>
</tr>
<tr>
<td>Impact</td>
<td>The effect of an incident, problem, or change on the business processes.</td>
</tr>
<tr>
<td>Urgency</td>
<td>How long the resolution can be delayed until an incident, problem, or change has a significant business impact.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the task. Priority is based on impact and urgency.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group to work on this incident. If you do not provide a value, the incident is automatically assigned based on assignment rules.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user to work on this incident.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the incident.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed explanation of the incident.</td>
</tr>
<tr>
<td>Notes</td>
<td>Users who receive notifications about the incident when comments are added.</td>
</tr>
<tr>
<td>Watch list</td>
<td>Users who receive notifications about the incident when work notes are added.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notifications about the incident when work notes are added.</td>
</tr>
<tr>
<td>Additional comments</td>
<td>More information about the issue as needed. All users who can view incidents can also see additional comments.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about how to resolve the incident or steps taken to resolve it, if applicable.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Records</td>
<td></td>
</tr>
<tr>
<td>Parent Incident</td>
<td>Associated parent incident that makes the current incident a child incident.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When the parent incident is resolved, the child incident is also marked as resolved.</td>
</tr>
<tr>
<td>Problem</td>
<td>Any related problem record.</td>
</tr>
<tr>
<td>Change Request</td>
<td>Any related change request.</td>
</tr>
<tr>
<td>Caused by Change</td>
<td>Associated change request that prompted the creation of the incident.</td>
</tr>
<tr>
<td>Resolution Information</td>
<td></td>
</tr>
<tr>
<td>Knowledge</td>
<td>Option for enabling a knowledge article to be created from this incident when the incident is closed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you activate the KCS Integration for Incident Management plugin (com.snc.incident.knowledge), the check box is disabled and the Create Knowledge UI is available by clicking the more actions icon.</td>
</tr>
<tr>
<td>Resolution code</td>
<td>The resolution code for the incident.</td>
</tr>
<tr>
<td>Resolution notes</td>
<td>How or why the incident was closed.</td>
</tr>
<tr>
<td>Resolved by</td>
<td>User who resolved the issue.</td>
</tr>
<tr>
<td>Resolved</td>
<td>Date and time when the incident was resolved.</td>
</tr>
</tbody>
</table>

5. **Click Save.**

An incident is created and the interaction appears in the Interactions related list.

**Create an incident from a chat**

With ITSM Agent Workspace, you can accept and respond to customer chat requests and create incidents as needed.

Role required: agent_workspace_user or admin
Chat with customers and find out more about their issues. Jot down notes about both the customer and the issue in an interaction form. If it’s an easy fix, solve the issue directly from the interaction. If the issue requires more investigation, create an incident and assign it to an agent.

**Workflow: Create an incident from a chat**

1. Set your presence status so that you’re ready to accept chats.
   
   From your inbox, click **Status** and select **Available**.

2. Accept a chat from your inbox and respond to the customer.
   
   Click **Accept** on the chat card, review the information in the Active Chat panel, and type your response.

3. Ask questions and find out more about the issue.

4. Add information about the customer and issue to the interaction record.

5. Create an incident for this issue.
   
   Click **Create Incident** on the Interaction form to open a new incident with the details from the interaction.

**Resolve an incident using knowledge**

**Resolve an incident using knowledge**

Resolve an incident by searching for related knowledge and attaching a knowledge article.

Role required: agent_workspace_user or admin
When you are ready to work on an incident, select an incident from a list or from your inbox. Read the details in the activity stream to get an understanding of the issue. Use Agent Assist to search for related knowledge, select and preview an article, and then attach it to the incident.

**Workflow: Resolve an incident using knowledge**

1. Open an incident from a list or from your inbox.
2. Review the incident details in the activity stream.
3. Use Agent Assist to search for related knowledge.
4. Select and preview an article.
5. Click **Attach** and then **Attach Article** to attach the article to the incident.

The system attaches the knowledge article to the incident and adds the action to the activity stream.

From the ITSM Service Portal, the customer can see the knowledge article attached to the incident and can click the link to open the article in a new tab. If the article solves the issue, the customer can click **Close Incident** in the Actions widget.

**Create a knowledge article from an incident**

Create a knowledge article from an incident in ITSM Agent Workspace and capture the detailed information used to resolve an issue. Use the knowledge article for quick resolution of similar incidents.
Role required: agent_workspace_user or admin

Activate the KCS Integration for Incident Management plugin (com.snc.incident.knowledge).

You can create a knowledge article only when the incident is resolved and a knowledge article has not yet been created from the incident.

Workflow: Create knowledge article from an incident

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. From the list, click **Incidents > Resolved**.
3. Open the incident record from which you want to create a knowledge article.
4. Click the more actions icon (⋯) and then click **Create Knowledge**.
5. On the form, fill in the fields.

**Note:** If the KCS Integration for Incident Management (com.snc.incident.knowledge) plugin is active, then the fields listed in the CSM Table Map (csm_table_map) table are copied from the incident. If the plugin is not active, then the incident number from the parent incident is copied to the **Parent** field of the knowledge gap feedback task and the text from the **Short Description** is copied to the **Description** field.
### Incident KCS Article form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>(Auto-generated) Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Knowledge base in which the article is stored. The Incident KCS Article is stored in the (kb_template_incident_kcs_article) table.</td>
</tr>
<tr>
<td>Category</td>
<td>(Auto-generated) Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Date after which the knowledge article is deleted from the database. After this date, the article does not appear in the search result.</td>
</tr>
<tr>
<td>Version</td>
<td>(Auto-generated) Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Workflow</td>
<td>(Auto-generated) Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Source Task</td>
<td>(Auto-generated) Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Option to automatically download an attached article instead of opening the article, when you access an article.</td>
</tr>
<tr>
<td>Display attachments</td>
<td>Option to display attachments in the knowledge article. The attachments appear below the article text.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the knowledge article.</td>
</tr>
<tr>
<td>Issue</td>
<td>Information on the cause of the incident.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Method used to resolve the incident.</td>
</tr>
</tbody>
</table>

6. Optional: If you want to attach a supporting document, click the attachment icon and select the file.

7. Click **Save**. A knowledge article is created. The article record is listed in the Created Knowledge related list on the Incident form.

### Report a knowledge gap from an incident

Report a knowledge gap when you do not find any appropriate resolution documented for an incident. The knowledge gap record helps the team know to create a knowledge article for the incident.

Role required: agent_workspace_user or admin

If the KCS Integration for Incident Management (com.snc.incident.knowledge) plugin is active, then the fields to be copied from an incident to the knowledge gap feedback task are maintained in the CSM Table Map (csm_table_map) table. If the plugin is not active, the incident
number from the parent incident is copied to the **Parent** field of the knowledge gap feedback task and the text from the **Short Description** is copied to the **Description** field.

**Note:** Incident managers with the sn_km_ml.knowledge_curation_user role can use the Demand Insights for Incidents dashboard to identify which incidents have no or insufficient knowledge coverage. For more information, refer [Demand Insights for Incidents dashboard](#).

---

**Workflow: Report knowledge gap from an incident**

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. Open an incident record from which you want to create a record to report a knowledge gap.
3. Click the more actions icon (…) and then click **Report Knowledge Gap**.
   
   A knowledge gap feedback task record is created in a sub-tab.
4. On the form, fill in the fields.
5. Click **Save**.
   
   The knowledge gap feedback task is saved and added to the Knowledge Gaps related list.
Capture information on affected configuration items in ITSM Agent Workspace

Capture information on affected configuration items (CIs), with type as asset, in an incident to keep a record of the updated, repaired, swapped, or retired configuration items. By keeping track of the assets, you can tell where the assets are located, how they are used, and when changes were made to them. This information helps you to monitor and manage your company using a systematic approach.

Role required: itil or admin

Activate the Hardware Asset Management Professional plugin (com.sn_hamp).

If you are not the caller of the incident and have a CI value in the affected CIs list, it is mandatory to provide information on the CI before changing the state of the incident to Resolved.

You can enter CI information either from the Affected CIs related list. You need to manually add the Asset Action and the Swapped CI fields in the related list. To know how to add related lists, refer Add field or related list to a workspace form.

1. Navigate to Incident > Open.
2. Open an incident.
3. Navigate to the Affected CIs related list before resolving the incident.
4. Open the affected CI.
5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Action</td>
<td>Information on whether a CI is updated or repaired, swapped with another CI, or retired from the system. The options available are: No action, Update/Repair, Swap, and Retire.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you swap or retire a CI, the sn_hamp_asset.swap or sn_hamp_asset.retire events are generated respectively.</td>
</tr>
<tr>
<td>Swapped CI</td>
<td>Information on the new CI that is swapped with the existing CI.</td>
</tr>
<tr>
<td>Note:</td>
<td>- This field appears only when you select the value of the Asset Action field as Swap.</td>
</tr>
<tr>
<td></td>
<td>- The CI values available for swapped CI are the ones with asset CI class as hardware.</td>
</tr>
</tbody>
</table>

6. Click Save.
The record is saved and the information about CI is stored in the (task_ci) table.
Create a copy of an incident in ITSM Agent Workspace

You can create a copy of an incident to avoid having to manually enter the value of all the fields in the new incident.

Role required: agent_workspace_user or admin

Users with the agent_workspace_user role can copy any incident but users without any role can copy only the incidents that they created. Fields and related lists are copied from the parent incident to the new incident based on the incident property settings.

**Note:** Affected CIs (task_ci) and Impacted Services (task_cmdb_ci_service) are available by default in the related list. You cannot add any other table in this field but you can remove any of the default values.

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the list, click Incidents > Open.
3. Open the incident record that you want to copy.
4. Click the more actions icon (…) and select Copy Incident.
5. In the Copy Incident dialog box, enter the name of the caller for whom you are creating the copied incident.
6. Click OK.

A new incident is created and saved. The following message appears in the activity stream:

This incident is copied from INCXXXXXXX.

Propose an incident to be a major incident from a workspace

Proposing an incident as a major incident sends the request to the major incident manager to analyze the incident and accept or reject it as a major incident. Major incidents have a separate procedure with shorter timescales and urgency that is required to accelerate resolution process for incidents with high business impact.

Role required: agent_workspace_user or admin

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. In the menu, click Incidents > Open.
3. Open the incident record that you want to propose as a major incident.
4. Click the more actions icon (…) and then click Propose Major Incident.
5. In the Work notes field in the Propose Major Incident dialog box, provide information about the business impact that supports classifying this incident as a major incident and click Propose.

The major incident state changes to Proposed and the message INCXXXXXXX has been proposed as a major incident candidate is displayed.

Report a knowledge gap from an incident

Report a knowledge gap when you do not find any documented appropriate resolution documented for an incident. The knowledge gap record helps the team know to create a knowledge article for the incident.
Role required: agent_workspace_user or admin

If the KCS Integration for Incident Management (com.snc.incident.knowledge) plugin is active, then the fields to be copied from an incident to the knowledge gap feedback task are maintained in the CSM Table Map (csm_table_map) table. If the plugin is not active, the incident number from the parent incident is copied to the Parent field of the knowledge gap feedback task and the text from the Short Description is copied to the Description field.

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the list, click Incidents > Open.
3. Open the incident record from which you want to create a record to report a knowledge gap.

Click the more actions icon (…) and then click Report Knowledge Gap.
A knowledge gap feedback task record is created in a sub-tab.

5. On the form, fill in the fields.
6. Click Save.

The knowledge gap feedback task is saved and added to the Knowledge Gaps related list.

Create a problem record from an incident

When the cause of an incident is an error or widespread issue, you can create a problem record to track the root cause of the issue.

Role required: agent_workspace_user or admin

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the list, click Incidents > Open.
3. Open the incident record from which you want to create a problem record.

Click the more actions icon (…) and then click Create Problem.

5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>(Auto-generated) Unique number to identify the problem record.</td>
</tr>
<tr>
<td>First reported by</td>
<td>Task that first identified the problem. In this case, it is the incident number from which it is being created.</td>
</tr>
<tr>
<td>Category</td>
<td>Group to which the problem belongs, such as software or hardware. After selecting the category, select the subcategory, if applicable.</td>
</tr>
<tr>
<td>Service</td>
<td>Business service that is affected.</td>
</tr>
<tr>
<td>Service Offerings</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. You can choose to receive different levels of performance and features for a given service through service offerings.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>Configuration item that is affected. The CI class of the selected configuration item identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
<tr>
<td>State</td>
<td>For customers prior to the Madrid release, the available states are: Open, Pending Change, Known Error, and Closed or Resolved.</td>
</tr>
<tr>
<td></td>
<td>For customers starting with the Madrid release, the new state model is applied and the State field is read only. The field value changes as the problem proceeds from one state to another state. The states available are: New, Assess, Root Cause Analysis, Fix in Progress, Resolved, and Closed.</td>
</tr>
<tr>
<td>Impact</td>
<td>Effect that the problem has on business.</td>
</tr>
<tr>
<td>Urgency</td>
<td>Extent to which the problem resolution can bear delay.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the problem.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group to which the problem is assigned. If you don’t supply a value, the problem is automatically assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Problem coordinator that the problem is assigned to. If an assignment rule applies, the problem is automatically assigned to the appropriate user or group.</td>
</tr>
<tr>
<td>Problem statement</td>
<td>Brief description of the problem.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the problem.</td>
</tr>
<tr>
<td>Notes section</td>
<td>Work notes list Users who receive notifications about the problem when work notes are added.</td>
</tr>
<tr>
<td></td>
<td>Users who receive notifications about the problem when work notes are added.</td>
</tr>
</tbody>
</table>

Note: To access the new state management process, activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.

Note: The Priority field is read-only and is set according to the Impact and Urgency values.

Note: The administrator must create an email notification for the work notes list. For more information, see Create an email notification.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work notes</td>
<td>Information about the work that you perform on the problem.</td>
</tr>
<tr>
<td>Analysis Information section</td>
<td></td>
</tr>
<tr>
<td>Workaround</td>
<td>Method used to temporarily solve the problem until it is resolved.</td>
</tr>
<tr>
<td></td>
<td>If a workaround is available, the problem coordinator can click the <strong>Communicate Workaround</strong> action to notify the related incidents. For more information, see <a href="#">Synchronization between incident and problem records</a>.</td>
</tr>
<tr>
<td>Cause notes</td>
<td>Description of what caused the problem.</td>
</tr>
<tr>
<td>Resolution Information section</td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>Date and time when the incident was resolved.</td>
</tr>
<tr>
<td>Resolved by</td>
<td>User who resolved the issue.</td>
</tr>
<tr>
<td>Fix notes</td>
<td>Information on how fixed the problem was fixed.</td>
</tr>
<tr>
<td>Other Information section</td>
<td></td>
</tr>
<tr>
<td>Opened</td>
<td>(Auto-generated) The user who opened the problem.</td>
</tr>
<tr>
<td>Opened by</td>
<td>(Auto-generated) Date and time when the user opened the problem.</td>
</tr>
<tr>
<td>Confirmed</td>
<td>(Auto-generated) User who confirmed the problem.</td>
</tr>
<tr>
<td>Confirmed by</td>
<td>(Auto-generated) Date and time the user confirmed the problem.</td>
</tr>
</tbody>
</table>

6. Optional: If you want to attach a supporting document, click the attachment icon and select the file.

7. Click **Save**.

**Create a change request from an incident**

If the cause of an incident requires a change to your infrastructure or a business service, you can create a change request from the incident as part of fixing the problem.

Role required: agent_workspace_user or admin

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. From the list, click **Incidents > Open**.
3. Open the incident record from which you want to create a change.
4. Click the more actions icon ( ) and click Create Change Request.

5. In the Create Change Request dialog box, select the type of change.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Any service change that is not a standard change or an emergency change.</td>
</tr>
<tr>
<td>Standard</td>
<td>A pre-authorized change that is low risk, relatively common, and follows a</td>
</tr>
<tr>
<td></td>
<td>specified procedure or work instruction.</td>
</tr>
<tr>
<td>Emergency</td>
<td>An emergency change that bypasses group and peer review and approval, and</td>
</tr>
<tr>
<td></td>
<td>goes straight to the authorization state for approval by the CAB approval</td>
</tr>
<tr>
<td></td>
<td>group.</td>
</tr>
</tbody>
</table>

6. Click Create.

7. Creating the change record.

   For more information, see Create a change task.

8. Click Save.

   The change record appears under the Change Requests related list.

Create a knowledge article from an incident in ITSM Agent Workspace

You can create a knowledge article from an incident in Agent Workspace to capture the troubleshooting steps and other detailed information used to resolve an issue for faster resolution of similar incidents.

Role required: agent_workspace_user or admin

Activate the KCS Integration for Incident Management plugin (com.snc.incident.knowledge)

You can create a knowledge article only when the incident is resolved and you have not already created a knowledge article from that incident.

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the list, click Incidents > Resolved.
3. Open the incident record from which you want to create a knowledge article.
4. Click the more actions icon ( ) and then click Create Knowledge.
5. On the form, fill in the fields.

   **Note:** If the KCS Integration for Incident Management (com.snc.incident.knowledge) plugin is active, then the fields listed in the CSM Table Map (csm_table_map) table are copied from the incident. If the plugin is not active, then the incident number from the parent incident is copied to the Parent field of the knowledge gap feedback task and the text from the Short Description is copied to the Description field.

   **Incident KCS Article form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>(Auto-generated) Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Knowledge base in which the article is stored. The Incident KCS Article is stored in the (kb_template_incident_kcs_article) table.</td>
</tr>
<tr>
<td>Category</td>
<td>(Auto-generated) Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Date after which the knowledge article is deleted from the database. After this date, the article does not appear in the search result.</td>
</tr>
<tr>
<td>Confidence</td>
<td>Maturity of an article based on its completeness and reusability.</td>
</tr>
<tr>
<td>Version</td>
<td>(Auto-generated) Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Workflow</td>
<td>(Auto-generated) Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Source Task</td>
<td>(Auto-generated) Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Option to automatically download an attached article instead of opening the article, when you access an article.</td>
</tr>
<tr>
<td>Display attachments</td>
<td>Option to display attachments in the knowledge article. The attachments appear below the article text.</td>
</tr>
<tr>
<td>Governance</td>
<td>An attribute of an article that allows you to control sensitive, critical, or regulated information. Not all articles have the same requirement for compliance reviews. Some articles are based on the collective experience of those who use the articles (experience-based). Other articles have policy or legal information that require tight control (compliance-based).</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the knowledge article.</td>
</tr>
<tr>
<td>Issue</td>
<td>Information on the cause of the incident.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Method used to resolve the incident.</td>
</tr>
</tbody>
</table>

**Note:** The **Confidence** and **Governance** fields appear when the Knowledge Management KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities) is activated. For more information, see *Managing the KCS article state.*

6. Optional: If you want to attach a supporting document, click the attachment icon ![attachment icon](image) and select the file.

7. Click **Save**.
A knowledge article is created. The article record is listed in the Created Knowledge related list on the Incident form.

Create an improvement initiative from an incident

Create an improvement initiative from an incident to track and manage tasks for improving a service or process, or tasks related to the incident.

Role required: agent_workspace_user, itil, or admin

- The Continual Improvement Management (com.sn_cim) plugin must be activated. For more information on activating the plugin, see Request Continual Improvement Management.
- The administrator must add the Improvement Initiatives related list to the incident form in Workspace view.

An improvement initiative contains goals to measure success, and phases that contain tasks with specific actions to complete the improvement. For more information, see Continual Improvement Management overview.

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the list, click Incidents > All.
3. Open the incident for which you want to create an improvement initiative.
4. Click the Improvement Initiative related list.
5. Click New.
6. In the Improvement Initiative field, click the search icon to find the appropriate initiative.
7. Associate an existing initiative or create a new one.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you find an existing initiative</td>
<td>Select the initiative to associate with this incident.</td>
</tr>
<tr>
<td>If you do not find an initiative</td>
<td></td>
</tr>
<tr>
<td>1.</td>
<td>Click the Create Improvement Initiative related link.</td>
</tr>
<tr>
<td>2.</td>
<td>Create an initiative by filling in the Improvement Initiative form. For more information, see Create an improvement request.</td>
</tr>
</tbody>
</table>

8. Optional: If you want to attach a supporting document, click Browse and select the file.
9. Click Save.

The improvement initiative is now associated with the incident.

Delete an incident

If you no longer need incident information, you can delete the incident. This action deletes the incident both from the ServiceNow database and from the Incident (incident) table.

Role required: agent_workspace_user or admin

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the list, click Incidents > Open.
3. Open the incident record that you want to delete.
4. Click the more actions icon and then click Delete.
5. In the Confirmation dialog box, click OK.

**ITSM Agent Workspace - Problem**

The Problem workspace form is similar to the default platform Problem form. All fields that are available on the Problem form are available on the problem workspace form. However, on the problem workspace form, the **State** field is read-only.

**Note:** Currently, Agent Workspace supports only the creation and minor update of a Problem record such as updating the short description, description, and work notes.
<table>
<thead>
<tr>
<th>Number</th>
<th>Problem statement</th>
<th>State</th>
<th>Resolution code</th>
<th>Assignment group</th>
<th>Assigned to</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRB0007001</td>
<td>Unable to send or receive emails.</td>
<td>New</td>
<td></td>
<td>(empty)</td>
<td>Problem Coordinator</td>
</tr>
<tr>
<td>PRB0001002</td>
<td>Unable to connect to WiFi</td>
<td>Assess</td>
<td></td>
<td>(empty)</td>
<td>Problem Coordinator</td>
</tr>
<tr>
<td>PRB0001001</td>
<td>Issue in connecting to internet using...</td>
<td>New</td>
<td></td>
<td>(empty)</td>
<td>Problem Coordinator</td>
</tr>
<tr>
<td>PRB0001000</td>
<td>Unable to connect to the VPN</td>
<td>New</td>
<td></td>
<td>(empty)</td>
<td>System Administrator</td>
</tr>
<tr>
<td>PRB0001006</td>
<td>The Webex application is unavailable...</td>
<td>Root Cause Analysis</td>
<td></td>
<td>(empty)</td>
<td>Problem Manager</td>
</tr>
<tr>
<td>PRB0000014</td>
<td>My laptop is performing very badly</td>
<td>Resolved</td>
<td>Fix Applied</td>
<td>(empty)</td>
<td>Problem Coordinator</td>
</tr>
<tr>
<td>PRB0000012</td>
<td>Cannot disable wireless when plug in...</td>
<td>Assess</td>
<td></td>
<td></td>
<td>Problem Coordinator</td>
</tr>
<tr>
<td>PRB0000011</td>
<td>Unknown source of SAP outage</td>
<td>Root Cause Analysis</td>
<td></td>
<td></td>
<td>Problem Manager</td>
</tr>
<tr>
<td>PRB0000010</td>
<td>Oracle Down</td>
<td>Assess</td>
<td></td>
<td></td>
<td>Problem Coordinator</td>
</tr>
<tr>
<td>PRB0000008</td>
<td>Hang when trying to print VISIO do...</td>
<td>Assess</td>
<td></td>
<td></td>
<td>Problem Coordinator</td>
</tr>
</tbody>
</table>

Showing 1-10 of 16
Create and track a problem in workspace

When you have recurring incidents or a major incident, you can create a problem to identify the root cause of the incidents and help prevent them from happening again.

Role required: agent_workspace_user, problem_coordinator, or admin

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the Lists menu, select Problems > Open.
3. Click New.
4. On the form, fill in the fields.

Create New Problem form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>(Auto-generated). Unique number that identifies the problem record.</td>
</tr>
<tr>
<td>First reported by</td>
<td>Task that first identified this problem.</td>
</tr>
<tr>
<td>Category and Subcategory</td>
<td>Group to which the problem belongs, such as software or hardware. After selecting the category, select the subcategory, if applicable.</td>
</tr>
<tr>
<td>Service</td>
<td>Business service, such as email or IT Services, that the problem applies to.</td>
</tr>
<tr>
<td>Service Offering</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. Service offering enables you to receive different features and their levels of performance for a given service.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the problem applies to. The CI class of the selected configuration item identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
</tbody>
</table>

Note: Activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>For customers prior to the Madrid release, the available states are: <strong>Open</strong>, <strong>Pending Change</strong>, <strong>Known Error</strong>, and <strong>Closed</strong> or <strong>Resolved</strong>. For customers starting with the Madrid release, the new state model is applied and the State field is read only. The field value changes as the problem proceeds from one state to another state. The states available are: <strong>New</strong>, <strong>Assess</strong>, <strong>Root Cause Analysis</strong>, <strong>Fix in Progress</strong>, <strong>Resolved</strong>, and <strong>Closed</strong>.</td>
</tr>
<tr>
<td>Impact</td>
<td>Effect that the problem has on business operations.</td>
</tr>
<tr>
<td>Urgency</td>
<td>Extent to which the problem resolution can bear delay.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the problem. The Priority field is automatically set to the Impact and Urgency values.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group to which the problem is assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Problem coordinator to whom the problem is assigned. If an assignment rule applies, the problem is automatically assigned to the appropriate user or group.</td>
</tr>
<tr>
<td>Problem statement</td>
<td>Brief description of the problem.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the problem.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notification when work notes are added to the problem.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Informative notes about the work performed on the problem.</td>
</tr>
<tr>
<td>Analysis Information</td>
<td></td>
</tr>
<tr>
<td>Workaround</td>
<td>Method used to overcome the issue if no resolution is available yet.</td>
</tr>
<tr>
<td>Cause notes</td>
<td>The cause of the problem.</td>
</tr>
<tr>
<td>Auto-generated information</td>
<td></td>
</tr>
</tbody>
</table>
Create a problem from an interaction

You can create a problem record directly from an interaction when the customer contacts regarding an issue and you need to investigate the cause of the issue.

Role required: agent_workspace_user or admin

- Select the Allow Problem creation from Interaction (glide.problem.interaction.allow_create) problem property from Problem > Problem Properties.

**Note:** Users who used to create problem record from the New Call feature of the Service Desk Call (com.snc.service_desk_call) plugin, can now create problems from Interaction. Starting the Orlando release, the Service Desk Call (com.snc.service_desk_call) plugin is a maintenance plugin and the user cannot activate the plugin.

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. Create an interaction record.
   For more information, see Create an interaction record in ITSM Agent Workspace.
3. On the interaction page, click the more actions icon

   ![More Actions Icon](image)

   and then select Create Problem.
4. On the form, fill in the fields.
### Problem form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>(Auto-generated). Number that identifies the problem record.</td>
</tr>
<tr>
<td>First reported by</td>
<td>Task that first identified the problem.</td>
</tr>
<tr>
<td>Category and Subcategory</td>
<td>Group to which the problem belongs to such as software or hardware. After selecting the category, select the subcategory, if applicable.</td>
</tr>
<tr>
<td>Service</td>
<td>Business service that the problem applies to.</td>
</tr>
<tr>
<td>Service Offering</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. Service offering enables you to receive different features and their levels of performance for a given service.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the problem applies to. The CI class of the selected configuration item identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
<tr>
<td>State</td>
<td>For customers prior to the Madrid release, the available states are: Open, Pending Change, Known Error, and Closed or Resolved. For customers starting with the Madrid release, the new state model is applied and the State field is read only. The field value changes as the problem proceeds from one state to another state. The states available are: New, Assess, Root Cause Analysis, Fix in Progress, Resolved, and Closed.</td>
</tr>
</tbody>
</table>

**Note:** To access the new state management process, activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact</td>
<td>Effect that the problem has on business operations.</td>
</tr>
<tr>
<td>Urgency</td>
<td>Extent to which the problem resolution can bear delay.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the problem. The <strong>Priority</strong> field is automatically set to the <strong>Impact</strong> and <strong>Urgency</strong> values.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group to which the problem is assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Problem coordinator to whom the problem is assigned. If an assignment rule applies, the problem is automatically assigned to the appropriate user or group.</td>
</tr>
<tr>
<td>Problem statement</td>
<td>Brief description of the problem.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the problem.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notification when work notes are added to the problem.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Informative notes about the work performed on the problem.</td>
</tr>
<tr>
<td>Analysis Information</td>
<td></td>
</tr>
<tr>
<td>Workaround</td>
<td>Method used to overcome the issue if no resolution is available yet.</td>
</tr>
<tr>
<td>Cause notes</td>
<td>The cause of the problem.</td>
</tr>
<tr>
<td>Resolution information</td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>(Auto-generated). Date and time when the user resolved the problem.</td>
</tr>
<tr>
<td>Resolved by</td>
<td>(Auto-generated). The user who resolved the problem.</td>
</tr>
<tr>
<td>Fix notes</td>
<td>Information on how the problem was fixed.</td>
</tr>
<tr>
<td>Other Information</td>
<td></td>
</tr>
<tr>
<td>Opened</td>
<td>(Auto-generated). Date and time when the user opened the problem.</td>
</tr>
<tr>
<td>Opened by</td>
<td>(Auto-generated). User who opened the problem.</td>
</tr>
<tr>
<td>Confirmed</td>
<td>(Auto-generated). Date and time when the issue was confirmed as a problem.</td>
</tr>
</tbody>
</table>

**Note:** Activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.
5. Click **Save**.  
A problem record is created and the record appears in the Related tasks related list on the Interaction form.

**Create a problem task in a workspace**

If you need to engage another team or agent for help, create a problem task and assign it to them.

Role required: agent_workspace_user, problem_task_analyst, or admin

Activate the Problem Management Best Practice — Madrid — State Model (com.snc.best_practice.problem.madrid.state_model) plugin to access the problem task types

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. In the List menu, choose **Problems > Open**.
3. Open the problem record for which you want to create tasks.
4. Click the Problem Tasks related list, and then click **New**.
5. In the Create Problem Task dialog box, select the problem task type to be created.
   - **General**: Tasks other than root cause analysis tasks.
   - **Root Cause Analysis**: Tasks to investigate the root cause of a problem and find a resolution for the problem.

6. Click **Create**.
7. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>(Auto-generated). Number that identifies the problem task record.</td>
</tr>
<tr>
<td>State</td>
<td>For customers prior to the Madrid release, the available states are: Open, Pending Change, Known Error, and Closed or Resolved. For customers starting with the Madrid release, the new state model is applied and the State field is read only. The field value changes as the problem proceeds from one state to another state. The states available are: New, Assess, Root Cause Analysis, Fix in Progress, Resolved, and Closed.</td>
</tr>
<tr>
<td>Type</td>
<td>The problem task type.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>Configuration item (CI) that the problem task applies to. The CI class of the selected configuration item identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
<tr>
<td>Due date</td>
<td>Date by which the problem task must be completed.</td>
</tr>
<tr>
<td>Problem</td>
<td>ID number of the problem for which the problem task is created.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the problem.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group to which the problem task is assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Problem analyst to whom the task is assigned.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the problem tasks must be associated to the problem.</td>
</tr>
</tbody>
</table>

**Note:** Activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Brief description of the problem task.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the problem task.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notification when work notes are added to the problem task.</td>
</tr>
<tr>
<td>Work notes (Private)</td>
<td>Information about the work performed on the problem task.</td>
</tr>
</tbody>
</table>

**Analysis information — Available for the Root Cause Analysis problem type**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause code</td>
<td>Code for the cause of the problem type such as Environmental disaster, Hardware issue, or People/Process/Documentation.</td>
</tr>
<tr>
<td>Cause notes</td>
<td>Information on the cause of the problem task.</td>
</tr>
</tbody>
</table>

**Note:** Activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proposed fix notes</td>
<td>Proposed fix for the problem task.</td>
</tr>
<tr>
<td>Workaround</td>
<td>Method used to overcome the issue if no resolution is available yet.</td>
</tr>
<tr>
<td>Closure information</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Closed by</td>
<td>(Auto-generated). Name of the user who closed the problem task.</td>
</tr>
<tr>
<td>Closed</td>
<td>Date and time when the user closes the problem task.</td>
</tr>
<tr>
<td>Close notes (Only for General problem task type)</td>
<td>Information on the work completed for the problem task.</td>
</tr>
</tbody>
</table>

8. **Click Save.**
   The problem task record is created and is added to the Problem tasks related list on the Problem form.

**Attach a knowledge article to a problem or problem task from Agent Assist**

You can attach a knowledge article, for example a Known Error article, to a problem or problem task that provides information to solve the issue quickly.

Role required: agent_workspace_user or admin

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. In the Lists menu, choose **Problems > Open**.
3. Access the relevant problem record or problem task.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are attaching an article to a problem record</td>
<td>Open the problem record.</td>
</tr>
<tr>
<td>If you are attaching an article to a problem task</td>
<td>1. Open the related problem record.</td>
</tr>
<tr>
<td></td>
<td>2. Click the Problem Tasks related list.</td>
</tr>
<tr>
<td></td>
<td>3. Select the problem task record.</td>
</tr>
</tbody>
</table>

4. In Agent Assist, search for the article you want to attach and select it.
5. **Click the more actions icon and click Attach.**
Create a change request from a problem

If the cause of a problem requires a change to your infrastructure or a business service, you can create a change request from the problem as part of fixing the problem.

Role required: agent_workspace_user, itil, or admin

You can implement a resolution to a problem by applying a standard change procedure and testing to confirm service recovery. For a normal change, you raise a Request For Change (RFC). The Change Advisory Board (CAB) must approve the RFC before a resolution is applied to the Problem.

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the list, click Problems > Open.
3. Open the problem record from which you want to create a change request.
4. Click the more actions icon (....) and click Create Change Request.
5. In the Create Change Request dialog box, select the type of change.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Any service change that is not a standard change or an emergency change.</td>
</tr>
<tr>
<td>Standard</td>
<td>A pre-authorized change that is low risk, relatively common, and follows a specified procedure or work instruction.</td>
</tr>
<tr>
<td>Emergency</td>
<td>An emergency change that bypasses group and peer review and approval, and goes straight to the authorization state for approval by the CAB approval group.</td>
</tr>
</tbody>
</table>

6. Click Create.
7. Create the change record.
   For more information, see Create a change task.
8. Click Save.
   The change record appears under the Change Requests related list.

Create an improvement initiative from a problem

Create an improvement initiative from a problem to track and manage tasks for improving a service or process, or tasks related to the problem.

Role required: agent_workspace_user, itil, or admin

- The Continual Improvement Management (com.sn_cim) plugin must be activated. For more information on activating the plugin, see Request Continual Improvement Management.
- The administrator must add the Improvement Initiatives related list to the problem form in Workspace view.

An improvement initiative contains goals to measure success, and phases that contain tasks with specific actions to complete the improvement. For more information, see Continual Improvement Management overview.

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. In the Lists tab, click Problems > All.
3. Open the problem for which you want to create an improvement initiative.
4. Click the Improvement Initiative related list.
5. Click New.
6. In the Improvement Initiative field, click the search icon to find the appropriate initiative.
7. Associate an existing initiative or create a new one.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you find an existing initiative</td>
<td>Select the initiative to associate with this incident.</td>
</tr>
<tr>
<td>If you do not find an initiative</td>
<td>1. Click the Create Improvement Initiative related link.</td>
</tr>
<tr>
<td></td>
<td>2. Create an initiative by filling in the Improvement Initiative form. For more information, see Create an improvement request.</td>
</tr>
</tbody>
</table>

8. Optional: If you want to attach a supporting document, click Browse and select the file.
9. Click Save.
   The improvement initiative is now associated with the problem.

Delete a problem

If you no longer need problem information, you can delete the problem. This action deletes the problem both from the ServiceNow database and from the Problem table.

Role required: admin

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the list, click Problem > Open.
3. Open the problem record that you want to delete.
4. 
   Click the more actions icon ( ) and then click Delete.
5. In the Confirmation dialog box, click OK.

ITSM Agent Workspace - Change Management

Use ServiceNow® ITSM Agent Workspace to create and manage your change requests.

The Change workspace form is similar to the Now Platform Change request form. You can customize the view of the Agent Workspace form by changing the workspace view. For more information, see Add field or related list to a workspace form.
<table>
<thead>
<tr>
<th>Number</th>
<th>Short description</th>
<th>Type</th>
<th>State</th>
<th>Planned start date</th>
<th>Planned end date</th>
<th>Updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHC004001</td>
<td>Please reboot ApplicationServer/Host1</td>
<td>Emergency</td>
<td>New</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
</tr>
<tr>
<td>CHC004002</td>
<td>Increase database buffer from 3000</td>
<td>Normal</td>
<td>Authorize</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
</tr>
<tr>
<td>CHC004003</td>
<td>Upgrade to Windows 5.1</td>
<td>Normal</td>
<td>Authorize</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
</tr>
<tr>
<td>CHC004004</td>
<td>Add network switch to cabinet</td>
<td>Standard</td>
<td>Scheduled</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
</tr>
<tr>
<td>CHC004005</td>
<td>Please reboot ASK10</td>
<td>Emergency</td>
<td>New</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
</tr>
<tr>
<td>CHC004006</td>
<td>Please reboot ApplicationServer/Host1</td>
<td>Emergency</td>
<td>New</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
</tr>
<tr>
<td>CHC004007</td>
<td>Upgrade Tomcat server to 4.0</td>
<td>Emergency</td>
<td>New</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
</tr>
<tr>
<td>CHC004008</td>
<td>Upgrade MySQL 5.7 to 5.7</td>
<td>Emergency</td>
<td>New</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
</tr>
<tr>
<td>CHC004009</td>
<td>Change default router on undo201</td>
<td>Normal</td>
<td>Authorize</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
</tr>
<tr>
<td>CHC004010</td>
<td>Add network switch to cabinet</td>
<td>Standard</td>
<td>Scheduled</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
</tr>
<tr>
<td>CHC004011</td>
<td>Please reboot ASK10</td>
<td>Emergency</td>
<td>New</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
</tr>
<tr>
<td>CHC004012</td>
<td>Upgrade Tomcat server to 4.0</td>
<td>Emergency</td>
<td>New</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
</tr>
<tr>
<td>CHC004013</td>
<td>Upgrade MySQL 5.7 to 5.7</td>
<td>Emergency</td>
<td>New</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
<td>2023-02-02 10:00:00</td>
</tr>
</tbody>
</table>
Create a change request in Agent Workspace

A change request is a proposal to alter a supported configuration item (CI). Use a change request form to record information such as the reason for the change, type, priority, and risk.

Role required: sn_change_write, itil, or admin

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the navigation list, click Change > Open.
3. Click New.
4. Select a change type and then click Create.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Any service change that is not a standard change or an emergency change.</td>
</tr>
<tr>
<td>Standard</td>
<td>A pre-authorized change that is low risk, relatively common, and follows a specified procedure or work instruction.</td>
</tr>
<tr>
<td>Emergency</td>
<td>An emergency change that bypasses group and peer review and approval, and goes straight to the authorization state for approval by the CAB approval group.</td>
</tr>
</tbody>
</table>

5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique change request number</td>
</tr>
<tr>
<td>Requested by</td>
<td>User who requested the change.</td>
</tr>
<tr>
<td>Category</td>
<td>The category of the change, for example, Hardware, Network, or Software.</td>
</tr>
<tr>
<td>Service</td>
<td>The business service that you want to make available for the change request.</td>
</tr>
<tr>
<td>Service Offerings</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. Service offering enables you to receive different features and their levels of performance for a given service.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the change applies to. You can associate any type of CI with a change request, including service offerings. It also provides detailed access to SLA and availability requirements.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority value that is auto-generated based on impact and urgency. It identifies how quickly the service desk should address the task.</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact auto-calculated value that indicates a measure of the effect of an incident, problem, or change on business processes.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>Displays the selected change request type (Standard, Normal, or Emergency). You can change this value by selecting another type.</td>
</tr>
<tr>
<td>State</td>
<td>State of the change request. By default, the state is <strong>New</strong>.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group assigned to the change.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User assigned to the change request. If an assignment rule applies, the change is automatically assigned to the appropriate user or group.</td>
</tr>
<tr>
<td>Risk</td>
<td>The risk level for the change. Either <strong>High</strong>, <strong>Moderate</strong>, or <strong>Low</strong>. You can set this value manually or use <strong>Risk Calculation and Risk Assessment</strong> to derive it.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the change.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the change.</td>
</tr>
<tr>
<td>Planning section</td>
<td></td>
</tr>
<tr>
<td>Justification</td>
<td>Reason for the planned change request, which helps approvers determine their decision.</td>
</tr>
<tr>
<td>Implementation plan</td>
<td>Plan or process to follow to implement the change.</td>
</tr>
<tr>
<td>Risk and impact analysis</td>
<td>Detailed analysis of the risk and impact foreseen if the change is implemented.</td>
</tr>
<tr>
<td>Backout plan</td>
<td>The information required to restore the system to its original state if an implementation fails.</td>
</tr>
<tr>
<td>Test plan</td>
<td>Detailed information on the test strategy and objectives for the change request.</td>
</tr>
<tr>
<td>Schedule section</td>
<td></td>
</tr>
<tr>
<td>Planned start date</td>
<td>Date to begin working on the change.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Date the change is planned to be completed.</td>
</tr>
<tr>
<td></td>
<td>If the task type is <strong>Implementation</strong>, the <strong>Planned start date</strong> and <strong>Planned end date</strong> values must fall within the planned start and end dates specified in the change request.</td>
</tr>
<tr>
<td>Unauthorized</td>
<td>Option to indicate that the change is an unauthorized change. For more information see, <strong>Unauthorized change request</strong>.</td>
</tr>
<tr>
<td>Actual start date</td>
<td>Start date of the implementation.</td>
</tr>
<tr>
<td>Actual end date</td>
<td>Date when the change was completely implemented.</td>
</tr>
<tr>
<td>Notes section</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Watch list</td>
<td>Users to receive notifications when work notes are added.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users to receive notifications when work notes are added.</td>
</tr>
<tr>
<td><strong>Note:</strong> The administrator must create an email notification for the work notes list.</td>
<td></td>
</tr>
<tr>
<td>Additional comments (Customer visible)</td>
<td>More information about the change.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about how to resolve the change or steps taken to resolve it, if applicable. This note is for internal use. The work notes information is not visible to your customer.</td>
</tr>
<tr>
<td>Closure Information section</td>
<td></td>
</tr>
<tr>
<td>Close code</td>
<td>Resolution code for the change.</td>
</tr>
<tr>
<td>Close notes</td>
<td>How or why the change was closed.</td>
</tr>
</tbody>
</table>

6. **Click Save.**

**Create a standard change from an interaction**

Create a standard change record directly from an interaction to implement a pre-approved, low-risk change without having to go through the Change Management module to implement it.

Role required: itil, sn_change_write or admin

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home.**
2. Create an interaction record.
   For more information, see **Create an interaction record in ITSM Agent Workspace.**
3. On the Interaction form, click the more actions icon

   ![More Actions Icon]

   and then click **Create Standard Change.**

4. On the New Catalog Item page, expand the **Standard change** list and select from the available change categories.
5. **Click Submit.**
   A standard change is created and the record appears in the Related tasks related list on the Interaction Management form.

**Link a change request to an incident through Agent Assist**

You can identify incidents caused by a change and link it to the change record from the Agent Assist panel in a workspace.

Role required: sn_change_write, itil, or admin

1. Navigate to **Work Experience > Workspaces > Agent Workspace Home.**
2. From the list, click **Change > Open.**
3. Click the change record you want to work on.
4. In Agent Assist, click the settings icon.
   ( )
5. Select Change Related Incidents from the menu list.
6. Click the more actions icon
   ( )
in the incident tile that you want to link to the change.
7. Click the Link to Incident menu item.
8. In the Link to Incident form, fill in the work notes and any additional comments.
9. Click Link to Incident.

The change record is linked to the incident and the incident details appear when you view the Incidents Caused By Change related list.

View similar incidents caused by change
Agent workspace for Change Management uses machine-learning algorithms to identify and display similar incidents caused by change using past data. You can view the ranked list of potential incidents caused by change in Agent Assist and link them to the change request.

Role required: sn_change_write, itil, or admin
1. Navigate to Work Experience > Workspaces > Agent Workspace Home.
2. From the list, click Change > Open.
3. Click the change record you want to work on.
4. In Agent Assist, click the settings icon
   ( )
5. Select Incidents Caused By Change from the menu list.
6. Click the more actions icon
   ( )
in the incident tile that you want to link to the change.
7. Click the Link to Change menu item.
8. In the Link to Change form, fill in the work notes and any additional comments.
9. Click Link to Change.

Delete a change request
If you no longer require the change information, you can delete the change record. This action deletes the change record from the ServiceNow database and the Change (change) table.

Role required: agent_workspace_user, itil_admin, or admin
1. Navigate to Work Experience > Workspaces > Agent Workspace Home.
2. From the list, click Change > Open.
3. Open the change record that you want to delete.
4. Click the more actions icon ( ) and then click Delete.
5. In the Confirmation dialog box, click OK.

**Disable creating an emergency change in Agent Workspace**

Limit the access to create an Emergency change request from the Agent Workspace. However, you can continue creating the emergency change from your Now Platform instance.

Role required: itil_admin or admin

1. Navigate to **Change > Administration > Workspace Record Types Selectors**.
2. Click the **change_request** target table that has the **Emergency** display value. The record opens in the read-only mode.
3. Click **here** in the message displayed to edit the record. The editable record opens.
4. Click the **Active** check box to make it inactive. By making the record inactive, you remove the **Emergency** option that appears in the **New Change Request** window of the Agent Workspace. This action impacts creating change in placed where the interceptor is used.

**ITSM Agent Workspace - Scheduling**

Use ITSM Agent Workspace Scheduling to manage your schedule.

**Manage your schedule using the ITSM Agent Workspace**

Look up your schedule, request time off, or swap your shift with your peers using the calendar in ITSM Agent Workspace. If you can work during the requested shift, you can also approve your peer's request for shift swap.

Role required: sn_shift_planning.agent

You can swap shifts with agents that are within your assignment group.

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. Click the Calendar icon.

   You can access your schedule in the **My Calendar** tab. If you want to see a list of all agents in your assignment groups and their schedules, click the **Team Calendar** tab.

   To view your schedule or another agent's schedule, you can:
   - View your schedule by clicking the **My Calendar** tab. Then, use the list menu to select the schedule that you want to view by day, week, or month.
   - View another agent's schedule by clicking the **Team Calendar** tab. Then, click an agent's schedule to see that agent's work and break times.

3. Make a request.

   You can communicate with other agents by using Connect Chat or the activity stream on the record to make sure that they would like to swap the requested shift with you.
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request a shift swap</td>
<td>1. Click Request shift swap.</td>
</tr>
<tr>
<td></td>
<td>2. From the Shift menu for your shift, select the shift that you want</td>
</tr>
<tr>
<td></td>
<td>to swap with another agent.</td>
</tr>
<tr>
<td></td>
<td>3. In the Agent field for the requested shift, select the agent that</td>
</tr>
<tr>
<td></td>
<td>you want to swap with.</td>
</tr>
<tr>
<td></td>
<td>4. From the Shift menu for the requested shift, select the agent's</td>
</tr>
<tr>
<td></td>
<td>shift that you want to swap with.</td>
</tr>
<tr>
<td></td>
<td>5. Click Submit.</td>
</tr>
<tr>
<td>Request a time off</td>
<td>1. Click Request time off.</td>
</tr>
<tr>
<td></td>
<td>2. From the Start time field, enter the time that you want your time</td>
</tr>
<tr>
<td></td>
<td>off to start.</td>
</tr>
<tr>
<td></td>
<td>3. From the End time field, enter the time that you want your time off</td>
</tr>
<tr>
<td></td>
<td>to end.</td>
</tr>
<tr>
<td></td>
<td>You can add attachments using the attachments icon or templates using</td>
</tr>
<tr>
<td></td>
<td>the templates icon.</td>
</tr>
<tr>
<td></td>
<td>4. Click Submit.</td>
</tr>
</tbody>
</table>

The shift-swap request moves to the approval queue of the agent that you have requested to swap with. For more information, see Approve or reject a shift swap.

The time-off request moves to your manager’s approval queue. For more information about approvals, go to Track and manage your teams’ schedule.

### Approve or reject a shift-swap

You can approve a shift swap requested by your peer if you are available to work for that time period. You can reject it if you are unable to work then.

Role required: sn_shift_planning.agent

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. Click the Lists icon.
3. Go to Approvals > My Approvals.
4. Select the request you want to approve or reject.
5. Review the details of the shift swap request and do one of the following:
   - To approve the request, click Approve.
   - To reject the request, click Reject.

If you approve a shift-swap, the application moves the request to your manager’s approval queue. For more information, go to Track and manage your teams’ schedule.

### ITSM Agent Workspace - Coaching

Use ITSM Agent Workspace Coaching to review and complete training.
Complete assigned training using Workforce Optimization for ITSM

Improve your skills set by completing the training assigned by your coach.
Role required: sn_coaching.trainee

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. Click the Lists icon.
3. Go to Training > Pending Training.
4. Select a training.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn from a training module</td>
<td>1. From the Training ID field, select a training module.</td>
</tr>
<tr>
<td></td>
<td>2. Complete the training.</td>
</tr>
<tr>
<td>Review a knowledge article</td>
<td>1. From the Training ID field, select a knowledge article.</td>
</tr>
<tr>
<td></td>
<td>2. Review the article. You can also mark it as helpful or rate the article.</td>
</tr>
</tbody>
</table>

5. Click Complete Training.
If you had enabled the Award skills on completion field, the skill associated with the training is added to the trainee profile.

Workforce Optimization for ITSM

Manage and maintain the productivity of your workforce from a single location using Workforce Optimization for ITSM. Using this application, you can efficiently manage your team’s skills and schedules, route work assignments to your team, and monitor their performance.

Workforce Optimization for ITSM enables you to do these tasks:
- Predict and recommend skills for agents.
- Use queues to route the agents based on their assigned groups and skills set.
- Monitor and measure team performance and provide feedback using assessments.
- Create opportunities to coach and train your teams.

Workforce Optimization for ITSM in action

Here’s how managers use Workforce Optimization for ITSM.

Key Features

Managing teams from a central location
Schedule your team’s work shifts and align agents to handle incidents.

Scheduling


Today  ➔  May 7, 2020  ➔

| Time  | 02:00 | 03:00 | 04:00 | 05:00 | 06:00 | 07:00 | 08:00 | 09:00 | 10:00 | 11:00 | 12:00 | 13:00 | 14:00 | 15:00 | 16:00 | 17:00 | 18:00 | 19:00 | 20:00 | 21:00 |
|-------|-------|-------|-------|-------|-------|-------|-------|-------|-------|-------|-------|-------|-------|-------|-------|-------|-------|-------|-------|
| Total coverage | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
| Application Support | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
|  - Sandi Stokes | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
|  - Shena Aguinya | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
| Deskide Support | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
|  - Billie Toothaker | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
|  - Radolph Wolfgang | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
|  - Stanford Bolton | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
|  - System Administrator | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
| IT Service Desk | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
|  - Alberta Vivens | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
|  - Anita Dushah | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
|  - Delia Sicum | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
|  - Dottie Monn | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
|  - Vincere Palma | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
|  - Hestie Deparia | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
Automating employee coaching and training
Assess your team’s performance and set coaching plans to improve their skills.
Integrated application data

Drive workforce optimization effectively by managing schedules, shifts, and queues for your teams. You can assess skills, automate agent
recommendations based on those skills, and provide mentoring opportunities for
Get started

---

**Explore Workforce Optimization for ITSM**

Use Workforce Optimization for ITSM to optimize your workforce and manage your teams efficiently. Coach your teams so that they gain the skills that let you address the demands from your customers. Efficiently schedule your teams to provide better coverage with integrated channel management.

As a manager, you can monitor the demand for agents and skills in your organization to resolve issues. Assess agent skills, identify areas where they need improvement and provide training to enhance their skills set. Track your teams performance, and manage the schedule of all agents in your assignment group—all from a unified location.

As an agent, you can manage your own schedule, access the schedule of your peers and request time off or shift swaps.

Get an overview of how you can set up Workforce Optimization for ITSM in this video.

Get an overview of how managers can monitor the status of incidents and the KPIs for organizational performance in this video.

**Channel Management**

Monitor your teams in real time and jump in to help when there is a need.

Using this application, you can also:

- Route work to specific groups based on agent skills
- Review real-time performance as the team is actively working on tasks across channels
- Monitor pending work items in a queue

**Scheduling**

Access your teams' calendar to know which agents are scheduled for coverage and which agents have taken time-off.
Using the application, you can also:

- Assign agents to shifts
- Define break time
- Preview and publish team schedule
- Approve agent time-off or shift-swap requests

**Teams**

Monitor performance trends for your teams using KPI groups. Create a set of KPIs and apply them to all groups within a team and assess team performance from one location.

Using the application, you can also:

- Identify all the teams you manage as well as the ones you have visibility into
- Analyze KPIs that are crucial for your team
- Drill into agents within each team and monitor their performance
- Access each agent’s profile to view details such as their manager, peers, and assignment groups
- Drill down into each agent’s skills or recommend them for coaching

**Coaching and Skills Assessment**

Enhance the quality of work done by your agents using Coaching. Use Predictive Intelligence to recommend skills based on issues the agents have resolved. Create coaching opportunities based on the recommendation and train the agents to acquire those skills.

Using this application, you can also:

- Automate the scoring, grading, and assessment of agent skills
- Use coaching opportunities to create assessments
- Track training assigned to agents based on their assessments
- Analyze skill gap and recommend training

**Channels in Workforce Optimization for ITSM**

Learn how you can use channels to route work to specific groups and with skill-based routing to ensure that the right work goes to the right agent. Monitor the health of your queues reviewing real-time performance and jumping in to help with escalations.

Manage queues and monitor real-time team performance from a central location using Channel Management.
<table>
<thead>
<tr>
<th>Record</th>
<th>Agent</th>
<th>Service channel</th>
<th>Queue Name</th>
<th>Work Item State</th>
<th>Opened</th>
</tr>
</thead>
</table>

Work Items: 32

Assign
As a channel manager, you can:

- Associate assignment groups to queues
- Monitor the health of your queues in real time
- Track team performance
- Monitor pending work items in the queue

Example: channel management using Workforce Optimization for ITSM

Understand how you can route work to specific groups and monitor real-time performance using Channel Management.

Ingrid manages IT operations for a large organization and has 12 teams reporting to her. Each of her teams has anywhere from 20 through 50 agents. She must ensure that incoming work gets effectively routed to the right groups across all channels.

As a manager, Ingrid must ensure that she can set up Channel Management to monitor team performance as follows:

- Add service channels and queues to route work items
- Add KPIs to the channels and queues to measure team performance
- Monitor her teams’ ongoing work and performance
- Join chat conversations to assist agents

For detailed information on setting up channels using Workforce Optimization for ITSM, refer to Setting up Channels using Workforce Optimization for ITSM.

Scheduling in Workforce Optimization for ITSM

Learn how you can plan shifts with automatically staggered break times for your agents to effectively manage their schedule in Workforce Optimization for ITSM. Publish schedules for the next scheduling period to get a snapshot of which agent is lined up to solve issues for that time period.

Manage the scheduling for your organization from a central location.
Scheduling

Ensure that you have the coverage you need and dedicated agents to resolve issues as they arise

Scheduler

sn_shift_planning.admin

Plan
Create shift plans that automatically stagger breaks to maximize coverage

Schedule
Assign agents to shifts and publish a schedule for the next scheduling period

Manage
Manage agent time-off and shift-swaps from a single location

Agent

sn_shift_planning.agent

Request time-off
Send a request for the time period you want to take off

Swap shifts
Trade shifts with your peers

View team schedule
Know when your peers are working and when they are taking time off

Scheduler

Assess planned coverage and see which agents cover the shifts for each of your groups
Gain visibility into your teams’ schedule and modify published schedules as needs arise

Agent

Manage your schedule and request time-off
Get visibility into the schedule of your peers and swap shifts with them
As a shift planning administrator, you can:

- Create shifts to ensure customer coverage for the required span of time.
- Add breaks to the shifts that automatically stagger agent availability for those shifts.
- Preview the schedule and make necessary changes before publishing it to your agents.
- Access the schedule of all of your teams from one location.

As a shift planning agent, you can:

- Look up your schedule and request time off when required.
- Swap your shift with one of your peers.

**Example: scheduling using Workforce Optimization for ITSM**

Understand how you can set up and publish agent schedules and how your agents can manage their own schedule based on an example.

Ingrid manages IT operations for a large organization and has 12 teams reporting to her. Each of her teams has anywhere from 20 through 50 agents. At any given point, she needs visibility into her teams’ schedule. She must also be able to create shifts, and approve or reject shift-swap or time-off requests from her agents.

As a manager, Ingrid can manage her entire teams’ schedule using **Scheduling**. Ingrid’s team can manage their own schedule effectively by requesting shift-swaps or time-off.

Ingrid and her team can manage schedules by performing the following steps from one central location:

1. Create shift plan
2. Create a schedule plan
3. Assign agents to work shifts
4. Publish the schedule
5. Agents make requests to change the schedule or take time off
   - For more information, refer to **ITSM Agent Workspace - Scheduling.**
6. Approve requests

Get an overview of how to you can create shift plans and assign agents to the shifts using the schedule plan in this video.

Get an overview of how you can monitor shifts and schedule for your entire team from a single location in this video.

Get an overview of how agents use the workspace to manage their schedule.

For detailed information on creating and managing schedules using Workforce Optimization for ITSM, refer to **Scheduling in Workforce Optimization for ITSM.**

**Teams in Workforce Optimization for ITSM**

Learn how you can organize each of your teams into assignment groups. You can then define a set of Key Performance Indicators (KPIs) to analyze the performance of all groups within that...
team. Drill into the metrics for a group, an agent, or an incident within that team—all from a central location.
Teams

Analyze the performance of your agents and teams, also known as assignment groups, with common indicators for consistent reporting across your teams.

- Organize the teams you manage into assignment groups
- Add a manager to the group
- Assign additional managers
- Add a primary assignment group for a user

- Create KPI groups for different types of teams
- Add indicators that matter most to your teams

- Associate the KPI group with multiple assignment groups that represent your teams
- Apply the KPI set once to a KPI group and it gets automatically applied to all groups within that team
Drill down into your reports.
As an administrator for Teams, you can:

- Create a KPI group for a common set of indicators (KPIs) you use to measure your teams’ performance.

  **Note:** Your teams are called assignment groups within the Teams application.

- Add the KPIs to the KPI group.
- Add assignment groups to the KPI group.

  **Note:** Ensure that you have added a manager to each assignment group. The manager either directly manages the assignment group or needs visibility into the assignment group.

As a manager, you can:

- Analyze the performance trends for your teams.
- Drill down into the performance of teams, agents, or incidents.

**Example: teams using Workforce Optimization for ITSM**

Understand how you can manage your teams from a single location using an example.

Ingrid is the manager of IT Service Desk and directly manages 15 teams. She is an additional manager of other teams that she has visibility into although they don’t directly report to her.

To effectively analyze the performance of her teams from one location, she sets up the Teams as follows:

1. Organizes her teams into groups called assignment groups. The teams either directly report to her or she may have visibility into their performance.
2. Creates a KPI group with a set of indicators that matter most to measure the performance of her assignment groups.
3. Adds all assignment groups that use the set of KPIs to the KPI group.

With this set up, she can effectively analyze the performance of her teams grouped by KPI groups.

Ingrid can set up and use Teams by performing the following steps:

1. Create a KPI group
2. Add KPIs to that group
3. Add managers to assignment groups
4. Add assignment groups to the KPI group
5. Drill down into a KPI, agent, or an incident to analyze performance

Get an overview of how you can set up team performance and how KPI aggregates are calculated.

Get an overview of how you can analyze team performance in this video.

For detailed information on how to setup and use Teams, see Teams.
Coaching in Workforce Optimization for ITSM

Learn how you can review and assess the quality of your team’s completed interactions and tasks. You can enhance your team’s skills set by assigning training that is based on those assessments. You can also add skills to your team’s profiles after they get trained.
Assess
- Evaluate agents skills based on quality of completed tasks

Train
- Recognize improvement opportunities and assign training tasks

Improve
- Monitor team performance for more improvement

Coach admin
- Configure
  - Set conditions in coaching opportunities that trigger an assessment
- Design
  - Define surveys used to assess agent performance

System generates the assessment along with the survey, if defined, and assigns to the coach

Assess
- Assess agents ability to resolve incidents and the quality of their service

Train
- Assign training tasks to agents based on the assessment

Trainee
- Completes assigned training tasks to address skill gaps and enhance skills set

Use surveys to apply consistent, measurable scores across teams or tasks to evaluate them

Coaching roles
- Coach admin: sn_coaching.admin
- Coach: sn_coaching.coach
- Trainee: sn_coaching.trainee

Predictive intelligence
- Predictive Intelligence uses supervised and unsupervised solutions definitions to recommend skills based on the work the agent has completed.
Here's an example of how Workforce Optimization for ITSM uses Predictive Intelligence to recommend skills for agents:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Predictive Intelligence associates the incidents that were closed using similar skills and then groups the tasks by the agents who resolved them.</td>
<td>Predictive Intelligence looks at the similarity between the tasks that were resolved using the skill Firewall.</td>
</tr>
<tr>
<td>2.</td>
<td>When agents resolve incidents, the Skill Recommendation application stores the skill and agent associations.</td>
<td>Agent A completes a task that requires the skill Firewall, but that skill is not in the agent's user profile yet.</td>
</tr>
<tr>
<td>3.</td>
<td>System administrators set the threshold for the skill and agent associations. When the threshold is reached, the Skill Recommendation application recommends to the agent's manager that the skill be added to an agent's profile.</td>
<td>The system administrator sets the threshold at 10. That means that the agents must have the same skill and complete 10 similar tasks. Agent A completes 10 tasks using the skill Firewall. The Skill Recommendation application recommends the skill Firewall for Agent A to the agent's manager.</td>
</tr>
<tr>
<td>4.</td>
<td>The manager approves and adds the skill to the agent's profile.</td>
<td>Agent A's manager approves the skill Firewall and adds that skill to Agent A's profile.</td>
</tr>
<tr>
<td>5.</td>
<td>Advanced work assignment (AWA) uses the new skills that were added to the agent's profile, looks up tasks that require those skills, and assigns the agents to complete those tasks.</td>
<td>When a task requires the skill Firewall, Agent A is automatically considered for that task assignment.</td>
</tr>
<tr>
<td>6.</td>
<td>Over time, the Predictive Intelligence machine learning algorithms learn which skills were assigned to the agents to resolve the incidents.</td>
<td></td>
</tr>
</tbody>
</table>

The infographic shows how you can use Predictive Intelligence to recommend skills for your agents.
Skill recommendation using Predictive Intelligence

1. Predictive Intelligence (PI) compares incidents closed in the last 90 days with skills data for similarity

   - Tasks: desktop, laptop, security, server, software, protect
   - Skills: Firewall, Hardware, Network

   PI groups the incidents based on skills agents used to resolve them

2. Skills Recommendation Application stores the skill and agent associations

   - Agent A completes 3 tasks using the Firewall skill
   - Agent B completes 4 tasks using the Hardware skill
   - Agent C completes 8 tasks using the Network skill

   Threshold: 10

   Admin sets threshold for this association

3. When the threshold is met, Skill Recommendation Application recommends the skill to the agent’s manager

4. Manager approves the recommendation

   - Agent A: Skills: Firewall

   Skill assigned to the agent

5. Advanced Work Assignment starts routing tasks to agents based on newly assigned skills

6. PI algorithms learn from the repeated task to skill associations that agents use to resolve incidents
As a coach, you can:

- Use surveys to evaluate your team's performance.
- Recognize improvement opportunities and assign training tasks.
- Assess a trainee's ability to resolve incidents.
- Assign training that is based on the assessments.
- Add skills to a trainee's profile that is based on a recommendation from Predictive Intelligence.

As a trainee, you can get trained to address your skill gaps.

**Example: coaching using Workforce Optimization for ITSM**

Understand how you can assess your agents' performance, identify skill gaps, and train them to enhance their skills with Coaching.

Ingrid manages IT operations for a large organization and has 12 teams reporting to her. Each of her teams has anywhere from 20 through 50 agents. She is also added as a manager of other teams where she needs visibility.

She wants a single location where she can:

- Monitor the skills that her teams use the most to solve issues
- Analyze metrics and monitor pending coaching assessments and training for the teams
- Add skills used for resolving issues or when Predictive Intelligence Workbench recommends them.

Ingrid can manage all of these actions by doing the following:

1. Set conditions that trigger coaching opportunities.
2. Assess her agents' skills and assign training.
3. Add skills to agent profile when they complete training or using recommendations from Predictive Intelligence.

Get an overview on coaching, creating assessments, taking surveys, assigning training, and adding skills.

Get an overview of how you can add skills manually or the ones recommended using Predictive Intelligence and the Skill Recommendation application.

For detailed instructions on setting up and using Coaching for Workforce Optimization for ITSM, see *Coaching*.

**Set up Workforce Optimization for ITSM**

Enable Workforce Optimization for ITSM and configure settings to use the Teams, Coaching, Scheduling, and Channel Management applications.

**Request Workforce Optimization for ITSM**

The Workforce Optimization for ITSM plugin (com.snc.wfo_itsm) requires a separate subscription and must be activated by a ServiceNow personnel. This plugin activates related plugins that enable users to use the Scheduling, Coaching, Teams, and Channel Management applications in Workforce Optimization for ITSM.
Role required: none

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

---

**Workforce Optimization for ITSM Reference**

Workforce Optimization for ITSM installs the roles and tables when you enable the Workforce Optimization for ITSM plugin (com.snc.wfo_itsm).

---

### Workforce Optimization for ITSM

#### Roles

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workforce Optimization User (sn_wfo.user)</td>
<td>Grants read access to primary group and additional managers.</td>
<td>pa_analyst</td>
</tr>
<tr>
<td>Workforce Optimization Admin (sn_wfo.admin)</td>
<td>Grants administrative rights to create, read, update, and delete (CRUD) additional managers.</td>
<td>sn_wfo.user, pa_analyst</td>
</tr>
<tr>
<td>Workforce Optimization ITSM Manager (sn_wfo_itsm.manager)</td>
<td>Grants rights to create, read, or update, coaching, scheduling, teams, or channel management applications.</td>
<td>itil, sn_mgr_workspace.manager, sn_wfo.user, sn_shift_planning.admin, coaching.coach, team_perf.user, sn_channel_mgmt.user</td>
</tr>
</tbody>
</table>
**Role title (name)**  | **Description**  | **Contains roles**  
--- | --- | ---  
**Workforce Optimization**  
**ITSM Admin**  
(sn_wfo_itsm.admin)  | Grants administrative rights to create, read, update, and delete (CRUD) coaching, scheduling, teams, or channel management applications.  |  
• sn_mgr_workspace.manager  
• sn_wfo.user  
• sn_shift_planning.admin  
• coaching.admin  
• sn_team_perf.team_performance_admin  
• sn_mgr_workspace.admin  
• sn_sre.skill_recommendation_admin  
• skill_model_admin  

**Scheduled job**

| **Name**  | **Description**  
--- | ---  
WFO data collection  | Runs the job on demand and collects data for all Workforce Optimization for ITSM indicators.  

**ITSM Manager Workspace**

**Roles**

| **Role title (name)**  | **Description**  | **Contains roles**  
--- | --- | ---  
Manager Workspace User  
(sn_mgr.workspace.user)  | Grants read access to home and list modules.  | workspace_user  
Manager Workspace Manager  
(sn_mgr.workspace.manager)  | Grants read access to primary groups, additional managers, and the approval button.  |  
• sn_mgr_workspace.user  
• sn_wfo.user  
Manager Workspace Admin  
(sn_mgr.workspace.admin)  | Grants administrative rights to create, read, update, and delete (CRUD) all applications and settings in Manager Workspace.  |  
• sn_mgr_workspace.manager  
• workspace_admin  
• ui_builder_admin  

**Properties**

| **Properties**  | **Description**  
--- | ---  
**cnm_skills.ws_max_users_swap_skill_matrix**  | The limit for the number of users to swap axes in the skill matrix.  
• **Type:** integer  
• **Default value:** 50  

Indicators

<table>
<thead>
<tr>
<th>Indicator Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed Incidents</td>
<td>Number of incidents closed.</td>
</tr>
<tr>
<td>Customer Satisfaction</td>
<td>Average customer satisfaction for incidents based on CSAT survey results. This indicator is associated with agent and assignment group breakdowns. It provides the customer satisfaction survey results for each agent and the agent's team.</td>
</tr>
<tr>
<td>Quality</td>
<td>Provides calculated assessment feedback score.</td>
</tr>
<tr>
<td>Average Handling Time (MTTR)</td>
<td>Mean time taken to resolve an incident.</td>
</tr>
<tr>
<td>First Call Resolution</td>
<td>Percentage of incidents resolved on first call.</td>
</tr>
</tbody>
</table>

Channel Management

Roles

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Management User (sn_channel_mgmt.user)</td>
<td>Grants read access to channel reports, channel view, and queue report tables.</td>
<td>awa_manager</td>
</tr>
<tr>
<td>Channel Management Admin (sn_channel_mgmt.admin)</td>
<td>Grants administrative rights to create, read, update, and delete (CRUD) channel reports, channel view, and queue report tables.</td>
<td>sn_channel_mgmt.user, awa_admin, sn_wfo.admin, report_admin</td>
</tr>
</tbody>
</table>

Note: Channel management properties are not visible by default and must be added to the System Property (sys_properties) table. For information on how to add a system property, refer to Add a system property

Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_channel_mgmt.list_auto_refresh.enable</td>
<td>Select to disable auto refresh of lists in Channel Management.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Type:</strong> True or False</td>
</tr>
<tr>
<td></td>
<td>· <strong>Default value:</strong> True</td>
</tr>
<tr>
<td>sn_channel_mgmt.list_auto_refresh.interval.seconds</td>
<td>Defines the auto-refresh interval for the channel management list.</td>
</tr>
<tr>
<td></td>
<td>· <strong>Type:</strong> Integer</td>
</tr>
<tr>
<td></td>
<td>· <strong>Default value:</strong> 30</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_channel_mgmt.kpi_auto_refresh.interval.seconds</td>
<td>Set the frequency for refreshing data on channel management indicators.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 5</td>
</tr>
</tbody>
</table>

## Reports

<table>
<thead>
<tr>
<th>Report name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interaction Work Items Assigned Today</td>
<td>Number of interaction work items assigned on a given day.</td>
</tr>
<tr>
<td>Abandoned Interaction Work Items</td>
<td>Number of abandoned interaction work items.</td>
</tr>
<tr>
<td>Unassigned Interaction Work Items</td>
<td>Number of interaction work items not assigned to agents.</td>
</tr>
<tr>
<td>Average Work Item CSAT Score</td>
<td>Customer Satisfaction score for an average work item.</td>
</tr>
<tr>
<td>Unassigned Incident Work Items</td>
<td>Number of incident work items not assigned to agents.</td>
</tr>
<tr>
<td>Completed Interaction Work Items</td>
<td>Number of interaction work items completed by agents.</td>
</tr>
<tr>
<td>Today's Average Interaction Service Time</td>
<td>Average time it takes to close an interaction.</td>
</tr>
<tr>
<td>Interaction Work Items Resolved Today</td>
<td>Average number of interaction work items resolved on a given day.</td>
</tr>
<tr>
<td>New Incident Work Items Created Today</td>
<td>New work items created for incidents on a given day.</td>
</tr>
<tr>
<td>Average Handling time for Interaction Work Items</td>
<td>Average time taken to resolve interaction work items.</td>
</tr>
<tr>
<td>Agents Available to take Interaction Work Items</td>
<td>Number of agents available to work on the interaction work items.</td>
</tr>
<tr>
<td>Breached SLA Incident Work Items</td>
<td>Number of work items with breached SLAs.</td>
</tr>
<tr>
<td>Open P1 Incident Work Items</td>
<td>Number of work items open for P1 incidents.</td>
</tr>
<tr>
<td>Incident Work Items Resolved Today</td>
<td>Number of work items resolved on a given day.</td>
</tr>
<tr>
<td>Average Walkup Interaction Wait Time</td>
<td>The average time a user is in queue before starting a walk-up interaction.</td>
</tr>
<tr>
<td>Currently Waiting Interaction Work Item</td>
<td>Work items currently in queue waiting to be processed.</td>
</tr>
</tbody>
</table>
# Scheduling

## Roles

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift Planning User (sn_shift_planning.user)</td>
<td>Grants read access for scheduling including the ability to view schedules and shifts.</td>
<td></td>
</tr>
<tr>
<td>Shift Planning Agent (sn_shift_planning.agent)</td>
<td>Grants agents access to their calendar. Agents can request shift swap or time off.</td>
<td>sn_shift_planning.user</td>
</tr>
<tr>
<td>Shift Planning Admin (sn_shift_planning.admin)</td>
<td>Grants administrative access to create, read, update, and delete (CRUD) schedules and work shifts.</td>
<td>sn_shift_planning.approver, sn_shift_planning.user, sn_shift_planning.agent</td>
</tr>
</tbody>
</table>

## Teams

## Roles

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teams User (sn_team_perf.team_performance_user)</td>
<td>Grants access to read KPI tables.</td>
<td>wfo.user</td>
</tr>
<tr>
<td>Teams Admin (sn_team_perf.team_performance_admin)</td>
<td>Grants access to create and configure KPIs, KPI groups, and assignment groups in the Teams module.</td>
<td>wfo.admin</td>
</tr>
</tbody>
</table>

## Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_team_perf.kpi_group.max_parent_kpis</td>
<td>The maximum number of parent indicators that you can add to one KPI group.</td>
</tr>
<tr>
<td>sn_team_perf.kpi_group.max_supporting_kpis</td>
<td>The maximum number of supporting KPIs you can define for a parent KPI.</td>
</tr>
</tbody>
</table>
### Paris IT Service Management

**Property**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sn_team_perf.ws.max_assignment_groups</code></td>
<td>The maximum number of assignment groups prioritized by order number to display on the Teams application in Manager Workspace.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type:</strong> Integer</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value:</strong> 15</td>
</tr>
<tr>
<td><code>sn_team_perf.default_date_range</code></td>
<td>The default date range set in the date range picker.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type:</strong> Integer</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value:</strong> 30</td>
</tr>
</tbody>
</table>

### Coaching

**Roles**

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaching Admin (sn_coaching.admin)</td>
<td>Grants administrative rights to create, read, update, and delete (CRUD) coaching opportunities, assessments, training, and skills.</td>
<td>sn_coaching.coach</td>
</tr>
<tr>
<td>Coaching Coach (sn_coaching.coach)</td>
<td>Grants administrative rights to create, read, or update coaching opportunities, assessments, training, and skills.</td>
<td>sn_coaching.trainee, pa_viewer</td>
</tr>
<tr>
<td>Coaching Trainee (sn_coaching.trainee)</td>
<td>Grants access to add training, assessments, and skill records.</td>
<td>skill_user, pa_viewer, survey_reader</td>
</tr>
</tbody>
</table>

**Business rule**

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate coaching survey score</td>
<td>Assessment Instance (asmt_assessment_instance)</td>
<td>Sets the feedback rating based on the survey score.</td>
</tr>
</tbody>
</table>
Skill Recommendation

Roles

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skill Recommendation User (sn_sre.user)</td>
<td>Grants rights to view skill recommendation tables.</td>
<td>wfo.user</td>
</tr>
<tr>
<td>Skill Recommendation Admin (sn_sre.admin)</td>
<td>Grants administrative rights to edit the properties for skill recommendation.</td>
<td>wfo.admin, sn_sre.user</td>
</tr>
</tbody>
</table>

Navigate to **Skill Recommendation > Configuration** to configure these properties.

Properties

- **Enable skill recommendation.**
  - Type: true
    - false
  - Default value: true
Using supervised learning, the maximum number of skills to predict for each incident ordered by confidence of prediction.

- **Type:** Integer
- **Default value:** 3

Using unsupervised learning, the maximum number of skills to predict for each incident ordered by confidence of prediction.

- **Type:** Integer
- **Default value:** 3
The number of resolved similar incidents to use for predicting skills using supervised learning, ordered by confidence of prediction, to resolve similar types of incidents.

- **Type**: Integer
- **Default value**: 15
The number of times Predictive Intelligence must predict the same skill for an agent before recommending the skill. The sn_search.user_predicted_skill_threshold agent:

- **Type**: Integer
- **Default value**: 20
Similarity solution definition to recommend skills from similar incidents.

sn_sre.unsupervised_solution_definition_for_incidents

Name of the Predictive Intelligence solution definition used for predicting skills to resolve incidents using unsupervised learning. If you have created your own solution definition, you can replace the default one with the one you have created.

- **Type**: String
- **Default value**: ml_sn_sn_sre_global_recommend_similar_skills_for_incidents
Paris    IT Service Management

property
description
similarity
solution
definition
to
recommend
skills
for
incidents.

sn_sre.supervised_solution_definition_for_incidents

Name of the Predictive Intelligence solution definition used for predicting skills to resolve incidents using supervised learning. If you have created your own solution definition, you can replace the default one with the one you have created.

- **Type:** String
- **Default value:** ml_sn_sn_sre_global_recommend_skills_from_similar_incidents

Scheduled job

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start skill prediction</td>
<td>Runs the job every day at 1 AM on all incidents that were closed the previous day. Recommends the skills used to close the incidents to resolve similar open incidents.</td>
</tr>
</tbody>
</table>
## Domain separation and Workforce Optimization for ITSM

Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

### Overview

**Support level: Basic**

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

### How domain separation works in Workforce Optimization for ITSM

Domain separation is supported in Workforce Optimization for ITSM and does not require any setup or configuration.

### Domain separation for Scheduling Workforce Optimization for ITSM

When an agent schedule is generated and assigned to an agent, the schedule is only available in the domain to which that agent belongs.

Domain separated tables for Scheduling
- `sn_shift_planning_agent_schedule`

---

**Tables**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| User Predicted Skill (sn_sre_user_predicted_skill) | - Stores how many times a skill has been predicted for the user.  
- Skills not recommended in the last 60 days are automatically deleted from this table. |
| Task Predicted Skill (sn_sre_task_predicted_skill) | - Stores the skills predicted to resolve each type of incident.  
- Tables created over 60 days ago are automatically deleted from this table. |
• sn_shift_planning_agent_schedule_request
• sn_shift_planning_break
• sn_shift_planning_day
• sn_shift_planning_event
• sn_shift_planning_schedule_plan
• sn_shift_planning_schedule_shift
• sn_shift_planning_schedule_shift_agent
• sn_shift_planning_shift_plan
• sn_shift_planning_shift_swap_request

Domain separation for Teams in Workforce Optimization for ITSM

The sn_wfo_add_manager table is domain separated. When users are added as additional managers, those users can only view users within that domain.

Domain separation for Skill Recommendation in Workforce Optimization for ITSM

Domain separated tables for Skill Recommendation
• sn_sre_task_predicted_skill
• sn_sre_user_predicted_skill

Domain separation for Coaching in Workforce Optimization for ITSM

For information on how domain separation works in Coaching for Workforce Optimization for ITSM, refer to Domain separation and Coaching

Setting up Channels in Workforce Optimization for ITSM

Channel administrators can set up service channels and work item queues and then automatically route incoming work to agents. Managers can monitor their agents' work across all channels and drill down into the KPIs to analyze team performance.

Set up Channel Management using the information provided below. To use Channel Management, refer to Use Channel Management in Workforce Optimization for ITSM.

Add service channels and queues

Add service channels and queues to automatically route incoming work items to agents.
Role required: sn_channel_mgmt.admin

A service channel is a means of assigning a specific type of work items to agents. You can modify the existing service channels or create your own custom service channel.

1. To create a service channel, do the following:
   1. Navigate to Workforce Optimization for ITSM > Channel Management > Service Channels.
   2. Click New and refer to the information in the Create a service channel to create the service channel.
   3. Click Submit.
The service channel is created.

2. To create a queue, do the following:
   1. Navigate to Workforce Optimization for ITSM > Channel Management > Queues or select the service channel and click the Queues tab.
   2. Click New and refer to the information in Create a work item queue to create the queue.

The queue is created in the service channel.

Create assignment rules and groups

Define assignment rules and specify groups of agents eligible to receive overflow work assignments for a queue. An eligible assignment group can consist of one or more groups of agents available to work on items in the queue. This feature helps to find a qualified agent from a wider group of agents.

Role required: sn_channel_mgmt.admin

1. Navigate to Workforce Optimization for ITSM > Channel Management > Queues
2. Select a queue to define an assignment rule.
3. In the Assignment Eligibility tab, click New.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent assignment rule</td>
<td>Name of the rule to assign work items to agents.</td>
</tr>
<tr>
<td>Eligible at</td>
<td>The duration that this assignment rule is valid for a set of agents.</td>
</tr>
<tr>
<td>Groups</td>
<td>The set of groups eligible for assignment.</td>
</tr>
<tr>
<td></td>
<td>• Click the lock icon to unlock it and select the agent groups in the eligible assignment pool.</td>
</tr>
<tr>
<td></td>
<td>• Click the lock icon to lock it.</td>
</tr>
</tbody>
</table>

5. Click Submit to create the eligible or Update if modifying an eligible assignment pool. The Queues (awa_queues) table is updated with the eligible assignment group.

Note: For a new service channel, you must first create a new assignment rule and then create a service channel.

Configure KPIs for service channels

Configure key performance indicators in service channels to track the ongoing work and real-time performance of your teams.

Role required: sn_channel_mgmt.admin

Add key performance indicators to channels to help managers perform the following actions:

- Review real-time performance as the team is actively working on tasks across channels and queues.
- Track progress against KPIs and drill down into agents, team, and individual performance.
- Drill down into all queues and monitor ongoing cases, interactions, and tasks.
Jump in and support agents for help requested work items using chat whisper or add work notes to a task.

1. Click the service channel to which you want to add KPIs.
2. In the Reports tab, click Edit.
3. Add Workforce Optimization for ITSM KPIs filtered based on My Managed Groups. To create reports that are explicitly applicable to your managed teams, refer to Create a report.
4. Click Submit.
   The key performance indicators are added to the service channel and appears in the Channels and Queues page in Manager Workspace. The first five KPIs that are configured with the lowest order number appear in the service channel. By default, the key performance indicators are automatically refreshed at an interval of five seconds. You can add the sn_channel_mgmt.kpi_auto_refresh.interval.seconds property in the system properties to modify the interval time of the single score KPIs.

Configure KPIs for queues

Configure key performance indicators in queues to track the incoming work for specific categories of work in a service channel.

Role required: sn_channel_mgmt.admin

1. Add KPIs to a queue.

   To | Do This
   ---|---
   Add from a service channel | 1. Navigate to Workforce Optimization for ITSM > Channel Management > Service Channel  
   | 2. Select a service channel.  
   | 3. Select the Queue tab.  
   | 4. Select a queue.

2. Click the Reports tab.

   Note: You may have to configure the related list to display the Reports tab.

3. Click Edit.
4. Add Workforce Optimization for ITSM KPIs (reports) that are filtered based on My Managed Groups. To create reports that explicitly apply to your managed teams, refer to Create a report.
5. Click Submit.
   The key performance indicators are added to the queue and appear in the All Queues tab in Manager Workspace. By default, the indicators get automatically refreshed at an interval of five seconds. You can add the sn_channel_mgmt.kpi_auto_refresh.interval.seconds property to the system properties to modify the interval time.

Configure supervisor lists for service channels

Create a database view in a service channel.
Role required: sn_channel_mgmt.admin

1. Navigate to **Workforce Optimization for ITSM > Channel Management > Service Channels**.
2. Select the service channel to which you want to add a supervisor list.
3. Click the **Supervisor Lists** tab.
4. Click **New**.
5. Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Title</td>
<td>The display name for the list.</td>
</tr>
<tr>
<td>Tab Title</td>
<td>Title for the tab that displays in workspace.</td>
</tr>
<tr>
<td>Service Channel</td>
<td>A service channel that has the supervisor list.</td>
</tr>
<tr>
<td>View Name</td>
<td>Select the database view for the service channel.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter the number to display the order.</td>
</tr>
</tbody>
</table>

6. Click **Update**.
   The supervisor list is added to the service channels in Manager Workspace.

**Setting up Teams in Workforce Optimization for ITSM**

Organize your teams into assignment groups and create reports for those groups so that you can gain visibility into the team's performance.

**Create KPI groups to monitor team performance**

Create key performance indicator (KPI) groups with the KPIs that matter most to your teams. When you associate your KPI groups with assignment groups, you can monitor your team's performance.

Role required: sn_team_perf.team_performance_admin

By default, the KPIs that are associated with your KPI assignment groups are scheduled to collect data daily. The KPIs must have the following indicator breakdown:

- Assignment groups
- Assigned to

1. Create a KPI group.
   1. Navigate to **Workforce Optimization for ITSM > Team Performance > KPI Groups**.
   2. Click **New**.
   3. In the **Name** field, enter a name for the KPI group.
   4. In the Type menu, select **Teams**.
   5. Right-click the form header and click **Save**.

   You can add up to five KPIs to a KPI group. For more information about KPIs and how the aggregates are calculated, see the overview video in the **Teams example** section.

2. Add KPIs to a KPI group.
   1. In the KPIs related list, click **New**.
   2. In the **KPI** field, select the KPI to apply for this group.
3. Click **Submit**.

3. Add KPI assignment groups to the KPI group.

   **Note:**
   - You can associate a KPI assignment group to only one KPI group.
   - You can add additional managers to each assignment group.
   - You can associate a user with a KPI group as the primary assignment group for that user.

   1. In the **Assignment Groups** tab, click **Edit**.
   2. Move the desired assignment groups from the Collection to the Assignment Groups list.
   3. Click **Save**.

---

### Add managers to a KPI assignment group

Assign one or more managers to each KPI assignment group so that they can gain visibility into the group and monitor the team's performance.

Role required: sn_wfo_admin or admin

You can associate a user with a primary assignment group by selecting the group in the user record.

1. Navigate to **Workforce Optimization for ITSM > Team Performance > Additional Managers**.
2. Click **New**.
3. In the **Assignment Group** field, select an assignment group.
4. In the **Manager** field, select a manager that you want to add to this assignment group.
5. Click **Submit**.

---

### Analyze the performance trends for your teams.

---

### Setting up skill prediction in Workforce Optimization for ITSM

Collect skill data based on skills agents have used for incident resolution. Use supervised learning to recommend these skills for agents to resolve similar open incidents. You can also find patterns in how skills are used for incident resolution and use unsupervised learning to recommend skills for agents.

Predictive Intelligence must be set up and configured on your instance to train the models. For more information, see [*Predictive Intelligence*](#).

Activate the Skill Recommendation application plugin (com.snc.sre) to use predictive intelligence for recommending skills.

Role required: sn_sre.admin

1. Configure the **properties for the Skill Recommendation application**.
2. Run the solution definition models to train the supervised and unsupervised solutions. For more information on training a solution, refer to [*Create and train a similarity solution*](#).
3. Run the **Start skill prediction** scheduled job everyday to start predicting skills for incidents or agents.
This scheduled job is inactive by default. When you activate it, the job runs daily at 1:00 AM on all incidents resolved the previous day. The job then adds the skills to the User Predicted Skill (sn_sre_user_predicted_skill) table and Task Predicted Skill (sn_sre_user_predicted_skill) table.

Use extension points for skill prediction

Use scripted extension points to customize skill prediction for tasks.

The Skill Recommendation extension point is included with the Skill Recommendation (com.snc.sre) plugin.

Role required: admin

You can create multiple implementations for each extension point and provide an order number for each implementation. The implementation that has the lowest order number is executed.

1. Navigate to System Extension Points > Client Extension Points.
2. From the Extension Points list, select Skill Recommendation (sn_sre.SkillPredictionAPI).
3. Do one of the following:
   - To create a new skill recommendation implementation, click Create Implementation.
   - To modify an existing implementation, from the Implementations related list, select a class.
4. Modify the script as required.
5. Click Update.

Use Workforce Optimization for ITSM

Enhance the quality and efficiency of your teams using smart scheduling and monitor team performance in a unified location. Assess the quality of tasks completed, recommend skills for agents, and train them to address skill gaps.

Workforce Optimization for ITSM manager landing page

Monitor your teams' work and organizational performance using Workforce Optimization for ITSM.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>As a workspace manager, you can:</td>
<td>sn_mgr_workspace.manager</td>
</tr>
<tr>
<td>· Analyze the incidents your team is currently working on or incidents that have not yet been assigned.</td>
<td></td>
</tr>
<tr>
<td>· Monitor incidents with SLAs that have been breached or at risk, open P1 incidents, or the ones not been updated in 24 hours.</td>
<td></td>
</tr>
<tr>
<td>· Track the mean time to resolution, first call resolution, and customer satisfaction to analyze the performance of your whole organization.</td>
<td></td>
</tr>
</tbody>
</table>

Use case

Monitor your agent's work when you start your day, view reports that need your attention, and navigate to the incidents on which you want to take action.

Indicators

Mean time to resolution
The average time taken to resolve incidents.

First call resolution
Number of incidents resolved the first time it was handle by an agent.

Customer satisfaction
Overall customer satisfaction on incident resolution.

My teams' work
A list of incidents assigned to the teams managed by the current logged-in user.

Unassigned incidents
A list of incidents assigned to groups managed by the current logged-in user that does not have an assignee.

Breakdowns

- Priority
- Category
- Assignment Group
- Assigned To
## Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open P1 Incidents</td>
<td>Single</td>
<td>Number of open incidents with top priority.</td>
</tr>
<tr>
<td>Incidents not updated in 24 hours</td>
<td>Single</td>
<td>Number of incidents that have not been updated in the last 24 hours.</td>
</tr>
<tr>
<td>Incident SLAs Breached</td>
<td>Single</td>
<td>Number of incidents with SLAs that have been breached.</td>
</tr>
<tr>
<td>Incident SLAs at Risk</td>
<td>Single</td>
<td>Number of incidents with SLAs that are at risk.</td>
</tr>
</tbody>
</table>

### Channels in Workforce Optimization for ITSM

Route work items to assigned groups using channels. Use skill-based routing to ensure that the right work goes to the right agent. Review real-time performance as your team is actively working on tasks across channels. When you see escalations, you can help your agents resolve issues without the requester being aware of it.

### Use Channels in Workforce Optimization for ITSM

Use Channels to monitor ongoing work, jump in to escalations, and to track and manage agent performance.

*Monitor ongoing work in service channels and queues*

Monitor the incoming data and on-going work done by your agents against each service channel and queue.

Role required: sn_wfo_itsm.manager
Track the real-time performance of your teams directly reporting to you and the teams you have visibility into. Drill down into the data for a work item, a specific agent, service channel, queue, or assignment group. Assign the work items or help agents as needed.

Drill-down into the specific record and perform the following actions against each channel and queue:

- Real-time information of ongoing incidents, interactions, and other tasks.
- Work done during the day.
- Waiting work items that must be assigned.
- Drill down and view agent information in one or more assignment groups.
- Summary information across queues and agents
- Take or change ownership.
- Add comments.

1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.
2. Using one of the following ways, select a service channel:
   - From the **Overview** section.
   - From the **Active Work Items** tab.
3. Monitor ongoing work from agents.

### Manage service channels and queues
Manage your agents' on-going work against every queue. Monitor the incoming data of the service channels and track real-time performance of your direct reporting teams and additional managing teams using key performance indicator reports in service channels and queues.

Role required: sn_wfo_itsm.manager

The work item views display the list of pending and queued work items from all channels and queues. Drill down into the specific record to get an idea of how much work is at-hand within the team on various channels and queues pertaining to the assignment groups. The work item is allocated to qualified agents using work item queues, routing conditions, and assignment criteria that you define. Using channels and queues, managers at a glance can gain visibility into the team’s on-going work, quality of service, and improve agent performance and end-user experience.

1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.
2. Click the **Channels** icon.
3. Click the **Queues** tab.
4. Select a queue and do any of the following:
   - Assign work items to agents.
   - Take or change work item ownership.
   - Review agent performance.

### Assist agents by joining their chat conversation
Assist agents in real time by joining their chat conversation and collaborate on any record by connecting with the right people instantly to achieve faster resolution.

Role required: sn_wfo_itsm.manager

View the work-in-progress chat interactions and see if any of the agents has set the Help Requested flag as Yes. Open the interaction record and view all messages exchanged between
the end user and agent, gain the context and choose to join the conversation by either sending internal messages or joining the conversation in public.

1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Do one of the following:
   • Click the Help Requested indicator on the landing page.
   • Click the Channels icon, select a queue and then click the Active Interactions tab.
   • In Lists, click Conversation Monitoring.
3. Click the interaction record for which you want to join the conversation.
4. Choose Join Conversation to start interacting with the agent or Send Private Message to send an message that only goes to the agent.
   The chat conversation is established.

Allocate work items manually to agents
Allocate pending work items to agents to complete the work.

Role required: sn_wfo_itsm.manager

Ensure that the agent has relevant skills, availability, and access to at least one queue in the service channel.

The active work items remain in the queue pending manual allocation for one of the following reasons:
• The agent’s capacity is exceeded to the maximum.
• Work items may not be accepted by any available agents.
• Agents with required skills are not available.

1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Click the Channels icon.
3. Do one of the following to manually allocate the work items:

<table>
<thead>
<tr>
<th>Navigate To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Work Items tab</td>
<td>Select the work item and click <strong>Allocate</strong>.</td>
</tr>
<tr>
<td>Service Channel page</td>
<td>1. Click a service channel. For example, Chat.&lt;br&gt;2. Click the Work Items tab.&lt;br&gt;3. Select the work item.&lt;br&gt;4. Click <strong>Allocate</strong>.</td>
</tr>
<tr>
<td>All Queues tab</td>
<td>1. Click a queue.&lt;br&gt;2. Click the Work Items tab.&lt;br&gt;3. Select the work item.&lt;br&gt;4. Click <strong>Allocate</strong>.</td>
</tr>
</tbody>
</table>

The list of available agents appears with details such as presence state, capacity, and matching skills.

4. Select the agent to assign the work item. For example, if the capacity is 0/4, it means that the agent’s maximum capacity is 4 work items.
Note: You can allocate a single work item at a time to the agent.

5. Click **Allocate**.

The work item is allocated to the selected agent. The agent gets an alert on the assigned work item.

- If the agent accepts the work item and the status moves from **Pending Accept** to **Accepted** state. The **Assigned To** field is updated with the agent’s name.
- If the agent rejects the work item and the status moves to **Queued** state.
- If the agent does not accept the work item for a long time and the status remains in **Pending Accept** state and you must allocate it again.

**Track and analyze agent’s performance**

View your agent’s profile and summary information in Agent 360 and review their performance.

Role required: sn_wfo_itsm.manager

You can drill down into the data for a specific agent and view the following details.

- Real-time information of ongoing cases, interactions, and other tasks.
- Upcoming time off.
- Assigned training tasks.
- Skill set, schedule, and profile

1. Navigate to **Workforce Optimization for ITSM > Channel Management > Service Channels**.
2. To view information about the agent and their work, click the **All Agents** tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent</td>
<td>Agent name. Click the agent’s name to view the agent’s profile summary in Agent 360.</td>
</tr>
<tr>
<td>Service Channel</td>
<td>Service channel name.</td>
</tr>
<tr>
<td>Total Capacity</td>
<td>Number of items automatically assigned to agents (pending overrides).</td>
</tr>
<tr>
<td></td>
<td>- Chat: The default is 4.</td>
</tr>
<tr>
<td></td>
<td>- Incident: The default is 2.</td>
</tr>
<tr>
<td>Capacity in use</td>
<td>The number of on-going work items.</td>
</tr>
<tr>
<td>Utilization</td>
<td>Condition that determines what constitutes an active item that counts toward agent workload/capacity in percentage.</td>
</tr>
<tr>
<td>Assignment Group</td>
<td>Group to which the work item is assigned.</td>
</tr>
</tbody>
</table>

**Using Cloud Call Center with Workforce Optimization for ITSM**

Use Cloud Call Center to deflect incidents using bots, record phone interactions when agents resolve issues and monitor those interactions to evaluate and improve the quality of incident resolutions.

You can enable the workforce to work with the voice channel, get call recordings, call transcripts, and sentiment analysis reports of agent interactions with callers using the Cloud Call Center application and visualize all of this within Workforce Optimization for ITSM. Analyze the call
transcripts and user sentiments after an interaction is complete and create assessments to provide feedback and training for agents. You can also synchronize agent presence within the queue.

Cloud Call Center allows you to integrate with any third-party telephony service. By default, Cloud Call Center provides you with the ability to integrate with Amazon Connect. To learn more about Cloud Call Center, see Cloud Call Center.

Visualize the metrics from the Amazon Connect phone queues routed through Cloud Call Center using the Channels application in Workforce Optimization for ITSM. The Cloud Call Center uses Advanced Work Assignment to report data from the Amazon Connect queues.

Here is a representation of the Cloud Call Center integration with Amazon Connect:
Let’s try and deflect the call
Cloud Call Center recognizes this is Zeke and identifies that there is a wifi issue in his office location

There is a wifi issue in San Diego. Is this why you are calling?

“No, can you please tell me the status of my request?

I will look up the status of your request.

Data lookup
Operation handlers find Joe's request

Your request should be completed in 5 days.

That’s way too long! Please transfer me to an agent.
As a manager, you can:

- Monitor agent calls as they resolve customer issues.
- View synchronized agent presence states within the Channels application in Workforce Optimization for ITSM.
- Assess agents by reviewing recordings of agent interaction and call transcripts.
- Analyze sentiments from the call transcripts and use that to coach and train your agents.

As an agent, you can:

- Get information about the caller before you answer an incoming call.
- View call transcripts and listen to recordings after you complete an interaction.
- Place outbound calls using automated outbound dialing.

**Associate Amazon Connect queues for ITSM to a ServiceNow instance**

Set up phone queues for Amazon Connect to gain visibility into the queues using Workforce Optimization for ITSM.

You must have the Advanced Work Assignment plugin (com.glide.awa) installed to create the Amazon Connect queues. Make sure you install this plugin before you install Cloud Call Center Core (sn_cti_core) plugin for Cloud Call Center to be able to integrate the two applications.

Role required:

sn_wfo_itsm.admin and sn_cti_amzn_cct.admin

After an agent completes a call, you can get insights into data such as:

- who was on hold and how long they were on hold
- how long calls are taking
- which agents are available and when
- how many agents are available and what is their current utilization

using Workforce Optimization for ITSM.

The following queues are available when you install the demo data along with the sample contact flow:

- **Basic Queue**: calls get routed to this queue when an utterance is generic, such as, “I want to talk to an agent”.
- **VIP Queue**: calls get routed to this queue when a user who has the VIP field enabled calls Support.
- **IT Equipment Support**: calls get routed to this queue when an utterance includes IT equipment support or hardware issues.
- **Application Support**: calls get routed to this queue when an utterance includes application support.

In the Amazon Connect instance that is integrated with your ServiceNow instance using Cloud Call Center, you must create a routing profile for each agent. Each profile can be associated with multiple Amazon Connect agent queues. Each of these agent queues must be associated with the corresponding agent queue in your ServiceNow instance using an Amazon Connect ARN number. This association allows you to report on queue statistics and call metrics within Workforce Optimization for ITSM.

1. Create placeholder queues for an Amazon Connect (phone) service channel if you need additional queues. For more information on creating the queue, refer to Create a work item queue.
2. Associate the ServiceNow Advanced Work Assignment (AWA) queue record with the Amazon Web Services (AWS) queue ARN.

3. Add assignment groups to a queue.
   1. Select a work item queue.
   2. Click Group Queue Priorities related list.
      
         **Note:** You must configure the form to display this related list.

3. Click New.

4. In the **Group** field, add an assignment group that include agents who can handle this queue.

5. In the **Order** field, select the order number for the assignment group. This is the order of assignment group priority in which the incoming calls are handled.

6. Click Submit.

**Listen in to an agent call**

Monitor agent calls when they are resolving issues for the customer.

Role required: sn_wfo_itsm.manager

You must also have an active session with Amazon Connect and be able to monitor live conversations. For more information, refer to **Monitor live conversations**

When a call comes in from the external source and is answered by Amazon Connect, an interaction is created.

1. **Monitor your agent’s call queue** when an agent is talking to an external caller in Workforce Optimization for ITSM.
2. Open the active interaction when the phone call is in progress, click **Monitor Call**, and listen into the call in Amazon Connect.

**Analyze transcripts and sentiments for the Amazon Connect phone channel**

When an agent is interacting with an external caller, the calls gets recorded and transcribed. Every statement within a transcript gets tagged with a sentiment score that generates a sentiment report after the call has been completed. Gain visibility into the call recording and transcripts and analyze reports on the sentiments to assess the call quality and train your agents.

Role required: sn_cti_core.user_manager

The manager must have an active session with Amazon Connect to view the transcripts and sentiments. The transcripts and sentiments are generated in the Amazon Connect application and displayed in the Channels application in Workforce Optimization for ITSM.

1. Navigate to **Workspace Optimization for ITSM > Manager Workspace**.
2. Select an interaction record to analyze transcripts and sentiments.
<table>
<thead>
<tr>
<th>To analyze call transcripts and sentiments</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Channels</td>
<td><img src="image" alt="Note: You can view call transcripts and sentiments for all interactions that were closed today." /></td>
</tr>
<tr>
<td>1. Click the Channels icon.</td>
<td></td>
</tr>
<tr>
<td>2. Click Amazon Connect (Phone).</td>
<td></td>
</tr>
<tr>
<td>3. From the All Interaction tab, select an interaction record.</td>
<td></td>
</tr>
</tbody>
</table>

| From Teams                               |         |
| 1. Click the Teams icon.                 |         |
| 2. Select a team.                        |         |
| 3. Select a user.                        |         |
| 4. Click the Interactions tab.           |         |
| 5. Select an interaction record.         |         |

| From Coaching                            | ![Note: When you have assessments triggered from calls, you can view call transcripts and sentiments for those interactions.](image) |
| 1. Click the Coaching icon.              |         |
| 2. Click the Assessment tab.             |         |
| 3. Select an interaction record.         |         |
| 3. Click Call Analysis.                  |         |

3. **Click Call Analysis.**

The report displays all interactions and sentiment analysis of those interactions that are generated by Amazon Connect.

4. **Optional: Assess the quality of completed interactions** and assign training to coach the agents.

### Scheduling in Workforce Optimization for ITSM

Manage your workforce efficiently by planning shifts for each day and assigning users to the shifts. With Scheduling, you can use your resources efficiently by planning and managing schedules across your teams from one location.

### Create a shift plan

Schedule shifts for your team so that you can make sure that you are covering all work assignments and breaks. You can also specify the days of the week that you might need to override scheduled shifts.

Role required: sn_shift_planning.admin

1. Create a work shift.
   1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.
   2. Click the Schedule icon.
3. Click the **Shift** tab.
4. Click **New**.
5. In the **Name** field, enter a name for the shift.
6. Select the time window for the shift.
   a. In the **Time Zone** field, select the time zone of the users that you want to allocate to the shift.
   
   **Note:** To add a shift for agents working in their local time zones, select the **Use agent time zone** option. The system uses the time zone that is specified in the agent’s user record.

   b. In the **Start Time** field, enter the time of day when you want to start the shift.
   c. In the **End Time** field, enter the time of day when you want to end the shift.
7. Click **Save**.

2. Set the days of the week that you want to add to the shift.
   2. Click the **Days of the Week** tab.
   2. Click **New**.
   3. In the **Days of the week** field, select a day.
   4. If you want to add an override for this shift, select the **Override shift times** option.
   
   For example, you can initially set a shift that spans from 9:00 to 17:00. You can override this shift span to start at 7:00 and end at 16:00.
3. Optional: Add schedule breaks to the shift.
   1. Click the **Breaks** tab.
   2. Click **New**.
   3. In the **Name** field, enter a name for the break.
   4. Set a duration for the break.
      a. In the **Duration** field, enter the length of time for the break.
      b. In the **Earliest Start Time** field, enter the earliest time to start the break.
      c. In the **Latest End Time** field, enter the latest time to end the break.
      
      For example, you can set the earliest start time as 11:00, the latest end time as 15:00, and the duration of the break as one hour. If you add four agents to that work shift, the Scheduling application automatically staggers the break duration for each agent. Stagger breaks to ensure that your four agents can cover the entire shift span.
      
      d. Click **Save**.

4. Click **Submit**.
Create a schedule plan

Manage your team's schedule by creating a schedule plan that covers a span of time and includes your team's work shifts. You can also assign agents to shifts based on their skills and availability. This way, you can make sure that you are using your resources in the best way possible for your organization.

Role required: sn_shift_planning.admin

1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Click the Schedule icon.
3. Click New.
4. Create a schedule plan.
   1. In the Name field, enter a name for the schedule plan.
   2. From the Start Date field, select a date to start the schedule plan.
   3. From the End Date field, select a date to end the schedule plan.
   4. Click Save.
5. Add a work shift to the schedule plan.
   1. Select the Work Shifts tab.
   2. Click New.
   3. In the Shift field, select the work shift that you want to assign for the schedule plan.
   4. Click Save.
6. Add agents to the work shift.
   1. Select the Agent tab.
   2. Click Add Agents.
   3. Select the agents that you want to add to the schedule shift.
   4. Click Add.

Generate a preview of a schedule plan

Generate a preview of your schedule plan and publish it so that your agents can see what their shifts and schedules are ahead of time.

Role required: sn_shift_planning.admin

You can update a schedule after you generate a preview. Updates could include adding or removing agents or modifying work hours or shift breaks. You can also unpublish a schedule to make changes, make updates, and then publish it again. When you unpublish a schedule, the scheduler changes the end date to the current date and the schedule is removed from the agent's calendar.

1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Click the schedule icon.
3. Click the Schedule tab.
4. Select a schedule plan that you would like to publish.
5. Preview the plan.
1. Click **Generate Preview**. The schedule is queued for processing and generates the schedule preview.
2. Click the **Preview** tab.
3. Review the schedule plan and make updates as necessary.

6. Click **Publish Schedule**. You can view the published schedule in the **team calendar**.

### Track and manage your teams’ schedule

Create, update, or monitor your teams’ schedule from one location. You can approve or reject requests for swapping shifts or time off for agents within your assignment group.

**Role required:** sn_shift_planning.admin

Using the calendar, you can access the list of all of your agents by assignment group. When you select a shift for an agent, you can see the agent’s work schedule including the break time. You can also view the number of agents that are scheduled at every time interval for each group.

1. **Modify an agent’s shift.**
   
   The schedule that includes this shift must be in **Preview** or **Published** state.

   1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.
   2. Click the Schedule icon.
   3. In the **Calendar** tab, navigate and point to the shift for the agent that you want to modify the schedule for.
   4. In the shift pop-up window, click the Edit icon.
   5. Modify the agent’s shift as desired.
   6. Click **Save**.

2. **Approve or reject an agent’s time off or shift-swap with another agent.**

   1. Click **Approvals**. You can view all agent requests in your queue and the details for each request.
   2. Select a request that you want to approve or reject and do one of the following:
      - To approve a request, click **Approve**.
      - To reject a request, click **Reject**.

   If you approve the request, the schedule gets updated in the calendar based on the approvals.

### Teams in Workforce Optimization for ITSM

Use Teams to track and analyze performance trends for your teams from a single location. You can monitor the trends for each agent within your team and compare your agents or team members with one another. With Teams, you can identify skill gaps so that you can recommend which skills are needed to coach your agents.

Organize your teams into assignment groups. You can add a set of key performance indicators (KPIs) to help you measure team performance consistently across the groups.
For example, let’s say that you manage the IT Service Desk unit. The unit contains multiple teams, such as Hardware and Network Support. You can create a KPI group for the IT Service Desk unit and then add Hardware and Network Support as assignment groups to this KPI group. Next, you add a set of KPIs to the KPI group. With this data, you can measure the performance trends across the Hardware and Network Support teams.

**Analyze the performance trends for your teams**

Analyze trends to monitor your team’s performance within a KPI group.

Role required: sn_mgr_workspace.manager

Analyze the data by drilling down into the data for a team, a specific team member, an indicator, or an incident.

1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Click the Teams icon.
3. Select a date range to view your team’s performance for that time period.
   You can set the default date range using the sn_team_perf.default_date_range system property.

   All teams that you manage are identified with a My team highlight in the group header. You can also see the team that you have visibility into.

4. Analyze your team’s performance.
   1. Select a team.
   2. In the Performance tab, track and analyze the overall indicator performance for all members in the team.
   3. Drill down into the data for this team:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze indicator performance</td>
<td>• To analyze the indicator performance for the team, click an indicator value for the team in the header row.</td>
</tr>
<tr>
<td></td>
<td>• To analyze indicator performance for a team member, click an indicator value for the team member.</td>
</tr>
<tr>
<td>Track incidents</td>
<td>Click the Tasks tab and analyze all incidents that are related to the team.</td>
</tr>
<tr>
<td></td>
<td>• To view the incident details, select an incident.</td>
</tr>
<tr>
<td></td>
<td>• To view a team member’s details, select a team member.</td>
</tr>
</tbody>
</table>

You can also review incidents, details of assignment groups, additional managers, and information that is relevant to the team.

**Coaching in Workforce Optimization for ITSM**

By using Coaching in Workforce Optimization for ITSM, you can assess your team’s abilities to efficiently resolve incidents by reviewing their work at critical service moments.

With Coaching, you can do the following:
Assess the quality of your agent’s completed tasks

Assess the ability of your agents to resolve incidents or the quality of their completed tasks.

Coaching assessments get created and assigned to the coach based on the trigger conditions that are defined in coaching opportunities.

Role required: sn_coaching.coach

If the coaching opportunity includes a survey, you can opt to take the survey and the assessment. When you use a survey to assess a trainee, the score for the survey is automatically calculated when you complete the survey. The assessment rating is then updated based on that score.

The Coaching Overview screen displays the average quality of the tasks that were completed in the past 30 days for your assignment groups.

1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Click the Coaching icon.
3. Click the Assessments tab.
4. Select an incident to assess.
5. On the form, fill in the fields.

Assessments form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opportunity</td>
<td>Coaching opportunity that is associated with the coaching assessment.</td>
</tr>
<tr>
<td>State</td>
<td>State of the assessment.</td>
</tr>
<tr>
<td></td>
<td>• Open: New coaching opportunity</td>
</tr>
<tr>
<td></td>
<td>• Work in progress: Trainee is being coached</td>
</tr>
<tr>
<td></td>
<td>• Resolved: Trainee is assigned coaching programs and training modules.</td>
</tr>
<tr>
<td></td>
<td>• Closed Complete: Assessment has been resolved and closed.</td>
</tr>
<tr>
<td></td>
<td>• Closed Incomplete: Assessment that has been closed but not completed, typically because the coaching assessment Due Date has expired.</td>
</tr>
<tr>
<td>Assessment Rating</td>
<td>How well the agent resolved the incident. The Coaching application automatically populates this field when a coach completes a survey for the trainee.</td>
</tr>
<tr>
<td>Follow up</td>
<td>Whether the coach must take further action to improve the trainee performance.</td>
</tr>
<tr>
<td>Comments</td>
<td>Notes, if any, to add about the assessment.</td>
</tr>
<tr>
<td>Award skills on completion</td>
<td>Option that you can enable to automatically add skills to the trainee when the training is complete.</td>
</tr>
</tbody>
</table>
Manage skills using Workforce Optimization for ITSM

Add or update skills for an agent. You can approve predicted skills if the skill is necessary for the agent to complete assigned tasks. You can also reject a skill if it doesn't apply to the agent.

Role required: skill_manager

The Predictive Intelligence application for skills displays the recommended skills on each agent's profile. The application uses sample incidents that the agent has worked on to recommend skills for an agent.

1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Click the coaching icon.
3. Click the Skills tab.

You can view the list of all assigned skills and the skill level for each agent on your team. For more information on skills and skills levels, see Skills Management.

4. Add a skill or skill level.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Add a skill                | 1. In the skill matrix, click **Add** for the skill that you want to add to the agent.  
  The agent's user name and skill gets automatically populated in the user skill record.  
  2. Optionally, in the **Skill level** field, select a level for the skill.  
  3. Click **Save**. |
| Update a skill level       | 1. In the skill matrix, select a skill level for an agent.  
  2. Select the skill level that you want to add for the agent.  
  3. Click **Save**. |

5. Approve or reject a skill that is recommended by Predictive Intelligence.

1. In the skill matrix, click **Recommended** to approve and recommend a skill for the user.
2. In the Details tab, review the request for skill approval, the sample incident resolutions that were used to predict the skill, and the activity stream.

   - To approve a skill, click **Approve**. The skill is added to the agent and the lowest level for the skill is automatically associated with the added skill. The state for the request changes to Approved and the skill is added to the agent.
   - To reject a skill, click **Reject**. The state for the request changes to Rejected. Predictive Intelligence does not recommend the skill for the user again and the field changes to Add.

   Click the more options (…) icon and select **Save**.
The application assigns the skill to the user. If the assigned skill does not have a skill level, the application adds the basic skill level to the user.

Incident Communications Management

The ServiceNow® Incident Communications Management application enables organizations to create and manage communications related to major business issues or incidents.

Incident Communications Management allows incident communications administrators to bring together all involved users during these events and establish quick and easy communication within this group.

For example, a major issue occurs in a server room, which leads to a high-priority incident to be raised. The incident can potentially impact all users, so it is important to bring together key representatives and communicate quickly and effectively. An incident communication plan can facilitate this communication process and help resolve the source incident.

Usage of Incident Communications Management

- Create an incident communication plan when a crisis occurs.
- Set up contact responsibilities to identify the individuals who receive automatic notifications when incident communication plans are created. If they want to receive notifications, Self-Service users can subscribe to incident communication plans.
- Manage incident communication plans to improve communication while dealing with the crisis.
- Use the optional Notify feature to send notifications by SMS messages and voice mails, and to set up conference calls.
- Monitor events and results with the incident communication plan dashboard and reports.

Explore
- Incident communication plan state model (old)
- Incident communication plan state model (new)
- Domain separation in Incident Communications Management

Set up
- Activate Incident Communications Management

Administer
- Run an incident communication plan report

Use
- NA

Develop
- Developer training
- Developer documentation

Integrate
- Incident Communications Management integrations

Troubleshoot and get help
- Ask or answer questions in the Incident Communications Management community
- Search the HI knowledge base for known error articles
Incident Communications Management plugins

Activate Incident Communications Management plugin (com.snc.iam) in the base system.

Activate Incident Communications Management

Activate the Incident Communications Management (com.snc.iam) plugin if you have the admin role.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Incident Communications Management

Several types of components are installed with activation of the Incident Communications Management plugin (com.snc.iam), including tables and user roles.

   Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>ia_admin</td>
<td>Can create, edit, or cancel incident communication plan, incident communication task, and manage contact information.</td>
<td>contact_admin, sn_comm_management.comm_plan_manager, notify_view</td>
</tr>
</tbody>
</table>

   Note: The role is available when you activate the Notify plugin.
### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impacted CI</td>
<td>The CIs impacted by the source CI in the incident communication plan.</td>
</tr>
<tr>
<td>(impacted_ci)</td>
<td></td>
</tr>
<tr>
<td>Incident Communication Plan</td>
<td>The Incident Communication Plan table extends from the Communication Plan</td>
</tr>
<tr>
<td>(incident_alert)</td>
<td>table (comm_plan) so that the incident communication plan inherits any future</td>
</tr>
<tr>
<td></td>
<td>enhancements made to the communication object.</td>
</tr>
<tr>
<td>Incident Communication Task</td>
<td>The Incident Communication Task table extends the Communication Task table</td>
</tr>
<tr>
<td>(incident_alert_task)</td>
<td>(comm_task).</td>
</tr>
</tbody>
</table>

### Incident communication plan state model (new)

Incident communication plan state model helps you to understand the different states through which a plan can progress and track the plan through its states.

Incident communication plans are created with an **Open** state. They follow a process that finishes with the **Closed** or **Canceled** state. The following state model is applicable to new customers starting the Madrid release.
The following two properties are responsible for different actions that take place on Incident Communication Plan and Incident Communication Task:

- The **Close open Incident Communication Plans when Incident is closed or canceled** property \( \text{com.snc.incident.incident_alert.closure} \) is responsible for the following action:
  - When incident is closed, any open Incident Communication Plan is closed.
  - When an incident is canceled, any open Incident Communication Plan is canceled.

- The **Close open Incident Communication Tasks when an Incident Communication Plan is closed or canceled** property \( \text{com.snc.iam.incident_alert_task.closure} \) is responsible for the following actions:
  - If an Incident Communication Plan is **Closed** or **Canceled**, then the state of any open Incident Communication Task on which communication is not yet performed, is set to **Skipped**.
  - If an Incident Communication Plan is **Closed** or **Canceled**, then the state of any open Incident Communication Task on which communication is performed at least once, is set to **Complete**.

**Note:** The **Close open Incident Communication Plans when Incident is closed or canceled** and **Close open Incident Communication Tasks when an Incident Communication Plan is closed or canceled** property is visible when you activate the Incident Communications Management plugin \( \text{com.snc.iam} \). This property is set to false for both new and existing customers.
Incident communication plan state model (old)

Incident communication plan state model helps you to understand the different states through which a plan can progress and also to track the plan through its states.

Incident alerts are created with a **New** state. They follow a process that finishes with the **Closed** or **Canceled** state.

**Note:** The state model shown below is available only for customers prior to the London release. Beginning London release, customers who have upgraded to the latest release, can refer to *Incident communication plan state model (new)*.

Incident communication plan stages

The incident communication plan changes from the **New** state to the **Work in Progress** state when you update the **Actions Taken** field. Only the incident communication plan creator or a user with the admin role can cancel an incident communication plan.

The following two properties are responsible for different actions that take place on Incident Communication Plan and Incident Communication Task:

- The **Close open Incident Communication Plans when Incident is closed or canceled** property *(com.snc.incident.incident_alert.closure)* is responsible for the following actions:
  - If an incident is closed or canceled when the incident communication plan state is **New** or **Work in Progress**, the incident communication plan state is set to **Canceled**.
- If an incident is closed or canceled when the incident communication plan state is **Resolved**, the incident communication plan state is set to **Closed**.

- The Close open Incident Communication Tasks when an Incident Communication Plan is closed or canceled property (com.snc.iam.incident_alert_task.closure) is responsible for the following actions:
  - If an incident communication plan is closed, the state of all open incident communication tasks is set to **Closed Incomplete**.
  - If an incident communication plan is canceled, the state of all open incident communication tasks is set to **Closed Skipped**.

**Note:** The Close open Incident Communication Plans when Incident is closed or canceled and Close open Incident Communication Tasks when an Incident Communication Plan is closed or canceled property is visible when you activate the Incident Communications Management plugin (com.snc.iam). This property is set to false for both new and existing customers.

**Working with Incident Communications Management**

Incident Communications Management provides a framework for defining and managing a communication process for an incident. It helps you to streamline a communication process by creating designated incident communication plans for effective communication during an event.

**Communication plan definition**

An incident communication plan helps you to streamline a communication process with regards to an incident. It defines the stakeholders who should be informed, what information should be shared, when the information should be delivered, and the methods of communication.

For information on how to create a communication plan definition, refer to **Define a communication plan**.

**Important:** While creating the Communication Plan definition, ensure that the table is Incident (incident). If you have upgraded to London or a higher release and you use communication plan to streamline the communication process, deactivate the Major Incident Response and Resolution flow designer.

**Communication task definition**

Each communication plan involves a series of communication tasks. A communication task definition helps you to specify the mode of communication (channel) and the frequency at which the communication must be carried out.

For information on how to create a communication task definition, refer to **Define a communication task**.

**Communication contact definition**

Communication contact definition helps you to define the recipients of a particular communication plan. The contact determines the target audience involved in each communication task and the responsibilities they are expected to handle. A notification for
a task is sent to all individuals specified for that task. You can add or remove any particular communication contact manually.

For information on how to create a communication contact definition, refer to Define a communication contact.

**Communication channel definition**

You can define a communication channel for each communication task. The communication channel determines which mode of communication to use for the task when a plan is attached to an incident. The modes of communication available are: email, SMS, conference, and Slack.

For information on how to create a communication channel definition, refer to Define a communication channel.

**Create adhoc incident communication plan**

Create an adhoc incident communication plan to manage and track communications around a high-priority incident or other issues.

The adhoc incident communication plan can be created in the following ways:

- Create adhoc incident communication plan from Incident Communications Management.
- Create adhoc incident communication plan from an incident.

**Create adhoc incident communication plan from Incident Communications Management**

Create an incident communication plan from Incident Communications Management when an issue is not considered earlier. If you need collaboration on that issue, you can create an incident communication plan.

Role: major_incident_manager, ia_admin, or admin

1. Navigate to Incident Communications Management > Create New.
2. On the form, fill in the fields.
Incident Communication Plan form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique incident communication plan ID, in the ICPxxxxxxx format.</td>
</tr>
<tr>
<td>Source incident</td>
<td>The source incident for this communication plan, if any. If you select a source incident, the Background field is populated with data from this incident, unless there is existing data in this field.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of communication plan available are Ad hoc, End User, Stakeholder, and Technical.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Communication plan definition | The communication plan definition based on which this incident communication plan is attached.
State | The state of the communication plan. The available values are Open, Closed, or Canceled.
Assignment group | The assignment group, if any, for that incident communication plan. For example, there might be a group that represents a crisis management team, including several Incident Managers, Duty Directors, and Duty Managers.
Assigned to | The assigned user for the communication plan. By default, the assigned to user is the one who creates the communication plan. The communication plan can also be assigned to an ITIL user or an incident communication plan administrator.
Order | Order in which the communication plan appears in the incident. If there are multiple communication plans, this field indicates which communication plan to execute first.
Short description | A brief summary of the communication plan.
Description | A detailed description of the communication plan.
Notes | Work notes, activities, and background information regarding the incident communication plan.

3. Click **Submit**.
   An incident communication plan is created. The **Communication** tab lists the communication tasks that have email, SMS, or slack as the communication channel. The **Conference** tab lists the communication tasks that have conference as the communication channel.

### Create adhoc incident communication plan from incident

Create an adhoc incident communication plan from an incident when an issue related to the incident is not considered earlier. The incident automatically populates the required information in the adhoc communication plan, saving you time and effort.

Role: major_incident_manager, ia_admin, or admin

1. Navigate to **Self-Service > Incident > Open**.
2. Open an existing incident.
3. Click the Incident Communication Plans related list.
4. Click **New**.
   The original incident becomes the source incident of this communication plan.
5. On the form, fill in the fields.
Incident Communication Plan form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated unique incident communication plan ID, in the ICPxxxxxxxx format.</td>
</tr>
<tr>
<td>Source incident</td>
<td>The source incident for this communication plan, if any. If you select a source incident, the Background field is populated with data from this incident, unless there is existing data in this field.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of communication plan available are Ad hoc, End User, Stakeholder, and Technical.</td>
</tr>
<tr>
<td>Communication plan definition</td>
<td>The communication plan definition based on which this incident communication plan is attached.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the communication plan. The available values are Open, Closed, or Canceled.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The assignment group, if any, for that incident communication plan. For example, there might be a group that represents a crisis management team, including several Incident Managers, Duty Directors, and Duty Managers.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The assigned user for the communication plan. By default, the assigned to user is the one who creates the communication plan. The communication plan can also be assigned to an ITIL user or an incident communication plan administrator.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the communication plan appears in the incident. If there are multiple communication plans, this field indicates which communication plan to execute first.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief summary of the communication plan.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the communication plan.</td>
</tr>
<tr>
<td>Notes</td>
<td>Work notes, activities, and background information regarding the incident communication plan.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.
An incident communication plan is created. The **Communication** tab lists the communication tasks that have email, SMS, or slack as the communication channel. The **Conference** tab lists the communication tasks that have conference as the communication channel.
Create adhoc incident communication task from Incident Communications Management

Create an adhoc incident communication task while you are working on the communication plan. The communication task helps you to specify the mode of communication (channel) and the frequency at which the communication must be carried out.

Role required: major_incident_manager, ia_admin, or admin

1. Navigate to Incident Communications Management > Open.
2. Open the incident communication plan for which you want to create the communication task.
3. In the Incident Communication Tasks related list and click New.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Incident Communication Task form</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique incident communication task ID, in the ICTxxxxxxx format.</td>
</tr>
<tr>
<td>Incident Communication Plan</td>
<td>(Read-only field) Incident communication plan for which you create the task.</td>
</tr>
<tr>
<td>Source incident</td>
<td>(Read-only field) Lookup icon to select the incident on which you want the plan to be attached.</td>
</tr>
<tr>
<td>Type</td>
<td>Lookup icon to select the type of task such as internal communication.</td>
</tr>
<tr>
<td>Communication task definition</td>
<td>(Read-only field) Unique name of the communication task definition for which you are creating the task.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the communication plan. The available values are Pending, Open, In Progress, Complete, and Skipped.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The assignment group, if any, for that incident communication task.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The assigned user for the communication task.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the communication task appears in the communication plan. If there are multiple communication tasks, this field indicates which communication task to execute first.</td>
</tr>
<tr>
<td>Communication frequency</td>
<td>Frequency of the communication task execution. You can send the notification once or the notification can be repeated.</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Due in</td>
<td>Time by which the communication task must be completed.</td>
</tr>
<tr>
<td>Last communication sent</td>
<td>The date and time when the last communication is sent to the user or the group.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief summary of the communication task.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the communication task.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Create adhoc incident communication channel. For more information on how to define a communication channel, refer Define a communication channel.

**Incident Communications Management and Contacts**

You can define contacts to associate users or groups to an incident communication plan. The users or groups are contacted to complete the tasks included in a communication plan.

If you have the ia_admin role, you can assign users or groups to an incident communication plan based on the information provided in these records:

- **Contact responsibilities:** Provides a name, such as Incident Duty Manager, for a set of tasks related to incident communication plan. The contact responsibility record also indicates whether the tasks are performed by an individual user or a group of users. Contact responsibilities can also be used to manually add contacts to an incident communication plan.
- **Contact definitions:** Identifies a set of conditions to determine which specific user or group is assigned to handle a particular responsibility for an incident communication plan. For example, All P1 Incidents must have an Incident manager, assigned to US Incident Management group.

Contact responsibilities and contact definitions allow you to define and modify data-driven contact information for automatic notifications. You do not have to specify individual users or groups directly for each incident communication plan.

You can use group contacts. You can use the Group contacts functionality when you have on-call scheduling, Notify, and Incident Communications Management. Group contacts include the people that are on-call. The group contacts can be included when initiating a conference call that is a result of an incident communication plan. By default, the primary and secondary on-call persons are available. To modify this behavior, set the system property `com.snc.iam.on_call_escalation_level`.

**Responsibilities for Incident Communication Plan**

Contact responsibilities helps you to identify contacts by their responsibilities and to understand what you can expect from the user throughout the life cycle of the communication plan.

There are two types of responsibilities available for use with incident communication plans:

- **Default Responsibilities:** Contacts who are notified by default.
• Other Responsibilities: Contacts who can be selected for notification.

Use contact definitions to view and modify the rules that determine the specific users associated with contact responsibilities.

Default Responsibilities

By default, contacts with the following responsibilities are notified when an incident communication plan is created:

• Duty Manager
• Incident Manager
• Duty Director

These roles are involved with resolving the source incident or original event that the incident communication plan relates to. They are seen as key contacts for the incident communication plan.

The following sections describe typical operational roles for these responsibilities.

<table>
<thead>
<tr>
<th>Responsibility</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duty Manager</td>
<td>The senior point of presence in the monitoring environment at the time an incident occurs. The Duty Manager assesses the incident against standard operating procedures, escalation triggers, and personal knowledge and experience, to take corrective actions. To clarify the urgency and impact of an incident, the Duty Manager can contact the Incident Manager for advice.</td>
</tr>
<tr>
<td>Incident Manager</td>
<td>A senior technician, accountable for coordinating and managing all technical resources required to resolve incidents. After being notified by the Duty Manager of a serious incident, the Incident Manager assesses the seriousness and associated business impact. Based on this assessment, the Incident Manager decides whether to escalate the incident to the Duty Director. The Incident Manager may escalate to the Duty Director to gain access to resources outside of the department, if necessary.</td>
</tr>
<tr>
<td>Duty Director</td>
<td>The escalation point for all issues that affect critical services. The Duty Director works in partnership with the business directors in the organization to approve recovery plans developed by the Incident Manager. The Duty Director also manages the senior level communications for the source incident.</td>
</tr>
</tbody>
</table>
Other Responsibilities

Incident Communications Management provides the following additional responsibilities that can be added to incident communication plans. You can also create contact responsibilities, as needed. The associated users receive notifications about the incident communication plan.

<table>
<thead>
<tr>
<th>Responsibility</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Director</td>
<td>Director within the business who is identified as a potential contact when an incident communication plan occurs.</td>
</tr>
<tr>
<td>Communication Manager</td>
<td>Business-facing role in the event communication is required in an incident communication plan.</td>
</tr>
<tr>
<td>Crisis Action Manager</td>
<td>Overall responsibility and accountability for managing incident communication plans.</td>
</tr>
<tr>
<td>Crisis Action Team Member</td>
<td>Nominated department heads who are involved when an incident communication plan occurs.</td>
</tr>
<tr>
<td>Development personnel</td>
<td>Development personnel involved in the troubleshooting and resolving an incident communication plan.</td>
</tr>
<tr>
<td>Operations support personnel</td>
<td>Personnel involved in the second or third level of support in troubleshooting and resolving an incident communication plan.</td>
</tr>
<tr>
<td>Service Owner</td>
<td>Service owner or manager who is identified as a potential contact when an incident communication plan relates to one or more of their services.</td>
</tr>
<tr>
<td>Technical Support</td>
<td>Second or third level technical support personnel involved in troubleshooting and resolving an incident communication plan.</td>
</tr>
</tbody>
</table>

Define contact responsibilities

Define the different contacts or target audience involved in the communication process and their responsibility to understand the expectations from those contacts throughout the process.

Role required: ia_admin or admin

1. Navigate to Incident Communications Management > Contact Administration > Contact Responsibilities .
2. Click New.
3. On the form, fill in the fields.
### Contact Responsibility form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>Check box to determine whether the contact responsibility is available for all tables or for a specific table. If the check box is not selected, the Table field appears where you can select the table for which you are defining the contact responsibility.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name of the contact, such as Business Director or Communication Manager, involved in the communication process.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of contact such as user, group, or recipient list.</td>
</tr>
<tr>
<td>Table</td>
<td>Table on which contact is activated when a communication plan is attached.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.  
   Contact responsibilities are defined.

### Create a contact definition

Define the recipients of a particular incident communication plan to determine the target audience involved in each communication task and the responsibilities the recipients are expected to handle.

**Role:** ia_admin or admin

1. Navigate to **Incident Communications Management > Contact Administration > Contact Definitions**.
2. Click **New**.
On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the contact definition.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of contact such as user or group that you want to involve in the plan.</td>
</tr>
<tr>
<td>Responsibility</td>
<td>Responsibility that the user or group is expected to handle.</td>
</tr>
<tr>
<td>Source</td>
<td>Method to determine the user or group to associate with this definition.</td>
</tr>
</tbody>
</table>

The source can be:

- **None**: Use no association. You should associate users or groups manually within the Incident Communication Plan form.
- **Default Override**: Use default override to associate users or groups based on conditions.
- **Form Field**: Use information from the incident communication plan form based on the value specified in the Source field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity</td>
<td>The maximum number of contacts that can be associated with the selected responsibility for each incident communication plan record. Note: The Quantity field appears only when you select None as the value for the Source field.</td>
</tr>
<tr>
<td>Source field</td>
<td>The field on the Incident Communication Plan form whose value is considered to be the contact associated with the selected contact responsibility.</td>
</tr>
<tr>
<td></td>
<td>· For contact type as User, the values are Assigned to, Closed by, Opened by, or Resolved by.</td>
</tr>
<tr>
<td></td>
<td>· For contact type as Group, the value is Assignment group.</td>
</tr>
<tr>
<td></td>
<td>Note: The Source field appears only when you select Form field as the value for the Source field.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to indicate whether the definition is active or not.</td>
</tr>
<tr>
<td>Condition</td>
<td>The conditions that must be met to associate this contact definition to a particular user or group. If multiple conditions are defined, each condition is evaluated in the order listed.</td>
</tr>
</tbody>
</table>

4. Click Submit.

**Create a default override**

Create a default override to specify user or group for a contact definition of an incident communication plan. It helps you to set multiple conditions based on which a user or a group is considered as a contact.

Role: ia_admin or admin

The Default overrides related list is available only if you select Default override as the value of the Source field in the Contact definition form.

1. Navigate to Incident Communications Management > Contact Administration > Contact Definitions.
2. Open the contact definition record.
3. In the Default override section, click New.
4. On the form, fill the fields.

**Default override form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>The order in which the condition in default override should be evaluated.</td>
</tr>
<tr>
<td>User value</td>
<td>User specified in the <strong>User value</strong> field is assigned as the contact if the condition in the default override matches.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The <strong>User value</strong> field appears if the value of the <strong>Type</strong> field in the Contact definition form is <strong>User</strong>.</td>
</tr>
<tr>
<td>Group value</td>
<td>Group specified in the <strong>Group value</strong> field is assigned as the contact if the condition in the default override matches.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The <strong>Group value</strong> field appears if the value of the <strong>Type</strong> field in the Contact definition form is <strong>Group</strong>.</td>
</tr>
<tr>
<td>Condition</td>
<td>The conditions defining whether the default override values are to be applied. If multiple conditions are defined, each condition is evaluated as per the listed order. If no conditions match, the default override is not applied.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

Default override and its conditions are defined for a contact definition.
Add a user as a contact

Add a user to a communication plan if you have not added the user earlier in the contact. You can assign a communication task to the user to resolve an issue.

Role: ia_admin or admin

1. Navigate to Incident Communications Management > Open.
2. Open an incident communications plan record.
3. Click the Users related list and click New.

4. On the form, fill in the fields.

**Contact form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Task table for which you are creating the contact.</td>
</tr>
<tr>
<td>Document</td>
<td>The incident communication plan for which you are creating the contact.</td>
</tr>
<tr>
<td>Responsibility</td>
<td>Responsibility that the user is expected to handle throughout the communication process.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of contact such as user, group, or recipient list that you want to involve in the plan.</td>
</tr>
</tbody>
</table>

**Note:** To add a user, select User for the Type field.

| User        | Name of the user who is considered as the contact.                         |

5. Click Submit.

The contact information appears in the Users related list.
Close an incident communication plan

Close an incident communication plan after its execution or if it is no longer needed.
Role required: itil, ia_admin, or admin

- The business rule IA_State_Management allows any user with the ia_admin role or an itil user who is assigned to the incident communication plan, to close or cancel an incident communication plan.
- If a user with the itil role closes or cancels a parent incident, all related incident communication plans are closed or canceled.

**Note:** Use the incident management property Close open Incident Communication Plans when Incident is closed or canceled (com.snc.incident.incident_alert_closure) to control this behavior.

1. Navigate to Incident Communications Management > Open.
2. Open the incident communications plan record that you want to close.
3. In the State field, select Closed.
4. Right-click on the form header and click Save.

Initiate conference call on incident communication task

Initiate a conference call and include all the required stakeholders to discuss on the resolution of the incident and the communication task.

Role required: sn_comm_management.comm_plan_manager or sn_comm_management.comm_plan_admin

Activate the Notify plugin (com.snc.notify), configure the Twilio account, configure the com.snc.iam.notify_number property and create a default provider selector. You can also create a provider selector on the Incident Communication Task table (incident_alert_task). The provider selector specifies the Notify group containing the Notify phone numbers or conference provider to make outgoing calls.

1. Navigate to Incident > All.
2. Open an incident record.
3. From the Incident Communication Plan related list, open the incident communication plan.
4. From the Incident Communication Tasks related list, open the incident communication task.
5. In the related link, click Initiate Conference Call.
6. Select the conference bridge number and the participants for the conference call and click Start Call.

Join or end conference call on incident communication task

After a conference call is initiated, join the call to participate in the discussion or end the call when the conference is no longer required.

Role required:
- Join conference call: ia_admin, itil, or sn_incident_write
End conference call: sn_comm_management.comm_plan_manager or sn_comm_management.comm_plan_admin

1. Navigate to Incident > All.
2. Open an incident record.
3. From the Incident Communication Plan related list, open the incident communication plan.
4. From the Incident Communication Tasks related list, open the incident communication task.
5. In the related links, perform any of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join Conference Call</td>
<td>If the logged in user is not already a part of the conference call, the user can join the conference.</td>
</tr>
<tr>
<td>End Conference Call</td>
<td>End the conference when the discussion is over.</td>
</tr>
</tbody>
</table>

**Note:** The work notes get updated with the details of the conference call such as duration and participants.

---

### Send communication updates

Update users on the latest communication on an incident through selected communication channels.

- Role required: admin
- Activate the Notify plugin (com.snc.notify) if you want to send communication through SMS.
- Set at least one communication channel of a communication task as SMS or email.

1. Navigate to Incident Communications Management > All.
2. Open an incident communication plan record.
3. From the Incident Communication Tasks related list, open the incident communication task for which you want to send updates.
4. In the related links, click **Send Updates**.
5. Fill in the required information and click **Send**.
   
   For sending an SMS communication, in the **From** list, select a number from which you want to send the communication. It contains a list of phone numbers derived from the selected **Provider selector** column which is a reference to the Provider selector table (notify_group_selector). The **From** list displays phone numbers of all the groups associated with the Provider selector only when the following conditions are met:
   
   - The **Manual selector** check box in the Provider selector form is selected.
   - The value of the **Source table** field in the Provider selector is either empty or the same table that you have selected.

6. Click **Send**.

### Run an incident communication plan report

Run an incident communication plan report to view the status of communication plans. You can track the progress of the plan and intervene to improve the overall efficiency and effectiveness of the communication process.
Role: ia_admin or admin

1. Navigate to Reports > View / Run.
2. Click Create a report.
3. Under Data, fill in the fields.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report name</td>
<td>Unique name for the report.</td>
</tr>
<tr>
<td>Source type</td>
<td>Source from which the data is populated. The default value is Table.</td>
</tr>
<tr>
<td>Table</td>
<td>Table from which the data is retrieved.</td>
</tr>
</tbody>
</table>

4. Click Run.
<table>
<thead>
<tr>
<th>Number</th>
<th>Opened</th>
<th>Short description</th>
<th>State</th>
<th>Assignment group</th>
<th>Assigned to</th>
<th>Updated</th>
<th>Updated by</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICP001001</td>
<td>27-02-2019 00:12:37</td>
<td>ad</td>
<td>Closed</td>
<td>(empty)</td>
<td>Santosh Chaudhuri</td>
<td>28-02-2019 07:43:43</td>
<td>samratha.chaudhuri</td>
</tr>
<tr>
<td>ICP001002</td>
<td>27-02-2019 00:12:37</td>
<td>dds</td>
<td>Open</td>
<td>(empty)</td>
<td>Santosh Chaudhuri</td>
<td>28-02-2019 07:43:43</td>
<td>samratha.chaudhuri</td>
</tr>
<tr>
<td>ICP001003</td>
<td>27-02-2019 00:12:37</td>
<td>ad</td>
<td>Closed</td>
<td>(empty)</td>
<td>Santosh Chaudhuri</td>
<td>28-02-2019 07:43:43</td>
<td>samratha.chaudhuri</td>
</tr>
<tr>
<td>ICP001007</td>
<td>29-02-2019 00:00:02</td>
<td>Technical Communications</td>
<td>Open</td>
<td>(empty)</td>
<td>(empty)</td>
<td>29-02-2019 00:00:02</td>
<td>system</td>
</tr>
<tr>
<td>ICP001008</td>
<td>24-03-2018 04:12:46</td>
<td>Technical Communications</td>
<td>Open</td>
<td>Service Desk</td>
<td>David Lee</td>
<td>24-03-2018 04:12:46</td>
<td>admin</td>
</tr>
</tbody>
</table>
Subscribe to incident communication notifications

Subscribe to incident communication notifications to get periodic information about issues related to incident communication plans.

Role: itil, ia_admin, or admin

1. Navigate to **Self-Service > My Notification Preferences**.
2. Under System Settings, select **Notifications**.
3. Under **Notifications By Category**, select **Incident Communication Plan**.
   
   The following notification options appear for incident communication plan: **IA Actions Taken**, **IA Cancelled, IA Resolved Or Closed**, and **New IA Raised**.

4. Click the notification option for which you want to receive notifications.
5. Under **NOTIFICATION CHANNELS**, right-swipe or left-swipe the toggle button to subscribe or unsubscribe from a notification.
6. Click the channel name to add a schedule for the notification and to filter the notification conditions as required.

**Note:** Apply filter to your notification channel to avoid receiving every notification for the subscription.
7. Click **Save**.
   You are subscribed to incident communication notification.

### Incident Communications Management integrations

Incident Communications Management is integrated with other applications such as Notify to improve the overall communication process.

### Notify with Incident Communications Management

Notify allows you to integrate with the Twilio telephony service to send and receive phone calls and SMS from within your instance. In Incident Communications Management, Notify provides you with SMS and conference as channels.

For more information on how notify works with Incident Communications Management, refer to the [Using Notify with Incident Communications Management](#) guide.
Domain separation in Incident Communications Management

This is an overview of domain separation and Incident Communications Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Standard

- Includes Basic level support.
- Business logic: Processes can be created or modified per customer by the service provider (SP). The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The owner of the instance needs to be able to configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin needs to be able to make comments mandatory when a record closes for one tenant, but not for another.

Overview

- The Incident Communications Management application enables organizations to create and manage communications related to major business issues or incidents. Incident communication plan administrators can bring together all involved users during these events and establish quick and easy communication within this group.
- Typically, Incident Communication Plan Admin or Major Incident Manager creates incident communication plans for an existing incident. Multiple incident communication plans can be created against the same incident.
- The incident communication plan and incident communication task tables support domain separation. Therefore, an ITIL/Fulfiller sees only incident communication plans or incident communication tasks that have been created within the (tenant) domain that they belong to.

How domain separation works in Incident Communications Management

Fulfillers see only incident communication plan and incident communication plan tasks that have been created within the (tenant) domain that they belong to.

Domain separated tables

- Incident Communication Plan (incident_alert)
- Incident Communication Task (incident_alert_task)
# Use cases

- An Incident Communication Plan Admin or Major Incident Manager is able to view incidents only of those domains that they have access to. They can create incident communication plans against only those incidents.

# Incident Management

Incident Management restores normal service operation while minimizing impact to business operations and maintaining quality.

ServiceNow Incident Management supports the incident management process in the following ways:

- Log incidents in the instance or by sending email.
- Classify incidents by impact and urgency to prioritize work.
- Assign to appropriate groups for quick resolution.
- Escalate as necessary for further investigation.
- Resolve the incident and notify the user who logged it.
- Use reports to monitor, track, and analyze service levels and improvement.

Any user can record an incident and track it through the entire incident life cycle until service is restored and the issue is resolved.

## Explore

- Incident Management process
- Incident Management state model
- Domain separation in Incident Management

## Set up

- Create an incident template

## Administer

- Show flagged VIPs in the incident list

## Use

- Create an incident
- Major incident management
- Copy an incident or create child incident
- Promote an incident

## Develop

- Developer training
- Developer documentation

## Integrate

- Incident ticketing integrations
- Slack integration - Incident Management

## Troubleshoot and get help

- Ask or answer questions in the Incident Management community
- Search the HI knowledge base for known error articles
- Contact ServiceNow Technical Support
**Incident Management process**

ServiceNow Incident Management supports the incident management process with the ability to identify and log incidents, classify and prioritize incidents, assign incidents to appropriate users or groups, escalate, resolve, and report incidents.

Any user can record an incident and track it until service is restored and the issue is resolved. Each incident is generated as a task record that contains pertinent information. Incidents can be assigned to appropriate service desk members, who resolve the task and document the investigation. After the incident is resolved, you can manually close the incident. You can also close incidents automatically based on the last updated date or the resolution date of the incident. For more information about auto-closing incidents, see [Configure incidents to close automatically](#).

Any user can log an incident within the system using the following methods.

ServiceNow Incident Management process follows these steps:

1. Incident identification
2. Incident logging
   - Incident categorization
   - Incident prioritization
3. Incident response
   - Initial diagnosis
   - Incident escalation
   - Investigation and diagnosis
   - Resolution and recovery
   - Incident closure

**Incident Identification**

The first step in the life of an incident is incident identification. You can report incidents through emails, sms, phone call, support chats, walk-ups, and applications. The service desk decides if the issue is truly an incident or if it is a request.

**Incident logging**

Once identified as an incident, the service desk logs the incident. The incident should include information, such as the caller, business service, configuration item, and contact type. The logging process includes categorization and prioritization of an incident.

**Incident categorization**

Incident categorization is a vital step in the incident management process. Categorization involves assigning a category and at least one subcategory to the incident.
Incident prioritization

Incident prioritization is important for SLA response adherence. The priority of an incident is determined by its impact on users or business and its urgency.

Incident response

Once identified, categorized, prioritized, and logged, the service desk can handle and resolve the incident. Incident resolution involves five steps:

- Initial diagnosis: Occurs when the user describes his or her problem and answers troubleshooting questions.
- Incident escalation: Happens when an incident requires advanced support, such as sending an on-site technician or assistance from certified support staff.
- Investigation and diagnosis: Takes place during troubleshooting when the initial incident hypothesis is confirmed as being correct. Once the incident is diagnosed, service desk can apply a solution, such as changing software settings, applying a software patch, or ordering new hardware.
- Resolution and recovery: Happens the service desk confirms that the service of the user is restored within the stipulated SLA time.
- Incident closure: At this point, the incident is considered closed and the incident process ends.

Life cycle of an Incident

Incident Management is responsible for managing the life cycle of incidents, from creation to closure.

The Incident Management process has many states, and each is vitally important to the success of the process and the quality of service delivered. The different states can be represented in a diagram as follows:
Incident management state model flow
Incident states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Incident is logged but not yet investigated.</td>
</tr>
<tr>
<td>In Progress</td>
<td>Incident is assigned and is being investigated.</td>
</tr>
<tr>
<td>On Hold</td>
<td>The responsibility for the incident shifts temporarily to another entity to provide further information, evidence, or a resolution. When you select the On Hold option, the On hold reason list appears. If the On hold reason is Awaiting Caller, the Additional comments becomes mandatory.</td>
</tr>
<tr>
<td>Resolved</td>
<td>A satisfactory fix is provided for the incident to ensure that it does not occur again.</td>
</tr>
<tr>
<td>Closed</td>
<td>Incident is marked Closed after it is in the Resolved state for a specific duration and it is confirmed that the incident is satisfactorily resolved.</td>
</tr>
<tr>
<td>Canceled</td>
<td>Incident was triaged but found to be a duplicate incident, an unnecessary incident, or not an incident at all.</td>
</tr>
</tbody>
</table>

Note: If the caller updates the incident, the On hold reason field is cleared and the state of the incident is changed to In Progress. An email notification is sent to the user whose name is mentioned in the Assigned to field as well as to the users in the Watch list. An incident can be placed in the On hold state one or more times prior to being closed.

Incident Management plugins

Many of the Incident Management plugins are activated in the base system. Others, you can activate when you are ready to use them. Some plugins include demo data.

Activate Incident

You can activate the Incident plugin (com.snc.incident) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

Incident plugin activates these related plugins if they are not already active.

Plugins for Incident

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Management Basics</td>
<td>Provides the baseline for Service Management functionality.</td>
</tr>
<tr>
<td>(com.snc.service)</td>
<td></td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Incident Management Notification
(com.snc.incident_notification)
Provides notification functionality for Incident Management.

Incident Overview Homepage
(com.glideapp.report.itsm.incident.overview)
Incident Overview Homepage

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Incident
Several types of components are installed with activation of the Incident plugin.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>The Incident table is extended from the Task (task) table. It inherits all the fields, rules and policies from task.</td>
</tr>
</tbody>
</table>

Request Incident Management — Core
Incident Management - Core plugin (com.snc.incident_management) is a new incident state model that includes demo data and activates related plugins if they are not already active.

Role required: admin
Incident Management - Core (com.snc.incident_management) is available by default in new instances. Customers upgrading from Geneva or earlier versions must request the plugin. For more information, see KB0564465.
Note: If the new state model is installed on upgraded instances, then ensure that the old states are mapped to the new ones. The mapping is especially important if you have made customizations, implemented workflows, added script includes, and added business rules.

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the request form on HI.

3. On HI, select to be redirected to the HI Service Portal Service Catalog.
4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>plugin to be enabled</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

| Reason/Comments                                 | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click Submit.

**Request ITSM Roles — Incident Management**

Request the ITSM Roles plugin (com.snc.itsm.roles) to activate the ITSM Roles — Incident Management plugin (com.snc.itsm.roles.incident_management) to gain more control over the access that different service desk agents, technicians, and managers have within your Incident Management process.

Role required: admin

The ITSM Roles plugin (com.snc.itsm.roles) includes an additional security model. The security model provides more granular roles across ITSM applications as well as within them, allowing you flexibility in setting up access controls. The ITSM Roles plugin is available by default in new instances. Users upgrading from Madrid or earlier versions must request the plugin.
## Plugins for ITSM Roles

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Adds roles</th>
</tr>
</thead>
</table>
| Business Stakeholder  
(com.snc_business_stakeholder) | business_stakeholder  

**Note:** The business_stakeholder role contains the sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.

| ITSM Roles — Incident Management  
(com.snc.itsm.roles.incident_management) | · sn_incident_read  
· sn_incident_write |
| ITSM Roles — Problem Management  
(com.snc.itsm.roles.problem_management) | · sn_problem_read  
· sn_problem_write |
| ITSM Roles — Change Management  
(com.snc.itsm.roles.change_management) | · sn_change_read  
· sn_change_write |
| ITSM Roles — Request Management  
(com.snc.service_management.roles.request_management) | · sn_request_read  

**Note:** As there are future updates expected for the sn_request_read role, do not assign it to users without the business_stakeholder role.  
· sn_request_write |

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and subproduction instances, generally within a few days.

If you don’t have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.

**Note:** Activate the ITSM Roles plugin on a subproduction environment and test the functionality before requesting activation in the production environment. For assistance, contact the ServiceNow Professional Services team.

1. Navigate to **System Applications > All Available Applications > All**.  
2. On the All Applications page, click **Request Plugin** to open the request form on Hi.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.
4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
</tbody>
</table>
| Specify the date and time you would like | The date and time must be at least two business days from the current time.
| this plugin to be enabled                |                                                                             |

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click Submit.

**Components installed with ITSM Roles — Incident Management**

Several user roles are installed with activation of the ITSM Roles — Incident Management plugin (com.snc.itsm.roles.incident_management).

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.
Roles installed

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident read</td>
<td>Read access to the Incident Management application and related records.</td>
<td>NA</td>
</tr>
<tr>
<td>(sn_incident_read)</td>
<td><img src="image" alt="Note: An ESS user (user with no role) can view only those incidents that they create or someone else creates on their behalf. A user with the sn_incident_read role can view all incidents as well as the major incident workbench." /></td>
<td></td>
</tr>
<tr>
<td>Incident write</td>
<td>Write access to the Incident Management application and related records.</td>
<td>• sn_incident_read • template_editor</td>
</tr>
<tr>
<td>(sn_incident_write)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Activate Business Stakeholder**

Activate the Business Stakeholder plugin (com.snc.business_stakeholder) if you have an admin role. This plugin installs the Business Stakeholder role. Users with this role can view and approve records at all ITSM product levels.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in [Request a plugin](#).
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

![Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.](image)

**Installed with Business Stakeholder**

The Business Stakeholder plugin (com.snc.business_stakeholder) installs the Business Stakeholder role when activated.

![Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.](image)
Roles installed

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Business Stakeholder (business_stakeholder) | Users with this role can view and approve records within all products of ITSM. | · pa_viewer.business_stakeholder  
· approver_user.business_stakeholder  
· cmdb_read.business_stakeholder |

Note: The business_stakeholder role contains the following ITSM roles sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.

Activate KCS Integration for Incident Management

Activate the KCS Integration for Incident Management plugin (com.snc.incident.knowledge) if you have the admin role. This plugin provides integration of Incident Management with the Advanced Knowledge Management features.

Role required: admin

The KCS Integration for Incident Management plugin (com.snc.incident.knowledge) activates the Knowledge Management Advanced Installer plugin.

### Plugin for KCS Integration for Incident Management

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Management Advanced Installer (com.snc.knowledge_advanced.installer)</td>
<td>Use this plugin to install the Knowledge Management Advanced plugin. Activating or upgrading this plugin validates knowledge articles and knowledge bases to ensure that the Knowledge Management Advanced plugin can be successfully installed.</td>
</tr>
</tbody>
</table>

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Component installed with KCS Integration for Incident Management plugin

The Incident KCS Article table is installed with the activation of the KCS Integration for Incident Management plugin (com.snc.incident.knowledge).
Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident KCS Article</td>
<td>The table is used to store knowledge articles created from the Incident KCS template.</td>
</tr>
<tr>
<td>(kb_template_incident_kcs_article)</td>
<td></td>
</tr>
</tbody>
</table>

### Activate Incident Management Notification

You can activate the Incident Management Notification plugin (com.snc.incident_notification) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Activate Incident Updates

You can activate the Incident Updates plugin (com.snc.incident.updates) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>. 
Activate Incident Management — ATF Tests

You can activate the Incident Management — ATF Tests plugin (com.snc.incident.atf) if you have the admin role. The plugin delivers ATF tests for Incident Management. This plugin includes demo data.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

*Note:* When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Configuring Incident

You can configure the incident form and other incident features, such as incident categories and UI behavior. The ITSM guided setup helps you configure incident management on your ServiceNow instance.

Configure the Incident form in the base system to follow ITIL best practices. The administrator can configure the incident form and use the form designer to customize it. You can copy or create child incident to reduce the effort of configuring the functionality of an open incident.
Form configuration and design

<table>
<thead>
<tr>
<th>Menu option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Form design</strong></td>
<td>Administrators or users with the personalize_form role can use the form design feature to quickly create new or change existing form views. Form design is an alternative to configuring forms that combines several configuration options into one tool.</td>
</tr>
<tr>
<td><strong>Form layout</strong></td>
<td>Administrators or users with the personalize_form role can configure a form to show or hide fields from a view. You can create new fields on the table associated with the form.</td>
</tr>
<tr>
<td><strong>Related lists</strong></td>
<td>Related lists display records in another table that have a relationship with the current record. Administrators or users with the personalize_form role can configure related lists to appear on the form.</td>
</tr>
</tbody>
</table>

Using guided setup to implement Incident Management

IT Service Management guided setup provides a sequence of tasks that help you configure Incident Management on your ServiceNow instance. To open ITSM guided setup, navigate to Guided Setup > ITSM Guided Setup. For more information about using the guided setup interface, see Using guided setup.

Quick start tests for Incident Management

Validate that Incident Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Incident Management quick start tests require activating the Incident Management - ATF Tests plugin (com.snc.incident.atf).

**Incident Management test suite**

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>INCIDENT MGMT: Incident Resolution SLA</td>
<td>Test to verify the Incident Resolution SLA baseline functionality.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Incident Response SLA</td>
<td>Test to verify the Incident Response SLA baseline functionality.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Copy Incident</td>
<td>Test to verify whether the fields from the original Incident are copied correctly to the new Incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>INCIDENT MGMT: Copy Incident from a Closed Incident</td>
<td>Test to verify that the Copy Incident UI action is visible for closed Incidents.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Create Standard Change from Incident</td>
<td>Test to verify the creation of a Standard Change from an Incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Create of Emergency Change from an Incident</td>
<td>Test to verify the creation of an Emergency Change from an Incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Create Normal Change from an Incident</td>
<td>Test to verify the creation of a Normal Change from an Incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Create Problem from an Incident</td>
<td>Test to verify the creation of a Problem from an Incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Create Knowledge from an Incident</td>
<td>Test to verify the creation of a Knowledge from an Incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Incident State flow</td>
<td>Test to verify the state flow of an incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Reopening an Incident</td>
<td>Test to verify the reopen incident functionality.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Incident Assignment</td>
<td>Test to verify the incident assignment functionality.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Create child Incident using UI action and verify its fields</td>
<td>Test to verify the creation of a child Incident from an Incident through the Create Child Incident UI action. The test also verifies that the fields of the child Incident get copied correctly from the parent incident to the child incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Incident creation — Self Service</td>
<td>Test to verify the creation of an Incident using the Create Incident catalog item.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Parent and Child Incident state sync up</td>
<td>Test to verify that the state of a child Incident synchronizes with the parent Incident when the child Incident is created.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Parent and child Incident state sync up after reopening an Incident</td>
<td>Test to verify that the state of a child Incident synchronizes with the parent Incident when the parent Incident is reopened.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>
INCIDENT MGMT: Verify creation of knowledge article from an Incident

Test to verify the creation of a knowledge article from an Incident using the Create Knowledge UI action on the Incident form. The UI action is visible when you activate the KCS Integration for Incident Management plugin (com.snc.incident.knowledge).

Orlando

Incident management properties

Incident management properties are used to control features such as copying and creating child incidents. The major incident properties control the promotion of major incident candidates to major incidents.

These properties are available at Incident > Administration > Incident Properties.

Properties for incident management

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident closure properties</td>
<td></td>
</tr>
</tbody>
</table>
| Enable auto closure of incidents based on Resolution date. Setting this to 'No' will make auto closure to run based on the Updated date. com.snc.incident.autoclose.basedon.resolved_at | Select the check box to auto-close incidents based on the resolution date of the incident instead of the last updated date. 

<i>Note: This property is set to true only for the new (Madrid) customers. Existing customers have to manually set the property to true.</i>

| Number of days (integer) after which Resolved incidents are automatically closed. Zero (0) disables this feature glide.ui.autoclose.time | Sets the duration of the incident auto-close function. |
| Close open Incident Tasks when Incident is closed or canceled com.snc.incident.incident_task.closure | Select the check box to close open incident task when Incident is closed or canceled. 

<i>Note: This property is set to true by default only for the new (Madrid) customers.</i>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close open Incident Communication Plans when Incident is closed or canceled</td>
<td>Select the check box to close open incident communication plan when an Incident is closed or canceled.</td>
<td>This property is visible when Incident Communications Management plugin (com.snc.iam) is enabled. This property is set to false for both new and existing customers.</td>
</tr>
<tr>
<td>Close open Incident Communication Tasks when an Incident Communication Plan is closed or canceled</td>
<td>Select the check box to close open incident communication task when an incident communication plan is closed or canceled.</td>
<td>This property is visible when Incident Communications Management plugin (com.snc.iam) is enabled. This property is set to false for both new and existing customers.</td>
</tr>
<tr>
<td>Incident Re-open Properties</td>
<td></td>
<td></td>
</tr>
<tr>
<td>List of fields (comma-separated) to copy from the original incident when an incident is reopened by email</td>
<td>Enter the name of the fields that you want to be copied from the original incident to the new incident when you reopen an incident through email.</td>
<td>When an incident is reopened, a new incident is created.</td>
</tr>
<tr>
<td>Copy Incident and Create Child Incident Properties</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable copy incident feature</td>
<td>Select the check box to get the Copy Incident option in the context menu.</td>
<td></td>
</tr>
<tr>
<td>Enable create child incident feature</td>
<td>Select the check box to get the Create Incident option in the context menu.</td>
<td></td>
</tr>
<tr>
<td>Copy attachments from originating incident</td>
<td>Select the check box to copy attachments from original incidents when an incident is copied for created.</td>
<td></td>
</tr>
<tr>
<td>List of attributes (comma-separated) that will be copied from the originating incident</td>
<td>Enter the name of the attributes that you want to be copied from the original incident to the new incident when you copy or create an incident.</td>
<td></td>
</tr>
<tr>
<td>Related lists (comma-separated) that will be copied from the originating incident</td>
<td>Enter the name of the related lists that you want to be copied from the original incident to the new incident when you copy or create an incident.</td>
<td></td>
</tr>
</tbody>
</table>
### Property Form Fields Configuration Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of attributes (comma-separated) from Affected CIs (task_ci) related list that will be copied from the originating incident</td>
<td>Enter the name of the attributes from Affected CIs related list that you want to be copied from the original incident to the new incident when you copy or create an incident.</td>
</tr>
<tr>
<td>com.snc.incident.copy.rl.task_ci.attributes</td>
<td></td>
</tr>
<tr>
<td>List of attributes (comma-separated) from Impacted Services (task_cmdb_ci_service) related list that will be copied from the originating incident</td>
<td>Enter the name of the attributes from Impacted Services related list that you want to be copied from the original incident to the new incident when you copy or create an incident.</td>
</tr>
<tr>
<td>com.snc.incident.copy.rl.task_cmdb_ci_services.attributes</td>
<td></td>
</tr>
<tr>
<td>Incident Form Fields Configuration Properties</td>
<td></td>
</tr>
<tr>
<td>List of fields (comma-separated) that appear in the activity formatter for Incident</td>
<td>Enter the names of the fields that are visible in the activity formatter. If the activities are personalized, this property updates automatically.</td>
</tr>
<tr>
<td>glide.ui.incident_activity.fields</td>
<td></td>
</tr>
<tr>
<td>Additional comments icon used in Task Activity formatter</td>
<td>Enter the path of the icon that is used for additional comments.</td>
</tr>
<tr>
<td>glide.ui.incident_activity.image.comments</td>
<td></td>
</tr>
<tr>
<td>Work notes icon used in Task Activity formatter</td>
<td>Enter the path of the icon that is used for work notes.</td>
</tr>
<tr>
<td>glide.ui.incident_activity.image.work_notes</td>
<td></td>
</tr>
<tr>
<td>Incident additional comments style</td>
<td>Enter the html syntax of comment style for incident additional comments.</td>
</tr>
<tr>
<td>glide.ui.incident_activity.style.comments</td>
<td></td>
</tr>
<tr>
<td>Incident work notes style</td>
<td>Enter the html syntax of comment style for incident additional comments.</td>
</tr>
<tr>
<td>glide.ui.incident_activity.style.work_notes</td>
<td></td>
</tr>
</tbody>
</table>

### Major incident management

A user with admin or incident_manager role can edit the major incident properties to define whether a new major incident must be created or a major incident candidate must be promoted to a major incident. The properties are available only when you activate the Incident Management - Major Incident Management plugin (com.snc.incident.mim).

These properties are available at Incident > Administration > Major Incident Properties.

### Properties for major incident management

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create major incident from candidate</td>
<td>Provides option to create a new major incident or to promote a major incident candidate to a major incident.</td>
</tr>
<tr>
<td>sn_major_inc_mgnt.com.snc.incident.min.major_incident_creation</td>
<td></td>
</tr>
<tr>
<td>Compose Email on Major Incident Overview</td>
<td>Provides comma-separated list of incident communication task types that can have Compose Email option on Major Incident Workbench.</td>
</tr>
<tr>
<td>sn_major_inc_mgnt.com.snc.incident.mim.compose_email_on_iatasks</td>
<td></td>
</tr>
</tbody>
</table>
Incident categories and subcategories

Categorization of incidents helps in routing to the right team and saves a lot of time in troubleshooting and bringing the service to normalcy.

One of the KPIs (Key Performance Indicators) of the Incident Management process is to identify how many times the incident is sent to different teams. It also helps in analyzing incidents based on the classification to do proactive Problem Management which, in turn, helps to reduce Incidents. Proper incident classification is very important to identify and prioritize on which Incidents to work on first.

Using categories and subcategories also improves the clarity and granularity of report data. The following categories and associated subcategories are in the base system. An administrator can add additional categories and subcategories, and use them in assignment rules and notifications.

<table>
<thead>
<tr>
<th>Category</th>
<th>Subcategory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inquiry / Help</td>
<td>· Antivirus</td>
</tr>
<tr>
<td></td>
<td>· Email</td>
</tr>
<tr>
<td></td>
<td>· Internal Application</td>
</tr>
<tr>
<td>Software</td>
<td>· Email</td>
</tr>
<tr>
<td></td>
<td>· Operating System</td>
</tr>
<tr>
<td>Hardware</td>
<td>· CPU</td>
</tr>
<tr>
<td></td>
<td>· Disk</td>
</tr>
<tr>
<td></td>
<td>· Keyboard</td>
</tr>
<tr>
<td></td>
<td>· Memory</td>
</tr>
<tr>
<td></td>
<td>· Monitor</td>
</tr>
<tr>
<td></td>
<td>· Mouse</td>
</tr>
<tr>
<td>Network</td>
<td>· DHCP</td>
</tr>
<tr>
<td></td>
<td>· DNS</td>
</tr>
<tr>
<td></td>
<td>· DNS</td>
</tr>
<tr>
<td></td>
<td>· IP Address</td>
</tr>
<tr>
<td></td>
<td>· VPN</td>
</tr>
<tr>
<td></td>
<td>· Wireless</td>
</tr>
</tbody>
</table>
**Configure incident category or subcategory**

Configure incident category and subcategory for easy classification of incidents which helps in routing incidents to the right team. You can also generate reports based on category and subcategory of incidents.

Role required: admin

1. Navigate to Incident > All.
2. Open an incident record.
3. Do any of the following:
   - Right-click on the Category field name and select Configure Choices.
   - Right-click on the Subcategory field name and select Configure Choices.
4. Move the required category or subcategory from the Available list to the Selected list.
5. Click Save.

**Add a category or a subcategory**

Add category or subcategory to assign incidents to the correct team and save time in troubleshooting and bringing the service to normalcy.

Role required: admin

1. Navigate to Incident > All.
2. Open an incident record.
3. Do any of the following:
   - Right-click Category > Configure Choices.
   - Right-click Subcategory > Configure Choices.
4. In the Enter new item field, enter the new category or the subcategory name.
5. and click Add.
   - The new category or subcategory is added under the Selected list.

**Delete a category or a subcategory**

Delete a category or subcategory if your organization no longer uses the category or subcategory.

Role required: admin

1. Navigate to Incident > All.
2. Open an incident record.
3. Do any of the following activities:
   - Right-click on the Category field name and select Configure Dictionary.
   - Right-click on the Subcategory field name and select Configure Dictionary.
4. Click the Choices related list.

<table>
<thead>
<tr>
<th>Category</th>
<th>Subcategory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>• DB2</td>
</tr>
<tr>
<td></td>
<td>• MS SQL Server</td>
</tr>
<tr>
<td></td>
<td>• Oracle</td>
</tr>
</tbody>
</table>
5. Select the category or the subcategory record that you want to delete.
6. Click **Actions on selected rows** menu and select **Delete**.

### Define priority lookup rules

Define impact and urgency of an incident to calculate the priority. The priority calculation can then be used to prioritize work and drive service level agreements.

**Role required:** admin

1. Navigate to **System Policy > Rules > Priority Lookup Rules**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact</td>
<td>Impact is a measure of the effect of an incident, problem, or change on business processes.</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency is a measure of how long the resolution can be delayed until an incident, problem, or change has a significant business impact.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority is based on impact and urgency, and it identifies how quickly the service desk should address the task.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the rules. The scope defines whether the rules are available for all applications or for scoped applications.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to define whether the rule is active or not.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the rules appear in the priority lookup list. This field indicates which rule to execute first.</td>
</tr>
</tbody>
</table>

**Note:**

Priority is calculated according to the following sample data lookup rules:

#### Priority Data lookup rules

<table>
<thead>
<tr>
<th>Impact</th>
<th>Urgency</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - High</td>
<td>1 - High</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>1 - High</td>
<td>2 - Medium</td>
<td>2 - High</td>
</tr>
<tr>
<td>1 - High</td>
<td>3 - Low</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>1 - High</td>
<td>2 - High</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>2 - Medium</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>3 - Low</td>
<td>4 - Low</td>
</tr>
</tbody>
</table>
By default, the **Priority** field is read-only and must be set by selecting the **Impact** and **Urgency** values. To change how priority is calculated, administrators can either alter the priority lookup rules or disable the **Priority is managed by Data Lookup - set as read-only** UI policy and create their own business logic.

4. Click **Submit**.

### Define assignment rules for incidents

Define assignment rules to identify the right group or the user which is skilled to work on an incident.

Role required: assignment_rule_admin or admin

1. Navigate to **System Policy > Rules > Assignment**.
2. Create assignment rules by following the steps provided in **Create an assignment rule**.
3. Click **Submit**.

### Incident templates and record producers

Templates simplify the process of submitting new records by populating fields automatically. A template ensures consistency in the way information about the incident is captured. A record producer is a specific type of catalog item that allows end users to create task-based records, such as incident records, from the service catalog.

You can use incident templates to quickly create incidents for similar issues.

- An administrator or user with the **template_editor_global** role can create templates that are available to everyone.
- An administrator can enable the global option for any personal template that a user creates so that all other users can access the template.
- A user with the **itil** role can create their own templates for incidents they log frequently.

ESS users typically log incidents using a record producer in the service catalog. A template can be used to create an incident record producer. The template automatically populates fields in the incident form.

For example, an incident record producer can be created to request account access to a network server. The user who submits the incident enters variable values, such as the server name, level of access needed, and due date. The incident template assigned to the record producer populates the incident **Category**, **Subcategory**, and **Assignment Group**. These fields and values applied from the template do not appear in the record producer form.

### Create incident template

Create an incident template to ensure consistency in the way information about the incident request is captured. A template also helps you to create incident easily and accurately.
Role required: admin

Let us consider an example where you want to create a template to log an incident when you are denied access to the Bond Trading application.

1. Navigate to System Definition > Templates. You can also Create a template from the incident form.

2. Complete the steps in Create a template using the Template form using the following information:
   - **Name**: Bond Trading Access Denied
   - **Global**: Select the check box. The Global option allows any user to use the template, not just the template creator.
   - **Short Description**: Bond Trading Access Denied
   - **Template**: Add the following values to define the fields that are filled in when the template is used:
     - (Category): (Inquiry / Help)
     - (Configuration Item): (Bond Trading)
     - (Description): (The user was denied access to the Bond Trading application)
     - (Impact): (2 - Medium)
     - (Urgency): (3 - Low)
3. Click Submit.

Create a module that uses incident template

Create a module to log an incident with pre-filled field values from an existing template.
Role required: admin

In the Create incident template topic, you have created the Bond Trade Access Denied template. In this topic, you can use the template with a module in the Self-Service application.

1. Point to Self-Service and click the edit icon.

2. In the Modules related list, click New.

3. On the form, fill in the fields.

   - **Title:** Bond Trading Access Denied.
   - **Order:** In the Module records list, view the order numbers and enter a number that is appropriate. For example, if the order number of Homepage is 50 and the order number of Business Applications is 52, and you want to place the new module between Homepage and Business Applications, enter the order number as 51.
   - **Hint:** Log an incident about the Bond Trade application.

**Link Type section:**

- **Link Type:** URL (from Arguments:)
- **Arguments:** `incident.do?sys_id=-1&sysparm_template=Bond Trading Access Denied`

**Note:** This path deploys the template in the new incident record.
4. Click **Submit**.

The new module appears in the Self-Service application.

Click the module to open a new incident record with the applied Bond Trading Access Denied template.
Create a record producer to log incidents

Create record producers to log incidents directly from Service Catalog.

Role required: catalog_admin or admin

Incident record producers provide users with an interface from which user can log an incident. For example, the default Can We Help You? category features record producers such as Create Incident to enable users to log incidents from the catalog.

The following example demonstrates how to create a record producer to request a wireless router reset.

1. Navigate to Service Catalog > Catalog Definitions > Record Producers.
2. Click New and complete the steps in Create a record producer using the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Request to Reset Router</td>
</tr>
<tr>
<td>Table name</td>
<td>Incident (incident)</td>
</tr>
<tr>
<td>What it will contain</td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>Reset wireless router request</td>
</tr>
<tr>
<td>Description</td>
<td>Please reset the building's router</td>
</tr>
<tr>
<td>Accessibility</td>
<td></td>
</tr>
<tr>
<td>Catalogs</td>
<td>Service Catalog</td>
</tr>
<tr>
<td>Category</td>
<td>Can We Help You?</td>
</tr>
</tbody>
</table>
3. Right-click on the form header and from the context menu select **Save**. Several related lists appear at the end of the form, including Variables and Variable Sets.

4. In the Variables related list, click **New**.

5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Reference</td>
</tr>
<tr>
<td>Question</td>
<td>Which router needs to be reset?</td>
</tr>
<tr>
<td>Name</td>
<td>Router</td>
</tr>
<tr>
<td>Type Specifications</td>
<td></td>
</tr>
<tr>
<td>Reference</td>
<td>IP Router (cmdb_ci_ip_router)</td>
</tr>
</tbody>
</table>
6. Click **Submit**.

7. Optional: To view the new record producer, click **Try It** in the form header.

   In Service Catalog, the new catalog item appears and any user can select it.

**Create a record producer using a template**

If a predefined incident template exists, it can be used with the record producer to fill in standard information for the incident.

Role required: catalog_admin or admin

1. Navigate to **Service Catalog > Catalog Definitions > Record Producers**.
2. Click **New** and complete the steps in **Create a record producer**.
3. Click Generated Record Data and select the incident template to populate fields when the record producer is submitted.
4. Right-click on the form header and click Save.

View VIP status for a caller in incident

View the callers with VIP status on the incident records list view as well as incident form. Organizations commonly designate VIP status in the user record for some of their VIP users.

Role required: personalize_list or admin

When a caller is assigned to an incident, the user record is automatically checked for VIP status. If the caller is a VIP caller, an icon appears beside the caller name in the list view or the caller field in the form view.

1. Navigate to Incident > Open.
2. View the record for the VIP caller in the list of incident records.

3. Click the record to view the VIP status in the Caller field.
View incident notifications

View incident notifications that are sent during specific events in an incident life cycle. These notifications are sent to various recipients including the ESS and the ITIL users.

Role required: admin

1. Navigate to System Notification > Email > Notifications.
2. Filter the list of notifications by (Table) (is) (incident).
3. View the following list of default notifications for incidents.
4. Click the notification name to view the details.

**Note:** To receive these notifications, the end user must enable notifications. For more information, see *Subscription-based notifications*.

---

**Configure default user for auto-closing incidents**

Change the default user who last updated an incident to the user you mention for auto-closing incidents.

Role required: admin

1. Navigate to **System Scheduler > Scheduled Jobs > Scheduled Jobs**.
2. Open the **Autoclose Incidents** schedule job.
3. In the **Job context**, add the following:

   ```
   fcRunAs=<user_name>
   fcScriptName=incident autoclose
   ```

   For example, if you add `fcRunAs=admin`, the code places **System Administrator** in the **Updated by** field.

---

**Incident ticketing integrations**

An incident ticketing integration exchanges ticket data between your ServiceNow instance and a third-party system.

The advantages of an incident ticketing integration include the following items.

- Establishing a ticket number that provides a unique key between systems.
- Synchronizing the systems so that notifications can be triggered.
- Transforming data for more uniform processing.
- Tracking ticket activity for accurate reporting.

The level of data and the direction of the data that is exchanged categorizes the integration as uni-directional or bi-directional. In a uni-directional integration, a third-party system creates an incident ticket, passes data to your instance, and receives a ticket ID back as confirmation. In a bi-directional integration, incident data is exchanged, synchronized, and updated while data is sent between the systems.

For both integration types, a good practice is to implement a record-based log of the individual transactions for a given time period. If an outage occurs, a record-based log can tell you what data was exchanged, how it was transformed, when processing occurred, and if there were any errors. Record-based logs also allow you to run all the validation and transformation logic away from the main form, helping performance.

Before implementing your project, develop an integration plan in which all the implementation aspects and requirements are defined. Developing the integration plan helps you to review the current data, plan for future requirements, and identify and sequence project tasks.

---

**Uni-directional incident ticketing integrations**

Consider the requirements for an external, third-party system to create tickets. Define the data that must be sent to create a ticket, and what validation is required.
In this way, a standard web service interface can be created and published. This integration responds with a ticket number on success, or with a structured error message for validation failures and processing issues. An advantage of this implementation is that you can publish once and reuse for multiple applications, provided the additional integrations follow the integration specifications. A good practice is to create a dedicated account for each interface. Accounts provide accountability and report user statistics, and use a simple connectivity Point of Contact (POC).

**Integration plan contents**

- Firewall requirements
- Protocols to be used
- Required middleware (for example, MS Biztalk)
- Error messages
- Validation rules

**Example using basic authentication**

This implementation responds to the third-party system with the ticket ID. The Import Set tables function as a staging area for your data.
Uni-directional ticketing integration using basic authentication

Example using import sets

An implementation variation for the inbound path would be to use the Import Set Tables as interface tables. In this example, the Incident_Interface Table stores a history of data as it was...
received and before the data was transformed. The destination Incident Table could store a history of how the incident has changed over time and who changed it. The transform scripts would process the import set and the business rules would run on the target table.

Uni-directional ticketing integration using import sets
Bi-directional incident ticketing integrations

A bi-directional integration exchanges data between your ServiceNow instance and a third-party system so that incident information is synchronized between the systems.

This integration is more complex than a uni-directional integration because it has the following requirements.

- Comprehensive definitions of field mappings.
- Standardization of where transformations take place: inbound, outbound, or both.
- Consideration of the ownership of reference data.
- How updates are performed on an ongoing basis.

Implement error handling. Include all these implementations in the integration plan.

While bi-directional implementations are developed on their own merits, you can develop a framework in the Now Platform that can be reused, for example, data driven validation rules.

Integration plan contents

- Plan contents for all the aspects needed for a bi-directional integration.
- State models for each organization.
- Business rule definitions for keeping the tickets synchronized.
- Requirements to store history of individual transactions. If this form of audit is a requirement, consider creating an interface table which is populated prior to creating and updating the destination table.
- Transformation rules for all data elements.
- Time lines for when reference data is transported to the information system. Include requirements to perform transformations before sending the data to and from each system.
- Statement of reference data ownership at all stages.
- Update schema definitions.

Example using import sets and web services

In this implementation, data authentication is done before insertion into the import set. Transform maps and scripts execute before the data reaches the Incident table. The Incident table is used to store the history of the incident records. For the outbound data path, the target table could trigger business rules before the data is queued in the outbound web service.
Bi-directional ticketing integration using import sets and web services

Example using import sets and the ECC queue

An implementation variation for the inbound path would be to use an import set table (in our example, the Incident Interface table) to store historical data. Data validation is also done now,
and you can clear exceptions with processing or manual intervention. The Incident table uses a Third-Party Information table as a reference, and messages are generated based on business rules.

Implementing this type of integration involves a web-service component for third-party applications for inbound data. The ECC queue is recommended for outbound data.

Bi-directional ticketing integration using import sets and the ECC queue
Managing Incidents

Working on incidents involves diagnosing and investigating the incident, recording results, and sometimes escalating or promoting the incident.

Initial diagnosis of incidents is largely a human process. The service desk agent looks at the details of the incident and communicates with the user to diagnose the issue.

To aid in the diagnosis, the service desk agent can query the configuration management database, or CMDB. The CMDB contains information about hardware and software within a network and the relationships between them. The CMDB can be populated in two ways: Discovery and Help the Help Desk. Discovery is available as a separate product, but Help the Help Desk is provided with the base system.

Incident investigation

Incident investigation is also a human process. The service desk continues to use the information in the Incident form as well as the CMDB to solve the issue. Work notes are added to the incident as the service desk evaluates the incident, facilitating communication between the concerned parties. Work notes and other updates can be communicated to the concerned parties through email notifications.

One way to investigate incidents is to determine whether related records exist, using one of the following features.

Related incidents icon

The show related incidents icon ( ) appears beside the Caller field when it is populated. Click the icon to view the list of incidents for the same caller.

Note: Administrators can add this icon to any reference field by modifying the dictionary entry and adding the ref_contributions=user_show_incidents dictionary attribute. The icon appears only for users who have read or write access to the field. A UI macro named user_show_incidents defines the behavior. The UI macro must be active to view the related incidents icon.

Incidents by Same Caller related list

Another way to research related incidents is to use the Incidents by Same Caller related list. The administrator may need to configure the form to display this related list.

Dependency views

Dependency views can help find related incidents based on configuration items (CI). If a configuration item is attached to an incident, click the map icon ( ) to display the dependency views map. In the dependency map, if you want to view the tasks that are attached to the CI, click the down arrow next to the CI and from the menu, select View Related Tasks.
Incident promotion

When the incident management team has determined that the cause of an incident is an error or widespread problem, the team initiates the problem management process. When the issue requires a change to the infrastructure or a business service, the team initiates the change management process.

A menu item on the Incident form lets you create a problem or change record easily and associate the incident with the problem or change record. For more information, refer Create a task record from incident

**Note:** If the incident already has an associated problem or change record, you cannot create another record of the same task type.

Sometimes, the resolution for the user is to request hardware or software for them. For example, a user may report a problem that requires a new mouse device or keyboard. The service desk agent can create a request from the incident. The incident is associated with the requested item.

**Note:** This feature is available only in new instances starting with Jakarta or a later release. The Problem Management Best Practice – Jakarta plugin (com.snc.best_practice.problem.jakarta) plugin must be activate.
Incident escalation

There are two escalation methods the platform uses to track and report on incidents that are not being resolved according to your organization standards.

**Service level agreements (SLAs)**

SLAs monitor the progress of an incident according to a set of agreements between a service provider and customer that define the scope, quality, and speed of the services being provided. As time passes, the SLA escalates the priority of the incident and leaves a marker as to its progress. SLAs are also used as a performance indicator for the service desk.

**Inactivity monitor**

The inactivity monitor generates an event to prevent incidents from going unnoticed. When a certain amount of time has passed without an update to the incident, the event creates an email notification or triggers a script.

Logging an incident

Log incident records from sources such as email, service desk, service catalog, or external applications as per your convenience. You can also generate incident using business rules or SOAP messaging.

<table>
<thead>
<tr>
<th>Where</th>
<th>How</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service desk</td>
<td>User can call a service desk agent and the agent can log an incident based on the information provided by the user. Service desk (ITIL) agents can log an incident from the <strong>Self-Service &gt; Incidents &gt; Create New</strong> module.</td>
</tr>
<tr>
<td>Service catalog</td>
<td>User can log an incident in service catalog from the <strong>Self-Service &gt; Service Catalog &gt; Can We Help You? &gt; Create Incident</strong> record producer.</td>
</tr>
<tr>
<td>Email</td>
<td>User can send an email to the instance mailbox. An incident is created according to the inbound email actions.</td>
</tr>
<tr>
<td>SMS</td>
<td>User can send an SMS to ServiceNow Customer Service number and an incident is automatically created for the user. <strong>Note:</strong> The user must install the Notify plugin (com.snc.notify) and set up a Twilio account in order to avail the messaging service.</td>
</tr>
<tr>
<td>Chat window</td>
<td>User can request to create an incident using the Connect chat icon that appears on the upper-right corner of the instance. On the chat window, the user can add an ITIL user and also provide a short description of the issue. Based on the description, the ITIL user creates an appropriate incident.</td>
</tr>
</tbody>
</table>
Note: If you want to create a security incident, first activate the Security Incident Response Dependencies plugin (com.snc.si_dep). You can then click Create Security Incident on a new incident form to create a security incident from the currently displayed incident.

ESS users can:

- View the incidents they have opened. By default, the **Watch list**, **State**, and **Urgency** fields are available on the ESS view of the **Incident** form.
- Update the **Watch list** and **Short Description** fields, and enter **Additional comments**. The administrator can configure other fields to be editable.

User who do not have the itil role can view an incident only if the user is the caller for that incident, has opened the incident, or is included in the watchlist. The **incident query** business rule controls this function.

Automatically generated incidents

- Incidents can be automatically generated using business rules. Business rules use JavaScript to generate an incident if pre-defined conditions are met.
- Incidents can be generated from outside the platform with SOAP messaging. For more information, refer to **SOAP messaging**.

Create an incident

Create an incident record to document a deviation from an expected standard of operation.

Role required: itil, sn_incident_write, or admin

Incidents are also logged when a user fills out a record producer in the service catalog, or sends an email to the instance. This procedure describes how an ITIL agent completes the Incident form.

1. Navigate to **Incident > Create New**.
   - You can also click **New** from the Incident list view.
2. Optional: **Use a template**, if one exists for the type of incident you are logging.
   - If the organization uses form templates, you can apply a template to pre-populate some of the fields for specific types of incidents.
3. On the form, fill in the fields.
   - Your organization has configured the Incident form to adhere to its incident management process. Enter information in the form field based on the process. The following table describes typical Incident form fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique system-generated incident number.</td>
</tr>
<tr>
<td>Caller</td>
<td>The user who contacted you with an issue.</td>
</tr>
<tr>
<td>Category and Subcategory</td>
<td>The type of issue. After selecting the category, select the subcategory, if applicable.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service</td>
<td>The affected business service, if applicable.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you select a business service as the configuration item and that business service is also listed as the configuration item in any other active task, the active tasks icon ( <img src="image" alt="active tasks icon" /> ) appears. Click the icon to view the list of all the other active tasks that are affecting the business service.  You can view the BSM map (dependency view) of the selected business service by clicking the dependency icon <img src="image" alt="dependency icon" />.</td>
</tr>
<tr>
<td>Service Offering</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. Service offering enables you to receive different features and their levels of performance for a given service.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>The affected CI, if applicable.</td>
</tr>
<tr>
<td>Contact type</td>
<td>The communication method used by the user to create the incident.</td>
</tr>
<tr>
<td>State</td>
<td>The state moves and tracks incidents through several stages of resolution.</td>
</tr>
<tr>
<td>Tip:</td>
<td>Use the State field, rather than the Incident State or Problem State fields, as your primary means of tracking the state of an incident as it progresses through the entire processing cycle. To learn more, see Life cycle of an Incident.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact is a measure of the effect of an incident, problem, or change on business processes.</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency is a measure of how long the resolution can be delayed until an incident, problem, or change has a significant business impact.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority is based on impact and urgency, and it identifies how quickly the service desk should address the task.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group to work on this incident. If left blank, the incident is automatically assigned. <strong>Note:</strong> The <code>sys_user_group</code> read ACL calls the <code>SNCRoleUtil</code> function. The function verifies whether the group that is reviewed contains either the admin role or <code>security_admin</code> role. The function allows the user to view the group only if the user has the same role. As a result, an ITIL user cannot assign an incident to a group that has the admin role or <code>security_admin</code> role nor to one whose parent has the role.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user to work on this incident. If the <strong>Assignment group</strong> changes, the <strong>Assigned to</strong> field is cleared.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the incident.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed explanation on the incident.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Watch list</td>
<td>Users who receive notifications about this incident when comments are added. Click the add me icon to add yourself to the watch list.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notifications about this incident when work notes are added. Click the add me icon to add yourself to the work notes list. <strong>Note:</strong> The administrator must create an email notification for the work notes list.</td>
</tr>
<tr>
<td>Additional comments</td>
<td>More information about the issue as needed. All users who can view incidents see additional comments.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about how to resolve the incident, or steps taken to resolve it, if applicable.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Actions taken | A journal field where you can enter details of the actions taken for a major incident. This field is for only internal users.

**Note:** This field is only visible when you activate the Major Incident Management plugin (com.snc.incident.mim).

| Related Records |
|---|---|
| Problem | The unique number of any related problem record that is related to the incident. |
| Change Request | The unique number of any related change request that is related to the incident. |
| Caused by Change | The unique number of the change request that resulted in the creation of the incident. |

4. **Click Submit.**

**Note:** To mail the incident record, click in the title bar and select Email. The user who requested the incident and the user who is assigned to the incident are automatically populated in the list of recipients.

**Capture information on affected configuration items in an incident**

Capture information on affected configuration items (CIs), with type as asset, in an incident to keep a record of the updated, repaired, swapped, or retired configuration items. By keeping track of the assets, you can tell where the assets are located, how they are used, and when changes were made to them. This information helps you to monitor and manage the assets in your company using a systematic approach.

**Role required:** itil or admin

Activate the Hardware Asset Management Professional plugin (com.sn_hamp).

If you are not the caller of the incident and have a CI value in the affected CIs list, it is mandatory to provide information on the CI before changing the state of the incident to Resolved.

You can enter CI information either from the Affected CIs related list or from the form layout of the Affected CIs. You need to manually add the Asset Action and the Swapped CI fields in the related list.
Add fields in the related list

<table>
<thead>
<tr>
<th>Where</th>
<th>How</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related list</td>
<td>• In the <strong>Affected CIs</strong> related list, click the settings icon</td>
</tr>
<tr>
<td></td>
<td>• Move the <strong>Asset Action</strong> and the <strong>Swapped CI</strong> fields from the <strong>Available</strong> column to the <strong>Selected</strong> column.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>

1. Navigate to **Incident > Open**.
2. Open an incident.
3. Navigate to the **Affected CIs** related list before resolving the incident.
4. Optional: If you want to enter information in the form layout, click the CI.
5. On the related list or the form, fill in the fields.

**Information on Affected CIs**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Asset Action</strong></td>
<td>Information on whether a CI is updated or repaired, swapped with another CI, or retired from the system. The options available are: No action, Update/Repair, Swap, and Retire.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you swap or retire a CI, the <code>sn_hamp_asset.swap</code> or <code>sn_hamp_asset.retire</code> events are generated respectively.</td>
</tr>
<tr>
<td><strong>Swapped CI</strong></td>
<td>Information on the new CI that is swapped with the existing CI.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field appears only when you select the value of the <strong>Asset Action</strong> field as <strong>Swap</strong>. The CI values available for swapped CI are the ones with asset CI class as hardware.</td>
</tr>
</tbody>
</table>

6. Click **Update**.
The record is saved and the information about CI is stored in the `(task_ci)` table.

**Note:** You can filter the **Affected CIs** related list to have the list of affected CIs with class as Asset.
Create a template from the incident form

Create a template that define default values for forms so that users can easily create incident. You need to have appropriate permissions before creating templates.

Role required: itil, sn_incident_write, or admin

1. Navigate to Incident > Create.
2. Click the more options icon and then click **Toggle Template Bar** to see the template bar.
Incident:

- **Number**: 1612655080
- **Category**: Inquiry/Help
- **Subcategory**: None
- **Contact type**: None
- **State**: New
- **Impact**: 3 - Low
- **Urgency**: 3 - Low
- **Primary**: Planning
- **Assignee**: None
- **Assigned to**: None

Related Search Results:

- **Search**: None
- **Knowledge Catalog**: None

No results to display.
3. On the template bar, click the add icon.

( )
### Incident (New record)

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>IN4567890</td>
</tr>
<tr>
<td>Category</td>
<td>Inquiry/Help</td>
</tr>
<tr>
<td>Service</td>
<td></td>
</tr>
<tr>
<td>Configuration item</td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
</tbody>
</table>

**Contact type**: New

**State**: New

**Impact**: 3 - Low

**Urgency**: 3 - Low

**TIER**: 5 - Planning

**Assignment group**: N/A

**Assigned to**: N/A

**Notes**

**Related Records**

**Resolution Information**

**Watch list**

**Work orders list**

**Template**: Incident Call Type

**Major Incident**
4. On the form, fill in the fields.

Create New Template form

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the template.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that this template applies to. Select <strong>Global</strong> to make the template available for use with all tables.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for making the template available for use. A template must be active to be used.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the rules. The scope defines whether the rules are available for all applications or for scoped applications.</td>
</tr>
<tr>
<td>User</td>
<td>User who can configure and apply the template. If you define a user, no other users can see the template unless you select the <strong>Global</strong> option.</td>
</tr>
<tr>
<td>Groups</td>
<td>Group whose members can configure and apply the template. If you define a group, no other groups can see the template unless you select the <strong>Global</strong> option.</td>
</tr>
<tr>
<td>Global</td>
<td>Option for allowing any user who can access the templates to view and apply this template.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description of the template.</td>
</tr>
</tbody>
</table>

**Note:** Adding content to this field does not add that content to the **Short description** field of the forms that use this template.

| Template   | Content that automatically populates records that are based on this template. Select a field from the specified table in the left column and then enter the data to automatically populate in the right column. |

**Note:** Even though you can select dot-walked fields in the template, they do not apply to fields that are on the form.

5. Click **Submit**.

The template is created and you can find it on the template bar.
Apply a template in the Incident form

Apply a template to a new incident record if the pre-populated information in the template is applicable to the incident record. It saves your time and effort to enter values in the incident record fields individually.

Role required: itil, sn_incident_write, or admin

1. Navigate to Incident > Create New.
2. Click the more options icon and then click Toggle Template Bar to see all templates in the template bar.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>INCDE10026</td>
</tr>
<tr>
<td>Caller</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Inquiry / Help</td>
</tr>
<tr>
<td>Subcategory</td>
<td>- None -</td>
</tr>
<tr>
<td>Business service</td>
<td></td>
</tr>
<tr>
<td>Configuration Item</td>
<td></td>
</tr>
<tr>
<td>Contact type</td>
<td>- None -</td>
</tr>
<tr>
<td>State</td>
<td>New</td>
</tr>
<tr>
<td>Impact</td>
<td>3 - Low</td>
</tr>
<tr>
<td>Urgency</td>
<td>3 - Low</td>
</tr>
<tr>
<td>Priority</td>
<td>5 - Planning</td>
</tr>
<tr>
<td>Assignment group</td>
<td></td>
</tr>
<tr>
<td>Assigned to</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Related Search Results</td>
<td></td>
</tr>
<tr>
<td>Related Search</td>
<td></td>
</tr>
<tr>
<td>Knowledge &amp; Catalog (All)</td>
<td></td>
</tr>
</tbody>
</table>

No results to display.
3. Click a template to apply the template on the incident record.

Create an incident task

Create an incident task to communicate with and request work from assignment groups other than the one that is mentioned for the incident.

Role required: itil, sn_incident_write, or admin

1. Navigate to Incident > Open.
2. Open the incident record.
3. In the Incident Tasks related list, click New.
   If you do not see the Incident Tasks related list, you need to add it. For information on how to add a related list, refer Add a related list to a form.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique system-generated incident task number.</td>
</tr>
<tr>
<td>Incident</td>
<td>Incident with which the task is associated.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>The affected CI.</td>
</tr>
<tr>
<td>State</td>
<td>The state moves and tracks incident task through several stages of resolution.</td>
</tr>
<tr>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group who works on the incident task. If you leave it blank, the incident is automatically assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user to whom the incident task is assigned to work on.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the incident task.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed explanation on the incident task.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notifications about this incident task when work notes are added.</td>
</tr>
</tbody>
</table>

Note: If the Assignment group changes, the Assigned to field is cleared.

Note: You can the add me icon to add yourself to the work notes list.
Field | Description
---|---
Work notes | Information about how to resolve the incident task, or steps taken to resolve it, if applicable.

5. Click **Submit**.

### Synchronization between an incident and its incident tasks

Use incident tasks to collaborate with and request work from other stakeholders. An incident and its tasks are synchronized such that the state of incident tasks changes depending on the state of the incident.

**Note:** The Close open Incident Tasks when Incident is closed or canceled property (com.snc.incident.incident_task.closure) is responsible for different actions that take place on incident tasks based on the state of the incident.

The synchronization between an incident and its open incident task is as follows:

- When an incident is closed, the state of any open incident task is set to **Closed Incomplete**.
- When an incident is canceled, the state of any open incident task is set to **Closed Skipped**.

### Create a task record from incident

Create a problem, change, or request record from an incident. When the cause of an incident is an error or widespread issue, a problem is generated from the incident. When the issue requires a change to the infrastructure or a business service, a change record is created from the incident. When the resolution for the user is to request hardware or software, a request is created from an incident.

Role required: itil, itil_admin, or admin

1. Navigate to **Incident > Open**.
2. Open the incident record.
3. Right-click on the header form and on the context menu, select the appropriate option.

<table>
<thead>
<tr>
<th>Task record</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Problem</strong></td>
<td>Create Problem. For more information, refer to Create a problem.</td>
</tr>
<tr>
<td><strong>Request</strong></td>
<td>Create Request. For more information, refer to Create a request from an incident.</td>
</tr>
</tbody>
</table>

**Note:** Use the property List of attributes (comma-separated) that will be copied from the incident to create a new problem (com.snc.problem.create_from_incident.attributes) to specify fields on the Incident form. The values of these fields are copied to the respective fields on the Problem form. The property is available for customers starting the Madrid release.
<table>
<thead>
<tr>
<th>Task record</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change</td>
<td>Create Normal, Standard, or Emergency Change. For more information, refer to Create a change request.</td>
</tr>
</tbody>
</table>

**Note:**
The Create Normal Change, Create Standard Change, and Create Emergency Change scripts copy these fields from the Incident form:
- short_description
- description
- cmdb_ci
- priority
- company

The syntax for copying a field from the Incident form to the Change form is:
```
changeRequest.setValue("field_name", current.field_name);
```
The admin adds this information in the script block of the incident record.

The form for the new record appears and is already saved. Some specific fields are copied to the newly generated record from the incident. You can find reference of the newly created task record in the Related Records section of the Incident form.

4. Optional: Complete the Problem, Change, or Request form with additional information and click Update.

**Create a request from an incident**

When you work on an incident and determine that the user needs one or more catalog items, such as an application or a new laptop, you can create a request from the incident. It helps you in tracking the requests associated with an incident and vice versa.

Role required: itil or sn_incident_write

The Best Practice - Incident Resolution Workflow plugin (com.snc.bestpractice.incident) should be active for creating a request from an incident. To associate a parent incident with the request created for a record producer, the catalog_admin should add the following script in the script block of the record incident.

To associate a parent incident with the request created for a record producer, the administrator should add the following script in the script block of the record producer:

```
var incRPUtil = new LinkRecordProducerToIncident();
incRPUtil.linkRecordProducerToParentIncident(RP.getParameterValue('sysparm_req_parent'), current);
```
Note: If you set the `Use the sc_layout driven cart macros (default true)`
`(glide.sc.use_cart_layouts)` property to `false` and create a request from an incident, the request is not associated with the incident.

1. Navigate to **Incident > All.**
2. Select the required open incident.
3. Click the additional actions menu icon and select **Create Request.**
   The Catalogs home page is displayed with all active catalogs that you can access.

   Note: If there is only one active catalog, then that catalog page is displayed with available categories.

4. Select the required catalog and navigate through its categories and items.
5. Checkout the required catalog item, order guide, or record producer. For information on checkout models, see [Service Catalog checkout models](#).
   For a catalog item or order guide, a request is created and displayed under the **Requests** tab of the incident. For a record producer, the corresponding task is created and displayed under the **Problems** tab of the incident.

   Note:
   - The associated incident is specified in the annotation message throughout the request process.
   - Both for the one-step and two-step checkout, the caller of the incident is automatically set as the **Requested For** user for the request. If the two-step checkout is enabled, the fulfiller can change the **Requested For**.
   - You cannot add items to the wish list, or save a record producer in this flow.

### Copy an incident or create a child incident

Copy an incident or create a child incident without manually entering the value of all the fields in the new incident.

- Role required: itil, sn_incident_write, or admin
- Select the **Enable copy incident feature** (com.snc.incident.copy.enable) and the **Enable create child incident feature** (com.snc.incident.create.child.enable) incident properties at **Incident > Incident Properties.**

   Note: An itil user can copy or create a child of any incident whereas a user without any role can copy only the incident which the user has created.

The Copy Incident functionality copies the details of an existing incident record to a new incident record. The Create Child Incident functionality copies the details of the parent incident and links the new incident to the parent incident. You can enable the options as well as add or remove fields or related list using the copy incident and create child incident properties.

1. Navigate to **Incident > Open.**
2. Open an existing incident that you want to copy or from which you want to create a child incident.
3. Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy an incident</td>
<td>Click the Additional actions icon and then click <strong>Copy Incident</strong>.</td>
</tr>
</tbody>
</table>

**Note:** After the incident is copied, the **Work notes** field of the new incident is updated with the following message:
Created from a similar incident: INCXXXXXX.

| Create a child incident | Click the Additional actions icon and then click **Create Child Incident**. |

**Note:** Ensure you have added the **Parent Incident** field and the **Incident -> Parent Incident** related list to the incident form. The incident, from which you have created the child incident, is considered as the parent incident.

4. Fill out the other fields, as required.

5. Click **Submit**.

The default fields and related lists that are copied from the parent incident are:

<table>
<thead>
<tr>
<th>From where</th>
<th>What are copied</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fields</td>
<td>Category</td>
</tr>
<tr>
<td></td>
<td>Subcategory</td>
</tr>
<tr>
<td></td>
<td>Business Service</td>
</tr>
<tr>
<td></td>
<td>Configuration Item</td>
</tr>
<tr>
<td></td>
<td>Impact</td>
</tr>
<tr>
<td></td>
<td>Urgency</td>
</tr>
<tr>
<td></td>
<td>Assignment group</td>
</tr>
<tr>
<td></td>
<td>Short Description</td>
</tr>
<tr>
<td></td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>Related lists</td>
</tr>
<tr>
<td></td>
<td>Caused by Change</td>
</tr>
<tr>
<td></td>
<td>Location</td>
</tr>
<tr>
<td></td>
<td>Company</td>
</tr>
<tr>
<td></td>
<td>Problem</td>
</tr>
<tr>
<td></td>
<td>Change Request</td>
</tr>
<tr>
<td></td>
<td>Parent Incident</td>
</tr>
</tbody>
</table>

**Note:** If the problem, change, or the parent incident is not active, then details of those fields are not copied.
Synchronization between a parent and a child incident

The parent and the child incidents are synchronized such that the state of a child incident changes depending on the state of the parent incident.

**Parent-Child state synchronization**

<table>
<thead>
<tr>
<th>Parent State</th>
<th>On Hold Reason (Parent)</th>
<th>Child State</th>
<th>On Hold Reason (Child)</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Progress</td>
<td>NA</td>
<td>In Progress</td>
<td>NA</td>
</tr>
<tr>
<td>On Hold</td>
<td>Awaiting Change/Awaiting Problem/Awaiting Vendor</td>
<td>Same as parent</td>
<td>Same as parent</td>
</tr>
<tr>
<td>On Hold</td>
<td>Awaiting caller</td>
<td>Not updated</td>
<td>Not updated</td>
</tr>
<tr>
<td>Resolved</td>
<td>NA</td>
<td>Resolved.</td>
<td>NA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Activity log in the child incident form is updated with the resolution notes copied from the parent Incident.</td>
<td></td>
</tr>
<tr>
<td>Closed</td>
<td>NA</td>
<td>Not closed.</td>
<td>NA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Child incidents must always be closed by the caller or by the system based on the auto-closure property.</td>
<td></td>
</tr>
<tr>
<td>Canceled</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
</tr>
</tbody>
</table>

**Note:**

- When an incident has a child incident, the following actions take place:
  - If an ITIL user reopens the parent incident, then the parent incident as well as the child incident reopens. Both the parent and the child incident state is set to **In Progress**.
Enable the display of incident special handling notes

Enable the display of informative notes for a specific record or for a set of records that meet one or more conditions. Use these notes to help users understand the action that was taken for the incident or the next course of action to be taken.

Role required: admin

Activate the Special Handling Notes plugin (com.sn_shn) to add the Create Special Handling Notes related link from which you can create the notes.

1. Navigate to Incident > All.
2. Open any incident record.
3. Click the Additional actions icon and select Configure > Form Layout.
4. From the Available list, select Special Handling Notes Pop Up and move it to the Selected list.
5. Click Save.
   The Incident form can now display special handling notes.

Create a knowledge article from an incident using an article template

Provide a resolution for an issue by creating a knowledge article from an incident with fields defined in an article template.

Role required: itil, sn_incident_write, or admin

Activate the KCS Integration for Incident Management plugin (com.snc.incident.knowledge).

You can create a knowledge article only when the incident is resolved and you have not already created a knowledge article from that incident.

Note: Incident managers with the sn_km_ml.knowledge_curation_user role can use the Demand Insights for Incidents dashboard to identify which incidents have no or insufficient knowledge coverage. For more information, refer Demand Insights for Incidents dashboard.

1. Navigate to Incidents > Resolved.
2. Open a resolved incident record.
3. Access the Incident KCS Article form using one of the following methods:
   • Under Related Links, click Create Knowledge.
   • Right-click the form header and click Create Knowledge.

   The Incident KCS Article template provided with the base system appears. If you want to create your own article template, refer to Create an article template and use it to create a knowledge article.
4. On the form, fill in the fields.
## Incident KCS Article form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>(Auto-generated) Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Knowledge base in which the article is stored. The Incident KCS Article is stored in the (kb_template_incident_kcs_article) table.</td>
</tr>
<tr>
<td>Category</td>
<td>(Auto-generated) The value of this field is automatically provided from the Category field of the knowledge.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Date after which the knowledge article is deleted from the database. After this date, the article does not appear in the search result.</td>
</tr>
<tr>
<td>Confidence</td>
<td>Maturity of an article based on its completeness and reusability.</td>
</tr>
<tr>
<td>Version</td>
<td>(Auto-generated) Displays the article version number, which is incremented when changes are made to a published article.</td>
</tr>
<tr>
<td>Workflow</td>
<td>(Auto-generated) Workflow that is followed for creating the knowledge article. For more information, refer Knowledge workflows.</td>
</tr>
<tr>
<td>Source Task</td>
<td>(Auto-generated) Incident record from which you have created the article.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Check box to automatically download an attached article instead of opening the article, when you access an article.</td>
</tr>
<tr>
<td>Display attachments</td>
<td>Check box to display attachments in the knowledge article. The attachments appear below the article text.</td>
</tr>
<tr>
<td>Governance</td>
<td>An attribute of an article that allows you to control sensitive, critical, or regulated information. Not all articles have the same requirement for compliance reviews. Some articles are based on the collective experience of those who use the articles (experience-based). Other articles have policy or legal information that require tight control (compliance-based).</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the knowledge article.</td>
</tr>
<tr>
<td>Issue</td>
<td>Information on the cause of the incident.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Method used to resolve the incident.</td>
</tr>
</tbody>
</table>

**Note:** The **Confidence** and **Governance** fields appear when the Knowledge Management KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities) is activated. For more information, see **Managing the KCS article state**.

5. **Click Submit.**
A knowledge article is created. The article record is listed in the Knowledge related list.

**Create a knowledge article from an incident**

When you are ready to close an incident, you can create a knowledge article so the next time the issue comes up the resolution is easy to find.

Role required: itil, sn_incident_write, or admin

When an incident is closed automatically or by the caller, a draft knowledge article is created.

1. Open a resolved incident that you want to close.
2. Ensure that the Knowledge check box is selected and that a resolution is entered in the Additional comments (Customer visible) field.
3. Click Close incident.

A new draft knowledge article is created. The content in the fields listed in the following table is copied from the Incident form to the Knowledge form.

<table>
<thead>
<tr>
<th>Field on Incident form</th>
<th>Field on Knowledge form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Additional comments</td>
<td>Text</td>
</tr>
<tr>
<td>Number</td>
<td>Source</td>
</tr>
</tbody>
</table>

The Knowledge related list on the Incident form is populated with the new draft knowledge article. The draft article does not appear in the knowledge base (KB) for users until it is reviewed and published.

If the Knowledge submission workflow (glide.knowman.submission.workflow) is enabled from the System Properties (sys_properties) table, the content in the Short description and Additional comments fields of the incident form become a knowledge submission instead of an article. The KB Submissions related list on the Incident form is populated with the new knowledge submission. For more information on creating a knowledge article and workflows, see [Enable creating a knowledge article from an incident and Knowledge workflows](https://servicenow.com/). To see the draft articles, navigate to Knowledge > My Knowledge Articles and then open the draft article by its KB number in the Knowledge form.

**View affected CIs in the dependency views map**

A configuration item (CI) can result in an incident. Use dependency view to identify other configuration items (CIs) that are affected by the CI that resulted in the incident.

Role required: itil, itil_admin sn_incident_write, or admin

Often, an incident is related to one or more specific configuration items (CIs). If the configuration management database (CMDB) is populated, the CI records hold valuable information to help resolve incidents. You can associate configuration items to an incident to see how the incident affects dependent CIs.

Use the Configuration Item field when a single CI is the cause of the incident and use the Affected CIs related list when multiple CIs are affected by the incident. For example, suppose a load-balancer in a data center is no longer operational. The Configuration Item field lists the specific server which is out of memory. The Affected CI related list contains the load-balancer, the data...
center, the servers that depend on the load-balancer, and business services that are impacted by the missing server.

1. On the Incident form, associate the CIs.

<table>
<thead>
<tr>
<th>From where</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration item field</td>
<td>Click the lookup icon beside the field and select the CI.</td>
</tr>
</tbody>
</table>
| Affected CIs related list       | 1. Click Add at the top of the list.  
2. Select the CI to associate.  
3. Click Add Selected.  
4. Right-click on the form header and click Save. |

2. Click the dependency views icon beside the Configuration item field. The Dependency Views map opens in a new tab or window.

3. To see items that this CI affects, click the down arrow and select View Affected CIs.
To add another affected CI to the incident, click the down arrow beside the CI and click Add Affected CI(s).

## Associate CIs with incident

Associate affected or impacted configuration items (CIs) with an incident record to find out how the incident affects other CIs with dependent relationships.

Role required: admin

Use the **Configuration Item** field when there is a single, primary CI that is the cause of the incident and the **Affected CIs** or the **Impacted Services/CIs** related list when multiple CIs are affected by the incident.

1. Navigate to **Incident > Open**.
2. Open the incident record to which you want to associate CI items.
3. Perform the following actions:

### Associate CI items

<table>
<thead>
<tr>
<th>Options</th>
<th>Procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration item</td>
<td>1. Click the lookup icon (🔍).</td>
</tr>
<tr>
<td></td>
<td>2. Select configuration item.</td>
</tr>
</tbody>
</table>

**Note:** By default, Service Offering is filtered out and CIs with Principal Class are selected. The Principal Class filter functionality is applicable to the new customers starting the Paris release.
**Options**

**Affected CIs**

**Procedures**

1. Click **Add**.
2. Select configuration items.

**Note:** By default, Service Offering is filtered out and CIs with Principal Class are selected. The Principal Class filter functionality is applicable to the new customers starting the Paris release.
Update the resolved incident notification template

Modify the content of the email template that is sent to the user when you resolve an incident.

Role required: admin

1. Navigate to System Notification > Templates.
2. Open the incident.ess.resolve template.
3. Manually update the template content.
4. Click Update.

Incident resolution and closure

An incident is considered resolved when you provide the user with a temporary workaround or a permanent solution for the issue.

When an incident is resolved, the escalators stop, and the caller can review the resolution. If the caller is satisfied with the resolution, the caller can close the incident or the incident is auto-closed after a certain time based on the incident auto-close properties.

If the cause of an incident is understood but cannot be fixed, the service desk can create a problem from the incident to find the root cause of the issue. The problem is then evaluated through the problem management process.

If the incident creates the need for a change in IT services, the service desk can generate a change from the incident, which is evaluated through the change management process.

Incident closure

You can configure incident properties to auto-close an incident.

Your organization can also generate customer satisfaction surveys when incidents are closed. Surveys allow the service desk to gather information about the quality of their service directly from the user.

Resolve and close an incident

When the service is restored by rectifying the issue that resulted for an incident, you can set the incident state as resolved. If the user is satisfied with the resolution, the user can close the incident or the incident is auto-closed after a certain time based on the incident auto-close properties.

Role required: itil, list_updater, sn_incident_write, or admin

1. Navigate to Incident > Open.
2. Open the incident that you want to resolve and close.
3. In the Resolution Information section, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolved by</td>
<td>The user who resolved the issue and the date and time the incident was closed.</td>
</tr>
<tr>
<td>Resolved</td>
<td>The date and time when the incident was resolved.</td>
</tr>
<tr>
<td>Resolution code</td>
<td>Information to categorize resolved cases.</td>
</tr>
<tr>
<td>Resolution notes</td>
<td>Document how an incident is resolved.</td>
</tr>
</tbody>
</table>

4. Click **Resolve**.  
The incident is in the resolved state.
5. Click **Close Incident**.  
The incident is closed.

**Configure incidents to close automatically**

Close incidents automatically based on the last updated date or the resolution date of the incident by configuring incident properties. You can also mention the number of days system must wait before initiating the auto-closing functionality.

Role required: admin

You can auto-close incident based on the last updated date or the resolution date of the incident using the property `Enable auto closure of incidents based on Resolution date`. Setting this to ‘No’ will make auto closure to run based on the Updated date (com.snc.incident.autoclose.basedon.resolved_at). This property is set to true only for the new customers starting the London release. Existing customers before the London release have to manually set the property to true.

**Note:** You cannot auto-close a major incident based on the incident auto-closure property. For more information, refer Close a major incident.

A scheduled job called **Autoclose Incidents (System Scheduler > Scheduled Jobs > Scheduled Jobs)** runs the **Incident Autoclose** business rule to close incidents as described. By default, it assigns the name of the administrator, who is logged in when the **Autoclose Incidents** job runs, to the **Updated by** field.

1. Navigate to **Incident > Administration > Incident Properties**.
2. Select the **Enable auto closure of incidents based on Resolution date. Setting this to ‘No’ will make auto closure to run based on the Updated date** check box if you want the incident to be auto-closed based on the resolution date.
3. In the **Number of days (integer) after which Resolved incidents are automatically closed. Zero (0) disables this feature (glide.ui.autoclose.time)** property, enter the number of days.

**Note:** If you have an inactivity monitor triggering on your incident, it resets this auto-close clock each time it triggers, preventing your incident to be closed. To prevent this reset, set a **Reset Condition** on your inactivity monitor to **(Incident state) (is not) (Resolved)**.
4. Click Save.

**Close multiple incidents from list**

Close multiple incidents from the incident list simultaneously that can have the same resolution code.

Role required: itil, list_updater, sn_incident_write, or admin

1. Select the check box beside each incident that you want to close.
2. Right-click on any list column header and click Update Selected.
3. Set the value of **State** to **Closed**.
4. In the Resolution Information section, select a **Resolution code** and enter your notes in **Resolution notes**.
5. Click **Update**.
   The changes apply to all the selected records.
Create a UI action to close multiple incidents

Create a UI action to close multiple incidents at once from the Actions list in the list view.

Role: business_rule_admin (for business rule), ui_action_admin (for UI action), or admin

Closing an incident from Actions list adds the same close note to all the incidents that are closed and does not require the list_updater role. Implementing this process requires a script include that is referred from a UI action and a custom UI page.

1. Navigate to System Definition > Script Includes and click New.
2. Create the script includes with the following information.
   - **Name**: IncidentClosure
   - **Client callable**: Select the check box
   - **Active**: Select the check box
   - **Script**: Paste the following information:

   ```javascript
   var IncidentClosure = Class.create();
   IncidentClosure.prototype = Object.extendsObject(AbstractAjaxProcessor, {
       closeIncidents: function() {
           var selectedIncidents = this.getParameter("sysparm_incidents");
           var notes = this.getParameter("sysparm_closeNote");
           var code = this.getParameter("sysparm_closeCode");
           var incidentGr = new GlideRecord('incident');
           incidentGr.addQuery('sys_id', 'IN', selectedIncidents);
           incidentGr.query();
           while (incidentGr.next()) {
               incidentGr.setValue('state', 7);
               incidentGr.setValue('close_notes', notes);
               incidentGr.setValue('close_code', code);
               incidentGr.update();
           }
           return true;
       },
       type: 'IncidentClosure'
   });
   ```

3. Save the record.
4. Create the following steps to create a UI page.
   - **Name**: mandatory_fields_to_close_incident_ui
   - **HTML**: Paste the following information:

   ```xml
   <?xml version="1.0" encoding="utf-8" ?>
   <j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide"
   xmlns:j2="null" xmlns:g2="null">
   <style>
   #content_row .reference-label {
       padding-right: 15px;
   }
   
   #page_timing_div {
       display: none;
   }
   </style>
   <form class="form-horizontal">
   ```

© 2020 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Client script: Paste the following information:

```javascript
function actionOK() {
  var modal = GlideModal.prototype.get("mandatory_fields_to_close_incident_ui");
  var incidents = modal.getPreference("selected_incidents");
  if (incidents) {
    // close the incidents
    var glideAjax = new GlideAjax("IncidentClosure");
    glideAjax.addParam("sysparm_name", "closeIncidents");
    glideAjax.addParam("sysparm_incidents", incidents);
  }
}
```
5. Save the record.
6. Complete the following steps to create the UI action for closing multiple incidents.
   a) Navigate to **System Definition > UI Actions** and click **New**.
   b) Create the UI actions with the following information:
      - **Name**: Close incidents
      - **Table**: Incident [incident]
      - **Show update**: Select the check box
      - **List choice**: Select the check box
      - **List v2 Compatible**: Select the check box
      - **Client**: Select the check box
      - **Onclick**: closeIncidents()
      - **Condition**: `current.getValue('state') !== '7'`
      - **Script**: paste the following information

```
function closeIncidents() {
    var list = GlideList2.get('incident');
    var title = list.getTitle();
    var incidents = list.getChecked();
    if (incidents) {
        var o = new GlideModal('mandatory_fields_to_close_incident_ui');

```
getMessage("Close Incidents", function(msg) {
    o.setTitle(msg);
    o.setPreference('selected_incidents', incidents);
    o.render();
});

7. Save the record.

Service desk agents can close multiple incidents using Close incidents in the Actions list below the Incident list.

**Reopening an incident**

Reopen an incident from the resolution notification email or from the incident to get answer for your query.

If you are not satisfied with the resolution of your incident, request to reopen the incident from the resolution notification email. You can also reopen the incident itself. The state of the incident is then changed from Resolved to In Progress.

If the incident is already closed and you request to reopen the incident by replying to the resolution notification email, a new incident is opened with selected field values from the closed incident. The values of the fields that you mention in the List of fields (comma-separated) to copy from the original incident when an incident is reopened by email property (com.snc.incident.clone_fields_on_reopen) are copied from the closed incident to the new incident. Add the text Please reopen to the subject line of the email.

- If an incident is reopened by a user after it was resolved, the Last reopened by and the Last reopened at fields are automatically populated with the name of the person who reopened it and the date and time when the incident is reopened. During audit, this information helps you to generate various reports for reopened incidents.
- On the Incident form, there is an existing field named Reopen count. Incidents that were reopened prior to the Kingston release, may already have some non-zero values in the Reopen count field while the values in the new fields, Last reopened by and the Last reopened at are null. For incidents that are reopened after the Kingston release, the Last reopened by and the Last reopened at fields are populated.
- If you do not have any roles in the system (ESS) and you change the incident state to Resolved, you receive a notification with a Reopen incident link.
- If you do not have any roles in the system (ESS) and you are the caller, you can click Reopen incident on the incident form to reopen the incident. Add the text Please reopen to the subject line of the email.

**Note:** An ESS user is not able to resolve, reopen, or close a major incident even if the user is the caller.

**Incident standard ticket page**

The Incident standard ticket page is where you and your employees can view the details of an incident and can be used with service portal.

You can access the Incident ticket page in Service Portal using the Requests option from the main menu header of Service Portal. The Incident ticket page is available by default for new as well
as upgrade users. The Incident standard ticket page shows the details of an incident, such as the short description, caller, and urgency. It also shows the **Actions** list from where you can resolve, close, or reopen incident.

<table>
<thead>
<tr>
<th>Number</th>
<th>Created</th>
<th>Updated</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN0017801</td>
<td>2y ago</td>
<td>11h ago</td>
<td>New</td>
</tr>
</tbody>
</table>

**Employee payroll application server is down.**

**Caller:** David Miller  
**Urgency:** 1 - High

**Activity**

- **System Administrator**  
  Updated the priority of the Incident based on the criticality of the Incident.

- **System Administrator**  
  IN0017801 Created

---

**Incident standard ticket page**
Incident standard ticket page configuration

You can configure the appearance of the Incident standard ticket page header and tabs from Standard Ticket > Standard Ticket Configuration > Incident. For more information, refer Configure incident ticket page.

Configure incident ticket page

Configure the Incident ticket page from where users can view the details of an Incident in Service Portal.

Role required: admin

2. Click the Incident record.
3. On the form, configure the fields.

**Ticket Configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Task-extended table for which you want to configure the standard ticket page.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to specify if the ticket configuration is active.</td>
</tr>
<tr>
<td>Application</td>
<td>Application associated with the ticket configuration.</td>
</tr>
<tr>
<td>State field</td>
<td>Any field of the task-extended table. By default, this field is mapped to the State field of the task-extended table. You have to configure the form to add this field.</td>
</tr>
</tbody>
</table>

**Note:** You cannot add fields for any of the following information:
- Number
- Short description
- Created date
- Updated date
- Watch list
- Any user input such as comments and work notes

Info Region
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Show 'Description'     | Scenario where the request description should be displayed. Possible options are:  
  - None  
  - Always  
  - When no variables

  **Note:** When displayed, you can expand and collapse the description.

<table>
<thead>
<tr>
<th>Advanced</th>
<th>Option to specify that a widget should be displayed in the info region.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info widget</td>
<td>Widget that should be displayed in the info region. This field appears only when the <strong>Advanced</strong> check box is selected.</td>
</tr>
<tr>
<td>Info widget parameters</td>
<td>Comma-separated list of info widget parameters. This field appears only when the <strong>Advanced</strong> check box is selected.</td>
</tr>
<tr>
<td>Info fields</td>
<td>Fields that should be displayed in the info region. This field disappears when you select the <strong>Advanced</strong> check box.</td>
</tr>
</tbody>
</table>

  **Note:** You cannot add fields for any of the following information:  
  - Number  
  - Short description  
  - Created date  
  - Updated date  
  - Watch list  
  - State  
  - Any user input such as comments and work notes

<table>
<thead>
<tr>
<th>Action Region</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Action widget</td>
<td>Widget to specify the actions available in the info region.</td>
</tr>
<tr>
<td>Action widget parameters</td>
<td>Comma-separated list of action widget parameters.</td>
</tr>
</tbody>
</table>

**Note:**  
- By default, the Activity and Attachments type tab configurations are available for all standard configurations.  
- You cannot duplicate any tab type other than Custom.  
- You can configure a maximum of five tabs.  
- You can add only one of these tab types:  
  - Variable Editor (Read-Only)
4. Right-click the header menu and click **Save**.
5. On the Tab Configurations related list, configure the fields.

### Tab Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Tab type based on which a widget is displayed. Possible options are:</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- Activity</td>
</tr>
<tr>
<td></td>
<td>- Attachments</td>
</tr>
<tr>
<td></td>
<td>- Custom</td>
</tr>
<tr>
<td></td>
<td>- Variable Editor (Read-Only)</td>
</tr>
<tr>
<td></td>
<td>- Variable Summarizer</td>
</tr>
<tr>
<td><strong>Tab name</strong></td>
<td>Name of the tab.</td>
</tr>
<tr>
<td><strong>Application</strong></td>
<td>Application associated with the ticket configuration.</td>
</tr>
<tr>
<td><strong>Order</strong></td>
<td>Order in which the tab should be displayed in the tabs section.</td>
</tr>
<tr>
<td><strong>Visible</strong></td>
<td>Conditions for the tab visibility.</td>
</tr>
<tr>
<td><strong>Widget</strong></td>
<td>Widget that should be displayed in the tabs section. This field appears only when <strong>Custom</strong> is selected from <strong>Type</strong>.</td>
</tr>
<tr>
<td><strong>Widget parameters</strong></td>
<td>Comma-separated list of tab widget parameters. This field appears only when <strong>Custom</strong> is selected from <strong>Type</strong>.</td>
</tr>
</tbody>
</table>

6. On the Ticket Configuration form, click **Update**.

---

**Incident reporting**

Service desk and other IT managers can use dashboards and reports to monitor and track incident status and service levels.

**Incident Overview**

The [Incident > Overview](#) dashboard provides a quick glance at the current state of open incidents. At the top, single score widgets enumerate the open incident statuses, such as critical incidents, unassigned incidents, and overdue incidents. Charts in the dashboard group incidents by factors such as priority and state. The incident overview is fully interactive and configurable.
Incident reports

Various incident reports are available in the base system, and you can modify the existing reports or create new ones. Navigate to Reports > View / Run and enter incident in the search box to view all incident reports. Base system reports include the following:

- Basic bar or pie chart reports, such as incidents by assignment group, location, priority, or state. These reports help you analyze a specific data point, for example, whether enough staff is allocated to an assignment group.
- Time series reports, such as Incident Trend by Configuration Item. This report lets you analyze closed incidents by configuration item (CI) to identify potential problems.
- Multidimensional reports, such as Incidents by Priority and State older than 30 Days. This report can help you identify gaps in service levels. For example, if a high number of low-priority incidents are still in New state after being open more than 30 days.

Incident metric definition

A metric measures and evaluates the effectiveness of IT service management processes. The service desk can improve the incident management process using information gathered within the platform. You can activate the Metric Definition plugin (com.glide.metrics) and define the metrics to monitor within the system. With these metrics, and the information within the database, it is possible to generate reports that can be added to homepages or automatically generated and distributed.

Using this information, it is possible to refine automatic rules such as the assignment rules, service level agreements, or inactivity monitors to better suit the unique environment of the service desk. Unnecessary incidents can be avoided by encouraging users to consult the knowledge base before creating an incident. The related search results function in the Incident form assists with this strategy.

Complimentary Performance Analytics for Incident Management

Complimentary Performance Analytics for Incident Management and aggregates data over time, and is enabled by default for Incident Management. Complimentary Performance Analytics for Incident Management provides an Incident Management dashboard with 15 indicators to help you assess organizational performance. For more information, see .

If you subscribe to Performance Analytics, additional Analytics and Reporting Solutions are available for Incident Management. The Analytics and Reporting Solution for Incident Management contains preconfigured dashboards.

A subscription to Performance Analytics also gives you access to In-form analytics. In-form analytics integrate performance insights into Incident records so that users can access important metrics in context and make better decisions. For more information, see In-form analytics.

Incident Management Analytics and Reporting Solutions

Analytics and Reporting Solutions and in-form analytics contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting...
Solutions, you can get value from Performance Analytics for your application with minimal setup. You can always create your own objects as well.

**Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

**Note:** Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see *Configure Analytics and Reporting Solutions*.

The Analytics and Reporting Solution for Incident Management is available by default as part of Complimentary Performance Analytics for Incident Management.

**Incident Management Dashboard**

The Incident Management dashboard lets you see recent trends in incident creation, duration, and resolution. Use the information on this dashboard to spot problem areas and plan your incident management strategy going forward.
### Incident Management

<table>
<thead>
<tr>
<th>Incident Overview</th>
<th>Incident Open</th>
<th>Incident New</th>
<th>Incident Resolved</th>
</tr>
</thead>
</table>

---
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Manager: Needs to know how the incident management process is doing so they can plan for the future.</td>
<td>itil</td>
</tr>
</tbody>
</table>

Indicators

**Number of open incidents**
Daily count of the number of incidents that do not have a resolution date. This indicator is used as the basis of several other indicators on this dashboard.

**Number of open incidents not updated in last 5 days**
Daily count of the number of incidents last updated more than five days ago.

**Number of open incidents not updated in last 30 days**
Daily count of the number of incidents last updated more than 30 days ago.

**Number of new incidents**
Daily count of the number of incidents opened ‘today.’

**Number of resolved incidents**
Daily count of indicators with State = Resolved.

**Incident Backlog Growth**
Tracks the increase or decrease in open incidents. The score is calculated according to the formula \((\text{Number of new incidents}) - (\text{Number of resolved incidents})\).

**Average age of open incidents**
The average age in days in which an incident has been open. The score is calculated according to the formula \((\text{Summed age of open incidents}) / (\text{Number of open incidents})\) * 24).

**% of new critical incidents**
The percentage of new incidents filtered on the Priority breakdown with the breakdown element 1 - Critical. The score is calculated according to the formula \((\text{Number of new incidents} > \text{Priority} = 1 - \text{Critical}) / (\text{Number of new incidents})\) * 100.

**Average resolution time of resolved incidents**
The average number of days it takes to resolve an incident, provided it is resolved. The score is calculated according to the formula \((\text{Summed duration of resolved incidents}) / (\text{Number of resolved incidents})\) * 24).

The following indicators are not shown directly on the dashboard but are used in calculating formulas:

- Summed age of open incidents
- Summed duration of resolved incidents
Breakdowns

- Category
- Priority
- Age

Incident Daily 7d - 28d dashboard

View the last 28 days of incidents as raw trends, as a 7-day running average, or as a 28-day running average. Filter the scores by assignment groups or by the category of incident.
Incident daily - 7d - 28d

Open incidents - 7d running average

Resolved incidents - 7d running sum

Average resolution time - 7d running average

Open incidents not updated last 5d - 7d running average

Open incidents not updated last 30d - 7d running average
## Indicators

### Number of open incidents
Daily count of the number of incidents that do not have a resolution date. This indicator is used as the basis of several other indicators on this dashboard.

### Number of resolved incidents
Daily count of indicators with State = Resolved.

### Average resolution time of resolved incidents
The average number of days it takes to resolve an incident, provided it is resolved. The score is calculated according to the formula \( \frac{\text{Summed duration of resolved incidents}}{\text{Number of resolved incidents} \times 24} \).

### Number of open incidents not updated in last 5 days
Daily count of the number of incidents last updated more than five days ago.

### Number of open incidents not updated in last 30 days
Daily count of the number of incidents last updated more than 30 days ago.

## Breakdowns
You can apply breakdown elements on this dashboard to all widgets simultaneously. Above the chart in the upper left, select either Groups or...
Incident.Category. You can then select one or more elements and they will apply to all widgets.

**Incident Premium dashboard**

This dashboard uses Workbench widgets and other advanced Performance Analytics features to give you all the information about the Incident process in one place.

**Tabs of the Incident Premium dashboard**
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Manager: Needs to know how the incident management process is doing so they can plan for the future.</td>
<td>ITIL</td>
</tr>
</tbody>
</table>

Indicators

**Number of open incidents**
Daily count of the number of incidents that do not have a resolution date. This indicator is used as the basis of several other indicators on this dashboard.

**Number of new incidents**
Daily count of the number of incidents opened ‘today.’

**Number of closed incidents**
Daily count of indicators with State = Closed.

**Number of resolved incidents**
Daily count of indicators with State = Resolved.

**Average age of open incidents**
The average age in days in which an incident has been open. The score is calculated according to the formula \((\text{Summed age of open incidents})/((\text{Number of open incidents}))\times24\).

**Average reassignment of open incidents**
The average number of times currently open incidents have been reassigned. This indicator is shown as ‘Average re-assignment times’ in the Process by State tab. The score is calculated according to the formula \((\text{Summed re-assignment of open incidents})/((\text{Number of open incidents}))\).

**Average age of last update of open incidents**
How long on average it has been since the last update to one of the currently open incidents, in days. The score is calculated according to the formula \((\text{Summed age of last update of open incidents})/((\text{Number of open incidents}))\times24\).

**% of incidents not updated in last 5 days**
The percentage of currently open incidents that have not been updated for the last five days. The score is calculated according to the formula \( ((\text{Number of open incidents not updated in last 5 days})/((\text{Number of open incidents}))) \times 100\).

**% of incidents not updated in last 30 days**
The percentage of currently open incidents that have not been updated for the last 30 days. The score is calculated according to the formula \( ((\text{Number of open incidents not updated in last 30 days})/((\text{Number of open incidents}))) \times 100\).

**% of new critical incidents**
The percentage of new incidents filtered on the Priority breakdown with the breakdown element 1 - Critical. The score is calculated according to the formula \( \left( \frac{\text{Number of new incidents} > \text{Priority = 1 - Critical}}{\text{Number of new incidents}} \right) \times 100. \)

**Average close time of incidents**

The average amount of time in days it takes to close an incident. The score is calculated according to the formula \( \left( \frac{\text{Summed duration of closed incidents}}{(\text{Number of closed incidents}) \times 24} \right) \)

**% of incidents resolved without reassigning**

The percentage of incidents with a State of Resolved that were never reassigned from the first assignment group. The score is calculated according to the formula \( \left( \frac{\text{Number of resolved incidents by first assigned group}}{\text{Number of resolved incidents}} \right) \times 100. \)

**% of incidents closed by self-service**

The percentage of incidents with State = Closed and Close code = Closed/Resolved by Caller. The score is calculated according to the formula \( \left( \frac{\text{Number of incidents closed by self-service}}{\text{Number of closed incidents}} \right) \times 100. \)

**% of open incidents reassigned at least once**

The percentage of incidents that are open and that have been transferred at least once. The score is calculated according to the formula \( \left( \frac{\text{Number of reassigned open incidents}}{\text{Number of open incidents}} \right) \times 100. \)

**% of incidents resolved same day opened**

The percentage of incidents with State = Resolved where the day in the Resolved field is the same as the day in the Opened field. The score is calculated according to the formula \( \left( \frac{\text{Number of resolved incidents resolved on the same day opened}}{\text{Number of resolved incidents}} \right) \times 100. \)

**% of incidents not solved**

The percentage of closed incidents where Close code = Not Solved (Not Reproducible) or Not Solved (Too Costly). The score is calculated according to the formula \( \left( \frac{\text{Number of incidents not solved}}{\text{Number of closed incidents}} \right) \times 100. \)

The following indicators are not shown directly on the dashboard but are used in calculating formulas:

- Summed age of open incidents
- Summed re-assignment of open incidents
- Summed age of last update of open incidents
- Number of open incidents not updated in last 5 days
- Number of open incidents not updated in last 30 days
- Summed duration of closed incidents
- Number of resolved incidents by first assigned group
- Number of incidents closed by self-service
- Number of reassigned open incidents
- Number of incidents resolved on the same day opened
- Number of incidents not solved

**Breakdowns**

- Priority
### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incidents Opened Today</td>
<td>Single Score</td>
<td><img src="42" alt="42" /></td>
</tr>
<tr>
<td>Unassigned Incidents</td>
<td>Single Score</td>
<td><img src="42" alt="42" /></td>
</tr>
<tr>
<td>Overdue Incidents</td>
<td>Single Score</td>
<td><img src="42" alt="42" /></td>
</tr>
<tr>
<td>Open Incidents</td>
<td>Single Score</td>
<td><img src="42" alt="42" /></td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Incidents not updated for 7 days</td>
<td>Single Score</td>
<td><img src="image" alt="42" /></td>
</tr>
<tr>
<td>Open incidents older than 30 days</td>
<td>Single Score</td>
<td><img src="image" alt="42" /></td>
</tr>
<tr>
<td>Open Incidents - Grouped</td>
<td>Horizontal Bar</td>
<td><img src="image" alt="Bar Chart" /></td>
</tr>
<tr>
<td>Open incidents older than 30 days - Grouped</td>
<td>Horizontal Bar</td>
<td><img src="image" alt="Bar Chart" /></td>
</tr>
<tr>
<td>Incidents by Priority and State</td>
<td>Heatmap</td>
<td><img src="image" alt="Heatmap" /></td>
</tr>
<tr>
<td>Incidents by Priority and State older than 30 days</td>
<td>Heatmap</td>
<td><img src="image" alt="Heatmap" /></td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Incidents opened per week</td>
<td>Line</td>
<td></td>
</tr>
<tr>
<td>Incidents closed per week</td>
<td>Line</td>
<td></td>
</tr>
<tr>
<td>Open Incidents older than 30 days by Assignment Group and State</td>
<td>Heatmap</td>
<td></td>
</tr>
<tr>
<td>Open Incidents Not Updated In Last 30 Days by Assignment Group and State</td>
<td>Heatmap</td>
<td></td>
</tr>
<tr>
<td>Open Incidents where assignee is not active</td>
<td>Heatmap</td>
<td></td>
</tr>
<tr>
<td>Open Incidents with closed Problem</td>
<td>Heatmap</td>
<td></td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Open Incidents Age Monitor dashboard

View average age and assignment times and breakdown incidents in different age buckets.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Manager: Needs to know how the incident management process is doing so they can plan for the future.</td>
<td>itil</td>
</tr>
</tbody>
</table>

Indicators

**Number of open incidents**
Daily count of the number of incidents that do not have a resolution date. This indicator is used as the basis of several other indicators on this dashboard.

**Average age of open incidents**
The average age in days in which an incident has been open. The score is calculated according to the formula \( \frac{\text{Summed age of open incidents}}{\text{Number of open incidents} \times 24} \). 

**Average reassignment of open incidents**
The average number of times currently open incidents have been reassigned. This indicator is shown as 'Average re-assignment times' in the Process by State tab. The score is calculated according to the formula \( \frac{\text{Summed re-assignment of open incidents}}{\text{Number of open incidents}} \).

**Average age of last update of open incidents**
How long on average it has been since the last update to one of the currently open incidents, in days. The score is calculated according to the formula \( \frac{\text{Summed age of last update of open incidents}}{\text{Number of open incidents} \times 24} \).

The following indicators are not shown directly on the dashboard but are used in calculating formulas:
- Summed age of open incidents
- Summed re-assignment of open incidents
- Summed age of last update of open incidents

Breakdowns

- Priority
- Category
- Assignment Group
- State

Open Incident State Monitor dashboard

View average age and number of reassignments and breakdown incidents in the New, In Progress, and On Hold states.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Manager: Needs to know how the incident management process is doing so they can plan for the future.</td>
<td>ITIL</td>
</tr>
</tbody>
</table>

Indicators

**Number of open incidents**

Daily count of the number of incidents that do not have a resolution date. This indicator is used as the basis of several other indicators on this dashboard.

**Average age of open incidents**

The average age in days in which an incident has been open. The score is calculated according to the formula \( \frac{\text{Summed age of open incidents}}{\text{Number of open incidents}} \times 24 \).

**Average reassignment of open incidents**

The average number of times currently open incidents have been reassigned. This indicator is shown as 'Average re-assignment times' in the Process by State tab. The score is calculated according to the formula \( \frac{\text{Summed re-assignment of open incidents}}{\text{Number of open incidents}} \).

**Average age of last update of open incidents**

How long on average it has been since the last update to one of the currently open incidents, in days. The score is calculated according to the formula \( \frac{\text{Summed age of last update of open incidents}}{\text{Number of open incidents}} \times 24 \).

**% of incidents not updated in last 5 days**

The percentage of currently open incidents that have not been updated for the last five days. The score is calculated according to the formula \( \frac{(\text{Number of open incidents not updated in last 5 days})}{\text{Number of open incidents}} \times 100 \).

The following indicators are not shown directly on the dashboard but are used in calculating formulas:

- Summed age of open incidents
- Summed re-assignment of open incidents
- Summed age of last update of open incidents
- Number of open incidents not updated in last 5 days

Breakdowns

- Priority
- Category
- Assignment Group
- State
Open Incidents Reports dashboard

View the current information about open incidents as a list, or as a heatmap or pivot table organized by breakdown.
<table>
<thead>
<tr>
<th>Number</th>
<th>Short description</th>
<th>Priority</th>
<th>State</th>
<th>Assignment group</th>
<th>Assigned to</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC0010112</td>
<td>Assessment : ATF Assessor</td>
<td>5 - Planning</td>
<td>New</td>
<td>(empty)</td>
<td>(empty)</td>
<td>Inquiry / Help</td>
</tr>
<tr>
<td>INC0010111</td>
<td>ATF : Test1</td>
<td>5 - Planning</td>
<td>New</td>
<td>(empty)</td>
<td>(empty)</td>
<td>Inquiry / Help</td>
</tr>
<tr>
<td>INC0009009</td>
<td>Unable to access the shared folder.</td>
<td>4 - Low</td>
<td>New</td>
<td>(empty)</td>
<td>(empty)</td>
<td>Inquiry / Help</td>
</tr>
<tr>
<td>INC0009005</td>
<td>Email server is down.</td>
<td>1 - Critical</td>
<td>New</td>
<td>(empty)</td>
<td>(empty)</td>
<td>Software</td>
</tr>
<tr>
<td>INC0009001</td>
<td>Unable to post content on a Wiki page</td>
<td>3 - Moderate</td>
<td>New</td>
<td>(empty)</td>
<td>(empty)</td>
<td>Inquiry / Help</td>
</tr>
<tr>
<td>INC0007002</td>
<td>Need access to the common drive.</td>
<td>4 - Low</td>
<td>New</td>
<td>(empty)</td>
<td>(empty)</td>
<td>Inquiry / Help</td>
</tr>
<tr>
<td>INC0007001</td>
<td>Employee payroll application server is down.</td>
<td>1 - Critical</td>
<td>New</td>
<td>OpenSpace</td>
<td>(empty)</td>
<td>Hardware</td>
</tr>
<tr>
<td>INC0006920</td>
<td>Unable to Access Salesforce Community Connect</td>
<td>5 - Planning</td>
<td>In Progress</td>
<td>Technical Services Support</td>
<td>Bess Marso</td>
<td>Software</td>
</tr>
<tr>
<td>INC0006919</td>
<td>Unable to Access SuccessFactors Learning</td>
<td>4 - Low</td>
<td>In Progress</td>
<td>SAP Support</td>
<td>Amelia Caputo</td>
<td>Software</td>
</tr>
</tbody>
</table>

Please grant me
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Use case

Interactive filters

- Priority
- Category
- Assignment Group
- State
- Age

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Incidents List</td>
<td>List</td>
<td>List of all incident records for open incidents</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="List icon" /></td>
</tr>
<tr>
<td>Open Incidents Pivot</td>
<td>Pivot</td>
<td>Table that lets you explore open incidents by combinations of state, assignment group, category, priority, and age.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="Pivot icon" /></td>
</tr>
</tbody>
</table>
### Incident SLA Management Analytics and Reporting Solutions

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can get value from Performance Analytics for your application with minimal setup. You can always create your own objects as well.

**Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

**Note:** Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see [Configure Analytics and Reporting Solutions](#).

To enable the solution for Incident SLA Management, an admin can navigate to **Performance Analytics > Guided Setup**. Click **Get Started** then scroll to the section for Incident SLA Management. The guided setup takes you through the entire setup and configuration process.

The dashboards in this content pack are inactive when installed. Complete configuration and run data collection jobs before you activate these dashboards. You can activate dashboards in Dashboard Properties, accessible from the context menu. You have to assign an owner to the dashboard to activate it. For more information about configuring Analytics and Reporting Solutions, see [Configure Analytics and Reporting Solutions](#).

#### Inactive dashboards

Some dashboards in this content pack are inactive when installed. Complete configuration and run data collection jobs before you activate these dashboards. You can activate dashboards in Dashboard Properties, accessible from the context menu. You have to assign an owner to the dashboard to activate it. For more information about configuring Analytics and Reporting Solutions, see [Configure Analytics and Reporting Solutions](#).

#### Incident SLA Management dashboard

See how well the incidents that are subject to a Service Level Agreement meet the deadlines of those SLAs.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level Manager who is responsible for seeing that incident resolution meets the service level agreements.</td>
<td>sla_manager, and pa_viewer for the Incident SLA Assignment tab</td>
</tr>
</tbody>
</table>

Use case

Indicators

**Number of open and overdue incidents**
The number of open incidents with the following characteristics:
- Related to an SLA task of type 'SLA' (contract_sla.type)
- Not in stage 'Cancelled' (task_sla.stage)
- The amount of time taken to work on the task is over the SLA limit, determined by having an elapsed percentage (task_sla.percentage) value more than 100%.

**Number of open incidents that should be resolved in time**
The number of open incidents with the following characteristics:
- Related to an SLA task of type 'SLA' (contract_sla.type)
- Not in stage 'Cancelled' (task_sla.stage)

**% open and overdue incidents**
The percentage of open incidents that are overdue. The score is calculated according to the formula: 
\[(\text{Number of open and overdue incidents}) \div (\text{Number of open incidents that should be resolved in time}) \] * 100.

**Number of incidents resolved in time**
The number of SLA tasks related to an incident with the following characteristics:
- The resolution date (incident.resolved_at) is the date that the score is collected.
- The type is 'SLA' (contract_sla.type).
- The stage is not 'cancelled' (task_sla.stage).
- The amount of time taken to close the task is under the SLA limit, determined by having an elapsed percentage (task_sla.percentage) value less than or equal to 100%.

**Number of incidents resolved that should have been resolved in time**
Number of incidents resolved that should have been resolved in time is measured daily as unit #. The goal for this indicator is to maximize.

The score is the COUNT DISTINCT on the data source Incidents.SLA.Resolved, which is using the table Incident SLA (incident_sla) with the following conditions:
- The resolution date (incident.resolved_at) is the date that the score is collected.
• The type is 'SLA' (contract_sla.type).
• The stage is not 'cancelled' (task_sla.stage).

% incidents resolved in time
The percentage of resolved incidents that were resolved in time. The score is calculated according to the formula: \( \frac{(\text{Number of incidents resolved in time})}{(\text{Number of resolved incidents that should be resolved in time})} \times 100. \)

Average Resolution Time In Hours For Resolved Incident SLA Tasks
The score is calculated according to the following formula: \( \frac{(\text{Summed duration time of resolved incident SLA tasks in hours})}{(\text{Total resolved Incident SLA tasks})} \).

Total resolved Incident SLA tasks
The score is the COUNT on the data source Incidents.SLA.Resolved, which is using the table Incident SLA (incident_sla) with the following conditions:
• The resolution date (incident.resolved_at) is the date that the score is collected.
• The type is 'SLA' (contract_sla.type).
• The stage is not 'cancelled' (task_sla.stage).

Number of incident assignments responded to in time
The number of SLA tasks related to an incident with the following characteristics:
• The close date (task_sla.end_time) is the date that the score is collected.
• The type is 'OLA' (contract_sla.type), meaning that it is a response task.
• The stage is not 'cancelled' (task_sla.stage).
• The amount of time taken to close the task is under the SLA limit, determined by having an elapsed percentage (task_sla.percentage) value less than or equal to 100%.

Number of incident assignments that should have been responded to in time
The number of SLA tasks related to an incident with the following characteristics:
• The close date (task_sla.end_time) is the date that the score is collected.
• The type is 'OLA' (contract_sla.type), meaning that it is a response task.
• The stage is not 'cancelled' (task_sla.stage).

Number of open and overdue incident assignments
The number of SLA tasks related to an incident with the following characteristics:
• The type is 'OLA' (contract_sla.type), meaning that it is a response task.
• The stage is not 'cancelled' (task_sla.stage).
• The amount of time taken to work on the task is over the SLA limit, determined by having an elapsed percentage (task_sla.percentage) value more than 100%.

Number of open incident assignments that should be responded to in time
The number of open incidents related to an SLA task with the following characteristics:
• The type is 'OLA' (contract_sla.type), meaning that it is a response task.
• The stage is not 'cancelled' (task_sla.stage).
• The response task is still open.
% incident assignments responded to in time
The percentage of response tasks that were responded to within the SLA limit. The score is calculated according to the following formula: 

\[
\left( \frac{\text{Number of incident assignments responded to in time}}{\text{Number of incident assignments that should have been responded to in time}} \right) \times 100.
\]

% open and overdue incident assignments
The percentage of open incident assignments that are overdue according to the SLA limit. The score is calculated according to the following formula:

\[
\left( \frac{\text{Number of open and overdue incident assignments}}{\text{Number of open incident assignments that should be responded to in time}} \right) \times 100.
\]

The following indicator is used to calculate formulas but is not displayed directly on the dashboard:

Summed duration time of resolved incident SLA tasks in hours
This indicator sums the results of a script run on the Incident SLA (incident_sla) table that calculates the time it took for an incident SLA task to be resolved.

Breakdowns

- State
- Priority
- Category
- Assignment Group
- Task SLA Breached Status

Overdue by State dashboard
This dashboard lets you see incidents that are overdue according to an SLA, divided by the New, In Progress, and On Hold states. You can see the average age of the incidents, the average number of times they have been reassigned, and how long on average since the last update. You can also group them by standard breakdowns like Priority and Assignment Group.

This dashboard is inactive by default. Before using this dashboard, a Performance Analytics administrator or power user must open the Dashboard Properties, assign an owner, and select Active.
Overdue Incident State Monitor (inactive)

New: 2
In Progress: 3
On Hold: 0

Mar 19
In Progress

3

Average age: 74.03 days
Average reassignment times: 2.33 times
Average age of last update: 2.90 days

Breakdowns

Records

In Progress, Mar 19:3

<table>
<thead>
<tr>
<th>Priority</th>
<th>Name</th>
<th>Mar 19</th>
<th>Change</th>
<th>Trend</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>!important</td>
<td>Critical</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>!important</td>
<td>High</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>!important</td>
<td>Moderate</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level Manager who is responsible for seeing that incident resolution meets the service level agreements.</td>
<td>sla_manager</td>
</tr>
</tbody>
</table>

Indicators

**Number of open and overdue incidents**
The number of incidents on the Incident.SLA.Open indicator source with the following characteristics:

- Related to an SLA task of type 'SLA' (contract_sla.type)
- Not in stage 'Cancelled' (task_sla.stage)
- The amount of time taken to work on the task is over the SLA limit, determined by having an elapsed percentage (task_sla.percentage) value more than 100%.

**Average age open and overdue incidents**
The score is calculated according to the following formula: 
\[
\frac{\text{Summed age of open and overdue incidents}}{\text{(Number of open incidents that should be resolved in time)}}
\]

**Average reassignments of open and overdue incidents**
The score is calculated according to the following formula: 
\[
\frac{\text{Summed reassignments of open and overdue incidents}}{\text{(Number of open and overdue incidents)}}
\]

**Average age of updated since of open and overdue incidents**
The average length of time in days since the last update of open, overdue incidents. The score is calculated according to the following formula: 
\[
\frac{\text{Summed age of updated since of open and overdue incidents}}{\text{(Number of open and overdue incidents)}} / 24
\]

The following indicators are used to calculate formulas but are not displayed directly on the dashboard:

**Number of open incidents that should be resolved in time**
The number of open incidents with the following characteristics:

- Related to an SLA task of type 'SLA' (contract_sla.type)
- Not in stage 'Cancelled' (task_sla.stage)

**Summed age of open and overdue incidents**
Summed age of open incidents related to an SLA task with the following characteristics:

- Related to an SLA task of type 'SLA' (contract_sla.type)
- Not in stage 'Cancelled' (task_sla.stage)
- The amount of time taken to work on the task is over the SLA limit, determined by having an elapsed percentage (task_sla.percentage) value more than 100%.

**Summed age of updated since of open and overdue incidents**
Sum of hours since the last update of all open and overdue incidents.

**Summed reassignments of open and overdue incidents**

The sum of the Reassignment Count field of all open and overdue incidents.

**Breakdowns**

- State
- Priority
- Age
- Assignment Group
- SLA

**Overdue by Age dashboard**

This dashboard lets you see incidents that are overdue according to an SLA, divided by age buckets. You can see the average age of the incidents, the average number of times they have been reassigned, and how long on average since the last update. You can also group them by standard breakdowns like Priority and Assignment Group.

This dashboard is inactive by default. Before using this dashboard, a Performance Analytics administrator or power user must open the Dashboard Properties, assign an owner, and select Active.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level Manager who is responsible for seeing that incident resolution meets the service level agreements.</td>
<td>sla_manager</td>
</tr>
</tbody>
</table>

Indicators

**Number of open and overdue incidents**
The number of incidents on the Incident.SLA.Open indicator source with the following characteristics:

- Related to an SLA task of type 'SLA' (contract_sla.type)
- Not in stage 'Cancelled' (task_sla.stage)
- The amount of time taken to work on the task is over the SLA limit, determined by having an elapsed percentage (task_sla.percentage) value more than 100%.

**Average age open and overdue incidents**
The score is calculated according to the following formula: 
\[
\frac{\text{Summed age of open and overdue incidents}}{\text{Number of open incidents that should be resolved in time}}
\]

**Average reassignments of open and overdue incidents**
The score is calculated according to the following formula: 
\[
\frac{\text{Summed reassignments of open and overdue incidents}}{\text{Number of open and overdue incidents}}
\]

**Average age of updated since of open and overdue incidents**
The average length of time in days since the last update of open, overdue incidents. The score is calculated according to the following formula: 
\[
\frac{\text{Summed age of updated since of open and overdue incidents}}{\text{Number of open and overdue incidents}} / 24
\]

**Breakdowns**

- State
- Priority
- Age
- Assignment Group
- SLA

**Overdue Reports dashboard**
See the currently open incidents that are subject to an SLA. You can view a list of the incidents or see how they break down in a heatmap or a pivot table.

This dashboard is inactive by default. Before using this dashboard, a Performance Analytics administrator or power user must open the Dashboard Properties, assign an owner, and select **Active**.
<table>
<thead>
<tr>
<th>Number</th>
<th>Short description</th>
<th>Priority</th>
<th>State</th>
<th>Assignment group</th>
<th>Assigned to</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC00000031</td>
<td>Need help with Remedy. Can we configure UI?</td>
<td>1 - Critical</td>
<td>In Progress</td>
<td>(empty)</td>
<td>David Lee</td>
<td>Inquiry / Help</td>
</tr>
<tr>
<td>INC00008893</td>
<td>Page hangs while trying to query a record in Workday Payroll</td>
<td>3 - Moderate</td>
<td>New</td>
<td>HR Systems Support</td>
<td>Randall Gansen</td>
<td>Software</td>
</tr>
<tr>
<td>INC0000840</td>
<td>Application response time is poor when performing any action in Workday Work!...</td>
<td>2 - High</td>
<td>New</td>
<td>HR Systems Support</td>
<td>Chad Araiza</td>
<td>Software</td>
</tr>
<tr>
<td>INC0000674</td>
<td>Getting automatically logged out from Workday Human Capital Management</td>
<td>2 - High</td>
<td>In Progress</td>
<td>HR Systems Support</td>
<td>Charity Dyckman</td>
<td>Software</td>
</tr>
<tr>
<td>INC0000674</td>
<td>Getting automatically logged out from Workday Human Capital Management</td>
<td>2 - High</td>
<td>In Progress</td>
<td>HR Systems Support</td>
<td>Charity Dyckman</td>
<td>Software</td>
</tr>
<tr>
<td>INC0000680</td>
<td>Application response time is poor when performing any action in Workday Work!...</td>
<td>2 - High</td>
<td>New</td>
<td>HR Systems Support</td>
<td>Chad Araiza</td>
<td>Software</td>
</tr>
<tr>
<td>INC0000609</td>
<td>Please grant me additional roles in Sales Force Automation</td>
<td>4 - Low</td>
<td>Closed</td>
<td>Technical Services Support</td>
<td>Apogelaie Schmerthenhorn</td>
<td>Software</td>
</tr>
<tr>
<td>INC000037</td>
<td>Request for a new service</td>
<td>3 - Moderate</td>
<td>In Progress</td>
<td>Service Desk</td>
<td>Howard Johnson</td>
<td>Inquiry / Help</td>
</tr>
</tbody>
</table>
## Overdue Incidents Pivot

<table>
<thead>
<tr>
<th>State</th>
<th>Category</th>
<th>1 - Critical</th>
<th>2 - High</th>
<th>3 - Moderate</th>
<th>4 - Low</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>▼ New</td>
<td>Total</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Software</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>▼ In Progress</td>
<td>Total</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Inquiry / Help</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Software</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>▼ Closed</td>
<td>Total</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Software</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

| Count    | 1            | 4            | 2          | 1            | 8       |
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level Manager who is responsible for seeing that incident resolution meets the service level agreements.</td>
<td>sla_manager</td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overdue list</td>
<td>List</td>
<td>List of all incident records for overdue open incidents</td>
</tr>
<tr>
<td>Overdue pivot</td>
<td>Pivot</td>
<td>Table letting you explore the number of open and overdue incidents by any combination of state, assignment group, category, and priority, for any age bucket or for all ages.</td>
</tr>
<tr>
<td>Overdue heatmap</td>
<td>Heatmap</td>
<td>Heatmap letting you explore the number of open and overdue incidents by any combination of state, assignment group, category, and priority, for any age bucket or for all ages.</td>
</tr>
</tbody>
</table>

Domain separation in Incident Management

Overview of domain separation and Incident Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.
Support level: Standard

- Includes Basic level support.
- Business logic: Processes can be created or modified per customer by the service provider (SP). The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The owner of the instance needs to be able to configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin needs to be able to make comments mandatory when a record closes for one tenant, but not for another.

Overview

- The goal of Incident Management is to restore normal service operation as quickly as possible, while minimizing impact to business operations and ensuring quality is maintained.
- Typically, end users log incidents when a service they are using is impacted or not available. ITIL / Fulfiller users in your organization classify these incidents, route them as appropriate and work on resolving the incident.
- The incident and incident task tables support domain separation. Therefore, a Fulfiller sees only incidents or incident tasks that have been created within the (tenant) domain that they belong to.

How domain separation works in Incident Management

Fulfillers see only incidents and incident tasks that have been created within the (tenant) domain that they belong to.

Domain separated tables

- Incident (incident)
- Incident Task (incident_task)

Use cases

- An ESS user belonging to “Initech” domain, creates an incident. Only those ITIL users belonging to “Initech” domain or global domain can see this incident.
- An ITIL user belonging to a parent domain can see incidents of all its child domains as well.
- An ITIL user belonging to a specific domain can create incidents only on behalf of the domains that they have access to.
- An ITIL user can associate child incidents only of those domains that they have access to.
- If a user has access to multiple domains, the domain specified on the current record drives the functionality of that record and reference fields.
Major incident management

A major incident (MI) is an incident that results in significant disruption to the business and demands a response beyond the routine incident management process. Major incidents have a separate procedure with shorter timescales and urgency that is required to accelerate resolution process for incidents with high business impact.

The definition of what constitutes a major incident must be determined and agreed upon. For example, a major incident can be created if a critical business service is impacted or if there is a service outage that affects a large number of users.

There are multiple ways to create a major incident candidate. You can:

- Propose an incident as a major incident candidate by clicking Propose Major Incident from the context menu of the Incident form.
- Create a new major incident candidate by clicking Create Major Incident Candidate from the left navigation pane.
- Mark an incident as a major incident candidate based on the major incident trigger rules.

As a major incident manager, you can:

- Promote a candidate to a major incident by clicking Promote to Major Incident from the context menu.
- Create a new major incident by clicking Create Major Incident from the left navigation pane.
- Promote an incident to a major incident without going through the proposal process.

Crucial things in responding to a major incident are to involve right resources, communicate updates to users and stakeholders, setup conference calls to investigate and resolve the incident, and escalate when required. Using Task Communications Management, you can define communication plans that are associated with a major incident based on pre-defined conditions. Incident communication plans and related communication tasks are created for a major incident based on the communication plan definitions. Thereafter, tasks get executed as defined in the attached incident communication.

Major Incident Management process

A major incident is a highest-impact, highest-urgency incident that affects a large number of users, depriving the business of one or more crucial services. Given the urgency of the situation, a well-coordinated response process is required to accelerate the resolution and minimize the business impact.

The goal of an organization is to have an effective and efficient system for responding to major incidents. The requirements are to:

- Minimize the impact of service interruptions.
- Ensure that an appropriate Incident Manager/Major Incident Team/Management Group are in place to manage a major incident.
- Ensure that stakeholders are well-informed of service interruptions, degradations, and resolutions.
- Conduct a review of each major incident once service is restored. Its purpose is to analyze the incident, and understand what can be done to prevent a similar incident in the future. This review also provides an opportunity to evaluate the incident response process and identify areas for improvement.
- Create a problem for root cause analysis.
Keeping the goals in mind, a major incident management process can be broadly classified into the following phases:

**Identification**

The first step in the process is to identify a potential major incident. A potential major incident can be identified automatically based on trigger rules or an existing incident can be proposed as a major incident candidate. These incidents are classified as major incident candidates and are reviewed by major incident managers who initiate the major incident response process.

**Communication and Collaboration**

Timely communication during a major incident is crucial to ensure that the IT teams, business stakeholders, end users, and customers are informed about the impact and progress of the incident. An occurrence of a major incident requires a comprehensive communication plan that includes who is contacted, the methods and frequency of communication, messaging, and so on. The communication plan enables the incident response team to focus their efforts on the resolution process and sets expectations for any future communications.

You can define one or more communication plans based on the type, priority of the incident, or the target audience. For example, communication plans for a P1 major incident could have more frequent communication than a communication plan for a P2 major incident.

Throughout the life cycle of the major incident, notifications and status updates are sent to the stakeholders to keep them informed and involved.

**Resolution**

In this phase, the agreed upon path to resolution is followed to resolve the issue. Resolving a major incident resolves all associated child incidents, and the individual callers receive a notification about incident resolution.

**Post incident review**

This is the final phase of a major incident life cycle. After the major incident is resolved, a post-incident review is conducted. Its purpose is to analyze the incident and understand what can be done to prevent a similar incident in the future. This review also provides an opportunity to evaluate the incident response process and identify areas for improvement.

To streamline the process, a post-incident report is created when an incident is resolved. The post-incident report can be reviewed and updated during the review process before it is shared with stakeholders.

A major incident progresses through different states during its life cycle. The following diagram illustrates the different states involved in a major incident management:
Major Incident Management state flow

Major Incident Management plugins

You can activate the Major Incident Management plugins if you have the admin role.
Activate Incident Management - Major Incident Management

You can activate the Incident Management - Major Incident Management plugin (com.snc.incident.mim) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

Incident Management - Major Incident Management plugin (com.snc.incident.mim) must be manually activated for new and existing customers.

Incident Management - Major Incident Management plugin activates these related plugins if they are not already active:
- Incident Communications Management (com.snc.iam)
- Incident Updates (com.snc.incident.updates)
- Task-Outage Relationship (com.snc.task_outage)

Optional plugins for Incident Management - Major Incident Management

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify (com.snc.notify)</td>
<td>Provides platform features for workflow-driven voice calls, conference calls, and SMS messages. Requires the Twilio Direct Driver and a separate contract with Twilio for SMS and Voice capabilities.</td>
</tr>
<tr>
<td></td>
<td>Note: Existing users already using Twilio Driver need to migrate to Twilio Direct Driver.</td>
</tr>
<tr>
<td>On-Call Scheduling (com.snc.on_call_rotation)</td>
<td>Provides the ability to create on-call schedules and escalation trees. When an incident is created, dynamically route the escalation to an on-call resource. On-Call Scheduling enables you to configure and build different on-call schedules per process and assignment group.</td>
</tr>
</tbody>
</table>

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Incident Management - Major Incident Management

Several types of components are installed with activation of the Incident Management - Major Incident Management plugin, including tables and user roles.
Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major incident manager</td>
<td>A major incident manager can:</td>
<td>This role inherits the ia_admin role.</td>
</tr>
<tr>
<td>(major_incident_manager)</td>
<td>• Initiate the major incident process by assessing and approving major</td>
<td></td>
</tr>
<tr>
<td></td>
<td>incident candidates or creating a major incident.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Reject a major incident candidate.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Demote a major incident after it is accepted so that the incident can be</td>
<td></td>
</tr>
<tr>
<td></td>
<td>handled as a regular incident.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Maintain the ownership and accountability for the life cycle of the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>incident.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Identifies the users and groups to be involved in the resolution</td>
<td></td>
</tr>
<tr>
<td></td>
<td>activities.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Creates adhoc communication plans and tasks.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>•Edits a communication plan that is attached to a major incident.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Close a major incident.</td>
<td></td>
</tr>
<tr>
<td>Communications manager</td>
<td>• Manages communications for major incidents and is responsible for</td>
<td>This role inherits the ia_admin role.</td>
</tr>
<tr>
<td>(communication_manager)</td>
<td>communicating with all stakeholders.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Creates adhoc communication plans and tasks.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Edits a communication plan that is attached to a major incident.</td>
<td></td>
</tr>
</tbody>
</table>
### Incident Manager

**Incident Manager**

*Incident_manager*

*(Existing role with added responsibilities)*

- Manages incident properties and major incident trigger rules.
- Can create and edit Communication Plan Definitions.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major Incident Trigger Rules</td>
<td>This table extends the Application File (sys_metadata) table and stores the major incident trigger rules.</td>
</tr>
</tbody>
</table>

### Slack notification installed with Major Incident Management

Slack notifications are added with activation of Incident Management – Major Incident Management.

<table>
<thead>
<tr>
<th>Slack notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major Incident Candidate assigned</td>
<td>Notifies Major Incident Management Group when <strong>Major Incident State</strong> changes to <strong>Proposed</strong>.</td>
</tr>
<tr>
<td>IAT conference notification</td>
<td>When conference call is initiated, a slack notification is sent to all the participants of the conference call.</td>
</tr>
</tbody>
</table>

### Quick start tests for Major Incident Management

Validate that Major Incident Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

### Major Incident Management

Major Incident Management quick start tests require activating the Incident Management - Major Incident Management plugin (com.snc.incident.mim).

#### MIM: Major Incident Management test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIM: Create a Major Incident</td>
<td>Test to verify the creation of major incident from the application navigation module.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>MIM: Create a Major Incident Candidate</td>
<td>Test to verify the Create a Major Incident Candidate module from navigation menu.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Create a Major Incident from a Major Incident Candidate</td>
<td>Test to verify the creation of a major incident from a major incident candidate.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Major Incident Candidate creation when it matches Major Incident Management trigger rule</td>
<td>Test to verify the creation of a major incident candidate when conditions to create a major incident match the major incident management trigger rule.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Propose a major Incident (Assignment group empty)</td>
<td>Test to verify auto assignment of major incident candidate when an incident is proposed as a major incident and the Assignment group and the Assigned to fields are empty.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Propose a major Incident (Assignment group is not empty)</td>
<td>Test to verify the auto assignment of a major incident when an incident is proposed as major incident and the Assignment Group and the Assigned to fields are not empty.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Promote a candidate to major Incident (Assignment group is empty)</td>
<td>Test to verify auto assignment of major incident when a candidate is promoted to a major incident and the Assignment Group is empty.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Promote a candidate to major Incident (Assignment group is not empty)</td>
<td>Test to verify auto assignment of major incident when a candidate is promoted to a major incident and the Assignment Group is not empty.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Reject a Major Incident Candidate</td>
<td>Test to verify the rejection of a major incident candidate.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Demote a Major Incident</td>
<td>Test to verify whether a major incident gets demoted to an incident.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Major Incident closure</td>
<td>Test to validate the major incident closure functionality.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: State sync up with ICP and ICT</td>
<td>Test is to verify the state sync up with Incident Communication Plan and Incident Communication Task.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>MIM: ICP attached to an Incident based on conditions and its state sync up with ICT</td>
<td>Test is to verify Incident Communication Plan attached to an Incident based on defined conditions.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Resolving MI and PIR</td>
<td>Test is to verify resolving a Major Incident and Post Incident Report.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Major Incident workbench layout verification</td>
<td>Test is to verify Major Incident workbench layout verification.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Verify communication task from MI workbench</td>
<td>Test is to verify communication task from MI workbench.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

To learn more about Major Incident Management, see *Major Incident Management*.

### Create trigger rules for major incidents

Create trigger rules to define conditions under which a trigger action is executed. You can create major incident trigger rules to define conditions under which an incident is automatically considered as a major incident candidate.

Role required: incident_manager or admin

Major incident trigger rules are evaluated asynchronously each time an incident is created or updated provided the following conditions are met:

- Incident record does not have the Parent Incident populated which means that the current incident is not a child incident.
- Major incident is not proposed or accepted.
- Incident is active.

**Note:** The base system major incident trigger rules are disabled by default.

1. Navigate to **Major Incidents > Administration > Major Incident Trigger Rules**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the trigger rule.</td>
</tr>
<tr>
<td>Table</td>
<td>Table on which the trigger rule executes.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the trigger rule. The trigger rule is available for all applications or for scoped applications.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Execution Order</td>
<td>The rule with lowest execution order is triggered first. In the following example, the rule with order = 100 is executed first.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td>• If business criticality of business service is 1-most critical or 2-somewhat critical, Order = 100.</td>
</tr>
<tr>
<td></td>
<td>• If the number of child incidents is greater than 20, then Order = 200.</td>
</tr>
<tr>
<td></td>
<td>• For P1 incident, Order = 300.</td>
</tr>
<tr>
<td></td>
<td>Note: If any of the existing trigger rule conditions are met, the incident is considered to be a major incident candidate and verification of</td>
</tr>
<tr>
<td></td>
<td>the remaining rules is not required. Otherwise, all the rules are verified based on the execution order.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate or deactivate the trigger rule.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions which must be met so that the trigger rule executes.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Working on major incident management**

The section covers topics that help you with a variety of technical concepts related to major incident management such as the different ways to create a major incident, ways to reject a major incident candidate, demote a major incident, or close a major incident.

**Create a major incident candidate**

You can create a major incident candidate in multiple ways. After a major incident candidate is created, the major incident manager evaluates the candidate and decides whether the candidate should be promoted to a major incident.

Role required: itil, sn_incident_write, or admin

A major incident manager can accept or reject a major incident candidate.

Perform any of the following actions:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create major incident trigger rules</td>
<td>An incident can be marked as a major incident candidate based on the major incident trigger rules. A major incident manager or an incident manager can Create trigger rules for major incidents to identify major incident candidates automatically.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The base system major incident trigger rules are disabled by default. A major incident manager or an incident manager needs to activate the trigger rules that define conditions under which an incident is automatically considered as a major incident candidate.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Propose an incident as a major incident candidate manually</td>
<td>Manually propose an existing incident to be a major incident candidate by clicking Propose Major Incident from the context menu. You are prompted to enter the reason for proposing the incident as a candidate, and specifying the business impact of the incident.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If an incident is in the resolved, closed, or canceled state, the Propose Major Incident option does not appear on the context menu.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Create a candidate from application navigation</td>
<td>1. Create a new major incident candidate by clicking Incident &gt; Major Incidents &gt; Create Major Incident Candidate.</td>
</tr>
<tr>
<td></td>
<td>2. Fill in the fields and click Submit.</td>
</tr>
</tbody>
</table>

**Note:**
- When an incident is proposed as a major incident candidate, the Major incident state field in the incident form under the Major incident section is changed to Proposed.
- When you create a new major incident from a candidate, a new incident is created and becomes the major incident. The candidate is added as the child of the major incident. To get this behavior, the incident manager needs to set the major incident management property Create major incident from candidate – A new incident is created from a candidate as a major incident. The candidate is associated with the new incident as a child. (sn_major_inc_mgmt.com.snc.incident.mim.major_incident_creation) to Create major incident from candidate.
- System automatically assigns the newly created parent major incident to a user when the On-Call Scheduling plugin (com.snc.on_call_rotation) is activated, a shift is defined for the major incident management group, and a user is available for the on-call shift. If no on-call shift exists, the major incident manager decides the user for the Assigned to field.
Create a major incident

Create a major incident directly or review the candidates and promote the candidates to major incidents.

Role required: major_incident_manager

Perform any of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Promote an incident to a major incident manually</td>
<td>On the context menu, click <strong>Promote to Major Incident</strong>. The incident directly becomes a major incident.</td>
</tr>
</tbody>
</table>

Note:

- Only a major incident manager can promote an incident to a major incident. If an incident is in the resolved, closed, or canceled state, the **Promote to Major Incident** option does not appear on the context menu.
- When an incident is promoted to a major incident, the incident itself is considered as a major incident and no new incident is created.

To get this behavior, you need to set the major incident management property **Create major incident from candidate** – A new incident is created from a candidate as a major incident. The candidate is associated with the new incident as a child. (sn_major_inc_mgmt.com.snc.incident.mim.major_incident_creation to **Promote candidate to a major incident**.)

Create a major incident from application navigation

1. Click **Incident > Major Incidents > Create Major Incident**.
2. Fill in the fields and click **Submit**.

Major incident assignment

A major incident is assigned to a group automatically at the time of proposal and promotion based on the value of the property **Major Incident Management Group (sys_id)** to whom the Major Incident should be re-assigned on promotion to 'Major Incident' (sn_major_inc_mgmt.major_incident_management_group). The assigned group works on the major incident and resolves it.

The incident is assigned to an individual if the On-Call Scheduling plugin (com.snc.on_call_rotation) is activated and a shift is defined for the group. The following table illustrates the different conditions under which a major incident is assigned to a group and a user.
### Assignment of major incident

<table>
<thead>
<tr>
<th>Action</th>
<th>Condition</th>
<th>Assignment group</th>
<th>Assigned to</th>
</tr>
</thead>
</table>
| Incident is proposed as a candidate manually or based on major incident trigger rules | Assignment Group is empty                     | Group based on the property value                     | • If on-call is activated, shift is defined and a user is available on-call then the incident is assigned to the on-call user  
• If on-call is not activated, the **Assigned to** field remains empty |
| Assignment Group is not empty                               | No change - Incident retains the current value of the assignment group | No change - incident remains with the current value in the **Assigned to** field | |
| Incident is manually promoted to a major incident            | Assignment Group is empty                     | Group based on the property value                     | The value for the **Assigned to** field is the user who promoted the incident to a major incident |
| Assignment Group is not empty                               | • Incident reassigned to group based on the property value  
• Send a notification to the original Assignment Group members about the latest incident reassignment. | • **Assigned to** value is overwritten by the user who promoted the major incident candidate  
• Send a notification to the user to whom the major incident was previously assigned | |
| Major incident is created                                   | Assignment Group is empty                     | Group based on the property value                     | The value of the **Assigned to** field is the user who has created the major incident |
| Assignment Group is not empty                               | No change - Incident retains the current value of the assignment group | No change - incident remains with the current value in the **Assigned to** field | |

### Assignment of incident communication plan and communication task

<table>
<thead>
<tr>
<th>Action</th>
<th>Condition</th>
<th>Assignment group</th>
<th>Assigned to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident communication plan is created with source as major incident</td>
<td>Assignment Group is empty</td>
<td>The value for the <strong>Assignment group</strong> field is copied from the source incident</td>
<td>The value of the <strong>Assigned to</strong> field is copied from the source incident</td>
</tr>
</tbody>
</table>
Accept or reject a major incident candidate

When an incident is proposed as a major incident candidate, a major incident manager can accept or reject the candidate. The manager accepts a candidate as a major incident if the incident requires accelerated resolution.

Role required: major_incident_manager

Perform any of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Accept a major incident candidate           | 1. Navigate to Incident > Major Incidents > Candidates and open the candidate to be approved.  
|                                             | 2. Click the additional actions icon and select Promote to Major Incident.    |

Note:
- While promoting the candidate, the major incident manager is prompted to enter work notes and business impact.
- The incident is promoted to a major incident, and the Major incident state field under the Major incident section is changed from Proposed to Accepted.
- The incident is assigned to the user who approves the major incident.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reject a major incident candidate</strong></td>
<td>1. Navigate to Incident &gt; Major Incidents &gt; Candidates and open the candidate to be rejected.</td>
</tr>
<tr>
<td></td>
<td>2. Click the additional actions menu icon and select <strong>Reject</strong> Major Incident Candidate.</td>
</tr>
</tbody>
</table>

**Note:**
- While rejecting the candidate, the major incident manager is prompted to enter the reason for rejecting the candidate. A notification is sent to the user in the Assigned to field.
- The state of the incident remains the same while the Major incident state field is changed to **Rejected**.

**Associate multiple incidents with a major incident**

You can associate one or more incidents with a major incident using the Actions menu.

Role required: itil, sn_incident_write, or admin

When a major incident occurs, there are usually multiple incidents created for the same issue and there might be multiple major incident candidates created for a single issue. All the incidents for a single issue can be associated with the appropriate major incident.

1. Navigate to Incident > Open.
2. Select the incidents that need to be associated with a major incident.
3. On the Actions menu, click **Link to Major Incident**.
<table>
<thead>
<tr>
<th>Incident</th>
<th>Number</th>
<th>Date/Time</th>
<th>Description</th>
<th>Creator</th>
<th>Priority</th>
<th>Status</th>
<th>Category</th>
<th>Assigned to</th>
<th>Updated</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>INC0000030</td>
<td>2019-01-05 15:53:46</td>
<td>Need to add more memory to laptop</td>
<td>Dan Goodlife</td>
<td>1</td>
<td>Critical</td>
<td>Hardware</td>
<td>IT User</td>
<td>2019-06-26 02:20:54</td>
</tr>
<tr>
<td></td>
<td>INC0000040</td>
<td>2019-01-24 15:50:05</td>
<td>Please remove the latest huffle from my PC</td>
<td>Fred Luddy</td>
<td>2</td>
<td>High</td>
<td>Software</td>
<td>IT User</td>
<td>2019-06-26 02:20:54</td>
</tr>
<tr>
<td></td>
<td>INC0000050</td>
<td>2019-01-26 14:00:44</td>
<td>I can't get my weather report</td>
<td>Charlie Wutherspoon</td>
<td>5</td>
<td>Planning</td>
<td>Inquiry / Help</td>
<td>Service Desk</td>
<td>2019-04-28 12:52:57</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Trouble getting to Oregon email server</td>
<td>Bud Richman</td>
<td>5</td>
<td>Planning</td>
<td>Network</td>
<td>Howard Johnson</td>
<td>2019-04-28 12:39:15</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>My desk phone does not work</td>
<td>Ron Brumel</td>
<td>3</td>
<td>Moderate</td>
<td>Hardware</td>
<td>IT User</td>
<td>2019-04-28 12:52:15</td>
</tr>
</tbody>
</table>
4. In the Choose a Major Incident dialog box, select the major incident with which you want to associate the incidents.

5. Click OK.
The incidents are added as a child to the major incident.

Reject multiple major incident candidates using the Actions menu

You can reject one or more major incident candidates using the Actions menu. If you decide that the candidates do not qualify to be major incidents, then you can reject multiple candidates at once and provide the rejection reason.

Role required: major_incident_manager

1. Navigate to Incident > Major Incidents > Candidates.
2. Select the candidates that you need to reject.
3. On the Actions menu, click Reject Major Incident Candidate.
4. On the Rejection Reason dialog box, enter the reason why you decided not to accept the candidates as major incident.

5. Click Reject.
   The major incident candidates are rejected.

Demote a major incident

When an incident is incorrectly evaluated to be a major incident, you can demote the major incident even after it is accepted so that the incident can be handled as a regular incident.

Role required: major_incident_manager

1. Navigate to Major Incidents > Open.
2. Open the major incident that you want to demote.
3. Click the additional actions icon and select Demote Major Incident.
4. Enter the reason for the demotion.
   The major incident state is set to Canceled but the incident state remains the same.

Close a major incident

You can close a major incident manually after validating the resolution and when the major incident is in the Resolved state.

- Role required: major_incident_manager or admin
- Major incident is in resolved state

1. Navigate to Major Incidents > Open.
2. Open the major incident that you want to close.
3. Click Close Incident.

Note:

- If you cancel an incident and the major incident state is in Proposed or Accepted state, the major incident state changes to Canceled.
- The incident auto-closure property Enable auto closure of incidents based on Resolution date. Setting this to ‘No’ will make auto closure to run based on the Updated date does not close any incident record that is accepted as a major incident. Users with the major_incident_manager or admin role must close a major incident manually, after validating the resolution and when the major incident is in the Resolved state.
- If an incident was promoted as a major incident, then an ESS user cannot resolve, close, or reopen the incident.

View major incident information on the Incident form

When an incident enters the major incident life cycle, the Major Incident and the Post Incident Report tab appears on the incident form.

Role required: admin
Incident is in the major incident life cycle.

1. Navigate to Incident > Open.
2. Click the Major Incident tab.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Major incident state | A major incident state can be one of the following:  
  - **Proposed**: The initial state when a major incident candidate is created or proposed.  
  - **Accepted**: The state when a major incident is directly created by a major incident manager or when a candidate is promoted to a major incident by a major incident manager.  
  - **Rejected**: The major incident candidate is rejected by a major incident manager.  
  - **Canceled**: The major incident is demoted by a major incident manager. |
| Proposed by       | The user who proposed the incident as a major incident candidate. |
| Proposed          | Date and time when the incident was proposed as a major incident candidate. |
| Promoted by       | The user who promoted the incident to a major incident. |
| Promoted          | Date and time when the incident was promoted to a major incident. |
| Business impact   | The business impact of the issue identified in the major incident. |
| Probable cause    | The probable cause of the issue identified in the major incident. |

3. Click the **Post Incident Report** tab.  
If you have already filled the post incident report information in the major incident workbench, the same information appears in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>Summary of the incident.</td>
</tr>
<tr>
<td>Findings</td>
<td>Information on what caused the major incident and any lessons learnt in the process.</td>
</tr>
<tr>
<td>Timeline</td>
<td>Information of all the activity feeds not only of the incident but also of the incident communication plan and incident communication tasks related to the incident.</td>
</tr>
</tbody>
</table>

### Major incident workbench

The major incident workbench is a single pane view designed for major incident managers, communication managers, and resolver groups. The workbench helps to manage major incidents by aggregating and providing actionable information.

To navigate to the major incident workbench, open a major incident or a major incident candidate, and click **View Workbench** on the form header.
Note: Groups and number of members involved in the groups widget are populated from the Assignment group and the Assigned to fields of incident, incident communication plan, incident task, as well as the members involved in an active conference call.

Header components

- From the workbench, to navigate back to the incident form, click View Form that appears on the header of the workbench.
- If an incident is not yet in the Resolved state, then the header displays the Resolve button. To resolve an incident, click Resolve.
- When an incident is not yet accepted as a major incident, then the workbench displays a choice list on the header. The list displays options to promote the incident to a major incident or to reject the incident.
- Use the chat icon ( ) on the header to initiate a chat on the incident level. The chat is a record feed — whatever you write in the chat appears in the activity stream.
- You can click to change the state of the incident.
- Duration is an active timer that tracks the time since the creation of the incident. The timer stops when the incident is resolved.

Major incident workbench UI elements

The major incident workbench provides UI elements which display the summary of tasks, progress of communication plan, conferencing information, and a report on the cause and resolution of the major incident.

The major incident workbench has the following UI elements: Summary, Communication, Conference, and Post Incident Report.

Note: You need to activate the Notify plugin (com.snc.notify) for the Conference tab to appear. The Post Incident Report tab is visible only when the incident state is either Resolved or Closed.

Major Incident workbench — Summary tab

The Summary tab provides a unified view of information in the form of a card layout. The information on impacted services, affected CIs, active outages, locations that are impacted, and child incidents helps to keep you informed about related records associated with an incident.
Summary tab

Email/Exchange server is down

<table>
<thead>
<tr>
<th>State</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolved</td>
<td>521:08:16:19</td>
</tr>
</tbody>
</table>

- Impacted Services: 1
- Affected CIs: 1
- Outages: 1
- Affected Locations: 0
- Child Incidents: 0

Latest Activity

- Work notes

Communication Tasks

<table>
<thead>
<tr>
<th>Short description</th>
<th>State</th>
<th>Time remaining</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical Conference</td>
<td>Open</td>
<td>Overdue</td>
</tr>
<tr>
<td>Initial Technical Communication</td>
<td>Open</td>
<td>Overdue</td>
</tr>
<tr>
<td>Initial End User Communication</td>
<td>Open</td>
<td>Overdue</td>
</tr>
<tr>
<td>Initial Stakeholder Communication</td>
<td>Open</td>
<td>Overdue</td>
</tr>
</tbody>
</table>

Groups

<table>
<thead>
<tr>
<th>Name</th>
<th>No. of members</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- User ITIL User has been contacted via Email
- Incident escalated to User ITIL User
- This Incident Escalation is In Process. Escalation Plan is new
- Escalation to Escalation to User ITIL User
- Escalation to Escalation to User ITIL User
- Escalation to Escalation to User ITIL User
- Escalation to Escalation to User ITIL User

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
You can add, create, or edit each of the components. You can also view, post, or filter the latest activity on the major incident.

The tab also provides a quantitative summary of the active and completed tasks, as well as users or groups who are involved in resolving the major incident. The communication tasks are sorted in ascending order based on the order value.

The **Time remaining** column provides information regarding the time when the communication task is due.

- If you do not perform the communication task within the set time, the value changes to **Overdue**.
- If you activate the On-call Scheduling plugin (com.snc.on_call_rotation): The user who is on-call for the respective group and the group name appear in the summary.

The Groups section displays On-Call information, including the On-Call Escalation Tracking icon that indicates the active status of the escalation. Green indicates an active escalation, and black indicates a finished escalation. Click the icon to view the On-Call Escalation Tracking pop-up.

Activate the Event Management plugin (com.glideapp.itom.snac) to add an **Alert** card under the **Summary** tab that keeps you up-to-date on the number of alerts for each incident. The count is the total of all primary and secondary alerts for the incident.

**Major Incident workbench — the Communications tab**

The **Communications** tab helps you understand the progress of communication plan and its related tasks.

If there are multiple communication tasks associated with a communication plan, all the tasks appear under the respective communication plan.

<table>
<thead>
<tr>
<th>Summary</th>
<th>Communications</th>
<th>Conference</th>
<th>Post Incident Report</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Communication Tasks</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Technical Communications</strong></td>
<td>0 / 3 Tasks completed</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Communication task filter**

You can filter the communication task to view all tasks, active tasks, or completed tasks. You can also add a new communication plan by clicking **Add**. You can create communication task for an existing plan by clicking **Add Task**. For more information, see **Add communication plan from the major incident workbench**. If you want to add or remove recipients from a particular plan after the plan is saved, click **Manage Recipients**.
Manage recipients

The following actions can be performed on a given communication task:
Communication task actions

- **Close Task**: If the task is performed at least once, closes the communication task and changes the state to **Complete** else changes the state to **Skipped**.
- **Snooze**: Available only for recurring communication task. Allows the user to skip the communication task once and the due-in timer is refreshed.
- **View Form**: For each task in the plan, you can navigate back to the form.
- **View Activity**: Allows you to view activity history and post your work notes or additional comments for a communication task.

You can also view the due time of upcoming tasks and the overdue time in case the task is not completed within the expected time.

To send a notification, click **Send**. If the notification has to be send only once, then after sending the notification, the status of the task changes to **Complete**. If the task is recurring, the status of the task changes to **Open**. After a recurring communication task is performed, the status of the communication task changes to **Sent** followed by the number of times the recurring communication task is performed until that time. For example, Sent(2x) means that the communication task is performed twice.
# Communication task state

Icons to the left of the Communication Task name represent the state of the communication task such as completed, skipped, or active.

Under the Work Notes & Activity section, you can initiate a chat at the incident or incident communication plan level. You can also view the activity stream for that record.
Messaging users through Slack

For Slack functionality, install Collaboration services from ServiceNow® Store.

When you add Slack as a communication channel, it appears as follows:

Click Send to convey the Slack message to the contacts that you have already mentioned in the communication contact while defining the communication plan.

**Note:** A Slack channel is created and the name of the channel is the same as the incident communication plan number (example: ICP001001). All the users whom you have mentioned in the communication contact, get connected to the newly created slack channel. The users can communicate through the new channel.

You can perform the communication task actions such as Closed Task, Snooze, View Form, and View Activity.

**Major Incident workbench — the Conference tab**

The Conference tab helps you to view information about communication tasks that have conference as their communication channel. It also allows you to manage the participants in a conference call.
Like the Summary tab, you can add a new communication plan by clicking Add. You can create communication task for an existing plan by clicking Add Call. For more information, see Add communication plan from the major incident workbench. If you want to add or remove recipients from a particular plan after the plan is saved, click Manage Participants.

To initiate a conference call, click Start Call. If the communication task is a one-time task, then after the call is ended, the status of the task changes to Complete. If task is recurring, the status of the task changes to Open and it displays the number of times the conference call is initiated.

Note: When you add a user group to the conference call, the group itself is added to the call, and the escalation hierarchy is automatically followed once you start the call. Set the com.snc.iam.conference_call_follow_on_call_escalation property to true. For more information about the property, see System properties for On-Call Scheduling.
Under each task, the Active participant section displays the active participants and the Inactive participant section displays the inactive participants.

If the call is in progress, the itil user, who has access to the workbench, can join the conference call by clicking **Join Call**. The participants can also add another user to an ongoing conference call by clicking **+ Participants**. The conference leader can end the conference call by clicking **End Call**. The conference leader can mute, unmute, or kick an active participant by hovering over the active participant and clicking .

Under the Work Notes & Activity section, you can send connect message at incident or incident communication plan level. You can also view the activity stream.

To initiate a call directly to the group members, click **Start a call**.

To start a call, populate the **sn_major_inc_mgmt.notify_webrtc_number** property with a valid notify number that has voice capability. For user who is already in an active conference call, **Start a call** is disabled. You can mute or unmute all the participants using the **Mute All** and **Unmute All** options. If you activate the Notify - Twilio Direct Driver plugin (com.snc.notify.twilio_direct), the active participants are highlighted in green.

**Major Incident workbench — the Post Incident Report tab**

The **Post Incident Report** tab helps you to understand the cause of the major incident, and the actions taken by the teams to resolve the incident.

The teams can assess the incident response and resolution process and determine follow-up action items. The post incident report is required to record the actions performed, the reasons for doing them, and findings.

**Note:** The major incident manager can edit a report when the incident is in the **Resolved** state.
View of the Post Incident Report tab

The post incident report includes the following sections where a major incident manager can provide required information:

- **Overview**: Summary of the incident.
- **Findings**: Information on what caused the major incident and any lessons learned in the process.
- **Resolution**: Information on the resolution steps taken to resolve the issue. The major incident manager can also add or edit any related Problem or Change information by clicking Add or Manage respectively.
- **Timeline**: Information of all the activity feeds, not only of the incident but also of the incident communication plan and incident communication tasks related to the incident. You can update the timeline with the latest activity by clicking Regenerate Timeline.

**Note**: The information that you provide for Overview, Findings, and Timeline gets updated in the Post Incident Report section on the Incident form.

If you activate the Continual Improvement Management (CIM) plugin (com.sn_cim), the Related Improvement Records section is displayed in the report. This section displays the Inbound CIM Integrations records.

When you click View Complete Report, all the information entered by the major incident manager is compiled together and you can download the report in the .PDF format by clicking Download Report PDF.

The following links appear in the Incident form under the Related Links section:

- **Regenerate PIR Timeline**: This link appears when incident is in the Resolved state and the user has the major_incident_manager role.
• **Preview PIR**: This link appears when incident is in the **Resolved** or **Closed** state and the user has the **itil** role.

**Note:** On the downloaded report, under **Incident Response Timeline**, the time displayed in the timing type **Time to Identify** is calculated in the following ways:

- If you propose the incident as a major incident: The time indicates the time from creation of the first related alert for this incident or creation of the incident (in case there is no alert or the Event Management plugin is inactive), whichever occurs first, until the time the incident is first proposed as a major incident.
- If you create a major incident directly: The time indicates the time from creation of the first related alert for this incident or creation of the incident (in case there is no alert or the Event Management plugin is inactive), whichever occurs first, until the time the incident is promoted as a major incident.

---

**Associate a new post incident report**

Create your own post incident report and associate the UI page with the **View Complete Report** button under the **Post Incident Report** tab. Using the customized report, you can add information that is specific to your organization.

**Role required:** itil, major_incident_manager, or admin

For associating the **View Complete Report** button with your customized post incident report page, set the value of the **PIR export ui page url major incident** property to the new UI page.

1. Navigate to **System UI > UI Pages** and click **New**.
2. Create a UI page.
   - For information on how to create a UI page, refer to **UI pages**.
3. Navigate to **Incident > Major Incident Properties**.
4. In the **PIR export ui page url** (sn_major_inc_mgmt.pir_export_pdf_ui_page) property, enter the link of the new UI page.
5. Click **Save**.
   - When you click the **View Complete Report** button, the new UI page opens.

---

**Add communication plan from the major incident workbench**

You can create a new communication plan or add a new communication task to an existing communication plan from the workbench. This UI action is helpful when you do not have an existing well-defined communication plan in the system.

**Role required:** major_incident_manager

1. Navigate to **Major incident workbench**.
2. Click the **Communications** tab and then click **Add** that appears in Communication Tasks section.
   - The Adhoc Communication pop-up window appears.
3. On the form, fill in the fields.
Create New Template form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Plan</td>
<td>List to select a new communication plan or to select an existing plan and add communication tasks to the plan.</td>
</tr>
<tr>
<td>Plan Short description</td>
<td>Brief description of what the communication plan is all about.</td>
</tr>
<tr>
<td>Task Short description</td>
<td>Brief description of what the communication task is all about.</td>
</tr>
<tr>
<td>Channels</td>
<td>Check box to select email, SMS, slack, or conference as mode of communication for the plan.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Frequency at which a specific task needs to be executed. A task can be executed only once or on specific durations.</td>
</tr>
<tr>
<td>Due in (Minutes)</td>
<td>Time span when the task must be executed after the task initiates. For recurring tasks, it also indicates the time span after which the task must repeat.</td>
</tr>
</tbody>
</table>

**Add similar incidents from major incident workbench**

Add similar incidents to a major incident so that the support teams can work on the parent record for a coordinated response process.

Role required: itil, major_incident_manager, communication_manager, incident_manager, or admin

- Activate the Predictive Intelligence plugin (com.glide.platform_ml).
  - Configure Predictive Intelligence and train the solution definition with the name `ml_sn_global_similar_incidents_mim`. For more information on how to train a solution definition, refer to Create and train a similarity solution.

- Ensure that there is an active ML solution at Predictive Intelligence > Similarity > Solutions with the solution name `ml_sn_global_similar_incidents_mim`.

1. Navigate to Major incident workbench.
2. Click the Summary tab.
3. In the Child Incidents section, click and then click Find Similar.
4. From the Add Similar Incidents dialog box, select the similar incidents that you want to relate to the major incident and then click **Add Selected**. The similar child incidents appear under the Child Incidents section.

**Access on-call escalation path from major incident workbench**

Access on-call roster and escalation details from major incident workbench to reach out to a support group.

Role required: itil, sn_incident_read, sn_incident_write, major_incident_manager, communication_manager, incident_manager, or admin
Activate the On-Call Scheduling plugin (com.snc.on_call_rotation).

1. Navigate to **Major incident workbench**.
2. Click the **Communications** tab.
3. Under the **Groups** section, click **On Call Groups**.
4. From the list, select a group.
5. Click Roster and Escalation details.
6. In the window, click Escalation path.
   You can access the on-call escalation information.

Major incident overview (dashboard)

Major Incident Overview module provides two versions of the Performance Analytics (PA) Dashboard to review major incident information at a glance.

Users with itil, sn_incident_write, major_incident_manager or communication_manager role can access the dashboard.

The two versions of the Performance Analytics (PA) Dashboard are normal and premium. You must activate the Incident Management - Major Incident Management plugin (com.snc.incident.mim) to view the normal dashboard. To access the premium version of Major Incident Overview dashboard, activate Performance Analytics – Content Pack for Major Incident Management (com.snc.pa.incident.mim).

You can navigate to the dashboard in the following ways:

- Incident > Major Incidents > Overview
- Self – Service > Dashboard > Major Incident Overview
Major incident overview

- Major Incident Overview dashboard

- Overview: 0
- Major Incident Candidates: 0
- Active Major Incidents: 0
- Resolved Major Incidents: 0

- Major Incidents Nearing Breach: 0
- Major Incidents Overdue: 0
- Unassigned Major Incidents: 0

- Open Major Incidents: 0
- Major Incidents Opened Today: 0
- Major Incidents Resolved Today: 0

- Open Major Incidents - Grouped: No data to display
- Open Major Incidents Older Than 7 Days - Grouped: No data to display

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Major Incident Overview module provides information on the following content:

<table>
<thead>
<tr>
<th></th>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Dashboard controls</td>
<td>Provides options to create, duplicate, or delete a dashboard. You can copy the dashboard URL or duplicate the dashboard. In addition, you can add the dashboard in your favorite list, create a tab, or reset filters in the dashboard.</td>
</tr>
<tr>
<td>2</td>
<td>Dashboard overview</td>
<td>Takes you to the UI page where you view the recently accessed dashboard, dashboards owned or shared by you, or all the dashboards in the system. To create a new dashboard, click <strong>New</strong>.</td>
</tr>
<tr>
<td>3</td>
<td>Dashboard choice list</td>
<td>Provides options to select between different dashboards in the system.</td>
</tr>
<tr>
<td>4</td>
<td>Add widgets</td>
<td>Provides option to add widgets. You can drag to move or resize the widget on the dashboard.</td>
</tr>
<tr>
<td>5</td>
<td>Sharing</td>
<td>Provides option to specify groups, users, and roles for the dashboard.</td>
</tr>
<tr>
<td>6</td>
<td>Configuration</td>
<td>Provides the configuration pane to select a layout to snap the widgets against or to modify a layout as required.</td>
</tr>
<tr>
<td>#</td>
<td>UI component</td>
<td>Description</td>
</tr>
<tr>
<td>----</td>
<td>-----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 7  | Tabs            | • **Major Incidents Nearing Breach**: Number of active major incidents where the Major incident state is *Accepted* and the response or resolution SLA has reached 75% of the allotted time.  
• **Major Incidents Overdue**: Number of active major incidents where the Major incident state is *Accepted* and the response or resolution SLA has breached.  
• **Unassigned Major Incidents**: Number of active major incidents where *Assigned to* is empty.  
• **Open Major Incidents**: Major incidents which are open and has major incident state as *Accepted*.  
• **Major Incidents Opened Today**: Major incident state is *Accepted* and the major incident is created on the current day.  
  
  **Note**: Major incidents opened for that day includes both active and inactive incidents.  
• **Major Incidents Resolved Today**: Major incidents that are resolved on the current day and have the state as *Resolved*.  
• **Open Major Incidents – Grouped**: You can filter these incidents based on *Group by* and *Stacked by*.  
• **Open Major Incidents Older Than 7 Days – Grouped**: You can filter these incidents based on *Group by* and *Stacked by*.  
• **Major Incidents by Priority and State**  
• **Major Incidents by Priority and State Older than 7 Days**  
• **Major Incidents Opened per Week**  
• **Major Incidents Closed per Week** |

**Major Incident Overview – Premium**

Major Incident Overview – Premium provides the following additional functions:

• **Process KPIs**: Provides information on **Active Major Incidents**, **Number of resolved major incidents**, **Average resolution time of Major Incidents**, and **New Major Incidents Vs Resolved**.  
• Interactive filters: Helps to filter incidents based on category, priority, assignment group, and state.
### Major Incident Overview - Premium Dashboard

<table>
<thead>
<tr>
<th>Category</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major Incidents Nearing Breach</td>
<td>0</td>
</tr>
<tr>
<td>Major Incidents Overdue</td>
<td>0</td>
</tr>
<tr>
<td>Unassigned Major Incidents</td>
<td>0</td>
</tr>
<tr>
<td>Major Incidents Resolved Today</td>
<td>0</td>
</tr>
</tbody>
</table>

### Process KPIs

- **Major Incidents**
  - Nearing Breach: 0
  - Open: 0
  - Overdue: 0
  - Resolved: 0

## Incident Category
- **All**

## Incident Priority
- **All**

## Incident Assignment Group
- **All**

## Incident State
- **All**
- New
- In Progress
- On Hold
- Resolved
Mobile experience with ITSM Mobile agent

The new ITSM Mobile Agent app delivers out of the box mobile-first experiences designed for agents to triage, act on, and resolve incidents on the go. ITSM Mobile Agent improves productivity with an intuitive interface to manage all the work, view schedules, check who is on-call, respond to major incidents, and more.

Get started with ITSM Mobile agent

Access ITSM mobile agent on your mobile to manage incidents, view, and update on-call schedules.

Download ITSM mobile agent on an iOS platform from the Apple app Store or on an Android platform from Google Play Store.

Time required for this task: 10-15 minutes.

1. Tap the mobile app icon on your device, and then tap the plus button to login to an instance.
2. In the instance address field, enter the instance address in one of two ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual input</td>
<td>Type the instance address in the instance address field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: You do not need to include service-now.com at the end of the instance name.</td>
</tr>
<tr>
<td>Scan QR code</td>
<td>Tap the QR icon (Scan a QR code), and then scan the QR code given by your administrator.</td>
</tr>
</tbody>
</table>

3. Optional: Enter a nickname for this instance. If you have multiple instances added to the device, nicknames can help you quickly locate a Now Platform instance.

4. Tap **Save and Login**.

The ITSM Agent mobile landing screen opens. You can search for incidents, change tasks and more using the search bar on top of the landing screen.

My work

Use the My work applet in the ITSM mobile agent to perform various functions from the mobile.

As an agent, you can:

- Easily access incidents, change tasks, and catalog tasks.
- Take quick actions and provide timely updates.
- Add work notes or comments, update incident details, assign incidents to other agents.
- Easily access change requests and request approvals.

From the main screen of the agent mobile app, you can directly create an incident using a single click.
Create an incident from app landing page

Create an incident directly from your agent mobile app landing page with a single tap.

1. On your agent mobile app landing page, click on the

   landing screen.

   to create an incident directly from the

2. Fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caller</td>
<td>Tap on the arrow to search and choose a caller to whom this incident should be assigned.</td>
</tr>
<tr>
<td>Urgency</td>
<td>Populate the urgency of the incident. The available options are:</td>
</tr>
<tr>
<td></td>
<td>1 - High</td>
</tr>
<tr>
<td></td>
<td>2 - Medium</td>
</tr>
<tr>
<td></td>
<td>3 - Low</td>
</tr>
<tr>
<td>Short description</td>
<td>Provide a brief description of the incident.</td>
</tr>
<tr>
<td>Description</td>
<td>Provide the detailed description of the incident.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Tap the arrow to search and choose an assignment group to which the incident should be assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Tap the arrow to search and choose a person from the assignment group.</td>
</tr>
<tr>
<td>Service</td>
<td>Tap the arrow to search and choose the service to which the incident belongs.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Tap the arrow to choose the configuration item for the incident.</td>
</tr>
</tbody>
</table>

My incidents

Use the My incidents applet to work on the incidents that are assigned to you.
Resolve, reassign the incident, or add comments to an incident assigned to you. Add work notes, view the details of an incident, or edit an incident, all from a single screen on your mobile.

1. On the ITSM mobile agent landing screen, tap See All on the My incidents applet. The Assigned Incidents screen opens with a list of incidents.
2. If you want to reduce the number of records on the screen, see Filter records to search for records that match specific search criteria.
3. On the Assigned incidents screen with the list of incidents, swipe left on an incident to open the menu.

4. On the menu, choose one of the actions to process the incident.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add comments</td>
<td>Add any additional comments or work notes about the incident in this field and tap to submit.</td>
</tr>
<tr>
<td>Reassign</td>
<td>Use this action to reassign an incident to another agent. On the Reassign incident screen, tap the Assignment group field to change the assignment group, select the agent from the list in the Assigned to field and add any notes in the Work notes, and tap to submit.</td>
</tr>
</tbody>
</table>
5. On the **Assigned incidents** screen, tap a record on the list to open it and view more details.
6. On the **My Incidents** screen, choose one of the actions in the table as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DETAILS tab</strong></td>
<td>Choose one to continue.</td>
</tr>
<tr>
<td></td>
<td>· View the fields for details about the incident. The fields with an arrow have additional information.</td>
</tr>
<tr>
<td></td>
<td>· At the top right of the screen, tap the menu icon to reassign, edit, or propose the incident as a major incident.</td>
</tr>
<tr>
<td></td>
<td>· Add any additional comments using the <strong>Add comments</strong> button.</td>
</tr>
<tr>
<td></td>
<td>· Resolve the incident after adding a resolution code and notes using the <strong>Resolve</strong> button.</td>
</tr>
<tr>
<td><strong>ACTIVITY tab</strong></td>
<td>View the activity on the incident like field changes or assignment changes.</td>
</tr>
<tr>
<td></td>
<td>Tap the add icon to perform any of the following activities on the incident.</td>
</tr>
<tr>
<td></td>
<td>1. <strong>Record Video</strong>: Record a video to be attached to the incident.</td>
</tr>
<tr>
<td></td>
<td>2. <strong>Open Gallery</strong>: Open your photo gallery to attach an existing image or a video to the incident.</td>
</tr>
<tr>
<td></td>
<td>3. <strong>Take Photo</strong>: Take a picture and attach it to the incident</td>
</tr>
<tr>
<td></td>
<td>4. <strong>Attach File</strong>: Attach a file from another application to the incident.</td>
</tr>
<tr>
<td></td>
<td>5. <strong>Add Additional Comments</strong>: Add any additional comments to the incident.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The comments can be made visible to the customer if you enable them using the toggle bar on the <strong>Additional Comments</strong> field.</td>
</tr>
<tr>
<td></td>
<td>6. <strong>Add Work Notes</strong>: Add your work notes on the incident.</td>
</tr>
<tr>
<td><strong>RELATED tab</strong></td>
<td>View the related lists of the incident, such as, child incidents, task SLAs, impacted services, and affected CIs. Tap on the arrow to view more details of these related items.</td>
</tr>
</tbody>
</table>
### Filter records

Set additional filters to limit the number of records that are displayed on a screen. Filtering records in the mobile app works like filtering with a condition builder on the Now Platform.

**Role required:** itil or group manager

1. To further refine your search results, or to enter additional filter criteria on any list of records that is displayed, tap the filter icon.
2. On the Filters screen that appears, tap the arrow on a field to expand it.
3. From the options available, tap the check box or tap an option for your filter. For many of the filters, you can select more than one option.
4. Tap the Back icon or **DONE** to save your changes to a field.
   The criteria you chose displays on the Filters screen. The number of records that match your criteria also display on the top of the screen. Tap **Clear** or **RESET** to remove any filters and restore the default setting.
5. Optional: Repeat steps 1-4 with the Filters screen displayed to continue setting your filter criteria.
6. Tap the intersection union after you set all criteria to create AND conditions. Alternatively, tap the union icon to create OR conditions.
7. After you have added all the criteria you want, tap **DONE**.
   The incident records that match your filter criteria display on the screen.

### Incidents at risk

View a list of incidents at risk and work on them from your mobile.

**Filter records**

Set additional filters to limit the number of records that are displayed on a screen. Filtering records in the mobile app works like filtering with a condition builder on the Now Platform.
Role required: ITIL or group manager

1. To further refine your search results, or to enter additional filter criteria on any list of records that is displayed, tap the filter icon.

2. On the Filters screen that appears, tap the arrow on a field to expand it.

3. From the options available, tap the check box or tap an option for your filter. For many of the filters, you can select more than one option.

4. Tap the Back icon or DONE to save your changes to a field.

   The criteria you chose displays on the Filters screen. The number of records that match your criteria also display on the top of the screen. Tap Clear or RESET to remove any filters and restore the default setting.

5. Optional: Repeat steps 1-4 with the Filters screen displayed to continue setting your filter criteria.

6. Tap the intersection union after you set all criteria to create AND conditions.

   Alternatively, tap the union icon to create OR conditions.

7. After you have added all the criteria you want, tap DONE.

   The incident records that match your filter criteria display on the screen.

Process an incident at risk

Work on an incident at risk from your mobile.

Role required: ITIL

Resolve, reassign the incident, or add comments to an incident assigned to you.

1. On the ITSM mobile agent landing screen, tap the Incidents at risk applet.

   The Incidents at risk screen opens with a list of incidents.

2. If you want to reduce the number of records on the screen, see Filter records to search for records that match specific search criteria.

3. On the Incidents at risk screen with the list of incidents, swipe left on an incident to open the menu.

4. On the menu, choose one of the actions to process the incident.
5. On the **Incidents at risk** screen, tap a record on the list to open it and view more details.

6. On the **Incidents at risk** screen as shown in the following figure, choose one of the actions in the table as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DETAILS tab</strong></td>
<td>Choose one to continue.</td>
</tr>
<tr>
<td></td>
<td>• View the fields for details about the incident. The fields with an arrow have additional information.</td>
</tr>
<tr>
<td></td>
<td>• At the top right of the screen, tap the menu icon</td>
</tr>
<tr>
<td></td>
<td>to reassign, edit, or propose the incident as a major incident.</td>
</tr>
<tr>
<td></td>
<td>• Add any additional comments using the Add comments button.</td>
</tr>
<tr>
<td></td>
<td>• Resolve the incident after adding a resolution code and notes using the Resolve button.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ACTIVITY tab</td>
<td>View the activity on the incident like field changes or assignment changes. Tap the add icon to perform any of the following activities on the incident.</td>
</tr>
<tr>
<td></td>
<td>1. <strong>Record Video</strong>: Record a video to be attached to the incident.</td>
</tr>
<tr>
<td></td>
<td>2. <strong>Open Gallery</strong>: Open your photo gallery to attach an existing image or a video to the incident.</td>
</tr>
<tr>
<td></td>
<td>3. <strong>Take Photo</strong>: Take a picture and attach it to the incident.</td>
</tr>
<tr>
<td></td>
<td>4. <strong>Attach File</strong>: Attach a file from another application to the incident.</td>
</tr>
<tr>
<td></td>
<td>5. <strong>Add Additional Comments</strong>: Add any additional comments to the incident.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The comments can be made visible to the customer if you enable them using the toggle bar on the Additional Comments field.</td>
</tr>
<tr>
<td></td>
<td>6. <strong>Add Work Notes</strong>: Add your work notes on the incident.</td>
</tr>
</tbody>
</table>

| RELATED tab | View the related lists of the incident, such as, child incidents, task SLAs, impacted services, and affected CIs. Tap on the arrow to view more details of these related items. |
| CALLS tab   | View the list of all the calls related to an incident. Tap on any of the calls to **Add participants** or to **Join call**. Tap on the menu on top of the Conference Call page and tap **End call** to end the call. |

**Breached Incidents**

View a list of all the breached incidents of your group and take appropriate action on these incidents.

**Filter records**

Set additional filters to limit the number of records that are displayed on a screen. Filtering records in the mobile app works like filtering with a condition builder on the Now Platform.

Role required: itil or group manager

1. To further refine your search results, or to enter additional filter criteria on any list of records that is displayed, tap the filter icon.

2. On the Filters screen that appears, tap the arrow on a field to expand it.

3. From the options available, tap the check box or tap an option for your filter. For many of the filters, you can select more than one option.
4. Tap the Back icon or DONE to save your changes to a field. The criteria you chose displays on the Filters screen. The number of records that match your criteria also display on the top of the screen. Tap Clear or RESET to remove any filters and restore the default setting.

5. Optional: Repeat steps 1-4 with the Filters screen displayed to continue setting your filter criteria.

6. Tap the intersection union after you set all criteria to create AND conditions. Alternatively, tap the union icon to create OR conditions.

7. After you have added all the criteria you want, tap DONE. The incident records that match your filter criteria display on the screen.

Process a breached incident
View and manage the breached incident from the mobile.
Role required: admin

1. On the ITSM mobile agent landing screen, tap the Breached incident applet. The Breached incidents screen opens with a list of incidents.

2. If you want to reduce the number of records on the screen, see Filter records to search for records that match specific search criteria.

3. On the Breached incidents screen with the list of incidents, swipe left on an incident to open the menu.

4. On the menu, choose one of the actions as described in the table.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add comments</td>
<td>Add any additional comments or work notes about the incident in this field and tap.</td>
</tr>
<tr>
<td>Reassign</td>
<td>Use this action to reassign an incident to another agent. On the Reassign incident screen, tap the Assignment group field to change the assignment group, select the agent from the list in the Assigned to field, and add any notes in the Work notes, and tap to submit.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Resolve</td>
<td>On the Resolve incident screen, tap the Resolution code field and choose a code for the resolution, add notes in the Resolution notes field, and tap</td>
</tr>
</tbody>
</table>

5. On the Breached incidents screen, tap a record on the list to open it and view more details.
6. On the Breached incidents screen, as shown in the following figure, choose one of the actions in the table as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| DETAILS tab| Choose one to continue.
  • View the fields for details about the incident. The fields with an arrow have additional information.
  • At the top right of the screen, tap the menu icon to reassign, edit, or propose the incident as a major incident.
  • Add any additional comments using the Add comments button.
  • Resolve the incident after adding a resolution code and notes using the Resolve button.  |
| ACTIVITY tab| View the activity on the incident like field changes or assignment changes. Tap to perform any of the following activities on the incident.
  1. Record Video: Record a video to be attached to the incident.
  2. Open Gallery: Open your photo gallery to attach an existing image or a video to the incident.
  3. Take Photo: Take a picture and attach it to the incident
  4. Attach File: Attach a file from another application to the incident.
  5. Add Additional Comments: Add any additional comments to the incident.
  ![Note](image) The comments can be made visible to the customer if you enable them using the toggle bar on the Additional Comments field.  |
  6. Add Work Notes: Add your work notes on the incident.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RELATED tab</td>
<td>View the related lists of the incident, such as, child incidents, task SLAs, impacted services, and affected CIs. Tap on the arrow to view more details of these related items.</td>
</tr>
<tr>
<td>CALLS tab</td>
<td>View the list of all the calls related to an incident. Tap on any of the calls to Add participants or to Join call. Tap on the menu on top of the Conference Call page and tap End call to end the call.</td>
</tr>
</tbody>
</table>

**Change tasks**

View and work on the change tasks assigned to you. You can view the details, activities, and other related change tasks by a single tap on the ITSM mobile agent app.

Tap on the card to access all the change tasks assigned to you.

1. You can filter the list according to your set criteria.
2. Swipe left to add comments to the task or close the task.
3. On the Change Tasks screen, tap on any task to view the details, activity and related change tasks. You can add comments or close a task from this screen.

**Note:** Each change task card shows you the risk value of the task. For example, very high, or moderate.

**Filter records**

Set additional filters to limit the number of records that are displayed on a screen. Filtering records in the mobile app works like filtering with a condition builder on the Now Platform.

Role required: itil or group manager

1. To further refine your search results, or to enter additional filter criteria on any list of records that is displayed, tap the filter icon.
2. On the Filters screen that appears, tap the arrow on a field to expand it.
3. From the options available, tap the check box or tap an option for your filter. For many of the filters, you can select more than one option.
4. Tap the Back icon or DONE to save your changes to a field.

The criteria you chose displays on the Filters screen. The number of records that match your criteria also display on the top of the screen. Tap Clear or RESET to remove any filters and restore the default setting.

5. Optional: Repeat steps 1-4 with the Filters screen displayed to continue setting your filter criteria.
6. Tap the intersection union after you set all criteria to create AND conditions.
Alternatively, tap the union icon to create OR conditions.

7. After you have added all the criteria you want, tap DONE. The incident records that match your filter criteria display on the screen.

View catalog tasks

View a catalog task and add comments to it as part of the catalog item fulfillment.

Tap on the card to access all the catalog tasks assigned to you.

1. You can filter the list according to your set criteria.
2. Swipe left to add comments or close the task.
3. On the Catalog tasks screen, tap on any task to view the details or activity of the catalog task. You can only add comments from this screen.

Filter records

Set additional filters to limit the number of records that are displayed on a screen. Filtering records in the mobile app works like filtering with a condition builder on the Now Platform.

Role required: itil or group manager

1. To further refine your search results, or to enter additional filter criteria on any list of records that is displayed, tap the filter icon.
2. On the Filters screen that appears, tap the arrow on a field to expand it.
3. From the options available, tap the check box or tap an option for your filter. For many of the filters, you can select more than one option.
4. Tap the Back icon or DONE to save your changes to a field. The criteria you chose displays on the Filters screen. The number of records that match your criteria also display on the top of the screen. Tap Clear or RESET to remove any filters and restore the default setting.
5. Optional: Repeat steps 1-4 with the Filters screen displayed to continue setting your filter criteria.
6. Tap the intersection union after you set all criteria to create AND conditions.
7. Alternatively, tap the union icon to create OR conditions.

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The incident records that match your filter criteria display on the screen.

Mobile On-Call Scheduling

As a member of a shift, view your upcoming shifts, request time off, and accomplish daily tasks related to your schedule.

My work application in the mobile agent app has the On-Call Scheduling applet to access your upcoming shifts and time-off requests of members of your team.

On-call schedule actions- Upcoming shifts

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap on <strong>Upcoming shifts</strong></td>
<td>View all upcoming shifts for the current month.</td>
</tr>
<tr>
<td>Swipe left on the shift card</td>
<td>Request time off for the shift.</td>
</tr>
<tr>
<td>Tap on the shift card</td>
<td>View details for the shift like the group, roster, start time, and end time.</td>
</tr>
<tr>
<td>Tap <strong>Request time-off</strong></td>
<td>Request time off for the shift.</td>
</tr>
<tr>
<td>Tap the icon.</td>
<td>Changes the view of the calendar from monthly to daily.</td>
</tr>
</tbody>
</table>

On-call schedule- Time-off requests

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap on <strong>Time-off requests</strong></td>
<td>View a list of time-off requests divided into pending and completed requests.</td>
</tr>
<tr>
<td>Tap the filter icon</td>
<td>Filter the time-off requests.</td>
</tr>
<tr>
<td>Tap the menu icon</td>
<td>Request time off from the Time-off requests screen.</td>
</tr>
<tr>
<td>Tap a pending time-off request</td>
<td>View the details of the request.</td>
</tr>
<tr>
<td>Tap <strong>Cancel time-off</strong></td>
<td>Cancel the time-off request by clicking YES on the confirmation message.</td>
</tr>
</tbody>
</table>

On-call schedule- Who is on-call

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap on <strong>Who is on-call</strong></td>
<td>View a form that lets you select a group from a list of groups.</td>
</tr>
<tr>
<td>Tap the right arrow</td>
<td>View the list of groups that should be on-call in a schedule.</td>
</tr>
<tr>
<td>Select a group</td>
<td>Select a group from the list of groups and click the arrow to view who is on-call for the schedule.</td>
</tr>
</tbody>
</table>

My Team

Easily access and get insights into the work of the groups you are managing.
With the My Team applet, as a group manager you can:

- Easily access unassigned incidents from your group and quickly triage work
- Act upon time-off requests submitted by your team
- Review any On-call conflicts or gaps in a schedule and plan for appropriate coverage
- Access dashboards to gain insights like MTTR, CSAT, and so on for your groups.

**My team dashboard**

As a group manager, with the My team dashboard, gain insights into the data like incidents at risk, breached incidents or overdue changes.

Tap on the sections to process the incidents.
My team dashboard

0
Incidents at risk

4
Breached incidents

29
Overdue changes

Unassigned incidents

2 - High
INC0002001
Unable to access company portal
State New
Caller Christen Mitchell

2 - High
Unable to edit $spreadsheet
State New
**Overdue changes**

Work on the overdue changes of your team

1. On the My team dashboard, tap on **Overdue changes** on the applet. The **Overdue changes** screen opens with a list of the changes.
2. If you want to reduce the number of records on the screen, see **Filter records** to search for records that match specific search criteria.
3. On the **Overdue changes** screen with the list of incidents, swipe left on an incident to open the menu.
4. On the menu, choose one of the actions to process the incident.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add comments</td>
<td>Add work notes about the change in this field and tap <img src="image" alt="button" /> to submit.</td>
</tr>
<tr>
<td>Cancel change</td>
<td>Use this action to cancel the change. Provide a reason on the <strong>Reason</strong> field and tap <img src="image" alt="button" /> to submit.</td>
</tr>
</tbody>
</table>

5. On the **Overdue changes** screen, tap a record on the list to open it and view more details.
6. On the **Change request** screen choose one of the actions in the table as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| DETAILS tab     | Choose one to continue.  
• View the fields for details about the incident. The fields with an arrow have additional information.  
• Add any additional comments using the **Add comments** button.  
• Use this action to cancel the change. Provide a reason on the **Reason** field and tap ![button](image) to submit. |
| PLANNING tab    | View all the planning details like the implementation plan, risk and impact analysis and backout plan for the change on this screen |
| Calls           | View the list of all the calls related to an incident. Tap on any of the calls to **Add participants** or to **Join call**. |

**Unassigned incidents**

Use the Unassigned incidents applet to assign, reassign, edit or promote to a major incident.
Role required: group manager

1. On the My team landing screen, tap See All on the Unassigned incidents applet. The Unassigned Incidents screen opens with a list of incidents.

2. If you want to reduce the number of records on the screen, see Filter records to search for records that match specific search criteria.

3. On the Unassigned incidents screen with the list of incidents, swipe left on an incident to open the menu.
Unassigned incidents

Can't access SFA software
State: New
Caller: Bud Richman

VPN not working
State: New
Caller: Tyree Courrège

The team file share is not accessible
State: New
Caller: Rick Berzle
4. On the menu, choose one of the actions to process the incident.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add comments</td>
<td>Add any additional comments or work notes about the incident in this field and tap.</td>
</tr>
<tr>
<td>Assign to me</td>
<td>Use this action to assign an incident to yourself.</td>
</tr>
<tr>
<td>Assign</td>
<td>On the Assign incident screen, tap the Assignment group field to change the assignment group, select the agent from the list in the Assigned to field and add any notes in the Work notes and tap to submit.</td>
</tr>
</tbody>
</table>

5. On the Unassigned incidents screen, tap a record on the list to open it and view more details.

6. On the Unassigned Incidents screen as shown in the following figure, choose one of the actions in the table as appropriate.
Add memory to laptop

State New

Caller Carol Coughlin

Description
I've installed the editing software and the memory in my laptop is insufficient to run it effectively.

Caller
Carol Coughlin

Category
Hardware

Subcategory
Memory

Service

Configuration item
IBM-T42-DLG
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Details tab** | Choose one to continue.  
  - View the fields for details about the incident. The fields with an arrow have additional information.  
  - At the top right of the screen, tap the menu icon to reassign, assign, edit or propose the incident as a major incident.  
  - Add any additional comments using the **Add comments** button.  
  - Use the **Assign to me** button to assign the incident to yourself.  
  - Once assigned to you, resolve the incident after adding a resolution code and notes using the **Resolve** button.|
| **Activity tab** | View the activity on the incident like field changes or assignment changes. Tap the add icon to perform any of the following activities on the incident.  
  1. **Record Video**: Record a video to be attached to the incident.  
  2. **Open Gallery**: Open your photo gallery to attach an existing image or a video to the incident.  
  3. **Take Photo**: Take a picture and attach it to the incident  
  4. **Attach File**: Attach a file from another application to the incident.  
  5. **Add Additional Comments**: Add any additional comments to the incident.  
  **Note**: The comments can be made visible to the customer if you enable them using the toggle bar on the **Additional Comments** field.  
  6. **Add Work Notes**: Add your work notes on the incident.|
<p>| <strong>Related tab</strong> | View the related lists of the incident, such as, child incidents, task SLAs, impacted services and affected CIs. Tap on the arrow to view more details of these related items. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calls</td>
<td>View the list of all the calls related to an incident. Tap on any of the calls to Add participants or to Join call</td>
</tr>
</tbody>
</table>

**Mobile My team On-Call Scheduling**

As an On-Call Scheduling manager, view your team’s schedule and perform activities like approving time-off requests and providing coverage.

**On-call schedule actions: Upcoming shifts**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap Upcoming shifts</td>
<td>View all upcoming shifts for the current month.</td>
</tr>
<tr>
<td>Swipe left on the shift card</td>
<td>Request time off for this shift.</td>
</tr>
<tr>
<td>Tap the shift card</td>
<td>View details for the shift (like group, roster, start time, and end time).</td>
</tr>
<tr>
<td>Tap Request time-off</td>
<td>Request time off for this shift by providing information on the Request time-off screen.</td>
</tr>
<tr>
<td>Tap Provide Coverage</td>
<td>Provide coverage for a shift member.</td>
</tr>
</tbody>
</table>

**On-call schedule: Time-off requests**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap Time-off requests</td>
<td>View a list of time-off requests divided into pending and completed requests.</td>
</tr>
<tr>
<td>Tap the filter icon</td>
<td>Filter the time-off requests using filters like End date or group.</td>
</tr>
<tr>
<td>Tap the menu icon</td>
<td>Request time off on the Time-off requests screen.</td>
</tr>
<tr>
<td>Tap a pending time-off request</td>
<td>View details of the request.</td>
</tr>
<tr>
<td>Tap Approve or Reject</td>
<td>Approve or reject a time-off request.</td>
</tr>
</tbody>
</table>

*Note:* Add a reason for rejection of a time-off request.

**On-call schedule: Gaps and conflicts**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap Gaps and conflicts</td>
<td>View a list of all the gaps and conflicts for the shifts in your group.</td>
</tr>
<tr>
<td>Tap any day of the month</td>
<td>View all gaps and conflicts for shifts on that day.</td>
</tr>
<tr>
<td>Tap any of the shift cards</td>
<td>View gaps and conflicts for the shift.</td>
</tr>
<tr>
<td>Swipe left on any of the shift cards</td>
<td>Tap Provide coverage to provide coverage for the shift.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Tap <strong>Provide Coverage</strong></td>
<td>Provide coverage for a gap in the shift.</td>
</tr>
</tbody>
</table>

**Performance metrics**

Access the performance data of your team directly from your mobile with the ITSM Agent mobile app.

As a group manager, with the My team dashboard, gain insights into the work of the groups you are managing by accessing metrics like MTTR (Mean Time To Resolution), CSAT, breached SLAs and so on.

Also view the graphical representation of the incidents raised in a week.
Performance metrics

Apr 02

Mean Time to Resolve (MTTR)
Since Apr 01

Apr 02

Customer Satisfaction (CSAT)
Since Apr 01

Feb 17

100.00%

Service Level Agreement (SLA)
▲ 15.79 (18.8%) Since Feb 16

My team’s weekly opened incidents
**Major incidents**

As a major incident manager you can quickly review active major incidents or proposed major incidents and act upon them.

As a major incident manager, you can also view and access the ongoing conference calls for current major incidents with the ability to start, join or end conference calls.

The major incident application contains the applets and folders as in the below table.

<table>
<thead>
<tr>
<th>Major incident management applets</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active major incidents</td>
<td>View, filter and act upon active major incidents.</td>
</tr>
<tr>
<td>Major incident candidates</td>
<td>Review the incidents that are proposed as major incidents and add comments.</td>
</tr>
<tr>
<td>Resolved major incidents</td>
<td>View resolved major incidents and add comments.</td>
</tr>
<tr>
<td>Major incident dashboard</td>
<td>Gain insights on the major incidents worked on by your group, like number of major incidents, Mean time to identify, and mean time to resolve.</td>
</tr>
<tr>
<td>Performance metrics</td>
<td>View a non-interactive graph of major incidents opened per week.</td>
</tr>
</tbody>
</table>

**Active major incidents**

View a list of related incidents, details of a major incident and activities on an incident.

Role required: major incident manager

1. On the Agent landing screen, tap **See All** on the **Active major incidents** applet. The **Active major incidents** screen opens with a list of major incidents.
2. If you want to reduce the number of records on the screen, see **Filter records** to search for records that match specific search criteria.
3. On the **Active major incidents** screen with the list of incidents, swipe left on an incident to open the menu.
4. Tap **Add comments** to add any additional comments or work notes about the incident in this field and tap.
5. Tap **Resolve** to resolve the major incident by adding the **Resolution code** and **Resolution notes**.
6. On the **Active major incidents** screen, tap a record on the list to open it and view more details.
7. You can also use the menu at the top of the screen for quick actions. The quick actions available for an active major incident are:
   - Assign to someone: Assign the major incident to someone in an appropriate assignment group.
- Resolve: Add a resolution code and resolution notes and tap the
  ![Resolution icon] to resolve the incident.
- Add comments: Add any additional comments or work notes for the major incident and tap the
  ![Comment icon] to add these comments to the record.

8. On the Active major incident screen, choose one of the actions in the table as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DETAILS tab</td>
<td>View the fields for details about the incident. The fields with an arrow have additional information.</td>
</tr>
<tr>
<td>ACTIVITY tab</td>
<td>View the activity on the incident like field changes or assignment changes. Tap the add icon ![Add icon] to perform any of the following activities on the incident.</td>
</tr>
<tr>
<td>1. Record Video: Record a video to be attached to the incident.</td>
<td></td>
</tr>
<tr>
<td>2. Open Gallery: Open your photo gallery to attach an existing image or a video to the incident.</td>
<td></td>
</tr>
<tr>
<td>3. Take Photo: Take a picture and attach it to the incident</td>
<td></td>
</tr>
<tr>
<td>4. Attach File: Attach a file from another application to the incident.</td>
<td></td>
</tr>
<tr>
<td>5. Add Additional Comments: Add any additional comments to the incident.</td>
<td></td>
</tr>
<tr>
<td>Note: The comments can be made visible to the customer if you enable them using the toggle bar on the Additional Comments field.</td>
<td></td>
</tr>
<tr>
<td>6. Add Work Notes: Add your work notes on the incident.</td>
<td></td>
</tr>
<tr>
<td>TASKS tab</td>
<td>View the list of all the tasks associated with the incident. Swipe left on an associated task to Close task or Snooze for a later time.</td>
</tr>
<tr>
<td>RELATED tab</td>
<td>View the related lists of the major incident, such as, child incidents, impacted services, outages, and affected CIs. Tap on the arrow to view more details of these related items.</td>
</tr>
</tbody>
</table>

Major incident candidates

View a list of major incident candidates and add comments to the incidents proposed as major incidents.
Review and work on a major incident candidate

View a list of major incident candidates and add comments to the incidents proposed as major incidents.

Role required: major incident manager

1. On the Agent landing screen, tap See All on the Major incident candidates applet. The Major incident candidates screen opens with a list of major incident candidates.

2. If you want to reduce the number of records on the screen, see Filter records to search for records that match specific search criteria.

3. On the Major incident candidates screen, swipe left on an incident to view the set of quick actions.
   a) Add any additional comments or work notes about the incident in this field and tap

   ![Add comment]

   b) Tap Reject, mention the reasons for rejection in the work notes and tap

   ![Reject]

   to process the rejection.

   c) Tap Promote, mention a reason to promote the incident to a major incident, describe the business impact, and tap

   ![Promote]

4. On the Major incident candidates screen, tap a record on the list to open it.

5. You can also use the menu

   ![Menu]

   at the top of the screen for quick actions. The quick actions available for an active major incident candidate are:
   - Assign to me: Tap on this quick action to assign the major incident candidate to yourself. You can use the Reject or Promote buttons for an appropriate action.
   - Assign to someone: Assign the major incident to someone in an appropriate assignment group.
   - Resolve: Add a resolution code and resolution notes and tap the

   ![Resolve]

   to resolve the incident.
   - Add comments: Add any additional comments or work notes for the major incident and tap the

   ![Add comments]

   to add these comments to the record.

6. On the Major incident candidates screen, as shown in the following figure, choose one of the actions in the table as appropriate.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DETAILS tab</td>
<td>View the fields for details about the incident. The fields with an arrow have additional information.</td>
</tr>
</tbody>
</table>
| ACTIVITY tab        | View the activity on the incident like field changes or assignment changes. Tap the add icon to perform any of the following activities on the incident.  
  1. **Record Video**: Record a video to be attached to the incident.  
  2. **Open Gallery**: Open your photo gallery to attach an existing image or a video to the incident.  
  3. **Take Photo**: Take a picture and attach it to the incident  
  4. **Attach File**: Attach a file from another application to the incident.  
  5. **Add Additional Comments**: Add any additional comments to the incident.  
  
| Note: The comments can be made visible to the customer if you enable them using the toggle bar on the Additional Comments field. |
| RELATED LIST tab    | View the related lists of the major incident, such as, child incidents, impacted services, outages, and affected CIs. Tap on the arrow to view more details of these related items. |

**Major incident dashboard**

Review major incident information at a glance on your mobile.

The dashboard in the Major incidents application provides the information about the count of major incidents, mean time to identify an incident as a major incident and mean time to resolve.
Major incident dashboard

Nov 21

3

Number of Major Incidents
0 (0.0%) Since Nov 21

Nov 21

Mean Time to Identify
Since Nov 21

Nov 21

1.26 Hrs

Mean Time to Resolve
0.00 (0.0%) Since Nov 21

Major Incidents Opened per Week

My work  My team  Major Incidents  Notification  Settings
Domain Separation and ITSM Mobile Agent

This is an overview of domain separation and ITSM Mobile Agent. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Basic

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

Overview

The mobile platform supports domain separation for all native clients. The mobile UI design clearly indicates the domain that a record is associated with.

Before extending the domain separation functionality to mobile, the feature must be enabled on the platform web-based interface. For further information on configuration, see Domain separation setup and administration.

How domain separation works in mobile

You can use the company or account fields to display appropriate records by domain. These fields are available in tables when the domain separation plugin is enabled. Because each company or account is linked to a single domain, when you create a record, you can use these fields to specify the domain in which you want to create the record.

After the feature has been set up through the platform web-based interface, a two-part process is required to further extend the domain separation functionality on mobile. For additional information about configuring domain separation on mobile devices, contact ServiceNow Technical Support.

Domain separated tables

- Incident (incident)
- Incident Task (incident_task)
Use cases

- An ESS user belonging to “Initech” domain, creates an incident. Only those ITIL users belonging to “Initech” domain or global domain can see this incident.
- An ITIL user belonging to a parent domain can see incidents of all its child domains as well.
- An ITIL user belonging to a specific domain can create incidents only on behalf of the domains that they have access to.
- An ITIL user can associate child incidents only of those domains that they have access to.
- If a user has access to multiple domains, the domain specified on the current record drives the functionality of that record and reference fields.

Enable push notification categories

Enable push notification categories so your users can enable or disable notifications by category.

Role required: admin

1. Type `sys_properties.list` in the application navigator.
2. In the system properties list, find and open the property with the name `com.glide.sg.notifications.management`.

   Note: If the property does not exist, click New and create a true I false property with the name in the previous step. After changing this property, users must log out and back in for the change to take effect.

3. In the Value field, enter true.
4. Click Update.
The user can enable or disable notifications by category. The categories shown in the notification preferences screen are defined in the **Notifications** (syseven_email_action) table. The screen to the left shows all the reference categories defined on this table. The screen to the right shows the record matching the selected category.

After you have updated your system property, your users will be able to enable or disable notifications by the defined categories. For information on how users perform these tasks see *Manage push notifications for mobile*.

**Configurable actionable notifications for ITSM Mobile Agent**

With configurable actionable notifications for ITSM Mobile Agent, you can perform actions based on push notifications without having to open the ITSM Mobile Agent application.

You can associate up to three actions with a push notification. These actions must refer to an existing mobile function. The following function types of actions are supported:

- Action item
- Navigation
- URL
- Chat launcher
Process for creating actionable push notifications

Create actionable push notifications using the following process:
1. Create an actionable push notification for ITSM Mobile Agent.
2. Create a push action category.
3. Create function for each push action.
4. Map functions with push actions on the actionable push notification.
5. Create push message content.
6. Create a standard notification.

Create an actionable push notification for ITSM Mobile Agent

Create a push notification for various actions performed on the ITSM Mobile Agent application.
Role required: admin
2. Click **New**.
3. In the push notification form, fill in the fields.

**Push notification form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>The name of your push notification.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This name does not appear to users viewing the notification.</td>
</tr>
<tr>
<td><strong>Application</strong></td>
<td>The scoped application for your notification. This field automatically uses the current application scope.</td>
</tr>
<tr>
<td><strong>Actionable</strong></td>
<td>Option for making a notification actionable.</td>
</tr>
<tr>
<td><strong>Screen</strong></td>
<td>Optional screen associated with your notification. Displays to a user when they tap on the notification.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

The notification record is created, and the **Push Action Instances** related list appears on the form.

### Create a push action category

Create a push action category if any of the pre-defined push action categories do not meet the business requirements.

Role required: admin

1. Navigate to **System Mobile > Mobile Push Notifications > Push Action Categories**.

**Push action categories**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>accept-reject-back</td>
<td>Displays <strong>Accept</strong> and <strong>Reject</strong> buttons. Users can select an option without opening the app.</td>
</tr>
<tr>
<td>Accept-Reject-fore</td>
<td>Displays <strong>Accept</strong> and <strong>Reject</strong> buttons. The app opens when the user selects an action.</td>
</tr>
<tr>
<td>accept-rejectwcomments-back</td>
<td>Displays <strong>Accept</strong> and <strong>Reject</strong> buttons. When users select the <strong>Reject</strong> option, a confirmation dialog box appears that requires the user to provide a message and click Send.</td>
</tr>
<tr>
<td>ack-escalate-ignore-back</td>
<td>Displays <strong>Acknowledge</strong>, <strong>Escalate</strong>, and <strong>Ignore</strong> buttons. Users can select an option without opening the app.</td>
</tr>
<tr>
<td>approve-reject-back</td>
<td>Displays <strong>Approve</strong> and <strong>Reject</strong> buttons. Users can select an option without opening the app.</td>
</tr>
<tr>
<td>approve-rejectwcomments-back</td>
<td>Displays <strong>Approve</strong> and <strong>Reject</strong> buttons. When users select the <strong>Reject</strong> option, a confirmation dialog box appears that requires the user to provide a message and click Send. Users can select an option without opening the app.</td>
</tr>
<tr>
<td>confirm-reschedule-cancel-back</td>
<td>Displays <strong>Confirm</strong>, <strong>Reschedule</strong>, and <strong>Cancel</strong> buttons. Users can select an option without opening the app.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>joinbridge-fore</td>
<td>Displays a Join Meeting button. Tapping this button opens the app.</td>
</tr>
<tr>
<td>PromoteWComments-RejectWComments-fore</td>
<td>Displays Promote and Reject buttons. When users select either option, a confirmation dialog box appears that requires the user to provide a message and click Send.</td>
</tr>
<tr>
<td>queueerejoin-openincident-back</td>
<td>Displays Online Check-in and Open Incident buttons. Users can select an option without opening the app.</td>
</tr>
<tr>
<td>queuestay-queueleave-back</td>
<td>Displays Stay in Queue and Leave Queue buttons. Users can select an option without opening the app.</td>
</tr>
<tr>
<td>yes-no-back</td>
<td>Displays Yes and No buttons. Users can select an option without opening the app.</td>
</tr>
</tbody>
</table>

2. Click New.
3. In the push action category form, enter a name for the category in the **Name** field.
4. Click the lock icon next to the **Actions** field.
5. Click the reference icon to display the **Push Actions** list and select the actions for the push action category.
6. Click **Save**.

**Create a push action**

Create a push action if any of the pre-defined push actions do not meet the business requirements.

Role required: admin

1. Navigate to System Mobile > Mobile Push Notifications > Push Actions.
2. Click **New**.
3. In the push action form, fill in the fields.

**Push action form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Text your users will see in the notification for this action.</td>
</tr>
<tr>
<td>Application</td>
<td>Scoped application for this record. This field automatically populates.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the push action.</td>
</tr>
<tr>
<td>Foreground</td>
<td>When enabled, the app opens when your users select this action.</td>
</tr>
</tbody>
</table>
Create functions for notification push actions

Create a mobile function for each function in the action category. These actions perform tasks on your instance based on what the user selects in the notification.

Role required: admin

1. Navigate to System Mobile > Functions.
2. Click New to create a new function record.
3. Create a function for one of your push actions.
   a) When selecting a function type in the Type field, you must select one of the function types supported for actionable push notifications:
      - Action item
      - Navigation
      - URL
      - Chat launcher
   
   For information on function types, and detailed steps for creating functions, see Mobile functions.

4. Create additional functions for each push action.
   For example, if you have selected ack-escalate-ignore-back as your push notification category, your notification displays the Acknowledge, Escalate, and Ignore buttons. Create a function to determine the behavior of each of these buttons.

Map functions with push actions for actionable push notifications

Map functions with push actions for actionable push notifications

Associate functions to the actions for an actionable push notification.

Role required: admin

2. Open a notification.
3. In the Push Action Instances related list, click New.
4. On the form, fill in the fields.

Push action instance form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Push Notification</td>
<td>Push notification associated with this push action instance. This field is automatically filled in with your push notification.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Application</td>
<td>Scoped application associated with this record. This field is automatically filled in with the current application.</td>
</tr>
<tr>
<td>Push Action</td>
<td>Push action from your push notification record. Select one of the available actions.</td>
</tr>
<tr>
<td>Button</td>
<td>Function to associate with the push action. This action triggers when a user uses the action listed in the Push Action field.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

This example notification uses the `accept-rejectwcomments-back` in the **Category** field. Clicking the preview icon shows the two actions used by this category: **Accept** and **Reject**.

In the example push action instance, the **Approve** push action is selected in the **Push Action** field, and the **Approve REQ /w comments** function is selected in the **Button** field. The instance executes this function when a user taps the **Approve** button in the notification.
Create push message content
Create the content of the message to be displayed as a notification.
Role required: admin
2. Open the notification.
3. Click Create Push Message Content in the Related Links section.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your push message content record. This name is not visible to your users.</td>
</tr>
<tr>
<td>Application</td>
<td>Scoped application associated with this record. This field is automatically filled in with the current application.</td>
</tr>
<tr>
<td>Push app</td>
<td>Mobile Agent app on which the push notification is displayed.</td>
</tr>
<tr>
<td>Push Message Generation</td>
<td>The script that generates the push notification. When you create message content, this script is automatically generated.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Create a standard notification
Create a record to determine the information to be displayed for a notification.
Role required: admin

1. Navigate to **System Notification > Push > Create Push Notification.**
2. On the form, fill in the fields.

### Push notification form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your notification. This name is not visible to your users.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for determining whether the notification is active. The instance does not send inactive notifications to your users.</td>
</tr>
<tr>
<td>Table</td>
<td>Table containing the records relating to your notification. For example, notifications about new incidents use the Incident (incident) table.</td>
</tr>
<tr>
<td>Push Message Only</td>
<td>Indicates the notification is a push message only. This field cannot be changed.</td>
</tr>
<tr>
<td>Category</td>
<td>The category for your notification. This field value is <strong>Uncategorized</strong> by default.</td>
</tr>
</tbody>
</table>

3. Right-click the form header and select **Save.**
4. Configure the push message for your standard notification.
   a) Click to display the **What to Send** tab.
   b) Click the lock icon  
   ![lock_icon](image)
   next to the **Push Messages** field.
   c) Click the reference icon  
   ![reference_icon](image)
   to display the **Push Notification Messages** list.
   d) Click **New.**
   e) On the form, fill in the fields.

### Push Notification Message form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your push notification message record. This name is not visible to your users.</td>
</tr>
<tr>
<td>Application</td>
<td>Scoped application associated with this record. This field defaults to the current application.</td>
</tr>
<tr>
<td>Push App</td>
<td>Mobile Agent app on which the push notification is displayed.</td>
</tr>
<tr>
<td>Table</td>
<td>Table containing the records relating to your notification. For example, a notification about new incidents would use the Incident (incident) table.</td>
</tr>
<tr>
<td>Push Message Content</td>
<td>The record for the push message content.</td>
</tr>
</tbody>
</table>
5. In the Notification form, click Update.

**Settings**

View the information related to the settings of your ITSM Agent mobile app.

You can adjust the settings of the ITSM Agent mobile app. The following information is available in the Settings screen of your app.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance</td>
<td>Name of the app version</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the app</td>
</tr>
<tr>
<td>Security</td>
<td>If the administrator has set authentication requirements, enter the secure credentials in the field.</td>
</tr>
<tr>
<td>Analytics</td>
<td>Enable the analytics of the app usage</td>
</tr>
<tr>
<td>Legal</td>
<td>Read the privacy policies, Open source licence information and End user licence agreement</td>
</tr>
<tr>
<td>Logout</td>
<td>Logout from the instance</td>
</tr>
</tbody>
</table>

**Creating an incident in Microsoft Outlook**

To create incidents and VTB tasks or to chat with a virtual agent from within your Outlook email, activate and deploy the ServiceNow Add-in for Microsoft Outlook feature.

The ServiceNow Add-in for Microsoft Outlook feature lets you engage with IT directly from an email or, for IT users, quickly create an incident from an email and immediately assign it to the correct team. It also lets you create a VTB task.

**Activate the ServiceNow Add-in for Microsoft Office**

You can activate the ServiceNow Add-in for Microsoft Office plugin (com.sn_outlook_addin) if you have the admin role.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.
Deploy the ServiceNow Add-in for Microsoft Outlook

Deploy the ServiceNow add-in for Microsoft Outlook to chat with a virtual agent, create incidents and VTB tasks from within the Microsoft Outlook.

In addition to having one of the following roles on the ServiceNow instance, you must be an Office365 administrator to deploy the ServiceNow add-in.

Role required: admin, sn_outlook_addin.outlook_addin_setup

Deploy the ServiceNow add-in to Microsoft Outlook using the instructions in this Microsoft article: Publish Office Add-ins using Centralized Deployment via the Office 365 admin center

**Note:** You must be an Office365 administrator to deploy the ServiceNow add-in.

The ServiceNow add-in is only supported for use with Outlook for Mac and Outlook for Windows (Requirement set 1.4).

You can add or remove fields directly on the Incident form for users with the itil role by customizing the Outlook view form layout. For users that do not have the itil role, you can configure a Service Catalog record producer to use for creating new incidents.

1. Navigate to **ServiceNow Add-Ins for Office > Office Add-In Manifests**.
2. Click **New** on the **Office Manifests** page.
3. Fill in the form fields.

<table>
<thead>
<tr>
<th><strong>Deploy MS Outlook add-in form fields</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Add-in Name</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Plugin ID</td>
</tr>
<tr>
<td>Version</td>
</tr>
<tr>
<td>Icon URL</td>
</tr>
<tr>
<td>Active</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Note:** The Office Controls related list shows the menu and menu items associated with the add-in.
5. Click **Download Manifest** to download the add-in manifest file and follow the instructions in the Microsoft article for deployment. Microsoft article: *Publish Office Add-ins using Centralized Deployment via the Office 365 admin center page.*

6. Optionally, you can also customize the add-in by clicking **Clone Manifest** from the context menu. This option clones the current manifest into a new record that allows customizing the labels, icons, menus, and menu items.

7. To customize the Incident form for users with the itil role, configure the Incident form layout directly.
   a) Click the context menu (…) on the form and select **View > Outlook**.
   b) Click the context menu again and select **Configure > Form Layout**.
   c) Add or remove fields, as needed.

8. To customize the Incident form for users that do not have the itil role, use a Service Catalog record producer to configure the Incident form.
   a) Navigate to **Service Catalog > Record Producers**.
   b) Right-click the record producer to use for creating new incidents and select **Copy sys_id**.
   c) Paste the copied sys_id into the **Value** field of the **Provide sys_id of the record producer for create incident action from Outlook Add-In (sn_outlook_addin.create_incident_cat_item)** system property.

---

### Use the ServiceNow Add-in for Microsoft Outlook

Create an incident or VTB task or chat with a virtual agent directly from within Microsoft Outlook using ServiceNow icons.

**Role required**: none

1. On the Microsoft Outlook Home tab, click the **ServiceNow** icon (…) and select **Create Incident** or **Create VTB Task**.

2. In the ServiceNow IT Service Management pane, click **Login** and enter your ServiceNow credentials.
   You may need to reauthenticate if your session has expired.

3. For an incident record, fill in the following fields and click **Submit**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Auto-generated incident number.</td>
</tr>
<tr>
<td>Caller</td>
<td>Current logged in user (default).</td>
</tr>
<tr>
<td>Short description</td>
<td>Subject of the current email (default).</td>
</tr>
<tr>
<td>Additional comments</td>
<td>Email body in text format (default).</td>
</tr>
</tbody>
</table>
You can add or remove fields directly on the Incident form for users with the ITIL role by customizing the Outlook view form layout.

Note: For users that do not have the ITIL role, the configured Service Catalog form for creating new incidents is shown.

4. For a task record, see fill in the following fields and click Create.

VTB Task form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Board</td>
<td>VTB board to which task belongs.</td>
</tr>
<tr>
<td>Select Lane</td>
<td>Lane of the VTB board.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Short description of the task.</td>
</tr>
</tbody>
</table>

5. To chat with a virtual agent, select the Chat with Virtual Agent UI action. A chat window opens as a pane. You can begin the virtual chat regarding your requests.

On-Call Scheduling

On-Call Scheduling provides a way to determine which member of a user group is available to complete a task, for example to find the right person to assign an incident.

The On-Call Scheduling application helps you to ensure that dedicated support team members are available to resolve issues as they arise. You can set up on-call schedules, roster rotations, and escalation policies, escalate notifications for a group, and determine the current contact for an escalation.

Explore
- On-Call Scheduling concepts
- Domain separation and On-Call Scheduling

Set up
- Activate On-Call Scheduling
- Configure or update an On-Call schedule
- Configure or update an On-Call shift
- On-call properties
- Setting up Slack as a contact method
- Configure contact preferences

Administer
- Define an escalation trigger rule
- Escalations in On-Call Scheduling
- System properties for On-Call Scheduling

Use

Develop

Integrate
Activate On-Call Scheduling

You can activate the On-Call Scheduling (com.snc.on_call_rotation) plugin if you have the admin role.

Activating the On-Call Scheduling plugin activates the following third-party libraries:

- Subscription-based notifications
- Advanced Schedules support
- NG shared components
- ServiceNow common calendar
- Fullcalendar library

**Note:** The On-Call Scheduling plugin (com.snc.on_call_rotation) is active by default for zBoot customers.

1. Navigate to **System Applications > All Available Applications > All.**
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin.**
3. Click **Install,** and then in the Activate Plugin dialog box, click **Activate.**

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, they will receive the following error: **Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.**

Tables installed with On-Call Scheduling

On-Call Scheduling adds the following tables.
### Tables installed with On-Call Scheduling

**Note:** Tables with prefix "v_" such as (v_alternate_rotation) are view-only tables used for generating on-call reports. Do not use these tables to create reports.

<table>
<thead>
<tr>
<th>Display name (Table name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-call Member (cmn_rota_member)</td>
<td>Table of group members that are participating in the on-call schedule and escalations.</td>
</tr>
<tr>
<td>Roster (cmn_rota_roster)</td>
<td>Table that holds the members of the shift, the shift interval, and escalation settings.</td>
</tr>
<tr>
<td>Shift (cmn_rota)</td>
<td>The table that holds the on-call schedule for a shift.</td>
</tr>
<tr>
<td>Roster Schedule Span (roster_schedule_span)</td>
<td>Table that contains the schedule span definitions. On-Call Scheduling adds a group reference and the On-call type to the Type field.</td>
</tr>
<tr>
<td>Trigger Rule (trigger_rule)</td>
<td>Table that extends the Assignment Rule (sysrule_assignment) table and stores when the escalation process is triggered and what actions to take.</td>
</tr>
<tr>
<td>On-call Notifications (v_on_call)</td>
<td>Table that lists the reminder notifications that were sent.</td>
</tr>
<tr>
<td>Rotation Schedule (v_rotation)</td>
<td>Table that lists shift schedules by start date and time and includes user contact information, if available.</td>
</tr>
<tr>
<td>User Rotation Schedule (v_user_rotation)</td>
<td>Table that lists the shift schedule by user.</td>
</tr>
<tr>
<td>Alternate Rotation Schedule (v_alternate_rotation)</td>
<td>Table that lists the alternate user schedules by shift and roster and the start and end date and time stamps.</td>
</tr>
<tr>
<td>Rotation Escalation (cmn_rota_escalation)</td>
<td>Table that lists the escalations including the event and last updated time stamp.</td>
</tr>
<tr>
<td>Shift Contact Preference (cmn_rota_contact_preference)</td>
<td>Table that holds the contact preferences for default and custom escalations.</td>
</tr>
<tr>
<td>On-Call Communication Type (on_call_communication_type)</td>
<td>Table that lists the type of communication channel used.</td>
</tr>
<tr>
<td>On-Call Group Template (sys_on_call_group_template)</td>
<td>Table with information about the template used to create/edit a schedule of a group.</td>
</tr>
<tr>
<td>On-Call Shift Template (sys_on_call_shift_template)</td>
<td>Table with information about the template used to create/edit a schedule of a shift.</td>
</tr>
<tr>
<td>On-Call User Preference (on_call_user_preference)</td>
<td>Table with information on a member's preferences.</td>
</tr>
<tr>
<td>On-Call User Contact Preference (on_call_user_contact_preference)</td>
<td>Table with information on a member's contact preferences.</td>
</tr>
<tr>
<td>(sys_on_call_contact_source)</td>
<td>Table that lists the contact sources and devices.</td>
</tr>
<tr>
<td>Display name (Table name)</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>On-Call Escalation (on_call_escalation)</td>
<td>Table that records the source, group, and related details for escalation tracking.</td>
</tr>
<tr>
<td>On-Call Escalation Level (on_call_escalation_level)</td>
<td>Table that logs the escalation levels reached for an escalation and related details for escalation tracking.</td>
</tr>
<tr>
<td>On-Call Escalation Contact Attempt (on_call_escalation_con_attempt)</td>
<td>Table that logs contact attempts at an escalation level and related details for escalation tracking.</td>
</tr>
<tr>
<td>On-Call Escalation Notification (on_call_escalation_comm)</td>
<td>Table that logs both the notifications and the responses for a contact attempt and related details for escalation tracking.</td>
</tr>
<tr>
<td>On-Call Escalation Response (on_call_escalation_response)</td>
<td>Table that tracks On-Call escalation responses by On-Call workflows. Once consumed, entries are deleted by the system.</td>
</tr>
</tbody>
</table>

**Scheduled jobs installed with On-Call Scheduling**

On-Call Scheduling includes scheduled jobs.

<table>
<thead>
<tr>
<th>Schedule job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-Call Reminders</td>
<td>Sends daily reminders to on-call roster members.</td>
</tr>
<tr>
<td>On-Call Gaps Conflicts Report</td>
<td>Sends a weekly report of gaps and conflicts in on-call schedules to shift managers, group managers, and admin.</td>
</tr>
</tbody>
</table>

**Quick start tests for On-Call Scheduling**

Validate that On-Call Scheduling still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

**On-Call Scheduling**

Activate the On-Call Scheduling plugin (com.snc.on_call_rotation) to run the On-Call Scheduling quick start tests.

**On-Call: On-Call scheduling ATF Suites**

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-Call: Verify request time-off when PTO approval preferences is Not allowed</td>
<td>Verify whether you can request a time-off when PTO approval preferences is set to <strong>Not allowed</strong></td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Create overlapping shifts without selecting a template</td>
<td>Verify whether you can create overlapping shifts without selecting a template.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>On-Call: Create overlapping shifts when allow shift overlap is set to No</td>
<td>Verify whether you can create overlapping shifts when Allow overlap is set to No.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Request time-off when PTO approval preferences is with approval</td>
<td>Verify whether you can request a time-off when PTO approval preference is With approval.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Assign shift managers for maintaining on-call schedules.</td>
<td>Verify whether shift managers can maintain on-call schedules.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Search on-call schedules by user name</td>
<td>Verify whether you can search for on-call schedules by user name.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Search on-call schedules by group name or schedule name</td>
<td>Verify whether you can search for on-call schedules by group name or schedule.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Roster details for overlapping shifts with the escalation rule 'Escalate to incoming shift'</td>
<td>Verify the roster details for overlapping shifts when the escalation rule is set to Escalate to incoming shifts.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Calendar preview with timezone options</td>
<td>Verify whether the calendar preview is available with the timezone options.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Create overlapping shifts by selecting a template</td>
<td>Verify whether you can create overlapping shifts by selecting a template.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Show active shifts</td>
<td></td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Make shift draft/publish form shift form</td>
<td>Verify whether you can publish/unpublish a shift and alternate between making the rota Draft and Publish state from the form.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Roster Details for overlapping shifts with the escalation rule 'Escalate to outgoing shift'</td>
<td>Verify the roster details for overlapping shifts when the escalation rule is set to Escalate to outgoing shifts.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Roster Details for overlapping shifts with the escalation rule 'Escalate to all shifts'</td>
<td>Verify the roster details for overlapping shifts when the escalation rule is set to Escalate to all shifts.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-call: Verify On-Call workbench</td>
<td>Test to verify the On-Call workbench layout.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-call: Hide or show shifts</td>
<td>Verify whether you can hide or show shifts from On-Call calendar</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
Domain separation and On-Call Scheduling

The On-Call Scheduling application helps you to ensure that dedicated support team members are available to resolve issues as they arise. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Standard

- Includes Basic level support.
- Business logic: Processes can be created or modified per customer by the service provider (SP). The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The owner of the instance needs to be able to configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin needs to be able to make comments mandatory when a record closes for one tenant, but not for another.

Overview

- On-Call Scheduling behaves the same with domain support as it does without domain support. Customers have the same ability to create and maintain on-call shifts.
- A shift includes a selection of users from a group. It uses the base-system Advanced Schedules Support plugin to specify when the shift is active.

How domain separation works in On-Call Scheduling

With domain separation enabled, a user with the rota_admin role uses the Create New Schedule wizard to generate schedules in the group’s domain. All generated related records for the new schedule are created with a matching domain.

This setup is enforced with a combination of the domain field and the domain_master attribute. The attribute is used to derive the domain of the record from the master record. For the roster table, it derives the domain from the associated shift record.

Domain-separated tables

- Shift (cmn_rota)
- Rotation Escalation (cmn_rota_escalation)
- Shift Escalation Set (cmn_rota_escalation_set)
- Shift Escalation Step Definition (cmn_rota_esc_step_def)
- On-Call Group Preference (on_call_group_preference)
- On-Call Contact Source (sys_on_call_contact_source)
- On-Call Group Template (sys_on_call_group_template)
- On-Call Shift Template (sys_on_call_shift_template)
- On-Call Escalation (on_call_escalation)
- On-Call Escalation Level (on_call_escalation_level)
- On-Call Escalation Contact Attempt (on_call_escalation_con_attempt)
- On-Call Escalation Notification (on_call_escalation_comm)

**Tables that use the domain_master attribute**

- Roster (cmn_rota_roster): `domain_master=rota`
- Rota Member (cmn_rota_member): `domain_master=roster`
- Roster Schedule Span (roster_schedule_span): `domain_master=schedule`
- Shift Escalation Set (cmn_rota_escalation_set): `domain_master=cmn_rota`
- Shift Escalation Step Definition (cmn_rota_escalation_set): `domain_master=cmn_rota_escalation_set`
- On-Call Escalation Level (on_call_escalation_level): `domain_master=escalation`
- On-Call Escalation Contact Attempt (on_call_escalation_con_attempt): `domain_master=escalation_level`
- On-Call Escalation Notification (on_call_escalation_comm): `domain_master=contact_attempt`

To learn more, see *Domain support for schedules*

**Use cases**

For the following On-Call Scheduling features, domain separation ensures that end users (whether they possess the itil or rota_admin role) are able to see only shifts accessible via their domain:

- On-Call calendars
- On-Call schedules
- My Schedule reports
- Schedule reports
- Escalations

**Definitions of On-Call Scheduling terms**

Some terms have specific meaning in the On-Call Scheduling application.

**Shift**

A shift is the time period during which the members of a roster are on-call. You can view the details of any shift from the calendar.

**Roster**

A roster is a set of members that is on call for a shift. Because there is typically a roster for each escalation level (primary, secondary, tertiary), there are typically multiple rosters for a shift. The members of any roster are contacted in the order that is defined by the escalation policy.

**Roster members (members)**

The members of a roster are the users that have been added to a single roster. Roster members typically have the itil role. During an assigned shift, members must be available to act if notified of an escalation.

- Users must be members of the same group.
The shift manager (rota_manager role) might or might not be a roster member.

**Rotation**
Rotation is the process of exchanging the turn of duty of members of a roster.

- Members’ From and To dates determine when they are members of the roster.

**Schedule**
A schedule specifies the times that shifts are active. For example, a company that wants coverage of tasks around the clock would use a 24-7 schedule. Companies that provide support around the globe could use a follow the sun schedule to cover time zones across continents.

**Escalation**
Escalations are a series of notifications to roster members for a task. The notifications happen in the order specified by the escalation path for the shift.

**Notification**
On-Call Scheduling sends escalation notifications to members of a shift. Notification methods include email, voice, Slack, and SMS.

**Holidays and time off**
Roster members can request time off. Managers can plan for and manage holidays and requests for time off.

**Administering and managing On-Call Scheduling**
You can configure On-Call Scheduling properties, templates, trigger rules, escalation policies, rosters, and schedules.

**Tasks for the On-Call Scheduling admin**
As an on-call administrator, you can configure preferences and application behavior and create tools that improve the effectiveness of roster members and shift managers.

**Assigning On-Call Scheduling roles**
Admins can assign On-Call Scheduling roles to user groups and to individual users based on user activities and responsibilities.
<table>
<thead>
<tr>
<th>Role</th>
<th>Tasks and access permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift administrator (rota_admin)</td>
<td>A user with the rota_admin role can create, read, update, and delete shifts. The rota_admin can create shifts using the <a href="#">Create new schedule wizard</a>, modify shifts and rosters, and maintain coverage and time off on the <a href="#">Manage shifts from the Calendar view</a>. The rota_admin role contains the platform assignment_rule_admin role.</td>
</tr>
</tbody>
</table>
| Shift manager (rota_manager)              | The Shift manager role is for the manager of a group. The purpose of the role is to distinguish a member that has been delegated the role of managing shifts of a group. The role cannot be used to manage all groups on the instance. The role can be delegated to the members of a group. See [Delegating roles](#). A user with the Shift manager role that meets any of the following requirements can manage shifts for their group:  
  - The user is the manager of the group.  
  - The user was delegated the rota_manager role. For information on delegating the shift manager role, see [Delegate the shift manager (rota_admin) role](#). For information on role delegation, see [Delegating roles](#).  
  - The user is configured as a shift manager for a group. For information on configuring group preferences, see [Configure preferences for a user group](#). |
<p>| itil                                       | A user with the itil role can view the <a href="#">Manage shifts from the Calendar view</a>, on-call commitments on reports, and has general read-only access to their group’s shifts.                                                            |
| Premium Dashboard user (rota_prem_dashboard_user) | Access to the On-Call Premium dashboard. The Premium dashboard displays performance metrics across groups. See <a href="#">Viewing the Performance reports for escalations</a>.                                                                 |</p>
<table>
<thead>
<tr>
<th>Role</th>
<th>Tasks and access permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEPRECATED: roster_admin</td>
<td>Caution: Do not use this role for new users. This deprecated legacy role exists only to support customers that still use the role.</td>
</tr>
</tbody>
</table>

**Viewing Escalation Overview reports**

Run Escalation Overview reports to view count and rate information on escalations currently in progress, acknowledged and unacknowledged escalations, and Mean Time to Acknowledge (MTTA). You can view data for all groups or for one or more selected groups.

**Opening the reports**

Any user with the itil role can view the reports. Use one of the following methods to open the reports:

- Click **Self-Service > Dashboards** and select **On-Call Overview**. If you have licensed the premium version, then click **On-Call Overview - Premium**.
- Click **On-Call Scheduling > Reports > Overview**.

Click the **Escalations Overview** tab.

**Escalations Overview reports**

- **Acknowledged escalations** are accepted by at least one user. The “true” value indicates acknowledged escalations.
- **Unacknowledged escalations** are not accepted by any user or are rejected by all users. The “false” value indicates unacknowledged escalations.
My On-Call Groups

- **Active Escalations**: 0
- **Unacknowledged Escalations - 7 days**: 2
- **Acknowledged Escalations - 7 days**: 151

**Acknowledged Escalations by Level - 7 days**

- **Hardware**: 51 (Fire), 43 (False)
- **Network**: 53 (Fire), 23 (False)
- **Service Desk**: 54 (Fire), 1 (False)

**Acknowledge vs Unacknowledged Escalations - 7 days**

- Hardware: 31 (Fire), 20 (False)
- Network: 1 (Fire), 1 (False)
- Service Desk: 1 (Fire), 3 (False)

**Escalations per Day - 7 days**

- **Time to Acknowledge - 7 days**
  - Chart showing average time to acknowledge with a range from 0 seconds to 12 minutes 30 seconds.
Select one or more groups. Only data for selected groups appears in the reports. If no group is specified, then data for all groups appears.

**Active Escalations - 7 days**
The number of escalations that are currently in progress.

**Unacknowledged Escalations - 7 days**
The number of escalations that nobody has yet acknowledged during the most recent seven-day period.

**Acknowledged Escalations**
The number of escalations that escalatees have acknowledged during the most recent seven-day period.

**Acknowledged Escalations by Level - 7 days**
The number of acknowledged escalations during the most recent seven-day period.

- The Y axis indicates groups.
- The X axis indicates escalation level.
- The color shade indicates the count of escalations in the box.

**Acknowledged and Unacknowledged Escalations by Group - 7 days**
The number of escalations by group during the most recent seven-day period.

- The "true" value indicates acknowledged escalations.
- The "false" value indicates unacknowledged escalations.

**Escalations per Day**
The number of escalations for the specified date.

- The Y axis represents the count of escalations.
- The X axis represents time by date.

**Mean Time to Acknowledge (MTTA) - 7 days**
The average time that it took a user to acknowledge an escalation during the most recent seven-day period.

- The Y indicates the time it took a user to acknowledge an escalation.
- The X axis indicates the group.

**Viewing Group Overview reports**
Run My Groups Overview reports to view the activities of a selected group: Count information on acknowledged and unacknowledged escalations by shift, acknowledged escalations by user, and the hours for each user over seven days.

**Opening the reports**
Any user with the itil role can view the reports. Use one of the following methods to open the reports:
- Click **Self-Service > Dashboards** and select **On-Call Overview**. If you have licensed the premium version, then click **On-Call Overview - Premium**.
- Click **On-Call Scheduling > Reports > Overview**.

Click the **My Groups Overview** tab and then specify the group in the **My On-Call Groups** list.

- **Acknowledged escalations** are accepted by at least one user. The “true” value indicates acknowledged escalations.
- **Unacknowledged escalations** are not accepted by any user or are rejected by all users. The “false” value indicates unacknowledged escalations.
My Groups Overview reports

On-Call Overview

On-Call Groups

On-Call Hours - 7 days

11 Days 16 Hours

On-Call Groups

On-Call Hours - 7 days

Acknowledged Escalations by Shift - 7 days

Acknowledged vs Unacknowledged Escalations by Shift - 7 days

- The Y axis represents the count of escalations.
- The X axis represents the shift.

On-Call Hours - 7 days

The sum for each day over the last seven days: (Number of hours / roster member) * (number of roster members that worked on an escalation)

Acknowledged and Unacknowledged Escalations by Shift - 7 days

The number of escalations by shift during the most recent seven-day period.

- The Y axis represents the count of escalations.
- The X axis represents the shift.
- The “true” value indicates acknowledged escalations.
- The “false” value indicates unacknowledged escalations.

**Hours Distribution by User - 7 days**
Pie chart that displays the number of hours that each user in the group worked on escalations during the most recent seven-day period.

**Acknowledged Escalations by User - 7 days**
Pie chart that displays the number of acknowledged escalations that each user in the group worked on during the most recent seven-day period.

**Viewing the Performance reports for escalations**
The Performance reports enable detailed review of how well escalations are being processed. You have precise control of the data that describes escalation progress using filters like group, priority, level, or escalation category.

**Opening the reports**
You must have the Premium Dashboard user (rota_prem_dashboard_user) role to view the Performance reports. Use one of the following methods to open the reports:
- Click **Self-Service > Dashboards** and select **On-Call Overview - Premium**.
- Click **On-Call Scheduling > Reports > Overview**.

Click the **Performance** tab and then select the date of interest. The time line shows the time of day at which escalations happen. Use the tabs to control the type of data to view:

**Breakdowns tab**
Use the filters to segment the data into categories that suit your need. For example, if you are investigating your SMS costs, you can set filters to display how many notifications of the SMS type are sent and to which groups or users they are being sent. For example, you might notice that you sent 68 SMS messages to users in the Network group. The group, however, did not acknowledge any escalations. You might therefore consider that you can lower SMS costs by not sending SMS notifications to that group.

- Groups
- Escalation Category

**Records tab**
The **Records** tab lists the individual records that make up the results that you configured on the **Breakdowns** tab. Click a name to view record details.

**Note:** Each record also appears in the appropriate escalation log. See View details in an escalation log.

**All Escalations tab**
- Acknowledged escalations are accepted by at least one user.
- **Unacknowledged escalations** are not accepted by any user or are rejected by all users.

- All Escalations: Count of escalations that started on the selected date.
- Escalation Notifications: Count of notifications that were sent on the selected date. An escalation might have triggered several notifications.

**Acknowledged Escalations tab**
• Acknowledged Escalation Notifications: Count of escalations that had any of the following values in the Response field for the notification:
  • Accepted or Accepted from other device
  • Auto-assigned

• Acknowledged Escalation %: Percent of escalations that had a valid value in the Response field for the notification.
• Acknowledged Contact Attempt %: Percent of contact attempts that were acknowledged.

Unacknowledged Escalations tab

Unacknowledged escalations have one of the following values for each member of an escalation path in the Response field for the escalation notification:
• Rejected
• Rejected from other device
• Invalid response
• (no response)
Enable users to subscribe to the On-Call calendar

Configure an On-Call calendar subscription URL and send it to the members of a shift. The URL is an iCal link that enables users to subscribe to their on-call calendar from their preferred calendar client.

Role required: admin, rota_admin, or rota_manager
Because the subscription URL supports basic authentication, the end user must provide instance credentials to authenticate and view their on-call events. Only the Calendar application on Mac OS X 8.0 and newer and the Outlook application on Windows 2013 and newer support basic authentication for calendar subscriptions. If SSO is in use, basic authentication is still required to subscribe with the URL.

1. Navigate to **On-Call Scheduling > My Group Schedules.**
2. Select the shift for which you want to send the on-call calendar subscription URL.
3. Specify the following details in the **Calendar Subscription** section.

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coverage interval</td>
<td>Select if you want to update the subscribed calendar with weekly or daily coverage details.</td>
</tr>
<tr>
<td>Get coverage for</td>
<td>Based on your coverage interval selection, select the number of weeks or days for which you want to update the subscribed calendar.</td>
</tr>
</tbody>
</table>

4. Click **Update.**
5. Click **Send Subscriptions** to send the calendar subscription URL to all members of the shift by email.

### Configure preferences for a user group

Specify the On-Call preferences for a user group.

Role required: admin, rota_admin, or rota_manager.

1. Navigate to **On-Call Scheduling > Administration > Group Preferences** and then set the values as needed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>User group for which the On-Call preferences should apply.</td>
</tr>
<tr>
<td>Allow Shift Schedule Overlap</td>
<td>Specifies if overlapping schedules are allowed for shifts within the group. When set to <strong>Default</strong>, the value selected for the <strong>Configuration to control whether to allow overlapping Shift schedules</strong> (<code>com.snc.on_call_rotation.allow_rota_overlap</code>) property is applied.</td>
</tr>
</tbody>
</table>

**Note:** Shift overlap is required to have a hand-off period between shifts. With this, multiple shifts can be on-call for the same duration. On-call members from multiple shifts can be contacted.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation rule on Shift overlap</td>
<td>Escalation rule that applies when there is a shift overlap. When set to Default, the value selected for the Escalation rule which applies when Shifts overlap (com.snc.on_call_rotation.escalation_rule_rota_over) property is applied.</td>
</tr>
<tr>
<td>PTO approval preferences</td>
<td>Specifies if an On-Call member in the group can create PTO. When set to Default, the value selected for the This property governs if an On-Call user ('Not admin, rota_manager, group manager or rota_admin') is allowed to create PTO (com.snc.on_call_rotation.pto.configuration) property is applied.</td>
</tr>
<tr>
<td>Shift managers</td>
<td>Users who can manage the shift in addition to group managers, shift managers (rota_admin), and delegated shift managers. You can also select the current group members.</td>
</tr>
</tbody>
</table>
How a trigger rule works

When a task is created or updated, the instance compares the assignment rules with the rule’s conditions to determine whether a condition is met. If there is a match, then the instance activates the workflow or script that is specified by the rule’s action. Trigger rules are an extension of assignment rules and they have the same behavior as assignment rules.

For example, a trigger rule might specify:

- If (rule condition): An incident with level Critical or High is raised and is assigned to the Network group.
- Then (rule action): Run the Assign and Notify workflow. (The workflow sends an email notification to the current on-call roster member.)
### Rule condition on the When to activate tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>High Priority for Network</td>
</tr>
<tr>
<td>Execution Order</td>
<td>80</td>
</tr>
<tr>
<td>Table</td>
<td>Incident [incident]</td>
</tr>
<tr>
<td>Match conditions</td>
<td>All</td>
</tr>
<tr>
<td>Conditions</td>
<td>Add Filter Condition, Add &quot;OR&quot; Clause</td>
</tr>
<tr>
<td>Priority</td>
<td>is one of</td>
</tr>
<tr>
<td></td>
<td>1 - Critical</td>
</tr>
<tr>
<td></td>
<td>2 - High</td>
</tr>
<tr>
<td></td>
<td>3 - Moderate</td>
</tr>
<tr>
<td></td>
<td>4 - Low</td>
</tr>
<tr>
<td>Category</td>
<td>is</td>
</tr>
<tr>
<td></td>
<td>Network</td>
</tr>
<tr>
<td>AND</td>
<td></td>
</tr>
<tr>
<td>OR</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td></td>
</tr>
</tbody>
</table>
Rule action on the What action to take tab

See Define an escalation trigger rule.

About escalation policies

An escalation policy includes the following configurations:

- The escalation audience (roster members and managers).
- A policy type that defines the order in which rosters and roster members receive escalation notifications.
- Other aspects of the escalation process like the contact methods to use and the number of reminders to send for each notification.

You can create a custom escalation policy for a shift by overriding settings in a default escalation type, for example, by configuring custom delays between escalation steps.

Define an escalation trigger rule

A trigger rule specifies both the conditions under which an escalation process should begin and the actions (workflow or script) to perform for the escalation. Trigger rules fire only if the assigned_to and assignment_group fields in a task record are not populated.

Role required: rota_admin or admin

1. Navigate to On-Call Administration > Administration > Trigger Rules.
2. Click **New** and then fill in the form.

### Trigger Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique and meaningful name for the trigger rule.</td>
</tr>
<tr>
<td>Order</td>
<td>The run order of the trigger rule.</td>
</tr>
<tr>
<td>Table</td>
<td>A task table that applies to the trigger rule.</td>
</tr>
<tr>
<td>Match conditions</td>
<td>How to determine a match with the conditions of the rule.</td>
</tr>
<tr>
<td></td>
<td>- <strong>All</strong>: Each condition must be met.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Any</strong>: Any one of the conditions can be met.</td>
</tr>
<tr>
<td>Conditions</td>
<td>The conditions that must be met for the trigger rule to fire (run the workflow or script that is the action for the rule).</td>
</tr>
<tr>
<td>Group</td>
<td>The group that becomes the Task assignment group when the trigger rule fires.</td>
</tr>
<tr>
<td>Trigger action</td>
<td>The <strong>Workflow</strong> or <strong>Script</strong> (server-side JavaScript) to execute when the Match conditions and Conditions are met.</td>
</tr>
<tr>
<td>Trigger workflow</td>
<td>The workflow to execute. Available only if Trigger action is set to <strong>Workflow</strong>.</td>
</tr>
<tr>
<td>Trigger script</td>
<td>The script (server-side JavaScript) to execute. Available only if the Trigger action is set to <strong>Script</strong>.</td>
</tr>
</tbody>
</table>

**Note:** Only tables and database views that are in the same scope as the trigger rule appear in the list.

3. Click **Submit**.

**Create an escalation policy**

An escalation policy includes the policy type that defines the order in which rosters and roster members receive escalation notifications. You can create a custom escalation policy for a shift by overriding settings in a default escalation type, for example, by configuring custom delays between escalation steps.

**Role required:** rota_admin, rota_manager, or admin

The escalation type determines the order in which members of a user group are notified about the escalation. The escalation type depends on the number of rosters.

- If a shift has only one roster, the escalation type is automatically set to **Rotate through members** and the escalation path goes through the member list of a roster (primary, secondary, tertiary) to determine whom to notify.
- If the shift has multiple rosters, the escalation type is automatically set to **Rotate through rosters** and the escalation path goes through all rosters to determine whom to notify.
If the shift has a customized escalation hierarchy, the escalation type is set to Custom and the escalation path goes through members as defined in the escalation hierarchy. See Create an escalation policy for details.

On-Call Scheduling supports multiple escalation policies per shift; for example, policies based on the priority of the incident or type of task record.

1. Create a custom escalation policy using the escalation designer.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Access the designer from the On-Call Schedules module | **1.** Navigate to On-Call Scheduling > On-Call Schedules.  
**2.** Click the required shift card.  
**3.** In the Shifts tab, click the actions icon for the shift.  
**4.** Click Override escalation and click OK in the confirmation window. |
| Access the designer from the My Group Schedules module | **1.** Navigate to On-Call Scheduling > My Group Schedules.  
**2.** Select the required shift.  
**3.** Click Override Escalation and then click OK in the confirmation dialog box. |

2. Click the Add Escalation Step icon and then fill in the Add Escalation Step form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the escalation step.</td>
</tr>
<tr>
<td>Escalation level</td>
<td>Hierarchy level of the step.</td>
</tr>
<tr>
<td>Time to next step</td>
<td>Wait time from the last reminder to run the next step.</td>
</tr>
<tr>
<td>Escalation set</td>
<td>Escalation set for the step.</td>
</tr>
<tr>
<td>Number of reminders</td>
<td>Number of reminders to send in this step.</td>
</tr>
<tr>
<td>Time between reminders</td>
<td>Time between each reminder of this step.</td>
</tr>
<tr>
<td>Roster</td>
<td>Rosters to which escalation notifications and reminders are sent.</td>
</tr>
<tr>
<td>Groups</td>
<td>User groups to which escalation notifications and reminders are sent.</td>
</tr>
<tr>
<td>Users</td>
<td>Users to whom escalation notifications and reminders are sent.</td>
</tr>
<tr>
<td>Devices</td>
<td>Devices to which escalation notifications and reminders are sent. For example, a mobile phone that is rotated between group members.</td>
</tr>
</tbody>
</table>
### Escalation and reminder settings for rosters

Use the escalation settings to specify how and when escalations occur and when reminder notifications are sent.

### Escalation and reminder settings

You can specify unique settings for each roster. When you configure a roster, you can specify

- **Forced communication channel**: You can specify a mandatory communication channel: SMS, voice, Slack, or email.
  - SMS and voice require that Notify is active.
• An on-call member must have an SMS device to receive SMS notifications. If the member does not have an SMS device, then no further attempts are made and the lack of an SMS device is logged.

• **Number of reminders**: The number of times the instance sends reminders to a person who does not reply within the time frame specified by **Time between reminders**.

• **Time between reminders**: The time interval between sending reminders.

• Values in the **Number of reminders** and **Time between reminders** fields determine the value in the **Time before escalation** field. For example, if **Number of reminders** is 2 and **Time between reminders** is 10 minutes, then the **Time before escalation** is 30 minutes. That is, the time that passes between the first notification of a non-responsive roster member and the first notification of the next member in the escalation path.

### Instructions

For detailed instructions, see *Configure a roster*.

**Example escalation reports**

Because escalation reports depend on the escalation type, report content can vary greatly.

Example reports follow:

**Example report for a Rotate through members escalation type**

In this example, users can see which shifts they are part of in My Schedule reports. Users who are not the first on-call person appear as well. This action enables the user to view the shift from a personal perspective, which is the preferred method for most users.
Example report for a Rotate through rosters escalation type

In this example, reminders are defined for the Primary, Secondary, and Tertiary rosters. Members of the primary roster are notified first, then the members of the secondary, and so on, for all rosters.
Track the progress of an escalation

Use the On-Call Escalation Tracking page for full visibility into the time line of an active or closed escalation as it progresses through its on-call escalation path.

Role required: Any role that enables the user to read incidents.

1. Navigate to Incident and open the incident.
   
   The Assignment group field includes the On-Call Escalation Tracking icon ( ) that indicates the active status of the escalation. Green indicates an active escalation, and black indicates a finished escalation.

2. Click the On-Call Escalation Tracking icon.
The On-Call Escalation Tracking dialog box opens.
1. The Escalation Path section identifies the escalation with start time, group, and shift that handles the escalation and Escalation category.
2. Indicators on the time line show status:
   a. For active escalations, a green arrow on the path time line indicates the current active response phase.
   b. Unfilled check mark: Skipped response.
   c. Filled green check mark: Accepted response.
   d. Red X: Rejected response.

3. Click the escalation timestamp for an escalatee or escalatee’s name to view timing details. The list on the Contact Information tab shows contact times, modes of contact, and responses for the associated escalation phase.

   The dots for the escalation timestamps indicate overall acceptance. Point to a dot to view further information. Color codes of the dots:
   - Green: At least one escalatee has accepted the escalation.
   - Orange: At least one escalatee has rejected the escalation.
   - Red: All escalatees have rejected the escalation.

   **Note:** To enhance the visual differences between dots, use the high-contrast user interface.

4. Depending on the contact settings, you can call or send a direct message to the person from the escalatee’s Profile tab.

**View details in an escalation log**

View the escalation log record for full details on the time line and actions for an on-call escalation as it progressed through the on-call escalation path. You can also access escalation and escalation notification information from reports.

Role required: rota_admin or admin

This topic describes how to use the logs to access escalation information. You can also access escalation notification information from reports. See Viewing the Performance reports for escalations.

You can enable or disable logging using the `com.snc.on_call_rotation.log_escalations` property, as described in System properties for On-Call Scheduling.

1. Navigate to **On-Call Scheduling > Escalations > Escalation Logs** and open the incident.
   The On-Call Escalations (Escalation Logs view) opens.

2. Click the Information icon
   (to open the incident record.)
3. For each item in the related lists, you can click the Information icon to drill deeper into the details of the escalation (for example, to determine Time to acknowledge values).

**System properties for On-Call Scheduling**
The property settings configure On-Call Scheduling operations.

**Setting properties from the UI**
You can set most property values from the On-Call Properties page at **On-Call Scheduling > Administration > On-Call Properties**.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.on_call_rotation.calendar_macro</td>
<td>The name of the macro that provides a calendar functionality for On-Call shift. The default uses DHTMLX scheduler. Fullcalendar is set by ocf_calendar.xml.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.support_legacy_spans</td>
<td>Used to search for override or time-off records that may have been generated as cmn_schedule_span records and not the standard roster_schedule_span table.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.pto.approval.required</td>
<td>Configuration to determine if PTO requests need approval.</td>
</tr>
</tbody>
</table>
| com.snc.on_call_rotation.factor_daily_rotation_interval_all_day | If true, mandates daily rotation to occur at midnight. If false, then use the time that is specified for the roster start time for the next day.  
  - **Location**: System Property (sys_properties) table |
| com.snc.on_call_rotation.log.level | Enable logs for debugging.  
  - **Location**: System Property (sys_properties) table |
| com.snc.on_call_rotation.log_escalations | Enable logging of escalations. See View details in an escalation log.  
  - **Location**: System Property (sys_properties) table |
| com.snc.on_call_rotation.calendar_macro | The name of the macro that provides a calendar for On-Call shift. The default uses DHTMLX scheduler. Fullcalendar is set by ocf_calendar.xml.  
  - **Location**: System Property (sys_properties) table |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.on_call_rotation.support_legacy_spans</td>
<td>Used to search for override or time-off records that may have been generated as records in the cmn_schedule_span table and not in the standard roster_schedule_span table.</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.pto.approval.required</td>
<td>Configuration to determine whether PTO requests require approval.</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property (sys_properties) table</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.contrast</td>
<td>Sets text color to either white or black depending on which has the highest contrast with the background color on the calendar. The following algorithms determine text color:</td>
</tr>
</tbody>
</table>
|                                                               |   • ContrastYIQ  
|                                                               |   • ContrastPercent  
<p>|                                                               |   • ContrastLuminance  |
|                                                               | <strong>Note</strong>: ContrastYIQ is used if the property is not enabled.                                                                                                                                              |
|                                                               |   • Location: System Property (sys_properties) table                                                                                                                                                    |
| com.snc.on_call_rotation.access.debug                        | If true, enable general On-Call logs for debugging.                                                                                                                                                       |
|                                                               |   • Location: System Property (sys_properties) table                                                                                                                                                    |
| com.snc.on_call_rotation.reminders.showtz                    | Include a user’s time zone in On-Call Shift Reminder notification emails.                                                                                                                                  |
|                                                               |   • Location: System Property (sys_properties) table                                                                                                                                                    |
| com.snc.on_call_rotation.show_legacy_calendar                | Show the legacy On-Call calendar.                                                                                                                                                                          |
|                                                               |   • Location: System Property (sys_properties) table                                                                                                                                                    |
| com.snc.on_call_rotation.calendar_read_roles                 | Comma-separated list of roles that can read the calendar.                                                                                                                                                    |
|                                                               |   • Location: System Property (sys_properties) table                                                                                                                                                    |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.snc.on_call_rotation.cover.color | Sets the color of the span for On-Call coverage for another roster member.  
- **Location**: System Property (sys_properties) table |
| com.snc.on_call_rotation.timeoff.color | Sets the color of the span when the type is time-off.  
- **Location**: System Property (sys_properties) table |
| com.snc.on_call_rotation.landing_page.group_limit | The number of On-Call schedules loaded per batch on the client side. Default: 20. |
| com.snc.on_call_rotation.landing_page.max_groups | The maximum number of On-Call schedules that can be loaded on the client side. Default: 300.  
**Note**: The default value is chosen as the limit of acceptable client performance. |
| com.snc.on_call_rotation.landing_page.pinned_notification | Displays a message when any schedule is pinned successfully. |
| com.snc.on_call_rotation.landing_page.notification_timeout | Specifies the time (in milliseconds) until the message for successful pinned scheduled is displayed. |
| com.snc.on_call_rotation.landing_page.show_wizard_btn | Displays the **New** button to open the On-Call schedule wizard. |
| com.snc.iam.conference_call_follow_on_call_escalation | If selected, On-Call the escalation path is followed when a user group is added to a conference call.  
This property is added when the Incident Communications Management (com.snc.iam) plugin is activated. |
| com.snc.iam.conference_call_escalation_workflow | If selected, custom escalation hierarchy is applicable in On-Call Scheduling workflows.  
This property is added when the Incident Communications Management (com.snc.iam) plugin is activated. |
<p>| com.snc.on_call_rotation.landing_page.show_pending_actions | Displays the pending actions on the On-Call Schedules landing page. |
| com.snc.on_call_rotation.allow_rota_overlap | If true, overlapping shifts are allowed for a user group. |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.on_call_rotation.escalation_rule_rota_overlap</td>
<td>Escalation rule that applies for shift overlap. Options:</td>
</tr>
<tr>
<td></td>
<td>• Escalate to outgoing Shift</td>
</tr>
<tr>
<td></td>
<td>• Escalate to incoming Shift</td>
</tr>
<tr>
<td></td>
<td>• Escalate to all Shift</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.pto.configuration</td>
<td>Specifies how a roster member can create vacation time (PTO). Options:</td>
</tr>
<tr>
<td></td>
<td>• With approval</td>
</tr>
<tr>
<td></td>
<td>• Without approval</td>
</tr>
<tr>
<td></td>
<td>• Not allowed</td>
</tr>
<tr>
<td>com.snc.notify.default.conference_call_follow_on_call_escalation</td>
<td>If true, the On-Call escalation path is followed when a user group is added to a conference call. Users can create properties for required task types such as incident. Example: For Incident, the property key would be com.snc.notify.incident.conference_call_follow_on_call_escalation.</td>
</tr>
<tr>
<td></td>
<td>Note: The property is enabled only when the Notify plugin (com.snc.notify) is active.</td>
</tr>
<tr>
<td>com.snc.notify.default.on_call_escalation_level</td>
<td>Fetches the number of users from the group escalation plan. A value of -1 fetches all users from the plan. A value of 1 fetches only the first level of users, and so on.</td>
</tr>
<tr>
<td></td>
<td>Note: This is the default property that is used until the specific property for the task type is configured. To use different workflows for different task types (such as incident or problem), create a new property by replacing the word default in the key with the task type.</td>
</tr>
<tr>
<td></td>
<td>Note: This property is used only when the com.snc.notify.default.conference_call_follow_on_call_escalation sys property is false.</td>
</tr>
<tr>
<td></td>
<td>The property is enabled only when the Notify plugin (com.snc.notify) is active.</td>
</tr>
</tbody>
</table>
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.notify.default.conference_call_escalation_workflow</td>
<td>The sys_id of the default workflow that must be attached when escalating a conference call.</td>
</tr>
</tbody>
</table>

**Note:** This is the default property that is used until the specific property for the task type is configured. To use different workflows for different task types (such as incident or problem), create a new property by replacing the word `default` in the key with the task type.

Example: For Incident, the property key would be `com.snc.notify.incident.conference_call_escalation_workflow`.

**Note:** The property is enabled only when the Notify plugin (com.snc.notify) is active.

---

**Configure or update an On-Call shift**

You can add extra coverage, specify extra times for when a shift is active, and schedule time off.

**Role required:** rota_admin or rota_manager

You can update the calendar only for the time zone specified in your user profile.

1. Navigate to **On-Call Scheduling > On-Call Calendars**.
   The on-call calendar opens.
2. Click the Timeline view icon
3. Click the Filters icon
   and then select the group.
   The calendar displays the selected group.
4. Right-click a block that represents a member of the shift and select **Manage Shift**.
   The Manage Shift dialog box displays the current shift settings.
5. Select an **Action**, as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Provide coverage</strong></td>
<td>Select details of the member who will provide on-call coverage for another roster member. The following options appear when you select this option:</td>
</tr>
<tr>
<td></td>
<td>- Rosters: Select one or more rosters for which the member will provide coverage.</td>
</tr>
<tr>
<td></td>
<td>- Member: Select the member to provide extra coverage.</td>
</tr>
<tr>
<td></td>
<td>- Shift start: Select the date from which the coverage will start.</td>
</tr>
<tr>
<td></td>
<td>- Shift end: Select the date on which the coverage will end.</td>
</tr>
</tbody>
</table>

**Note:** The coverage is created between the start and end date of the shift based on its schedule time.
### Option Description

#### Schedule extra time
Specify extra coverage for the selected shift. The following options appear when you select this option:
- Shift: Select the shift for which you want to specify extra time.
- Shift start: Select the date from which the extra time will start.
- Shift end: Select the date on which the extra time will end.

#### Schedule time off
Specify the group member who will take scheduled time off during the selected time frame. The following options appear when you select this option:
- Member: Select the member who requested time off.
- Starts: Select the date and time from which the time-off period will start.
- Ends: Select the date and time on which the time-off period will end.
- All day event: Select if the time-off period is a total of one working day.
- Proposed cover: Select the name of the shift member who you would like to provide cover in your absence.

6. **Click Schedule** to schedule the update.
7. To save the view settings, click the Bookmark this filter icon

---

**Configure a roster**

Edit a roster to specify its reminder and escalation settings and to identify a subset of group members to participate in the On-Call roster.

Role required: rota_admin or admin

1. Navigate to **On-Call Scheduling > On-Call Calendars**.
2. Right-click a shift and select **Edit Shift** from the **Actions** list.
3. In the **Rosters** related list, select a roster and then fill the form.

#### Roster form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the roster.</td>
</tr>
<tr>
<td>Shift</td>
<td>Shift associated with the current roster.</td>
</tr>
<tr>
<td>Active</td>
<td>If selected, the roster is active for on-call operations.</td>
</tr>
<tr>
<td>Order</td>
<td>Order of the roster.</td>
</tr>
<tr>
<td>Rotation interval</td>
<td>Type of the rotation interval.</td>
</tr>
<tr>
<td>Day of week for rotation</td>
<td>Weekday on which the roster rotation should start. When this field is specified, roster rotation happens based on the specified frequency and the weekday.</td>
</tr>
<tr>
<td>Rotate every</td>
<td>Frequency of the rotation interval.</td>
</tr>
</tbody>
</table>

**Note:** This field is displayed only if the **Rotation interval** field is set to **Weekly**.
## Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotation start date</td>
<td>Start date of the rotation.</td>
</tr>
<tr>
<td>Rotation start time</td>
<td>Start time of the rotation.</td>
</tr>
<tr>
<td>All day rotation</td>
<td>If selected, roster rotation happens throughout the day. To specify a particular time of day for roster rotation, for example 08:00 instead of midnight, deselect the check box and specify the time.</td>
</tr>
</tbody>
</table>

### Escalation Settings

<table>
<thead>
<tr>
<th># reminders</th>
<th>Number of times that reminders are sent to a user who does not reply within the time frame defined in Time between reminders.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time between reminders</td>
<td>Time between each reminder.</td>
</tr>
<tr>
<td>Time before escalation</td>
<td>Values in the Number of reminders and Time between reminders fields determine the value in the Time before escalation field. For example, if Number of reminders is 2 and Time between reminders is 10 minutes, then the Time before escalation is 30 minutes. That is, the time that passes between the first notification of a non-responsive roster member and the first notification of the next member in the escalation path.</td>
</tr>
</tbody>
</table>

### Reminder Communication

| Send on-call reminders        | If selected, a reminder is sent to the email address specified in the user record, unless it is specified somewhere else in the notification preferences. Notification preferences take precedence over the user record. |
| Reminder lead time (days)    | Lead time for email reminders.                                                                                                                                                                               |

Note: This field is displayed only when the Send On-Call Reminders check box is selected.

4. Click **Update**.

5. Optional: To remove users who do not participate in a shift, perform these steps:
   a) Click **Edit** on the Members related list.
   b) Remove the members and then click **Save**.

Note:
- Initially, roster members are automatically populated from the user group.
- All members of a roster must be members of the same user group.
**Update a member’s order in a roster**
You can modify the order number for a member without affecting past shift records.

Role required: rota_admin, rota_manager, or admin

1. Navigate to **On-Call Scheduling > My Group Schedules**.
   The appropriate list of shifts appears.
2. Select the shift to view the list of rosters.
3. Select the roster from the list of rosters within the shift.
4. Select the information icon next to the member name whose order you want to modify.
   The details for the selected member appear.
5. Enter the new order number in the **Order** field.
6. Click **Update**.
   The members appear in the new order. The original record has a **To** date for the end of validity and the new record has the current date as the **From** date for the start of validity.

**Delegate the shift manager (rota_admin) role**
As a shift manager, you can delegate your role to a member of shift.

Role required: rota_manager or admin

1. Navigate to **User Administration > Delegate Roles in Group**.
2. Follow the instructions to delegate the shift manager role to a member of your shift.

   **Note:** Ensure that you select the shift group where you want to delegate the shift manager role.

3. Submit the role delegation request.

**Set a shift to Draft mode while waiting for info**
If you do not have all the information that you need to define a shift, you can set the shift to Draft mode. Later, when all the information is available, you can publish the shift so you can add it to a schedule.

Role required: rota_manager

1. Navigate to **On-Call Scheduling > My Group Schedules**.
2. Select the shift that will include the group.
3. On the **Shift** dialog box, click **Move to Draft**.
   A message confirms that the rotation schedule is updated for the shift that you moved to a draft mode.

**Update shift details from the On-Call calendar**
To save time, update shift details directly from an on-call calendar.

Role required: rota_admin or admin

1. Navigate to **On-Call Scheduling > On-Call Calendars**.
2. In the title bar, click the toggle filters icon

   and select a user group.
3. Click the shift name on the calendar.
A dialog box displays the **Actions** list and information about the primary and secondary rosters. For each listed user, you have an option to either connect through phone, email, or chat. The application that is launched for phone or email is dependent on the client that is installed in the local machine.

4. Navigate to **Actions > Edit Shift.**

### Edit Shift form fields

<table>
<thead>
<tr>
<th>Question</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the shift.</td>
</tr>
<tr>
<td>Group</td>
<td>Select <strong>Yes</strong>, and then select one of the predefined options in the next question. Select <strong>No</strong> to set up the schedule's configuration manually.</td>
</tr>
<tr>
<td>Active</td>
<td>Shows the state of the shift.</td>
</tr>
<tr>
<td>Schedule</td>
<td>The shift is a part of this schedule. Choose from a predefined list of schedules using the lookup if you want to change the schedule. Click the calendar to view the complete schedule.</td>
</tr>
<tr>
<td>Based on</td>
<td>The template that the schedule is based on</td>
</tr>
<tr>
<td>Background Color</td>
<td>Use this field to specify the background color of the shift or to change from an existing color. Differentiate between groups with the colors.</td>
</tr>
</tbody>
</table>
| Catch All                 | Specify who should receive notifications in case none of the people who are on-call accepted the incident assignment. It can be none, a group manager, a shift manager, an individual, or any or all roster members.  
                           |   - Select **Notify Individual** to specify a member of the group to notify.  
                           |   - Select **Notify All** to specify a shift. All shift members are notified. |
| Manager                   | The user with the shift manager (rota_admin) role.                          |
| Override user preference  | User preferences are overridden with contact preferences when set to true.  |
| Send On-Call Reminders    | If selected, on-call reminders are sent.                                    |
| Reminder lead time (days) | Lead time for email reminders.                                              |
| Coverage interval         | Update interval for the subscribed calendar: Weekly or daily coverage details.|

**Note:** This field is displayed only when the **Send On-Call Reminders** check box is selected.
Send or resend reminders of an upcoming shift

Remind roster members of an upcoming shift by sending an email notification. You specify the number of days before their shift starts for the email.

Role required: rota_admin or admin

The reminder is sent to the email address specified in the user record, unless the address is specified in other notification preferences. Notification preferences take precedence over the user record.

1. Navigate to **On-Call Scheduling > My Group Schedules**.
   The option is also available when you edit a shift in an On-Call calendar.

2. Select the shift.

3. On the Shift form, select the **Send on-call reminders** check box and then specify the number of days in the **Reminder lead time** field.

   **Note:** If you set the value of **Reminder lead time (days)** to more than one day and also set the roster to daily rotation, the instance does not send reminder emails.

4. To resend a reminder, click **Resend**.

5. Click **Update**.

Create a shift template to simplify configuring shifts

You can predefine sets of shift settings using shift templates. Shift templates are a subset of group templates.

Role required: rota_admin

1. Navigate to **On-Call Scheduling > Administration > Group Templates**.

2. From the list of group schedule templates, select the template for which you want to create a new shift template.

3. On the related list of the shift templates, click **New** and then fill in the On-Call Shift Template form.

### New shift template fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift name</td>
<td>The friendly name of the shift template. For example, US or EMEA.</td>
</tr>
<tr>
<td>Schedule type</td>
<td>The type of schedule. You can specify settings for a Simple schedule. Alternatively, you can select an existing template.</td>
</tr>
<tr>
<td>All day</td>
<td>Select the check box if the shift spans the full workday.</td>
</tr>
<tr>
<td>Start Time</td>
<td>If this is not an all-day shift, then specify the start time of the shift.</td>
</tr>
<tr>
<td>End time</td>
<td>The end time of the shift.</td>
</tr>
</tbody>
</table>
4. Click **Submit**.

The template is now available for you to choose when creating or updating a shift.

### Configure the lead time for email reminders

On-Call Scheduling includes a scheduled job that checks if any shift members should be notified about upcoming On-Call commitments. Modify the lead time for the reminder to be sent.

Role required: rota_manager or rota_admin

1. Navigate to **On-Call Scheduling > On-Call Calendars**.
2. Right-click the shift and select **Edit Shift**.
3. Update the **Reminder lead time (days)** value for the on-call schedule record or for any of its rosters.

The reminder lead time defined on a roster is always respected. If no lead time is defined, the instance uses the schedule reminder lead time. If the reminder lead time is not defined for either the schedule or its rosters, then the instance uses a default of 2 days.

**Note:** The **Reminder lead time** on the Roster form is different from the **# reminders** and **Time between reminders** values in the Escalation Settings section of the form.

The escalation settings are only used to configure reminders for escalations. The **Reminder lead time** is in the Reminder Communication section of the Roster form, and is used to email reminders for upcoming on-call commitments.

### Manage requests for time off

As a shift manager, you can review and approve time-off requests from shift members. You also specify the roster member who can cover for the time.

Role required: rota_manager

1. Navigate to **Self-Service > My Approvals**.
2. Select the time-off request record to approve.

The time-off request displays the details of the time-off requested by the member of your team. In this example, the dark blue shade with stripes represents the requested time off. A message also gives you the request details including that of the proposed cover.
3. Optional. Enter comments in the Comments section.

4. Select Approve or Reject.
   - For rejection, the On-Call calendar no longer indicates the time-off details and the requester receives email notification.
   - For approval, the On-Call calendar indicates the time-off details and the requester receives email notification.
Resolve gaps, conflicts, and time-off requests in a shift

Review and resolve gaps and conflicts. Find a replacement on-call member for time-off requests to ensure proper support coverage.

Role required: rota_manager

Possible reasons for gaps are:

- Time off without coverage
- User has been moved out of the group
- User is marked as inactive

A conflict is possible if a user is assigned as both the primary and secondary point of contact for a shift.

1. Navigate to On-Call Scheduling > On-Call Schedules.
2. Click a shift card.

Note: If you are a shift manager or roster member, the schedule view opens. In all other cases, you are redirected to the calendar view. For more information on on-call scheduling calendars, see Manage shifts from the Calendar view.

- The On-Call Schedules page open. For more information, see Updating an On-Call schedule
- The pending actions for the current shift appear in the Pending Actions section.

3. To resolve gaps or conflicts, perform the following steps.
a) Click **Review** in the **Pending Actions** section. The calendar view appears, and gaps or conflicts are highlighted.

b) Click the Information icon to view gaps.

c) Right-click the shift and select **Edit shift** from the **Actions** list.

d) Navigate to the **Rosters** related list and select the roster where the user is unavailable.

e) In the **Members** related list, add a **To** value for the unavailable user.

f) Add a new member with a **From** value to close the gap.

4. To resolve a time-off request, perform the following steps.
   a) Click **Review** in the **Pending Actions** section. The calendar view appears, and time-off requests are highlighted.
   b) Right-click the shift and select **Manage shift** from the **Actions** list. The Manage Shift dialog box appears.
   c) Approve the time-off requests.

Add a new or returning employee to a roster

You can add a new employee or an employee who had previously been a member to a roster.

Role required: rota_manager, rota_admin, or admin

1. Navigate to **On-Call Scheduling > My Group Schedules** and select the shift.
2. On the Shift form, select the roster in the **Rosters** related list. The Roster form opens.
3. Click **New** in the **Members** related list and then fill in the form.

<table>
<thead>
<tr>
<th>On-call Member</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roster</td>
<td>Roster name. Read-only.</td>
</tr>
<tr>
<td>Member</td>
<td>The name of the member to add to the roster.</td>
</tr>
<tr>
<td>Rotation schedule</td>
<td>This field takes a value after you submit the record.</td>
</tr>
<tr>
<td>Order</td>
<td>The order number for the new member. The order number determines where the member starts on the rotation cycle.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>From</td>
<td>Enter the date that the employee will join the roster.</td>
</tr>
</tbody>
</table>

**Important:** For a returning employee: Ensure that the old employee record contains a To date that does not overlap with the returning employee’s new start date as specified by the From date.

**Note:** The user will be active on the roster from the next rotation.

| To    | Select the last date when the addition of the new member becomes valid on the roster. |

**Note:** If the To date falls in the middle of a rotation, then the user finishes the rotation.

4. Click Submit
   The instance adds the employee to the roster.

**Note:** For a returning employee: The instance displays two shift member records for the same employee with different start and end validity dates.

**Remove a member from a roster**

You might remove a member from a roster, for example, if they are no longer a member of the organization or of the group.

**Role required:** rota_manager, rota_admin, or admin

Use either of the following methods to remove a member from a roster:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify shift member validity period</td>
<td>From the on-call roster:</td>
</tr>
</tbody>
</table>

1. Navigate to On-Call Scheduling > My Group Schedules.
2. Select the shift.
3. Select the roster from the list.
4. Select the shift member.
5. Click the information icon for the selected name.
6. Enter the date from which you want the member to be removed in the To field.
7. Click Update to save the change and remove the member from the roster from the selected date.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete shift member record</td>
<td><strong>Caution:</strong> If you delete the member record, the deleted member rotation history is removed, and the rotation history of other members are affected.</td>
</tr>
</tbody>
</table>

From the on-call roster:

1. Navigate to **On-Call Scheduling > My Group Schedules**.
2. Select the shift.
3. Select the roster from the list.
4. Select the shift member.
5. Click **Edit** to open the list of members on the roster.
6. Move the name of the member from the **Members** list to the **Collection** list.
7. Click **Save** to remove the member and return to the roster.

---

**Configure or update an On-Call schedule**

Create an On-Call schedule or edit an existing schedule by defining shifts and rosters.

Role required: rota_admin, rota_manager

You can use the wizard to create an on-call schedule using an existing template or you can create shifts from scratch. You can create multiple shifts at given time and can preview shifts while creating them. This enables you to create rosters, define escalation policies, and review and publish shifts.

After running the wizard, you can adjust individual roster, escalation, and reminder settings to fine-tune the setup. You can also enable on-call notifications by setting up rotation workflow triggers.

1. Navigate to **On-Call Scheduling > Create/Edit Schedule**.
2. In the **Define Schedule**, from the **Select Group** choice list, select the group for which you are defining the schedule.
3. Choose an existing template for the shifts or create a new shift.
4. Optional. Select the **Allow Shift Schedule overlap** check box to allow overlapping schedules for shifts within the group.

   For example, if a group has a 24x7 schedule, you can create multiple schedules for the group. Shift overlap is required to have a hand-off period between shifts so that multiple shifts can be on-call for the same duration.

   If you select **Allow Shift Schedule overlap**, then the **Escalation rule on Shift overlap** check box appears.
5. Optional. Select the **Escalation rule on Shift overlap** check box to specify which shift needs to be notified of an escalation during a shift overlap.

   You can escalate to an incoming, an outgoing, or to all shifts.
6. Fill in the form fields.
## Define Schedule

<table>
<thead>
<tr>
<th>Question</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the shift that appears on the On-call calendar page.</td>
</tr>
</tbody>
</table>
| Would you like to use an existing schedule?            | Option to use an existing schedule.  
- Select **Yes** to use an existing or predefined shift.  
- Select **No** to create a new schedule.                                                                 |
| Schedule                                               | Select the value to base your schedule on. Some options are available in the base system, for example, 24x7, Workday 8-5.  
This option appears only if you answer **Yes** to **Would you like to use an existing schedule?**  
The logged-in user’s time zone is used as the basis for these schedules. If the logged-in user does not have a time zone specified, the instance time zone is used. |
| Start date                                             | The date on which the shift is scheduled to begin.                                                                                           |
| Specify holidays                                       | Option to define holidays.  
- Select **Yes** to define holidays for the on-call shift. You can select an existing holiday schedule.  
- Select **No** to not specify holidays for the shift.                                                                                       |
| Holiday Schedule                                       | Specify a holiday schedule for the group.                                                                                                     |

### Additional fields

- **Note:** The following fields are displayed only when the **Would you like to use an existing schedule?** field is set to **No**.

<table>
<thead>
<tr>
<th>Time Zone</th>
<th>The time zone in which the shift operates.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the shift for this schedule all day?</td>
<td>List of options. Specify whether this shift is an all-day shift.</td>
</tr>
<tr>
<td>Start</td>
<td>The time of day the shift is scheduled to start. The start and end time represent one shift. The date is different only if the shift spans midnight.</td>
</tr>
<tr>
<td>Question</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>End</strong></td>
<td>The time of day the shift is scheduled to end. The start and end time represent one shift. The the date is different only if the shift spans midnight. For example, for the 8 a.m. to 8 p.m. shift, the start is 2014-01-01 08:00:00 and the end is 2014-01-01 19:59:59. For the 8 p.m. to 8 a.m. shift, the start is 2014-01-01 20:00:00 and the end is 2014-01-02 07:59:59.</td>
</tr>
<tr>
<td><strong>Repeats</strong></td>
<td>The days that the shift repeats.</td>
</tr>
<tr>
<td><strong>Send On-Call Reminders</strong></td>
<td>Option to send on-call reminders to members of the roster.</td>
</tr>
<tr>
<td><strong>Reminder lead time (days)</strong></td>
<td>Lead time for email reminders.</td>
</tr>
<tr>
<td><strong>Coverage interval</strong></td>
<td>Interval for updates of coverage details. Specifies whether you want to update the subscribed calendar with weekly or daily coverage details.</td>
</tr>
<tr>
<td><strong>Get coverage for</strong></td>
<td>Number of weeks or days for which you want to update the subscribed calendar.</td>
</tr>
</tbody>
</table>

**Note:** The wizard does not provide a monthly or yearly option. Creating a monthly or a yearly shift by editing the schedule manually is not advised because it is hard to determine the on-call person over a long period. In this case, create a yearly or a monthly schedule with only one roster and one member so that the same person is always on-call. Make any exceptions as a one-time change in the roster for the shift.

**Note:** This field is displayed only when the Send On-Call Reminders option is selected.

**Note:** The instance saves the schedule and adds it to the list of existing schedules.

7. Click **Next**.
8. Optional: Click **Add Shift** to add another shift to the schedule if needed.
9. Use the **Members** page to specify members for a shift and rosters.

### Configure Members

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roster Name</td>
<td>Use the edit icon to edit the name of the roster that you are adding members to.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Which members would you like to be in your schedule?</td>
<td>Move the members you want to add from Available list to Selected list.</td>
</tr>
<tr>
<td>Rotation start date</td>
<td>Date on which the rotation needs to start.</td>
</tr>
<tr>
<td>Rotation interval</td>
<td>Type of the rotation interval.</td>
</tr>
<tr>
<td>Rotate every</td>
<td>Frequency of the rotation interval.</td>
</tr>
<tr>
<td><strong>Note:</strong> This field appears only if the Rotation interval field is set to <strong>Weekly</strong>.</td>
<td></td>
</tr>
<tr>
<td>Day of week for rotation</td>
<td>Day of the week on which the roster rotation should start. When this field is specified, roster rotation happens based on the specified frequency and the day of the week.</td>
</tr>
<tr>
<td><strong>Note:</strong> This field appears only if the Rotation interval field is set to <strong>Weekly</strong>.</td>
<td></td>
</tr>
<tr>
<td>Send On-Call Reminders</td>
<td>If selected, on-call reminders are sent to the members of the roster.</td>
</tr>
<tr>
<td>Reminder lead time (days)</td>
<td>Lead time for email reminders.</td>
</tr>
<tr>
<td><strong>Note:</strong> This field is displayed only when the Send On-Call Reminders option is selected.</td>
<td></td>
</tr>
</tbody>
</table>

10. Click **Next Step**. The Escalation Setup form appears.
11. Use the form to specify escalation settings.

**Escalation Setup steps**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation type</td>
<td>Method used to determine who receives an escalation notification. Its value is automatically set to <strong>Rotate Through Members</strong> if a shift has only one roster. The escalation path goes through all members of that roster. If a shift has more than one roster, the default value is <strong>Rotate Through Rosters</strong>. The escalation path goes through all the rosters to determine who to notify. <strong>Click Override escalation to change the default setting.</strong></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Catch-All</td>
<td>Specifies users who receive a notification when no other on-call users have acknowledged the escalation. The value can be none, a group manager, a shift manager, an individual, or any or all roster members.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Notify Individual</strong> to specify a member of the group to notify.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Notify All</strong> to specify a shift. All shift members are notified.</td>
</tr>
</tbody>
</table>

12. Click **Next Step**.

13. Click **Edit Reminder** to edit the reminder settings for an escalation. The Edit Reminder form opens.

14. Use the form to edit the reminder settings for a schedule.

**Escalation Reminder form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td># reminders</td>
<td>When escalations are configured for this group, the instance first sends this number of reminders before notifying the backup personnel.</td>
</tr>
<tr>
<td>Time between reminders</td>
<td>The interval of time between reminders. Default: 15 minutes</td>
</tr>
<tr>
<td></td>
<td>If your choice is not in the list, select the closest value. <strong>Edit the roster</strong> to update the number of reminders after the schedule is generated.</td>
</tr>
<tr>
<td>Time before escalation</td>
<td>The interval of time to wait before escalating a task.</td>
</tr>
</tbody>
</table>

15. Review the schedule and then click **Save**. The schedule is saved in Draft mode.

16. Select **Send subscriptions** to send a subscription URL to an on-call member after the shift is published.

17. After the schedule is complete, click **Finish** to save and publish the schedule.

Perform one of the following procedures to update the schedule.

**View On-Call schedules**

The tiled grouping of on-call shift schedules helps you to review shifts rather than having to search through all shifts in the system.

Role required: itil, rota_manager, or rota_admin

Each card on the On-Call Schedules page represents a shift and identifies the on-call members. A card displays the group name, the shift name, and rosters (Primary and Secondary).

On-Call schedules enable you to view the presence of on-call members. For more information on presence, see **User presence**.
Note: By default, On-Call schedules are loaded in batches of 20. You can use the com.snc.on_call_rotation.landing_page.group_limit property to update the setting. For details, see System properties for On-Call Scheduling.

1. Navigate to On-Call Scheduling > On-Call Schedules.

   Note: For a group with overlapping shifts, shift cards are displayed based on the escalation setting.

The following tabs appear:

- **Pinned On-Call Schedules**: Displays a personalized list of who is on-call for the groups you are most interested in. Pin groups here for fast access.
- **My On-Call Schedules**: Displays only the On-Call schedules that you manage or are a member of.
- **All On-Call Schedules**: Displays the list of all groups that have active On-Call schedules. You can also find who is on-call for groups that you have not pinned.

Use the filter to display On-call schedules by group, schedule, or username.

2. Optional: To pin a shift card, point to the card on the All On-Call Schedules tab and click the Pin icon. To unpin a card, click the Pin icon in the Pinned On-Call Schedules tab.

   Note: When you pin a shift card of a group with overlapping shifts, all other shift cards of that group are also pinned.

3. To view details of a shift, click the shift card.

   Note: Each shift card displays only the first two rosters.

If you are a shift manager or roster member, the schedule opens. For more information, see Updating an On-Call schedule. In all other cases, you are redirected to the calendar view. For more information on on-call scheduling calendars, see Manage shifts from the Calendar view.

4. Optional: To view roster and escalation details, click Roster and escalation details on the shift card.

A dialog box displays the following tabs:

- Roster: Displays a list of all rosters and contact number, email address, group, and the shift for the active On-Call member.
- Escalation Path: Displays the escalation path defined for the shift.

   Note: By default, the details of the on-call member of the primary roster are displayed. Click Send a direct message to send a direct message to the on-call member. Alternatively, call the member if the Notify WebRTC is configured. For more information on real-time messaging, see Connect. For information on Notify WebRTC, see Forward to notify client workflow activity. For information on the Specify a valid Notify Number with voice capability property that enables the Notify WebRTC for on-call, see System properties for On-Call Scheduling.

5. Optional: To view gaps and conflicts in a shift, click the info badge on the shift card.
• This is applicable only for group managers, shift managers, and delegated shift managers.
• This information is displayed based on the setting of the com.snc.on_call_rotation.landing_page.show_pending_actions property. For more information, see System properties for On-Call Scheduling.

Updating an On-Call schedule

Shift managers and members can use the Schedules tabs to view and update the on-call schedules of a group. Shift managers can review, manage, and resolve gaps or conflicts in your On-Call schedule from a single view.

Opening the Schedules page

To open and start working on a schedule, navigate to On-Call Scheduling > On-Call Schedules and then click the card for the group.

Overview tab

This tab gives an overview of the current shift. The following sections are available:

• On-Call: Displays information about the current on-call shift. From here, you can:
  • Navigate to the previous and next shifts.
  • View the roster and escalation details of the current shift. When you click Roster and escalation details, a dialog box displays the following tabs:
    • Roster: Displays a list of all rosters along with its active on-call member. Information of the on-call member such as the contact number, email address, group, and the shift to which the user belongs to is also available.
    • Escalation Path: Displays the escalation path defined for the shift.
    • Profile: Displays the user profile of the primary on-call member. You can send a direct message to the on-call member by clicking Send a direct message or call the member if Notify WebRTC for on-call is set up. For more information on real-time messaging, see Connect. For information on Notify webrtc, see Forward to notify client workflow activity. For information on the Specify a valid Notify Number with voice capability property that enables the Notify WebRTC for on-call, see System properties for On-Call Scheduling.
Contact Preferences: The contact preferences set for the primary on-call member.

Network (EMEA) 2019-06-30 23:00:00 to 2019-07-01 07:00:00

<table>
<thead>
<tr>
<th>Roster</th>
<th>Escalation Path</th>
<th>Profile</th>
<th>Contact Preferences</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>David Dan</td>
<td>Not available</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><a href="mailto:david.dan@example.com">david.dan@example.com</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Send a direct message</td>
</tr>
</tbody>
</table>
Pending Actions: Displays the pending actions for the group’s on-call schedule. You can review gaps, conflicts, and time-off requests to find a replacement and ensure proper support coverage. For information on resolving the pending actions, see Resolve gaps, conflicts, and time-off requests in a shift.

Note: This section is displayed only for a shift manager.

Your Upcoming Shifts: Displays your upcoming shifts in a calendar view.

Note: This section is displayed for a shift member or a Shift Manager who is a shift member.

On-call calendar: This section displays the calendar view of all shifts of the group. By default, the week view is displayed. For more information on on-call calendar, see Manage shifts from the Calendar view.

Shifts tab

This tab displays all shifts defined for the user group. From here, you can edit a shift or create a custom escalation policy to override the default policy. For information on editing the escalation type, see Create an escalation policy.

You can also edit contact preferences from this tab. For more information on configuring a contact preference, see Configure my availability and contact preferences.

Settings tab

This tab displays the group preferences set for your group’s on-call shift. If not already set, click Create Custom Group Settings to set the group preferences. For more information about group preferences, see Configure preferences for a user group.

Note: The group preferences set here affect only this group. These settings override the global settings.

To view on-call properties, click View Global Settings.

Note: View Global Settings is only visible to rota_admin.

Update a schedule entry

You can deactivate a schedule entry or update setting like schedule entry type, date, or time.

Role required: rota_admin or rota_manager

1. Navigate to On-Call Scheduling > On-Call Calendars. The on-call coverage for your group’s calendar appears.

2. Click the shift name and navigate to Actions > Edit span. The Schedule Entry dialog box is displayed.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Hardware (EMEA)</td>
</tr>
<tr>
<td>Type</td>
<td>On call</td>
</tr>
<tr>
<td>Group</td>
<td></td>
</tr>
<tr>
<td>Show as</td>
<td>On call</td>
</tr>
<tr>
<td>When</td>
<td>2018-10-08 23:00:00 to 2018-10-09 07:30:00</td>
</tr>
<tr>
<td>Time zone</td>
<td>US/Pacific</td>
</tr>
<tr>
<td>Repeats</td>
<td>Weekly</td>
</tr>
<tr>
<td>Repeat every</td>
<td>1 Week</td>
</tr>
<tr>
<td>Repeat on</td>
<td>Mon, Tue, Wed, Thu</td>
</tr>
<tr>
<td>Repeat until</td>
<td></td>
</tr>
</tbody>
</table>

Update, Deactivate, Delete
3. Update the fields as needed.

**Schedule Entry**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Modify the name of the schedule entry, if required.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of schedule entry. For example, on-call or time off.</td>
</tr>
<tr>
<td>Group</td>
<td>The <strong>Group</strong> field is empty by design. <strong>Caution:</strong> If the <strong>Group</strong> field is populated, then the spans for the entry are not displayed.</td>
</tr>
<tr>
<td>Show as</td>
<td>Select what the schedule entry must be displayed as. For example, busy or on-call.</td>
</tr>
<tr>
<td>When</td>
<td>Select the appropriate start and end date, and time for the schedule entry.</td>
</tr>
<tr>
<td>All day check box</td>
<td>Select the check box to make the schedule entry active for the entire duration.</td>
</tr>
<tr>
<td>Timezone</td>
<td>Displays the time zone for the schedule entry. This cannot be modified.</td>
</tr>
<tr>
<td>Repeats</td>
<td>Select the frequency with which the schedule entry repeats. For example, daily or weekly.</td>
</tr>
<tr>
<td></td>
<td>The following fields appear if you select <strong>Monthly:</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Monthly type</strong>: specify the date of the month when the schedule entry repeats.</td>
</tr>
<tr>
<td></td>
<td>The following fields appear if you select <strong>Yearly:</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Yearly type</strong>: specify the date of the year when the schedule entry repeats or if it is floating. If you select the <strong>Floating</strong> option, then the following fields appear:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Float week</strong>: Select the week of the month when the schedule entry repeats.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Float day</strong>: Select the day of that week when the schedule entry repeats.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Month</strong>: Select the month when the schedule entry repeats.</td>
</tr>
<tr>
<td>Repeat every</td>
<td>If the schedule entry is selected to repeat, then specify how often it repeats. For example, if you select weekly repetitions, specify the frequency such as every week or every two weeks.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Repeat on</td>
<td>If the schedule entry is selected to repeat, then specify when it repeats.</td>
</tr>
<tr>
<td>Repeat until</td>
<td>If the schedule entry is scheduled to repeat, then specify an end date until which the schedule entry repeats itself.</td>
</tr>
<tr>
<td>Deactivate</td>
<td>Deactivate the schedule entry. A warning message appears.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the schedule entry. A warning message appears.</td>
</tr>
</tbody>
</table>

4. Click Update.

**Specify the sources of contact information for schedule notifications**

Configure the communications methods that shift managers can choose from to send on-call schedule notifications. For example, add email and phone contact sources.

Role required: admin

1. Navigate to **On-Call Scheduling > Administration > Contact Sources**.
2. Click **New** and then fill in the form.

**On-Call Contact Source form**

<table>
<thead>
<tr>
<th>Name</th>
<th>Unique and meaningful display label for the type of contact source.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table that contains the contact source.</td>
</tr>
<tr>
<td>User Field</td>
<td>Reference field to the user table. This field appears only for some tables.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the contact source for use.</td>
</tr>
<tr>
<td>Source Type</td>
<td>Type of communication method.</td>
</tr>
<tr>
<td>Source</td>
<td>• For email, the source of the email address.</td>
</tr>
<tr>
<td></td>
<td>• For phone numbers, the source of the phone number.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Override contact preferences for a shift**

Override all shift members’ contact preferences to enforce a communication channel, for example, in case of an emergency.

Role required: rota_admin, rota_manager

1. Use one of the following methods to open the Edit Escalation and Contact Preferences page:
1. Navigate to **On-Call Scheduling > On-Call Schedules.** The On-Call Schedules page opens to the All On-Call Schedules tab.

2. Click a schedule card.

3. On the **Shifts** tab, click the Actions icon

   for the shift and select **Edit Escalation and Contact Preferences.**

1. Navigate to **On-Call Scheduling > My Group Schedules.**

2. Select the shift.

3. Click **Edit Escalation and Contact Preferences**

   2. On the **Contact Preferences** tab, click the contact **Attempt** method to configure.
   The **Contact Preferences** dialog box appears.

3. Select the contact methods that the instance should use for all shift members for the selected contact attempt.
   Depending on your instance configuration, you can specify any or all of the following notification methods:
   - SMS text
   - Email
   - Slack
   - Voice

   **Note:** SMS and voice require that Notify is active.

4. Enable the **Override user preference** option.

### Manage shifts from the Calendar view

The Calendar view displays all shifts for a user group for a specified time interval. Use the Calendar view of an On-Call schedule to update or manage shifts.

**Role required:**
- View and update: rota_admin, rota_manager, or admin
- View only: itil

- For information on updating a shift, see **Update shift details from the On-Call calendar.**
- For information on managing a shift, see **Configure or update an On-Call shift.**

1. Navigate to **On-Call Scheduling > On-Call Calendars.**

2. Click the Calendar View icon

   to open the calendar view of shifts.

   By default, the calendar displays one month of shifts.

   **Fastpath:** The Time Zone view displays shift members grouped by shift within the specified geographical time zone. To open the Time Zone view on this page, click the Time Zone icon.
See Manage shifts from the Timeline view.

3. Perform any of the following operations to organize the view for your needs:
   - Specify the time period that appears: View events for the current day, week, or month: In the title bar, click **Day**, **Week**, or **Month**.

     **Note:** You cannot view the calendar for a month in the Timeline view.

   - Navigate to the previous or the next occurrence of the time period: In the title bar, click the left or the right arrow next to **Today**.
   - View the event of any specific day, week, or month: In the title bar, click the Calendar icon and specify the date.
   - View the list of navigation shortcuts: In the title bar, click the keyboard shortcuts icon.

4. Configure the view: Click the Filter icon.

   - To show working hours for a time zone, enable **Time zone**.
   - To view roster assignments within a time zone, click the **Primary**, **Secondary**, or **Tertiary** check box as needed.
   - To view roster assignments for all rosters in all time zones, select the **Show all rosters** check box.
To show gaps: In the **Review options** section, enable **Show gaps**. An info icon indicates a shift with gaps. Click the icon to view the gaps. Gaps occur when no one is on-call when support coverage is required. Possible reasons:

- Time off without coverage.
- User has been moved out of the group.
- User is marked as inactive.
For information on resolving gaps and conflicts, see *Resolve gaps, conflicts, and time-off requests in a shift*.

- To show conflicts: In the **Review options** section, enable **Show conflicts**.

  For example, a conflict occurs when a user is assigned as both primary and secondary point of contact for a shift. An info icon indicates a shift with conflicts. Click the icon to view the conflicts.

  For information on resolving gaps and conflicts, see *Resolve gaps, conflicts, and time-off requests in a shift*.

5. To save the view settings, click the Bookmark this filter icon.

---

**Manage shifts from the Timeline view**

Use the Timeline view of an On-Call schedule to update or manage shifts based on the geographical location of roster members.

Role required: rota_admin, itil, rota_manager, or admin

- For information on updating a shift, see *Update shift details from the On-Call calendar*.
- For information on managing a shift, see *Configure or update an On-Call shift*.

1. Navigate to **On-Call Scheduling > On-Call Calendars**.
2. Click the Timeline view icon.

   ![Timeline view icon](image)

   **Fastpath:** The Calendar view on this page displays all shifts for a user group for a specified time interval. To open the Calendar view, click the Calendar View icon.

   ![Calendar view icon](image)

   See *Manage shifts from the Calendar view*.

3. Perform any of the following operations to organize the view for your needs:

   - Specify the time period that appears: View events for the current day, week, or month: In the title bar, click **Day, Week, or Month**.

     ![Title bar](image)

     **Note:** You cannot view the calendar for a month in the Timeline view.

   - Navigate to the previous or the next occurrence of the time period: In the title bar, click the left or the right arrow next to **Today**.

     ![Title bar](image)

   - View the event of any specific day, week, or month: In the title bar, click the Calendar icon and specify the date.

     ![Calendar icon](image)

   - View the list of navigation shortcuts: In the title bar, click the keyboard shortcuts icon.

     ![Keyboard shortcuts icon](image)
4. Configure the view: Click the Filter icon.
   - To show working hours for a time zone, enable **Time zone**.
   - To view roster assignments within a time zone, click the **Primary**, **Secondary**, or **Tertiary** check box as needed.
   - To show gaps: In the **Review options** section, enable **Show gaps**. An info icon indicates a shift with gaps. Click the icon to view the gaps. Gaps occur when no one is on-call when support coverage is required. Possible reasons:
     - Time off without coverage.
     - User has been moved out of the group.
     - User is marked as inactive.

   For information on resolving gaps and conflicts, see *Resolve gaps, conflicts, and time-off requests in a shift*.
   - To show conflicts: In the **Review options** section, enable **Show conflicts**.

   For example, a conflict occurs when a user is assigned as both primary and secondary point of contact for a shift. An info icon indicates a shift with conflicts. Click the icon to view the conflicts.

   For information on resolving gaps and conflicts, see *Resolve gaps, conflicts, and time-off requests in a shift*.

5. To save the view settings, click the Bookmark this filter icon.

Create a group template to simplify configuring schedules

Create templates to help your group create on-call schedules. For example, use the 24/7 template, which is available in the on-call demo data, to create on-call schedules for continuous service.

Role required: rota_admin

1. Navigate to On-Call Scheduling > Administration > Group Templates.
2. Click **New** to create a new template. In the new record form that opens, enter the following details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the new template. For example, 8-5.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description of the template.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

On-Call Scheduling workflows

Workflows perform On-Call Scheduling operations.
Workflows installed with On-Call Scheduling

On-Call: Assign by Acknowledgement

The workflow uses data from escalation settings, including overlapping shifts and custom escalation settings for shifts and rosters. Depending on the settings, the workflow moves through the escalation path and sends notifications by SMS, voice, or email that ask users to accept a task.

To send notifications, a trigger rule is required. Trigger rules supersede some On-Call business rules in earlier releases. To define a trigger rule, you must deactivate business rules that you customized in earlier releases.

The workflow respects time off as specified in rosters. Roster members with time off are not included in the escalation path and no notifications are sent to them.

If Force communication channel is specified in the Escalation settings for rosters, the preferred contact method (user device) is used: SMS, email, or voice. If the preferred method is SMS and the on-call member does not have an SMS device defined, the user is not contacted even if the user has an email address. When forcing a communication channel on an escalation level does not succeed, no further communication attempts are made. The failed contact attempt is logged. The setting Force communication channel is available only if Notify is installed.

- Until acknowledged, sends on-call notifications to escalatees based on the escalation policy and configured contact preference.
- Logs escalation details for each communication.
- Resumes the workflow immediately after rejection.
- Catch-all users are treated like all other escalation users: A response is expected and the incident might be assigned to them based on their response.

On-Call: Escalations by Email

- Until acknowledged, sends on-call email notifications to escalatees based on the escalation policy and configured email contact preferences.
- Logs escalation details for each communication.
- Catch-all users are treated like all other escalation users: A response is expected and the incident might be assigned to them based on their response.

On-Call: Assign

Assigns the task to the current primary roster member.

On-Call: Check Assignment Response

- Triggered when an inbound SMS message is received.
- Based on the response in the message, assigns the task to the roster member.
- Updates the response in the corresponding notification record.

On-Call: Assign by Acknowledgement Voice

- Triggered when an outbound call is made from the on-call number to any user or device.
- Based on the response to the voice call, assigns the task to the roster member.
- Updates the response in the corresponding notification record.

On-Call: Time-off approval
• Triggered when vacation time off (PTO) is requested by a user.
• Sends approval requests to appropriate managers.

On-Call: Conference Call Escalation

• Triggered when a conference call is initiated and a group is added to the call.
• Makes a voice call to the first group member in the escalation policy.
• If the member does not join the conference call, then escalates to next group member in the policy

Workflow Activities for On-Call Scheduling

Workflow activities in On-Call Scheduling workflows.

Escalation workflow activities

On-Call: Log Escalation Start

Creates an escalation record based on group, task, and workflow details

Note:

The escalation that the workflow creates the workflow.scratchpad.escalationSysId sys_id. Use the sys_id in any of the other workflow activities.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>sys_id of the group that the escalation belongs to.</td>
</tr>
<tr>
<td>Table</td>
<td>Table name of the task record of the incident.</td>
</tr>
<tr>
<td>Source</td>
<td>sys_id of the task record on which the escalation happened.</td>
</tr>
<tr>
<td>WorkflowDefinition</td>
<td>sys_id of the workflow definition that is used to escalate.</td>
</tr>
<tr>
<td>WorkflowContext</td>
<td>sys_id of the workflow context.</td>
</tr>
<tr>
<td>ParentEscalationLevelId</td>
<td>sys_id of the parent escalation in the case that the escalation was triggered from another escalation.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the escalation. One of: (assign_by_acknowledgement, auto_assignment, notify_manual_assignmen,conferencing).</td>
</tr>
<tr>
<td>Channels</td>
<td>Comma-separated list of the channels used to communicate during the escalation. Any or all of: (email, sms, voice, slack). For example, sms,email,voice</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>IgnoreDefReminders</td>
<td>If true, the workflow sends notification reminders as specified by the workflow, rather than as specified in On-Call Escalation settings. For example, in Conference On-Call escalations, the workflow might to dial the on-call members at one-minute intervals instead of the standard 15-minute intervals.</td>
</tr>
</tbody>
</table>

**On-Call: Log Escalation Level**

Creates an escalation level record given escalation and level details.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EscalationId</td>
<td>sys_id of the escalation to which the level belongs.</td>
</tr>
<tr>
<td>RotaId</td>
<td>sys_id of the shift for which the escalation is happening.</td>
</tr>
<tr>
<td>Level</td>
<td>Current escalation level. For example, 2.</td>
</tr>
<tr>
<td>Escalatee</td>
<td>Escalatee object at current escalation level. For example, getEscalationPlan()[1].</td>
</tr>
<tr>
<td>CatchAll</td>
<td>True if the escalation level belongs to a catch-all.</td>
</tr>
</tbody>
</table>

**On-Call: Log Escalation Attempt**

Creates a Contact attempt record given an escalation, level, and attempt details.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EscalationId</td>
<td>sys_id of the escalation to which the contact attempt belongs.</td>
</tr>
<tr>
<td>RotaId</td>
<td>sys_id of the shift for which the escalation is happening.</td>
</tr>
<tr>
<td>Level</td>
<td>Current escalation level. For example, 2.</td>
</tr>
<tr>
<td>ContactAttempt</td>
<td>Contact attempt number within the escalation level. For example, 1.</td>
</tr>
</tbody>
</table>

**On-Call: Log Escalation Communication**

Creates a communication record given escalation, level, attempt, and communication details.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EscalationId</td>
<td>sys_id of the escalation to which the communication belongs.</td>
</tr>
<tr>
<td>RotaId</td>
<td>sys_id of the shift for which escalation is happening.</td>
</tr>
<tr>
<td>Level</td>
<td>Current escalation level. For example, 2.</td>
</tr>
</tbody>
</table>
### Setting | Description
---|---
ContactAttempt | Contact attempt number within the escalation level. For example, 1.
EscalateeType | Type of escalatee to whom the communication is sent. One of: (user, device)
EscalateeId | sys_id of the user or device, depending on escalatee type.
CommType | Type of communication. One of: (sms, voice, email, slack)
CommValue | Phone number or email address, depending on communication type. For example, abel.tuter@servicenow.com
Status | Status of the communication. One of: (sent, failed).
Escalatee | Escalatee object at current escalation level. For example, getEscalationPlan()[1].
CatchAll | True if the escalation level belongs to a catch-all.

**On-Call: Log Escalation End**
Completes the escalation by setting active flag to false.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EscalationId</td>
<td>sys_id of the escalation.</td>
</tr>
</tbody>
</table>

**On-Call: Send Notification**
Sends notification to the current escalatee via voice, SMS, or Slack.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification type</td>
<td>Type of notification. One of: (sms, voice, slack).</td>
</tr>
<tr>
<td>Message</td>
<td>Text of message to send to current escalatee if notification type is sms.</td>
</tr>
</tbody>
</table>
| Notification detail | List of parameters that are required for a notification:  
  - SMS: notify_number, users, groups, numbers  
  - Voice: numberToCallFrom, numberToCall, user  
  - Slack: slack user, taskId, catchAllOption, wfContextId |

**On-Call: Manage Escalation Response**
Manage an escalation response record (insert escalation record, clean escalation records, update response to an escalation). An escalation response record keeps track of a response received for an escalation through the SMS, voice, email, or Slack notification channels.
An escalation response record is used to resume the **On-Call: Assign by Acknowledgement** workflow upon rejection of an escalation.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Context</td>
<td>Workflow context ID.</td>
</tr>
<tr>
<td>Escalatee ID</td>
<td>UserID of the current escalatee.</td>
</tr>
<tr>
<td>Table Name</td>
<td>Table name of the task record. For example, incident.</td>
</tr>
<tr>
<td>Current Record Id</td>
<td>sys_id of the task record.</td>
</tr>
<tr>
<td>Action Type</td>
<td>Type of action. One of: (add,clean,update)</td>
</tr>
<tr>
<td>Response</td>
<td>Response by escalatee to an escalation. One of: (accepted,rejected)</td>
</tr>
</tbody>
</table>

Example uses:
- Insert (add) - Workflow Context, Escalatee ID, Table Name, Current Record ID
- Clean - Workflow Context
- Update - Escalatee ID, Table Name, Current Record ID, Response

### Setting up Slack as a contact method

You configure Slack to enable users to receive Slack notifications for escalations. To offer Slack as a contact method for shift members, you install the IntegrationHub spoke for Slack.

#### Procedure: Configuring Slack for On-Call Scheduling

For more information on the IntegrationHub implementation, see *Slack spoke*. To configure the integration with Slack, follow the instructions at: *Set up Slack spoke*.

The Slack spoke automates On-Call Scheduling notifications and responds to them. The following configurations support On-Call Scheduling notifications:

### Outbound Configurations

**Slack > Outbound Configurations > On-Call: Assign by Acknowledgement**

Generates a general escalation message. Modify the record to customize the message template.
Slack > Outbound Configurations > On-Call: Assign by Acknowledgement Catch All

Generates a catch-all escalation message. Modify this record to customize the message template.
Inbound Decisions

Slack > Inbound Decisions > On-Call: Assign by Acknowledgement Decision

Defines inbound configuration for general response handling for Accept or Reject escalation messages. Use **action_id** as the key to map outbound configuration and inbound decisions for general escalations. The answer points to the subflow that is executed when the user clicks **Accept** or **Reject**. Modify the record to change the response handling behavior.
Slack > Inbound Decisions > On-Call: Assign by Acknowledgement Catch All Decision

Inbound configuration for catch-all response handling for escalation for Accept or Reject messages. Use **action_id** as the key to map outbound configuration and inbound decisions for catch-all situations. The answer points to the subflow that is executed when the user clicks **Accept** or **Reject**. Modify the record to change response handling behavior.
Decision
On-Call: Assign by Acknowledgement Catch All Decision

Label to use for this Decision condition

Label: On-Call: Assign by Acknowledgement Catch All Deci
Order: 100

Application: Global
Answer: Flow: On-Call Assign by Acknowledgement

Default answer: [ ]

All of the following conditions must be true, for this answer to be used

Condition: action_id
Operator: is
Value: on_call_assign_by_ace

Update Delete
Subflows

On-Call Assign by Acknowledgement

This subflow handles incoming responses from Slack and then acts. For example, assign a task to a user and return an acknowledgement message. In case of rejection, the subflow logs the response and moves the escalation to the next escalatee.

Insert Slack Response

This action creates a record in the `sn_slack_ah_v2_inbound` table for incoming Slack responses. You can reference the response by workflow based on `context_id`.

On-Call Response Controller

This action performs appropriate operations when the user clicks **Accept** or **Reject** from Slack. It invokes the utility methods to perform actions from the `OnCallSlackUtils` script include.

Setting up SMS and voice messaging as contact methods

To send On-call escalation notifications as SMS or voice messages, you must configure use Notify. One important application is sending messages when an incident is assigned.

Configure the following items to use Notify with On-Call Scheduling:

- You must add at least one Notify phone number to the On-Call Group number group. This group is configured by default to handle inbound SMS responses (via On-Call: Check
Assignment Response) that accepts or rejects an on-call assignment and to handle outbound voice calls (via On-Call: Assign by Acknowledgement Voice) to accept or reject assignments.

- You must configure workflows, such as the On-Call: Assign by Acknowledgement to drive escalations via SMS and Voice.

On-Call roster members: Your schedules and preferences

You can view your schedule, see who is on-call with you, request time off, and set your preferences for contact methods.

You can view your schedule, see who is on-call with you, request time off, and set your preferences for contact methods.

Configure my availability and contact preferences

You specify your availability and the methods to use to contact you for On-Call escalations. The instance notifies you if an admin overrides your settings for some reason.

Role required: itil or admin

1. Navigate to On-Call Scheduling > My Preferences
2. On the Contact Attempts tab, click the + icon and fill in the Availability form.

<table>
<thead>
<tr>
<th>Availability form</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique and meaningful name for this record of your availability settings.</td>
</tr>
<tr>
<td>User</td>
<td>The user for whom you are creating the availability (typically yourself).</td>
</tr>
<tr>
<td>Active</td>
<td>Option to enable this availability record. Select the check box to activate your availability.</td>
</tr>
<tr>
<td>Schedule type</td>
<td>Select an existing availability schedule or create a custom schedule.</td>
</tr>
</tbody>
</table>

Use these fields to create a custom availability schedule:

| Start time | If this shift is not an all-day shift, then specify the start time of your availability. |
| End time   | The end time of your availability. |
| Repeat on  | The time of a single duration. For example, if you select weekly repetitions, specify the days of the week when you are available. |
| Time zone  | The time zone of your availability. |

Note: The time zone is not editable and is taken from your user's profile.

3. Click Submit.
4. On the Contact Preferences tab, click the contact Attempt method to configure.

The Contact Preferences dialog box appears.
5. Select the contact methods that the instance should use to contact you while you are on-call.

The methods you select are the contact methods that the instance should use for this contact attempt. Depending on your instance configuration, you can specify any or all of the following notification methods:

- SMS text
- Email
- Slack
- Voice

6. Repeat the process for each contact attempt.

Note: Admins can specify overrides of your contact methods for all members of your group. Override settings appear on the Contact Overrides tab.

View my group schedules

You can see the on-call schedules for your groups.

Role required: itil

1. Navigate to On-Call Scheduling > My Group Schedules.
2. Open a schedule.
3. Optional: To view a roster, click its order number in the Rosters related list.

View my personal schedule on the My Schedule report

You can view when you are on call and the escalation lineup for a particular date range.

Role required: itil

1. Navigate to On-Call Scheduling > Reports > My Schedule Report.
2. In the Show for field, select a date range and then click Submit.

The User Rotation Schedules list shows the shift, the roster, and the start and end times for each timeslot.
3. To view alternate rosters, expand an entry by clicking the arrow. The alternate roster appears for that timeslot. For example, if you are the primary contact, this list shows secondary and tertiary contacts for the timeslot.
<table>
<thead>
<tr>
<th>User</th>
<th>Shift</th>
<th>Role</th>
<th>Type</th>
<th>Start date</th>
<th>End date</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITA User</td>
<td>Hardware (Weekend)</td>
<td>Primary</td>
<td>On-call</td>
<td>2019-04-20 00:00:00</td>
<td>2019-04-21 15:30:00</td>
</tr>
<tr>
<td>ITA User</td>
<td>Global</td>
<td>Primary</td>
<td>On-call</td>
<td>2019-04-20 00:00:00</td>
<td>2019-04-28 22:00:00</td>
</tr>
<tr>
<td>ITA User</td>
<td>Americas</td>
<td>Notify All</td>
<td>2019-04-20 00:00:00</td>
<td>2019-04-21 15:00:00</td>
<td></td>
</tr>
<tr>
<td>ITA User</td>
<td>Americas</td>
<td>Secondary</td>
<td>On-call</td>
<td>2019-04-20 00:00:00</td>
<td>2019-04-26 18:00:00</td>
</tr>
<tr>
<td>ITA User</td>
<td>Hardware (APAC)</td>
<td>Primary</td>
<td>On-call</td>
<td>2019-04-20 15:00:00</td>
<td>2019-04-21 23:30:00</td>
</tr>
</tbody>
</table>
Request time off and suggest who can cover

You can schedule your own time off and suggest a suitable cover from among fellow roster members.

To use this feature, the system administrator must enable the Configuration to determine if PTO requests need approval system property (com.snc.on_call_rotation.pto.approval.required).

Role required: itil

1. Navigate to On-call Calendar.
2. Select the shift entry for the time off.
3. Click Schedule Time Off and fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Member</td>
<td>The member getting time off (typically, yourself).</td>
</tr>
<tr>
<td>Starts and Ends</td>
<td>Start and end dates for the time off.</td>
</tr>
<tr>
<td>Propose cover</td>
<td>Name of a roster member who can provide cover in the absence.</td>
</tr>
<tr>
<td>All day event</td>
<td>Option to specify that the time-off period involves full workdays.</td>
</tr>
</tbody>
</table>
4. Click Schedule.
The time off is tentatively scheduled in your On-Call calendar.

View my On-Call calendar on my calendar app
You can subscribe to your On-Call calendar using your personal calendar client.
1. Ensure that your calendar client uses and supports the iCalendar format.
2. Ensure that your calendar client can subscribe to an external calendar.
3. If calendar client meets the requirements, ask your shift manager to send your On-Call calendar subscription URL by email notification.

Attention: You must provide your instance credentials to authenticate yourself to use the subscription URL to view On-Call events. Currently, only the Calendar application on Mac OS X 8.0 and newer and the Outlook application on Windows 2013 and newer support authenticated calendar subscriptions.

Role required: rota_admin, itil, rota_manager, or admin
1. On your calendar client, add a new external calendar subscription.
2. Enter the On-Call calendar subscription URL that you received.
3. Click Subscribe.
4. Enter your login details for your instance.
5. Specify additional details such as how frequently to update the calendar.

Run a Schedule report to view my schedule
An On-Call Rotation Schedule report shows users or groups that are on-call for a specified time period.

Role required: itil
1. Navigate to On-Call Scheduling > Reports > Schedule Report.
The On-Call Rotation Schedule report form opens.
2. Specify the Report style:
   - Table: Display a list that can be sorted, filtered, and configured.
   - Formatted: Generate a report in PDF format. Click Click to Print to print the report.
3. Select the start date for the report.
4. Move at least one group into the Selected list.
Enter the first few letters of the group into the Name starts with field to see a list of groups that start with those letters. Or select the All groups check box to see the list of all groups.
5. Click Run Report.
Example Formatted report: The report shows on-call commitments for all specified groups during the specified date range.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Monday</td>
<td>Tuesday</td>
<td>Wednesday</td>
<td>Thursday</td>
<td>Friday</td>
</tr>
<tr>
<td>Hardware (US)</td>
<td>Primary</td>
<td>07:00:00-15:30:00</td>
<td>Beth Anglin</td>
<td>Beth Anglin</td>
<td>Beth Anglin</td>
<td>Beth Anglin</td>
<td>Beth Anglin</td>
</tr>
<tr>
<td></td>
<td>Secondary</td>
<td>07:00:00-15:30:00</td>
<td>David Loo</td>
<td>David Loo</td>
<td>David Loo</td>
<td>David Loo</td>
<td>David Loo</td>
</tr>
<tr>
<td>Hardware (APAC)</td>
<td>Primary</td>
<td>15:00:00-23:30:00</td>
<td>David Dan</td>
<td>David Dan</td>
<td>David Dan</td>
<td>David Dan</td>
<td>David Dan</td>
</tr>
<tr>
<td></td>
<td>Secondary</td>
<td>15:00:00-23:30:00</td>
<td>Bow Ruggeri</td>
<td>Bow Ruggeri</td>
<td>Bow Ruggeri</td>
<td>Bow Ruggeri</td>
<td>Bow Ruggeri</td>
</tr>
<tr>
<td>Hardware (Weekend)</td>
<td>Primary</td>
<td>15:00:00-23:59:59</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ITIL User</td>
</tr>
</tbody>
</table>

Run an Escalations report to view who is on call

The Escalations report displays the escalation sequence and the rules that apply for a selected date. For each group that you are authorized to see, you can choose to show either the active roster members or the on-call person.

Role required: itil

1. Navigate to On-Call Scheduling > Reports > Escalations Report.
2. Select a value for the For each group, show setting.
   - Active escalation members: Display the on-call persons and catch-all persons in the escalation order, along with their delay times.
   - On-call person: Determine who is on duty.
3. Select the start date for the report.
4. Move at least one group into the Selected list.
   Enter the first few letters of the group into the Name starts with field to see a list of groups that start with those letters. Or select the All groups check box to see the list of all groups.
5. Click Run Report.
Mobile experience for On-Call Scheduling

View and manage on-call schedules from a mobile device with the On-Call Scheduling mobile applet.

On-call managers and shift managers can perform the following actions:

- View your group's on-call schedule including any gaps, time-off requests, and so on.
- View roster and escalation details for a shift.
- Review and act on gaps and conflicts.
- Approve/Reject time-off and shift-swap requests.
- Provide, replace, or delete coverage and delete time offs.

Members of a roster can perform the following actions:

- View your on-call schedules, who else is on-call during a shift, and your role for the shift (primary/secondary).
- View the roster and escalation details for a shift.
- Submit time-off and shift swap requests.
- Send a message (Slack/MS teams/Push notifications) to find a replacement.

Getting started with the On-Call Scheduling mobile app

Use the ServiceNow Agent mobile app to access the On-Call Scheduling mobile application. Then log in to an instance and work on your schedules.

Depending on your device, go to the Apple App Store or the Google Play Store and download the ServiceNow Agent mobile app.

1. Tap the mobile app icon on your device, and then tap + to open an instance.
2. In the instance address field, enter the instance address in one of two ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual input</td>
<td>Type the instance address in the instance address field.</td>
</tr>
<tr>
<td></td>
<td>Note: You do not need to include service-now.com at the end of the instance name.</td>
</tr>
<tr>
<td>Scan QR code</td>
<td>Tap the QR icon (Scan a QR code), and then scan the QR code that was provided by your administrator.</td>
</tr>
</tbody>
</table>

3. Tap Login.

Mobile On-Call Scheduling overview

Members and managers of a shift can use the On-Call Scheduling applets and navigation menu on the ServiceNow Agent application to view and manage shifts and schedules.
Applet launchers

Applet launchers serve as landing pages or home pages. When you log in to your instance, you see an applet launcher and the applets configured to display on that launcher. The system administrator configures the applet launcher and applets for the Now Agent mobile application.

Navigation bar

The navigation bar appears at the bottom of the mobile application screen. This bar includes the following tabs that you can use to access different applets and application launch pages:

- **My Work:** As a member of a shift, view your upcoming shifts, request time off, and accomplish daily tasks related to your schedule.
- **My Team:** As an on-call manager, view your team’s schedule and act upon important activities, like approving time-off requests and providing coverage.
- **Notification:** View a list of the notifications that have been pushed to an agent. Tap a notification in the list to see the details, then tap the details open the case.
- **Settings:** Manage settings for the mobile application.

Mobile On-Call Scheduling

As a member of a shift, view your upcoming shifts, request time off, and accomplish daily tasks related to your schedule.

My work application in the mobile agent app has the On-Call Scheduling applet to access your upcoming shifts and time-off requests of members of your team.

### On-call schedule actions - Upcoming shifts

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap on <strong>Upcoming shifts</strong></td>
<td>View all upcoming shifts for the current month.</td>
</tr>
<tr>
<td>Swipe left on the shift card</td>
<td>Request time off for the shift.</td>
</tr>
<tr>
<td>Tap on the shift card</td>
<td>View details for the shift like the group, roster, start time, and end time.</td>
</tr>
<tr>
<td>Tap <strong>Request time-off</strong></td>
<td>Request time off for the shift.</td>
</tr>
<tr>
<td>Tap the icon.</td>
<td>Changes the view of the calendar from monthly to daily.</td>
</tr>
</tbody>
</table>

### On-call schedule - Time-off requests

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap on <strong>Time-off requests</strong></td>
<td>View a list of time-off requests divided into pending and completed requests.</td>
</tr>
<tr>
<td>Tap the filter icon</td>
<td>Filter the time-off requests.</td>
</tr>
<tr>
<td>Tap the menu icon</td>
<td>Request time off from the Time-off requests screen.</td>
</tr>
<tr>
<td>Tap a pending time-off request</td>
<td>View the details of the request.</td>
</tr>
</tbody>
</table>
Tap Cancel time-off

Cancel the time-off request by clicking YES on the confirmation message.

On-call schedule- Who is on-call

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap Who is on-call</td>
<td>View a form that lets you select a group from a list of groups.</td>
</tr>
<tr>
<td>Tap the right arrow</td>
<td>View the list of groups that should be on-call in a schedule.</td>
</tr>
<tr>
<td>Select a group</td>
<td>Select a group from the list of groups and click the arrow to view who is on-call for the schedule.</td>
</tr>
</tbody>
</table>

Mobile My team On-Call Scheduling

As an On-Call Scheduling manager, view your team’s schedule and perform activities like approving time-off requests and providing coverage.

On-call schedule actions: Upcoming shifts

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap Upcoming shifts</td>
<td>View all upcoming shifts for the current month.</td>
</tr>
<tr>
<td>Swipe left on the shift card</td>
<td>Request time off for this shift.</td>
</tr>
<tr>
<td>Tap the shift card</td>
<td>View details for the shift (like group, roster, start time, and end time).</td>
</tr>
<tr>
<td>Tap Request time-off</td>
<td>Request time off for this shift by providing information on the Request time-off screen.</td>
</tr>
<tr>
<td>Tap Provide Coverage</td>
<td>Provide coverage for a shift member.</td>
</tr>
</tbody>
</table>

On-call schedule: Time-off requests

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap Time-off requests</td>
<td>View a list of time-off requests divided into pending and completed requests.</td>
</tr>
<tr>
<td>Tap the filter icon</td>
<td>Filter the time-off requests using filters like End date or group.</td>
</tr>
<tr>
<td>Tap the menu icon</td>
<td>Request time off on the Time-off requests screen.</td>
</tr>
<tr>
<td>Tap a pending time-off request</td>
<td>View details of the request.</td>
</tr>
<tr>
<td>Tap Approve or Reject</td>
<td>Approve or reject a time-off request.</td>
</tr>
<tr>
<td>Note</td>
<td>Add a reason for rejection of a time-off request.</td>
</tr>
</tbody>
</table>
On-call schedule: Gaps and conflicts

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap Gaps and conflicts</td>
<td>View a list of all the gaps and conflicts for the shifts in your group.</td>
</tr>
<tr>
<td>Tap any day of the month</td>
<td>View all gaps and conflicts for shifts on that day.</td>
</tr>
<tr>
<td>Tap any of the shift cards</td>
<td>View gaps and conflicts for the shift.</td>
</tr>
<tr>
<td>Swipe left on any of the shift cards</td>
<td>Tap <strong>Provide coverage</strong> to provide coverage for the shift.</td>
</tr>
<tr>
<td>Tap <strong>Provide Coverage</strong></td>
<td>Provide coverage for a gap in the shift.</td>
</tr>
</tbody>
</table>

**Problem Management**

ServiceNow® Problem Management helps to identify the cause of an error in the IT infrastructure, reported as occurrences of related incidents.

Problem Management is responsible for managing the life cycle of all problems and to prevent problems and resulting incidents from happening. It also aims at eliminating recurring incidents and minimizing the impact of incidents that cannot be prevented. Resolving a problem includes the activities required to diagnose the root cause of incidents and to determine the resolution for the problem. Problem resolution and elimination of root cause often calls for applying a change to the configuration item in the existing IT environment.

Problem Management also maintains information about problems and the appropriate workarounds and resolutions, so that the organization is able to reduce the number and impact of incidents over time. In this respect, Problem Management has a strong interface with Knowledge Management so that the known error articles are documented thoroughly for any future reference.

**Explore**

- Problem Management process
- Life cycle of a problem
- Problem management integrations

**Set up**

- Configuring problem management
- Problem management integrations

**Administer**

- Managing Problems
- Communicating the outcome of a problem

**Use**

- Data lookup for prioritizing problems
- Quick start tests for Problem Management
- Communicating the outcome of a problem

**Develop**

- Developer training
- Developer documentation

**Troubleshoot and get help**

- Ask or answer questions in the Problem Management community
- Search the HI knowledge base for known error articles
- Contact ServiceNow Technical Support

**Understanding problem management**

Understand the Problem Management process, the plugins that you activate, and the functionalities that you can validate after any configuration change.
Problem Management process

Problem Management supports the ITIL process to find and fix the root cause of issues that result in incidents. You can record problems, associate incidents, and assign them to appropriate groups. You can create knowledge from problems, request changes, escalate, and manage problems to its resolution and reporting.

Within the platform, problems are handled using the task record system. Each problem is generated as a task record through various means, and is populated with the pertinent information. These tasks are assigned to Problem Management team members to resolve and then close.

Identify and log problems

A problem can be created in several ways. For detailed information, refer Create a problem. Associating a problem with a configuration item using CMDB helps the Problem Management team see the affected items and its relationship to other configuration items.

A problem can be associated with one or more incidents in the Incidents related list. The association is automatic if the problem is generated from an incident. Associating incidents provides the Problem Management team with access to the information gathered during incident investigation.

Investigate and update problems

If the Problem Management team has a problem model process for dealing with certain problems, they can be added to the system with workflows. Workflows standardize and automate a process.

As a problem is updated, email notifications are sent to concerned parties. If inbound email actions are specified, the problem can be updated via email.

You can use the other active tasks icon next to Configuration item to look up active problem records. When you click the icon, it shows all active tasks linked to that configuration item.

The platform provides escalations rules to ensure that problems are handled promptly. Two types of escalation rules are available in the system.

- **Service level agreements**: SLAs can be used to ensure that problems are highlighted. As investigating and fixing a problem could be a long-term effort, it is not recommended that you apply SLAs to an overall problem. SLAs are also used as a performance indicator for the Problem Management team.
- **Set an inactivity monitor**: The inactivity monitors prevent problems from being overlooked by generating an event. When a problem has not been updated within a certain amount of time, the event can create an email notification or trigger a script.

Resolve problems

If a problem needs a change request to be resolved, it is possible to request a change that goes through the change management process. After requesting a change, the problem appears on a related list on the Change Request form.
Note: For Madrid Best Practices: The problem coordinator, whom the Problem is assigned to, is notified when all related change requests are completed or canceled.

The following information applies for London and prior releases:

- A business rule (SNC-ITIL-Close-related) automates the process of closing problems in Pending Change state when the change request is closed. If the problem is closed, another business rule (SNC-ITIL-Resolve Related Incidents) automatically sets the State to Resolved for all incidents associated with that problem whose State was On Hold and On hold reason was Awaiting Problem.
- If the cause of a problem has been determined but there is no permanent fix, change the problem state to Known Error to communicate this fact. IT agents can click the Known Errors module and look for the issue they are investigating to reduce time spent on a similar issue. To communicate information related to a problem, you can open the problem and describe a workaround, create a knowledge base article, or create a news item.

Life cycle of a problem

Problem Management is responsible for managing the life cycle of underlying problems. State transition of a problem guides you through the stages of a problem life cycle, from creation to closure.

Problem Management has one single goal: Identifying and resolving the underlying issues that cause Incidents. Problem Management is a systematic, methodical process where time to resolution is less important than identifying and resolving the root cause.

Note: The state-based information is available only in new instances starting from the Madrid release. Activate the Problem Management Best Practice — Madrid — State Model (com.snc.best_practices.problem.madrid.state_model) plugin. Existing users (London and prior releases) cannot activate this plugin.

The Problem Management process has many states, and each is vitally important to the success of the process and the quality of service delivered. The different states can be represented in a diagram as follows:
Problem Management state transitions

Life cycle of a problem task

A problem task is the smallest unit of work that you should perform to complete a problem. State transition of a problem task guides you through the stages of a problem task life cycle, from creation to closure.

If a problem coordinator requires help to resolve a problem, the coordinator can create and assign problem tasks to assignment groups or users to complete those activities.

Note: The state-based information is available only in new instances starting from the Madrid release. Activate the Problem Management Best Practice — Madrid — State Model (com.snc.best_practices.problem.madrid.state_model) plugin. Existing users cannot activate the plugin.

You can create the following types of tasks:

- **Root Cause Analysis**: When you need to investigate the root cause and the resolution for a problem
- **General**: For any other task
Problem task state transitions

Problem Management plugins

Many of the Problem Management plugins are activated in the base system. Others, you can activate when you are ready to use them. Some plugins include demo data.

**Activate Problem Management**

You can activate the Problem Management plugin (com.snc.problem) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

The Problem Management plugin activates these related plugins if they are not already active.

**Plugins for Problem Management**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem Overview Homepage</td>
<td>This plugin delivers content for Problem Overview home page.</td>
</tr>
<tr>
<td>(com.glideapp.report.itsm.problem.overview)</td>
<td></td>
</tr>
</tbody>
</table>

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

### Components installed with Problem Management

Several types of components are installed with activation of the Problem Management plugin, including tables.

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem</td>
<td>The Problem table is extended from the Task (task) table. It inherits all the fields, rules and policies from task.</td>
</tr>
</tbody>
</table>

### Activate Problem Management Best Practice — Madrid

Activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Role required:** admin

The Problem Management Best Practice — Madrid plugin identifies the cause of a service interruption reported by a significant or recurring incidents. The plugin does the following activities:

- Provides roles for problem management including a problem task analyst, a problem coordinator, a problem manager, and a problem administrator.
- Provides fields to record the category where the issue was first reported, the workaround, the cause notes, and the fix notes.
- Searches for and attaches knowledge articles.
- Communicates when a workaround or fix is available.
- Clears the **Assigned to** field when changing the **Assignment Group**.

**Note:** The plugin is activated by default for the new customers. Existing customers need to request the plugin.

1. **Navigate to** System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar. You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.
3. **Click Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the
Components installed with Problem Management

Several types of components are installed with activation of the Problem Management Best Practice — Madrid plugin, including user roles.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem Task Analyst</td>
<td>Works on a problem task and manages it through its life cycle.</td>
<td>None</td>
</tr>
<tr>
<td>(problem_task_analyst)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Co-ordinator</td>
<td>Works on a problem or problem task and manages it through its life cycle.</td>
<td>problem_task_analyst and itil</td>
</tr>
<tr>
<td>(problem_coordinator)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Manager</td>
<td>Responsible for the overall problem management process and can configure problem management settings as well as act as a problem coordinator.</td>
<td>problem_coordinator</td>
</tr>
<tr>
<td>(problem_manager)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Admin</td>
<td>Responsible for the overall problem management process as well as delete problems and problem tasks.</td>
<td>problem_manager</td>
</tr>
<tr>
<td>(problem_admin)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Activate Business Stakeholder

Activate the Business Stakeholder plugin (com.snc.business_stakeholder) if you have an admin role. This plugin installs the Business Stakeholder role. Users with this role can view and approve records at all ITSM product levels.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
Installed with Business Stakeholder

The Business Stakeholder plugin (com.snc.business_stakeholder) installs the Business Stakeholder role when activated.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Business Stakeholder      | Users with this role can view and approve records within all products of ITSM. | • pa_viewer.business_stakeholder  
                             | (business_stakeholder)                                                        | • approver_user.business_stakeholder  
                             |                                                                 | • cmdb_read.business_stakeholder     |

Note: The business_stakeholder role contains the following ITSM roles sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.

Request ITSM Roles — Problem Management

Request the ITSM Roles plugin (com.snc.itsm.roles) to activate the ITSM Roles — Problem Management plugin (com.snc.itsm.roles.problem_management) to gain more control over the access that different service desk agents, technicians, and managers have within your Problem Management process.

Role required: admin

The ITSM Roles plugin (com.snc.itsm.roles) includes an additional security model. The security model provides more granular roles across ITSM applications as well as within them, allowing you flexibility in setting up access controls. The ITSM Roles plugin is available by default in new instances. Users upgrading from Madrid or earlier versions must request the plugin.

Plugins for ITSM Roles

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Adds roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Stakeholder (com.snc.business_stakeholder)</td>
<td>business_stakeholder</td>
</tr>
<tr>
<td></td>
<td>Note: The business_stakeholder role contains the sn_incident_read,</td>
</tr>
<tr>
<td></td>
<td>sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.</td>
</tr>
</tbody>
</table>

ITSM Roles — Incident Management (com.snc.itsm.roles.incident_management) | • sn_incident_read  
                                                                          | • sn_incident_write
<table>
<thead>
<tr>
<th>Plugin</th>
<th>Adds roles</th>
</tr>
</thead>
</table>
| ITSM Roles — Problem Management (com.snc.itsm.roles.problem_management) | • sn_problem_read  
• sn_problem_write |
| ITSM Roles — Change Management (com.snc.itsm.roles.change_management) | • sn_change_read  
• sn_change_write |
| ITSM Roles — Request Management (com.snc.service_management.roles.request_management) | • sn_request_read  
• sn_request_write |

Note: As there are future updates expected for the sn_request_read role, do not assign it to users without the business_stakeholder role.

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and subproduction instances, generally within a few days.

If you don’t have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the request form on H1.

Note: Activate the ITSM Roles plugin on a subproduction environment and test the functionality before requesting activation in the production environment. For assistance, contact the ServiceNow Professional Services team.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.
4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click Submit.

**Components installed with ITSM Roles — Problem Management**

Several user roles are installed with activation of the ITSM Roles — Problem Management plugin (com.snc.itsm.roles.problem_management).

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.
Activate Problem Management Best Practice — Madrid — State Model


Role required: admin

The new best practices are not compatible with the previous version of problem management and requires verification before this plugin can be activated. The plugin is activated by default for the new customers.

Existing customers should use the Migration Utility to verify and migrate to this plugin.

Activate Problem Management Best Practice — Madrid — Knowledge Integration

Activate the Problem Management Best Practice — Madrid — Knowledge Integration (com.snc.best_practice.problem.madrid.knowledge) plugin if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

The Problem Management Best Practice — Madrid — Knowledge Integration plugin (com.snc.best_practice.problem.madrid.knowledge) helps you to create known error articles to help with incident deflection. The plugin helps in the following activities:

- Creating a known error article from a problem.
- Creating a knowledge base for known error articles.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
Components installed with Problem Management

Several types of components are installed with activation of the Problem Management Best Practice — Madrid — Knowledge Integration plugin, including tables. Demo data is available for this feature.

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Known Error article</td>
<td>Table to store Known Error articles.</td>
</tr>
<tr>
<td>(kb_template_known_error_article)</td>
<td></td>
</tr>
</tbody>
</table>

Activate Problem Management — ATF Tests

You can activate the Problem Management — ATF Tests plugin (com.snc.problem.atf) if you have the admin role. This plugin includes demo data.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Activate Problem Management Best Practice — Jakarta

The Problem Management Best Practice — Jakarta plugin introduces lookups (impact, urgency and priority) for Problem Management.

Role required: admin

Important: Do not activate this plugin if you have upgraded from a pre-Jakarta release.

If you have modified the base functionality required for the Problem Management Best Practice — Madrid — State Model plugin (com.snc.best_practice.problem.madrid.state_model), use the Migration Utility to repair the plugin.

Migration Utility

The Problem Management Migration Utility, available in the ServiceNow® Store, is a guided setup application that helps you upgrade to adopt the base version of Problem Management using the guided problem life cycle.
Important:
If you run into issues or need additional help with resolving your modifications, contact your ServiceNow Account Representative or ServiceNow Solution Consultant. You might need help from ServiceNow Customer Outcomes or a partner.

The migration utility consists of several guided activities:

---

**Introduction**
Describes the purpose of the Problem Management Best Practice State Model plugin and the migration utility. This activity also confirms that you have practiced or are practicing on a sub-production instance that is a clone of the production instance.

**Preparation**
Helps you prepare for your migration, including optional scenarios if you want to remove all of your existing problem and problem task records.

**Migrate**
Guides you through the Migration job.

**Clean-up**
The guided setup activity guides you through the manual clean-up activities after you have completed the main migration.

---

**Introducing activities for migration**
The Introduction activity helps you to understand the purpose of the migration utility.
The activity helps you understand the Problem Management Best Practice State Model plugin and the new problem and task states. This activity also confirms that you have practiced or are practicing on a sub-production instance that is a clone of the production instance.

**Preparing for migration**
You can prepare your instance for migration before you start the migration activity. Before you start the migration activity, if you want to optionally remove all of your problem records or all of your problem task records, take a backup of the records first before you remove them.

**Migration job**
Get your instance ready for the Problem Management Best Practice — Madrid — State Model plugin (com.snc.best_practice.problem.madrid.state_model) and so you can update your existing records with the new states.

The stages to get your instance ready for the problem state model and to migrate your records are:

1. **Resolve blocking modifications**
2. **Review warning modifications**
3. **Map problem states**
4. **Map problem task states**
5. **Activate Problem Management Best Practice — Madrid — State Model**
6. Prepare base plugins
7. Restore base plugins
8. Resolve blocking and warning modifications
9. Migrate active records
10. Migrate inactive records

Resolve blocking modifications

Blocking modifications that are detected in your instance are not compatible with the problem state model and you must resolve them before you activate the Problem Management Best Practice — Madrid — State Model plugin.

Role required: admin

1. Review and resolve all blocking modifications.
   For more information about modifications that block the problem state model plugin from being activated, see the KB0819060 article in the Hi Knowledge Base.
2. Click Run Checks.

Review warning modifications.

Review warning modifications

Warning modifications do not block the Problem Management Best Practice — Madrid — State Model plugin from being activated.

Role required: admin

For more information about warning and informational modifications and how to resolve them, see the Problem Management Migration Utility - How to resolve detected modifications (KB0819196) article in the Hi Knowledge Base.

1. Review and resolve all warning modifications.
   Warning modifications, though initially are not blocking, can become blocking when you activate the problem state model plugin. You must resolve them before you can migrate your records.
2. View informational modifications.
   Informational modifications provide information about only the changes that you have made that do not impact the migration.
3. If you resolved any warnings, click Run Checks.
4. Click Next.

Map problem states.

Map problem states

Define how problem records are updated when you migrate the records.

Role required: admin

1. Provide information for all the mandatory fields at this stage.
   The required field values are used when you apply new states to the existing problem records.
2. Map all current problem states to the new states.
   The following table provides an example of state mapping for the base system version of the
   problem records:

   **Mapping of the current states to the new states**

<table>
<thead>
<tr>
<th>Current state</th>
<th>New state</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Open</td>
<td>101 - New</td>
</tr>
<tr>
<td>2 - Known Error</td>
<td>107 - Closed as Risk Accepted</td>
</tr>
<tr>
<td>3 - Pending Change</td>
<td>104 - Fix in Progress</td>
</tr>
<tr>
<td>4 - Closed/Resolved</td>
<td>107 - Closed as Fix Applied</td>
</tr>
</tbody>
</table>

3. Click **Detect Unmapped States** to verify whether any state is not mapped.
   If any state is not mapped, you must provide a mapping.

   **Map problem task states.**

   **Map problem task states**

   Define how problem task records are updated when you migrate the records.

   Role required: admin

   1. Provide the information for the mandatory fields at this stage.
      The mandatory field values are used when you apply new states to the existing problem task
      records.

      **Note:**
      - The **Assigned to** field is used when the new state is beyond **151 - New** and the
        problem task is not already assigned to a user.
      - If you have activated the problem state model plugin, you can assign only users
        with the **problem_task_analyst**, **problem_coordinator**, **problem_manager** or
        **problem_admin** role.
      - The **${current.state}** variable is replaced with the current state value and label.

   2. Map all current problem task states to the new states.
      The following table provides an example of state mapping for the base system version of the
      problem task records:

      **Mapping of the current states to the new states**

      | Current state     | New state |
      |-------------------|-----------|
      | -5 - Pending      | 151 - New |
### Current state | New state
--- | ---
1 - Open | 151 - New
2 - Work in Progress | 154 - Work in Progress
3 - Closed Complete | 157 - Closed as Complete
4 - Closed Incomplete | 157 - Closed as Canceled
7 - Closed Skipped | 157 - Closed as Canceled

3. **Click Detect Unmapped States** to verify whether any state is not mapped. If any state is not mapped, you must provide a mapping.

### Activate Problem Management Best Practice — Madrid — State Model

You can activate the Problem Management Best Practice — Madrid — State Model plugin (com.snc.best_practice.problem.madrid.state_model) on your instance using the Problem Management Migration Utility store app.

Before you activate the plugin, be sure to resolve blocking modifications. For more information, see [Resolve blocking modifications](#).

**Role required:** admin

An administrator must activate the Problem Management Best Practice — Madrid — State Model plugin (com.snc.best_practice.problem.madrid.state_model) (first introduced in the Madrid release) through the Migration Utility because the plugin includes features that are not compatible with the previous version of Problem Management.

New York Patch 9 or Orlando Patch 3 or later are required before the administrator can see and activate the problem state model plugin on an instance. If you do not have the required patch, you have to request the plugin as it is a development plugin.

1. **Activate the plugin.**

   If you have the required patch level, you have access to the plugin and can activate it. If you do not have the patch level, you must request it.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
   | **Activate the plugin (required patch level is installed)** | 1. Click **Request Plugin** in the plugin activation stage of the migration utility migration job.  
   2. On the System Plugin page, click the **Activate/Repair** related link.  
   3. Click **Activate**.  
   4. Close and reload the form.  
   The plugin status changes to **Activated**. You can return to the Migration Utility and continue with the migration. |

© 2020 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Request the plugin | 1. Click **Request Plugin** in the plugin activation stage of the migration utility migration job.  
2. On the **ServiceNow HI Request Plugin** page, provide the required details.  
   - Target instance: Instance on which to request the plugin  
   - Plugin Name: `com.snc.best_practice.problem.madrid.state_model`  
   - Reason/Comments: Request from the Problem Management Migration Utility  
   - Select Maintenance Start Time: Select your preferred start time  
3. Click **Submit**.  
4. Once the plugin is activated, return to the Migration Utility and continue with the migration. |

2. Continue with the migration process.

*Prepare base plugins.*

**Prepare base plugins**

Prepare to restore the base functionality that is required for the problem state model you have modified.

Role required: admin

*Note:* You cannot move back to any earlier stage because in the previous stage you activated the Problem Management Best Practice — Madrid — State Model plugin (`com.snc.best_practice.problem.madrid.state_model`) on this instance and the old states are invalid.

1. Resolve blocking modifications.  
   1. For each blocking modification, click **View Modification**.  
   2. Select the **Replace on upgrade** check box.  
   
   *Note:* If this option is not available, add the **Replace on update** field to the form using **Configure > Form Layout**.

3. Click **Update**.  
4. Click **Back**.

2. Click **Run Checks**.

*Restore base plugins.*
**Restore base plugins**

Repair the plugins in the specified order to restore the base functionality that is required for the problem state model.

Role required: admin

New York Patch 9, or Orlando Patch 3 or later are required before you can see and repair the Problem Management Best Practice – Jakarta (com.snc.best_practice.problem.jakarta) and Problem Management Best Practice — Madrid — State Model (com.snc.best_practice.problem.madrid.state_model) plugins. Before the mentioned patches, these plugins were development plugins.

**Note:** If you do not have the required patch, refer to Blocking modifications for required base functionality in the KB0819196 article in the HI Knowledge Base.

1. Repair the plugins, one at a time.
   1. Repair the plugin or apply the update set as required.

**Note:** Certain plugins contain functionality for applications including Problem Management. For those plugins, refer to the specified knowledge article to restore the required problem functionality instead of repairing the plugin.

2. Return to the migration job and mark that plugin as repaired.

2. Click Run Checks.

**Resolve blocking and warning modifications**

Resolve any blocking modifications and resolve or verify any warning modifications that are detected on your instance.

Role required: admin

For more information about blocking, warning, and informational modifications and how to resolve them, see the Problem Management Migration Utility - How to resolve detected modifications (KB0819196) article in the HI Knowledge Base.

1. Review and resolve all blocking modifications.
2. Review and resolve or verify warning modifications.
3. Optional: View informational modifications.
4. Click Run Checks after you have resolved all blocking modifications and you have either resolved or verified the warning modifications.

**Migrate active records**

Migrate active records to apply the new mappings to your active problem and problem task records.

Role required: admin

   Click Migrate Active Records.
If there are no active records to migrate, the migration job moves to the migrate inactive records stage.

**Note:** Even if you close the migration window or navigate away from the migration job, the migration of records continues. If you click **Migrate Active Records**, the migration window displays the current progress.

If any record fails to migrate, it is listed in one of the related lists:
- Failed Active Problem Updates
- Failed Active Problem Task Updates

Verify the reason for their failure, resolve it, and migrate the records again.

**Migrate inactive records.**

**Migrate inactive records**

Migrate inactive records to apply the new mappings to all the remaining problem and problem task records.

Role required: admin

Click **Migrate Inactive Records**.

If there are no inactive records to migrate, the migration job moves to the migrated stage.

**Note:** Even if you close the migration window or navigate away from the migration job, the migration of records continues. If you click **Migrate Inactive Records**, the migration window displays the current progress.

If any record fails to migrate, it is listed in one of the related lists:
- Failed Inactive Problem Updates
- Failed Inactive Problem Task Updates

Verify the reason for their failure, resolve it, and migrate the records again.

View the **Migrated** topic.

**Migrated**

You have successfully activated the Problem Management Best Practice - Madrid - State Model plugin and updated your problem and problem task records to the new best practice states.

Role required: admin

1. Optional: View the records after migration in the related links.
   The records are listed in one of the following related lists:
   - Problems by State
   - Problem Tasks by State

2. Optional: If any record failed to migrate, verify the reason for the failure, resolve it, and migrate the records again.
   The failed records are listed in one of the following related lists:
3. Click **Finish** to return to guided setup to perform the clean-up tasks.

**Modifications**

A modification is any alteration such as addition, deletion, or update that you carry out on Problem Management. If you have made significant modifications, you will need to review and resolve some possible blocking modifications.

For more information on modifications, see the following KB articles:

- For more information about modifications that block the problem state model plugin from being activated, see the **KB0819060** article in the HI Knowledge Base.
- For more information about other types of modification and how to resolve them, see the **Problem Management Migration Utility - How to resolve detected modifications (KB0819196)** article in the HI Knowledge Base.

**Activities to clean up after migration**

After you complete your main migration, you must do some manual clean-up to make your instance similar to the base version of problem management.

Manual clean-up involves the following activities:

- Reactivate problem state models
- Remove old module menus
- Remove old UI actions
- Remove old business rules
- Remove old UI policies
- Update the dashboard overview
- Reset problem form layouts

**Note:** You can skip this action if you have not modified your form.

- Search for problems from incidents

**Update dashboard overview**

When you activate the problem state model, you need to update the overview dashboard to use the new states.

Role required: admin

In the problem overview dashboard, refer to the closed problems by setting `Active = false` instead of `state = 4`.

**Note:** If you have added your own custom dashboards or charts, you may need to manually update them as you have migrated to the problem state model.

1. If you are prompted with the message To edit this record click here, then click **here**.
2. Click the configuration icon ( ).

3. Hover your mouse on Problems Closed per Week chart to view and select the Edit Content menu.

4. Select the filter to open the condition builder and update the condition from Problem state is 4 to Active is false.

5. Click Run.

6. Click Save.

7. Click Back to return to the dashboard.

Configuring problem management

Create or redesign problem form layouts to be aligned with the workflow of the business process of the organization. Categorize problems for monitoring and reporting purpose. Use data lookup and assignment rules to automatically assign a task to a user or group based on pre-defined conditions.

Configure the problem form

Configure the problem form layout to conform to the workflow and the process of your organization. Add, remove, and customize fields and related lists, create problem categories, and modify links as needed.

Role required: admin

The Problem form in the base system is configured to follow recommended ITIL practices. Evaluate the form layout and design with your existing business processes, and plan the changes to make.

For additional form customization not described in this page, such as adding company-specific annotations or configuring related lists, see Form administration and Configuring the form layout.

By default, auditing is enabled for the problem table. The administrator can configure the form layout to add the Audit Records and Audit History related lists. For more information about options for auditing a table, see Enable auditing for a table.

- Navigate to Problem > Create New.

Some of the following configuration activities are not accessed from within the problem form. These activities are noted in the procedure.

Configure the problem form layout

Configure the problem form so the information it collects is relevant to your organization’s processes. You can easily modify the form to show only the fields, related lists, and other elements that you need.

Role required: personalize_form

1. Navigate to Problem > Create New.

2. In the problem form context menu, select Configure > Form Layout.

3. Follow the steps in Configuring the form layout to perform any of the following layout modifications. Some of these modifications are illustrated in the example.

- Show or hide fields on a form.
- Add a related list to a form.
The **Incidents** and **Problem Tasks** related lists appear by default. Review the available related lists and select appropriate lists. For example, if you enable auditing for the Problem table, add the **Audit History** related list.

- Add an annotation to a form.
- Create a form section.
- Embed a list within a form.

This activity allows the embedded list to be used like any other element on the form. In addition, technicians can create records in the list view. Changes made to the contents of the embedded list are saved when the form is saved.

**Note:** There are other activities described in the form layout topic, but the items listed here are commonly configured during initial setup.
Move fields into or out of the form using these lists.

Add a field to the table and the form.

Select the view to modify or create a new view.

Problem form layout example
Redesign the problem form

The form designer allows you to customize elements in the problem form to create different form views, display a field navigator, or provide field properties.

Role required: admin

Form design is an alternative to configuring forms that combines several configuration options into one tool. You can make and save changes, then return to the browser tab with the open problem form and reload the form to test your changes. Using the form designer lets you try out the changes you want to make for the best result.

1. In the form context menu, select **Configure > Form Design** to open the form designer in a new browser tab.
2. Follow the directions in **Form design** to customize elements in the problem form.

Configure problem categories

Configure problem categories to provide a refined way of monitoring and reporting problems. Add to or remove category and subcategory choices from the list of problem categories or subcategories.

Role required: admin

Follow the steps in **View choice list definitions** to enter your problem categories.

Define an assignment rule for problems

After a problem is logged, it must be assigned to the appropriate group or individual to handle the problem. You can define assignment rules to automate the assignment process.

Role required: assignment_rule_admin or admin

Some assignment rules are predefined for Problem Management. Review the predefined assignment rules, and verify that the problem assignment rules you want to use are active. For example, the Network Problem assignment rule looks at the configuration item class for network problems and assigns the problem to the Network group.

In this procedure, define an assignment rule to assign database problems to the Database group. It is just an example to let you know how to define an assignment rule. The Database Problem assignment rule is already available in the base system.

1. Navigate to **System Policy > Assignment** and click **New**.
2. Complete the form using the following information.
   - **Name**: Database Problems
   - **Applies To** tab or section:
     - **Table**: Problem (problem)
     - **Conditions**: Dot-walk to (Configuration Item.Class) (is) (Database).
   - **Group** in the **Assign To** tab or section: Database
3. Click **Submit**.
4. Test the assignment rule by completing the following steps.
   a) Navigate to **Problem > Create New**.
   b) Complete the problem form and select a configuration item with a class of **Database**.
   c) Click **Submit**.
d) Open the problem and verify that the assignment group was added.

Categorize a problem as a major problem

You can prioritize a problem and highlight that it needs a review.

Role required: admin

Note: This feature is available only in new instances starting with Jakarta or a later release. The Problem Management Best Practice – Jakarta plugin (com.snc.best_practice.problem.jakarta) plugin must be activate.

- If the Problem Management Best Practice – Madrid plugin (com.snc.best_practice.problem.madrid) is activated, configure the Problem form to include the Major problem check box and add the Major problem review field to the Resolution Information tab.
- If the Problem Management Best Practice – Madrid plugin (com.snc.best_practice.problem.madrid) is not activated, add the Review outcome field to the Closure Information tab.

1. Open a Problem record to categorize it as a major problem.
2. Select the Major problem check box.
   The Work notes field is mandatory. Either the Major problem review field is displayed in the Resolution Information tab, or the Review outcome field is displayed in the Closure Information section.
3. Fill out the Review outcome field to document review results and lessons learned.
4. Click Update.

Data lookup for prioritizing problems

To follow ITIL guidelines, problem records are prioritized by the impact and urgency of the problem.

Problem prioritization is available on new instances.

On the problem form, users select values from the Impact and Urgency fields that determine which priority value is generated for the problem.

<table>
<thead>
<tr>
<th>ITIL problem order</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Impact</td>
</tr>
<tr>
<td>Urgency</td>
</tr>
<tr>
<td>Priority</td>
</tr>
</tbody>
</table>
Priority is calculated according to the following data lookup rules:

<table>
<thead>
<tr>
<th>Impact</th>
<th>Urgency</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - High</td>
<td>1 - High</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>1 - High</td>
<td>2 - Medium</td>
<td>2 - High</td>
</tr>
<tr>
<td>1 - High</td>
<td>3 - Low</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>1 - High</td>
<td>2 - High</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>2 - Medium</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>3 - Low</td>
<td>4 - Low</td>
</tr>
<tr>
<td>3 - Low</td>
<td>1 - High</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td>3 - Low</td>
<td>2 - Medium</td>
<td>4 - Low</td>
</tr>
<tr>
<td>3 - Low</td>
<td>3 - Low</td>
<td>5 - Planning</td>
</tr>
</tbody>
</table>

By default, the **Priority** field is read-only and must be set by selecting the **Impact** and **Urgency** values. To change how priority is calculated, administrators can either alter the priority lookup rules or disable the **Priority is managed by Data Lookup - set as read-only** UI policy and create their own business logic.

In the Problem Priority Data Lookup (dl_problem_priority) table, you can modify data lookup rules for task priority.

**Work notes for problem priorities**

When you initially create and save a problem, the **Work notes** field is not mandatory. If you change the priority of the problem by selecting different **Impact** or **Urgency** values on a problem form that was saved, the **Work notes** field becomes mandatory.

**Note:** This feature is available only in new instances starting with Jakarta or a later release. The Problem Management Best Practice – Jakarta plugin (com.snc.best_practice.problem.jakarta) plugin must be activate.

**Problem management properties**

Problem Management properties are used to control features such as creating problem task on a closed problem and reanalyzing a closed or a canceled problem.

These properties are available at **Problem > Administration > Problem Properties**.

**Properties for Problem Management**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem State Transition Properties</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Accept Risk moves the Problem to Closed state instead of Resolved state | • Type: string  
• Value: true or false  
• Default value: true |
| Can create a Problem Task on a Closed Problem? | • Type: string  
• Value: true or false  
• Default value: false |
| Who can Re-analyze a Canceled Problem? | • Type: choice list  
• Default value: problem_manager |
| Who can Re-analyze a Risk Accepted (Closed state) Problem? | • Type: choice list  
• Default value: problem_manager |
| Who can Re-analyze a Completed Problem? | • Type: choice list  
• Default value: problem_manager |
| Problem Task State Transition Properties |  |
| Cancel open Problem Tasks when closing a Problem | • Type: string  
• Value: true or false  
• Default value: true |
| Who can Re-assess a Completed or Canceled Problem Task? | • Type: choice list  
• Default value: problem_coordinator |
| Problem Related List Properties |  |
| List of related task records (comma-separated) to track as fixes for this Problem. Used to notify the Coordinator when all the related fix records are Completed or Canceled. E.g. incident.problem_id, change_request.parent | • Type: string  
• Default value: change_request.parent, rm_defect.parent, rm_release.parent, rm_enhancement.parent, sn_cim_register.source_id |
| List of related task records (comma-separated) to move over when a problem is marked as a duplicate of another. E.g. incident.problem_id, change_request.parent | • Type: string  
• Default value: incident.problem_id, sn_customerservice_case.problem |
| Problem Created from Incident Properties |  |
Quick start tests for Problem Management

Validate that Problem Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Problem Management quick start tests require activating the Problem Management Best Practice — Madrid plugin (com.snc.best_practice.problem.madrid) and the Problem Management — ATF Tests plugin (com.snc.problem.atf). For all state related test, the Problem Management State Model (com.snc.best_practice.problem.madrid.state_model) plugin needs to be active.

PRB MGMT: Problem Management test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRB MGMT: Cancel a Problem when the state of the Problem is Assess</td>
<td>Verify that when a Problem in the Assess state is canceled, the state of the Problem changes to Closed with Resolution code as Canceled.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Cancel a Problem when the state of the Problem is Root Cause Analysis</td>
<td>Verify that when a Problem is in the Root Cause Analysis state and is canceled, the state of the Problem changes to Closed with Resolution code as Canceled.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Mark a Problem as Duplicate when the state of the Problem is Assess</td>
<td>Verify that when a Problem is in the Assess state and is marked as duplicate, the state of the Problem changes to Closed with Resolution code as Duplicate.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Mark a Problem as Duplicate when the state of the Problem is Root Cause analysis</td>
<td>Verify that when a Problem is in the Root Cause Analysis state and is marked as duplicate, the state of the Problem changes to Closed with Resolution code as Duplicate.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>PRB MGMT: Accept Risk of Problem (problem.acceptrisk.move_to_closed: false, state: Fix in Progress)</td>
<td>Verify that when a Problem state is <strong>Fix in Progress</strong> and the risk is accepted, then the Problem state changes to <strong>Resolved</strong> with Resolution code as <strong>Risk Accepted</strong>. Note: The test is valid when Problem property <strong>Accept Risk moves the Problem to Closed state instead of Resolved state</strong> (problem.acceptrisk.move_to_closed) is false.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Accept Risk of Problem (problem.acceptrisk.move_to_closed: true, state: Fix in Progress)</td>
<td>Verify that when a Problem state is <strong>Fix in Progress</strong> and the risk is accepted, then the Problem state changes to <strong>Closed</strong> with Resolution code as <strong>Risk Accepted</strong>. Note: The test is valid when Problem property <strong>Accept Risk moves the Problem to Closed state instead of Resolved state</strong> (problem.acceptrisk.move_to_closed) is true.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Accept Risk of Problem (problem.acceptrisk.move_to_closed: false, state: Root Cause Analysis)</td>
<td>Verify that when a Problem state is <strong>Root Cause Analysis</strong> and the risk is accepted, then the Problem state changes to <strong>Resolved</strong> with Resolution code as <strong>Risk Accepted</strong>. Note: The test is valid when Problem property <strong>Accept Risk moves the Problem to Closed state instead of Resolved state</strong> (problem.acceptrisk.move_to_closed) is false.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>PRB MGMT: Accept Risk of Problem (problem.acceptrisk.move_to_closed: true, state: Root Cause Analysis)</td>
<td>Verify that when a Problem state is Root Cause Analysis and the risk is accepted, then the Problem state changes to Closed with Resolution code as Risk Accepted.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Note: The test is valid when Problem property Accept Risk moves the Problem to Closed state instead of Resolved state (problem.acceptrisk.move_to_closed) is true.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRB MGMT: Reanalyze Problem which is closed-Risk Accepted from state Root Cause Analysis</td>
<td>Verify that when a Problem is reanalyzed after it is Closed with the Resolution code as Risk Accepted, Problem state changes to Root Cause Analysis.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Create Emergency Change from Problem</td>
<td>Verify the creation of Emergency Change from a Problem.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Create Normal Change from Problem</td>
<td>Verify the creation of Normal Change from a Problem.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Problem State Management</td>
<td>Verify problem state management.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Reanalyze a Problem from Complete</td>
<td>Verify that when a Problem is reanalyzed after it is Closed with the Resolution code as Fix Applied, Problem state changes to Root Cause Analysis.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Reanalyze a Problem which is canceled from state Assess</td>
<td>Verify that when a Problem is reanalyzed after it is Closed with the Resolution code as Canceled, Problem state changes to Root Cause Analysis.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Reanalyze a Problem which is canceled from state Root Cause Analysis</td>
<td>Verify that when a Problem is reanalyzed after it is Closed with the Resolution code as Canceled, Problem state changes to Root Cause Analysis.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Reanalyze Problem which is closed-Risk Accepted from state Fix in progress</td>
<td>Verify that when a Problem is reanalyzed after it is Closed with the Resolution code as Risk Accepted, Problem state changes to Root Cause Analysis.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>PRB MGMT: Create a Known Error article from Problem</td>
<td>Verify creation of Known Error article from a Problem.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Risk Accept reason on Incident</td>
<td>Verify the Risk Accepted reason is copied to the Incidents which are awaiting resolution of a Problem.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Communicate Fix</td>
<td>Verify the communicate fix functionality.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Communicate Workaround</td>
<td>Verify the communicate workaround functionality.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Fix information on Incident</td>
<td>Verify that when a Problem is resolved, the state of the Incidents that are awaiting resolution of the Problem changes to Resolved. The fix notes of the Problem are copied to the Incidents.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Problem task (Type:General) state management</td>
<td>Verify Problem task state management of a general type Problem.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

**Managing Problems**

Understand how Problem and Problem task is created, assessed, investigated, and fixed in a Problem or Problem task states.

**Create a problem**

A problem is a cause of one or more incidents. Create a problem to identify the root cause of the incidents and try to prevent them from happening again.

Role required: itil, sn_problem_write, admin, problem_admin, problem_manager, or problem_coordinator

If you do not have Problem Management Best Practice — Madrid plugin (com.snc.best_practice.problem.madrid) activated, see Create a problem (legacy).

- You can generate a problem record manually by navigating to Problem > Create New or by clicking New from the problem record list.
- You can generate a problem from an incident.
- You can create a record producer to log problems from the service catalog.
- You can also generate a problem from an email when an appropriate inbound email action is configured.

1. Create the problem with one of these options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Problem module</td>
<td>Navigate to Problem &gt; Create New.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>From an incident</td>
<td>1. Open the incident.</td>
</tr>
<tr>
<td></td>
<td>2. On the context menu, click <strong>Create Problem</strong>.</td>
</tr>
</tbody>
</table>

**Note:** Use the property **List of attributes (comma-separated)** that will be copied from the incident to create a new problem (**com.snc.problem.create_from_incident.attributes**) to specify fields on the incident form. The values of these fields are copied to the respective fields on the Problem form.

2. On the Problem form, fill in the fields.

**Problem form fields**

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Read-only field. Unique number to identify the problem.</td>
</tr>
<tr>
<td>First reported by</td>
<td>Task that first identified this Problem.</td>
</tr>
<tr>
<td>Category</td>
<td>Group to which the problem belongs to such as software, hardware. After selecting the category, select the subcategory, if applicable.</td>
</tr>
<tr>
<td>Service</td>
<td>Business service that the problem applies to. If you select a business service as the configuration item and that business service is also listed as the configuration item in any other active task, the active tasks icon appears. Click the icon to view the list of all the other active tasks that are affecting the business service. You can view the BSM map (dependency view) of the selected business service by clicking the dependency icon.</td>
</tr>
<tr>
<td>Service Offering</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. Service offering enables you to receive different features and their levels of performance for a given service.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>Configuration item (CI) that the problem applies to. The CI class of the selected configuration item identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
<tr>
<td>Name</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>For existing customers, the available states are: <strong>Open</strong>, <strong>Pending Change</strong>, <strong>Known Error</strong>, and <strong>Closed</strong> or <strong>Resolved</strong>. For new customers from Madrid, the state management process is applied. This state field is a read-only field. The field value changes as the problem proceeds from one state to another state. The states available are: <strong>New</strong>, <strong>Assess</strong>, <strong>Root Cause Analysis</strong>, <strong>Fix in Progress</strong>, <strong>Resolved</strong>, and <strong>Closed</strong>.</td>
</tr>
<tr>
<td>Resolution code</td>
<td>Indicates whether the problem is resolved, a fix is applied, a duplicate is available, or the problem coordinator accepts the risk. <strong>Note:</strong> This field appears only for new customers from Madrid or a later release as it is part of the state management process.</td>
</tr>
<tr>
<td>Duplicate of</td>
<td>When <strong>Resolution code</strong> is <strong>Duplicate</strong>, the <strong>Duplicate of</strong> field is the reference to the Problem from which the current Problem is duplicated.</td>
</tr>
<tr>
<td>Impact</td>
<td>Effect that the problem has on business. Select the appropriate impact level (<strong>High</strong>, <strong>Medium</strong>, or <strong>Low</strong>).</td>
</tr>
<tr>
<td>Urgency</td>
<td>Extent to which the problem resolution can bear delay. Select the appropriate urgency level (<strong>High</strong>, <strong>Medium</strong>, or <strong>Low</strong>).</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the problem (<strong>Critical</strong>, <strong>High</strong>, <strong>Moderate</strong>, <strong>Low</strong>, or <strong>Planning</strong>). The <strong>Priority</strong> field is read-only and is set according to the <strong>Impact</strong> and <strong>Urgency</strong> values entered.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group that the problem is assigned to.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Specific problem coordinator that the problem is assigned to. If an assignment rule applies, the problem is automatically assigned to the appropriate user or group.</td>
</tr>
<tr>
<td>Problem Statement</td>
<td>Description of the problem that the problem-solving team addressing. When you update the problem statement and move to another field, the <strong>Related Search</strong> field displays knowledge articles. If you configure the problem properties, then the <strong>Related Search</strong> field displays other related information related to the problem statement.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the problem.</td>
</tr>
<tr>
<td>Related Search</td>
<td>Result of a search. <strong>Note:</strong> If you want to search and link a known error article or knowledge article to the Problem, click <strong>Attach</strong>.</td>
</tr>
<tr>
<td>Notes</td>
<td>Users who receive notification when work notes are added to the problem.</td>
</tr>
<tr>
<td>Name</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Work notes</td>
<td>Inscription about the work that you perform on the Problem.</td>
</tr>
<tr>
<td>Analysis Information</td>
<td></td>
</tr>
<tr>
<td>Workaround</td>
<td>Method that you have used to overcome the Problem. Providing a workaround if useful for fast Incident resolution. It can be a way of dealing with a problem or making something work despite the problem not being resolved. If a workaround is available, the problem coordinator can click the Communicate Workaround action to notify the related Incidents.</td>
</tr>
<tr>
<td>Cause notes</td>
<td>Inscription on what had caused the problem.</td>
</tr>
<tr>
<td>Resolution Information</td>
<td></td>
</tr>
<tr>
<td>Resolved by</td>
<td>Read-only field. Name of the user who resolved the issue.</td>
</tr>
<tr>
<td>Resolved</td>
<td>Read-only field. The date and time when the Problem is resolved.</td>
</tr>
<tr>
<td>Fix notes</td>
<td>Inscription on how you have fixed the problem. If a fix is available, the problem coordinator can click the Communicate Fix action to notify the related Incidents.</td>
</tr>
<tr>
<td>Other Information</td>
<td></td>
</tr>
<tr>
<td>Opened by</td>
<td>Read-only field. Name of the user who opened the problem.</td>
</tr>
<tr>
<td>Opened</td>
<td>Read-only field. The date and time when the user opened the Problem.</td>
</tr>
<tr>
<td>Confirmed by</td>
<td>Read-only field. Name of the user who confirms that the problem is valid and needs a resolution.</td>
</tr>
</tbody>
</table>
3. Click **Submit**.  
The problem enters the **New** state.

Assess the problem.

**Create a problem (legacy)**

A problem is a cause of one or more incidents. Create a problem to identify the root cause of the incidents and try to prevent them from happening again.

Role required: **itil**

1. Create the problem with one of these options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Problem module</td>
<td>Navigate to Problem &gt; Create New.</td>
</tr>
<tr>
<td>From an incident</td>
<td>1. Open the incident.</td>
</tr>
<tr>
<td></td>
<td>2. On the context menu, click <strong>Create Problem</strong>.</td>
</tr>
</tbody>
</table>

2. Complete the form, as appropriate.

**Problem form fields**

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business service</td>
<td>Business service that the problem applies to. If you select a business service as the configuration item and that business service is also listed as the configuration item in any other active task, the active tasks icon appears. Click the icon to view the list of all the other active tasks that are affecting the business service. You can view the BSM map (dependency view) of the selected business service by clicking the dependency icon.</td>
</tr>
<tr>
<td>Name</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the problem applies to. The CI class of the selected configuration item identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
<tr>
<td>Change request</td>
<td>Change request associated with the problem.</td>
</tr>
<tr>
<td>Major problem</td>
<td>Check box to prioritize a problem and highlight that it needs a review.</td>
</tr>
<tr>
<td>Knowledge</td>
<td>Check box to automatically submit a knowledge article when a problem is closed.</td>
</tr>
</tbody>
</table>
| State              | State of the problem:  
- **Open**: Open and unassigned.  
- **Pending Change**: Waiting for the corresponding change request to be closed.  
- **Known Error**: This problem is not going to be fixed and there is a workaround. Users with the itil role have access to the Known Errors module.  
- **Closed/Resolved**: The problem is fixed and closed. |
| Impact             | Effect that the problem has on business. Select the appropriate impact level (**High**, **Medium**, or **Low**).                              |
| Urgency            | Extent to which the problem resolution can bear delay. Select the appropriate urgency level (**High**, **Medium**, or **Low**).               |
| Priority           | How quickly the service desk should address the problem (**Critical**, **High**, **Moderate**, **Low**, or **Planning**). The Priority field is read-only and is set according to the Impact and Urgency values entered. |
| Assignment group   | Group that the problem is assigned to.                                                                                                     |
| Assigned to        | Specific user that the problem is assigned to. If an assignment rule applies, the problem is automatically assigned to the appropriate user or group. |
| Parent             | The parent task for this problem.                                                                                                          |
| Short description  | Summary of the problem.                                                                                                                     |
| Description        | Detailed description of the problem.                                                                                                       |
| Work notes list    | Users who receive notification when work notes are added to the problem. Click the Add me icon to add yourself to the work notes list for problems you are interested in monitoring. |

3. To enter work notes for the problem, click the **Notes** tab.  
When you initially create and save a problem, entering notes in the **Work notes** field is not mandatory. If you change the priority of the problem by selecting different **Impact** or **Urgency** values on an existing problem, the **Work notes** field becomes mandatory.

**Note:** This feature is available only in new instances starting with Jakarta or a later release. The Problem Management Best Practice – Jakarta plugin (com.snc.best_practice.problem.jakarta) plugin must be activate.
4. To enter notes on why the problem is closed, click the **Closure Information** tab and enter the information.
   The date on which the problem was closed and the user who closed it populate automatically.
5. Click **Submit**.

Assess the problem.

Assess a problem

Assess a problem to determine whether the problem requires a thorough investigation.

- Role required: admin, problem_admin, problem_manager, or problem_coordinator
- Activate the Problem Management Best Practice — Madrid — State Model (com.snc.best_practice.problem.madrid.state_model) to get the new best practice states and guided actions to navigate the lifecycle of a problem. For details, see Activate Problem Management Best Practice — Madrid — State Model.

Assessing a problem involves analyzing the scale and extent of the problem, as well as its cause and effect.

Click **Assess** and fill the mandatory fields.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action to be taken</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the problem is valid and requires a resolution</td>
<td>Click <strong>Confirm</strong>.</td>
</tr>
<tr>
<td>If there is an existing problem with similar issue</td>
<td>Click <strong>Mark Duplicate</strong>.</td>
</tr>
</tbody>
</table>

**Note:**
- When you mark a problem as duplicate, the related records from the duplicate problem are moved to the existing problem.
- The List of related task records (comma-separated) to move over when a problem is marked as a duplicate of another (problem.duplicate.records_to_move) problem management property controls the related records that are copied from the existing to the original problem.
<table>
<thead>
<tr>
<th>Option</th>
<th>Action to be taken</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the problem is not a valid problem</td>
<td>Click Cancel.</td>
</tr>
</tbody>
</table>

After you confirm that the problem needs investigation and a resolution, the problem enters the Root Cause Analysis state.

**Add multiple incidents to a problem**

Add multiple incidents to a problem to avoid creating multiple problems for incidents that have the same issue.

Role required: itil, admin, problem_admin, problem_coordinator or problem_manager

The topic applies to Problems where you have activated the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.

1. Navigate to **Problem > Open**.
2. Open a problem record.
3. In the related list, click the **Incidents** tab.
4. Click **Add**.
5. From the list, select the records and click **Add Selected**.
   The selected incidents appear under the **Incidents** tab.

**Associate CIs with Problem**

Associate multiple affected or impacted configuration items (CIs) to a problem to find out all the CIs that are affected by the same problem.

Role required: itil, sn_problem_write, admin, problem_admin, problem_coordinator or problem_manager

Use the **Configuration Item** field when there is a single, primary CI that is the cause of the problem and the **Affected CIs** or the **Impacted Services/CIs** related list when multiple CIs are affected by the problem.

1. Navigate to **Problem > Open**.
2. Open the problem record to which you want to associate CI items.
3. Perform the following actions:
### Associate CI Items

<table>
<thead>
<tr>
<th>Options</th>
<th>Procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration item</td>
<td>1. Click the lookup icon ( ).</td>
</tr>
<tr>
<td></td>
<td>2. Select configuration item.</td>
</tr>
</tbody>
</table>

**Note:** By default, Service Offering is filtered out and CIs with Principal Class are selected. The Principal Class filter functionality is applicable to the new customers starting the Paris release.
<table>
<thead>
<tr>
<th>Options</th>
<th>Procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Affected CIs</td>
<td>1. Click <strong>Add</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Select configuration items.</td>
</tr>
</tbody>
</table>

**Note:** By default, Service Offering is filtered out and CIs with Principal Class are selected. The Principal Class filter functionality is applicable to the new customers starting the Paris release.
### Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impacted Services/CIs</td>
<td>1. Click <strong>Add</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Select configuration items.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> By default, Service Offering is filtered out.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>Add Selected</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the Impacted Services/CIs is not visible on the form, configure the form layout.</td>
</tr>
</tbody>
</table>

---

### Data for problem resolution

The quick resolution of problems requires gathering as much information as possible about the problem.

In addition to the information within the problem ticket, useful information is often found in other tables.

#### Pertinent related records

Common related records include changes (through the Change request related list) and incidents in the Incidents related list. All the directly related records are accessible through related lists. If the appropriate related list does not appear on the form, the administrator can configure the form to add it.

#### Known errors and knowledge articles

Information about already-known issues can be found in two places: the Known Errors module in the Problem Management application, or in the Knowledge application. The Known Errors module filters the problem table to present all the problems whose cause has been identified but cannot be fixed. The knowledge base can have information that was gathered from incidents, and may also have useful workarounds for problems.

#### Dependency Views map

The Dependency Views map provides a visual representation of the configuration items and their relationships and displays information about related issues.

For example, the following image is a map for the CI **nyc rac na200**, which is a mass storage device.
Map for nyc rac nas200 storage device

The icons beside CIs indicate the following information. You can view information for the selected CI by clicking Details in the form header, or by pointing to the icon and viewing a pop-up box.

- The cloud ⬤ icon indicates that the CI has an associated problem, which is listed in the Problem details pane.
- The (!) icon indicates that there is a related incident.
- The link icon indicates that there are associated tasks, which can be incidents, problems, or changes. If you select the CI, the Details pane displays the associated records.

To open the incident or problem record, click the number in the Details pane. The map shows the upstream and downstream relationships of the CI. The storage device problem might be an improper change to one of the UNIX servers.

**CMDB baseline history**

If a baseline is generated, planned or unplanned changes are tracked within the system. A common cause of problems is improperly executed changes, and reviewing the history of changes to a CI helps track problems caused by improper changes.

To check the CMDB Baseline, view the CI record and check Baseline Differences and Scheduled Changes. The administrator can use the form designer to add these formatters.
In the example above, the change in RAM is associated with a change request. You can review the change and see what was planned and what was implemented. The removal of QuickTime software was recorded as an unplanned change.
Investigate root cause of a problem

Identify the root cause of the problem to analyze, track, and resolve recurring incidents permanently.

- Role required: admin, problem_admin, problem_coordinator, or problem_manager
- Activate the Problem Management Best Practice — Madrid — State Model (com.snc.best_practice.problem.madrid.state_model) to get the new best practice states and guided actions to navigate the lifecycle of a problem. For details, see Activate Problem Management Best Practice — Madrid — State Model.

You can perform any one of the following tasks:

<table>
<thead>
<tr>
<th>Option</th>
<th>Actions to be taken</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you can resolve the problem</td>
<td>Click Start Fix. The problem state changes to Fix in Progress. You can then create a new Change Request or link to an existing Change Request to apply a permanent fix to the problem.</td>
</tr>
<tr>
<td>Note: Notification is sent to the problem coordinator, who is assigned to the Problem, when all the related Change Requests are completed or canceled.</td>
<td></td>
</tr>
<tr>
<td>If you acknowledge the problem but there is no permanent resolution to the problem</td>
<td>Click Accept Risk. The problem directly enters the Closed or Resolved state with the Resolution code as Risk accepted.</td>
</tr>
<tr>
<td>Note: Whether the problem enters the Closed state or the Resolved state, depends on the property Accept Risk moves the Problem to Closed state instead of Resolved state (problem.acceptrisk.move_to_closed).</td>
<td></td>
</tr>
<tr>
<td>If you decide to reanalyze the problem</td>
<td>Click Re-analyze. The problem opens for reanalysis and the state is changed to Root Cause Analysis.</td>
</tr>
</tbody>
</table>

If you had created any known error article for this problem or any similar problem, you can add the reference of that article in the Primary Known Error article field.

Note: The Primary Known Error article field is available only when you activate the Problem Management Best Practice — Madrid — Knowledge Integration plugin (com.snc.best_practice.problem.madrid.knowledge).
You can resolve and complete the problem. You can also create a change request to implement a fix for the problem.

Resolve and complete a problem

Resolve the issue and add detailed note of the resolution for future reference.

- Role required: admin, problem_admin, problem_coordinator, or problem_manager
- Activate the Problem Management Best Practice — Madrid — State Model (com.snc.best_practice.problem.madrid.state_model) to get the new best practice states and guided actions to navigate the lifecycle of a problem. For details, see Activate Problem Management Best Practice — Madrid — State Model.

1. Click Resolve.

The problem enters the Resolved state with Resolution code as Fix Applied.

2. Click Complete.

The problem enters the Closed state with Resolution code as Fix Applied.

Note:

- When a problem is closed or canceled, all related open problem tasks are canceled provided you select the problem management property Cancel open Problem Tasks when closing a Problem (problem.closed.cancel_open_tasks).
- When a problem is closed, you can still create problem tasks provided you select the problem management property Can create a Problem Task on a Closed Problem? (problem.closed.can_create_tasks).

You can reanalyze the problem even after it is closed by clicking Re-analyze. The state of the problem changes from Closed to Root Cause Analysis. The following problem management properties controls who can reanalyze the problem:
• Who can Re-analyze a Canceled Problem?
  (problem.closed.role.reanalyze_from_canceled)
• Who can Re-analyze a Risk Accepted (Closed state) Problem?
  (problem.closed.role.reanalyze_from_closed_riskaccepted)
• Who can Re-analyze a Completed Problem?
  (problem.closed.role.reanalyze_from_completed)

When all the related tasks mentioned in the problem management property List of related task records (comma-separated) to track as fixes for this Problem. Used to notify the Coordinator when all of the related fix records are Completed or Canceled. E.g. incident.problem_id, change_request.parent (problem.fix.records) are completed, a notification is sent to the problem coordinator regarding the same.

Note: Changing this property to include new tables also requires you to create a corresponding Business Rule for the overall functionality to work seamlessly. For example, for the Change request, the Business Rule is Check Related Problem Fixes - Change Req.

Create change request from a problem

After you investigate and perform a root cause analysis of the Problem, you can understand whether the Problem can be resolved or you should find a temporary workaround for the Problem. If the Problem can be resolved, implement the fix, or the resolution for the Problem.

Role required: problem_coordinator or admin

You can implement a resolution to a problem by applying a standard change procedure and testing to confirm service recovery. For a normal change, you raise a Request For Change (RFC). The Change Advisory Board (CAB) needs to approve the RFC before a resolution is applied to the Problem.

1. Navigate to Problem > Open and open a problem record.
2. On the context menu, perform any one of the following activities:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action to be taken</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal change</td>
<td>Click Create Normal Change.</td>
</tr>
<tr>
<td>Emergency change</td>
<td>Click Create Emergency Change.</td>
</tr>
</tbody>
</table>

A change request is created to implement the solution for the problem.

Add multiple change requests to a problem

Add multiple change requests to a problem to capture all the requests that you need to implement to fix the problem.

Role required: itil, admin, problem_admin, problem_coordinator or problem_manager

The topic applies to Problems where you have activated the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.

1. Navigate to Problem > Open.
2. Open a problem record.
3. In the related list, click the Change Requests tab.
4. Click Add.
5. From the list, select the records and click Add Selected.
The selected change requests appear under the Change Requests tab.

Create a problem task

A problem task is the smallest unit of work that you should perform to complete a problem. Divide your problem into multiple problem tasks which you can easily assign to different assignment groups or users.

Role required: itil, sn_problem_write, admin, problem_admin, problem_coordinator, problem_manager, or problem_task_analyst

1. Navigate to Problem > Open.
2. Open the problem record for which you want to create a problem task.
3. In the related list of the problem record, click Problem Tasks and click New.
4. Select any one of the following problem tasks:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root Cause Analysis</td>
<td>Tasks where you investigate the root cause of a problem and find a resolution for the problem</td>
</tr>
<tr>
<td>General</td>
<td>All other tasks</td>
</tr>
</tbody>
</table>

5. In the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Read-only. Unique number to identify the task.</td>
</tr>
<tr>
<td>Type</td>
<td>Read-only state. Determines whether the problem task is created specifically to investigate the cause of the problem or is a general task.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the problem applies to. The CI class of the selected configuration item identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
<tr>
<td>Due date</td>
<td>Date within which the problem task should be completed.</td>
</tr>
<tr>
<td>Source problem</td>
<td>Unique number of the problem for which the problem task is created.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>For existing customers, the available states are: <strong>Pending</strong>, <strong>Open</strong>, <strong>Work in Progress</strong>, <strong>Closed Complete</strong>, <strong>Closed Incomplete</strong>, and <strong>Closed Skipped</strong>. For new customers from Madrid, the state management process is applied. This state field is a read-only field. The states available are: <strong>New</strong>, <strong>Assess</strong>, <strong>Work in Progress</strong>, and <strong>Closed</strong>.</td>
</tr>
<tr>
<td>Close code</td>
<td>Read-only field indicating whether the problem task was completed or canceled. <strong>Note:</strong> This field appears only for new customers from Madrid or a later release as it is part of the state management process.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the problem task (Critical, High, Moderate, Low, or Planning).</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Specific group to whom the problem task is assigned to.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Specific problem analyst to whom the task is assigned to.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the problem task. When you update the short description, and move to another field, the <strong>Related Search</strong> field displays knowledge articles. If you configure the problem properties, then the <strong>Related Search</strong> field displays other related information related to the short description.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the problem task.</td>
</tr>
<tr>
<td>Related Search</td>
<td>Result of a search.                                                                                                                          <strong>Note:</strong> If you want to search and link a knowledge article to the Problem task, click <strong>Attach</strong>.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notification when work notes are added to the problem task.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Inscription about the work that you perform on the problem task.</td>
</tr>
<tr>
<td>Analysis Information</td>
<td></td>
</tr>
<tr>
<td>Cause code</td>
<td>Cause of the Problem such as Environmental disaster, Hardware issue, People/Process/Documentation.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workaround (Root Cause Analysis only)</td>
<td>Method that you have used to overcome the problem. It can be a way of dealing with a problem or making something work despite the problem not being resolved.</td>
</tr>
<tr>
<td>Closure Information</td>
<td></td>
</tr>
<tr>
<td>Completed by</td>
<td>Read-only field. Name of the user who completed the task.</td>
</tr>
<tr>
<td>Completed</td>
<td>The reason why this problem task has been canceled.</td>
</tr>
<tr>
<td>Fix notes (Root Cause Analysis only)</td>
<td>Inscription on how you have fixed the problem task.</td>
</tr>
<tr>
<td>Close notes (General task only)</td>
<td>Inscription on the work you have completed.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.
   The problem task enters the **New** state.

Assess the problem task.

**Assess a problem task**

Assess a problem task to determine the feasibility of working on the task.

Role required: admin, problem_admin, problem_coordinator, problem_manager, or problem_task_analyst

Assessing a problem task involves analyzing the scale and extent of the task, as well as its cause and effect.

1. Click **Assess**.

   The problem task enters the **Assess** state. You can confirm whether there is enough information to work on the task or if the task should be canceled.

2. After assessing the task, you can perform the following actions:
Option | Actions to be taken
--- | ---
When you are ready to work on the task | Click **Start Work**. The problem task enters the **Work in Progress** state.
When you do not need to work on the task. For example, if the problem task is duplicate or no longer needed | Click **Cancel**. The problem task enters the **Closed** state with **Close code** as **Canceled**.

Resolve the problem task.

**Complete a problem task**

Resolve and complete the problem task.

Role required: admin, problem_admin, problem_coordinator, problem_manager, or problem_task_analyst

Click **Complete**.

The problem task enters the **Closed** state with **Close code** as **Complete**.

**Note:** You can configure the Problem properties to reanalyze a task even after it is closed by clicking **Re-assess**. The state of the task changes from **Closed** to **Assess**. After all the problem tasks are completed or canceled, a notification is sent to the problem coordinator regarding the same.

**Resolve related incidents from a problem**

After you consider a problem to be resolved, the incidents related to the problem with the state **On Hold** may be resolved using a UI action from the **Problem** form.

Role required: itil
The topic only applies to legacy problem — Jakarta to London.

1. Open a resolved problem that has associated incidents.
2. From the context menu, click Resolve Incidents.
3. Enter values for mandatory fields.

**Note:** Only the incidents in state On Hold and with Awaiting Problem as the on hold reason can be resolved.

The state of the incidents in the problem related list is changed to Resolved and work notes are added to the activity feed.

**Synchronization between incident and problem records**

Change in a Problem record impacts related Incident records. Notification is sent to the user for each such update.

When you activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) and the Problem Management Best Practice — Madrid — State Model (com.snc.best_practice.problem.madrid.state_model) plugin, the changes in a Problem record impact incidents that are associated to that Problem.

**Impact on incident records**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Incident state</th>
<th>Problem state</th>
<th>Action on Problem</th>
<th>Action on Incident</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem Management Best Practice — Madrid plugin</td>
<td>Any incident state other than resolved, closed, or canceled.</td>
<td>Any</td>
<td>Click the Communicate workaround related link</td>
<td>• The workaround information is copied from the Workaround field on the Problem form to the Additional Comments field on the Incident form. • An email notification is sent to the caller and the user who is assigned to the Incident.</td>
</tr>
<tr>
<td>com.snc.best_practice.problem.madrid</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Plugin</th>
<th>Incident state</th>
<th>Problem state</th>
<th>Action on Problem</th>
<th>Action on Incident</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem Management Best Practice — Madrid plugin</td>
<td>On Hold and On hold reason is Awaiting Problem</td>
<td>Any</td>
<td>Click the Communicate fix related link</td>
<td>• The fix information is copied from the Fix notes field on the Problem form to the Additional Comments field on the Incident form.</td>
</tr>
<tr>
<td>com.snc.best_practice.problem.madrid</td>
<td></td>
<td></td>
<td></td>
<td>• An email notification is sent to the caller and the user who is assigned to the Incident.</td>
</tr>
<tr>
<td>Problem Management Best Practice — Madrid — State Model plugin</td>
<td>On Hold and On hold reason is Awaiting Problem</td>
<td>Problem state is Closed or Resolved and the problem Resolution code is Fix Applied</td>
<td>NA</td>
<td>• The Resolution notes on the incident form displays the message Related problem INCxxxx closed. Please see additional comments for fix notes, where INCxxxx is the incident number from which the problem was created.</td>
</tr>
<tr>
<td>com.snc.best_practice.problem.madrid.state_model</td>
<td></td>
<td></td>
<td></td>
<td>• The incident state is changed to Resolved.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• The Resolution code is changed to Solved (Permanently).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• An email notification is sent to the caller and the user who is assigned to the Incident.</td>
</tr>
<tr>
<td>Plugin</td>
<td>Incident state</td>
<td>Problem state</td>
<td>Action on Problem</td>
<td>Action on Incident</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>----------------------------------------------------</td>
<td>------------------------------------</td>
<td>-------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Problem Management Best Practice — Madrid — State Model plugin</td>
<td>On Hold and On hold reason is Awaiting Problem</td>
<td>Problem state is Closed or Resolved and the problem Resolution code is Risk Accepted</td>
<td>NA</td>
<td>- The information from the Risk accepted reason field on the Problem form is copied to the Work notes field on the Incident form. - An email notification is sent to the user who is assigned to the Incident.</td>
</tr>
</tbody>
</table>

### Communicating the outcome of a problem

Document the cause and resolution of a problem to resolve incoming incidents quickly and avoid further problems to be raised on the same issue.

### Communicate workaround for Problem

Document and communicate workaround to let others know that you are aware of the issue. The workaround is a temporary way to restore service failures and lessen the impact of a Problem for which an actual resolution is not yet available.

admin, problem_admin, problem_manager or problem_coordinator

When you communicate a workaround, notification is sent to related incidents that a workaround is available. The Incident process is designed to use the workaround information or to notify the user of the same. For more information on notification, refer [Synchronization between incident and problem records](#).

**Note:** The topic applies to Problems where you have activated the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.

1. Navigate to Problem > Open.
2. Open the Problem record.
3. Enter the information in the Analysis information > Workaround field.
4. Save the record.
5. Under Related Links, click Communicate Workaround.

### Communicate workaround (legacy)

You can enter a workaround note into a problem record, and then post the information into every associated incident.

Role required: itil or admin
The **Communicate Workaround** related link on the Problem form eliminates the need to manually update each incident related to the Problem.

1. Open the problem for which you have a workaround.
2. Enter the information in the **Workaround** field.
3. Click **Post**.
4. Click the **Communicate Workaround** related link.

   The problem number and the content of the **Workaround** field are added to the activity stream on all related incidents. By default, any entries made in an incident activity stream field generate an email notification to the **Caller** that you mention on the Incident form.

If group on-call rotation scheduling is in effect when you communicate a workaround, the system stops the escalations on the associated incidents. Escalation stops because a workaround is available. This action effectively communicates knowledge to the appropriate audience, but does not create a knowledge article.

### Communicate a fix

After you have completed root cause analysis of a problem and have come up with a resolution or fix for that problem, submit change requests to get the problem fixed. Documenting and communicating fix helps user to know the solution to a problem.

**admin, problem_admin, problem_manager or problem_coordinator**

When you communicate a fix, notification is sent to related incidents that a fix is available. The Incident process is designed to use the fix information or to notify the user of the same. For more information on notification, refer *Synchronization between incident and problem records*.

**Note:** The topic applies to Problems where you have activated the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.

1. Navigate to **Problem > Open**.
2. Open the Problem record.
3. Enter the information in the **Resolution Information > Fix notes** field.
4. Save the record.
5. Under Related Links, click **Communicate Fix**.

### Knowledge articles from problems

Knowledge bases house the information an organization wants to keep and share. The Problem form includes four options for creating knowledge and communicating information.

**Note:** If you have Problem Management Best Practice — Madrid — Knowledge Integration plugin (com.snc.best_practice.problem.madrid.knowledge) activated, see *Create a known error article*. The topic applies to legacy Problem (London or a prior release) only.

- You can select the **Knowledge** check box and automatically submit a knowledge article when a problem is closed.
- You can enter a workaround note into a problem record, and then post the information into every associated incident.
- You can create a knowledge article from the problem immediately, and not wait for when the problem is closed.
• You can quickly create and publish a knowledge article in the News category.

By default, most new articles are created as drafts and move through a review state before they are published. An exception to the standard workflow is posting news from the Problem form.

If the administrator enables the optional knowledge submission workflow, articles created from incidents or problems become knowledge submissions, which are processed through a different path. For more information, see Knowledge workflows.

Use the knowledge check box

As with incidents, problems often generate information that may be needed in the future. The system can automatically submit a knowledge article when a problem is closed.

Role required: itil

Note: If you have Problem Management Best Practice — Madrid — Knowledge Integration plugin (com.snc.best_practice.problem.madrid.knowledge) activated, see Create a known error article. The topic applies to legacy Problem (London or a prior release) only.

You can select the Knowledge check box and automatically submit a knowledge article when a problem is closed.

1. Select the Knowledge check box on the Problem form.
2. Resolve and close the problem.

Closing the problem triggers the business rule Problem Create Knowledge. By default, the business rule creates a knowledge article in the Draft workflow state, ready for a knowledge team member to review and publish. The problem Short description becomes the article Short description, and the problem Work notes become the article Text.

If the knowledge submission workflow is enabled, the problem Work notes become a knowledge submission instead of an article. For more information, see Knowledge workflows.

Create a known error article

Create known error articles as reference material. The known error articles document the root cause and the workaround of the problem to help with deflecting incidents.

Role required: admin, problem_admin, problem_coordinator, or problem_manager


After you create a known error article from a problem, the article is saved in the knowledge base and maintained in the Knowledge Management application. The publishing and retirement processes for a knowledge article are controlled by workflows defined for the knowledge base that the article belongs to. For more information, see Knowledge workflows.

1. Navigate to Problem > Open.
2. Open the Problem record.
3. Under Related Links, click Create Known Error Article.

Note: The link appears when the Primary Known Error article field is empty under the Analysis Information tab on the Problem form.

4. On the form, fill in the fields.
## Known Error article form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Read-only field. Unique number to identify the known error article.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Knowledge base (defaults to Known Error) in which the article is stored for future reference. The article is saved in the Known Error article (kb_template_known_error_article) table.</td>
</tr>
<tr>
<td>Category</td>
<td>Read-only field. The value of this field is reference from the Category field of the Problem.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Date after which the known error article is deleted from the database. After this date, the article does not appear in the search result.</td>
</tr>
<tr>
<td>Version</td>
<td>Read-only field. Managed by the Knowledge Management process when changes are made to a published article.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Read-only field.</td>
</tr>
<tr>
<td>Source Task</td>
<td>Read-only field. The Problem record on which you are creating the article.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Select the check box so that the article appears as an attachment in the Problem record. If you do not select the check box, the content of the article appears in the work note of the Problem.</td>
</tr>
<tr>
<td>Display attachments</td>
<td>Select the check box so that all attachments to the article appear when you view the article. The field is relevant only when the Attachment link field is not selected.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the Known Error.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed explanation of the Known Error.</td>
</tr>
<tr>
<td>Workaround</td>
<td>Method that you have used to overcome the Problem. It can be a way of dealing with a problem or making something work despite the problem not being resolved.</td>
</tr>
<tr>
<td>Cause</td>
<td>Information on what had caused the problem.</td>
</tr>
</tbody>
</table>

**Note:** Click **Search for Duplicates** to search for existing known error articles. The search is based on short description, category, and topic.

5. Click **Submit**.

**Note:** To read the content of the article, click **View Article** under **Related Links**.
Click Publish to send the article for review and approval. Depending on the Knowledge base where the article is stored and the Knowledge Base access controls, this Known Error article may be available to search for users outside of the IT team to help with Incident deflection.

**Post knowledge**

You can create a knowledge article from the problem immediately, and not wait for when the problem is closed.

Role required: itil, knowledge

If you have Problem Management Best Practice — Madrid — Knowledge Integration plugin (com.snc.best_practice.problem.madrid.knowledge) activated, see Create a known error article. The topic applies to legacy Problem (London or a prior release) only.

1. Open a problem from which to post a knowledge article.
2. Click the Post Knowledge related link.

The resulting knowledge article contains the following information.

- The problem number and **Short description** become the knowledge article **Short description**.
- The problem **Description** and **Workaround** become the knowledge article **Text**.
- The problem **Configuration item** becomes the knowledge article **Configuration Item**.
- The article **Topic** is set to **Known Error**.

By default, the system creates a knowledge article in **Draft** workflow state. If the knowledge submission workflow is enabled, the problem **Short description** and **Work notes** are placed into a knowledge submission instead of an article. For more information, see Knowledge workflows.

**Problem management integrations**

Problem Management is integrated with other ServiceNow applications such as Contextual search and Performance Analytics to improve the overall business process.

The following topics provide information about integration of different applications with Problem Management and way to enable functionality of those integrated applications.

**Working with contextual search**

Contextual search display results on forms and record producers based on the text that you provide in a field.

**Note:** Contextual Search is available for problems in instances starting with the Madrid release. Existing users can request to activate the Problem Management Best Practice — Madrid plugin (com.snc.best_practice.problem.madrid).

You can:

- Find articles using the **Related Search** field. The articles can be based on any category that you select from the choice list.
- Use the choice list next to the **Related Search** field to select the category such as **Knowledge (All)**, **Pinned Articles**, **Incidents**, **Open Problems**, and **Resolved Problems**.
- Attach the article in the **Notes > Work notes** if your search result displays knowledge articles.
Domain separation and problem management

The topic includes an overview of domain separation and Problem Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Standard

- Includes Basic level support.
- Business logic: Processes can be created or modified per customer by the service provider (SP). The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The owner of the instance needs to be able to configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin needs to be able to make comments mandatory when a record closes for one tenant, but not for another.

Overview

- Problem Management is about eliminating the root cause of a service interruption.
- The problem and problem task tables support domain separation. Therefore a Problem user sees only problems or problem tasks that have been created within the (tenant) domain that they belong to.
- Only Problem users can create and access Problems and problem tasks.
- Problem and problem task tables both support domain separation. Therefore, a Problem user sees only problems and problem tasks that have been created within the (tenant) domain that they belong to.

How domain separation works in Problem Management

Problem users see only problems and problem tasks that have been created within the (tenant) domain that they belong to.

Problem users can use Problems and problem tasks within the tenant domains. Problem users can create and update problems and problem tasks of their domain, any child domains, and the global domain.

Known Issues

Task-Outage Relationship [cmdb_ci_outage] is not domain separated.

If installed, the Task-Outage Relationship table is not domain separated. Therefore Fulfillers or Problem users can view any Task-Outage Relationship records regardless of the domain that the records belong to.

The Task-Outage Relationship table is installed when administrator activates the optional Task-Outage Relationship plugin.
Problem Management Analytics and Reporting Solutions

Analytics and Reporting Solutions and in-form analytics contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can get value from Performance Analytics for your application with minimal setup. You can always create your own objects as well.

**Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

**Note:** Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see Configure Analytics and Reporting Solutions.

To enable the solution for Problem Management, an admin can navigate to Performance Analytics > Guided Setup. Click Get Started then scroll to the section for Problem Management. The guided setup takes you through the entire setup and configuration process.

Several of the dashboards in this content pack are inactive when installed. Complete configuration and run data collection jobs before you activate these dashboards. You can activate dashboards in Dashboard Properties, accessible from the context menu. You have to assign an owner to the dashboard to activate it. For more information about configuring Analytics and Reporting Solutions, see Configure Analytics and Reporting Solutions.

**Inactive dashboards**

Some dashboards in this content pack are inactive when installed. Complete configuration and run data collection jobs before you activate these dashboards. You can activate dashboards in Dashboard Properties, accessible from the context menu. You have to assign an owner to the dashboard to activate it. For more information about configuring Analytics and Reporting Solutions, see Configure Analytics and Reporting Solutions.

**Problem Overview dashboard**

This dashboard shows the current state of open problems.
**Problem Overview**

- **Critical Open Problems**: 3
- **Unassigned Problems**: 11
- **Overdue Problems**: 4

**Open Problems**

- **Total**: 70

**Problems not updated for 7 days**

- **Total**: 67

**Open Problems older than 30 Days**

- **Total**: 67

**Problems by Priority and State**

- **1 - Critical**: 2
- **2 - High**: 1
- **3 - Moderate**: 5

**Problems older than 30 Days by Priority and State**

- **1 - Critical**: 2
- **2 - High**: 1
- **3 - Moderate**: 5
## End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem manager and Problem agent - View the current number of critical, overdue, and unassigned problems to identify immediate action areas.</td>
<td>None</td>
</tr>
</tbody>
</table>

## Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical open problems</td>
<td>Single Score</td>
<td>All open problems where Priority is 1 - Critical. This report tells you at a glance how many top priority problems there are.</td>
</tr>
<tr>
<td>Unassigned problems</td>
<td>Single Score</td>
<td>All open problems where 'Assigned to' is empty. These are the problems you have to assign.</td>
</tr>
<tr>
<td>Overdue problems</td>
<td>Single Score</td>
<td>All open problems where Escalation = Overdue</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open problems</td>
<td>Single Score</td>
<td>All open problems</td>
</tr>
<tr>
<td>Problems not updated for 7 days</td>
<td>Single Score</td>
<td>Open problems where the value in the Updated field is more than 7 days ago</td>
</tr>
<tr>
<td>Open problems older than 30 days</td>
<td>Single Score</td>
<td>Open problems where the value in the Created field is more than 30 days ago</td>
</tr>
<tr>
<td>Open problems - Grouped</td>
<td>Horizontal Bar</td>
<td>Open problems grouped by Priority</td>
</tr>
<tr>
<td>Open problems older than 30 days - Grouped</td>
<td>Horizontal Bar</td>
<td>Open problems where the value in the Created field is more than 30 days ago, grouped by Priority</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Problems by Priority and State</td>
<td>Heatmap</td>
<td>Open Problems grouped on a matrix of Priority and State</td>
</tr>
<tr>
<td>Open problems older than 30 days by Priority and State</td>
<td>Heatmap</td>
<td>Open problems where the value in the Created field is more than 30 days ago, grouped on a matrix of Priority and State</td>
</tr>
<tr>
<td>Problems Opened per Week</td>
<td>Line</td>
<td>Count of all problems opened this year, trending by Opened per Week</td>
</tr>
<tr>
<td>Problems Closed per Week</td>
<td>Line</td>
<td>Count of all problems closed this year, trending by Closed per Week</td>
</tr>
</tbody>
</table>

**Problem Management dashboard**

Use this dashboard to gain a high-level view across the problem management process, from opening to closing.
Problem New tab
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem manager -</td>
<td>pa_viewer needed to view the Basic Indicators list</td>
</tr>
</tbody>
</table>

Indicators

**Number of open problems**
Problems on the Problem (problem) table created on or before today and with no Closed date. This indicator is used in several other indicators on the dashboard.

**Number of new problems**
Problems on the Problem (problem) table created today. This indicator is used in several other indicators on the dashboard.

**Number of closed problems**
Problems on the Problem (problem) table closed today. This indicator is used in several other indicators on the dashboard.

**Problem backlog growth**
The score for this indicator is calculated according to the formula 
\[
\text{((Number of new problems))} - \text{((Number of closed problems))}
\]

**Average age of open problems**
The score for this indicator is calculated according to the formula 
\[
\frac{\text{Summed age of open problems}}{\text{Number of open problems}} / 24
\]

**% of new critical problems**
The score for this indicator is calculated according to the formula 
\[
\frac{\text{((Number of new problems > Priority = 1 - Critical))}}{\text{((Number of new problems))}} * 100
\]

**Average close time of problems**
The score for this indicator is calculated according to the formula 
\[
\frac{\text{Summed duration of closed problems}}{\text{Number of closed problems}} / 24
\]

The following indicators are not shown directly on the dashboard but are used in calculating formulas:
- Summed age of open problems
- Summed duration of closed problems

Breakdowns
- Priority

Problem Premium dashboard
This dashboard uses advanced features such as interactive filters and workbench widgets to provide a broad view of problem reports, both current and over time.
Problem Process by Age

| 0 - 1 day: 5 | 1 - 5 days: 4 | 6 - 30 days: 18 | 31 - 90 days: 20 | 90+ days: 50 |

Mar 23

1 - 5 days

4

▼ 3 (-42.9%)

Average age

Days

Average re-assignment times

Breakdowns

Records

1 - 5 days, Mar 23: 4 ▼ 3 (-42.9%)

Priority ▼ 4 - Low □

Name ▫ Mar 23 ▫ Change ▫ Trend ▫ Distribution

4 - Low ▫ 0 ▫ 0 ▫
Note: The Overview tab has the same contents as the Problem Overview dashboard.
### Open Problems Older Than 30 Days by Assignment Group and State

<table>
<thead>
<tr>
<th>Assignment Group</th>
<th>New</th>
<th>Asses</th>
<th>Root Cause Analysis</th>
<th>Fix In Progress</th>
<th>Received</th>
<th>Closed</th>
</tr>
</thead>
<tbody>
<tr>
<td>(empty)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Financial Systems...</td>
<td>14</td>
<td>5</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>HR Systems Support</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Marketing Systems...</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oracle Support</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Solving</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales Systems Sup...</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAP Support</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ServiceNow System...</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Service...</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Open Problems Not Updated In Last 30 Days by Assignment Group and State

<table>
<thead>
<tr>
<th>Assignment Group</th>
<th>New</th>
<th>Asses</th>
<th>Root Cause Analysis</th>
<th>Fix In Progress</th>
<th>Received</th>
<th>Closed</th>
</tr>
</thead>
<tbody>
<tr>
<td>(empty)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Financial Systems...</td>
<td>14</td>
<td>5</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>HR Systems Support</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Marketing Systems...</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oracle Support</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Solving</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales Systems Sup...</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAP Support</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ServiceNow System...</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Service...</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
% of new critical problems

17%

Average age of open problems

182 days

Average close time of problems

1 days

% of problems reassigned at least once

65%

% of problems closed on first assignment

0

Average reassignment count of closed problems

No data available
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>All roles concerned with Problem Management</td>
<td>itil to see the list of Problem records</td>
</tr>
</tbody>
</table>

Indicators

**Number of open problems**
Problems on the Problem (problem) table created on or before today and with no Closed date. This indicator is used in several other indicators on the dashboard.

**Number of closed problems**
Problems on the Problem (problem) table closed today. This indicator is used in several other indicators on the dashboard.

**Average age of open problems**
The score for this indicator is calculated according to the formula 
\[
\text{Average age of open problems} = \frac{\text{Summed age of open problems}}{\text{Number of open problems}} / 24
\]

**Average re-assignment of open problems**
The average number of times an open problem gets reassigned. The score for this indicator is calculated according to the formula 
\[
\text{Average re-assignment of open problems} = \frac{\text{Summed re-assignment of open problems}}{\text{Number of open problems}}
\]

**Average age of updated since of open problems**
The average time in days since the last update of an open problem. The score for this indicator is calculated according to the formula 
\[
\text{Average age of updated since of open problems} = \frac{\text{Summed age of updated since of open problems}}{\text{Number of open problems}} / 24.
\]

**% of new critical problems**
The score for this indicator is calculated according to the formula 
\[
\% \text{ of new critical problems} = \left( \frac{\text{Number of new problems > Priority = 1 - Critical}}{\text{Number of new problems}} \right) \times 100
\]

**Average close time of problems**
The score for this indicator is calculated according to the formula 
\[
\text{Average close time of problems} = \frac{\text{Summed duration of closed problems}}{\text{Number of closed problems}} / 24
\]

**% of problems reassigned at least once**
The score for this indicator is calculated according to the formula 
\[
\% \text{ of problems reassigned at least once} = \left( \frac{\text{Number of reassigned open problems}}{\text{Number of open problems}} \right) \times 100
\]

**% of problems closed on first assignment**
The score for this indicator is calculated according to the formula 
\[
\% \text{ of problems closed on first assignment} = \left( \frac{\text{Number of problems closed on first assignment}}{\text{Number of closed problems}} \right) \times 100
\]

**Average reassignment count of closed problems**
The average value of the Reassignment Count field on closed problems, where Reassignment Count is not empty.

**% of open problems classified as known error**
The score for this indicator is calculated according to the formula \( \frac{\text{Number of open problems classified as known error}}{\text{Number of open problems}} \times 100. \)

**% of closed problems without any close notes**

The score for this indicator is calculated according to the formula \( \frac{\text{Number of closed problems without close notes}}{\text{Number of closed problems}} \times 100. \)

**% of open problems with at least one incident**

The score for this indicator is calculated according to the formula \( \frac{\text{Number of open problems with at least one incident}}{\text{Number of open problems}} \times 100. \)

The following indicators are not shown directly on the dashboard but are used in calculating formulas:

- Summed age of open problems
- Summed age of updated since of open problems
- Summed duration of closed problems
- Summed re-assignment of open problems
- Number of reassigned open problems
- Number of problems closed on first assignment
- Number of open problems classified as known error
- Number of closed problems without close notes
- Number of open problems with at least one incident

**Breakdowns**

- Age
- Priority
- State
- Assignment Group

**Reports**

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical open problems</td>
<td>Single Score</td>
<td>All open problems where Priority is 1 - Critical. This report tells you at a glance how many top priority problems there are.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unassigned problems</td>
<td>Single Score</td>
<td>All open problems where 'Assigned to' is empty. These are the problems you have to assign.</td>
</tr>
<tr>
<td>Overdue problems</td>
<td>Single Score</td>
<td>All open problems where Escalation = Overdue</td>
</tr>
<tr>
<td>Open problems</td>
<td>Single Score</td>
<td>All open problems</td>
</tr>
<tr>
<td>Problems not updated for 7 days</td>
<td>Single Score</td>
<td>Open problems where the value in the Updated field is more than 7 days ago</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open problems older than 30 days</td>
<td>Single Score</td>
<td>Open problems where the value in the Created field is more than 30 days ago</td>
</tr>
<tr>
<td>Open problems - Grouped</td>
<td>Horizontal Bar</td>
<td>Open problems grouped by Priority</td>
</tr>
<tr>
<td>Open problems older than 30 days - Grouped</td>
<td>Horizontal Bar</td>
<td>Open problems where the value in the Created field is more than 30 days ago, grouped by Priority</td>
</tr>
<tr>
<td>Problems by Priority and State</td>
<td>Heatmap</td>
<td>Open Problems grouped on a matrix of Priority and State</td>
</tr>
<tr>
<td>Open problems older than 30 days by Priority and State</td>
<td>Heatmap</td>
<td>Open problems where the value in the Created field is more than 30 days ago, grouped on a matrix of Priority and State</td>
</tr>
<tr>
<td>Open problems not updated in last 30 days by assignment group</td>
<td>Heatmap</td>
<td>Open problems where the value in the Updated field is more than 30 days ago, grouped on a matrix of State and Assignment Group</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>----------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Problems Opened per Week</td>
<td>Line</td>
<td>Count of all problems opened this year, trending by Opened per Week</td>
</tr>
<tr>
<td>Problems Closed per Week</td>
<td>Line</td>
<td>Count of all problems closed this year, trending by Closed per Week</td>
</tr>
<tr>
<td>Open Problems Where Assignee Is Not Active</td>
<td>Heatmap</td>
<td>Open problems where the value of Assigned to Active is false, grouped on a matrix of State and Assignment Group</td>
</tr>
<tr>
<td>Problems Pending a Change Request that is Already Closed</td>
<td>Heatmap</td>
<td>Open problems where the Change request has a State value of 3, meaning the request is closed, grouped on a matrix of State and Assignment Group</td>
</tr>
</tbody>
</table>

**Problem daily 7d - 28d dashboard**

Track the progress made by different assignment groups in resolving problems in the daily, weekly, and monthly time frames.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem manager - Track the progress of their groups in managing problems across daily, weekly, and monthly time frames</td>
<td>None</td>
</tr>
<tr>
<td>Problem agent - Track the progress of incidents they own across daily, weekly, and monthly timeframes</td>
<td>None</td>
</tr>
</tbody>
</table>

Indicators

In the 7 day and 28 day tabs, the widgets apply seven day and 28 day time series aggregations to the indicators.

Number of open problems

Problems on the Problem (problem) table created on or before today and with no Closed date. This indicator is used in several other indicators on the dashboard.

Number of closed problems

Problems on the Problem (problem) table closed today. This indicator is used in several other indicators on the dashboard.

Average age of open problems

The score for this indicator is calculated according to the formula \(\frac{\text{Summed age of open problems}}{\text{Number of open problems}} / 24\)

Number of open problems not updated in last 30 days

The number of open problems with the value of the Updated field more than 30 days ago.

Number of open problems not updated in last 90 days

The number of open problems with the value of the Updated field more than 90 days ago.

Average close time of problems

The score for this indicator is calculated according to the formula \(\frac{\text{Summed duration of closed problems}}{\text{Number of closed problems}} / 24\)

The following indicators are not shown directly on the dashboard but are used in calculating formulas:

- Summed age of open problems
- Summed duration of closed problems

Breakdowns

You can apply breakdown elements on this dashboard to all widgets simultaneously. Only Assignment Group elements are available. Select one or more assignment groups from the Select elements list.
Open Problem Age Monitor dashboard

Use this dashboard to track the progress of open problems across different age buckets. You can break down the problems by priority or assignment group.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem manager - Track how their groups are managing long-standing problems</td>
<td>ITIL to read records, otherwise none</td>
</tr>
<tr>
<td>Problem agent - Track long-standing problems that they own</td>
<td>ITIL to read records, otherwise none</td>
</tr>
</tbody>
</table>

Indicators

**Number of open problems**

Problems on the Problem (problem) table created on or before today and with no Closed date. This indicator is used in several other indicators on the dashboard.

**Average age of open problems**

The score for this indicator is calculated according to the formula \( \frac{\text{Summed age of open problems}}{\text{Number of open problems}} / 24 \)

**Average re-assignment of open problems**

The average number of times an open problem gets reassigned. The score for this indicator is calculated according to the formula \( \frac{\text{Summed re-assignment of open problems}}{\text{Number of open problems}} \).

**Average age of updated since of open problems**

The average time in days since the last update of an open problem. The score for this indicator is calculated according to the formula \( \frac{\text{Summed age of updated since of open problems}}{\text{Number of open problems}} / 24 \).

The following indicators are not shown directly on the dashboard but are used in calculating formulas:

- Summed age of open problems
- Summed re-assignment of open problems
- Summed age of updated since of open problems

Breakdowns

- Priority
- State
- Assignment Group

Release Management

The ServiceNow® Release Management application encompasses the planning, design, build, configuration, and testing of hardware and software releases to create a defined set of release components.
The Release Management application handles releases using the task record system. Each planned feature is generated through various means as a task record, populated with the pertinent information in individual fields. These tasks can be assigned to appropriate release management team members, who deal with the tasks as appropriate until the release has been properly deployed.

Release Management can be effectively used to coordinate releases as a vehicle for planning releases, composed of individual work items such as, projects, epics, stories, problems, and so on. After the release scope (projects, stories, and so on) is finalised, you can generate Change Items and associate them to the release, allowing the implementation and deployment of a release to be handled within the change management process.

**Domain separation in Release Management**

This is an overview of domain separation and Release Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: Basic**

- There is business logic to ensure data goes into the proper domain for the application’s service provider use cases.
- In the application, the user interface, cache keys, reporting, rollups, aggregations, and so on, all consider domain at run time.
- The owner of the instance needs to be able to set up the application to function normally across multiple tenants.

Use case: As a service provider when I use chat to respond to a tenant-customer’s message, the client must be able to see my response.

**Release Management concepts and tables**

The Release Management application encompasses the planning, design, build, configuration, and testing of hardware and software releases to create a defined set of release components.

Release management comprises of a series of activities performed to ensure that the changes are applied successfully to both pre-production and product environments.
# Release Management concepts

<table>
<thead>
<tr>
<th>Concept</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Products</td>
<td>Represents the hardware or software for which releases are built. A product can be linked with a Business Service in the CMDB to link it with other ITIL processes.</td>
</tr>
<tr>
<td>Releases</td>
<td>Bundles all the work done (projects, epics, stories, enhancements, defects, problems, incidents, and so on) for products or services together and ensures that these work items are built, tested, and deployed on non-production and/or production environments.</td>
</tr>
<tr>
<td>Release Phases</td>
<td>Represents the planned phases within a release, which are used to group the tasks required to carry out the release. For example, gathering requirements, planning, design, development, testing, and deployment.</td>
</tr>
<tr>
<td>Release Tasks</td>
<td>Represents any of the tasks required to implement a feature of a product.</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Table relationships

Note: The tables for Feature and Feature Task under a release are not removed. If you already use Feature and Feature Task under a release, you can continue doing so.
Activate Release Management

Activate the Release Management plugin (com.snc.release_management_v2) with the admin role.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for &lt;plugin name&gt;.

Release Management v2 application

The Release Management v2 plugin (com.snc.release_management_v2) provides release tables which store information about the planned release and tasks that are required to execute the release.

The Release Management v2 application contains with a flexible product, release, phase, release work items, and task hierarchical table layout to allow for releases of varying complexity.

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product (rm_product)</td>
<td>Represent whole products whose releases are being managed.</td>
</tr>
<tr>
<td></td>
<td>It is optional to use the Product construct. A generic release can also be defined without any specific product.</td>
</tr>
<tr>
<td>Release (rm_release)</td>
<td>Represent individual releases of the product.</td>
</tr>
<tr>
<td>Release Phase (rm_release_phase)</td>
<td>Represent the different stages of work required to complete a release.</td>
</tr>
<tr>
<td>Release Tasks (rm_task)</td>
<td>Represent tasks under a phase for phase activities.</td>
</tr>
<tr>
<td>Release Items (rm_m2m_release_task)</td>
<td>Represents work items and change records associated to the release.</td>
</tr>
</tbody>
</table>

Product hierarchy in Release Management

If a product has releases defined, the Product Hierarchy related link displays the hierarchy of releases, phases, and phase tasks associated with the product.

A release can be an enterprise release, in which it is associated to all products or services or to more than one product. In either case, defining a product is not required.
Define a product in Release Management

A product record stores information about a product for reference purposes and groups all the releases and work artifacts for the product.

To define a product, navigate to Release > Products and click New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique identifier for the Product. Generated using Number Maintenance.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>The CI that corresponds to the product.</td>
</tr>
<tr>
<td>Assignment Group</td>
<td>A group responsible for the product.</td>
</tr>
</tbody>
</table>
You can use the Configuration Items reference field to link the product with a corresponding CI in the CMDB. Each CI keeps information about how it relates to other CIs, and can track any incidents, problems, or changes related to it. Specifying a CI for the Product connects information from the release process to other processes in the instance.

After releases are defined for a product, the Product Hierarchy related link displays the hierarchy of releases, release phases, and release tasks associated with the product.

Define a release in Release Management

During the release planning process, release managers define the type of the release (major, minor, and so on.), schedule of the release (planned start and end dates), required phase, phase tasks, and the scope.

1. Navigate to Release > Products.
2. Click the product number to which you want to add a release.
3. In the Releases related list, click New.

**Note:** If a release belongs to no product or more than one product, navigate to Release > Releases to define the release.

4. Fill in the fields, as appropriate:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release Type</td>
<td>Select the type of the release such as Major, Minor, Upgrade, Patch, or others.</td>
</tr>
<tr>
<td>Priority</td>
<td>The priority of the release such as Critical, High, Moderate, or others.</td>
</tr>
<tr>
<td>State</td>
<td>State of the release such as Draft, Work in progress, testing, or others.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>The progress of the release in percentage of the whole.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief of the release. This description helps in identifying a release from a list of releases.</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the release.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>Tentative start date of the release.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Tentative end date of the release.</td>
</tr>
</tbody>
</table>
5. Click Submit.

- Attach documents such as release and deployment plans, installation manuals, and training documentation to a release.
  
  For more information, see Add and manage attachments.
- Releases can have child releases. So, you can group minor releases under major releases.
  
  To add a child release, click New in the Releases related list in the Release form.
- Define a release phase in Release Management.
- Define scope of a release in Release Management

Define a release phase in Release Management

Define a release phase from the Release form.

For release governance and smooth execution, many a times release managers define multiple phases for a release.

For example, if the release is managed more like a waterfall process, the release phases could be requirement gathering, design, development, testing, build, acceptance, and deployment. For each phase, there can be release tasks associated to it. The phase gets completed as and when all tasks are completed for a phase. Release managers must keep the release phases updated.

If the release is divided into multiple merges, the phases could be merge 1, merge 2, merge 3, and so on. The type and number of phases would depend upon the release management process of your organization.

2. Click the release number to which you want to add a release phase.
3. In the Release Phases related list, click New.
4. Fill in the fields, as appropriate:

### Release form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>The priority of the phase such as Critical, High, Moderate, or others.</td>
</tr>
<tr>
<td>State</td>
<td>State of the phase such as Draft, Work in progress, testing, or others.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>The progress of the phase in percentage of the whole.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief of the phase. This description helps in identifying a phase from a list of release phases.</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the phase.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>Tentative start date of the phase.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Planned end date | Tentative end date of the phase.
Planned duration | The duration of the phase in days. This field is automatically updated based on the values of Planned start date and Planned end date.

5. **Click Submit.**

**Define scope of a release in Release Management**

Add projects, epics, stories, enhancements, and defects to define the scope of a release.

**Role required:** Release manager

Before starting the release execution, you must define scope of the release. Scope of a release includes the work artifacts such as projects, epics, stories, enhancements, defects, and so on, that are a part of the release.

For example, a minor release might only have a few problems and enhancements whereas a major release might have multiple projects or epics associated to it.

1. **Navigate to Release > Releases.**
2. **Click the release number for which you want to define the scope.**
3. **In the Release form, navigate to one of the following related lists:**
   - Projects
   - Scrum Epics
   - Scrum Stories
   - SAFe Epics
   - SAFe Features
   - SAFe Stories
   - Defects
   - Enhancements
   - Incidents
   - Problems
   - Changes

**Note:** To view the respective work items, ensure that the plugins Agile Development 2.0, Project Portfolio Management, Essential SAFe, and Portfolio SAFe are active.

4. **Click Attach task.**
5. **To find and locate the required task, click the search icon .**
6. **To add the task as a release task, click the task number.**
7. **Click Submit.**

**Software control distribution**

The application enables the Release Management team to control the distribution of software by creating a **Definitive Media Library (DML)** stored in the CMDB.
The DML consists of a physical store and a logical store.

- The physical store holds master copies of all software media. This tends to be software that has been provided from an external source.
- The logical store is the index of all software and releases, versions, and so on, highlighting where the physical media can be located. The logical store may also be used to store software that is developed within the organization.

Both physically and logically stored software are represented as records on the DML table.

**Release Management roles**

Access the application and task-related modules of the application using the Release Management roles.

The release_v2_admin and release_v2_user roles can access the applications as follows:

- Admins can access the entire application.
- Users can access the all the various feature and task-related modules but cannot update their content.

**Request Management**

Request Management allows catalog items to be requested and fulfilled based on defined flows.

**Request Management architecture**

Request Management allows catalog items to be requested and fulfilled based on defined flows.

**Request Management hierarchy**

Service Catalog is the starting point of the request management process. The request management process is triggered only when a catalog item from the Catalog Item (sc_cat_item) table is requested.

When a user submits a request for a catalog item, records are generated in the following hierarchy.
Note: When you configure Request Management:

- The data model does not support a record producer generating request management objects such as request, request item, and catalog task. Hence, do not use a record producer to insert records in the following request management tables:
  - Request (sc_request)
  - Request Item (sc_req_item)
  - Catalog Task (sc_task)

- Do not write business rules with the `before` trigger for the following tables:
  - Request (sc_request)
  - Request Item (sc_req_item)
  - Cart (sc_cart)
  - Cart Item (sc_cart_item)

Request management process

Catalog item is ordered directly without adding it to the cart

When a catalog item is ordered or requested directly without adding it to the cart, the following steps are performed:

1. A temporary cart, sc_cart, is created.
2. The catalog item along with the variables (values entered by the user) is added to the temporary cart as a record in the Cart Item (sc_cart_item) table.
3. The variables are saved in the Options (sc_item_option) and Variable Ownership (sc_item_option_mtom) tables.
4. The temporary cart is checked out by performing these steps.
   a. A record in the Request (sc_request) table is initialized but not committed in the database.
   b. A record in Request Item (sc_req_item) table is initialized but not committed in the database.
   c. The request reference for the Request Item (sc_req_item) table record is updated with the Request (sc_request) table record.
   d. The variables record in the Options (sc_item_option) and Variable Ownership (sc_item_option_mtom) tables are updated based on the Request Item (sc_req_item) table record.
   e. The Request Item (sc_req_item) table record is committed in the database.
   f. The Request (sc_request) table record is committed in the database.

Request is submitted after adding the item to the cart

If a catalog item is added to the cart and the request is submitted using the checkout process, the default cart is checked out. All steps mentioned in the preceding scenario, Catalog item is ordered directly without adding it to the cart, are applicable. However, if multiple catalog items are added to the cart, step b to step e are repeated for each item.

Request is submitted using an order guide

For a two-step order guide checkout, the temporary cart is used for all items. For a three-step order guide checkout, the default cart is used for the items. All steps mentioned in the preceding scenario, Catalog item is ordered directly without adding it to the cart, are applicable.

Domain separation in Request Management

This is an overview of domain separation in Request Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Standard

- Includes Basic level support.
- Business logic: Processes can be created or modified per customer by the service provider (SP). The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The owner of the instance needs to be able to configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin needs to be able to make comments mandatory when a record closes for one tenant, but not for another.
Activation information

The Domain Support - Domain Extensions Installer plugin (com.glide.domain.msp_extensions.installer) should be activated to enable domain separation for Request Management. For information on how you can request for this plugin activation, see Request domain separation.

How domain separation works in Request Management

Fulfillers see only requests, requested items, and catalog tasks that have been created within the (tenant) domain for which the fulfillsr has the visibility. For information on visibility in domain hierarchies, see Visibility domains and Contains domains.

Domain separated tables

- Request (sc_request)
- Requested Item (sc_req_item)
- Catalog Task (sc_task)

Use cases

- A user belonging to “Initech” domain, submits a request. Only those fulfillers belonging to “Initech” domain or global domain can see this request.
- A fulfiller belonging to a parent domain can see requests, requested items, and catalog tasks of all its child domains as well.
- A fulfiller belonging to a specific domain can create requests only on behalf of the domains that they have access to.
- If a user has access to multiple domains, the domain specified on the current record drives the functionality of that record and reference fields.

Agent Workspace for Request Management

Agent Workspace for Request Management integrates the platform functionality specific to tier 1 agents into an easy-to-navigate interface. This multi-tab interface helps the agents to efficiently manage multiple incidents, catalog requests, and catalog tasks. The ITSM Workspace plugin (com.snc.agent_workspace.itsm) that automatically activates the Service Catalog - Workspace (com.glideapp.servicecatalog.workspace) plugin should be activated for the Request Management flows in workspace.

Request Management categories in workspace

- Request: Displays the active requests and requested items.
- Catalog Task: Displays the active tasks assigned to the current user, and to at least one of the assignment groups of the user.
Request Management forms in workspace

The form layouts, UI actions, UI policies, and client scripts that are available on the following Request Management forms in Platform are also available on the corresponding Workspace forms.

- Request
- Request Item
- Catalog Task

Note: A variable editor is displayed as a pop-up window for request items and catalog tasks only if it is included in the Platform forms.

If you want to change the view of any workspace form, customize the workspace view from the corresponding request management form in the platform UI.

Create a catalog request in Agent Workspace

You can create a catalog request in Agent Workspace to join the Service Catalog flow from a different flow. For example, from an incident flow, you can create a request, and associate the request with the incident. It helps you in tracking the requests associated with an incident and vice versa.

Role required: itil

You can create a catalog request in Agent Workspace to join the Service Catalog flow from a different flow. For example, from an incident flow, you can create a request, and associate the request with the incident. It helps you in tracking the requests associated with an incident and vice versa.

- To associate a request with any parent table record, the corresponding mapping configuration should be available in the Catalog Administration > Request Parent Mapping submodule.
- To associate a record producer request with the parent table record, retrieve the sysparm_parent_sys_id and sysparm_parent_table parameters from the URL using the RP.getParameterValue() method in the Script field of the record producer.
- For the Create Request UI actions in workspace on the Interaction [interaction] table, the field values should be as follows:
  - Workspace Client Script:
    ```javascript
    function onClick() { var result = g_form.submit('sysverb_ws_save'); if (!result) { // failed form submission return; } result.then(function() { var params ={}; params.sysparm_parent_table = "interaction"; params.sysparm_parent_sys_id = g_form.getUniqueValue(); g_service_catalog.openCatalogItem('sc_cat_item', '-1', params); }); } }
    ```
- For the Create Request UI actions in workspace on the Incident [incident] table, the field values should be as follows:
  - Condition: current.incident_state != global.IncidentState.CLOSED && gs.hasRole("itil")
  - Workspace Client Script:
    ```javascript
    function onClick() { g_form.submit('sysverb_ws_update').then(function() { var params ={}; params.sysparm_parent_table = "incident";
    ```
params.sysparm_parent_sys_id = g_form.getUniqueValue();
g_service_catalog.openCatalogItem('sc_cat_item', '-1', params); }}; }

1. Initiate a catalog request using any of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
</table>
| **From an incident using the Create Request UI action** | 1. From the List panel, select an open incident.  
2. In the Details tab, from the More UI Actions menu, select Create Request. The Service Catalog categories page is displayed with available categories.  
3. Navigate to a catalog item, order guide, or record producer that you want to order.  

**Note:** You can only order items from the catalogs that are accessible. |

| From an incident using Agent Assist          | 1. From the List panel, select an open incident.  
2. In the Details tab, click the Toggle Sidebar.  
3. From Agent Assist in the contextual sidebar, search for the catalog item, order guide, or record producer that you want to request.  
4. Click Order. |

| From an interaction record                  | 1. Select Add New > Interaction.  
2. From the More UI Actions menu, select Create Request. The Service Catalog categories page is displayed with available categories.  
3. Navigate to a catalog item or order guide that you want to order.  

**Note:** You can only order items from the catalogs that are accessible. |

2. Click Order Now.  
The Order Confirmation window is displayed.  

**Note:** The caller of the incident is set as the Request For user by default.  

3. Optional: Specify the Delivery Information and Special instructions.  
4. Click Checkout.  
The request is created and associated with the parent incident.  
5. Click Close.  
6. Optional: To view the created request, click View Details.
Request ITSM Roles - Request Management

Request the ITSM Roles plugin (com.snc.itsm.roles) to activate the ITSM Roles — Request Management plugin (com.snc.itsm.roles.request_management) to gain more control over the access that different service desk agents, technicians, and managers have within your Request Management process.

Role required: admin

The ITSM Roles plugin (com.snc.itsm.roles) includes an additional security model. The security model provides more granular roles across ITSM applications as well as within them, allowing you flexibility in setting up access controls. The ITSM Roles plugin is available by default in new instances. Users upgrading from Madrid or earlier versions must request the plugin.

Plugins for ITSM Roles

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Adds roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Stakeholder (com.snc_business_stakeholder)</td>
<td>business_stakeholder</td>
</tr>
<tr>
<td><strong>Note:</strong> The business_stakeholder role contains the sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.</td>
<td></td>
</tr>
</tbody>
</table>
| ITSM Roles — Incident Management (com.snc.itsm.roles.incident_management) | • sn_incident_read  
• sn_incident_write |
| ITSM Roles — Problem Management (com.snc.itsm.roles.problem_management) | • sn_problem_read  
• sn_problem_write |
| ITSM Roles — Change Management (com.snc.itsm.roles.change_management) | • sn_change_read  
• sn_change_write |
| ITSM Roles — Request Management (com.snc.service_management.roles.request_management) | • sn_request_read  
• sn_request_write |
| **Note:** As there are future updates expected for the sn_request_read role, do not assign it to users without the business_stakeholder role. |

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and subproduction instances, generally within a few days.

If you don’t have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.
Note: Activate the ITSM Roles plugin on a subproduction environment and test the functionality before requesting activation in the production environment. For assistance, contact the ServiceNow Professional Services team.

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the request form on HI.

3. On HI, select to be redirected to the HI Service Portal Service Catalog.
4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click Submit.

**Components installed with ITSM Roles — Request Management**

Several user roles are installed with the activation of the ITSM Roles - Request Management plugin (com.snc.itsm.roles.request_management).

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see *Find components installed with an application*.
Roles installed

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_request_read</td>
<td>Read access to the Request (sc_request) or Requested Item (sc_req_item) only for a user who is also an approver of the request or requested item.</td>
<td>NA</td>
</tr>
</tbody>
</table>

**Note:** As there are future updates expected for the sn_request_read role, do not assign it to users without the business_stakeholder role.

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_request_write</td>
<td>Write access to the Request (sc_request) or Requested Item (sc_req_item).</td>
<td>task_editor, dependency_views, agent_workspace_user, view_changer, cmdb_read, cmdb_query_builder_read, sn_request_read</td>
</tr>
</tbody>
</table>

Activate Business Stakeholder

Activate the Business Stakeholder plugin (com.snc.business_stakeholder) if you have an admin role. This plugin installs the Business Stakeholder role. Users with this role can view and approve records at all ITSM product levels.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Installed with Business Stakeholder

The Business Stakeholder plugin (com.snc.business_stakeholder) installs the Business Stakeholder role when activated.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.
Roles installed

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Stakeholder</td>
<td>Users with this role can view and approve records within all products of ITSM.</td>
</tr>
</tbody>
</table>

Note: The business_stakeholder role contains the following ITSM roles sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.

- pa_viewer.business_stakeholder
- approver_user.business_stakeholder
- cmdb_read.business_stakeholder

Service Desk

The Now Platform includes a default homepage and the ServiceNow® Service Desk application to provide a basic set of service desk functions.

Note:
The Service Desk Call plugin (com.snc.service_desk_call) has started its end-of-life process from Orlando. This is a three release process and the plugin will be completely deprecated in the Quebec release. New users can no longer be able to activate the plugin. Similar outcome can be achieved using Interaction in Agent Workspace. For more details, refer Create an interaction record in ITSM Agent Workspace.

Both can be customized to suit the processes you are involved in and the needs of the organization.
The ITIL Homepage provides commonly used reports that give an overview of the processes you are involved in. Access the ITIL Homepage from the homepage icon on the edge (UI15) or favorites tab (UI16).

By default, the ITIL Homepage includes the following reports.

- **Users by location**: a pie chart displaying users divided by location.
- **Open Items by Escalation**: tasks with an open state, grouped by escalation.
- **My Groups Work**: outstanding work for your group.
- **My Work**: your outstanding work.
- **ITIL Summary Counts**: tasks that are critical, overdue, and over a week old.

These reports link directly to the appropriate records and tables. Use the work queues and the reports on critical tasks to manage your work directly from the homepage.

**Service Desk Call**

Using Service Desk Call, ITIL users can create a call record and quickly capture basic information from a customer contact. Users can then decide if the call is an incident, a problem, a change, or a service catalog request.

Note: The Service Desk Call plugin (com.snc.service_desk_call) has started its end-of-life process from Orlando. This is a three release process and the plugin will be completely deprecated in the rome release. New users can no longer be able to activate the plugin. Similar outcome can be achieved using Interaction in Agent Workspace. For more details, refer [Create an interaction record in ITSM Agent Workspace](#).

Service desk personnel can more quickly process customer calls by retaining and reusing the information captured during the call. Users with the itil role can read, create, and edit an existing call, but cannot delete existing calls or edit a call after it is transferred.

At the end of the call, the ITIL user can decide the action to take.

- Transfer the call record to an incident, problem, change, or service catalog request.
- Record the call as another type of contact, such as a wrong number.

Note: The Service Desk Call plugin (com.snc.service_desk_call) has started its end-of-life process from Orlando. This is a three release process and the plugin will be completely deprecated in the Quebec release. New users can no longer be able to activate the plugin. Similar outcome can be achieved using Interaction in Agent Workspace. For more details, refer [Create an interaction record in ITSM Agent Workspace](#).

**Request Service Desk Call**

The Service Desk Call plugin (com.snc.service_desk_call) has started its end-of-life process from the Orlando release. This is a three release process and the plugin will be completely deprecated in the Quebec release. New users can no longer be able to activate the plugin.

Role required: none
Similar outcome can be achieved using Interaction in Agent Workspace. For more details, refer to Create an interaction record in ITSM Agent Workspace.

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the request form on HI.

3. On HI, select to be redirected to the HI Service Portal Service Catalog.
4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches each business day in the Pacific time zone, once in the morning and once in the evening. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments. |

5. Click **Submit**.

### Installed with Service Desk Call

Several types of components are installed with Service Desk Call.

**Tables installed with Service Desk Call**

Service Desk Call plugin adds the following table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call</td>
<td>The base table for service desk call that contains all call information.</td>
</tr>
<tr>
<td>(new_call)</td>
<td></td>
</tr>
</tbody>
</table>

**Client scripts installed with Service Desk Call**

Service Desk Call plugin adds the following client script.
### Business rules installed with Service Desk Call

Service Desk Call plugin adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CallTypeChanged</td>
<td>Call</td>
<td>Creates an incident, problem, or change record, based on the call type selection.</td>
</tr>
<tr>
<td>CallTypeChanged to Request</td>
<td>Call</td>
<td>Redirects to a new service catalog request page based on the call type and request item selection.</td>
</tr>
<tr>
<td>Calculate time spent</td>
<td>Call</td>
<td>Calculates the time spent between opening the form and saving it.</td>
</tr>
<tr>
<td>Domain - Set Domain - SD Call</td>
<td>Call</td>
<td>Supports domain separation.</td>
</tr>
</tbody>
</table>

### Domain separation and Service Desk Call

This is an overview of domain separation and Service Desk Call. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

#### Support level: Basic

- **Business logic:** Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

#### Overview

- Using Service Desk Call, ITIL users can create a call record and quickly capture basic information from a customer contact. Users can then decide if the call is an incident, a problem, a change, or a service catalog request.
• Service Desk personnel can process customer calls more quickly by retaining and reusing the information captured during the call. Users with the ITIL role can read, create, and edit an existing call, but cannot delete existing calls or edit a call after it is transferred.

• At the end of the call, the ITIL user can decide one of two actions to take:
  • Transfer the call record to an incident, problem, change, or service catalog request.
  • Record the call as another type of contact, such as a wrong number.

• Typically, ITIL users create the new_call (Service Desk) records when they receive a call from ESS user. Once they understand the nature of the issue, the new_call record is converted into a corresponding incident, request, problem, change, and so on.

• The (new_call) table supports domain separation. Therefore, an ITIL/Filler sees only those new_call records that have been created within the (tenant) domain that they belong to.

How domain separation works in Service Desk
ITIL/Fillers see only those new_call records that have been created within the (tenant) domain that they belong to.

Domain separated tables
• Calls (new_call)

Use cases
• An ITIL/Filler creates new_call records only in those domains to which they have access.
• When a new_call record is converted into a Request / Incident / Problem / Change, and so on, the corresponding record is created in the same domain as that of the associated new_call record.
• An ITIL/Filler can create a new_call record only for those callers who belong to the domains to which they have access.

Service Desk Call and domain separated systems
Saving a call record may create two records: a service desk call record and a transferred record. For systems using domain separation, these two records may be stored in different domains.

The service desk call record is saved in the ITIL user’s domain. This domain is determined as follows:
• Use the ITIL user’s domain if the ITIL user has a domain.
• Otherwise, use the default domain.

Any transferred record is saved in the domain of the caller. This domain is determined as follows:
• Use the domain of the caller if applicable.
• Otherwise, use the default domain.

Service Desk Call uses
ITIL users, users with the itil role, can quickly capture basic information within a call record while in contact with the customer.

After the information has been gathered, they can decide how to classify that call record, for example, as an incident.
ITIL users can use service desk call to perform any of the following tasks.

- Create a call record.
- Transfer a call record to an incident, problem, change, or service request.
- View call record information.

**Note:**
The Service Desk Call plugin (com.snc.service_desk_call) has started its end-of-life process from Orlando. This is a three release process and the plugin will be completely deprecated in the Quebec release. New users can no longer be able to activate the plugin. Similar outcome can be achieved using Interaction in Agent Workspace. For more details, refer Create an interaction record in ITSM Agent Workspace.

**Create a call**

You can create a call when a user contacts you for assistance with an issue.

Role required: itil

1. Navigate to **Service Desk > Calls > New Call.**
2. Complete the form.

**Call form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>An auto-generated identifying number for the call record.</td>
</tr>
<tr>
<td>Caller</td>
<td>The person who contacted the service desk. Entry is mandatory if the call type is Incident, Problem, Change, or Request.</td>
</tr>
<tr>
<td>Company</td>
<td>The company where the call originated.</td>
</tr>
<tr>
<td>Call type</td>
<td>A field that specifies the status of the call.</td>
</tr>
<tr>
<td></td>
<td>- Select a task type, such as Incident, to transfer the call.</td>
</tr>
<tr>
<td></td>
<td>- Select Hang Up, Wrong Number, Status Call, or General Inquiry to save the call record without transferring.</td>
</tr>
<tr>
<td>Opened</td>
<td>The date and time when the call record was opened.</td>
</tr>
<tr>
<td>Opened by</td>
<td>The ITIL user who communicated with the customer.</td>
</tr>
<tr>
<td>Contact type</td>
<td>The type of communication used to contact the service desk.</td>
</tr>
<tr>
<td>Short description</td>
<td>A short description of the issue or question.</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about the call that might be helpful for others to know. This field is visible to the customer.</td>
</tr>
</tbody>
</table>

3. Click **Submit.**
If the call type is Incident, Problem, Change, or Request, the call transfers, creating another record of the appropriate task type. A message provides the task number as a link.

Tasks by same caller or company

When you submit a call, two related lists are associated with the call record: Tasks by Same Caller and Tasks by Same Company. Checking these related lists can be useful to check for duplicate calls.

Call related lists
All active incidents, problems, changes, and service catalog requests for that caller or company are listed.

The **Tasks by Same Caller** list shows all active records where the value in the **Caller** field on the Call form matches the value in:

- The **Caller** field on the Incident form.
- The **Opened by** field on the Problem form.
- The **Requested by** field on the Change Request form.
- The **Requested for** field on the service catalog Request form.

The **Tasks by Same Company** list shows all active records where the value in the **Company** field on the Call form matches the value in:

- The company of the caller on the Incident form.
- The company of the user that opened the problem on the Problem form.
- The company of the user that requested the change on the Change form.
- The company of the user the request was made for on the service catalog Request form.

**Call transfer**

Details gathered during the customer contact determine the type of record. Saving the call with a call type of **Incident**, **Problem**, **Change**, or **Request** saves the call record and also creates a record of the task type selected.

For example, the service desk receives a phone call from a customer reporting email issues with a laptop. When the call is answered, the service desk user opens a call record and enters basic information during the phone call. At the end of the phone call, the service desk user decides it should be logged as an incident, sets the **Call type** to **Incident**, and saves the call record. A new incident record with details taken from the original call record is created. The new incident is handled through standard incident management processes.

After a call is transferred, the number of the new record appears in the **Transferred to** field on the Call form and the Calls list. A link to the new record appears above the Calls list.

**Transfer a call to an incident, problem, or change**

When you select a task call type, you transfer the call to an incident, problem, or change request.

Role required: itil

1. In the Call form, set **Call type** to **Incident**, **Problem**, or **Change**.
2. Click **Submit** to transfer the call.

A record of the appropriate type is created, with the following information copied from the call:

- Short description
- Description
- Company
- Contact Type
- Opened By
- Caller
- Location (Incident only, populated with the location of the caller)
- Requested by (Change only, populated with the name of the caller)
Transfer a call to a service catalog request

You can transfer a call to a service catalog request and enter the relevant details for the requested catalog item as part of a single process.

Role required: itil

1. In the Call form, set Call Type to Request.
   A Request item field appears on the form.
2. Select the catalog item to request.
   Content items, record producers, and order guides are not supported.
3. Click Submit.
   The order form for that catalog item appears.
4. Select any other options for that catalog item, as required.
5. Order the item.
   The service catalog request is created with the following information.
   • The Caller is copied to the Requested For field in the request.
   • The Description field in the Call form is copied to Special instructions.

The requested item is listed in the Task by Same Caller related list in the call.

View service desk calls

You can view call records from several Service Desk modules.

• Service Desk > Calls > My Calls lists all calls that you created.
• Service Desk > Calls > My Open Calls lists all calls you created that have transferred records, such as incidents, that are still open.
• Service Desk > Calls > All Open Calls lists all calls created in the last month that have transferred records that are still open.
My calls

The **Time Spent** column shows the time between creating and saving the call record.

### Service Portfolio Management

ServiceNow® Service Portfolio Management enables you to improve your IT business operations and meet customer demands by documenting and managing your IT services using a standardized, structured format.

#### Explore
- Service Portfolio Management release notes
- Service Owner Workspace release notes
- ServiceNow upgrades
- Understanding Service Portfolio Management
- Service Owner Workspace

#### Set up
- Set up Service Portfolio Management
  - Model your taxonomy using Service Portfolio Management sample IT services portfolio content
  - Create or modify portfolios in Service Portfolio Management
  - Create or modify Service Portfolio Management services
  - Create and manage Service Portfolio Management service offerings

#### Administer
- Activate Service Portfolio Management
- Activate Service Portfolio Management Sample Content Pack
- Activate Service Owner Workspace
- Change scope to Service Portfolio Management Premium

#### Use
- Service Portfolio Management taxonomy
- Service Portfolio Management portfolios
- Service Portfolio Management services

#### Develop
- Developer training
- Developer documentation
  - Installed with Service Portfolio Management
  - Installed with Service Owner Workspace

#### Troubleshoot and get help
- Ask or answer questions in the Service Portfolio Management community
- Search the HI Knowledge Base for known error articles
Understanding Service Portfolio Management

With the Service Portfolio Management application, your organization can document and manage services using a standardized, structured format.

What is Service Portfolio Management?

Service Portfolio Management is a single, centralized application that aggregates the information portfolio managers and service owners need to:

- Design a pipeline of services that meets the greatest needs of the organization.
- Prevent unnecessary service duplication and overlap.
- Quickly identify and retire low value services so resources can be redeployed.

In the IT industry, service portfolio management is the creation, organization, and management of a portfolio of IT services, for example, communication-related services or infrastructure-related services. The purpose of implementing service portfolio management is to improve your IT business operations and meet customer demands by optimizing the value of services and reducing their costs. The Service Portfolio Management application helps you accomplish these goals. A service portfolio includes information related to the organization of services and data about each service, including status, as well as related items.

The service portfolio typically consists of services in three phases:

- Service pipeline: Status of services that are not yet operational or available for use. These services are typically proposed or services in review for suitability. You can leverage this aspect of the portfolio to analyze and manage the future growth and time line for each service.
- Service catalog: Overview of all services that are operational and available for use, as well as design and development. These services typically have representation in a request catalog.
- Retired services: Overview of services that are no longer operational or available for use. This overview can include any essential historical information.

With Service Portfolio Management, you can manage the entire portfolio of IT services available to your enterprise. Apply modules and features to justify each service based on business need by ensuring they deliver maximum value within managed risks and costs.

What is Service Owner Workspace?

To enhance your Service Portfolio Management experience, you can subscribe to Service Owner Workspace. Service Owner Workspace provides a premium Service Portfolio Management experience. Portfolio managers and service owners access an integrated and graphically intuitive user interface to manage and monitor portfolios and services in a central location.

Service Owner Workspace tracks and measures the performance of services and service offerings within multiple portfolios across a variety of common key metrics. Service Owner Workspace provides these key features:
- Metrics configuration.
- Service Offering Estimated Spend.
- Integration with other applications, for example, Financial Management and Vendor Manager Workspace.

Add business-related services to your service portfolio taxonomy and create dependencies to this type of service. Technical-related services are not added as part of your service portfolio taxonomy, but you can still gain insight into these services using common information (CI) relationship dependencies.

For details about subscribing to this premium upgrade, refer to Service Owner Workspace.

**Who uses Service Portfolio Management?**

IT organizations looking to provide greater value to the business and meet customer needs through information technology services. These IT organizations need to fully understand the assortment of services they offer. Service portfolio management is typically a critical objective for mature IT organizations and businesses seeking to provide superior support to customers or users.

A team of people work together to create, manage, and oversee the service portfolio. There are strategic roles, as well as operational roles, among the team members. In most organizations, people may participate in more than one role and often share roles with others.

**Portfolio owner**

Strategic role involved in the ownership of a portfolio. This person has overall authority and accountability for an entire IT service portfolio, typically at the CIO level. The portfolio owner's goal is to deliver a portfolio that offers value to the organization. There is only one portfolio owner, per portfolio.

**Portfolio manager**

Operational role involved with overall administrative capabilities over a portfolio. Creates and edits portfolio records of all types.

**Service owner**

Strategic role involved in the ownership of services. Typically this person is at the director-level within IT and has end-to-end accountability for a given service and its offerings through the full life cycle. This person often owns more than one service and may even own a branch of services. Service owners are not heavily involved in the day-to-day operation of the service.

**Service manager**

Operational role involved in the management of a service. Typically this person is at the director-level within IT and is responsible for the day-to-day delivery and operation of a service. Occasionally, the service owner and service manager are the same person.

**Process owner**

Strategic role external to the ownership and management of a portfolio or service. This person is responsible for defining and evolving the services, taxonomy, policies, procedures, governance, roles, and responsibilities over time. The process owner's goal is to progress service portfolio management maturity for the business.

**Process manager**

Operational role external to the ownership and management of a portfolio or service. This person is responsible for ensuring consistency of the portfolios and services within the portfolios across the IT organization. This person also ensures that the policies, procedures, and
How do you benefit from Service Portfolio Management?

- Transform your focus from IT assets and associated costs into services that you can price and link to business value. Your IT organization can go from a business cost center to a value-added service provider offering transparency into operations and spending.
- Align your IT services to strategic business goals.
- Meet the service demands of your customers and end users.
- Make better decisions regarding new service creation, improvement, delivery, and retirement.
- Improve productivity of IT support staff by better identifying and increasing focus on the services that offer the most business value.
- Increase cost-efficiency by consolidating duplicate services, enhancing under-performing services, and retiring low-value, unnecessary, or unused services.
- Document the various services offered using a standardized, structured format. Link offerings to items in a consumer-friendly service catalog.
- Define service offerings and the system automatically begins to track performance against defined metrics for operational service offerings. If outages occur, the platform handles availability tracking.

Service Portfolio Management administration

Service Portfolio Management includes several plugins to enable the organization, documentation, and management of service portfolios within your IT business department. Depending on the maturity of your IT business department, features and functionality are available at both the foundation level and at the premium level, with Service Owner Workspace. Administrators can activate plugins and assign specific Service Portfolio Management roles to system users.

Service Portfolio Management product applications

The following product application plugins are available:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portfolio Management Core (com.snc.service_portfolio_core)</td>
<td>Adds the Service Offering table (service_offering) to the Configuration Management Database (CMDB). Available by default for ITSM SKUs.</td>
</tr>
<tr>
<td>Service Portfolio Management Foundation (com.snc.service_portfolio)</td>
<td>Enables your organization to document portfolios, taxonomies, services, and service offerings using a standard and structured format. Contains demo data.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Service Owner Workspace  
(com.spm_owner_workspace) | Enables enhanced features and provides the Service Owner Workspace to the Service Portfolio Management environment.  
Automatically activates the Service Portfolio Management Premium plugin (com.snc.spm).  
Requires a separate subscription. Part of ITSM Professional suite. |

**Service Portfolio Management Taxonomy Content Pack**

You can also activate the Service Portfolio Management Taxonomy Content Pack plugin (com.snc.spm.content). This plugin contains demo data and provides sample taxonomy metadata, complete with portfolio, taxonomy layers, and nodes. Users can view services and service offerings, including related items, such as SLAs, incidents, changes, and more as a demonstration.

Portfolio managers benefit from the Service Portfolio Management Taxonomy Content Pack because it provides a useful example of how service portfolios and services are constructed within the application. This example results in faster modeling of an organization's service portfolio. Also, often portfolio managers must quickly provide the organization an example of a portfolio structure to accelerate decision making regarding business approach.

**Activate Service Portfolio Management**

The Service Portfolio Management Core plugin (com.snc.service_portfolio_core) is available by default for users with ITSM SKUs. You can activate additional available related plugins for enhanced features and functionality.

Role required: admin

The Service Portfolio Management Foundation plugin (com.snc.service_portfolio) enables your organization to document portfolios, taxonomies, services, and service offerings using a standardized, structured format. It contains demo data and activates related plugins.

The premium Service Owner Workspace plugin (com.spm_owner_workspace) requires a separate subscription and automatically activates the Service Portfolio Management Premium plugin (com.snc.spm). Subscribe to Service Owner Workspace to enable enhanced features and provide a superior Service Portfolio Management experience. For details, refer to Service Owner Workspace. View subscription applications and plugins to verify if your company has purchased a subscription for this premium plugin.

The Service Portfolio Management Foundation plugin (com.snc.service_portfolio) activates related plugins if they are not already active.
The table below includes related plugins for Service Portfolio Management Foundation:

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portfolio Management Core</td>
<td>Adds the Service Offering table (service_offering) to the Configuration Management Database (CMDB). Available by default for users with ITSM SKUs.</td>
</tr>
<tr>
<td>Service Catalog core applications</td>
<td>Enables integrations with the Service Catalog application and its capabilities.</td>
</tr>
<tr>
<td>Report Engine- use summary table for reports</td>
<td>Adds the glide.report_summary_engine system property and enables the Summary Sets reporting engine for all reports within Service Portfolio Management.</td>
</tr>
</tbody>
</table>

Several additional plugins offer increased functionality to Service Portfolio Management Foundation. Activate these plugins to enhance your experience.

### Additional plugins for Service Portfolio Management Foundation functionality

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portfolio Management SLA Commitments</td>
<td>Adds SLA Commitment support to Service Portfolio Management. Includes demo data.</td>
</tr>
<tr>
<td>Service Portfolio Management Taxonomy Content Pack</td>
<td>Provides sample taxonomy metadata, complete with portfolio, layers, and nodes. Demo data includes services and service offerings, including related items, such as SLAs, incidents, changes, and more. Includes demo data.</td>
</tr>
</tbody>
</table>

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

---

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, they will receive the following error: **Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>**.

### Installed with Service Portfolio Management

Service Portfolio Management Core is active by default for users with ITSM SKUs. Service Portfolio Management Foundation is administrator activated and enables you to document portfolios, taxonomies, services, and service offerings using a standardized, structured format.
Two plugins are available to obtain feature Service Portfolio Management functionality. The Service Portfolio Management Foundation plugin (com.snc.service_portfolio) automatically activates the Service Portfolio Management Core plugin (com.snc.service_portfolio_core), if not already activated. Each plugin independently installs a set of roles and tables.

### Service Portfolio Management Core

**Roles installed with Service Portfolio Management Core**

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Portfolio Admin (portfolio_admin)| Manages the service portfolio, related commitments, and availability. Updates portfolios, taxonomy layers, taxonomy nodes, services, service offerings, and can reparent services. | • portfolio_editor  
• sla_manager |
| Service Editor (service_editor) | Can view all layers and update owned services. Service Editors cannot reparent a service. | • service_viewer |
| Service Viewer (service_viewer) | Can view all services and offerings.                                          | • cmdb_read  
• sn_svc_workspace.service_workspace_user |

**Note:** The `sn_svc_workspace.service_workspace_user` role is used to view Service Owner Workspace. The Service Portfolio Management Premium plugin (com.snc.spm) and the Service Owner Workspace plugin (com.spm_owner_workspace) are available as separate subscriptions.
### Tables installed with Service Portfolio Management Core

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Offering (service_offering)</td>
<td>Extends the (cmdb_ci_service) table.</td>
</tr>
</tbody>
</table>

### Service Portfolio Management Foundation

#### Roles installed with Service Portfolio Management Foundation

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portfolio Editor (portfolio_editor)</td>
<td>Updates portfolios, taxonomy layers, taxonomy nodes, services, service offerings, and can reparent services.</td>
<td>• service_editor • portfolio_viewer</td>
</tr>
<tr>
<td>Portfolio Viewer (portfolio_viewer)</td>
<td>Can view portfolios, taxonomy layers, taxonomy nodes, and services.</td>
<td>• service_viewer</td>
</tr>
</tbody>
</table>

#### Tables installed with Service Portfolio Management Foundation

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spm Service Portfolio (spm_service_portfolio)</td>
<td>Used to create or modify a service portfolio.</td>
</tr>
<tr>
<td>Spm Taxonomy Layer Definition (spm_taxonomy_layer_definition)</td>
<td>Used to define the order of a taxonomy layer associated with a service portfolio.</td>
</tr>
<tr>
<td>Spm Taxonomy Node (spm_taxonomy_node)</td>
<td>Used to create or modify a taxonomy node associated with a service portfolio and taxonomy layer.</td>
</tr>
<tr>
<td>Service Subscribe Company (service_subscribe_company)</td>
<td>Used to associate service offering subscriptions to a specific company.</td>
</tr>
<tr>
<td>Service Scope (service_scope)</td>
<td>Used to stores user-defined limits to the service levels of a service.</td>
</tr>
<tr>
<td>Service Subscribe Department (service_subscribe_department)</td>
<td>Used to associate service offering subscriptions to a specific department.</td>
</tr>
<tr>
<td>Service Availability (service_availability)</td>
<td>Used to store the calculated availability records of a service.</td>
</tr>
<tr>
<td>Service Subscribe Sys User (service_subscribe_sys_user)</td>
<td>Used to create a module enabling you to categorize subscribers by individual user.</td>
</tr>
</tbody>
</table>
### Service Portfolio Management users and roles

An IT organization employs a team of people to work together to create, manage, and oversee the service portfolio. The team can consist of strategic, more supportive users, as well as operational, and critical day-to-day users. Roles assignment is contingent on the responsibilities and duties of each team member.

### System security role assignment

A person with the Admin (admin) role can assign Service Portfolio Management roles to other users. Assign roles to users based on their individual access needs to create, read, update, and delete records.

A person with the Portfolio admin (portfolio_admin) role can assign Service Portfolio Management roles to other users.

Admins or portfolio admins assign roles to system users based on functions, duties, and responsibilities. Users can perform the necessary functions within the service portfolio, taxonomies, services, and service offerings they are responsible for, based on assigned roles.
Service Portfolio Management users and roles

Common Service Portfolio Management team members with typical role assignment include the following users:

**Portfolio owner**
Typically assigned the Portfolio Editor (portfolio_editor) role.
Strategic role involved in the ownership of a portfolio. This person has overall authority and accountability for an entire IT service portfolio, typically at the CIO level. The goal of the portfolio owner is to deliver a portfolio that offers value to the organization. There is only one portfolio owner.
Portfolio owners can read and update the entire portfolio that they own. They do not have access to taxonomies within other portfolios that they do not own.

**Portfolio manager**
Typically assigned the Portfolio Admin (portfolio_admin) role.
Operational role involved with overall administrative capabilities over a portfolio.
Portfolio managers can create, read, update, and delete portfolio records of all types, including portfolios, taxonomy levels and nodes, services, service offerings, relationships, and performance criteria for the entire business.

**Service owner**
Typically assigned the Portfolio Viewer (portfolio_viewer) and Service Editor (service_editor) roles.
Strategic role involved in the ownership of services. Usually at the director-level within IT, this person is accountable for a given service and its offerings through the full service life cycle. The service owner typically owns more than one service, and may even own a branch of services. Typically, service owners are not heavily involved in day-to-day operations of the service.
Service owners can read portfolios and existing taxonomy assets, services, and service offerings. However, they can only update services and service offerings that they own or delegate.
Service owners cannot reparent services, or change the service owner. However, they can add subscriber groups, locations, departments, companies, and users.

**Service owner delegate**
Typically assigned the Portfolio Viewer (portfolio_viewer) and Service Editor (service_editor) roles.
Optional role involved in the management of a service. This person is designated as an editor of a set of services, potentially delegating for multiple service owners.
Service owner delegates can read portfolios and existing taxonomy assets, services, and service offerings. However, they can only update services and service offerings that they delegate.
Service owner delegates cannot reparent services, or change the service owner. However, they can add subscriber groups, locations, departments, companies, and users.

For more details regarding roles and assigning roles to users and groups, refer to Installed with Service Portfolio Management for Service Portfolio Management-specific roles and User administration for role usage in the platform.

Activate Service Portfolio Management Sample Content Pack

Activate the Service Portfolio Management Taxonomy Content Pack plugin (com.snc.spm.content) to access a sample portfolio structure and service taxonomy. This sample data offers a demonstration users can adopt to accelerate the creation and management of a service portfolio.
Role required: admin or portfolio_admin

**Note:** The Service Portfolio Management Taxonomy Content Pack data is best viewed in Service Owner Workspace. For details about accessing this workspace through a Service Owner Workspace subscription, refer to Service Owner Workspace.

The Service Portfolio Management Taxonomy Content Pack plugin (com.snc.spm.content), contains demo data and provides sample taxonomy structure metadata. Users can quickly and efficiently implement portfolios and associated taxonomies.

Gain access to a sample list of services that provides examples of service data, offerings, catalog items, and the relationships they share. Link to periphery example data, such as vendors and contracts, SLA definitions, cost models, and more.

After sample data loads, use it as a starting point to create and manage your service portfolios. You can view sample content in the Service Portfolios module of the Service Portfolio Management application as Sample IT Services Portfolio. Alternatively, if subscribed to and activated, users can view this data in Service Owner Workspace.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**View Service Portfolio Management sample IT services portfolio content**

Access, view, and analyze the Service Portfolio Management sample IT services portfolio content to plan and create your service portfolio. Consider the sample structure as a starting point. You can add to it or modify it to suit the specific needs of your organization.

Role required: portfolio_admin, service_editor, or service_viewer

Sample IT service portfolio content provides both usable data, in the form of portfolios, taxonomy layers, and taxonomy nodes. It also provides demo data in the form of services, service offerings, incidents, commitments, and more.

Sample IT service portfolio content is available for view by anyone with a Service Portfolio Management-related assigned role. Only users with the Portfolio Admin (portfolio_admin) or Service Editor (service_editor) role can create and manage the levels and nodes of a service portfolio based on the structure and presented sample content.

You can view the sample content in the Service Portfolios module in the Service Portfolio Management application. Sample content is best viewed in Service Owner Workspace, provided you have subscribed to and activated the Service Owner Workspace plugin (com.spm_owner_workspace).

**Note:** For details about accessing Service Owner Workspace, refer to Activate Service Owner Workspace.

1. Navigate to Service Portfolio Management.
2. To view the sample IT service portfolio, click either Service Owner Workspace, if activated, or Service Portfolios.

3. In the Service Owner Workspace, click All Services to reveal the sample list of service-related taxonomy nodes. Alternatively, on the Service Portfolio form in platform view, click Sample IT Services Portfolio and then the Taxonomy Nodes Related List to see the sample list of service-related nodes.

A list of sample IT service-related nodes appear including:

- Software Management
- Hardware Support
- IT Management and Consulting
- Network Support
- Data Center Management
- Software Support

4. Click a service-related taxonomy node in platform view, or expand a service in the Service Owner Workspace to view associated information.

5. Study the sample IT service portfolio and its taxonomy layers and nodes to understand the basic structure.

Domain separation in Service Portfolio Management

This is an overview of domain separation and Service Portfolio Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Basic*

The support level is Basic but has some exceptions or special conditions.

- Business logic: Ensure data goes into the proper domain for the application’s service provider (SP) use cases.
- In the application, the user interface, cache keys, reporting, rollups, aggregations, and so on, all use domain at production run time.
- The owner of the instance needs to be able to set up the application to function across multiple tenants.

Use case: When an SP uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

Overview

*All components of Service Portfolio Management (SPM) and Service Owner Workspace (SOW) are domain-separated in releases of New York and forward. If using Financial Management for the SPM plugin for estimated spend, there can be only one fiscal calendar defined per instance. When this plugin is activated, there can be only one approach for service offering cost modeling per instance (using either the Financial Management engine or local data. Different domains cannot choose their own spend model.
Set up Service Portfolio Management

Set up Service Portfolio Management to define services, document them, track performance against defined availability commitments, and relay the performance information in real-time to your stakeholders.

Role required: portfolio_admin or service_editor

1. Define the service offerings and commitments.
   Create service offering records that define different levels of service for an existing service. For example, you might offer two levels of desktop support in your organization. You offer a standard offering for upgrades and virus protection and an executive offering that also includes availability guarantee. Create a complete set of service offerings defined by service commitments that define the specifics of the offering.

2. Define the scope of the service offerings.
   Scope in Service Portfolio Management refers to the detailed service parameters that define the limits of a service. Define specific additional services related to the service as In Scope or Out of Scope. For instructions about applying scope definitions to services, refer to Apply scope to a service in Service Portfolio Management.

3. Configure the price of the service offering.
   Each service offering may have a pricing model and a price unit. Values are set on the parent service and inherited by the offerings. The actual price per unit that is charged for the service is established in the offering. For information about price modeling, refer to Set Service Portfolio Management service offering price models and units and Service Portfolio Management service offering price.

4. Configure the service catalog for the end user.
   All the data created in the previous steps displays on the service catalog page for a service. The layout is not configurable, but an administrator can control how the service is categorized and who can view the service in the catalog. For information, see Service Catalog administration.

5. Subscribe to service offerings.
   With Service Portfolio Management, service owners can subscribe various business entities to service offerings, refer to Service Portfolio Management service offering subscriptions.

Service Portfolio Management design experience

Creating and maintaining a service portfolio for your organization requires an investment in planning and design time. The Service Portfolio Management application is a powerful tool that provides a time-conscious approach for you to successfully plan, design, build, and implement your service portfolios.

Service Portfolio Management key design experience features and capabilities

Portfolio managers and owners can access the many benefits of the Service Portfolio Management application, including the following system capabilities:

- Review and use sample IT service portfolio content provided via the Service Portfolio Management Taxonomy Content Pack plugin (com.snc.spm.content). This data offers an accelerated, time-to-value solution for designing, creating, and implementing a service portfolio.
Enable this sample content to build a service taxonomy that quickly results in the creation of standard portfolios with optimal taxonomy.

View a list of service-related taxonomy nodes that provides examples of service data, offerings, catalog items, and the relationships they share. Sample data also includes links to periphery data, such as providers, vendors, contracts, SLA definitions, cost models, and more.

Create and manage portfolios.
Add new services to a portfolio.
Create and oversee service categories and service lines.
Create and manage the overall portfolio taxonomy.
Create and manage layers of services within the taxonomy for optimal organization.

Access the Service Owner Workspace to monitor and manage portfolio health and performance. Quickly view and summarize all information related to a given portfolio and its component services.

Note: Service Owner Workspace is available with a separate subscription. For details about accessing this workspace, refer to Service Owner Workspace.

Service owners benefit from the following system capabilities and can perform the following tasks:

View a list of services that provides service data, offerings, catalog items, and the relationships they share. You can also access links to periphery data, such as providers, vendors, contracts, SLA definitions, cost models, and more.
Access the Service Owner Workspace, when activated, to monitor and manage services.
Add new services and compare them for any redundancy.
Evaluate services for business suitability.
Incorporate appropriate data elements from service requirements, descriptions, and relationships into a service record. For example, data from users or groups, cost models, SLAs, vendors, and other related services.
Establish governance and management of life-cycle states and approvals.
Integrate with Change Management by obtaining and recording approval to develop new services.
Add services to a service catalog.
Create a catalog item stub from the service offering.
Link catalog items to service offerings.
Record request fulfillment.
Build reporting for service and offering consumption based on request fulfillment.
Link offering and catalog item state models.
Assess the value provided to an organization from a given service or offering, based on indicators and data, such as, expenditures, tasks, CSAT, and more.
Manage subscriptions to offerings by departments, groups, and more.
Include services in the platform benchmarking framework with Benchmarks.

Note: Some feature functionality requires a subscription to Service Owner Workspace.
Integration with Common Service Data Model

Improve your measurement and evaluation by using services and offering references on multiple IT Service Management task forms, including:

- Problem
- Change
- Continual Improvement Management
- Incident

Directly reference a service offering as the target of a problem, change, or incident for consistency with the Common Service Data Model (CSDM). The system filters available offerings based on the service selected.

View and define the Service Model reference field added to the Service and Offering forms to integrate with the CSDM.

Service Portfolio Management portfolios

A service portfolio presents an overall top-level view of your currently available services, possible future services, and services that existed in the past. By establishing service portfolios, you can more precisely evaluate the impact that services have on your business, and prioritize them accordingly. With Service Portfolio Management you can define and manage a single portfolio or multiple portfolios, each with its own unique taxonomy structure, owner, and market scope.

Gain valuable knowledge about your service portfolio, including an overall performance score and estimated spend. This knowledge helps you optimize your service budgeting efforts and streamline your decision-making regarding adding new services and retiring services that no longer benefit your business.

Note: Application functionality requires the activation of several Service Portfolio Management plugins. Refer to Activate Service Portfolio Management for details.

Users with the portfolio_admin role can create a single service portfolio or multiple portfolios. If your organization has multiple businesses, the ability to define multiple portfolios enables you to segregate portfolios by business location, by vendor, or by Chief Information Officer (CIO). Portfolio Admins can add and remove services from the portfolio, and determine how those services are categorized. Portfolio Admins can update associated taxonomy layers and nodes. Portfolio Admins can update portfolio data. Both Portfolio Admins and users with the service_editor role can update services and service offerings, and also reparent services.

Think of the service portfolio as a container that holds a hierarchical organization of definable taxonomy layers and associated nodes, services, and service offerings. Taxonomy in Service Portfolio Management refers to the classification of your portfolio layers and associated services. Typically, taxonomy is structured from a general, high-level perspective to a specific level, such as a service offering. With this dynamic taxonomy structure, you can organize your service portfolios in a variety of ways.

Create or modify portfolios in Service Portfolio Management

You can create a single service portfolio or multiple service portfolios, each with its own taxonomy structure. Creating a service portfolio presents an overall view of your currently available IT services, what services may be available in the future, and what services existed in the past.

Role required: portfolio_admin
Creating a service portfolio is the first step before you define taxonomy layers and nodes and populate it with services and service offerings. Once you create the service portfolio, you can edit it within the platform and monitor its performance in Service Owner Workspace. Refer to Service Owner Workspace for details on accessing Service Owner Workspace.

1. To create a new service portfolio, navigate to Service Portfolio Management > Service Portfolios and click New. Alternatively, to edit an existing service portfolio, click the name of the service portfolio to open the form. Change any of the form field data as needed.

To delete an existing service portfolio, click Delete Portfolio and Taxonomy.

2. Fill in or edit the form fields.

### Service Portfolio

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name that reflects the nature of the service portfolio, for example, IT Service Portfolio.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief detail about the service portfolio.</td>
</tr>
<tr>
<td>Description</td>
<td>Comprehensive details about the service portfolio, such as, Software and Network Support Tiers.</td>
</tr>
<tr>
<td>Market scope</td>
<td>Detailed service parameters that define the limits of a service. For example, who uses the portfolio services.</td>
</tr>
<tr>
<td>Service portfolio owner</td>
<td>Person who owns the portfolio, typically at the CIO level. This person has the portfolio_editor role and can view and update owned portfolios only.</td>
</tr>
<tr>
<td>Service portfolio manager</td>
<td>Person authorized to manage the service portfolio. This person has the portfolio_admin role and can create, read, update, and delete portfolio records of all types, including portfolios, taxonomy levels and nodes, services, service offerings, relationships, and performance criteria for the entire business.</td>
</tr>
<tr>
<td>Upper performance score threshold</td>
<td>Designated high threshold percentage point above which the indicators change from amber to green in Service Owner Workspace. Default is 80.</td>
</tr>
<tr>
<td>Lower performance score threshold</td>
<td>Designated low threshold percentage point below which the indicators change from amber to red in Service Owner Workspace. Default is 60.</td>
</tr>
<tr>
<td>Performance score</td>
<td>Displays the most recent performance score for the entire portfolio of services.</td>
</tr>
</tbody>
</table>

**Estimated Spend** details for the portfolio display if you have integrated with Financial Management and have configured the Estimated SpendCost model field on the Service Offering form.

3. Click Submit to save your service portfolio or click Update after editing a service portfolio.
The newly created service portfolio appears in the Service Portfolios module list. Click the newly created service portfolio name in the list. The Taxonomy Nodes, Portfolio Metrics, and Taxonomy Node Weights Related Lists appear on the Service Portfolio form. Refer to Service Portfolio Management taxonomy for detailed information regarding creating and adding taxonomy nodes within your service portfolio structure.

Service Portfolio Management taxonomy

Service Portfolio Management uses a taxonomy to classify containers of services your organization provides and manages via a service portfolio. A service portfolio can contain multiple elemental layers—from general to specific—that provide the hierarchical top-to-bottom structure of your portfolio.

Taxonomy structure

The Service Portfolio Management taxonomy structure is a framework for organizing and managing your services.

The taxonomy framework ends where your services begin. For example, your structural framework may contain, at its highest level, a taxonomy layer named Tier. The Tier layer may contain several taxonomy nodes, named, for example, Software Support Tier and Network Support Tier. The Tier layer may contain a sublevel taxonomy layer named Category. This second-level Category layer may also contain several taxonomy nodes, such as Virtual Machines Category, Archiving Category, and Networking Category.

Leaf nodes comprise the bottom-level of the taxonomy structure and contain associated services. The services contain the associated service offerings. This taxonomy structure presents as an organized hierarchical structure.

Note: Your taxonomy structure can have multiple layers. The bottom-level layer nodes are the leaf nodes and they contain services.

Taxonomy layer and node definitions

Build your service portfolio by defining your taxonomy layers and nodes. Taxonomy layers are high-level containers for the associated taxonomy nodes. Nodes represent all the available branches for that layer. For example, a layer named Tier may contain two nodes or branches named Software Support Tier and Network Support Tier.

Taxonomy layer creation and modification

Users with the portfolio_admin role can create, view, update, and delete taxonomy layers. Users with the portfolio_editor role can update existing layers. When creating a taxonomy layer, you must provide a layer name, specify the order of appearance in the hierarchical structure, and associate the layer to a service portfolio.

There is no limit to how many taxonomy layers you can create. To create nodes and attach services in a service portfolio, your portfolio must contain at least one taxonomy layer. Nodes are added to layers as children of a parent node. You cannot add nodes to any random layer. A node must be attached to a parent node in the parent layer.
Order layers according to how they appear in the taxonomy structure. A layer with the **Order** number 100, appears at the top of the service portfolio structure and contains all other elements below it.

If nodes exist in a taxonomy layer, you cannot delete or reorganize that layer. To delete or reorganize the layer, move the nodes to a new or existing layer.

**Taxonomy node creation and modification**

Users with the **portfolio_admin** role can create, view, update, and delete taxonomy nodes. Parent nodes create the taxonomy structure within a layer. When creating a taxonomy node, you must provide a node name, and associate the node to a parent node and taxonomy layer.

There is no limit to how many taxonomy nodes you can create within a layer. To create nodes and attach services in a service portfolio, your portfolio must contain at least one taxonomy layer.

You can reparent a node by changing the **Parent** value on the Taxonomy Node form.

- You can reparent a node to another node at the same taxonomy layer.
- You can reparent multiple nodes simultaneously using list view in the application.

Child nodes display in a related list on the Taxonomy Node form, enabling you to browse deeper into the hierarchical service portfolio structure.

Leaf nodes at the bottom of the hierarchical structure contain a Related List of associated services. Create new services from or add existing services by modifying the **Taxonomy Node** field on the Service form.

**Create or modify Service Portfolio Management taxonomy layer definitions**

Create an unlimited number of taxonomy layers to organize, label, and manage your service portfolio. Taxonomy layers represent the highest containment levels of your service portfolio. Each level supports branches, or nodes, that contain child nodes or services in a hierarchical top-to-bottom structure.

Role required: **portfolio_admin**

Opening the **Taxonomy Layer Definitions** module displays a list of all existing layers defined for all service portfolios.

By default, the service portfolio name associated with the taxonomy layer is listed in the first **Service portfolio** column of the list. The service portfolio is the parent element to the taxonomy layer. Existing taxonomy layers appear in the **Name** column, and are chronologically sorted in the **Order** column. Your layer with order number 100 is always at the top, followed by order number 200, and so on.

Always associated taxonomy layers with a parent service portfolio. Example layers for an IT services portfolio might include the following taxonomy layers:

- Service Class
- Service Group

If the Service Portfolio Management Taxonomy Content Pack (com.snc.spm.content) plugin sample data is activated on your instance, review the provided taxonomy data to gain an understanding of how to best define your taxonomy layers. Refer to [Activate Service Portfolio Management Sample Content Pack](#) for more details.

1. To create a new taxonomy layer definition, navigate to **Service Portfolio Management > Taxonomy Layer Definitions** and click **New**. Alternatively, to edit an existing taxonomy layer
definition, click the name of the taxonomy layer definition to open the form. Change any of the form field data as needed.

2. Fill in or edit the form fields.

**Taxonomy Layer Definitions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name that defines the purpose of the taxonomy layer, for example, Tier, as in software support tier or network support tier.</td>
</tr>
<tr>
<td>Order</td>
<td>Value that represents the hierarchical level where the taxonomy layer will exist. 1 is the highest level, with each chronological number following at a lower level.</td>
</tr>
</tbody>
</table>

**Note:** Layer ordering is locked and cannot be changed when a node is created for any layer in a service portfolio. Nodes cannot be added to layers if there is a gap in the layer order.

<table>
<thead>
<tr>
<th>Service Portfolio</th>
<th>Service portfolio for which the taxonomy layer is associated.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Brief detail about the taxonomy layer purpose.</td>
</tr>
</tbody>
</table>

3. Click **Submit** to save your service portfolio or click **Update** after editing a taxonomy layer.

4. Click the newly created taxonomy layer definition in the list.

The Taxonomy Nodes and Portfolio Metrics Related Lists appear on the Service Portfolio form. Refer to **Service Portfolio Management taxonomy** for detailed information regarding creating and adding taxonomy nodes within your service portfolio structure.

**Create or modify Service Portfolio Management taxonomy nodes**

Create an unlimited number of nodes, or branches, and add them to your service portfolio taxonomy layers. By configuring taxonomy nodes, you can successfully achieve a highly detailed and organized service portfolio containing multiple elemental layers—­from general to specific.

Role required: **portfolio_admin**

Add new nodes as needed and edit existing nodes, as well as reparent nodes or delete nodes. You can reparent a node to another node at the same taxonomy layer.

In Service Portfolio Management, taxonomy nodes typically represent service types within the configured taxonomy layers. These types act as containers for child nodes or services. Examples for an IT services portfolio could include the following taxonomy nodes:

- Data Center Management
- Hardware Support
- Software Management

If the Service Portfolio Management Taxonomy Content Pack (com.snc.spm.content) plugin sample data is activated on your instance, review the provided taxonomy data to gain an
understanding of how to best define your taxonomy layers. Refer to Activate Service Portfolio Management Sample Content Pack for more details.

1. To create a new taxonomy node, navigate to Service Portfolio Management > Taxonomy Nodes and click New. Alternatively, to edit an existing taxonomy node, click the name of the taxonomy node to open the form. Change any of the form field data as needed.
To delete an existing node, click Delete.
2. Fill in or edit the form fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name that defines the purpose of the node.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief detail about the taxonomy node purpose.</td>
</tr>
<tr>
<td>Description</td>
<td>In-depth details about the node.</td>
</tr>
<tr>
<td>Service portfolio</td>
<td>Service portfolio this taxonomy node is associated with.</td>
</tr>
<tr>
<td>Taxonomy layer</td>
<td>Taxonomy layer this node is associated with.</td>
</tr>
<tr>
<td>Parent</td>
<td>Taxonomy node to which the taxonomy node is associated.</td>
</tr>
<tr>
<td>Owned by</td>
<td>Owner of the taxonomy node.</td>
</tr>
<tr>
<td>Valid from</td>
<td>The date the taxonomy code is valid.</td>
</tr>
<tr>
<td>Valid to</td>
<td>The date the taxonomy code is no longer valid.</td>
</tr>
<tr>
<td>Performance score</td>
<td>Most recent performance score for this node.</td>
</tr>
</tbody>
</table>

3. Right-click in the header to save or click Submit to save your taxonomy node. Alternatively, you can click Update after editing an existing taxonomy node.
4. If available, to edit or define the taxonomy node weights, click the Edit Weights Related Link to edit existing child service weights or child node weights. Alternatively, you can navigate to Service Portfolio Management > Taxonomy Nodes and find a node in the list. Click to open the form.

5. Specify weight values for each associated child node.
Total weight must equal 100 percent. For more information on weights and specifying weight values, refer to Service Owner Workspace performance metrics.
6. Review Related List records. Depending on the type of node, whether it is a leaf node or a non-leaf node, Related Lists display the following associated data:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taxonomy Nodes</td>
<td>List of all associated child nodes. You can edit an existing child node by clicking New and completing the Taxonomy Node form.</td>
</tr>
<tr>
<td>Services</td>
<td>List of all associated services shown for leaf nodes. Edit the list by clicking Edit and making changes to the form. You can select a service in the Related List to modify and update. Create a new associated service by clicking New and completing the Service form. Refer to Create or modify Service Portfolio Management services.</td>
</tr>
</tbody>
</table>

**Service Portfolio Management services**

Configure IT services within your portfolios to add the most value to your organization. The IT services defined in your portfolios may, or may not be, specifically aligned to an application. IT services defined in your portfolios may, or may not be, represented in a request catalog.

The phase and status of a service indicates the life-cycle position of the service. You can view, track, and monitor the services by phase and status with platform lists and reports. The lists can also include retired services for viewing purposes.

Each service record has a unique number to identify the record.

To reflect the importance or impact of each service on the operations of your organization, you can select a criticality level for them. For example, you might select a high level for a service that supports sales functionality using the organization’s website. You might then select a lower level for a service that provides internal printing for the organization’s employees.

**Business services**

Business services make up the structure of your service portfolio taxonomy. You can create dependencies to these types of services and view and manage associated service and offering details via the dependency tabs of the related list on the Service and Service Offering forms as well as in Service Owner Workspace if activated.

Create offerings as children of services. Offerings are created in the Service Offering (service_offering) table. Refer to Service Portfolio Management service offerings for more details.

You can designate services as Services I depend On or Services Dependent On Me via form related lists.

**Technical services**

Although technical services are not added as part of your service portfolio taxonomy, you can still gain insight into these services by adding them as Services I depend On or Services Dependent On Me in the related list section of the Service form.
Create or modify Service Portfolio Management services

Create services that benefit and add value to your internal organization and external customers and users.

Role required: portfolio_admin or service_editor

All occurrences of the table and reference field label Business Service throughout the product have changed to Service. For example, the Business Service form has changed to Service form.

**Note:** This change is for new instances only and does not affect existing upgraded instances.

1. To create a new service, navigate to Service Portfolio Management > Services and click New. Alternatively, to edit an existing service, click the name of the service to open the form. Change any of the form field data as needed.
   To delete an existing service, click the delete button in the form header.
2. Fill in the form fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated unique identification for a new service record. Its value consists of a 'BSN' string and a unique number. Other forms and scripts can reference this identification. The Number field is visible with the Service Portfolio form view.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name that reflects the nature of the service.</td>
</tr>
<tr>
<td>Model ID</td>
<td>Service model display name, manufacturer (if applicable), and model class data.</td>
</tr>
<tr>
<td>Service portfolio</td>
<td>Service portfolio this service is associated with.</td>
</tr>
<tr>
<td>Taxonomy node</td>
<td>Taxonomy leaf node within a portfolio this service is associated with.</td>
</tr>
<tr>
<td>Business criticality</td>
<td>Criticality level that defines the importance of the service in your organization.</td>
</tr>
<tr>
<td>Phase</td>
<td>Phase that the service is in. Available values are: Pipeline, Catalog, and Retired.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the service per phase.</td>
</tr>
<tr>
<td>Service classification</td>
<td>Type of service. Available values are: Business Service, Technical Service, and Application Service.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the service.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Aliases</td>
<td>Other names used for this service.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date the service is available.</td>
</tr>
<tr>
<td>End date</td>
<td>Date the service is retired.</td>
</tr>
<tr>
<td>Last review date</td>
<td>Date the service was last reviewed.</td>
</tr>
<tr>
<td>Maintenance schedule</td>
<td>Time during which maintenance is scheduled.</td>
</tr>
<tr>
<td>Owned by</td>
<td>Service owner responsible for this service in the organization.</td>
</tr>
<tr>
<td>Delegate</td>
<td>Person authorized to manage the service on behalf of the service owner.</td>
</tr>
<tr>
<td>Business contact</td>
<td>Person to contact for issues related to this service.</td>
</tr>
<tr>
<td>Managed by</td>
<td>Person who manages the service, typically an IT infrastructure manager.</td>
</tr>
<tr>
<td>Delivery manager</td>
<td>The delivery manager for the service.</td>
</tr>
<tr>
<td>Business relation manager</td>
<td>Relationship manager for this service.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The vendor providing this service.</td>
</tr>
<tr>
<td>Approval group</td>
<td>Group whose approval is requested.</td>
</tr>
<tr>
<td>Support group</td>
<td>Group managing the service.</td>
</tr>
<tr>
<td>Price model</td>
<td>Pricing structure for a service. Choices are Per Unit and Fixed.</td>
</tr>
<tr>
<td>Price Unit</td>
<td>Short name of the unit for this service. Appears when Per Unit is chosen for the Price Model type.</td>
</tr>
<tr>
<td>Location</td>
<td>Physical location of the service.</td>
</tr>
<tr>
<td>Performance score</td>
<td>Most recent performance score. Populated after the service is active. The performance score is calculated by a nightly script and cannot be changed by the user.</td>
</tr>
<tr>
<td>CSAT score</td>
<td>Note: Appears with a Service Owner Workspacesubscription.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Brief details about the service.</td>
</tr>
<tr>
<td>Service level requirement</td>
<td>Field captures the requirements, which include the service level agreements and service level targets, for the service.</td>
</tr>
<tr>
<td>Unit Description</td>
<td>Detailed description of the unit for this service.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>Other services that a user should have access to before they can use this service.</td>
</tr>
<tr>
<td>Business need</td>
<td>Business need this service supports.</td>
</tr>
<tr>
<td>Compatibility dependencies</td>
<td>Software or technologies that this service depends on, for example, an online email service may require a specific browser and version for access.</td>
</tr>
<tr>
<td>Monitoring requirements</td>
<td>Requirements necessary to monitor this service.</td>
</tr>
<tr>
<td>Comments</td>
<td>Description or a note about the service.</td>
</tr>
</tbody>
</table>

3. After completing the form, right-click in the header bar and select **Save** from the pop-up menu.

The related lists for the service appear. View associated or create new:
- Service offerings
- In Scope
- Out of Scope
- Services I depend On
- Services Dependent On Me
- Incidents
- Problems
- Change Requests
- Other tasks
- Knowledge Articles
- Service Offering Node Weights
- Improvement Initiatives

4. Click **Submit** to save your service or click **Update** after editing a service.

**Apply scope to a service in Service Portfolio Management**

Define the limits of a service with scope details. Out of Scope items define what a service cannot provide and In Scope items define what a service provides. By defining scope, you can grant or deny specific services that define a more detailed view of a service. For example, nightly backups may be In Scope for the Desktop Support service, but Out of Scope for the Disaster Recovery service.

Role required: portfolio_admin or service_editor

The In Scope and Out of Scope definitions appear in the service catalog page that users see when they access the service catalog.

To view the list of scope entries in your system, enter `service_scope.list` in the navigator and press the Enter key.

1. Navigate to **Service Portfolio Management > Services.**
2. Select the name of a service for which you want to define scope.
   - Only a parent service can have scope.
3. In the In Scope or Out of Scope related list, click **New** to create a new definition or click **Edit** to add the scope to the In Scope or Out of Scope list for the service.
Configure scope with anything that is pertinent to the service and helps define the limits of the service.

4. Give the scope item a descriptive name and provide details in the Description field.
5. Click Submit.

Set Service Portfolio Management service offering price models and units

Define the pricing structure for a service offering to use either a per unit price model or a fixed price model.

Role required: portfolio_admin or service_editor

1. Navigate to Service Portfolio Management > Services Offerings.
2. Select a service offering from the Service Offerings list.
3. Define the Price model.
   The choices are Per Unit and Fixed. If you select Per Unit, the Price unit field appears.
4. Type the name of a unit to use for pricing, for example, service, server, or person.
5. Click Update.

Service Portfolio Management service offerings

A service offering derives from a service, refining the parent service to a specific business need and performance level.

Service offerings and commitments

Service offering records define different levels of performance for an existing service. For example, you might offer two levels of desktop support in your organization. You can offer a standard offering for upgrades and virus protection and an executive offering that also includes availability guarantee.

Service offering types include business service offerings and technical service offerings.

Create a complete set of service offerings defined by commitments that define the specifics of the offering. Each service must have at least one defined offering to move to the Catalog phase. This is because service offerings are where you define Service Level Agreements (SLAs) and where metrics are collated.

For detailed information about SLAs, including SLA definitions and results, refer to Service Level Management.

Service offering pricing

Each service offering may have a pricing model and a price unit. Use this pricing data towards creating catalog items.

Service offering subscriptions

You can subscribe different entities to a service offering. This data is then used to determine the total subscriber count on the offering form.
Technical service offerings

Technical service offerings can be shown as inherited relationships to business services and offerings. They are not included in metric models and do not use the weighting model.

Re-parenting service offering types

You can change a service offering parent from one type of service to another. For example, changing an offering parent from a business service to a technical service or vice versa. Offerings cannot be re-parented to an application service. Some important information and guidelines concerning re-parenting service offering types, include:

- When you change the offering parent from a business service to a technical service you will receive a message alerting you that performance scoring is not available with technical service offerings.
- When you re-parent from one service type to another, existing weighting rules will apply.
- If you try to re-parent and the parent service is in Catalog phase with only one offering, you will receive a message that you cannot make this change.
- If the metric weight on the parent service is >0, you will receive a message alerting you to adjust the data before re-parenting the offering. You cannot re-parent the offering to a different service type until the weight for the offering on the former service type is set to zero.

Create and manage Service Portfolio Management service offerings

Create service offerings to define services, document them, track performance against defined availability commitments, and relay the performance information in real time to your end users.

Often, data defined on the service and its child offerings is identical. For example, the same person may own a service and its offerings, as defined in the Owned by field on the Service form. However, flexibility exists for defined data to be different between services and child offerings if the organization desires. For example, one person may own the service while another person owns the child offering.

Link service offerings to catalog items required to provision a service. Each service offering has commitments, which in turn, have service level agreements.

A service offering consists of a set of service commitments which uniquely define the level of service in terms of availability, scope, and pricing. For example, an organization may offer two levels of Desktop Support in your organization. A Standard offering of upgrades and virus protection. And an Executive offering with the standard commitments plus some type of availability guarantee, such as 98% availability from 8-5 on weekdays.

1. To create a new service offering, navigate to Service Portfolio Management > Service Offerings and click New. Alternatively, to edit an existing service offering, click the name of the service offering to open the form. Change any of the form field data as needed.

2. Fill in the form fields.

Service offering form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent</td>
<td>Parent service.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name that reflects the nature of the service.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Model ID</td>
<td>Service model display name, manufacturer (if applicable), and model class data.</td>
</tr>
<tr>
<td>Managed by</td>
<td>Person who manages the service, typically an IT manager. The person can be different from the person in the <strong>Owned by</strong> field.</td>
</tr>
<tr>
<td>Aliases</td>
<td>Other names used for this service.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the service offering.</td>
</tr>
<tr>
<td>Owned by</td>
<td>Service owner responsible for this service in the organization.</td>
</tr>
<tr>
<td>Delegate</td>
<td>Person authorized to manage the service along with the service owner.</td>
</tr>
<tr>
<td>Business criticality</td>
<td>Degree of how critical this service offering is to the business. You can base a demand response strategy off this value.</td>
</tr>
<tr>
<td>Location</td>
<td>Physical location of the service.</td>
</tr>
<tr>
<td>Phase</td>
<td>Phase that the service is in. Available values are: <strong>Pipeline</strong>, <strong>Catalog</strong>, and <strong>Retired</strong>.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the service per phase.</td>
</tr>
<tr>
<td>Price model</td>
<td>Pricing structure for a service offering as defined in the parent service. The <strong>Price model</strong> field is read-only. This value is set in the parent service.</td>
</tr>
<tr>
<td>Price unit</td>
<td>Short name of the unit for this service. Appears when Per Unit is chosen for the <strong>Price Model</strong> type in the parent service. The <strong>Price unit</strong> field is read-only. This value is set in the parent service.</td>
</tr>
<tr>
<td>Price</td>
<td>Price and currency.</td>
</tr>
<tr>
<td>Support group</td>
<td>Group managing the service.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The vendor providing this service.</td>
</tr>
<tr>
<td>Delivery Manager</td>
<td>The delivery manager for this service.</td>
</tr>
<tr>
<td>Supported by</td>
<td>Person supporting this service offering.</td>
</tr>
<tr>
<td>Contract</td>
<td>Associated contract number.</td>
</tr>
<tr>
<td>Maintenance schedule</td>
<td>Time during which maintenance is scheduled.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date the service is available.</td>
</tr>
<tr>
<td>End date</td>
<td>Date the service is retired.</td>
</tr>
<tr>
<td>SLA</td>
<td>Service Level Agreement for this service offering.</td>
</tr>
</tbody>
</table>
### Field Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance score</td>
<td>Most recent performance score. Populated after the service is active. The performance score is calculated by a nightly script.</td>
</tr>
<tr>
<td><img src="image" alt="Note: Appears with a Service Owner Workspacesubscription." /></td>
<td><img src="image" alt="Note: Appears with a Service Owner Workspacesubscription." /></td>
</tr>
<tr>
<td>Total Subscribers</td>
<td>Number of subscriptions for this service offering. Total subscribers is calculated by a nightly script.</td>
</tr>
<tr>
<td><img src="image" alt="Note: Appears with a Service Owner Workspacesubscription." /></td>
<td><img src="image" alt="Note: Appears with a Service Owner Workspacesubscription." /></td>
</tr>
<tr>
<td>CSAT Survey Frequency</td>
<td>How often a customer satisfaction survey is sent.</td>
</tr>
<tr>
<td><img src="image" alt="Note: Appears with a Service Owner Workspacesubscription." /></td>
<td><img src="image" alt="Note: Appears with a Service Owner Workspacesubscription." /></td>
</tr>
<tr>
<td>CSAT Survey Last Sent</td>
<td>Last time a customer satisfaction survey was sent.</td>
</tr>
<tr>
<td><img src="image" alt="Note: Appears with a Service Owner Workspacesubscription." /></td>
<td><img src="image" alt="Note: Appears with a Service Owner Workspacesubscription." /></td>
</tr>
<tr>
<td>Short Description</td>
<td>Brief details about the service offering.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the service.</td>
</tr>
<tr>
<td>Unit Description</td>
<td></td>
</tr>
<tr>
<td>Service level requirement</td>
<td>Field captures the requirements, which include the service level agreements and service level targets, for the service.</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments about the service.</td>
</tr>
</tbody>
</table>

3. In the **Estimated Spend** section, choose a value for the **Cost model** field. Choices include the default **None**, **Fixed**, and **Per unit**. View read-only data in the **Estimated spend** field.

   ![Note: When Service Owner Workspace (com.spm_owner_workspace) and Financial Management for SPM (com.snc.financial_management_for_spm) are activated and the sn_spm_spend.offering_cost_source system property is set to the value Financial Management the Estimated Spend form section displays the fields FM period and FM cost. These fields reveal read-only data associated with the service offering. For more information on estimated spend, refer to Financial Management for Service Owner Workspace.](image)  

4. After completing the form, right-click in the header bar and select **Save** from the pop-up menu.

   The **Related Links** and related lists for the offering appear.

5. In **Related Links** you can create an offering improvement initiative, edit offering metric weights, and subscribe to the offering by clicking the associated link.
6. View associated related lists and items or create a new item. Related lists include:
The related lists for the offering appear. View associated or create new:
- Service Commitments
- Service Offerings I Depend On
- Service Offerings Dependent On Me
- Outages
- Incidents
- Problems
- Change Requests
- Other Tasks
- Knowledge Articles
- Catalog Items
- Subscribed by Group
- Subscribed by Location
- Subscribed by Department
- Subscribed by User
- Subscribed by Company
- Performance Metrics
- Improvement Initiatives

7. Click Submit to save your service offering or click Update after editing a service offering.

Define Service Portfolio Management service commitments

Service commitments are specific services that define the unique availability guarantees, scope, and pricing for a service offering.

Role required: service_editor

Service commitments define the expected level of a service. A service offering derives from a service, tailoring the parent service to a specific business need. A service offering consists of a set of service commitments which uniquely define the service offerings.

To create service commitments, each service needs at least one associated service offering.

1. Navigate to Service Portfolio Management > Service Offerings. Alternatively, you can navigate to Service Portfolio Management > Commitments.
2. Open a service offering record.
3. In the Service Commitments related list, click New. The Service commitment form opens.
4. Give the commitment a descriptive name. You can specify any kind of service.
5. Select the Type of commitment from the list.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability or Maintenance Window</td>
<td>Used in system processing. If you select <strong>Maintenance Window</strong>, the <strong>Schedule</strong> field is required. Creates Availability records for the service offering based on the outages for that offering. If an Availability commitment exists, when an Outage is created against a service offering with the Availability commitment, it will begin tracking down time and availability.</td>
</tr>
<tr>
<td>Response Time, Delivery or Other</td>
<td>Display additional information in the service catalog. This information details the type of service commitment the user may expect from a given service offering. These service commitment types do not provide additional functionality or a homepage gauge.</td>
</tr>
<tr>
<td>Recovery time objective</td>
<td>Guarantee of how long it takes to recover the system from the recovery point. Set the recovery time in the <strong>Time Amount</strong> field that appears when you select this commitment type. This field is available with vendor ticketing.</td>
</tr>
<tr>
<td>Recovery point objective</td>
<td>Guarantee of how often backups are performed. Set the backup interval in the <strong>Time amount</strong> field that appears when you select this commitment type. This field is available with vendor ticketing.</td>
</tr>
<tr>
<td>SLA</td>
<td>Allows commitments defined by a service level agreement (SLA) that tracks whether a vendor provides a level of service for a defined percentage of the time. The SLA results are calculated automatically and can be viewed on the <strong>My Services - SLAs</strong> homepage or by navigating to <strong>Services &gt; Service Offering SLAs &gt; SLA Results</strong>.</td>
</tr>
</tbody>
</table>

6. Optionally, select a **Contract** for this service commitment. This information is used when creating vendor credit records.

7. Enter the information to calculate credit owed by the vendor for any contract breaches. These fields are available with vendor ticketing:
   - **Breach penalty amount**: Amount assessed per unit of time for a breach.
   - **Per**: Unit of time used to calculate the total credit owed for a breach.
   - **Breach penalty time**: Amount of free time provided by the vendor per breach.

8. Complete the form and click **Submit**.
The Service Offering form opens, and the new commitment appears in the Service Commitment related list.

9. Click **New** to add another service commitment or click **Edit** to add an existing commitment to this offering.

### Create Service Portfolio Management service outages

Adjust your service commitment availability by creating maintenance commitments to accommodate planned outages.

Role required: service_editor

Service Portfolio Management tracks and reports on outages for all service offerings that include availability commitments. Outages are recorded manually and are visible in service offering records and in Service Owner Workspace. Availability is a key metric used in Service Owner Workspace.

**Note:** For details about access to Service Owner Workspace refer to Service Owner Workspace.

The outage is used to evaluate the availability of the offering and appears in the reports generated for this offering. There are three types of outages:

- **Outage**: Unplanned outages such as those caused by hardware or network issues. The only type of outage considered when calculating availability of a service.
- **Planned Outage**: Necessary, expected outages caused by planned maintenance or upgrades.
- **Degradation**: Indicates a problem affecting a service that does not result in a disruption of that service.

Outage records can relate to multiple configuration items (CIs). You can link a single outage to multiple CI records using the Affected CIs related list.

**Note:** An outage must be created and saved before you can add a CI relation or link an outage to multiple CI records using the Affected CIs related list.

View a unique **Outage Number** identifier for your outage records. View the Outage Number column in the Outage table records list and on the Outage form.

**Note:** The Outage Numbering plugin (com.snc.outage_numbering) must be activated to introduce number data. The plugin is automatically activated for all instances and upgrades except those that already have a number prefix column on the Outage table. Refer to the **Activate Outage Numbering plugin (KB0823685)** article in the HI Knowledge Base or contact ServiceNow Technical Support if the plugin is not active and you want to move to the base system field.

When an outage is opened against a service, the system adds all child offerings to the Affected CI related list on the outage form, affecting all child offering availability. An outage record is then created for each offering. A pop-up notifies you that the outage affects all child offerings. The offerings can be removed from the Affected CIs related list if needed.

1. Navigate to **Service Portfolio Management > Outages**.
2. Click **New** to create a new outage or find the service offering in the Outages records list **Configuration item** field to edit.
3. Edit the Type field as necessary or choose None.
4. Enter any desired text in the Message field.
5. Define the length of the outage by selecting the Begin and End dates and times with the calendar, or by entering the Duration as a function of days and hours.
6. Right-click in the form header to save the record or click Submit or Update to edit an existing outage record.

Note:
If a single outage impacts multiple service offerings, you can add those offerings to the Affected CIs related list.

7. To add an associated affected CI, click Add.
The Add Affected Configuration Items list window appears displaying Service Offering as the configuration class. All affected CIs are listed.
8. Select a single CI or group of CIs by checking the box next to the CI name and clicking Add Selected. Alternatively, you can choose to add all the listed affected CIs to the outage record by clicking Add All.
9. Close the Add Affected Configuration Items list window. The CI or CIs are added to the Affected CIs related list.
10. Click Update.

Service Portfolio Management service offering price
Service offerings inherit the pricing structure of the associated parent service. Each service offering in Service Portfolio Management may have a price model, defined as either fixed or per unit. If the price model is defined in the parent service as per unit, then each service offering must also have an associated price unit. The actual price for that unit is established in the service offering record.

You can review service offering information regularly as a part of Data Certification and workflow. For example, you can set up a certification to validate pricing for your service offerings.

Forecast service usage and cost for a fiscal period to plan your future business using the Showback functionality of Financial Management.

To set a service offering price, navigate to Service Portfolio Management > Service Offerings and select an offering for which a defined pricing structure exists. Enter the Price for the service price unit and update the record. You can also type an optional description in the Unit description field of the service offering record.

Service Portfolio Management service offering subscriptions
Service Portfolio Management enables service owners to subscribe users to service offerings.

Note: Functionality described here requires the Service Portfolio Management Foundation plugin (com.snc.service_portfolio).

With Service Portfolio Management, service owners can subscribe various business entities to service offerings.
Subscribe users to a service offering in Service Portfolio Management

Subscribe your users to a service offering. This functionality also applies to subscribing companies, locations, groups, and departments to service offerings when that foundational data is available.

Role required: service_editor

1. In a Service Offering record, click Edit in the Subscribed by User Related List.
2. In the slushbucket that appears, move the subscribed users to the Subscribed by User List.
3. Save your changes.
   These users can now add a gauge for this service offering to their home pages.

Service Level Management for Service Portfolio Management

Service Portfolio Management leverages the Service Level Management application and includes a module to manage your Service Level Agreement (SLA) definitions and results.

If not already activated, you can activate the Service Portfolio Management SLA Commitments plugin (com.snc.service_portfolio.sla_commitment) to enable Service Level Agreement (SLA) commitment support to Service Portfolio Management. Refer to Activate Service Portfolio Management for more information about this and other plugins that add feature functionality to Service Portfolio Management.

View, modify, or create SLA definitions from the Service Portfolio Management application. You can also view, modify, or create SLA results. Refer to Service Level Agreement (SLA) definition and Create an SLA definition for information about SLA definitions and configuration. For complete detailed information about SLAs, refer to Service Level Management.

Create or modify a Service Portfolio Management SLA result

Define service commitments for your service offerings and monitor the results to manage performance.

Role required: admin

1. To create a new SLA result, navigate to Service Portfolio Management > Service Level Management > SLA Results and click New. Alternatively, to edit an existing SLA result, click the name of the SLA result to open the SLA Result form. Change any of the form field data as needed.
2. Fill in the form fields.

<table>
<thead>
<tr>
<th>SLA Result form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Service offering</td>
<td>Select the service offering for which you want to create or modify an SLA Result record.</td>
</tr>
<tr>
<td>Service commitment</td>
<td>Select the service commitment to apply the SLA Result record.</td>
</tr>
<tr>
<td>Start</td>
<td>Specify the start date for this SLA Result interval.</td>
</tr>
<tr>
<td>End</td>
<td>Specify the end date for this SLA Result interval.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Company</td>
<td>Specify the company for which the SLA Result record is created.</td>
</tr>
<tr>
<td>Required SLA percentage</td>
<td>Enter the percentage of tasks that must meet this SLA.</td>
</tr>
</tbody>
</table>

**Note:** The following fields display SLA result data when available:
- **Total tasks** — Total number of tasks related to this service offering for this SLA.
- **Breached** — Number of tasks that breached this SLA for this interval.
- **Achieved** — Number of tasks that achieved this SLA for this interval.
- **Total achieved %** — SLA percentage achieved for the entire interval.

3. Click **Submit**.
   The Tasks for Interval Related List appears.

**Note:** When an SLA definition is triggered against a particular task, a task SLA record generates and contains all the tracking data for the specific SLA on that record.

4. To create an SLA task or modify an existing task, refer to **Task SLA table**.

**Service Owner Workspace**

ServiceNow® Service Owner Workspace provides a premium Service Portfolio Management experience. If you’re a portfolio manager or service owner, you can manage and monitor portfolios and services in one integrated and graphically intuitive user interface.

Service Owner Workspace is available as a separate subscription and is part of the Service Portfolio Management Premium experience.

Track and analyze how your services are performing and which services need attention. You can also integrate data from the Vendor Management Workspace, Contract Management, SLA Contracts, Risk Management, and Continual Improvement Management (CIM) applications to quickly access data from one place.
### Key features

<table>
<thead>
<tr>
<th>Data all in one place</th>
<th>Comprehensive service performance layout</th>
<th>Integrated application data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage the performance of your services. Evaluate performance against value to ensure your services merit the investment.</td>
<td>Analyze service performance metrics using a comprehensive layout of all information that is related to a service and its offerings.</td>
<td>Use aggregated data from multiple applications and measure service performance using qualitative and quantitative metrics.</td>
</tr>
</tbody>
</table>
Get started

Select a tile to get started.

Exploring Service Owner Workspace

The Service Owner Workspace provides portfolio and service owners with an integrated and graphically intuitive user experience to manage and monitor portfolios and services.

Track and analyze how your services are performing
How does Service Owner Workspace work?

Service Owner Workspace is a read-only user interface driven by Service Portfolio Management Premium plugin (com.snc.spm) functionality. Service Portfolio Management Premium collects service offering metrics and rolls these calculations up to parent services and taxonomy nodes for performance scores and other metrics viewed via Service Owner Workspace. Performance Analytics indicators capture this data and Service Portfolio Management Premium uses the Performance Analytics data as input metrics to calculate a service offering performance score. These indicators can also track data about a service offering without including it in the offering performance score.

Users can create new metric definitions or use the metric definitions provided in the base system application. Assign metrics to service portfolios and define weights for every metric at an offering level to provide more granularity into performance. Daily jobs then calculate the offering performance score and roll the scores up to the service and other associated taxonomy nodes to monitor in Service Owner Workspace.

Service Owner Workspace browser requirements

ServiceNow workspaces do not support mobile devices, and, starting with the Paris release, Internet Explorer, or Microsoft Edge. Instead, use Microsoft Edge-Chromium or one of the other supported browsers listed in Browser support. If you’re using New York or an earlier release and you’re using Internet Explorer 11 or Microsoft Edge with any workspace, such as ServiceNow® CSM Agent Workspace or ServiceNow® Vendor Manager Workspace, you must migrate to a newer browser before you upgrade to at least the Paris release. See the Internet Explorer 11 Performance (KB0683275) article in the HI Knowledge Base for more information.

Service Owner Workspace overview

Manage and monitor your services with premium features. View service offering details in the workspace:
<table>
<thead>
<tr>
<th>Number</th>
<th>Agent Workspace feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1      | Tabs                    | The multi-tab interface enables you to easily navigate between service-related records.  
|        |                         | - All services open in the **Services Home** tab.  
|        |                         | - Associated service offering details open in subtabs. Drill down to the lowest hierarchical level to view details about all related service offerings. |
| 2      | Form header             | The form header provides you with a quick summary of the service offering and an associated performance score. Estimated spend details appear in the form header when available. |
| 3      | Related items menu      | Service-related information is available to view in the related items menu. Click an item to see the related information. |
| 4      | Ribbon                  | Ribbon components display service offering performance score, customer satisfaction, and total subscriber trends. Estimated spend data is also viewable when available. |
| 5      | Form pane               | Additional service-related information is displayed as you scroll down the page and drill deeper into the data. Information includes, service-offering availability, breached SLAs, customer satisfaction, stability, and activity. |
| 6      | Contextual side panel details | Unique data details are displayed. Click icons to display **Outages**, **Critical Incidents**, **Change Requests**, or **Attachments** details. |
| 7      | Contextual side panel   | The contextual side panel displays unique data depending on which icon you select. |

**Integration with Common Service Data Model**

Improve your measurement and evaluation by using services and offering references on multiple IT Service Management task forms, including:

- Problem
- Change
- Continual Improvement Management
- Incident

Directly reference a service offering as the target of a problem, change, or incident for consistency with the Common Service Data Model (CSDM). The system filters available offerings based on the service selected.

View and define the service model **Model ID** reference field on the Service and Offering forms to integrate with the CSDM.
Service Owner Workspace performance metrics

Service Owner Workspace includes a metrics model in the platform Service Portfolio Management Premium application for measuring the performance of services offerings. These performance metrics are then aggregated to services and taxonomy nodes via a weighting mechanism.

Metric Definitions

When activated, Service Portfolio Management Premium collects service offering metrics which permit calculations to roll up to parent services and taxonomy nodes for performance scores and other metrics. All metric configurations are performed in the platform application. Service owners can view these performance scores and metrics via Service Owner Workspace. The following Metric Definitions are installed with the Service Portfolio Management Premium plugin (com.snc.spm):

Activity

The metric indicator is from service portfolio-related catalog activity. The metric is calculated from fulfilled request items derived from catalog items, which are connected to service offerings.

Availability

The metric indicator is Service Portfolio Management availability as calculated from outage records.

Note: If more than one Availability commitment exists for a service offering, at least one must be set as the Primary for trending purposes. Only one availability commitment is considered for performance score calculation, determined by the Use in performance score flag. Additional features include:

- Creation of Availability definitions specific to describe Availabilities for service offerings.
- Directly link a service offering commitment to an Availability definition.
- Maintain Availability statistics regarding outages.

Breached SLA
The metric indicator is from an SLA record, based on a breached SLA. Calculations depend on activation of the Service Portfolio Management SLA Commitments plugin (com.snc.service_portfolio.sla_commitment), which enables the following features:

- Creation of SLA definitions specific to describe the SLAs in place for service offerings.
- Directly link a service offering commitment to an SLA definition.
- Maintain SLA statistics regarding breaches.

**Note:** If more than one SLA commitment exists for an offering, at least one must be set as the Primary for use in performance scoring. Only one SLA commitment is considered for performance score calculation, determined by the **Use in performance score** flag.

**Customer Satisfaction**

Calculations are tabulated from surveys sent to unique subscribers to an offering.

**Stability**

The metric indicator is calculated from a combination of P1 and major incident counts.

**Service offering performance weighting**

Service owners can vary the inclusion and weighting of service offering metrics to reflect the business needs and perspectives of their stakeholders. Metrics are normalized and weighted to determine the performance of an offering. Metrics are only maintained for service offerings with an operational status. Weights must equal 100 percent.

To disable a service offering metric with unavailable or unreliable data from performance calculations, you can set the metric weight to 0 in the platform Service Portfolio Management Premium application.

Click the **Edit Metric Weights** Related Link on the **Service Offering** form to edit the upper and lower boundaries for each metric. The **Maintenance** pop-up window appears for you to customize per service offering. The upper and lower boundaries define how a metric is measured against a 0 through 100 percent scale and normalized together. To obtain a 100% score for negative metrics, such as for Stability, the score must be below or equal to the lower boundary.
Service offering to service performance weighting

Service owners can vary the inclusion and weighting of the service offering in service performance to reflect the business needs and perspectives of their stakeholders. Service offering performance is weighted and combined to determine the performance of a service. Only offerings with an operational status are used to contribute to service performance.

Set a service offering weight to 0 to disable it from the performance calculations of its parent service.
Click the **Edit Weights** Related Link on the **Services** form to edit the weights for associated offerings. Weights are valued against a 0 through 100 percent scale and normalized together.
Note: Upper and lower weight boundaries can be anything, from negative numbers to thousands of numbers. They do not have to be 0 to 100. But the outcome of the linear ranging math is to use those boundaries to make a normalized number between 0% and 100%.

For example, the normalization process dictates, that if you choose -20 and 150 as lower and upper boundaries, then anything at -20 or below will get normalized to 0% and anything at or above 150 will get normalized to 100%. Every number in between -20 and 150 is scaled to within the 0 through 100 range.

Another way to describe the normalization process is, for example, if you choose 5 and 150 as lower and upper boundaries and the metric is negative (minimize). With this metric anything below or equal to 5 gets a normalized score of 100%. Therefore, for a negative metric, the lower the raw score is, the higher the normalized score, which is capped at 100%. If you choose 5 and 150 as lower and upper boundaries and the metric is positive (maximize), then anything below or equal to 5 will get a normalized score of 0%.

Service to nodes performance weighting

Portfolio owners and editors can vary the inclusion and weighting of services in node performance to reflect the business needs and perspectives of their stakeholders. Service performance is weighted and combined to determine the performance of sublevel taxonomy nodes, also called child nodes.

Use the Edit Weights Related Link on the Taxonomy Nodes form to edit the associated service weights. Service weights are valued against a 0 through 100 percent scale and normalized together.
Node to node performance weighting

Portfolio owners and editors can vary the inclusion and weighting of node in node performance to reflect the business needs and perspectives of their stakeholders. Node performance is weighted and combined to determine the performance of taxonomy parent nodes.
Performance scores

The performance score for services and offerings are highlighted with a different color in Service Owner Workspace based on the configured threshold limit defined on the portfolio record.

- Red: Indicates the score is lower than the set threshold limit.
- Amber: Indicates the score is within the set threshold.
- Green: Indicates the score is higher than the set threshold limit.
Metrics configuration

To view or configure Service Owner Workspace metric definitions, refer to Configure Service Owner Workspace metric definitions.

To view or configure Service Owner Workspace portfolio metrics, refer to Configure Service Owner Workspace portfolio metrics.

Setting up Service Owner Workspace

Prepare for your Service Owner Workspace experience by activating necessary applications, accessing quick start tests to ensure proper functionality, and configuring metrics to monitor.

Integrate with other applications

After activating the Service Owner Workspace plugin (com.spm_owner_workspace), align with other ServiceNow applications to expand your service portfolio monitoring experience.

Service Owner Workspace is meant to work seamlessly with Vendor Manager Workspace. Often service owners are also vendor managers. For this reason, activation of the Vendor Manager Workspace application is useful. Toggling between the two workspaces is easy because they share the same interface. Simply click the Vendor Manager Workspace icon in the workspace to view vendor-related data.
Integrating with the Financial Management application provides estimated spend calculations based on fiscal periods and rolls spend data up from service offerings to associated services and taxonomy nodes within your portfolio. Estimated spend data is available to monitor and analyze in the workspace.

Refer to Service Owner Workspace integrations for complete details about applications that you can activate to add greater depth and value to your Service Owner Workspace monitoring experience.
Metrics definition and configuration

Monitoring your services involves metrics and scores that keep you apprised of how well your services are performing, how satisfied your customers are with the services you provide, and how many people are subscribing to your services. Defining metrics and applying the metrics to your portfolios, services, and offerings ensures an accurate and goal-oriented monitoring experience. You determine the upper and lower thresholds of service performance.

Activate Service Owner Workspace

The Service Owner Workspace plugin (com.spm_owner_workspace) is available as a separate subscription. It activates related plugins, including the Service Portfolio Management Premium plugin (com.snc.spm). Subscribing to Service Owner Workspace adds the service-owner user interface and premium functionality to your Service Portfolio Management environment.

Role required: admin

You can subscribe to Service Owner Workspace if your organization has purchased a Service Owner Workspace subscription. Refer to View subscription applications and plugins to verify if your company has purchased the subscription.

Note:

A subscription to Service Owner Workspace entitles you to Service Portfolio Management Premium. Service Owner Workspace automatically activates the Service Portfolio Management Premium plugin. The Service Owner Workspace plugin enables platform functionality, which provides access to all the data necessary for workspace effectiveness.

A subscription to Service Owner Workspace includes full access to Performance Analytics.

The Performance Analytics - Premium plugin (com.snc.pa.premium) is necessary for Service Owner Workspace feature functionality. It must be activated before you can activate the Service Owner Workspace plugin.

The Service Owner Workspace plugin (com.spm_owner_workspace) activates related plugins if they are not already active.
### Related plugins for Service Owner Workspace

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Analytics — Premium</td>
<td>Adds the following functionality to Service Portfolio Management:</td>
</tr>
<tr>
<td>(com.snc.pa.premium)</td>
<td>• Create indicators, breakdowns, and other records.</td>
</tr>
<tr>
<td></td>
<td>• Create text analytics widgets.</td>
</tr>
<tr>
<td></td>
<td>• Use Performance Analytics with external data.</td>
</tr>
<tr>
<td></td>
<td>• Preserve performance scores beyond 180 days.</td>
</tr>
<tr>
<td><strong>Note:</strong> This plugin must be activated before activating the Service Owner Workspace plugin (com.spm_owner_workspace).</td>
<td></td>
</tr>
<tr>
<td>Service Portfolio Management Premium</td>
<td>Collects service offering metrics and rolls these calculations up to parent services and taxonomy nodes for performance scores and other metrics viewed via Service Owner Workspace.</td>
</tr>
<tr>
<td>(com.snc.spm)</td>
<td></td>
</tr>
<tr>
<td>Service Portfolio Management Estimated Spend</td>
<td>Provides a simple cost model.</td>
</tr>
<tr>
<td>(com.snc.spm.spend)</td>
<td></td>
</tr>
<tr>
<td>Agent Workspace - Form</td>
<td>Provides workspace form configurations.</td>
</tr>
<tr>
<td>(com.snc.agent_workspace.form)</td>
<td></td>
</tr>
<tr>
<td>Agent Workspace - List</td>
<td>Provides workspace list configurations.</td>
</tr>
<tr>
<td>(com.snc.agent_workspace.list)</td>
<td></td>
</tr>
<tr>
<td>Agent Workspace - Highlighted Values</td>
<td>Provides support for highlighted values in workspace.</td>
</tr>
<tr>
<td>(com.snc.agent_workspace.highlighted_values)</td>
<td></td>
</tr>
<tr>
<td>Agent Workspace - Declarative Actions</td>
<td>Provides support for declarative actions in workspace.</td>
</tr>
<tr>
<td>(com.snc.agent_workspace.declarative_actions)</td>
<td></td>
</tr>
<tr>
<td>Service Workspace</td>
<td>Provides the Service Workspace application.</td>
</tr>
<tr>
<td>(com.snc.service_workspace)</td>
<td></td>
</tr>
</tbody>
</table>

Several additional plugins offer increased functionality to Service Owner Workspace. Activate these plugins to enhance your monitoring experience.

#### Additional plugins for Service Owner Workspace monitoring functionality

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Manager Workspace</td>
<td>Provides integration with the Vendor Manager Workspace as part of the Service Owner Workspace monitoring experience.</td>
</tr>
<tr>
<td>(com.snc.vlm.vmw)</td>
<td></td>
</tr>
<tr>
<td>Continual Improvement Management CIM</td>
<td>Enables display of existing CIM records in Service Owner Workspace when a service relation is indicated on associated forms. Service owners can initiate a CIM record to address a performance issue with a service or offering.</td>
</tr>
<tr>
<td>(com.sn_cim)</td>
<td></td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Incident Management - Major Incident Management (com.snc.incident.mim)</td>
<td>Provides a consolidated workbench to view major incidents via Service Owner Workspace.</td>
</tr>
</tbody>
</table>

**Note:** Users can also choose not to use the local cost model or the Financial Management model by selecting None in the

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Installed with Service Owner Workspace**
Service Owner Workspace automatically activates the Service Portfolio Management Premium plugin (com.snc.spm). Service Portfolio Management Premium installs the following components.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

**Service Portfolio Management Premium**

**Tables installed with Service Portfolio Management Premium**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metric Definition (spm_metric_definition)</td>
<td>Used to define metrics for use in the Service Portfolio Management Premium application.</td>
</tr>
</tbody>
</table>
Table | Description
---|---
Service Offering Metric Data  
(service_offering_metric_data) | Used to configure service offering metric data.  
With this record you can:  
- Set boundaries within a service offering performance score range.  
- Set a weight value.

Portfolio Metric  
(spm_portfolio_metric) | Used to configure portfolio metric data.

SPM Node Weight  
(spm_node_weight) | Used to assign a weight value to a node in relation to the value of its sibling nodes.

Quick start tests for Service Portfolio Management Premium

Validate that Service Portfolio Management Premium still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Service Portfolio Management Premium quick start tests require activating the Service Portfolio Management Premium plugin (com.snc.spm).

**Service Portfolio Management Premium - ATF Tests test suite**

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portfolio Editor: Not Portfolio Owner, Read Only Taxonomy Access</td>
<td>Ensure a portfolio editor can only read associated non-owned portfolio taxonomies.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Portfolio Editor: Cannot create new Portfolios</td>
<td>Ensure a portfolio editor cannot create new portfolios.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Portfolio Editor: Valid Portfolio Owner Taxonomy Access</td>
<td>Ensure a portfolio owner has access to taxonomies within owned portfolios.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Service Editor: Access</td>
<td>Ensure a service editor can only edit owned services and offerings.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Portfolio Editor: Can Modify Owned Portfolios</td>
<td>Ensure a portfolio editor can modify and update owned portfolios.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Create a Portfolio</td>
<td>Ensure a portfolio admin can create a new portfolio.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Portfolio Editor: Cannot Modify Non-Owned Portfolios</td>
<td>Ensure a portfolio editor cannot modify non-owned portfolios.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Service Workflow</td>
<td>Verify that a service cannot move forward to Catalog phase without a service portfolio, taxonomy node, and service offering attached to it. Verify a service cannot move backward from the Catalog phase to the Pipeline phase.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Service Portfolio (Normal)</td>
<td>Create a service portfolio, taxonomy layer, and taxonomy nodes.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Create a Portfolio + 3 Taxonomy Layers</td>
<td>Create a service portfolio with three taxonomy layers.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Service Portfolio (Exception) - Taxonomy Layer Definition Set 01</td>
<td>Create a service portfolio, taxonomy layer, and taxonomy nodes.</td>
<td>Orlando</td>
</tr>
<tr>
<td>SPM: Create a Portfolio</td>
<td>Create a service portfolio.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Create a Portfolio + 3 Taxonomy Layers</td>
<td>Create a service portfolio, with three taxonomy layers.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Service Portfolio (Normal)</td>
<td>Create a service portfolio, taxonomy layer, and taxonomy nodes.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Service Portfolio (Exception) - Taxonomy Layer Definition Set 01</td>
<td>Create a service portfolio, taxonomy layer, and taxonomy nodes.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Portfolio Editor: Can Modify Owned Portfolios</td>
<td>Ensure a portfolio editor can modify portfolios that they own.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Portfolio Editor: Cannot Modify Non-Owned Portfolios</td>
<td>Ensure a portfolio editor cannot modify portfolios that they do not own.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Portfolio Editor: Cannot create new Portfolios</td>
<td>Ensure a portfolio editor cannot create new Portfolios.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Portfolio Editor: Valid Portfolio Owner Taxonomy Access</td>
<td>Ensure portfolio owners have access to taxonomies that they own.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Portfolio Editor: Not Portfolio Owner, Read Only Taxonomy Access</td>
<td>Ensure a portfolio editor can only read the taxonomies of portfolios they do not own.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Service Editor: Access</td>
<td>Ensure a service editor can only edit services and offerings that they own or are a delegate of.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Service Viewer: Access</td>
<td>Ensure a service viewer has access to view services.</td>
<td>Paris</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>SPM: Service Workflow</td>
<td>Verify a service cannot move forward to Catalog phase without a service portfolio, taxonomy node, and service offering attached to it. Verify a service cannot move backward from Catalog to Pipeline phase.</td>
<td>Paris</td>
</tr>
</tbody>
</table>

**Service Owner Workspace Migration Dashboard**

Service Owner Workspace provides a migration dashboard to support your transition from the legacy Service Portfolio Management structure to the enhanced application structure.

By viewing the Migration Dashboard, portfolio managers can quickly determine which existing services and offerings contain a deprecated structure or are considered orphaned in the enhanced Service Portfolio Management taxonomy structure.

Users with the following assigned roles can view the Service Portfolio Management dashboard:

- service_viewer
- portfolio_admin

Users with the portfolio_admin or service_editor role can modify services and service offerings to structurally comply with and migrate to the Service Portfolio Management Foundation application.

By default, the dashboard displays reports for all existing service portfolios. An interactive filter enables you to choose a single portfolio to view. The dashboard reports are visible even if there are no service portfolios defined.

Dashboard report categories display the number of related identified migration issues. If there are no migration issues identified for a report category, a 0 is shown.

Access the dashboard by navigating to Service Portfolio Management > Migration Dashboard. To view detailed information, hover over any report graphic. All report graphs can be refreshed for the latest data.

Migration issues are indicated when a number graphic greater than zero is indicated on the report. For these reports, hover over and click the number graphic. A list opens displaying the services or offerings that require modification to migrate to the Service Portfolio Management Enterprise structure.

The following reports are available on the Migration Dashboard. If migration issues are indicated, refer to the report description and how to remedy the issue for migration.
<table>
<thead>
<tr>
<th>Migration Dashboard report</th>
<th>Description and migration task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deprecated Operational Status Used for Offerings</td>
<td>Indicates the number of existing service offerings using the deprecated singular status of Operational Status.</td>
</tr>
<tr>
<td></td>
<td>Modify these offerings by filling in both the Phase and Status fields on the Service Offering form.</td>
</tr>
<tr>
<td></td>
<td>Note: Status can be one of several choices, such as Design, Development, Build/Test/Release, Operational, and Retiring.</td>
</tr>
<tr>
<td></td>
<td>Click Update.</td>
</tr>
<tr>
<td>Deprecated Operational Status Used for Service</td>
<td>Indicates the number of existing services using the deprecated singular status of Operational Status.</td>
</tr>
<tr>
<td></td>
<td>Modify these services by filling in both the Phase and Status fields on the Service form.</td>
</tr>
<tr>
<td></td>
<td>Note: Status can be one of several choices, such as Requirements, Definition, Analysis, Approved, and Chartered.</td>
</tr>
<tr>
<td></td>
<td>Click Update.</td>
</tr>
<tr>
<td>Operational Services not in a Portfolio</td>
<td>Indicates the number of existing services not currently associated with a portfolio.</td>
</tr>
<tr>
<td></td>
<td>Modify the Service form by selecting a portfolio in the Service portfolio field. Click Update.</td>
</tr>
<tr>
<td>Orphaned Services in Catalog Phase</td>
<td>Indicates the number of services in Catalog phase that do not have a parent taxonomy node.</td>
</tr>
<tr>
<td></td>
<td>Modify the Service form by selecting a taxonomy node in the Taxonomy node field. Click Update.</td>
</tr>
<tr>
<td>Deprecated Usage of Service Catalog Entry</td>
<td>Indicates the number of services or offerings linked to a catalog item via the deprecated Service Catalog Entry(sc_cat_item_service) table.</td>
</tr>
<tr>
<td>Orphaned Service Offerings</td>
<td>Indicates the number of service offerings where the Parent field on the Service Offering form is not pointing to a parent service. Offerings must be children of a service.</td>
</tr>
<tr>
<td></td>
<td>In the Parent field on the Service Offering form, search for and select the associated service. Click Update.</td>
</tr>
<tr>
<td>Cataloged Non-operational Offerings</td>
<td>Indicates the number of active catalog items connected to service offerings not in the catalog phase or with an operational status.</td>
</tr>
<tr>
<td></td>
<td>Modify the Service Offering form Phase field to Catalog and the Status field to Operational. Click Update.</td>
</tr>
</tbody>
</table>
## Migration Dashboard report

<table>
<thead>
<tr>
<th>Description and migration task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicates the number of services in the <strong>Catalog</strong> phase without at least one associated service offering. An offering must be defined for a service to move into Catalog phase.</td>
</tr>
<tr>
<td>To associate a service offering to a service, open a specific service offering associated with the cataloged service indicated in the <strong>Migration Dashboard</strong>. In the <strong>Parent</strong> field on the <strong>Service Offering</strong> form, search for and select the associated service. Click <strong>Update</strong>.</td>
</tr>
</tbody>
</table>

---

**Service Owner Workspace integrations**

Align with other product applications to add value to your Service Owner Workspace monitoring experience.

**Service Owner Workspace and product alignment**

Activate and integrate with these products to expand the functionality of Service Owner Workspace:

**Vendor Manager Workspace**

Activate the Vendor Manager Workspace plugin (com.snc.vlm.vmw) to align this workspace data with Service Owner Workspace.

- Manage your vendors from the same workspace interface to effectively gain knowledge of all vendor-related information.
- Monitor and view vendor performance reports from the workspace view.
- Decide what vendor metrics to monitor and manage in workspace view.
- Calculate and view vendor CSAT weight and vendor service offering performance weight.

**Financial Management**

Activate the Service Portfolio Management Estimated Spend plugin (com.snc.spm.spend) to view service offering spend, enabling you to select between your local cost model and the cost model provided by the Financial Management application.

Activate the Financial Management for SPM plugin (com.snc.financial_management_for_spm) to provide preconfigured service offering cost models to view in . Select between your local cost model and the Financial Management application model, when used.

**Continual Improvement Management (CIM)**

Display existing CIM records in Service Owner Workspace when a service relation is indicated on associated forms.

Service owners can initiate a CIM record when a performance issue with a service or offering is displayed.

**Incident Management — Major Incident Management**
Activate the Incident Management - Major Incident Management plugin (com.snc.incident.mim) to provide a consolidated workbench to view major incidents via the Service Owner Workspace activity stream.

Integration with Common Service Data Model

Improve your measurement and evaluation by using services and offering references on multiple IT Service Management task forms, including:

- Problem
- Change
- Continual Improvement Management
- Incident

Directly reference a service offering as the target of a problem, change, or incident for consistency with the Common Service Data Model (CSDM). The system filters available offerings based on the service selected.

View and define the service model Model ID reference field on the Service and Offering forms to integrate with the CSDM.

When the Service Portfolio Management Premium plugin (com.snc.spm) is activated with CSDM is applied, the navigational pane includes the modules Manage Technical Services and Sell and Consume. Service offerings with associated catalog items are available to view and manage via Technology Request Catalog and Business Request Catalog within these modules. For complete information about CSDM and how it relates to Service Portfolio Management Premium, refer to Common Service Data Model.

Configure Service Owner Workspace metric definitions

Configure unique metric definitions to measure the performance of your service offerings in Service Owner Workspace.

Role required: admin or portfolio_admin
Service Owner Workspace includes several metric definitions which you can view and edit, if necessary. You can also create new metric definitions unique to your desired performance monitoring needs.

1. Navigate to Service Portfolio Management > Configuration > Metric Definitions.
2. View the available base system metric definitions and associated indicators.
3. To create a unique metric definition, click New.
   The Metric Definition form opens.
4. Provide a unique name for the metric definition in the Name field.
5. Select a Performance Analytics indicator in the Indicator field.
6. Click Submit.
   For more information about metrics and weight configuration, refer to Service Owner Workspace performance metrics.

Configure Service Owner Workspace portfolio metrics

Decide which metrics to configure for your service portfolio to measure the performance of your service offerings in Service Owner Workspace.

Role required: admin or portfolio_admin

1. Navigate to Service Portfolio Management > Configuration > Portfolio Metrics.
2. Click an existing service portfolio to learn what metrics are associated.
   The Portfolio Metrics list opens displaying all the metrics applied to the service portfolio.
3. To add an additional metric to the service portfolio, click New.
4. Fill in the form fields.

<table>
<thead>
<tr>
<th>Portfolio Metric form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Service portfolio</td>
<td>Select the service portfolio for which you want to create a metric</td>
</tr>
<tr>
<td>Metric</td>
<td>Select the metric to apply. Choices include: Activity, Availability, Breached SLA, Customer Satisfaction, and Stability.</td>
</tr>
</tbody>
</table>
### Generate a service offering availability

Generate on-demand availability reports displayed in Service Owner Workspace. When a service commitment contains an availability guarantee, the service offering displays an availability report.

**Role required:** service_editor

---

Availability records are generated by a daily job when you select an Availability type service commitment for your service offering. By defining service offering availability, you generate reports that track the actual availability of the offering. For a 7-day chart, no reporting data is available until five days after the service offering is created. For 30-day charts, 23 days of data is required before a report is generated. For a 12-month chart, the database must contain at least 10 months of data.

1. To generate a new service availability, navigate to Service Portfolio Management > Availability and click **New**.

   **Note:** When an Availability commitment type is added to a service offering, it will generate a year’s worth of availability records for that offering and commitment. For this reason, existing Availability forms should not be edited. Availability is calculated based on the outages in the system for that offering. If an outage is updated, then the related availability records are updated too.

2. Fill in the form fields.
## Service Availability form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Enter the name of the service availability as it appears in record lists. Automatically set at record creation based on service offering and commitment.</td>
</tr>
<tr>
<td>Service offering</td>
<td>Select the service offering for which you want to generate an availability record.</td>
</tr>
<tr>
<td>Service commitment</td>
<td>Select the service commitment to apply the availability record.</td>
</tr>
<tr>
<td>Start</td>
<td>Choose the start of this availability interval.</td>
</tr>
<tr>
<td>End</td>
<td>Choose the end of this availability interval.</td>
</tr>
<tr>
<td>Committed uptime</td>
<td>Enter the total expected service availability for this commitment.</td>
</tr>
<tr>
<td>Acceptable downtime</td>
<td>Enter the acceptable amount of downtime against this commitment schedule for this interval.</td>
</tr>
<tr>
<td>Total downtime</td>
<td>Enter the wall-clock downtime, independent of schedule.</td>
</tr>
<tr>
<td>Met commitment</td>
<td>Availability commitment was met for this interval. Check to indicate the commitment was met.</td>
</tr>
</tbody>
</table>

### Note:
The following fields display SLA result data when available:
- **Total availability %** — Availability percentage for the entire interval, independent of schedule.
- **Total outages** — Total number of outages in this interval, independent of schedule.
- **Commitment availability %** — Availability percentage within this commitment schedule.
- **Commitment downtime** — Downtime that counts against this commitment schedule.
- **Commitment outages** — Number of outages against this commitment schedule in this interval.

3. **Click Submit.**
   View service offering **Availability** reports in Service Owner Workspace.

### Change scope to Service Portfolio Management Premium

Grant access to a dedicated user to enable switching the scope from Global to Service Portfolio Management Premium to create a custom automated indicator.

Role required: admin
Both the indicator and the job must be in the same scope. Provide a user with delegated developer access and the pa_admin role to change the scope from Global to Service Portfolio Management Premium when creating custom indicators for Service Portfolio Management Premium jobs.
1. In the Navigator, type `sys_scope.list` and press Enter.
2. Search by name for Service Portfolio Management Premium and click the application name to open the associated Store Application form.

3. In Related Links, click **Manage Developers**.

4. Search for the user or group you want to grant delegated developer access to. The **Permissions** configuration screen appears.

5. Configure delegated developer access for the user or group.
   a) In the **File Type Access** section, toggle the **Reporting** category radio button to grant this type of access.
   b) Click **Save**.

Grant access to any other section category by toggling the associated radio button.

6. Assign the pa_admin role to the user or group with delegated developer access.

---

**Create indicators in Service Portfolio Management Premium**

Create custom indicators for your Service Portfolio Management Premium jobs in the correct scope.

Role required: pa_admin

---

You must have the Reporting file type delegated developer access to change the scope from Global to Service Portfolio Management Premium when creating custom indicators for the application. Administrators grant the Reporting file type delegated developer access. For information regarding obtaining delegated developer access, refer to *Change scope to Service Portfolio Management Premium*.

When you create an indicator and associate it with a job in an application, both the indicator and the job must be in the same scope. Jobs and indicators available in the Service Portfolio Management Premium base system are in the correct Service Portfolio Management Premium scope. However, when you create a custom indicator, by default it is created in the Global scope. To associate a custom indicator with a Service Portfolio Management Premium job, you need to first change the scope from Global to Service Portfolio Management Premium.
2. In System Settings, click Developer.
3. In Application, find and select Service Portfolio Management Premium.
4. Navigate to Performance Analytics > Indicators > Automated Indicators and click New to create an indicator in the Service Portfolio Management Premium scope. For details on how to create an automated indicator, refer to Create an automated indicator.

Using Service Owner Workspace

Use Service Owner Workspace to monitor the health of your services and your customer satisfaction. View outages, critical incidents, and change requests associated with services and offerings.

With Service Owner Workspace you can monitor metrics and analyze the health of your services from a single user interface. Get to know how metric models are created and configured for service offerings and how they are used in Service Owner Workspace.

Service Owner Workspace features

Service Owner Workspace features include:

- A view-only, multi-tab interface for monitoring and managing multiple portfolios and related services.
- Dashboards offer immediate access to portfolio and service health and performance metrics, as well as who owns and manages the service.

**Note:** In most cases, data is collected up to the previous day. If there is a current outage or incident, then data does not appear in trend charts or displays.

- Comprehensive layout of all information related to a portfolio and its component services.

Service owners can access the workspace to perform their most common tasks, including:

- View and manage owned IT services, as well as view all IT services the business manages.
- Expand service lists to expose child services and service offerings.
- Select a service to access pertinent information, including service trends, related services and information, improvement initiatives, and associated service offerings.
- View and monitor service performance score reports, customers' scores, and total subscribers.
- Monitor recent and upcoming changes.
- Drill down into service offerings to view availability, SLA compliance, customer satisfaction, offering stability, performance scores, and more.
- View associated unique or critical information about the service offering in the impact stream panel on the right side of the workspace. For example, you can view outages records with a unique Outage Number identifier. You can also see the outage number on the list view for outages via the Outage tab in the report viewer.

**Note:** The Outage Numbering plugin (com.snc.outage_numbering) must be activated to introduce number data. The plugin is automatically activated for all instances and upgrades except those that already have a number prefix column on the Outage table. Refer to the Activate Outage Numbering plugin (KB0823685) article in the HI Knowledge Base or contact ServiceNow Technical Support if the plugin is not active and you want to move to the base system field.

System administrators can configure the workspace according to the specific needs within the organization:

- Disable particular metrics from displaying in the workspace.
- Configure the metric weights that contribute to performance scores within the workspace.
- Configure the metric thresholds for each metric that displays in the workspace.

Start here: Access Service Owner Workspace.

**Access Service Owner Workspace**

Open the Service Owner Workspace to access and display all your portfolios and services at a single location. Monitor and manage your services and offerings from the workspace.

Role required: service_viewer

---

To access and use Service Owner Workspace, the Service Owner Workspace plugin (com.spm_owner_workspace) must be activated and you must be assigned the Service Viewer (service_viewer) role.

1. Navigate to Service Portfolio Management > Service Owner Workspace.
2. Click a portfolio name to expand the layers of services.
3. Click My Services to view portfolios that you own and manage. Or click All Services to view all the services your organization owns and manages.
A list of services displays. You can expand each service to see child services within the service taxonomy.

4. Click a service name to view pertinent information about the service. The Overview dashboard Additional Node Info sidebar displays who owns and manages the service, as well as the associated Performance score, Taxonomy Nodes (services), and Estimated spend if available.
To contact a service owner, service offering owner, or associated manager, click the person’s name in the workspace and then click the associated email. Phone numbers are also displayed for quick access to service stakeholders.

5. Choose how to group and sort dashboard data in the Group by and Sort by lists. You can group by No grouping or Taxonomy node owner. You can sort by Ascending, Descending, Node weight, Performance score, or Name.

6. Click a Taxonomy Node (service) to view pertinent information about the service. The associated service displays in the Overview tab.

7. Click in the Service card to drill deeper into the details and view health and performance metrics, as well as any associated service offerings. Service health and performance metrics, such as Service Performance Score, Customer Satisfaction, Total Subscribers, Estimated spend, and associated Service Offerings are displayed.
8. Click additional tabs besides the **Overview** tab to display data relevant to the offering, including:

- **Trends** — View performance over a specified time frame, as well as SLA compliance.
- **Relationships** — View service dependency details. This tab shows offering relationships, for example, which services a service depends on and which services depend on it.

View the **I depend on** and **Depends on me** sections to see service offering dependencies at the parent service level via a card with a highlighted label reading **Inherited relationship**.

**Note:** Dependencies that a service inherits from a child offering are visually distinct from dependencies defined directly between services.

Service and offering types are distinguishable in the card by a unique icon and label specifying the type of service and offering. For example, **Business Service**, **Application Service**, and **Technical Service**. When you click on an offering card, the record view of the offering is displayed.

- **Info** — View the service offering description, performance breakdown, general information, commitments, team, and more. You can also view your service offering to catalog item relationships via this tab. Click to open a catalog item to drill down into more details.

Monitor fulfilled requests for all associated catalog items in the **Offering Activity** metric. For complete details about service offerings and associated catalog items, refer to **Service offering to catalog item relationships**.

**Note:** The **Create Catalog Item** action is only available when there is no catalog item mapped to a service offering and there is no catalog item with the same name as the offering. This prevents the issue of having catalog items with the same name.

- **Improvement Initiatives** — View all CIM initiatives as links to the records. This tab displays with activation of the Continual Improvement Management (CIM) plugin (com.sn_cim).

9. Click icons in the impact stream panel, on the right side of the workspace, to display related information about **Outages**, **Critical Incidents**, **Change Requests**, or **Attachments** details.

View the associated unique or critical information about the service offering in the impact stream.
### Critical Incidents

<table>
<thead>
<tr>
<th>Incident</th>
<th>Description</th>
<th>Severity</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT Outage</td>
<td>Power outage in data center</td>
<td>Critical</td>
<td>In Progress</td>
<td>Power restored</td>
</tr>
<tr>
<td>Data Breach</td>
<td>Hacked database</td>
<td>Severe</td>
<td>Under Investigation</td>
<td>Investigation underway</td>
</tr>
<tr>
<td>Network Down</td>
<td>Issues with DNS servers</td>
<td>Medium</td>
<td>In Progress</td>
<td>Server restarts complete</td>
</tr>
</tbody>
</table>

*Note: Images and diagrams are not included in the plain text representation.*
10. Click an outage, critical incident, or change request to drill deeper into the details.

Once you click an impact stream item, for example, a critical incident, you can view all details related to the item and even open the associated record by clicking **Open record**.

Recent, current, and upcoming outage data is available. Click a type of outage for the information you want. Refer to **Outages** for information about a unique **Outage Number** identifier and activating the Outage Numbering plugin (com.snc.outage_numbering).

11. If the service you are viewing has associated child offerings, click an offering to drill down and view details.
View the offering overview, as well as other pertinent data, such as service offering availability, breached SLAs, customer satisfaction, stability, and activity. Available service offering tabs include, Overview, Trends, Relationships, Info, Catalog Items, and Improvement Initiatives. These tabs similar data as is provided for services. The Catalog Items tab displays all catalog items related to the service offering, as well as a short description of the item.

Service offering to catalog item relationships

Manage the relationships between your service offerings and catalog items by associating your pre-existing catalog items to your service offerings and vice versa. View relationships in both Now Platform form related lists and Service Owner Workspace.

Required roles and actions

Service owners and catalog administration managers can edit relevant forms to associate and manage pre-existing service offering to catalog item relationships. This feature is in addition to the Create Catalog Item feature that enables you to create a new catalog item.

With the service_editor role, you can add, change, and remove catalog items associated with an owned service offering via the Service Offering form Catalog Item related list. You can also create a catalog item from a service offering via Service Owner Workspace by clicking the Create Catalog Item link. A single service offering may have many related catalog items. Click the Link button in the Catalog Item related list to make a change.

**Note:** If a catalog item is already associated with a service offering, you cannot associate the item to a new offering. You will have to contact a catalog_admin to remove the existing association so that you can make changes.

With the catalog_admin role, you can add, change, and remove service offerings associated with a catalog item via the Catalog Item form Service Offerings related list. A single catalog item can be related to one service offering.

Click the Link button in the related list to make a change. You can remove the association if needed with the related list Delete button.

**Note:** If a service offering is already associated to a catalog item, the Link button does not appear in the related list. For details about viewing and editing Catalog Items, refer to Create or edit a catalog item.

Catalog items in Service Owner Workspace

View catalog items related to a service offering in Service Owner Workspace from the offering page Catalog Items tab. Click to open a catalog item to drill down into more details and even open up the form view.

Monitor fulfilled requests for all associated catalog items and order guides in the offering Trend tab Activity metric.

Hover over the Trends tab Activity metric to view both the catalog item name and the 30 day average running count.

When you click the trend line for an individual catalog item, only Requested Items for that catalog item and the offering are visible on the list view of the report viewer.
Things to keep in mind

- Avoid model phase conflicts between offerings and catalog items.
  - Catalog items can only be associated to service offerings in the Catalog phase.
  - The service offering must be operational for catalog items to be active.
  - Inactive catalog items can be associated to operational service offerings.

- Order guides are not referenced as associated items.
  - In Service Owner Workspace, Activity metrics are driven by catalog items that compose an order guide.

Service Portfolio Management Premium notifications

Notifications are added with Service Portfolio Management Premium to manage your service offering to catalog item relationships.

Service Portfolio Management Premium includes several email notifications that alert catalog admins when a service offering associated with a catalog item is retired or when a new catalog item has been created from a service offering.

The following notifications are included:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offering retired</td>
<td>Sends an email to a specified user group when a service offering that is associated with a catalog item is retired.</td>
</tr>
<tr>
<td>Table: Service Offering (service_offering)</td>
<td></td>
</tr>
<tr>
<td>Catalog Item created from Offering</td>
<td>Sends an email to a specified user group when a new catalog item has been created from a service offering. The email asks that the new catalog item be reviewed and prepared for activation in the catalog.</td>
</tr>
<tr>
<td>Table: Available for Subscribers (sc_cat_item_subscribe_mtom)</td>
<td></td>
</tr>
</tbody>
</table>

To configure catalog_admin recipients for these notifications, refer to Create a user group.

Service Owner Workspace Service Offering survey

Subscribers can rate their experience with service offerings via the Service Portfolio Management Premium Service Offering survey. This feedback provides portfolio managers and service owners with valuable information to improve service offering performance and subscriber satisfaction.
In the base system, a predefined SPM Service Offering Survey is available. Surveys are sent for operational and retiring service offerings only. Portfolio admins (portfolio_admin) can edit the survey and service editors (service_editor) can configure the associated trigger conditions.

You must have the admin or portfolio_admin role to modify the SPM Service Offering Survey. To view the survey, navigate to Survey > View Surveys.

The SPM Service Offering Survey is triggered randomly for 10% of service offering subscribers. Only subscribers who have not been polled within the previous three-month time period can receive a survey. Subscribers receive an email with the survey link. The service offering name is displayed and the survey inquires how satisfied the subscriber is with the service or service offering. Subscribers use radio buttons to rate satisfaction on a 1 through 5 scale, with 1 being not satisfied and 5 being very satisfied.

You are encouraged to modify the survey to better match your organizations needs.

Two system properties determine the percentage of subscribers to receive the survey and how often a subscriber is polled.

- **sn_spm.csat.survey_probability**: Default value is 10% of subscribers are randomly polled.
- **sn_spm.csat.survey_period**: Default value is 90 days. The system does not send a survey to a subscriber who has been polled within the previous 90 days.

Service owners can use the Service Offering form to define how often to send a CSAT survey. The **CSAT survey frequency** field offers the following frequency choices:

- **Never** (default)
- **Daily**
- **Weekly**
- **Monthly**

Service owners can view the last time a survey was sent for an offering in the **CSAT survey last sent** field on the Service Offering form.

Portfolio managers and service owners can review responses and view vendor CSAT weight in Service Owner Workspace.

For more detailed information about working with surveys, trigger conditions, and survey questions, see **Survey Management**.
Financial Management for Service Owner Workspace

Integrate Service Owner Workspace with Financial Management to access preconfigured service offering cost models. You can use these cost models to evaluate expenses and generate cost lines based on the level of service offering for a defined cost.

Activation and features

Activate the Financial Management for SPM plugin (com.snc.financial_management_for_spm) to access the preconfigured, base system models. Financial Management for SPM contains demo data and activates related plugins if they are not already active.

The Service Portfolio Management Estimated Spend plugin (com.snc.spm.spend) is available to enhance your Service Owner Workspace experience. With this feature, you can choose to use the default local service offering cost model or access the cost models offered via the Financial Management application.

When Service Owner Workspace (com.spm_owner_workspace) and Financial Management for SPM (com.snc.financial_management_for_spm) are activated and the sn_spm_spend.offering_cost_source system property is set to the value Financial Management the Estimated Spend form section displays the fields Estimated annual spend, FM aggregated period, and FM aggregated cost. These fields reveal read-only data stored on the service offering, service, and taxonomy records.

View calculated spend per offering in Service Owner Workspace

When you choose to use the cost models offered via the Financial Management application, calculated spend per service offering is displayed as a single score widget in Service Owner Workspace. View Estimated Spend as part of the Overview dashboard displaying associated service offering health and performance metrics.
Personal Printing

Performance Score

<table>
<thead>
<tr>
<th></th>
<th>Performance Score</th>
<th>Customer Satisfaction</th>
<th>Total Unique Subscribers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dec 31, 2019</td>
<td>47,10</td>
<td>2,89</td>
<td>256</td>
</tr>
<tr>
<td></td>
<td>↑ 0.05 (1.5%)</td>
<td>↑ 0.12 (4.5%)</td>
<td>↓ 13 (4.8%)</td>
</tr>
</tbody>
</table>

Estimated Spend

Per Month

387,2174
Service offering spend estimates are combined and summed up per period to the service and portfolio levels within your portfolio taxonomy. Estimated spend at the service and portfolio level enables you to better understand costs and how this aligns with performance throughout your service portfolio. With the estimated spend feature, you can:

- Balance your required service performance with the appropriate spend.
- Compare similar services by weighing spend to performance.
- Verify whether service spend is meeting your desired goals.
- View cost drivers within your service portfolio and the taxonomy structure.
- Compare an internal service spend to external service provider options.

**Local model compared to Financial Management model for estimated spend**

Estimated spend calculations run daily as a separate job.

When the system property `sn_spm_spend.offering_cost_source = Local Model`, the estimated annual spend for a service offering, service, and taxonomy is determined by adding the estimated annual spends for all child entities. Estimated annual spend data is stored on the service offering, service, and taxonomy records.

When the system property `sn_spm_spend.offering_cost_source = Financial Managment`, the estimated spend for a service offering, service, and taxonomy is determined by adding the Financial Management estimated spends for all child entities.

For each node, determine the Financial Management estimated spend for the currently selected Financial Management period by adding all the child entity estimated spends. This happens recursively up the entire taxonomy structure, starting with the service offering, to the service, to the taxonomy.

For detailed information about integrating with Financial Management and configuring costing for a service offering, refer to *Financial Management for licensed SPM users*.

**Configure the estimated spend offering cost source**

Define the source used to calculate the estimated cost for service offerings. You can use the default local model or access the preconfigured Financial Management service offering cost models.

Role required: admin
The Service Portfolio Management Estimated Spend plugin (com.snc.spm.spend) is automatically activated with Service Owner Workspace.

Activate the Financial Management for SPM plugin (com.snc.financial_management_for_spm) to enable the associated cost model.

Service Portfolio Management Estimated Spend provides the `sn_spm_spend.offering_cost_source` system property. With this property, you can define the source used to calculate the estimated cost for service offerings. Values include:

- Local Model
- Financial Management
- None

The default value is **Local Model**.

1. Enter `sys_properties.list` in the navigation filter to open the System Properties (`sys_properties`) table.
2. Find the `sn_spm_spend.offering_cost_source` system property and set it to the desired value.

---

**Note:** Users can choose not to use the local cost model or the Financial Management model, by selecting **None** as the desired value.

---

### Estimated spend offering cost source

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Model</td>
<td>With this default source, the offering Estimated Spend cost is calculated based on the following fields on the Service Offering form:</td>
</tr>
<tr>
<td></td>
<td>• Cost model: Choices include, Fixed and Per unit.</td>
</tr>
<tr>
<td></td>
<td>• Estimated spend: The estimated cost of the offering for the associated time period.</td>
</tr>
<tr>
<td></td>
<td>When the Cost model value is Fixed, additional fields appear on the Service Offering form, including: Offering cost, Time period, and Cost Unit.</td>
</tr>
<tr>
<td></td>
<td>When the Cost model is Per Unit, additional fields appear on the Service Offering form, including: Offering cost, Time period, Units per period, and Cost Unit.</td>
</tr>
<tr>
<td>Financial Management</td>
<td>With this source, the offering Estimated Spend cost is calculated based on the following Service Offering form fields, as calculated by the Financial Management application:</td>
</tr>
<tr>
<td></td>
<td>• FM period: Fiscal calendar period.</td>
</tr>
<tr>
<td></td>
<td>• FM cost: The actual currency amount.</td>
</tr>
<tr>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>None</td>
<td>With this value, or any incorrect values, the system ignores both the local and Financial Management cost models and does not display associated Service Offering form fields.</td>
</tr>
</tbody>
</table>

3. Click **Update** to save any changes.

**Service Level Management**

The ServiceNow® Service Level Management (SLM) application helps to gather service requirements as well as monitor and report with regards to agreed service levels (SLAs). SLM can be used across the organization in departments such as HR, Facilities, and IT. Service Level Managers are responsible for negotiating a set of agreements between a service provider and customer that define the scope, quality and speed of the services being provided and ensuring that the agreed service levels are met.

**Explore**
- Domain separation in Service Level Management
- Migrate to service level management
- Service Level Agreement (SLA) processing
- SLA calculation
- Scheduled jobs for SLA

**Set up**
- Configure Service Level Agreement (SLA) properties
- Add custom business rules to Service Level Agreement (SLA)

**Administer**
- Create an SLA definition
- Service Level Agreement (SLA) processing
- Repair Service Level Agreement (SLA)
- Monitoring Service Level Agreement (SLA)

**Use**
- Task SLA table
- SLA timeline

**Develop**
- Developer training
- Developer documentation
- Installed with Service Level Management

**Troubleshoot and get help**
- Ask or answer questions in the Service Level Management community
- Search the HI Knowledge Base for known error articles
- Contact ServiceNow Technical Support

**Service Level Management concepts**

The ServiceNow® Service Level Management (SLM) application enables you to monitor and manage the quality of the services offered by your organization.

Service Level Managers are responsible for a set of agreements between a service provider and customer that define the scope, quality, and speed of the services being provided. The intention of SLM is to provide the customer with an expectation of service within a known timescale and the ability to monitor when service levels are not being met.

SLM can be used across the organization in departments such as HR, Facilities, and IT to track how internal and external teams are performing against their agreed service levels.
The SLM offers the following features:

- Service Level Agreement (SLA) definitions
- Task SLAs
- Integration with other ServiceNow plugins

Service Level Agreement (SLA) roles

Ensure that users can perform all necessary actions by assigning SLA roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>sla_admin</td>
<td>Provides full administrative rights to SLM. Users that possess the sla_admin role can configure SLM properties, run SLA repair, view the SLA Overview dashboard, and manage SLA definitions. They may associate existing workflows or schedules to SLA definitions, but are unable to create workflows. The additional roles required to create workflows or schedules must be granted explicitly. See Base system roles for more information.</td>
</tr>
<tr>
<td>sla_manager</td>
<td>Lets users define SLA definitions, view SLA repair logs, and view the SLA Overview dashboard. Does not let users change SLM property values or define SLA condition types.</td>
</tr>
</tbody>
</table>

Service Level Agreement (SLA) definitions

Use the SLA Definition record to define a specific set of criteria that would result in an SLA being generated. Define some of the following parameters:

- Table: The task table that the SLA is defined for.
- Duration: The time duration in which the service must be provided to the customer.
- Schedule: The schedule, which indicates valid working and non-working days that the service provider follows to deliver the service. The selected schedule is used to determine when the SLA breaches.
- Conditions: The conditions under which the SLA starts, pauses, stops, or resets.

Task SLA definitions

When an SLA definition is triggered against a particular task, the task SLA record is generated and contains all the tracking data for the specific SLA on that record. For example, if an SLA definition exists for P1 incidents a task SLA record attaches to the P1 incident record and captures all the data associated with it. Often there are multiple task SLA records against a single task because many definitions apply.

Note: This feature is available only in new instances starting with Jakarta or a later release. The Problem Management Best Practice – Jakarta plugin (com.snc.best_practice.problem.jakarta) plugin must be activate.
On the Task SLA form, you can also select the target for the SLA: **Response**, **Resolution**, or **None**.

### Integration with other ServiceNow plugins

The following plugins introduce extra functionality within SLM:
- SLA Contract Add-on
- Service Portfolio Management - SLA Commitments

### Define a service contract

A new table of SLA contracts is provided through the **Service Level Management > Service Contracts** module. These contracts group together SLAs that relate to a single vendor or customer, as well as the CIs, locations, groups, users, and child contracts that are related to the contract.

The table Service Contract (ast_service) extends the table Contract (ast_contract). It stores information about service contracts for asset management purposes. To get the service contract functionality, activate the Service Level Management - Contract Management Integration (com.snc.sla.contract2) plugin. Installing the SLA Contract Add-on plugin adds relations to this table to make it useful for Service Management purposes. Once the plugin is installed, the Service Contract record possesses related lists for:
- SLAs
- Contract CIs
- Contract Locations
- Contract Groups
- Contract Users
- Child Contracts

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>A unique number associated with the contract.</td>
</tr>
<tr>
<td>Starts</td>
<td>The date on which the contract takes effect.</td>
</tr>
<tr>
<td>Ends</td>
<td>The date on which the contract expires.</td>
</tr>
<tr>
<td>Approver</td>
<td>The person who approves the contract.</td>
</tr>
<tr>
<td>Location</td>
<td>The primary location of the contract, if applicable. If there are multiple, use the Contract locations related list.</td>
</tr>
<tr>
<td>Active</td>
<td>Whether the contract is currently in use.</td>
</tr>
<tr>
<td>Automatically renew/extend</td>
<td>Whether the contract has the possibility of being renewed or extended at the end of its term.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The vendor responsible for the contract.</td>
</tr>
<tr>
<td>Vendor account</td>
<td>The account the vendor is responsible to.</td>
</tr>
<tr>
<td>Contract number</td>
<td>The number of the contract defining the Service Contract.</td>
</tr>
<tr>
<td>Total cost</td>
<td>The total cost of the contract.</td>
</tr>
<tr>
<td>Payment amount</td>
<td>The amount which has been paid so far.</td>
</tr>
<tr>
<td>Payment schedule</td>
<td>The duration at which payments are made.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Process non-contractual SLAs</td>
<td>If selected, you can have both contractual SLAs as well as non-contractual SLAs, such as OLA and Underpinning contracts, processed for the same task. You can track the contractual SLAs as well as any SLA that is internal to the organization to enhance compliance.</td>
</tr>
</tbody>
</table>

**Note:** The Process non-contractual SLAs check box is available for the zboot and upgrade customers. The system property `com.snc.sla.contract.tables` is not available for zboot customers so that contracts are processed for any table in the system instead of specific tables.

<table>
<thead>
<tr>
<th>Short description</th>
<th>A short description of the Service Contract.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>A full description of the Service Contract.</td>
</tr>
</tbody>
</table>

### Add contract field to task form

Depending on how the contract is used, the **Contract** field can be added to any task form by configuring the form. For information about how to configure a form, see *Form configuration*. As the **Caller**, **Assignment Group**, **Location**, and **Configuration item** fields are populated, the **Contract** field filters appropriately, helping the support desk to associate the ticket to the correct contract.

**Note:** Do not add the same field to different sections of a form unless the field displays read-only data. Having two or more instances of an editable field can cause data loss and prevent the proper functioning of UI and data policies.

### Service Level Management plugins

You can activate one or more of the Service Level Management plugins if they are not already active. Some plugins include demo data.

You can activate one or more of the following Service Level Management plugins.

### Activate Service Level Management

You can activate the Service Level Management plugin (com.snc.sla) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

Activating this plugin, provides the core SLA functionalities.

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in *Request a plugin*.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.
### Installed with Service Level Management

Activating the Service Level Management plugin adds or modifies these components: tables, properties, UI actions, UI policies, script includes, client scripts, business rules, email notifications, scheduled jobs, and workflows.

#### Tables installed with Service Level Management

Tables are added with Service Level Management.

<table>
<thead>
<tr>
<th>Display name (Table name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA Definition (contract_sla)</td>
<td>Provides the conditions, duration, and schedule for an SLA Definition.</td>
</tr>
<tr>
<td>SLA Conditions (sla_condition_class)</td>
<td>Defines how the conditions in the SLA Definition are used to determine the transitions between different stages of each task SLA.</td>
</tr>
<tr>
<td>SLA Repair Log(sla_repair_log)</td>
<td>Used to provide a log of when the SLA Repair function is set to action.</td>
</tr>
<tr>
<td>SLA Repair Log Entry (sla_repair_log_entry)</td>
<td>Extends syslog and stores the before or after values of a task SLA record that has been repaired.</td>
</tr>
<tr>
<td>Task SLA (task_sla)</td>
<td>Associates a task with the SLA Definition that applies to it.</td>
</tr>
<tr>
<td>SLA Timer Configuration (sla_timer_config)</td>
<td>Stores the timer configuration information.</td>
</tr>
<tr>
<td>SLA timer configuration mapping</td>
<td>Stores the Task SLA mapping information.</td>
</tr>
<tr>
<td>(sla_timer_config_mapping)</td>
<td></td>
</tr>
</tbody>
</table>

#### Roles installed with Service Level Management

Roles are added with activation of Service Level Management plugin.

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sla_admin</td>
<td>Users with this role have full administrative rights to the Service Level Management application</td>
<td>flow_operator</td>
</tr>
<tr>
<td>sla_manager</td>
<td>Users with this role can define SLA definitions and view SLA repair logs.</td>
<td>flow_operator</td>
</tr>
</tbody>
</table>

#### Scheduled jobs installed with Service Level Management

Scheduled jobs are added with Service Level Management.

---

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Scheduled job

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA update (already breached)</td>
<td>Refreshes the timings in task SLA records that have already breached. This is limited to task SLAs where the breach time is within the last 365 days. This job runs once a day.</td>
</tr>
<tr>
<td>SLA update (breach after 30 days)</td>
<td>Refreshes the timings in task SLA records where the breach time is more than 30 days away. This is limited to task SLA records where the breach time is within the next 365 days. This job runs every 5 days.</td>
</tr>
<tr>
<td>SLA update (breach within 1 day)</td>
<td>Refreshes the timings in task SLA records where the breach time is more than 1 hour away and less than 24 hours away. This job runs every hour.</td>
</tr>
<tr>
<td>SLA update (breach within 1 hour)</td>
<td>Refreshes the timings in task SLA records where the breach time is more than 10 minutes away and less than 1 hours away. This job runs every 10 minutes.</td>
</tr>
<tr>
<td>SLA update (breach within 10 min)</td>
<td>Refreshes the timings in task SLA records where the breach time is in the next 10 minutes. This job runs every minute.</td>
</tr>
<tr>
<td>SLA update (breach within 30 days)</td>
<td>Refreshes the timings in task SLA records where the breach time is more than 1 day away and less than 30 days away. This job runs once a day.</td>
</tr>
</tbody>
</table>

### Activate SLA Breakdown definitions

You can activate the SLA Breakdowns plugin (com.snc.sla.breakdowns) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

SLA Breakdowns plugin (com.snc.sla.breakdowns) activates these related plugins if they are not already active.

#### Plugins for SLA Breakdowns

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service level management</td>
<td>Provides the core SLA functionality. SLA Definitions provide conditions to start, pause, stop, cancel and reset Task SLAs against any Task type.</td>
</tr>
<tr>
<td>(com.snc.sla)</td>
<td>In addition, you can specify a schedule on the definition to define the working hours and also a workflow to run against each Task SLA which is typically used to generate notifications.</td>
</tr>
</tbody>
</table>

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Installed with SLA breakdown definitions

Several types of components are installed with the SLA breakdown definitions.

**Plugins installed with SLA breakdowns**

Plugins are added with activation of SLA breakdowns.

SLA breakdowns adds the following plugin.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA Breakdowns</td>
<td>com.snc.sla.breakdowns</td>
<td>Provides the ability to generate breakdown data for each Task SLA record. For example, the breakdown data for each Task SLA record can be generated by <strong>Assignment group</strong> or <strong>Assigned to</strong> field.</td>
</tr>
</tbody>
</table>

**Note:** You must have up-to-date versions of script includes **TaskSLAController** and **RepairTaskSLAController** before activating the plugin to ensure that breakdown data is generated correctly. If you have customized versions of either of these script includes, any customizations should be incorporated into the versions of these files from the most recent upgrade.

**Table installed with SLA breakdowns**

Tables are added with activation of SLA breakdowns.

SLA breakdowns adds the following tables.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA Breakdown Definition (sla_breakdown_definition)</td>
<td>A breakdown definition that is associated to a specific task type. For example, Incident.</td>
</tr>
<tr>
<td>SLA Breakdown Definition Field (sla_breakdown_definition_field)</td>
<td>A breakdown definition field (a child record of a breakdown definition). Each record defines a mapping between a field on the associated task table and the breakdown data table.</td>
</tr>
<tr>
<td>SLA Breakdown Definition to SLA Definition relation (sla_definition_sla_breakdown)</td>
<td>The relation between SLA Breakdown Definition and SLA Definitions.</td>
</tr>
<tr>
<td>SLA Breakdown Core (sla_breakdown_core)</td>
<td>The common columns for all SLA breakdown data tables. Each breakdown data table must extend this core table.</td>
</tr>
<tr>
<td>SLA Breakdown By Assignment (sla_breakdown_by_assignment)</td>
<td>Contains the breakdown records generated for each Task SLA record that has an associated breakdown definition.</td>
</tr>
</tbody>
</table>

Properties installed with SLA breakdowns

Properties are added with activation of SLA breakdowns.

SLA breakdowns adds the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.sla.breakdown_processor.log</td>
<td>Logging level for script include SLABreakdownProcessor. Type: Choice list Default value: Notice Location: SLA logging module</td>
</tr>
</tbody>
</table>

UI policy installed with SLA breakdowns

UI policies are added with activation of SLA breakdowns.

SLA breakdowns adds the following UI policies.

<table>
<thead>
<tr>
<th>UI policy</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make definition fields read only</td>
<td>SLA Breakdown Definition Field (sla_breakdown_definition_field)</td>
<td>Make read only any fields on the form that are from the parent SLA Breakdown Definition</td>
</tr>
<tr>
<td>UI policy</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hide 'Fieldname data' field</td>
<td>SLA Breakdown Definition Field</td>
<td>The ui policy hides the field “Fieldname data” from the form. This field is only used by scripts that dynamically update other fields on the form and which should not be modified through the UI.</td>
</tr>
<tr>
<td></td>
<td>(sla_breakdown_definition_field)</td>
<td></td>
</tr>
</tbody>
</table>

**Script includes installed with SLA breakdowns**

Script includes are added with activation of SLA breakdowns.

SLA breakdowns adds the following script includes.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLABreakdown</td>
<td>Base class that provides constants for SLA Breakdowns.</td>
</tr>
<tr>
<td>SLABreakdownDefinition</td>
<td>Extends SLABreakdownDefinitionSNC and in future releases can be used to override default functionality or provide additional methods. For the Madrid release, the script include is read only.</td>
</tr>
<tr>
<td>SLABreakdownDefinitionSNC</td>
<td>Provides methods for managing records in the sla_breakdown_definition table.</td>
</tr>
<tr>
<td>SLABreakdownDefinitionAJAX</td>
<td>Provides client callable methods used for managing records in the sla_breakdown_definition table.</td>
</tr>
<tr>
<td>SLABreakdownDefinitionBreakdownField</td>
<td>Extends SLABreakdownDefinitionBreakdownFieldSNC and in future releases can be used to override default functionality or provide additional methods. For the Madrid release, the script include is read only.</td>
</tr>
<tr>
<td>SLABreakdownDefinitionBreakdownFieldSNC</td>
<td>Provides methods that determine the available values for breakdown_field on the sla_breakdown_definition_field table.</td>
</tr>
<tr>
<td>SLABreakdownDefinitionSourceField</td>
<td>Extends SLABreakdownDefinitionSourceFieldSNC and in future releases can be used to override default functionality or provide additional methods. For the Madrid release, the script include is read only.</td>
</tr>
<tr>
<td>SLABreakdownDefinitionSourceFieldSNC</td>
<td>Provides methods that determine the available values for source_field on the sla_breakdown_definition_field table.</td>
</tr>
<tr>
<td>SLABreakdownDefinitionTaskTables</td>
<td>Extends SLABreakdownDefinitionTaskTablesSNC and in future releases can be used to override default functionality or provide additional methods. For the Madrid release, the script include is read only.</td>
</tr>
<tr>
<td>SLABreakdownDefinitionTaskTablesSNC</td>
<td>Provides the method that determines the available Task tables for breakdown definitions.</td>
</tr>
<tr>
<td>SLABreakdownProcessor</td>
<td>Extends SLABreakdownProcessorSNC and can be used to override default functionality or provide additional methods.</td>
</tr>
<tr>
<td>SLABreakdownProcessorSNC</td>
<td>Provides the methods for generating the breakdown data records for Task SLAs based on the available breakdown definition records.</td>
</tr>
</tbody>
</table>
Script include | Description
--- | ---
SLABreakdownUtils | Extends SLABreakdownUtilsSNC and can be used to override default functionality or provide additional methods.
SLABreakdownUtilsSNC | Provides utility methods used by some of the other SLA breakdown script includes.
TaskSLABreakdownUtils | Extends TaskSLABreakdownUtilsSNC and can be used to override default functionality or provide additional methods.
TaskSLABreakdownUtilsSNC | Provides methods for the task_sla table.

**Client scripts installed with SLA Breakdowns**

Client scripts are added with activation of SLA breakdowns.

SLA breakdowns adds the following client scripts.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide assignment breakdown reports</td>
<td>Task SLA (task_sla)</td>
<td>Hides the embedded charts on the Task SLA form when no breakdown data is available.</td>
</tr>
<tr>
<td>Set available breakdown tables</td>
<td>SLA Breakdown Definition (sla_breakdown_definition)</td>
<td>Populates the options in the sla_breakdown_table field.</td>
</tr>
<tr>
<td>Set fieldname data</td>
<td>SLA Breakdown Definition Field (sla_breakdown_definition_field)</td>
<td>Sets data into a hidden field which is then used by the field choice scripts that populate breakdown_field_name and source_field_name.</td>
</tr>
<tr>
<td>Show 2010 engine message</td>
<td>SLA Breakdown Definition (sla_breakdown_definition)</td>
<td>Displays a message on the form for instances that are running the 2010 SLA engine.</td>
</tr>
<tr>
<td>Show breakdown data exists message</td>
<td>SLA Breakdown Definition Field (sla_breakdown_definition_field)</td>
<td>Displays a message on the form to explain that fields are read only due to breakdown data existing.</td>
</tr>
<tr>
<td>Show breakdown data exists message</td>
<td>SLA Breakdown Definition (sla_breakdown_definition)</td>
<td>Displays a message on the form to explain that fields are read only due to breakdown data existing.</td>
</tr>
<tr>
<td>Update already defined task tables</td>
<td>SLA Breakdown Definition (sla_breakdown_definition)</td>
<td>Disables options in the task_table field for task types that already have a breakdown definition.</td>
</tr>
<tr>
<td>Warning on setting inactive</td>
<td>SLA Breakdown Definition (sla_breakdown_definition)</td>
<td>Prompts for confirmation when a breakdown definition is updated to be inactive.</td>
</tr>
</tbody>
</table>

**Business rules installed with SLA breakdowns**

Business rules are added with the activation of SLA breakdowns.

SLA breakdowns adds the following business rules.
<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear SLA Breakdown definitions cache</td>
<td>SLA Breakdown Definition to SLA Definition relation (sla_definition_sla_breakdown)</td>
<td>Clears the SLA breakdown definitions cache whenever a record is inserted, updated, or deleted.</td>
</tr>
<tr>
<td>Clear SLA Breakdown definitions cache</td>
<td>SLA Breakdown Definition Field (sla_breakdown_definition_field)</td>
<td>Clears the SLA breakdown definitions cache whenever a record is inserted, updated, or deleted.</td>
</tr>
<tr>
<td>Clear SLA Breakdown definitions cache</td>
<td>SLA Breakdown Definition (sla_breakdown_definition)</td>
<td>Clears the SLA breakdown definitions cache whenever a record is inserted, updated, or deleted.</td>
</tr>
<tr>
<td>Delete active breakdown data on inactive</td>
<td>SLA Breakdown Definition (sla_breakdown_definition)</td>
<td>Deletes any breakdown data records for active Task SLA records when the breakdown definition is updated to inactive.</td>
</tr>
<tr>
<td>Get breakdown table data</td>
<td>SLA Breakdown Definition (sla_breakdown_definition)</td>
<td>Populate data on the scratchpad that is required by client scripts.</td>
</tr>
<tr>
<td>Get SLA breakdown data</td>
<td>Task SLA (task_sla)</td>
<td>Populate data on the scratchpad that is required by client scripts.</td>
</tr>
<tr>
<td>m2mSLABreakdownRestrictBreakdownDefs</td>
<td>Global (global)</td>
<td>Script to restrict the available values in the sla_breakdown_definition column in many-to-many table sla_definition_sla_breakdown.</td>
</tr>
<tr>
<td>m2mSLABreakdownRestrictSLAs</td>
<td>Global (global)</td>
<td>Script to restrict the available values in the sla_definition column in many-to-many table sla_definition_sla_breakdown.</td>
</tr>
<tr>
<td>Process changes to tables</td>
<td>SLA Breakdown Definition (sla_breakdown_definition)</td>
<td>Perform additional processing when either the sla_breakdown_table or task_table is changed.</td>
</tr>
<tr>
<td>Process SLA Breakdowns</td>
<td>Task SLA (task_sla)</td>
<td>Creates and updates breakdown data whenever a Task SLA record is created or updated.</td>
</tr>
<tr>
<td>Set field values into scratchpad</td>
<td>SLA Breakdown Definition Field (sla_breakdown_definition_field)</td>
<td>Populate data on the scratchpad that is used by other business rules or client scripts.</td>
</tr>
</tbody>
</table>
Activate SLA timeline

You can activate the SLA timeline plugin (com.snc.sla.timeline) if you have the admin role. This plugin activates related plugins if they are not already active.

Role required: sla_admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Script includes installed with SLA timeline

When SLA timeline is activated, script includes are installed.

SLA timeline adds the following script includes.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLATimeline</td>
<td>This script include generates the timeline data for a task SLA record by replaying the task’s history and using the SLATimelineAPI to determine the appropriate stage transitions and timings for the task SLA.</td>
</tr>
<tr>
<td>SLATimelineAPI</td>
<td>This script include provides a number of functions that simulate how the SLA engine processes a particular task and SLA definition without actually creating any task SLA records.</td>
</tr>
<tr>
<td>SLATimeLineV2SNC</td>
<td>This script include is used by SLA Timeline internal REST API to inspect audit history of a Task and extract task SLA details to be presented on the UI.</td>
</tr>
<tr>
<td>ReadOnlyTaskSLAController</td>
<td>This script include is a helper script include and is for internal use. This script include is called by SLATimeLineV2SNC to process the task SLA stage details.</td>
</tr>
</tbody>
</table>

Activate Service Level Management - SLA Timer Config API

You can activate the Service Level Management - SLA Timer Config API plugin (com.sn.slm.timer) if you have the admin role. Activating this plugin provides the ability to set a preferred SLA for a given task through configuration which is dynamic, such as First SLA to breach, or declarative through a hierarchical mapping of first to match SLA definitions. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Installed with Service Level Management- SLA Timer Config API

The Service Level Management - SLA Timer Config API (com.sn_slm_timer) plugin installs the admin role.

Roles installed

<table>
<thead>
<tr>
<th>Role title</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_slm_timer.sla_timer_admin</td>
<td>Users with this role have full administrative rights to the Service Level Management timer configuration.</td>
<td>sn_sla_definition_read</td>
</tr>
</tbody>
</table>

Script Includes installed with SLA Timer Config API

When SLA Timer Config API is activated, script includes are installed.

SLA Timer Config API adds the following script includes.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLATimerConfigAPI</td>
<td>This script includes provides various functions to process and identify the task SLA that is about to breach.</td>
</tr>
</tbody>
</table>

Configure Service Level Agreement (SLA)

Configure SLAs to define a set amount of time for a task to reach a certain condition, to ensure that incidents are closed or resolved according to the expectations set for customers.

Service Level Agreement (SLA) definition

An SLA definition is used to create and progress SLAs, enabling you to use an SLA system for your organization’s tasks.

An SLA definition record defines the timings, conditions, workflows, and other information required to create and progress task SLAs.

For example, the default Priority 1 resolution (8 hour) SLA Definition defines the Task SLAs to attach to incidents with a P1 - Critical priority, specifies appropriate conditions for those Task SLAs, and...
uses the default SLA workflow to create events such as to send a notification, when an incident's Task SLA reaches 50% of its allotted time.

Create an SLA definition

You can create one or more Service Level Agreement (SLA) definitions and use them to create an SLA record. This SLA record enables you to use an SLA system for your organization's task.

When you create an SLA definition, avoid using dot-walked fields that change frequently in any of the SLA conditions (start, stop, pause, and reset). The SLA engine features, such as SLA Timeline and SLA Repair, replays the audit history of the Task record that the task_sla is attached to. The SLA engine does not replay the audit history of any dot-walked fields from that Task, rather only considers the final state of the dot-walk fields.

For example, a pause condition is set to an incident dot-walk field `incident.company.cost_center`. The value of the Cost Center is first set to Finance and later changed to Engineering. When the SLA repair runs, only the final value of the Cost Center is considered. So, if the SLA pause condition is `incident.company.cost_center is Engineering`, SLA Repair pauses immediately, because the SLA Repair does not consider the previous Cost Center value: Finance. This condition also applies to SLA Timeline (as well as when executing the SLA Engine asynchronously).

Now, if the requirement is to pause when `incident.company.cost_center is Engineering` and not `Finance`, then the audit history must be on the Task record using a custom field. Create a custom field (in this example on the incident table) such as: `u_company_cost_center` and a business rule to populate the field when either the company changes or the Cost Center of the company changes. In this approach, instead of setting the SLA pause condition to the dot-walked field, it is set against the custom field. The given approach ensures that the task_sla, SLA repair, and SLA Timeline always show the same results.

Note: The deeper the dot walk, the more business rules are required.

Role required: admin

1. Navigate to Service Level Management > SLA > SLA Definitions.
2. Click New.
   The SLA Definition form is displayed.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that identifies the SLA definition.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of agreement being defined: SLA, OLA, or Underpinning contract.</td>
</tr>
</tbody>
</table>
  **Note:** Type is used for reporting purposes only. |
| Target             | Select the target of the agreement being defined: None, Response, or Resolution. Target is used for filtering, searching, and reporting purposes only. |
  **Note:** This feature is available only in new instances starting with Jakarta or a later release. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table that determines the records tracked by the SLA. SLAs can be defined for any table that extends the task table, including incident, change request, and service catalog tasks.</td>
</tr>
<tr>
<td>Note:</td>
<td>Starting with the Helsinki release, you can and for Event Management.</td>
</tr>
<tr>
<td>Flow</td>
<td>Select the flow to run when the SLA definition attaches to a Task record. Selecting a flow disables the Workflow field.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Select the workflow to run when the SLA definition attaches to a Task record. Selecting a workflow disables the Flow field.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Select the vendor associated with the SLA definition.</td>
</tr>
<tr>
<td>Service Commitment</td>
<td>A flag that helps to differentiate between a normal SLA definition and a service offering SLA definition.</td>
</tr>
<tr>
<td>Enable logging</td>
<td>Check box to activate debug logging just for the specific SLA definition. The debug logging information includes details of the conditions that have matched or not matched. The information also provides the before and the after values for the task SLA and task records.</td>
</tr>
<tr>
<td>Duration type</td>
<td>Specify the method for calculating the duration of the SLA. The duration can either be a User specified duration, or a Relative Duration, such as Breach on Due Date or End of next business day.</td>
</tr>
<tr>
<td>Duration</td>
<td>Specify the length of time the SLA runs before it is marked Breached. This field appears when the duration is User specified duration.</td>
</tr>
<tr>
<td>Note:</td>
<td>The number of days specified in this field is converted to 24-hour blocks. If the Schedule field identifies a schedule with eight-hour days, a duration of 1 Day sets the SLA to breach three business days later.</td>
</tr>
<tr>
<td>Relative duration works on</td>
<td>Specify the record that the relative duration should be calculated for. Select either Task record or SLA record. This field appears only when the relative duration is specified.</td>
</tr>
<tr>
<td>Schedule source</td>
<td>Specify the schedule to be used when creating task SLAs. You can specify one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- No schedule: If the No Schedule option is selected, the SLA calculates the schedule duration based on a 24 x 7 schedule.</td>
</tr>
<tr>
<td></td>
<td>- SLA definition: If the SLA definition option is selected, the Schedule choice list appears.</td>
</tr>
<tr>
<td></td>
<td>- Schedule: Specify the hours during which the SLA timer runs.</td>
</tr>
<tr>
<td></td>
<td>- Task field: This option title is determined from the option selected in the Table field, for example, if the Incident option is selected in the Table field, this option becomes the Incident field. If the Task table field option is selected, the Schedule source field list appears.</td>
</tr>
<tr>
<td></td>
<td>- Schedule source field: Select the appropriate field from the task such as an incident or problem that provides the schedule. For example, Configuration item &gt; Schedule.</td>
</tr>
</tbody>
</table>
### Field Source

Specify the time zone source to be used when creating task SLAs. You can specify one of the following time zones:

- **The caller’s timezone.**
- **The SLA definition’s timezone:** If the **The SLA definition’s timezone** option is selected, the **Timezone** choice list appears.
  - **Timezone:** Specify a time zone for the SLA. The time zone can be the system time zone or active standard geographical time zones.
- **The CI location’s timezone.**
- **The task’s location’s timezone.**
- **The caller’s location’s timezone.**

### Tabs

**Start condition**

Define the conditions under which the SLA is attached.

For the **When to cancel** list, you can choose the conditions under which the SLA is canceled.

- **Start conditions are not met** option: If one or more of the specified start conditions change, the SLA is canceled. This option is selected by default.
- **Cancel conditions are met** option: The start condition must be met only once, thereafter the SLA is canceled only when the cancel condition is met.
- **Never** option: The SLA is never canceled.

**Retroactive start:** to choose a date and time field from the task that provides the start time of the task SLA. If you select the **Retroactive start** check box, the **Set start to** field and the **Retroactive pause time** check box appear.

- **Set start to** field: Offers the date and time fields available on the task type that this SLA definition applies to. For example, if you select **Retroactive start** on a Priority 1 SLA definition and then select the **Retroactive pause time** check box, the SLAs that have enabled retroactive start can recover prior to the pause time.

**Note:** The **Retroactive pause time** check box is available only when the duration is a user-specified duration.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Pause condition        | Define the conditions under which the SLA suspends increasing elapsed time. From the **When to resume** list, you can choose the conditions under which the SLA resumes increasing elapsed time.  
  - **Pause conditions are not met** option: If one or more of the specified pause conditions no longer match, the elapsed time continues to increase. The **Pause conditions are not met** option is selected by default.  
  - **Resume conditions are met** option: If one or more of the specified resume conditions match, the elapsed time continues to increase. |
| Stop condition         | Define the conditions under which the SLA completes. If all these conditions match, then the task SLA completes regardless of whether it is breached. |
| Reset condition        | Determines whether the existing task is canceled or completed on task SLA reset. Defines the conditions under which the running SLA is canceled or completed and a new SLA is attached. For a new SLA to be attached, the start condition must match.  
  Reset condition also helps to configure SLAs when the value of any specific field on the task record changes, changes to, or changes from a specific value. For example, the value of the **Location** field in the task record is 101 Broadway East, Seattle, WA. If you set the SLA reset condition as **Location changes from** 101 Broadway East, Seattle, WA, any change in the value of the **Location** field resets the SLA of the task record. |
| Fields that can be added by configuring the form |  |
| Condition type         | Select the condition type to determine when an SLA attaches, pauses, completes, or resets. |

### Flows for SLA

Use the flow actions to send SLA notifications when the duration specified in the SLA definition is crossed.

You can create and edit flows using the Flow Designer. The default flow that is available with the Service level management plugin is **Default SLA flow**.

The **Default SLA flow** creates the events that send out notifications. For example, it creates an event to send a notification to the user assigned to a task, such as an incident, when the task SLA reaches 50% of its allotted time.

The **SLA Notification and Escalation flow** creates the events that send out notifications. When a task reaches 50% of its allotted SLA duration, a notification is sent to the assignee and the user listed in the **Supported by** field on the configuration item. At 75% and 100%, a notification is sent to the assignee and the assignee's manager.

**Note:** This feature is available only in new instances starting with Orlando or a later release.

### Workflows for SLA

SLA typically uses workflows to send notifications.
You can create and edit workflows with the Workflow Editor. The default workflow that is available with the Service level management plugin is **Default SLA Workflow**.

The **Default SLA Workflow** creates the events that send out notifications. For example, it creates an event to send a notification to the user assigned to a task, such as an incident, when the task SLA reaches 50% of its allotted time.

The **SLA Notification and Escalation Workflow** creates the events that send out notifications. When a task reaches 50% of its allotted SLA duration, a notification is sent to the assignee and the user listed in the **Supported by** field on the configuration item. At 75% and 100%, a notification is sent to the assignee and the assignee’s manager.

**Note:** This feature is available only in new instances starting with Jakarta or a later release. The Problem Management Best Practice ± Jakarta plugin (com.snc.best_practice.problem.jakarta) plugin must be activate.

### SLA duration types

You can select one of two SLA duration types to define the length of time within which a task must be completed before the SLA is breached. If an SLA schedule is defined, the duration works along with the schedule. In a user-specific duration, you can choose to specify the length of time that an SLA must run before it is marked as breached. Relative durations specify durations that are relative to the start time of the task SLA and are defined using a script.

When you define an SLA, you can select either a **user specified duration** or a **relative duration**.

**User specified duration**

Specifies a static duration period, such as 8 hours, along with a business schedule. The **Duration** field is displayed, enabling you to specify the length of time in days, hours, minutes, and seconds that the SLA must run before it is marked as **breached**. The number of days specified in the **Duration** field is converted to 24-hour blocks.

Each time that you set a duration, an example breach time information message is displayed at the top of the form. This information assists you in understanding how the breach date is calculated. For example, if the current date is January 1, 2015, the time is 10:30 am, and the duration is set to 10 hours and no schedule has been selected, the following information message is displayed: **An SLA starting now will end breach on 2015-01-01 20:30** (Actual elapsed time: 10 Hours).

**Relative duration**

Specifies a duration relative to the start time of the task SLA and is defined using a script. For example, you can select a relative duration such as **Breach on Due Date**, **End of next business day** or **Next business day by 4pm**. The set of relative durations is defined in the core configuration using script-based duration calculations.

**Note:** Pause conditions are not compatible with relative durations.

You can use a relative duration within the Service Level Management application in the following ways:

- Specify a relative duration.
- Relative duration usage scenarios.

**Specify a relative duration**
To specify a relative duration, select an option such as **Next business day by 4pm** or **End of next business day** from the list of available relative durations in the **Duration type** field.

When you select a relative duration such as **Next business day by 4pm**, the **Relative duration works on** field appears. You can specify the record that the relative duration should be calculated for. You can select to use **Task record** or **SLA record** and the record you select is available as **current** for the relative duration script.

**Note:** If a relative duration is selected, the example breach date information message is not displayed.

If your task record has a target date and time field, you can create an SLA with a relative duration based on that field.

**Relative duration usage scenarios**

If a schedule is selected in the SLA definition, the SLA duration works with the SLA schedule. For example, an SLA might have a user-specified duration of **16 hours** with the schedule as **8-5 weekdays**. If this SLA starts to run for a task at 8:00, it breaches at 17:00. The breach time is calculated from the schedule that defines working time as eight hours per day from Monday to Friday. So the 16-hours duration equates to two days later in the schedule.

The **Breach on Due Date** sets the breach time of the SLA to the date and time from the **Due Date** field of the task that the SLA is attached to.

If the **Due Date** field is empty or occurred in the past, the breach time of the task SLA is calculated to be one second ahead of the task SLA start time. If the date and time in the **Due Date** field is outside the schedule for the task SLA, the breach time is set to the next available scheduled time. For example, if the SLA definition specifies a task SLA schedule as 08:00-17:00 and the value in the **Due Date** field is **Wednesday 11th Jan 2017 20:30**, the breach time is set to **Thursday 12th 2017 Jan 08:00**.

If your task record has a target date and time field, you can create an SLA with a relative duration based on that field.

**Schedules within SLA**

Schedules within SLA enable you to define the time periods during which the SLAs accumulate business time.

Schedules are typically based on the working hours of the resource or departments to whom a task is allocated. When you define an SLA, you can select a schedule during which the SLA will accumulate business time. You can specify the schedule that each SLA must use in the SLA definition form.

**Schedules in SLA definitions**

You can specify the schedule to be used when creating new task SLAs in the **Schedule source** field. You can specify one of the following options:

- **No schedule**: If the **No Schedule** option is selected, the SLA will calculate based on a 24 x 7 schedule.
- **SLA definition**: If the **SLA definition** option is selected, the Schedule drop-down list appears.
  - **Schedule**: Specify the hours during which the SLA timer runs. These set of schedules are defined in the core configuration. For example, you can select a schedule of **8-5 weekdays** or **8-5 weekdays excluding holidays**.
- **Task table field**: This option picks its title from the option selected in the Table field earlier on the SLA Definition form. For example, if Incident is selected in the Table field, then this option appears as Incident field. If the Task table field option is selected, the Schedule source field drop-down list appears.

- **Schedule source field**: Select the appropriate field from the task such as an incident or problem that will provide the schedule. For example, Configuration item > Schedule.

### SLA duration and schedules

Schedules have an impact on the duration specified in an SLA definition. This impact is reflected in the timings that are taken into consideration while calculating an SLA.

**Note**: If a schedule is not selected for an SLA, the SLA will run 24X7.

Consider a scenario where you select a duration of one day, which is 24 hours, and a schedule of 9 am to 5 pm, which is 8 hours. The SLA calculation will distribute the 24 hours across three working days of 8 hours each. So a team working on a task associated with this SLA has 3 days to complete the task before the SLA is breached.

![Slab.png](attachment:Slab.png)

### Time zones in SLAs

You can specify the geographical time zone that is used for schedule calculation.

Specify the time zone source to be used when creating task SLAs. You can select one of the following options:

- **The caller’s timezone**: If this option is selected and the caller has not selected a time zone, then the system time zone is used.

- **The SLA definition’s timezone**: If the The SLA definition’s timezone option is selected, the Timezone list appears.
- **Timezone**: Specify a time zone for the SLA. The time zone can be the system time zone or active standard geographical time zones.

- **The CI location’s timezone**
- **The task location’s timezone**
- **The callers’ location’s timezone**

**Note**: If you select a time zone source other than the **The SLA definition’s timezone** and the time zone derived from the time zone source is empty, the system time zone is used.

### SLA conditions

SLA conditions determine when a task SLA record is attached, paused, resumed, reset, canceled, and completed.

On the SLA definition, you specify up to six conditions that are evaluated each time a task record is created or updated. For example, for an SLA to attach to a task, the start conditions must match and stop conditions must not match.

SLA conditions work in the following ways:

- **SLA conditions**
- **SLA condition evaluation**

### SLA conditions

You can set up to six SLA conditions: start, cancel, pause, resume, stop, reset.

**Start condition**

Enables you to define the conditions under which the SLA will be attached.

You can choose the conditions from the **When to cancel** list under which the SLA will be canceled.

- **Start conditions are not met** option: If one or more of the specified start conditions change, then the SLA will be canceled. The **Start conditions are not met** option is selected by default.
- **Cancel conditions are met** option: The start condition has to be met only once, thereafter the SLA will only cancel when the cancel condition is met.
- **Never** option: The SLA will never be canceled.

- Select **Retroactive start** to choose a date and time field from the task that will provide the start time of the task SLA. If you select the **Retroactive start** check box, the **Set start to** field appears offering the date and time fields available on the task type that this SLA definition applies to. For example, if you select **Retroactive start** on a Priority 1 SLA definition and then choose **Created** in the **Set start to** field, then the SLA is attached with the start time being the date and time from the **Created** field on the Incident.

**Cancel condition**

Enables you to define the conditions under which the SLA will cancel. You can specify the cancel conditions at the same time when you specify the start conditions.

**Pause condition**

Enables you to define the conditions under which the SLA will suspend increasing elapsed time.
You can choose the conditions from the **When to resume** list under which the SLA will resume increasing elapsed time.

- **Pause conditions are not met** option: If one or more of the specified pause conditions no longer match, then the elapsed time will continue to increase. The **Pause conditions are not met** option is selected by default.
- **Resume conditions are met** option: If one or more of the specified resume conditions match, then the elapsed time will continue to increase.

**Resume condition**

Enables you to define the conditions under which the SLA will resume increasing elapsed time. You can specify the resume conditions at the same time when you specify the pause conditions.

**Stop condition**

Enables you to define the conditions under which the SLA completes. If all of the specified stop conditions match, then the task SLA will complete regardless of whether it is breached.

**Reset condition**

Enables you to define the conditions under which the running SLA will be completed and a new SLA will be attached. For a new SLA to be attached, the start condition must match.

Reset condition also helps to configure SLAs when the value of any specific field on the task record changes, changes to or changes from a specific value in the record. For example, the value of the **Location** field in the task record is 101 Broadway East, Seattle, WA. If you set the SLA reset condition as **Location changes from** 101 Broadway East, Seattle, WA, any change in the value of the **Location** field resets the SLA of the task record.

**SLA condition evaluation**

Every task in the system is evaluated in the following order:

- **Process new SLAs**: Determine if a new SLA record must be attached to a task
- **Process existing SLA records attached to a task**.

SLA conditions are evaluated in the following ways:

- **Attach** if start condition matches and both the stop and cancel conditions don’t match.
- **Complete** if the stop condition matches.
- **Pause** if the pause condition matches.
- **Resume** if the pause condition doesn’t match or resume condition matches.
- **Reattach** if both the reset and the start conditions match.
- **Cancel** if the start condition doesn’t match or cancel conditions matches.

Consider this evaluation order when you create conditions. For example, if your Start condition is a subset of your Stop condition, the Stop condition will always match when the Start condition matches and the SLA will never attach. This includes processing any new SLAs that were just created.

Similarly, if your Pause condition is a subset of your Start condition, the SLA will attach but will permanently be in Paused state. As soon as the Pause condition does not match, the equivalent Start condition will also not match and that task SLA record will be canceled.
In addition, if you create a SLA definition with a Start condition and a Pause condition that are mutually exclusive, your SLA will never pause but will always be canceled first. For example, for an SLA definition where the Start condition is **State is one of “New, Active”** and the Pause condition is **State is “On Hold”**, when the Task is updated to state **On Hold**, the start condition will no longer match and the task SLA will be canceled.

### SLA transitions

SLA records pass through a series of transitions during processing.

The following transitions exist for an SLA:

- **Attach**: when an SLA is created and bound to a task.
- **Pause**: when an SLA should temporarily stop tracking time.
- **Resume**: when an SLA should resume tracking elapsed time.
- **Complete**: when an SLA is marked complete.
- **Reattach**: when an SLA is marked completed and a new copy is reapplied.
- **Cancel**: when an SLA is cancelled.

SLA conditions determine what action is performed on a task SLA record.

<table>
<thead>
<tr>
<th>SLA condition</th>
<th>Resultant action on task SLA record</th>
</tr>
</thead>
<tbody>
<tr>
<td>If Start condition matches and both Stop and Cancel conditions don’t match</td>
<td>Attach</td>
</tr>
<tr>
<td>If Start condition matches, and When to Cancel is set to Start conditions are not met</td>
<td>Cancel if one or more of the specified start conditions no longer match.</td>
</tr>
<tr>
<td>If Start condition matches, and When to Cancel is set to Cancel conditions are met</td>
<td>Cancel when cancel conditions match.</td>
</tr>
<tr>
<td>Pause condition matches</td>
<td>Pause</td>
</tr>
<tr>
<td>If Pause condition matches, and When to Resume is set to Pause conditions are not met</td>
<td>Resume if one or more of the specified paused conditions no longer match.</td>
</tr>
<tr>
<td>If Pause condition matches, and When to Resume is set to Resume conditions are met</td>
<td>Resume if one or more of the specified resume conditions match.</td>
</tr>
<tr>
<td>Start and Reset</td>
<td>Reattach</td>
</tr>
<tr>
<td>Stop</td>
<td>Complete</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancel</td>
</tr>
</tbody>
</table>
SLA condition methods when the default cancel and resume conditions are selected
SLA Conditions Methods when the cancel and resume conditions are selected

Each of these conditions is defined as a method within a Script Include, referenced by an SLA Conditions Rule record.

**SLA condition rules**

SLA condition rules control how the different conditions you define in an SLA definition are combined to determine whether an SLA should attach, pause, complete, reattach, or cancel.

The way that the conditions in an SLA definition are interpreted, to control transitions in state, can be varied using SLA Condition Rules. SLA Condition Rules are defined globally, and can be overridden for specific SLA definitions.

**SLAConditionBase** is the default set of SLA condition rules.
Navigate to Service Level Management > Administration > SLA Condition Rules to see a list of SLA condition records.

**SLAConditionBase script**
The SLAConditionBase script includes implements the default SLA transitions.
The SLAConditionBase script includes implements the default SLA condition processing.

To view the script, navigate to Service Level Management > Administration > SLA Condition Rules, then click on the SLAConditionBase entry to view details. The record in the Class name field is the script include that defines the condition processing.

**Note:** We recommend you do not modify this script, but use it as an example for creating your own script includes.

The following diagram shows how the transitions work:

![Diagram showing SLA stage transitions for SLAConditionBase](image-url)

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**SLAConditionSimple script**

The **SLAConditionSimple** script include provides an example modification of default SLA condition processing.

The **SLAConditionSimple** script include is one of the default supplied SLA condition rules. This shows an example of how you can modify and extend condition processing, by overriding the SLAConditionBase methods, with a ‘simple’ variation that interprets each condition to match a particular transition. For example, for an SLA to attach only the start condition is checked. This affects attach, reattach, and cancel.

To edit this script, navigate to **Service Level Management > Administration > SLA Condition Rules**, then click on the **SLAConditionSimple** entry to view or modify details. Click **Class name** field to open the script include that defines the condition processing.

The following diagram shows how the transitions work:

**Task SLA stage transitions**

**SLAConditionSimple**

(optional, 2011 version)

---

**SLAConditionSimple**

*Extend SLA condition rules*

You can create custom SLA condition class and condition rule records.
Custom SLA condition class and condition rule records enable you to modify the logic around one or more of the transitions involved in task SLA processing. The custom records can then be applied globally to the processing of all task SLA records or on a per SLA definition basis.

Create a custom SLA condition rule

You can create custom SLA condition rules to determine whether an SLA should attach, pause, complete, reattach, or cancel. SLA condition classes contain script to define processing for an SLA condition rule. Create an SLA condition rule after the SLA condition class is defined.

1. **Define an SLA Condition Class.**
   
   Navigate to **System Definition > Script Includes** and click **New**.
   
   Within the script in the SLA Condition Class, provide methods to modify one or more of the default SLA transitions (attach, pause, complete, reattach, cancel), defining the conditions for SLA processing. For example, the `attach` method defines when an SLA is created and attached to a task. The methods need to test a condition, referencing the condition fields on the SLA Definition form.

2. **Create an SLA Condition Rule.**
   
   a) Navigate to **Service Level Management > SLA Condition Rules** and click **New**.
   
   b) Name the SLA Condition Rule.
   
   c) Select the Script Include defined above in the **Class Name** reference field.

**Example of an SLA Condition Class**

For example, including the following method in an SLA Condition Class attaches the SLA if its condition matches the SLA’s `start_condition` field:

```javascript
attach: function() {
    return (this._conditionMatches(this.sla.start_condition));
},
```

The following is an example which shows the format of a script include that would extend the `SLAConditionBase` class and provide methods for each of the SLA transitions:

```javascript
var SLAConditionLocal = Class.create();
SLAConditionLocal.prototype =
Object.extendsObject(SLAConditionBase, {
    attach: function() { // insert script here
    },
    pause: function() { // insert script here
    },
    complete: function() { // insert script here
    },
    reattach: function() { // insert script here
    },
    cancel: function() {
```

© 2020 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Invoke an SLA condition rule globally
You can globally change the default set of SLA condition rules.

By default, the SLAConditionBase is used for the SLA condition rules. This can be changed by doing the following:

1. Navigate to **Service Level Management > SLA Properties**.
2. Change the value of the **com.snc.sla.default_conditionclass SLA property** to the new condition rule name:

   ```
   The name of the Script Include class that will be used to evaluate SLA Conditions for the 2011 SLA engine (use to override with your own extension of the SLAConditionBase class)
   SLAConditionBase
   ```

   **Note**: This is the default condition rule, if no condition rule is specified on an SLA definition.

Invoke SLA condition rules on a specific SLA definition
You can change the SLA condition rules for a specific SLA definition.

In cases where a particular SLA requires that specific SLA condition rules should be used, you can specify the condition rule to be used within the relevant SLA definition form,

1. Navigate to **Service Level Management > SLA > SLA Definitions**.
2. Open an SLA definition record.
3. Configure the form to add the **Condition type** field to the form.
4. Specify the appropriate SLA condition rule in the **Condition type** field

   **Note**: If no condition rule is defined, the global default condition rule is used.

Use SLA retroactive start and pause
You can use retroactive start to retain timing information for an SLA when a task record changes. Retroactive pause prevents immediate breaches and notifications when retroactive start is enabled for SLA definitions.

When a task record changes, typically a new SLA may be attached, with a new set of timing information. This is useful if you are re-assigning an incident to another group and want to attach a new SLA record with new timing information.

However, you may want to retain time information for the task in specific situations. For example, an incident is raised with a priority of **3 - Moderate** and the priority changes to **1 - Critical** after 3 hours. A priority 1 SLA is attached to the incident at that time. You can use retroactive start to ensure this SLA timing is adjusted retroactively to count from when the incident was first created, rather than from when the incident's priority changed. This reflects the actual time the user contacted you.
You can use the retroactive pause property to apply pause times to the new SLA.

1. Navigate to Service Level Management > SLA > SLA Definitions.
2. Open the relevant SLA definition record.
3. In the Start Condition section, select the Retroactive start check box.
4. From the Set start to, select the event from which the SLA starts.
   This option determines the start time used for every task SLA record created from this SLA definition.
   For example, you can select Opened to start the SLA from when the task form was initially opened to create the record, which accurately reflects the time the end user contacts the service desk. Alternatively, you can select Created to start the SLA from when the task form was initially saved.
5. To enable the retroactive pause property, select the Retroactive pause check box.
   Enabling this property ensures that the new task SLA record gets any pause time that would have been accumulated during the period between the retroactive start time and now. This pause time increases the breach time with the appropriate amount.
6. Click Update.

When retroactive start is enabled, it may result in task SLAs being breached as soon they attach, which will trigger multiple notifications. To prevent the workflow from being processed for these breached SLAs, set the com.snc.sla.workflow.run_for_breached property to false.

**Configure Service Level Agreement (SLA) properties**

You can configure the SLA engine, logging, and repair properties based on the requirements within your organization.

Role required: admin

1. Navigate to Service Level Management > Properties.
2. Select one of the following:
   - **SLA Engine**
     configure properties for the SLA engine.
   - **SLA Logging**
     configure logging properties for SLA Script Includes and logging output destination.
   - **SLA Repair**
     configure properties for the SLA Repair process.

**SLA engine properties**

Administrators can manage the SLA engine using SLA engine properties.

Navigate to Service Level Management > Properties > SLA Engine to view SLA engine properties.
## SLA Engine Properties

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **com.snc.sla.calculation.percentage**           | Maximum 'Actual elapsed percentage' value after which the 'SLA - update calculations' scheduled job will stop regularly calculating the SLA's time values. This is used to prevent 'long since breached' records from being unnecessarily updated. Setting to '0' will stop all calculations and leaving this blank will allow all SLAs to be calculated. By default, this is set to 1,000%, so that recalculation stops after the breach is exceeded by a factor of 10.  
  - Type: integer  
  - Default value: 1000 |
| **com.snc.sla.maximum_duration**                 | Maximum duration in days that is allowed in the SLA definition.  
  - Type: integer  
  - Default value: 1095 |
| **com.snc.sla.engine.version**                   | Run the 2011 SLA engine (2010, 2011)  
  - Type: choice list  
  - Default value: 2011 |
| **com.snc.sla.engine.async**                     | Run the 2011 SLA engine asynchronously after task insert or update operations.  
  - Type: true | false  
  - Default value: false |
| **com.snc.sla.compatibility.breach**             | Enable compatibility with 2010 'breached' status of SLAs (default: false)  
  Only enable if you require the old way of showing breached status (in the stage value), for reporting purposes. Using only the 'breached flag' is preferred  
  - Type: true | false  
  - Default value: false |
| **com.snc.sla.default_conditionclass**           | The name of the Script Include class that will be used to evaluate SLA Conditions for the 2011 SLA engine (use to override with your own extension of the SLAConditionBase class)  
  - Type: String  
  - Default value: SLAConditionBase |
<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.sla.workflow.run_for_breached</td>
<td>An update to a Task can result in an SLA being attached that is already breached - for example when an Incident that has already been open for a while is upgraded to a high priority with a short resolution SLA. By default if there is a workflow specified in the SLA Definition it will not run if the Task SLA is attached and the Planned End Time has already passed. Enable this property if you would like the workflow to run for a Task SLA that is already breached when it is attached to the Task.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
</tbody>
</table>
| com.snc.sla.calculate_planned_end_time_after_breach | Continue to re-calculate the ’Planned End Time’ of SLAs after they have breached  

• Type: true | false  

• Default value: false  |

| com.snc.sla.calculation.use_time_left         | Use field business_time_left to calculate breach time instead of business_percentage field. Using business_time_left is more accurate because the business_percentage field is rounded to 2 decimal places. This means that once the business percentage reaches 99.995%, it is recorded as 100%, and the task SLA is marked as breached.  |
|                                                 | • Type: true | false  |
|                                                 | • Default value: false                                                                                                                             |
| glide.sla.calculate_on_display                | Recalculate Task SLA records when a Task form is displayed. This ensures that the task SLAs calculations are up to date but this may increase form load time.  |
|                                                 | • Type: true | false  |
|                                                 | • Default value: false                                                                                                                             |
### SLA logging properties

Administrators can configure SLA logging using SLA properties.

Navigate to **Service Level Management > Properties > SLA Logging** to view SLA logging properties.

The **Logging level for...** properties set logging levels for relevant script includes. This allows you to activate extra logging targeted at whenever that script include is invoked via a task SLA. For example, if you know of an issue with the `TaskSLAWorkflow` script include, you can use the `com.snc.sla.workflow.log` property to enable logging on that script include. These properties are all set to **Notice** level by default.

#### SLA Logging Properties

<table>
<thead>
<tr>
<th>SLA Logging Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>com.snc.sla.task_sla_controller.log</code></td>
<td>Logging level for TaskSLAController</td>
</tr>
<tr>
<td><code>com.snc.sla.task_sla.log</code></td>
<td>Logging level for TaskSLA</td>
</tr>
<tr>
<td><code>com.snc.sla.condition.log</code></td>
<td>Logging level for SLAConditionBase</td>
</tr>
<tr>
<td><code>com.snc.sla.workflow.log</code></td>
<td>Logging level for TaskSLAWorkflow</td>
</tr>
<tr>
<td><code>com.snc.sla.calculatorng.log</code></td>
<td>Logging level for SLACalculatorNG</td>
</tr>
<tr>
<td><code>com.snc.sla.repair.log</code></td>
<td>Logging level for SLARepair (<em>SLA repair</em> must be enabled to use this)</td>
</tr>
<tr>
<td><code>com.snc.sla.log.destination</code></td>
<td>Logging output destination. Adjust the log destination: either output to both the Database and node logs (the default), or output to node logs only.</td>
</tr>
</tbody>
</table>

#### Logging levels

The following logging levels are available for the **Logging level for...** properties:
### Logging Levels

<table>
<thead>
<tr>
<th>Level</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emerg</td>
<td>Emergency</td>
<td>Total failure.</td>
</tr>
<tr>
<td>Alert</td>
<td>Alert</td>
<td>System corruption of a database, for example.</td>
</tr>
<tr>
<td>Crit</td>
<td>Critical</td>
<td>Typically used for hardware errors, for example.</td>
</tr>
<tr>
<td>Err</td>
<td>Errors</td>
<td>Errors</td>
</tr>
<tr>
<td>Warning</td>
<td>Warnings</td>
<td>Warnings</td>
</tr>
<tr>
<td>Notice</td>
<td>Notice</td>
<td>Possible action required but not essential.</td>
</tr>
<tr>
<td>Info</td>
<td>Informative</td>
<td>No action required.</td>
</tr>
<tr>
<td>Debug</td>
<td>Debugging</td>
<td>Generally not used except for capturing everything for fault-finding.</td>
</tr>
</tbody>
</table>

**Note:** By default, logging levels are set to Notice

### SLA repair properties

Administrators can manage the SLA repair function using system properties.

Navigate to **Service Level Management > Properties > SLA Repair** to view SLA repair properties.

#### SLA repair properties

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.sla.repair.enabled</td>
<td>Enable SLA repair. When enabled the Repair modules and UI Actions will be activated.</td>
</tr>
<tr>
<td></td>
<td>• Type: true / false</td>
</tr>
<tr>
<td></td>
<td>• Default value: true for new instances and false for upgraded instances</td>
</tr>
<tr>
<td>com.snc.sla.repair.use_repair_workflow</td>
<td>When repairing SLAs, use the Repair workflow instead of the one configured on the SLA Definition.</td>
</tr>
<tr>
<td></td>
<td>• Type: true / false</td>
</tr>
<tr>
<td></td>
<td>• Default value: false for new instances, true for upgraded instances</td>
</tr>
<tr>
<td></td>
<td>• Learn more: <a href="#">Configure SLA repair</a></td>
</tr>
</tbody>
</table>
### Service Level Agreement (SLA) process example

As work is done on the relevant task, the SLA may change stage appropriately, depending on the information defined for that SLA in the relevant SLA definition.

For example, if an incident is resolved within the time specified, the SLA stage is typically set to **Complete**.

Similarly, if the incident does not reach the required condition within the set amount of time, the Task SLA record associated to that Incident marked as **Has Breached**. For example, by default, if a P1 incident is not resolved within 8 hours, the Task SLA for that incident will have **Has Breached** set to **true**.

This example demonstrates how an SLA can be attached to an incident, then progressed to completion.

1. Navigate to **Incident > Create New**.
2. Set both **Impact** and **Urgency** to **1**. This changes the **Priority** to **1 - Critical**.
3. Save the form.

   The **Task SLA** Related List should now have a Priority 1 SLA attached to this incident.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
4. Change the **Impact** to 2, which changes the **Priority** to **2 - High**, then save the form. The **Priority 1 SLA** is now marked **Cancelled**, and a **Priority 2 SLA** has been attached, because of the conditions on the SLAs.

5. Change the **Incident State** to **Awaiting User Info**, then save the form. **Awaiting User Info** is a **Pause** condition on the **Priority 2 SLA**, so the SLA is marked **Paused**.

    **Note:** The **pause duration on Task SLA gets updated only after the SLA moves out of pause.**

6. Change the **Incident State** to **Active**, then save the form. Because the incident is no longer in a **Pause** condition, it resumes timing.
7. Enter any **Close code** and **Close notes** values in the **Closure Information** section of the incident.

8. Change the **Incident State** to **Resolved**, then save the form. The SLA is marked **Completed**.

---

**Add custom business rules to Service Level Agreement (SLA)**

You can add custom business rules to your SLAs.

**Role required:** admin

Select one of the following methods to add custom business rules.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use setWorkflow(false)</td>
<td>1. Prior to updating your task, add a call to setWorkflow(false) on the GlideRecord object for the task within the business rule that is updating the task. This prevents the business rules from being processed.</td>
</tr>
</tbody>
</table>

**Note:** The setWorkflow(false) disables processing of all engines and the update does not appear in the audit history of the task.

For example, a script that copies the breach time to a custom field on the task.

```javascript
(function(){
  if (current.planned_end_time.changes()) {
    var taskGr = current.task.getRefRecord();
    taskGr.u_sla_breach_time = current.planned_end_time;
    taskGr.setWorkflow(false);
    taskGr.update();
  }
}());
```
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create a sys_trigger (Schedule job) to update the task | In your custom business rule, use the Script field to generate a scheduled job to update the task. To ensure that the scheduled job is queued for processing immediately, it must be of type Run once, and have next action time of Now.  

**Note:** The ScheduleOnce script includes includes functions to specify the target record and when to run the scheduled job. This enables you to specify the script to be executed and call another function to create the appropriate record in the sys_trigger table.  

For example, a script to create a scheduled job that copies the breach time from the task SLA to a custom field on the task.

```plaintext
(function(){
  if (current.planned_end_time.changes()) {
    var scheduleJob = new ScheduleOnce();
    scheduleJob.setDocument(t.task.getRefRecord());
    scheduleJob.script = "current.u_sla_breach_time.setValue('"
                        + current.getValue('planned_end_time') + "');current.update();";
    scheduleJob.schedule();
  }
})();
```

---

**Add custom business rules to Service Level Agreement (SLA) considerations**

Prior adding custom business rules to the task SLA table, you must consider a few points regarding the processing and calculation of the task SLA based on your organization’s needs.

**Add custom fields to the task SLA table**

You can add custom fields to the task SLA table and write business rules to populate them. This does not impact the SLA engine. However, you must consider performance implications, if any, of these business rules since task SLAs are updated frequently during their lifecycle.
Points to consider

- Business rule that directly updates the parent task when an SLA is updated.
  
  Avoid writing a business rule on the task SLA table that updates the parent task directly. Doing so causes recursive processing of the business rules. This is represented in the diagram.

- Business rule that updates the default fields on a task SLA.
  
  Avoid writing a business rule on the task SLA table that updates the default fields. These default fields are managed and updated by the SLA engine, and any updates made to them might result in the following.
  - Fields being ignored, overwritten, or both the next time the SLA is calculated.
  - Incorrect calculations of other values on the task SLA.

Service Level Agreement (SLA) breakdown definitions

Using SLA breakdown, the service owner or service desk manager can see detailed task ownership and SLA duration related data for any task SLA record associated with a task. This helps determine which teams and users are contributing to SLA compliance. SLA breakdown is configurable and typically should be configured for the more significant SLAs such as P1 and P2 resolution.

By default, the system deletes SLA breakdown data that is more than one year old. This is performed by a new table cleanup job `sla_breakdown_by_assignment`. Table cleanup jobs are defined in the `sys_auto_flush` table.

Create SLA breakdown definitions

You can define an SLA breakdown to capture, store, and relay detailed task ownership information and duration for all task SLA records related to a specific task (incident). SLA breakdown is configurable and you can configure it on the basis of a specific SLA definition.

Role required: admin

SLA breakdown data includes:

- Task SLA
- SLA Definition
- Assigned to
- Assignment Group
- Start time
- End time
- Business time during this period
- Total % of allocated SLA Duration
- Whether the Task SLA is breached during this period

![Note: SLA breakdown is on a per task-type basis. For example, once you define a breakdown definition for Incident that uses the breakdown table (SLA Breakdown by Assignment), you cannot define another breakdown definition for this task type.]

SLA breakdown by assignment

1. Navigate to Service Level Management > Breakdowns > Breakdown definitions, and click New.
2. On the form, fill in the fields.

### SLA Breakdown Definitions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the SLA breakdown.</td>
</tr>
<tr>
<td>Task table</td>
<td>Task table on which the definition is applicable.</td>
</tr>
<tr>
<td>SLA breakdown table</td>
<td>Table where the SLA breakdown data is stored.</td>
</tr>
</tbody>
</table>

**Note:** For the Madrid release, only a single breakdown table is available: (SLA Breakdown by Assignment).

4. Under the SLA Breakdown Definition Fields tab, click New and fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown field name</td>
<td>Field in the breakdown table that is mapped with the field that you select in the source field.</td>
</tr>
<tr>
<td>Source field name</td>
<td>Field in the task record table which is mapped to the breakdown field.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
The breakdown field and the associated source field appears under the **SLA Breakdown Definitions Field** tab.

6. Under the **SLA Definitions** tab, click **Edit** to relate one or more SLA definitions to the breakdown definition.

7. In the slush bucket, under Collection, select SLA Definitions to related to SLA Breakdown Definition.
The breakdown is applied on this task record.

8. Click **Save**.
The selected SLA Definitions appear.

**Service Level Agreement (SLA) processing**

The SLA engine performs two passes to evaluate SLA definitions and their conditions based on a task.

The SLA engine performs the following passes:

1. Checks the SLA definitions that do not have an active SLA record associated to the task. The SLA engine determines if the SLA definition applies to the task and if it needs to create a SLA record. The following condition checks are performed:
   a. If the Start condition is true and the Stop condition is true, do nothing. No SLA record is created, because the Stop condition overrides the Start condition.
   b. If the Start condition is true and the Stop condition is false, a new SLA record is created for this task using the SLA definition. The SLA record is then set to the In Progress stage.

2. Checks all active SLA records associated to the task. The engine determines if the SLA records are changing stage. The condition checks are performed in the following order:
   a. If the Stop condition is true, the SLA changes to **Completed** and becomes inactive.
   b. If both the Reset and Start conditions are true, the SLA changes to **Completed** and a new task SLA is created.
   c. If the Start condition is false, the SLA changes to **Cancelled** and becomes inactive.
   d. If the SLA is active, the Pause condition is true, and the SLA stage is **In Progress**, the SLA is paused.
   e. If the SLA is active, the Pause condition is false, and the SLA stage is **Paused**, the SLA changes back to **In Progress**.
Actual and business elapsed times

Task SLA records contain two sets of timing information: Actual elapsed and Business elapsed. The difference between these two sets of timing is vital when you create and report on SLA definitions.

- **Actual elapsed** values are calculated on a 24x7 basis.
- **Business elapsed** values are calculated based on the schedule specified in the task SLA. The schedule is taken from the SLA definition by default.

**Note:** If no schedule is specified, then the Business elapsed time is the same as the Actual elapsed time. This can be disabled by changing the com.snc.sla.always_populate_business_fields property to false in the SLA Engine. When this property is set to false, the Business fields will be 0 or empty.

By default, the related list for the task SLA record displays the actual elapsed time only. You can configure the list to also display the business elapsed time.

Elapsed times and schedules

Consider a scenario where an SLA has a defined schedule of 9 am to 5 pm on weekdays. With this schedule, the difference between actual and business elapsed times can be significant.

For example, if a task SLA starts at 2 pm on a weekday, its business elapsed time at 9 am on the next weekday is 3 hours while its actual elapsed time is 19 hours.

**SLA Schedule: 9:00 AM- 5:00PM**

Business elapsed time vs actual elapsed time

In addition, if a schedule defines an 8 hour working day, then 24 hours or one day in business elapsed time equates to 3 days in actual elapsed time.
Example: Business and actual elapsed times - 24 X 7

Example

For example, an incident is opened on Friday, December 12 at 9 pm, outside of the SLA schedule of 8 am to 5 pm on weekdays.

If the current time is the following Monday at 9:30 am, then:

- **Business elapsed time** is 1 hour and 30 minutes because the SLA business timer stopped at 5 pm on Friday and restarted at 8 am on Monday.
- **Actual elapsed time** is 60 hours and 30 minutes, representing the real time between the incident being opened and the current time.

Elapsed percentages are also similarly calculated. The actual elapsed percentage is over 750% while the business elapsed percentage is 19% on an 8 hour SLA.

**SLA calculation**

SLAs are calculated and assessed by a business rule and scheduled jobs that run in the background.
The mechanisms that control SLA Workflow and SLA Automation are independent of each other. You may have a requirement to send out email notifications from the SLA Workflow displaying the current elapsed percentage of the SLA. However, this does not work because using percentage in a notification only displays the most recently calculated value of the Task SLA. This results in inaccurate values sent out in email when using SLA calculated values in a Task SLA email notification.

One solution is to specify elapsed percentage in SLA notifications by using notifications for each percentage level. For example, an email notification for “75 percent SLA Warning” is created and a special event is used to trigger that notification. The event can be called “sla.warning.75”. Another solution is hard-coding these email notifications to trigger at a specified duration percentage, and configure the workflow linked to that SLA definition to send an email notification after waiting an elapsed percentage.

Run the 2011 SLA engine asynchronously

By default in the 2011 SLA engine, the SLA processing is performed by the Run SLAs business rule. This business rule runs synchronously and is the suggested configuration.

Role required: sla admin, admin

SLA processing runs asynchronously. For example, you can run this for performance reasons, such as to avoid delays when a user saves a new incident record. While the SLA engine is running asynchronously, there can be a short delay before the Task SLA records are available after updating a Task. Refresh the form to see the updated Task SLAs.

Use synchronous processing to get the best user experience. Asynchronous processing mode is used only when there a performance issues.

Note: In the 2010 engine, the Process SLAs business rule runs the asynchronous processing.

2. Select Yes for the Execute the 2011 SLA Engine asynchronously (com.snc.sls.engine.async) property.
3. Click Save.

Recalculate SLA times automatically

By default when a user opens a task, the SLA timing information for that task is not automatically recalculated.

You can enable this information to be automatically recalculated each time the task is opened, to provide current information rather than information from the last scheduled job.

2. For the Recalculate Task SLA records when a task’s form is displayed property, select the Yes check box.

Note: This property is disabled by default because there is a potential performance impact when several users concurrently open tasks.

3. Click Save.

Use exact times in SLA calculations

When business percentages are used for SLA calculations, they are rounded up to two decimal places.
As a result, breaches can occur when SLA calculations are rounded up to 100%. You can enable SLA calculations to instead use the business time or actual time left.

For example, a business percentage of 99.951% is rounded up to 100%, which causes a breach.

For more accurate SLA calculations, enable the SLA engine property for using the exact value of the business time left if a schedule is specified or the actual time left if the SLA has no schedule specified.

2. For the Use field “business_time_left” to calculate breach time instead of “business_percentage” field property, select the Yes check box.
3. Click Save.

Scheduled jobs for SLA

SLA has default scheduled jobs to regularly refresh the time calculations on each active task SLA.

- SLA update (breach after 30 days): repeats every 5 days
- SLA update (breach within 1 day): repeats every hour
- SLA update (breach within 1 hour): repeats every 10 minutes
- SLA update (breach within 10 min): repeats every 1 minute
- SLA update (breach within 30 days): repeats every day
- SLA update (already breached): repeats every day

Note: By default, the SLA update (already breached) scheduled job will calculate either for up to one year after it was breached or if 1000% of its allocated time is breached. You can set this maximum actual elapsed percentage value property in the SLA Engine properties.

Scheduled job runs more frequently when the task SLA is closer to being breached.

Repair Service Level Agreement (SLA)

SLA Administrators can repair SLA records to ensure SLA timing and duration information is accurate.

Repair of SLAs is useful to determine accurate timing information if your system has SLA records that contain incorrect values. For example, you may need to repair SLA records as a result of:

- poorly defined schedules
- poorly defined conditions on an SLA Definition
- some other system anomaly

The repair function removes the SLA record, then recreates and recalculates it from the start, including recreating the workflow. The repair uses the history from the Task and if appropriate will also create new Task SLAs that did not previously exist. For example, a new Task SLA may be needed if a new SLA Definition has been added since an associated Incident was created or updated.

SLA repair does not use the history of dot-walk fields but considers only the final state of the dot-walk fields. For example, if a pause condition is set to an incident dot-walk field as incident.caller_id.location and in real time the location is set to London, and later changed to San Diego. Then, when the SLA repair runs, only the final location is considered. So,
if SLA is in pause state when the `incident.caller_id.location` is San Diego, repair pauses immediately as it does not consider the previous London location.

The workflow used when recreating the SLAs is controlled by system properties and can be found by navigating to Service Level Management > Properties > SLA Repair. Any workflow that is used in the repair process will attempt to follow a repair path when processing the SLA Percentage Timer activities. This can be used to avoid running activities that are not needed for the repair over and over again.

You can repair single SLAs from the relevant form or multiple SLAs from relevant lists.

Note: SLA repair is not available on SLA definitions, as running a repair operation for an SLA definition could affect large numbers of records on your system, with significant performance impact.

You can also configure and manage SLA repair functions.

**Configure SLA repair**

Administrators can set SLA repair properties and view repair logs.

**Enable or disable SLA repair**

The Repair SLA function is enabled for all new installed instances running the 2011 engine, but is disabled by default for upgraded instances. If disabled, no SLA repair functions are available, including all SLA repair modules, SLA repair logs, and UI actions.

Note: Repair actions will not be available for instances that are not running the 2011 engine.

To enable or disable SLA repair, use the `com.snc.sla.repair.enabled` repair property.

Note: You can also configure SLA workflow usage.

**View repair logs**

An SLA repair log record is created each time a repair action takes place with details such as who initiated the repair and start and end date and time. The log record contains a number of child SLA Repair Log Entry records related to it. Each repair log entry has a type of either Before repair or After repair that will contain the appropriate values from each Task SLA record that is repaired. If there is only a Before repair entry record for a task SLA, this indicates that it has been deleted. If there is only an After record, the repair function has created a task SLA that did not previously exist.

Navigate to Service Level Management > Repair Logs to view repair log information:

- **Active Repairs**: view repairs that are still in progress.
- **My Repairs**: view repairs you have run.
- **All Repairs**: view all repairs.
- **Repair Entries**: view SLA Repair Log entries for all repairs that have run.
Repair SLA from a form

You can repair task SLA records from the Task form, or from the task SLA form for an SLA associated to a Task.

You can also repair multiple task SLA records from a list.

1. To repair all SLAs associated to a specific task, open that form and select the **Repair SLAs** related link.
2. Alternatively, to repair a specific SLA on a specific Incident record, open the Incident record, open the SLA record associated with that incident, then select the **Repair** button on that SLA form.

   The SLAs selected are repaired. When the repair process is completed, the user selecting to repair receives a standard notification of the repair results.
Repair SLAs from a list
You can repair multiple SLA records from a list of task or SLA records.

You can also repair SLA records from the relevant Task form, or from the SLA form for the SLA associated with the task.

1. Navigate to a list of SLA records or task records.
2. Check the records to repair against.
3. Select the Repair SLAs for selected list action.
4. Alternatively, to repair SLAs for all records on that list, select the Repair for all filtered definitions related link.

The SLAs selected are repaired. When the repair process is completed, the user selecting to repair receives a standard notification of the repair results.

SLA Repair workflow
You can configure workflow usage for SLA repair operations.

Workflow usage
The SLA repair workflow is used if SLA repair functionality is enabled.

When the SLA repair function is in progress and new task SLA records are created, the workflow will follow a repair path through the workflow. The repair path is based on the result of the SLA Percentage Timer activities. While repair is in progress, the result of this activity will be repair, which enables the workflow to follow a different path in order to skip certain actions, such as generating events for notifications. This avoids duplicate notifications from being sent out during the repair process for each SLA that is repaired.

To specify that the SLA repair function should use the SLA’s original workflow for repair operations, go to Service Level Management > Properties > SLA Repair and remove the selection from the com.snc.sla.repair.use_repair_workflow repair property.

Note: If you choose to use a non-default repair workflow, or a workflow you have changed, you should modify this workflow to ensure it includes appropriate repair conditions on the SLA Percentage Timer activities. When a task SLA is repaired, the repair transitions are followed for any activities that occurred in the past. For example, the Default SLA Repair workflow configures the repair conditions to follow repair transitions.
Workflows for new or upgraded instances

For new instances, the SLA Repair function uses the Default SLA workflow, which incorporates repair activities. For upgrades, the SLA Repair function uses the Default SLA Repair workflow because the Default SLA workflow will not be updated in case it has been customized.

To change the default workflow the SLA repair function uses, go to Service Level Management > Properties > SLA Repair and set the com.snc.sla.repair.workflow repair property.

Monitoring Service Level Agreement (SLA)

You can view the details for every task SLA record created for a task.

In the task SLA record, you can view the task SLA details such as the stage the task SLA is in and if it has breached.

You can also view the target of the agreement being defined: None, Response or Resolution. Target is used for filtering, searching, and reporting purposes only.

Note: This feature is available only in new instances starting with Jakarta or a later release. The Problem Management Best Practice – Jakarta plugin (com.snc.best_practice.problem.jakarta) plugin must be activate.

In addition, you can get an overview of the timings for the task SLA such as the actual and business elapsed time and percentage, and the actual and business time left in days and hours.

SLA timeline

The SLA timeline is a feature of the Service Level Management application. The SLA timeline detail helps you understand the progress of an SLA. The timeline provides detailed insight to the task updates which triggered stage changes during the life cycle of a task SLA.

The SLA timeline detail helps you to:

- View the progress of SLAs, OLAs, and underpinning contracts.
- View related task updates.
- Identify the reason a task update triggered a specific stage in the task SLA.
- Debug and verify a task SLA and the SLA definition.

Note: This feature is available only on the SLA Engine 2011 version.

Role required: itil, sla_admin, sla_manager
**SLA Timeline**

**SLA Timeline field description**

<table>
<thead>
<tr>
<th>Levels</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>Specifies the SLA definition name and lists the task SLAs that result from the SLA definition. This field also displays, in the form of symbols, the last known stage, and the completion or the cancellation status, if any, of the task SLA.</td>
</tr>
<tr>
<td>Levels</td>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| 2      | Preference to see **Business elapsed time** or **Business time left** on timeline row | **Business elapsed time:**
Specifies the business time that has accumulated from the beginning of the SLA to its end.

**Business time left:**
Specifies the business time that is remaining by which the SLA task must be completed.

**Note:** The selected option from the choice list is saved as a user preference and is selected by default when you navigate to the SLA timeline in the future. Whether you set the system property **Always populate business fields on a Task SLA** to true or false, the SLA timeline always populates the **Business fields for representation**.

| 3      | Enables filtering of the data displayed by the SLA timeline. You can filter data by selecting the following options: | Enables filtering of the data displayed by the SLA timeline. You can filter data by selecting the following options:

- **Show only breached**: When selected, displays the task SLAs that are breached. This check box appears only when the SLA engine property **Enable compatibility with 2010 ‘breached’ stage for SLAs** is set to false.
- **SLA Stage**: Select to view the task SLA records that match the final stage of a specific task SLA.

**Note:** If the SLA engine property **Enable compatibility with 2010 ‘breached’ stage for SLAs** is set to true, the **Completed** stage appears as **Achieved** and the **Breached** check box appears under the SLA stage.

- **SLA Definitions**: Select to view the task SLA records for a specific SLA definition.

| 4      | Lets you view detailed information about the task when you click the information icon. | Lets you view detailed information about the task when you click the information icon.
<table>
<thead>
<tr>
<th>Levels</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td><img src="image" alt="Zoom In/Out Icons" /></td>
<td>Provides several zoom in/out levels to control SLA timeline zoom resolution.</td>
</tr>
</tbody>
</table>

**Note:** If the duration of any task SLA is more than 1 year, then the 5-minutes view is disabled because of performance issues and browser limitations. The condition is applicable for all the browsers.

For IE and EDGE:
- The 5-minutes view is not available for any task SLA that has a duration of more than 35 days.
- The 8-hours view is not available for any task SLA that has a duration of more than 10 months, and the default view is set to 16 hours.
- The 16-hours view is not available for any task SLA that has a duration of more than 21 months, and the default view is set to 24 hours.
<table>
<thead>
<tr>
<th>Levels</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td></td>
<td>The legend provides the following categories.</td>
</tr>
</tbody>
</table>

**Shapes**
- **Completed**: Symbolizes a task update which completed the task SLA.
- **Canceled**: Symbolizes a task update which canceled the task SLA.
- **Task update**: Symbolizes an update of the task.
- **Task update with stage change**: Symbolizes an update of the task which also led to the change in SLA stage.
- **Breach time (Estimated)**: Symbolizes estimated Breach time of an in-progress task SLA that is not yet breached or paused.
- **Expected start**: Symbolizes estimated Start time of a task SLA. This scenario is encountered for a retroactive task SLA starting in the future.

**Bar color (SLA Duration)**
- **Below 50%**: Green represents a task SLA stage below 50% of the defined SLA duration.
- **In-between 50% and 75%**: Yellow represents a task SLA stage between 50% and 75% of the defined SLA duration.
- **In-between 75% and 100%**: Orange represents a task SLA stage between 75% and 100% of the defined SLA duration.
- **Above 100%**: Red represents a task SLA stage after the SLA is breached.
- **Paused**: Gray represents a task SLA stage when it is paused.

**Modifiers**
- **Retroactive (in lighter shade)**: Represents the stages, updates, and out-of-schedules that are in the retroactive time.
- **Out of schedule (with center stripe)**: Represents the time period that the task SLA was outside of the schedule time defined in the SLA definition.
<table>
<thead>
<tr>
<th>Levels</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>![Image]</td>
<td>Provides a toggle to show and hide task updates that did not cause an SLA stage. Task updates that are not responsible for an SLA stage change can help debug SLA definition conditions.</td>
</tr>
<tr>
<td>8</td>
<td>![Image]</td>
<td>Refreshes the information on the SLA timeline.</td>
</tr>
<tr>
<td>Levels</td>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Task SLA Details</td>
<td>Displays the details of a task SLA, depending on where you click the timeline.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Stage details</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Task update details</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Out of schedule details</td>
</tr>
<tr>
<td></td>
<td>Stage details</td>
<td>When you click the update on the task SLA timeline, the stage details section appears with the following information:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Summary of the changes or useful information relevant to the selected stage.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Information on stage start and stage end such as the start and the end time, actual elapsed time and percentage, actual time left, pause duration. The stage information also displays any breach of the SLA.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
<td>If no schedule is attached to the SLA definition, then business values are hidden and actual values are displayed. If any schedule is attached to the SLA definition, both the business and the actual values are displayed.</td>
</tr>
<tr>
<td></td>
<td>Task update details</td>
<td>When you click the task update, the Task update details section appears with the following information:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SLA definition conditions: Displays the respective conditions of the task SLA and the values for the related columns at that point for the task. A blue check mark appears for the conditions that affect the SLA stage change.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Time: Displays the date and the time when an update takes place in the task SLA. It also displays the delta changes that occurred in the task for that update.</td>
</tr>
<tr>
<td></td>
<td>Out of schedule details</td>
<td>When you click the out of business schedule on the task SLA timeline, the outside business period details section appears with the following information:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Start date: Displays the start date of the selected task SLA.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• End date: Displays the end date of the selected task SLA.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Duration: Displays the duration of the current out of schedule selection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Total out of schedule duration: Displays the total out-of-schedule hours until the end of the current selection.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
<td>Click &lt; and &gt; to navigate to the left and right task update in the details section.</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The SLA timeline receives information about the task from the audit history and refers to the current SLA definition to pull data for the SLA timeline. The SLA timeline displays task SLA information as though the SLA repair is already executed, irrespective of whether it is executed or not.

Verify SLA definition using SLA timeline

You can verify that a task is mapped appropriately with a defined SLA using the SLA timeline. If a task is mapped with the SLA definition, the SLA timeline displays a graphical representation of the progress of the task SLA.

Role required: admin

1. Navigate to SLA > SLA Definitions.
2. Click the SLA Definition that you want to verify.
3. Click the Validate SLA Definition related link. The SLA Timeline page appears.
4. From the SLA Definition Picker, select the SLA definition for which you want to confirm if an appropriate task is mapped.
5. From the Task Record Picker, select the task that must be mapped to the SLA definition.
   
   If the selected task is mapped to the SLA definition, then the SLA timeline displays a graphical progress of the task SLA.

Note:

When a selected task does not have any task SLA attached to it, the SLA timeline still displays the update to the task when the Show all Task updates check box is selected. This information can be used for debugging the task SLA.

View SLA timeline

You can view an SLA timeline from a Task SLA record or from an SLA definition.

Role: itil, sla_admin, sla_manager

To view the SLA timeline:

You can open an SLA definition from the following:

<table>
<thead>
<tr>
<th>Location</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA definition</td>
<td>Navigate to Service Level Management &gt; SLA &gt; SLA Definitions. Click on the name of the SLA definition and then click the Validate SLA Timeline link.</td>
</tr>
<tr>
<td>Task SLA record</td>
<td>Open a task SLA record from the task form. Click the Validate SLA Timeline link to view the SLA timeline for that specific SLA.</td>
</tr>
</tbody>
</table>
| Task form              | • Click the Validate SLA Timeline link that appears under related links in the task form. The SLA Timeline appears with the list of all the SLAs that are associated with the task.  
                            • Right-click on a Task SLA in the related list on a task form such an incident record and select the Validate SLA Timeline option. The SLA Timeline appears for the specific SLA. |
The SLA timeline for the selected task or incident is displayed. It includes SLA report details and visual representation of the progress of the task SLA over the lifetime of the task.

Understand why an SLA did not trigger as expected

Describes the conditions when an SLA might not trigger as expected.

Using Task SLA -1 (highlighted in the screenshot) as an example, an SLA Manager may have expected this SLA to trigger earlier.

To troubleshoot this inconsistency, the SLA Manager can enable Show all task updates from the settings menu in the upper right of the SLA Timeline. The SLA timeline displays task updates that do not cause an SLA stage change as a white triangle.

If you click the first or second task updates that did not cause a stage change, the details section displays the SLA start conditions and the task values that are key to trigger the start condition. In this case, the Configuration Item field is not populated and the SLA Definition conditions are defined to trigger when the Configuration Item is defined as the CI SAN 001.
On inspecting the details for the task update that triggered the SLA start condition, you can find that the configuration item is set to Storage Area Network 001 and this matches the SLA Definition start condition.

**Show all task updates** is a powerful tool to help SLA Managers understand why an SLA may not have behaved as expected.
Use SLA timeline to determine business schedule

This example demonstrates how to use the SLA timeline to determine the business schedules and business percentage time related to a task SLA.

SLA timeline

In the example above, the business percentage for the priority 2 incident is 0 seconds. The dark stripe in the SLA timeline determines the time when the SLA was out-of-schedule. The SLA time is not calculated during the out-of-schedule time. So, the business elapsed time is 0 since the total duration of this SLA is out of schedule.
If you want more detail of the out-of-schedule duration, you can hover over the dark stripe for summary detail or click it. The Out of Schedule detail section provides information on the details of the schedule such as when the out of schedule started, when it ended, the current duration of that out of schedule time and the total duration of all out of schedule time for the entire SLA. This provides detailed insight into when the SLA was accumulating time and the periods of time it did not accumulated time.

Out of schedule details

Using another example, you can understand in details how business time in an SLA is calculated. In the example below, the total SLA defined duration for Task SLA-2 is 8 hours. The highlighted area shows that the SLA is out of schedule from 07:00AM until 08:00AM and starts accumulating time at 8:00AM reaching 50% of it’s total duration at 12:00PM. From 12:00PM to 14:00PM the SLA accumulates from 50 – 75% of it’s total duration and from 14:00PM to 16:00PM it accumulates from 75 – 100% of it’s total duration, ultimately breaching at 16:00PM.

At any time, you can hover over any stage to get a summary of it’s detail or click a stage to get comprehensive detail of that SLA’s stage, including a summary and detail of the stage start and stage end.

Details of task stage

Use SLA timeline to understand SLA stage change

Describes how you can understand SLA stage changes using SLA timeline.

Using Task SLA-2 as an example, you can see a period of retroactive and out of schedule time preceding the task update that caused the SLA to attach to INC0010001. The task update is
represented by the first triangle. When this event is selected, the detail pane displays and the Start tab has a blue check and is highlighted indicating this is the SLA Definition condition this event met and the task values which matched the SLA Definition start condition.

When the second task update represented by the second black triangle, which triggered an SLA stage change occurs, you can see that it triggers a pause condition. If you select this event in the timeline, the detail pane displays the highlighted Pause that contains a blue check indicating a match. Once again, the task values which match the SLA Definition condition are displayed so you easily know why the stage change occurred.

Similarly, when the third task update which triggers a stage change occurs, you can see this resumes the SLA. When that update is clicked, the Stage details section highlights the Resume tab which now contains a blue check and provides detailed information about the task update that occurred and the SLA conditions those updates matched.
The SLA continues to accumulate time, until it is breached and this is visually represented by the yellow, orange, and the red colors. Eventually, another task update occurs which triggers the SLA’s cancel conditions that is represented by the white diamond. The Stage details section highlights the conditions for the task SLA cancellation. In this case, the SLA Definition is defined to cancel when the ‘Start conditions are not met’.

Use SLA Timeline to validate a new SLA definition

When a new SLA Definition is created the SLA Timeline can be used to see how the SLA will behave against existing task records.

From the SLA Definition form, open the SLA Timeline by clicking the Validate SLA Definition related link. Select a task by using the task picker in the upper left. The SLA Definition automatically populates for you. When a task is selected that matches your SLA Definition, the SLA Timeline allows you to inspect the different elements of the SLA.
**SLA timer**

Use the SLA timer component to track the amount of time that is required to complete the task as defined by the matching SLA definition.

The SLA timer component is designed to visually display the current status of the Task SLA. You can also view more information about the task in the tooltip, such as the SLA definition name, the remaining time to breach, and the percentage completed details. When your task is in-schedule, then the tooltip provides extra information, such as the out-of-schedule details.

The timer component can show any of the following stages depending on the current status of the task.

<table>
<thead>
<tr>
<th>Stage</th>
<th>Color code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In-progress</td>
<td></td>
<td>The stage of the timer when the task SLA is in progress. You can find more information about the schedule and time on tooltip. The color code changes for in-progress state:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• green to yellow: When the time to complete reaches 50%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• yellow to orange: When the time to complete reaches 25%</td>
</tr>
<tr>
<td>Breached</td>
<td></td>
<td>The stage of the timer when the time allocated to complete the task SLA is over. The tooltip provides more information on the time that the task was breached.</td>
</tr>
<tr>
<td>Cancelled</td>
<td></td>
<td>The stage of the timer when the task SLA is cancelled. On the tooltip, you can see the time when it was cancelled.</td>
</tr>
<tr>
<td>Paused</td>
<td></td>
<td>The stage of the timer when the task SLA is paused or put on-hold. The color displayed in this stage will correspond to the percentage elapsed when the task SLA was paused. When the stage changes from Paused to in-progress the timer starts from time when it was paused. You can find more information about the schedule and time on tooltip.</td>
</tr>
</tbody>
</table>
**Stage** | **Color code** | **Description**
--- | --- | ---
Achieved (2010 SLA engine) | ![Achieved] | The stage of the timer when the task SLA is achieved. The information on when it was achieved is seen on the tooltip.
Completed | ![Completed] | The stage of the timer when the task SLA is completed. You can see when it was completed on the tooltip.
Out of Schedule | ![Out of Schedule] | The stage of the timer when the task SLA goes out-of-schedule. You can find more information about the schedule and time on tooltip.

**SLA timer configurations**

Configure the SLA timer to determine which task SLA must be displayed as part of the timer component.

Role required: admin, sla_admin, sla_manager, itil, or sn_slm_timer.sla_timer_admin

All Service Level Agreement (SLAs) attached to a task, such as an incident, problem, or change are of equal importance. However, on various scenarios and user interfaces, you might want to configure a hierarchy of preferred SLAs. After configuring the hierarchy, you can determine from the list, the most important or preferred SLA that can be displayed.

The `slm-timer-config-api` application provides the ability to set a preferred SLA for a given task using the configuration that is either dynamic, such as **First SLA to breach** or declarative from a hierarchical mapping of first to matching SLA definitions.

The SLA timer configuration provides the following demo data which also serves as an example to customize.

**Do not show SLA timer**

Use this configuration if you do not want to show the timer component.

**Show SLA that will breach first**

Use this configuration to determine the task SLA that has the earliest breach time.

**Incident Response and Resolution Team**

Use this configuration if you prefer to display Task SLA matching specific SLA Definition in the timer component. This configuration creates hierarchy of SLA Definitions to be displayed.

The **SLA Timer Configuration** application comes only with demo data, it is always advisable to create your own configuration records. You can use the demo data as a guide to help ensure the preferred task SLA record is shown against a particular task.

1. Navigate to **Service Level Management > Administration > SLA Timer Configuration**.
2. Click **New**.
3. On the forms, fill in the fields.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the SLA timer configuration</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SLA timer source</td>
<td>Choose any one of the following:</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong></td>
</tr>
<tr>
<td></td>
<td>When you do not want to show the timer.</td>
</tr>
<tr>
<td></td>
<td><strong>First to breach</strong></td>
</tr>
<tr>
<td></td>
<td>When you want to display the task SLA with the earliest breach time.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When a task SLA with the earliest breach time pauses, goes out of schedule, or is completed, then the next task SLA is displayed.</td>
</tr>
<tr>
<td>Task to SLA mapping</td>
<td>When you want to create your own display hierarchy of task SLAs. If you choose this option, you must define the SLA Definition mappings to ensure that there is always a preferred SLA definition.</td>
</tr>
<tr>
<td>Show completed</td>
<td>Select if you want to display the preferred task SLA that includes the breached stage. If this option is selected, on complete, it will not move to the next SLA priority.</td>
</tr>
<tr>
<td>Show completed</td>
<td>Select if you want to display the timer when the task SLA canceled. If this option is selected, on cancel, it will not move to the next SLA priority.</td>
</tr>
</tbody>
</table>

4. Click **Update**.
5. Open the SLA configuration you created.
6. If the SLA timer **Source** is set to **Task to SLA Mapping**, then you must configure the mappings.
7. To configure the task to SLA mapping, click **New** in the **SLA timer configurations mappings** related list.
8. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA timer config</td>
<td>Select the timer config from the look-up list. If created from related list, the timer config will be auto-populated with the parent record.</td>
</tr>
<tr>
<td>Order</td>
<td>The hierarchical order of the task SLA. This value is pre-populated. However, you can edit it based on your requirements.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table that the task belongs to, for example, Incident, Problem, or Change. This is used as a reference qualifier on the SLA definition.</td>
</tr>
<tr>
<td>SLA definition</td>
<td>Select the SLA definition that is available for the table.</td>
</tr>
</tbody>
</table>
Note: If there is an identical mapping for the Order or SLA definition in the selected table, the configuration is prevented using business rules. This check ensures that there is always only one preferred SLA definition at each level in the hierarchy.

9. Click **Submit**.

If no configuration sys_id is provided to the sla-timer-configuration API, then default behaviour is:

- **SLA Timer source**: First to Breach
- **Show cancel**: true
- **Show complete**: true

However, as a best practice do not provide a configuration sys_id to the application. Setup their own configuration, even if it is identical to the default behavior.

**SLA notifications**

SLA sends notifications at certain events defined in the workflow.

By default, SLA notifications are sent on three occasions:

1. SLA is at 50% of the duration specified in the SLA Definition: Notification is sent to the user in the **Assigned to** field mentioned in the incident form and the **Supported by** field in the configuration item form.

2. SLA is at 75% of the duration specified in the SLA Definition: Notification is sent to the user in the **Assigned to** field mentioned in the incident form and the manager of the user.

3. SLA is breached: Notification is sent to the user in the **Assigned to** field mentioned in the incident form and the manager of the user.

**Legacy Service Level Agreement (SLA) engines**

If you are on an earlier version of the SLA engine, you can upgrade to the 2011 engine to make use of the complete service level management functionality.

The SLA engine has three versions:

<table>
<thead>
<tr>
<th>SLA engine version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation engine (pre-2010)</td>
<td>Tracks only one SLA per task.</td>
</tr>
<tr>
<td>The 2010 engine (the Service level management plugin)</td>
<td>Supports multiple SLAs per task. Business rules handle the processing of these SLAs while workflows handle notifications. The majority of logic is in a single large business rule called Process SLAs.</td>
</tr>
<tr>
<td>The 2011 engine (also part of the Service level management plugin)</td>
<td>The 2010 SLA engine functionality is concentrated into a number of script includes. Provides retroactive pause calculations and enables the customization of SLA condition processing through the use of condition rules.</td>
</tr>
</tbody>
</table>
Legacy SLA fields

Previously, only a single SLA could be attached to a task via the Escalation engine. The information for the SLA was stored in the task table using the SLA Due, Made SLA, and Escalation fields.

The Task SLA engine now enables multiple SLAs to be attached to a single task, making the earlier task fields redundant. Their equivalents are in the task_sla table for each SLA attached to the task.

- **Task SLA, Breach time**: This is equivalent to the SLA Due field
- **Task SLA, Has breached**: This will be true if the SLA has breached, the opposite of Made SLA field.
- **There is no equivalent field for Escalation field.** Notifications can be sent via the SLA workflow and an increase in priority can trigger additional SLAs to be attached to the task.

**Note:** The Business Duration field is neither part of the Escalations Engine nor the Task SLA Engine.

The fields on the Task are considered legacy and are not updated by the Task SLA engine. In case these fields are being updated, the legacy Escalation engine may still be running. This can happen if you have upgraded from Express or a previous instances.

To prevent the Escalation engine from running, set the `com.snc.sla.run_old_sla_engine` property to false. If this property is set to false and the fields are still being updated, check the customizations made to your instance.

Migrate to service level management

Migrate SLA processing from the escalations engine to use the service level management functionality.

The two core differences between the old SLA engine and the new service level management plugin are that tasks can now run multiple SLAs simultaneously, and the escalation concept has been replaced with the more robust Workflow Editor. This allows administrators greater control on what actions, notifications, and events are triggered by tasks, to take into account more mature Service Level processes.

If an instance has been using the original SLA engine and has just activated the Service Level Agreements (SLA) Plugin, the old SLAs will not work. For the old SLAs to work, they must be converted to the new SLA Definition records, which will attach the appropriate Task SLA records to the matching Task records. This is done manually by creating new SLA Definition records that reflect the definition of the old SLA. Old SLAs will continue to function, but any time a task is updated, the appropriate new Task SLAs will attach.

Once new Task SLAs are implemented, they will attach themselves to any new or updated incident, including ones which already have old SLAs attached. If the new Task SLA is set to retroactively start, it will automatically calculate the duration from that point in the past, which means that the duration will still be accurate.

When enabled, the property `Compute prior SLA pause time for new, retroactive SLAs (2011 SLA engine only)` calculates the pause time when a retroactive SLA is attached.

For example: if a retroactive SLA attaches to an incident one hour after its creation, and meets the pause conditions for half an hour, then the elapsed time is half an hour rather than the full hour.
Move from the 2010 Engine to the 2011 Engine

You can upgrade SLA processing to use the 2011 Engine.

The service level management plugin was enhanced with the ability to script the condition rules for SLA transitions, giving control over how the conditions in an SLA Definition are used. Please review the documentation before enabling the enhancements to understand how the new engine will impact existing customizations.

Note: Activating the 2011 SLA engine will deactivate all business rules on the task_sla table (except for the rule Task SLA Empty Schedule Warning, which is part of the 2011 engine). If you have added any additional business rules or customized the default business rules, these will not be automatically deactivated. So you should review these customizations, and manually deactivate such business rules, before making this change.

The default Process SLAs rule on the task table will also be deactivated, so any customizations to this script must be incorporated into the new SLA engine.

In addition, breach information is removed from the Stage field, and stored in the new Has breached field.

To enable the new functionality:

1. Navigate to Service Level Management > SLA Properties.
2. Change the following property from 2010 to 2011:

   ![Which version of SLA engine to run (Default '2011' for new installations)](default)

   By default, the 2011 Engine sets the Stage field to In Progress, shaded red to indicate the breached status, and sets the Has Breached field to true. The SLA continues to run until the stop conditions are met.

Organize the migration process

There are several ways to convert the old SLAs to the new Task SLAs.

Perform the following steps to organize the conversion process:

1. Convert the old SLAs to new SLA Definitions, but leave the Active flag unchecked on each one.
2. Back up the old SLAs by exporting the table to XML.
3. Deactivate the old SLAs, setting the Run the old SLA engine (System Policy -> SLA Management) system property (com.snc.sla.run_old_sla_engine) to false. This deactivates the legacy SLA engine preventing both engines from running and conflicting. This property is set to true by default, but will be set to false by the new SLA plugins, effectively deactivating the old SLAs.
4. Activate the new SLA Definitions by checking the Active flags on each one.
5. Navigate to **Incident > Open** and use the List Editor to “touch” each record. As each record is updated, the new Task SLA will attach to each incident. If there are too many open incidents to effectively touch using the List Editor, run a business rule that will update every open incident.

**Convert an SLA to an SLA Definition**

You must replicate the default SLA record as a new SLA definition.

To convert old SLAs to SLA Definitions:

1. Transfer the **Name** and **Table** fields.
2. If desired, check the **Retroactively Start** checkbox.
   If checked, this will cause the SLA to calculate from the moment the record is created (or from the date and time on the selected task), rather than the moment the SLA is attached. This is especially helpful for Task SLAs that will attach to active incidents that have old SLAs currently running.
3. Transfer the **Conditions** field to the **Start Conditions** field. Make sure to add **Active is True** as well, so that the new Task SLAs don’t attach to closed incidents when they are updated.
4. Define a new set of **Pause Conditions** and **Close Conditions**.
5. Set the **Duration Type** and **Duration** fields. The old SLAs did not support relative duration, so to define the Task SLA to behave similarly to the old SLA, select **User Defined Duration** as the **Duration Type** and put the total length of time of all of the escalations here.
   For instance, an old SLA that has escalations of 4 hours to Moderate, 2 hours to High, and 2 hours to Overdue, the new Task SLA should have **Duration** set to **Days 0 Hours 08:00:00**.
6. Calendars have been replaced by Schedules, so if schedules haven’t been defined yet, they will need to be.
7. Instead of escalations, attach an SLA Workflow.
   There is a default SLA workflow, however, you must create a new workflow to replicate the escalation levels on the old SLA. Escalation Levels are defined hour-by-hour, whereas the SLA Workflow uses a percentage timer.
   So for the above example of 4 hours to Moderate, 2 hours to High, and 2 hours to overdue, the workflow will need a 50% timer and then two 25% timers. The new task SLA records do not use the **Escalation** or **Made SLA** fields on the task record.

The following example is an old SLA for Priority 1 incidents to be resolved on a Monday-Friday (8-5) Calendar, with escalations to Moderate at 4 hours, to High at 2 hours, and to Overdue at 2 hours:
Old SLA example

This is the new Task SLA created from the same information:
New SLA example

This is the workflow which powers the new Task SLA.

**Note:** This example workflow responds to each escalation by firing off an event. A business rule can be configured to respond to escalation events, or the workflow can be adjusted to match the organization's process.
New SLA workflow

Task SLA table

The Task SLA (task_sla) table stores Task SLA records for the SLAs attached to particular tasks. For each task, attached SLAs are accessible in a related list on the Task's form.
Task SLA table

The SLA form for a task shows further details:
## Task SLA Form

<table>
<thead>
<tr>
<th>SLA definition</th>
<th>Priority 1 resolution (8 hour)</th>
<th>Stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>INC0000025</td>
<td>Schedule</td>
</tr>
<tr>
<td>Updated</td>
<td>2015-06-03 05:53:41</td>
<td>Timezone US/Pacific-New</td>
</tr>
</tbody>
</table>

### Timings

<table>
<thead>
<tr>
<th>Start time</th>
<th>2015-03-04 15:56:07</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop time</td>
<td></td>
</tr>
</tbody>
</table>

**Actual elapsed time**

- Days: 90
- Hours: 12 56 34

**Actual elapsed percentage**: 27.162.2

**Actual time left**

- Days: 0
- Hours: 00 00 00

**Business elapsed time**

- Days: 00
- Hours: 00 00 00

**Business elapsed percentage**

**Business time left**

- Days: 00
- Hours: 00 00 00
Stage values

The following **Stage** values are defined:
- In progress
- Cancelled
- Paused
- Completed

**Note:** The **Breached** stage value is also available for systems either using the 2010 SLA engine, or running in compatibility mode.

Timing information

The **Timings** fields on the Task SLA contain the crucial information powered by the SLA Engine:

**Task SLA Time-Based Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>The time the SLA was started.</td>
</tr>
<tr>
<td>Stop time</td>
<td>The time the SLA ended.</td>
</tr>
<tr>
<td>Breach time</td>
<td>The time the SLA will breach, adjusted for business pause duration (for task SLAs with a schedule specified) or pause duration (for task SLAs with no schedule).</td>
</tr>
<tr>
<td>Actual Elapsed Time</td>
<td>Time between start time and now (minus pause duration).</td>
</tr>
<tr>
<td>Actual Elapsed Percentage</td>
<td>Percentage of total SLA that has elapsed (minus pause duration).</td>
</tr>
<tr>
<td>Actual Time Left</td>
<td>Time remaining until SLA breach.</td>
</tr>
<tr>
<td>Business Elapsed Time</td>
<td>Time within the specified schedule between start time and now (minus pause duration).</td>
</tr>
<tr>
<td>Business Elapsed Percentage</td>
<td>Percentage of total SLA that has elapsed within the specified schedule (minus pause duration).</td>
</tr>
<tr>
<td>Business Time Left</td>
<td>Time within the schedule remaining until SLA breach.</td>
</tr>
</tbody>
</table>

**Note:** Breach time is the same as Planned end time.
### Reactivate escalation engine

Escalation engine is replaced with 2011 SLA Engine.

**Role:** admin

ServiceNow Express used the legacy Escalation Engine to process SLAs. If for any reason a customer who has upgraded from ServiceNow Express to ServiceNow Enterprise wants to reactivate the Escalation engine, they can follow the steps below.

1. Navigate to `sys_properties.list`.
2. Update the property `com.snc.sla.run_old_sla_engine` to `true`.

**Note:** ServiceNow recommends using the 2011 SLA Engine.

### Service level management overview dashboard

The Service Level Management Overview Dashboard provides insight into Service Level Agreement (SLA) information relevant to the logged-in user. By default, the Overview dashboard is available to users who possess the itil role.

The Overview Dashboard is enabled by default for new customers. Customers upgrading from a prior release have to enable the Service Level Management Dashboard plugin (`com.snc.sla.overview`) to activate this feature.

You can navigate to the dashboard in the following ways:

- Service Level Management > Overview
- Self – Service > Dashboard > SLA Overview
<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My at Risk SLAs</td>
<td>Number of active task SLAs for tasks assigned to the logged in user that have not yet breached but have elapsed 75% of the duration of the SLA.</td>
</tr>
<tr>
<td>My Active Breached SLAs</td>
<td>Number of active task SLAs for tasks assigned to the logged in user that have breached.</td>
</tr>
<tr>
<td>My Active SLAs (count)</td>
<td>Number of active task SLAs for tasks assigned to the logged in user.</td>
</tr>
<tr>
<td>My Groups Active SLAs (count)</td>
<td>Number of active task SLAs for tasks assigned to groups that the logged in user is a member of.</td>
</tr>
<tr>
<td>My Active SLAs (bar chart)</td>
<td>Displays a bar chart of active task SLAs for tasks assigned to the logged in user. The data can be grouped and/or stacked on some of the fields available in the task SLA records.</td>
</tr>
<tr>
<td>My Groups Active SLAs (bar chart)</td>
<td>Displays a bar chart of active Task SLAs for Tasks assigned to groups that the logged in user is a member of. The data can be grouped and/or stacked on some of the fields available in the task SLA records.</td>
</tr>
<tr>
<td>My Active SLAs (list)</td>
<td>Displays a list of active task SLAs for tasks assigned to the logged in user. The data can be grouped on some of the fields available in the task SLA records.</td>
</tr>
</tbody>
</table>

### Analytics and Reporting Solutions for Service Level Management

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

### Enabling the Performance Analytics Solution

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.

**Note:** Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.

To enable the solution for Service Level Management, an admin navigates to **System Definitions > Plugins** and activates the Service Level Management PA Dashboard (com.snc.pa.sla.overview) plugin.

To use this Analytics and Reporting Solution, you must have an entitlement to use Performance Analytics with Service Level Management.

### Domain separation and ‘Run As’ user

By default, System Administrator is the **Run As** user for data collection jobs in the Analytics and Reporting Performance Analytics Solutions. Verify that this user exists on the instance, and whether this user has the appropriate level of access. An inappropriate **Run As** user can cause errors or limit the data that is collected. This setting only has an effect if domain separation is enabled.
**Service level management PA dashboard**

The Service Level Agreement (SLA) Overview module provides a Performance Analytics (PA) Dashboard to review SLA information at a glance.

Users with the itil role can access the dashboard.

You can navigate to the PA dashboard in the following ways:

- **Service Level Management** > **Overview**
- **Self – Service** > **Dashboard** > **SLA Overview (Premium)**

This dashboard has the following requirements:

- An entitlement to use Performance Analytics with Service Level Management.
- The Service Level Management PA Dashboard (com.snc.pa.sla.overview) plugin, which contains this dashboard.
- The SLA Breakdowns plugin (com.snc.sla.breakdowns) plugin, because some of the reports are generated from the breakdown data.
Overview tab
<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration of Active Breached SLAs</td>
<td>Uses available SLA breakdown data to generate a report showing time spent working on breached task SLAs that are still active and the SLA Definition Type is SLA.  Use the Group by and Stacked By breakdown lists to show different representations of this data, for example: Group by Assignment group and Stacked By SLA Definition.  The Assignment Group filter on the right can be used to limit the data shown in this report to a specific group.</td>
</tr>
<tr>
<td>Active Breached SLAs</td>
<td>This chart shows all breached task SLAs that are still active and the SLA Definition Type is SLA.  Use the Group by and Stacked By breakdown lists to show different representations of this data, for example: Group by Assignment group and Stacked By SLA Definition.  The Assignment Group filter on the right can be used to limit the data shown in this report to a specific group.</td>
</tr>
<tr>
<td>Achieved SLAs in Last 30 Days</td>
<td>This chart shows all task SLAs that completed in the last 30 days without breaching and where the SLA Definition Type is SLA.  Use the Group by and Stacked By breakdown lists to show different representations of this data, for example: Group by Assignment group and Stacked By SLA Definition.</td>
</tr>
</tbody>
</table>

### KPI tab

The KPI dashboard uses the following Performance Analytics indicators:

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average durations of breached task SLA closed today</td>
<td>London</td>
</tr>
<tr>
<td>Number of closed task SLA today</td>
<td>London</td>
</tr>
<tr>
<td>Average duration of achieved SLA today</td>
<td>London</td>
</tr>
<tr>
<td>Number of achieved closed task SLA today</td>
<td>London</td>
</tr>
<tr>
<td>Achieved SLAs Today</td>
<td>London</td>
</tr>
</tbody>
</table>

**Note:** These indicators are calculated on a daily basis to provide trend analysis.

Further operations are performed on the Performance Analytics indicators to generate the following KPIs on the dashboard:
KPIs based on Performance Analytics indicators

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of Active Breached SLAs (Daily)</td>
<td>Shows the % of active task SLAs that breached yesterday.</td>
</tr>
<tr>
<td>Average Assignment Duration (Breached)</td>
<td>Shows the average duration of individual assignments for breached task SLAs completed yesterday. The KPI that provides the data captures this value on a daily basis to provide trend analysis. This report is based on SLA breakdown data and so shows data only for SLA definitions that are linked to an SLA Breakdown definition.</td>
</tr>
<tr>
<td>% of Achieved SLAs (Daily)</td>
<td>Shows the % of task SLAs that were completed yesterday without breaching. The KPI that provides the data captures this value on a daily basis to provide trend analysis.</td>
</tr>
<tr>
<td>Average Assignment Duration (Achieved)</td>
<td>Shows the average duration of individual assignments for achieved task SLAs completed yesterday. The KPI that provides the data captures this value on a daily basis to provide trend analysis. This report is based on SLA breakdown data and shows data only for SLA definitions that are linked to an SLA Breakdown definition.</td>
</tr>
<tr>
<td>Average Duration of Assignments for Breached SLAs</td>
<td>Shows the average duration of individual assignments for breached task SLAs completed yesterday broken down by either Assignment group or SLA Definition. Use the Breakdown field to change which breakdown data is displayed. The KPI that provides the data captures this value on a daily basis to provide trend analysis. This report is based on SLA breakdown data and shows data only for SLA definitions that are linked to an SLA Breakdown definition.</td>
</tr>
<tr>
<td>Average Duration of Assignments for Achieved SLAs</td>
<td>Shows the average duration of individual assignments for achieved task SLAs completed yesterday broken down by either Assignment group or SLA Definition. Use the Breakdown field to change which breakdown data is displayed. The KPI that provides the data captures this value on a daily basis to provide trend analysis. This report is based on SLA Breakdown data and shows data only for SLA definitions that are linked to an SLA Breakdown definition.</td>
</tr>
</tbody>
</table>

Domain separation in Service Level Management

This is an overview of domain separation and Service Level Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.
Support level: Standard

- Includes Basic level support.
- Business logic: Processes can be created or modified per customer by the service provider (SP). The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The owner of the instance needs to be able to configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Use case: An admin needs to be able to make comments mandatory when a record closes for one tenant, but not for another.

Overview

- Service Level Management helps customers monitor, measure, and report on agreed service level agreements (SLAs); SLA definitions encapsulate these agreements.
- Users can see only content in the domain to which they have access.

How domain separation works in Service Level Management

The intention of SLM is to provide customers with an expectation of service within a known timescale and the ability to monitor when service levels are not being met. To learn specific terms and definitions see Service Level Management concepts.

- SLA definitions and task SLAs have domain fields. However, task SLAs are created only in the domain of its attached task record.
- SLA definitions must be defined in a tenant domain (or global) in order for task SLAs to be created and attached to a given task (or extensions).
- Task SLAs attach to a task if an SLA definition exists in the task records domain or in an ancestor domain.
- Task SLAs always inherit the domain of its attached task record, which includes the workflow running on the task SLA record.
  - If a task record ever flips, the task SLA also flips.
- If an SLA definition exists in an ancestor’s domain, the definition can be overridden in a sub-domain (delegated administration).

Domain-separated tables

- SLA definition (contract_sla)
- Task SLA (task_sla)

Use cases

- An ESS user in the ACME domain logs in and creates an incident, at which point an SLA is attached. The SLA is created in the domain of the associated task record (incident), which
is the ACME domain. The ESS user is not able to read SLA records. These are restricted to the following roles:

- Administrator
- ITIL
- SLA Administrator
- SLA Manager

- An ITIL user in the Acme domain logs in and creates an incident. The process above is the same except that the ITIL user can read the SLA record attached to the incident.
- If an SLA definition exists in the Acme domain and doesn’t meet the needs of an Acme sub-domain (Acme child) an SLA Administrator can remediate. SLA Administrators can navigate to the ACME SLA definition when their session domain is ACME child, make the relevant changes, and save them. The SLA Administrator is alerted that an override has been created.
- An ITIL user sets the session domain to Acme child and creates an incident. The task SLA is created using the SLA definition from Acme child.

Quick start tests for Service Level Management

Validate that Service Level Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Service Level Management quick start tests require activating the Service Level Management - ATF Tests plugin (com.snc.service_level_management.atf).

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLM: Service Level Management Task SLA completed workflow</td>
<td>Tests that a user can create a task SLA and complete the workflow.</td>
<td>Orlando</td>
</tr>
<tr>
<td>SLM: Service Level Management Task SLA cancelled workflow</td>
<td>Tests that a user can create a task SLA and cancel the workflow.</td>
<td>Orlando</td>
</tr>
<tr>
<td>SLM: Service Level Management Task SLA timer REST API</td>
<td>Tests that the SLA Timer API response matches data expected by SLA Timer Seismic component.</td>
<td>Paris</td>
</tr>
</tbody>
</table>

Task Outage

CI unavailability, or outage, is the actual down time of a CI. Whenever there is an outage for any of the CI items, the outage information is stored in the Outage (cmdb_ci_outage) table. The Task-Outage table (task_outage) maintains the mapping between the Task (task) table and the Outage (cmdb_ci_outage) table.

Activate Task-Outage Relationship

Activate the Task-Outage Relationship plugin (com.snc.task_outage) to track outage duration.

Role required: admin
The Task-Outage Relationship plugin creates a many-to-many relationship between the Task (task) table and the Outage (cmdb_ci_outage) table.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Task-Outage Relationship

The Task Outage table is installed with activation of the Task-Outage Relationship plugin (com.snc.task_outage).

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Table installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Outage</td>
<td>A many-to-many table that stores references to the Task (task) and Outage (cmdb_ci_outage) tables.</td>
</tr>
</tbody>
</table>

Add the Outage UI action to another task form

By default, the Create Outage UI action is available on the incident and problem forms, and can be added to other task forms. For new instances from Jakarta only, this feature is also available on the change request form.

Role required: admin

1. Navigate to System Definition > UI Actions.
2. Select the UI Action Create Outage on the Task (task) table.
   
   By default, the condition is:
   
   ```
current.getRecordClassName() == 'incident' || current.getRecordClassName() == 'problem'
   ```
3. Modify the Conditions field as described in the following examples.
Option | Description
--- | ---
To add this UI action to the Ticket (ticket) table | `current.getRecordClassName() == 'incident' || current.getRecordClassName() == 'problem' || current.getRecordClassName() == 'ticket'`

To use the UI action on only the Problem (problem) table | `current.getRecordClassName() == 'problem'`

4. Click **Update**.

**Associate a task with an outage**

You can associate multiple tasks with a defined outage.

Role required: itil

The administrator must configure the Outage form to include the Tasks related list.

1. Navigate to the outage record.
2. Click **Edit** in the Tasks related list.
   - All incident and problem tasks are listed. For new instances in Jakarta, change requests are also listed.
3. Use the filter or the search field above the **Collection** box to locate the task to associate to the outage.
   - For example, filter for the same configuration item or business service, or look for tasks created on the same day as the outage.
4. Move the associated tasks to the **Task List** box on the right.
5. Click **Save**.

**Create an outage from a task**

Create an outage from a task record to understand the down time of a configuration item.

Role required: itil or admin

The **Create Outage** UI action is added for the Task (task) table. When the Task-Outage Relationship plugin (com.snc.task_outage) is activated, the Outages related list is added to the related list of the task forms such as Incident, Problem, or Change. If you have the admin role, you can assign multiple tasks to an outage by configuring the Tasks related list to appear on the Outages form.

1. Open the task record.
2. Right-click the header form and select **Create Outage**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique number that identifies the outage.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>Look up icon to select configuration item from the list.</td>
</tr>
</tbody>
</table>
### Field separation for task outage

The topic includes an overview of domain separation and task outage. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Task-Outage Relationship (cmdb_ci_outage) is not domain separated. If installed, the Task-Outage Relationship table is not domain separated. Fulfillers can view any Task-Outage Relationship records regardless of the domain that the records belong to. The Task-Outage Relationship table is installed when administrator activates the optional Task-Outage Relationship plugin.

### Collaboration services

Collaboration services provides a way to communicate and collaborate in real time. You can directly use a collaboration tool from task records and as a channel within communication plans.

### Compatibility

Compatible with all the releases starting with the Madrid release.

### Key features

- Add Slack as a collaboration channel when creating communication plans for tasks.
- Create a dynamic slack channel for a task based on pre-defined communication plans.
- Add or remove users from the slack channel by managing recipients on the task record.
- Post a message to the channel to collaborate with support teams or send a communication to keep stakeholders informed.
• Archive the channel when the task is closed.

Install Collaboration services

You can install the Collaboration services application (sn_tcm_collab_hook) if you have the admin role.

• Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

• Collaboration services requires the following ServiceNow Store applications. Ensure that these applications are installed before you install Collaboration services.

Required ServiceNow Store applications

Slack Spoke for ServiceNow IntegrationHub (com.sn.slack.ahv2)

If you want Slack integration for tasks or task communication management, install the Slack Spoke for ServiceNow IntegrationHub application. The application provides actions that you can use when designing flows. These actions allow you to communicate with Slack APIs.

ServiceNow for Microsoft Teams

If you want to integrate ServiceNow for Microsoft Teams, install the IT Service Management integration with Microsoft Teams or HR Service Delivery integration with Microsoft Teams applications as required. For more information on the integration, see IT Service Management integration with Microsoft Teams and HR Service Delivery integration with Microsoft Teams.

Role required: admin

For the tables that are installed with Collaboration services, refer Components installed with Collaboration services.

1. Navigate to System Applications > All Available Applications > All.

2. Find the application ( ) using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install .

4. Optional: If demo data is available and you want to install it, click Load demo data.

   Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don’t load the demo data during installation, it’s unavailable to load later.
5. Click **Install**.

### Components installed with Collaboration services

Several types of components are installed with activation of the Collaboration services application.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see *Find components installed with an application*.

#### Tables installed

**Note:** The tables are installed when you activate the Task Communications Management plugin (com.snc.task_communication_management).

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Channel Definition — Slack (comm_channel_def_slack)</td>
<td>Extends the Communication Channel Definition (comm_channel_definition) table.</td>
</tr>
<tr>
<td>Communication Channel — Slack (comm_channel_slack)</td>
<td>Extends the Communication Channel Definition (comm_channel) table.</td>
</tr>
<tr>
<td>Communication Plan — Collaboration Service Data (comm_plan_collab_data)</td>
<td>Stores Collaboration Service related data.</td>
</tr>
</tbody>
</table>

### Setting up Slack for communication

The Slack spoke requires creating a custom app on your Slack account to generate OAuth 2.0 tokens for the Slack spoke.

For more information, refer to *Set up Slack spoke*.

### Configure Slack as a communication channel for a communication task

Configure Slack as a mode of communication for a communication task to send direct message to the users.

Role required: admin

1. Navigate to **Incident > Communication Plan Definitions**.
2. Open the communication plan where you want to add Slack as a communication channel for a communication task.
3. Open the communication task definition for which you want to add Slack as the mode of communication.
4. Click the **Add Channel — Slack** related links.
5. Click **Submit**.
Slack gets added as a communication channel for the communication task.

**Process flow for Slack communication**

Collaborate with the stakeholders from major incident management workbench using slack for an open and transparent communication.

Define a communication plan to manage the communication process. The plan includes tasks to achieve the plan goal and the stakeholders whom you must contact in the process.

When you create communication tasks for a plan, select slack as a mode of communication. To know how to define a channel for any communication task, refer to Define a communication channel. Keeping in mind the fact that it not always possible to plan for a communication plan or task in advance, you have the option to create adhoc communication plan and its tasks from an incident. When any task record meets the conditions in the communication plan, the plan gets attached with the task record. If for a major incident, a communication plan gets attached to the incident which has communication channel as slack for any of its tasks, you can send slack notifications from the major incident workbench.

**Note:** The slack communication is a one-way communication from ServiceNow application to slack. The contacts in the slack cannot reply to the person who initiated the slack communication. Also, the users in slack must be employees of the organization. For example, the email address that they share for participating in a slack collaboration must be their email address of that organization.

Slack communication uses the following subflows:
- TCM Slack – Add Users to Channel
- TCM Slack – Archive Channel
- TCM Slack – Create Channel
- TCM Slack – Send Message
- TCM Slack – Remove User From Channel

**Slack communication through workbench**

- In the major incident workbench, under the Communications tab, you can find all the communication tasks for the plan.
- For the task where you have selected slack as a channel, you can click Send to start a slack communication.
- In the dialog box, the To field includes the contacts that you have added while creating the communication contact for the plan.
- The Channel field is filled with the communication plan number.

**Note:** The same communication plan number appears as the group name in the slack when you send the communication.

- If you add or remove any user from the contact list in the application, a message appears in slack for the same.
- When you resolve or close the incident, the slack group is automatically archived.
**Slack integration - Incident Management**

With Slack integration, you can create a dedicated channel for incident responders to collaborate during an incident enabling bidirectional integration with slack. You can create and update an incident, view information such as who is on-call for a group or view the list of incidents assigned to you.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**Compatibility**

The Collaboration services store app version 2.0.x is compatible with all the releases starting with the Paris Patch 3 release.

**Key features**

- Send a direct message to the caller
- Assign the incident to a user
- Create a collaboration channel for an incident
- View and join a channel from an incident
- Create and update incident using a Slash Command
- View who is on-call for a group

**System requirements**

Ensure that the system has the following plugins installed:

- Incident Management (com.snc.incident)
- Collaboration services plugin (sn_tcm_collab_hook) version 2.0.x
- Slack Spoke for ServiceNow IntegrationHub plugin (com.sn.slack.ahv2) version 1.3.x and the necessary IntegrationHub license to use Slack as a collaboration channel.

**Note:** The Slack spoke requires creating a custom app on your Slack account to generate OAuth 2.0 tokens for the Slack spoke. For more information, refer Set up Slack spoke.

**Create slack channel for incident**

Create a private or a public slack channel to collaborate with support teams or send a communication to keep stakeholders informed.

- Role required: sn_incident_write, itil, or admin
- Plugins required:
- Collaboration services plugin (sn_tcm_collab_hook) version 2.0.x
- Slack Spoke for ServiceNow IntegrationHub plugin (com.sn.slack.ahv2) version 1.3.x

- Ensure you have set up interactivity and shortcuts for slack. For more information, refer configure slack app.

The system property `sn_tcm_collab_hook.slack_on_task` enables the slack feature on a task table. By default, the value is incident. If you want to enable the slack feature on other task tables such as problem or change_request, add the table names in the Value field.

1. Navigate to **Incident > Open**.
2. Open an active incident record.
3. Click the **Create Slack Channel** related link.

![Create slack channel form](image)

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add participants</td>
<td>Individual users or groups whom you want as participants to the channel.</td>
</tr>
</tbody>
</table>
### Recommended and Selected

Columns to personalize your list. Select the items in the **Recommended** column and move them to the **Selected** column using the right-arrow icon (➡️).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Channel name</strong></td>
<td>Unique name of the channel that differentiates it from the rest of the channels in Slack.</td>
</tr>
<tr>
<td><strong>Channel topic</strong></td>
<td>Description about the purpose of the channel.</td>
</tr>
<tr>
<td><strong>Include a brief message for participants</strong></td>
<td>Brief message that you want to send to the participants.</td>
</tr>
<tr>
<td><strong>Private channel</strong></td>
<td>Option to indicate whether the slack channel is private or public. If you select the check box, the channel is created as a private channel else it is created as a public channel.</td>
</tr>
</tbody>
</table>

5. Click **Create channel**.

A slack channel is created and an invitation is sent to the participants. Any duplicate user is removed from the selected participant list before the notification is sent. The participants can click **Skip** or **Join Channel** to ignore or join a slack channel.

### View or join slack channel from incident

View all slack channels associated with an incident to know if a required slack channel already exists before you create a new one.

- **Role required:** sn_incident_write, itil, or admin
- **Plugins required:**
  - Collaboration Services plugin (sn_tcm_collab_hook) version 2.0.x
  - Slack Spoke for ServiceNow IntegrationHub plugin (com.sn.slack.ahv2) version 1.3.x

The system property `sn_tcm_collab_hook.slack_on_task` enables the slack feature on a task table. By default, the value is incident. If you want to enable the slack feature on other task tables such as problem or change_request, add the table names in the Value field.

**Note:** When an incident becomes inactive, the associated slack channels get archived.

1. Navigate to **Incident > Open**.
2. Open an active incident record.
3. Click the **View Slack Channels** related link.
All the dedicated slack channels for the incident are displayed.

**Note:** The Join channel option appears only when the channel is public.

4. Optional: Click View channel to open the slack channel.
5. Optional: Click Join channel to join any slack channel.

### Add form section to view slack channels

View unarchived slack channels associated with an incident in the form section. It saves you the effort of opening the available channel list manually from the related list.

Role required: personalize_form or admin

1. Navigate to Incident > Open.
2. Open an incident record.
3. Click the Additional actions icon and select Configure > Form Layout.
   For more information, refer Configuring form layouts.
4. Under Form view and section, in the Section field, click New.
5. In the Section caption field, enter a name for the section such as Slack Channels and click OK.
6. From the Available column, select View Slack Channels and move it to the Selected column using the right-arrow icon ( ).
7. Click Save.
   The new section displays all the active slack channels.
### Slack Channels

<table>
<thead>
<tr>
<th>Channel name</th>
<th>Channel topic</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>@inc0010112-network</td>
<td>Troubleshoot network issues</td>
<td>View channel</td>
</tr>
<tr>
<td>@inc0010112-device</td>
<td>Track the status</td>
<td>View channel</td>
</tr>
<tr>
<td>@inc0010112_support</td>
<td>Internal support</td>
<td>View channel</td>
</tr>
<tr>
<td>@inc0010112_review</td>
<td>Troubleshoot hardware issues</td>
<td>View channel Join channel</td>
</tr>
</tbody>
</table>
**Set up slack for a user or group**

Set up slack from an incident to communicate and work together in channels with a user or a group.

Role required: admin

To enable slack for the **Assignment group** field, ensure you have set up a slack channel for that group. For more information, refer Associate existing slack channel with a group.

1. Download the Fix script to add Slack field decorators update set to get the fix scripts from ServiceNow Store app.
2. Import the update set file.
   For more information, refer Import an update set.
3. Navigate to System Definition > Fix Scripts.
4. Open the Add Slack Field Decorator fix script.
5. Optional: In the Scripts field, edit the script to indicate the table and the field for which you want to enable the slack communication.
6. Click Run Fix Script.

The slack icon ( ) appears next to the fields mentioned in the script. Clicking the icon takes you to the direct message with the user on slack or slack channel for an assignment group.

**Associate existing slack channel with a group**

Associate an existing slack channel to reach out to an assignment group from an incident. Assignment groups are a great way to contact all your stakeholders at once.

Role required: sn_slack_ah_v2.slack_admin or admin

1. Navigate to Slack > Slack Channel Cache and click New.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Name</td>
<td>Name of the existing slack channel.</td>
</tr>
<tr>
<td>Channel ID</td>
<td>Unique id given by slack for a channel.</td>
</tr>
<tr>
<td>Channel Topic</td>
<td>Description about the purpose of the channel.</td>
</tr>
<tr>
<td>Channel Link</td>
<td>URI scheme to deep link into a user’s native Slack client. Example: slack://channel?team={TEAM_ID}&amp;id={CHANNEL_ID}, where &lt;TEAM_ID&gt; is slack workspace id and &lt;CHANNEL_ID&gt; is the unique id for the slack channel.</td>
</tr>
</tbody>
</table>

**Note:** For more information, refer Deep linking into Slack.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document ID</td>
<td>The group record for which channel is intended to be used.</td>
</tr>
<tr>
<td></td>
<td>- Table: Group (sys_user_group)</td>
</tr>
<tr>
<td></td>
<td>- Document: &lt;Reference to a group&gt;</td>
</tr>
<tr>
<td>Is Archived</td>
<td>Option to indicate whether the slack channel is active or inactive.</td>
</tr>
<tr>
<td>Is Private</td>
<td>Option to indicate whether the slack channel is private or public.</td>
</tr>
<tr>
<td>Creator</td>
<td>User who creates the slack channel cache record.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

### Open slack from an incident

Open slack from an incident and send message to a user or an assignment group to exchange incident information. You do not need to manually search for a user in slack to send a message.

Role required: sn_incident_read, sn_incident_write, itil, or admin

The slack icon (습) appears for the fields that you include in the fix script. For example, if you have the **Caller**, **Assigned to**, and the **Assignment group** fields for incident in the fix script, then the icon appears for these fields.

1. Navigate to **Incident > Open**.
2. Open an active incident record.
3. Click the slack icon (습) that appears next to the **Caller**, **Assigned to**, or the **Assignment group** fields.
4. In the Open Slack dialog, click **Open Slack**. A direct message with the user on slack or a slack channel opens for the group.

### Slack slash commands

Slash commands provides a quick way to invoke your app to perform specific actions from Slack.

You need to **configure slash commands** to execute the commands. Only a user with the sn_incident_write, itil or an admin role can execute the commands.

#### Slash commands

<table>
<thead>
<tr>
<th>Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/now help</td>
<td>Provides list of available ServiceNow commands with description.</td>
</tr>
<tr>
<td>Commands</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>/now create incident</td>
<td>Creates an incident with the inputs provided by the user.</td>
</tr>
<tr>
<td>/now list incidents</td>
<td>Lists all active incidents assigned to the user.</td>
</tr>
<tr>
<td>/now oncall (group name)</td>
<td>Displays shifts and members who are currently on-call for a group.</td>
</tr>
<tr>
<td>Note: Only a user with the ITIL or the admin role can execute this command.</td>
<td></td>
</tr>
<tr>
<td>/now comment (comment)</td>
<td>Posts a comment in the Additional comments field of the associated incident.</td>
</tr>
<tr>
<td>/now note (note)</td>
<td>Posts a note in the Work notes field of the associated incident.</td>
</tr>
<tr>
<td>/now assigntome</td>
<td>Assigns associated incident to the slack user.</td>
</tr>
<tr>
<td>/now assign (@slack_user)</td>
<td>Assigns associated incident to a specific user.</td>
</tr>
</tbody>
</table>

### Vendor Manager Workspace

Monitor the performance of your company’s vendors and manage all vendor-related information using the ServiceNow® Vendor Manager Workspace. Assess vendor performance using configurable vendor metric indicators.

Track and analyze how your vendors are executing on their goals and which areas need attention from a unified, central location. Integrate data from Service Portfolio Management (SPM), Contract Management, Assets, SLA Contracts, Vendor Risk Management, and Continual Improvement Management (CIM) applications.

### Vendor Manager Workspace in action

Here’s how agents use Vendor Manager Workspace.

### Key features

**Data in a unified location**

View vendor profile and manage the performance of your company’s vendors in a unified location.
Comprehensive vendor information layout

Analyze historical vendor health using a comprehensive layout of all information related to a vendor and its services.
# Vendor Satisfaction

**November 26, 2019**

<table>
<thead>
<tr>
<th>Assessment Metric</th>
<th>This Month</th>
<th>Previous Month</th>
<th>Previous 3 Months</th>
<th>Previous 6 Months</th>
<th>Previous 12 Months</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addresses questions and issues in a timely manner</td>
<td>Low: 38.60%</td>
<td>Low: 28.00%</td>
<td>Low: 15.00%</td>
<td>Low: 55.00%</td>
<td>Low: 47.00%</td>
</tr>
<tr>
<td>Analyses and reviews problem</td>
<td>Good: 100.00%</td>
<td>Moderate: 75.00%</td>
<td>Moderate: 75.00%</td>
<td>Moderate: 75.00%</td>
<td>Low: 50.00%</td>
</tr>
<tr>
<td>Applies lessons from previous errors</td>
<td>Low: 28.00%</td>
<td>Low: 20.00%</td>
<td>Low: 15.00%</td>
<td>Low: 45.00%</td>
<td>Low: 40.00%</td>
</tr>
<tr>
<td>Communicates effectively</td>
<td>Good: 100.00%</td>
<td>Moderate: 75.00%</td>
<td>Good: 95.00%</td>
<td>Moderate: 75.00%</td>
<td>Moderate: 60.00%</td>
</tr>
<tr>
<td>Fosters a collaborative environment</td>
<td>Low: 50.00%</td>
<td>Moderate: 75.00%</td>
<td>Moderate: 55.00%</td>
<td>Low: 54.00%</td>
<td>Low: 45.00%</td>
</tr>
<tr>
<td>Proposes relevant solutions</td>
<td>Trivial: N/A</td>
<td>Good: 30.00%</td>
<td>Low: 15.00%</td>
<td>Moderate: 75.00%</td>
<td>Moderate: 41.00%</td>
</tr>
</tbody>
</table>

**Vendor Satisfaction**

**Dec 2019**

- **77.07%**
  - **21.08% (28.0%)**
  - Target: 90.00% (Cop): -3.33% (-0.7%)
Integrated application data

Use aggregated data from multiple applications and measure vendor performance using qualitative and quantitative metrics.
Get started

Select a tile to get started.

- **EXPLORE**: Agents and system administrators go here to learn about Workspace.
- **SET UP**: System administrators go here to set up Workspace.
- **USE**: Agents go here to learn how to use Workspace.

Explore Vendor Manager Workspace

Vendor Manager Workspace allows you to monitor metrics and analyze your vendor's health from a single user interface. Get to know how metric models are created and configured for vendors and how they are used in the Vendor Manager Workspace.

**Tip:** For an example of how you can implement and use the Vendor Manager Workspace application, go to Sample Vendor Manager Workspace setup and use

The image below shows the work flow for Vendor Manager Workspace application.
As a vendor administrator, in the ServiceNow® platform:

- **Create vendor score metric models** for evaluating your vendors.

  **Note:** Vendor score metric models are also referred to as vendor scoring models.
• Configure up to six indicators for each metric model to calculate vendor score that can be used to measure vendor health.
• Add more indicators to monitor vendor health in other areas.

As a vendor manager, in the Vendor Manager Workspace:

• Associate the metric models with the vendors.
• Monitor the performance of your company’s vendors in a single interface.
• Access the vendor directory to view vendors you personally manage and also view all vendors your business contracts with.
• Analyze performance metrics for vendors as well as the metrics for associated service offerings, contracts, improvement initiatives, and SLA definitions.
• Drill deeper into each metric report to view trends and historical performance.

The Vendor Manager Workspace application includes two major components for configuring and analyzing vendor scores: the vendor score metrics model module and the vendor manager workspace.

Understanding the vendor score metric model

Use metric models to customize the data you want to analyze for different types of vendors. For example, to monitor mean time to resolution by your vendor’s assignment groups, you can add performance indicators specific to that measurement in the metric model. You can then add that metric model to all contract-related vendor profiles.

Create vendor score metric models from the Vendor Score Metric Models module to analyze vendor metrics. A metric is a standard of measurement used for assessing the effectiveness of a process.

Each metric model includes:

• Vendor score metric model indicators and configurable attributes
• Additional metrics
• A list of all vendors associated with this metric model

Vendor score metric model

Create a metric model that allows you to select a set of metrics to apply and assess different groups of vendors. Define upper and lower threshold values that you can apply for each vendor group.

Vendor score metric model indicators

In each metric model, you can include up to six vendor score metric model indicators with a percentage value. The metrics from these indicators are used to calculate the vendor score. The unit of measurement is pre-populated based on the performance analytics indicator you’ve selected and is derived from that indicator record.

When you create an indicator, consider whether you want to use the maximize or minimize direction for that indicator. The vendor score is calculated based on the indicator direction.

Additional metrics

Configure up to 15 additional metrics that have any unit such as days, percentage, or month. All additional indicators configured for a metric model are displayed in workspace.
Vendor Manager Workspace reference

The Vendor Manager Workspace reference section includes descriptions for the vendor score metric model, vendor score indicator, and the scheduled job. These configurations are available by default. The reference also includes an example of how the vendor score is calculated.

IT Services Vendor Score Metric Model

The IT Services vendor score metric model is added by default to vendor records that have one of the following:

- a vendor manager assigned to the company account
- at least one service offering

The IT Services vendor score metric model form includes the following sections:

- Vendor Score Metric Model
- Vendor Score Metric Model Indicators
- Additional Metrics

Vendor Score Metric Model

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The default name, which is IT Services, provided for the metric model.</td>
</tr>
<tr>
<td>Active</td>
<td>Metric model is active by default. Vendors that use this metric model can manage and monitor performance of their IT Service Providers.</td>
</tr>
<tr>
<td>Description</td>
<td>Brief explanation of this metric model.</td>
</tr>
<tr>
<td>Vendor Score Lower Threshold</td>
<td>The lower limit set for this metric model. The default value is set to 60. If this value for a vendor is lower than this threshold, it is highlighted in red.</td>
</tr>
<tr>
<td>Vendor Score Upper Threshold</td>
<td>The upper limit set for this metric model. The default value is set to 80. If this value for a vendor is lower than this threshold, it is highlighted in green.</td>
</tr>
</tbody>
</table>

Vendor Score Metric Model Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Performance Score of Service Offerings</td>
<td>Measures the daily average customer satisfaction on service offerings associated with the vendor. The indicator direction is set to maximize and therefore the score should increase over time.</td>
</tr>
<tr>
<td>Vendor Satisfaction</td>
<td>Provides monthly breakdown of vendor satisfaction scores.</td>
</tr>
</tbody>
</table>

Additional Metrics

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Customer Satisfaction</td>
<td>Measures CSAT scores based on service offerings.</td>
</tr>
<tr>
<td>Indicator</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Average Breached SLA</td>
<td>Calculates average value of breached SLAs.</td>
</tr>
<tr>
<td>Average Availability</td>
<td>Service Portfolio Management average availability as calculated from outage records.</td>
</tr>
<tr>
<td>Average Stability</td>
<td>Provides average values calculated from a combination of P1 and major incident counts.</td>
</tr>
<tr>
<td>Average Request Activity</td>
<td>Average value calculated from fulfilled request items derived from service portfolio catalog items. These items must be connected to service offerings.</td>
</tr>
</tbody>
</table>

These metrics are based on Service Portfolio Management service offerings. For more information on these metrics, refer to [Service Owner Workspace performance metrics](#).

**Vendor score indicator**

The **Vendor Score** indicator is an automated indicator. It is used for calculating and displaying the vendor score. The calculation is done based on all indicators added to the metric model for evaluating vendor performance.

**Schedule job**

The **VMW Update Vendor Score** scheduled job runs daily and updates the score. You can run this job on-demand to get updated scores at any time.

The **VMW Update Vendor Profile** scheduled job runs monthly and updates all vendor profiles. You can run this job on-demand to get updated vendor profiles at any time.

**Calculating the vendor score**

The table below provides an example of how a vendor score is calculated.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Indicator weight</th>
<th>Indicator metric score</th>
<th>Indicator score that contributes towards vendor score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Satisfaction</td>
<td>10.00%</td>
<td>54.42%</td>
<td>5.442%</td>
</tr>
<tr>
<td>Average Customer Satisfaction</td>
<td>55.00%</td>
<td>83.00%</td>
<td>45.65%</td>
</tr>
<tr>
<td>Average Breached SLA</td>
<td>25.00%</td>
<td>88.50%</td>
<td>22.125%</td>
</tr>
<tr>
<td>Average Stability</td>
<td>10.00%</td>
<td>100.00%</td>
<td>10.00%</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td></td>
<td></td>
<td><strong>83.217%</strong></td>
</tr>
</tbody>
</table>
The total vendor score has been rounded up to 83.22%. The score is also highlighted in the header with colors that are distinct for values that fall within the threshold or when they go above or below the threshold.

**Note:** The vendor score is impacted based on the whether the *direction for the indicator* is set to maximize or minimize. Below is an example that shows how the vendor score is impacted based on the indicator direction.

### Vendor score impacted by indicator direction

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Direction</th>
<th>Indicator weight</th>
<th>Indicator metric score</th>
<th>Indicator score that contributes towards vendor score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Satisfaction</td>
<td>Maximize</td>
<td>10.00%</td>
<td>54.42%</td>
<td>5.442%</td>
</tr>
<tr>
<td>Average Customer Satisfaction</td>
<td>Maximize</td>
<td>55.00%</td>
<td>83.00%</td>
<td>45.65%</td>
</tr>
<tr>
<td>Average Breached SLA</td>
<td>Minimize</td>
<td>25.00%</td>
<td>88.50%</td>
<td>2.875% ((100 - 88.5) \times 0.25)</td>
</tr>
<tr>
<td>Average Stability</td>
<td>Minimize</td>
<td>10.00%</td>
<td>100.00%</td>
<td>0%</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td></td>
<td></td>
<td></td>
<td><strong>53.967%</strong></td>
</tr>
</tbody>
</table>

### Analyzing indicator scores in Vendor Manager Workspace

You can use monthly aggregates or running averages to analyze metrics for an indicator with a daily or monthly data collection frequency.

To understand how the Performance Analytics application collects data, see *Performance Analytics data collection*.

### Sample representation of indicator scores calculated using monthly aggregates

The example in the figure shows the monthly aggregate values for an indicator.
The table describes what data is displayed for each time period assuming the current month is March.

<table>
<thead>
<tr>
<th>Data collection time period</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mar 2020</td>
<td>Displays the value of data collected from March 1, 2020 to the current day.</td>
</tr>
<tr>
<td>Feb 2020</td>
<td>Displays the value of data collected for February 2020.</td>
</tr>
<tr>
<td>Dec 2019</td>
<td>Displays the value of data collected for December 2019.</td>
</tr>
<tr>
<td>Sept 2019</td>
<td>Displays the value of data collected for September 2019.</td>
</tr>
<tr>
<td>Mar 2019</td>
<td>Displays the value of data collected for March 2019.</td>
</tr>
</tbody>
</table>

Sample representation of indicator scores calculated using running average values

The example in the figure shows the running average values for an indicator.
# Average Customer Satisfaction

## April 2020

65.60%

<table>
<thead>
<tr>
<th>Service Offerings</th>
<th>This month</th>
<th>Previous Month</th>
<th>Previous 3 Months</th>
<th>Previous 6 Months</th>
<th>Previous 12 Months</th>
</tr>
</thead>
<tbody>
<tr>
<td>Laptops</td>
<td>Low: 63.9%</td>
<td>Low: 60.9%</td>
<td>Low: 45.1%</td>
<td>Low: 46.5%</td>
<td>Low: 64.0%</td>
</tr>
<tr>
<td>New Email Service Node for Acer</td>
<td>Good: 100.0%</td>
<td>Good: 100.0%</td>
<td>Good: 90.0%</td>
<td>Good: 90.0%</td>
<td>Good: 90.0%</td>
</tr>
<tr>
<td>Acer New Email Service Model</td>
<td>Low: 60.9%</td>
<td>Low: 60.9%</td>
<td>Low: 60.9%</td>
<td>Low: 60.9%</td>
<td>Low: 60.9%</td>
</tr>
<tr>
<td>Acer New Email Service Model2</td>
<td>Low: 60.9%</td>
<td>Low: 60.9%</td>
<td>Low: 60.9%</td>
<td>Low: 60.9%</td>
<td>Low: 60.9%</td>
</tr>
<tr>
<td>Acer New Email Service Model3</td>
<td>Low: 60.9%</td>
<td>Low: 60.9%</td>
<td>Low: 60.9%</td>
<td>Low: 60.9%</td>
<td>Low: 60.9%</td>
</tr>
<tr>
<td>Acer New Email Service Model4</td>
<td>Good: 90.0%</td>
<td>Good: 50.0%</td>
<td>Moderate: 55.0%</td>
<td>Moderate: 55.0%</td>
<td>Moderate: 55.0%</td>
</tr>
</tbody>
</table>
The table describes what data is displayed for each time period.

<table>
<thead>
<tr>
<th>Data collection time period</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>This Month</td>
<td>Displays the average value of data collected for the current month.</td>
</tr>
<tr>
<td>Previous Month</td>
<td>Displays the average value of data collected for the previous month.</td>
</tr>
<tr>
<td>Previous 3 Months</td>
<td>Displays the average value of data collected for the last three months.</td>
</tr>
<tr>
<td>Previous 6 Months</td>
<td>Displays the average value of data collected for the last six months.</td>
</tr>
<tr>
<td>Previous 12 Months</td>
<td>Displays the average value of data collected for the last 12 months.</td>
</tr>
</tbody>
</table>

**Vendor Manager Workspace user interface**

The Vendor Manager Workspace is a unified interface that allows you to monitor all aspects of vendor performance.

Using the Vendor Manager Workspace, for each vendor profile, you can view and analyze:

- Vendor score for the selected vendor
- Vendor score metric model indicator metrics
- Additional indicator metrics

You can also drill down into the vendor score indicator metrics and the additional indicator metrics to analyze the metric breakdown.

**Vendor score for the selected vendor**

The vendor score is the sum of the score of all vendor score metric model indicators added to the metric model. It also considers the percentage weight value assigned to each indicator. For information on how to calculate the vendor score, see *Calculating the vendor score*. The workspace header displays the score as a highlighted value.

**Vendor score metric model indicator metrics**

The Vendor Score Metrics section displays the vendor score metric model indicator metrics and the weight for each metric. You can view the daily and monthly breakdown for each indicator by clicking *View breakdown*. For example, you could have a metric to analyze potential savings for products. The breakdown would show the savings for each product per month.

The indicator metric values are highlighted as follows:

- Red—below the lower threshold.
- Amber—within the lower and upper threshold.
- Green—above the upper threshold.

For information on customizing the colors for the highlights, refer to *Highlight list fields in a workspace*.

**Additional indicator metrics**

The Additional Metrics section displays the metrics for additional indicators. Click an indicator to view and analyze the metric breakdown for that indicator.

**Refreshing the score with scheduled jobs**

The *VMW Update Vendor Score* scheduled job runs daily. You can run this job at any time to refresh the data.
**Set up Vendor Manager Workspace application**

Bring in data from other ServiceNow applications to assess the relationship with your vendors. Segregate and analyze data between business entities using domain separation. Validate configuration changes to your instance using quick tests.

**Vendor Manager Workspace Integrations**

Increase the benefits of and complete your Vendor Manager Workspace experience by aligning with the following applications:

- **Service Portfolio Management and Service Owner Workspace**—Understand the active service offerings and unique service offering subscribers associated with your vendors. Use this information to evaluate the business impact a vendor has on your company.
- **Asset Management**—Track and analyze assets related to your vendors.
- **Continual Improvement Management**—Track performance improvements or optimization initiatives by viewing the continual improvement initiatives a vendor is engaged in.
- **Contract Management**—Discover how many active contracts a vendor has to evaluate the financial impact the vendor has on your company.
- **Service Level Management**—Find out how many active SLA definitions a vendor has to monitor their service level agreements with your company.
- **Vendor Assessments**—Use data collected in vendor assessments to evaluate, score, and rank vendors.
- **Vendor Risk Management**—Use a centralized process to view and manage risks associated with your vendor portfolio and completing the vendor assessment and remediation life cycle.

**Browser support for workspaces**

Do not use Internet Explorer 11 to access any workspaces. Internet Explorer 11 is not supported. See KB0683275 for more information on Internet Explorer 11, and see Browser support for more information about supported browsers that you can use across the platform.

**Activate Vendor Manager Workspace**

The Vendor Manager Workspace (com.snc.vlm.vmw) plugin is available as a separate subscription. This plugin activates related plugins if they are not already active.

Role required: admin

You can use guided setup to configure the Vendor Manager Workspace application on your instance. Navigate to Vendor Manager Workspace > Configuration > Guided Setup to access the guided setup.

If your organization has purchased the Vendor Manager Workspace subscription, you can subscribe to and activate the plugin. To verify if your company has purchased the plugin, refer to View the applications and plugins that are included with a subscription.
## Vendor Manager Workspace plugins

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
</table>
| Vendor Manager Workspace (com.snc.vlm.vmw)   | Activates the Performance Analytics - Premium (com.snc.pa.premium) plugin which adds the following functionality to Vendor Manager Workspace:  
  - Create indicators, breakdowns, and other records.  
  - Create text analytics widgets.  
  - Use Performance Analytics with external data.  
  - Preserve performance scores beyond 180 days.  
  Activates the Service Owner Workspace (com.spm_owner_workspace) plugin which adds the following functionality:  
  - Measure the performance of your vendor's services and service offerings.  
  - Analyze data across multiple portfolios that have common metrics between the two applications.  
  Activates all related plugins that are not already active. |

## Additional plugins for data integration from other applications

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continual Improvement Management CIM (com.sn_cim)</td>
<td>You can subscribe to this plugin and activate it to monitor the continual improvement initiatives that your vendors are engaged with.</td>
</tr>
<tr>
<td>Contract Management (com.snc.contract_management)</td>
<td>You can subscribe to this plugin and activate it to monitor your vendor contracts.</td>
</tr>
<tr>
<td>Risk Management (app-grc) and (app-vendor-risk-management)</td>
<td>If you have the Risk Management application available from the ServiceNow Store, you can view the risk rating for your vendors. For more information on downloading the Risk Management application, refer to <a href="#">Download Risk Management</a>.</td>
</tr>
</tbody>
</table>

1. Navigate to **System Applications > All Available Applications > All**.  
2. Find the plugin using the filter criteria and search bar.  
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in [Request a plugin](#).  
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.
Installed with Vendor Manager Workspace

Vendor Manager Workspace provides a single destination for you to view and manager your vendors.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Vendor Manager Workspace

When you activate Vendor Manager Workspace, the following components are installed.

Roles installed with Vendor Manager Workspace

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor admin (sn_vlm.vendor_admin)</td>
<td>Can create, edit, or delete vendor types and vendor score metric models in Vendor Manager Workspace</td>
<td>sn_vlm.vendor_manager</td>
</tr>
<tr>
<td>Vendor Manager (sn_vlm.vendor_manager)</td>
<td>Views and manages vendors using Vendor Manager Workspace.</td>
<td>pa_viewer, service_viewer</td>
</tr>
<tr>
<td></td>
<td>Configures vendor performance metrics for use in Vendor Manager Workspace.</td>
<td></td>
</tr>
</tbody>
</table>

Tables installed with Vendor Manager Workspace

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Score Metric Model (sn_vlm_vmw_vendor_score_metric_model)</td>
<td>Stores the metric models created to calculate vendor score.</td>
</tr>
</tbody>
</table>

Domain separation in Vendor Manager Workspace

Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

The Vendor Manager Workspace application uses performance analytics to collect data and provides Level 3 — Tenant self-managed configuration domain separation support.
Request Vendor Manager Workspace Domain Separation

The Domain Support - Domain Extensions Installer plugin (com.glide.domain.msp_extensionsinstaller) must be activated by ServiceNow personnel. After this plugin has been activated, as an administrator, you can activate the Performance Analytics - Domain Support plugin (com.snc.pa.domain_support) plugin.

The Performance Analytics - Domain Support plugin (com.snc.pa.domain_support) must be activated to enable the features for Vendor Manager Workspace

Configure domain separation for Vendor Manager Workspace

Configure domain separation for Vendor Manager Workspace to collect vendor scores and analyze the data for a specific domain. Configure domains for vendor score metric models.

Role required: pa_data_collector or admin

1. Configure a domain to collect vendor score performance analytics data for that domain.
   1. Navigate to Performance Analytics > Data Collector > Domain Configurations.
   2. Create a domain configuration for Vendor Manager Workspace
      a. Click New.
      b. In the Name field, enter a name for the configuration.
      c. In the Configuration type menu, select Conditions.
      d. In the Aggregate options section, select the Collect children check box to collect scores from all child domains.

3. Right-click the form header and click Save.
4. Add the following performance analytics jobs to the related list:

   Note: If you do not have the Jobs related list, you must configure the form to display the related list.

   - VMW Scheduled Data Collection
   - VMW Weight Collection
   - VMW Daily Data Collection
   - VMW Vendor Score Collection

5. Click Update.

For more information on creating or scheduling a data collection job, refer to Create or schedule a data collection job

Note: The Performance Analytics application:

- Runs the job and collects the score as the Run as user.
- Collects the scores only for the domain in which the logged-in user runs the job. The scores are not visible to vendor admins or vendor managers who are not part of that domain in Vendor Manager Workspace.
2. Configure a domain to assign a vendor score metric model to a domain.
   1. Navigate to Vendor Manager Workspace > Vendor Score Metric Models
   2. Do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure the Vendor Score Metric Model list</td>
<td>1. Click the personalize icon.</td>
</tr>
<tr>
<td></td>
<td>2. Move Domain from the Available to the Selected column.</td>
</tr>
<tr>
<td></td>
<td>3. Click OK</td>
</tr>
</tbody>
</table>

Configure a Vendor Score Metric Model form

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. From the list, select a vendor score metric model.</td>
</tr>
<tr>
<td></td>
<td>2. Right-click the context menu icon and select Configure &gt; Form Layout. Make sure you are in the Vendor Manager Workspace section.</td>
</tr>
<tr>
<td></td>
<td>3. Move Domain from the Available to the Selected column.</td>
</tr>
<tr>
<td></td>
<td>4. Click Save.</td>
</tr>
</tbody>
</table>

Quick start tests for Vendor Manager Workspace

Validate that Vendor Manager Workspace still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Vendor Manager Workspace quick start tests require activating the Vendor Manager Workspace plugin (com.snc.vlm.vmw) and loading demo data.

**Vendor Manager Workspace - Tests test suite**

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>VLM: Create a Vendor</td>
<td>Track problems with the Vendor Manager Workspace plugin after upgrade. Create a new vendor.</td>
<td>New York</td>
</tr>
</tbody>
</table>

Generate the Vendor Satisfaction Assessment

Use Assessments and Surveys to assess how satisfied your stakeholders are with the vendors they collaborate with. View the base-system pre-configured Vendor Satisfaction Assessment and decide to generate the assessment as is or modify it to best meet your needs.
Role required: assessment_admin or sn_vlm.vendor_manager

The **Vendor Satisfaction Assessment** indicator provided by default measures the satisfaction of stakeholders who collaborate with your vendors.

1. Navigate to **Assessments > Metric Definitions > Types**.
2. Click **Vendor Satisfaction Assessment** to open the pre-configured form.
3. Review the assessment and if it meets your needs as is, click **Generate Assessments**. Alternatively, you can edit the form, click **Update** to save the changes and then click **Generate Assessments**.

   To edit the form fields and for detailed information about Assessments and Surveys, refer to [Configure an assessment, Assessments, and Survey Management](#).

### Sample Vendor Manager Workspace setup and use

Understand how vendor score metric models are set up and how vendor scores are calculated and displayed in the Vendor Manager Workspace based on an example.

**Setup and use Vendor Manager Workspace with three simple steps:**

1. Create vendor score metric models
2. Assign metric models to vendors
3. Analyze vendor health using Vendor Manager Workspace

### Setting up a vendor score metric model

Using the vendor admin role, you can create or modify vendor score metric models. **Creating vendor score metric model indicators**

Create vendor score metric models. Add vendor score metric model indicators that contribute to the vendor score calculation. You can also add additional indicators that display in Vendor Manager Workspace.

Let's assume a vendor manager wants to measure his Cloud MSPs against metrics specific to that vendor type. To create a metric model, provide a name for the metric model. Define the upper and lower vendor score thresholds for this metric model. These thresholds would apply for all vendors that use this metric model model.

The vendor score for vendors that have this vendor score metric model assigned are highlighted with a different color in the Vendor Manager Workspace based on the threshold limits.

- **Red**—lower than the set threshold limit
- **Amber**—within the set threshold
- **Green**—higher than the set threshold limit

The image below shows how the configuration parameters for the vendor score metric model in the platform display in Vendor Manager Workspace.
The vendor score for a vendor is calculated based on the sum of each vendor score metric model indicator score that comprises the metric model taking into consideration the percentage weight value assigned to each indicator. For more information on how a vendor score is calculated, see Calculating the vendor score.

Adding vendor score indicators to the metric model

Add up to six vendor score metric model indicators that meet the following criteria:

- Has a percentage value
- Has a vendor breakdown associated with the company (core_company) table
- Has a frequency that is set to daily or monthly

Set the following parameters for each indicator:

- upper and lower threshold
- the weight in percentage that is applied to the vendor score
- whether you want to apply the SPM threshold or a Vendor Score Metric Model indicator threshold
- whether you want it displayed on Vendor Manager Workspace

The image below displays the breakdown for the vendor score metric model indicators and shows how the configuration in platform displays in Vendor Manager Workspace.
You can view the monthly averages based on running average or a monthly average.
Analyzing the lowest performing scores

If the **Average Performance Score of Service Offerings** indicator is selected in the vendor score metric model indicators or the additional metrics indicators, then the vendor profile will display the lowest performing service offerings for that vendor.

<table>
<thead>
<tr>
<th>Lowest Performing Service Offerings by Performance Score</th>
<th>This month</th>
<th>Previous Month</th>
<th>Previous 3 Months</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Equipment</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>New Email Service Node for Adtran</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

View breakdown

**Additional vendor manager metrics**
Add more indicators to view additional information for the vendor.

**Additional metrics**
The image below shows how the additional metrics configured in platform is displayed in Vendor Manager.
Using a vendor score metric model

As a vendor manager, you can associate vendor score metric models to vendors and analyze the metrics using the Vendor Manager Workspace.

Analyzing metric breakdown

Drill down the data for each metric and evaluate the vendor's performance over the last 12 months.

In workspace, when you click on a widget, you can view the drill down for each metric.

The drill down shows:

- A single score widget with the indicator score
- A time-series widget that displays the trend for the last 12 months
- A breakdown of service offerings for the last 12 months
- The threshold for each service offering highlighted for a visual indication of the performance for that offering.
## Average Performance Score of Service Offerings

**Dec 2019**

### 65.10%

↑ 2.93 (4.7%)

### Service Offerings

<table>
<thead>
<tr>
<th>Service Offerings</th>
<th>This month</th>
<th>Previous Month</th>
<th>Previous 3 Months</th>
<th>Previous 6 Months</th>
<th>Previous 12 Months</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Center Environment Management</td>
<td>Green: 96.1%</td>
<td>Green: 100.0%</td>
<td>Green: 77.7%</td>
<td>Moderate: 73.77%</td>
<td>Moderate: 80.04%</td>
</tr>
<tr>
<td>Data Center Support</td>
<td>Green: 95.0%</td>
<td>Green: 95.0%</td>
<td>Green: 91.0%</td>
<td>Moderate: 74.49%</td>
<td>Low: 13.64%</td>
</tr>
<tr>
<td>Email Cloud</td>
<td>Moderate: 61.7%</td>
<td>Moderate: 62.0%</td>
<td>Low: 60.6%</td>
<td>Low: 67.69%</td>
<td>Low: 57.67%</td>
</tr>
<tr>
<td>Maintenance</td>
<td>Low: 41.1%</td>
<td>Low: 37.1%</td>
<td>Low: 33.2%</td>
<td>Moderate: 41.18%</td>
<td>Low: 37.22%</td>
</tr>
<tr>
<td>Web Hosting</td>
<td>Low: 60.6%</td>
<td>Low: 49.8%</td>
<td>Low: 48.6%</td>
<td>Moderate: 61.27%</td>
<td>Moderate: 60.41%</td>
</tr>
</tbody>
</table>
Qualitative analysis using Vendor Satisfaction Widget

The Vendor Satisfaction indicator gathers data from the vendor satisfaction assessments. If you add Vendor Satisfaction as one of the indicators to calculate vendor score, the breakdown for this widget also displays the number of vendor satisfaction surveys that were sent out and the number of assessments that have been completed.

Create a vendor score metric model

For each metric model, add configurable indicators that contribute to the vendor score. Add more metrics that you can monitor in Vendor Manager Workspace.

Configure performance analytics indicators that you want to add to each vendor score metric model. For a list of indicators that come with your application by default and for information on how a vendor score is calculated, refer to Vendor Manager Workspace reference

Role required: sn_vlm.vendor_admin

You can configure and track up to six vendor score metric model indicators with a percentage value that contribute towards the vendor score. Add 15 more metrics to analyze additional data.

The indicators must meet the following criteria:

- The vendor score metric model indicator must have a percentage value. The additional indicators can be have any unit.
- Has a vendor breakdown on the Company (core_company) table with associated vendors.
- Data collection frequency is set to monthly.

If an indicator breakdown is related to Service Portfolio Management (SPM), you have the option of applying the threshold set for SPM.

For each indicator, configure:

- A weight value—A numeric value that indicates the percentage of contribution towards the vendor score. This value represents the importance of that indicator relative to other indicators in that metric model. Each indicator is weighted against 100% of the combined weight of all indicators added to a metric model. You can choose to include the weight for a metric to calculate the vendor score, but not display in the vendor profile.
- Order of priority—You can also establish the order of priority in which you want these indicators to appear on the vendor profile.
- Thresholds—Define upper and lower limit values to assess vendor performance for each indicator. If the indicator is defined based on service offerings, you can use the Service Portfolio Management (SPM) thresholds already defined in SPM at the portfolio level.

1. Navigate to Vendor Manager Workspace > Configuration > Vendor Score Metric Models.
2. Create a vendor score metric model.
   1. Click New.
   2. Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for the vendor score metric model.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to enable the metric model and apply it to vendors.</td>
</tr>
</tbody>
</table>
3. Right-click the form and click Save.

3. Add indicators to the metric model.

You can add existing indicators to the metric model. If you want to add new indicators, you must create the indicator before adding them to the metric model.

In the **Vendor Score Metric Model Indicators** section, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator</td>
<td>Descriptive name for the indicator.</td>
</tr>
<tr>
<td>Indicator display name</td>
<td>Business-friendly name for the indicator. This name displays in the Vendor Score Metrics widget in Vendor Manager Workspace.</td>
</tr>
<tr>
<td>Weight</td>
<td>The percentage of the total score you would like to attribute to this indicator. The combined weight of all indicators added to a metric model must equal to 100.</td>
</tr>
<tr>
<td>Order</td>
<td>The order of priority in which you want this indicator to display in the Vendor Score Metrics widget in Vendor Manager Workspace.</td>
</tr>
<tr>
<td>Lower Threshold</td>
<td>Lower limit defined for this indicator. You can view the highlighted value seen in the vendor profile.</td>
</tr>
<tr>
<td>Upper Threshold</td>
<td>Upper limit defined for this indicator. You can view the highlighted value seen in Vendor Manager Workspace.</td>
</tr>
<tr>
<td>Apply SPM Thresholds</td>
<td>If this indicator is related to Service Portfolio Management (SPM), you can choose to apply the SPM threshold set for this indicator. By default, this value is set to <strong>true</strong>. To apply the threshold set for the vendor score metric model indicator, set this value to <strong>false</strong>.</td>
</tr>
<tr>
<td>Display</td>
<td>If you select <strong>false</strong>, the indicator widget does not display in workspace.</td>
</tr>
</tbody>
</table>

**Note:** The application uses this metric to calculate the vendor score.

4. In the **Additional Indicators** related list, repeat the steps above to create additional indicators for the metric model. All additional indicators display in workspace.

5. Click **Submit**.

The application creates the vendor score metric model.

**Associate** the vendor score metric model to vendors.
Use Vendor Manager Workspace

Create metric models, add them to vendors and evaluate vendor health using Vendor Manager Workspace.

Associate a vendor score metric model with a vendor

Add metric models to vendors and monitor the metrics using Vendor Manager Workspace.
Role required: sn_vlm.vendor_manager, sn_vlm.vendor_admin, or admin
The metric model must include all performance indicators you want to monitor to measure vendor health.

1. Navigate to Vendor Manager Workspace > Organization > Vendors.
2. In the Name field, select a vendor.
3. In the Vendor Score Metric Model field, click the search icon and select the metric model for this vendor.
4. Click Update.

Note: The metric model must be active to associate it with vendors.

Analyze vendor score metrics

After you add vendor score metric models to vendors, you can analyze the metrics related to all of your vendors in one location.
Role required: sn_vlm.vendor_manager

In workspace, you can sort the list by vendor types and analyze the performance of each vendor type in a single view. You can then drill down to each vendor and analyze additional data. You can also add attachments for the vendor profile in the Vendor Details section and download added attachments.

1. Navigate to Vendor Manager Workspace > Vendor Manager Workspace.
2. Analyze the vendor score. For information on how the vendor score is calculated, refer to Calculating the vendor score.

The color indicator that highlights the vendor score in the header shows you how the vendor is performing based on the set threshold.

Note: The VMW:Update Vendor Score scheduled job is set to run daily. If you want to view updated score, you can run this scheduled job at any time.

3. Click each indicator widget to view the breakdown for that metric.

You can view:
  - A single-score widget that displays the indicator metric.
  - A time-series widget that shows the trend line for the last 12 months
  - A breakdown of related service offerings for the last 12 months
  - Threshold for each indicator highlighted to provide a visual indication for each service offering

For the breakdown on the Vendor Satisfaction indicator, you can also view the Assessments Completed widget that displays the results of vendor satisfaction surveys.
4. Add supporting documents to a vendor profile.

   1. In the Vendor Details section, click the attachments icon.

   2. Click Browse and select the desired file to attach to the profile.

   3. Optionally, you can click the ellipses icon and download, replace, or remove the attachment.

5. Optional: To view additional details, click the preview icon for each service offering and view the information on the service offering.

6. Optional: To view detailed information on the service offering, click Open in Services. The details for the service offering opens in Service Owner Workspace.

Create an improvement initiative for a vendor

Create an improvement initiative for a vendor to track and manage tasks for improving a service, process, or tasks related to vendors.

The Continual Improvement Management (com.sn_cim) plugin must be activated. For more information on activating the plugin, see Request Continual Improvement Management.

You can view your vendor initiatives by navigating to Vendor Manager Workspace > Vendor Improvement Initiatives.

Role required: sn_vlm.vendor_manager, sn_vlm.vendor_admin, or admin

1. Navigate to Vendor Manager Workspace > Vendor Manager Workspace.
2. From the list, go to Vendors > All Vendors.
3. Select a vendor to create the improvement initiative.
4. Create an improvement initiative.

<table>
<thead>
<tr>
<th>To create an initiative</th>
<th>Do this</th>
</tr>
</thead>
</table>
| From the vendor profile | 1. Select the Improvement Initiatives tab.  
2. Click New. |
| From an indicator       | 1. On the vendor profile screen, click the indicator for which you want to create the initiative.  
2. On the indicator screen, click the ellipses icon and then select Create CIM Initiative. |

The Improvement KPI field is automatically populated with the name of the selected indicator.

5. In the Vendor field, select the vendor for which you want to create the initiative.
6. In the Service offering field, select the service offering for which you want to set improvement goals.
7. Fill in all required fields to complete the initiatives. For information on field descriptions, see Improvement field descriptions.
8. Optional: If you want to add supporting documents, click Browse and select the file.
9. Click Save.
Vendor Performance

The ServiceNow® Vendor Performance application is not available for new instances in the Paris release. Vendor Performance is still available on instances upgraded from a previous release. Vendor Performance will remain accessible to you, but will not be supported by ServiceNow. Upgrading to Paris will not affect your content, enabling your continued use of Vendor Performance in the Paris release.

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. *Vendor ticketing and Vendor credit* applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to *Vendor Manager Workspace*.

Vendor managers can use instance assessment tools to evaluate, score, and rank vendors across a variety of categories, such as compliance, product reliability, and user satisfaction. Scorecards incorporate vendor-related information from Configuration Management Database (CMDB) Database (CMDB), Asset Management (including procurement), incident and problem records, and any other service management process.

A typical use for Vendor Performance is to monitor enterprise services delivered by vendors to an organization. Examples include telephony and business machine procurement and maintenance.

### Vendor Performance features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Top tasks</th>
</tr>
</thead>
</table>
| **Vendor management** | Vendor managers create and modify vendor records, vendor types, vendor contacts, and vendor activities, such as demos and trade shows. Vendor managers use the information in scorecards, decision matrices, and bubble charts to examine and make decisions about vendors. | • Add vendors  
• Add vendor contacts  
• Create vendor activities  
• Add a vendor type |
| **Vendor assessments** | Use assessments with Vendor Performance to rank the importance of your vendors and to detect possible problem areas, such as contract breaches and incidents. | • Vendor assessments |
| **Vendor scorecards** | The printable vendor scorecard contains a comprehensive vendor summary and views of vendor ratings, based on assessment results. Use it to compare current and previous assessment results, or to compare results between vendors. | • Vendor scorecards  
• Scorecard ratings |
| **Vendor bubble charts** | Vendor managers create and use bubble charts to compare the relative standing of vendors. A bubble chart is a dynamically updated graph that plots assessment results for multiple vendors. | • Using vendor bubble charts  
• Create a vendor bubble chart |
Vendor decision matrixes

A decision matrix plots assessment results for multiple vendors. Vendor managers use them to compare the relative standing of vendors in selected categories.

**Top tasks**
- Vendor decision matrixes
- View a vendor decision matrix

---

**Vendor ticketing**

Use the vendor ticketing feature to extend vendor performance to establish a relationship between vendors, incidents, and service level agreements (SLAs). Track credits that a vendor owes due to breached service contacts.

An administrator can activate the Vendor Ticketing plugin (`com.snc.vendor_ticket`). It is integrated with Service Portfolio Management, Service Portfolio Management-SLA Commitments, and Task-Outage Relationship. Vendor credits can be issued when SLA commitments are not met and when a vendor issue causes an outage.

**Configuring Vendor Performance**

Plan and define information to use for managing vendors and assessing their performance. Assign vendor managers to manage and maintain vendor contacts, activities, and performance.

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. **Vendor ticketing and Vendor credit** applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to [Vendor Manager Workspace](#).

Vendor records are entered into the Company (core_company) table with the **Vendor** check box selected. The Vendors module in the Vendor Performance application opens the list of vendor company records, and records appear in the Vendor form view. The Vendor form view is customized to include fields and related lists relevant to managing vendors.
Company record in Vendor view
Implementing Vendor Performance

Begin the implementation of Vendor Performance by reviewing the base system values and outlining the data in the following areas to collect and enter. When you have completed the planning phase, configure the application in the following order.

Add a vendor type

Vendor types group vendors that offer similar goods and services, and are useful for reporting and comparing vendor performance. Evaluate the vendor types in the base system and add other types that your organization uses.

Role required: vendor_manager or admin

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

By default, decision matrixes filter data by vendor type so you can compare similar vendors. A vendor can be classified as more than one vendor type.

Vendor types in the base system

<table>
<thead>
<tr>
<th>Vendor type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applications</td>
<td>Vendors that provide enterprise applications, such as enterprise resource planning software.</td>
</tr>
<tr>
<td>Hardware</td>
<td>Vendors that provide hardware products, such as computers or cell phones.</td>
</tr>
<tr>
<td>Services</td>
<td>Vendors that provide services, such as catering or custodial duties.</td>
</tr>
<tr>
<td>Software</td>
<td>Vendors that provide software, such as word processing or email applications.</td>
</tr>
</tbody>
</table>

Create other vendor types that are useful for your organization. For example, if you purchase office supplies from several vendors, create an Office supplies vendor type.

1. Navigate to Vendor Performance > Vendors > Vendor Types.
2. Click New.
3. Enter the Name, and then click Submit.
Create a vendor record

Create vendor records or add information to existing vendor records. Plan and define the information to collect and enter to accomplish the vendor performance goals of the organization.

Role required: vendor_manager or admin

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. *Vendor ticketing and Vendor credit* applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to [Vendor Manager Workspace](#).

Planning includes defining the information to include in vendor records, and then gathering that data. Examples of data to plan and gather include contact and contract information, the manager to assign, and evaluation criteria.

1. Navigate to **Vendor Performance > Vendors > Vendors**.
2. Click **New**.
3. Fill in the fields, as appropriate.

**Company vendor form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the vendor.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Phone</td>
<td>Enter the vendor primary contact phone number.</td>
</tr>
<tr>
<td>Vendor manager</td>
<td>Click the lock icon to add one or more users as vendor managers.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Select only users who have the vendor_manager role.</td>
</tr>
<tr>
<td>Vendor type</td>
<td>Click the lock icon to add one or more vendor types that apply to the vendor.</td>
</tr>
<tr>
<td>Fax phone</td>
<td>Enter the fax number for the vendor primary contact.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Leave the check box selected, so this company is recognized in the system as a vendor.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Select the check box if the company is a manufacturer.</td>
</tr>
<tr>
<td>Notes</td>
<td>Provide additional information about the vendor, if known.</td>
</tr>
<tr>
<td>Address fields</td>
<td>Enter the full address of the location you work with for the vendor, including city, state, and zip code. For example, enter the corporate headquarters or a local branch address.</td>
</tr>
<tr>
<td>Stock symbol</td>
<td>Enter the three or four letter stock symbol for the vendor, if any.</td>
</tr>
<tr>
<td>Latitude and Longitude</td>
<td>Enter geographical coordinates for the vendor location, if known.</td>
</tr>
<tr>
<td>Website</td>
<td>Click the lock icon to enter URL for the vendor website.</td>
</tr>
<tr>
<td>Banner image</td>
<td>Select <strong>Click to add</strong> to upload an image to appear in the vendor scorecard header, usually the company logo. The image should be approximately 60-70 pixels high, and in one of these file formats: .jpg, .png, .bmp, .gif, .jpeg, and .ico.</td>
</tr>
<tr>
<td>Banner text</td>
<td>Enter up to 100 characters of text for the vendor scorecard, such as the company slogan.</td>
</tr>
<tr>
<td>Financial information (Profits, Revenue per year, Stock price, Market cap)</td>
<td>Enter any useful financial information to use in the management or evaluation of the vendor. As this information fluctuates over time, devise a process for keeping it up to date, if necessary.</td>
</tr>
<tr>
<td>Number of employees</td>
<td>Enter the number of employees for the vendor, if known.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Publicly traded</td>
<td>Select the check box if the vendor is a publicly traded company.</td>
</tr>
<tr>
<td>Rank tier</td>
<td>Select the ranking that represents the organization opinion of the products from this vendor. The Rank tier field appears on the Catalog Item and Product Model forms in the Vendor Catalog Items related list. This ranking helps the catalog administrator decide whether to promote or discontinue using this vendor.</td>
</tr>
</tbody>
</table>
| Discount        | Enter the discount specified in the contract with the vendor. 

**Note:** This discount is not the one displayed in the scorecard summary, which is derived from purchase agreement contracts. |
| Fiscal year     | Click the calendar icon to select the date on which the vendor fiscal year ends. |

4. Open the form context menu and click **Save**. The following related links and related lists appear.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Links</td>
<td></td>
</tr>
<tr>
<td>Create Vendor Credit</td>
<td>Click to create a vendor credit for this vendor. This related link is available only when vendor ticketing is active.</td>
</tr>
<tr>
<td>View Matrix</td>
<td>Click to view the default decision matrix. Use decision matrixes to compare vendors in selected categories.</td>
</tr>
<tr>
<td>View Vendor Scorecard</td>
<td>Click to view the scorecard for this vendor. Use scorecards to view various rating summaries for a vendor. This related link is available only if there are assessable records for the vendor.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Related Lists</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Contacts</td>
<td>Vendor contacts by role with contact details.</td>
</tr>
<tr>
<td>Vendor Activities</td>
<td>Activities related to the vendor, such as demos and trade shows.</td>
</tr>
<tr>
<td>Product Models</td>
<td>Product models related to the vendor, for vendors that are designated as manufacturers.</td>
</tr>
<tr>
<td>Assets</td>
<td>Assets purchased from the vendor that are available for assignment to in use.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Incidents</td>
<td>Incidents related to the vendor that require vendor resolution. Placing an incident in <strong>On Hold</strong> state as <strong>Awaiting Vendor</strong> force entry of the vendor and the ticket open with the vendor. This related list is available when vendor ticketing is active.</td>
</tr>
<tr>
<td>Contracts</td>
<td>Contracts established with the vendor and the contract status.</td>
</tr>
<tr>
<td>Vendor Catalog Items</td>
<td>Catalog items from the vendor that are available for users to order. This related list is available when vendor ticketing is active.</td>
</tr>
<tr>
<td>Vendor Stakeholders</td>
<td>Stakeholders who evaluate specific categories of performance when assessing this vendor.</td>
</tr>
<tr>
<td>Vendor Categories</td>
<td>Metric categories related to the vendor.</td>
</tr>
<tr>
<td>Service Offerings</td>
<td>Business services offered by this vendor. This related list is available when vendor ticketing is active.</td>
</tr>
<tr>
<td>Service Commitment for Vendor</td>
<td>Service commitments negotiated with the vendor. For example, a cloud services vendor commits to 95% uptime. This related list is available when vendor ticketing is active.</td>
</tr>
<tr>
<td>Purchase Orders</td>
<td>Purchase orders opened with the vendor. This related list is available when procurement is active.</td>
</tr>
</tbody>
</table>

Vendor record
Assign vendor managers and other applicable roles

Vendor managers use the information in scorecards, decision matrices, and bubble charts to examine and make decisions about vendors. Assessment administrators set up assessments for vendor management. Other roles are used with vendor management. Assign the appropriate roles to users.

Role required to update user roles: user_admin or admin

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

The following roles apply to the processes and tasks of managing vendors.

### Vendor performance process roles

<table>
<thead>
<tr>
<th>Role title</th>
<th>Role name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor manager</td>
<td>vendor_manager</td>
<td>Create and modify vendor records, vendor types, vendor contacts, vendor activities, and bubble charts. Vendor managers can also view vendor assessable records.</td>
</tr>
<tr>
<td>IT agent or technician</td>
<td>itil</td>
<td>Perform basic technician operations in the system. Technicians track vendor-related events and can view vendor scorecards and decision matrices.</td>
</tr>
<tr>
<td>Assessment administrator</td>
<td>assessment_admin</td>
<td>Configure assessments for evaluating vendor performance.</td>
</tr>
<tr>
<td>Administrator</td>
<td>admin</td>
<td>Access and work with all vendor performance and assessment processes. Only administrators can set up vendor assessment schedules.</td>
</tr>
</tbody>
</table>

Assign both the vendor_manager and assessment_admin roles to users as applicable so they can manage both vendors and vendor assessments.

1. Prepare a list of the users to assign as vendor managers, and the vendors each is assigned to manage.
2. Identify the users to configure vendor performance assessments.
3. Follow the steps in Assign a role to a user to grant the necessary access.

Create a vendor contact

Create vendor contacts for vendor managers to request assistance, report issues, or resolve problems with their products.

Role required: vendor_manager or admin

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. **Vendor ticketing and Vendor credit** applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

Enter known vendor contacts and include the role they hold in the vendor organization. Vendor managers use the information to contact the most appropriate vendor user based on the issue or need. Creating vendor contacts does not create new users in the system. Vendor contacts are for reference only, and are not used by the system in other processing.

1. Navigate to **Vendor Performance > Vendors**, and select the Vendor Contacts related list.
2. Click **New**.
3. Fill in the fields, providing as much contact information as is known.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Full name.</td>
</tr>
<tr>
<td>Type</td>
<td>Role the contact holds in the vendor organization. The <strong>Primary</strong> contact is displayed on the vendor scorecard with an email link.</td>
</tr>
<tr>
<td>Primary phone</td>
<td>Main phone number.</td>
</tr>
<tr>
<td>Alternate phone</td>
<td>Secondary phone number.</td>
</tr>
<tr>
<td>Email</td>
<td>Email address.</td>
</tr>
<tr>
<td>Title</td>
<td>Job title within the vendor organization.</td>
</tr>
<tr>
<td>Address</td>
<td>Full street address.</td>
</tr>
<tr>
<td>Fax</td>
<td>Fax number.</td>
</tr>
<tr>
<td>Company</td>
<td>Company for which this person is a contact. It defaults to the company from which you create a vendor contact.</td>
</tr>
</tbody>
</table>
Vendor contact

Create vendor activity

Vendor managers and other staff use activities to record and track significant events and activities. For example, vendor managers and IT technicians can record details of engagements with the vendor, such as meetings and phone calls. Events, such as the vendor annual conference, are another example.

Role required: vendor_manager or admin

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

Vendor activities are not related to vendor assessments.

1. Complete one of the following steps to add a vendor activity.

<table>
<thead>
<tr>
<th>To</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add an activity from the vendor record</td>
<td>Click <strong>New</strong> in the Vendor Activities related list.</td>
</tr>
<tr>
<td>Add an activity from a module</td>
<td>Navigate to <strong>Vendor Performance &gt; Vendors &gt; Vendor Activity</strong> and click <strong>New</strong>.</td>
</tr>
</tbody>
</table>
2. Fill in the fields, as appropriate

Vendor activity form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>Vendor associated with the activity. If you started from the Vendor Activities related list, the vendor name appears by default.</td>
</tr>
<tr>
<td>Activity type</td>
<td>Type of interaction with the vendor.</td>
</tr>
<tr>
<td>Activity date</td>
<td>Date and time of the activity. You can select a past, present, or future date.</td>
</tr>
<tr>
<td>User</td>
<td>User who is involved with the activity. The logged-in user appears by default.</td>
</tr>
<tr>
<td>Summary</td>
<td>Information about the activity, such as location, additional parties involved, purpose, and action items.</td>
</tr>
</tbody>
</table>

3. Click Submit.

Vendor activity

Vendor assessments

Using assessments effectively enhances your ability to evaluate vendor performance. Vendor managers use data collected in vendor assessments to evaluate, score, and rank vendors.
Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

A vendor scorecard summarizes information, provides visual breakdowns of its performance, and includes assessment results when they are available. Vendor decision matrixes, which are graphs of assessment results for multiple vendors, use only assessment results.

Assessments consist of metric types, metric categories, and metrics. Metric categories represent the assessment, and metrics are the questions. Users are assigned to metric categories that they are qualified to evaluate.

The Vendor metric type and associated categories and metrics become available when Vendor Performance is activated. An assessable record is inserted automatically for every vendor in your system, and for new vendors that you add.
Assessments and vendor performance

As illustrated in the diagram, you associate metric categories and category users to the assessable record for the vendor. When the administrator generates vendor assessments, the users can open the assessment from Self-Service > My Assessments & Surveys. Only one assessment is generated for each user. It contains sections for each vendor and each metric category.

In this example, there are three vendors. You can see the metric categories for ServiceNow, and the metric for the Procurement Rating metric category.
Set up vendor assessments

Assessment administrators define the metric categories and metrics you use to assess vendor performance. They complete the assessable records to prepare for assessment generation.

Verify that there are vendor company records and assign vendor managers to them. Obtain a list of the vendor managers and the vendors they manage, and the areas of expertise for each manager.

Role required: assessment_admin or admin

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

Complete the following steps to plan and configure vendor assessments, and to prepare them for assignment to vendor managers.

1. Review and update the metric categories for the Vendor assessment type.
   a) Navigate to Assessments > Metric Definition > Types, and select Vendor.
   b) Open each record in the Metric Categories related list.
   c) For each record, review the category and metric details, and update them to align with your business requirements.

2. Navigate to Assessments > Assessable Records and filter by Vendor type. Assessable records are listed by vendor name. Vendor records that existed when Vendor Performance was activated are associated with all base system metric categories. Manually add metric categories to vendors that were added after Vendor Performance was activated.

3. For each vendor assessable record, review and update the assigned metric categories.
   a) Open an assessable record and select the Metric Categories related list.
   b) Click Edit, and add or remove metric categories as appropriate.
   c) Click Save, and then repeat this process for all vendor assessable records.

4. For each vendor assessable record, assign category users.
   a) Select the Category users related list and click Edit.
      The Edit Members page that opens lists user (metric category) pairs for each user and metric category associated with the assessable record. For example, for user Beth Anglin you see Beth Anglin (Importance Rating), Beth Anglin (SLA Performance), Beth Anglin (User Satisfaction), and so on.
   b) Select the user (metric category) pairs that apply to this vendor.
   c) Click Save, and then repeat this process for all vendor assessable records.
The system administrator generates assessments from the Vendor Performance > Admin > Generate Assessments module. The users associated with the vendor and metric category open the assessment from Self-Service.

Vendor assessments can be generated also using other assessment generation methods. Establish a process for routinely generating assessments and notifying vendor managers the assessments are ready to complete.

For more information about assessment generation methods, see Assessment administrator tasks. For more information about defining notifications for assigned assessment, see Create an email notification.

Activate Vendor Performance

An administrator can activate the Vendor Performance plugin to access the application.

Role required: admin

Note:
The ServiceNow® Vendor Performance application is not available for new instances in the Paris release. Vendor Performance is still available on instances upgraded from a previous release. Vendor Performance will remain accessible to you, but will not be supported by ServiceNow. Upgrading to Paris will not affect your content, enabling your continued use of Vendor Performance in the Paris release.

To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Vendor Performance

Several types of components are installed with activation of the Vendor Performance plugin, including tables and user roles.
Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available with Vendor Performance.

Roles installed

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>vendor_manager</td>
<td>Vendor managers can:</td>
<td>itil</td>
</tr>
<tr>
<td></td>
<td>· View and customize the Overview module.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· View assessable records, vendor scorecards, and decision matrixes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· View, create, edit, and delete vendor types, vendors, vendor contacts, and bubble charts.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· View vendor assessment records by directly navigating to the tables.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If vendor ticketing is activated, vendor managers can also view, create, edit, and delete vendor credits and vendor tickets.</td>
<td></td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Activity</td>
<td>Stores vendor activity records, to help vendor managers track significant events and interactions with vendors.</td>
</tr>
</tbody>
</table>
### Use the Vendor Performance Overview

The Vendor Performance overview is a homepage with widgets that provide vendor statistics.

Role required: vendor_manager or admin

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

Use the widgets to get information at a glance about vendor performance and comparative statistics. Click an element, such as one bar in a chart, to see a list of the corresponding records.

Add and remove content as desired from the Overview page.

1. Navigate to **Vendor Performance > Overview**.
2. Click elements within the reports to obtain more information.

The following reports are included by default:

- Average Score by Vendor
- P1 and P2 Incidents by Vendor (with Vendor Ticketing)
- Open Vendor Tickets (with Vendor Ticketing)
- Vendors in SLA Breach
- Assets by Vendor
- Top 12 Vendors
- CIs by Vendor
- Asset Cost by Vendor
- Residual Value by Vendor
Vendor scorecards

The printable vendor scorecard contains a comprehensive vendor summary and views of vendor ratings, based on assessment results. Use it to compare current and previous assessment results, or to compare results between vendors.

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

The vendor scorecard is a view of the Company form. A scorecard compares current vendor assessment results with previous results, or to the results of other vendors. Vendor scorecards show the most current information because the information is calculated when you generate the scorecard.

The vendor scorecard displays the vendor logo and name, a summary of the vendor’s information from the system, and the vendor ratings.

View a vendor scorecard

View a vendor scorecard to get a snapshot of its performance and current assessment results compared with prior results.

Role required: vendor_manager or admin

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

1. Navigate to Vendor Performance > Vendors > Vendor Scorecard.
2. Select a vendor to open the scorecard.
   You can also click the View Vendor Scorecard related link in a vendor record.

Vendor scorecard details

Each scorecard displays a header to clearly identify the vendor. Review the summary section for financial information and to see how the vendor engages with your organization.

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace...
Paris IT Service Management

It is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

Vendor scorecard header

In the header, click the name to view the vendor company record.
Vendor summary details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Click a vendor type to display the decision matrix for that type and view a comparison of its ratings with similar vendors. Click a vendor name in the decision matrix to open the scorecard for the vendor. The name of the originating vendor scorecard displays in purple text.</td>
</tr>
<tr>
<td>Rank/Tier</td>
<td>This ranking helps a catalog administrator decide whether to promote or discontinue products from this vendor. Click the rank to open the vendor record for editing.</td>
</tr>
<tr>
<td>Assets</td>
<td>Click the number to view a list of assets that are in use within the organization. In this example, there are 516 assets, such as laptops and phones, in stock or allocated to a user. Missing and retired assets are not listed.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Incident Breaches</td>
<td>Click the number to view the list of incident SLA breaches associated with this vendor.</td>
</tr>
<tr>
<td>Incidents</td>
<td>Click the number to view the list of open incidents associated with this vendor. The calculation of this value depends on whether vendor ticketing is active.</td>
</tr>
<tr>
<td></td>
<td>- Active: Number of incidents in which this vendor is listed in the incident.</td>
</tr>
<tr>
<td></td>
<td>- Not active: Number of incidents in which this vendor associated with the configuration item.</td>
</tr>
<tr>
<td>Awaiting Vendor</td>
<td>Click the number to view incidents that are on hold pending the receipt of information from the vendor. Vendor ticketing must be active.</td>
</tr>
<tr>
<td>Vendor Managers</td>
<td>Click the name to view details about the manager.</td>
</tr>
<tr>
<td>Contacts</td>
<td>Click the link to view and update the list of contacts for this vendor.</td>
</tr>
<tr>
<td>Asset Value</td>
<td>Click the number to view a list of assets that are in use within the organization. The number represents the total value of the allocated and available assets.</td>
</tr>
<tr>
<td>Spend</td>
<td>Amount of money spent on products and services for this vendor. The calculation of this value depends on whether procurement is active.</td>
</tr>
<tr>
<td></td>
<td>- Active: Calculated from the purchase orders submitted for the current contract with this vendor.</td>
</tr>
<tr>
<td></td>
<td>- Not active: Estimated amount spent based on the cost and installation date from the asset record.</td>
</tr>
<tr>
<td></td>
<td><strong>Spend</strong> is calculated for the last year unless <strong>Commitment</strong> shows that there is a purchase agreement contract. If a contract exists, the calculation uses the date range of the purchase agreement.</td>
</tr>
<tr>
<td>Commitment End Date</td>
<td>View the commitment end date of the purchase order with the earliest date. This information is visible only when there is an active purchase order.</td>
</tr>
<tr>
<td>Commitment</td>
<td>Click the number that represents the total monetary commitment or all active purchase agreements. The list of active purchase agreements opens for your review.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remaining Commitment</td>
<td>View the value of the contract that remains after subtracting the <strong>Spend</strong> from the <strong>Commitment</strong>. This value appears when procurement is active and there is an active purchase agreement. If <strong>Spend</strong> is greater than <strong>Commitment</strong>, this field is <strong>0</strong>.</td>
</tr>
<tr>
<td>Availability Breaches</td>
<td>Click the number to review a list of the service availability breaches for service offerings from this vendor. Appears when vendor ticketing is active.</td>
</tr>
<tr>
<td>Stock</td>
<td>Click the stock symbol to see the current share price information on an external web site.</td>
</tr>
<tr>
<td>Revenue Market Cap Employees</td>
<td>View the vendor published yearly revenue, current market cap, and number of employees, if recorded in the vendor record.</td>
</tr>
<tr>
<td>Actual Discount</td>
<td>Click the number to view the vendor purchase orders. The number is calculated from the difference between the total cost of the purchase order line items and the total list price. This link appears only when procurement is active.</td>
</tr>
<tr>
<td>Agreed Discount</td>
<td>Click the number to view active purchase agreements and the associated discounts. This value is a weighted average of all promised discounts from the active purchase agreements. This link appears when procurement is active and a purchase agreement is active.</td>
</tr>
<tr>
<td>Credits</td>
<td>Click the number to view the unused vendor credits caused by breached business service contracts. Appears if vendor ticketing is active.</td>
</tr>
</tbody>
</table>

**Scorecard ratings**

Review scorecard ratings to evaluate and compare vendors. Each view provides a different type of information.

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. **Vendor ticketing and Vendor credit** applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to **Vendor Manager Workspace**.
**Scorecard rating views**

The overall rating column, if it appears, displays a weighted average of categories used to evaluate the vendor. Only categories in which the vendor has been evaluated appear on the scorecard. If the ratings section has no data, either the assessable record or the category results were deleted for that vendor.

Click a category to view the metric category record. Point to a metric category in any view to display a line chart that shows the rating trend for that category.
Averages by vendor type

This view compares the current ratings for a vendor in each metric category with the average, maximum, and minimum values for all vendors of a certain type.

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

All ratings are from assessments generated over the trailing twelve months (TTM).
Rating variance highlights

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Vendor is below average in this category. The Diff column displays a negative number.</td>
</tr>
<tr>
<td>Green</td>
<td>Vendor is above average in this category. The Diff column displays a positive number.</td>
</tr>
<tr>
<td>White</td>
<td>Vendor is average in this category. The Diff value is 0.0.</td>
</tr>
</tbody>
</table>

Select a vendor type to compare the current vendor against similar vendors, such as Hardware or Software. By default, all vendors of the specified type are included. A vendor manager can add a filter condition in the vendor assessment metric type record. For example, to compare hardware vendors with a market cap less than $1,000,000.

Example averages comparison of software vendors

Averages by categories

The Categories view bar chart compares the average ratings for each metric category in the selected time interval.

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors.
In your organization, **Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace.** For more information about Vendor Manager Workspace, including activation, please refer to **Vendor Manager Workspace**.

---

**Metric category average ratings over time**

**Category metrics**

This view displays the weighted average results for each metric (question) within a metric category.
Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

Select a category from the choice list to display the chart. If no metrics are available, the metric results have been deleted. To view metric results, navigate to Assessments > Results > Metric Results and look for records in the Source column that begin with Vendor.

Metric results by metric category
Head-to-head vendor comparison

The Head to Head Compare view displays the comparison between the average ratings for the current vendor and a selected vendor. This view is useful when deciding between vendors.

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. *Vendor ticketing and Vendor credit* applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to *Vendor Manager Workspace*.

Select a vendor to compare against the current vendor's trailing twelve month (TTM) average ratings. *Diff* displays the difference between each vendor's most recent TTM ratings. The scorecard displays three years of average ratings for the comparison record.

### Averages over past 12 months

<table>
<thead>
<tr>
<th>Metric</th>
<th>Current TTM</th>
<th>Diff</th>
<th>Other TTM</th>
<th>2017</th>
<th>2016</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Rating</td>
<td>6.37</td>
<td>0.53</td>
<td>5.84</td>
<td>5.64</td>
<td>5.99</td>
</tr>
<tr>
<td>Importance Rating</td>
<td>4.77</td>
<td>2.13</td>
<td>2.63</td>
<td>3.12</td>
<td>3.74</td>
</tr>
<tr>
<td>Compliance Score</td>
<td>7.32</td>
<td>-0.37</td>
<td>7.70</td>
<td>8.28</td>
<td>8.92</td>
</tr>
<tr>
<td>User Satisfaction</td>
<td>7.44</td>
<td>1.59</td>
<td>5.85</td>
<td>6.37</td>
<td>6.56</td>
</tr>
<tr>
<td>Company Alignment</td>
<td>7.79</td>
<td>3.90</td>
<td>3.88</td>
<td>4.09</td>
<td>3.53</td>
</tr>
<tr>
<td>Procurement Rating</td>
<td>2.81</td>
<td>0.08</td>
<td>2.53</td>
<td>2.74</td>
<td>3.41</td>
</tr>
<tr>
<td>Catalog Depth</td>
<td>7.24</td>
<td>0.29</td>
<td>6.95</td>
<td>6.89</td>
<td>7.56</td>
</tr>
<tr>
<td>Technology Rating</td>
<td>7.77</td>
<td>3.01</td>
<td>4.76</td>
<td>5.24</td>
<td>5.95</td>
</tr>
</tbody>
</table>

Head-to-head vendor comparison with Acer
Overall Rating

The Overall Rating is calculated as:

\[
\text{(sum of normalized values in category result)} / \text{(number of assessment groups)}
\]

In the following example, the calculation is

\[
(2.13 + 2.86 + 3.79 + 1.43 + 2.39 + 3.7) / 2 = 8.15
\]

Normalized values

Vendor scorecard history

The History view compares the current ratings for each metric category with ratings from the previous three years or four quarters.
Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

Ratings that have dropped are highlighted in red and appear as negative numbers. Ratings that have improved appear in green with positive numbers. Arrows beside the Diff column indicate the trend of the current assessment against the previous assessment.

3 Years History scorecard

To calculate the current ratings, the system averages the ratings from the trailing 12 month (TTM) period. The Diff column shows the discrepancy between the current ratings and the previous calendar year ratings.
History for three years

4 Quarters History scorecard

Quarterly assessments compare the average rating for each category in the current quarter against the previous four quarters. The **Diff** column shows the discrepancy between the current ratings and the previous quarter ratings. The column labels count backward, by quarter, from the current quarter.

For example, if the current quarter is the third quarter of 2018, then the previous quarters appear as **2nd** (2018), **1st** (2018), **4th** (2017), and **3rd** (2017). All four of the previous quarters appear, whether or not there were any ratings for them.
## History for four quarters

### Overall Rating

The Overall Rating is calculated as:

\[
\text{(sum of normalized values in category result) / (number of assessment groups)}
\]

In the following example, the calculation is

\[
(2.13 + 2.86 + 3.79 + 1.43 + 2.39 + 3.7) / 2 = 8.15
\]
Normalized values

Vendor decision matrixes

A decision matrix plots assessment results for multiple vendors. Vendor managers use them to compare the relative standing of vendors in selected categories.

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with
Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

Assessment administrators can view and create these dynamically updated graphs, which make it possible to compare assessable records by category. Decision matrixes display data from a trailing twelve month (TTM) period.

For information about the components and calculations of decision matrixes, see Decision matrixes

**View a vendor decision matrix**

View a vendor decision matrix to compare relative standings of vendors in selected categories.

Role required: vendor_manager or admin

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

1. Navigate to **Vendor Performance > Vendors > Vendor Decision Matrix**.
2. Click the name of the decision matrix to review.
3. Select the options for the information to evaluate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Select the vendor type, or include all vendors.</td>
</tr>
<tr>
<td>Scale</td>
<td>Select the size of the matrix to view.</td>
</tr>
</tbody>
</table>

The decision matrix includes the following components.

- **X- and Y-axes:** Represent one or more categories or themes used to evaluate vendors.
- **Plotted items:** The labeled points represent averages of category scores for vendors. Point to a vendor name to view the vendor rating summary. Click a vendor name to view the vendor scorecard.
Example decision matrix
Plotted item rating summaries

When you point to a vendor name on a decision matrix, a pop-up rating summary displays the vendor's average ratings for each axis.

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. **Vendor ticketing and Vendor credit** applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to **Vendor Manager Workspace**.

Rating summary window

If an axis represents one category, the ratings are calculated averages from results for that category. If an axis represents multiple categories, the ratings are calculated averages from results for all of the categories. The rating summary shows:

- Current rating
- Difference between the current rating and the previous year's rating
- Ratings from each of the three previous years, if available
Using vendor bubble charts

Vendor managers create and use bubble charts to compare the relative standing of vendors. A bubble chart is a dynamically updated graph that plots assessment results for multiple vendors.

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. *Vendor ticketing and Vendor credit* applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to *Vendor Manager Workspace*.

Bubble charts compare the relative standing of vendors in three categories. The X- and Y-axes each represent a different category. Vendors are plotted on the chart as circular markers, or bubbles, which vary in size according to scores for the third category, or Z-axis.

The **Vendor Quality** bubble chart is added when Vendor Performance is activated. View this bubble chart in *Vendor Performance > Vendors > Vendor Bubble Charts*. Click the name, and then click the *View Bubble Chart* related link.
Vendor Quality bubble chart

Vendor list

1. Aeric
   - Address: 333 W. San Carlos St., Ste. 1500, San Jose, CA 95110
   - Phone: (408) 333-7700
   - Updated: 2013-06-06 05:47:42

2. Adobe Systems
   - Address: 345 Park Avenue, San Jose, CA 95110-2704
   - Phone: 408-536-0000
   - Updated: 2013-06-06 13:30:25

3. Atrian
   - Address: 901 Explorer Boulevard, Huntsville, AL 35806-2807
   - Phone: (256) 903-0000
   - Updated: 2013-06-06 15:29:17

4. Allids
   - Address: 350 Ellis Street, Mountain View, CA 94043
   - Phone: (650) 227-0000
   - Updated: 2013-06-06 10:50:49
• Chart axes: Each axis represents a category.
• Bubbles: Each labeled bubble represents an average of category scores for a vendor. Point to a bubble to view a vendor score summary. Click a bubble or bubble label to view the scorecard for the vendor.
• Vendor list: Lists all active vendors. The bubble chart only plots vendors for which there are assessment results.

Vendor score summary

The vendor score summary displays the vendor’s average score for each category. The scores are based on data from the last 12 months. Use it to see the breakdown for the rated categories.

Create a vendor bubble chart

Create a bubble chart to customize the comparison of vendor assessment results.

Role required: vendor_manager or admin

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. **Vendor ticketing and Vendor credit** applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to **Vendor Manager Workspace**.

1. Navigate to **Vendor Performance > Vendors > Vendor Bubble Charts**.
2. Click **New**.
3. Enter a descriptive name for the comparison the bubble chart represents.
4. Edit the labels and colors of the four quadrants, as desired.

For color fields, enter HTML names or hexadecimal (hex) values. For hex values, the # character is optional, and values are not case-sensitive. For example, all of the following values are valid: LightGray, lightgray, #D3D3D3, d3d3d3.

5. Select the categories and enter the labels for the X-, Y-, and Z-axes.
   The Z-axis appears in the bubble score summary pop-up window when you point to a vendor bubble in the chart.

6. Optional: Enter a different hex number or HTML name for the quadrant border color.
   The Default check box is not used with vendor bubble charts.
7. Open the form context menu and click **Save**.
8. Click **View Bubble Chart** to open it in a new browser tab or window.

**Vendor ticketing**

Vendor ticketing helps establish stronger relationships between vendors, incidents, and SLAs. With vendor ticketing, vendor managers monitor how quickly vendors resolve issues with their products and services.

*Note:* To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. **Vendor ticketing and Vendor credit** applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to **Vendor Manager Workspace**.

The organization receives credit with the vendor when contractual obligations are not met. Vendor ticketing provides the following features.

- An easy way to pause contract or service commitment SLAs and start vendor-oriented SLAs from an incident.
- A view on the vendor record, of all incidents opened against services or products provided by the vendor.
- The ability to start vendor-oriented SLAs from different vendor events from the incident.

Vendor ticketing is activated by the administrator, and activation adds the Vendor Credits module to the Vendor Performance application menu. Vendor managers create and track credits that a vendor owes due to breached service contracts. Various reports can be used to identify missed commitments, criticality of issues by vendor, and so on.

**Roles used with Vendor Ticketing**

The following roles are installed when other applications are activated. Assign the appropriate roles to users involved with creating or tracking vendor tickets.

<table>
<thead>
<tr>
<th>Role Title</th>
<th>Description</th>
<th>Installed with</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor manager</td>
<td>Vendor managers manage and track vendor information, including vendor credits.</td>
<td>Vendor Performance</td>
</tr>
<tr>
<td>vendor_manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IT agent or technician</td>
<td>IT agents and technicians add vendor information to incidents.</td>
<td>Base system</td>
</tr>
<tr>
<td>itil</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Portfolio administrator</td>
<td>Portfolio administrators view, create, and delete SLA records, and use all vendor ticketing features included with SLAs.</td>
<td>Service Portfolio Management</td>
</tr>
<tr>
<td>portfolio_admin</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Activate Vendor Ticketing

An administrator can activate the Vendor Ticketing (com.snc.vendor_ticket) plugin.

Role required: admin

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Vendor Ticketing

One table is installed with activation of the Vendor Ticketing plugin.

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available with Vendor Ticketing.
Table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Credit</td>
<td>Stores vendor credit records for vendors that breach service level agreements (SLAs).</td>
</tr>
</tbody>
</table>

Using Vendor Ticketing

Vendor Ticketing integrates with Vendor Performance for contract and service offering service level agreements (SLAs). When an incident is moved to a specific state and a vendor is associated with the configuration item (CI), a service offering is started for the vendor.

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

Incident fields record the date and time of specific vendor events, and appear as options for starting an SLA. When an incident requires vendor interaction, an SLA can start when the incident is opened, closed, or resolved. The Vendor Credit module in the Vendor Performance application menu is used to enter and track credit owed by a vendor from breached business service contracts.

SLA stage example

This example uses demonstration data available with vendor ticketing to illustrate how the application can manage SLA stages for different incident states.

Role required: vendor_manager or admin

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

1. Create a new incident record and select the MacBook Pro 15\" computer as the affected Configuration item.
2. Set the **Impact** and **Urgency** to either **Medium** or **High**.

![Incident ticket example](image)

**Selecting the CI**

The system starts a contract SLA for this incident based on the incident priority, not the CI. In this case, the system creates the **Priority 1 resolution (8 hour)** SLA. The system adds the SLA to the **Task SLAs** related list.
3. You call Apple, the vendor for this CI, and update the incident state to **On Hold**, and select **Awaiting Vendor** as the **On hold reason**.

The Vendor form section or tab appears, with **Apple** entered as **Vendor**.

4. Complete the required vendor fields and save the record.
<table>
<thead>
<tr>
<th>Number</th>
<th>INC0010010</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caller</td>
<td>Allyson Gillespie</td>
</tr>
<tr>
<td>Category</td>
<td>Inquiry / Help</td>
</tr>
<tr>
<td>Subcategory</td>
<td>-- None --</td>
</tr>
<tr>
<td>Business service</td>
<td></td>
</tr>
<tr>
<td>Configuration item</td>
<td>MacBook Pro 15&quot;</td>
</tr>
<tr>
<td>Contact type</td>
<td>Phone</td>
</tr>
<tr>
<td>State</td>
<td>On Hold</td>
</tr>
<tr>
<td>On hold reason</td>
<td>Awaiting Vendor</td>
</tr>
<tr>
<td>Impact</td>
<td>1 - High</td>
</tr>
<tr>
<td>Urgency</td>
<td>1 - High</td>
</tr>
<tr>
<td>Priority</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Service Desk</td>
</tr>
<tr>
<td>Assigned to</td>
<td></td>
</tr>
</tbody>
</table>

**Short description:** Machine is out of disk space

**Related Search Results**

**Notes**

**Related Records**

**Closure Information**

**Vendor**

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Apple</th>
</tr>
</thead>
</table>

**Vendor ticket**

**Vendor point of contact**
The **Priority 1 resolution (8 hour)** SLA paused when the incident state is **On Hold**.

5. You discover that this CI is part of a service offering called **Apple iCloud** that has an SLA. You change the **Configuration item** value to the service offering and save the record.
The system starts the SLA for the Apple iCloud service offering. The SLA for this service offering is configured to start when the **Vendor open** event occurs in the incident. The event is triggered when the incident is updated by setting the incident state to **On Hold** and adding a vendor.
6. After the vendor responds, update the incident state appropriately.

   The SLAs react to each state as follows:

   **States**

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Hold</td>
<td>Additional help is needed to resolve this incident. Any of these states marks the service offering SLA as Complete. The incident SLA remains Paused.</td>
</tr>
<tr>
<td>Active</td>
<td>The vendor responded with the information needed to work on the incident. This state restarts the paused contract SLA and marks the service offering SLA as Complete.</td>
</tr>
<tr>
<td>Resolved or Closed</td>
<td>Work on the incident is complete. Either state marks both SLAs as Complete.</td>
</tr>
</tbody>
</table>

   If the issue is reopened, a new contract SLA is started with the start date and time of the original SLA. The stage is set to In progress.

**Configure SLAs for vendor ticketing**

Review the service offering SLAs that are installed with vendor ticketing. Update existing SLAs or add new SLAs to pause contract SLAs and start service offering SLAs automatically for incident state changes.

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from...
Configure a contract SLA

A contract SLA applies to vendors that offer products, such as laptops or copy machines. The contract with the vendor specifies the duration of the service level agreement (SLA).

Role required: sla_admin, sla_manager, or admin

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. **Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.**

For example, the contract with a vendor specifies that malfunctioning copy machines must be fixed within 48 hours. When an incident is opened for one of the vendor copy machines, the SLA tracks the resolution time.

1. Navigate to Service Level Management > SLA > SLA Definitions.
   To review existing SLA definitions, filter the form to show SLAs for the Incident [incident] table.
2. Click New.
3. Select Contract SLA.
4. Complete the form based on the details of the contract with the vendor, as illustrated in the following example.
   A contract SLA is configured to start when a priority 1 incident is opened in Paris. The SLA is configured to pause when the user working on the incident is on hold for the **On hold reason** set to **Awaiting Vendor.**
Add vendor information to an incident

Vendor information is added to an incident when the agent or technician sets the incident status to **On Hold** for the reason **Awaiting Vendor**.

Role required: itil or admin

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the `core_company` table to identify vendors in your organization. **Vendor ticketing and Vendor credit** applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to **Vendor Manager Workspace**.

The Vendor form section appears, and the agent must select the vendor enter the ticket number opened with the vendor before saving the incident.
Vendor form section in an incident

When the record is saved, a timestamp is inserted into the **Vendor Open** field. Other vendor time fields are updated as the vendor ticket is resolved. These fields do not appear in the default Incident view. Agents, technicians, and vendor managers use the Metrics view of the incident form to review the state of incidents associated with the vendor.
Incident vendor ticketing metrics view

When the incident moves to closed or resolved state, those fields are automatically updated with the timestamp.

1. When you work on an incident that cannot be resolved until the vendor takes action, select **Awaiting Vendor** in the State field.
   This state pauses any SLAs affected by this incident that have **Awaiting Vendor** defined as a pause condition. This action ensures that vendor delays do not impact SLA performance.
2. Complete the information in the Vendor form section that appears.

   **Vendor**

   If necessary, select the vendor associated with the incident. The vendor appears automatically when the incident is associated with a configuration item manufactured by a company that is also a vendor.

   **Vendor ticket**

   Enter a ticket or incident number provided by the vendor. This ticket is the vendor identification number for the issue and is for reference only.

   **Vendor point of contact**

   Enter contact information for the vendor. For example, enter the name of a customer service representative, a phone number, or an email address.

3. In the Notes section or tab, add comments or work notes to document the action the vendor agreed to take to resolve the issue.

4. Save, update, or submit the record.

5. After the vendor resolves the issue, select a state of **Active** to restart the SLA.

When the vendor issue is resolved, change the state to **In Progress** or **Resolved**, as appropriate. Setting the state to **In Progress** restarts the SLA.

**View an incident from a vendor record**

A vendor manager views incidents for the vendor products from the vendor form. The manager uses the list to get a snapshot of how the vendor products are performing.

Role required: vendor_manager or admin

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. **Vendor ticketing and Vendor credit** applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to **Vendor Manager Workspace**.

1. Navigate to **Vendor Performance > Vendors > Vendors**.
2. Select a vendor, such as Microsoft, from the list.
3. Select the **Incidents** related list.

   Sort and group the listed incidents in a meaningful way for evaluation. For example, sort by **Category** or group by the **State**. Click the number of an incident to see its details.
Vendor-related incidents

Note: The related list is visible only if there is at least one incident associated with the vendor.

Vendor credit

Vendor credit offers a method for manually tracking the credit that a vendor owes an organization because of a breached business service contract.

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

Monetary penalties for contract breaches are tracked as service commitment. The information from the service commitment for the vendor service offering is used to calculate the vendor credit due for a breach. Manual vendor credits are entered by vendor managers using the Vendor Credit module. The Credits field in a vendor scorecard provides access to unused vendor credit records.

Create a vendor credit manually

Vendor managers can enter vendor credits manually when they cannot be processed automatically.
Role required: vendor_manager or admin

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

1. Navigate to Vendor Performance > Vendors > Vendor Credits.
2. Click New.
3. Select the Vendor, and then fill in the other fields, as appropriate.

Note: The selected vendor determines the options available for other fields. If you change the vendor, all field values are cleared.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System generated reference number for this credit record.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Name of the vendor.</td>
</tr>
<tr>
<td>Related incident</td>
<td>Number of any incidents related to these vendor products.</td>
</tr>
<tr>
<td>Service offering</td>
<td>Service offering related to this vendor.</td>
</tr>
<tr>
<td>Service commitment</td>
<td>Specific service commitment that affects this vendor credit.</td>
</tr>
<tr>
<td>Service availability</td>
<td>Business service availability commitment that affects this vendor credit.</td>
</tr>
<tr>
<td>Related outage</td>
<td>Actual outage that created the vendor credit. The value in this field is from the Short description in the outage record.</td>
</tr>
<tr>
<td>Vendor contract</td>
<td>Contract for this vendor, if any. Choose a contract for the specified vendor. These contracts can be in any state.</td>
</tr>
<tr>
<td>Reference number</td>
<td>Any reference that pertains to this credit, for example, a confirmation number from the vendor or the name of a contact.</td>
</tr>
<tr>
<td>Breach penalty time</td>
<td>Duration of the breach. This value is the elapsed time of the credit-generating event and is inherited from the Service commitment selected.</td>
</tr>
<tr>
<td>Breach penalty amount</td>
<td>Total amount of credit due from this event, inherited from the Service commitment selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Per</td>
<td>Unit of time used to calculate the breach penalty amount, inherited from the Service commitment selected.</td>
</tr>
<tr>
<td>Credit used</td>
<td>Check box indicating that credit from this vendor has been recovered.</td>
</tr>
<tr>
<td>Notes</td>
<td>Notes pertaining to this credit record, for example, to keep track of recovered credit.</td>
</tr>
</tbody>
</table>

### Create a vendor credit from specific records

Several types of records that track issues with vendor products have a **Create Vendor Credit** related link. Creating a vendor credit when the need is identified saves time and prevents credits from being missed.

Role required: itil, vendor_manager, or admin

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. **Vendor ticketing and Vendor credit** applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to [Vendor Manager Workspace](#).

The **Create Vendor Credit** related link appears in records when the record references a vendor. These procedures contain instructions for exposing the link when it is hidden.

- Click the **Create Vendor Credit** related link in the following types of records:
  - Outage
  - Incident
  - Service availability
  - Company

When a vendor credit record is created from one of these sources, it automatically populates the form with related data, such as vendor name, contract, and service offering. The **Breach penalty amount**, **Per**, and **Breach penalty time** fields are populated from the service commitment record.

**Create vendor credit from an outage**

Create vendor credit when an outage is related to a vendor or its products.

Role required: itil or admin

**Note:** To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from
1. Open a task outage record.
2. If the Create Vendor Credit related link does not appear on the Outage form, define a vendor in the referenced table.
   a) Click the Configuration Item field reference icon. The Service Offering form opens.
   b) Select a vendor.
   c) Click Update. The Outage form reopens with the related link available.
3. In the Outage form, click the Create Vendor Credit related link. The Vendor, Service offering, Vendor contract, and Related outage fields are populated.

Create vendor credit from an incident
Create vendor credits from incidents opened against business services. Other configuration item types do not have service offerings and cannot issue vendor credits.

Role required: itil or admin

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

1. If the Create Vendor Credit related link does not appear on the Incident form, define a vendor for the incident.
   a) Select On Hold in the State field, and Awaiting Vendor in the On hold reason field. The Vendor form section appears.
   b) Select the vendor and enter the vendor ticket reference number.
   c) Click Update. The related link appears on the Incident form.
2. When the issue results in a vendor credit, open the incident and click the Create Vendor Credit related link. The Vendor, Related incident, Service offering, and Vendor contract fields are populated.

Create vendor credit from Service Availability
You can create vendor credit from the Service Availability form.

Role required: portfolio_admin or admin
Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

1. If the Create Vendor Credit related link does not appear on the Service Availability form, define a vendor in the referenced service offering record.
   a) In the Service Availability form, click the Service Offering field reference icon.
      The Service Offering form opens
   b) Select a vendor.
   c) Click Update.
      The Service Availability form reopens with the related link available.

2. In the Service Availability record, click the Create Vendor Credit related link.
   The Vendor, Service offering, and Service commitment fields are populated.

Create vendor credit from the vendor
Vendor managers can create a vendor credit when view the vendor company details.

Role required: vendor_manager or admin

Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

1. Navigate to Vendor Performance > Vendors > Vendors.
2. Open the vendor record to issue a credit.
3. Click the Create Vendor Credit related link.
   The Vendor field is populated.

Domain separation in Vendor Performance

This overview describes domain separation in Vendor Performance. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.
Note: To access the next generation vendor management and performance application, transition to Vendor Manager Workspace in the Paris release. Vendor Manager Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Manager Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Manager Workspace. However, Vendor Manager Workspace continues to use the core_company table to identify vendors in your organization. Vendor ticketing and Vendor credit applications are not available with Vendor Manager Workspace. For more information about Vendor Manager Workspace, including activation, please refer to Vendor Manager Workspace.

Support level: No support

- The domain field may exist on data tables, but there is no business logic to manage data.
- This level is not considered domain-separated.

For more information, see Application support for domain separation.

ITSM Predictive Intelligence Workbench

The ServiceNow® ITSM Predictive Intelligence Workbench application provides prebuilt use case templates and guides you through your machine learning implementation to create intelligent ITSM business processes.

What is ITSM Predictive Intelligence Workbench?

The ITSM Predictive Intelligence Workbench application is built to help you get started using machine learning to quickly solve and expedite your IT incidents.

The workbench includes prebuilt use case templates that systematically guide you through the process of creating and training new predictive models, evaluating and testing them, and finally adding them to your business process to add value to your IT organization.

Guided machine learning provides next steps and helps you make informed decisions while you increase your knowledge of machine learning.

Once you train your use cases, they are usable immediately. Using Performance Analytics capabilities, you can monitor your successfully implemented use cases to ensure the best model efficacy. Define thresholds and monitor whether your models are performing as expected or if they are under-performing with the Predictive Intelligence for Incidents dashboard.

The ITSM Predictive Intelligence Workbench application depends on activation of the Predictive Intelligence application, which is available with the ITSM Pro SKU.

Who uses ITSM Predictive Intelligence Workbench?

Business process architects use Predictive Intelligence Workbench functionality to get started with machine learning-based use cases. You can determine your business value, monitor your models, and view related statistics using the Predictive Intelligence Workbench dashboard.

If you are a process architect or owner, or someone who is championing machine learning for your IT organization, ITSM Predictive Intelligence Workbench can help you streamline your incident
case load. Trained predictive models can resolve your incidents through past similar resolutions or by recommending relevant knowledge base articles to help expedite your incident investigation and resolution processes. This frees up valuable time for IT professionals who often need to spend time on more complex and challenging issues.

No prior knowledge or experience with artificial intelligence or machine learning is required when you use ITSM Predictive Intelligence Workbench. The application includes templates with prebuilt guidance to assist you in creating, training, evaluating, testing, and producing, your unique predictive models. You can also link to your knowledge base articles to support your IT incident case load, as well as access the many features of the Predictive Intelligence platform application.

How do you benefit from ITSM Predictive Intelligence Workbench?

Cutting-edge artificial intelligence and machine learning technologies are widely adopted throughout many industries. The ITSM Predictive Intelligence Workbench application provides you with the machine learning tools you need to quickly and effectively resolve your IT incident tasks and improve your IT organization. The process of creating and implementing your predictive models can result in valuable business analysis and operations optimization.

ITSM Predictive Intelligence Workbench administration

Administrators can activate the necessary plugins for ITSM Predictive Intelligence Workbench. Users with the piwb_admin role can configure the application to meet specific requirements. Predictive Intelligence Workbench admins can perform the following tasks:

- Configure Predictive Intelligence Workbench property settings, such as the minimum number of predictions for evaluating use cases that underperform and the minimum percentage of net automation to show a pretrained model.
- Create a Predictive Intelligence Workbench user group and assign users necessary roles to move through the model implementation process.
- Configure notifications to alert Predictive Intelligence Workbench users via email for the following events:
  - When a new model is trained and ready for evaluation.
  - When batch testing is initiated and when test results are available.
- Create new use case templates and make them available to your Predictive Intelligence Workbench users.

Activate ITSM Predictive Intelligence Workbench

ITSM Predictive Intelligence Workbench is available with activation of the core Predictive Intelligence Workbench (com.sn_piwb_ml) plugin and the Predictive Intelligence Workbench ITSM content (com.sn_piwb_itsm_content) plugin.

Role required: admin

The ITSM Predictive Intelligence Workbench-related plugins require activation of the Predictive Intelligence application. Predictive Intelligence is available with activation of the Predictive Intelligence (com.glide.platform_ml) plugin and the Predictive Intelligence Reports (com.glide.platform_ml_pa) plugin, which require an ITSM Pro package subscription. For more details, refer to Activate Predictive Intelligence.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Installed with ITSM Predictive Intelligence Workbench

Several roles are installed with activation of the Predictive Intelligence Workbench plugin.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Two plugins are available to obtain feature ITSM Predictive Intelligence Workbench functionality.

- Predictive Intelligence Workbench (com.sn_piwb_ml): Provides a common framework for creating and managing use cases.

  Note: Requires activation of Predictive Intelligence and Predictive Intelligence Reports plugins, which are available with an ITSM Pro subscription.

- Predictive Intelligence Workbench ITSM content (com.sn_piwb_itsm_content): Enables access to ITSM-specific content that provides implementation guidance for use cases created through Predictive Intelligence Workbench Also, with this plugin you can access the Predictive Intelligence for Incidents dashboard to communicate value across multiple applications within IT Service Management.

  Note: Requires activation of Predictive Intelligence Workbench, Performance Analytics - Content Pack - ITSM Dashboards, and Incident plugins.

### Predictive Intelligence Workbench

#### Roles installed with Predictive Intelligence Workbench

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Predictive Intelligence Workbench admin (piwb_admin) | Predictive Intelligence Workbench administrator. Configures the Predictive Intelligence Workbench property settings. Can create and manage use cases. | • piwb_manager  
• ml_admin |
### Role title (name)

**Predictive Intelligence Workbench manager** *(piwb_manager)*  
**Description**  
Typically a business process architect. Can create and manage use cases. Configures the Predictive Intelligence Workbench property settings. Monitors the **Predictive Intelligence for Incidents** dashboard.  
**Contains roles**  
- ml_admin
- piwb_viewer
- pa_admin

**Predictive Intelligence Workbench viewer** *(piwb_viewer)*  
**Can view the Predictive Intelligence for Incidents dashboard.**  
**Contains roles**  
- pa_viewer
- ml_report_user

---

**Note:** All new records are created and updated through the Predictive Intelligence Workbench application. Only users with the maint role can update the base system tables.

---

### Tables installed with ITSM Predictive Intelligence Workbench

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Usecase Prediction Run <em>(piwb_prediction_run)</em></td>
<td>Used to define the test prediction type for a use case, whether it is a single or batch test.</td>
</tr>
<tr>
<td>PIWB Use Case Template <em>(piwb_usecase_template)</em></td>
<td>Used to create a use case template. Extends the Application File (sys_metadata) table.</td>
</tr>
<tr>
<td>Setup Assistant Tracker <em>(piwb_usecase_sa_tracker)</em></td>
<td>Used to track the status of the guided path steps (Stage or Task).</td>
</tr>
<tr>
<td>PIWB Setup Assistant Stage Task <em>(piwb_sa_stage_task)</em></td>
<td>Used to store the tasks for each stage of setup assistant plan. Extends the PIWB Setup Assistant Base Task (piwb_sa_task_base) table.</td>
</tr>
<tr>
<td>PIWB Setup Assistant Plan <em>(piwb_sa_plan)</em></td>
<td>Used to define the Setup Assistant Plan (Guided Path) for each type of use case.</td>
</tr>
<tr>
<td>PIWB Setup Assistant Base Task <em>(piwb_sa_task_base)</em></td>
<td>Used to create a new Setup Assistant Base Task record and to make the task active.</td>
</tr>
<tr>
<td>PIWB Use Case <em>(piwb_usecase)</em></td>
<td>Used to create a new use case per prebuilt template (piwb_admin and piwb_manager can create, update, and delete; piwb_viewer can only view).</td>
</tr>
<tr>
<td>PI Solution Model <em>(piwb_model)</em></td>
<td>Used to create a <strong>Predictive Intelligence</strong> solution model and to make the model active (piwb_admin and piwb_manager can create, update, and delete; piwb_viewer can only view).</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PIWB Setup Assistant Stage</td>
<td>Extends the PIWB Setup Assistant Base Task (piwb_sa_task_base) table.</td>
</tr>
<tr>
<td>(piwb_sa_stage)</td>
<td></td>
</tr>
<tr>
<td>Usecase Prediction Result</td>
<td>Used to define a use case prediction result based on the Prediction Run and Model (piwb_admin and piwb_manager can create, update, and delete; piwb_viewer can only view).</td>
</tr>
<tr>
<td>(piwb_prediction_result)</td>
<td></td>
</tr>
<tr>
<td>PI Solution Comment</td>
<td>Used to define a comment on a Predictive Intelligence solution for a given class (piwb_admin and piwb_manager can create, update, and delete; piwb_viewer can only view).</td>
</tr>
<tr>
<td>(piwb_model_comment)</td>
<td></td>
</tr>
</tbody>
</table>

**Domain separation and Predictive Intelligence Workbench**

This is an overview of domain separation and the Predictive Intelligence Workbench application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: Standard**

- Includes Basic level support.
- Business logic: Processes can be created or modified per customer by the service provider (SP). The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The owner of the instance needs to be able to configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

**Overview**

Predictive Intelligence Workbench enables the creation of machine learning models using historic datasets. A machine learning model can be configured in Predictive Intelligence Workbench per domain, which ensures that the data used by the solution is domain-specific data. After a model is trained for a domain, the model calls for a prediction to be made for resolution, depending on what that domain belongs to. For example, the model predicts an incident or case.

**How domain separation works in Predictive Intelligence Workbench**

An instance owner can train a machine learning model for each domain by creating a model definition for each domain and training those models. In this way each model uses data specific to the corresponding domain.

- Data can be domain separated
- Domain column is present for base system application tables
- Domain-specific configuration is managed by instance owner
- Tenant domains can manage their own application data
Configure ITSM Predictive Intelligence Workbench settings

View the default Predictive Intelligence Workbench property settings and configure them to meet your business process needs.

Role required: piwb_admin or piwb_manager

Predictive Intelligence Workbench includes several configurable property settings that enable you to define how you want to use and experience the application. For example, decide how many rows you want for batch testing or the minimum percentage of net automation to show that a model is auto trained. Default settings are configured in the base-system application.

1. Navigate to Predictive Intelligence Workbench > Administration > Settings.
   The Predictive Intelligence Workbench Settings page appears with default setting configurations.
2. Modify the property settings, if desired, or work within the default parameters.
3. Click **Save** if you make any changes.

**ITSM Predictive Intelligence Workbench notifications**

Email notifications are added with Predictive Intelligence Workbench.

<table>
<thead>
<tr>
<th>Predictive Intelligence Workbench Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Predictive Intelligence Workbench</strong></td>
</tr>
<tr>
<td>The minimum # of predictions for evaluating use case underperformance</td>
</tr>
<tr>
<td>The % difference between estimated and actual net automation for an underperforming use case</td>
</tr>
<tr>
<td>The # of recommended input fields to display that best correlate to the output field</td>
</tr>
<tr>
<td>The minimum % of net automation to show auto-trained model</td>
</tr>
<tr>
<td>Maximum # of rows for batch testing</td>
</tr>
</tbody>
</table>

**Save**
Predictive Intelligence Workbench includes several email notifications that alert users throughout the use case model implementation.

Predictive Intelligence process architects creating and training use case models receive an email notification when a use case model is successfully trained and when batch testing has finished successfully. If a use case fails training or if batch testing produces errors, users will receive notifications about these scenarios, as well.

Users can click a link in the email notification to view a newly trained use case or batch test results. They can also download the test results, if desired. Users can receive the following notifications:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use case model training successful</td>
<td>Sends an email to a specified user group when a use case model is successfully trained.</td>
</tr>
<tr>
<td>Table: PI Solution Model (piwb_model)</td>
<td></td>
</tr>
<tr>
<td>Batch test run complete</td>
<td>Sends an email to a specified user group when batch testing is complete.</td>
</tr>
<tr>
<td>Use case Model training failed</td>
<td>Sends an email to a specified user group when a use case model training has failed.</td>
</tr>
<tr>
<td>Table: PI Solution Model (piwb_model)</td>
<td></td>
</tr>
</tbody>
</table>

Create an ITSM Predictive Intelligence Workbench user group and add users or roles to ensure Predictive Intelligence process architects are notified during the use case model implementation process. Refer to Create an ITSM Predictive Intelligence Workbench user group.

For more details about email notifications for Predictive Intelligence Workbench, refer to Preview email notification.

### Create an ITSM Predictive Intelligence Workbench user group

Create an ITSM Predictive Intelligence Workbench user group and add users or roles to the group to receive email notifications when the use case model training and testing phase is complete.

**Role required:** admin

Create an ITSM Predictive Intelligence Workbench user group and add either users or roles to the group so that email notifications are sent to alert users throughout the use case model training and testing phases.

Users can receive notifications for the following Predictive Intelligence Workbench events:

- Use case training is successful
- Batch testing is complete
- Use case training has failed

To create an ITSM Predictive Intelligence Workbench user group and add users, refer to Create a user group.

For more information about the email notifications provided with this application, refer to ITSM Predictive Intelligence Workbench notifications.
Predictive Intelligence Workbench pretrained use cases

The pretrain functionality mechanism for use cases enables and trains the machine learning solution definition when you activate the Predictive Intelligence Workbench application.

When a pretrained machine learning solution exists in the system, Predictive Intelligence Workbench highlights the use case templates with the **Pretrained model available** flag.

The **Pretrained model available** flag for use case templates displays when the following criteria are met.

- The Predictive Intelligence Workbench `piwb.instance_eligible_auto_train` system property for pretraining is enabled (true) on the your instance. This property is disabled by default. Requires the `piwb_admin` role to enable.
- The instance has to be one of the following types:
  - ded-prod
  - shared-prod
  - ded-subprod
  - shared-subprod
- The associated machine learning solution is active and ready for deployment.
- The use case template does not contain an existing pretrained use case.
- The machine learning solution net automation is greater than the threshold value.

**Note:** The default base-system threshold value is 30. You can configure this value via the Predictive Intelligence Workbench `piwb.auto_train_threshold` system property for. Requires the `piwb_admin` role to modify the default value.

- The machine learning solution is a pretrained base-system solution with an associated record for its definition in the ML Auto Train Solution (`ml_autotrain_solution`) table.

Predictive Intelligence Workbench integration and customization

Predictive Intelligence Workbench uses scripted extension points to integrate a trained use case model for prediction.
Scripted extension points for trained use case integration implementation

The scripted extension point is PIWBPredictionProcessor and PIWBPredictionProcessor_incident is the default implementation of PIWBPredictionProcessor for the Incident (incident) table. PIWBPredictionProcessor_incident runs all the predictions for integrated incident-related use case models.

Customizing default implementation

If you want to customize the default implementation, you can modify the PIWBPredictionProcessor_incident script. The business rule PIWB Prediction – Incident on the Incident table calls the PIWBPredictionProcessor_incident script for predictions. For details about scripted extension points, refer to Using extension points to extend application functionality.

ITSM Predictive Intelligence Workbench implementation

Use machine learning to optimize your business processes. You can train and implement ITSM Predictive Intelligence Workbench use case models to augment your existing application workflows.

Explore use case templates

Users with the piwb_admin or piwb_manager role can explore the prebuilt use case templates and create predictive machine learning models. To create a machine learning model, you first select a prebuilt use case template. Some of the prebuilt templates are guided. Guided templates include a comprehensive setup process to help you ease through implementation.

Templates with available pretrained models accelerate your setup process, by providing a pre-generated model based on your data. When a template indicates Pretrained model available, this means you can go directly to the evaluation phase of the use case setup. If the pretrained model is acceptable, you can directly integrate it with your business processes. Otherwise, you can tune this model or create another model. You may change the name and description of the use case later. Pretrained models display the estimated percentage of your correctly predicted incidents.
Non-guided templates provide links to relevant Predictive Intelligence Workbench product documentation or link to the ServiceNow platform Predictive Intelligence application.
Use case creation phases

Creating a predictive machine learning model involves several phases. After you create and train your model, you need to evaluate and tune it, test its prediction results, and then integrate it with your business process. Use case model creation phases include:

- **Create and train models:** Define parameters to create a model that you’ll train based on your unique data. It is common to create multiple models in this phase.
- **Evaluate and tune your models:** After you create your models, you’ll refine them by defining the right combination of coverage and precision to use.
- **Test your models:** Get prediction results from your models to decide which one is best to integrate with your business process. To see if a model returns a correct result, you can use the single or batch testing process.
- **Integrate the best model:** Deploy the best model into your business process. After you determine which model returns the best, correct result, integrate it into production.

Note: For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

Predict Assignment Group for incoming incidents

Use this guided template to auto-assign incoming incidents to the correct assignment group to reduce your incident resolution times.

Role required: piwb_manager or piwb_viewer

This template walks you through customizing a use case model to predict the correct assignment group for your incoming incidents. When the use case template shows the label **Auto trained model available**, you are automatically taken to the **Evaluate and tune your models** implementation section when you click **Start**. You will, therefore, bypass several implementation steps. Otherwise, you will begin by creating a machine learning model.

1. Navigate to Predictive Intelligence Workbench > Use Cases > Templates.
2. Select the Predict Assignment Group for incoming incidents guided template.

The **Use case - Predict Assignment Group for incoming incidents** pop-up form opens.
3. Provide a unique name for your use case in the **Use case name** field.
4. Provide unique details about the use case in the **Short description** field.
5. Click **Start**.

**Note:** To start implementation, you must provide a use case name and short description.

The use case setup page opens displaying the name and description of the use case you created. On this page, you can see all the implementation phases you will work through to create and implement your use case model.
6. In the Create and train models section of the setup, click Start to create a model associated with your use case.

7. Fill in the mandatory fields with a Model name and Short description.

   **Note:** Other data related to the model is pre-filled by default, such as the Data table, Predicted field, and Processing Language.

8. Expand the Review filters to create a representative data set section to view the default filters. You can customize the filters to best represent your business data or add new criteria by clicking New Criteria.

9. Expand the Review the input fields we selected for this model section to view the pre-populated fields. You can customize the fields to best represent your business data by moving fields between the Available and Selected slush buckets.

10. Click Save.
    The use case setup page opens.

11. Click Continue in the Create and train models section.
    The Create a model page opens.

12. Click Train this model.
    The Train this model pop-up appears letting you know that the process will take a while.

13. Click Start to initiate training.
Train this model

This process will take a while.
We will examine all of your selected records to train this model, which can take a while.

What’s next?
Your team will be notified via email once the training is completed. From there, you can evaluate its precision and coverage and tune its values.

You are returned to the use case setup page.

14. Click View Progress below the header on the use case setup page to monitor the training process.
Note: When training is complete, you will receive an email notification letting you know your use case model training was successful. For more information about use case model notifications, refer to ITSM Predictive Intelligence Workbench notifications. Next you will evaluate and tune your model.

15. On the use case setup page, click Start in the Evaluate and tune your models section. The use case Evaluate and tune your models page opens. Here you can refine your use case model, defining the right combination of coverage and precision to use.

16. Click the box next to the use case model that you want to evaluate and tune. You can view the evaluation data for the use case model by clicking the chevron icon next to the model name to expand details.
17. In the Select an Action drop-down menu, select Open model record. The use case model record opens. You can view the Precision(%), Coverage(%), and Net Automation(%) scores.

<table>
<thead>
<tr>
<th>Model name</th>
<th>Auto trained model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input fields</td>
<td>Short description</td>
</tr>
<tr>
<td>Filter</td>
<td>active=false^sys_created_onLast 12 months@javascript:gs.b</td>
</tr>
<tr>
<td>Precision(%)</td>
<td>94.60</td>
</tr>
<tr>
<td>Coverage(%)</td>
<td>91.96</td>
</tr>
<tr>
<td>Net Automation(%)</td>
<td>86.99</td>
</tr>
</tbody>
</table>

Retraining frequency
Determine how often this model will take recent data to improve itself.

<table>
<thead>
<tr>
<th>Retraining Schedule</th>
<th>Run Once</th>
</tr>
</thead>
</table>

18. In the Retraining Schedule field you can change the definition, if desired. The default value is Run Once, but you can retrain as often as every 30 days to every 180 days.

19. If you made evaluation or tuning changes to the use case model, click either Update or Update and retrain, to run retraining again one time.

The use case Evaluate and tune your models page opens.

20. If you are ready to test your use case model, click the box next to the model that you want to test.

21. In the Select an Action drop-down menu, select Test this model.

The use case Testing your models page opens with the use case model you selected to test is in the Selected slush bucket.
Testing your models

Get prediction results from your models to decide which one is best. You may select multiple models at the same time for comparison. Pass through a single record's form field inputs or test many existing records at once. Learn more

Select models to test

Select the models you want to test and compare. Selecting more models will increase processing time for a batch test.

Defined testing parameters

For a single test, fill out the blank input fields to see how the selected model predicts an output based on a theoretical incoming record. For a batch test, select a representative data set to test and compare how the selected models perform with your existing data.

NOTE: This is for testing purposes only and won’t impact your real data. By default, the first 1,000 rows in a table will be tested. Displayed results are overwritten after each test is run.

Select the type of test

- Single test
- Batch test

Top N results to display

1

Input fields

Short description

Run Test
22. In the **Select models to test** section, decide if there are other use case models available that you want to test. If so, move them to the **Selected** slush bucket.

23. In the **Define testing parameters** section, decide if you want to test one use case model. If so, select the **Single test** test type. **Single test** is the default.

   **Note:** Select **Batch test** when you want to test more than one use case model.

24. Determine the number of top results you want to display.

25. In the **Input fields** section, provide a short description of your use case model test.

26. Click **Run Test**.

27. View the test results data for the use case model in the **View test results** section.
### Input fields
- **Type of text**: Single text
- **Top K results to display**: 1
- **Short description**: my laptop is not working

### View test results
<table>
<thead>
<tr>
<th>Predict assignment group ID</th>
<th>Predicted Value</th>
<th>Confidence</th>
<th>Threshold</th>
<th>Short description</th>
<th>Integrated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predict Assignment Group Model (1)</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Result</td>
<td>IT Security</td>
<td>50.00</td>
<td>48.44</td>
<td>my laptop is not working</td>
<td></td>
</tr>
</tbody>
</table>
### Last test run results

<table>
<thead>
<tr>
<th>Model</th>
<th>Net Automation (%)</th>
<th>Precision (%)</th>
<th>Coverage (%)</th>
<th># of Total Records</th>
<th># of Skipped Records</th>
<th>Integrated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predict Assignment Group Model</td>
<td>54.00</td>
<td>60.00</td>
<td>90.00</td>
<td>1000</td>
<td>641</td>
<td>No</td>
</tr>
</tbody>
</table>
28. If you are ready to integrate your use case model into your business processes, return to the use case **Evaluate and tune your models** page and select the box next to the model that you want to integrate. **Start** in the **Integrate the best model** section.

29. In the **Select an Action** drop-down menu, select **Integrate this model**. The **Select a model to integrate** page opens.

### Select a model to Integrate

Once a model is selected and integrated, the default business logic implementation will automatically apply the model's predictions when a record is inserted in the target table. [Learn more]

<table>
<thead>
<tr>
<th>Model to Integrate</th>
<th>Auto trained model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input fields</td>
<td>Short description</td>
</tr>
<tr>
<td>Filter</td>
<td>active=false^sys_created_onCNLast 12 months@javascript:gs.b</td>
</tr>
<tr>
<td>Precision(%)</td>
<td>94.60</td>
</tr>
<tr>
<td>Coverage(%)</td>
<td>91.96</td>
</tr>
<tr>
<td>Net Automation(%)</td>
<td>86.99</td>
</tr>
</tbody>
</table>

### Retraining frequency

Determine how often this model will take recent data to improve itself.

<table>
<thead>
<tr>
<th>Retraining Schedule</th>
<th>Run Once</th>
</tr>
</thead>
</table>

30. Click **Integrate**.

31. Click **Integrate** again when the pop-up asks you if you are sure you want to perform this action.

You have integrated a use case model into your business process.
Predict Category for incoming incidents

Use this guided template to auto-assign incoming incidents to the correct category to reduce your incident resolution times.

Role required: piwb_manager or piwb_viewer

This template includes a pretrained model and walks you through customizing a use case model to predict the category for your incoming incidents. When the use case template shows the label **Auto trained model available**, you are automatically taken to the **Evaluate and tune your models** implementation section when you click **Start**. You will, therefore, bypass several implementation steps. Otherwise, you will begin by creating a machine learning model.

1. Navigate to **Predictive Intelligence Workbench > Use Cases > Templates**.
2. Select the **Predict Category for incoming incidents** guided template.

The **Use case - Predict Category for incoming incidents** pop-up form opens.
3. Provide a unique name for your use case in the **Use case name** field.
4. Provide unique details about the use case in the **Short description** field.
5. Click **Start**.

**Note:** To start implementation, you must provide a use case name and short description.

The use case setup page opens displaying the name and description of the use case you created. On this page, you can see all the implementation phases you will work through to create and implement your use case model.
6. In the **Create and train models** section of the setup, click **Start** to create a model associated with your use case.

7. Fill in the mandatory fields with a **Model name** and **Short description**.

   **Note:** Other data related to the model is pre-filled by default, such as the **Data table**, **Predicted field**, and **Processing Language**.

8. Expand the **Review filters to create a representative data set** section to view the default filters. You can customize the filters to best represent your business data or add new criteria by clicking **New Criteria**.

9. Expand the **Review the input fields we selected for this model** section to view the pre-populated fields. You can customize the fields to best represent your business data by moving fields between the **Available** and **Selected** slush buckets.

10. Click **Save**. The use case setup page opens.

11. Click **Continue** in the **Create and train models** section. The **Create a model** page opens.

12. Click **Train this model**. The **Train this model** pop-up appears letting you know that the process will take a while.

13. Click **Start** to initiate training.
14. Click View Progress below the header on the use case setup page to monitor the training process.
Note: When training is complete, you will receive an email notification letting you know your use case model training was successful. For more information about use case model notifications, refer to ITSM Predictive Intelligence Workbench notifications. Next you will evaluate and tune your model.

15. On the use case setup page, click **Start** in the **Evaluate and tune your models** section. The use case **Evaluate and tune your models** page opens. Here you can refine your use case model, defining the right combination of coverage and precision to use.

16. Click the box next to the use case model that you want to evaluate and tune. You can view the evaluation data for the use case model by clicking the chevron icon next to the model name to expand details.

17. In the **Select an Action** drop-down menu, select **Open model record**.
The use case model record opens. You can view the **Precision(%)**, **Coverage(%)**, and **Net Automation(%)** scores.

<table>
<thead>
<tr>
<th>Model name</th>
<th>Auto trained model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input fields</td>
<td>Short description</td>
</tr>
<tr>
<td>Filter</td>
<td><code>active=false\sys_created_onONLast 12 months@javascript:sb</code></td>
</tr>
<tr>
<td>Precision(%)</td>
<td>94.60</td>
</tr>
<tr>
<td>Coverage(%)</td>
<td>91.96</td>
</tr>
<tr>
<td>Net Automation(%)</td>
<td>86.99</td>
</tr>
</tbody>
</table>

**Retraining frequency**
Determine how often this model will take recent data to improve itself.

<table>
<thead>
<tr>
<th>Retraining Schedule</th>
<th>Run Once</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Update**  **Update and retrain**

18. In the **Retraining Schedule** field you can change the definition, if desired. The default value is **Run Once**, but you can retrain as often as every 30 days to every 180 days.

19. If you made evaluation or tuning changes to the use case model, click either **Update** or **Update and retrain**, to run retraining again one time.

The use case **Evaluate and tune your models** page opens.

20. If you are ready to test your use case model, click the box next to the model that you want to test.

21. In the **Select an Action** drop-down menu, select **Test this model**.

The use case **Testing your models** page opens with the use case model you selected to test is in the **Selected** slush bucket.
Testing your models

Get prediction results from your models to decide which one is best. You may select multiple models at the same time for comparison. Pass through a single record's form field inputs or test many existing records at once. Learn more.

Select models to test

Select the models you want to test and compare. Selecting more models will increase processing time for a batch test.

Available

Test models:

Selected

Add trained model

Define testing parameters

For a single test, fill out the blank input fields to see how the selected model predicts an output based on a theoretical incoming record. For a batch test, select a representative data set to test and compare how the selected models perform with your existing data.

NOTE: This is for testing purposes only and won’t impact your real data. By default, the first 2,000 rows in a table will be tested. Displayed results are overwritten after the next test is run.

Select the type of test

- Single test
- Batch test

Top N results to display

1

Input fields

Short description

Run Test
22. In the **Select models to test** section, decide if there are other use case models available that you want to test. If so, move them to the **Selected** slush bucket.

23. In the **Define testing parameters** section, decide if you want to test one use case model. If so, select the **Single test** test type. **Single test** is the default.

   **Note:** Select **Batch test** when you want to test more than one use case model.

24. Determine the number of top results you want to display.

25. In the **Input fields** section, provide a short description of your use case model test.

26. Click **Run Test**.

27. View the test results data for the use case model in the **View test results** section.
<table>
<thead>
<tr>
<th>Predict assignment group ID</th>
<th>Predicted Value</th>
<th>Confidence</th>
<th>Threshold</th>
<th>Short description</th>
<th>Integrated</th>
</tr>
</thead>
<tbody>
<tr>
<td>#Predict Assignment Group Model(1)</td>
<td>1</td>
<td>0.995</td>
<td>0.99</td>
<td>my laptop is not working</td>
<td>No</td>
</tr>
</tbody>
</table>

**Result:** IT Security

**Status:** 99:00

**Confidence:** 0.995

**Threshold:** 0.99

**Description:** my laptop is not working
### Last test run results

<table>
<thead>
<tr>
<th>Model</th>
<th>Net Automation (%)</th>
<th>Precision (%)</th>
<th>Coverage (%)</th>
<th># of Total Records</th>
<th># of Skipped Records</th>
<th>Integrated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predict Assignment Group Model</td>
<td>54.00</td>
<td>60.00</td>
<td>90.00</td>
<td>1000</td>
<td>641</td>
<td>No</td>
</tr>
</tbody>
</table>
28. If you are ready to integrate your use case model into your business processes, return to the use case **Evaluate and tune your models** page and select the box next to the model that you want to integrate. **Start** in the **Integrate the best model** section.

29. In the **Select an Action** drop-down menu, select **Integrate this model**. The **Select a model to integrate** page opens.

**Select a model to integrate**

Once a model is selected and integrated, the default business logic implementation will automatically apply the model's predictions when a record is inserted in the target table. [Learn more]

<table>
<thead>
<tr>
<th>Model to Integrate</th>
<th>Auto trained model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input fields</td>
<td>Short description</td>
</tr>
<tr>
<td>Filter</td>
<td>active=false^sys_created_onCNLast 12 months@javascript:gs.b</td>
</tr>
<tr>
<td>Precision(%)</td>
<td>94.60</td>
</tr>
<tr>
<td>Coverage(%)</td>
<td>91.96</td>
</tr>
<tr>
<td>Net Automation(%)</td>
<td>86.99</td>
</tr>
</tbody>
</table>

**Retraining frequency**

Determine how often this model will take recent data to improve itself.

<table>
<thead>
<tr>
<th>Retraining Schedule</th>
<th>Run Once</th>
</tr>
</thead>
</table>

30. Click **Integrate**.

31. Click **Integrate** again when the pop-up asks you if you are sure you want to perform this action.

You have integrated a use case model into your business process.
Predict Configuration Item for incoming incidents

Use this guided template to auto-assign incoming incidents to the correct configuration item to reduce your incident resolution times.

Role required: piwb_manager or piwb_viewer

This template walks you through customizing a use case model to predict the configuration item for your incoming incidents. When the use case template shows the label Auto trained model available, you are automatically taken to the Evaluate and tune your models implementation section when you click Start. You will, therefore, bypass several implementation steps. Otherwise, you will begin by creating a machine learning model.

1. Navigate to Predictive Intelligence Workbench > Use Cases > Templates.
2. Select the Predict the Configuration Item for incoming incidents guided template.
   The Use case - Predict the Configuration Item for incoming incidents pop-up form opens.
3. Provide a unique name for your use case in the **Use case name** field.
4. Provide unique details about the use case in the **Short description** field.
5. Click **Start**.

**Note:** To start implementation, you must provide a use case name and short description.

The use case setup page opens displaying the name and description of the use case you created. On this page, you can see all the implementation phases you will work through to create and implement your use case model.
6. In the **Create and train models** section of the setup, click **Start** to create a model associated with your use case.

7. Fill in the mandatory fields with a **Model name** and **Short description**.

   **Note:** Other data related to the model is pre-filled by default, such as the **Data table**, **Predicted field**, and **Processing Language**.

8. Expand the **Review filters to create a representative data set** section to view the default filters. You can customize the filters to best represent your business data or add new criteria by clicking **New Criteria**.

9. Expand the **Review the input fields we selected for this model** section to view the pre-populated fields. You can customize the fields to best represent your business data by moving fields between the **Available** and **Selected** slush buckets.

10. Click **Save**.
    The use case setup page opens.

11. Click **Continue** in the **Create and train models** section.
    The **Create a model** page opens.

12. Click **Train this model**.
    The **Train this model** pop-up appears letting you know that the process will take a while.

13. Click **Start** to initiate training.
You are returned to the use case setup page.

**14.** Click **View Progress** below the header on the use case setup page to monitor the training process.
15. On the use case setup page, click **Start** in the **Evaluate and tune your models** section. The use case **Evaluate and tune your models** page opens. Here you can refine your use case model, defining the right combination of coverage and precision to use.

16. Click the box next to the use case model that you want to evaluate and tune. You can view the evaluation data for the use case model by clicking the chevron icon next to the model name to expand details.

17. In the **Select an Action** drop-down menu, select **Open model record**.

**Note:** When training is complete, you will receive an email notification letting you know your use case model training was successful. For more information about use case model notifications, refer to *ITSM Predictive Intelligence Workbench notifications*. Next you will evaluate and tune your model.
In the Retraining Schedule field, you can change the definition, if desired. The default value is Run Once, but you can retrain as often as every 30 days to every 180 days.

If you made evaluation or tuning changes to the use case model, click either Update or Update and retrain, to run retraining again one time.

The use case Evaluate and tune your models page opens.

If you are ready to test your use case model, click the box next to the model that you want to test.

In the Select an Action drop-down menu, select Test this model.

The use case Testing your models page opens with the use case model you selected to test is in the Selected slush bucket.
Testing your models

Get prediction results from your models to decide which one is best. You may select multiple models at the same time for comparison. Pass through a single record's form field inputs or test many existing records at once. Learn more

Select models to test

Select the models you want to test and compare. Selecting more models will increase processing time for a batch test.

<table>
<thead>
<tr>
<th>Available</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test module</td>
<td>Auto-trained model</td>
</tr>
</tbody>
</table>

Define testing parameters

For a single test, fill out the blank input fields to see how the selected model predicts an output based on a theoretical incoming record. For a batch test, select a representative data set to test and compare how the selected models perform with your existing data.

NOTE: This is for testing purposes only and won’t impact your real data. By default, the first 1,000 rows in a table will be tested. Displayed results are overwritten after the next test is run.

- Select the type of test: Single test, Batch test
- Top N results to display: 1
- Input fields:
  - Short description: [Blank]

Run Test
22. In the **Select models to test** section, decide if there are other use case models available that you want to test. If so, move them to the **Selected** slush bucket.

23. In the **Define testing parameters** section, decide if you want to test one use case model. If so, select the **Single test** test type. **Single test** is the default.

    **Note:** Select **Batch test** when you want to test more than one use case model.

24. Determine the number of top results you want to display.

25. In the **Input fields** section, provide a short description of your use case model test.

26. Click **Run Test**.

27. View the test results data for the use case model in the **View test results** section.
<table>
<thead>
<tr>
<th>Predict assignment group ID</th>
<th>Predicted Value</th>
<th>Confidence</th>
<th>Threshold</th>
<th>Short description</th>
<th>Integrated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predict Assignment Group Model (1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>Result</td>
<td>IT Security</td>
<td>88.00</td>
<td>43.44</td>
<td>my laptop is not working</td>
<td></td>
</tr>
<tr>
<td>Model</td>
<td>Net Automation (%)</td>
<td>Precision (%)</td>
<td>Coverage (%)</td>
<td># of Total Records</td>
<td># of Skipped Records</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------</td>
<td>---------------</td>
<td>--------------</td>
<td>--------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Predict Assignment Grouper Model</td>
<td>54.00</td>
<td>60.00</td>
<td>90.00</td>
<td>9300</td>
<td>641</td>
</tr>
</tbody>
</table>
28. If you are ready to integrate your use case model into your business processes, return to the use case Evaluate and tune your models page and select the box next to the model that you want to integrate. Start in the Integrate the best model section.

29. In the Select an Action drop-down menu, select Integrate this model. The Select a model to integrate page opens.

Select a model to Integrate

Once a model is selected and integrated, the default business logic implementation will automatically apply the model's predictions when a record is inserted in the target table. Learn more

<table>
<thead>
<tr>
<th>Model to Integrate</th>
<th>Auto trained model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input fields</td>
<td>Short description</td>
</tr>
<tr>
<td>Filter</td>
<td>active=false^sys_created_on&lt;=last 12 months@javascript:gs.b</td>
</tr>
<tr>
<td>Precision(%)</td>
<td>94.60</td>
</tr>
<tr>
<td>Coverage(%)</td>
<td>91.96</td>
</tr>
<tr>
<td>Net Automation(%)</td>
<td>86.99</td>
</tr>
</tbody>
</table>

Retraining frequency

Determine how often this model will take recent data to improve itself.

<table>
<thead>
<tr>
<th>Retraining Schedule</th>
<th>Run Once</th>
</tr>
</thead>
</table>

30. Click Integrate.

31. Click Integrate again when the pop-up asks you if you are sure you want to perform this action. You have integrated a use case model into your business process.
Predict Service for incoming incidents

Use this guided template to auto-assign incoming incidents to the correct service to reduce your incident resolution times.

Role required: piwb_manager or piwb_viewer

This template walks you through customizing a use case model to predict the configuration item for your incoming incidents. When the use case template shows the label Auto trained model available, you are automatically taken to the Evaluate and tune your models implementation section when you click Start. You will, therefore, bypass several implementation steps. Otherwise, you will begin by creating a machine learning model.

1. Navigate to Predictive Intelligence Workbench > Use Cases > Templates.
2. Select the Predict Service for incoming incidents guided template.
   The Use case - Predict Service for incoming incidents pop-up form opens.
3. Provide a unique name for your use case in the **Use case name** field.
4. Provide unique details about the use case in the **Short description** field.
5. Click **Start**.

**Note:** To start implementation, you must provide a use case name and short description.

The use case set up page opens displaying the name and description of the use case you created. On this page, you can see all the implementation phases you will work through to create and implement your use case model.
6. In the **Create and train models** section of the setup, click **Start** to create a model associated with your use case.

7. Fill in the mandatory fields with a **Model name** and **Short description**.

   **Note:** Other data related to the model is pre-filled by default, such as the **Data table**, **Predicted field**, and **Processing Language**.

8. Expand the **Review filters to create a representative data set** section to view the default filters. You can customize the filters to best represent your business data or add new criteria by clicking **New Criteria**.

9. Expand the **Review the input fields we selected for this model** section to view the pre-populated fields. You can customize the fields to best represent your business data by moving fields between the **Available** and **Selected** slush buckets.

10. Click **Save**.
    The use case setup page opens.

11. Click **Continue** in the **Create and train models** section.
    The **Create a model** page opens.

12. Click **Train this model**.
    The **Train this model** pop-up appears letting you know that the process will take a while.

13. Click **Start** to initiate training.
You are returned to the use case setup page.

14. Click View Progress below the header on the use case setup page to monitor the training process.
When training is complete, you will receive an email notification letting you know your use case model training was successful. For more information about use case model notifications, refer to ITSM Predictive Intelligence Workbench notifications. Next you will evaluate and tune your model.

15. On the use case setup page, click Start in the Evaluate and tune your models section. The use case Evaluate and tune your models page opens. Here you can refine your use case model, defining the right combination of coverage and precision to use.

16. Click the box next to the use case model that you want to evaluate and tune. You can view the evaluation data for the use case model by clicking the chevron icon next to the model name to expand details.

17. In the Select an Action drop-down menu, select Open model record.
The use case model record opens. You can view the **Precision(%)**, **Coverage(%)**, and **Net Automation(%)** scores.

<table>
<thead>
<tr>
<th>Model name</th>
<th>Auto trained model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input fields</td>
<td>Short description</td>
</tr>
<tr>
<td>Filter</td>
<td><code>active=false^sys_created_onONLast 12 months@javascript:gs.b</code></td>
</tr>
<tr>
<td>Precision(%)</td>
<td>94.60</td>
</tr>
<tr>
<td>Coverage(%)</td>
<td>91.96</td>
</tr>
<tr>
<td>Net Automation(%)</td>
<td>86.99</td>
</tr>
</tbody>
</table>

**Retraining frequency**

Determine how often this model will take recent data to improve itself.

**Retraining Schedule**

- **Run Once**

[Update] [Update and retrain]

18. In the **Retraining Schedule** field you can change the definition, if desired. The default value is **Run Once**, but you can retrain as often as every 30 days to every 180 days.

19. If you made evaluation or tuning changes to the use case model, click either **Update** or **Update and retrain**, to run retraining again one time.

   The use case **Evaluate and tune your models** page opens.

20. If you are ready to test your use case model, click the box next to the model that you want to test.

21. In the **Select an Action** drop-down menu, select **Test this model**.

   The use case **Testing your models** page opens with the use case model you selected to test is in the **Selected** slush bucket.
Testing your models

Get prediction results from your models to decide which one is best. You may select multiple models at the same time for comparison. Pass through a single record's form field inputs or test many existing records at once. Learn more

Select models to test

Select the models you want to test and compare. Selecting more models will increase processing time for a batch test.

Available

Selected

Add trained model

Define testing parameters

For a single test, fill out the blank input fields to see how the selected model predicts an output based on a theoretical incoming record. For a batch test, select a representative data set to test and compare how the selected models perform with your existing data.

NOTE: This is for testing purposes only and won’t impact your real data. By default, the first 1,000 rows in a file will be tested. Displayed results are overwritten after the next test is run.

Select the type of test

- Single test
- Batch test

Top N results to display

Input fields

Short description

Run Test
22. In the Select models to test section, decide if there are other use case models available that you want to test. If so, move them to the Selected slush bucket.

23. In the Define testing parameters section, decide if you want to test one use case model. If so, select the Single test test type. Single test is the default.

**Note:** Select Batch test when you want to test more than one use case model.

24. Determine the number of top results you want to display.

25. In the Input fields section, provide a short description of your use case model test.

26. Click Run Test.

27. View the test results data for the use case model in the View test results section.
### Input fields

- **Select the type of test**: Single text
- **Top K results to display**: 1
- **Short description**: my laptop is not working

### View test results

<table>
<thead>
<tr>
<th>Predict assignment group</th>
<th>Predicted Value</th>
<th>Confidence</th>
<th>Threshold</th>
<th>Short description</th>
<th>Integrated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predict Assignment Group Model (1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>Result</td>
<td>IT Security</td>
<td>50.00</td>
<td>45.44</td>
<td>my laptop is not working</td>
<td></td>
</tr>
</tbody>
</table>
### Last test run results

<table>
<thead>
<tr>
<th>Model</th>
<th>Net Automation (%)</th>
<th>Precision (%)</th>
<th>Coverage (%)</th>
<th># of Total Records</th>
<th># of Skipped Records</th>
<th>Integrated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predict Assignment Group Model</td>
<td>54.00</td>
<td>60.00</td>
<td>90.00</td>
<td>1000</td>
<td>641</td>
<td>No</td>
</tr>
</tbody>
</table>

---

© 2020 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
28. If you are ready to integrate your use case model into your business processes, return to the use case Evaluate and tune your models page and select the box next to the model that you want to integrate. Start in the Integrate the best model section.

29. In the Select an Action drop-down menu, select Integrate this model. The Select a model to integrate page opens.

Select a model to Integrate

Once a model is selected and integrated, the default business logic implementation will automatically apply the model’s predictions when a record is inserted in the target table. Learn more

<table>
<thead>
<tr>
<th>Model to Integrate</th>
<th>Auto trained model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input fields</td>
<td>Short description</td>
</tr>
<tr>
<td>Filter</td>
<td>active=false^sys_created_onCNLlast 12 <a href="mailto:months@jsa.pdfs.b">months@jsa.pdfs.b</a></td>
</tr>
<tr>
<td>Precision(%)</td>
<td>94.60</td>
</tr>
<tr>
<td>Coverage(%)</td>
<td>91.96</td>
</tr>
<tr>
<td>Net Automation(%)</td>
<td>86.99</td>
</tr>
</tbody>
</table>

Retraining frequency

Determine how often this model will take recent data to improve itself.

Retraining Schedule | Run Once

30. Click Integrate.

31. Click Integrate again when the pop-up asks you if you are sure you want to perform this action.

You have integrated a use case model into your business process.
Suggest relevant Incidents for an Incident

Use this template to recommend similar relevant incidents to help expedite your incident investigation and resolution processes.

Role required: piwb_manager or piwb_viewer

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for incoming incidents. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with past resolved incidents for smarter resolution. Similar past active incidents are displayed in Agent Assist and also in the Incident form via related search.

Note: You will need business users to validate the similar past active incident search results. Contact ServiceNow Technical Support, if necessary, to configure sources for contextual search.

When the use case template shows the label Pretrained model available, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.

1. If you started this procedure directly from the Predictive Intelligence Workbench product Templates module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Templates.

2. Select the Suggest relevant Incidents for an Incident template.

The Suggest relevant Incidents for an Incident pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.

3. Create and train a machine learning predictive model.

Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

a) Create a word corpus.

When creating a word corpus on the Word Corpus Content form, select an incidents-related table, such as Incident (incidents) in the Table field and define the time frame that best describes the current usage of words in the Filter field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the Field List field, define only the fields that best capture the words: Description, Short description, and Resolution notes. Defining these alone is typically enough, since the prediction rule is expected to find incidents based on the short description.

Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

b) Create and train a similarity solution.

c) For this initial model creation, provide the similarity solution definition label Similar Incidents in the Label field.
d) Set the **Training Frequency** field to **Run Once**. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

e) Set the **Update Frequency** field to **Every 15 minutes**. This defines the frequency at which past incidents refresh in the search window.

When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the **Table** field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for incoming incidents. You can select more inputs in the **Test Table** field, if required, for comparison. It is best to start with similar fields for both the **Table** and **Test Table** fields.

The **Filter** field conditions determine the search window for past resolved incidents. Configure the filter conditions to optimize for the best set of resolved incidents to search within. This includes many considerations, such as, time frame, location, category where incidents are relevant, and more.

f) Click **Submit & Train** to create your similarity solution record and train it.

Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

---

4. **Evaluation and tune your model.**

If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold**.

5. **Once you have a satisfactory model, test the similarity solution prediction.**

You can manually provide inputs and select the top similar results outcome values.

6. **Once you have tested the behavior, configure the user experience layout to show attributed results and actions performed on the results.**

You can configure these results and actions via Workspace UI for Agent Assist or via the Now Platform for Contextual Search. Configure actions and search context though **Tables configuration** and user experience and card layout through **Contextual Search > Search Result Display Configuration**.

7. **Integrate trained models by exporting them to production.**

   **Note:** For details regarding trained use case integration implementation, refer to **Predictive Intelligence Workbench integration and customization**.

8. **Monitor similarity results and ensure IT agents are providing useful feedback.**

The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation
and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.

Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The “likes” you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

Suggest relevant Incidents for a Major Incident

Use this template to recommend similar resolved incidents to help expedite your major incident investigation and resolution processes.

Role required: piwb_manager or piwb_viewer

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for incoming incidents. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with past resolved incidents for smarter resolution. Similar past active incidents are displayed in Agent Assist and also in the Incident form via related search.

Note: You will need business users to validate the similar past active incident search results. Contact ServiceNow Technical Support, if necessary, to configure sources for contextual search.

When the use case template shows the label Pretrained model available, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.

1. If you started this procedure directly from the Predictive Intelligence Workbench product Templates module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Templates.

2. Select the Suggest relevant Incidents for an Major Incident template.

The Suggest relevant Incidents for an Major Incident pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.

3. Create and train a machine learning predictive model.

Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

a) Create a word corpus.

When creating a word corpus on the Word Corpus Content form, select an incidents-related table, such as Incident (incidents) in the Table field and define the time frame that best describes the current usage of words in the Filter field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the Field List field, define only the fields that best capture the words: Description, Short description, and Resolution notes. Defining these alone is typically enough, since the prediction rule is expected to find incidents based on the short description.
Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

b) *Create and train a similarity solution.*

c) For this initial model creation, provide the similarity solution definition label Similar Incidents in the **Label** field.

d) Set the **Training Frequency** field to **Run Once**. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

e) Set the **Update Frequency** field to **Every 15 minutes**. This defines the frequency at which past incidents refresh in the search window.

When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the **Table** field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for incoming incidents. You can select more inputs in the **Test Table** field, if required, for comparison. It is best to start with similar fields for both the **Table** and **Test Table** fields.

The **Filter** field conditions determine the search window for past resolved incidents. Configure the filter conditions to optimize for the best set of resolved incidents to search within. This includes many considerations, such as, time frame, location, category where incidents are relevant, and more.

f) Click **Submit & Train** to create your similarity solution record and train it.

Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**

   If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

   If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

   If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold**.

5. **Once you have a satisfactory model, test the similarity solution prediction.**

   You can manually provide inputs and select the top similar results outcome values.

6. **Once you have tested the behavior, configure the user experience layout to show attributed results and actions performed on the results.**

   You can configure these results and actions via Workspace UI for Agent Assist or via the Now Platform for Contextual Search. Configure actions and search context though **Tables** configuration and user experience and card layout through **Contextual Search > Search Result Display Configuration**.

7. **Integrate trained models by exporting them to production.**

   **Note:** For details regarding trained use case integration implementation, refer to **Predictive Intelligence Workbench integration and customization**.

8. **Monitor similarity results and ensure IT agents are providing useful feedback.**
The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.

Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The “likes” you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

Suggest relevant Major Incident for an Incident

Use this template to recommend similar resolved major incidents to help expedite your incident investigation and resolution processes.

Role required: piwb_manager or piwb_viewer

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for incoming incidents. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with past resolved incidents for smarter resolution. Similar past active incidents are displayed in Agent Assist and also in the Incident form via related search.

Note: You will need business users to validate the similar past active incident search results. Contact ServiceNow Technical Support, if necessary, to configure sources for contextual search.

When the use case template shows the label Pretrained model available, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.

1. If you started this procedure directly from the Predictive Intelligence Workbench product Templates module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Templates.

2. Select the Suggest relevant Major Incident for an Incident template. The Suggest relevant Major Incident for an Incident pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.

3. Create and train a machine learning predictive model.

Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

a) Create a word corpus.
When creating a word corpus on the Word Corpus Content form, select an incidents-related table, such as Incident (incidents) in the **Table** field and define the time frame that best describes the current usage of words in the **Filter** field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the **Field List** field, define only the fields that best capture the words: **Description**, **Short description**, and **Resolution notes**. Defining these alone is typically enough, since the prediction rule is expected to find incidents based on the short description.

Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

b) **Create and train a similarity solution.**

c) For this initial model creation, provide the similarity solution definition label **Similar Incidents** in the **Label** field.

d) Set the **Training Frequency** field to **Run Once**. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

e) Set the **Update Frequency** field to **Every 15 minutes**. This defines the frequency at which past incidents refresh in the search window.

When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the **Table** field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for incoming incidents. You can select more inputs in the **Test Table** field, if required, for comparison. It is best to start with similar fields for both the **Table** and **Test Table** fields.

The **Filter** field conditions determine the search window for past resolved incidents. Configure the filter conditions to optimize for the best set of resolved incidents to search within. This includes many considerations, such as, time frame, location, category where incidents are relevant, and more.

f) Click **Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**

If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold**.

5. Once you have a satisfactory model, **test the similarity solution prediction**.

You can manually provide inputs and select the top similar results outcome values.

6. Once you have tested the behavior, **configure the user experience** layout to show attributed results and actions performed on the results.

You can configure these results and actions via Workspace UI for Agent Assist or via the Now Platform for Contextual Search. Configure actions and search context through **Tables**
configuration and user experience and card layout through **Contextual Search > Search Result Display Configuration**.

7. **Integrate trained models by exporting them to production.**

   **Note:** For details regarding trained use case integration implementation, refer to *Predictive Intelligence Workbench integration and customization*.

8. **Monitor similarity results and ensure IT agents are providing useful feedback.**

   The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. **Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.**

   Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The “likes” you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

   For information regarding the Predictive Intelligence for Incidents dashboard, refer to *ITSM Predictive Intelligence Workbench dashboard*.

**Suggest relevant KB article for an Incident**

Use this template to recommend relevant knowledge base articles to help expedite your incident investigation and resolution processes.

**Role required:** piwb_manager or piwb_viewer

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for incoming incidents. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with relevant knowledge base articles for smarter resolution. Similar past active incidents are displayed in Agent Assist and also in the Incident form via related search.

**Note:** You will need business users to validate the similar past active incident search results. Contact ServiceNow Technical Support, if necessary, to configure sources for contextual search.

When the use case template shows the label **Pretrained model available**, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.

1. **If you started this procedure directly from the Predictive Intelligence Workbench product Templates module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Templates.**

2. **Select the Suggest relevant KB article for an Incident template.**
The **Suggest relevant KB article for an Incident** pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.

3. Create and train a machine learning predictive model.

Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

   a) **Create a word corpus.**

      When creating a word corpus on the Word Corpus Content form, select an incidents-related table, such as Incident (incidents) in the **Table** field and define the time frame that best describes the current usage of words in the **Filter** field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the **Field List** field, define only the fields that best capture the words: **Description**, **Short description**, and **Resolution notes**. Defining these alone is typically enough, since the prediction rule is expected to find incidents based on the short description.

      Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

   b) **Create and train a similarity solution.**

   c) For this initial model creation, provide the similarity solution definition label **Similar Knowledge Articles** in the **Label** field.

   d) For this initial model creation, set the **Training Frequency** field to **Run Once**. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

   e) Set the **Update Frequency** field to **Every 15 minutes**. This defines the frequency at which past incidents refresh in the search window.

      When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the **Table** field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for incoming incidents. You can select more inputs in the **Test Table** field, if required, for comparison. It is best to start with similar fields for both the **Table** and **Test Table** fields.

      The **Filter** field conditions determine the search window for past resolved incidents. Configure the filter conditions to optimize for the best set of resolved incidents to search within. This includes many considerations, such as, time frame, location, category where incidents are relevant, and more.

   f) Click **Submit & Train** to create your similarity solution record and train it.

      Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**

   If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

   If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

   If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold.**
5. Once you have a satisfactory model, test the similarity solution prediction. You can manually provide inputs and select the top similar results outcome values.

6. Once you have tested the behavior, configure the user experience layout to show attributed results and actions performed on the results. You can configure these results and actions via Workspace UI for Agent Assist or via the Now Platform for Contextual Search. Configure actions and search context though Tables configuration and user experience and card layout through Contextual Search > Search Result Display Configuration.

7. Integrate trained models by exporting them to production.

Note: For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

8. Monitor similarity results and ensure IT agents are providing useful feedback.

The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.

Select one or more KPIs that you think is most beneficial to your IT agents. Create aPerformance Analytics dashboard showing the trend of these KPIs. The “likes” you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

Suggest relevant Open incidents for an Incident

Use this template to recommend similar open incidents to help expedite your incident investigation and resolution processes.

Role required: piwb_manager or piwb_viewer

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for incoming incidents. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with past resolved incidents for smarter resolution. Similar past active incidents are displayed in Agent Assist and also in the Incident form via related search.

Note: You will need business users to validate the similar past active incident search results. Contact ServiceNow Technical Support, if necessary, to configure sources for contextual search.
When the use case template shows the label **Pretrained model available**, you can go directly to the **Testing your models** implementation section. Otherwise, you will begin by creating a machine learning model.

1. If you started this procedure directly from the Predictive Intelligence Workbench product **Templates** module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to **Predictive Intelligence Workbench > Use Cases > Templates**.

2. Select the **Suggest relevant Open Incidents for an Incident** template. The **Suggest relevant Open Incidents for an Incident** pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.

3. Create and train a machine learning predictive model.

Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

a) **Create a word corpus.**

When creating a word corpus on the Word Corpus Content form, select an incidents-related table, such as Incident (incidents) in the **Table** field and define the time frame that best describes the current usage of words in the **Filter** field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the **Field List** field, define only the fields that best capture the words: **Description**, **Short description**, and **Resolution notes**. Defining these alone is typically enough, since the prediction rule is expected to find incidents based on the short description.

Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

b) **Create and train a similarity solution.**

c) For this initial model creation, provide the similarity solution definition label **Similar Open Incidents** in the **Label** field.

d) Set the **Training Frequency** field to **Run Once**. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

e) Set the **Update Frequency** field to **Every 15 minutes**. This defines the frequency at which past incidents refresh in the search window.

When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the **Table** field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for incoming incidents. You can select more inputs in the **Test Table** field, if required, for comparison. It is best to start with similar fields for both the **Table** and **Test Table** fields.

The **Filter** field conditions determine the search window for past resolved incidents. Configure the filter conditions to optimize for the best set of resolved incidents to search within. This includes many considerations, such as, time frame, location, category where incidents are relevant, and more.

f) Click **Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**
If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to Update your similarity score threshold.

5. Once you have a satisfactory model, test the similarity solution prediction. You can manually provide inputs and select the top similar results outcome values.

6. Once you have tested the behavior, configure the user experience layout to show attributed results and actions performed on the results. You can configure these results and actions via Workspace UI for Agent Assist or via the Now Platform for Contextual Search. Configure actions and search context through Tables configuration and user experience and card layout through Contextual Search > Search Result Display Configuration.

7. Integrate trained models by exporting them to production.

Note: For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

8. Monitor similarity results and ensure IT agents are providing useful feedback. The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics. Select one or more KPIs that you think is most beneficial to your IT agents. Create aPerformance Analytics dashboard showing the trend of these KPIs. The “likes” you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

Suggest relevant Resolved Incidents for an Incident

Use this template to recommend similar relevant resolved incidents to help expedite your incident investigation and resolution processes.

Role required: piwb_manager or piwb_viewer

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for incoming incidents. The template also provides a link to the Predictive Intelligence platform application and associated documentation.
The use case uses a similarity-based predictive model that compares an incoming incident with past resolved incidents for smarter resolution. Similar past active incidents are displayed in Agent Assist and also in the Incident form via related search.

**Note:** You will need business users to validate the similar past active incident search results. Contact ServiceNow Technical Support, if necessary, to configure sources for contextual search.

When the use case template shows the label **Pretrained model available**, you can go directly to the **Testing your models** implementation section. Otherwise, you will begin by creating a machine learning model.

1. If you started this procedure directly from the Predictive Intelligence Workbench product **Templates** module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to **Predictive Intelligence Workbench > Use Cases > Templates**.

2. Select the **Suggest relevant Resolved Incidents for an Incident** template. The **Suggest relevant Resolved Incidents for an Incident** pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.

3. Create and train a machine learning predictive model.

   Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

   a) **Create a word corpus.**

      When creating a word corpus on the Word Corpus Content form, select an incidents-related table, such as Incident (incidents) in the **Table** field and define the time frame that best describes the current usage of words in the **Filter** field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the **Field List** field, define only the fields that best capture the words: **Description**, **Short description**, and **Resolution notes**. Defining these alone is typically enough, since the prediction rule is expected to find incidents based on the short description.

      Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

   b) **Create and train a similarity solution.**

   c) For this initial model creation, provide the similarity solution definition label **Similar Resolved Incidents** in the **Label** field.

   d) Set the **Training Frequency** field to **Run Once**. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

   e) Set the **Update Frequency** field to **Every 15 minutes**. This defines the frequency at which past incidents refresh in the search window.

      When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the **Table** field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for incoming incidents. You can select more inputs in the **Test Table** field, if required, for comparison. It is best to start with similar fields for both the **Table** and **Test Table** fields.

      The **Filter** field conditions determine the search window for past resolved incidents. Configure the filter conditions to optimize for the best set of resolved incidents to search
within. This includes many considerations, such as, time frame, location, category where incidents are relevant, and more.

f) Click **Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**

If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold**.

5. **Integrate trained models by exporting them to production.**

6. **Once you have a satisfactory model, test the similarity solution prediction.**

You can manually provide inputs and select the top similar results outcome values.

You can configure these results and actions via Workspace UI for Agent Assist or via the Now Platform for Contextual Search. Configure actions and search context though **Tables configuration and user experience and card layout through Contextual Search > Search Result Display Configuration.**

7. **Integrate trained models by exporting them to production.**

   - Note: For details regarding trained use case integration implementation, refer to **Predictive Intelligence Workbench integration and customization.**

8. **Monitor similarity results and ensure IT agents are providing useful feedback.**

The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. **Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.**

Select one or more KPIs that you think is most beneficial to your IT agents. Create a **Performance Analytics dashboard showing the trend of these KPIs.** The “likes” you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to **ITSM Predictive Intelligence Workbench dashboard.**
Suggest relevant Open Change requests for an Incident

Use this template to recommend similar open change requests to help expedite your change request investigation and resolution processes.

Role required: piwb_manager or piwb_viewer

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for change requests. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an open change request with past resolved change requests for smarter resolution. Similar open changes are displayed in Agent Assist and also in the Incident form via related search.

Note: You will need business users to validate the similar open changes search results. Contact ServiceNow Technical Support, if necessary, to configure sources for contextual search.

When the use case template shows the label Pretrained model available, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.

1. If you started this procedure directly from the Predictive Intelligence Workbench product Templates module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Templates.

2. Select the Suggest relevant Open Change requests for an incident template.

   The Suggest relevant Open Change requests for an Incident pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.

3. Create and train a machine learning predictive model.

   Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

   a) Create a word corpus.

   When creating a word corpus on the Word Corpus Content form, select Incident (incidents) and Change (change) in the Table field and define the time frame that best describes the current usage of words in the Filter field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the Field List field, define only the fields that best capture the words: Description, Short description, and Resolution notes. Defining these alone is typically enough, since the prediction rule is expected to find change requests based on the short description.

   Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

   b) Create and train a similarity solution.

   c) For this initial model creation, provide the similarity solution definition label Similar Open Change requests in the Label field.

   d) Set the Training Frequency field to Run Once. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

   e) Set the Update Frequency field to Every 15 minutes. This defines the frequency at which past change requests refresh in the search window.
When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the **Table** field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for change requests. You can select more inputs in the **Test Table** field, if required, for comparison. It is best to start with similar fields for both the **Table** and **Test Table** fields.

The **Filter** field conditions determine the search window for past resolved change requests. Configure the filter conditions to optimize for the best set of resolved change requests to search within. This includes many considerations, such as, time frame, location, category where change requests are relevant, and more.

**f)** Click **Submit & Train** to create your similarity solution record and train it.
Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**

If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold.**

5. Once you have a satisfactory model, **test the similarity solution prediction.**
You can manually provide inputs and select the top similar results outcome values.

6. Once you have tested the behavior, **configure the user experience** layout to show attributed results and actions performed on the results.
You can configure these results and actions via Workspace UI for Agent Assist or via the Now Platform for Contextual Search. Configure actions and search context though **Tables configuration and user experience and card layout through Contextual Search > Search Result Display Configuration.**

7. **Integrate trained models by exporting them to production.**

   **Note:** For details regarding trained use case integration implementation, refer to **Predictive Intelligence Workbench integration and customization.**

8. **Monitor similarity results and ensure IT agents are providing useful feedback.**

The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. **Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.**
Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The “likes” you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence workbench dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

Suggest relevant Open Problem for an Incident

Use this template to recommend similar open problem records to help expedite your problem investigation and resolution processes.

Role required: piwb_manager or piwb_viewer

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for problem records. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an open problem record with past resolved problem records for smarter resolution. Similar open problem records are displayed in Agent Assist and also in the Incident form via related search.

Note: You will need business users to validate the similar open problem search results. Contact ServiceNow Technical Support, if necessary, to configure sources for contextual search.

When the use case template shows the label Pretrained model available, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.

1. If you started this procedure directly from the Predictive Intelligence Workbench product Templates module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Templates.

2. Select the Suggest relevant Open Problems for an Incident template. The Suggest relevant Open Problems for an Incident pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.

3. Create and train a machine learning predictive model.

Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

a) Create a word corpus.

When creating a word corpus on the Word Corpus Content form, select Incident (incidents) and Problem (problem) in the Table field and define the time frame that best describes the current usage of words in the Filter field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the Field List field, define only the fields that best capture the words: Description, Short description, and Resolution notes. Defining these alone is typically enough, since the prediction rule is expected to find problems based on the short description.

Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

b) Create and train a similarity solution.
c) For this initial model creation, provide the similarity solution definition label Similar Open Problems in the Label field.

d) Set the Training Frequency field to Run Once. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

e) Set the Update Frequency field to Every 15 minutes. This defines the frequency at which past problem records refresh in the search window.

When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the Table field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for problem records. You can select more inputs in the Test Table field, if required, for comparison. It is best to start with similar fields for both the Table and Test Table fields.

The Filter field conditions determine the search window for past resolved problem records. Configure the filter conditions to optimize for the best set of resolved problem records to search within. This includes many considerations, such as, time frame, location, category where problem records are relevant, and more.

f) Click Submit & Train to create your similarity solution record and train it.
Alternatively, you can click Submit to save your similarity solution record and return to train it later.

4. Evaluation and tune your model.

If you have a similarity score above 60, but the two problem records do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to Update your similarity score threshold.

5. Once you have a satisfactory model, test the similarity solution prediction.
You can manually provide inputs and select the top similar results outcome values.

6. Once you have tested the behavior, configure the user experience layout to show attributed results and actions performed on the results.
You can configure these results and actions via Workspace UI for Agent Assist or via the Now Platform for Contextual Search. Configure actions and search context through Tables configuration and user experience and card layout through Contextual Search > Search Result Display Configuration.

7. Integrate trained models by exporting them to production.

Note: For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

8. Monitor similarity results and ensure IT agents are providing useful feedback.

The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the
similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.

Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The “likes” you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence workbench dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

Suggest skill assignment by comparing completed work with skills

Use this template to recommend who an assignment is routed to, based on skill set to help expedite your problem investigation and resolution processes.

Role required: piwb_manager or piwb_viewer

Note: The Skill Recommendation plugin (sn.sre) must be activated to use predictive intelligence for recommending skills. Configure skill recommendations in the Skill Recommendation module as part of this procedure.

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for problem records. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an open problem record with past resolved problem records for smarter resolution. Similar open problem records are displayed in Agent Assist and also in the Incident form via related search.

Note: You will need business users to validate the similar open problem search results. Contact ServiceNow Technical Support, if necessary, to configure sources for contextual search.

When the use case template shows the label Pretrained model available, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.

1. Navigate to Skill Recommendation > Configuration to define the properties to recommend skills.

Note: By default, the Enable skill recommendation property is configured to recommend skills for agents. Deselect the check box to disable skill recommendation.

2. If you started this procedure directly from the Predictive Intelligence Workbench product Templates module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Templates.

3. Select the Suggest skill assignment by comparing completed work with skills template.

The Suggest skill assignment by comparing completed work with skills pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.
4. Create and train a machine learning predictive model.
   Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.
   a) *Create a word corpus.*

   When creating a word corpus on the Word Corpus Content form, select Incident (incidents) and Problem (problem) in the **Table** field and define the time frame that best describes the current usage of words in the **Filter** field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the **Field List** field, define only the fields that best capture the words: **Description**, **Short description**, and **Resolution notes**. Defining these alone is typically enough, since the prediction rule is expected to find problems based on the short description.

   Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

   b) *Create and train a similarity solution.*

   c) For this initial model creation, provide the similarity solution definition label **Similar Open Problems** in the **Label** field.

   d) Set the **Training Frequency** field to **Run Once**. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

   e) Set the **Update Frequency** field to **Every 15 minutes**. This defines the frequency at which past problem records refresh in the search window.

   When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the **Table** field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for problem records. You can select more inputs in the **Test Table** field, if required, for comparison. It is best to start with similar fields for both the **Table** and **Test Table** fields.

   The **Filter** field conditions determine the search window for past resolved problem records. Configure the filter conditions to optimize for the best set of resolved problem records to search within. This includes many considerations, such as, time frame, location, category where problem records are relevant, and more.

   f) **Click Submit & Train** to create your similarity solution record and train it.

   Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

5. **Evaluation and tune your model.**

   Make sure you run the **Start Skill Prediction** scheduled job every day to start predicting skills for incidents or agents.

   **Note:** By default, this scheduled job is disabled. When enabled, it is set to run daily at 1:00 AM on all incidents resolved the previous day. The skills are then added to the User Predicted Skill (sn_sre_user_predicted_skill) table and Task Predicted Skill (sn_sre_user_predicted_skill) table.

   If you have a similarity score above 60, but the two problem records do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.
If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to Update your similarity score threshold.

6. Once you have a satisfactory model, test the similarity solution prediction.
   You can manually provide inputs and select the top similar results outcome values.

7. Once you have tested the behavior, configure the user experience layout to show attributed results and actions performed on the results.
   You can configure these results and actions via Workspace UI for Agent Assist or via the Now Platform for Contextual Search. Configure actions and search context though Tables configuration and user experience and card layout through Contextual Search > Search Result Display Configuration.

8. Integrate trained models by exporting them to production.

   **Note:** For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

9. Monitor similarity results and ensure IT agents are providing useful feedback.

   The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

10. Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.

    Select one or more KPIs that you think is most beneficial to your IT agents. Create aPerformance Analytics dashboard showing the trend of these KPIs. The “likes” you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

    For information regarding the Predictive Intelligence workbench dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

**Manage ITSM Predictive Intelligence Workbench use cases**

View your ITSM Predictive Intelligence Workbench use cases to monitor model performance and reevaluate the associated models, if necessary. You can also continue setup of models you started, but did not complete.

Role required: piwb_admin or piwb_manager

1. Navigate to Predictive Intelligence Workbench > Use Cases > All.
   The Use Cases - All page opens displaying all use cases. The status of the use case is depicted on the card, for example, In progress. Other statuses include, Completed and Monitoring.
Manage use cases or continue setting them up

For each use case, you may continue setup or revisit a completed use case to reevaluate its models.
NOTE: If a use case is underperforming, the net automation is lower than the threshold configured in the settings page. Learn more

**Use cases - All**

<table>
<thead>
<tr>
<th>Use cases</th>
<th>Completed use cases</th>
<th>Use cases in progress</th>
<th>Underperforming</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predict Category for incoming incidents</td>
<td>In progress</td>
<td>Predict Assignment Group for incoming incidents</td>
<td>In progress</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Predict Category for incoming incidents</th>
<th>Predict Assignment Group for incoming incidents</th>
</tr>
</thead>
<tbody>
<tr>
<td>In progress</td>
<td>In progress</td>
</tr>
</tbody>
</table>

2. Click on a use case to continue with implementation. Or you can evaluate performance if the use case is in the Monitoring state.

**Note:** If a use case is under performing, the net automation is lower than the threshold configured in the Settings page. Refer to Configure ITSM Predictive Intelligence Workbench settings.

**ITSM Predictive Intelligence Workbench dashboard**

ITSM Predictive Intelligence Workbench provides the Predictive Intelligence for Incidents dashboard to enable you to measure the value of using machine learning to automate your IT business processes. Monitor use case models and view associated statistics. Effectively demonstrate business value to stakeholders with dashboard views.
## Monitoring Models tab

<table>
<thead>
<tr>
<th>Class</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT Securities</td>
<td>All</td>
</tr>
</tbody>
</table>

- **Estimated Net Automation**
  - Mar 18
  - 81%
  - Change: 0 (0.0%)
Model Statistics tab
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process architect, process owner, or machine learning advocate:</td>
<td>Predictive Intelligence Workbench manager or viewer (piwb_manager) (piwb_viewer)</td>
<td>Ability to measure the value of using Predictive Intelligence to automate ITSM processes.</td>
</tr>
<tr>
<td>Visualize operational and automation metric performance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Communicate machine learning value to stakeholders to increase the automation capabilities of predictive intelligence</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Indicators

**Prediction Coverage for Incident**

The score for this indicator is calculated according to the formula: if ([Number of attempted predictions based on Created Today for Incident] == 0) {0} else{([Number of applied predictions based on Created Today for Incident])/([Number of attempted predictions based on Created Today for Incident]*100).

**Number of predicted results based on final date for incident**
The number of predicted results is based on the final value date for an incident. The score is measured daily as unit #.

**Net Automation for Incident**
The score for this indicator is calculated according to the formula: ([Prediction Precision for Incident]*([Prediction Coverage for Incident])/100.

**Number of applied predictions based on Created Today for Incident**
Number of applied predictions based on Created Today for Incident is measured daily as unit #.

**Number of attempted predictions based on Created Today for Incident**
Number of attempted predictions based on Created Today for Incident is measured daily as unit #.

The goal for this indicator is to maximize the quality of predictions.

**Prediction Precision for Incident**
The score for this indicator is calculated according to the formula: if ([Number of predicted results based on final value date for Incident] == 0) {0} else{([Number of successful predictions not skipped based on final value date for Incident])/([Number of predicted results based on final value date for Incident]*100).

**Estimated Net Automation**
Estimated net automation measured daily as unit %.

**Breakdowns**
- Use Case

**Reports**

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predictions Skipped</td>
<td>Single Score</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Estimated precision measured as unit %, based off the data the model was trained on.</td>
</tr>
<tr>
<td>Predictions Skipped</td>
<td>Line</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Predictions Skipped (num). Number of ___, due to low confidence.</td>
</tr>
<tr>
<td>Class Distribution - Training Data</td>
<td>Bar</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Predictions Skipped (line).</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Source table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-----------------------</td>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>% Estimated Precision</td>
<td>Single Score</td>
<td>sn_piwb_itsm_conte_dbv_ml_solutions</td>
<td>Predicted Correctly (num). Number of ___, comparing initial predicted value to final record value.</td>
</tr>
<tr>
<td>Classes Excluded due to Low Distribution</td>
<td>Single Score</td>
<td>sn_piwb_itsm_conte_dbv_ml_excluded_classes</td>
<td>Predicted Incorrectly (line).</td>
</tr>
<tr>
<td>Class Distribution - Actual</td>
<td>Bar</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Predicted Incorrectly (num). Number of ___, comparing initial predicted value to final record value.</td>
</tr>
<tr>
<td>Predicted Correctly</td>
<td>Single Score</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Predicted Incorrectly (line).</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Source table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------</td>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Predicted Correctly</td>
<td>Line</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Training Data. Distribution of classes in data that the solution was trained on.</td>
</tr>
<tr>
<td>Predicted Incorrectly</td>
<td>Single Score</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Actual. Current distribution of classes in live data.</td>
</tr>
<tr>
<td>Predicted Incorrectly</td>
<td>Line</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Number of values the model can return as a prediction.</td>
</tr>
<tr>
<td>Prediction Classes</td>
<td>Single Score</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Number of values the model was not confident enough to return as a prediction, due to not enough data.</td>
</tr>
</tbody>
</table>

**Note:** Regarding source tables, all indicators and reports are built off of newly added database views, combining ServiceNow platform Predictive Intelligence tables with Predictive Intelligence Workbench use case tables. With these new views, you can filter...
Performance Analytics ITSM Dashboards

The ITSM Dashboards content pack provides several Analytics and Reporting Solutions that contain preconfigured dashboards. This content pack also includes several dashboards and indicators of its own. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can get value from Performance Analytics for your application with minimal setup. You can always create your own objects as well.

**Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

**Note:** Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see Configure Analytics and Reporting Solutions.

To enable the solution plugin for ITSM dashboards, an admin can navigate to System Definitions > Plugins and activate the Performance Analytics - Content Pack - ITSM Dashboards plugin.

**ITSM Dashboard solutions**

The ITSM Dashboards plugin (com.snc.pa.itsm_dashboards) activates the following solutions, along with a set of additional dashboards:

- Change Management (com.snc.pa.change)
- Problem Management (com.snc.pa.problem)
- Request Management (Requested Item) (com.snc.pa.request)
- Request Management (Requests) (com.snc.pa.request2)
- Incident SLA (com.snc.pa.sla)
- Major Incident Management (com.snc.pa.incident.mim)
- Spotlight - Incident Spotlight Content Pack (com.snc.pa.spotlight.incident)

**Note:** For Performance Analytics Spotlight solutions, see Analytics and Reporting Spotlight solutions.

- Fixed Costs (com.snc.fixed_costs)

**Inactive dashboards**

Some dashboards in this content pack are inactive when installed. Complete configuration and run data collection jobs before you activate these dashboards. You can activate dashboards in Dashboard Properties, accessible from the context menu. You have to assign an owner to the dashboard to activate it. For more information about configuring Analytics and Reporting Solutions, see Configure Analytics and Reporting Solutions
Add Self-Service Analytic widgets to the ITSM dashboards

If you have Self-Service Analytics activated on an instance, you can add Self-Service analytics widgets to your Performance Analytics dashboards or a Service Portal. To obtain a ready-made set of indicators and breakdowns, activate the Self-Service Analytics PA (com.snc.pa.self_service_analytics) plugin. Find the Self-Service indicators through the Performance Analytics Admin Console, then create widgets and add them to your dashboard or portal. Also activate the (SSA) Self-Service Analytics data collection job.

IT Executive dashboard

See a high-level view across all of ITSM.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT Executive</td>
<td>None</td>
</tr>
</tbody>
</table>

Indicators

% of new critical incidents
The result of the formula \( \left( \frac{\text{Number of new incidents > Priority = 1 - Critical}}{\text{Number of new incidents}} \right) \times 100 \)

% of new critical problems
The result of the formula \( \left( \frac{\text{Number of new problems > Priority = 1 - Critical}}{\text{Number of new problems}} \right) \times 100 \)

% of open incidents not updated in last 5 days
Number of open incidents not updated in last 5 days as a percentage of number of open incidents, according to the formula \( \left( \frac{\text{Number of open incidents not updated in last 5 days}}{\text{Number of open incidents}} \right) \times 100 \)

% of open requested items before due date
The result of the formula \( \left( \frac{\text{Number of open requested items before due date}}{\text{Number of open requested items}} \right) \times 100 \)

% of overdue requested items
The result of the formula \( 100 - \left( \frac{\text{Number of open requested items before due date}}{\text{Number of open requested items}} \right) \times 100 \)

Active Breached SLAs Today
The result in percentage of the formula \( \left( \frac{\text{Number of breach task sla today}}{\text{Number of active task sla}} \right) \times 100 \)

Average age open incidents
The result, in days, of the formula \( \left( \frac{\text{Summed age of open incidents}}{\text{Number of open incidents}} \right) / 24 \)

Average Cost per Resolved Incident - Weekly
The result of the formula \( \left( \frac{\text{Cost of Incidents Resolved / By week SUM +}}{\text{Number of resolved incidents / By week SUM +}} \right) \). In other words, the weekly sum of the cost of resolved incidents, including partial weeks, divided by the weekly sum of resolved incidents, including partial weeks.

Average reassignment of open incidents
The result of the formula \( \left( \frac{\text{Summed re-assignment of open incidents}}{\text{Number of open incidents}} \right) \)

Average resolution time of resolved incidents
The result of the formula \( \left( \frac{\text{Summed duration of resolved incidents}}{\text{Number of resolved incidents}} \right) / 24 \)

ITSMS Average Overall Customer Satisfaction
Average of the normalized score for the Customer Satisfaction survey, as a result of the formula
\[
\frac{\text{ITSM normalized satisfaction score}}{\text{ITSM survey instances}}
\]

**Number of new incidents**
The number of incidents opened today

**Number of new problems**
The number of incidents opened today

**Number of open incidents**
Number of incidents with no Resolved date

**Number of open incidents not updated in last 5 days**
Number of open incidents with an Updated date of more than five days ago

**Number of open requested items**
Number of requests with a registration date on or before today and no closed date, or a closed
date after today

**Number of open requested items before due date**
Number of requested items open today (before midnight on collection date) and a due date
after midnight on the collection date.

**Number of resolved incidents**
Number of incidents with a value in the Resolved date field

The following indicators do not appear on the dashboard but are used in formulas:

**Cost of Incidents Resolved**
The daily sum of the Value field of incident_metric records where the Definition field value is
Incident Resolution Fixed Cost.

**ITSM normalized satisfaction score**
Sum of the normalized score of metric results for the Customer Satisfaction survey

**ITSM survey instances**
Number of the survey instances of the Customer Satisfaction survey

**Number of active task sla**
The count of active SLA tasks on task_sla with a start time before today and a stop time after
today.

**Number of breach task sla today**
The count of active SLA tasks on task_sla with a breach time before today

**Summed age of open incidents**
The sum of hours between the time an incident was opened and now

**Summed duration of resolved incidents**
The sum of hours between the time an incident was opened and the time it was resolved

**Summed reassignments of open incidents**
The summed reassignment count of all open incidents
### Breakdowns

- Age (Requested Item, Incident)
- Assignment Group
- Backordered (Requested Item)
- Category (Incident)
- Contact Type (Incident)
- Item
- Opened by Department
- Priority (Requested Item, Incident, Problem)
- Requested by Department (Requested Item)
- SLA Definition
- Stage (Requested Item)
- State (Change, Request, Problem)

### IT Manager dashboard

Follow the daily and weekly progress of incidents, problems, and requests for your assignment groups.
**Customer Satisfaction Score**

- **6.4**
  - **+ 5.7** (72.3%)

**% Breached SLAs - Daily**

- **33.33%**
  - **+ 20.83** (144.7%)

**Planned Changes - Next 7 Days**

- **6**

**Mean Time to Resolve**

- **Apr 30**
  - **3.04 days**
  - **Change:** **-28.40** (-90.3%)
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT Manager - Needs to track the progress of their group in resolving incidents, problems, and requests</td>
<td>pa_viewer is required to see lists of indicators</td>
</tr>
</tbody>
</table>

Indicators

**% Closed Requests with Breached SLA**
The results of the formula \( \frac{\text{Number of Closed Requests with Breached SLAs}}{\text{Number of closed requests}} \times 100\)

**% of incidents resolved by first assigned group**
The results of the formula \( \frac{\text{Number of resolved incidents by first assigned group}}{\text{Number of resolved incidents}} \times 100\)

**% of open incidents missed SLA**
The percentage of open incidents that did not meet the SLA, as calculated by the formula \( \frac{\text{Number of incidents missed SLA}}{\text{Number of open incidents}} \times 100\)

**% of open incidents not updated in last 5 days**
Number of open incidents not updated in last 5 days as a percentage of number of open incidents, according to the formula \( \frac{\text{Number of open incidents not updated in last 5 days}}{\text{Number of open incidents}} \times 100\)

**% of open incidents with problem**
The result of the formula \( \frac{\text{Number of open incidents with problem}}{\text{Number of open incidents}} \times 100\)

**% of open problems not updated in last 30 days**
The result of the formula \( \frac{\text{Number of open problems not updated in last 30 days}}{\text{Number of open problems}} \times 100\)

**% of open problems with at least one incident**
The result of the formula \( \frac{\text{Number of open problems with at least one open incident}}{\text{Number of open problems}} \times 100\)

**% open and overdue incidents**
The result of the formula \( \frac{\text{Number of open and overdue incidents}}{\text{Number of open incidents that should be resolved in time}} \times 100\)

**% Resolved Incidents with Breached SLA**
The result of the formula \( \frac{\text{Number of Resolved Incidents with Breached SLAs}}{\text{Number of resolved incidents}} \times 100\)

**Active Breached SLAs Today**
The result in percentage of the formula \( \frac{\text{Number of breach task sla today}}{\text{Number of active task sla}} \times 100\)
**Average age of open problems**
The result, in days, of the formula \[rac{\text{Summed age of open problems}}{\text{Number of open problems}} \times 24\]

**Average age of open requests**
The result, in days, of the formula \[rac{\text{Summed age of open requests}}{\text{Number of open requests}} \times 24\]

**Average age open incidents**
The result, in days, of the formula \[rac{\text{Summed age of open incidents}}{\text{Number of open incidents}} \times 24\]

**Average close time of requests**
The result, in days, of the formula \[rac{\text{Summed duration of closed requests}}{\text{Number of closed requests}} \times 24\]

**Average Cost per Incident**
The result of the formula \[rac{\text{Cost of Incidents Resolved}}{\text{Number of resolved incidents}}\], when the number of resolved incidents is more than zero.

**Average Cost per Request**
The result of the formula \[rac{\text{Cost of Requests Completed}}{\text{Number of completed requests}}\], when the number of completed requests is more than zero.

**Average Cost per Request - Weekly**
The result of the formula \[rac{\text{Cost of Requests Completed / By week SUM +}}{\text{Number of completed requests / By week SUM +}}\]. In other words, the weekly sum of the cost of completed requests, including partial weeks, divided by the weekly sum of completed requests, including partial weeks.

**Average Cost per Resolved Incident - Weekly**
The result of the formula \[rac{\text{Cost of Incidents Resolved / By week SUM +}}{\text{Number of resolved incidents / By week SUM +}}\]. In other words, the weekly sum of the cost of resolved incidents, including partial weeks, divided by the weekly sum of resolved incidents, including partial weeks.

**Average reassignments of open and overdue incidents**
The result of the formula \[rac{\text{Summed reassignments of open and overdue incidents}}{\text{Number of open and overdue incidents}}\]

**Average resolution time of resolved incidents**
The result of the formula \[rac{\text{Summed duration of resolved incidents}}{\text{Number of resolved incidents}} \times 24\]

**Closed workload**
The result of the formula \[	ext{Number of closed incidents} + \text{Number of closed problems} + \text{Number of closed requests}\]

**ITSM Average Overall Customer Satisfaction**
Average of the normalized score for the Customer Satisfaction survey, as a result of the formula \[rac{\text{ITSM normalized satisfaction score}}{\text{ITSM survey instances}}\]

**New workload**

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The result of the formula 

\[ \text{Number of new incidents} + \text{Number of new problems} + \text{Number of new requests} \]

**Number of closed complete requests**
Number of requests closed today as complete (State = Complete)

**Number of closed incidents**
The number of incidents closed today

**Number of closed problems**
The number of problems closed today

**Number of closed requests**
The number of requests closed today

**Number of Closed Requests with Breached SLAs**
Count Distinct of SLA tasks (task_sla) with a task type of Request, Has breached = true, Stage ! = Cancelled, and closed today

**Number of new incidents**
The number of incidents opened today

**Number of new problems**
The number of incidents opened today

**Number of new requests**
The number of incidents opened today

**Number of open changes planned in the next 7d**
The number of Change Request (change_request) records opened today with a Planned Start date between today and the end of next week

**Number of open incident unassigned**
The number of open incidents not assigned to anyone

**Number of open incidents**
Number of incidents with no Resolved date

**Number of open incidents not updated in last 5 days**
Number of open incidents with an Updated date of more than five days ago

**Number of open and overdue incidents**
The number of open incidents related to an SLA task that is not in the Cancelled stage (task_sla.stage) and has an actual elapsed percentage greater than 100% (task_sla.percentage).

**Number of open incidents that should be resolved in time**
The count distinct of open incidents associated with an SLA task (task_sla) that is not in the Cancelled stage.

**Number of open incidents with problem**
The number of open incidents with a value in the Problem field

**Number of open problems**
The number of problems opened on or before today and not yet closed.

**Number of open problems not updated in last 30 days**
Number of open problems with an Updated date of more than 30 days ago

**Number of open problems with at least one open incident**
The count distinct of open incidents where the Problem Active field value is true.

**Number of open requests**
Number of requests opened on or before today and not yet closed

**Number of requests closed after due date**
Number of requests that are closed after request due date (sc_request.closed_at > sc_request.due_date)

**Number of resolved incidents**
Number of incidents with a value in the Resolved date field

**Number of resolved incidents by first assigned group**
Number of incidents that were resolved by the first group assigned to them

**Open workload**
The result of the formula $([\text{Number of open incidents}] + [\text{Number of open problems}] + [\text{Number of open requests}])$

**Predicted Average Cost of Open Incidents**
The result of the formula $([\text{Cost of Incidents Resolved / By week SUM +}] / [\text{Number of resolved incidents / By week SUM +}] * [\text{Number of open incidents}])$

**Predicted Average Cost of Open Requests**
The result of the formula $([\text{Cost of Requests Completed / By week SUM +}] / [\text{Number of requests completed / By week SUM +}] * [\text{Number of open requests}])$

**Workload backlog growth**
The result of the formula $([\text{New workload}] - [\text{Closed workload}])$

The following indicators do not appear on the dashboard but are used in formulas:

**Cost of Incidents Resolved**
The daily sum of the Value field of incident_metric records where the Definition field value is Incident Resolution Fixed Cost.

**Cost of Requests Completed**
The daily sum of the Value field of sc_request_metric records where the Definition field value is Request Resolution Fixed Cost.

**ITSM normalized satisfaction score**
Sum of the normalized score of metric results for the Customer Satisfaction survey

**ITSM survey instances**
Number of the survey instances of the Customer Satisfaction survey

**Number of active task sla**
The count of active SLA tasks on task_sla with a start time before today and a stop time after today.

**Number of breach task sla**
The count of active SLA tasks on task_sla with a breach time before today

**Number of incidents missed SLA**
The number of records on the incident_sla table created on or before today, not yet closed, and that have breached SLA

**Number of open incidents with problem**
The count of open incidents with a Problem referenced in the Problem field.

**Number of Resolved Incidents with Breached SLAs**
Number of Incident-type SLA tasks that are not cancelled, that were resolved today, and where Has Breached is true

**Summed age of open incidents**
The sum of hours between the time an incident was opened and now

**Summed age of open problems**
The sum of hours between the time a problem was opened and now

**Summed age of open requests**
The sum of hours between the time a request was opened and now

**Summed duration of closed requests**
The sum of hours between the time a request was opened and the time it was closed

**Summed duration of resolved incidents**
The sum of hours between the time an incident was opened and the time it was resolved

**Summed reassignments of open and overdue incidents**
The summed reassignment count of all open Incident SLAs

**Breakdowns**

- Age (Request, Incident, Problem, and Change)
- Assignment Group
- Category (Incident, Change)
- Contact Type (Incident, Request)
- Location
- Priority (Request, Incident, Problem, and Change)
- Risk (Change)
- SLA
- SLA Definition
- State (Change, Request, Problem)
Define fixed costs for IT Manager dashboard

Define generic industry-based fixed costs to analyze impact by channel using the IT Manager dashboard in ITSM Performance Analytics Solutions.

Role required: admin

Use the fixed cost model to analyze the cost for incidents and requests across channels (email, phone, self-service, walk-up, virtual agent) for cost management. For example, view current costs per channel and verify whether costs are reduced over time after implementing a solution.

Cost definitions are stored in the Fixed Cost Definitions (fixed_cost_definitions) table.
Average Cost per Incident - Weekly

$23.4

Resolved Incident Activity by Channel

Phone: 14

Oct 26:

14

% First Call Resolution: 100.00

Incident Cost Trend - Weekly

No data available
## Incident and request KPIs

<table>
<thead>
<tr>
<th>Area</th>
<th>KPI</th>
</tr>
</thead>
</table>
| Volume| Total number of incidents  
Total number of requests |
| FCR   | Number of incidents resolved on first assignment  
Number of requests resolved on first assignment |
| MTTR  | Average time to resolve an incident  
Average time to resolve a request |
| SLA   | % of incidents that breached SLAs  
% of requests that breached SLAs |
| CSAT  | Average customer satisfaction score                                      |
| Cost  | Average cost to resolve an incident  
Average cost to resolve a service request |

**Breakdown:**
- Assignment group
- Agent
- Skill

Navigate to **Fixed Costs > Define Fixed Cost** (see table for field descriptions).

### Fixed Cost Definitions form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>Description of the cost.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that contains the field for the fixed cost condition.</td>
</tr>
<tr>
<td>Filter</td>
<td>Condition for the fixed cost definition, if applicable.</td>
</tr>
<tr>
<td>Cost Value</td>
<td>Currency type and fixed cost value.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the fixed cost.</td>
</tr>
</tbody>
</table>
|                   | • Total Fully Loaded Cost  
                   | • Per Hour Cost                                                             |
| Source of the Cost| Source of the fixed cost.                                                   |
|                   | • HDI  
                   | • ServiceNow  
                   | • Manual
### Cost per Network Incident

**Fixed Cost Definitions form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>Incident in Network Category</td>
</tr>
<tr>
<td>Table</td>
<td>Incident (incident)</td>
</tr>
<tr>
<td>Filter</td>
<td>Category is Network</td>
</tr>
<tr>
<td>Cost Value</td>
<td>$15.56</td>
</tr>
<tr>
<td>Category</td>
<td>Total Fully Loaded Cost</td>
</tr>
<tr>
<td>Source of the Cost</td>
<td>HDI</td>
</tr>
<tr>
<td>Active</td>
<td>Selected</td>
</tr>
</tbody>
</table>

### IT Agent dashboard

View the open incidents, problems, and requests that belong to you and your assignment groups through personalized reports. You can also see which incidents that belong to your assignment groups exceed the Spotlight threshold.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT Agent - see only those incidents, problems, and requests that concern you</td>
<td>None, but to see Spotlight reports you need the pa_spotlight_viewer role.</td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open unassigned incidents</td>
<td>Single score</td>
<td>Incidents that belong to one of your assignment groups do not have a person assigned to them</td>
</tr>
<tr>
<td>Open requests</td>
<td>Single score</td>
<td>Open requests that belong to you or one of your groups</td>
</tr>
<tr>
<td>Critical incidents</td>
<td>Single score</td>
<td>Incidents with a Priority of 1 - Critical that belong to you or one of your groups</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>My open problems - Heatmap</td>
<td>Heatmap</td>
<td>Your problems by assignment group and priority</td>
</tr>
<tr>
<td>Incidents above Spotlight threshold</td>
<td>Single score</td>
<td>Incidents belonging to one of your groups that meet enough Spotlight criteria to exceed the Spotlight threshold</td>
</tr>
<tr>
<td>My open requests</td>
<td>Single score</td>
<td>Open requests that belong to you</td>
</tr>
<tr>
<td>My open incidents - Heatmap</td>
<td>Heatmap</td>
<td>Your incidents by assignment group and priority</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open incidents</td>
<td>Single score</td>
<td>Open incidents that belong to you or one of your groups</td>
</tr>
<tr>
<td>Open incidents not updated in last 7 days</td>
<td>Single score</td>
<td>Open incidents that belong to you or one of your groups and have not been updated for the last 7 days</td>
</tr>
<tr>
<td>My open requests - Heatmap</td>
<td>Heatmap</td>
<td>Your requests by assignment group and priority</td>
</tr>
<tr>
<td>Open problems</td>
<td>Single score</td>
<td>Open problems that belong to you or one of your groups</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Spotlight incidents P1 - Critical</td>
<td>Single score</td>
<td>Incidents belonging to your group that exceed the Spotlight threshold and have a priority of P1 - Critical</td>
</tr>
<tr>
<td>My open problems</td>
<td>Single score</td>
<td>Open problems that belong to you</td>
</tr>
<tr>
<td>Spotlight incidents - Unassigned</td>
<td>Single score</td>
<td>Incidents belonging to one of your groups that exceed the Spotlight threshold and have no one assigned to them</td>
</tr>
<tr>
<td>My open incidents</td>
<td>Single score</td>
<td>Open incidents that belong to you</td>
</tr>
</tbody>
</table>
# IT Service Management integration with Microsoft Teams

IT Service Management integration with Microsoft Teams extends the Now Virtual Agent integration with Microsoft Teams to enable employees to more effectively request and receive service from within Microsoft Teams.

ServiceNow for Microsoft Teams is available for IT Service Management and HR Service Delivery and delivered via the following applications:

- **IT Service Management integration with Microsoft Teams**
  Employees can create requests and interact with agents for an incident, requested item, and change request.

- **HR Service Delivery Management with Microsoft Teams**
  Employees can create HR cases within Microsoft Teams and communicate with the agent to quickly resolve those cases in Microsoft Teams. For more information, visit [HR Service Delivery integration with Microsoft Teams](#).

**IT Service Management integration with Microsoft Teams** and **HR Service Delivery Management with Microsoft Teams** applications include the following capabilities:

- Enables employees to respond to the comments on tickets, approval requests, and changes with actionable notifications within Microsoft Teams.
- Enables employees to see pending tasks, check the status of open tickets and receive company communications via the embedded “Your Hub” dashboard.
- Provides agents the ability to initiate a Microsoft Teams chat with an employee from a ticket and then to copy the chat transcript back to the ticket as a comment.

If you want to install both **IT Service Management integration with Microsoft Teams** application and **HR Service Delivery Management with Microsoft Teams** application, you need to configure your ServiceNow instance only once. To configure ServiceNow instance with Microsoft Teams, perform the setup tasks.

### Setup Tasks

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow store release notes.</td>
<td>Install IT Service Management integration with Microsoft Teams application</td>
<td>Employee actions</td>
</tr>
<tr>
<td></td>
<td>Setup and configure ServiceNow for Microsoft Teams</td>
<td>Agent actions</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Overview of IT Service Management integration with Microsoft Teams

IT Service Management integration with Microsoft Teams extends the Now Virtual Agent integration with Microsoft Teams to enable employees to more effectively request and receive service from within Microsoft Teams.

Use the ServiceNow® Virtual Agent in Microsoft Teams application to design and build automated conversations that help your users quickly obtain information for any ticket reported in the ServiceNow instance.

The IT Service Management integration with Microsoft Teams application includes the following additional capabilities:

- Actionable notifications – for approval and comments on tickets. Users can reply on the notifications from within Microsoft Teams.
  - Approval – for Request (single Requested Item), Change Request
  - Ticket comments: Employees are able to respond to notifications on the tickets from within Microsoft Teams: Incident, Requested Item, and Change Request.
  - Provides agents the ability to initiate a Microsoft Teams chat with an employee from an incident, change request, and request item and then to copy the chat transcript back to the ticket as a comment.
  - Additional informational notifications for:
    - Incident: Resolved, Updated
    - Requested Item: Completed, Approved, Rejected, Updated
    - Approval (for all approvals other than Request (with a single requested item), and Change Request)

### Feature mapping

<table>
<thead>
<tr>
<th>Feature</th>
<th>License Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actionable Notifications</td>
<td>ITSM Pro</td>
</tr>
<tr>
<td>Chat - Agent to Employee/Agent to Agent</td>
<td>ITSM Standard or above</td>
</tr>
<tr>
<td>Dashboard</td>
<td>ITSM Standard or above</td>
</tr>
</tbody>
</table>

An enhanced version of the Your Hub dashboard is available with Employee Service Center.
Setup and configure IT Service Management with Microsoft Teams

The IT Service Management with Microsoft Teams plugin uses the Now Virtual Agent in application. Customers already using the Now Virtual Agent application can skip the configuration process.

Admin setup and tasks

Configuring the IT Service Management integration with Microsoft Teams application involves setup and installation tasks that you and your users must perform.

Install IT Service Management integration with Microsoft Teams application

Install the IT Service Management integration with Microsoft Teams application for the collaboration between the agents and employees.

Role required: admin

1. Navigate to System Application > All Available Applications > All.
2. In the search field, enter IT Service Management integration with Microsoft Teams.
   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from ServiceNow store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release note information for all released apps, see the ServiceNow Store version history release notes.
3. Click Install button.
   Note: All the dependent plugins are automatically installed in this process.

You must also install the fix_script_start_chat_field_decorator_IT update set to have a field decorator in a ticket to initiate a chat with the requester. Visit the app store IT Service Management integration with Microsoft Teams to download the fix script.

Setup and configure ServiceNow for Microsoft Teams

Setup the ServiceNow instance to integrate ServiceNow for Microsoft Teams applications.

The following steps are common for both IT Service Management integration with Microsoft Teams and the HR Service Delivery Management integration with Microsoft Teams applications and must be done only once.

Note: After completing the common setup, you need to configure the IT Service Management integration with Microsoft Teams. For more information, visit Configure IT Service Management integration with Microsoft Teams

Create Microsoft Azure application to authenticate Microsoft Teams users with ServiceNow

Create a Microsoft Azure application in Microsoft Azure portal to enable agents to import the conversations and access Your Hub dashboard from Microsoft Teams to ServiceNow.

Role required: admin

Note: You can use one Microsoft Azure application if you use both IT Service Management integration with Microsoft Teams, and HR Service Delivery integration with Microsoft Teams applications.

1. Log in to Microsoft Azure portal.
3. Click New registration.
The **New registration** page displays.

4. On the **New registration** form, perform the following actions:
   
   1. **Name**: Enter the name of your application. Example: ServiceNow Auth app.
   
   2. **Redirect URI**: Enter `https://<instance-name>/sn_now_teams_ms_login_redirect.do`, where `<instance-name>` is the name of your ServiceNow instance.

5. Click **Register**.

6. Click **Redirect URIs**.
7. Select the **Access tokens** check box.
8. Click **Save**.

Authenticate users to access Your Hub dashboard
Assign permissions to users to view Your Hub dashboard in Microsoft Teams application.

Role required: admin

1. Log in to Microsoft Azure portal.
2. Navigate to **Azure Services** > **Azure Active Directory** > **Manage** > **App registrations**.
3. Click the app created to enable agents to import the conversations from Microsoft Teams to the ServiceNow instance. Example: ServiceNow Auth app.
4. Navigate to **Manage** > **Authentication**.
5. Navigate to Add a platform > Web applications > Web.
6. On the **Configure Web** form, fill the fields.

**Configure Web form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implicit grant</td>
<td>Check <strong>Access tokens</strong>, and <strong>ID tokens</strong></td>
</tr>
</tbody>
</table>
Configure Web

Redirect URIs

The URIs that we will accept as destinations when returning authentication responses (tokens) after successfully authenticating users. Also referred to as reply URLs. Learn more about Redirect URIs and their restrictions

Logout URL

This is where we send a request to have the application clear the user's session data. This is required for single sign-out to work correctly.

e.g. https://myapp.com/logout

Implicit grant

Allows an application to request a token directly from the authorization endpoint. Checking Access tokens and ID tokens is recommended only if the application has a single-page architecture (SPA), has no back-end components, does not use the latest version of MSAL.js with auth code flow, or it invokes a web API via JavaScript. ID Token is needed for ASP.NET Core Web Apps. Learn more about the implicit grant flow

To enable the implicit grant flow, select the tokens you would like to be issued by the authorization endpoint:

- [x] Access tokens
- [x] ID tokens
7. Click Configure.

8. Navigate to Manage > API Permissions > Add a permission > Microsoft Graph.

9. Click Delegated permissions.

10. Click Openid permissions accordion, and select email, offline_access, openid, and profile check-boxes.
# Request API permissions

- **All APIs**

  **Microsoft Graph**
  
  https://graph.microsoft.com/ Docs

  What type of permissions does your application require?

  - **Delegated permissions**
    Your application needs to access the API as the signed-in user.

  - **Application permissions**
    Your application runs as a background service or daemon without a signed-in user.

**Select permissions**

Start typing a reply url to filter these results

<table>
<thead>
<tr>
<th>Permission</th>
<th>Admin consent required</th>
</tr>
</thead>
</table>

- **OpenId permissions (4)**

  - **email**
    View users' email address

  - **offline_access**
    Maintain access to data you have given it access to

  - **openid**
    Sign users in

  - **profile**
    View users' basic profile
11. Click **Add permissions**.
12. In the **API permissions** screen, click **Grant admin consent for (tenant)** link.
13. Click **Yes** on the pop-up dialog box.
14. Navigate to **Manage > Expose an API**.
15. Click **Set against Application ID URI**, and enter the application URI in the format: api://
   `{instance}.service-now.com/{client_id}`.
16. Click **Save**.
17. Click **Add a scope**. In the **Add a scope** form, fill the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope name</td>
<td>access_as_user</td>
</tr>
<tr>
<td>Who can consent</td>
<td>Admins only</td>
</tr>
<tr>
<td>Admin consent display name</td>
<td>Teams can access the user’s profile.</td>
</tr>
<tr>
<td>Admin consent description</td>
<td>Allows Teams to call the app’s web APIs as the current user.</td>
</tr>
<tr>
<td>User consent display name</td>
<td>Teams can access the user profile and make requests on the user’s behalf.</td>
</tr>
<tr>
<td>User consent description</td>
<td>Enable Teams to call this app’s APIs with the same rights as the user.</td>
</tr>
<tr>
<td>State</td>
<td>Enabled</td>
</tr>
</tbody>
</table>
Scope name *
access_as_user

Who can consent?
- Admins and users
- Admins only

Admin consent display name *
Teams can access the user's profile.

Admin consent description *
Allows Teams to call the app's web APIs as the current user.

User consent display name
Teams can access the user profile and make requests on the user's behalf.

User consent description
Enable Teams to call this app's APIs with the same rights as the user.

State
- Enabled
- Disabled
18. Click **Add scope** button.
19. Navigate to **Authorized client applications > Add a client application**.
20. In the **Add a client application** form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Client ID      | • Microsoft Teams mobile/desktop application: 1fec8e78-bce4-4aaf-ab1b-5451cc387264  
                  • Value for Microsoft Teams web application: 5e3ce6c0-2b1f-4285-8d4b-75ee78787346 |

| Authorized scopes | Check the authorized scope |

21. Click **Add application** button.
   Copy the Application (client) ID, and Directory (tenant) ID from the application overview page in the Microsoft Azure portal to update the details in the ServiceNow instance.
Create Manifest file to integrate ServiceNow for Microsoft Teams application
Enables users to interact with the agents from Microsoft Teams application.

Role required: virtual_agent_admin and external_app_install_admin or admin

1. Navigate to ServiceNow for Microsoft Teams > Administration > Application Manifest.
2. On the form, fill the fields.

ServiceNow for Microsoft Teams Manifest form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short name</td>
<td>Short name for the manifest file.</td>
</tr>
<tr>
<td>Full name</td>
<td>Complete name for the manifest file.</td>
</tr>
<tr>
<td>Use default images.</td>
<td>Option to use default images for the manifest file. If you don’t want the default images, uncheck Use default images, and upload the images of resolution 192x192, and 32x32 in the respective placeholders.</td>
</tr>
<tr>
<td>State</td>
<td>This field is non-editable.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the manifest file. Ex: 1.0.0</td>
</tr>
<tr>
<td>Enable tabs</td>
<td>Option to enable tabs in Microsoft Teams. Displays Your Hub and About tabs in Microsoft Teams. The Application (client) ID and Directory (tenant) ID are used to authenticate the tabs in Microsoft Teams.</td>
</tr>
<tr>
<td>Application (client) ID</td>
<td>Value for from Application (client) ID field from the app registration page in Microsoft Azure portal.</td>
</tr>
<tr>
<td>Directory (tenant) ID</td>
<td>Value for from Directory (tenant) ID field from the app registration page in Microsoft Azure portal.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description about the manifest file.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description about the manifest file.</td>
</tr>
</tbody>
</table>

3. Click Move to Ready.
4. Click Download Manifest.
   If you want to edit the fields, click Move to Draft. The manifest file downloads in a zip file format.

   The values provided in the Application (client) ID and Directory (tenant) ID are automatically updated in the ServiceNow for Microsoft Teams app in the system application registry when you define the values in the manifest file for the first time.

Edit a manifest file
   Edit a manifest file to update the application (client) ID, Directory (tenant) ID fields.
   Role required: virtual_agent_admin and external_app_install_admin or admin

1. Navigate to ServiceNow for Microsoft Teams > Administration > Application Manifest.
2. Click Move to Draft button.
3. On the form, fill the fields.

ServiceNow for Microsoft Teams Manifest form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short name</td>
<td>Short name for the manifest file.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Full name</td>
<td>Complete name for the manifest file.</td>
</tr>
<tr>
<td>Use default images.</td>
<td>Option to use default images for the manifest file. If you don’t want the default images, uncheck Use default images, and upload the images of resolution 192x192, and 32x32 in the respective placeholders.</td>
</tr>
<tr>
<td>State</td>
<td>This field is non-editable.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the manifest file. Ex: 1.0.1</td>
</tr>
<tr>
<td>Enable tabs</td>
<td>Option to enable tabs in Microsoft Teams. The Application (client) ID and Directory (tenant) ID are used to authenticate the tabs in Microsoft Teams.</td>
</tr>
<tr>
<td>Application (client) ID</td>
<td>Value for from Application (client) ID field from the app registration page in Microsoft Azure portal.</td>
</tr>
<tr>
<td>Directory (tenant) ID</td>
<td>Value for from Directory (tenant) ID field from the app registration page in Microsoft Azure portal.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description about the manifest file.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description about the manifest file.</td>
</tr>
</tbody>
</table>

4. Click **Move to Ready**.
5. Click **Download Manifest**.
   
   If you want to edit the fields, click **Move to Draft**. The manifest file downloads in a zip file format.

1. **Verify and update application registry values**
2. **Install ServiceNow for Microsoft Teams app**

Verify and update application registry values
Verify and update the application registry values to authenticate the users in Microsoft Teams application.

Role required: admin

Verify the **ServiceNow for Microsoft Teams** application registry and modify the Application (client) ID and Directory (tenant) ID if required after you create a manifest file.

1. Navigate to **System OAuth > Application Registry**.
2. Click **ServiceNow for Microsoft Teams APP**.
3. Edit the entry.
4. On the **OAuth OIDC Entity – ServiceNow for Microsoft Teams app** form, fill the fields.

**OAuth OIDC Entity form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Verify and update the domain name and client ID in api://(domainName)/(clientID)</td>
</tr>
<tr>
<td>OAuth OIDC Provider Configuration</td>
<td>Verify and update tenant ID value in <a href="https://sts.windows.net/(tenantID)/.well-known/openid-configuration/">https://sts.windows.net/(tenantID)/.well-known/openid-configuration/</a></td>
</tr>
</tbody>
</table>

5. Right-click on the form header, and click **Save**.
Install ServiceNow for Microsoft Teams app
Enables users to interact with the agents from Microsoft Teams application.

Role required: admin

1. Launch Microsoft Teams application.
2. Click Apps menu.
3. Click Upload a custom app.
4. Select the manifest file from the directory, and click Open.
5. Click ServiceNow for Microsoft Teams app.
6. Click Add.

The ServiceNow for Microsoft Teams app appears in Microsoft Teams.

Connect Virtual Agent in Microsoft Teams with ServiceNow instance
ServiceNow for Teams app embeds the Virtual Agent capabilities. This procedure will connect the Virtual Agent capabilities on the ServiceNow for Teams app we installed.

Note the following important issues before installing:

- The Virtual Agent integration with Microsoft Teams creates a one-to-one association between the ServiceNow instance that you are installing from and the Microsoft Teams tenant in which the integration runs. Use a separate Microsoft Teams tenant for each instance that you plan to install the integration in.
- The Virtual Agent integration is only supported for users who have a user record in ServiceNow.
- ServiceNow for Teams app embeds the Virtual Agent capabilities. This procedure will connect the Virtual Agent capabilities on the ServiceNow for Teams app we installed.

Roles required:

- virtual_agent_admin and external_app_install_admin or admin
- Administrator for third-party applications

1. Navigate to Collaboration > Messaging Apps Integration.
2. Click Install that appears next to Microsoft Teams.
3. In the Entering a third-party site dialog, click OK.
4. Log in to Microsoft Teams.
5. On the Microsoft dialog box, click Accept.
6. If the selected tenant has already been assigned to NOW Virtual Agent, click **Override** to change the tenant or **Cancel** to leave the current assignment in place.
7. Click **Go to MS Teams** to log in to Microsoft Teams.
8. Click **Apps** menu.
9. In the search field, enter **ServiceNow for Microsoft Teams**.
10. Click **ServiceNow for Microsoft Teams** app.
11. Click **Open** button to add the app to Microsoft Teams.
12. In your instance, check the Messaging Apps Integration page **Collaboration > Messaging Apps Integration** to verify the installation.
Register the Microsoft Azure application to link to ServiceNow

Enables employees to interact with employees and import messages from Microsoft Teams.

Role required: admin

1. **Register the tenant id to link to ServiceNow instance**
2. **Register the client id to link to ServiceNow instance**

Register the tenant id to link to ServiceNow instance

Register the tenant id of your instance with Microsoft Teams application to interact with the employees and import messages to your instance.

Role required: admin

For more information on creating system properties for your own applications, take the training on the ServiceNow® Developer Site.

1. In the left navigation pane, enter `sys_properties.list`.
2. Click **New**.
3. On the System Property form, fill in the fields.
   a) Suffix: Enter `tenant_id` in the field.

**Note:** Select **Enable notifications for all users** option, to receive non-actionable notifications (Provider Notifications).
b) Application: Select ServiceNow for Microsoft Teams.

c) Name: sn_now_teams.tenant_id is displayed when you select application as ServiceNow for Microsoft Teams.

d) Description: Enter the value for Directory (tenant) ID field from the application registration page in Microsoft Azure portal.

e) Type: Select string.

f) Value: Value for sn_now_teams.tenant_id from Directory (tenant) ID field from the app registration page in Microsoft Azure portal.
ServiceNow Authentication App

**Essentials**

- **Display name**: ServiceNow Authentication App
- **Application client ID**: 25168c54-445c-450e-976a-27089c352616
- **Directory server ID**: 27a758ab-8f46-46f7-84c3-40e4b5e33bac21

**Call APIs**

Build more powerful apps with both user and business data from Microsoft services and your own company's data sources.

**Documentation**

- Microsoft identity platforms
- Authentication services
- Authorization services
- Code samples
- Microsoft Graph
- Glossary
- Help and Support

---

Starting June 2020, we will no longer add any new features to Azure Active Directory (Azure AD) and Azure AD Graph. We will continue to provide technical support and security updates but we will no longer accept applications. We will be phasing out support for Microsoft Authentication Library (MSAL) and Microsoft Graph. Learn more.
g) Read roles: Define the roles that have read access to this property.

h) Write roles: Define the roles that have write access to this property.

4. Click **Submit**.

   The Microsoft Teams integration with ServiceNow instance is compatible with domain separation.

   For the domain separated instances, a domain separated application property entry can be created. For more information, refer [Domain separation application properties](#).

Register the client id to link to ServiceNow instance

Register the client id of your instance with Microsoft Teams application to enable agents to initiate Microsoft Teams chats with the employees and import the chats to your instance.

Role required: admin

1. In the left navigation pane, enter `sys_properties.list`.

2. Click **New**.

3. On the System Property form, fill in the fields.
   a) Suffix: Enter `app_client_id` in the field.
   b) Application: Select **ServiceNow for Microsoft Teams**.
   c) Name: `sn_now_teams.app_client_id` is displayed when you select application as **ServiceNow for Microsoft Teams**.
   d) Description: Enter the value for **Application (client) ID** field from the application registration page in Microsoft Azure portal.
   e) Type: Select **string**.
   f) Value: Value for `sn_now_teams.app_client_id` from **Application (client) ID** field from the app registration page in Microsoft Azure portal.
g) Read roles: Define the roles that have read access to this property.
h) Write roles: Define the roles that have write access to this property.

4. Click **Submit**.

**Configure IT Service Management integration with Microsoft Teams**

Complete the following procedures to configure IT Service Management integration with Microsoft Teams.

**Customize IT Service Management integration with ServiceNow**

Customize the features in your instance to meet your organization needs.

You can customize:
- UI actions
- Business rules
- Your Hub dashboard in Microsoft Teams application

**Customize UI actions for IT Service Management with Microsoft Teams**

Enables you to extend the UI actions to the tables you require.

You can extend the following UI actions to any other tables:
- Start Microsoft Teams chat
- Import Messages from Microsoft Teams

**Customize Start Microsoft Teams chat UI action**

Enables you to extend the Start Microsoft Teams chat UI actions to the tables you require.

Role required: admin

**1. Navigate to ServiceNow for Microsoft Teams > UI Actions.**

**2. Open the existing Start Microsoft Teams chat UI action in a new window.**

**3. Click New.**

**4. On the UI action form, fill the fields:**

<table>
<thead>
<tr>
<th><strong>UI action form</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td><strong>Table</strong></td>
</tr>
<tr>
<td><strong>Application</strong></td>
</tr>
<tr>
<td><strong>Form button</strong></td>
</tr>
<tr>
<td><strong>Show insert</strong></td>
</tr>
<tr>
<td><strong>Client</strong></td>
</tr>
<tr>
<td><strong>Condition</strong></td>
</tr>
<tr>
<td><strong>Script</strong></td>
</tr>
</tbody>
</table>
5. Click **Submit**.

**Customize Import Messages from Microsoft Teams UI action**

Enables you to extend the **Import Messages from Microsoft Teams** UI action to the tables you require.

Role required: admin

1. Navigate to **ServiceNow for Microsoft Teams > UI Actions**.
2. Open the existing **Import Messages from Microsoft Teams** UI action in a new window.
3. On the **UI Actions** screen, Click **New**.
4. On the **UI Action** form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the UI action. Ex: Import Messages from Microsoft Teams</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the Import Messages from Microsoft Teams UI action is to be available</td>
</tr>
<tr>
<td>Application</td>
<td>IT Service Management integration with Microsoft Teams</td>
</tr>
<tr>
<td>Form button</td>
<td>Check this box</td>
</tr>
<tr>
<td>Show insert</td>
<td>Uncheck this box</td>
</tr>
<tr>
<td>Client</td>
<td>Check this box</td>
</tr>
<tr>
<td>Condition</td>
<td>Copy and paste the condition of the existing Import Messages from Microsoft Teams. Modify the column name as required.</td>
</tr>
<tr>
<td>Script</td>
<td>Copy and paste the script of the existing Import Messages from Microsoft Teams. Modify the column name as required.</td>
</tr>
<tr>
<td>Workspace Form Button</td>
<td>Check this box. Check and paste the <strong>Workspace Client Script</strong> of the existing Import Messages from Microsoft Teams. Modify the column name as required.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Customize business rules for IT Service Management with Microsoft Teams**

Enables you to customize the pre-defined business rules to the tables you require.

Role required: admin

1. Navigate to **ServiceNow for Microsoft Teams > Notifications > Actionable Notifications - Business Rules**.
2. Open a business rule you would like to extend to another table. Ex: Send comment to caller.
3. Click **New**.
4. On the **UI Action** form, fill the fields.

**UI action for business rule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the business rule</td>
</tr>
<tr>
<td>Table</td>
<td>Table to which the Send comment to caller is to be assigned.</td>
</tr>
<tr>
<td>Application</td>
<td>IT Service Management integration with Microsoft Teams</td>
</tr>
<tr>
<td>Active</td>
<td>Check this box</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check this box</td>
</tr>
</tbody>
</table>
| Where to run| • When: after  
• Insert: Check this box  
• Update: Check this box  
• Filter Conditions: Apply the filter condition of the Send comment to caller business rule |
| Advanced    | • Condition: Copy and paste the value of the condition from the existing Send comment to caller business rule. Modify the values as required.  
• Script: Copy and paste the script from the existing Send comment to caller business rule. Modify the values as required. |

5. Click **Submit**.

**Your Hub dashboard in Microsoft Teams**

Use the Your Hub dashboard from Microsoft Teams to view the widgets that show pending tasks, requests, and the internal company announcements.

Launch Microsoft Teams. Navigate to **ServiceNow for Microsoft Teams > Your Hub**.
You can customize the following in the Your Hub dashboard:

- Banner image
- Quick links widget
- Complete your to-dos widget
- Track your request widget
Your Hub

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banner image</td>
<td>Welcome name, along with the count of requests, and to-dos</td>
</tr>
<tr>
<td>Visit your employee portal</td>
<td>Link to navigate to the employee portal</td>
</tr>
<tr>
<td>Complete your To-dos</td>
<td>List of your pending tickets</td>
</tr>
<tr>
<td>Track your requests</td>
<td>List of your requests</td>
</tr>
<tr>
<td>IT announcements</td>
<td>IT announcements released by the IT department</td>
</tr>
<tr>
<td>Upcoming events</td>
<td>Upcoming events in your company</td>
</tr>
<tr>
<td>Holiday calendar</td>
<td>Upcoming holidays for the current year</td>
</tr>
<tr>
<td>IT outages</td>
<td>Active IT outage details</td>
</tr>
<tr>
<td>Find your apps</td>
<td>Apps provided by your company</td>
</tr>
</tbody>
</table>

If the Employee Service Center (com.sn_hr_service_portal) plugin is activated, Your Hub dashboard displays as shown in the screen below:

The banner will display the count of the tasks to be completed by the logged in user.
Quick Links

Visit your Employee portal displays in the quick links section. When you click this link, it will redirect to Employee Service Center portal.

Complete Your To-dos

Complete your to-dos is displayed as the title of the widget.
<table>
<thead>
<tr>
<th>Lenovo - Carbon x1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested by Abel Tuter</td>
<td>Due today</td>
</tr>
<tr>
<td>Lenovo - Carbon x1</td>
<td></td>
</tr>
<tr>
<td>Requested by Abraham Lincoln</td>
<td>Due today</td>
</tr>
<tr>
<td>Lenovo - Carbon x1</td>
<td></td>
</tr>
<tr>
<td>Due today</td>
<td></td>
</tr>
<tr>
<td>Lenovo - Carbon x1</td>
<td></td>
</tr>
<tr>
<td>Requested by Arpita Gupta</td>
<td>Due today</td>
</tr>
<tr>
<td>Lenovo - Carbon x1</td>
<td></td>
</tr>
<tr>
<td>Requested by Arpita Gupta</td>
<td>Due today</td>
</tr>
</tbody>
</table>

Next ➔
The data is fetched from `sn_hr_sp.todos_config` table and displays in the **Complete your to-dos** widget.

Each record displays the following attributes:

- Short description
- Requester (This field will not display if the requester field is empty)
- Due date of the record

**Track your request**

Customize the data to be displayed for the users in the track your request widget.

The data is fetched from the "request_filter" table and displays the pending requests for the user.
<table>
<thead>
<tr>
<th>Track your requests</th>
<th>1-6 of 24</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard Laptop</strong></td>
<td></td>
</tr>
<tr>
<td>Open</td>
<td>2h ago</td>
</tr>
<tr>
<td><strong>Standard Laptop</strong></td>
<td></td>
</tr>
<tr>
<td>Open</td>
<td>2h ago</td>
</tr>
<tr>
<td><strong>Standard Laptop</strong></td>
<td></td>
</tr>
<tr>
<td>Open</td>
<td>2h ago</td>
</tr>
<tr>
<td><strong>Apple iPad 3</strong></td>
<td></td>
</tr>
<tr>
<td>Open</td>
<td>2h ago</td>
</tr>
<tr>
<td><strong>Standard Laptop</strong></td>
<td></td>
</tr>
<tr>
<td>Open</td>
<td>2h ago</td>
</tr>
</tbody>
</table>
Each record displays the following attributes:

- Short description
- State

Customize Script Includes
You can customize to display the data in Your Hub dashboard in Microsoft Teams.

Role required: admin

You can customize the approval notifications, and dashboard widgets for ServiceNow for Microsoft Teams application in your ServiceNow instance:

- Approval Notifications
- Your Hub dashboard widgets: Quick links, Complete your To-dos, Track your requests

1. Navigate to **System Definition > Script Includes**.
2. Click **PortalLinkConfig** script include.
3. In the **Script** field, review the code-comments and add the quick links.

### Customize script includes form

<table>
<thead>
<tr>
<th>Widget</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Notifications</td>
<td>You can customize the card fields in – MSTeamsApprovalNotificationUtil script include's buildCardFieldsObj function for approval notification</td>
</tr>
<tr>
<td>Quick Links</td>
<td>You can specify up to five quick links under PORTAL_LINK_GROUP object.</td>
</tr>
<tr>
<td>Complete your To-dos</td>
<td>You can override the portal in sn_now_teams.PortalLinkConfig script include. Override the implementation for getPortalSuffix: function(sourceGr) { }.</td>
</tr>
<tr>
<td>Track your requests</td>
<td>You can override the portal in sn_now_teams.PortalLinkConfig script include. Override the implementation for getPortalSuffix: function(sourceGr) { }.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

Review the active notifications for Microsoft Teams
The notifications added by ServiceNow for Microsoft Teams, might duplicate existing notifications in your instance. Review and disable any duplicate notifications to avoid notifying users multiple times for the same event.

Role required: admin

1. Navigate to **System Notification > Provider > Notifications**.
2. Identify a duplicate notification. Example: **Incident Update**.
3. Open the **Incident Update** notification.
4. Clear **Active**.
5. Click **Update**.
6. Repeat the process for the following notifications:
   - SysApproval Approver Insert
   - Incident Update
   - Requested Item Update

Leave a comment on an incident record, only one notification appears about the comment in Microsoft Teams.

**Install fix-script for IT Service Management integration with Microsoft Teams**

Install the `fix_script_start_chat_field_decorator_IT` in the ServiceNow instance to display **Start Microsoft Teams chat** field decorator in the ticket to initiate a chat with the requester.

**Role required:** admin

Download the `fix_script_start_chat_field_decorator_IT` update set from the app store. Visit the app store [IT Service Management integration with Microsoft Teams](#) to download the fix script.

1. Navigate to **System Update Sets > Local Update Sets**.
2. Right-click on the **Name** column, and click **Import XML** menu.
3. On the **Import XML** form, fill in the fields:
   4. In the XML file field, click **Choose file** button and select `fix_script_start_chat_field_decorator_IT` XML file and upload the XML file.
5. Navigate to **System Definition > Fix Scripts**.
6. In the **Name** search field, enter **Add Teams chat Field Decorator**.
7. Click **Add Teams chat Field Decorator** fix script.
8. Check **Active** check box.
9. Click **Run Fix Script** button.

The ![icon](image) icon is displayed as a field decorator in a record.

**User setup and actions**

Link your ServiceNow account with Microsoft Teams application to access non-public Virtual Agent topics that use ServiceNow records.

*Add ServiceNow for Microsoft Teams app*

Enables users to interact with the agents from Microsoft Teams application.

**Role required:** admin

To receive notifications from Virtual Agent, users must link their accounts to Microsoft Teams. Guest users can't receive notifications.

1. Launch Microsoft Teams application.
2. Click **Apps**.
3. In the apps search field, enter **ServiceNow for Microsoft Teams**.
4. Click **ServiceNow for Microsoft Teams** app.
5. Click **Open**.

The **ServiceNow for Microsoft Teams** app is successfully installed in your Microsoft Teams application.
Link ServiceNow user account to Microsoft Teams application for Virtual Agent

Link your ServiceNow account to Microsoft Teams application to access the non-public Virtual Agent topics that use ServiceNow records.

Role required: user

The authentication step occurs in your instance or in a specific Service Portal, if set by your admin.

1. Open the Microsoft Teams application.
2. Find your Virtual Agent bot.
3. Start a conversation with your Virtual Agent bot.
   The bot then presents a prompt that provides options to authenticate Link to ServiceNow, continue as a guest user, or see the help menu Check out Tips.

4. Click Link to ServiceNow to authenticate.
   Authentication directs you to your instance or a specific Service Portal set by your admin. If you are not already logged in to your instance or a Service Portal, you are prompted to enter your login credentials.

5. On the confirmation dialog, click Confirm to link your account.

Unlink your ServiceNow user account from Microsoft Teams for Virtual Agent

Unlinking your account from Microsoft Teams to deactivate the association between your ServiceNow account and the Microsoft Teams application.
Role required: user

After you unlink your account, you can no longer engage in Virtual Agent conversations that query or change records in the ServiceNow database.

1. From the application navigator, navigate to **Self-Service > My Profile**.
2. Click the **View Linked Accounts** related link.
3. In the linked accounts page, select the check box for the messaging integration to be unlinked.
4. Select **Actions on selected rows** and then click **Unlink account**.

   The link between your ServiceNow account and the Virtual Agent messaging integration becomes inactive.

**Note:** Even though you unlinked your account, you can still run public Virtual Agent conversations. To link your account again, repeat steps 1 through 3 for the associated messaging integration and in the **Actions on selected rows...** click **Link account**.

---

**Using ServiceNow for Microsoft Teams**

Employees and agents can collaborate to receive service and resolve issues effectively from Microsoft Teams.

**Employee actions**

Respond to the approval notifications and the comments against the service-related tickets.

Actionable notifications sent through Virtual Agent in Microsoft Teams. You can:

- Accept or reject approvals in response to an actionable notification
- Respond to a comment from an agent in an actionable notification

**View informational notifications**

View the notifications that are sent during specific events in a ticket life cycle. These notifications are sent to the requester associated with the ticket.

Role required: user

The following informational notifications are included with ServiceNow for Microsoft Teams application:

- Incident resolved
- Incident state update
- Requested item complete
- Requested item approved
- Request item rejected
- Request item update

1. Launch Microsoft Teams application.
2. Click **Activity**.
3. View the list of notifications feeds for:
   - Incident
   - HR case
   - Change request
Approval Notifications
The user receives a notification with an Approve or Reject action. If rejecting, a comment must be provided.

Role required: user
1. Launch Microsoft Teams application.
2. Click Activity.
3. View the list of notifications feeds for:
   - Request
   - Change Request
4. Click the notification to view the details.
5. Enter a comment as required.
6. Click either Approve or Reject the request.
7. Click View details to view the complete details of the ticket.

Respond to a comment in a notification
A comment in the activity stream generates a notification to which the user can respond directly, without leaving Microsoft Teams.

Role required: user
If the user needs to take an additional action, such as attaching a document, they must click **View Ticket Details** to go to the ticket in a Service Portal.

1. Launch Microsoft Teams application.
2. Click **Activity**.
3. View the list of notifications feeds for:
   - Incident
   - HR case
   - Change request
   - Requested item
4. Click the notification to view the details.
5. Click **Send reply**.
6. Enter your comment.
7. Click **Send**.
8. Click **View ticket details** to view the complete details of the ticket.

*View notifications for a major incident*

View the notifications that are sent during specific events in a major incident. These notifications are sent to all the stakeholders associated with the major incident.
Role required: major_incident_manager, agent

The following informational notifications are triggered for a major incident when:

- A communication task is created for a major incident
- SLA reaches 75%
- SLA is breached

1. Launch **Microsoft Teams** application.
2. Click **Activity**.
3. View the list of notifications feeds for the major incident.
4. Click the notification to view the details.
New communication task

INC0000530

Naveen Mallepally created First technical communication for this Incident

<table>
<thead>
<tr>
<th>Task name</th>
<th>First technical communication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication plan</td>
<td>Immediate response</td>
</tr>
<tr>
<td>Channels</td>
<td>E-mail</td>
</tr>
<tr>
<td>Due</td>
<td>2020-09-29 23:45:23</td>
</tr>
</tbody>
</table>

5. Click **View workbench** to view the ticket details in ServiceNow.
Your hub dashboard
Use the Your Hub dashboard from Microsoft Teams to view the widgets that show pending tasks, requests, and the internal company announcements.

For customers with Employee Service Center, Content managers and Communications Specialists will be able to leverage Microsoft Teams as an additional channel to reach employees with personalized and timely communications.

Launch Microsoft Teams. Navigate to ServiceNow for Microsoft Teams > Your hub.

Click the tickets you would like to work to open in the ServiceNow instance.
You can view and access the following widgets:

<table>
<thead>
<tr>
<th>Widget</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View your employee portal</td>
<td>Click to navigate to the employee portal</td>
</tr>
<tr>
<td>Complete your To-dos</td>
<td>List of your pending tickets</td>
</tr>
<tr>
<td>Track your requests</td>
<td>List of your requests</td>
</tr>
<tr>
<td>IT announcements</td>
<td>View the IT announcements released by the IT department</td>
</tr>
<tr>
<td>Upcoming events</td>
<td>View the upcoming events in your company</td>
</tr>
<tr>
<td>Holiday calendar</td>
<td>View the upcoming holidays for the current year</td>
</tr>
<tr>
<td>IT outages</td>
<td>View the active IT outage details</td>
</tr>
<tr>
<td>Find your apps</td>
<td>List of apps provided by your company.</td>
</tr>
</tbody>
</table>

**Agent actions**

Work on the service-related tickets created by the employees.

*Start chat and import messages from the record*

Interact with a requester in Microsoft Teams for an issue related to an incident, request item, change request, and import the chat back to your instance.

*Initiate chat with requester*

Initiate a conversation with the requester to resolve the ticket.

You must have the “write” role to use the Start Microsoft Teams chat and Import messages from Microsoft Teams features for an incident, request, change request. This role is available when you activate the ITSM roles plugin, or for all the instances starting the Madrid release.

**Record and Role**

<table>
<thead>
<tr>
<th>Record</th>
<th>Role</th>
<th>Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>sn_incident_write</td>
<td>ITSM Roles - Incident Management (com.snc.itsm.roles.incident_management) plugin</td>
</tr>
<tr>
<td>Change Request</td>
<td>sn_change_write</td>
<td>ITSM Roles — Change Management (com.snc.itsm.roles.change_management) plugin</td>
</tr>
<tr>
<td>Request</td>
<td>sn_request_write</td>
<td>ITSM Roles — Request Management (com.snc.itsm.roles.request_management) plugin</td>
</tr>
</tbody>
</table>

*Initiate chat with requester from field decorator*

Interact with a requester in Microsoft Teams from the field decorator from the agent workspace to quickly resolve the ticket.

Role required: user with access to the respective records

1. Navigate to an open ticket in your ServiceNow instance from agent work space.
Navigational path

<table>
<thead>
<tr>
<th>Record</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>Navigate to Incident &gt; Open. Open the record you want to work on.</td>
</tr>
<tr>
<td>Change Request</td>
<td>Navigate to Change &gt; Open. Open the record you want to work on.</td>
</tr>
<tr>
<td>Request Item</td>
<td>Navigate to Requests &gt; Open Requests. Open the record you want to work on.</td>
</tr>
</tbody>
</table>

2. Point to

next to the Caller field

The chat is initiated with the caller in Microsoft Teams.

Initiate conversation with a requester from a record

Interact with a requester in Microsoft Teams for an issue related to an incident, request item, change request, and HR case records to quickly resolve the ticket.

Role required: user with access to the respective records

1. Navigate to an open ticket in your ServiceNow instance:

Navigational path

<table>
<thead>
<tr>
<th>Record type</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>Navigate to Incident &gt; All. Open the record you want to work on.</td>
</tr>
<tr>
<td>Change Request</td>
<td>Navigate to Change &gt; All. Open the record you want to work on.</td>
</tr>
<tr>
<td>Request Item</td>
<td>Navigate to Service Catalog &gt; Open Records &gt; Item. Open the record you want to work on.</td>
</tr>
</tbody>
</table>

2. Click Start Microsoft Teams Chat.

3. Within the dialog box that appears, select the participants for the chat.
The dialog box displays the **Recommended** and **Selected** participants for the chat. All users from the assigned group for the ticket are in the recommended section by default. The user who initiates the chat is added to the selected list of participants.

4. Click **Add Participants** list to:
   - **Users**: Enter the name of the user to include in the chat.
   - **Group**: Enter the group of users to be included in the chat.
If the On-Call Scheduling (com.snc.on_call_rotation) plugin is activated, the On-Call Scheduling users will be added when you select a group. On-Call Scheduling (com.snc.on_call_rotation) plugin isn’t activated, it adds all users from the selected group.

- **Email**: Enter a valid email of the participant to be included in the chat.

5. Click **Add to selected**.

   The **Chat Title** appears only if there are more than two participants in the chat.

   The chat title specified shows up as the title of the group chat in Microsoft Teams. The default title is the ticket number appended with the short description. You can modify the chat title.

6. Click **Start Chat**.

The Microsoft Teams application opens the tab where the agent can chat with the all the selected participants.

**Import messages from a ticket**

You can import the conversation with a user from Microsoft Teams and append them in the **Comments** to store all the important messages in the ServiceNow instance.

**Role required**: user

Importing messages helps agents to view the history of the ticket, allow the requester to see all discussions about their ticket in one place. This helps to capture the information required for post-ticket review and continuous improvement processes.

1. Navigate to an open ticket in your ServiceNow instance:

   **Navigational path**

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>Navigate to Incident &gt; All. Open the record you want to work on.</td>
</tr>
<tr>
<td>Change Request</td>
<td>Navigate to Change &gt; All. Open the record you want to work on.</td>
</tr>
<tr>
<td>Request Item</td>
<td>Navigate to Service Catalog &gt; Open Records &gt; Item. Open the record you want to work on.</td>
</tr>
</tbody>
</table>

2. Click **Import messages from Microsoft Teams**.

   You receive a prompt to log in to Microsoft Teams if you are not logged in.

3. Click **Accept**.
4. On the **Import messages from Microsoft Teams** form, fill in the fields:
### Import messages from Microsoft Teams table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show conversations</td>
<td>Choose from:</td>
</tr>
<tr>
<td></td>
<td>• Started from this record: Lists all the communication tasks created for the record.</td>
</tr>
<tr>
<td></td>
<td>• List all conversations: Lists all conversations by the logged in agent.</td>
</tr>
<tr>
<td>Select a conversation</td>
<td>Choose a conversation to import the messages for the record.</td>
</tr>
<tr>
<td>Import messages as</td>
<td>• <strong>Additional comments</strong>: The messages will be appended under Additional comments.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Work notes</strong>: The messages will be appended under Work notes.</td>
</tr>
</tbody>
</table>
Import messages from Microsoft Teams

Show conversations

Started from this record

Select a conversation

survey user, System Administrator

- You 10:21:44
  content_css_c4874d655362101084a5ddee7b123e.xml

- Wednesday 2020-09-02

- You 09:54:36
testing

- Friday 2020-09-11

- You 19:38:22
test

Import messages as

Additional comments

Cancel Import messages
5. Select the messages, files, and the images you would like to import and click **Import messages**.

**Start chat and import messages from agent workspace**

Interact with a requester in Microsoft Teams from the agent workspace for an issue related to an incident, request item, change request, and import the chat back to ServiceNow.

**Initiate chat from Agent Workspace**

- Initiate a conversation with the requester to resolve the ticket.

**Initiate chat with requester from field decorator**

Interact with a requester in Microsoft Teams for an issue related to an incident, request item, and a change request ticket to quickly resolve the ticket.

Role required: user with access to the respective records

1. Navigate to an open ticket in your ServiceNow instance from agent work space.

**Navigational path**

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>Navigate to <strong>Incident</strong> &gt; <strong>Open</strong>. Open the record you want to work on.</td>
</tr>
<tr>
<td>Change Request</td>
<td>Navigate to <strong>Change</strong> &gt; <strong>Open</strong>. Open the record you want to work on.</td>
</tr>
<tr>
<td>Request Item</td>
<td>Navigate to <strong>Requests</strong> &gt; <strong>Open Requests</strong>. Open the record you want to work on.</td>
</tr>
</tbody>
</table>
2. Point to
The chat is initiated with the user in **Microsoft Teams**.

Initiate conversation with a requester from Agent Workspace

Interact with a requester in Microsoft Teams from the agent workspace to quickly resolve the ticket.

Role required: user with access to the respective records

1. Navigate to an open ticket in your ServiceNow instance from agent workspace.

   **Navigational path**

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>Navigate to Incident &gt; Open. Open the record you want to work on.</td>
</tr>
<tr>
<td>Change Request</td>
<td>Navigate to Change &gt; Open. Open the record you want to work on.</td>
</tr>
<tr>
<td>Request Item</td>
<td>Navigate to Requests &gt; Open Requests. Open the record you want to work on.</td>
</tr>
</tbody>
</table>

2. Click **Start Microsoft Teams Chat** button.

   The chat will be initiated with the requester in Microsoft Teams.

3. Within the dialog box that appears, select the participants for the chat.
The dialog box displays the **Recommended** and **Selected** participants for the chat. All users from the assigned group for the ticket are in the recommended section by default. The user who initiates the chat is added to the selected list of participants.

4. Click **Add Participants** list to:

- **Users**: Enter the name of the user to include in the chat.
- **Group**: Enter the group of users to be included in the chat.
If the On-Call Scheduling (com.snc.on_call_rotation) plugin is activated, the On-Call Scheduling users will be added when you select a group. On-Call Scheduling (com.snc.on_call_rotation) plugin isn't activated, it adds all users from the selected group.

- **Email**: Enter a valid email of the participant to be included in the chat.

5. **Click Add to selected.**

   The **Chat Title** appears only if there are more than two participants in the chat.

6. **Click Start Chat.**

The Microsoft Teams application opens the tab where the agent can chat with all the selected participants.

**Import messages from Agent Workspace**

You can import the conversation with a user from agent workspace and append them in the **Comments** to store all the important messages in the ServiceNow.

**Role required: user**

1. Navigate to an open ticket in your ServiceNow instance from agent work space.

<table>
<thead>
<tr>
<th>Record</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>Navigate to <strong>Incident &gt; Open</strong>. Open the record you want to work on.</td>
</tr>
<tr>
<td>Change Request</td>
<td>Navigate to <strong>Change &gt; Open</strong>. Open the record you want to work on.</td>
</tr>
<tr>
<td>Request Item</td>
<td>Navigate to <strong>Requests &gt; Open Requests</strong>. Open the record you want to work on.</td>
</tr>
</tbody>
</table>

2. **Click Start Microsoft Teams Chat list.**

3. **Click Import messages.**

   You receive a prompt to log in to Microsoft Teams if you are not logged in.

4. **Select the messages you would like to import and click Import messages.**
Index

Special Characters
<feature name> activate 317

A
activate
  Change Management - Change Schedule 307
  Change Schedule 307
  service portfolio management plugin 1261
  sla breakdowns 1345
  Vendor Manager Workspace plugin 1456
actual elapsed time 1383
add
  change state 347
  custom business rules 1377
  related tasks 398
  related tasks to change schedule 398
add assignments
  create from request 224
add new change state 340, 347
add state change condition 346
application
  contract management 188
assess risk 411
Asset and CI management
  adding depreciation to asset 39
  allocate pre-allocated assets 47
  consume consumable assets 46
  create assets 31
  create consumable assets 44
  create fixed assets 41
  create license assets 40
  create pre-allocated assets 46
  delete assets 36
  depreciation with fixed assets 42
  life cycle of consumables 43
  set asset states and substates 40
  split pre-allocated assets 48
  view consumable assets 44
asset classes
  create 38
Asset Management
  Asset and CI management 28
  asset classes 38
  asset classes, create 38
  calculate software licenses 91
  counters 103, 104, 104, 105, 106, 109, 110, 112, 114, 116
  create a custom license type 96
  create license calculation script 96
  determine where software is installed 73
  IBM PVU Process Pack 118
  installed with 177
  installed with Model Management 172
  installed with Oracle process pack 133
  installed with Software Asset Management 64
  license calculation types 92
  license calculations 91
  manage software licenses 80, 83, 84
  managing software models 85, 88
  Oracle mapping 135
  Oracle process pack 131, 131
  Oracle software counter 131, 136
  Oracle software license 135
  Oracle software models 131
  process 61
  Software Asset Management 76
  software discovery models 98, 99, 99, 100
  software license reconciliation 103, 104, 104, 105, 106, 109, 110, 112, 114, 116
asset state
  set 40
asset substate
  set 40
Asset-CI mapping
  map asset state 37, 38
  map CI install status 37
  map fields 36
  map hardware status 38
assets
  delete 36
assignment rule
  for change requests 329
automated conflict detection 433

B
Badge Reader Integration
  Installed with 689
Benchmarks
  dashboard 285
  enable a KPI 276
  enabling a KPI 277
  KPI conditions 278
  KPI configuration 269
  KPI data 294
  KPI data view 288
  KPI performance trend view 289
  KPI recommendations 289
  opt in 267
  opt out 267, 268
  overview 261
  roles 266
  troubleshooting 294
blackout schedule 426
breakdown
  sla 1380
breakdown definitions
  service level management 1380
bulk CI changes
  proposed change 382
Bulk CI changes
installed components
  tables 317
business elapsed time 1383
Business percentage time
  SLA Timeline 1401
business rules
  Change Management - Change Schedule 309
Business schedule
  SLA Timeline 1401

C
CAB agenda 456
CAB definition 444
cab meeting
  cab workbench 458
  manage 461
CAB meeting 449
CAB meeting invitations 458
cab workbench
  cab meeting 458
CAB workbench 443
cancel conflict detection 434, 435
change
  conflict calendar 429
  change conflict calendar
    view 429
change conflict detection 411
change management
  bulk CI change 381
  change types 296
  discovery 467
  integration 466
  mass update CI 381
  properties 322
  SAM 468
Change Management
  affected CIs 378
  Associate multiple CIs 378
  change risk assessment 415, 415
  Extend multiple CI association 335
  impacted CIs 378
  ITIL 295
  manage CI changes 377, 378
  risk assessment 418
Change Management - Change Schedule
  business rules 309
  installed with 307
  properties 308
  roles 308
  script includes 311
  tables 308
  ui policies 310
  ui scripts 312
change request
  assignment rules 329
  create 364
  process 376
  change request on hold 382
change request type
  new 330
change risk assessment 411
change risk calculator
  module 411
change schedule
  create 396, 397
  related tasks 398
change schedule definitions
  define style rules 400
change schedules
  landing page 391
change state
  new 347
change state example 347
Change State Model 335
change state tutorial 347
change task template
  change 388
change types
  change management 296
client scripts 1349
Coaching
  Assess a trainee 509
  Coaching field descriptions 519
  Coaching reference 516
  Define trigger conditions for a coaching opportunity 502
coaching loops
  activating 495
  application roles 497
configure
  SLA properties 1369
  standard change properties 386
configure problem form 1163
configure SLA properties 1369
configure state model 346
configure state transition 346
conflict detection
  activate 305
  installed components
    tables 306
consumable assets
  consume 46
  create 44
  view 44
consumables
  life cycle of 43
Continual Improvement Management
  Continual Improvement Management Overview 530
  Improvement field descriptions 577
contract 1342
contract management
  add a configuration item 199
  add a user 199
  add an asset 199
  add document 200
  add terms and conditions 205
  adjust contract 200
  approval history 204
approve contract 203
build terms and conditions 205
cancel contract 202
components 190
condition check definitions 213
contract life cycle 193
contract notification 203
create a contract 195
create terms and conditions 204
define condition check 213
extend contract 201
installed components
  business rules 191
  client scripts 191
  roles 190
  script includes 190
  tables 190
  user roles 190
reject contract 203
renew contract 200
send for approval 203
software maintenance contract 198
terms and conditions 204
Contract Management
  use contract management 193
Contract Management Overview Module 188
contract rate cards 207, 208
contracts
  monitor 211
  reports 212
conversion process
  organize 1410
convert SLA
  task SLA 1411
create
  change request 364
  change schedule 396, 397
  change task template 388
  SLA breakdown definitions 1380
Create a catalog request in Agent Workspace 1240
create knowledge
  use the knowledge check box 1198
create vendor credit
  from incidents 1536
  from Outage form 1535
  from Service Availability form 1536
  from table records 1535
  from the Company form 1537
  from Vendor Credit form 1533
custom business rules
  add 1377

define assignment rule
  problems 1166
define CAB 444
define service contract 1342
define style rules
  change schedule definitions 400
  style rules table 400
detect conflicts 411
discovery
  change management 467
duration
  SLA 1359

E

editing style rules
  span style 401
Elapsed time 1383
deployed 771
deployment 799
dependency graph 811
derivation 811
detail 1021
description 1021
description comment 1021
description field 1021
description field comment 1021
description fields 1021
description tab 1021
description text 1021
description value 1021
derivation in component 799
dependent objects 1021
dependent version 1021
deployment 799
  deploy 799
  deployed 771
deployment package 799
deployment tasks 799
deployment version 799
deployed 771
deployed version 771
deploying 799
deployments 799
deployments v 799
dependent version 1021
dependent versions 1021
description text 1021
description value 1021
determine
edit 1110
deployment 799
deployment tasks 799
deployment version 799
deployed 771
deployed version 771
deployment 799
deployment package 799
dependent 1021
dependent versions 1021
deployment tasks 799
deployment version 799
deployed 771
deployed version 771
deployment
task 799
deployment version 799
deployed 771
deployed version 771
deployments
  v 799
deployments version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments version 799
deployed version 771
deployment version 799
deploy workers
  worker 799
deployment
  package 799
deployment tasks 799
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
display 771
display tasks 799
deployment
  package 799
deployment tasks 799
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
deployment version 799
deployed
  version 771
deployment version 799
deployed version 771
deployments
  version 799
deployment version 799
deployed version 771
new
  change request type 330
new change request type 330
new change state
  add 340
new manufacturer
  create 171
new SLA condition rule
  create
    SLA condition rule 1367
  define
    SLA condition class 1367
new vendor
  create 171
normal
  change 296
Notification
  SLA 1408

O
old SLA engine
  reactivate 1418
on-call
  scheduling 1055
On-Call roles 1062
On-Call schedule
  create on-call schedule 1105
on-call scheduling
  escalation settings 1081
  installed components
    tables 1056
  use notify 1131
On-Call scheduling
  properties 1089
On-Call Scheduling
  reminder lead time 1100
  shift reminder 1099
Operational status 1277
Organization Management
  create new manufacturer 171
  create new vendor 171
  Locations module 171
overview
  major incident 1007
overview dashboard
  sla 1418

P
PA dashboard
  sla 1421
plugins 1346
pre-allocated asset
  allocate 47
  split 48
pre-allocated assets
  create 46
problem configuration 1163
problem management
  associate a task to an outage 1427, 1428
  creating knowledge 1198
Problem Management
  prioritize problems 1167
process
  change request 376
  processing within SLA 1382
procurement
  activate 217
  consumable asset 237
  create 229
  create an asset 233
  create purchase order 227
  edit a catalog task 226
  purchase order
    cancel 232
    reorder 233
  purchase order line item
    cancel 232
    reorder 233
  purchase order management 225
  purchase order status 231
  purchase orders
    expected delivery date 232
    receive assets 234, 234
    receiving slip 236
    receiving slip line 236
    reserve asset 233
    roles 215
  service catalog
    cancel request 225
    track request 225
    view a catalog task 226
    workflows 215
Procurement 217
procurement overview module
  use 217
product catalog
  activate items 256
  create item 252
  create vendor catalog items 249
  deactivate item 256
  installed components
    business rules 240
    client scripts 239
    roles 239
    script includes 239
    tables 238
  items 252
  link to hardware catalog 250
  link to software catalog 251
  publish to hardware catalog 251
  publish to software catalog 251
  synchronize information 248
  vendor catalog 248
  view vendors 252
Product Catalog 238
Product Hierarchy 1231
properties
  Change Management - Change Schedule 308
purchase order
  create from a request 223

R
rate card
  expense generation 210
rating summary
  vendor decision matrix 1513
related tasks
  add 398
  change schedule 398
related tasks to change schedule
  add 398
release
  define 1233
  scope 1235
Release 1231
release management
  activate 1231
  user roles 1236
release phase
  define 1234
Release v2
  defining a product 1232
remove member from shift 1104
request items
  add assignment 221
  purchase order 221
  source 221
  transfer order 221
Request Management 1236
retroactive pause
  SLA 1368
risk assessment
  changes 418
  define 415
  migrate 419
roles
  Change Management - Change Schedule 308

S
SAM
  change management 468
  schedule
    SLA 1359
schedule entry
  modify 1113
schedule time off 1093
scheduled jobs
  SLA 1386
schedules 391
scheduling
  on-call 1055
script includes
  Change Management - Change Schedule 311
security, On-Call Scheduling 1062
service 1277
service contract 1342
service desk 1246
service desk call
  create call 1253
  domains 1252
  installed components
    business rules 1251
    client scripts 1250
    tables 1250
  tasks by same company 1254
  tasks by same user 1254
  transfer call 1255
  transfer call to request 1256
  transfer call to task 1255
  view calls 1256
Service Desk Call 1248
service level agreement 1369, 1372, 1373
service level management
  breakdown definitions 1380
Service Level Management
  installed components
    Business rules 1344
    Client scripts 1344
    Email notifications 1344
    properties 1344
    scheduled jobs 1344
    Script includes 1344
    tables 1344, 1344
    UI actions 1344
    UI policies 1344
    Workflows 1344
Service level requirement 1277
service owner workspace
  access 1325
  use 1325
Service Owner Workspace
  activate plugin 1307
  configure estimated spend 1338
  configure offering cost source 1338
  configure spend offering cost 1338
  csat 1334
  Explore 1292
  installed with 1310
  integrations 1315
  migration dashboard 1313
  performance metrics 1296
  quick start tests 1311
  service availability 1318
  service offering survey
    survey 1334
    set up 1305
    use 1324
    view or configure metric definitions 1316, 1317
service portfolio management
  activate plugin 1261
Service Portfolio Management
  administration 1260
  apply scope to a service 1280
  create a service 1278
create service portfolios 1271
domain separation 1268
installed with 1262
manage service portfolios 1271
portfolio design experience 1269
portfolios 1271
sample portfolio taxonomy
activate 1266
view 1267
service commitments 1285
service level management 1289
service offering price 1288
service offerings 1288
service outages 1287
service subscriptions 1288
set service offering price model
set service offering price units 1281
setup 1269
SLA results 1289
subscribe to service subscriptions 1289
taxonomy 1273
taxonomy layers definitions 1274
taxonomy nodes 1275
understanding 1258
users
roles 1265
Service Portfolio Management Premium
assign access
change scope 1319
create automated indicators 1322
set up 689
setup
Service Portfolio Management 1269
show SLA timeline 1398
Show SLA Timeline 1391
sla
breakdown definitions 1380
overview dashboard 1418
PA dashboard 1421
SLA
calculation 1384
duration 1359
Notification 1408
repair 1386, 1387, 1390
repair from a form 1388
repair from a list 1390
retroactive pause 1368
retroactive start 1368
schedule 1359
scheduled job 1386
scheduled jobs 1386
Trigger 1399
Validate SLA definition 1404
SLA breakdown definitions
create 1380
sla breakdowns
activate 1345
business rules 1349
client scripts 1349
installed with 1346
plugins 1346
properties 1347
script includes 1348
table 1346
ui policy 1347
SLA calculations 1385
SLA condition rule
customize 1366
extend 1366
invoke globally 1368
invoke on a specific SLA 1368
SLA condition rules 1364, 1366
SLA definition
verify 1398
SLA Definition
create 1353
SLA definitions 1352
SLA Due 1409
SLA engine 1382
SLA processing 1382
SLA properties
configure 1369
SLA stage change
SLA
Stage change 1402
SLA Timeline 1402
SLA timeline
activate 1351
use 1398
view 1398
SLA Timeline
Business percentage time 1401
Determine business schedule 1401
installed components
script includes 1351
SLA stage change 1402
Validate SLA defintion 1404
SLA transitions 1362
SLA workflow
SLA 1356
workflow 1356
SLAConditionBase 1365
SLAConditionSimple 1366
SLM 1340
SLM landing page 1340
software
find on network 74
installed 73
scan installations 75
Software Asset Management
activate 136
administration 165
custom product 166, 166
dashboard 140
Discovery 154
get started 139
installed with 64
licensing 142
migrate 170
migrate software installs 167
migration 168
overview module 62
| **plugin** | 136 |
| **properties** | 167 |
| **reconciliation** | 161 |
| **roles** | 140 |
| **run reconciliation** | 165 |
| **set up** | 138 |
| **setup process** | 73 |
| **software discovery models** | 155 |
| **software entitlement** | 149, 153 |
| **software model results** | 162 |
| **software models** | 143 |
| **software suite** | 147 |
| **using** | 62 |

Software Asset Management Foundation 136

**software contracts**
- creating 131

**software discovery models**
- automatic matching to an existing model 99
- create new models 100
- edit 99, 159

**software installations**
- custom patterns 159
- manual override edition 159

Software License Compliance Checker
- using 102

**Software licenses**
- add new 77
- create and manage subscription license 79
- create software user license entitlement 80
- downgrade a license 83
- entitle license to configuration item 81
- entitle license to user 81
- entitlements 79
- upgrading 82
- view list of unallocated software licenses 84

**Software Licenses**
- creating enterprise licenses 78
- upgrade and downgrade 81

solution 473, 933, 957, 1202, 1621

Solutions 1420

**Stage change**
- SLA 1402

**standard**
- change 296

**standard change catalog** 314, 315, 385

**standard change properties**
- configure 386

**state model**
- activation 303
- emergency change 338
- installed components
  - tables 305
- normal change 338
- standard change 338

State Model
- activate 303
- installed components 305

stockrooms
- create 48
- create stock rules 52
- create types 51

| **delete** | 49, 49 |
| **stock rules** | 51 |
| **types** | 49 |

**style rules**
- define 399

**style rules table**
- define style rules 400

T

**table**
- Task SLA 1414

**tables**
- Change Management - Change Schedule 308

**Task SLA**
- table 1414

**Time**
- time zones 1359
- timeline 1398
- Timeline 1391

**transfer order**
- create from request 224

**transfer orders**
- create 57
- create transfer order line 57
- delete 56
- delete transfer order line 56
- line asset tracking 60, 60, 60
- return items 56
- transfer assets 55
- transfer process 55

**Trigger**
- SLA 1399
- tutorial 347

U

**ui policies**
- Change Management - Change Schedule 310

**ui policy** 1347

**ui scripts**
- Change Management - Change Schedule 312

unallocated software licenses
- view 84

Use Counters for Software License Reconciliation
- schedule 104
- set up quick counters 109
- software counter 105, 106
- software counters 104, 104
- view software counter detail 114
- view software counter results 110
- view software counter summary 112
- view usage counter result 116

Use Time Zones
- service level agreements 1359
- time zone 1359

Use Vendor Ticketing
- configure contract SLAs 1527
- configure SLAs 1526
- sla stage 1520
V

Validate SLA definition
SLA 1404
SLA Timeline 1404
Vendor Bubble Charts
using 1514
vendor catalog
create a catalog item 249
link to hardware catalog 250
link to software catalog 251
publish to hardware catalog 251
publish to software catalog 251
synchronize information 248
view vendors 252
vendor credit 1533
vendor decision matrix
view 1511
vendor decision matrixes 1510
Vendor manager workspace
vendor satisfaction survey 1460
Vendor Manager Workspace
activate plugin 1456
Analyzing indicator scores in Vendor Manager Workspace 1451
Associate a vendor score metric model with a vendor 1471
Create an improvement initiative for a vendor 1472
domain separation 1458
Explore Vendor Manager Workspace 1446
installed with 1458
Use Vendor Manager Workspace 1471
Vendor Manager Workspace reference 1449
Vendor Manager Workspace user interface 1455
Vendor Performance
activating 1491
assessment 1490
configuring 1474
create vendor record 1477
use vendor ticketing 1520, 1520, 1526, 1527, 1529, 1532
vendor activity 1485
vendor assessments set up 1486
vendor contact 1484
vendor managers 1483
vendor scorecards 1495, 1495, 1495, 1499, 1501, 1502, 1503, 1505, 1506
vendor ticketing 1519
vendor type 1476
vendor performance overview module
use 1493
Vendor Scorecards
averages by vendor type 1501
categories 1502
category metrics 1503
head to head compare 1505
history 1506
ratings 1499
vendor ticketing
activate 1519
Vendor Ticketing
installed with 1519
view
change conflict calendar 429
conflict calendar 429
view group schedule 1133
View SLA Timeline 1391
W
walk-up center 649
walk-up experience 649
Walk-up Experience
activate 656
activation approval 698
administration 656
appointment booking 667
appointment booking administration 667
appointment booking configuration 668
appointment booking reminders
activate 677
assigned locations 702
assisted 695
badge scanning integration
activate 688
configuration 699
client 690
configuration 659
configure 677, 690
configure application appointments 669
configure locations 679
configure notifications 666
configure schedules 666
configure service appointment daily schedule 674
configure service appointments 670
configure service channel 665
configure stockroom 678
configure surveys 684
configure walk-up portal 660
create badge handlers 693
create record producer 669
create survey 685
customization 699
dashboard 710
domain separation 653
enable appointment booking 668
enable online check-in 661
fulfill requests using platform view 707
Installed with 656
interaction management 700
manage automatic interactions 703
manage interactions manually 705
manual 697
queue management 700
register badge reader 695, 697
remove a location 685
scan logs 699
security
portal access 655
service portal online check-in 662
set up 690
understanding 650
use agent assist 708
view and manage appointments from application navigator 709
view and manage appointments in Agent Workspace 709
view inbox 702
view interactions 703, 705
view stockrooms and assets 707
walk-up location 649
workbench
major incident 990
Workforce Optimization
Workforce Optimization for ITSM 769
Workforce Optimization for ITSM
Add managers to a KPI assignment group 808
Add service channels and queues 804
Allocate work items manually to agents 814
Analyze the performance trends for your teams 824
Analyze transcripts and sentiments for the Amazon Connect 819
Assess the quality of completed tasks 825
Assist agents by joining their chat conversations 813
Associate Amazon Connect queues to a ServiceNow instance 818
Channels in Workforce Optimization for ITSM 776, 812
Cloud Call Center with Workforce Optimization for ITSM 815
Coaching in Workforce Optimization for ITSM 786, 824
Configure KPIs for queues 806
Configure KPIs for service channels 805
Configure supervisor lists for service channels 806
Create a schedule plan 822
Create a shift plan 820
Create assignment rule and groups 805
Create KPI groups to monitor team performance 807
Domain Separation and Workforce Optimization for ITSM 803
Example Channel Management for Workforce Optimization for ITSM 778
Example Coaching Workforce Optimization for ITSM 790
Example Teams in Workforce Optimization for ITSM 785
Explore Workforce Optimization for ITSM 775
Generate a preview of a schedule plan 822
Listen in to an agent call 819
Manage service channels and queues 813
Manage skills using Workforce Optimization for ITSM 826
Manage your schedule using ITSM Agent Workspace 767
Monitor ongoing work in service channels and queues 812
Request Workforce Optimization for ITSM 790
Scheduling in Workforce Optimization for ITSM 778, 820
Scheduling Workforce Optimization for ITSM 780
Set up Workforce Optimization for ITSM 790
Setting up Channels in Workforce Optimization for ITSM 804
Setting up skill prediction 808
Setting up Teams in Workforce Optimization for ITSM 807
Teams in Workforce Optimization for ITSM 823
Teams Workforce Optimization for ITSM 780
Track and analyze agents’ performance 815
Track and manage your teams’ schedule 823
Use Channels in Workforce Optimization for ITSM 812
Use Workforce Optimization for ITSM 809
Workforce Optimization for ITSM Reference 791
Use extension points for skill prediction 809

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.